sometimes I have to debug an application that was written with Borland C++ Builder. This application loads dlls compiled with Visual C++. Is there a debugger that can debug both parts of the application? Currently I have to decide - either I can easily set break points and see the source in Visual Studio or I have to start Borland C++, but I can't work with the source from the Visual-Studio compiled dll.
thank you for your help, Tobias
You could try OllyDbg - version 1.x does not seem to support the latest Win version but there is also the 2.0 although it's still in alpha state(haven't tried myself that one yet).
EDIT - clarification:
Source debugging OllyDbg reads debugging information in Borland and Microsoft formats. This information includes source code and names of functions, labels, global and static variables. Support for dynamical (stack) variables and structures is very limited.
The above is take from here.
UPDATE:
I'm not familiar with the Borland C++ Builder but at this link you can find some articles explaining how to deal with some interoperability issues between Borland and MS that might be of help.
if both parts built using ulink linker and have debug info you could try cdb32 debugger (from the ulink linker author)
cdb32 is still in its alpha stage though and I personally never tried such "mixed" debugging
I suspect there is no perfect answer to your question, you are going to have to compromise in some way, as I'm sure you are already doing.
I have a similar problem to yours at work. The applications that I work on are written in Python instead of Borland C++, but like your situation, these apps rely on a rather large Visual Studio compiled DLL for some functions.
My method of debugging these applications involves a combination of two debugging strategies: the use of an interactive debugger and the so called "printf" debugging technique.
What I basically do is pick one of the two areas as my main debug focus, and that determines my debugging approach:
If for a given situation I decide that I need to debug the DLL with greater detail, then I work with the VS debugger. I set the executable to run in the DLL project as my python script and that enables full debugging of the DLL code. If I need debugging support from the Python side, then I add print statements. If I need a breakpoint on the Python side to inspect some values, I just print all those values and immediately after call a C++ function that does nothing, but that has a breakpoint set in VS.
When I need to concentrate more on the Python side more I use a Python interactive debugger, but I have VS with the DLL project loaded on the side so that I can quickly add any necessary printfs on the DLL and recompile, so essentially the reverse of the above.
I know it's not the answer you expect, but it is a decent solution in my opinion.
It looks that it is possible to convert the debugging information generated by C++ Builder to a format understood by WinDbg (link to discussion). If so you could use it to debug both parts of your application (I haven't tried this though).
you can convert the .map files to Microsoft's debug file format http://code.google.com/p/map2dbg/
now you can use Windebug; there is also a tool mentioned to convert to pdb format, so you could try the vc++ debugger
Have you tried loading the DLL code in VS, loading the app code in BCB, and having both debuggers attached to the same running process at the same time? Not sure if Windows will allow that, but it might be worth a try.
Watching the //BUILD stuff, I saw that WinRT API's can be consumed by C code:

I am rather excited about a fresh C API available to Win32 developers.
Where can I find information on the C WinRT API? How is it better than the existing Win32 C API?
WinRT is fundamentally COM, so using WinRT components from C is like using COM components from C. Like before, you get .idl files for all WinRT components, and also .h files produced from those .idl files. The .h files include both C++ and C declarations (wrapped in #ifdef __cplusplus as needed). You can just #include them and start hacking away.
It's not exactly neat, though, e.g. something like this C++/CX:
Windows::UI::Xaml::Controls::TextBlock^ tb = ...;
tb->Text = "Foo";
which is equivalent to this vanilla C++:
Windows::UI::Xaml::Controls::ITextBlock* tb = ...;
HSTRING hs;
hr = WindowsStringCreate(L"Foo", 3, &hs);
// check hr for errors
HRESULT hr = tb->set_Text(hs);
// check hr for errors
tb->Release();
would be written in C as:
__x_Windows_CUI_CXaml_CControls_CITextBlock* tb = ...;
HRESULT hr;
HSTRING hs;
hr = WindowsCreateString(L"Foo", 3, &hs);
// check hr for errors
hr = __x_Windows_CUI_CXaml_CControls_CITextBlock_put_Text(tb, hs);
// check hr for errors
IUnknown_Release(tb);
Look inside "C:\Program Files (x86)\Windows Kits\8.0\Include\winrt" in Developer Preview to see the .idl and .h files.
Earlier today, as I was coding a method and it struck me that I wasn't sure exactly why the idiom I was implementing compiles. If everything else is abstracted away, it would look something like this:
private int Example()
{
while (true)
{
if (some condition)
{
return 1;
}
}
}
You have an explicitly infinite loop, and some set of conditions inside the loop that cause the loop to end with a return statement. Let's ignore for the time being why I was doing this as opposed to checking for a termination condition in the while clause as the answer is convoluted and irrelevant -- what I want to know is why the compiler doesn't flag this with a "Not all paths return a value." error, as, strictly speaking not all paths do return a value. The case in which the while loop is never entered (which, of course, never happens) doesn't return anything.
Now, there are two reasons I can imagine it happening: this is a side effect of optimization that's occurring for other reasons, or this case is explicitly being handled by the compiler to allow this idiom. My instinct is that it's probably the first case. It doesn't surprise me at all, for instance, that this compiles:
private int Example2()
{
if (true) return 1;
}
Because the compiler sees a constant true in the if, and optimizes the conditional away. I don't really get why this would "fix" the first example, though.
Oh, and even more weirdly, if some optimization that gets rid of the loop is in play, this compiles:
private int Example3()
{
while (true)
{
if (false)
{
return 1;
}
}
}
I would think that the entire inner loop would be optimized away, getting rid of all of the valid returns. What's actually going on here at the bytecode/compiler level that makes this all make sense?
The compiler doesn't flag this because the end of the method is unreachable. That's not a problem - it's only a problem if you can get to the end of the method (the closing brace) without returning a value.
This isn't a matter of compiler optimization - it's a case of following the definitions for reachability laid down in the spec.
Note that you don't need a return statement at all... this code is useless, but perfectly valid:
public int EndlessLoop()
{
while (true)
{
}
}
To give you a use case for these kinds of infinite loops, consider the following code:
public int KeyboardChecker()
{
while (true)
{
if (KeyHasBeenPressed())
{
HandleKeyPress();
}
}
}
You then run this method on its own thread, thereby asynchronously handling keyboard input (this is the polling pattern, having an event system in place is usually preferable).
You might imagine threads to return status codes when they are finished, so the return value of the method is int. However, since this particular thread will never finish, it's not a problem at all that the method does not contain any return statement. The C# designers knew about these of use cases and made the above method legal.
Note that the general problem of figuring out whether a particular method will always return a value is undecidable (ie, cannot be solved by any computer program). Therefore, the C# compiler might complain about code that will always return a value (though it will never accept programs that do not):
public int DoWork()
{
// The compiler doesn't figure out this will always be true.
if (((int)Math.Sqrt(4)) == 2)
{
return 3;
}
// And therefore complains that not all code paths return a value for this method.
}
I've been searching around the internet - and StackOverflow - for some recommendations on some lightweight .NET debuggers, but so far I haven't had a lot of luck. Some articles/posts are either pretty dated, or otherwise don't exactly suit me needs.
What I'm specifically looking for is a very light-weight .NET debugger that I can wrap into my application, where I can create a "Debug mode" for administrators/developers. Because this application is very specific to the data, and environment it runs in, and features some scripting as well, it would be really useful to allow users the ability to debug their scripts, and in some cases the underlying engine.
In short, the requirements are:
I could use the standard Visual Studio debugger, and use Debugger.Break(), but ultimately, this fails requirement number 1 of it being lightweight - I need something I can wrap into my application.
The CLR Managed Debugger (mdbg) Sample should get you started.
What about using the CSharpCodeProvider class? This will at least provide compiling, and I believe will provide debugging info. Although I'm not sure of the detail. Maybe between the CLR mdbg as @Eric recommends and the CodeProvider, you will get what you want.
You should be able to compile stand-alone scripts and debug. Although, it would be impossible to debug the application itself, while it is running - a point I certainly missed while @Hans is sharp enough to point out in his comment.
Could anyone provide a comparison or specific details of how is template instantiation handled at compile and/or link time in GCC and MS compilers? Is this process different in the context of static libraries, shared libraries and executables? I found this doc about how GCC handles it but I'm not sure if the information is still referring to the current state of things. Should I use the flags they suggest there when compiling my libraries e.g. -fno-implicit-templates?
What I know (might not necessarily be correct) is that:
templates will be instantiated when actually used
Not exactly, but roughly. The precise point of instantiation is a bit subtle, and I delegate you over to the section named Point of instantiation in Vandevoorde's/Josuttis' fine book.
However, compiler do not necessarily implement the POIs correctly: Bug c++/41995: Incorrect point of instantiation for function template
templates will be instantiated when actually used
That is partially correct. It is true for function templates, but for class templates, only the member functions that are used are instantiated. The following is well-formed code:
#include <iostream>
template <typename> struct Foo {
void let_me_stay() {
this->is->valid->code. get->off->my->lawn;
}
void fun() { std::cout << "fun()" << std::endl; }
};
int main () {
Foo<void> foo;
foo.fun();
}
let_me_stay() is checked syntactically (and the syntax there is correct), but not semantically (i.e. it is not interpreted).
However, only dependent code is interpreted later; clearly, within Foo<>, this is dependent upon the exact template-id with which Foo<> is instantiated, so we postponed error-checking of Foo<>::let_me_alone() until instantiation time.
But if we do not use something that depends on the specific instantiation, the code must be good. Therefore, the following is not well-formed:
$ cat non-dependent.cc
template <typename> struct Foo {
void I_wont_compile() { Mine->is->valid->code. get->off->my->lawn; }
};
int main () {} // note: no single instantiation
Mine is a completely unknown symbol to the compiler, unlike this, for which the compiler could determine it's instance dependency.
The key-point here is that C++ uses a model of two-phase-lookup, where it does checking for non-dependent code in the first phase, and semantic checking for dependent code is done in phase two (and instantiation time) (this is also an often misunderstood or unknown concept, many C++ programmers assume that templates are not parsed at all until instantiation, but that's only myth coming from, ..., Microsoft C++).
The definition of Foo<>::let_me_stay() worked because error checking was postponed to later, as for the this pointer, which is dependent. Except when you would have made use of
explicit instantiations
cat > foo.cc
#include <iostream>
template <typename> struct Foo {
void let_me_stay() { this->is->valid->code. get->off->my->lawn; }
void fun() { std::cout << "fun()" << std::endl; }
};
template struct Foo<void>;
int main () {
Foo<void> foo;
foo.fun();
}
g++ foo.cc
error: error: ?struct Foo<void>? has no member named ?is?
When you explicitly instantiate, you instantiate explicitly. And make all symbols visible to the linker, which also means that the template definition may reside in different units of translation:
$ cat A.cc
template <typename> struct Foo {
void fun(); // Note: no definition
};
int main () {
Foo<void>().fun();
}
$ cat B.cc
#include <iostream>
template <typename> struct Foo {
void fun();
};
template <typename T>
void Foo<T>::fun() {
std::cout << "fun!" << std::endl;
} // Note: definition with extern linkage
template struct Foo<void>; // explicit instantiation upon void
$ g++ A.cc B.cc
$ ./a.out
fun!
However, you must explicitly instantiate for all template arguments to be used, otherwise
$ cat A.cc
template <typename> struct Foo {
void fun(); // Note: no definition
};
int main () {
Foo<float>().fun();
}
$ g++ A.cc B.cc
undefined reference to `Foo<float>::fun()'
As far as I know, what you say is correct. Templates will be instantiated when actually used (including when declared as a member of another type, but not when mentioned in a function declaration (that does not have a body)) or as a result of explicit instantiations.
A problem with templates is that if you use the same template (e.g. vector) in several different compilation units (.cpp files), the compiler repeats the work of instantiating the template in each .cpp file, thus slowing down compilation. IIRC, GCC has some (non-standard?) mechanism that can be used to avoid this (but I don't use GCC). But Visual C++ always repeats this work, unless you use explicit template instantiation in a precompiled header (but even this will slow down your compile, since a larger PCH file takes longer to load.) Afterward, the linker then eliminates the duplicates. Note: a comment below linked to a page which tells us that not all compilers operate this way. Some compilers defer function instantiation until link time, which should be more efficient.
A template is not fully instantiated when it is first used. In particular, functions in the template are not instantiated until they are actually called. You can easily verify this by adding a nonsense function to a template you are actively using:
void Test() { fdsh "s.w" = 6; wtf? }
You won't get an error unless you instantiate the template explicitly, or try to call the function.
I expect static libraries (and object files) will store the object code of all templates that were instantiated. But if your program has a certain static library as a dependency, you can't actually call the template functions that were already instantiated therein, at least not in VC++, which always requires the source code (with function bodies) of a template class in order to call functions in it.
I don't think it's possible to call a template function in a shared library (when you don't have the source code of the template function you want to call).
I freak out whenever I open up any STL-related code from Visual Studio's implementation while debugging my code:
// From <xtree>
if (_Where == begin())
{ // insert at beginning if before first element
if (_DEBUG_LT_PRED(this->comp,
this->_Kfn(_Val), _Key(_Where._Mynode())))
return (_Insert(true, _Where._Mynode(), _Val));
}
else if (_Where == end())
{ // insert at end if after last element
if (_DEBUG_LT_PRED(this->comp,
_Key(_Rmost()), this->_Kfn(_Val)))
return (_Insert(false, _Rmost(), _Val));
}
//...
else if (_DEBUG_LT_PRED(this->comp,
_Key(_Where._Mynode()), this->_Kfn(_Val))
&& (++(_Next = _Where) == end()
|| _DEBUG_LT_PRED(this->comp,
this->_Kfn(_Val), _Key(_Next._Mynode()))))
{ // insert after _Where
if (_Isnil(_Right(_Where._Mynode())))
return (_Insert(false, _Where._Mynode(), _Val));
else
return (_Insert(true, _Next._Mynode(), _Val));
}
The presence of comments makes me feel as though a human wrote them, but the poor formatting, liberal use of underscores at the beginning of everything (why?), and extremely unreadable conditions like (++(_Next = _Where) == end() || _DEBUG_LT_PRED ...) make me feel as though they were generated from another piece of source code, not written as-is.
Does anyone know which of those is the case? (If it was generated from some other piece of code, I'd be interested in knowing how/why this was done.)
For the record, here's the same thing, but "properly formatted":
if (Where == begin())
{
// insert at beginning if before first element
if (DEBUG_LT_PRED(this->comp, this->Kfn(Val), Key(Where.Mynode())))
return (Insert(true, Where.Mynode(), Val));
}
else if (Where == end())
{
// insert at end if after last element
if (DEBUG_LT_PRED(this->comp, Key(Rmost()), this->Kfn(Val)))
return (Insert(false, Rmost(), Val));
}
//...
else if (DEBUG_LT_PRED(this->comp, Key(Where.Mynode()), this->_Kfn(Val))
&& (++(Next = Where) == end()
|| DEBUG_LT_PRED(this->comp, this->_Kfn(Val), Key(Next.Mynode()))))
{
// insert after Where
if (Isnil(Right(Where.Mynode())))
return (Insert(false, Where.Mynode(), Val));
else
return (Insert(true, Next.Mynode(), Val));
}
IMHO this is more like how it would turn out if a human wrote it, but then again, I have no idea.
Two things:
The indentation is actually fine, although nowadays unusual (and I personally hate it): they use an indentation of four, which is achieved via spaces, but use tabs for all multiples of eight. This used to be the standard almost everywhere (notably it?s still the default setting in several editors such as Vim). But as a consequence, the code is only indented correctly if you set your tab width to 8. So the code actually looks like this:
else if (_Where == end())
{ // insert at end if after last element
if (_DEBUG_LT_PRED(this->comp,
_Key(_Rmost()), this->_Kfn(_Val)))
return (_Insert(false, _Rmost(), _Val));
}
Which, though still unusual, is perfectly logical and legible.
It?s good style (or even mandated?) that the standard library uses only reserved identifiers to avoid name clashes with customers? C++ code. These reserved names are either names starting with an underscore followed by a capital letter (_DEBUG_LT_PRED, _Key), or two underscores (not in this code, but the GCC libstdc++ is littered with __x etc.).
Hence the alphabet soup.
But yes, this code is indeed manually written ? at least it is in the case of the GCC. The active source branch of the libstdc++ looks exactly like the code above, and isn?t auto-generated.
The STL provided by VC++ is written by Dikunmware (and possibly adapted).
As far as I know, it is written by humans, but heavily optimized, which might leave a sour taste in the mouths of maintainers. There is a reason, after all, that we advise beginners not to micro-optimize their code - it makes it hard to read. However, we do expect from a library as essential as the STL to be heavily optimized: we don't have to maintain it anyway.
I myself find it quite readable:
You might want to look at libc++ to convince yourself that even a human written library, without legacy code (it's fresh), can get pretty complicated. Example <algorithm> (love the sort algorithm).
Original company for the MS STL was Dinkumware. They had this awful code style, and it looks to be still there even though MS no longer use them. I'm sure it's hand written, probably all by the same person, I could name him but I don't think I will.
I was experimenting with a C++ project using the Compile Time Hashing technique I found here. The macros work as expected, and the compile time is reasonable, but the 64 recursive macros seem to being playing hell with Visual Studio's Intellisense. After every short edit, the IDE hangs for ~30 seconds. I suspect that it is getting wound up trying to parse the nested macros. As soon as I remove the #include "consthashmacro.h line, responsiveness returns to normal.
Is there a way to disable Intellisense for a specific header file?
I've found this article titled "Controlling IntelliSense Through Macros", but the solution there does not seem to be working correctly for me either.
Perhaps it's not intelliSense? It's definitely related to that header. Any ideas?
EDIT:
I tried disabling Intellisense entirely by [renaming the feacp.dll as recommended].(http://blogs.msdn.com/b/yash/archive/2007/09/19/intellisense-issues-in-visual-c-2005.aspx) I get the same behavior - edits cause the IDE to hang for long periods. Removing the header restores performance. What other feature of VS2055 could be causing this incredible lag?
To Reproduce:
Using Visual Studio 2005, Create a new "Win32 Console Application" with the default settings (i.e: using precompiled headers). Add the following code to the cpp file. (Extract 'consthashmacro.h' into the source directory (available from the zip file at Chris Savoie's site)
#include "stdafx.h"
#define CONSTHASH(s) ((s)[0])
//#include "consthashmacro.h"
void Send(long hash, long value)
{
printf("Sending %x %x\n", hash, value);
}
#define QQuot_(x) #x
#define QQuote(x) QQuot_(x)
#define Debug_Print(s, v) (Send( CONSTHASH(QQuote(__LINE__)##s), *((long*)&(v))))
int _tmain(int argc, _TCHAR* argv[])
{
int i = __LINE__;
float f= 3.14f;
Debug_Print("This is a test %d", i);
i++;
Debug_Print("This is a test %d", i);
Debug_Print("This was test %f", f);
return 0;
}
When I replace the #define CONSTHASH with the include line underneath it, performance slows to a crawl.
I was correct that something was getting hung up on the recursive macros, but it wasn't IntelliSense. The culprit turned out to be the free version of Refactor! for C++ from DevExpress that I had installed a long while ago (and rarely used).
When I uninstalled that, IDE performance returned to normal. I re-enabled IntelliSense, and it works with no problems.
I would like to offer a formal apology to IntelliSense: I regret that I cast unfair aspersions upon you.
More of a troubleshooting suggestion than an answer really, but:
Grab a copy of Process Explorer: http://technet.microsoft.com/en-us/sysinternals/bb896653.
Check out the process dll's, threads, sockets, open file descriptors, etc by double clicking the line where the process is listed in Process Explorer.
Also, are you redefining CONSTHASH? Try:
#ifndef CONSTHASH
#define CONSTHASH(s) ((s)[0])
#endif
And breakpoint it to see if the line of execution skips your define. Maybe your redefining something that shouldn't be redefined?
Recently, I've run into a classical Heisenbug. Here's the situation:
The bug is easily reproducible and happens in both "Release" and "Debug" build configurations. But: As soon as I set a breakpoint in the event handler (for the "Add new node" menu entry) and enable it, everything works fine =>Heisenbug! I don't have to do any real debugging. Clicking "continue" after the breakpoint gets hit is enough.
For better understanding, I've made a video that should illustrate what's going on.
Everything I could think of to get rid of the issue was putting the thread (the application is single-threaded) to sleep for a few seconds, but that doesn't work.
I'd greatly appreciate any suggestions on what I could try to determine the cause of the issue. Or maybe someone has a guess about the cause?
I'm targeting the 3.5 framework and using x86 as solution platform. The tree list control is from DevExpress' WinForms controls; Visual Studio version is 2010.
Thanks
Update 3: Issue solved. The problem was that the call to the detail view's Focus() method didn't trigger the GotFocus event, which is crucial for updating the detail view. (I don't know why, probably it already had the focus.) However, the method did not fail, it simply did nothing.
Now I just focus another control before focussing the detail view and that's it. The reason why everything worked fine during debugging was that switching from Visual Studio back to my application correctly set the focus on the detail view.
A major obstacle in hunting down this issue was that setting a breakpoint in the GotFocus event handler is useless: anytime you try to switch back from Visual Studio to the app, the GotFocus event gets re-triggered, and you're stuck in an endless loop. Comments on how that could be worked around are welcome.
Anyway, my specific problem is solved.
Thank you very much to everybody who answered or commented. It helped me a lot.
Update 2: In my code, I select the newly created node in the tree. This triggers a FocusedNodeChangedEvent. In the corresponding event handler, I update the detail view and call its Focus() method.
It seems as if that fails when there's no breakpoint set. I think what triggers the correct update during debugging is that the detail view automatically gets the focus.
Update 1: Here are the window messages that Eddy's answer provided. (Long list of messages deleted)
First time I've seen a video to support an SO :)
I'm thinking that the right-hand pane, or control group, need(s) to have Invalidate() called - which I think the breakpoint is triggering because it switches to VS, overdrawing the window. Then, when you switch back again, it forces everything to redraw, thus making it work.
Put a System.Diagnostics.Debugger.Break() in the update routine for the other window. Then when the bug appears, a run time break point will be fired and you can view the stack.
When you have a "heisenbug" you need to see what is going on but with a lighter touch that doesn't interrupt the flow of the program.
I would suggest that you form an hypothesis about where your problem lies. I would then edit the code to include calls to the various methods of the Debug class, that test the hypothesis or just give runtime information for diagnosis. Then run your code in debug mode and see what you get in the output.
If you have a more elusive "hiesenbug" theat occurs only in release mode you would need to roll you own logging mechanism to gather your evidence.
It seems that the problem has to do with not getting the right event called to trigger and update to the child panel. When hitting the breakpoint your app loses focus and when you return it gains it again (which is a difference from running it). In order to inspect what events are and aren't called and what the difference is between the two scenario's add the following code to your form to see all the window messages that appear.
protected override void WndProc(ref Message winmsg)
{
base.WndProc(ref winmsg);
System.Diagnostics.Debug.WriteLine(winmsg.Msg + " - " + winmsg);
}
Comparing the differences might help you in determining a way how to workaround this problem.
Firstly, I apologize for the length of this question.
I am the author of IronScheme. Recently I have been working hard on emitting decent debug info, so that I can use the 'native' .NET debugger.
While this has been partly successful, I am running into some teething problems.
The first problem is related to stepping.
Due to Scheme being an expression language, everything tends to be wrapped in parenthesis, unlike the major .NET languages which seems to be statement (or line) based.
The original code (Scheme) looks like:
(define (baz x)
(cond
[(null? x)
x]
[(pair? x)
(car x)]
[else
(assertion-violation #f "nooo" x)]))
I have on purpose laid out each expression on a newline.
The emitted code transforms to C# (via ILSpy) looks like:
public static object ::baz(object x)
{
if (x == null)
{
return x;
}
if (x is Cons)
{
return Builtins.Car(x);
}
return #.ironscheme.exceptions::assertion-violation+(
RuntimeHelpers.False, "nooo", Builtins.List(x));
}
As you can see, pretty simple.
Note: If the code was transformed into a conditional expression (?:) in C#, the whole thing would just be one debug step, keep that in mind.
Here is IL output with source and line numbers:
.method public static object '::baz'(object x) cil managed
{
// Code size 56 (0x38)
.maxstack 6
.line 15,15 : 1,2 ''
//000014:
//000015: (define (baz x)
IL_0000: nop
.line 17,17 : 6,15 ''
//000016: (cond
//000017: [(null? x)
IL_0001: ldarg.0
IL_0002: brtrue IL_0009
.line 18,18 : 7,8 ''
//000018: x]
IL_0007: ldarg.0
IL_0008: ret
.line 19,19 : 6,15 ''
//000019: [(pair? x)
.line 19,19 : 6,15 ''
IL_0009: ldarg.0
IL_000a: isinst [IronScheme]IronScheme.Runtime.Cons
IL_000f: ldnull
IL_0010: cgt.un
IL_0012: brfalse IL_0020
IL_0017: ldarg.0
.line 20,20 : 7,14 ''
//000020: (car x)]
IL_0018: tail.
IL_001a: call object [IronScheme]IronScheme.Runtime.Builtins::Car(object)
IL_001f: ret
IL_0020: ldsfld object
[Microsoft.Scripting]Microsoft.Scripting.RuntimeHelpers::False
IL_0025: ldstr "nooo"
IL_002a: ldarg.0
IL_002b: call object [IronScheme]IronScheme.Runtime.Builtins::List(object)
.line 22,22 : 7,40 ''
//000021: [else
//000022: (assertion-violation #f "nooo" x)]))
IL_0030: tail.
IL_0032: call object [ironscheme.boot]#::
'ironscheme.exceptions::assertion-violation+'(object,object,object)
IL_0037: ret
} // end of method 'eval-core(033)'::'::baz'
Note: To prevent the debugger from simply highlighting the entire method, I make the method entry point just 1 column wide.
As you can see, each expression maps correctly to a line.
Now the problem with stepping (tested on VS2010, but same/similar issue on VS2008):
These are with IgnoreSymbolStoreSequencePoints not applied.
When applying IgnoreSymbolStoreSequencePoints (as recommended):
I also find in this mode that some lines (not shown here) are incorrectly highlighted, they are off by 1.
Here are some ideas what could be the causes:
The second, but also serious, issue is the debugger failing to break/hit breakpoints in some cases.
The only place where I can get the debugger to break correctly (and consistantly), is at the method entry point.
The situation gets a bit better when IgnoreSymbolStoreSequencePoints is not applied.
Conclusion
It might be that the VS debugger is just plain buggy :(
References:
Update 1:
Mdbg does not work for 64-bit assemblies. So that is out. I have no more 32-bit machines to test it on. Update: I am sure this is no big problem, does anyone have a fix? Edit: Yes, silly me, just start mdbg under the x64 command prompt :)
Update 2:
I have created a C# app, and tried to dissect the line info.
My findings:
brXXX instruction you need to have a sequence point (if not valid aka '#line hidden', emit a nop).brXXX instruction, emit a '#line hidden' and a nop.Applying this, does not however fix the issues (alone?).
But adding the following, gives the desired result :)
ret, emit a '#line hidden' and a nop.This is using the mode where IgnoreSymbolStoreSequencePoints is not applied. When applied, some steps are still skipped :(
Here is the IL output when above has been applied:
.method public static object '::baz'(object x) cil managed
{
// Code size 63 (0x3f)
.maxstack 6
.line 15,15 : 1,2 ''
IL_0000: nop
.line 17,17 : 6,15 ''
IL_0001: ldarg.0
.line 16707566,16707566 : 0,0 ''
IL_0002: nop
IL_0003: brtrue IL_000c
.line 16707566,16707566 : 0,0 ''
IL_0008: nop
.line 18,18 : 7,8 ''
IL_0009: ldarg.0
IL_000a: ret
.line 16707566,16707566 : 0,0 ''
IL_000b: nop
.line 19,19 : 6,15 ''
.line 19,19 : 6,15 ''
IL_000c: ldarg.0
IL_000d: isinst [IronScheme]IronScheme.Runtime.Cons
IL_0012: ldnull
IL_0013: cgt.un
.line 16707566,16707566 : 0,0 ''
IL_0015: nop
IL_0016: brfalse IL_0026
.line 16707566,16707566 : 0,0 ''
IL_001b: nop
IL_001c: ldarg.0
.line 20,20 : 7,14 ''
IL_001d: tail.
IL_001f: call object [IronScheme]IronScheme.Runtime.Builtins::Car(object)
IL_0024: ret
.line 16707566,16707566 : 0,0 ''
IL_0025: nop
IL_0026: ldsfld object
[Microsoft.Scripting]Microsoft.Scripting.RuntimeHelpers::False
IL_002b: ldstr "nooo"
IL_0030: ldarg.0
IL_0031: call object [IronScheme]IronScheme.Runtime.Builtins::List(object)
.line 22,22 : 7,40 ''
IL_0036: tail.
IL_0038: call object [ironscheme.boot]#::
'ironscheme.exceptions::assertion-violation+'(object,object,object)
IL_003d: ret
.line 16707566,16707566 : 0,0 ''
IL_003e: nop
} // end of method 'eval-core(033)'::'::baz'
Update 3:
Problem with above 'semi-fix'. Peverify reports errors on all methods due to the nop after ret. I dont understand the problem really. How can a nop break verification after a ret. It is like dead code (except that it is NOT even code) ... Oh well, experimentation continues.
Update 4:
Back at home now, removed the 'unverifiable' code, running on VS2008 and things are a lot worse. Perhaps running unverifiable code for the sake of proper debugging might be the answer. In 'release' mode, all output would still be verifiable.
Update 5:
I have now decided my above idea is the only viable option for now. Although the generated code is unverifiable, I have yet to find any VerificationException's. I dont know what the impact will be on the end user with this scenario.
As a bonus, my second issue has also be solved. :)
Here is a little screencast of what I ended up with. It hits breakpoints, does proper stepping (in/out/over), etc. All in all, the desired effect.
I, however, am still not accepting this as the way to do it. It feel overly-hacky to me. Having a confirmation on the real issue would be nice.
Update 6:
Just had the change to test the code on VS2010, there seems to be some problems:
Both these cases work correctly under VS2008. The main difference is that under VS2010, the entire application is compiled for .NET 4 and under VS2008, compiles to .NET 2. Both running 64-bit.
Update 7:
Like mentioned, I got mdbg running under 64-bit. Unfortunately, it also have the breakpoint issue where it fails to break if I rerun the program (this implies it gets recompiled, so not using the same assembly, but still using the same source).
Update 8:
I have filed a bug at the MS Connect site regarding the breakpoint issue.
Rant mode on
Let's hope this gets fixed by MS, unlike previous bugs the claim to have fixed, but are yet to be seen in public.
Rant mode off
I am an engineer on the Visual Studio Debugger team.
Correct me if I am wrong, but it sounds like the only issue left is that when switching from PDBs to the .NET 4 dynamic compile symbol format some breakpoints are being missed.
We would probably need a repro to exactly diagnose the issue, however here are some notes that might help.
The JIT creates an implicit sequence point based on the following rules: 1. IL nop instructions 2. IL stack empty points 3. The IL instruction immediately following a call instruction
If it turns out we do need a repro to solve your issue, you can file a connect bug and upload files securely through that medium.
Update:
We are encouraging other users experiencing this issue to try the Developer Preview of Dev11 from http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=27543 and comment with any feedback. (Must target 4.5)
Thanks,
Luke
I am an engineer on the SharpDevelop Debugger team :-)
Did you solve the problem?
Did you try to debug it in SharpDevelop? If there is a bug in .NET, I wonder if we need to implement some workaround. I am not aware of this issue.
Did you try to debug it in ILSpy? Especially without debug symbols. It would debug C# code, but it would tell us if the IL instructions are nicely debugable. (Mind that ILSpy debugger is beta though)
Quick notes on the original IL code:
David
I've developed a tool in C++, using Visual Studio 2010, which I'd like to deploy on Linux systems as well. The code itself is programmed entirely platform-independent, using only the STL and the standard library.
Now my problem is: I don't have experience with Linux.
I have, however, tried to get some other programs I wrote to compile using GCC, and the results were a truckload of errors being thrown at me, which took me 3 hours to resolve - the horrors!
Noting from this experience I think that the same is about to happen, just a lot worse, if I try to port my current project to GCC.
My questions are:
What does a Visual Studio user need to know to successfully get their program running on Linux? (do I need to learn make?)
Do you know of a good source which covers not the topic of GCC / Linux programming as a whole, but specifically the problem of switching from a Visual Studio environment?
I recommend skipping make altogether, its a rather old technology and you may face portability issues while using it. Instead, learn another build system like CMake http://www.cmake.org/ or SCons http://www.scons.org/
I use CMake myself and find it to be excellent. You write very simple build scripts (you can easily get started in an hour or two) and it generates the makefiles for you. The biggest advantage is that it can generate makefiles for almost any compiler or build system you could want. It can generate standard unix makefiles, Microsoft Visual C++ Projects, XCode Projects, Code::Blocks projects, even KDevelop and Eclipse CDT4 projects.
I haven't used SCons myself, but I do know that it actually builds your program for you and runs on python.
Getting started in Linux/Unix can really mean anything you want. Going from Visual Studio can mean going to Eclipse or another IDE, which is as simple as learning the new IDE, or it can mean going straight to the shell and forgetting you ever knew what an IDE looked like. My personal recommendation is to stick with the IDE- Eclipse is great as an industry standard and its very cross-platform (just get the CDT plugin).
On the topic of the GCC, you probably won't really be invoking it yourself very much if you're writing CMake scripts since CMake will generate the makefiles. The simplest command line arguments are:
g++ <source-files> -o <output-name> -I <another include directory> -l <library to link to>
as an example:
g++ helloworld.cpp -o world.out -I /usr/include -l mylib
To run an executable from the shell, navigate to the directory its in and type:
./world.out
Note that the default output when invoking g++ (i.e. g++ helloworld.cpp) is a.out.
And that's all you really need to know! The rest comes easily. You'll learn to love Unix, and I really recommend learning the shell even if you do go the path of the IDE. It can make your life alot easier.
EDIT: So to port your program to Linux and the GCC with CMake, here's what you would do:
CMakeLists.txt file in your source directory (its the Makefile format CMake uses)CMakeLists.txt file automatically and generate build scripts of your choicemake into the shellP.S: I never learned normal make, although it definitely has its uses. CMake found an eager user in me.
i was going to say "man g++" but that manual is very long in lines.
just type
g++ main.cpp utility.cpp
g++ will automatically compile and link main.cpp, utility.cpp into a file named a.out type ./a.out into command line to run the compiled code.
you won't need to learn make, but if you do, simple make scripts only take 4-5 lines of code. It's pretty easy to type in, but it's actually pretty different for a visual studio user, so it's completely non-friendly if you put bad code your Makefile.
about learning linux, there's a lot to learn. I can't even tell you where to start, but there's no secrets. Not like Microsoft products where you have to learn the workaround to make your code run.
oh and here's g++ info: http://homepages.gac.edu/~mc38/2001J/documentation/g++.html
My company is working towards moving our development from C++.net into C#. Our product has standard monthly release (for instance, 5.0.19.2...).
In in C++.net, we had a common app.rc file, that standardized the company info, as well as version number. Since every project within the solution would include the same app.rc file once, it was very easy to change the version info on over 200 projects.
How does this solution translate into the C# world? The questions that I checked before writing this mention it through the property window in the solution explorer, but that is not what I want.
I know the assemblyinfo.cs contains the information I want to modify, but I don't think I could have one master file. Do I need to split it up into multiple files?
Thanks in advance!
You can add a file as a link instead of the actual file. E.g, my solution could be:
Solution
- My Project
- Properties
- AssemblyInfo.cs
- SharedAssemblyInfo.cs (Linked)
- Solution Items
- SharedAssemblyInfo.cs
When you add an existing item to the solution, you can use the drop down arrow on the Add link, and select Add as Link. The SharedAssemblyInfo.cs file can contain common/shared assembly attributes, e.g.:
[assembly: AssemblyVersion("2.0.*")]
[assembly: AssemblyFileVersion("2.0.0.0")]
[assembly: AssemblyCompany("My Company")]
... etc. The project local can contain project specific attributes:
[assembly: AssemblyTitle("My Assembly")]
... etc.
It's a common practice in c# solutions to comment out version information in the assemblyinfo.cs of each project and then have a single common "shared_assemblyinfo.cs" (named to taste) that contains version information and is shared across all projects...
You can have one assembly info file and only specify the assembly version in it:
using System;
using System.Reflection;
[assembly: AssemblyVersion("1.0.0.0")]
Then, you just add the file as a link to each of your other projects (you'll have to remove the AssemblyVersion attribute from each of the Properties\AssemblyInfo.cs files by hand though). When they build, they'll all use this file.
A master assembly.cs is possible - simply delete your project's assembly.cs file, and re-add a master assembly.cs to every project with the "As a Link" option in the "Add File" dialog.
http://www.tigraine.at/2009/01/22/sharing-a-common-assemblyinfo-between-projects-in-a-solution/
I would suggest to have version information for every project, considering that they are 400 or could be so big, it's extremely important to know on every new big setup which versions of assemblies make part of that setup. Every assembly developed by different person(s) like a separate projects and finally they finished in one big mosaic of your main app, with it's MainVersion.
Regards.
I am using the asp:FileUpLoad to upload files in my asp.net c# project. This all works fine as long as the file size does not exceed the maximum allowed. When the maximum is exceeded. I get an error "Internet Explorer cannot display the webpage". The problem is the try catch block doesn't catch the error so I cannot give the user a friendly message that they have excced the allowable size. I have seen this problem while searching the web but I cannot find an acceptable solution.
I would look at other controls, but my managemment probably wouldn't go for buying a third-party control.
In light of answer suggesting ajac, I need to add this comment. I tried to load the ajax controls months ago. As soon as I use an ajax control, I get this compile error.
Error 98 The type 'System.Web.UI.ScriptControl' is defined in an assembly that is not referenced. You must add a reference to assembly 'System.Web.Extensions, Version=4.0.0.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35'.
I could get rid of it although I did add 'System.Web.Extensions'. So I abandoned Ajax and used other techniques.
So I need to solved this problem or a completely new solution.
Default file size limit is (4MB) but you can change the default limit in a localized way by dropping a web.config in the directory where your upload page lives. That way you don't have to make your whole site allow huge uploads (doing so would open you up to a certain kinds of attacks).
Just set in web.config under <system.web> section. e.g. In the below example I am setting the maximum length that is 2GB
<httpRuntime maxRequestLength="2097152" executionTimeout="600" />
Please note that the maxRequestLength is set in KB's and it can be set up to 2GB (2079152 KB's). Practically we don't often need to set 2GB request length, but if you set the request length higher, we also need to increase the executionTimeout.
Execution Timeout Specifies the maximum number of seconds that a request is allowed to execute before being automatically shut down by ASP.NET. (Default time is 110 seconds.)
For Details please read httpRuntime Element (ASP.NET Settings Schema)
Now if you want to show the custom message to user, if the file size is greater than 100MB.
You can do like..
if (FileUpload1.HasFile && FileUpload1.PostedFile.ContentLength > 104857600)
{
//FileUpload1.PostedFile.ContentLength -- Return the size in bytes
lblMsg.Text = "You can only upload file up to 100 MB.";
}
You can try the asp.net tool kit upload control. It's free!
http://www.asp.net/ajax/ajaxcontroltoolkit/samples/AsyncFileUpload/AsyncFileUpload.aspx
Indeed, a try catch won't help you. But here is a workaround : you could handle the error in your Global.asax Application_Error method.
Example :
void Application_Error(object sender, EventArgs e)
{
// manage the possible 'Maximum Length Exceeded' exception
HttpContext context = ((HttpApplication)sender).Context;
/* test the url so that only the upload page leads to my-upload-error-message.aspx in case of problem */
if (context.Request.Url.PathAndQuery.Contains("mypage"))
Response.Redirect("/my-upload-error-message.aspx");
}
Of course , be aware that if any other kind of error occurs on your "mypage" page, you will be redirected to the /my-upload-error-message.aspx, regardless of what happened.
At the client, Flash and/or ActiveX and/or Java and/or HTML5 Files API are the only ways to test file size and prevent submit. Using a wrapper/plug-in like Uploadify, you don't have to roll your own and you get a cross-browser solution.
On the server, in global.asax, put this:
public const string MAXFILESIZEERR = "maxFileSizeErr";
public int MaxRequestLengthInMB
{
get
{
string key = "MaxRequestLengthInMB";
double maxRequestLengthInKB = 4096; /// This is IIS' default setting
if (!Application.AllKeys.Contains(key))
{
var section = ConfigurationManager.GetSection("system.web/httpRuntime") as HttpRuntimeSection;
if (section != null)
maxRequestLengthInKB = section.MaxRequestLength;
Application.Lock();
Application.Add(key, maxRequestLengthInKB);
Application.UnLock();
}
else
maxRequestLengthInKB = (double)Application[key];
return Convert.ToInt32(Math.Round(maxRequestLengthInKB / 1024));
}
}
void Application_BeginRequest(object sender, EventArgs e)
{
HandleMaxRequestExceeded(((HttpApplication)sender).Context);
}
void HandleMaxRequestExceeded(HttpContext context)
{
/// Skip non ASPX requests.
if (context.Request.Path.ToLowerInvariant().IndexOf(".aspx") < 0 && !context.Request.Path.EndsWith("/"))
return;
/// Convert folder requests to default doc;
/// otherwise, IIS7 chokes on the Server.Transfer.
if (context.Request.Path.EndsWith("/"))
context.RewritePath(Request.Path + "default.aspx");
/// Deduct 100 Kb for page content; MaxRequestLengthInMB includes
/// page POST bytes, not just the file upload.
int maxRequestLength = MaxRequestLengthInMB * 1024 * 1024 - (100 * 1024);
if (context.Request.ContentLength > maxRequestLength)
{
/// Need to read all bytes from request, otherwise browser will think
/// tcp error occurred and display "uh oh" screen.
ReadRequestBody(context);
/// Set flag so page can tailor response.
context.Items.Add(MAXFILESIZEERR, true);
/// Transfer to original page.
/// If we don't Transfer (do nothing or Response.Redirect), request
/// will still throw "Maximum request limit exceeded" exception.
Server.Transfer(Request.Path);
}
}
void ReadRequestBody(HttpContext context)
{
var provider = (IServiceProvider)context;
var workerRequest = (HttpWorkerRequest)provider.GetService(typeof(HttpWorkerRequest));
// Check if body contains data
if (workerRequest.HasEntityBody())
{
// get the total body length
int requestLength = workerRequest.GetTotalEntityBodyLength();
// Get the initial bytes loaded
int initialBytes = 0;
if (workerRequest.GetPreloadedEntityBody() != null)
initialBytes = workerRequest.GetPreloadedEntityBody().Length;
if (!workerRequest.IsEntireEntityBodyIsPreloaded())
{
byte[] buffer = new byte[512000];
// Set the received bytes to initial bytes before start reading
int receivedBytes = initialBytes;
while (requestLength - receivedBytes >= initialBytes)
{
// Read another set of bytes
initialBytes = workerRequest.ReadEntityBody(buffer,
buffer.Length);
// Update the received bytes
receivedBytes += initialBytes;
}
initialBytes = workerRequest.ReadEntityBody(buffer,
requestLength - receivedBytes);
}
}
}
Create a BasePage class that your pages will inherit and add this code to it:
public int MaxRequestLengthInMB
{
get
{
return (Context.ApplicationInstance as Global).MaxRequestLengthInMB;
}
}
protected override void OnInit(EventArgs e)
{
base.OnInit(e);
CheckMaxFileSizeErr();
}
private void CheckMaxFileSizeErr()
{
string key = Global.MAXFILESIZEERR;
bool isMaxFileSizeErr = (bool)(Context.Items[key] ?? false);
if (isMaxFileSizeErr)
{
string script = String.Format("alert('Max file size exceeded. Uploads are limited to approximately {0} MB.');", MaxRequestLengthInMB);
ScriptManager.RegisterClientScriptBlock(this, this.GetType(), key, script, true);
}
}
Finally, in web.config, you MUST set maxAllowedContentLength (in bytes) greater than maxRequestLength (in kB).
This seems to be problem of session timeout, increase session time and then try again. You can set session timout in web.config file
In your web.config, set the max allowed content lenght higher than what you want to accept:
<system.webServer>
<security>
<requestFiltering>
<requestLimits maxAllowedContentLength="2000000000" />
</requestFiltering>
</security>
</system.webServer>
Then, in global.asax, use Application_BeginRequest to set your own limit:
private const int MyMaxContentLength = 10000; //Wathever you want to accept as max file.
protected void Application_BeginRequest(object sender, EventArgs e)
{
if ( Request.HttpMethod == "POST"
&& Request.ContentLength > MyMaxContentLength)
{
Response.Redirect ("~/errorFileTooBig.aspx");
}
}
Microsoft Visual Studio's linker has a /DRIVER flag specifically for building drivers:
Use the
/DRIVERlinker option to build a Windows NT kernel mode driver.
However, Microsoft says:
You must not build drivers by using the compiler or linker that Microsoft Visual Studio provides.
which begs the question:
Why should I not compile/link drivers with Visual Studio?
Is the output generated by the DDK/WDK tools different from that generated by Visual Studio?
If so, how is it different?
Notice that I'm talking about using Visual Studio's compiler and linker, not libraries!
I use the WDK headers and libraries with VS's compilers and linkers, but Microsoft specifically says that I need to avoid this:
You must not build drivers by using the compiler or linker that Microsoft Visual Studio provides.
They didn't even mention headers and libraries, so of course that's not my question.
Why?
This article put me on the right track, I think. That's because the DDK tools use different runtime libraries than Visual Studio.
Visual Studio will link the driver with the runtime libraries it provides (or optionally, the latest version of the runtime installed on the system), but a driver should arguably be linked with the exact same runtime used to build the operating system itself.
I've finished my C# application, but I have a little problem :
When I try to run my application in another PC, I need always to Install .NET Framework 4.0
Is there something to do to make it work without installing the framework from internet ?
I tried before InnoSetup for a VB6 application, but I'm not sure if it's going to work for .NET 4.0 !
Any ides ?
Thank you.
Use Visual Studio Setup project. Setup project can automatically include .NET framework setup in your installation package:
Here is my step-by-step for windows forms application:
Create setup project. You can use Setup Wizard.

Select project type.
Select output.
Hit Finish.
Open setup project properties.
Chose to include .NET framework.
Build setup project
Check output
You need to create installer, which will check if user has required .NET Framework 4.0. You can use WiX to create installer. It's very powerfull and customizable. Also you can use ClickOnce to create installer - it's very simple to use. It will allow you with one click add requirement to install .NET Framework 4.0.
Include an Setup Project (New Project > Other Project Types > Setup and Deployment > Visual Studio Installer) in your solution. It has options to include the framework installer. Check out this Deployment Guide MSDN post.
My application is being executed in debug mode and then deadlock happens. Is there any way to see the stacktrace before deadlock or at least the last called method?
Click BreakAll (Ctrl + Alt + Break) and open Debug->Windows->Threads
There you can see stacktrace for every thread
Does anybody know why the internal access modifier icon in visual studio is a mail envelope?
Is there any significance or history behind this decision?
There probably isn't any real reason, other than the symbols were available at the time and were different from the other icons. In practice what matters is learned recognition through repeated usage, it doesn't really matter what symbols the icons actually have. The important thing is consistency of use, so that with experience they have become an almost subconcious memory trigger. Colour and images are very powerful memory aids.
I'm making the leap to android applications and java development and am trying to find my way around the java world, specifically eclipse. I am an experienced C# .Net developer and everything looks familiar but I need to get a few fundamentals.
I just need to have a few things clarified relating C#/Visual to Java/Eclipse:
1: Are Java Projects/Packages/Classes the equivilant to C#/VS Solutions/Projects/Classes?
2: In C#/VS my project "ProjectName" will compile down to ProjectName.dll that I can then reference, how does this work in the Java world?
3: In C#/VS you have different project types, console apps, win form apps, class library etc, whats the equivalent in Java if any?
I think thats enough for now.
Any help would be appreciated.
Cheers.
1: Are Java Projects/Packages/Classes the equivilant to C#/VS Solutions/Projects/Classes?
Java Projects -> C# Projects and solutions (depending on the type of Java project .. for example a single project can collect together different projects in Java)
Java Packages -> C# Namespaces
Java Classes -> C# Classes
2: In C#/VS my project "ProjectName" will compile down to ProjectName.dll that I can then reference, how does this work in the Java world?
In Java there are no .dll files which are windows specific. Libraries and applications are packaged in JAR files normally and they can be added to the project build path when you required them. In order to package them, you need to export a project to a JAR file. Jar files can also be packaged to be runnable and thus perform similarly to .exe files as well.
Hope this helps.
Yes/No/Yes. Packages in Java are analogous to Namespaces in .NET. Unfortunately, .NET does not have the strict file layout requirements for its namespaces. So, while Java requires com.yourcompany.yourclass to exist as com/yourcompany/yourclass.java, .NET can have com.yourcompany.yourclass exist anywhere in the file tree.
In Java, you are compiling everything into Jar files. This is analogous to compiling to a DLL or EXE.
It's completely IDE specific. These are just conveniently preset templates to help you get started without requiring you, the developer, to setup all of your dependencies. I'm pretty sure each one is represented almost verbatim under Eclipse project creation.
Well, there are many different ways to make a 'solution/project' in Eclipse, but I think that you can generally think of Eclipse projects as VS solutions. C# namespaces would be equivalent to Java packages, and classes are classes in both cases.
A Java .jar file is equivalent to a .dll from C#.
All apps with a 'main' function in Java can be used as console apps. To make a graphical app you would use something with a Windowing Toolkit (such as Swing or AWT). And a library would be Java code that you put into a .jar. Eclipse has a pluggable interface, which allows for plugin developers to create new ways to organize projects. If you are looking for something to help you layout a graphical interface, there is likely a plugin that can assist you with that.
Also worth note is that there are other IDE's to use with Java. You might also want to take a look at IntelliJ IDEA and NetBeans.
Check the Java Tutorials site from Oracle. Under 'Trails Covering the Basics', the links 'Learning the Java Language' and 'Deployment' should help answer your questions.
I have a following issue. I have a solution that contains about 40 projects. There is a project A that references project B that references project C. There isn't any code in project A that uses classes from project C. However, if I use any LINQ extension method in any code, e.g.:
var r = new int[] { 1, 2, 3 }.Where(a => a > 1);
I get compiler error:
somefile.cs(70,13): error CS0012: The type 'XXX' is defined in an assembly that is not referenced. You must add a reference to assembly 'Project C assembly name, Version=0.0.0.0, Culture=neutral, PublicKeyToken=xxx'.
The error is on the line that uses linq extension method.
I'm using VS2010, .NET 3.5.
Update: It happens with every extension method. I have created a class in the same file, that looks like this:
public static class SomeClass
{
public static int[] Test(this int[] a)
{
return a;
}
}
And then I write this code and compilation breaks with same error:
new int[] { 1, 2, 3 }.Test();
Update2: Ok, I found out what causes the error. But I don't know why. Following code causes error:
using System.Linq;
using B;
namespace TestApp
{
public class A
{
public void M()
{
var c = new string[] { "a", "b", "c" }.Where(s => s != null);
}
}
}
But if I remove using B (I'm stil following the names from my description that A references B, B references C) it compiles. This is the ONLY code in project A. It compiles if I remove usage of extension method or if I remove "using B" as I said before.
Update3:
First of all, thanks for all your suggestions. The smallest example I can come up with is the following. I created a new project, csproj looks like this (nothing has been changed, only C project name and C project guid):
<?xml version="1.0" encoding="utf-8"?>
<Project ToolsVersion="4.0" DefaultTargets="Build" xmlns="http://schemas.microsoft.com/developer/msbuild/2003">
<PropertyGroup>
<Configuration Condition=" '$(Configuration)' == '' ">Debug</Configuration>
<Platform Condition=" '$(Platform)' == '' ">AnyCPU</Platform>
<ProductVersion>8.0.30703</ProductVersion>
<SchemaVersion>2.0</SchemaVersion>
<ProjectGuid>{B649AB2C-926A-4AD1-B7E3-5A29AE1E9CC2}</ProjectGuid>
<OutputType>Library</OutputType>
<AppDesignerFolder>Properties</AppDesignerFolder>
<RootNamespace>ClassLibraryTest</RootNamespace>
<AssemblyName>ClassLibraryTest</AssemblyName>
<TargetFrameworkVersion>v3.5</TargetFrameworkVersion>
<FileAlignment>512</FileAlignment>
</PropertyGroup>
<PropertyGroup Condition=" '$(Configuration)|$(Platform)' == 'Debug|AnyCPU' ">
<DebugSymbols>true</DebugSymbols>
<DebugType>full</DebugType>
<Optimize>false</Optimize>
<OutputPath>bin\Debug\</OutputPath>
<DefineConstants>DEBUG;TRACE</DefineConstants>
<ErrorReport>prompt</ErrorReport>
<WarningLevel>4</WarningLevel>
</PropertyGroup>
<PropertyGroup Condition=" '$(Configuration)|$(Platform)' == 'Release|AnyCPU' ">
<DebugType>pdbonly</DebugType>
<Optimize>true</Optimize>
<OutputPath>bin\Release\</OutputPath>
<DefineConstants>TRACE</DefineConstants>
<ErrorReport>prompt</ErrorReport>
<WarningLevel>4</WarningLevel>
</PropertyGroup>
<ItemGroup>
<Reference Include="System" />
</ItemGroup>
<ItemGroup>
<ProjectReference Include="..\C.csproj">
<Project>{55AFFA2D-63E0-4BA9-XXXX-B70E6A936F5E}</Project>
<Name>C</Name>
</ProjectReference>
</ItemGroup>
<ItemGroup>
<Compile Include="Class1.cs" />
</ItemGroup>
<ItemGroup>
<Folder Include="Properties\" />
</ItemGroup>
<Import Project="$(MSBuildToolsPath)\Microsoft.CSharp.targets" />
</Project>
Class1.cs contains following code:
using C;
namespace TestApp
{
public static class Ext
{
public static void M213dsacxvz(this string[] a)
{
}
}
public class A
{
public void B()
{
new string[] { "a", "b", "c" }.M213dsacxvz();
}
}
}
The compiler error I get is as follows:
D:\xxx\Class1.cs(16,13): error CS0012: The type 'xxx' is defined in an assembly that is not referenced. You must add a reference to assembly 'xxx, Version=0.0.0.0, Culture=neutral, PublicKeyToken=xxx'.
If I remove using C; it compiles just fine.
Thanks in advance for help.
Here is a small example that reproduces the problem. It is caused by an extension method in B that uses types defined in C in its signature. Even though the extension method is not used, the error is triggered by the process of searching all extension methods that are accessible via usings.
ConsoleApplicationA.cs:
using ClassLibraryB;
namespace ConsoleApplication1
{
public static class Extensions
{
public static int Test(this int a)
{
return a;
}
}
public class ProgramA
{
static void Main(string[] args)
{
0.Test();
}
}
}
ClassLibraryB.cs:
using ClassLibraryC;
namespace ClassLibraryB
{
public static class Extensions
{
public static ClassC Test(this ClassB b)
{
return new ClassC();
}
}
public class ClassB
{
}
}
ClassLibraryC.cs:
namespace ClassLibraryC
{
public class ClassC
{
}
}
This test case produces this error:
error CS0012: The type 'ClassLibraryC.ClassC' is defined in an assembly that is not referenced. You must add a reference to assembly 'ClassLibraryC, Version=1.0.0.0, Culture=neutral, PublicKeyToken=null'.
Edit:
In my opinion, this is a bug in the C# compiler, because it very surprising behavior for a method you did not reference to cause your program to fail to compile. The C# compiler team may have a different opinion.
In the meantime, a workaround is to place your extension methods in B that use types from C in their signature into a separate namespace and add a using to that namespace only when the calling assembly has a reference to both B and C. Alternatively if the number of offending extension methods is small and their value is limited you might be able to move or remove them. Finally, and most obviously, you can be done with it and simply add the reference to C that it tells you you should add.
Second edit:
Caveat: I just reviewed this to clean up the example and it is weaker than I had thought. It only fails if the name of the called extension method in A exactly matches the name of the uncalled extension method in B. So for example if you rename Test in B to NotCalled it no longer fails, yet in the original problem, presumably it would.
Final edit:
With collaboration we narrowed down the necessary conditions to reproduce the issue described in the original question: an extension method in B with types from C in its signature that use a generic type constraint. The above test case is a narrower example. The specific conditions are clearly related to the specific implementation of the way the compiler searches for extension methods.
In summary, references are a run-time feature and extension methods are a compile-time feature. No matter how the error message is generated, if the method is not called, the compiler is the one who desires the reference at compile-time, the assembly does not need the reference at run-time. Therefore the error is not one that the compiler has no choice but the emit, it's just an inconvenient situation for the compiler.
I found the solution.
You may download the whole solution (vs 2010) from this link: https://rapidshare.com/files/4269394110/ExtensionProblem.zip.
I found the complete answer thanks to @Rick Sladkey whose answer was almost complete. The only thing that causes the code to always fail to compile is a constraint on generic method in project B that is specified using class from project C.
Ok, here is the listing:
PROJECT A
ClassA.cs
using B;
namespace A
{
public class ClassA
{
public void Foo()
{
new int[] { 1, 2, 3 }.ExtMethodC();
}
}
}
If you want the code to compile comment first line (using B;).
Here is a class that includes random extension method in project A.
ExtensionsA.cs
namespace A
{
public static class ExtensionsA
{
public static void ExtMethodC(this int[] a)
{
}
}
}
PROJECT B
Extensions.cs - this class has method with generic constraint T : ClassC
using C;
namespace B
{
public static class Extensions
{
public static string ExtMethodB<T>(this T cInstance) where T : ClassC
{
return cInstance.Foo;
}
}
}
PROJECT C
ClassC.cs - we need this class to use it in extension method in project B
namespace C
{
public class ClassC
{
public string Foo;
}
}
For me it looks like a bug in compiler that is too eager to check if extension method in project B may be used in project A.
Thanks for all your answers! Especially @Rick Sladkey.
The most likely answer seems to me to be that there is an extension method on IEnumerable or IEnumrable<T> called Where in B. This extension method uses a type from C (as return type? or type constraint?) which requires you to reference it.
What does Visual Studio tell you Where is?
As for solution, it seems B is under your control, so you should delete the extension method, it really shouldn't be there. As an alternative solution, you can use the long syntax: Enumerable.Where(collection, s => s != null).
I found it curious that the file rename sometimes ask to refactor the class inside and (most) sometimes just renames the files.
I think the class name has to match the filename exactly. It may also depend on whether your code compiles at the time, though not sure on that point.
In addition to what AndrewS said, I belive that if you have multiple classes in a single file, it will also not ask to refactor it.
There can be problems when the inherited class lays in another assembly. For me a restart of VisualStudio sometimes fixed it.
Here is a complete list from all answers that I could verify
The refactoring will not trigger if
the namespace does not exactly match the convention (Foldername = namepsacename)
the class is generic
the classname didn't match the filename
there are more than one class in the file
there are errors in the file
the file is located in another project
I've been asked to add automatic numbering to assemblies in our code library. I've been changing versions from the default 1.0.0.0 to 1.0.* like this:
[assembly: AssemblyVersion("1.0.*")]
It generates a number as I'd like.
However, the code library has many hundreds of DLLs, with many referencing each other. Now when I compile some projects they complain that the version of a DLL needed by a referenced component is not correct and they won't build :(
How can I make this work? We need it so that when a DLL at the bottom of our code library hierarchy is compiled, all other DLLs that reference it work correctly without needing recompiling.
The error I get is like this:
Error 1 CA0058 : The referenced assembly 'Library1, Version=1.0.4146.17993
, Culture=neutral, PublicKeyToken=d9c65edd2096ad48' could not be found. This assembly
is required for analysis and was referenced by:
D:\Work\Source Code\Library\Library2\bin\Release\Library2.dll.
The version 1.0.4146.17993 is not correct - the DLL has a higher value. The DLLs are set to Copy Local because the software we deliver requires it (don't ask why). The DLL that's copied locally is the one with the higher version number, which is the one we want it to be.
So far I've tried changing the references to set the "Specific Version" flag to false but this didn't help.
The version numbers that VS generates when you use the 1.0.* syntax are not necessarily going to increment in sequence. The documentation has this to say (emphasis added):
You can specify all the values or you can accept the default build number, revision number, or both by using an asterisk (). For example, [assembly:AssemblyVersion("2.3.25.1")] indicates 2 as the major version, 3 as the minor version, 25 as the build number, and 1 as the revision number. A version number such as [assembly:AssemblyVersion("1.2.")] specifies 1 as the major version, 2 as the minor version, and accepts the default build and revision numbers. A version number such as [assembly:AssemblyVersion("1.2.15.*")] specifies 1 as the major version, 2 as the minor version, 15 as the build number, and accepts the default revision number. The default build number increments daily. The default revision number is random.
If it's vital that you get versioning exactly right, I highly recommend that you use a third-party solution. The Build Version Increment add-in is excellent.
What you want to do is manage the assembly version yourself. Only increment this when you make a breaking change to the assembly's public interface. Changing this attribute makes your assembly incompatible with other assemblies that reference it, even if you didn't change a thing in your code. Instead, the only thing you want to automatically increment is the assembly file version. Unlike the assembly version, this attribute is not checked by the CLR to determine compatibility.
The Build Version Increment add-in gives you the kind of fine-grained control over what is incremented that you need to get this right. It's what probably should be included in VS to begin with.
This is actually a pretty indepth question, and I hope someone answers this in detail for you, but my 2 cents after you get the assembly infos under control is you should look at using Nuget to manage your dependencies. This way when team A releases v2 of assembly X, all they do is put it on your Nuget repo (network share probably) and then you can basically right click < update inside your projects that consume the DLLs.
I would also recommend looking at http://semver.org/ and use Semantic Versioning, if you don't want to follow a system like this one (or institute a similar standard for your shop), it's probably not worth even trying to version your DLLs you're just going to give yourself massive headaches. However using Semantic Versioning will make your version numbers actually MEAN something. And not just be whatever felt like being tagged onto the current version.
delete your reference (in the project that uses it) and re-do it by pointing to the project reference type.
PS: If when you are adding the reference, you choose browse and point to a place the dll will always be, the reference will not be broken!
> However, the code library has many hundreds of DLLs,
If it is ok for you that all source projects and their generated dll-s have the same version-number you can put the versionnumber into one file that is shared between all dlls as described in shared AssemblyInfo.cs. So you (or the version-number-generator you are using) have to update only one file if there is a new relase/Version.
This does not answer your original question but may be a simple workaroud for the dependency problem.
I recently switched to Visual Studio 2010 and for Intellisense not to take half a minute to show up when using boost libraries, Microsoft's suggestion seems to use precompiled headers.
Except that I never used them before (except when forced to by Ugly ATL Wizards (TM)), so I searched around to figure out how they work.
Basically, the Big Centralized stdafx.h approach seems plain wrong. I never want to include (even cheaply) a whole bunch of header files in all my sources. Since I don't use windows libraries (I make C++/CLI higher level wrappers, then use .NET for talking to the outside world), I don't have "a whole truckload of non-changing enormous headers". Just boost and standard library headers scattered around.
There is an interesting approach to this problem, but I can't quite figure out how to make this work. It seems that each source file must be compiled twice (please correct me if I'm wrong): once with /Yc and once with /Yu. This adds burden on the developper which must manually tweak the build system.
I was hoping to find some "automatically generate one precompiled header for each source file" trick, or at least some "best practices", but most people seem happy with including the world into stdafx.h.
What are the options available to me to use precompiled headers on a per source file basis ? I don't really care about build times (as long as they don't skyrocket), I just want intellisense to work fast.
For starters, you are reading the article wrong. Every file is NOT compiled twice. The file stdafx.cpp gets compiled once with /Yc (c, for create) before anything else and then every other file in your project gets compiled once with /Yu (u, for use) and imports the result of the previously created saved state from stdafx.cpp.
Secondly, the article is 7 years old and is talking about VC++ 6, so you should start off distrusting it. But even assuming the information in it still applies to VC++ 2008 or 2010, it seems like bad advice. The approach it recommends using /pragma hdrstop is solution looking for a problem. If you have headers that contain things you don't want in every file, then they simply shouldn't go in your pre-compiled header.
Precompiled headers aren't too bad if you use them properly.
Don't use them as a replacement for proper and precise #includes, but as a way to speed things up. Achieve this by making the precompiled header do nothing in release builds, only speeding stuff up in debug.
You are wrong, each file is only compiled once. You have one .cpp file that is compiled with /Yc and the rest are compiled with /Yu. The file with /Yc, which is stdafx.cpp by default, contains one line, #include "myMainHeader.h" (changed the name from the default) All other .cpp files must start with #include "myMainHeader.h" When your /Yc file is compiled, the entire internal state of the compiler is saved. That file is loaded when each of your other files is compiled. That is why you must start with including the PCH, so that the /Yu option doesn't change the result of compilation, only the time. Xcode does not make this requirement and will use a PCH regardless of if your .cpp file starts with the right include directive. I have used libraries that relied on this and could not be built without PCH.
Your problem basically seems to be that Intellisense is slow for Boost in VS2010? I don't have a direct solution for this problem, but could Visual Assist X be an option for you? I have used it in various versions of Visual Studio now and with great pleasure. Not a direct solution, but it might work for you.
I have a C# console app in Visual Studio 2010 that I can run just fine. When I attempt to run the process in debug mode, I am presented with the following error:
I have tried searching for any information, but I haven't been able to find anything. Can anyone provide clues as to why I can't run this with the debugger?
EDIT: I should clarify that I have been able to successfully debug a console app previously, this is a new situation.
From what I can tell when I'm able to reproduce this error, it is caused by being in the middle of installing Windows updates. So, running updates, then postponing a reboot, then attempting to debug code is what was putting me in this broken state.
I have finally solved this!
It seemed to have happened after I updated my Windows 7. One of my files must have been out of date.
The fix: Install VS 2010 Service Pack 1
Worked correctly right after I installed. Hitting breakpoints and everything!
Hope this works for you too!
I also updated Service pack1, and made sure windows updates are upto date..but still was having the same issue
"The Version of CLR.dll in the target does not match the one mscordacwks.dll was built for."
Some Microsoft A' soles closed this issue in connect.microsoft.com article as not reproducible...Unforgivable, irresponsible Support system!!
But in social.msdn.com directed the link for updates through this link
Hope it helps,
A curious case of Visual Studio 2010 debugger(it can not hit a break point)
This is the code that reproduces the problem:
class Program
{
static void Main(string[] args)
{
bool b = false;
if (b)
{
List<string> list = new List<string>();
foreach (var item in list)
{
}
}
else
{
Console.WriteLine("1");
}
Console.WriteLine("2");//add a break point here in VS2010
}
//1. configuration: release
//2. platform target: x64 or Any Cpu
//3. debug info: pdb only or full
//4. OS: Win7 x64
//5. optimize code: enabled
}
Add a break point to the last statement of the code, then debug it in vs2010, you'll see that the break point can not be hit.
To reproduce this curious case, you'll need to meet the following conditions:
Operation system: windows 7 x64;
2.VS build configuration: release;
3.VS build platform target: x64 or Any Cpu;
4.VS build debug info: pdb only or full;
5.VS build optimize code: enabled;
I am not sure those conditions are sufficient to reproduce it, but it's how my machine was configured when I found this issue.
Why is the debugger not able to hit the break point?
Thanks in advance.
And if you can reproduce this issue, please consider to vote on this post: http://connect.microsoft.com/VisualStudio/feedback/details/664400/a-curious-case-of-visual-studio-2010-debugger-it-can-not-hit-a-break-point#tabs
Using VS2010 SP1, it stops on the last line if you set a breakpoint in release mode. You should really install it, it specifically mentions it fixes debugger issues where it would sometimes skip over breakpoints (although not this specific case).
When the provided example is built in release mode and then JIT-ed into 64-bit machine code, it does not contain enough information for the debugger to correlate the breakpoint with any particular machine instruction. That?s why debugger never stops at this breakpoint during execution of a JIT-ed machine code. It just does not know where to stop. Probably it is some kind of misbehavior or even a bug in 64-bit CLR debugger because it is reproducible only when it is JIT-ed into 64-bit machine code but not into 32-bit machine code.
When the debugger sees a breakpoint in your code it tries to find out a machine instruction in the JIT-ed code that corresponds to the location marked by the breakpoint. First, it needs to find an IL instruction that corresponds to a breakpoint location in your C# code. Then it needs to find a machine instruction that corresponds to the IL command. Then it sets a real breakpoint on the found machine instruction and starts execution of the method. In your case, it looks like that the debugger just ignores a breakpoint because it cannot map it to a particular machine instruction.
The debugger cannot find an address of a machine instruction that immediately follows if?else statement. The if?else statement and the code inside it somehow causes this behavior. It does not matter what statement follows the if?else. You can replace the Console.WriteLine(?2?) statement with some other one and you will be still able to reproduce the issue.
You will see that the C# compiler emits a try?catch block around the logic that reads the list if you will disassemble the resulting assembly with Reflector. It is a documented feature of the C# compiler. You can read more about it at The foreach statement
A try?catch?finally block has a pretty invasive effect on a JIT-ed code. It uses the Windows SEH mechanism under the hood and rewrites your code badly. I cannot find a link to a good article right now but I?m sure that you can find one out there if you are interested.
It is what happens here. The try?finally block inside of if?else statement causes the debugger to hiccup. You can reproduce your issue with a much simple code.
bool b = false;
if (b)
{
try
{
b = true;
}
finally
{
b = true;
}
}
else
{
b = true;
}
b = true;
This code does not call any external functions (it eliminates effect of method inlining proposed by one of the answers) and it compiles directly into IL without any additional coded added by the C# compiler.
It is reproducible only in release mode because in the debug mode the compiler emits the IL NOP instruction for every line of your C# code. The IL NOP instruction does nothing and it is directly compiled to the CPU NOP instruction by the JITer that does nothing too. The usefulness of this instruction is that it can be used by the debugger as an anchor for breakpoints even if the rest of the code is badly rewritten by the JITer.
I was able to make the debugger to work correctly by putting one NOP instruction right before the statement that follows the if?else.
You can read more about NOP operations and debugger mapping process here Debugging IL
You can try to use WinDbg and SOS extension for it to examine JIT-ed version of the method. You can try to examine machine code that JIT-er generates and try to understand why it cannot map back that machine code to particular line of C#.
Here are couple link about using WinDbg for breaking in managed code and getting a memory address of a JIT-ed method. I believe that you should be able to find a way to get JIT-ed code for a method from there: Setting a breakpoint in WinDbg for Managed Code, SOS Cheat Sheet (.NET 2.0/3.0/3.5).
You can also try to report an issue to Microsoft. Probably this is a CLR debugger bug.
Thank you for the interesting question.
Change your build configuration to "Debug", instead of "Release".
The JIT compiler uses optimization techniques that may cause this.
One such optimization is called method inlining, that may be responsible for this behavior.
I cannot tell exactly right now, because I am using another person's computer... but you can test that yourself:
1) Create the following method:
[MethodImpl(MethodImplOptions.NoInlining)]
public static void MyMethod(string str)
{
str += "-CONCAT-STRING";
}
2) replace the calls to "Console.WriteLine" with just "MyMethod"
3) Set the breakpoint, and try it.
4) Now, remove the "MethodImpl" attribute from the method "MyMethod".
//[MethodImpl(MethodImplOptions.NoInlining)]
public static void MyMethod(string str)
{
str += "-CONCAT-STRING";
}
5) Run again, with the breakpoint in the same place.
6) If it stops in the first run, but not in the second run... then this is the reason.
I think that when you debug using release mode your breakpoints may not correspond to actual lines in the code because the machine code may have been optimized. In the case of your code you are actually not doing anything part from printing "1" and then "2" so it would be safe to assume that the compiler would remove the code of the (b==false) since it will never be reached.
Building the release omits creating the debug-symbols, which in itself is obvious.
You can override this by going to the properties of your project. select the Release-configuration and hit 'Advanced' on the Build-tab. Set the Debug-Info to full.
I'm experimenting around with writing custom WinForms components and I wrote a couple of simple validator components for use with a subclass of ErrorProvider that automatically hooks up validation events. All these components can be added to a form and hooked up using only the designer, thanks to IExtenderProvider.
Now in trying to go up one level, I'm trying to get a composite validator to be usable with the designer. I can get it up and working with code, but that's really easy. I'd like to get it to work in a designer-only way.
My difficulty resides in exposing a property that is a collection of other validators that are in the same form. The validators all inherit directly from Component, and implement a IControlValidator interface. I'm open to changing this to have them inherit from a ValidatorComponent base class if it helps.
I thought of a couple solutions, but either I don't like them, or I can't get them to work:
Make the validators into invisible controls, and the have composite validator contain them, similar to what a Panel does;
This one I don't like because it is more of a hack, and having to juggle them among true controls just feels wrong;
Use a collection editor, as you use for toolbars;
I looked around the web and found a couple of articles about this, but I couldn't get it to work. At least without building my own editor form, which would be too much of a hassle for an experiment project.
I admit I didn't spend much time trying this, because I realized using the standard CollectionEditor would lock me down to using a fixed set of validator types (it would, wouldn't it?).
I also thought of creating a simple ValidatorReference class with a single property of type IControlValidator and use that as the element type for a simple collection editor. I would then add one of these, and in its property grid set the property to an existing validator component. This one seems easy to get working, but loses its appeal because it is such an obvious hack.
Anyone has any other ideas? Is there something I'm missing and this is actually something simple?
Why not creating an editor to do this??? You think it sounds an overkill, but actually it is not.
I will demonstrate with a sample.
In this sample I will be creating a control named ButtonActivityControl that is abled to make multiple references to other controls in the same form, using a property called Buttons, that is an array of type Button (i.e. Button[]).
The property is marked with a custom editor, that makes it easy to reference the controls in the page. The editor shows a form that consists of a checked list box, that is used to select multiple controls that are in the very same form.
1) a Form called ReferencesCollectionEditorForm
Code of ReferencesCollectionEditorForm:
public partial class ReferencesCollectionEditorForm : Form
{
public ReferencesCollectionEditorForm(Control[] available, Control[] selected)
{
this.InitializeComponent();
List<Control> sel = new List<Control>(selected);
this.available = available;
if (available != null)
foreach (var eachControl in available)
this.checkedListBox1.Items.Add(new Item(eachControl),
selected != null && sel.Contains(eachControl));
}
class Item
{
public Item(Control ctl) { this.control = ctl; }
public Control control;
public override string ToString()
{
return this.control.GetType().Name + ": " + this.control.Name;
}
}
Control[] available;
public Control[] Selected
{
get
{
List<Control> selected = new List<Control>(this.available.Length);
foreach (Item eachItem in this.checkedListBox1.CheckedItems)
selected.Add(eachItem.control);
return selected.ToArray();
}
}
}
2) an UITypeEditor
Code of ReferencesCollectionEditor:
public class ReferencesCollectionEditor : UITypeEditor
{
public override object EditValue(ITypeDescriptorContext context, IServiceProvider provider, object value)
{
List<Control> available = new List<Control>();
ButtonActivityControl control = context.Instance as ButtonActivityControl;
IDesignerHost host = provider.GetService(typeof(IDesignerHost)) as IDesignerHost;
IComponent componentHost = host.RootComponent;
if (componentHost is ContainerControl)
{
Queue<ContainerControl> containers = new Queue<ContainerControl>();
containers.Enqueue(componentHost as ContainerControl);
while (containers.Count > 0)
{
ContainerControl container = containers.Dequeue();
foreach (Control item in container.Controls)
{
if (item != null && context.PropertyDescriptor.PropertyType.GetElementType().IsAssignableFrom(item.GetType()))
available.Add(item);
if (item is ContainerControl)
containers.Enqueue(item as ContainerControl);
}
}
}
// collecting buttons in form
Control[] selected = (Control[])value;
// show editor form
ReferencesCollectionEditorForm form = new ReferencesCollectionEditorForm(available.ToArray(), selected);
form.ShowDialog();
// save new value
Array result = Array.CreateInstance(context.PropertyDescriptor.PropertyType.GetElementType(), form.Selected.Length);
for (int it = 0; it < result.Length; it++)
result.SetValue(form.Selected[it], it);
return result;
}
}
3) a control that uses other controls in the same form
Code of custom control:
public class ButtonActivityControl : Control, ISupportInitialize
{
[Editor(typeof(ReferencesCollectionEditor), typeof(UITypeEditor))]
public Button[] Buttons { get; set; }
Dictionary<Button, bool> map = new Dictionary<Button, bool>();
protected override void OnPaint(PaintEventArgs e)
{
e.Graphics.FillRectangle(Brushes.White, e.ClipRectangle);
if (this.Site != null) return; // this code is needed otherwise designer crashes when closing
int h = e.ClipRectangle.Height / this.Buttons.Length;
int top = 0;
foreach (var button in this.Buttons)
{
e.Graphics.FillRectangle(map[button] ? Brushes.Black : Brushes.White, new Rectangle(0, top, e.ClipRectangle.Width, h));
top += h;
}
base.OnPaint(e);
}
void ISupportInitialize.BeginInit()
{
}
void ISupportInitialize.EndInit()
{
if (this.Site != null) return; // this is needed so that designer does not change the colors of the buttons in design-time
foreach (var button in this.Buttons)
{
button.Click += new EventHandler(button_Click);
button.ForeColor = Color.Blue;
map[button] = false;
}
}
void button_Click(object sender, EventArgs e)
{
map[(Button)sender] = !map[(Button)sender];
this.Invalidate();
}
}
Now create a form that will contain the custom control, place some buttons on it, and then place a ButtonActivityControl on it. The custom control has a property called Buttons, that is editable.
That's it!!
No reason to fear custom Editors... and not so complex.... dit it in half an hour.
I think this is the answer... that is, I think it is! =) Maybe I didn't understand the question well... but thats the best one can do: trying to help others!
EDIT
This code is needed in the ReferencesCollectionEditor:
public override UITypeEditorEditStyle GetEditStyle(ITypeDescriptorContext context)
{
return UITypeEditorEditStyle.Modal;
}
public override bool GetPaintValueSupported(ITypeDescriptorContext context)
{
return false;
}
This is not production code, I tried to keep it short so it's just enough to illustrate the idea. Initialization and disposal is handled in the .Designer file created by VS2010.
using System;
using System.Collections.Generic;
using System.ComponentModel;
using System.Text.RegularExpressions;
using System.Windows.Forms;
namespace ValidationControls
{
[ProvideProperty("ErrorMessage", typeof (TextBoxBase))]
[ProvideProperty("RegEx", typeof (TextBoxBase))]
public partial class ValidationComponent : Component, IExtenderProvider
{
private readonly Dictionary<Control, string> _errorMessages =
new Dictionary<Control, string>();
private readonly Dictionary<Control, string> _regExDictionary =
new Dictionary<Control, string>();
private TextBoxBase _activeControl;
private ErrorProvider _errorProvider;
public ValidationComponent()
{
InitializeComponent();
}
public ValidationComponent(IContainer container)
{
container.Add(this);
InitializeComponent();
}
public ErrorProvider ErrorProvider
{
get { return _errorProvider; }
set { _errorProvider = value; }
}
#region IExtenderProvider Members
public bool CanExtend(object extendee)
{
return extendee is TextBoxBase;
}
#endregion
[DefaultValue("")]
[Category("Validation")]
public string GetRegEx(TextBoxBase control)
{
string value;
return _regExDictionary.TryGetValue(control, out value) ? value : string.Empty;
}
[Category("Validation")]
public void SetRegEx(TextBoxBase control, string value)
{
if (string.IsNullOrWhiteSpace(value))
{
_regExDictionary.Remove(control);
control.Validating -= OnControlValidating;
control.Validated -= OnControlValidated;
}
else
{
_regExDictionary[control] = value;
control.Validating += OnControlValidating;
control.Validated += OnControlValidated;
}
}
[Category("Validation")]
public string GetErrorMessage(TextBoxBase control)
{
string value;
return _errorMessages.TryGetValue(control, out value) ? value : string.Empty;
}
[Category("Validation")]
public void SetErrorMessage(TextBoxBase control, string value)
{
if (string.IsNullOrWhiteSpace(value))
{
_errorMessages.Remove(control);
}
else
{
_errorMessages[control] = value;
}
}
private void OnControlValidating(object sender, CancelEventArgs e)
{
_activeControl = (TextBoxBase) sender;
var regExPattern = GetRegEx(_activeControl);
if (Regex.IsMatch(_activeControl.Text, regExPattern, RegexOptions.Singleline))
return;
e.Cancel = true;
var errorMsg = GetErrorMessage(_activeControl);
if (_errorProvider != null)
_errorProvider.SetError(_activeControl, errorMsg);
}
private void OnControlValidated(object sender, EventArgs e)
{
if (sender != _activeControl)
return;
if (_errorProvider != null)
_errorProvider.SetError(_activeControl, "");
_activeControl = null;
}
}
}
I struggled finding a how-to which provides a stable solution for using Qt with Visual Studio 2010, so after collecting all the bits of information and some trial and error, I would like to write my solution into a guide.
It seems that using binaries built for Visual Studio 2008 might work in some special cases, but I found them not to work. In my case they compiled OK, but they produce runtime errors, like this:
or when started from Visual Studio 2010:
Update: I found a blog post analysing why does it work for some people, while it does not for others. In one word, it depends on whether you have Visual Studio 2008 installed on the same machine, or not. http://blog.paulnettleship.com/2010/11/11/troubleshooting-visual-studio-2010-and-qt-4-7-integration/
The most important thing (that I stupidly didn?t realize) was the fact that you CANNOT use the Visual Studio 2008 compiled libraries and dll?s (available on the Qt webpage) if you don?t have Visual Studio 2008 installed. The reason is because the Qt SDK you download is a debug build which is dependant on the VC9.0 DebugCRT, meaning it needs the Visual C++ 2008 Debug Runtime installed, which is NOT available as a redistributable installer. The only way to install the DebugCRT is to install the entirety of Visual Studio 2008.
First of all, it?s very important to understand that for using Qt with Visual Studio 2010, it's not possible to use the pre-built binaries which were made for Visual Studio 2008, but you have to compile it from source.
On http://qt.nokia.com/downloads, click LGPL.
You should not download Qt by clicking "Qt libraries 4.7.2 for Windows (Visual Studio 2008, 218 MB)", but by clicking on the "zip" link above it.
On that link, you get a big zip file like "qt-everywhere-opensource-src-4.7.2.zip". Unzip this into a folder and make its path something nice and small, for example "E:\Qt"
Now that we have the sources, we need to build the binaries. To do it, open the Microsoft Visual Studio 2010\Visual Studio Tools\Visual Studio Command Prompt (2010) link from your start menu, or even pin it to the taskbar (a good idea). This is a special command prompt which has all the variables set for building with Visual Studio 2010 tools.
Once within the command prompt, navigate to your extracted Qt folder using old-school DOS way, which means you have to change drive letter by E:, enter directories by cd Qt and list dir contents by dir. You can use the tab key for helping you with the directory names. When you have arrived at the correct directory, a dir command should return something like this.
Now it?s time for configure and build. For configuring a minimalist Qt, I'm using the following flags with configure.exe. Just copy and paste it into the command line. Look in the Qt reference manual for what flag to use or not to use.
configure.exe -release -no-webkit -no-phonon -no-phonon-backend -no-script -no-scripttools -no-qt3support -no-multimedia -no-ltcg
Once configure.exe has finished (it was 10 minutes for me), you'll need to start the build process. It will take about 20-30 minutes with the above flags. To start it, just type:
nmake
Basically, we are done. All you need to do is to set your environment variables (QTDIR and PATH), which tell programs where to find Qt. If you are on Windows 7, you can use the following command to set QTDIR to your installation dir.
setx QTDIR e:\Qt
For setting the PATH, I strongly recommend using Path Editor. Within Path Editor
add the directory of Qt\bin to your PATH
(it doesn't matter if it's in system path or user path)
If you prefer to use Control Panel\System\Environment Variables, then you can set these there, too.
Here you go, after a logoff-logon or a restart, all the Qt demo applications should start correctly (I recommend have a look at bin\qtdemo.exe). Now you can download and install the Visual Studio Add-in (qt-vs-addin-1.1.9.exe) from the Qt download page, it will work perfectly.
There is a page at the official wiki at the Qt website called Qt 4.7 Installing Qt for Windows, but I found it lacking important information.
Qt DevNet forums
Recommended flags for a minimalistic Qt build
Building Qt 4.5 with Visual C++ 2010
How to compile Qt as static
Qt 4.7: Configure options for Qt
Edit the PATH environment variable in
Windows without pain - op111.net
For the following line of C# code:
BitArray bitty = new BitArray(new[] {false, false, true, false});
If I evaluate "bitty" in the Watch window, I don't see the members of the collection. If I evaluate "bitty, results", which is supposed to enumerate the IEnumerable and show the results, I get the message "Only Enumerable types can have Results View", even though a BitArray IS an IEnumerable.
Why does the debugger do this?
CLARIFICAITON: I'm asking what is happening inside the VS Debugger Expression Evaluator, NOT asking how to view a BitArray in the debugger..
The results view only works for collections which meet the following conditions
IEnumerable<T> or IEnumerable (VB.Net only works for IEnumerable<T>)IList, IList<T>, ICollection or ICollection<T> (C# restriction only) DebuggerTypeProxy attributeIn this case BitArray implements both IEnumerable and ICollection. The latter disqualifies it from being used with the results view.
One way to work around this is to use the Cast extension method. This produces an IEnumerable<T> value from which you can use the results view
bitty.Cast<bool>(), results
The reason for #2 is a combination of factors.
IEnumerable<T>. IList/<T> and ICollection<T> type already have a method that let you view the contentsHence the C# team decided to minimize risk and not add IEnumerable<T> to types which they felt already displayed well. VB.Net chose the other direction and will display it for any IEnumerable<T>.
You might rightfully ask how two teams could look at the same data and make different decisions. It comes down to perspective and of course time. The VB.Net team was very keen on providing a great LINQ debugging experience. VB.Net has a long history of providing a rich debugging + ENC experience and hence was more accustom / willing to take this type of risk on and additionally had the bandwidth to test it. C# was simply more risk adverse, very tight on the schedule and pragmatically decided against it.
Note: My earlier confusion about IEnumerable not being supported is because that's actually the case in the VB expression evaluator. The C# expression evaluator does support IEnumerable though and by the above rules.
This is question is inspired by the question: In what areas does F# make "absolute no sense in using"?
In theory, it should be possible to use any .NET supported language in a single project. Since every thing should be compiled into IL code, then linked into a single assembly.
Some benefits would include the ability to use say F# for one class, where F# is more suited to implement it's function, and C# for another.
Is there some technical limitation I'm overlooking that prevents this sort of setup?
A project is restricted to a single language because, under the hood, a project is not much more than an MSBuild script which calls one of the command-line compilers to produce an assembly from the various source code files "contained" in the project folder. There is a different compiler for each language (CSC.exe is for example the one for C#), and what each project has to do to turn its "contained" source code into an assembly differs with each language.
To allow multiple languages to be compiled into a single assembly, the project would basically have to produce an assembly for each language, then IL-Merge them. This is costly, requires complex automation and project file code generation, and in most circumstances it's a pretty fringe need, so the VS team simply didn't build it in.
While projects are restricted to a single language, a solution is not... and solutions can contain multiple projects.
As others mentioned, a project is a stand-alone unit that is compiled by a single compiler.
I hear the question about including e.g. one F# type in a larger C# project quite often, so I'll add some details from the F# specific point of view. There are quite a few technical problems that would make it really difficult to mix F# and C# in one project:
System.Type information, so how would they share the information? (Both of them would need to agree on some common interface that allows them to include language-specific information - and the information may be also incomplete).I think this is enough to explain that doing this is not just a feature that may or may not be done depending on the schedule. It is actually an interesting research problem.
For what it's worth, it's possible to have ASP.NET projects that use C# and VB.NET (or anything else, you define the compilers in web.config), just in different files.
All code files are processed by a single compiler. That's why a project can only contain a single language.
Mixing languages may not make much sense either, since each language generates it's own IL.
This of course doesn't restrict you form having multiple projects from different langauges in the same solution, since each project is compiled independently
Consider using ILMerge if you want to maintain a single .exe or .dll built by a number of different compilers.
Technically, you can mix languages in a single project, if one (or more) of those languages are scripting languages. See How to use Microsoft.Scripting.Hosting? for more details.
I know this isn't what you were talking about, but it's a little fun fact if you weren't aware.
The project file is nothing but an elevated list of command line parameters to the relevant compiler. A file with the extension of .csproj contains the parameters for a C# compiler, .vbproj for the VB.NET compiler and so on.
You can however create two or more projects in the same solution file, one for each language and then link them together in one exe file using ILMerge.
How do I change the fonts used in the TableAdapter Configuration Wizard SQL Statement?
As you see here, the alignment of the Query is wrong, so I want to set this box so it uses a monospaced font like "Consolas" or "Courier New".
I think I need to change something in Tool - Options - Environment - Fonts and Colors:
But I cannot find which setting/display item I need to select to change it. There's one named "Query and View Designer" but it (only) changes the font when you use the Query builder by clicking the "Query builder" button.
How do I do this? Do I need to change a setting somewhere else?
It looks like this wizard has a TextBox, probably in WPF since Visual Studio 2010 is mostly WPF. Since Visual Studio has many hooks to support extensions, it is possible that an extension could be created. I would not use my time trying to find it--my gut is that down such a path lies much suffering.
Seems easier to leave open a SQL Management Studio query window (or a SQL syntax-highlighting text editor of your choice) on the side, then copy and paste as needed.
Sure, just ask Microsoft to add it in ;-)
Is it possible and if so how, to make Visual Studio highlight dynamic expressions in code?
When I just hovered above some code, visual studio told me it was a dynamic expression. This made me realize I made a mistake in my code and used one dynamic too many. But I also realized that if I had not hovered, a 'huge swath' of dynamic code that was supposed to be static would have escaped.
So I wondered if it is possible to make Visual Studio change the background color of dynamic expressions, so those pieces will be clearly recognizable.
[edit]
With dynamic expressions I mean the use of the dynamic keyword in regular code.
You would need an Extension. You can create your own but I would suggest getting pre-built ones.
Visual Studio been making a lot of extansions as of late since their popularity. I would go with them but they all inhibit a lot of bugs .. so i would suggest using some safe ones like Resharper my all time favorite and for most others as well
there is also JustCode which I like.
So many more out there and if you want cruise down the Visual Studio Gallery like Morvader said. Visual Studio Gallery
EDIT:
2 notes i forgot to mention:
just had this idea for something that I'd love to be able to use:
Let's say I have to fix a bug and I decide to write an ugly code line that fixes the immediate problem - but only because I promise myself that I will soon find the time to perform a proper refactoring.
I want to be able to somehow mark that code line as "Expired in" and add a date - so that if the code is compiled some time after that date there will be a compilation error/warning with a proper message.
Any suggestions? It must be possible to perform - maybe using some complicated #IF or some options in visual studio? I'm using VS 2005 - mainly for C#.
Thanks!
[EDIT]: Wow - never expected this question to raise so much interest :) Thank you all for your answers and for turning this into an interesting debate. I know it's hard to justify using anything like this - and I probably won't use it - but sometimes, when you have to ship a version YESTERDAY and you find yourself compromising on a patchy fix instead - you want to force yourself to fix it in the near future.
I chose MartinStettner's suggestion as the answer because it met my needs - no error on runtime - only during compilation, no need to define new types just for this goal - and it's not limited to a scope of an entire method. Cheers!
Mark the code with the System.ObsoleteAttribute attribute, you'll get a compiler warning, which will nag you to fix the code
[Obsolete("You've an ugly hack here")]
public void MyUglyHack()
{
...
}
Alternatively . . .
Write your own attribute, passing it an expiration date on the constructor, in the constructor throw an exception if DateTime.Now >= expirationDate.
The compile will fail until you fix the code (or more likely increase the expiration date, or far more likely you just remove the Attribute.
oooohhh - this is 'orrible. try this for a giggle:
[AttributeUsage(AttributeTargets.All)]
public class BugExpiryAttribute : System.Attribute
{
// don't tell 'anyone' about this hack attribute!!
public BugExpiryAttribute(string bugAuthor, string expiryDate)
{
DateTime convertedDate = DateTime.Parse(expiryDate);
Debug.Assert(DateTime.Now <= convertedDate,
string.Format("{0} promised to remove this by {1}",
bugAuthor, convertedDate.ToString("dd-MMM-yyyy")));
}
}
then, decorate your method/class etc:
[BugExpiryAttribute("Jack Skit", "2011-01-01")]
public static void Main(string[] args)
{
...
}
... nasty :-)
[DISCLAIMER] - created in the name of academic interest, not production code finese!!
[edit] - just to clarify, code compiled and in production will continue to run on/after the 'bugExpriryDate'. only once the code is run in the compiler (on/after the date), will the warning message be raised (debug.assert). just thought it worth making that distinction - cheers MartinStettner.
[caveat] - if used in classes/methods etc would need to be read via reflection. however (and this is interesting) will work straight off in the compiler if used on sub Main(). how strange!! (thanks for the nod Hans...)
I think this is the reason Visual Studio has a Task List. Add the comment:
\\ TODO: Fix this spaghetti by 01APR11
and it will show up like this
.
the keywords are configurable from the options
You could write comment lines in the form
// Expires on 2011/07/01
and add a prebuild step which does a solution-wide replace of these lines by something like
#error Code expired on 2011/07/01
for all lines that contain a date before the current day. For this prebuild step you would need to write a short program (probably using regular expressions and some date comparision logic)
This step could also be performed by a VS macro, which allows for easier access to all files fo the solution but has the disadvantage that it must be installed and run on all VS installations where your project is compiled.
Well it doesn't do exactly what you're asking for but you could use a Debug.Assert() method call which would alert you (in Debug only) that the code has expired. One benefit would we that the it wouldn't inadvertently affect your production code (compilation or execution) but would be sufficiently annoying in Debug for you to want to correct it.
// Alert the developer after 01/07/2011
Debug.Assert(Date.Now < new DateTime(2011, 7, 1))
One more option if you have unit tests for your code you can time bomb the tests that verifies your fix. This way you don't introduce strange checks in your production code.
Also I think the best option if you have to put in hack (you've probably already spent enough time looking at it to fix properly... but still want a hack there) than open bug/create task/work item (whatever you use to track future work) and decide if you want to fix it later.
Without controlling the compiler (possible in the 5.0 timeframe with compiler as a service?), you are not going to have your code expire. You can mark the code as deprecated, or use the Obsolete attribute, or similar, to fire off a warning, but people can ignore warnings (many devs I have met have not learned the rule that warnings are errors).
I think it is a lot of work to try to protect people from themselves. It is even harder when you are protecting them from themselves in the future. Mark the code as a kludge and leave it at that.
Instead of embedding a time bomb, perhaps consider applying a BUGBUG: comment?
Rather than forcing you or someone else to fix code that may be kind of unsightly but works as expected down the road, you can just do a solution-wide search and find the ugly bits when you decide it's time to get down and refactor the really ugly stuff.
Track it in a bug instead. Then it can be properly scheduled and prioritized with other refactoring work.
TODO comments in code can have a tendency to be lost and forgotten. Throwing a compiler error after a particular date will likely lead to that date being pushed forward, or the comment/attribute removed.
Both TIME and DATE emit strings and, to my knowledge, there is no way to parse them out at the preprocessing stage.
There are a few methods you can easily do in code to ensure that the code at least warns you at run time. Including an assert is one way, putting in a code comment also works, but the way I handle it is through including a doxygen comment with a note explaining that the function contains a hack, bug, or performance issue that needs to be resolved. This ends up getting filtered by many programmers and is easily viewable on the website for myself or other people to fix.
When customizing my Visual Studio color scheme I am often confounded by the "Fonts and Colors" area.
Often, I want to change a specific color, say: the color used for TODO lines, but I need to read through 100s of color names just to figure out what that is. Often I am unable to figure what what color is what.
Is there any documentation out there that lists which colors are which?
Or even better, is there a plugin that allow me to highlight text in the editor and change the scheme of the selected text (figure out what color/s it is)?
I totally agree that this list is messy.
I personally find the Studio Styles page helpful to create Visual Studio color schemes.
If you click on Create a scheme and hover over the different code elements it will show you a tooltip with the naming of that item to find it in Visual Studio (like Keyword, User Types(Delegates), Brace Matching(Rectangle) etc.):
Of course you could also just build the complete theme then on their page and export it. It also provides an import functionality to change your pre-existing Visual Studio scheme directly there.
Anyhow, I would also love to have an extension to do so directly in Visual Studio ;)
I had a function: void foo(bool boolParam = true)
And I changed it to: void foo(const char* charParam, bool boolParam = true)
To avoid searching I just compiled the code hoping that the compiler will give an error (or at least an warning) where the function was called because of wrong parameter type, but instead of this the compiler silently converted false to NULL and compiled everything without error or warning. Is this behavior correct? I know that false and NULL are both 0, but I think the compiler should give at least some warning message...
You could leave your original function unimplemented:
void foo(bool boolParam = true);
void foo(const char* charParam, bool boolParam = true)
{
// do stuff
}
Now whenever you call foo(), foo(true), and foo(false) it will cause a compile error. However, foo(NULL) won't compile either because NULL and false are ambiguous (and then we are back to square one...).
The behavior is entirely correct, because (as you note) the conversion from false (a valid null pointer constant) to pointer is implicit. Try a std::string instead.
I currently use Web Deploy, http://learn.iis.net/page.aspx/346/web-deploy/ to publish my MVC2 app. It used to work well, but now it is got to the point where I can't continue using it:
When the MVC app was small and had only a few users it was easy to publish. Just right click the project in Visual Studio and choose "Publish". And because there were only a few users it was easy to find a time when no one was using the site to do a quick update.
Then the app got bigger and had a few more users. The "Publish" action started taking longer and longer and occasionally timing out. Even when I recycled the app pool before deploy it still took a long time.
Also it became harder to find a time when no one was using the site so the update could be done without affecting anyone.
Then the "Publish" action started timing out every single time, and I had to switch to manual deployment as per this earlier unanswered question: Visual Studio 2010 - web deploy times out - what to do?
Now the manual deploy is taking longer and longer, from 5 to 20 minutes. And the number of users has grown significantly, so the deployment always affects someone (slow response times, timeouts, site unavailable, etc)
So what can I do? Is there a better alternative to using web deploy?
Edit:
Today's deployment took 18 minutes to publish just 49 changed files. The situation is just ridiculous and is one of the biggest weaknesses of our site right now. So I'm starting a decent sized bounty in the hopes of solving this.
Some more questions that may lead to a solution:
In reply to answers:
Re: http://www.troyhunt.com/2010/11/you-deploying-it-wrong-teamcity_24.html This is exactly how I was doing the deploy, and would be an ideal method. Web deploy does correctly identify which files have changed, however it times out and no publish occurs. There are around 2500 files in the solution, perhaps it is taking too long to identify which ones are changed? Or it could be that publish has a short timeout value and that just uploading the 15mb zip file uses all that time up.
I do have full control over the server, and it does support web deploy. There are actually 2 servers: the primary live server, and a redundant server that we keep ready in case the first falls over. So any solution has to be easy to deploy to more than one server (web deploy was ideal until it stopped working).
The suggestion of creating a new folder for each release and then just changing IIS to point to that new folder sounds like it will result in lower downtime/slowtime when during the publish. But it is a very manual process and I would prefer something more automated.
Edit #2
I have managed to narrow it down, and found exactly where it is slow - but not why. This is from the deploy log:
[9/02/2011 12:11:56 a.m.] Performing synchronization pass #1.
[9/02/2011 12:11:56 a.m.] Parameter entry 'IIS Web Application Name/1' is applicable to 'iisApp/C:\src\Site.2010\Site.UI\obj\Release\Package\PackageTmp' because of its scope.
[9/02/2011 12:11:56 a.m.] Parameter entry 'IIS Web Application Name/2' is applicable to 'setAcl/C:\src\Site.2010\Site.UI\obj\Release\Package\PackageTmp' because of its scope.
[9/02/2011 12:11:56 a.m.] Parameter entry 'IIS Web Application Name/2' is applicable to 'setAcl/C:\src\Site.2010\Site.UI\obj\Release\Package\PackageTmp' because of its scope.
[9/02/2011 12:11:56 a.m.] Parameter entry 'Add write permission to App_Data Folder/1' is applicable to 'setAcl/C:\src\Site.2010\Site.UI\obj\Release\Package\PackageTmp\App_Data' because of its scope.
[9/02/2011 12:11:56 a.m.] Source createApp (C:\src\Site.2010\Site.UI\obj\Release\Package\PackageTmp) does not match destination (Default Web Site/virtual-dir/) differing in attributes (isDest['False','True']). Update pending.
[9/02/2011 12:11:56 a.m.] Update operation on createApp (C:\src\Site.2010\Site.UI\obj\Release\Package\PackageTmp) skipped because of rule CreateApplicationRule.
[9/02/2011 12:11:56 a.m.] Source filePath (C:\src\Site.2010\Site.UI\obj\Release\Package\PackageTmp\App_Data\Create.sql) does not match destination (Default Web Site/virtual-dir/App_Data\Create.sql) differing in attributes (size['259691','259697'],lastWriteTime['02/08/2011 10:45:20','02/06/2011 03:48:16']). Update pending.
[400 lines of file updates skipped, time expired 2 seconds ....]
[9/02/2011 12:11:58 a.m.] Delete operation on filePath (Default Web Site/v2/zzz_app_offline.htm) skipped because of rule DoNotDeleteRule.
[9/02/2011 12:11:58 a.m.] Source setAcl (C:\src\Site.2010\Site.UI\obj\Release\Package\PackageTmp) does not match destination (Default Web Site/virtual-dir/) differing in attributes (isDest['False','True'],setAclUser,setAclAccess). Update pending.
[9/02/2011 12:11:58 a.m.] Updating setAcl (Default Web Site/virtual-dir/).
[9/02/2011 12:13:47 a.m.] Source setAcl (C:\src\Site.2010\Site.UI\obj\Release\Package\PackageTmp) does not match destination (Default Web Site/virtual-dir/) differing in attributes (isDest['False','True'],setAclUser,setAclAccess). Update pending.
[9/02/2011 12:13:47 a.m.] Updating setAcl (Default Web Site/virtual-dir/).
[9/02/2011 12:17:11 a.m.] Source setAcl (C:\src\Site.2010\Site.UI\obj\Release\Package\PackageTmp\App_Data) does not match destination (Default Web Site/virtual-dir//App_Data) differing in attributes (isDest['False','True'],setAclUser,setAclAccess). Update pending.
[9/02/2011 12:17:11 a.m.] Updating setAcl (Default Web Site/virtual-dir//App_Data).
[9/02/2011 12:17:11 a.m.] The dependency check 'DependencyCheckInUse' found no issues.
[9/02/2011 12:17:11 a.m.] The synchronization completed in 1 pass(es).
The cause of the slowness is the "Updating setAcl" component. I am examining the ACLs of the development box and server box to see what is different. However it seems like an extremely bad idea to copy the ACL from a dev box to a server box! I already had the ACL set up just fine on the server.
@JK from the info you provided it feels like a timeout issue. I agree with @TroyHunt 2500 files in 15 megs should delploy quickly. In particular the the output showing a delay while applying ACLs (whether or not they need to be changed). If it were me, I would start out doing some non-web deploy health checks. A few thoughts come to mind
dcdiag show ?netdiag show ?Is there a chance you are trying to apply users or groups that don't exist any more, are disabled , or come from domains other than the web server domain? It's possible your organization has a domain hierarchy with child domains or domain trusts, that are valid, but communication is blocked in the production data center.
I think i would also manually look at the ACLs and see if there are entries that can't be resolved (they show up as SIDS before resolution).
HTH, -eric
If you have control over the server a really good option is to manually upload the zip. Unzip it and then use IIS manager to point to the new codebase. This way the downtime should be minimal. And if something goes wrong you have your last version intact and can just point IIS to that folder again.
On a shared host this won't work as well though. Maybe there is some way to adapt the same strategy by uploading the code and then rename folders to make it point to the new files.
Anyway it seems like web deploy should support sending only changed content. But I think you host need to support Web deploy in that case: http://www.troyhunt.com/2010/11/you-deploying-it-wrong-teamcity_24.html
If you don't have that I guess you could use a script to detect modifications in SVN. Here are some information about how to find changed files: http://blog.lysender.com/2010/11/svn-list-modified-files-between-revisions/ You would have to remember that codefiles are compiled into dll files so I would imagine something like this:
Some other options you could consider:
1) Deploy to a fresh directory each time and then switch between directories using IIS.
2) Use a separate Subversion repository for your binaries. svn-load-dirs.pl can load the binaries in to subversion and can correctly mark files that have been added, removed or changed. You can run svn load-dirs on the end of your automated build process. The build process is the only 'user' checking into this repository and the production server is the only place checking it out so there are no versioning conflicts.
To deploy you simply svn update the working directory from the binary subversion repository. It efficiently copies down just the changed files in an atomic fashion (i.e. if the download fails it doesn't replace any files). If you find a problem right after deployment you can quickly go back to the previous version. If you want to update a single aspx file you can do a targeted svn update on that single file.
If you have TortoiseSVN installed on the server you can also see immediately if anyone has changed any files on the server without going through the correct build->checkin->deploy path.
The only caveat is that subversion doesn't handle binary diffs so your repository will grow rapidly, but you can simply wipe it and start again occasionally if that ever becomes a problem.
Another plus is that you have a complete record of every version you've ever deployed.
I've used this technique for several projects and wish all deployment systems worked more like it: i.e. atomic update, easy to roll back, targeted single file update, complete version history, ...
I'd start by trying to isolate where the timeout is happening. You've mentioned a 15MB zip with 2,500 files which doesn't strike me as particularly large. Have you tried creating a deployment package in Visual Studio then running it directly on the server? This will take network latency out of the picture which is a pretty fundamental variable when it comes to timeouts.
As for why a zip with the entire application needs to be uploaded, you need to remember the actual identification of what has changed and subsequent deployment into IIS all happens on the server. It's not Visual Studio or msdeploy on your local machine calling the shots on this.
As for why you don't just manually copy the changed files over, it's summarised in my blog post you've referenced but in short, it's laborious and error prone. It means you need to consciously work through the thought process of "which of my 2,500 files just changed" rather than simply saying "make my target site match my development version". You haven't mentioned if you're publishing the web.config or not but obviously config transforms is another important reason why the simple CTRL-C then CTRL-V approach is cumbersome.
Trying to just take a change directly from SVN is also risky. Your first problem is you need to have complete confidence in the integrity and accuracy of the revision you're updating from if you're to get the appropriate changes published. You're then left with trying to sync these to the target and you're back at the same issues raised in the previous paragraph. The other big problem is versioning object code is always nasty; you'll be in a perpetual state of conflict with anyone else on the project and VCS is simply not intended to function this way.
My advice would be to focus on solving the root cause of the problem - Web Deploy is timing out - rather than simply trying to work around the symptoms. Manually publishing changes only or messing around with IIS bindings is only going to create more trouble for you in the long run and a lot more work in the immediate term. See how you go sharing the results of creating a package, copying it to the server then executing it locally and we'll take it from there. Once you have it working as designed, you should be seeing deployments no more than a few minutes and site outage measured in seconds.
BTW - You might also like to add what sort of latency you have between your PC and the server and how long it would normally take to transfer a 15MB file over HTTP.
Here's how I'm doing the publish:
Result->Users get 0 seconds downtime.
If you want to cut some corners. You can do a git pull directly on the production site. Result->1 2 seconds downtime for users
If you really really want to cut some corners. You can install the dropbox folder directly into your production folder and dropbox will sync everything. Result 5 6 or more seconds downtime for users.
On the build/dev box, use command-line MSBuild to build the project's SLN (or wdproj). Make sure to precompile everything. Use a separate output path that you clean before the build. Get the results zipped up, and transfer that to the web server out-of-band (via UNC path or FTP server, or whatever). On the server, unzip and do a xcopy deploy.
To minimize transfer time, use rsync (there are versions for Windows), or use 7-zip with maximum settings to zip binaries.
Server downtime is minimized since it would be only copying from local disk to local disk. Even though it's fast, the IIS app pool will recycle, to make up for that you'll need two machines behind a load balancer, so that you can update one while the other serves requests. (Maybe overkill, investigate using IIS's web-gardens)
To automate the process, use Powershell, or maybe even simpler, with batch files and PSExec for running remote commands.
The fact that you are deploying from VS and not from a build/continuous integration server is the problem here.
Why not use Dropbox?! Seriously....
WARNING: THIS HASN'T BEEN TESTED BY ME, JUST AN HYPOTHETICAL ANSWER
Solution 1: In a non-professional way, I would install Dropbox on all servers including the staging server. And just web deploy from Visual studio to the staging.
Dropbox syncs files very quickly especially when you enable "Network downloading" where files get downloaded from local servers instead from dropbox!
Solution 2: Create deployment package from Visual Studio and save it to a local folder that syncs with dropbox. Then create a scheduled task that auto-runs deploy.cmd and clears the content of the deployment folder once done to avoid re-deploying over and over.
Problems with using Dropbox
I was working around with C# and noticed that when I had a very large integer and attempted to make it larger. Rather that throwing some type of overflow error, it simply set the number to the lowest possible value (-2,147,483,648) I believe.
I was wondering if there was a way to enable the overflow checking in Visual Studio?
You can use the following steps to enable Arithmetic Overflow/Underflow checking in Visual Studio :
- Right click on your project in the Solution Explorer and select Properties.
- On the Build tab, click the Advanced button. (It's towards the bottom)
- Check the "Check for arithmetic overflow / underflow" check-box.
This will throw a System.OverflowException when the overflow occurs rather than it's usual operation of changing the value to a minimum value.
Without Arithmetic Overflow/Underflow enabled:
int test = int.MaxValue;
test++;
//Test should now be equal to -2,147,483,648 (int.MinValue)
With Arithmetic Overflow/Underflow enabled:
int test = int.MaxValue;
test++;
//System.OverflowException thrown
Using a checked block:
checked
{
int test = int.MaxValue;
test++;
//System.OverflowException thrown
}
The documentation for checked is available here. (Thanks to Sasha for reminding me about it.)
I'm currently trying to configure Visual Studio to automatically set up the appropriate configurations for 32-bit and 64-bit compilation.
Ideally, I'd like to be able to have Visual Studio automatically show x64 as a platform under the Configuration Manager.
How can I configure VS so any new project I create has this?
Thanks!
Visual Studio 2010 and 2008 both provide a way to do this.
Project Templates are used by VS to create new projects. These templates can be copied and updated as alternate versions or the originals can even modified in place. You can either use the VS editor to modify the Project Template or you can do it manually; it's your choice:
To use the Visual Studio editor:
File -> Export TemplateTo dig into the Project Template files yourself:
Project Template files are stored here: C:\Program Files (x86)\Microsoft Visual Studio 10.0\Common7\IDE\ProjectTemplates
An example is the Windows Forms Application project template, which is housed in this ZIP file: C:\Program Files (x86)\Microsoft Visual Studio 10.0\Common7\IDE\ProjectTemplates\CSharp\Windows\1033\WindowsApplication.zip
The ZIP file contains a handful of files that form the structure of the project (ie: form1.cs) and contain templatized versions of what you get when you create a project of this type.
The important file you'll want to modify is: windowsapplication.csproj. The name of the file will be different for each template, but the .csproj will remain consistent. It is the templatized project file, so modifying this will modify the project settings for all future projects made from this template.
To modify it, simply extract it from the ZIP, make your changes, then put it back into the ZIP file, overwriting the existing one.
In all cases, the result will be:
Now, when you create a new project of that type in the future, just pick YOUR template instead of the default one and you'll have x64 as a Configuration. You can even share the configuration with your friends since it's stored as a ZIP file.
This MSDN page documents the steps needed for 2010. Click "Other Versions" at the top of that page to see the instructions for VS 2008:
http://msdn.microsoft.com/en-us/library/ms185319(v=VS.100).aspx
Is there a way to save (and later revert to) a given window layout in VS2010?
Yes, you can use the "Import and Export Settings Wizard" (found in the Tools menu) to export only the settings that relate to your current window layout to a file. Uncheck everything but "General Settings" > "Window Layouts", and save the file somewhere you'll be able to find it later.
Then, you can use the "Import and Export Settings Wizard" again to import that settings file, restoring all of your tool windows to their previous layout. (Note that the wizard also allows you to limit what you import from a particular settings file the same way you can limit what you export.)
I use this on my laptop, where switching back and forth between single and multiple monitor setups turns window management into a real pain. I just maintain settings files that describe each of the layouts I use most frequently, and import the one that best fits my current working environment when I need it.
There's a nice Visual Studio plugin that lets you save and load custom window layouts: http://perspectives.codeplex.com (you can also find it in the VS gallery).
I use it because I often have to switch between a three screens layout(when my laptop is docket) and a single screen layout (laptop display only).
It's also useful because VS randomly forgets my custom layout after debugging.
Cody nailed it. I have a blog post here that shows how to do what he describes: http://blogs.msdn.com/b/zainnab/archive/2010/11/05/the-resetsettings-switch-vstipenv0047.aspx
I installed Visual Studio 2010 SP1 the other day and now when i try to "publish" my apps i get this error on ALL of my projects.
The target "_CopyBinDeployableAssemblies" does not exist in the project.
I have no idea what the problem is here and i find nothing on the all mighty Google and that makes me a bit nervous.
Can anyone point me in the right direction here or maybe somebody else has the same problem? Because it happens in all of my projects so i'm kind of amazed im alone with this problem.
The sites are ASP.NET Web Applications, some of them are mixed Web forms/MVC but one is only Webforms. 1 site is super mega simple with almost no references and i still get the error.
I also experienced this problem after installing Visual Studio 2010 SP1 Beta.
The missing target _CopyBinDeployableAssemblies is defined in:
$(MSBuildExtensionsPath)\Microsoft\VisualStudio\v10.0\WebApplications\Microsoft.WebApplication.targets
I solved the problem by adding an <Import> element to the broken project files.
So if you have a depdendency on the above targets, which you can find out by looking for the following <Import> in your project files:
<Import Project="$(MSBuildExtensionsPath)\Microsoft\VisualStudio\v10.0\Web\Microsoft.Web.Publishing.targets" />
You need to also import:
<Import Project="$(MSBuildExtensionsPath)\Microsoft\VisualStudio\v10.0\WebApplications\Microsoft.WebApplication.targets" />
From joao-angelo's blog post
<Target Name="Noop"></Target>
<PropertyGroup>
<CollectFilesFrom_binDeployableAssembliesDependsOn>
Noop
</CollectFilesFrom_binDeployableAssembliesDependsOn>
</PropertyGroup>
before importing
<Import Project="$(MSBuildExtensionsPath)\Microsoft\VisualStudio\v10.0\Web\Microsoft.Web.Publishing.targets" />
That works for me using ClickOnce on VS2010 SP1 using App.config transform
Well, spent 4h on this today and i solved it now. But unfortunately i do not have a definite answer what the problem was. Buit i will describe what i did.
And well, i don't blame MS for this at all. I knew it where a beta but i never had issues like this before.
Hope this solves the problem for somebody else.
The answer given above by Ragge was what I needed. But in my case, I only added the second line. The first line Ragge gave was already in the project file.
<Import Project="$(MSBuildExtensionsPath)\Microsoft\VisualStudio\v10.0\WebApplications\Microsoft.WebApplication.targets" />
I have a huge Visual Studio 2010 solution. I work with Visual Studio 2005, so I want to convert the solution to the desired version. Basically, it's a portable C++ code so it should compile on Visual Studio 2005 too. Changing the version in the *.sln file doesn't help because the *.vcxproj format is completely different from the old *.vcproj format.
Recreating the solution by hand is not an option because of its size. Also there may be some non-default compiler flags, dependencies, etc. that I don't know of (and I can't look through ALL this XML junk that I don't understand).
There is already a related question on How Do I Downgrade a C++ Visual Studio 2008 Project to 2005. However, the utility suggested there supports at most Visual Studio 2008.
Any suggestions?
In my work made a utility which utilized the EnvDTE.dll and scanned a vcproj-file and optionally all vcproj-files within a sln-file. It compared all settings with a "template" and would issue a warning or optionally update the setting to correct values. We used this utility so that settings would be verified to be correct and consistent throughout all projects. I haven't updated the utility to 2010 yet due to other priorities.
EnvDTE hasn't changed much from Visual Studio 2008 to Visual Studio 2010. Perhaps it is possible to create a simple utility which opens the vcxproj-file using DTE100 and saves it using DTE90, or earlier.
Easiest way is probably to create a new project in VS 2005, and use the add existing item dialog to add the code to the project. I'd suggest using 'Empty Project' as the project type, so you don't have a lot of rubbish autogenerated for you that you'll just delete anyway.
I haven't tried it, but this looks promising:
http://www.emmet-gray.com/Articles/ProjectConverter.htm
edit: Nope, not promising, sorry :-(
When you subscribe to an event in code, Visual Studio automatically completes the code after += and generates the appropriate event handler:
button.Click += new EventHandler(button_Click);
// ?_____auto generated code_____?
Notice how it explicitly creates the delegate instance: even though method groups are implicitly convertible to delegates since C# 2, the IDE behavior still hasn't changed in VS2010.
So I'd like to know, is there a way to generate code like this instead?
button.Click += button_Click;
EDIT
just to make things clear to everyone: the code above is not in a designer file (I wouldn't care which syntax is used if it was the case). It's the snippet that is triggered when you type += after an event name and press TAB
EDIT2
I reported this as a suggestion on Connect, you can vote for it if you also want the current behavior to be changed
Thanks for clarifying your question. Unfortunately, there isn't a way to configure or customize the event hookup code that is generated by the C# language service. To make matters worse, the Generate Method Stub feature won't work on an event hookup either -- though it should, and that is already fixed for the next release of Visual Studio.
Sorry that there isn't a better story for this particular feature. :-(
The suggestion on Connect has been marked as fixed, so the new behavior should be included in the next public build of VS11.
I would like to configure Visual Studio to open Beyond Compare by default as the diff tool. How can I do this?
Using Beyond Compare with Version Control Systems
In Visual Studio, go to the Tools menu, select Options, expand Source Control, and click on the Configure User Tools button.
Click the Add button.
Enter/select the following options for Compare:
Enter/select the following options for Merge:
Here is an article detailing how to do this, very handy reference:
http://whyiamright.wordpress.com/2008/01/18/changing-the-diffmerge-program-used-by-visual-studio/
I've been using Visual Studio for a number of years now and obviously find intellisense very useful.
However I've always been "guessing" at what the little icons actually mean such as this icon obviously means a property:
I would like to know if there is any reference manuals out there to explain all of the different icons?
They're called Babel Icons, and there's a method to the madness.
There are various different sets of icons, each with six variations. Those variations correspond to the access concepts of public, internal, friend, protected, private, and shortcut.
A mostly complete list of the icons themselves (with their proper names!) is also available in your Visual Studio Image Library folder. For example, in VS 2010:
\Program Files\Microsoft Visual Studio 10.0\Common7\VS2010ImageLibrary\Objects\bmp_format\Office and VS
and they're all the icons that begin with the VS_ prefix.
A complete list is here.
EDIT: Scratch that. These are from 2004.
MSDN has some documentation about those icons here. The icons (and hence the documentation) is aimed at people who are developing their own language parsers for Visual Studio and need the icons for intellisense.
Older so might not have every one but a good start...
VS 2010 icon key: http://msdn.microsoft.com/en-us/library/y47ychfe(v=VS.100).aspx
I my project I'm using some 3rd party librarys. I include them using the references folder in the Visual Studio.
But where should i save the dlls files? They are referenced from a path in the file system, but itwould be nice if I can include it into the project. But how?
How the quesiton is more or less clear ;)
This is what I do:
You can also add solution folder and add them there.
Typically, the structure of my projects looks like this (at a minimum):
projectname
- trunk
- src
- lib
- support
- docs
- releases
The trunk folder contains the copy of the source that I am working on right now. Also, there's a directory 'lib', which contains all the 3rd party assemblies that are referenced by my project.
(I reference the assemblies at that position).
The 'releases' folder contains branches of the trunk. For instance, whe v1 is released, a branch is taken of the trunk so that I have a copy of the sourcecode and all its dependencies that is necessary to build version 1 of the application. (This is handy for bugfixes. Fix the bug in that branch, merge the fix to the trunk, rebuild that branch and you have a fixed v1 of your application).
All these things go into sourcecontrol. (Yes, the referenced assemblies as well). By doing so, it is very easy if another collegue has to work on the project as well. He just gets the latest version from source-control, and he (or she) has everyting in place in order to be able to compile / build).
(Note that this is also true if you use something like CruiseControl for continuous integration).
In the properties window of Visual Studio for the reference to the dll, there is a Property called 'Copy Local' - set this to true, and they'll be copied to your local project's bin directory
Do have a look at Tree Surgeon - Creates a development tree for a .NET project, which can be a good starting point and from there you can improvise.
You should look at nuget. It's a package management extension for VS2010 designed exactly for what you want.
Personally, I have a folder in my source control for 3rd party DLLs (with a folder for each company, organisation) and reference them from there.
These files are then available for all developers who download the source and can be updated easily.
To answer this properly you need to differentiate between the environment and working set.
Environment:
Working Set:
You need to decide into which category your component fits.
Summary:
memcpy seems unable to transfer over 2GB/sec on my system in a real or test application. What can I do to get faster memory-to-memory copies?
Full details:
As part of a data capture application (using some specialized hardware), I need to copy about 3 GB/sec from temporary buffers into main memory. To acquire data, I provide the hardware driver with a series of buffers (2MB each). The hardware DMAs data to each buffer, and then notifies my program when each buffer is full. My program empties the buffer (memcpy to another, larger block of RAM), and reposts the processed buffer to the card to be filled again. I am having issues with memcpy moving the data fast enough. It seems that the memory-to-memory copy should be fast enough to support 3GB/sec on the hardware that I am running on. Lavalys EVEREST gives me a 9337MB/sec memory copy benchmark result, but I can't get anywhere near those speeds with memcpy, even in a simple test program.
I have isolated the performance issue by adding/removing the memcpy call inside the buffer processing code. Without the memcpy, I can run full data rate- about 3GB/sec. With the memcpy enabled, I am limited to about 550Mb/sec (using current compiler).
In order to benchmark memcpy on my system, I've written a separate test program that just calls memcpy on some blocks of data. (I've posted the code below) I've run this both in the compiler/IDE that I'm using (National Instruments CVI) as well as Visual Studio 2010. While I'm not currently using Visual Studio, I am willing to make the switch if it will yield the necessary performance. However, before blindly moving over, I wanted to make sure that it would solve my memcpy performance problems.
Visual C++ 2010: 1900 MB/sec
NI CVI 2009: 550 MB/sec
While I am not surprised that CVI is significantly slower than Visual Studio, I am surprised that the memcpy performance is this low. While I'm not sure if this is directly comparable, this is much lower than the EVEREST benchmark bandwidth. While I don't need quite that level of performance, a minimum of 3GB/sec is necessary. Surely the standard library implementation can't be this much worse than whatever EVEREST is using!
What, if anything, can I do to make memcpy faster in this situation?
Hardware details: AMD Magny Cours- 4x octal core 128 GB DDR3 Windows Server 2003 Enterprise X64
Test program:
#include <windows.h>
#include <stdio.h>
const size_t NUM_ELEMENTS = 2*1024 * 1024;
const size_t ITERATIONS = 10000;
int main (int argc, char *argv[])
{
LARGE_INTEGER start, stop, frequency;
QueryPerformanceFrequency(&frequency);
unsigned short * src = (unsigned short *) malloc(sizeof(unsigned short) * NUM_ELEMENTS);
unsigned short * dest = (unsigned short *) malloc(sizeof(unsigned short) * NUM_ELEMENTS);
for(int ctr = 0; ctr < NUM_ELEMENTS; ctr++)
{
src[ctr] = rand();
}
QueryPerformanceCounter(&start);
for(int iter = 0; iter < ITERATIONS; iter++)
memcpy(dest, src, NUM_ELEMENTS * sizeof(unsigned short));
QueryPerformanceCounter(&stop);
__int64 duration = stop.QuadPart - start.QuadPart;
double duration_d = (double)duration / (double) frequency.QuadPart;
double bytes_sec = (ITERATIONS * (NUM_ELEMENTS/1024/1024) * sizeof(unsigned short)) / duration_d;
printf("Duration: %.5lfs for %d iterations, %.3lfMB/sec\n", duration_d, ITERATIONS, bytes_sec);
free(src);
free(dest);
getchar();
return 0;
}
EDIT: If you have an extra five minutes and want to contribute, can you run the above code on your machine and post your time as a comment?
I'm not sure if it's done in run time or if you have to do it compile time, but you should have SSE or similar extensions enabled as the vector unit often can write 128 bits to the memory compared to 64 bits for the CPU.
Try this implementation.
Yeah, and make sure that both the source and destination is aligned to 128 bits. If your source and destination are not aligned respective to each other your memcpy() will have to do some serious magic. :)
I have found a way to increase speed in this situation. I wrote a multi-threaded version of memcpy, splitting the area to be copied between threads. Here are some performance scaling numbers for a set block size, using the same timing code as found above. I had no idea that the performance, especially for this small size of block, would scale to this many threads. I suspect that this has something to do with the large number of memory controllers (16) on this machine.
Performance (10000x 4MB block memcpy):
1 thread : 1826 MB/sec
2 threads: 3118 MB/sec
3 threads: 4121 MB/sec
4 threads: 10020 MB/sec
5 threads: 12848 MB/sec
6 threads: 14340 MB/sec
8 threads: 17892 MB/sec
10 threads: 21781 MB/sec
12 threads: 25721 MB/sec
14 threads: 25318 MB/sec
16 threads: 19965 MB/sec
24 threads: 13158 MB/sec
32 threads: 12497 MB/sec
I don't understand the huge performance jump between 3 and 4 threads. What would cause a jump like this?
I've included the memcpy code that I wrote below for other that may run into this same issue. Please note that there is no error checking in this code- this may need to be added for your application.
#define NUM_CPY_THREADS 4
HANDLE hCopyThreads[NUM_CPY_THREADS] = {0};
HANDLE hCopyStartSemaphores[NUM_CPY_THREADS] = {0};
HANDLE hCopyStopSemaphores[NUM_CPY_THREADS] = {0};
typedef struct
{
int ct;
void * src, * dest;
size_t size;
} mt_cpy_t;
mt_cpy_t mtParamters[NUM_CPY_THREADS] = {0};
DWORD WINAPI thread_copy_proc(LPVOID param)
{
mt_cpy_t * p = (mt_cpy_t * ) param;
while(1)
{
WaitForSingleObject(hCopyStartSemaphores[p->ct], INFINITE);
memcpy(p->dest, p->src, p->size);
ReleaseSemaphore(hCopyStopSemaphores[p->ct], 1, NULL);
}
return 0;
}
int startCopyThreads()
{
for(int ctr = 0; ctr < NUM_CPY_THREADS; ctr++)
{
hCopyStartSemaphores[ctr] = CreateSemaphore(NULL, 0, 1, NULL);
hCopyStopSemaphores[ctr] = CreateSemaphore(NULL, 0, 1, NULL);
mtParamters[ctr].ct = ctr;
hCopyThreads[ctr] = CreateThread(0, 0, thread_copy_proc, &mtParamters[ctr], 0, NULL);
}
return 0;
}
void * mt_memcpy(void * dest, void * src, size_t bytes)
{
//set up parameters
for(int ctr = 0; ctr < NUM_CPY_THREADS; ctr++)
{
mtParamters[ctr].dest = (char *) dest + ctr * bytes / NUM_CPY_THREADS;
mtParamters[ctr].src = (char *) src + ctr * bytes / NUM_CPY_THREADS;
mtParamters[ctr].size = (ctr + 1) * bytes / NUM_CPY_THREADS - ctr * bytes / NUM_CPY_THREADS;
}
//release semaphores to start computation
for(int ctr = 0; ctr < NUM_CPY_THREADS; ctr++)
ReleaseSemaphore(hCopyStartSemaphores[ctr], 1, NULL);
//wait for all threads to finish
WaitForMultipleObjects(NUM_CPY_THREADS, hCopyStopSemaphores, TRUE, INFINITE);
return dest;
}
int stopCopyThreads()
{
for(int ctr = 0; ctr < NUM_CPY_THREADS; ctr++)
{
TerminateThread(hCopyThreads[ctr], 0);
CloseHandle(hCopyStartSemaphores[ctr]);
CloseHandle(hCopyStopSemaphores[ctr]);
}
return 0;
}
Perhaps you can explain some more about how you're processing the larger memory area?
Would it be possible within your application to simply pass ownership of the buffer, rather than copy it? This would eliminate the problem altogether.
Or are you using memcpy for more than just copying? Perhaps you're using the larger area of memory to build a sequential stream of data from what you've captured? Especially if you're processing one character at a time, you may be able to meet halfway. For example, it may be possible to adapt your processing code to accommodate for a stream represented as ?an array of buffers?, rather than ?a continuous memory area?.
First of all, you need to check that memory is aligned on 16 byte boundary, otherwise you get penalties. This is the most important thing.
If you don't need a standard-compliant solution, you could check if things improve by using some compiler specific extension such as memcpy64 (check with your compiler doc if there's something available). Fact is that memcpymust be able to deal with single byte copy, but moving 4 or 8 bytes at a time is much faster if you don't have this restriction.
Again, is it an option for you to write inline assembly code?
You can write a better implementation of memcpy using SSE2 registers. The version in VC2010 does this already. So the question is more, if you are handing it aligned memory.
Maybe you can do better then the version of VC 2010, but it does need some understanding, of how to do it.
PS: You can pass the buffer to the user mode program in an inverted call, to prevent the copy altogether.
You have a few barriers to obtaining the required memory performance:
Bandwidth - there is a limit to how quickly data can move from memory to the CPU and back again. According to this Wikipedia article, 266MHz DDR3 RAM has an upper limit of around 17GB/s. Now, with a memcpy you need to halve this to get your maximum transfer rate since the data is read and then written. From your benchmark results, it looks like you're not running the fastest possible RAM in your system. If you can afford it, upgrade the motherboard / RAM (and it won't be cheap, Overclockers in the UK currently have 3x4GB PC16000 at £400)
The OS - Windows is a preemptive multitasking OS so every so often your process will be suspended to allow other processes to have a look in and do stuff. This will clobber your caches and stall your transfer. In the worst case your entire process could be cached to disk!
The CPU - the data being moved has a long way to go: RAM -> L2 Cache -> L1 Cache -> CPU -> L1 -> L2 -> RAM. There may even be an L3 cache. If you want to involve the CPU you really want to be loading L2 whilst copying L1. Unfortunately, modern CPUs can run through an L1 cache block quicker than the time taken to load the L1. The CPU has a memory controller that helps a lot in these cases where your streaming data into the CPU sequentially but you're still going to have problems.
Of course, the faster way to do something is to not do it. Can the captured data be written anywhere in RAM or is the buffer used at a fixed location. If you can write it anywhere, then you don't need the memcpy at all. If it's fixed, could you process the data in place and use a double buffer type system? That is, start capturing data and when it's half full, start processing the first half of the data. When the buffer's full, start writing captured data to the start and process the second half. This requires that the algorithm can process the data faster than the capture card produces it. It also assumes that the data is discarded after processing. Effectively, this is a memcpy with a transformation as part of the copy process, so you've got:
load -> transform -> save
\--/ \--/
capture card RAM
buffer
instead of:
load -> save -> load -> transform -> save
\-----------/
memcpy from
capture card
buffer to RAM
Or get faster RAM!
EDIT: Another option is to process the data between the data source and the PC - could you put a DSP / FPGA in there at all? Custom hardware will always be faster than a general purpose CPU.
Another thought: It's been a while since I've done any high performance graphics stuff, but could you DMA the data into the graphics card and then DMA it out again? You could even take advantage of CUDA to do some of the processing. This would take the CPU out of the memory transfer loop altogether.
One thing to be aware of is that your process (and hence the performance of memcpy()) is impacted by the OS scheduling of tasks - it's hard to say how much of a factor this is in your timings, bu tit is difficult to control. The device DMA operation isn't subject to this, since it isn't running on the CPU once it's kicked off. Since your application is an actual real-time application though, you might want to experiment with Windows' process/thread priority settings if you haven't already. Just keep in mind that you have to be careful about this because it can have a really negative impact in other processes (and the user experience on the machine).
Another thing to keep in mind is that the OS memory virtualization might have an impact here - if the memory pages you're copying to aren't actually backed by physical RAM pages, the memcpy() operation will fault to the OS to get that physical backing in place. Your DMA pages are likely to be locked into physical memory (since they have to be for the DMA operation), so the source memory to memcpy() is likely not an issue in this regard. You might consider using the Win32 VirtualAlloc() API to ensure that your destination memory for the memcpy() is committed (I think VirtualAlloc() is the right API for this, but there might be a better one that I'm forgetting - it's been a while since I've had a need to do anything like this).
Finally, see if you can use the technique explained by Skizz to avoid the memcpy() altogether - that's your best bet if resources permit.
Could it be that your implementation of memcpy results in code with single-byte movb instructions, rather than movl? Using instructions working on wider data should increase the performance significantly.
I'm by no means an expert in this field, but as far as I'm concerned, memcpy() is indeed slowish.
You might want to write an alternative implementation of memcpy(). I've found this blog post that describes such an implementation: http://www.danielvik.com/2010/02/fast-memcpy-in-c.html
I don't exactly feel up to testing it myself, sorry, but I hope it's of use to you.
Have you checked if you have enabled MMX/SSE support in your project ?
memcpy now days have special code paths depending on the project configuration, if I remember correctly.
One source I would recommend you read is MPlayer's fast_memcpy function. Also consider the expected usage patterns, and note that modern cpus have special store instructions which let you inform the cpu whether or not you will need to read back the data you're writing. Using the instructions that indicate you won't be reading back the data (and thus it doesn't need to be cached) can be a huge win for large memcpy operations.
I own a software development company. We develop software for other companies who brand under their name/titles. And we also have a couple self branded titles in the Accounting/ERP market. Our accounting software is roughly 60% of our business and written in C++ Builder.
Those who know, realize C++ Builder has had a very rocky road in changing hands from Borland, to CodeGear, to Embarcadero and possibly a few times in between. C++ Builder has screwed us a number of times on our accounting software. The QuickReports was notoriously buggy, Their XML build description is not tightly coupled to the GUI causing builds to not work -- generally buggy interface.
Over the past 8 years we've steadily made in roads to remove our reliance on the VCL and buggy components however, some 3rd party VCL components are just not easily replaceable still. We use a GRID package from Developer Express - great product.
I'm just about at the cross roads and with the latest version of C++ Builder XE on the market I'm having a hard time justifying the price when you look at the crappy history of this product.
So I'm looking for advise or steps anyone else followed who might be in similar situation and successfully made the switch to Visual Studio.
We've slowly moved most of our application to wxWidgets except for the Developer Express tools. And we've written our own TSQL abstraction we can port as well.
Any thoughts or suggestions? Have you moved your project to Visual Studio or have you played around with the new Builder XE to find may of it's previous short cummings now gone?
Looking for been there, done that advise.
Moving to wxWidgets has its advantages one of them being that you will not be bound to an IDE like C++Builder or Visual Studio. C++ Builder has had several problems, its main strength being the VCL framework, which in my oppinion is still among the best GUI frameworks around for C++. The problem ofcourse being that it requires C++ Builder, which to put it mildly does have some problems with stability and compiler performance.
However Visual Studio is not the ultimate IDE, the latest version is at best buggy, and many of the RAD tools you're given by C++ Builder simply do not exist in Visual C++ (unless you are willing to go for the .net languages).
I can perfectly well understand your wish to make your code less dependant on C++ Builder, to tell you the truth I kind of doubt it will continue to be around for long myself. However from what it sounds like in your post, most of your development really relies on rapid developed applications, and in the C++ universe C++ Builder is one of the best tools around for this particular requirement.
Personally I never really thought of C++ as the best solution for Rapid Developed Windows GUI Applications, perhaps your focus shouldn't be on finding a different IDE, but on finding a more appropriate language, I would suggest Delphi, by using Delphi you will be able to compile you're existing c++ builder projects, and even reuse your existing VCL components.
Delphi will - I trust - be around for longer than C++ Builder, either in the form of Delphi, or in the form of Lazarus (IDE for freepascal) which is even cross platform and gives support for 64 bit development.
If however a change of language is not an option, I would stick with C++ Builder for now, but not upgrading to the XE version, which I simply do not think is justified by the price tag. (Given ofcourse you already work on a relatively new version).
Visual Studio is not really comparable to Builder C++.
Yes they are both C++ compilers but:
The differences in compilers probably won't hurt you too much for non VCL dependent code. I have a DLL that I compile for clients under VC6, VS2008 and Builder 2010/XE. I have had to toss in a few #ifdefs, but most of them are actually for VC6.
The biggest recommendation I can make is DO NOT MOVE TO MFC, thats where the pain starts.
Think about the training for developers as well. Your developers will become significantly slower at producing working code while learning the idiosyncrasies of a new compiler.
With all that said, when I was given a choice for a client between moving to VS2008/2010 or Builder C++ for a new product, I picked Builder, just for the RAD IDE.
Good Luck.
I'd suggest Visual Studio. Nope, I don't have that kind of experience, you're asking about, but Visual Studio is Visual Studio. All companies I know, that write on Windows, use Visual Studio. It's just great (:
Now I'm writing on Linux and what each of my colleagues need - is really nice C++ IDE for Linux. And there's no such. Even "Windows haters" (argh, sounds ugly .. ) admit Visual Studio (especially VS' debugger - just the best). It's not an accident. Don't really have any experience with C++ Builder, but with no any doubt, I'd recommend VS - it's very easy to use ( very user-friendly ), and in the same time - it's very, very powerful tool.
So, I vote for Visual Studio with both hands (:
Check this Stack OverFlow Question for more information - it's not a duplicate, but it contains pretty much information.
If you are sticking with C++ and expect the same kind of IDE in Visual Studio for C++ that RAD Studio provides you'll be shocked.
To be honest, C++Builder has never been a bad GUI development environment for C++. It's likely the best the has ever been for C++. Why? Because you can take advantage of all the great Delphi components.
There is no substitute for ExpressQuantumGrid? Suite for C++ in Visual Studio.
Most of the serious complaints about C++Builder have been often centred on it's compliance with standards like the the STL and Boost.
I don't think that Embarcadero will give up on supporting C++Builder. The issues have usually been with the way the Delphi guys (3rd party) have coded stuff. Honestly I only recall one release of DevExpress's stuff being an issue.
Short and sweet: if you want to use C++ and some sort of RAD/GUI thing stick with C++Builder.
What @casablanca said, but you should also consider very good alternatives, if you say that you're not satisfied with the programs you're using now:
One word of warning: the Visual Studio Debugger is regarded as "as good as it gets", but you pay for it. 1-4 above are all free, and highly acclaimed products.
This means that the release of Visual Studio 2010 creates a new question: Does it make sense to upgrade Visual Studio even if you're not upgrading to .NET 4? The answer is "yes," and for a lot of reasons. But if you're going to .NET 4 you'll find a lot of support in Visual Studio 2010.
As soon as you start Visual Studio 2010 you'll notice that the Start Page is now more useful than the File menu (see Figure 1). The Start Page still provides access to project templates, but the rest of the page now provides organized access to training resources for the major .NET technologies.
Once you open a file you'll find that, thanks to Windows Presentation Foundation (WPF), there's more visual feedback in the editing window. For instance, if you click on a variable name, all uses of that variable name are highlighted. This feature isn't limited to variables -- clicking on a method header automatically highlights all the return clauses and the end of the method. But this extra highlighting isn't without a downside. When debugging, for instance, I sometimes lost the current line because its highlighting was overridden by the highlighting added for the currently selected item. aztec tattoos
I hate to say this, but my own company is at this same cross-roads. We have been using C++Builder for many years (never upgraded beyond v6), and our management people have recently pulled the trigger to make the switch to Visual Studio moving forward :-( I do not think we will be porting our existing C++Builder apps to VC++ anytime soon, as that would be a major re-write, but our new products in the future will be in VC++/.NET now.
We are in a slow move to VS2008 and wxWidgets. For every component that can be purchased for C++ Builder (Developer Express, etc) our plans are to hire someone to build that one piece or hire the component maker to build a wxWidget component for us.
C++ Builder is the best way to program visually on windows at the moment though. However, no x64bit support and no mac, linux support. Supposedly they are going to build a crossx version... how long can we wait?
i know c# 3.5 is used with VS2008 and .net 3.5
also c#4 is part of VS2010 and .net 4.0
but what is c#5? what IDE?
At the recent PDC, Anders announced:
Anders specifically did not announce:
For more information on the async feature in C#, check out the C# dev center or read my articles on the subject at
It's not released yet. Parts of it was presented at this year's PDC (professional developer conference). You can see Anders Hejlsberg's talk online where he explains the new async features that will end up in C# 5.0 when it is released (no dates yet)
I heard in an announcement that C# 5 comes from Microsoft in Beijing.
At the moment I can't find information about .NET 5 or in which IDE it will be released.
More info can be found on the MSDN Forums.
I have the following convention for most of my projects:
/src
/Solution.sln
/SolutionFolder
/Project1
/Project2
/etc..
/lib
/Moq
moq.dll
license.txt
/Yui-Compressor
yui.compressor.dll
/tools
/ILMerge
ilmerge.exe
You'll notice that I do not keep external libraries inside the source folder. I'm also very interested in using NuGet but don't want these external libraries inside the source folder. Does NuGet have a setting to change the directory that all packages are loaded into?
It's now possible to control which folder the packages are installed into.
http://nuget.codeplex.com/workitem/215
Edit: See Phil Haack's comment on Dec 10 2010 at 11:45 PM (in the work item/the link above). The support is partially implemented in 1.0, but is not documented.
According to @dfowler: Add a nuget.config file next to the solution with this:
<settings>
<repositoryPath>{some path here}</repositoryPath>
</settings>
I have used Visual Studio Professional 2008, and have been testing the free C# Express 2010 version recently. In general I'm amazed at how good it is for free, and how many of the full VS features it has. I'm thinking of using it for a commercial program and I know the license allows for that, it's just the description of it being for "non-professional developers like hobbyists, students and novice developers" concerns me a bit.
What I'm interested in knowing is what is stopping it being 'professional', that is:
I've searched for similar questions and found lists of differences between the full VS and express versions, but I'm more interested in knowing peoples personal experiences with it. It seems like many of the extra features in VS target developers working in large teams, so I'm mainly interested in hearing from either solo or small team developers where it seems like there's less compelling reasons to upgrade.
The limitations I've personally encountered are:
But the pluses seem to outweigh the minuses so far. Is there anything you found was a deal-breaker for you ?
Update: To come back to this a couple of months later, and after releasing a product built with the Express version, it is indeed possible to program professionally with the Express versions. The limitations within the program itself are pretty minor and can be worked around, but I've increasingly come to realise it's really the "extensions not supported" one that's the (only) major drawback. No Resharper, CodeRush or the like, and no source control, profiling, database explorer or unit testing and the like within VS itself. It's more of a productivity drag than a deal breaker, but it is annoying to come across a cool looking VS extension only to see that "Not supported in Express versions" notice.
If anyone else is in the same situation, I'd evaluate the extensions you use (or might be planning to use) first and see how important they are to you. Express is fine if you don't use any extensions or could live without them without a significant drop in productivity, otherwise stick with the Professional version.
I've used express for 5 years, it has everything you need to produce professional projects. There's one important feature that's missing, which is the extensible Database Explorer, e.g. if you need to generate an Entity Framework model from a MySQL database. But for that I use Visual Studio Shell (also free). For other stuff such as unit testing and source control I use other tools. You really don't need Visual Studio to have everything you need to manage a software project.
The biggest problem with the Express version is you don't have any source control. You can't professionally work without it, even if you are a lone freelancer. Keeping a change history on a project is vital when you mess something up and want to go to a previous version or simply want to compare different revisions.
Also I think in Express you can't have web and desktop applications in the same solution, or do other types of combination of projects. I'm not really sure about this one, because I don't use Express (for the first reason :))
No add-ins => No ReSharper => No dice.
Other answers have covert the fact that it can very well be enough, but if you are more than a hobbyists, students or novices, just get enrolled into the Microsoft BizSpark program.
You get all the tools for free (Visual Studio Ultimate, Team Foundation Server, All Windows Versions etc.) and you don't even need to be a company. Enrollment is super easy and uncomplicated.
The only requirements are (taken from the homepage):
- You develop software
- Privately held
- Less than 3 years in business
- < 1mio $ per year
This is not an ad. We have been very happy with the program and got access to everything we needed. Just wanted to let people know it existed.
Additional info:
I had been using VS Express for several years but I recently upgraded to VS Ultimate. There is nothing that you cannot do in Express, but the integration of features in the full product makes everything more convenient.
When you have source control, unit tests, performance/code analysis, installers all in the same solution, it saves a lot of time and hassle jumping between different programs. Also one big issue for me was not being able to mix features that are spread across the different Express editions, such as mixing ASP.NET with WinForms, or even VB.NET with C#.
I got a lot of use out of Express, it's a great product, but I was very happy the day I got to uninstall ten programs and replace them with one.
The pros:
The cons:
Professional is not the big step up here - Ultimate is. VS2010 Ultimate, for example, comes with bunches of profilers and that kind of thing. They give Professional away to any old student, for example.
There's only one plus: the cost. Every other difference is a minus (or at best reduces the cost of the minimum useful system). That means that, if the extra features are worth the money, buy the higher-end version.
The free lower-end version is great for (as they say) students, hobbyists, and novices. Students often don't have much money, and hobbyists and novices often don't want to spend all that much money on their hobbies and introductions.
However, a software professional is making money writing software, and presumably will make more money if he or she becomes more efficient. Assuming our professional is making decent money, the cost of an upper-end version of VS isn't large compared to revenues, and if it leads to even modest productivity increases it's worth it.
When you're doing something for money, don't try to do things too much on the cheap. Taking more time and inconvenience to do things will cost real money in that case, and avoiding it is worth real money.
Microsoft's marketing approach to these Express editions may be is to introduce Visual studio flavors to users (any user). Later, bring them on board with more powerful versions. Also, Express editions allows you to write code anywhere without getting worried about licensing part. You can use them to try out your test bed projects, community projects etc. I must re-iterate again that free licensing is the biggest draw towards Express editions
Thus far I've figured out out I needed to recompile the library as a .dll instead of a .lib, enable /clr and /EHa instead of /EHsc. Now I've got a managed dll which I've added as a reference in my C# project.
Now how do I use it?
I'm prepared to write some wrappers, but I don't know where to begin or how to "see" what functions I've gained access to. I've read a little bit about how the class names and functions might be mangled by the compiler... do I need to go back and add __declspec exports everywhere (if so, how?), or is there an option in VS2010 that says "don't mangle it!"?
The C++ library in question is still under active development, so I'm hoping I can modify the C++ library as little as possible and just recompile it periodically with a few switches, and then expose the new functionality as I need it.
If you are going to compile your C++ (if originally was unmanaged C++) you will need to do much more than just add the /clr switch. In order for C# to use the DLL you will need to create managed classes and other types based on CTS which are compatible with C# (.NET).
See and ref classes.
A good book to read about the subject (IMHO) is this one
You can either expose the functions as C style functions (i.e., no mangling) from your dll or you can expose them as COM objects.
I'd suggest writing a COM wrapper, and using that instead. Have a look at http://msdn.microsoft.com/en-us/library/035x3kbh%28v=VS.80%29.aspx for intro instructions. You'll want to make your object interfaces derived from IDispatch and be automation compatible, which should enable the runtime to consume them without any custom marshaling.
A nice benefit of this approach is you can continue to build your native code as a library, and just make your COM project use it. Also, it's still native code inside the COM object, so there's much less potential for unknown problems (once you get the interface layer working).
That's my suggestion, anyway.
Yes, wrap it in à COM object. I believe ATL is what you meed to do this with the least effort.
I have a Visual Studio 2010 project which references some third-party components. Their assemblies are accompanied by XML documentation files, which are useful for us (and only us) developers. And whenever the project is built (either in Debug or Release modes) these XML files are copied to the build directory.
I can't seem to find a setting or switch to disable the copy of those XML files to the build directory, either within Visual Studio or though MSBuild. A post-build script may be an option, but a smelly one. Any ideas? Thank you.
Visual studio project file has the same format as any msbuild file. So you can manually add the condition into corresponding section to not copy your xml files if configuration name is 'Release'.
It should be changing
<ItemGroup>
to
<ItemGroup Condition="'$(CONFIG)'=='RELEASE'">
or something like this.
What is the problem with having the XML files get copied into the folder on release builds? It seems to me that this is fine and that the real problem is with the code that picks up files to place them in the installer. Picking up third party dlls from your own bin\release folder is not a good practice in my opinion. I'd have my installer pick up third party dlls from their own folder in my source tree.
The setting is in the Properties of the project in question, under the "Build" tab, uncheck "XML documentation file". It's also an MSBuild property called <DocumentationFile> under the applicable <PropertyGroup> for your build configuration in the .*proj file.
If the .xml/.pdb are marked as build-action "Content" (etc), you can change them to "None". You should also ensure they copy-to-build-output is false.
Are both of those set?
I want to use the web.config transformation that works fine for publish also for debugging.
When i publish a web app, visual studio automatically transforms the web.config based on my currenc build configuration. How can i tell visual studio to do the same when i start debugging. On debug start it simply uses the default web.config without transformation.
Any idea?
Thanks
Cutter
OK, with the understanding that web.debug.config & web.release.config are for package/publish only. I have come up with a way in which to enable what you are trying to do. I've blogged about it at http://sedodream.com/2010/10/21/ASPNETWebProjectsWebdebugconfigWebreleaseconfig.aspx. Here is the summary.
Not let?s see how we can enable what the question asker wants to do. To recap, when he builds on a particular configuration he wants a specific transform to be applied to web.config. So obviously you do not want to maintain a web.config file, because it is going to be overwritten. So what we need to do is to create a new file web.template.config, which is just a copy of web.config. Then just delete web.config by using Windows Explorer (don?t delete using Visual Studio because we do not want to delete it from the project). Note: If you are using a source control provider which is integrated into Visual Studio then you probably want to delete web.config from source control. Also with this we do not want to use web.debug.config or web.release.config because these already have a well defined role in the Web Publishing Pipeline so we do not want to disturb that. So instead we will create two new files, in the same folder as the project and web.template.config, web.dev.debug.config and web.dev.release.config. The ideas is that these will be the transforms applied when you debug, or run, your application from Visual Studio. Now we need to hook into the build/package/publish process to get this all wired up. With Web Application Projects (WAP) there is an extensibility point that you can create a project file in the same folder with the name {ProjectName}.wpp.targets where {ProjectName} is the name of the project. If this file is on disk in the same folder as the WAP then it will automatically be imported into the project file. So I have created this file. And I have placed the following content:
<?xml version="1.0" encoding="utf-8"?>
<Project ToolsVersion="4.0" xmlns="http://schemas.microsoft.com/developer/msbuild/2003">
<!-- Make sure web.config will be there even for package/publish -->
<Target Name="CopyWebTemplateConfig" BeforeTargets="Build">
<Copy SourceFiles="web.template.config"
DestinationFiles="web.config"/>
</Target>
<PropertyGroup>
<PrepareForRunDependsOn>
$(PrepareForRunDependsOn);
UpdateWebConfigBeforeRun;
</PrepareForRunDependsOn>
</PropertyGroup>
<!-- This target will run right before you run your app in Visual Studio -->
<Target Name="UpdateWebConfigBeforeRun">
<Message Text="Configuration: $(Configuration): web.dev.$(Configuration).config"/>
<TransformXml Source="web.template.config"
Transform="web.dev.$(Configuration).config"
Destination="web.config" />
</Target>
<!-- Exclude the config template files from the created package -->
<Target Name="ExcludeCustomConfigTransformFiles" BeforeTargets="ExcludeFilesFromPackage">
<ItemGroup>
<ExcludeFromPackageFiles Include="web.template.config;web.dev.*.config"/>
</ItemGroup>
<Message Text="ExcludeFromPackageFiles: @(ExcludeFromPackageFiles)" Importance="high"/>
</Target>
</Project>
Let me explain this a bit. I have created the CopyWebTemplateConfig target which will always copy web.template.config to web.config on build, even if you are not debugging your application in Visual Studio. This is needed because we still need to support the package/publish process of Visual Studio. Then I extended the property PrepareForRunDependsOn to include the UpdateWebConfigBeforeRun target. This property is used to identify the list of targets which needs to be executed before any managed project is run from Visual Studio. In this target I am using the TransformXml task to transform web.template.config, using the correct web.dev.*.config file. After that your app starts up using the correct web.config based on your build configuration. After that I have another target ExcludeCustomConfigTransformsFiles, which I inject into the package/publish process via the attribute BeforeTargets=?ExcludeFilesFromPackage?. This is needed because we do not want these files to be included when the application is packaged or published. So that is really all there is to it. To explain the package/publish process a bit more for this scenario. When you package/publish web.debug.config or web.release.config, depending on build configuration, will still be used. But ultimately the file that it is transforming is web.template.config, so you may have to adjust depending on what you have in that file. Questions/Comments?
You could just use the 'default' web.config as your development/debugging version, and then the web.release.config would of course continue to be the release version, since its transforms are applied when you publish.
In your debug configuration, add a post-build step, and use it to replace/transform your web.config
Andrew is on the right path. When you are using this feature here is how it was designed to be used.
web.config This is the config file which developers should use locally. Ideally you should get this to be standardized. For instance you could use localhost for DB strings, and what not. You should strive for this to work on dev machines without changes.
web.debug.config This is the transform that is applied when you publish your application to the development staging environment. This would make changes to the web.config which are required for the target environment.
web.release.config This is the transform that is applied when you publish your application to the "production" environment. Obviously you'll have to be careful with passwords depending on your application/team.
The problem with transforming the web.config that you are currently running is that a transform can perform destructive actions to the web.config. For example it may delete a attributes, delete elements, etc.
Although I agree that the simplest approach is usually the best, I can easily imagine a circumstance where for some period of time you want to connect your IDE to a test database instead of your development database. Although you can specify the development connect strings in your default web.config file, it would be really nice to have a Web.Test.config file so that when you swap your build configuration to "Test", you would automatically get the new settings while still in your IDE.
The historical alternative is commenting out one set of connection strings for another, but these new config transforms held out the hope of finally putting a stake in the heart of that ugly practice. Although one default file for development and a transform for release may work much of the time, adding a post-build step to transform the web.config file is the more complete answer in my opinion.
-M
I have created a few different full programming languages using some of the various parsing tools available. However, how would someone create a programming language that runs the .Net framework? Would I have to output the .Net IL and compile that or is there a higher level of abstraction?
Also, is there an easy way to get the language working in Visual Studio?
There is a LOLCode compiler built in C# that might be a good starting point.
http://code.google.com/p/lolcode-dot-net/
As for implementing in Visual Studio, there is an open source view engine called Spark (http://www.sparkviewengine.com/) that did some work with getting intellisense to work. The context is different, but the lesson is the same, it's hard, and it's not a very well documented process.
You'll want to take a look at the Microsoft Research Common Compiler Infrastructure (CCI) project. It provides everything you need to generate the metadata and the MSIL for an assembly. And the debugging .pdb file, rather important to get your language going.
There's a sister project that might be useful as well, depends how far along you got.
Your compiler is responsible for converting the code it gets to ILCode. ILCode is the common language any and all .net languages compile to. This code gets interpreted by the JIT-Compiler at runtime. Of course, it can rely on the CodeDom classes in the framework to accomplish that, if you write the compiler in C# for example.
Your compiler could output either CIL assembly language, or an assembly (.dll / .exe) file.
Take a look at the CLI (Common Language Infrastructure) standard, which describes the CLI (the target platform), the CIL (assembly language), and the binary file format of assemblies.
By the way, the standard is also available as a book with annotations.
A great example for integrating your own language into Visual Studio is the Lua Language Support project.
Not sure if this is what you're looking for, but after I had a Question on SO i've created a .net Compiler for Brainf**k as an excersize (Part 6 contains the actual Compiler Source Code and is also on GitHub)
Essentially, the actual Compiler can be written in any .net Language and use the System.Reflection.Emit namespace to create assemblies, classes, methods etc. and emit IL into them.
The actual work of creating a new language obviously involves writing a parser/lexer/analyzer/whatever that can dissect your program into classes and "feed" your compiler - sorry, I have no experience in that, but check this list of resources on how to write a compiler.
You do want to read ECMA-335 to learn how the CLI works: What datatypes it supports and what commands it actually does.
I created a solution in Visual C# 2010 Express that contains two projects: one is the client, the other is the server. I would like to debug both at the same time, but I can only seem to run one of the projects during debugging.
Is there a way to run both at once?
Go to Solution properties -> Common properties -> Startup Project and select Multiple startup projects
You may find it easiest to just use two instances of Visual Studio. You could make a solution with just the server project in it, so that you can set the startup project separately for each solution
Max has the best solution for when you always want to start both projects, but you can also right click a project and choose Debug > Start New Instance.
This is an option when you only occasionally need to start the second project or when you need to delay the start of the second project (maybe the server needs to get up and running before the client tries to connect, or something).
Max nailed it. I have a post here that shows some screenshots for those interested: http://blogs.msdn.com/b/zainnab/archive/2010/05/10/multiple-startup-projects-vstipenv0015.aspx
I have a HTTPSystemDefinitions.cs file in C# project which basically describes the older windows ISAPI for consumption by managed code.
This includes the complete set of Structures relevant to the ISAPI not all or which are consumed by code. On compilation all the field members of these structures are causing a warning like the following:-
Warning Field 'UnionSquare.ISAPI.HTTP_FILTER_PREPROC_HEADERS.SetHeader' is never assigned to, and will always have its default value null
or
Warning The field 'UnionSquare.ISAPI.HTTP_FILTER_PREPROC_HEADERS.HttpStatus' is never used
Can these be disabled with #pragma warning disable? If so what would the corresponding error numbers be? If not is there anything else I can do? Bear in mind that I only what to do this for this file, its important that I get see warnings like these coming from other files.
Edit
Example struct:-
struct HTTP_FILTER_PREPROC_HEADERS
{
//
// For SF_NOTIFY_PREPROC_HEADERS, retrieves the specified header value.
// Header names should include the trailing ':'. The special values
// 'method', 'url' and 'version' can be used to retrieve the individual
// portions of the request line
//
internal GetHeaderDelegate GetHeader;
internal SetHeaderDelegate SetHeader;
internal AddHeaderDelegate AddHeader;
UInt32 HttpStatus; // New in 4.0, status for SEND_RESPONSE
UInt32 dwReserved; // New in 4.0
}
Yes, these can be suppressed.
Normally, I'm opposed to suppressing warnings, but in this case, structs used for interop absolutely requires some fields to be present, even though you never intend to (or can) use them, so in this case I think it should be justified.
Normally, to suppress those two warnings, you would fix the offending code. The first ("... is never used") is usually a code-smell of leftovers from earlier versions of the code. Perhaps code was deleted, but fields left behind.
The second is usually a code-smell for incorrectly used fields. For instance, you might incorrectly write the new value of a property back to the property itself, never writing to the backing field.
To suppress warnings for "Field XYZ is never used", you do this:
#pragma warning disable 0169
... field declaration
#pragma warning restore 0169
To suppress warnings for "Field XYZ is never assigned to, and will always have its default value XX", you do this:
#pragma warning disable 0649
... field declaration
#pragma warning restore 0649
To find such warning numbers yourself (ie. how did I know to use 0169 and 0649), you do this:
Copy the 4-digit warning code from the relevant message, which should look like this:
C:\Dev\VS.NET\ConsoleApplication19\ConsoleApplication19\Program.cs(10,28): warning CS0649: Field 'ConsoleApplication19.Program.dwReserved' is never assigned to, and will always have its default value 0
Caveat: As per the comment by @Jon Hanna, perhaps a few warnings is in order for this, for future finders of this question and answer.
#pragma warning disable XYZK, disables the warning for the rest of that file, or at least until a corresponding #pragma warning restore XYZK is found. Minimize the number of lines you disable these warnings on. The pattern above disables the warning for just one line.How can I fix this? It worked in Visual Studio 2008.
This still works, but was changed in VS 2010:
"With VS2010, we stopped supporting project dependencies defining implicit references and we also introduced a new way of defining project dependencies at the project level. Since a project reference and a project dependency are close concepts, both applying to a project, it made sense to have them represented together, in a consistent way, in the project file. As you will see in the snippets below, the only difference between a project reference definition and a project dependency definition consists in metadata that defines the output assembly inclusion/exclusion into/from the main project link command line. Although we did not remove the ?Project Dependencies? dialog, we recommend defining new project dependencies via the ?Framework and References? dialog. You need to set the ?Reference Assembly Output? property in the property page UI to false for a project dependency and to true for a project reference."
Just right-click on the console project, select "Properties->Common Properties->Framework and References->Add New Reference" and add the static library project; also check that "Link Library Dependencies" is True on the right hand side. Seems to work for debug and release builds. You learn something new every day. ;)
They changed the UI for adding C++ project dependencies in VS2010, but oddly enough, without removing the old UI, or in any way indicating that it no longer works.
To create the dependency in VS2010, you need to use "Add New Reference" (can be found in project properties), and maybe also in the project's right-click menu (don't have VS here to check)
The old "Project Dependencies" dialog is basically broken now.
I believe the old UI (dependencies) affects build order for Visual Studio, when building from within the IDE, for info. The new project configuration system embeds the references in each project file so that you can build from outside the IDE (whereas in previous versions, you could not, because you would not get automatic linking for dependencies, since dependencies were only done at the solution level).
There are also some issues with more complex projects in the new system; specifically, all resulting binary projects need to have explicit references to every dependent library to build correctly, whereas previously they could be effectively inherited from other dependent libraries. Same underlying cause, though.
Hope that helps.
Visual Studio Just-In-Time Debugger prompts to select "Possible Debuggers",
only "New instance of Microsoft Visual Studio 2010" is available,
I tick "Set the currently selected debugger as the default", click "Yes",
but, the dialog keeps being displayed every time.
I am debugging JavaScript in IE8 on Windows 7 x64.
How do I bypass this prompt?
These registry values do not solve the problem:
[HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\AeDebug]
"Auto"="1"
[HKLM\SOFTWARE\Wow6432Node\Microsoft\Windows NT\CurrentVersion\AeDebug]
"Auto"="1"
I actually just did this the other day.
In the following registry key:
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Messenger\Client]
Create 2 new DWORDs (Right-click --> New --> DWORD Value)
PreventAutoRun and PreventRun
Set both values to 1
Have you tried doing so directly from Visual Studio?
http://msdn.microsoft.com/en-us/library/5hs4b7a6.aspx
Scroll to "Enabling or disabling Just-In-Time debugging".
You can disable it only for Script if that's what you want.
Let me know how this works for you.
Is there any way to force the WPF designer to reload or refresh, without rebuilding the entire project or solution?
If there's an error, I get an option in the designer view to refresh the designer. But if I don't have an error, how can I get the designer to refresh after I've made a change?
The Visual Studio designer attempts to keep the rendered view in sync with the XAML. That's the advertised behavior.
As far as rebuilding your application goes, you don't need to do this as a habit. You only need to recompile it when the above conditions apply. Once they don't apply, you can just edit the XAML. Another way to say this is that if you haven't modified code, you shouldn't need to rebuild (modulo bugs).
At least in theory, the Design View is always in sync with the XAML, so no need to ever refresh it manually. May I ask under which circumstances would you want to reload it?
I'm not sure, but I think a build will refresh your view in that situation.
There is any event handled in that XAML file, then mostly it will not display the design preview from Visual Studio. If you want to see the design from Visual Studio, try with Command Binding instead of event, you will see the preview.
I'm not sure how this works in WPF editing, but with ASP.NET pages when the design view wont update i can do 2 things
Visual Studio keeps trying to indent the code inside namespaces.
For example:
namespace Test
{
void Testing();
void Testing()
{
}
}
Now, if I un-indent it manually then it stays that way. But unfortunately if I add something right before void Testing(); - such as a comment - VS will keep trying to indent it.
This is so annoying that basically because of this only reason I almost never use namespaces in C++. I can't understand why it tries to indent them (what's the point in indenting 1 or even 5 tabs the whole file?), or how to make it stop.
Is there a way to stop this behavior? A config option, an add-in, a registry setting, hell even a hack that modifies devenv.exe directly.
Just don't insert anything before the first line of code. You could try the following approach to insert a null line of code (it seems to work in VS2005):
namespace foo
{; // !<---
void Test();
}
This seems to suppress the indentation, but compilers may issue warnings and code reviewers/maintainers may be surprised! (And quite rightly, in the usual case!)
Probably not what you wanted to hear, but a lot of people work around this by using macros:
Sounds dumb, but you'd be surprised how many system headers use this. (glibc's stl implentation, for instance, has _GLIBCXX_BEGIN_NAMESPACE() for this.)
I actually prefer this way, because I always tend to cringe when I see un-indented lines following a {. That's just me though.
Here is a macro that could help you. It will remove indentation if it detects that you are currently creating a namespace. It is not perfect but seems to work so far.
Public Sub aftekeypress(ByVal key As String, ByVal sel As TextSelection, ByVal completion As Boolean) _
Handles TextDocumentKeyPressEvents.AfterKeyPress
If (Not completion And key = vbCr) Then
'Only perform this if we are using smart indent
If DTE.Properties("TextEditor", "C/C++").Item("IndentStyle").Value = 2 Then
Dim textDocument As TextDocument = DTE.ActiveDocument.Object("TextDocument")
Dim startPoint As EditPoint = sel.ActivePoint.CreateEditPoint()
Dim matchPoint As EditPoint = sel.ActivePoint.CreateEditPoint()
Dim findOptions As Integer = vsFindOptions.vsFindOptionsMatchCase + vsFindOptions.vsFindOptionsMatchWholeWord + vsFindOptions.vsFindOptionsBackwards
If startPoint.FindPattern("namespace", findOptions, matchPoint) Then
Dim lines = matchPoint.GetLines(matchPoint.Line, sel.ActivePoint.Line)
' Make sure we are still in the namespace {} but nothing has been typed
If System.Text.RegularExpressions.Regex.IsMatch(lines, "^[\s]*(namespace[\s\w]+)?[\s\{]+$") Then
sel.Unindent()
End If
End If
End If
End If
End Sub
Since it is running all the time, you need to make sure you are installing the macro inside in your EnvironmentEvents project item inside MyMacros. You can only access this module in the Macro Explorer (Tools->Macros->Macro Explorer).
One note, it does not currently support "packed" namespaces such as
namespace A { namespace B {
...
}
}
EDIT
To support "packed" namespaces such as the example above and/or support comments after the namespace, such as namespace A { /* Example */, you can try to use the following line instead:
If System.Text.RegularExpressions.Regex.IsMatch(lines, "^[\s]*(namespace.+)?[\s\{]+$") Then
I haven't had the chance to test it a lot yet, but it seems to be working.
I understand the problem when there are nested namespaces. I used to pack all the namespaces in a single line to avoid the multiple indentation. It will leave one level, but that's not as bad as many levels. It's been so long since I have used VS that I hardly remember those days.
namespace outer { namespace middle { namespace inner {
void Test();
.....
}}}
I'm trying to learn how to write Windows GUI* programs in C++, using Visual Studio 2008, but I haven't found any more comprehensive tutorial for beginners.
The more comprehensive tutorials I have found are either only about how to make buttons, menus, etc. OR only about how to write basic C++ console programs.
What I haven't found is a more comprehensive tutorial for beginners on how to combine buttons, menus, etc. with C++ code.
In other words, I'm looking for answers to the question: How do I link menus, buttons etc. to C++ code?
If you know where I can find answers to that question, post them here, please!
Note: "Graphical User Interface (GUI): Includes such things as icons, panels, and interactive windows, to enable users to perform such actions as opening files and creating applications with the click of the mouse" (intoweb.co.za/et-linux-tips.html).
I'm currently reading a C# tutorial at techotopia.com, that seems to include not only C# basics but also useful information on how to use C# to get buttons, menus. etc. to actually do something. I only started reading the tutorial, though, so how useful it actually is I don't know yet.
I've now finished reading the C# tutorial at techotopia.com and learned some basic facts about how to actually make controls on a windows form do something. Had I known what I now know about C# earlier, I most likely would have chosen to learn that language before I started learning C++.
It's beyond me why each and every C++ GUI programs tutorial for beginners aren't written in the same style as the tutorials at techotopia.com. I see no reason why C++ GUI programs tutorials for beginners can't be both crammed with basic facts AND explain even the simplest things to people like me, that need such explanations to understand a new subject. Well, there probably are such tuturials, only I haven't found them.
Now is the time, I think, to make a short list of what steps I have taken to get where I am today when it comes to computer skills in general and ability to write computer programs in particular. I'm posting the list here for the benefit of people who wants to become good at writing computer programs but don't know how to reach that goal or have mislead themselves, as I have time and time again. It's not a final list in any way. It's just a short account of what have worked for me.
Step 1. Use lots of computer programs (word processors, image editors and what else you're interested in) to see what can be done with a computer.
Step 2. Write web pages with HTML and CSS. HTML, Hypertext Markupup Language, are used to tell browsers things like the beginning and end of paragraphs, the structure of tables and where to include images. CSS, Cascading Style Sheets, are used to add things like text-size and background-color to web pages.
Step 3. Improve your web pages with PHP. PHP, Hypertext Preprocessor, reminds of C# and C++ and is a server-side scripting language. Server-side means that something is done to a web page before it is sent to a visitor's browser, like adding code that makes it possible to send a message. PHP is easier for a beginner than C# and C++. Also, if you have written some HTML pages, you can gradually add PHP to these pages. In other words, you can learn how to use PHP in a familiar context.
Step 4. Learn C#. Reminds of PHP and C++. More difficult for a beginner than PHP but easier than C++. This is where I am right now. These links may be of at least some use:
Step 5. Learn C++. Reminds of PHP and C#. More difficult for a beginner than PHP and C#. Allows the programmer to control more than C#. Some people say it's faster than C#, while other people don't. This is where I hopefully will be within a year or so.
Since there are as many roads as there are budding programmers, these steps may not be right for you. Hopefully, though, the list above is of at least some assistence to you when you decide what steps to take to reach your goal.
If you know more about programming than I do and disagree with the list above, feel free to provide your own list. If you do, I think you should also explain why you think your list is better.
Charles Petzold wrote a book on that.
I haven't read it, but his Win32 UI book is widely known as hilarious, so it is expected to be good for beginners.
As you can probably already tell from other answers and comments, the term "Windows Forms" is the name for a specific .NET technology.
You seem to want to ask a question more along line of how to learn to write Windows programs that have a GUI (menus, buttons, windows, etc).
There is no single way to write a Windows program. C++ itself doesn't know anything about Windows. Instead you will end up using some API or framework. So what you need to do is choose which particular one you want to use and then learn that.
So you probably need to do a little investigation to determine what technology you actually want to learn and use. Then you can go searching for appropriate tutorials.
Anybody else's VS2010 is extremely slow when closing code editor tabs?
Opening a .cs file is instantaneous but closing a tab takes ~8 seconds. I have uninstalled Power Commands and the Productivity Power Tools, the only other installed extensions are ReSharper (disabling it did not help) and the Color Theme Editor. I do have the UI Automation Performance Fix installed.
I tried most suggestions from Visual Studio Optimizations question; made sure the settings are saved locally; disabled the outlining mode; disabled the Anti-Virus -- nothing helps.
Googling only finds generic "VS2010 is a pig" complaints back from the Beta1 times. I even tried installing a few recent hot-fixes from https://connect.microsoft.com/VisualStudio/Downloads (KB2201993, KB2123002, KB2106584, KB981107, B2268081) but nothing seems to help.
Any ideas anybody?
--UPDATE---
Another clue: it only seems to happen for some solutions but not for others! Why would it be solution-specific?!!
Deleting .suo file helped!
Similar case was reported here but it involved a huge .suo file while mine was <1Mb
Another mention of similar problem can be found here in their case it was the debugger that was impacted.
Thanks to Sysinternals ProcessMonitor for the clue!
After half a year suffering, I just discovered that adding the project's folder to Security Essentials' excluded files & folders list clears this problem for me. Removing the exclusion brings the problem back.
I know you already tried disabling antivirus, but I wanted to post what worked for me. We're inflicted with Symantec Endpoint Protection where I work and I fixed the problem by excluding the solution's folder(s) from auto-protect. Closing file tabs in VS2010 used to take several seconds, now it's nearly instantaneous.
Here's how: Under your Symantec's Antivirus and Antispyware Protection -> Options -> Change Settings -> (tab) File System Auto-Protect -> Centralized Exceptions -> Add...[your folder(s)].
I was having this same issue. used procmon to find that visual studio was slamming my solution's .suo file. I deleted that file and immediately my file closings are immediate. no more 60 second closing all files!!! Man, MS needs to fix that problem, It's very bad.
I would like to study C# but I'm intimidated by Visual Studio's price tag. Any free/opensource alternatives? Thanks.
Visual Studio Express is Microsoft's free version: http://www.microsoft.com/express/windows/
Also if you are a student you may be eligible for the Microsoft DreamSpark program where you can get all the professional versions of Visual Studio for free.
Besides Visual Studio Express, I think MonoDevelop is pretty good too. It also exists for Linux and Mac. It is open-source and free - and, as the name suggest, have the Mono Project behind it so it is actively developed and will be in the future.
You can download Visual Studio Express C# for free.
While I'd probably go with Visual Studio Express, as others have said, note that Sharp Develop also exists:
[SharpDevelop] is a free IDE for C#, VB.NET and Boo projects on Microsoft's .NET platform.
You can try MonoDevelop. http://monodevelop.com/
You may also want to have a look at this Eclipse plugin for C# if you are already familiar with the Eclipse IDE.
There are several free IDEs you can take a look
I like Sharp Develop's embedded Boo interpreter. I do not use it often, but when I do it is a time saver: instead of writing a small program to test some .net class (or method) I have not used often, I create an instance in the interpreter and try there.
xacc.ide is a small and fast integrated development environment (IDE) mainly targeted at .NET development. It has syntax support for 27 languages and project support for various compilers. It has support for step debugging .NET based executables. Also featured is brace matching and folding support for some languages. Go To xacc
QuickSharp is a streamlined integrated development environment for Microsoft's .NET platform. It provides a simple, uncluttered development approach that lets you get programming in an instant. QuickSharp doesn't use solutions or projects, programs and libraries are developed as individual files making development a breeze. With QuickSharp you can work closer to the .NET Framework development tools and get to grips with the most advanced development platform for Windows from the ground up. QuickSharp is not just a development environment, it's also a lightweight application framework which can be easily modified and extended using a simple plugin-based architecture. The QuickSharp IDE is developed entirely using this framework and you can use it to create your own highly customized development environments.Go To Quick Sharp
X-develop is a multi-language IDE for the .NET and Java platforms. It supports the C#, Visual Basic.NET, Java and J# programming languages. Productivity-enhancing features such as on-the-fly error checking of all files, refactoring and smart code templates are supported for all languages.Go to X-develop
What is the function of the DBMDL file in a visual studio database project?
From what I can make out, it is a serialized file of your db model and is used as a cache for improving the performance of deployment. It is unique per user thus should not be checked into source control.
So I'm throwing this random question out there to see if anybody can or has done this in the past.
I'm looking at tidying up my project layout in Visual Studio and I'm wondering if there is any hack, plugin or trick to associate an .xml file with a .cs file of the same name so they appear grouped in my solution navigator/explorer.
similar to the way the code-behind file is associated with its aspx.
I know this is a bit random, but any suggestions welcome.
Thanks
In your project file :
<Compile Include="FileA.cs"/>
<Compile Include="FileA.xml">
<DependentUpon>FileA.cs</DependentUpon>
</Compile>
Or you could use Group Items command of VSCommands 2010 extension.
If you do not want to slow down you IDE with heavy and proprietary VSCommands extension you can use small extension NestIn instead. It can nothing but group/ungroup files
You have to implement the IVSSingleFileGenerater interface supplied with VS. I dont know all the details, but searching for that interface will point you in the right direction.
When I started new .NET Console Application in VS2010, By default Target Framework was set to .NET Framework 4.0 Client Profile, what is the difference between .NET Framework 4.0 and .NET Framework 4.0 Client Profile
Straight from the Microsoft castle:
What is it: The .NET Framework 4 Client Profile is a subset of the .NET Framework 4 that is optimized for client applications. It provides functionality for most client applications, including Windows Presentation Foundation (WPF), Windows Forms, Windows Communication Foundation (WCF), and ClickOnce features.
Why: This enables faster deployment and a smaller install package for applications that target the .NET Framework 4 Client Profile.
.NET Framework Client Profile:
http://msdn.microsoft.com/en-us/library/cc656912.aspx
The client profile attempts to restrict the set of referenced assemblies to those that are only interesting to a client application. For example it won't make System.Web available by default because it is not typically valuable to client apps.
The intent is to constraint the Visual Studio experience to that which is necessary to complete your application.
Several project templates in Visual Studio 2010 target the .NET Framework 4 Client Profile. The following is a list of the project templates in Visual Studio 2010 that target the .NET Framework 4 Client Profile by default. All other projects target the .NET Framework 4 by default.
Windows
WPF Application
WPF Browser Application
WPF Custom Control Library
WPF User Control Library
Windows Forms Application
Windows Forms Control Library
Console Application
Empty Project
Window Service
Office
WCF
Workflow
Activity Designer Library
Activity Library
Workflow Console Application
Visual F#
F# Application
F# Tutorial
Has somebody already evaluated the new MS Silverlight RAD tool "Lightswitch"? Is it also suitable for developing complex applications? Can I use it without Silverlight knowledge? Is it so flexible, that I can also extend "Lightswitch appications" with own code (C#,XAML)?
Based on the videos it is certainly powerful for developing data-centric business applications (i.e. the majority of business application).
Re Silverlight: Only .Net knowledge is assumed for the basics, but it is always wise to have platform specific knowledge of a technology you want to deploy on.
Like any code gen tool, it will do simple stuff easily and anything not provided in-the-box will require more effort, however I feel they made a very smart move generating standard C# (or VB) .Net projects you can extend using knowledge you [likely] already have.
As the same type of business code has been written manually countless times I think this has a lot of potential for eliminating drudge coding work. We will certainly keep an eye on it and evaluate it in detail (especially with a view to cheaply replacing legacy apps).
It assumes that all ?data rows? can be edited in isolation and therefore checks that a ?row? is valid before letting the user ?OK? the editor form.
In most cases this is not a problem, however if you have an application domain when the user need to edit ?many? objects before the system becomes valid again, then Lightswich is unlikely to be a good option for you.
Yes, I've been using LightSwitch for a while now, & there are several developers who are really pushing what LS can to to its limits.
While it was conceived as a "departmental" app tool, a number of professional developers (like myself) have recognised that it can be a very useful tool in our suite of development tools.
It is suitable for every complex situation? Not necessarily, but often it's more a matter of getting used to doing things the "LightSwitch" way, rather than how we may have done it in the past.
If you want more information, there's a fairly active MSDN forum, devoted to LS (currently Beta 2)
http://social.msdn.microsoft.com/Forums/en/lightswitchgeneral/threads
Yann
I find this behavior of TryCast in .NET 4.0 / VS 2010 rather confusing.
In my understanding TryCast works like DirectCast, but will return Nothing instead of throwing an exception if a conversion is not possible.
VS 2010 / .NET 4
?TryCast(CType(1, Object), String)
Nothing
?DirectCast(CType(1, Object), String)
"1"
VS 2008 / .NET 3.5
?TryCast(CType(1, Object), String)
Nothing
?DirectCast(CType(1, Object), String)
Cannot convert to 'String'.
The .NET 3.5 results are consistent with what I believe TryCast does... .NET 4 however is not.
Can someone please point me in the best direction to securely cast an object to String in .NET 4?
Based on your code samples starting with the ? I'm guessing you're using the immediate window to perform your test correct? The problem with this approach is that the immediate window is an interpretation instead of an actual evaluation. This leaves it susceptible to subtle corner case bugs and this is indeed one of them.
If you take your sample code and add it to a simple VB.Net console application you'll find that the 2010 behavior is identical to the 2008 behavior (throws an exception).
EDIT
So why did this regression happen? In 2010 I completely rewrote the VB EE debugging engine (expression evaluator). The older code base I inherited was simply too costly to maintain anymore. To the point that adding new features to the engine was more expensive that rewriting it from scratch with a better architecture that included the new features.
As said before debugging evaluations is an interpretation more than an execution of code. It forces the duplication of some algorithms between the EE and CLR / Compiler. One of the areas where duplication occurs is in the casting logic. There is no way to ask the CLR debugger to cast a debug time object, it's the responsibility of the EE to determine if the language specified cast is indeed valid.
The old EE casting logic had numerous bugs (especially in the area of generics and arrays). The newer infrastructure conforms very closely to the CLR guidelines. However you'll never have 100% parity because it would disallow very useful expressions in the EE (I may write a blog post on this in the future). But for most cases the behavior holds.
In this particular instance I added a subtle bug which allows for a DirectCast of a value which is typed to Object to use VB's Runtime Conversion operators vs. the specified behavior which only allows for CLR conversions. Hence this conversion succeeds where it should fail.
Why do I get this warning in C# with Visual Studio 2010?
"Unreachable expression code detected"
from the following code (DateTime.Now underlined in green squiggly):
public DateTime StartDate
{
get
{
DateTime dt = (DateTime)ViewState["StartDate"];
return ((dt == null) ? DateTime.Now : dt);
}
}
Because a DateTime struct can never be null.
If you're expecting a possible null value, you have to use a nullable DateTime struct. You could also use the null-coalescing operator instead of the conditional operator as well:
public DateTime StartDate
{
get
{
DateTime? dt = (DateTime?)ViewState["StartDate"];
return dt ?? DateTime.Now;
}
}
Or you could do it as a one-liner (as in the comments):
public DateTime StartDate
{
get { return (DateTime)(ViewState["StartDate"] ?? DateTime.Now); }
}
That could be because DateTime is a struct (value type) & not a reference type.
Hence, comparing it with null will always be false.
DateTime is a value type, so it can never be null. Therefore, the test for == null evaluates to a constant false at compile time, so half of the ?: will never be reached at runtime.
The answers given already -- that a non-nullable value type will never be null, and therefore the comparison is known to return false at compile time -- are correct, you might be wondering about the obvious follow-up question: why is this even legal? That question has been asked many times on SO; the short version is that C# provides a "lifted" equality operator for every struct that provides an equality operator on the non-nullable type (if a lifted one does not exist already of course.)
That is to say, because DateTime provides an == operator, the compiler automatically generates an == operator on DateTime?, and that operator is applicable in your case.
DateTime cannot be null
DateTime is not nullable, so its value will never be null.
I have always used Visual Studios built in GUI support for configuring my projects, often using property sheets so that several projects will use a common set.
One of my main gripes with this is managing multiple projects, configurations and platforms. If you just do everything with the main GUI (right click the project -> properties) it quickly becomes a mess, difficult to maintain and prone to bugs (like failing to correctly define some macro, or using the wrong runtime library, etc). Dealing with the fact that different people put there dependency libraries in different places (eg mine all live in "C:\Libs\[C,C++]\[lib-name]\") and then often manage the different versions of those libraries differently as well (release, debug, x86, x64, etc) is also a large problem since it vastly complicates the time to set it up on a new system, and then there is issues with version-control and keeping everyone's paths separate...
Property sheets make this a bit better, but I cant have one sheet have separate settings for different configurations and platforms (the drop down boxes a greyed out), resulting in me having many sheets which if inherited in the correct order do what I want ("x86", "x64", "debug", "release", "common", "directories" (deals with the previously mentioned dependency issue by defining user macros like BoostX86LibDir), etc) and if inherited in the wrong order (eg "common" before "x64" and "debug") lead to issues like trying to link an incorrect library version, or incorrectly naming the output...
What I want is a way of dealing with all these scattered dependencies and setting up a set of "rules" which are used by all my projects in the solution, like naming an output library as "mylib-[vc90,vc100]-[x86,x64][-d].lib", without having to do all this for each individual project, configuration and platform combination, and then keep them all correctly in sync.
I am aware of moving to entirely different systems like CMake that create the needed files, however this then complicates things elsewhere by making it so even simple tasks like adding a new file to the project then requires additional changes elsewhere, which is not something I am entirely happy with either, unless there is some with VS2010 integration which can keep track of these sorts of changes.
I just found out somthing I didnt think was possible (it is not exposed by the GUI) that helps make property sheet far more useful. The "Condition" attribute of many of the tags in the project property files and it can be used in the .props files as well!
I just put together the following as a test and it worked great and did the task of 5 (common,x64,x86,debug,release) separate property sheets!
<?xml version="1.0" encoding="utf-8"?>
<Project ToolsVersion="4.0" xmlns="http://schemas.microsoft.com/developer/msbuild/2003">
<PropertyGroup Label="UserMacros">
<!--debug suffix-->
<DebugSuffix Condition="'$(Configuration)'=='Debug'">-d</DebugSuffix>
<DebugSuffix Condition="'$(Configuration)'!='Debug'"></DebugSuffix>
<!--platform-->
<ShortPlatform Condition="'$(Platform)' == 'Win32'">x86</ShortPlatform>
<ShortPlatform Condition="'$(Platform)' == 'x64'">x64</ShortPlatform>
<!--toolset-->
<Toolset Condition="'$(PlatformToolset)' == 'v90'">vc90</Toolset>
<Toolset Condition="'$(PlatformToolset)' == 'v100'">vc100</Toolset>
</PropertyGroup>
<!--target-->
<PropertyGroup>
<TargetName>$(ProjectName)-$(Toolset)-$(ShortPlatform)$(DebugSuffix)</TargetName>
</PropertyGroup>
</Project>
Only issue is the properties GUI cant handle it, a project that uses the above property sheet just reports default inherited values like "$(ProjectName)" for the target.
I just filed a Connect bug for making conditions configurable via the GUI. Vote for it!
https://connect.microsoft.com/VisualStudio/feedback/details/634614
I had same pain for the product of my company (200+ projects) before. The way I solved it is to build a nice hierarchy of the property sheets.
The projects inherits the property sheet by its output type, say x64.Debug.Dynamic.Library.vsprops. This vsprops file simply inherits other property sheets using the InheritedPropertySheets attribute
<VisualStudioPropertySheet
ProjectType="Visual C++"
Version="8.00"
Name="x64.Debug.Dynamic.Binary"
InheritedPropertySheets=".\Common.vsprops;.\x64.vsprops;.\Debug.vsprops;.\Runtime.Debug.Dynamic.vsprops;.\Output.x64.Library.vsprops"
>
You can also use variables (i.e. UserMacro, whose value can be absolute or even environment variables) in property sheets to customize a lot of things based on your need. For example, defining a BIN variable in Debug.vsprops
<UserMacro name="BIN" Value="Debug" />
then when you set the output name in the series of vsprops, say, Output.x64.Library.vsprops
<VisualStudioPropertySheet
ProjectType="Visual C++"
Version="8.00"
OutputDirectory="$(BIN)"
>
The $(BIN) variable will be expanded to what's been set (in this case, Debug). Use this technique you can easily construct a nice hierarchy of property sheets to meet your demand.
Now there's one more thing you might want to do: build your own project templates that uses your property sheet set. The real difficult part is to enforce proper usage of the templates and property sheets. My personal experience is that even if everything is setup, somebody will still forget to use the template to create new projects ...
As far as the output library goes, you can select all your projects, then bring up the property pages, select All Configurations, All Platforms and then set the Target Name to:
$(ProjectName)-$(PlatformToolset)-$(PlatformShortName)-$(Configuration)
which would give an output like mylib-v100-x86-Debug.lib
We do something similar to this for Additional Library Directories as well, using $(PlatformName) and #(Configuration) to pick out the right library paths, although it does mean some messing around with initial setup of the libraries. eg we have boost install its libs to boost/lib.Win32 or boost/lib.x64.
With regards to libraries, and people installing them in different places, there are a couple of options. If you have a very robust source control system, you can just put everything in source control, living in a libs folder next to your source. That probably won't work if you use more than a few libraries though, or if they are particularly large.
The other option that comes to mind is to set an environment variable on each user machine that points to the root of their libraries folder, eg LIB_ROOT=c:\libraries, and you can then access that in Visual Studio as $(LIB_ROOT).
I made some improvements, may be useful for somebody
<?xml version="1.0" encoding="utf-8"?>
<Project ToolsVersion="4.0" xmlns="http://schemas.microsoft.com/developer/msbuild/2003">
<PropertyGroup Label="UserMacros">
<!--IsDebug: search for 'Debug' in Configuration-->
<IsDebug>$([System.Convert]::ToString( $([System.Text.RegularExpressions.Regex]::IsMatch($(Configuration), '[Dd]ebug'))))</IsDebug>
<!--ShortPlatform-->
<ShortPlatform Condition="'$(Platform)' == 'Win32'">x86</ShortPlatform>
<ShortPlatform Condition="'$(Platform)' == 'x64'">x64</ShortPlatform>
<!--build parameters-->
<BUILD_DIR>$(registry:HKEY_CURRENT_USER\Software\MyCompany\@BUILD_DIR)</BUILD_DIR>
</PropertyGroup>
<Choose>
<When Condition="$([System.Convert]::ToBoolean($(IsDebug)))">
<!-- debug macroses -->
<PropertyGroup Label="UserMacros">
<MyOutDirBase>Debug</MyOutDirBase>
<DebugSuffix>-d</DebugSuffix>
</PropertyGroup>
</When>
<Otherwise>
<!-- other/release macroses -->
<PropertyGroup Label="UserMacros">
<MyOutDirBase>Release</MyOutDirBase>
<DebugSuffix></DebugSuffix>
</PropertyGroup>
</Otherwise>
</Choose>
<Choose>
<When Condition="Exists($(BUILD_DIR))">
<PropertyGroup Label="UserMacros">
<MyOutDir>$(BUILD_DIR)\Bin\$(MyOutDirBase)_$(ShortPlatform)\</MyOutDir>
<MyIntDir>$(BUILD_DIR)\Build\$(Configuration)_$(ShortPlatform)_$(PlatformToolset)\$(ProjectGuid)\</MyIntDir>
</PropertyGroup>
</When>
<Otherwise>
<PropertyGroup Label="UserMacros">
<MyOutDir>$(SolutionDir)\Bin\$(MyOutDirBase)_$(ShortPlatform)\</MyOutDir>
<MyIntDir>$(SolutionDir)\Build\$(Configuration)_$(ShortPlatform)_$(PlatformToolset)\$(ProjectGuid)\</MyIntDir>
</PropertyGroup>
</Otherwise>
</Choose>
<PropertyGroup>
<OutDir>$(MyOutDir)</OutDir>
<IntDir>$(MyIntDir)</IntDir>
<!-- some common for projects
<CharacterSet>Unicode</CharacterSet>
<LinkIncremental>false</LinkIncremental>
-->
</PropertyGroup>
</Project>
have fun!
It sounds like it could be worth checking out a build tool - at my place we use a custom made tool that watches files and projects for changes and figures the dependencies and compile order. Adding a new file is no big deal - compilation is done with msbuild.
If i had to compile more than a bunch of projects I would use something like nant: http://nant.sourceforge.net/
Is there a standard option built into Visual Studio to act like the Vim scrolloff, or Emacs scroll-margin option.
The aim is for Visual Studio to always show at least "x" many lines above and below the current point.
I only know of the "Split View" feature in Visual Studio
As in http://msdn.microsoft.com/en-us/library/z01zks9a(v=vs.71).aspx it says:
Splitting the View
A Code Editor can be split into two separate parts for easier editing.
To split a pane
- Click the splitter bar (located above the scroll bar).
- Drag the splitter bar downward.
- To go back to a single pane, double-click the splitter bar dividing the two panes.
The new pane contains the same document, and any changes made to it are reflected in the other pane as long as that pane displays the same place in the document.
You can additionaly open a file in a new window (Menu Window>New Window) and dock it next to the original window to view additional different parts of that file simultaneously as in http://msdn.microsoft.com/en-us/library/z4y0hsax(v=VS.90).aspx
Tiling Document Windows
If you want to view more than one document at a time while editing code, you can tile the document windows.
To tile document windows
If the IDE is running in Tabbed documents mode, select a tab and drag it below or above the current document tile. A rectangular outline appears in the location where the new document tile will be placed.
Some screenshots for both options: http://www.kevinwilliampang.com/2008/08/19/visual-studio-tip-split-views/
Update:
Does navigating with Ctrl+↑ / Ctrl+↓ inside the editor window help you?
If you hold control when you use the arrow key for up/down, it'll scroll the text up/down without moving the cursor.
Also, there is a command called Edit.ScrollLineCenter which you can search for under tools/options/environment/keyboard & assign a hotkey to it.
In short: No there isn't.
Longer: No there isn't any that I am aware of. But there should be. Search the extensions and please report back.
I've followed the instructions on http://blogs.msdn.com/b/vstsqualitytools/archive/2009/12/01/executing-unit-tests-in-parallel-on-a-multi-cpu-core-machine.aspx to the letter and I can execute tests in parallel.
So far so good.
Now the problem: I can't set the parallelTestCount to zero (Auto configure) or to a value above 5. Running five parallel tests works fine but not six.
Yes I have more than five cores on my machine; I am running on an Intel i7 processor which has four cores with hyperthreading meaning I should be able to run 8 tests in parallel.
Now I'm sure there are some other logical or hard limitations and I am not expecting to be able to run on eight cores lightning-speeding eight tests through in parallel.
However it would be cool to know the reason for it not running more than five tests in parallel?
It seems that this is a bug in MSTest. I have stumbled upon the same problem, all tests are marked as aborted and there is a "Test run error" link in the Test Results window which if clicked yields this message: "Test run is aborting on '', number of hung tests exceeds maximum allowable '5'".
It could just be me but hyperthreading isn't a real core so an i7 only really has 4 physical cores not 8. Maybe it is something to do with that.
Or perhaps there is some bios setting relating to how the hyperthreading can be used by the OS that is preventing it.
I have some code which makes use of Extension Methods, but compiles under .NET 2.0 using the compiler in VS2008. To facilitate this, I had to declare ExtensionAttribute:
/// <summary>
/// ExtensionAttribute is required to define extension methods under .NET 2.0
/// </summary>
public sealed class ExtensionAttribute : Attribute
{
}
However, I'd now like the library in which that class is contained to also be compilable under .NET 3.0, 3.5 and 4.0 - without the 'ExtensionAttribute is defined in multiple places' warning.
Is there any compile time directive I can use to only include the ExtensionAttribute when the framework version being targetted is .NET 2?
The linked SO question with 'create N different configurations' is certainly one option, but when I had a need for this I just added conditional DefineConstants elements, so in my Debug|x86 (for instance) after the existing DefineConstants for DEBUG;TRACE, I added these 2, checking the value in TFV that was set in the first PropertyGroup of the csproj file.
<DefineConstants Condition=" '$(TargetFrameworkVersion)' == 'v4.0' ">RUNNING_ON_4</DefineConstants>
<DefineConstants Condition=" '$(TargetFrameworkVersion)' != 'v4.0' ">NOT_RUNNING_ON_4</DefineConstants>
You don't need both, obviously, but it's just there to give examples of both eq and ne behavior - #else and #elif work fine too :)
class Program
{
static void Main(string[] args)
{
#if RUNNING_ON_4
Console.WriteLine("RUNNING_ON_4 was set");
#endif
#if NOT_RUNNING_ON_4
Console.WriteLine("NOT_RUNNING_ON_4 was set");
#endif
}
}
I could then switch between targeting 3.5 and 4.0 and it would do the right thing.
Property groups are overwrite only so this would knock out your settings for DEBUG, TRACE, or any others. - See MSBuild Property Evaluation
Also if the DefineConstants property is set from the command line anything you do to it inside the project file is irrelevant as that setting becomes global readonly. This means your changes to that value fail silently.
Example maintaining existing defined constants:
<CustomConstants Condition=" '$(TargetFrameworkVersion)' == 'v2.0' ">V2</CustomConstants>
<CustomConstants Condition=" '$(TargetFrameworkVersion)' == 'v4.0' ">V4</CustomConstants>
<DefineConstants Condition=" '$(DefineConstants)' != '' And '$(CustomConstants)' != '' ">$(DefineConstants);</DefineConstants>
<DefineConstants>$(DefineConstants)$(CustomConstants)</DefineConstants>
This section MUST come after any other defined constants since those are unlikely to be set up in an additive manner
I only defined those 2 because that's mostly what I'm interested in on my project, ymmv.
See Also: Common MsBuild Project Properties
Is it possible to break a single thread in Visual Studio, while other threads will continue their execution?
I have one background thread that does simple data sending/receiving, which I would like to happen, while stepping through my code in some other thread.
open the thread view (Debug->Windows->Threads), right-click the thread you want to suspend, select 'Freeze'. Select 'Thaw' to put it back in a running state.
Generally it's impossible, but there are some things that might work for specific scenarios.
Basic solution As mentioned elsewhere, repeating the sequence: Freeze, Resume, (wait), Pause, Thaw, Step should result in the behavior you describe, giving other threads the possibility of running in the background while your target thread is halted.
This approach has at least two issues:
Improvements
The first issue may be tackled using a different procedure: Issue a Thread.Sleep(10000) in the Immediate Window, effectively keeping the focused thread occupied while the other threads execute normally. You could even bind that command to a macro.
The second issue can only be tackled by an approach that does not need to pause the debugger. But how would we examine state when the session isn't paused? That's where IntelliTrace comes in, but you may find you need to create custom IntelliTrace events. Drawback of this approach is that you can not manually modify state mid-flight.
All i can find to this, is that you can change the behaviour on a process level by the setting
but not on a Thread base.
For a long time I have been working with ReSharper.
But after seeing CodeRush being used in a tutorial video, I started to wonder if I should consider to try CodeRush as well.
But before giving a try I wanted to ask you if you've had a chance to work both with ReSharper and CodeRush, so that you could share your objective opinions on their advantages and disadvantages over each other.
Download a demo of CR and give it a shot.
If you've already spent good money on RS, think about the ROI and the (possible) learning curve for CR, although the learning curve should be sorted out during the evaluation :-). The company where I am is using the Developer Express suite of products (which include CR) and I am loving it. I find it very productive and useful.
Disclaimer: I am a DevExpress "fanboi."
I am a bit confused on how Visual Studio 2010 and Expression Blend 4 operate together. If I want to create a WPF application, should I start it in Expression Blend 4? If so, then how does Visual Studio 2010 natively open Expression Blend projects, or does it?
Or should I start my application in Visual Studio 2010? If so, how do I open my solution in Expression Blend.
Also, how do I modify an existing WPF form, if I need changes. If I already have events handled and code behind, how do I bring it over to expression blend, make my changes, then bring it back to visual studio without disrupting the events and code that I have created in Visual Studio 2010?
Also can someone recommend a good book that covers how to create WPF and/or Silverlight applications using Expression blend 4 and Visual Studio 2010 together.
Solutions are the same for Visual Studio and Expression Blend. You can open your solution through the file menu in expression blend, or by right clicking on a xaml file in Visual Studio and select "Open In Expression Blend".
Personally, when I need to make only a small change, like changing the text on a button, I don't go into Blend. But when I want to see what's going on, with margins and layout and stuff I always use Blend. Most often I have Visual Studio and Blend open side by side and I keep switching back and forth.
Because Expression Blend uses the same solution you don't have to worry about event handlers and such. When they are in place, they stay in place. Unless you delete the control the event is attached to of course.
Creating a solution can be done in both tools, but I start most projects in Visual Studio. There are however a few Project templates that can't be found in visual studio. For example the Databound Application project type. This will give you a start on an MVVM project, with folders in place for the Model, View and ViewModel.
You can have it open in both Visual Studio and Blend at the same time. You're prompted in Visual Studio if you make a change in Blend and vice versa.
Personally I create the new application in Visual Studio first then open it in Blend.
I usualy start my project in Blend. Remember Blend is specially designed to make great UI, easy databindig, make easy templates and custom controls.
You can edit the code behind of your app directly in Blend but sometimes it doesn't show the intellisense; thats when you need open VS, to do that right click on your project inside blend and click on edit with Visual Studio. It'll launch VS and you can start coding.
You dont need to close VS or Blend, they booth can be open, if you make some change in VS it will notify Blend, will appear a dialogbox telling you: reload the app, click Yes the changes will be sincronized in Blend and VS, the same happens when you make changes in Blend and go to an already open instance of VS.
Too remember to install de VS tools, it will allow you to open Silverlight projects inside VS, if they arent already installed an error message will appear.
Hope my answer help you
I have a Visual Studio solution, and this solution contains a few projects. Can I build all the projects from this solution into one dll?
You can use ILMerge to merge a number of assemblies into one.
There is also a fairly old mono project with similar capabilities - mono.merge.
Try using ILMerge http://research.microsoft.com/en-us/people/mbarnett/ilmerge.aspx
No, viusal studio will not combine the source/output from multiple projects into a single dll/application. Your best bet to do this is to set the post-build step of each project to call a third part application (like ILMerge). Just make sure the build order is correct and that the multiple projects are not trying to launch. You also may be able to get away with making another project that statically links to the other dlls.
Since you are talking about projects, you can also compile them as .netmodule and put them in one assembly like this: http://msdn.microsoft.com/en-us/library/226t7yxe(VS.90).aspx
I have Visual Studio 2008 and 2010 installed side by side, but trying to open either a 2008 or 2010 sln file results in nothing. The hour glass comes on for about a second and then it goes away and nothing is opened.
I read somewhere to relate sln file to VS directly, but I can't go that route because I don't want 2008 solutions to open with 2010. Does anyone know what the problem might be and how to fix it?
If you are running Vista or Windows 7 with the UAC enabled and have "Run this program as an Administrator" checked on the Compatibility tab for the Visual Studio exe (devenv.exe), you will get this behavior when you try to open a sln file directly from Windows Explorer.
One solution is to go to "%ProgramFiles%\Common Files\Microsoft Shared\MSEnv" or ("%ProgramFiles(x86)%\Common Files\Microsoft Shared\MSEnv" for 64-bit systems) and right-click VSLauncher.exe and select Properties. On the Compatibility tab, check "Run this program as an Administrator". Now when you try to open a sln file directly from Windows Explorer, you will get the elevation prompt and it will open the correct version of Visual Studio for the file.
Apparently, the "run as administrator" hack does not work anymore in Visual Studio 2010 SP1. Fabian describes a workaround here:
Getting Visual Studio 2010 SP1 to run elevated when launching .sln files
To sum it up:
Backup VSLauncher.exe
From within a Visual Studio 2010 Tools prompt, extract the manifest from VSLauncher.exe:
mt -inputresource:"VSLauncher.exe" -out:VSLauncher.exe.manifest
<requestedPrivileges>
<requestedExecutionLevel level="requireAdministrator" uiAccess="false">
</requestedExecutionLevel>
</requestedPrivileges>
mt -outputresource:VSLauncher.exe -manifest VSLauncher.exe.manifest
Other than setting a debug variable and incrementing it every time you start the foreach, when you break in with the visual studio debugger connected, is there any way to tell that this is the Xth time through the loop?
I guess this would be a feature of visual studio if anything, not something that would be added to the compiled code.
Set a breakpoint inside the loop, then right click on the breakpoint to set the conditions. You can also right click to see the hit count while debugging and reset it if you want. You can set a boolean expression that is evaluated when the breakpoint hits to conditionally break (or just pass over).
May be you can use breakpoint hit count. Not exactly what you want, but may be helpful.
Also is there any serious reason why you don't want to use for loop in this case.
Have you tried using assertion in debugging? The debugger will be launched at that exact point in your code:
For example: System.Diagnostics.Debug.Assert (myValue >=0)
Heres a previous SO question that seems to be what your looking for
get-index-of-current-foreach-iteration
answer quoted from that link:
Foreach is for iterating over collections that implement IEnumerable. It does this by calling GetEnumerator on the collection, which will return an Enumerator.
This Enumerator has a method and a property:
MoveNext()
Current
Current returns the object that Enumerator is currently on, MoveNext
updates Current to the next object.
Obviously, the concept of an index is foreign to the concept of
enumeration, and cannot be done.
Because of that, most collections are able to be traversed using an
indexer and the for loop construct.
I greatly prefer using a for loop in this situation compared to tracking
the index with a local variable.
from my comment
if whatever you are iterating supports the IndexOf() method you dont have to set a debug var.
like in this example:
foreach (var i in myList)
{
reportprogress(myList, i);
//dostuff;
}
private void reportprogress<T>(List<T> l, T i)
{
progressBar1.Value = ((l.IndexOf(i)) * 100) / l.Count;
Application.DoEvents();
}
I also felt that this could be a very useful feature, so I created it as part of a commercial extension I made for the Visual Studio debugging experience called BugAid.
The extension shows you exactly which iteration you are whenever you are inside a foreach loop:
When you click the "Iteration x of y" button, you'll see a new window, showing the complete list of items, with the your current location in the loop highlighted (this list is only shown if evaluating the collection in the debugger does not cause any side effects).
Once you open ths Foreach Visualization window, you can even right click any of the upcoming items and choose "Skip to Item", to run forward until you hit that item (this can save you from manually setting-up and messing with hit-count breakpoint):
I just tried it and I did not found a way to tell. Maybe if you could give us the code inside the foreach, we could find a "trick".
Visual Studio can be quite slow to open and work with. The menus and auto-hide windows can get sluggish and commands take a while to start. What are the list of things one can do to make the UI of Visual Studio load faster and operate faster? What settings can one change to make it feel lean and minimal?
PS: I know Visual Studio Express is way leaner and faster. However, I rely on some Visual Studio addons, and addons are not supported in Express.
PS2: I have already closed all unnecessary windows. All diagnostic windows are on auto-hide. And all the tool bars are closed. I work almost completely using keyboard shortcuts.
Here are some tips, actually collected from following blog posts
Improve Visual Studio's Source View Performance
Tips to improve performance of visual studio IDE
Visual Studio 2008 Tweaks
Visual Studio 2010 Performance Part 1: Startup
Visual Studio 2010 Performance Part 2: Text Editor
Visual Studio 2010 Performance Part 3: A Technical Update
Turn off background HTML validation. Go to Tools / Options and select Text Editor / HTML / Validation in the tree view on the left side. Uncheck the Show Errors check box.
Turn off AutoRecover. Go to Tools / Options and select Environment / AutoRecover in the tree view. Uncheck the Save AutoRecover check box.
Close your property grid (View / Properties Window)
Turn off AutoToolboxPopulate (Tools -> Options -> Windows Forms Designer set AutoToolboxPopulate False)
Turn off Track Active item (Tools -> Options -> Projects and Solutions uncheck Track Active Item in Solution Explorer)
Disable Navigation Bar(Tools -> Options -> Text Editor -> C#, uncheck Navigation bar)
Move file in App_Code into a class library project
Disable validation Options for HTML Editing (Tools -> Options -> Validation -> Clear show error checkbox)
I know that VS 2008 slowed down from VS 2005. I feel this pain every once in a while when im doing a quick Find or Find-Replace, or Find-In-Solution...etc. The UI sometimes isn't as fast as your hands are (when you're using keyboard shortcuts).
I found that just slowing down sometimes is the way to do it (it sucks, but then again, so does many things about Windows).
If it's load times youre concerned about; disable the startup stuff (from the Options menu). Here you can choose to load a blank screen upon VS load AND not to subscribe to any news feeds. (this helps alot depending on your internet connection).
you can also, via Options, adjust the visual animations that occur, as well as just disabling them altogether.
If there's anything else im missing, which im sure there is, i'd really like to know as well!
Without knowing the information I posted in the comments I will say the typical stuff. Turn off all addons, if you are using vista or 7 switch to basic vs aero, check all running processes. This is where I would start.
One thing that can potentially speed up visual studio is to disable document navigation.
Go to Tools -> Options -> Text Editor -> and uncheck 'Navigation Bar'.
This is definitately an option in 2008, pretty sure its in 2005 too.
Another option to try:
Go to Tools -> Options -> Text Editor and Uncheck 'Track Changes'.
In Visual Studio version 2002 and 2003 "Go To Definition" would find the selected type or member in the Object Browser. In 2005 onwards it opens a source window "generated from metadata" instead. How do I configure these newer versions to go to Object Browser? (In other words, I have the opposite problem to this one.)
Installing ReSharper makes this change, so I know it must be possible, but how do I do it without ReSharper?
As workaround you can create the following macro:
Sub GoToDefinitionUsingObjectBrowser()
DTE.ExecuteCommand("Edit.SelectCurrentWord")
DTE.ExecuteCommand("View.ObjectBrowser")
DTE.ExecuteCommand("View.ObjectBrowserSearch", DTE.ActiveDocument.Selection.Text)
End Sub
Then go to Tools/Options/Keyboard and assign hot key for this macro.
Tested in Visual Studio 2010.
I believe what re-sharper is doing is doing some hooks on that click event with the Visual Studio SDK I do not think there is any simple menu or location that can change that setting.
Instructions (pulled from CODE Magazine) edited down a bit to the part that pertainst to making the right click menus.
Creating a VSPackage
...The VS SDK installs a few more project templates in Visual Studio, one of them being the Visual Studio Integration Package (Figure 1), located under Other Project Types > Extensibility on the New Project dialog box.
After this standard dialog box, the Visual Studio Integration Package Wizard guides you through creating the new package project:
- Select a programming language. The wizard currently supports Visual C++ and Visual C#. You can create or pick a key file to sign the new package.
- Supply basic VSPackage information. The wizard prompts you for details such as the company name, VSPackage name, version, icon, detailed information, and minimum Visual Studio edition (such as Professional or Enterprise) that the package is designed to at this step. This information goes into the Visual Studio splash screen and About dialog box and is also used to request a PLK for the package (covered later).
- Select VSPackage options. A package may add three types of functionality: Menu Command, Tool Window, and Custom Editor.
A menu command is a command added either to the menu at the top of Visual Studio or to a context menu (right-click).
When the wizard finishes its job, the VS SDK adds core elements to the solution to support the new package. For instance, if you selected Tool Window as part of the functionality for the package, the project contains a user control where you should place the visual controls for the window. The project also contains files for .NET code to handle the functionality that you will add to the package.
A CtcComponents folder contains pseudo-C++ files (ctc files) where you define things like menu, groups, buttons, etc. Fortunately, Microsoft is phasing out CTC files and replacing them with a friendlier, XML-based VSCT file format (which will ship in the SDK for Visual Studio 2008).
The wizard creates a few other files with .NET code required for the plumbing of the package within Visual Studio. Some of these files contain classes that map the C++ constants to .NET constants and other files contain configuration information for the package when it?s installed.
Use VB.NET :-)
I heard it takes 30 days minimum to get comfortable with vi. I'm on day 2 hehe. Right now, I seem to be merely memorizing different shortcuts for things I already did in visual studio. (incremental search, prev/next word, etc)
So far the most powerful aspect seems to be the numeric keys combined with commands (5 * next line), and the idea of normal/insert modes.
There are a few things I miss from visual studio. Ctrl-Click'ing the mouse for quick copy and pasting is probably the biggest.
So that I don't get discouraged, can you guys walk me through some things in vi that you do regularly that can't be done in Visual Studio? It'll help me focus on what to learn and develop habits around.
I'll just leave a link to this SO answer here.
VI means never ever having to take you fingers off the keyboard.
This article is what got me started on Vim, and I never looked back:
http://www.viemu.com/a-why-vi-vim.html
It has some great examples on Vim's power.
Visual Studio's regular expressions are a little bit Mickey Mouse. Vim has the full POSIX regular expression language at your fingertips.
Use screen to keep a session running on a remote machine accessed over ssh
Edit a file on a Solaris machine that only allows SSH access.
As far as I can tell (in Visual C# express 2010) ctrl-click just selects whatever word you click on. To do the same in VIM, you can combine the yank command with a movement command.
So you press "y" for yank (copy) then "e" or "w" to copy to the end of the word.
There is many differences.
I suggest you watch some screencasts at http://vimcasts.org/ to get a feeling of the power of vim.
e.g.:
Note that I don't use Visual Studio, and know little about the available features in it. The following are examples of what I find useful in Vim, not a list of missing features in Visual Studio.
Macros
It's easy to create macros for complex (but repetitive) operations. To illustrate with a simple example, let's say we start with:
Line1
Line2
Line3
Line4
Line5
Now we want to envelop each line in a print(""); statement.
Place the cursor on the first line, and enter:
qx to start recording a macro to the register xprint(" Esc to insert text at the beginning of the line"); Esc to append text at the end of the linej to go down one lineq to stop recording the macro4@x to execute the macro in register x 4 timesSee :help complex-repeat for more info on Vim macros.
Text objects
Note that this is one of the improvements Vim has over the traditional Vi. If it doesn't work, you're probably running in Vi compatibility mode; use :set nocompatible to enable the full functionality of Vim.
Text objects allow you to easily select regions of text. Let's say we start with the following text, and place the cursor on some text:
<b><i>some text</i></b>
Now we want to delete everything between <i> and </i>. This can be done by simply typing the command dit (d'elete i'nner t'ag)! Or if we want to include the tags themselves in our selection, use dat (d'elete a t'ag). To delete everything inside the <b> tags, use d2it (d'elete two i'nner t'ags).
You can similarly use daw (delete a word), dap (delete a paragraph), di" (delete inside double-quotes), etc; see :help text-objects for the complete list.
Another useful example of text objects:
v2ap"+y
v toggles visual mode. This makes it easier to see what you're selecting, and lets you adjust your selection with a series of multiple motions before you execute a command.2ap selects this paragraph and the next one"+ selects the system clipboard as register for the next operationy yanks the selection to the given registerIn other words, that command would copy two paragraphs from your text to the system clipboard (e.g. for pasting them here at StackOverflow).
Global editing
The global command is used to apply an Ex command to all lines matching a given regular expression. Examples:
:global/test/print or :g/test/p would print all lines containing the phrase test:global/test/delete or :g/test/d would delete said lines:global/test/substitute/^/#/ or :g/test/s/^/#/ would search for lines containing the phrase test, and comment them out by substituting the regexp anchor ^ (beginning-of-line) with the symbol #.You can also do some cool stuff by passing the search motions /pattern or ?pattern as ranges:
:?test?move . searches backwards for a line containing test, and moves it to your current position in the file:/test/copy . searches forwards for a line containing test, and copies it to the current position in the fileGood luck and have fun learning Vim!
Vim Essentials is a nice set of slides.
Personally, I got used to vi a long time ago, when we didn't have the luxury of a mouse in student's Unix terminals. Since then, I used vi/vim for everything safe for writing emails.
To this day, I probably use only 1/20 of the commands, but never felt the need to write code with another text editor, and reaching for a mouse in an IDE feels very clumsy to me.
Using high level and expressive languages, that do not require an IDE (mainly python, sql, javascript) really helps. I suppose it wouldn't be as easy with Java or C++.
Not having to move and point with the mouse when coding (safe for using the browser) also helps preventing Carpal tunnel syndrome.
BTW, I suppose Vim integrates better with Unix than with Windows... and who said 30 minutes was a little optimistic :)
Edit documents over SSH. Vim's really nice for that.
Edit: looks like a lot of people have already said that :)
You could always use the Vim emulator/add-on for Visual Studio and get some of the power of vim mixed with the features of VS. If you're already using Visual Studio, I assume you're using a .NET language, which without VS, would be much more painful to use.
teco is your answer. You only need a PDP-10 and an ASR-33 and you're on your way!
Say I have a class and I want to deprecate a method. Is it possible to have that method not show up in intellisense so that people won't be temped to use it? I just want existing code that uses it to continue compiling but hide the method from view at the same time.
The EditorBrowsableAttribute attribute can be used to hide members from intellisense:
http://msdn.microsoft.com/en-us/library/system.componentmodel.editorbrowsableattribute.aspx
Alternatively, you can use the System.ObsoleteAttribute. It still might be a good idea to have the method show up in intellisense, since technically it exists.
Using this attribute will show the method name in the intellisense, but with a [deprecated] tag in front of it.
[Obsolete("Method is in the process of deprecation.")]
void MyMethod() {...}
If you use ReSharper, and tell it to override Visual Studio's Intellisense settings, it will strikethrough the method name.
Is there someway to get VS 2008 intellisense to default to Properties over Classes in a name collision?
Example:
Within my scope I have a property Foo, but I'm also using a class Foo. When writing code, if I start to type F o, VS2008 intellisense will think I mean the class Foo. I want it to think I mean the property Foo instead.
Unfortunately no this is not possible. Customization of the priority of value categories like classes / properties is not supported
There is no possibility in VS2010 and not even in ReSharper 5.0 to deal with this issue. It won't be a feature of ReSharper 6.0 as well, according to JetBrains. I use a different name for the property, when it starts making me aggressive and refactor it after I've done most of the work.
Update:
I reported the issue to JetBrains some time ago and I just got an eMail that the feature has been added and will be available in Release 6.1. So good news for ReSharper users on this one!
http://youtrack.jetbrains.net/issue/RSRP-273067?projectKey=RSRP
I was thinking the exact same thing today.
While the functionality is not in vanilla VS, it is quite possible to modify some code to add this functionality. For example, the XAML Presenter, probably named after the presenter component that you have to modify does something similiar.XAML Presenter
It narrows by namespace and sorts by attribute type. Basically, I'm just gonna take the list the Intellisense Completion Source gives and sort the list. Sounds simple enough.
More challenging is implementing the UI controls. I hate designing UI controls . . .
Edit:
However, I don't forsee a way to do this without breaking Resharper's Intelllisense features.
Use VS 2010, I suppose? I can't see which situation would make VS put classes over properties, though.
It often happens that a single C# solution contains some projects that are x86-specific (usually by having native dependencies) and others that are AnyCPU.
Up until recently I've always gone into the configuration manager and made sure that the solution platform was AnyCPU. This isn't too much of a problem; it requires occasional tweaks like the ones mentioned here, but overall isn't too bad.
However I recently started wondering if these efforts are misguided. I'm clearly going against the way VS2010 (and previously 2008) is designed to handle this. "Mixed Platforms" is actually an accurate description, and although it initially feels like there's something wrong, upon further thought I have to conclude that it's no more wrong than "Any CPU".
So, lately I have been trying to choose between keeping "Mixed Platforms" or changing to "x86" as my Solution Platform in such cases. The latter reflects the intention: the final exe is x86, and runs in 32-bit mode on 64-bit OSes. The former however is what Visual Studio really wants it to be.
In your experience, is there a particular solution platform that is more suitable in any way than the others in this situation?
Note 1: in every case that I've encountered, x86 is justified by native dependencies and AnyCPU is justified by being an external library that is really platform-independent.
Note 2: if I understand correctly, the solution platform doesn't make much of a difference; it's just a name. It seems to change the default "to-build-or-not-to-build" checkbox state when new projects are added, but that's about the only effect that it has. Right?
Ad Note 2: Yes. Solution platform is only a name for the set of project configurations, including whether to build or not a particular project.
I personally use x86 on all desktop applications (desktop because these are deployed on end users machines you usually have little control over - this is much easier if you are deploying a server application to a known server).
Reasons:
Yes, this is a bit of a mess you'll get into when you let the VS2010 project converter import a project from a previous version. Who doesn't. The old IDEs used Debug|Any CPU and Release|Any CPU as the default configuration names. VS2010 really prefers setting the Platform Target to x86 because the IDE works so much better when you do. And uses Debug|x86 and Release|x86 as the default configuration names.
Which produces the mix when you import an old project. And an extra set of configurations (mixed platforms) you didn't ask for to deal with the mess. Yuck. You cannot remove them either, the Remove button is disabled in the Configuration Manager.
These are just names btw that are not actually representative for the Platform Target setting. You can change the setting, it doesn't magically change the configuration name. Yuck.
You cannot fix this in the IDE. You'd have to edit the .sln and the .vcproj files to get rid of the extra configurations and edit the names of the ones you want to keep. Or just keep "Mixed Platforms" as your default configuration and ignore the rest. Just set the Platform Target to what you need, it doesn't have to match the configuration name.
I have only configured my startup Windows Forms app as "x86" and all class librarys in the project as AnyCPU. If I execute the app all unmanaged dependencies, even from class librarys that are x86 still work.
Now If I add a class library that hasn't x86 dependencies from my project to another app that is configured as AnyCPU it works out-of-the-box.
Before I did that all my librarys where x86 and I got an exception if I wanted to use them in a 64 bit project.
From my point of view that's the best solution.
Having had some more experience with this, here's what I now think:
Changing everything to x86 is undesirable for two reasons:
What is the difference between Build Solution, Rebuild Solution, and Clean Solution in Visual Studio?
When is the appropriate time to use each one of these?
(The links are to the devenv.exe command line switches, but they do the same as the menu items.)
Taken from this link:
Build means compile and link only the source files that have changed since the last build, while Rebuild means compile and link all source files regardless of whether they changed or not. Build is the normal thing to do and is faster. Sometimes the versions of project target components can get out of sync and rebuild is necessary to make the build successful. In practice, you never need to Clean.
Build Solution - Builds any assemblies which have changed files. If an assembly has no changes, it won't be re-built. Also will not delete any intermediate files.
Used most commonly.
Rebuild Solution - Rebuilds all assemblies regardless of changes but leaves intermediate files.
Used when you notice that Visual Studio didn't incorporate your changes in the latest assembly. Sometimes Visual Studio does make mistakes.
Clean Solution - Delete all intermediate files and rebuild all assemblies regardless of changes
Used when all else fails and you need to clean everything up and start fresh.
Build solution will build any projects in the solution that have changed. Rebuild builds all projects no matter what, clean solution removes all temporary files ensuring that the next build is complete.
I just think of Rebuild as performing the Clean first followed by the Build. Perhaps I am wrong ... comments?
Using Windows 7 32 bit, VS 2010, .NET 4 DLL, NUnit (2.5.5) to unit test the application. I'm currently getting the following error; seen plenty of posts and tried the following:
But I cannot get NUnit to hit my breakpoints when running;
I set the NUNit test project to point to the nunit.exe, and to load the testing .NET 4 DLL, but when I run it doesn't find the breakpoint, "no symbols have been loaded". I tried debug >windows > modules, it doesn't even show my unit testing project when I run it.
I found this, to use the nunit agent: http://groups.google.com/group/nunit-discuss/browse_thread/thread/5680d7def5b6982f
But I get an error when I use the nunit agent too. I was using nunit-agent-x86.exe, but I get a system.formatexception and it crashes...
Can anybody help?
Thanks.
There's another similar question here on Stack Overflow, where I posted my answer with what worked for me. I can set breakpoints and start NUnit directly from Visual Studio 2010 with Debug -> Start New Instance (which I think is your goal).
I set nunit.exe as the external program in project -> Properties -> Debugging and added:
<startup>
<requiredRuntime version="4.0.30319" />
</startup>
to the nunit.exe.config file found next to the nunit executable in the NUnit install directory.
The resolution was: start NUnit stand alone, then in VS 2010, do debug > attach to process, and attach to the nunit-agent.exe process, not the nunit process. Nunit process still didn't do it for me.
Are you running NUnit and then loading the DLL? Try instead opening the project properties, Debug tab, switch the start action to 'Start external program', point to the NUnit exe, put your dll name in 'command line arguments'. Then start the library project right-clicking it and choosing Debug -> start new instance.
I was getting "break point will not be hit ... no symbols loaded ..." for a website project. Found that there were build errors in my website (one of the referenced dll's went missing for some reason). Rebuilds didn't show the problem until I selected View=>Error list in VS2010, prior to the rebuild. Replacing the missing dll in the bin dir & updating the reference solved my problem.
Adding the following section in the nunit-x86.exe.config worked for me:
<startup>
<supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0,Profile=Client"/>
</startup>
The 'sku' section is only needed when running with .NET 4's Client Profile. Note that a previous answer showed using 'requiredRuntime' which is obsolete.
Many PCs we have on the development team are out-dated and are very slow to run Visual Studio 2008. They should very much be replaced with newer machines. But there's a general reluctance on management/company to buy new machines.
How do we come up with numbers and benchmarks to show that these slow PCs are causing a loss in productivity?
Obviously we can't call them to sit down with us as we build solutions and/or open various files.
Is there an objective way to come up with some kind of reliable numbers that non-technical people can understand?
It'd be nice to have a way to measure this across an entire organization on many different PCs running Visual Studio. I'm looking for an answer that does better than using a physical stopwatch. :)
Modify your solutions so that the pre-build and post-build events write the current time to a centralised database. Include the machine name and the name of the project.
You can then display this information as graph showing time for build vs machine.
This should show a correlation between the build time and the age of the machine, hopefully showing the the older machines are slower. You could even convert the time into a $ (or £ or ? ) value to show how much these older machines are costing. Summing this over time will give a value for the payback on any investment in new machines.
By modifying the solutions you can get this logging deployed onto all development machines by simply getting everyone to do a "get latest" from source control.
This does not really answer your question, but might help to achieve the required results. Tell your bosses that The Programmer's Bill of Rights is something to be taken seriously.
I would attempt to explain to them that programmers cost much more than machines. If you spend 30 minutes a day waiting, do the math and figure out what percentage of your salary is wasted due to laggy machines. Present these numbers to them, and compare it to the price of a new computer, and explain how they could save money in the long run by upgrading.
If they choose to continue to spend big bucks affording your wisdom only to have you sit there and watch a spinning cursor, just laugh because the joke is on them.
Many PHB's understand productivity in terms of lines of code (which IMO is very Wrong).
Can you record the amount of code produced per day on the slow machines vs not so slow machines?
Slow machines are the bane of development, IMHO, especially since any delay gets developers out of concentration and can lead to a much costlier switch to things like web browsers. There can be other weird effects like a how a slight increase in the latency for the Javadoc popup or C# equivalent) to appear when you hover a method and the chances someone would consult the documentation.
If legal in your company (at least for self use), record about half an hour of work with a screen capture tool like Camtasia. Then use a fast editor to spot the times the machine was hung (easy if you have a cursor change, progress bar, etc.) and count the time and number of instances. I've done that for hours of tapes - it doesn't take that long. Use these numbers to argue the case, though you need to also argue that it leads to the indirect costs like a context switch.
Also, in my experience, hard drives are often the major cause of slowdown, not CPU or RAM, and unfortunately most organizations skimp on fast hard drives or SSDs and have very strict rules about replacing them.
Don't forget to factor in the cost of time spent figuring out how much slow PCs cost you (this post in other words)!
We have a large base of code that contains several shared projects, solution files, etc in one directory in SVN. We're migrating to Mercurial. I would like to take this opportunity to reorganize our code into several repositories to make cloning for branching have less overhead. I've already successfully converted our repo from SVN to Mercurial while preserving history. My question: how do I break all the different projects into separate repositories while preserving their history?
Here is an example of what our single repository (OurPlatform) currently looks like:
/OurPlatform
---- Core
---- Core.Tests
---- Database
---- Database.Tests
---- CMS
---- CMS.Tests
---- Product1.Domain
---- Product1.Stresstester
---- Product1.Web
---- Product1.Web.Tests
---- Product2.Domain
---- Product2.Stresstester
---- Product2.Web
---- Product2.Web.Tests
==== Product1.sln
==== Product2.sln
All of those are folders containing VS Projects except for the solution files. Product1.sln and Product2.sln both reference all of the other projects. Ideally, I'd like to take each of those folders, and turn them into separate Hg repos, and also add new repos for each project (they would act as parent repos). Then, If someone was going to work on Product1, they would clone the Product1 repo, which contained Product1.sln and subrepo references to ReferenceAssemblies, Core, Core.Tests, Database, Database.Tests, CMS, and CMS.Tests.
So, it's easy to do this by just hg init'ing in the project directories. But can it be done while preserving history? Or is there a better way to arrange this?
EDIT::::
Thanks to Ry4an's answer, I was able to accomplish my goal. I wanted to share how I did it here for others.
Since we had a lot of separate projects, I wrote a small bash script to automate creating the filemaps and to create the final bat script to actually do the conversion. What wasn't completely apparent from the answer, is that the convert command needs to be run once for each filemap, to produce a separate repository for each project. This script would be placed in the directory above a svn working copy that you have previously converted. I used the working copy since it's file structure best matched what I wanted the final new hg repos to be.
#!/bin/bash
# this requires you to be in: /path/to/svn/working/copy/, and issue: ../filemaplister.sh ./
for filename in *
do
extension=${filename##*.} #$filename|awk -F . '{print $NF}'
if [ "$extension" == "sln" -o "$extension" == "suo" -o "$extension" == "vsmdi" ]; then
base=${filename%.*}
echo "#$base.filemap" >> "$base.filemap"
echo "include $filename" >> "$base.filemap"
echo "C:\Applications\TortoiseHgPortable\hg.exe convert --filemap $base.filemap ../hg-datesort-converted ../hg-separated/$base > $base.convert.output.txt" >> "MASTERGO.convert.bat"
else
echo "#$filename.filemap" >> "$filename.filemap"
echo "include $filename" >> "$filename.filemap"
echo "rename $filename ." >> "$filename.filemap"
echo "C:\Applications\TortoiseHgPortable\hg.exe convert --filemap $filename.filemap ../hg-datesort-converted ../hg-separated/$filename > $filename.convert.output.txt" >> "MASTERGO.convert.bat"
fi
done;
mv *.filemap ../hg-conversion-filemaps/
mv *.convert.bat ../hg-conversion-filemaps/
This script looks at every file in an svn working copy, and depending on the type either creates a new filemap file or appends to an existing one. The if is really just to catch misc visual studio files, and place them into a separate repo. This is meant to be run on bash (cygwin in my case), but running the actual convert command is accomplished through the version of hg shipped with TortoiseHg due to forking/process issues on Windows (gah, I know...).
So you run the MASTERGO.convert.bat file, which looks at your converted hg repo, and creates separate repos using the supplied filemap. After it is complete, there is a folder called hg-separated that contains a folder/repo for each project, as well as a folder/repo for each solution. You then have to manually clone all the projects into a solution repo, and add the clones to the .hgsub file. After committing, an .hgsubstate file is created and you're set to go!
With the example given above, my .hgsub file looks like this for "Product1":
Product1.Domain = /absolute/path/to/Product1.Domain
Product1.Stresstester = /absolute/path/to/Product1.Stresstester
Product1.Web = /absolute/path/to/Product1.Web
Product1.Web.Tests = /absolute/path/to/Product1.Web.Tests
Once I transfer these repos to a central server, I'll be manually changing the paths to be urls.
Also, there is no analog to the initial OurPlatform svn repo, since everything is separated now.
Thanks again!
This can absolutely be done. You'll want to use the hg convert command. Here's the process I'd use:
hg convert with a source type of svn and a dest type of hg (it sounds like you've already done this step)filemap files for use with hg convert's --filemap optionhg convert with source type hg and dest type hg and the source being the mercurial repo created in step one -- and do it for each of the filemaps you created in step two.The filemap syntax is shown in the hg help convert output, but here's the gist:
The filemap is a file that allows filtering and remapping of files and
directories. Comment lines start with '#'. Each line can contain one of
the following directives:
include path/to/file
exclude path/to/file
rename from/file to/file
So in your example your filemaps would look like this:
# this is Core.filemap
include Core
rename Core .
Note that if you have an include that the exclusion of everything else is implied. Also that rename line ends in a dot and moves everything up one level.
# this is Core.Tests
include Core.Tests
rename Core.Tests .
and so on.
Once you've created the broken-out repositories for each of the new repos, you can delete the has-everything initial repo created in step one and start setting up your subrepo configuration in .hgsub files.
I am running Visual Studio 2010. I have a XSD schema and want to use xsd.exe tool to generate appropriate C# file. I have done this successfully from a command line but now I want to do the same from IDE.
Is there some well-known route for this? I have managed to use a pre-build event but I hate to have the tool running on each build. Normally, it should only run when XSD changes.
Adding the generated .cs file to project puts it under .xsd of the same name, so the IDE knows they are related.
I know I can set "Custom Tool" on my .xsd but I am not sure if that achieves the desired effect. I was hoping for a more straightforward way.
And ultimately, VS2010 cannot execute XSD.EXE because it lives in the SDK folder and the path known to VS obviously does not include it.
Any suggestions are welcome!
You can check out Xsd2Code for a VS addin that does this interactively. The author is also working on a VS2010 version, as far as I know.
Microsoft's C++ compiler and linker seem to have an odd relationship with mspdb100.dll. When run from the IDE, of course, the compiler and linker work fine. When running either one from the command line, I get the following error:
No problem, I located the DLL and copied it to the directory. Now the compiler works fine, but the linker dies with:
I could solve the problem by adding "%VS10%\Common7\IDE" to my PATH, but for various reasons (performance, system purity, OCD, etc), I don't want to do that. Why is this setup so touchy, and is there anything else I can do to solve it?
try running path\to\VC\bin\vcvars32.bat from within your current shell first. This should ensure your command-line setup will match the IDE-setup.
This is not a permanent fix -- you need to do it every time you launch a new shell.
You could probably also find some way to add everything that's in that .bat permanently to the environment variables, but.... like you asked, why the heck doesn't the MS install do that already?
i know this is a bit dated but if anyone's looking for a way to get compiler running from command line; here's what I did to get it running . I'm using Win7 32bit and Visual Studio 2010. I created a small batch file in C:\Windows. open cmd prompt at C:\Windows as admin, then type the following:
copy con cl.bat (hit enter)
@"C:\Program Files\Microsoft Visual Studio 10.0\VC\bin\vcvars32" %1 %2 %3 %4 %5 %6 (hit enter) @"C:\Program Files\Microsoft Visual Studio 10.0\VC\bin\cl" %1 %2 %3 %4 %5 %6 (hit enter)
then press f6 and hit enter again
Obviously the path you will use is the install path to where you installed visual studio .
you now have working command line compiler from any location or directory in windows. To test this go to desktop and open cmd prompt as admin; I prefer to use Ctrl+Shift and right click then choose open command prompt here. At command prompt type "cl" (without quotes) and hit enter. you will see a message "Setting enviroment for using Microsoft Visual Studio 2010 x86 tools"
type "cl" and hit enter again and you will get your compiler info. you're all set to compile.
enjoy
Add Microsoft Visual Studio 10.0\Common7\IDE to your path, and this issue will not exist any more. You will be able to build without running this silly batch file every time.
OtherMichael - thanks that worked for me. Although, I had to call vcvars32.bat that is located in the bin folder, which is of course what you meant, but keyboard was trickier this time. I'm just clearing it out because it took me a minute to figure out that a slash got away from your Answer ;)
I noticed when I installed Microsoft Visual Studio 2010 Express that under the "Microsoft Visual Studio 2010 Express" folder in the Start Menu, there is a link to "Visual Studio Command Prompt (2010)", which sets up all the necessary environment variables when opened. That way you shouldn't have to edit you PATH variable.
This shortcut runs the following:
%comspec% /k ""C:\Program Files\Microsoft Visual Studio 10.0\VC\vcvarsall.bat"" x86
If it's not convenient to use the shortcut, perhaps you could learn something of use from investigating what this .bat file does?
I would like the files generated by my custom tool to be hidden, but I cannot find any documentation on how this is done.
An example of what I'm looking for is WPF code behind files. These files are not displayed in the Visual Studio project view, yet are compiled with the project and are available in IntelliSense. WPF code behind files (Window1.g.i.cs, for example), are generated by a custom tool.
The solution is to create a Target that adds your files to the Compile ItemGroup rather than adding them explicitly in your .csproj file. That way Intellisense will see them and they will be compiled into your executable, but they will not show up in Visual Studio.
Simple example
You also need to make sure your target is added to the CoreCompileDependsOn property so it will execute before the compiler runs.
Here is an extremely simple example:
<PropertyGroup>
<CoreCompileDependsOn>$(CoreCompileDependsOn);AddToolOutput</CoreCompileDependsOn>
</PropertyGroup>
<Target Name="AddToolOutput">
<ItemGroup>
<Compile Include="HiddenFile.cs" />
</ItemGroup>
</Target>
If you add this to the bottom of your .csproj file (just before </Project>), your "HiddenFile.cs" will be included in your compilation even though it doesn't appear in Visual Studio.
Using a separate .targets file
Instead of placing this directly in your .csproj file, you would generally placed it in a separate .targets file surrounded by:
<Project xmlns="http://schemas.microsoft.com/developer/msbuild/2003">
...
</Project>
and import into your .csproj with <Import Project="MyTool.targets">. A .targets file is recommended even for one-off cases because it separates your custom code from the stuff in .csproj that is maintained by Visual Studio.
Constructing the generated filename(s)
If you are creating a generalized tool and/or using a separate .targets file, you probably don't want to explicitly list each hidden file. Instead you want to generate the hidden file names from other settings in the project. For example if you want all Resource files to have corresponding tool-generated files in the "obj" directory, your Target would be:
<Target Name="AddToolOutput">
<ItemGroup>
<Compile Include="@(Resource->'$(IntermediateOutputPath)%(FileName)%(Extension).g.cs')" />
</ItemGroup>
</Target>
The "IntermediateOutputPath" property is what we all know as the "obj" directory, but if the end-user of your .targets has customized this your intermediate files will stil be found in the same place. If you prefer your generated files to be in the main project directory and not in the "obj" directory, you can leave this off.
If you want only some of the files of an existing item type to be processed by your custom tool? For example, you may want to generate files for all Page and Resource files with a ".xyz" extension.
<Target Name="AddToolOutput">
<ItemGroup>
<MyToolFiles Include="@(Page);@(Resource)" Condition="'%(Extension)'=='.xyz' />
<Compile Include="@(MyToolFiles->'$(IntermediateOutputPath)%(FileName)%(Extension).g.cs')"/>
</ItemGroup>
</Target>
Note that you can't use the metadata syntax like %(Extension) in a top-level ItemGroup but you can do so within a Target.
Using a custom item type (aka Build Action)
The above processes files that have an existing item type such as Page, Resource, or Compile (Visual Studio calls this the "Build Action"). If your items are a new kind of file you can use your own custom item type. For example if your input files are called "Xyz" files, your project file can define "Xyz" as a valid item type:
<ItemGroup>
<AvailableItemName Include="Xyz" />
</ItemGroup>
after which Visual Studio will allow you to select "Xyz" in the Build Action in the file's properties, resulting in this being added to your .csproj:
<ItemGroup>
<Xyz Include="Something.xyz" />
</ItemGroup>
Now you can use the "Xyz" item type to create the filenames for tool output, just as we did previously with the "Resource" item type:
<Target Name="AddToolOutput">
<ItemGroup>
<Compile Include="@(Xyz->'$(IntermediateOutputPath)%(FileName)%(Extension).g.cs')" />
</ItemGroup>
</Target>
When using a custom item type you can cause your items to also be handled by built-in mechanisms by mapping them to another item type (aka Build Action). This is useful if your "Xyz" files are really .cs files or .xaml or if they need to be made
EmbeddedResources. For example you can cause all files with "Build Action" of Xyz to also be compiled:
<ItemGroup>
<Compile Include="@(Xyz)" />
</ItemGroup>
Or if your "Xyz" source files should be stored as embedded resources, you can express it this way:
<ItemGroup>
<EmbeddedResource Include="@(Xyz)" />
</ItemGroup>
Note that the second example won't work if you put it inside the Target, since the target isn't evaluated until just before the core compile. To make this work inside a Target you have to list the target name in PrepareForBuildDependsOn property instead of CoreCompileDependsOn.
Invoking your custom code generator from MSBuild
Having gone as far as creating a .targets file, you might consider invoking your tool directly from MSBuild rather than using a separate pre-build event or Visual Studio's flawed "Custom Tool" mechanism.
To do this:
UsingTask element to your .targets file, and in your target add a call to your new taskHere is all you need to implement ITask:
public class GenerateCodeFromXyzFiles : ITask
{
public IBuildEngine BuildEngine { get; set; }
public ITaskHost HostObject { get; set; }
public ITaskItem[] InputFiles { get; set; }
public ITaskItem[] OutputFiles { get; set; }
public bool Execute()
{
for(int i=0; i<InputFiles.Length; i++)
File.WriteAllText(OutputFiles[i].ItemSpec,
ProcessXyzFile(
File.ReadAllText(InputFiles[i].ItemSpec)));
}
private string ProcessXyzFile(string xyzFileContents)
{
// Process file and return generated code
}
}
And here is the UsingTask element and a Target that calls it:
<UsingTask TaskName="MyNamespace.GenerateCodeFromXyzFiles" AssemblyFile="MyTaskProject.dll" />
<Target Name="GenerateToolOutput">
<GenerateCodeFromXyzFiles
InputFiles="@(Xyz)"
OutputFiles="@(Xyz->'$(IntermediateOutputPath)%(FileName)%(Extension).g.cs')">
<Output TaskParameter="OutputFiles" ItemGroup="Compile" />
</GenerateCodeFromXyzFiles>
</Target>
Note that this target's Output element places the list of output files directly into Compile, so there is no need to use a separate ItemGroup to do this.
How the old "Custom Tool" mechanism is flawed and why not to use it
A note on Visual Studio's "Custom Tool" mechanism: In NET Framework 1.x we didn't have MSBuild, so we had to rely on Visual Studio to build our projects. In order to get Intellisense on generated code, Visual Studio had a mechanism called "Custom Tool" that can be set in the Properties window on a file. The mechanism was fundamentally flawed in several ways, which is why it was replaced with MSBuild targets. Some of the problems with the "Custom Tool" feature were:
If you are using the old "Custom Tool" feature, I strongly recommend you switch to using a MSBuild task. It works well with Intellisense and allows you to build your project without even installing Visual Studio (all you need is NET Framework).
When will your custom build task run?
In general your custom build task will run:
To be more precise:
You may want to force your generator to run at other times, such as when some environment variable changes, or force it to run synchronously rather in the background.
To cause the generator to re-run even when no input files have changed, the best way is usually to add an additional Input to your Target which is a dummy input file stored in the "obj" directory. Then whenever an environment variable or some external setting changes that should force your generator tool to re-run, simply touch this file (ie. create it or update its modified date).
To force the generator to run synchronously rather than waiting for IntelliSense to run it in the background, just use MSBuild to build your particular target. This could be as simple as executing "MSBuild /t:GenerateToolOutput", or VSIP may provide a build-in way to call custom build targets. Alternatively you could simply invoke the Build command and wait for it to complete.
Note that "Input files" in this section refers to whatever is listed in the "Inputs" attribute of the Target element.
Final notes
You may get warnings from Visual Studio that it doesn't know whether to trust your custom tool .targets file. To fix this, add it to the HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\VisualStudio\9.0\MSBuild\SafeImports registry key.
Here is a summary of what an actual .targets file would look like with all the pieces in place:
<Project xmlns="http://schemas.microsoft.com/developer/msbuild/2003">
<PropertyGroup>
<CoreCompileDependsOn>$(CoreCompileDependsOn);GenerateToolOutput</CoreCompileDependsOn>
</PropertyGroup>
<UsingTask TaskName="MyNamespace.GenerateCodeFromXyzFiles" AssemblyFile="MyTaskProject.dll" />
<Target Name="GenerateToolOutput" Inputs="@(Xyz)" Outputs="@(Xyz->'$(IntermediateOutputPath)%(FileName)%(Extension).g.cs')">
<GenerateCodeFromXyzFiles
InputFiles="@(Xyz)"
OutputFiles="@(Xyz->'$(IntermediateOutputPath)%(FileName)%(Extension).g.cs')">
<Output TaskParameter="OutputFiles" ItemGroup="Compile" />
</GenerateCodeFromXyzFiles>
</Target>
</Project>
Please let me know if you have any questions or there is anything here you didn't understand.
To hide items from Visual Studio add a Visible metadata property to the item. The InProject metadata apparently does this too.
Visible: http://msdn.microsoft.com/en-us/library/ms171468(VS.90).aspx
InProject: http://blogs.msdn.com/b/jomo_fisher/archive/2005/01/25/360302.aspx
<ItemGroup>
<Compile Include="$(AssemblyInfoPath)">
<!-- either: -->
<InProject>false</InProject>
<!-- or: -->
<Visible>false</Visible>
</Compile>
</ItemGroup>
The only way I know to do it is to add the generated file to have a dependency on the file you want it hidden behind - in the proj file.
For example:
<ItemGroup>
<Compile Include="test.cs" />
<Compile Include="test.g.i.cs">
<DependentUpon>test.cs</DependentUpon>
</Compile>
</ItemGroup>
If you removed the DependentUpon element then the file shows up beside the other file instead of behind it ... how does your generator add the files? can you walk us through the use case and how you would like it to work?
I think you want to look here: http://msdn.microsoft.com/en-us/library/ms171453.aspx.
Specifically, the "Creating Items During Execution" section.
ListView.ScrollIntoView(object) currently finds an object in the ListView and scrolls to it. If you are positioned beneath the object you are scrolling to, it scrolls the object to the top row. If you are positioned above, it scrolls it into view at the bottom row.
I'd like to have the item be scrolled right into the center of my list view if it is currently not visible. Is there an easy way to accomplish this?
It is very easy to do this in WPF with an extension method I wrote. All you have to do to scroll an item to the center of the view is to call a single method.
Suppose you have this XAML:
<ListView x:Name="view" ItemsSource="{Binding Data}" />
<ComboBox x:Name="box" ItemsSource="{Binding Data}"
SelectionChanged="ScrollIntoView" />
Your ScrollIntoView method will be simply:
private void ScrollIntoView(object sender, SelectionChangedEventArgs e)
{
view.ScrollToCenterOfView(box.SelectedItem);
}
Obviously this could be done using a ViewModel as well rather than referencing the controls explicitly.
Following is the implementation. It is very general, handling all the IScrollInfo possibilities. It works with ListBox or any other ItemsControl, and works with any panel including StackPanel, VirtualizingStackPanel, WrapPanel, DockPanel, Canvas, Grid, etc.
Just put this in a .cs file somewhere in your project:
public static class ItemsControlExtensions
{
public static void ScrollToCenterOfView(this ItemsControl itemsControl, object item)
{
// Scroll immediately if possible
if(!itemsControl.TryScrollToCenterOfView(item))
{
// Otherwise wait until everything is loaded, then scroll
if(itemsControl is ListBox) ((ListBox)itemsControl).ScrollIntoView(item);
itemsControl.Dispatcher.BeginInvoke(DispatcherPriority.Loaded, new Action(() =>
{
itemsControl.TryScrollToCenterOfView(item);
}));
}
}
private static bool TryScrollToCenterOfView(this ItemsControl itemsControl, object item)
{
// Find the container
var container = itemsControl.ItemContainerGenerator.ContainerFromItem(item) as UIElement;
if(container==null) return false;
// Find the ScrollContentPresenter
ScrollContentPresenter presenter = null;
for(Visual vis = container; vis!=null && vis!=itemsControl; vis = VisualTreeHelper.GetParent(vis) as Visual)
if((presenter = vis as ScrollContentPresenter)!=null)
break;
if(presenter==null) return false;
// Find the IScrollInfo
var scrollInfo =
!presenter.CanContentScroll ? presenter :
presenter.Content as IScrollInfo ??
FirstVisualChild(presenter.Content as ItemsPresenter) as IScrollInfo ??
presenter;
// Compute the center point of the container relative to the scrollInfo
Size size = container.RenderSize;
Point center = container.TransformToAncestor((Visual)scrollInfo).Transform(new Point(size.Width/2, size.Height/2));
center.Y += scrollInfo.VerticalOffset;
center.X += scrollInfo.HorizontalOffset;
// Adjust for logical scrolling
if(scrollInfo is StackPanel || scrollInfo is VirtualizingStackPanel)
{
double logicalCenter = itemsControl.ItemContainerGenerator.IndexFromContainer(container) + 0.5;
Orientation orientation = scrollInfo is StackPanel ? ((StackPanel)scrollInfo).Orientation : ((VirtualizingStackPanel)scrollInfo).Orientation;
if(orientation==Orientation.Horizontal)
center.X = logicalCenter;
else
center.Y = logicalCenter;
}
// Scroll the center of the container to the center of the viewport
if(scrollInfo.CanVerticallyScroll) scrollInfo.SetVerticalOffset(CenteringOffset(center.Y, scrollInfo.ViewportHeight, scrollInfo.ExtentHeight));
if(scrollInfo.CanHorizontallyScroll) scrollInfo.SetHorizontalOffset(CenteringOffset(center.X, scrollInfo.ViewportWidth, scrollInfo.ExtentWidth));
return true;
}
private static double CenteringOffset(double center, double viewport, double extent)
{
return Math.Min(extent - viewport, Math.Max(0, center - viewport/2));
}
private static DependencyObject FirstVisualChild(Visual visual)
{
if(visual==null) return null;
if(VisualTreeHelper.GetChildrenCount(visual)==0) return null;
return VisualTreeHelper.GetChild(visual, 0);
}
}
Ray Burns' excellent answer above is WPF specific.
Here is a modified version that works in Silverlight:
public static class ItemsControlExtensions
{
public static void ScrollToCenterOfView(this ItemsControl itemsControl, object item)
{
// Scroll immediately if possible
if (!itemsControl.TryScrollToCenterOfView(item))
{
// Otherwise wait until everything is loaded, then scroll
if (itemsControl is ListBox) ((ListBox)itemsControl).ScrollIntoView(item);
itemsControl.Dispatcher.BeginInvoke( new Action(() =>
{
itemsControl.TryScrollToCenterOfView(item);
}));
}
}
private static bool TryScrollToCenterOfView(this ItemsControl itemsControl, object item)
{
// Find the container
var container = itemsControl.ItemContainerGenerator.ContainerFromItem(item) as UIElement;
if (container == null) return false;
// Find the ScrollContentPresenter
ScrollContentPresenter presenter = null;
for (UIElement vis = container; vis != null ; vis = VisualTreeHelper.GetParent(vis) as UIElement)
if ((presenter = vis as ScrollContentPresenter) != null)
break;
if (presenter == null) return false;
// Find the IScrollInfo
var scrollInfo =
!presenter.CanVerticallyScroll ? presenter :
presenter.Content as IScrollInfo ??
FirstVisualChild(presenter.Content as ItemsPresenter) as IScrollInfo ??
presenter;
// Compute the center point of the container relative to the scrollInfo
Size size = container.RenderSize;
Point center = container.TransformToVisual((UIElement)scrollInfo).Transform(new Point(size.Width / 2, size.Height / 2));
center.Y += scrollInfo.VerticalOffset;
center.X += scrollInfo.HorizontalOffset;
// Adjust for logical scrolling
if (scrollInfo is StackPanel || scrollInfo is VirtualizingStackPanel)
{
double logicalCenter = itemsControl.ItemContainerGenerator.IndexFromContainer(container) + 0.5;
Orientation orientation = scrollInfo is StackPanel ? ((StackPanel)scrollInfo).Orientation : ((VirtualizingStackPanel)scrollInfo).Orientation;
if (orientation == Orientation.Horizontal)
center.X = logicalCenter;
else
center.Y = logicalCenter;
}
// Scroll the center of the container to the center of the viewport
if (scrollInfo.CanVerticallyScroll) scrollInfo.SetVerticalOffset(CenteringOffset(center.Y, scrollInfo.ViewportHeight, scrollInfo.ExtentHeight));
if (scrollInfo.CanHorizontallyScroll) scrollInfo.SetHorizontalOffset(CenteringOffset(center.X, scrollInfo.ViewportWidth, scrollInfo.ExtentWidth));
return true;
}
private static double CenteringOffset(double center, double viewport, double extent)
{
return Math.Min(extent - viewport, Math.Max(0, center - viewport / 2));
}
private static DependencyObject FirstVisualChild(UIElement visual)
{
if (visual == null) return null;
if (VisualTreeHelper.GetChildrenCount(visual) == 0) return null;
return VisualTreeHelper.GetChild(visual, 0);
}
}
I seem to recall doing something like this myself at some point. As far as my memory goes, what I did was:
(index you want) - (number of objects displayed / 2) should be the top row, so scroll to that (making sure you don't go negative, of course)If you look at the template of a Listbox it is simply a scrollviewer with an itemspresenter inside. You'll need to calculate the size of your items and use scroll horizontally or vertically to position the items in your scrollviewer. The april silverlight toolkit has an extension method GetScrollHost that you can call on a listbox to get your underlying scrollviewer.
Once you have that you can use the current Horizontal or Vertical Offset as a frame of reference and move your list accordinly.
The below sample will find the scrollviewer of the listview and use it to scroll the item to me middle of the listview.
XAML:
<Window x:Class="ScrollIntoViewTest.Window1"
xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
Height="300" Width="300">
<Grid>
<Grid.RowDefinitions>
<RowDefinition Height="*" />
<RowDefinition Height="Auto" />
</Grid.RowDefinitions>
<ListView Grid.Row="0" ItemsSource="{Binding Path=Data}" Loaded="OnListViewLoaded"/>
<ComboBox Grid.Row="1" ItemsSource="{Binding Path=Data}" SelectionChanged="OnScrollIntoView" />
</Grid>
</Window>
Code behind:
using System;
using System.Collections.Generic;
using System.Windows;
using System.Windows.Controls;
using System.Windows.Media;
namespace ScrollIntoViewTest
{
public partial class Window1 : Window
{
public Window1()
{
InitializeComponent();
Data = new List<string>();
for (int i = 0; i < 100; i++)
{
Data.Add(i.ToString());
}
DataContext = this;
}
public List<string> Data { get; set; }
private void OnListViewLoaded(object sender, RoutedEventArgs e)
{
// Assumes that the listview consists of a scrollviewer with a border around it
// which is the default.
Border border = VisualTreeHelper.GetChild(sender as DependencyObject, 0) as Border;
_scrollViewer = VisualTreeHelper.GetChild(border, 0) as ScrollViewer;
}
private void OnScrollIntoView(object sender, SelectionChangedEventArgs e)
{
string item = (sender as ComboBox).SelectedItem as string;
double index = Data.IndexOf(item) - Math.Truncate(_scrollViewer.ViewportHeight / 2);
_scrollViewer.ScrollToVerticalOffset(index);
}
private ScrollViewer _scrollViewer;
}
}
I am trying to use VS2010's 1-Click Publish feature to deploy a test site from my laptop to my server. I have the firewall turned off on both machines and the MS Deployment Service is up and running on both my laptop and the server.
However, when I try and publish from VS2010 on my laptop I get the following error:
Error 1 Web deployment task failed.(Remote agent (URL https://192.168.1.181/:8172/msdeploy.axd?site=LocationsTest) could not be contacted. Make sure the remote agent service is installed and started on the target computer.)
The requested resource does not exist, or the requested URL is incorrect.
Error details:
Remote agent (URL https://192.168.1.181/:8172/msdeploy.axd?site=LocationsTest) could not be contacted. Make sure the remote agent service is installed and started on the target computer.
An unsupported response was received. The response header 'MSDeploy.Response' was '' but 'v1' was expected.
The remote server returned an error: (404) Not Found. 0 0 Test.Web
Any idea what I am doing wrong here?
Make sure you have the WMSvc Service (Web Management Service) set to 'Auto' (and started) so it's on when you restart & check out this link http://learn.iis.net/page.aspx/516/configure-the-web-deployment-handler/
Make sure you have set Site/Application correctly in publish profile:
You get the same error message if you spell site or application name wrong.
I've had this one come up on a few occasions after having just successfully deployed a WebApp on a server running IIS 7.5. Obviously since a deployment/publishing was done successfully on the server just before this error came up, there was very little that could have gone wrong on the server setup/configuration (unless the previous successful deployment did something horribly wrong and removed some configuration parameters on the server).
After having rebooted the server, checked that Web Management service and Web Deployment service were running correctly, and verified from cUrl tool that a GET of the MsDeploy.axd was successful there was only one thing left to do. Restart Visual Studio. Magically post restart of VS publish started working again. All on its own. Magical stuff, this Web Deployment :)
Although a lot of different unrelated things can contribute to getting the 404, I solved it for my by.
After this, everything works fine. Assuming the Web Management Service is setup correctly (mine is configured to accept remote connections, the firewall port was opened, and the user I'm uploading with was added to every single Site that I want to deploy to (using the IIS Manager Permissions icon in each Site node in the IIS Manager)).
This same message would occur almost at random when publishing projects from visual studio 2010.
The fix was to delete the $projectname.Publish.xml file (in the root directory of the project) and re-create it.
If you are using an SSL certificate you should go into Management Service under the IIS Manager section of Server Manager and stop the service, select the correct certificate and then start the service again. This is what worked for me (I was getting Forbidden message).
There is a list for GCC; is there a similar list for Visual Studio 2010?
There is also a list for Visual C++ 2010 (that article describes the core language features that have been implemented; the PDF linked from the article describes the library features that have been implemented).
Edit: I've just come across an awesome list: the Apache C++ Standard Library wiki has a table listing the C++0x core language features and which C++ compilers support each of them.
Here is the best list IMO since it breaks it down into several tabs like core language, library, etc: Summary of C++0x Feature Availability in gcc and MSVC
The What's new in Visual C++ 2010 MSDN page summarises the new feature support as well.
Update: A sample project reproducing this bug can be found here at Microsoft Connect. I have also tested and verified that the solution given in the accepted answer below works on that sample project. If this solution doesn't work for you, you are probably having a different issue (which belongs in a separate question).
This is a question asked before, both here on Stack Overflow and other places, but none of the suggestions I've found this far has helped me, so I just have to try asking a new question.
Scenario: I have a simple Windows Forms application (C#, .NET 4.0, Visual Studio 2010). It has a couple of base forms that most other forms inherit from, it uses Entity Framework (and POCO classes) for database access. Nothing fancy, no multi-threading or anything.
Problem: All was fine for a while. Then, all out of the blue, Visual Studio failed to build when I was about to launch the application. I got the warning "Unable to delete file '...bin\Debug\[ProjectName].exe'. Access to the path '...bin\Debug\[ProjectName].exe' is denied." and the error "Unable to copy file 'obj\x86\Debug\[ProjectName].exe' to 'bin\Debug\[ProjectName].exe'. The process cannot access the file 'bin\Debug\[ProjectName].exe' because it is being used by another process." (I get both the warning and the error when running Rebuild, but only the error when running Build - don't think that is relevant?)
I understand perfectly fine what the warning and error message says: Visual Studio is obviously trying to overwrite the exe-file while it the same time has a lock on it for some reason. However, this doesn't help me find a solution to the problem... The only thing I've found working is to shut down Visual Studio and start it again. Building and launching then works, untill I make a change in some of the forms, then I have the same problem again and have to restart... Quite frustrating!
As I mentioned above, this seems to be a known problem, so there are lots of suggested solutions. I'll just list what I've already tried here, so people know what to skip:
Adding the following to the following to the project's pre-build event:
if exist "$(TargetPath).locked" del "$(TargetPath).locked"
if not exist "$(TargetPath).locked" if exist "$(TargetPath)" move "$(TargetPath)" "$(TargetPath).locked"
Adding the following to the project properties (.csproj file):
<GenerateResourceNeverLockTypeAssemblies>true</GenerateResourceNeverLockTypeAssemblies>
However, none of them worked for me, so you can probably see why I'm starting to get a bit frustrated. I don't know where else to look, so I hope somebody has something to give me! Is this a bug in VS, and if so is there a patch? Or has I done something wrong, do I have a circular reference or similar, and if so how could I find out?
Any suggestions are highly appreciated :)
Update: As mentioned in comment below, I've also checked using Process Explorer that it actually is Visual Studio that is locking the file.
This is going to sound stupid, but I tried all these solutions, running VS2010 on Windows 7. None of them worked except the renaming and building, which was VERY tedious to say the least. Eventually, I tracked down the culprit, and I find it hard to believe. But I was using the following code in AssemblyInfo.cs...
[assembly: AssemblyVersion("2.0.*")]
This is pretty common, but for some reason, changing the version to 2.0.0.0 made things work again. I don't know if it's a Windows 7 specific thing (I've only been using it for 3-4 weeks), or if it's random, or what, but it fixed it for me. I'm guessing that VS was keeping a handle on each file it generated, so it would know how to increment things? I'm really not sure and have never seen this happen before. But if someone else out there is also pulling their hair out, give it a try.
Since I haven't gotten any more feedback on this issue, I thought I'd just share what ended up being my solution:
As suggested by Barry in a comment to the original post, manually renaming the '...bin\Debug[ProjectName].exe' to something else (e.g. '[ProjectName]1.exe') is one work-around (I'm however not allowed to delete the file myself, and I must say I find that a bit weird as one would believe the same lock preventing deletion would also prevent renaming...). It's not a good solution, but it's reasonable fast (at least after you've done it a couple of times, it almost becomes a routine), and at least way faster than restarting Visual Studio which is what I did in the beginning.
In case somebody wonders, I could also add that I only see this problem semi-randomly. It usually happens after I've done some changes in the design mode of a form (but not always). It usually doesn't happen if I only change business-logic code or non-visual related code (but sometimes it does...). Frustrating indeed, but at least I have a hack that works for me - let's just hope that my next project doesn't face this problem as well...
@Barry: if you would like to get credit for your comment, please feel free to post it as an answer and I'll make sure to accept it :)
I'd suggest download Process Explorer to find out exactly what process is locking the file. It can be found at:
http://technet.microsoft.com/en-us/sysinternals/bb896653.aspx
I have the same problem (MSB3021) with WPF project in VS2008 (on Windows 7 x32). The problem appearing if i try to re-run application too quick after previous run. After a few minutes exe-file unlocked by itself and i can re-run application again. But such a long pause angers me. The only thing that really helped me was running VS as Administrator.
This has been filed multiple times on Connect, Microsoft's community bug reporting site. FYI, I believe this bug has afflicted Visual Studio since 2003 and has been fixed after RTM each time. :( One of the references is as follows:
Using Visual Studio I could never come up with a simple project to reproduce the error.
My solution was to disable the Visual Studio Hosting process.
For those interested I have attached a handle trace for the offending handle:
0:044> !htrace 242C
--------------------------------------
Handle = 0x000000000000242c - OPEN
Thread ID = 0x0000000000001cd0, Process ID = 0x0000000000001a5c
0x000000007722040a: ntdll!ZwCreateFile+0x000000000000000a
0x0000000074b4bfe3: wow64!whNtCreateFile+0x000000000000010f
0x0000000074b3cf87: wow64!Wow64SystemServiceEx+0x00000000000000d7
0x0000000074ac276d: wow64cpu!TurboDispatchJumpAddressEnd+0x0000000000000024
0x0000000074b3d07e: wow64!RunCpuSimulation+0x000000000000000a
0x0000000074b3c549: wow64!Wow64LdrpInitialize+0x0000000000000429
0x00000000772184c8: ntdll!LdrpInitializeProcess+0x00000000000017e2
0x0000000077217623: ntdll! ?? ::FNODOBFM::`string'+0x000000000002bea0
0x000000007720308e: ntdll!LdrInitializeThunk+0x000000000000000e
0x00000000773d0066: ntdll_773b0000!NtCreateFile+0x0000000000000012
0x000000007541b616: KERNELBASE!CreateFileW+0x000000000000035e
0x0000000075b42345: KERNEL32!CreateFileWImplementation+0x0000000000000069
0x000000006a071b47: mscorwks_ntdef!StgIO::Open+0x000000000000028c
--------------------------------------
Handle = 0x000000000000242c - CLOSE
Thread ID = 0x0000000000000cd4, Process ID = 0x0000000000001a5c
0x000000007721ffaa: ntdll!ZwClose+0x000000000000000a
0x0000000074b3f2cd: wow64!whNtClose+0x0000000000000011
0x0000000074b3cf87: wow64!Wow64SystemServiceEx+0x00000000000000d7
0x0000000074ac276d: wow64cpu!TurboDispatchJumpAddressEnd+0x0000000000000024
0x0000000074b3d07e: wow64!RunCpuSimulation+0x000000000000000a
0x0000000074b3c549: wow64!Wow64LdrpInitialize+0x0000000000000429
0x000000007724d177: ntdll! ?? ::FNODOBFM::`string'+0x000000000002bfe4
0x000000007720308e: ntdll!LdrInitializeThunk+0x000000000000000e
0x00000000773cf992: ntdll_773b0000!ZwClose+0x0000000000000012
0x0000000075b42642: KERNEL32!BaseRegCloseKeyInternal+0x0000000000000041
0x0000000075b425bc: KERNEL32!RegCloseKey+0x000000000000007d
*** WARNING: Unable to verify checksum for mscorlib.ni.dll
0x0000000068f13ca3: mscorlib_ni+0x0000000000233ca3
0x0000000069bc21db: mscorwks_ntdef!CallDescrWorker+0x0000000000000033
0x0000000069be4a2a: mscorwks_ntdef!CallDescrWorkerWithHandler+0x000000000000008e
--------------------------------------
Handle = 0x000000000000242c - OPEN
Thread ID = 0x00000000000006cc, Process ID = 0x0000000000001a5c
0x0000000077220e0a: ntdll!NtOpenKeyEx+0x000000000000000a
0x0000000074b5d1c9: wow64!Wow64NtOpenKey+0x0000000000000091
0x0000000074b5313b: wow64!whNtOpenKeyEx+0x0000000000000073
0x0000000074b3cf87: wow64!Wow64SystemServiceEx+0x00000000000000d7
0x0000000074ac276d: wow64cpu!TurboDispatchJumpAddressEnd+0x0000000000000024
0x0000000074b3d07e: wow64!RunCpuSimulation+0x000000000000000a
0x0000000074b3c549: wow64!Wow64LdrpInitialize+0x0000000000000429
0x000000007724d177: ntdll! ?? ::FNODOBFM::`string'+0x000000000002bfe4
0x000000007720308e: ntdll!LdrInitializeThunk+0x000000000000000e
0x00000000773d0fca: ntdll_773b0000!NtOpenKeyEx+0x0000000000000012
0x0000000075b42721: KERNEL32!LocalBaseRegOpenKey+0x000000000000010c
0x0000000075b428c9: KERNEL32!RegOpenKeyExInternalW+0x0000000000000130
0x0000000075b427b5: KERNEL32!RegOpenKeyExW+0x0000000000000021
--------------------------------------
Handle = 0x000000000000242c - CLOSE
Thread ID = 0x0000000000000cd4, Process ID = 0x0000000000001a5c
0x000000007721ffaa: ntdll!ZwClose+0x000000000000000a
0x0000000074b3f2cd: wow64!whNtClose+0x0000000000000011
0x0000000074b3cf87: wow64!Wow64SystemServiceEx+0x00000000000000d7
0x0000000074ac276d: wow64cpu!TurboDispatchJumpAddressEnd+0x0000000000000024
0x0000000074b3d07e: wow64!RunCpuSimulation+0x000000000000000a
0x0000000074b3c549: wow64!Wow64LdrpInitialize+0x0000000000000429
0x000000007724d177: ntdll! ?? ::FNODOBFM::`string'+0x000000000002bfe4
0x000000007720308e: ntdll!LdrInitializeThunk+0x000000000000000e
0x00000000773cf992: ntdll_773b0000!ZwClose+0x0000000000000012
0x0000000075b42642: KERNEL32!BaseRegCloseKeyInternal+0x0000000000000041
0x0000000075b425bc: KERNEL32!RegCloseKey+0x000000000000007d
0x0000000068f13ca3: mscorlib_ni+0x0000000000233ca3
0x0000000069bc21db: mscorwks_ntdef!CallDescrWorker+0x0000000000000033
0x0000000069be4a2a: mscorwks_ntdef!CallDescrWorkerWithHandler+0x000000000000008e
--------------------------------------
Handle = 0x000000000000242c - OPEN
Thread ID = 0x0000000000001cd0, Process ID = 0x0000000000001a5c
0x0000000077220e0a: ntdll!NtOpenKeyEx+0x000000000000000a
0x0000000074b5d1c9: wow64!Wow64NtOpenKey+0x0000000000000091
0x0000000074b5313b: wow64!whNtOpenKeyEx+0x0000000000000073
0x0000000074b3cf87: wow64!Wow64SystemServiceEx+0x00000000000000d7
0x0000000074ac276d: wow64cpu!TurboDispatchJumpAddressEnd+0x0000000000000024
0x0000000074b3d07e: wow64!RunCpuSimulation+0x000000000000000a
0x0000000074b3c549: wow64!Wow64LdrpInitialize+0x0000000000000429
0x00000000772184c8: ntdll!LdrpInitializeProcess+0x00000000000017e2
0x0000000077217623: ntdll! ?? ::FNODOBFM::`string'+0x000000000002bea0
0x000000007720308e: ntdll!LdrInitializeThunk+0x000000000000000e
0x00000000773d0fca: ntdll_773b0000!NtOpenKeyEx+0x0000000000000012
0x0000000075b42721: KERNEL32!LocalBaseRegOpenKey+0x000000000000010c
0x0000000075b428c9: KERNEL32!RegOpenKeyExInternalW+0x0000000000000130
--------------------------------------
Handle = 0x000000000000242c - CLOSE
Thread ID = 0x0000000000000cd4, Process ID = 0x0000000000001a5c
0x000000007721ffaa: ntdll!ZwClose+0x000000000000000a
0x0000000074b3f2cd: wow64!whNtClose+0x0000000000000011
0x0000000074b3cf87: wow64!Wow64SystemServiceEx+0x00000000000000d7
0x0000000074ac276d: wow64cpu!TurboDispatchJumpAddressEnd+0x0000000000000024
0x0000000074b3d07e: wow64!RunCpuSimulation+0x000000000000000a
0x0000000074b3c549: wow64!Wow64LdrpInitialize+0x0000000000000429
0x000000007724d177: ntdll! ?? ::FNODOBFM::`string'+0x000000000002bfe4
0x000000007720308e: ntdll!LdrInitializeThunk+0x000000000000000e
0x00000000773cf992: ntdll_773b0000!ZwClose+0x0000000000000012
0x0000000075b42642: KERNEL32!BaseRegCloseKeyInternal+0x0000000000000041
0x0000000075b425bc: KERNEL32!RegCloseKey+0x000000000000007d
0x0000000068f13ca3: mscorlib_ni+0x0000000000233ca3
0x0000000069bc21db: mscorwks_ntdef!CallDescrWorker+0x0000000000000033
0x0000000069be4a2a: mscorwks_ntdef!CallDescrWorkerWithHandler+0x000000000000008e
--------------------------------------
Handle = 0x000000000000242c - OPEN
Thread ID = 0x0000000000001cd0, Process ID = 0x0000000000001a5c
0x0000000077220e0a: ntdll!NtOpenKeyEx+0x000000000000000a
0x0000000074b5d1c9: wow64!Wow64NtOpenKey+0x0000000000000091
0x0000000074b5313b: wow64!whNtOpenKeyEx+0x0000000000000073
0x0000000074b3cf87: wow64!Wow64SystemServiceEx+0x00000000000000d7
0x0000000074ac276d: wow64cpu!TurboDispatchJumpAddressEnd+0x0000000000000024
0x0000000074b3d07e: wow64!RunCpuSimulation+0x000000000000000a
0x0000000074b3c549: wow64!Wow64LdrpInitialize+0x0000000000000429
0x00000000772184c8: ntdll!LdrpInitializeProcess+0x00000000000017e2
0x0000000077217623: ntdll! ?? ::FNODOBFM::`string'+0x000000000002bea0
0x000000007720308e: ntdll!LdrInitializeThunk+0x000000000000000e
0x00000000773d0fca: ntdll_773b0000!NtOpenKeyEx+0x0000000000000012
0x0000000075b42721: KERNEL32!LocalBaseRegOpenKey+0x000000000000010c
0x0000000075b428c9: KERNEL32!RegOpenKeyExInternalW+0x0000000000000130
--------------------------------------
Parsed 0x358E stack traces.
Dumped 0x7 stack traces.
0:044> !handle 242c ff
Handle 242c
Type File
Attributes 0
GrantedAccess 0x120089:
ReadControl,Synch
Read/List,ReadEA,ReadAttr
HandleCount 2
PointerCount 3
No Object Specific Information available
I have the following method I came across in a code review. Inside the loop Resharper is telling me that if (narrativefound == false) is incorrect becuase narrativeFound is always true. I don't think this is the case, because in order to set narrativeFound to true it has to pass the conditional string compare first, so how can it always be true? Am I missing something? Is this a bug in Resharper or in our code?
public Chassis GetChassisForElcomp(SPPA.Domain.ChassisData.Chassis asMaintained, SPPA.Domain.ChassisData.Chassis newChassis)
{
Chassis c = asMaintained;
List<Narrative> newNarrativeList = new List<Narrative>();
foreach (Narrative newNarrative in newChassis.Narratives)
{
bool narrativefound = false;
foreach (Narrative orig in asMaintained.Narratives)
{
if (string.Compare(orig.PCode, newNarrative.PCode) ==0 )
{
narrativefound = true;
if (newNarrative.NarrativeValue.Trim().Length != 0)
{
orig.NarrativeValue = newNarrative.NarrativeValue;
newNarrativeList.Add(orig);
}
break;
}
if (narrativefound == false)
{
newNarrativeList.Add(newNarrative);
}
}
}
c.SalesCodes = newChassis.SalesCodes;
c.Narratives = newNarrativeList;
return c;
}
The variable narrativefound will never be true when control reaches that statement:
narrativefound = true;
// ...
break; // This causes control to break out of the loop.
I think Resharper is trying to tell you that the condition narrativefound == false will always be true.
You don't need the narrativeFound variable at all. In the scope where you set it true, you break from the foreach loop. If you don't set it to true, you don't break, and you add the newNarrative to the newNarrativeList.
So, this could be rewritten as
foreach (Narrative newNarrative in newChassis.Narratives)
{
foreach (Narrative orig in asMaintained.Narratives)
{
if (string.Compare(orig.PCode, newNarrative.PCode) == 0)
{
if (newNarrative.NarrativeValue.Trim().Length != 0)
{
orig.NarrativeValue = newNarrative.NarrativeValue;
newNarrativeList.Add(orig);
}
break;
}
newNarrativeList.Add(newNarrative);
}
}
It's a bug in your code.
foreach (Narrative newNarrative in newChassis.Narratives)
{
bool narrativefound = false;
foreach (Narrative orig in asMaintained.Narratives)
{
if (string.Compare(orig.PCode, newNarrative.PCode) ==0 )
{
narrativefound = true;
if (newNarrative.NarrativeValue.Trim().Length != 0)
{
orig.NarrativeValue = newNarrative.NarrativeValue;
newNarrativeList.Add(orig);
}
// narrativeFound == true, but now we exit the for loop
break;
}
// narrativeFound is always false here. The test is redundant
if (narrativefound == false)
{
newNarrativeList.Add(newNarrative);
}
}
}
R# is correct because if you turn narrativefound to true you are breaking out of the foreach right after you set it.
I believe it is telling you that becuase IF narriativefound is set to true then the for loop is exited (break;). So if the if (narriativefound == false) is evaluated it will always have a value of false.
I have installed Visual Studio 2010 Professional (final version), with some components, plug-ins and templates I use a lot. Recently, I been checking all the things that the Ultimate version has, and I've been wondering,
Can I just run the VS2010 ultimate installer and it upgrade the Sku, letting me use all of its features along with the previous plug-ins (like telerik rad controls, Deklarit for VS2010, and VS.php)??
Thanks in advance
Just for records, looks like everything worked pretty well.... And the answer to my own question is: Yes, you can Upgrade the Sku of Visual Studio 2010
Yes, it works, I also upgraded Professional to Ultimate. Have to mention, that while updating I was not able to change the path for additional components. But ugrade works.
Just to confirm that the upgrade path worked for me:
I simply ran the setup program for Ultimate without uninstalling Professional. It installed in less than an hour taking with it all of my settings, plugins and extentions & resharper came across also :)
Very Impressed ! :)
Would be a nice thing - do I have to write a script or can't I just tweak the build script to do some task?
Windows already has support for this, go to the Control Panel and open up Sounds and Audio Devices. Under the Sounds tab there is a section for program events. If you scroll down far enough one of the sections will be Microsoft Visual Studio. Then just pick the sound you want to hear for Build Succeeded and Build Failed.
If you dont want to enable it for every single build, you can make an app that plays a sound, and add it into the post build event for that project.
I am wondering what these greens things are in Visual Studio 2010. What are they for? They look pretty random but of course they have to have some meaning. Can any one tell me?
At first glance they don't mean any thing to me.
Picture 1:
Picture 2:
Edit:
They show saved changed content during the document open. Once you close the document they disappear.
They show lines that you have changed.
See here for more details and a table showing what the different colours mean:
This is edited lines of text after last save
or/and
Lines of code edited by Edit->Advanced->Format Document. It formats code (spaces, line breaks, etc) corresponding VS settings for current file's language
Yellow - source code that has been changed since you opened the file, and that hasn't been saved.
Green - source code that has been changed since you opened the file, and that has been saved.
Those indicate where the source code has been changed.
When unhandled exceptions are encountered in VStudio usually the debugger highlights the line YELLOW as the line that threw the exception.
However sometimes I encounter exceptions where the debugger highlights them green as shown:
I've always treated them as normal exceptions, but today I decided to ask since google/bing produced no results for "Visual Studio Green Exceptions"
The line is highlighted yellow if that is the line that directly threw the exception (typically a throw statement).
It's green if the line is a call to a different function that threw the exception (typically a call to a .Net function that threw an exception).
I'm having some problems with Edit and Continue when using Visual Studio 2010 on a Windows 7 64 bit machine. I've ensured the following
When I hit a break point and try to edit I and confronted with the following message.
This is happening for me for all projects that I create whether they are WPF/Win Forms/VB.NET/C#/.NET 4/.NET 3.
Any ideas?
OK guys I figured it out. The other night I was playing around with IntelliTrace and changed the setting to collect call information. I didn't notice the warning on that page stating "Edit and continue is disabled when collecting Call Information"! See screen shot.
So I just disabled that and I was good to go. Thanks, that was really annoying.
Another solution is to check if any 3rd party references included and check their options for: Embed Interop Types. Set it to False.
i Found problem!!!!
in Advance Compile Option (in Project Properties) Uncheck Enable Optizimations
I was using an MVC 3 project on x64 machine, my answer here SO post sorted this for me, might help someone else out.
forgive me, but I don't know the technical term to know what to search for.
I am trying to find a way to keep track of changes in my code during the development of my program. something that would allow me to go back to a section of code that I deleted. I am not talking about "undo". But rather a way that would let me keep track or be able to retrieve a section of my code that I deleted but now want it back.
Is there such a way. If there is, then what is this whole system/procedure called? Is there something that integrates with visual studio 2010?
Many thanks for your help.
It's called Revision Control.
you could use
SVN or GIT
but for local use, I would prefer SVN. its free and its easy. For visual studio there are a few SVN client plugins (like VisualSVN). But, I would suggest TortoiseSVN as the client.
To be clear, SVN is the server, TortoiseSVN is the client. (Both are free open source tools)
The term you are looking for is Source Control. Modern source control's provide all the functionality you described plus much more.
Team Foundation Server seamlessly integrates into VS2010 and is very useful. Read through Source Control for Visual Studio to get up to speed.
I'm not familiar with Visual Studio, but generally there are two approaches to implementing this:
1) Source/Revision control - But the problem is that it is very low-granularity, you usually commit a file when it is ready, but lose any interim changes. There are a lot of solutions compatible with visual studio.
2) A local history that tracks multiple versions between commits. Eclipse has this built in, not sure how to access it in VS.
3) A very granular log of all your development activities so you can examine and revert past changes. Not familiar with a commercial version of this. I once developed something like this for Eclipse.
Please read this thread here at SO: Keeping track of changes I make by copying project folders.
subversion has a lot of mind share these days, but it's very old-school, first-gen tech. Distributed revision control is gaining a lot of momentum and I'd highly recommend that you become familiar with it if you're going to be a code monkey professional. Look up mercurial (also referred to as hg) or bazaar. If nothing else, perforce - a professional, commercial revision control tool - is free for up to two users. It works very well, as long as you keep your branching craziness to a minimum.
Every source control does that, you know ;)
YOu have a legal VIsual Studio 2010? Try Team System.
I have a very simmilar problem as described here.
I also upgraded a mixed solution of C++/CLI and C# projects from VS2008 to VS2010. And now in VS2010 one C++/CLI project always runs out of date. Even if it has been compiled and linked just before and F5 is hit the messagebox "The project is out of date. Would you like to build it?" appears. This is very annoying because the dll is very low-tiered and forces almost all projects of the solution to rebuild.
My pdb settings are set to default value (suggested solution of this problem).
Is it possible the get the reason why VS2010 forces a rebuild or thinks a project is uptodate?
Any other ideas why VS2010 behaves like that?
To find the missing file(s), use info from the article Enable C++ project system logging to enable debug logging in Visual Studio and let it just tell you what's causing the rebuild:
%PROGRAMFILES%\Microsoft Visual Studio 10.0\Common7\IDE\)Add the following after the </configsections> line:
<system.diagnostics>
<switches>
<add name="CPS" value="4" />
</switches>
</system.diagnostics>
Search the debug log for any lines of the form:
devenv.exe Information: 0 : Project 'Bla\Bla\Dummy.vcxproj' not up to date because build input 'Bla\Bla\SomeFile.h' is missing.
(I just hit Ctrl+F and searched for not up to date) These will be the references causing the project to be perpetually "out of date".
To correct this, either remove any references to the missing files from your project, or update the references to indicate their actual locations.
This happened to me today. I was able to track down the cause: The project included a header file which no longer existed on disk.
Removing the file from the project solved the problem.
We also ran into this issue and found how to resolve it.
The issue was as stated above "The file no longer exists on the disk."
This is not quite correct the file does exist on the disk but the .VCPROJ file is referencing the file somewhere else.
You can 'discover' this by going to the "include file view" and clicking on each include file in turn untill you find the one that VS can not find. You then ADD that file (as an existing item) and delete the reference that can not be found and everything is ok.
A valid question is: How can VS even build if it does not know where the include files are?
We think the .vcproj file has some relative path to the offending file somewhere that it does not show in the VS GUI and this accounts for why the project will actually build even though the tree-view of the includes is incorrect.
The .net projects are always recompiled regardless. Part of this is to keep the IDE upto date (such as intellisense). I remember asking this question on an MS forum years ago and this was the answer I was given.
Most build systems use data time stamps to determine when rebuilds should happen - The date/time stamp of any output files is checked against the last modified time of the dependencies - if any of the dependencies are fresher, then the target is rebuilt.
This can cause problems if any of the dependencies somehow get an invalid data time stamp as its difficult for the time stamp of any build output to ever exceed the timestamp of a file supposedly created in the future :P
For me it was the presence of a non-existing header file on "Header Files" inside the project. After removing this entry (right-click > Exclude from Project) first time recompiled, then directly
========== Build: 0 succeeded, 0 failed, 5 up-to-date, 0 skipped ==========
and no attempt of rebuilding without modification was done. I think is a check-before-build implemented by VS2010 (not sure if documented, could be) which triggers the "AlwaysCreate" flag.
What are your recommended extensions for Visual Studio 2010? (Please indicate if its free or not)
CleanProject - Cleans Visual Studio Solutions
Resharper (not free)
PowerCommands (free)
NuGet (formerly NuPack) is a free, open source developer focused package management system for the .NET platform intent on simplifying the process of incorporating third party libraries into a .NET application during development.
AnkhSVN (free)
Even if you use other SVN shells outside VS (like TortoiseSVN), I recommend to install this Source Control Provider to automatically keep track of file renames, deletions and the like.
Ghost Doc (Free)
It takes a while to configure it properly, but it can be quite useful.
Visual Assist X(not free)
From my blog post (all free):
DevExpress CodeRush/Refactor! Pro (not free, $249.99)
It's way better than Resharper (which by the way always slowed down my VS to a crawl), it works with C# and VB.NET (including refactoring) and the support and community is excellent. Worth the price tag. And yes, it does support 2010 (in RC at the time of this writing).
Visual Studio Color Theme Editor (free)
I can't code unless my VS2010 has a StackOverflow-like theme.
VisualSVN (not-free)
I personally prefer this over AnkhSVN since its not an SCC provider and doesn't add extra files to my repository.
VSCommands is simply one of the best FREE plugins ot there! (visual studio gallery link)
DevExpress CodeRush Xpress (free)
tangible T4 Editor plus modeling tools for VS2010 adds IntelliSense and Syntax Coloring to T4 Text Templates (Free)
VisualHG is a Mercurial Source control plugin that drives TortoiseHG from VS. I'm a big fan of Mercurial & DVCS. VisualHG makes it nice n integrated. Git fans - I'm not asking for a flame war. Hg is just my brand.
Code Contracts Editor Extensions, a free extension which provides information about inherited contracts for the method you're currently working on, and a list of contracts for any methods that you're calling. Unfortunately, the latter feature conflicts with Resharper, but the former still works fine.
World of VS Default Browser Switcher for easily switching browser in web projects.
devColor (Free)
Small tool which underlines hex colors in stylesheets with the correct color. I really like how it integrates into the editor.
RockScroll (free) - Double-click on a word/symbol highlights all occurrences of that word/symbol. Also replaces the scroll bar with a preview of your code, with edit spots and "all occurences" lines highlighted.
Example of use: want to see whether a variable is used anywhere else in current source file? Double-click variable, look at scroll bar for any red highlights.
AtomineerUtils Pro (not free, $9.99 USD) is, in my opinion, better than Ghost Doc. But, just like Ghost Doc or any automatic documentation generator, the generated documentation is meant to be edited to be of any real value.
VS10x Code Map That is very cool. Easy jumping to property, method. And easy expand collapse region and more.
CodeMaid seems to be pretty useful - it AutoFormats on save which saves a lot of time between developers and code-diffs. (Are there other tools that can use the VS AutoFormat document?)
Vingy 1.0 is simple, but effective add in for Visual Studio 2010 so that you can search the web in a non intrusive way, and can filter results based on sources.
You can bring up Vingy either by clicking View->Other Windows ?> Vingy Search Window from the Visual Studio IDE, or just by high lighting some text in the document and then clicking Tools ?> Search Selected Text (Ctrl + 1).
Searching with Vingy is pretty straight forward. You can initiate a Search in two ways.
This is my list of extensions.
The list on this is pretty comprehensive, so I spent sometime to find the extensions that I need. Here is the snapshot. Hope it will help someone.
I tried installing Codemaid, and it appeared to be a nifty addon, but my Visual Studio response became very slow. Felt like some threads were doing some work all the time when Codemaid was on. So uninstalling for now.
VSFileNav - (Free) A Find File in Solution tool (cross between SonicFileFinder and Resharper). Lightweight, easy to use and fast (I got sick of the huge startup time with Sonic).
Disclaimer : I wrote this tool.
ReSharper (not-free)
I can't live without DPack - especially when working on large projects, makes navigating between files and members much easier. And it's free.
Favorite shortucts:
Alt+U : file browser, filters files as you type
Alt+G : code browser, filters all members as you type
Alt+M : code browser, filters methods in the current file as you type
...and so on. Much easier for me then finding my way around Project Explorer.
The ?Quick Add Reference? extension augments the smart tag that VS shows for unrecognized types giving you a chance to add the corresponding assembly reference for that type plus corresponding ?using? clause if needed in a single shot.
Plugin to quickly go to any file in solution Sonic file finder (free)
Fast switching between .h and .cpp file Macro available here (free)
And that's it =)
Mouse Zoom (Free)
Zoom at the mouse's cursor instead of at the top of the visible document. Always scroll 25% no matter what zoom level is currently set.
Ctrl + Mouse Wheel -> zoom in/out at mouse cursor. Ctrl + Shift + Mouse Wheel -> zoom in/out all the way (pausing at 100 percent). Ctrl + Middle Mouse Click -> zoom to 100 percent.
Visual Studio Gallery Home
http://visualstudiogallery.msdn.microsoft.com/en-us/6de43ab2-e65c-40b3-9986-b0351c28ce53
What about the HelpViewerKeywordIndex... helps (a bit) with what is as I see it 2010's greatest flaw, the new help viewer.
HQLAddin - for NHibernate HQL editor.
Bundles the following extensions for the Visual Studio 2010 JScript editor
Brace Matching
Adds support for automatically highlighting the matching opening or closing brace to the one currently at the cursor. Supports matching parenthesis: (), square brackets: [], and curly braces: {}. Braces in strings, comments and regular expression literals are ignored.
Outlining / Cold-folding
Adds support for automatically creating outlining regions for JScript blocks. Blocks are detected via opening and closing curly braces. Braces in strings, comments and regular expression literals are ignored.
Current Word Highlighting
Adds support for highlighting all instances of the word currently at the cursor.
IntelliSense Doc-Comments Support
Adds support for the element in JScript IntelliSense doc-comments to allow display of new lines in IntelliSense tooltips.
Align by - Obviously I'm bias since I wrote it but it's the extension I use more than any other.
Quick Open File for Visual Studio 2010 - free. Simulates the feature known to Eclipse users as Open Resource. This plugin gives Visual Studio equivalently quick method for opening any solution file.
VS10x Editor View Enhancer - free beta. Type and member definitions emphasizing, end-of-block details, clickable hotspots (C# and VB documents)
CppLister is free tool for C++ developers. It just collects information about currently open file from intellisense database and displays various information for easy navigation.
CleanProject - Cleans Visual Studio Solutions
How many times have you wanted to send a project to a friend or upload it to a web site like MSDN Code Gallery only to find that your zip file has lots of stuff that you don't need to send in it making the file larger than it needs to be.
bin folder obj folder TestResults folder Resharper folders And then if you forget about removing Source Control bindings whoever gets your project will be prompted about that. As someone who does this process a great deal I decided to share with you my code for cleaning a project.
I have a situation where the only way to generate a certain datafile is to print it manually to FILE: under Windows and save it in a file for further processing.
I would really like to have a small stand-alone program which embeds this binary printer driver so I can run it from a batch file and have it generate that binary file for me, as we can then fully automate the "save file in Visio, 'print' it and upload it to the final destination and trigger a remote test".
Is this possible with a suitable Windows SDK? I am a Java programmer, so I do not know Visual Studio and the possibilities with MSDN - yet! - but I'd appreciate pointers.
EDIT: I have the installation files for that printer driver, both 32 and 64 bit. Older versions may include a 16 bit driver.
EDIT: The "print to FILE:" functionality is just what was recommended by the documentation. I have played a little bit with using the LPR-protocol to see what it can do. I'd still prefer the "invoke small binary" approach.
The general problem which you formulate is difficult to solve. Mostly a printer driver consists from some well known components like Print Monitor, Print Processor etc. which are well documented in Windows Driver Kit http://msdn.microsoft.com/en-us/library/ff560885%28v=VS.85%29.aspx. Some years ago I wrote a Print Monitor. It worked many years at a customer. So I know exactly what I writing about. A Print Monitor is nothing more as a DLL with well documented functions. The same is about most other printer components. Those DLLs will be loaded and called from Spooler. If you have a modern printer driver it has no components which run in kernel mode. So one can load most of DLLs from which consist every printer driver and call corresponding function.
You are interesting for using one concert printer driver. So the first what one should do is to examine how this driver is implemented. If you find out which component do the job which you need, you will be probably able to load this DLL in your process and produce output which you need. It is possible that you post an URL where I could download this driver?
UPDATED: I though a little more about your requirements. It seems to me you can goes with the way suggested by developer of the printer driver. If the driver can print to a local port FILE, then it can print in any printer port. So you can give src of a Port Monitor Server driver from C:\WinDDK\7600.16385.1\src\print\monitors\localmon (see also http://msdn.microsoft.com/en-us/library/ff556478%28v=VS.85%29.aspx, http://msdn.microsoft.com/en-us/library/ff549405%28v=VS.85%29.aspx and http://msdn.microsoft.com/en-us/library/ff563806%28v=VS.85%29.aspx). (I is a windows 32/64 DLL, not a real driver) and makes small modification. Instead of saving results to a file you can dispatch the results to your application. It will be work with 100% without any tricks. If you will have some problem to understand localmon I can give you some tips. It is really not complex. The main changes which you have to do is to modify LcmStartDocPort LcmWritePort LcmReadPort LcmEndDocPort functions from localmon.c. Some easy thing which is distinguish Port DLL from a typical DLL, that instead of exporting all DLL's functions it export only one InitializePrintMonitor2 with pointers to all other functions.
UPDATED 2: One more tip for usage of "Local Port" monitor. If goes in printer configuration, then choose "Add Port...", select "Local Port" and click "New Port..." you can type any file name like "C:\temp\my.bin". Then all what you print through a printer will be printed in this file without any user iteration. The name can be any win32 file name (UNC names or Named pipes are also allowed). With this way you can realize some scenarios without any programming with DDK.
UPDATED 3: I looked at the printer driver from different sides and looked one more time in the API in DDK. Now I want recommend you to choose the easiest way, and the way which will be full supported from the driver manufacturer. I suggest following:
You install a printer with the driver which you need and choose as the output port a Local Port with a fixed file name (see Update 2). I named here the destination filename as C:\TEMP\Output.afp. So you receive exactly the same situation like recommend you driver manufacturer. Fixed file name is absolutely the same as FILE: port. So if you print to the printer you receive in Output.afp file in the C:\TEMP directory. To be sure the end of writing you can use ReadDirectoryChangesW or FindNextChangeNotification / FindFirstChangeNotification functions with dwNotifyFilter equal to FILE_NOTIFY_CHANGE_LAST_WRITE. Then you receive notification after last write-time of the file. It means after the end of writing and after FileClose and after the cache is sufficiently flushed. So the file Output.afp is not locked and you can really safe read the results.
For printing of simple documents you can use WritePrinter function (see http://msdn.microsoft.com/en-us/library/dd162959%28VS.85%29.aspx and remark in the documentation http://msdn.microsoft.com/en-us/library/dd145226%28VS.85%29.aspx). Writing of complex files with bitmaps, color and different fonts you have to use typical GDI API like one this in Windows (see http://msdn.microsoft.com/en-us/library/dd162865%28v=VS.85%29.aspx).
This solution looks not very spectacular like writing a printer driver component or a simulation of spooler environment for printer driver, but it will work, will safe work and will be full supported from the driver manufacturer.
(It's been 10 years since I did anything like this, but I don't think the overall concepts have changed all that much:)
What you want to do is implement a custom print processor. A print processor is the piece of code that takes the output that the printer driver generates and transports it to the output device. Print processors are implemented as regular user-mode DLLs. You should be able to find everything you need, including samples, in the Windows DDK.
A while ago we made a commercial application which captured print streams from any windows application and converted the result to XML and tiff images
We did make a prototype with the DDK, but ended up buying a SDK for the print capturing
The SDK was from BlackIce. Although it wasn´t a free SDK, the distribution of the runtimes were royalty free.
Implementation was done with Visual C (unmanaged) and VB6. The printer driver had to be installed on the server/PC that drove the printing process.
I remember that the tricky part was to control the printer settings in runtime (keep the tiffs compressed, output directory for the files, paper size:A4 or Letter and other settings that were defined in the DEVMODE print control structure).
UPDATE: (Your comment to @Oleg about MO:DCA P triggered my memory. Although it is not about a printer driver...)
For our commercial product, we also had to make a customization to convert MO:DCA (AFP) documents to tiffs and XML.
This SDK had to be able to extract both images and ascii text to enable later conversions
Conversion where then made in batch from AFP documents in one folder to XML and tiffs.
We chose to convert the AFP file after it had been printed (not during print).
The SDK is SnowBound RasterMaster and is available in different flavours (we used the Windows API with ActiveX, and I see now that it is available for Java)
So if your requirement is to convert an AFP document to someting else (extract images and extract ascii text) you could try out the software from SnowBound. Make sure you also get the Optional Feature to be able to extract ASCII text from the MO DCA documents.
This software SDK is more expensive, but it did the job.
They offer a trial version here.
At the moment i have one missing link in your explanation, so let me rephrase what i understood:
Now my missing part is, what do you want to give to your little batch script, so that it produces your binary file? Do you have a Visio file which should be automatically printed through this driver?
If yes, you should take a look into this little batch script. It is able to take any file with a registered file extension and send it to the default printer with its default settings. By using these settings you are able to change the printer settings within your windows system from a batch file to make your special driver the default one and putting the output into a file.
So if i understood you correctly i didn't had the complete solution but i think a good starting point to accomplish your task.
Ok, after reading your comment, i fully understood what you like to achieve. To get this to work you have to follow Per Larsens advice to write your own driver with the windows ddk (or to be more precise the Windows Driver Kit [WDK]) and encapsulate the already existing driver.
So in short and simple: Your driver signs up as new printer driver. When it is called it gets all the raw bytes from the application. Passes it into the driver that can generate your datafile. Get the output from that driver back and do with it whatever you like.
Some samples to get started can also be found in MSDN as overview or more precisely here.
But just to say it right beforehand: This is not an easy or simple task and the effort is quite high. Maybe trying to manipulate the driver settings of your special driver through the already given batches or a simple application (written with AutoIt) can also solve your problem, by just interacting (automatically) with the settings of the driver.
I can live with "When a user prints any file to this particular Windows printer, then automatically capture the bytes that would have been sent to the printer".
In that case, you want something like RedMon, which redirects the bytes which would have gone to the printer into the input for another program.
Just to reiterate, probably the simplest capture method is using a new Local Port configured as a filename. You can to monitor the output file as previously discussed to catch the output.
Otherwise, you want to write your own port monitor - not a printer driver or a print processor. All a port monitor does is receive the already rendered data from the printer driver, and sends it to the output device. So writing your own port monitor will allow you to go in and change the output port associated with the existing printer driver to be your own output port, and your port monitor can simply write the data to a file, probably one with a unique filename in a dedicated directory.
Printer drivers are far too complicated for what you want to do, and while a print processor could also capture the output data, you'd probably get entangled in some scantily documented system issues you won't want to have to figure out.
The LocalMon sample in the Windows Driver Kit is THE starting point for writing a port monitor. However, it manages all the system local ports and is quite a bit more complex than you need. In fact, much of it is just likely to confuse you. I'd recommend you start with LocalMon, and compare it to the Redmon source, which is much simpler because it manages a dedicated port. Beware that the Redmon source was taken from localmon long ago and appears to have a few bugs, so use Redmon as a reference and pare back the LocalMon code to what's needed to just write the output to a file.
You don't embed drivers in executables- drivers are for the operating system to communicate with the hardware.
You print via the Operating system.
Your 'batch' needs to select the correct printer, and print...
Does Visual Studio 2010 have a built-in way to quickly find/open files, similar to the Ctrl+Shift+O function in Eclipse?
Edit: Or does Resharper offer this functionality?
Ctrl+,
I'm surprised no one gave the right answer:
Navigate To can show you a list of open files and lots more. http://weblogs.asp.net/scottgu/archive/2009/10/21/searching-and-navigating-code-in-vs-2010-vs-2010-and-net-4-0-series.aspx
CTRL+COMMA is your friend.
Ctrl + Alt + A opens the command window, type "open" then start typing file names and it will dynamically autocomplete by available solution file name.
I use Ctrl + / to jump to the command bar (same as the search box, but with a > prefixed in the text). I then type "of" (for "open file") and start typing the name of the file to open. Possibly matches are automatically displayed by VS.
I also found that when using ReSharper, the familiar Eclipse shortcut for Open Type (Ctrl + Shift + T) is mapped to ReSharper's GotoFile command.
this addin will very usefule to quickly open files from visual studio by pressong CTRL + K + O
http://visualstudiogallery.msdn.microsoft.com/en-us/3eb2f230-2728-4d5f-b448-4c0b64154da7
CTRL+SHIFT+F will bring open a find in files search dialog box. The result will be listed, usually, on the lower section of VS in a Find Files result box. Double clicking a result will open it
Visual Assist comes with something like this. You will have to pay for the plugin (and I don't think you can use plugins in the express versions).
(If you're doing C++ and you don't plan to buy Visual Assist, be sure to never install the trial. It's that addictive.)
CTRL+SHIFT+F will bring up find-in-files dialog. I haven't heard of the functionality that you are looking for; though this may help...
Unfortunately, VS doesn't offer this search-as-you-type functionality (and lots more).
A free extension that does something similar to CTRL+COMMA is Sonic File Finder...
http://www.jens-schaller.de/sonic-tools/sonicfilefinder/overview/overview.htm
In Eclipse, Ctrl+Shift+O = "Organize Imports"... which I am not sure what this is. But it is not the Ctrl+Shift+F = Find in Files that is in Visual Studio.
What is the best method of storing an Enum in a Database using C# And Visual Studio and MySQL Data Connector.
I am going to be creating a new project with over 100 Enums, and majority of them will have to be stored in the database. Creating converters for each one would be a long winded process therefore I'm wondering if visual studio or someone has any methods for this that I haven't heard off.
We store ours as ints or longs and then we can just cast 'em back and forth. Probably not the most robust solution, but that what we do.
we are using typed DataSets, so, for example:
eunum BlockTreatmentType
{
All = 0
};
// blockTreatmentType is an int property
blockRow.blockTreatmentType = (int)BlockTreatmentType.All;
BlockTreatmentType btt = (BlockTreatmentType)blockRow.blocktreatmenttype;
In the end you will need a great way to deal with repetitious coding tasks such as enum converters. You can use a code generator such as MyGeneration or CodeSmith among many others or perhaps an ORM mapper like nHibernate to handle everything for you.
As for the structure... with hundreds of enums I would first consider trying to organize the data into a single table that might look something like this: (pseudo sql)
MyEnumTable(
EnumType as int,
EnumId as int PK,
EnumValue as int )
that would allow you to store your enum info in a single table. EnumType could also be a foreign key to a table that defines the different enums.
Your biz objects would be linked to this table via EnumId. The enum type is there only for organization and filtering in the UI. Utilizing all of this of course depends on your code structure and problem domain.
Btw, in this scenario you would want to set a clustered index on EnumType rather than leaving the default cluster idx that is created on the PKey.
Some things you should take in consideration.
Is the enumeration column going to be used directly by other applications like for example reports. This will limit the possibility of the enumeration being stored in it's integer format because that value will have no meaning when present in a report unless the reports have custom logic.
What are the i18n needs for your application? If it only supports one language you can save the enumeration as text and create a helper method to convert from a description string. You can use [DescriptionAttribute] for this and methods for the conversion can probably be found by searching SO.
If on the other hand you have the need to support multiple language and external application access to your data you can start considering if enumeration are really the answer. Other option like lookup tables can be considered if the scenario is more complex.
Enumerations are excellent when they are self contained in code... when they cross that border, things tend to get a bit messy.
Update:
You can convert from an integer using Enum.ToObject method. This implies that you know the type of the enumeration when converting. If you want to make it completely generic you need to store the type of the enumeration alongside it's value in the database. You could create data dictionary support tables to tell you which columns are enumerations and what type are them.
I'm not sure if it is the most flexible, but you could simply store the string versions of them. It is certainly readable, but maybe difficult to maintain. Enums convert from strings and back pretty easily:
public enum TestEnum
{
MyFirstEnum,
MySecondEnum
}
static void TestEnums()
{
string str = TestEnum.MyFirstEnum.ToString();
Console.WriteLine( "Enum = {0}", str );
TestEnum e = (TestEnum)Enum.Parse( typeof( TestEnum ), "MySecondEnum", true );
Console.WriteLine( "Enum = {0}", e );
}
If you want a store of all of your enums values, you can try the below tables to store enums and their members, and the code snippet to add those values. I'd only do this at install time, however, since those values will never change until you recompile!
DB Table:
create table EnumStore (
EnumKey int NOT NULL identity primary key,
EnumName varchar(100)
);
GO
create table EnumMember (
EnumMemberKey int NOT NULL identity primary key,
EnumKey int NOT NULL,
EnumMemberValue int,
EnumMemberName varchar(100)
);
GO
--add code to create foreign key between tables, and index on EnumName, EnumMemberValue, and EnumMemberName
C# Snippet:
void StoreEnum<T>() where T: Enum
{
Type enumToStore = typeof(T);
string enumName = enumToStore.Name;
int enumKey = DataAccessLayer.CreateEnum(enumName);
foreach (int enumMemberValue in Enum.GetValues(enumToStore))
{
string enumMemberName = Enum.GetName(enumToStore, enumMemberValue);
DataAccessLayer.AddEnumMember(enumKey, enumMemberValue, enumMemberName);
}
}
Why not try separating the enums altogether from the DB? I found this article to be a great reference while working on something similar:
http://stevesmithblog.com/blog/reducing-sql-lookup-tables-and-function-properties-in-nhibernate/
The ideas in it should apply regardless of what DB you use. For example, in MySQL you can use the "enum" data type to enforce compliance with your coded enums:
http://dev.mysql.com/doc/refman/5.0/en/enum.html
Cheers
Just as I started to assume this feature was ubiquitous(middle-clicking on a page, then scrolling speed/direction is relative to the distance of the pointer on the y-axis).
I can't believe this hasn't been implemented into the text editor in vs2010, I used it all the time in 2005 and 2008.
Has anyone managed to find a workaround or am I a minority user of this feature?
Here's an extension which makes it work (at least partially): http://visualstudiogallery.msdn.microsoft.com/en-us/3b81aea8-d022-4aa6-9b8c-16ef86cc610d
Looks like this was cut from VS 2010 :(. Here are some links to the Connect issues:
Not the answer you wanted but at least you don't have to waste time figuring this out.
Ade
Here's a better simple extension from the Visual Studio Gallery that add middle click scrolling: AutoScroller for VS 2010
But I recommend you to take a look to the Microsoft Productivity Tools extension. It adds middle click scrolling support to the Visual Studio 2010 IDE as well as many other improvements. After you install the extension you can enable/disable its features from menu "Tools -> Options -> Productivity Power Tools".
There are two major refactoring tools which can be installed for Visual Studio that provide C++ support. The full versions of both tools are $250, and they seem to offer similar functionality. They are:
Which tool is better?
EDIT: My initial evaluation of the tools seems to be that Refactor Pro/CodeRush has several more features, but is also quite buggy on occasion. It doesn't seem to like macros: Here's Visual Assist's interpretation of the same:
EDIT2: I think I like CodeRush over Visual Assist, but I'm not sure I can trust CR. CodeRush does seem to have problems parsing some C++ constructs, like the macros above. But it's UI is much more polished. For example:
On the other hand Visual Assist X seems to have a much larger following among C++ developers, and it's code analysis is MUCH better. It doesn't seem to make mistakes like R! Pro was making from time to time.
I think at this point I just have to play with both tools and see which one proves more useful. But I'm still curious if anyone has had horror / success stories with either tool.
I have used Visual Assist for years and I think it makes VS heaps more convenient for C++ development. The searchable file list, Go to Declaration and Rename functions in particular have been indispensable. VS2010 probably makes some of Visual Assist features obsolete but I imagine it will continue to be useful.
There are some situations where Visual Assist will stumble and not parse the code correctly, but they are few and far between, and it improves with every version.
I haven't used Refactor Pro so I can't say anything about it unfortunately.
I would suggest SlickEdit tools for Visual studio. They are much cheaper than Visual AssistX. You can buy both the editing toolbox and versioning toolbox for USD $98.
For those with experience of VS2008 and VS2010. Are there any areas in which you prefered 2008? Any annoyances with the upgrade?
Any reasons not to upgrade?
I'm coming at this from a Web Dev point of view.
Thanks
I think it depend principally of how you use VS.
If your goal is to continue to use Windows Form without Linq (some people stay with VB6...), VS 2010 don't seems to be a good investment...
But if you use, or plan to use WPF and co., VS 2010 seems to be a good investment for me !
So, i think it's interesting to ask yourself : "Any reason NOT to upgrade to WPF and Linq ?"
About your the fear of change like Office 2003 -> Office 2007
Yes, me too, i feel "dropped to my grandma's level"...
But i feel like that too with the change Windows Form -> WPF.
It's good for me : it's not with the improvement of the candle the the bulb was invented !
Office 2007 is for me a great improvement for the user interface... But it's just my point of vue.
The main reason to upgrade to Visual Studio 2010 is the .NET Framework's new version 4.0, and all the accompanying tools you can use.
If you don't need this new version now, you can delay the upgrade: that's a reason.
But sooner or later, because we all know that we can't stay behind, we'll have to step forward... This is why all of us are using Visual Studio 2008 instead of Visual Studio 6.0 and build software for Windows 7 instead of Windows 98...
If you're in a team, one person upgrading forces all of your developers to have to upgrade as the Solution files and Project files will be marked as being 2010 format and VS2008 won't read them. One of our developers checked in a project using a 2010 beta and now we can't work on it as we didn't buy 2010 yet :(
I suggest you get VS2010 Express (when it's around) and experiment with it as far as performance goes. It's not quite the same as the full version, but close enough to spot big problems I should think.
I am getting ready to test developer productivity tools for our team (Coderush, Resharper, JustCode, etc). We're planning to roll the tool out the same time as we deploy Visual Studio 2010 and TFS.
I've seen several posts discussing the merits of one tool versus another. However, I haven't been able to find any discussion of a methodology self evaluating. One approach I've seen is to use each tool for a month or so and decide which one you like best. This seems completely reasonable if I were evaluating it for myself, but since I'm evaluating for others as well, I'd like to do something more rigorous. I'm hoping to collect some ideas on how to do that.
As a starting point, my thinking was to come up a list of 10-20 crucial features to compare, then prepare a matrix where I can compare the relative strengths of each product. Once the matrix is complete, we can make a well informed decision about which product aligns with out needs. Since I'm not a user of any product now, it's been difficult to figure out which features are critical and which are less so.
Thank you!
Preamble
Ok so first up cards on the table I am a huge fan of CodeRush.
My suggestions of what to evaluate are based on my own experiences with CodeRush and also the very small amount of experience I have with Resharper. I have not looked at JustCode as at the time I was looking at it, it refused to coexist with any of the other tools on the market.
If someone from Telerik should read this and this has changed, please feel free to contact me and I will look again(RoryBecker @ gmail)
So what topics do I think should be compared?
My own personal preferences are:
Short answer: Interface & Intuitiveness, Navigability, CodeGeneration, Refactoring, Performance, Customization, Extensibility, Support and Community
Long Answer: (As above but with more detail.)
Interface & Intuitiveness:
Basic UI is a factor. You need to be at home in your main work tool without being distracted too much by things you see as unnecessary. Most tools will default to showing you everything you can do. This approach, whilst great for advertising can, be a little overwhelming. Tools should not be looked upon poorly for this, but they should provide a way of toning things down. (If you require help with this in CodeRush, just ask)
I have noted that there are some tools, whose UI simply refuses to get out of the way, and I have found that this makes those tools so much of an annoyance, that I am forced to look elsewhere.
Navigability:
There are several ways of navigating around your code. Such ways should be simple upon first glance, with scope for the power-user to learn more than just the surface detail. (Example : CodeRush has TabToNextReference [Tab], The References Toolwindow [Shift-F12], QuickNav [Ctrl+Shift+Q] and QuickFileNav[Ctrl+Alt+F]. CodeRush also provides ways to customize beyond the basic functionality. See my blogpost http://rorybecker.blogspot.com/2010/02/enhance-quicknav-coderush-or-coderush.html)
Refactoring:
Common Refactorings are ones you use all the time. (Rename, Introduce Local, Extract method). All refactorings should save you time. It should take far less time to complete their function compared with how long it would manually take to execute same.
However they should do much more that that.
They should be insanely quick to use, and they should not require any deviation / context switching from what you were already doing. When you have to think about "I have to rename here and here and here" or you are dragged away from the editor to fill out a form, you are context switching away from the problem at hand, and you are going to have to context-switch back.
You should not have to fill out a form of any kind in order to use them. After all, imagine if you had to hit OK after every 3rd or 5th [enter] keystroke. How annoying would that get?
When you're in "the zone" doing these kind of basic refactorings, they become every bit as important as the simpler things like saving a file or changing the document you're looking at.
There are many areas that can take advantage of refactorings... How many of these do you use day to day? How many are covered by each tool you are evaluating? VB, C#, Javascript, Html, XML, SQL
CodeGeneration
Code is generated in many ways.... I'm not talking about massive globules of code that are generated to form your data access layer. Those are certainly possible, but generally there are specialist tools for that sort of thing. Instead I'm talking about 2-3 other areas of code generation.
Simple Code Generation The first sort is kind of like a refactoring but, unlike a refactoring, this sort of code generation most certainly does have side effects. For example... Adding a setter to a property is very useful, but it certainly is not considered a refactoring.
Consume-First Declaration A specialization of the above. The CodeGeneration is activated whilst the caret is positioned within to a reference to a class, method, enum etc that does not already exist. The CodeGeneration then analyses the context (meta data already present in the code) and uses this to declare the actual class, method, enum etc.
ie Creating a method, from a call to said method. Deriving, in some cases, everything about the signature from the meta data. Method Name, Param Names, Param Types and Return Type can all be calculated, given enough contextual guidance. (This is present in many cases).
For example vs[space] creates a 'variable' of type 'string' and pre-highlights the name of the variable so you can over type it with what you really want to call it.
This template is intelligent. It will expand differently depending on context. (In VB) If expanded inside a method the expansion will be "Dim VarName As String" with VarName being highlighted. However if expanded within a class the expansion will, by default, be "Private VarName As String". The default scope for fields can of course be altered.
[Note: Generally speaking Templates appear cross language... Templates learned in C# are duplicated and will be found useful in VB and vice-versa. This can make it far easier to transfer between languages, making far fewer mistakes along the way.]
Clearly in the above example, 's' maps to 'string'. In CodeRush there are > 60 different predefined mappings of this sort (in just the standard list and not including generic variations) and you can add as many more as you like.
This mnemonic style of naming really comes into it's own with templates like ms[space] ('method' returning a 'String'), md8[space] ('Method' returning a 'date'), ml.d8[space] ('method' returning 'list' of 'dates')
The mnemonics system aids you by giving you a simple set of rules to access a seemingly infinite set of combinations. These associations are all logical and are also on hand via a companion training tool. (The CodeRush Training Toolwindow)
Performance
Good performance is clearly a requirement. Any tool will, by it's very presence, have an impact on performance. Any one who says different, is wrong. The trick is to find the balance between having as little impact on performance as possible, whilst providing as much functionality as can be squeezed out of said performance.
Here are a couple of links to blogposts (one mine, the other by Mark Miller - Chief architect of CodeRush) detailing performance and resource usage improvements that have been made in CodeRush.
http://rorybecker.blogspot.com/2009/06/coderush-920-speed-and-memory.html
Take special note of the sizes of projects used in testing, and see how your own projects compare.
You might also choose to compare things like memory usage, VS startup time and Time to completely load a Project (give each tool 2 attempts minimum at this as they may perform special analysis the first time a project is opened). All of these can be a factor in your daily usage of such a tool.
Customization
Ideally there should be a wide range of options available for you to tweak to your liking. Standards exist, but they should not be "the be all and end all". You should be able to adjust things to your liking.
So the question becomes, how easily can the settings of your chosen tool be configured to work the way you like to. (This is one area in which you should again seek the help of the respective communities)
Extensibility
No tool gets everything right. They are constantly producing new versions with new features and improvements to existing ones.
For me a large part of what makes CodeRush as good as I feel it is, is the extensibility provided. Sometimes I might require functionality which simply doesn't make commercial sense for a tool maker to support directly. Perhaps it is too specialist for enough people to care about.
In these cases I find it useful to be able to add to the existing tool in order to create the functionality I need. CodeRush provides the DXCore, (the framework upon which itself and RefactorPro were built) upon which to build such 3rd party plugins.
I have built a number of these plugins and they are available (free and with source code) here -> http://code.google.com/p/dxcorecommunityplugins/wiki/RoryBecker
Support
I doubt there is anyone who would argue that support is critical to any product that hopes to have any sort of longevity in the market. Look for Email Support, Forums, Issue Tracking, Blogs and the ability to access the people behind the products, should the need arise.
Community
As critical as official support is, it can rarely compare to the support you can get from other developers in the same, or similar position to you. Both of the main tools on the market have large numbers of users who work with the tools themselves every day. I would argue that CodeRush has a better 3rd party plugin community, but this is simply my opinion... You may decide that this area does not matter as much to you.
As I sit here writing this, I realize that I have already spent way too much time on it. I will stop for now, and If I think of anything else I will come back and add relevant content.
Conclusion
As stated in the summary, you should (IMHO) look to compare:
Interface & Intuitiveness, Navigability, CodeGeneration, Refactoring, Performance, Customization, Extensibility, Support and Community.
However you should also look to the community for advice and help with a tool. So if something is bothering you... See if the company or the community has a solution for you.
Crowd sourcing FTW ! :D
If you have any CodeRush related questions, feel free to contact me using any of the method specified at the bottom of my author page on the community plugin site. -> http://code.google.com/p/dxcorecommunityplugins/wiki/RoryBecker
Here's a few:
Inbuilt re-factorings (Extract Method, Introduce Variable etc)
Project Navigation (Go To Type, File)
Integration with test runners (NUnit, MSTest)
Configurable (can you set the lkey bindings as you wish)
Support (Find something it doesn't do and see how fast the makers answer!)
Kindness,
D
Great post Rory. :) I think you covered all the features developers should be looking for when trying to decide between the available productivity tools. I would like to take a moment and point out issues that cause developers to uninstall productivity tools after a few days, as I think this needs to be weighed alongside ?features.?
Slows Down VS
A big issue with many of the available tools is the added slow down they can cause VS, especially when you have a sizable solution open. The tool might make some tasks easier and quicker, but if it slows VS to a crawl all the time what is the point. ?Hurry up and wait?
Performance of the tool itself
Again, this is a ?hurry up and wait? type of issue. A developer is likely to uninstall, or not use, a tool if they constantly feel like they are waiting for it to respond, or complete a task. A tool should compliment your development habits, not hinder them. As soon as you feel like you can do a task faster than the tool, you will not use the tool.
In the way
Rory made a great point here. Some of the available tools seem to get in the way more than they help. If the tool interrupts the flow of your development, then you are going to quickly become annoyed and uninstall it
We have encountered many of these, issues and more while developing JustCode. For anyone interested you can check out my blog entry here seeing how we have tried our best to handle these issues, and some upcoming features in JustCode.
Feel free to get in touch with me if you need any JC information.
Thanks,
Joshua Holt
Developer Support Specialist ? Telerik
blogs.telerik.com/joshuaholt
twitter.com/jholt456 ?
Quick Note to answer Rory?s question:
If someone from Telerik should read this and this has changed, please feel free to contact me and I will look again(RoryBecker @ gmail)
JustCode does not play nice with some plugins, and as such it will ask you to disable them. (No uninstall required) This is in large part due to VS taking issue with both plugins using the API, and handling many of the same messages. However, this story is changing, and JustCode can now safely coexist with R# 5. VS2010 makes extensibility much easier, and we plan to keep improving in this area.
Great question Jacob and some great answers from everyone which may help us all when we come to review tools in the future.
Off track a little bit: not sure what's on your list to test but may also be worth checking out things like StyleCop for VS2010 (http://code.msdn.microsoft.com/sourceanalysis), MZ-Tools (http://mztools.com/index.aspx) and Code Rocket (http://www.getcoderocket.com/), if they are not already on your list.
The problem with renaming files is that if you want to take advantage of Visual Studio refactoring, you really need to do it from inside Visual Studio.
But most (not all*) version control system also want to be the ones doing the renaming.
One solution is to use integrated source control, but this is not always available, and in some cases is pretty clunky.
I'd personally be more comfortable using source control separately, outside of Visual Studio, but I'm not sure how to manage this question of file renames.
So, for those of you that use Visual Studio, which source control do you use? Do you use a VS integration (which one?) and otherwise, how do you resolve this renaming problem?
(* git is smart enough to work it out for itself)
I use SVN (TortiseSVN as the client) and use the Repair Move command from the commit dialog heavily. This allows me to rename the files within VS and resolve the rename when I'm ready to commit to keep version history.
As far as using the VS integration, like you, I find all VS integration clunky and do not use it.
mercurial usually prefers to do the renaming via hg rename however it can also detect renames from an outside source by using hg addremove -s 100 (or less than 100 if you want to match a rename with alterations) so clearly you can let VS do the rename and get mercurial to catchup with addremove.
We use SVN (TortoiseSVN to be exact), and i am always bothered with the renaming problem. The simplest solution i've found is to remove the files from the project, rename them via TSVN and add them back to the project. You have to manually update includes for renamed header files, but this is relatively easy using find&replace.
We use Team Foundation Server, and it works with no problems. I've also found that moving to using a fully integrated client has improved my workflow, as I don't need to flip between applications just to do trivial tasks.
We develop "Plastic SCM" and the Visual Studio Package supports move operations. But I see your point, I'm getting more and more comfortable with the idea of not having plugins/packages and then have the version control working behind the scenes and simply detecting what happened without having to be "plugged in" into the IDE. In fact we're working on it for next release...
Besides the above advice, for Visual Studio 2008 I found that after making all global changes to any file being renamed from within VS, including right clicking the file and renaming it, as well as a global search and replace for all strings, replacing the old file name with the new file name, you must, if the file is the initial startup file, right click and select it as "set as default page". Otherwise you'll may well get the "The resource cannot be found." error on runtime.
I now use the new Visual Studio 2010 and I experience something very annoying that wasn't happening before with Visual Studio 2008. Something changed with the way it handles the floating of tabs and I can't stand it. Every once in a while, I would somehow trigger the floating of a tab instead of just switching to it. It may have to do with the way I click (maybe a very fast double click gets sent), or maybe I very slightly drag the mouse when clicking the tab. I don't know. All I know is that I was fine with Visual Studio 2008.
Is there a way to disable this somewhere? I want to either un-register the double click as a floating tab trigger, or remove the floating option altogether.
How can I do that?
Thanks.
Not sure how to disable it, but if you hold and double click the tab again, it will dock back to its last position.
I found this very annoying but with Ctrl+DoubleClick the problem is not so painful anymore.
It looks like the latest edition of Productivity Power Tools includes features to change how the tabs are displayed / can be used. It does not currently support disabling of floating tabs or disabling dragging tabs off the dock; but in the comments section of the page, there is mention of adding it in future versions.
Bonus feature: middle click scrolling.
I have this exact same problem, and it happens often enough for it to be very annoying. I also didn't have any issues in VS2008. Ctrl-DoubleClick does restore it, but I'd much rather it didn't happen in the first place.
I'd thought it might be an artifact of my particular setup (I work in a Windows 7 VMWare virtual machine, VPN'ed into my work, then RDP'ed over to my development Windows 2008 server VM), but I guess not since you have it happening in a much simpler environment.
I've also been unable to find any way of disabling the floating editor windows - nothing obvious in the settings, and still nothing after a trawl through the registry.
Its not a problem in VS 2010 - it is useful when u r working on a lot of views at the same time. Here's a way to disable it. In the Menu -> Window -> "Reset Window Layout". It'll ask you to confirm, do it & it'll bring back your entire layout as it was originally. I had the same issue & i got this resolved. Let me know if it doesnt work.
Thx ! Raviku
I was wondering if anyone knew whether Visual Studio .NET had a parallel build process or not? I have a solution with lots of projects, every project has lots of markup/code, lots of types, etc. Just sitting there with intellisense on runs it up to about 700MB. But the build times are really slow and only seem to max out one of my two cpu cores.
Does this mean the build process is single threaded? My solution's build dependency chain isn't linear, so I don't see why it couldn't be building some of the projects in parallel. I remember Joel Spolsky blogging about his new SSD, and how it didn't help with compile times, but he didn't mention which compiler he was using. We're using VS 2005. Anyone know how it's compilation works? And is it any different/better in 2008/2010?
EDIT: Lots of good responses, here, but I'm interested specifically in C# and ASP.NET. No love for us web folks?
MSBuild (which VS uses to do builds, from 2005/.NET2) supports parallel builds. By default VS will set the maximum degree of parallelism to your number of processors. Use Tools | Options | Projects and Solutions | Build and Run to override this default.
Of course any one build might have more limited (or no) capacity to allow parallel builds. E.g. only one assembly in a solution provides no scope to build in parallel. Equally a large number of assemblies with lots of dependencies might block parallelism (A depends on B, C depends on A&B, D depends on C has no scope for parallel builds).
(NB. for C++, in VS 2005 & 2008 uses its own build system, in 2010 C++ will also be built with MSBuild.)
Scott Hanselman has a blog post from a couple years ago that details getting Faster Builds with MSBuild using Parallel Builds and Multicore CPUs that should be of interest. He also has a follow up post Hack: Parallel MSBuilds from within the Visual Studio IDE.
With VS2k5 it depends on which language you're trying to use. C/C++ has 'experimental' support for multi-threaded building, but this feature isn't officially supported until 2k8 using the /m: switch
Here is a good article on parallel builds in 2k5.
I would suggest that an SSD drive would provide the biggest benefit explicitly for builds
SuperUser which also refutes Joel's article
SO asking for best laptop etc: discussions on SSDs, cores, how VS works etc
Qualifier: I bought an Intel SSD for home use a month or 3 ago. Lordy it's fast and arguably the best piece of kit I've ever bought except for my Voodoo 2...
I have used parallel builds in Visual Studio 2008. It does speed things up, but has many annoying side effects.
I often get failed builds not because some compilation failed but because VS was unable to write into a locked symbol database. I have also got really messed up Intellisense results. Sometimes I have to repeat the build two or three times to get a final success.
When doing "Console" apps in Java with Eclipse, I see the output being put in a text box on the IDE itself, instead of having a Console popping up like in Visual Studio. This comes in handy, as even after the program has exited, I can still make good use of the text that was written in it, as it doesn't get erased until I run it again. Is it possible to achieve anything like that with Visual Studio? I know that instead of doing
System.Console.WriteLine(str);
I can do
System.Diagnostics.Debug.WriteLine(str);
but it is not quite the same thing, as you get a lot of "junk" in the Output window, as all the loaded symbols and such.
Even better, is it possible to have everything done in the IDE itself, when you run your app, instead of having the Console running?
Thanks
In the Visual Studio Options Dialog -> Debugging -> Check the "Redirect All Output Window Text to the Immediate Window".
Depending on what listeners you attach, trace output can go to the debug window, the console, a file, database, or all at once. The possibilities are literally endless, as implementing your own TraceListener is extremely simple.
It's not totally same but read this
You could create a wrapper application that you run instead of directly running your real app. The wrapper application can listen to stdout and redirect everything to Trace. Then change the run settings to launch your wrapper and pass in the path to the real app to run.
You could also have the wrapper auto-attach the debugger to the new process if a debugger is attached to the wrapper.
Is there a tool available that can scan a C# or VB.NET project and automatically remove all unused local variables?
Ahem: FxCop and ReSharper are nice and all, but the compiler will happily ignore unused variables and never even declare them in compiled code if you enable the optimize option.
You can use ReSharper. It will mark all unused variables and allow you to remove them.
You can use FxCop to analyse your code.
Our you van install resharper that greys unused local variables out
With both tools you have to delete them your self
It looks like ReSharper should help you clean up your code.
FxCop is a useful tool in a number of ways, one of which is that it will point out unused variables and parameters. This is helpful if you have your code going through a continuous integration process.
ReSharper will highlight unused variables and parameters when you are in Visual Studio.
Neither tool will automatically do the removal for you, although it's usually a simple thing to do...R# even provides a shortcut command to remove a single selected variable for you.
I need to move all the hard coded strings in my source code in .resx files. Is there a tool that could help me find all the hardcoded strings within C# code?
ReSharper 5 is obvious a choice, but many tips must be set so as to achieve your goals,
Then you can find almost all you need in Errors in Solution panel.
Hope this helps.
What about this:
http://www.codeplex.com/ResourceRefactoring
Courtesy scoob's answer here:
http://stackoverflow.com/questions/15133/tool-in-visual-studio-2008-for-helping-with-localization/16431#16431
You could always do a search for the " sign in all the .cs files. That should get you to most of them, without too much noise.
Resharper 5.0 (Beta) allows you to move strings to resources (it has built in Localization feature). Give it a try. Beta works fine, i use it every day and have no problems. Best of all it's free until out of beta. I even recommend using night builds as they seem to be stable.
Software localization and globalization have always been tough and at times unwanted tasks for developers. ReSharper 5 greatly simplifies working with resources by providing a full stack of features for resx files and resource usages in C# and VB.NET code, as well as in ASP.NET and XAML markup.
Dedicated features include Move string to resource, Find usages of resource and other navigation actions. Combined with refactoring support, inspections and fixes, you get a convenient localization environment.
Some are found by FxCop. Not sure what its limits are, I think it depends on parameter and property names (eg: a property called "Text" is considered to be localized).
I have an application that needs to operate on Windows 2000. I'd also like to use Visual Studio 2010 (mainly because of the change in the definition of the auto keyword). However, I'm in a bit of a bind because I need the app to be able to operate on older OS's, namely:
Visual Studio 2010's runtime library depends on the EncodePointer / DecodePointer API which was introduced in Windows XP SP2.
If using the alternate runtime library is possible, will this break code that relies on C++0x features added in VS2010, like std::regex?
The very simplest solution is just to set the Platform Toolset in project settings in VS2010 to v900, which will use the Visual Studio 2008 libraries and compiler. This also means you lose C++0x features like auto, but to be honest, working around that with some typedefs is probably easier than building your own version of the CRT or other more complicated solutions. Alternatively, just use VS2008! I don't know if there are other C++0x features that are critical to your application though, you didn't mention - other than std::regex, which I think is still in the v900 toolset under the technical report 1 namespace (std::tr1::regex).
Just from the impression I get, I would predict the inconvenience of getting the VS2010 libraries to run on XP SP1 is greater than the convenience of C++0x features, so overall it wouldn't be worth it.
You cannot use 2008 CRT, but you can prevent the new functions DecodePointer/EncodePointer to be linked from the kernel. It is quite easy to replace the new functions with stubs.
One might attempt following: Place code like this in your main.cpp source:
extern "C" {
void *__stdcall _imp__DecodePointer(void *x) {return x;}
void *__stdcall _imp__EncodePointer(void *x) {return x;}
};
The above does not work. While the basic idea is sound, the execution needs to be a little bit different. As described by snemarch in comment and another answer, __imp__ cannot be the function call, only the pointer to it. As it seems not possible to generate the pointer directly by the compiler, you need to assemble the following code with MASM and link against the produced object file.
.model flat
.data
__imp__EncodePointer@4 dd dummy
__imp__DecodePointer@4 dd dummy
EXTERNDEF __imp__EncodePointer@4 : DWORD
EXTERNDEF __imp__DecodePointer@4 : DWORD
.code
dummy proc
mov eax, [esp+4]
ret 4
dummy endp
end
The symbols from a project have preference against any symbols from libraries. DLL libraries are linked using .lib parts, which contain only __imp__ "vectors" jumping into the real functions. By replacing __imp__ "vectors" you do not touch the DLL linking, you replace the .lib part. I have verified there is no more any dependency of the exe on DecodePointer / EncodePointer.
Statically linked library brings only used functionality into the application. It is possible to find which particular CRT function bring in those new API using linker verbose progress output:
Found __imp__EncodePointer@4
Referenced in LIBCMT.lib(crtmboxw.obj)
Referenced in LIBCMT.lib(invarg.obj)
Referenced in LIBCMT.lib(handler.obj)
Referenced in LIBCMT.lib(onexit.obj)
Referenced in LIBCMT.lib(cmiscdat.obj)
Referenced in LIBCMT.lib(tidtable.obj)
Referenced in LIBCMT.lib(hooks.obj)
Referenced in LIBCMT.lib(winsig.obj)
Referenced in LIBCMT.lib(rand_s.obj)
Found __imp__DecodePointer@4
// ... same list, only order differs ...
This shows the new APIs are used in some of the CRT to provide more security for some functions which are deemed to provide frequent attack vectors.
With some effort it would be possible to use LoadLibrary / GetProcAddress to provide the real functionality where OS offers is, but I do not think it would really bring anything. The runtime functions which use DecodePointer / EncodePointer do not really need it to provide any encoding, all they need is the encoding to by symmetric. You do not really need the enhanced security (VS 2008 runtime would not give it to you either).
I hope there are no other obstacles waiting for you - I do not have an access to Win2k or XP pre SP2 system, therefore I am unable to try. If there are any exe header flags preventing even attempting to launch the exe on such systems, they should be easy to change.
Suma's solution looked pretty promising, but it doesn't work: the __imp__*@4 symbols need to be pointers to functions, rather than the functions themselves. Unfortunately, I don't know how to make Visual C++ spit out a pointer with that kind of name generation... (well, __declspec(naked) combined with __stdcall does the trick, but then I don't know how to emit a pointer).
If using an assembler at build-time is OK, the solution is pretty trivial - assemble the following code with FASM and link against the produced object file, and presto - no EncodePointer/DecodePointer references in the exe:
use32
format ms coff
section ".data" data
public __imp__DecodePointer@4
__imp__DecodePointer@4 dd dummy
public __imp__EncodePointer@4
__imp__EncodePointer@4 dd dummy
section ".text" code
dummy:
mov eax, [esp+4]
retn 4
This would be a lot easier if you're allowed to use a DLL. Basically, write an EXE that requires no C runtime functions at all, by using the linker /ENTRYPOINT function. Once you've tested that your basic prerequisites are met, and reported any problems to the user via only Windows-provided APIs available on all target OSes (i.e. MessageBox), then call LoadLibrary to kick off the DLL that contains the bulk of your logic. That DLL can use the VS2010 runtime as usual. You can even avoid deploying two separate files by decompressing the DLL from a resource contained within your main .EXE at startup. (You can do this entirely within memory without writing the .DLL to disk, but not if you want to take advantage of the Windows PE loader to fixup all your imports).
As Visual Studio comes with support for MASM (see project properties -> Build Customizations...) the following translation of snemarch's code to MASM might be useful:
.model flat
.data
__imp__EncodePointer@4 dd dummy
__imp__DecodePointer@4 dd dummy
EXTERNDEF __imp__EncodePointer@4 : DWORD
EXTERNDEF __imp__DecodePointer@4 : DWORD
.code
dummy proc
mov eax, [esp+4]
ret 4
dummy endp
end
And remember to set Linker->System->Minimum Required Version to 5.0 (default is 5.1) to run on Windows 2000.
The usual work-around for this problem is to build your own custom version of the CRT. There are instructions for it here. You'll just need to edit the code to ignore EncodePointer and DecodePointer. (There should already be a #define for that.)
There are two other minor things you'll need to do:
C:\Microsoft Visual Studio 9.0\VC\lib as the first path to search. (I'm assuming you used the default install directory, otherwise change as appropriate.)That should allow your program to run on Windows 2000 as well as later versions.
Option 1 - create a modified version of the 2010 runtime that redirects the problem API calls to a DLL that you supply. I don't know how easy or hard this would be - hopefully just a minor tweak to the symbol table, but it depends on the file format - and you're very likely to run into the reverse engineering clause of the license, of course.
Option 2 - Compare the exported symbols in two different versions of the runtime libs. If the symbols are the same, you have good odds of compatibility - though no guarantees. Its even possible that the lib file formats are different.
Option 3 - Check whether you can get access to runtime sources through the MSDN or similar, specifically in order to create a patched version.
Option 4 - Check whether you can use the 2010 compiler, but an older linker, perhaps configured in your solutions as a custom build step. Again, this depends on whether the obj and lib files are the same file format - but you may be able to write a small utility to patch simple differences like version numbers in a header. The older linker should have no problem linking in the older runtime - assuming the objs from the new compiler are compatible with it.
Option 5 - build DLLs in 2010 that don't need their own runtime, but which are loaded and hosted by an application built using the older compiler. Achieving the "no runtime" requirement for your DLLs may mean a lot of your libraries must be built in the hosting application, of course, and you may need to provide your own interfaces (via the host application) to library functions you need to work with - especially memory allocation stuff.
Options worth checking, but I'm sure you already thought of them all - sorry I have no idea whether any of them will work - or whether they'll almost work but cause intermittent problems.
Create a .LIB that implements the missing functionality and link it ahead of KERNEL32.LIB.
You will need to use the linker option /NODEFAULTLIB:kernel32.lib so that you can put your w2kcompat.lib ahead of kernel32.lib.
I'm really hoping someone can help me out with this one. When debugging in Visual Studio, sometimes I add a breakpoint but it's hollow and VS says "The breakpoint will not currently be hit. The source code is different from the original version." Obviously this prevents me being able to debug.
What on earth does the message mean? What original version? If I've just opened up the solution and not made any changes whatsoever to the code, how can there be an 'original version'?
The appearance of this problem just seems totally arbitrary. It's just Visual Studio going 'Na na na na na, I'm not going to debug for you today'.
Can anyone give any advice?
Ta
David
I have a straightforward (and obvious) solution for this issue. See: "The source code is different from the original version". So what does we have to do? Right click on the project folder inside the solution explorer >> and choose to Clean. So build a new version of the project and the breakpoint will work again!
Did you ever do this?
If you ticked the box and pressed "Yes" you will get the last successful build running even though your project does not compile. This means that whenever you set a breakpoint, you will get that error.
Try changing this value:
Tools
Options
Projects and Solutions
Build and Run
On Run, when build or deployment errors occur: Do not Launch
As lexu said:
"recompile/build the project before adding the break-point"
Pay attention to the "Output" window in visual studio. It will tell you what assemblies are loaded and when. You may see that an older version of your assembly somewhere in the folder is being loaded. For example if you have multiple assemblies and you are currently trying to break in one of the support assemblies, the CLR will handle the assembly resolving, which may load another assembly file than the one you have referenced in the visual studio project.
This happen often also if you are using a file references to binaries (instead of project references to code in your project), and the compiled binary that you are referencing falls out of sync with the corresponding source code on your machine. This can happen because you downloaded a new version of the binary from source control without the new source code that went with it, or you have a few versions of the binary on your machine and are referencing an old copy, etc. If this is indeed the problem, it's a good reason to use project references as much as it practical.
I made a notice myself as building a program what synchronizes time from remote server at start when program is started to run/debug. Just in this second when my debugged program syncs time with my development machine, the source codes get out of sync and debugging is no more possible because my development machines time is slighly different from when it was builded.
So make sure nothing , not ur developed program or anything else moves your computers clock while you try to debug.
Also, if u had these problems and just clicked all pop-up windows in great hate, make sure you dont have any of your files on solutions properties ignore source code list. That list can be found on -> Solution->Properties->Debug Source Files->Do not look for these source files:
I had the same problem today and found the following reason:
Someone else on the team unchecked the DLL project in the Debug build configuration, so my new code was never built! No wonder I got the above error message.
So go to Build --> Configuration Manager ... (in VS2010) and check if the project with the code you're trying to debug is checked for the current build configuration.
Hope this helps anyone :-)
I just encountered this problem and in my case the trouble was that I had added a new project to the solution and for some reason the default properties of the solution did NOT include building this particular project. To resolve this, right click on the Solution in the Solution Explorer, click Properties. Then see if the project you're currently trying to debug is marked with a check under the Build column (of the initial view, which should be Configuration Properties > Configuration. If it's not checked, check it!
As to why this occasionally happens, I do not know. The error message itself seems pretty self-explanatory, but in some situations doesn't reveal the true underlying cause.
I had this happen to me today while debugging. Regardless of building/rebuilding, the same message kept appearing. In order to get things going again, I had to close VS and open a new instance. After that, I was able to debug, as expected.
I do not like to play with knives but the only thing that worked for me involved editing the .csproj file itself. So, unload the project file, edit it by cutting and pasting the three asp.net files so that they are together in the ItemGroup. However, sometimes it is necessary to go further as explained here: http://carnotaurus.tumblr.com/post/4130422114/visual-studio-debugging-issue-with-files-of-the-same - Also, I give a list of other proposed solutions that did not work for me. I hope it helps.
Generally Visual Studio is telling the truth. For one reason or another, the source file ("current version") is more recent than the generated code ("original version", ie the version that was compiled). I've seen it happens many times, and each and every time it was a mistake from my side.
I'll try to list all the different mistakes I made that caused such a problem. I may help you find what kind of error can cause this warning.
As @Codesleuth said, you may have checked the option "Run the last successful build" and you're build is failing. In that case, the previous build will be run and the source will be more recent than the compiled object.
If you have multiple copy of your project on your computer (you're working on multiple features in parallel, each one developed in a branch), you may be editing the correct file but on another branch. This can happens if you open the file in the explorer, or via a "Find in file" with absolute path.
I've worked on a solution that contained lots of projects that could be built for PC or Xbox. The main project for each target was different (since the Xbox did not depend on every projects). If the selection is to build for the Xbox, but the project to launch is the main project of the PC version, then Visual will rebuild your code only for the Xbox, and then launch the PC executable that was not rebuild.
The project containing the current file may also be configured not to be rebuild in some particular build configuration (maybe it is not used in the retail version), and while checking something in the configuration manager the selected configuration for the project has been desynchronized from the rest of the solution (the configuration manager is IMO the worst possible editor, it is so easy to make a mistake and not see it, just use the mousewheel).
There is a tricky case for that: when you are using an activator and the assembly you set the breakpoint into has not been loaded yet. The error message is then confusing. The breakpoint will resolve once the activator loads the assembly (assuming the assembly and debug symbols are up to date). A good place to look at is the modules window in the debugging menu. There you should look for the assembly which your file belongs too. First check that the assembly is loaded. Then, from where is it loaded? Then, is the symbols file loaded. Again, where is the symbols file loaded from? Finally check the versions of both.
So sometimes (oftentimes!) you want to target a specific .NET version (say 3.0), but then due to some .NET service packs you get into problems like:
Dispatcher.BeginInvoke(Delegate, Object[]) <-- this was added in 3.0 SP2 (3.0.30618 )System.Threading.WaitHandle.WaitOne(Int32) <-- this was added in 3.5 SP1, 3.0 SP2, 2.0 SP2Now, these are detected by the JIT compiler, so building against .NET 3.0 in Visual Studio won't guarante it will run on .NET 3.0 only systems.
Short of
what's the best way to avoid against using extensions?
Thanks!
Microsoft tend to assume that, if you have .NET XXX installed, then you must be on the latest service pack because Windows Update will push them out to you as critical updates. I know it's a brittle assumption and sometimes breaks down, but that's what's supposed to happen.
Our products currently target .NET 3.5 SP1, and as such we would be astonished to find a target environment still running .NET 3.5 RTM.
This capability is built into Visual Studio as of VS 2008 SP1 and is also available in FxCop 1.36. Take a look at David Kean's blog post for more details.
There was a way of telling windows which .Net version use. It is something like creating a file called dllhost.exe.config IN windows\system32 with xmllike :
<? xml version = "1.0" ?>
<configuration>
<startup>
<SupportedRuntime version = XXXXXX>
</startup>
</configuration>
Before sending out a release, compile your application with the appropriate version of Visual Studio that corresponds to the least-common denominator of your target userbase.
Just keep a virtual machine ready that has, say Visual Studio 2005 no SPs at hand, and compile the solution from there before deploying.
Does this help: Versioning Controlled Build?
I am attempting to use Scintilla .NET in a project (I want a good editor + syntax highlighting, etc). Unfortunately, when I reference the binaries in my project, I can't seem to actually use the Scintilla controls. I get two different errors.
The first happens when adding SciLexer.dll as a reference to my project. I get a message that says: A reference to SciLexer.dll could not be added. Please make sure the file is accessible, and that it is a valid assembly or COM component.
The second error occurs when I try to use the controls from ScintillaNET.dll. If I try to drag the component into a form, I get the following message: Failed to create component Scintilla. The error message follows: System.ComponentModel.Win32Exception: %1 is not a valid Win32 application at ScintillaNet.Scintilla.get_CreateParams()
Any help with either of these problems would be much appreciated. For the record, I am running Visual Studio 2008 running on a 64-bit Windows 7 platform.
Thanks.
It's been a little while since I used Scintilla, but my understanding is that SciLexer.dll is an entirely native DLL, which is why you can't add a reference to it from Visual Studio.
Instead, you should 'arrange' for SciLexer.dll to appear in the right directory at runtime so that it can be loaded by ScintillaNET.dll. The safest way to do this would be to add SciLexer.dll to your Visual Studio project as a plain file (not as a reference), then change the properties on the file to have it copied to the output directory when your project is built.
Given that you're on 64-bit, I expect that you'll need to build your app specifically as 32-bit and not AnyCPU. As I say, it's been a while since I did this, but when I did, Scintilla only had 32-bit binaries.
I am using Phil Haack's T4CSS T4 template based on .less
One bad thing about Phil's solution is that visual studio opens the .less files as plain text files rather than as css files. (Thus no intellisense.)
How can I get VS to open a .less file in the CSS Source Editor?
I've tried:
Can this be done?
I just posted an extension that does this; you can download it from the Visual Studio Gallery.
The key to the extension is the .pkgdef file:
[$RootKey$\Languages\File Extensions\.less]
@="{A764E898-518D-11d2-9A89-00C04F79EFC3}"
[$RootKey$\Editors\{A764E89A-518D-11d2-9A89-00C04F79EFC3}\Extensions]
"less"=dword:00000028
Note that this extension doesn't do anything to help the CSS language service support Less; nested rules, for example, don't work very well at all (it confuses the CSS language service).
If you are using the dotless.Compiler.exe tool (as opposed to the http handler), there is nothing to say your files have to end with .less. I name my suffix my .less files with .css so that Visual Studio treats them like css files. E.g. my naming convention is:
/css/common.less.css ==> /css/common.css
I run the dotLess compiler as a post-build event, e.g.
$(SolutionDir)\packages\dotless.1.1.0\Tools\dotless.Compiler.exe "$(ProjectDir)\css\common.less.css" "$(ProjectDir)\css\common.css"
Midscape's Web Workbench Visual Studio Extension adds support for .less files, including syntax highlighting and Intellisense. It also adds support for SASS and CoffeeScript.
VS6 popped off a series of errors before bombing out completely during install on Windows 7. I specifically need to get VB6 functioning on Windows 7. Anyone having any luck?
Folks on the VB6 newsgroup report they have managed to get it working on Windows 7.
There's this step-by-step guide on how to install the IDE on Windows 7 (including 64 bit).
If that doesn't work (scrapes barrel) try this old tip about persuading the install not to install the Java VM?
Or (scrapes hole in barrel) these tips from an article about getting the IDE working on Vista?
The only way I've found that works is Windows XP mode (i.e. a virtual machine). Works fine there, but otherwise, not at all.
I installed VB6 on Windows 7 Pro without having to use compatibility settings or run as administrator.
Doesn't really help you, but does show that it can work.
Several people in my office have installed Visual Studio 6 (without VC++) on Windows 7, both 32-bit and 64-bit with no problems. The one thing we have in common: we've all turned UAC down to it's lowest setting. Nothing else special required.
I found ALL the answers in a thread at vbmonster.com. As mentioned above, you CAN install Visual Studio 6 with Service Pack 6 under Windows 7 by following Derek's detailed instructions at fortypoundhead.com.
I had a problem because I needed to install Service Pack 5. I use a third party program that does not work with Service Pack 6. A really smart programmer (GuideX) came up with a great hack to get around the MDAC 2.5 error.
I had a Vista x64 box with a working copy of the VB6 IDE (which was supported). I upgraded the OS to Windows 7 x64 and the VB6 IDE still works fine. You could try that. I know, a huge PITA and kludgy but still, it worked for me.
Where can I get the VSDoc for jQuery 1.4.2?
The adventurous can add the following lines starting at 2949:
delegate: function( selector, types, data, fn ) {
/// <summary>
/// Attach a handler to one or more events for all elements that match the selector, now or in the future, based on a specific set of root elements. See also "live".
/// </summary>
/// <param name="selector" type="String">
/// An expression to search with.
/// </param>
/// <param name="types" type="String">
/// A string containing a JavaScript event type, such as "click" or "keydown".
/// </param>
/// <param name="data" type="Object">
/// A map of data that will be passed to the event handler.
/// </param>
/// <param name="fn" type="Function">
/// A function to execute at the time the event is triggered.
/// </param>
return this.live( types, data, fn, selector );
},
undelegate: function( selector, types, fn ) {
/// <summary>
/// Remove a handler from the event for all elements which match the current selector, now or in the future, based upon a specific set of root elements. See also "die".
/// </summary>
/// <param name="selector" type="String">
/// An expression to search with.
/// </param>
/// <param name="types" type="String">
/// A string containing a JavaScript event type, such as "click" or "keydown".
/// </param>
/// <param name="data" type="Object">
/// A map of data that will be passed to the event handler.
/// </param>
/// <param name="fn" type="Function">
/// A function to execute at the time the event is triggered.
/// </param>
if ( arguments.length === 0 ) {
return this.unbind( "live" );
} else {
return this.die( types, null, fn, selector );
}
},
That documentation is pretty much ripped from jQuery web pages and from current definitions of "live" and "die", but feel free to adjust as you see fit.
Also, at line 224:
// The current version of jQuery being used
jquery: "1.4.2",
You always get it from http://docs.jquery.com/Downloading_jQuery - if it's not there yet, it's not available yet. v1.4.1 exists - see screenshot - but 1.4.2 isn't ready yet.
Just a note on Herb's answer. Line 2940, for me anyway, was in the middle of the 'trigger' method. I inserted the code after 2949. Also, since it took me about 45 minutes to figure out why the comments weren't working for those two new routines - the "summary" tags have one too many 'm's in them!
Here's the corrected version:
delegate: function(selector, types, data, fn) {
/// <summary>
/// Attach a handler to one or more events for all elements that match the selector, now or in the future, based on a specific set of root elements. See also "live".
/// </summary>
/// <param name="types" type="String">
/// A string containing a JavaScript event type, such as "click" or "keydown".
/// </param>
/// <param name="data" type="Object">
/// A map of data that will be passed to the event handler.
/// </param>
/// <param name="fn" type="Function">
/// A function to execute at the time the event is triggered.
/// </param>
/// <param name="selector" type="String">
/// An expression to search with.
/// </param>
return this.live(types, data, fn, selector);
},
undelegate: function(selector, types, fn) {
/// <summary>
/// Remove a handler from the event for all elements which match the current selector, now or in the future, based upon a specific set of root elements. See also "die".
/// </summary>
/// <param name="selector" type="String">
/// An expression to search with.
/// </param>
/// <param name="types" type="String">
/// A string containing a JavaScript event type, such as "click" or "keydown".
/// </param>
/// <param name="fn" type="Function">
/// A function to execute at the time the event is triggered.
/// </param>
if (arguments.length === 0) {
return this.unbind("live");
} else {
return this.die(types, null, fn, selector);
}
},
Not sure if it is the "official version" but now a 1.4.2-vsdoc file can be downloaded from the Microsoft CDN: http://ajax.microsoft.com/ajax/jQuery/jquery-1.4.2-vsdoc.js
As well as renaming the VSDoc file (1.4.1) you may also have to change the jQuery version number used in the 1.4.1-vsdoc.js file to 1.4.2.
See line# 224,
// The current version of jQuery being used
jquery: "1.4.2",
I decided to create one based on the input from this question & answers and share it. You can download it from this blog post:
http://hugeonion.com/2010/06/26/here-is-the-missing-jquery-1-4-2-vsdoc-file/
Hope that helps!
The latest VSDoc supported version seems to be v.1.4.4 from Microsoft and can be found at http://ajax.aspnetcdn.com/ajax/jQuery/jquery-1.4.4-vsdoc.js.
It is the new MS CDN for toolkits (replacing the old microsoft.com domain).
For the time being you could always just rename "jquery-1.4.1-vsdoc.js" to "jquery-1.4.2-vsdoc.js" and when they release the new vsdoc version just replace it.
Note: I had to then modify the script source path and then change it back again to force vs to pick up the vsdoc. I just added a forward slash at the start of the src attribute value and then removed it.
John T said:
For what it's worth, and from this question:
jQuery 1.4.3 vsdoc
Someone has updated the jQuery vsdoc for JQuery 1.4.3. It's at:
@John T: Thanks for the links!
For users of the v1.4.4 VSDOC file supplied here, there is a slight error that breaks IntelliSense; at line 1751 the file reads:
jQuery.proxy = function(function, context){
This causes Visual Studio to show the following error:
Error updating JScript IntelliSense: <your path>\jquery-1.4.4-vsdoc.js: Expected identifier @ 1750:24 (or near enough).
Update this line to read:
jQuery.proxy = function(method, context){
This bug was found and resolved in VS2008.
For what it's worth, and from this question:
Someone has updated the jQuery vsdoc for JQuery 1.4.3. It's at:
With VS2008 SP1 and the JSDoc Hotfix applied, I'm still getting this error wrt jQuery 1.4.4:
Warning 1 Error updating JScript IntelliSense: \Website\Javascript\jQuery\jquery-1.4.4-vsdoc.js: 'class2type' is undefined @ 2401:8
Using jQuery 1.4.4, and the vsdoc from http://appendto.com/community/vsdoc (as well as the fix for line ~1750), I can update my Intellisense without error; however, whenever I type:
$.
Not only do I not get any relevant Intelliprompts, but I see:
Javascript Intellisense Message: JSIntellisense:Internal/(3:4) : Object required
This references the first function in my .js file:
; (function ($) { $.fn.MobileFunction = function (options) {
//My Function
};
})(jQuery);
I do have one warning: "Expected Expression" on the first closing paren in })(jQuery); but I cannot find a syntax error in the code. Even with the entire function commented out, Intellisense produces no output.
this page contain a list of vsdoc files on microsoft's CDN
http://www.asp.net/ajaxlibrary/cdn.ashx
just search for vsdoc and u will find it :)
right now its not on official jquery download page
Looks like they have added the 1.4.2 to the JQuery download page:
http://docs.jquery.com/Downloading_jQuery
NM was looking in the wrong spot
I got a problem migrating from VS.Net 2008 / MVC 1 to VS.NET 2010 (+C# 4.0) / MVC 2
The web.config has been updated, the site runs well in Cassini, but my problem now is deploying on IIS 6.
I updated the web site to run using ASP.Net 4, but whatever URL I try, I always have a 404 error. It's as if the routing was not taken into account (yes, the wildcard mapping has been done).
I do not understand this mess and could not google anything interesting... Thanks for your suggestions !
Ok I got y answer (thanks to a colleague)
When migrating from ASP.Net 2.0 to ASP.Net4.0, if you meet the same problem, then check in Web Service Extension if ASP.Net v4 is Allowed.
In my case, after installing the .Net framework 4, it was prohibited.
Will & Mark : thanks for your help, hope it will helps others.
I think I know what's happening: on IIS6, as well as the wildcard mapping you will need a default document (Default.aspx) that routes folder requests to the MVC handler.
There was one included with the MVC1 project templates, but it has been removed in MVC2.
Default.aspx:
<%@ Page Language="C#" AutoEventWireup="true" CodeBehind="Default.aspx.cs" Inherits="YourNameSpace._Default" %>
<%-- Please do not delete this file. It is used to ensure that ASP.NET MVC is activated by IIS when a user makes a "/" request to the server. --%>
and Default.aspx.cs:
using System.Web;
using System.Web.Mvc;
using System.Web.UI;
namespace YourNameSpace
{
public partial class _Default : Page
{
public void Page_Load(object sender, System.EventArgs e)
{
// Change the current path so that the Routing handler can correctly interpret
// the request, then restore the original path so that the OutputCache module
// can correctly process the response (if caching is enabled).
string originalPath = Request.Path;
HttpContext.Current.RewritePath(Request.ApplicationPath, false);
IHttpHandler httpHandler = new MvcHttpHandler();
httpHandler.ProcessRequest(HttpContext.Current);
HttpContext.Current.RewritePath(originalPath, false);
}
}
}
When you say "It's as if the routing was not taken into account", I suspect that it actually isn't, and this is your problem.
This finally fixed it for me:
I commented earlier, and a wee bit prematurely. My comment to Mark B's post was getting my initial Index view to show up, but then I kept getting the 404 errors whenever I navigated to any other view.
I was also distracted by the green check mark approved solution in this particular forum, but I could not even see the web server extensions folder in IIS 6 on my desktop; therefore, I had no control from that stand point of enabling aspnet 4.0, though I made sure it was installed by performing running the following command line:
C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319> aspnet_regiis -i
Now for the actual piece that finally allowed me to navigate to the other views besides just my Home/Index:
In the Global.asax.cs file of your VS 2010 Solution, you will see code as follows in the RegisterRoutes method:
routes.MapRoute(
"Default", // Route name
"{controller}/{action}/{id}", // URL with parameters
new { controller = "Home", action = "Index", id = UrlParameter.Optional });
I simply added ".aspx" after the {action} section of the tag as follows:
routes.MapRoute(
"Default", // Route name
"{controller}/{action}.aspx/{id}", // URL with parameters
new { controller = "Home", action = "Index", id = UrlParameter.Optional });
And ahla wahla Peanut Butter and Jelly sandwiches. :0)
If you want to do it in C#, just add the System.DirectoryServices reference and this piece should do the job nicely.
DirectoryEntry w3svc = new DirectoryEntry("IIS://localhost/W3SVC");
w3svc.Invoke("EnableWebServiceExtension", "ASP.NET v4.0.30319");
w3svc.CommitChanges();
HTH
Every so often, I run into a case where I want a collection of classes all to possess similar logic. For example, maybe I want both a Bird and an Airplane to be able to Fly(). If you're thinking "strategy pattern", I would agree, but even with strategy, it's sometimes impossible to avoid duplicating code.
For example, let's say the following apply (and this is very similar to a real situation I recently encountered):
Bird and Airplane need to hold an instance of an object that implements IFlyBehavior.Bird and Airplane need to ask the IFlyBehavior instance to Fly() when OnReadyToFly() is called.Bird and Airplane need to ask the IFlyBehavior instance to Land() when OnReadyToLand() is called.OnReadyToFly() and OnReadyToLand() are private.Bird inherits Animal and Airplane inherits PeopleMover.Now, let's say we later add Moth, HotAirBalloon, and 16 other objects, and let's say they all follow the same pattern.
We're now going to need 20 copies of the following code:
private IFlyBehavior _flyBehavior;
private void OnReadyToFly()
{
_flyBehavior.Fly();
}
private void OnReadyToLand()
{
_flyBehavior.Land();
}
Two things I don't like about this:
It's not very DRY (the same nine lines of code are repeated over and over again). If we discovered a bug or added a BankRight() to IFlyBehavior, we would need to propogate the changes to all 20 classes.
There's not any way to enforce that all 20 classes implement this repetitive internal logic consistently. We can't use an interface because interfaces only permit public members. We can't use an abstract base class because the objects already inherit base classes, and C# doesn't allow multiple inheritance (and even if the classes didn't already inherit classes, we might later wish to add a new behavior that implements, say, ICrashable, so an abstract base class is not always going to be a viable solution).
What if...?
What if C# had a new construct, say pattern or template or [fill in your idea here], that worked like an interface, but allowed you to put private or protected access modifiers on the members? You would still need to provide an implementation for each class, but if your class implemented the PFlyable pattern, you would at least have a way to enforce that every class had the necessary boilerplate code to call Fly() and Land(). And, with a modern IDE like Visual Studio, you'd be able to automatically generate the code using the "Implement Pattern" command.
Personally, I think it would make more sense to just expand the meaning of interface to cover any contract, whether internal (private/protected) or external (public), but I suggested adding a whole new construct first because people seem to be very adamant about the meaning of the word "interface", and I didn't want semantics to become the focus of people's answers.
Questions:
Regardless of what you call it, I'd like to know whether the feature I'm suggesting here makes sense. Do we need some way to handle cases where we can't abstract away as much code as we'd like, due to the need for restrictive access modifiers or for reasons outside of the programmer's control?
Update
From AakashM's comment, I believe there is already a name for the feature I'm requesting: a Mixin. So, I guess my question can be shortened to: "Should C# allow Mixins?"
The problem you describe could be solved using the Visitor pattern (everything can be solved using the Visitor pattern, so beware! )
The visitor pattern lets you move the implementation logic towards a new class. That way you do not need a base class, and a visitor works extremely well over different inheritance trees.
To sum up:
For a reference, see the Visitor pattern
Visual Studio already offers this in 'poor mans form' with code snippets. Also, with the refactoring tools a la ReSharper (and maybe even the native refactoring support in Visual Studio), you get a long way in ensuring consistency.
[EDIT: I didn't think of Extension methods, this approach brings you even further (you only need to keep the _flyBehaviour as a private variable). This makes the rest of my answer probably obsolete...]
However; just for the sake of the discussion: how could this be improved? Here's my suggestion.
One could imagine something like the following to be supported by a future version of the C# compiler:
// keyword 'pattern' marks the code as eligible for inclusion in other classes
pattern WithFlyBehaviour
{
private IFlyBehavior_flyBehavior;
private void OnReadyToFly()
{
_flyBehavior.Fly();
}
[patternmethod]
private void OnReadyToLand()
{
_flyBehavior.Land();
}
}
Which you could use then something like:
// probably the attribute syntax can not be reused here, but you get the point
[UsePattern(FlyBehaviour)]
class FlyingAnimal
{
public void SetReadyToFly(bool ready)
{
_readyToFly = ready;
if (ready) OnReadyToFly(); // OnReadyToFly() callable, although not explicitly present in FlyingAnimal
}
}
Would this be an improvement? Probably. Is it really worth it? Maybe...
Cant we use extension methods for this
public static void OnReadyToFly(this IFlyBehavior flyBehavior)
{
_flyBehavior.Fly()
}
This mimics the functionality you wanted (or Mixins)
Cheers
You just described aspect oriented programming.
One popular AOP implementation for C# seems to be PostSharp (Main site seems to be down/not working for me though, this is the direct "About" page).
To follow up on the comment: I'm not sure if PostSharp supports it, but I think you are talking about this part of AOP:
Inter-type declarations provide a way to express crosscutting concerns affecting the structure of modules. Also known as open classes, this enables programmers to declare in one place members or parents of another class, typically in order to combine all the code related to a concern in one aspect.
I will use extension methods to implement the behaviour as the code shows.
Let Bird and Plane objects implement a property for IFlyBehavior object for an interface IFlyer
public interface IFlyer
{
public IFlyBehavior FlyBehavior
}
public Bird : IFlyer
{
public IFlyBehaviour FlyBehavior {get;set;}
}
public Airplane : IFlyer
{
public IFlyBehaviour FlyBehavior {get;set;}
}
Create an extension class for IFlyer
public IFlyerExtensions
{
public void OnReadyToFly(this IFlyer flyer)
{
flyer.FlyBehavior.Fly();
}
public void OnReadyToLand(this IFlyer flyer)
{
flyer.FlyBehavior.Land();
}
}
Could you get this sort of behavior by using the new ExpandoObject in .NET 4.0?
Scala traits were developed to address this kind of scenario. There's also some research to include traits in C#.
UPDATE: I created my own experiment to have roles in C#. Take a look.
Possible Duplicate:
How do I stop visual studio from automatically inserting asterisk during a block comment?
When adding a multi-line comment in Visual Studio, it automatically places an asterisk (*) at the beginning of a new line (on enter) inside the comment block. I personally find this a nuisance. Does anyone know how to disable it? Thanks.
Found this answer for you online (see here):
This works with Visual Studio 2005 and 2008:
in the IDE, go to Tools->Import and Export Settings; then Export selected environment settings; deselect everything except Options->Text Editor; save to a new file.
Edit your exported settings file in some text editor. Search for the string "AutoComment". There's a PropertyValue tag with value 1, change it to 0, and save the file.
in the IDE, import this new file using Tools->Import and Export Settings. It should stop formatting comments right away.
To be clear, I haven't tested it myself yet . . . please let us know if it works for you.
Update:
Another way, as posted in the previous question on this (linked by Rob van Groenewoud, above)
Tools > Options... > Text Editor > C# > Advanced > Uncheck "Generate XML Documentation comments for ///".
(Of course, in addition to getting rid of the automatic * in block comments, this will disable the autoformatting when you type "///", as it says.)
It sounds like the solution I gave above does the same thing, but by editing the settings file itself instead of using the menu options.
I would have left this as a comment on John Saunders' answer, but alas, my rep is not high enough :)
Vertical Selections
If you'd rather not be editing settings files, or you want to keep the automatic xml comment generation on typing "///", you could use vertical highlighting to select all the asterices and hit delete. Visual Studio, like Microsoft Office, gives you the ability to select a "column" of text: just hold alt and click-drag your selection across several lines.
It's possible you know this already, but it's still worth mentioning.
Pressing the delete key a few times works for me.
Does Visual Studio 2010 RC play nicely with Visual Studio 2008?
I am wondering if I need to setup a Virtual Machine to play with VS 2010 or if I can just install it on my Dev machine.
If it messes up VS 2010 then that is sad but ok. If it messed up VS 2008 then I would be in trouble.
Has anyone tried this out? Does it work well? Poorly?
Thanks for any answers.
I've had no problems. Microsoft has designed the last several versions of Visual Studio to be able to co-exist side-by-side.
That said, VS 2010 is an RC, so it is still a pre-release. And even after it goes RTM, it's still a complex product and like any complex software install there can be bugs. I wouldn't expect serious problems, but there's always the fraction of a percent that do run into issues. So I'd still plan to install it on a day when you'd have cycles to deal with potential issues (if nothing else, installing it on my machine that hadn't had OS updates installed in a while required at least 2 reboots).
Yes this works and is a supported scenario. My advice is to install 2008 first then 2010. This is the setup i have on multiple computers.
has worked for me without any issues so far. I would follow JaredPar's advice though, install 2008 first, then 2010.
I never trust the "plays nice with others" claims because I've been bit by it before. They supposedly co-exist, but I still put it in a VM.
See this blog post. Visual Studio 2010 / .NET Framework 4 RC Ready for General Download
I haven't installed it on my machine but my manager has and after we looked at it we decided it's best not to go there yet for two reasons:
1) We have to go through the whole conversion process again, which after our experience with 1.1 -> 2.0 wasn't very enticing.
2) We caused an error within the first couple minutes of playing around that worked fine on VS2008 leading us to believe it's not quite ready for primetime yet anyways. (It was adding a method in the class diagram that caused VS to crash for some reason).
Just my two cents though.
edit: I just found another great example, fifth one down: http://thedailywtf.com/Articles/Tell-a-programmer.aspx
I havent go into too much testing with my VS 2008 projects in 2010, but it does look like it works fine with VS 2010 RC.
Also, both versions seem to run fine on my machine. (I have also VS 2003 on my local as well)
Bearing in mind its the Release Candidate version, is should be very reliable in this area.
I've had no problems either. And I didn't with VS2010 beta 2 and VS2008 either.
I have both of them on my machine, so far no problems
I've run into an error with IIS and VS2010 -- it's solved by re-running the .NET 3.5 version of aspnet_regiis.
I installed 2010 with 2008 already installed. I had tons of hangs, crashes and general malfunctions. Reinstalling 2008 didn't help until I removed every trace of 2010 from registry.
I've installed 2010 with 2008 on this machine for silverlight development.. I haven't noticed any problems except for file associations all goto the 2010 version rather than what I'd prefer opened in 2008 by default. (2010 to me is much slower than 2008)
Is there a shortcut for Duplicate Line in Visual Studio 2008?
Duplicate Line i.e. like Ctrl + J in Edit Plus or Crtl + D in Notepad++.
It's simple Ctrl + C ; Ctrl + V , check this link.
Look at this link, you need to create macro to create the shortcut... Duplicate line command for Visual Studio
If you like eclipse style line (or block) duplicating using CTRL+ATL+UP or CTRL+UP+DOWN, below I post macros for this purpose:
Imports System
Imports EnvDTE
Imports EnvDTE80
Imports System.Diagnostics
Public Module DuplicateLineModule
Sub DuplicateLineDown()
Dim selection As TextSelection = DTE.ActiveDocument.Selection
Dim lineNumber As Integer
Dim line As String
If selection.IsEmpty Then
selection.StartOfLine(0)
selection.EndOfLine(True)
Else
Dim top As Integer = selection.TopLine
Dim bottom As Integer = selection.BottomLine
selection.MoveToDisplayColumn(top, 0)
selection.StartOfLine(0)
selection.MoveToDisplayColumn(bottom, 0, True)
selection.EndOfLine(True)
End If
lineNumber = selection.TopLine
line = selection.Text
selection.MoveToDisplayColumn(selection.BottomLine, 0)
selection.EndOfLine()
selection.Insert(vbNewLine & line)
End Sub
Sub DuplicateLineUp()
Dim selection As TextSelection = DTE.ActiveDocument.Selection
Dim lineNumber As Integer
Dim line As String
If selection.IsEmpty Then
selection.StartOfLine(0)
selection.EndOfLine(True)
Else
Dim top As Integer = selection.TopLine
Dim bottom As Integer = selection.BottomLine
selection.MoveToDisplayColumn(top, 0)
selection.StartOfLine(0)
selection.MoveToDisplayColumn(bottom, 0, True)
selection.EndOfLine(True)
End If
lineNumber = selection.BottomLine
line = selection.Text
selection.MoveToDisplayColumn(selection.BottomLine, 0)
selection.Insert(vbNewLine & line)
selection.MoveToDisplayColumn(lineNumber, 0)
End Sub
End Module
Here's a macro based on the one in the link posted by Wael, but improved in the following areas:
For visual studio 2010, try using these commands for quick line duplication (uses clipboard):
Click on the line you want to copy. Ctrl + C will copy that line.
Then press Ctrl + Shift + Enter to insert a blank below insertion point
(Alternatively use Ctrl + Enter to insert a blank line above the insertion point.)
Then simply use Ctrl + V to paste the line.
Not an answer, just a useful addition: As a freebie, I just invented (well... ehm... adjusted the code posted by Lolo) a RemoveLineOrBlock macro. Enjoy!
Imports System
Imports EnvDTE
Imports EnvDTE80
Imports EnvDTE90
Imports EnvDTE90a
Imports EnvDTE100
Imports System.Diagnostics
Public Module RemoveLineOrBlock
Sub RemoveLineOrBlock()
Dim selection As TextSelection = DTE.ActiveDocument.Selection
Dim lineNumber As Integer
Dim line As String
If selection.IsEmpty Then
selection.StartOfLine(0)
selection.EndOfLine(True)
Else
Dim top As Integer = selection.TopLine
Dim bottom As Integer = selection.BottomLine
selection.MoveToDisplayColumn(top, 0)
selection.StartOfLine(0)
selection.MoveToDisplayColumn(bottom, 0, True)
selection.EndOfLine(True)
End If
selection.LineDown(True)
selection.StartOfLine(vsStartOfLineOptions.vsStartOfLineOptionsFirstColumn,True)
selection.Delete()
selection.MoveToDisplayColumn(selection.BottomLine, 0)
selection.StartOfLine(vsStartOfLineOptions.vsStartOfLineOptionsFirstText)
End Sub
End Module
I'm working on one sub-module of a large project for which is use VSTS 2008.
I have a need to rollback the module to an earlier version (about 4 check-ins previous). I tried to do this in the Visual Studio UI, and finally realized there is no option to rollback.
After some research, I determined there is a power tools download that purports to support rollback via a command-line tool. However, there appears to be virtually no documentation for it.
Can anyone describe step by step how to rollback to a previous version in VS2008? (Using Power Tools or otherwise).
Bonus question--anyone know if we might get more robust rollback support in VS2010?
There IS a way but I don't find it pretty.. Open Visual Studio command prompt and ..
C:\Program Files (x86)\Microsoft Visual Studio 10.0\VC>tf rollback -?
TF - Team Foundation Version Control Tool, Version 10.0.30319.1
Copyright (c) Microsoft Corporation. All rights reserved.
Rolls back the changes in a single or a range of changesets:
tf rollback /changeset:changesetfrom~changesetto [itemspec] [/recursive]
[/lock:none|checkin|checkout] [/version:versionspec]
[/keepmergehistory] [/noprompt] [/login:username,[password]]
tf rollback /toversion:versionspec itemspec [/recursive]
[/lock:none|checkin|checkout] [/version:versionspec]
[/keepmergehistory] [/noprompt] [/login:username,[password]]
Versionspec:
Date/Time D"any .Net Framework-supported format"
or any of the date formats of the local machine
Changeset number Cnnnnnn
Label Llabelname
Latest version T
Workspace Wworkspacename;workspaceowner
Right-click on the folder in Source Control Explorer. Choose Get Specific Version. Choose the version that you want to get (by changeset, date, label, etc).
EDIT: At this point your local version will be the version that you want. Check out the changed files and then check them back in. This will bring up the merge wizard and it will probably be complaining about how the server has a newer version than you do. Go through the wizard and merge the files the way you want them (one of the options is to discard the server changes, which is what it sounds like you want). At the end of this process, it may tell you that no files were checked in due to the merge process (or something of that nature), just hit OK and then check in again. This should accomplish what you need.
Bonus question--anyone know if we might get more robust rollback support in VS2010?
Yes. Unlike the Power Tools, which is coded directly against the existing 2008 client API, TFS 2010 has a new API for executing rollbacks directly on the server. This makes them far faster and more reliable, while adding functionality that wasn't possible at all in 2008 such as reverting merge history.
From the MSDN article How to: Roll Back a Changeset (VS2008 although other versions are available)
To revert to an earlier version of a file
- In Source Control Explorer, right-click the file that you want to roll back, and then click Get specific version. The Get dialog box appears.
- Under Type, click Changeset.
- Under Changeset, click the ellipses (?).
- In the Find Changesets dialog box, either use the default values or specify criteria for your search, and then click Find.
- Under Results, click the changeset that contains the version to which you want to revert the file, and then click OK.
- In the Get dialog box, select the Overwrite writable files that are not checked out check box, and then click Get. The earlier version of the file is copied to your local working folder.
- In Source Control Explorer, right-click the file, and then click Check Out for Edit.
- In the Check Out dialog box, click Check Out.
- In Source Control Explorer, right-click the file again, and then click Check In Pending Changes.
- In the Check In - Source Files dialog box, click the file, and then click Check in. The Resolve Conflicts dialog box appears, and a message explains that no files have been checked in because the two versions have changes that conflict.
- In the message box, click OK. The Pending Changes ? Conflicts window appears.
- (Optional) In the toolbar of the Pending Changes window, click Compare Local to Server. The server and local copies appear side by side so that you can review your decision before you roll back the changes
- In the Pending Changes window, click Keep Local Version.
- In Source Control Explorer, right-click the file, and then click Check In Pending Changes.
- In the Check In - Source Files dialog box, click Check in.
The August 2011 TFS Power Tools added full rollback support right into the Visual Studio 2010 UI.
Download link: http://visualstudiogallery.msdn.microsoft.com/c255a1e4-04ba-4f68-8f4e-cd473d6b971f
In Visual Studio 2008, what determines the order in which projects appear within a solution folder? It's not alphabetical order, nor is it build order.
I cannot find any way of altering the order in which projects are being listed. I've tried removing my .suo file, as well as moving things about in the .sln file. Neither had any effect.
How can I change the order in which my projects are being displayed?
There is a feedback Request already placed in Connect.Microsoft.com. so, you will have to wait for the permanent solution.
Temporary workarounds are available.. but, not good enough i feel.. one of them is,
Press F2 to rename a project, then press enter without changing the name. This temporarily sorts the projects within that folder.
Or use http://solutionsorter.codeplex.com/ to alter SLN for permanent fix if your solution folders are not nested (it ate my solution)
But, this will not work if you close and open the solution..
If you use Resharper, you can press the short cut CTRL + N to find out files in solution and CTRL + F12 to find out methods in the file.
Hacky alternative: Copy out the section with these lines into a text file.
Project("{2150E333-8FDC-42A3-9474-1A3956D46DE8}") = "etc..."
EndProject
Use this F# script to sort it alphabetically (changing file path as required):
open System.IO
let readlines p = File.ReadAllLines(p)
let writelines p lines = File.WriteAllLines(p, lines)
let startpos = @"Project(""{FAE04EC0-301F-11D3-BF4B-00C04F79EFBC}"") = """.Length
let getProj (s:string) = s.Substring(startpos, s.IndexOf('"', startpos) - startpos)
let path = @"C:\Temp\sln.txt"
path |> readlines
|> Array.filter (fun s -> s.StartsWith("Project"))
|> Array.map (fun s -> (getProj(s), s))
|> Array.sortBy fst
|> Array.map snd
|> Array.collect (fun s -> [|s;"EndProject"|])
|> writelines path
(If you've only got a few projects, just sort it by hand)
Take file .sln in any text editor. Order the parts
" Project("{2150E333-8FDC-42A3-9474-1A3956D46DE8}") = "etc..."
...
EndProject
in any order you want. Save it. That's all. Next time you will open this solution the projects will be in THAT order.
Is there any way to work with F# on Visual Studio 2010 Expression Edition. I am having Visual Studio 2010 Express Edition Beta 2.
There won't be Visual F# Express but you can use the free Visual Studio Shell (wich is available for 2008 and 2010) with F#. It works perfectly for 2008 but I have not tested it with 2010.
More details: http://cs.hubfs.net/forums/thread/4387.aspx
UPDATE
The latest release of F# now works with the 2010 Integrated shell as well, see
http://blogs.msdn.com/b/dsyme/archive/2010/08/17/announcing-the-f-2-0-free-tools-for-net-4-0.aspx
Unfortunately, there are no plans to include an F# Express edition for Visual Studio 2010. The express editions for 2010 are:
For example, if I'm opening a file, I know a FileNotFoundException might happen, or if I'm converting a String to double, a FormatException may happen. Obviously, if a method does both, both can be raised.
Is there a way to quickly see all possible exceptions raised by a method though? Keeping track of it myself seems error prone.
It's not built into VS. There are 3rd party tools, though, like Redgate's exception hunter.
Edit I'm not employed by RG, but I am a fan of their products. I've tried this particular one, but we ended up not buying it.
If memory serves me correctly if the intellisense tool tip should have a list of exceptions the method can throw. You can also open a browser tab in visual studio pointing to MSDN like so: http://msdn.microsoft.com/en-us/library/b9skfh7s.aspx#ddueExceptionsToggle
I think Resharper does it if my memory serves correctly. Take a look at Pex, it might interest you too.
There is no concrete way to find all exceptions a piece of code unless you have a way of running every possible branch in whatever piece of code you are exercising. While tools may be able to evaluate what are likely errors are to occur you still are going to run into situations which these tools will will not catch. While i'm not saying there is no reason to run them you still have to code is such a way to handle errors your tool may not catch. I have seen tools like this used in place of good testing and coding practices.
Also some times exceptions are good things. Some of the hardest and greatest impact errors I have ever found is due to developers handling errors in such a way that program continues but is no longer in a state that any future called code is expecting. just my .02
The Agent Johnson pklugin to ReSharper
It seems that my problem is a bug in MSVC. I'm using the Visual Studio 2008 with Service Pack 1, and my code works with GCC (as tested on codepad.org).
Any official info on this bug? Any ideas how to work around it? Is the bug fixed in VS2010? All insights would be greatly appreciated.
The code:
struct Base {
Base(int i = 0) : i(i) {}
virtual ~Base() {}
virtual Base *clone() const = 0;
protected:
int i;
};
struct A : virtual public Base {
A() {}
virtual A *clone() const = 0;
};
struct B : public A {
B() {}
B *clone() const { return new B(*this); }
/// MSVC debugger shows that 'b' is for some reason missing the Base
/// portion of it's object ("Error: expression cannot be evaluated")
/// and trying to access 'b.i' causes an unhandled exception.
///
/// Note: This only seems to occur with MSVC
B(const B &b) : Base(b.i), A() {}
};
void foo(const A &elem) {
A *a = elem.clone();
if (a) delete a;
}
int main() {
A *a = new B;
foo(*a);
delete a;
}
It looks as though the compiler is not correctly adjusting the this pointer when calling through A::clone. If you remove the declaration of A::clone then everything works fine.
Digging in deeper, when you have A::clone, the vtable looks like this:
[0x0] 0x002f1136 [thunk]:B::`vector deleting destructor'`vtordisp{4294967292,0}' (unsigned int) void *
[0x1] 0x002f11e0 [thunk]:B::clone`vtordisp{4294967292,0}' (void) void *
[0x2] 0x002f12ad [thunk]:B::clone`vtordisp{4294967292,4}' (void) void *
[0x3] 0x002f12a3 B::clone(void) void *
And foo calls elem.__vfptr[2], offsetting this incorrectly by -4 bytes. Without A::clone, the vtable looks like this:
[0x0] 0x00ee1136 [thunk]:B::`vector deleting destructor'`vtordisp{4294967292,0}' (unsigned int) void *
[0x1] 0x00ee11e0 [thunk]:B::clone`vtordisp{4294967292,0}' (void) void *
[0x2] 0x00ee12a3 B::clone(void) void *
And foo calls elem.__vfptr[1]. That does not adjust this at all (and the code assumes that this will be equal to Base instead of B).
So it looks like the compiler assumes that A::clone is a new virtual method and doesn't override Base::clone when determining whether A requires a new virtual table, but then some other code later determines that A does not need a virtual table. You can verify this by comparing sizeof(B) with or without a new virtual function:
struct A : virtual public Base {
A() {}
virtual A *clone() const = 0;
}; //sizeof(B)==16
struct A : virtual public Base {
A() {}
virtual A *clone() const = 0;
virtual const A *clone2() const { return this; }
}; //sizeof(B)==20
So it's a compiler bug.
It would seem (from some testing) that the bug is caused by the combination of a virtual base class with a pure virtual method using covariant return types.
Since dropping either the pure virtual method from the Base class, or making Base a non-virtual base class or making the clone() method non-covariant seems to solve the bug.
I guess this one's solved for me (after I submit a bug report to MS), and I'm even left with a few options to circumvent it. :)
I'm new to Resharper and have 2 questions :
1.I installed Resharper and it works in VS but I want disable it for some reason.
But whenever I search in the Resharper menu cant find disable option.
[Update]{ I moved my second question here :
http://stackoverflow.com/questions/2189854/what-is-the-best-practice-to-jump-out-of-closing-bracket-in-resharper}
2.Its good when resharper inserts closing bracket automatically.
But assume condition that the method didn't have any parameter
in this situation it takes more time to jump out of the brackets is there a work around ?
now I use mouse to jump out from closing bracket.
I see the answer get 3 vote up but it not work for me :
You can disable Resharper 5 and newer versions by using the Suspend button in
Tools > Options > Resharper
If you want to do it without clicking too much, open the Command Window (Ctrl + W, A) and type:
ReSharper_Suspend or ReSharper_Resume depending on what you want.
Or you can event set a keyboard shortcut for this purpose. In VS, go to Tools > Options > Environment > Keyboard.
There you can assign a keyboard shortcut to ReSharper_Suspend and ReSharper_Resume.
Bind ReSharper_ToggleSuspended to a shortcut key.
Steps:
Binding ReSharper_ToggleSuspended to a shortcut key (in my case: Ctrl-Shift-Q) works very well. With ReSharper not supporting the async CTP yet (as of mid-2011), when dipping into the code the uses the async keyword, this shortcut is invaluable.
Tools/Add-In Manager. Uncheck resharper. That should disable it.
Re-Sharper, like all other Visual Studio Add-ins can be unloaded by going into the AddIn Manager and unchecking the addin you want to unload.
The AddInManager is under Tools | AddIn Manager.
For the brace completion behavior you can modify it under the Resharper Menu options, completion behavior. Not sure you can get exactly what you want but the available options are shown there.
When I add a web service by using "add service reference" in the console app, the app.config does not generate the configuration. How do I generate this app.config with a specific wsdl? Thanks!
(Same answer I gave at http://stackoverflow.com/questions/3022586/visual-studio-2010-adding-a-service-reference-to-a-2008-generated-wsdl/3113768#3113768 )
I have experienced the same issue with Visual Studio 2008. I find I get different results if I'm using the "Add Service Reference..." command, or digging deeper to "Add Service Reference..." | "Advanced..." | "Add Web Reference...".
However, the tried-and-true method--and the solution that worked for me--is still via the command line:
svcutil.exe /language:cs /out:GeneratedProxy.cs /config:app.config http://server/path_to/WebServiceBean?WSDL
That should give you a working app.config. Hope that helps!
C# desktop application on express edition. Worked then didn't work 5 seconds later.
I tried the following.
I have two WinForms projects in the solution. One of them loads the debug info, one doesn't. They both refer to the assembly I'm trying to get debug info on in exactly the same way in the project file. Any ideas?
I want to add in here, mostly for myself when I come back to review this question, that symbols are not loaded until the assembly is loaded, and the assembly is not loaded until it is needed. If the breakpoint is in a library that is only used in one function in your main assembly, the symbols will not be loaded (and it will show the breakpoint as not being hit) until that function is called.
Start debugging, Debug + Windows + Modules. Right-click the assembly in the list, Symbol Load Information. You'll get a dialog that lists all the directories where it looked for the .pdb file for the assembly. Verify that list against the actual .pdb location. Make sure it doesn't find an old one.
In normal projects, the assembly and its .pdb file should always have been copied by the IDE into the same folder as your .exe. The bin\Debug folder of your project. Make sure you remove one from the GAC if you've been playing with it.
Seems like a strange issue. I've had it a couple of times before as well.
Just something simple to try - you may have tried it already. Right click the Solution in solution explorer, click "clean solution", this deletes all the compiled and temporary files associated with a solution.
Do a rebuild of the solution and try to debug again.
I've also had troubles with breakpoints multiple projects in a solution - some compiled as x86, some as x64. Is this your setup?
Patrick
Did nothing. Working now. Sigh.
You need to enable "Generate debug info" in compiler settings
I was receiving the same error message on breakpoints in source code that I purchased for the purpose of embedding a discussion forum in our existing application. There are numerous possible solutions posted here and elsewhere online, but none worked for me .
However, with the help of Microsoft support, we found the cause of our problem. Are you ready for this? This code was using the "CodeBehind" attribute in the Page directive of the .aspx file instead of the "CodeFile" attribute (ASP.NET 2.0 and beyond). After days of desperation, a simple search and replace solved the problem.
I spent like an hour trying to solve this stupid problem. What I finally did was recreating problematic Project in my Solution using other name and moving all classes to the new one (hopefully I've got a Resharper).
I was going mad trying to figure out why my javascript file would not debug and it took looking in the "Script Documents" (the loaded scripts) to realise my script was not there.
The designer had edited the page headers and replaced my individual dev javascripts with a combined minified version. I didn't realise until an half an hours worth of googling and debugging attempts.
So basically I recommend looking in that list when debugging. If it's not in there, it can't be debugged. Doh.
Designer was doing the right thing, it just should have happened at the release stage, not the beta. A list of which script includes were minified would also be good, so it can be rebuilt for dev.
BTW I tried the Modules stuff above, and obviously it was not that. The script was actually not being loaded in the project. Sigh.
Which files should I include in .gitignore when using Git in conjunction with Visual Studio Solutions (.sln) and Projects?
Community Wiki:
#OS junk files
[Tt]humbs.db
*.DS_Store
#Visual Studio files
*.[Oo]bj
*.user
*.aps
*.pch
*.vspscc
*.vssscc
*_i.c
*_p.c
*.ncb
*.suo
*.tlb
*.tlh
*.bak
*.[Cc]ache
*.ilk
*.log
*.lib
*.sbr
*.sdf
*.opensdf
*.unsuccessfulbuild
ipch/
obj/
[Bb]in
[Dd]ebug*/
[Rr]elease*/
Ankh.NoLoad
#Tooling
_ReSharper*/
*.resharper
[Tt]est[Rr]esult*
#Project files
[Bb]uild/
#Subversion files
.svn
# Office Temp Files
~$*
#NuGet
packages/
I use the following .gitignore for C# projects. Additional patterns are added as and when they are needed.
[Oo]bj
[Bb]in
*.user
*.suo
*.[Cc]ache
*.bak
*.ncb
*.log
*.DS_Store
[Tt]humbs.db
_ReSharper.*
*.resharper
Ankh.NoLoad
Added InstallShield ignores for the build deployment. InstallShield is the new direction Microsoft is headed over Visual Studio Installer, so we've started using it on all new projects. This added line removes the SingleImage installation files. Other InstallShield types may include DVD distribution among others. You may want to add those directory names or just [Ee]xpress/ to prevent any InstallShield LE deployment files from getting into the repo.
Here is our .gitignore for VS2010 C# projects using Install Shield LE with SingleImage deployments for the installer:
#OS junk files
[Tt]humbs.db
*.DS_Store
#Visual Studio files
*.[Oo]bj
*.exe
*.pdb
*.user
*.aps
*.pch
*.vspscc
*.vssscc
*_i.c
*_p.c
*.ncb
*.suo
*.tlb
*.tlh
*.bak
*.[Cc]ache
*.ilk
*.log
*.lib
*.sbr
*.sdf
ipch/
obj/
[Bb]in
[Dd]ebug*/
[Rr]elease*/
Ankh.NoLoad
#InstallShield
[Ss]ingle[Ii]mage/
[Dd][Vv][Dd]-5/
[Ii]nterm/
#Tooling
_ReSharper*/
*.resharper
[Tt]est[Rr]esult*
#Project files
[Bb]uild/
#Subversion files
.svn
# Office Temp Files
~$*
While you should keep your NuGet packages.config file, you should exclude the packages folder:
#NuGet
packages/
Here's an extract from a .gitignore on a recent project I was working on. I've extracted the ones that I believe are related to Visual Studio, including the compilation outputs; it's a cross platform project, so there are various other ignore rules for files produced by other build systems, and I can't guarantee that I separated them out exactly.
*.dll
*.exe
*.exp
*.ilk
*.lib
*.ncb
*.log
*.pdb
*.vcproj.*.user
[Dd]ebug
[Rr]elease
Perhaps this question should be Community Wiki, so we can all edit together one master list with comments about which files should be ignored for which types of project?
Credit to Jens Lehmann for this one - if you keep source directories separate to your compiler project files and build output, you could simplify your .gitignore by negating it:
path/to/build/directory/*
!*.sln
!*.vcproj
You don't say what language(s) you're using, but the above should work for C++ projects.
Here is what I use in my .NET Projects for my .gitignore file.
[Oo]bj/
[Bb]in/
*.suo
*.user
/TestResults
*.vspscc
*.vssscc
This is pretty much an all MS approach, that uses the built in Visual Studio tester, and a project that may have some TFS bindings in there too.
I use Visual Studio as my editor for .css and .js files.. It REALLY SUCKS especially with .js files since it insists on indenting them in a very weird way, but I find it convenient that the first alt-tab is always the browser instead of another editor, and that ctrl-tab is always either the code file or the css/js.
Anyways, in all its radiant wisdom it decides to check them for syntax errors as well and every time I compile my project it gives several "errors" that push down the real errors of the compilation, so every time I make a syntax error in a code file I have to scroll down through all the js/css errors to see what's wrong.
Examples of such errors (that aren't really errors) are:
The situation also got much worse recently, since it now keeps parsing a .js file as a .css file for some reason, so I get errors such as:
I even deleted that particular file from the solution (it's not there anymore anywhere), but it keeps parsing it anyway.
In short, how can I disable this feature?
Enter the options through Tools > Options.
If it isn't checked, check the "Show all settings" box at the bottom of that window.
In the tree to the left, choose Text Editor > CSS > CSS Specific. Uncheck "Detect Errors".
Then, choose Text Editor > JScript > Miscellaneous. Uncheck "Show syntax errors".
You can also change how it indents each type of code too, in the various settings in those "Text Editor" sub-options.
I guess there is some issues with the indentation for Visual studio. The indentation can be changed if you go to your: Tools > Options > Text Editor > All Languages > Tabs
There set Indenting to Block.
Tab size and Indent size to 4.
And as a last thing, but very important, check Keep tabs.
I just ran into one of the most mind boggling errors ever. false == true What information would you guys need to confirm/debug this behavior? I've never seen anything like it.
Edit: I did a clean->rebuild and still the same.
Here's the assembly and registers. I don't know how to read this, but maybe it could help someone else.
I suppose your PDB files are not in phase and you have differences in what's really executed and what Visual Studio sees as a line number. Try rebuilding. We all know that it is impossible to have true = false, or the world as we know it may change :-)
Does it actually throw the error? The debugger can often highlight the wrong lines if you feed it the wrong pdb, so this could be a false lead. It is also trivial to reproduce using the "immediate" pane to change the value after the test.
If result was a field or a captured variable, it could also be set by external code (perhaps on another thread).
If result wasn't a bool but your own custom type, you could just override ==, or provide a custom true/false operator.
Probably the source does not correspond to the running version or there's a bug in the debugger.
Part of the problem is that you're assuming the debugger is 100% correct. It in fact is not and is subject to a number of situations where values can have incorrect or misleading displays. The most common causes of this are ...
But it in fact is almost certainly not false. The easiest way to verify this is to use a Debug.WriteLine call to print the value out to the output window.
Are you sure that's the exception being thrown? My hunch is that your method isContextSignatureValid is actually throwing an exception, but the Visual Studio debugger can get ahead of itself sometimes and highlight a line that is not actually throwing the exception.
Just to add a little suggestion:
If you ever get confusing results from the debugger, stick a Console.WriteLine() in there and get the code itself to tell you what is going on. This can often clear up confusion.
(You can also get an effect like this when debugging release code, but you said it was a debug build which eliminates that suspect)
Maybe you moved the current instruction pointer (yellow arrow) with your mouse inadvertently while in break mode... It happened to me once and I flipped out. :-)
I've seen this sort of thing before. A co-worker was convinced he'd uncovered a bug in the .Net Framework or CLR. In the end it was just an old assembly or pdb synch problem.
I'm trying to use xlsLib (http://xlslib.sourceforge.net/) for creating Excel spreadsheets from a C++ application. The trouble is that compiling xlsLib, I give a .a file (a GCC static library, generated by MinGW). But, my application depends on another API (PhysX) that only compiles with Visual Studio. Thus: is it possible to transform the GCC static library (xlslib.a) to a Visual Studio static library file (xlslib.lib)?
The archives of static libraries generated with MinGW are generally compatible with Visual C++ compiler/linker. So, you should be able to use them directly by adding .a files to linker input in your project properties in Visual Studio:
Properties (Alt-F7).Configuration Properties->Linker->Input.a archives you need to uselibgcc.a libraryAlso, there may occur problems regarding mixed C run-time libraries properties of C/C++->Code Generation->Runtime Library, but this depends on your build configuration you use with MinGW. Sometimes it is necessary to link against libmsvcrt.a from MinGW but in many (if not most) cases it causes problems.
Finally, this mixed MinGW and Visual C++ linking generally works but for C modules and it does not work for C++, as far as I know.
As far as I know, they are the same thing. Visual Studio's .lib files are also ar archives containing object files. Did you try just renaming the file? :)
Here are two resources I have found useful:
[snip, wrong link]
http://old.nabble.com/using-VC%2B%2B-.lib-with-mingw-td23151303.html
Edit. I can't find the link I was looking for. In the meanwhile, check this one out: http://www.willus.com/mingw/yongweiwu_stdcall.html
I haven't tested this myself
Situation
I have two .NET solutions (Foo and Bar) and a common library that contains ProjectA, ProjectB, and ProjectC. Foo and Bar reference one or more library projects, but the library projects are not located within the Foo and Bar Solution folders.
Directory structure:
-- My Documents*
-- Development
-- Libraries
-- ProjectA
-- ProjectB
-- ProjectC
-- Projects
-- Foo
-- Solution
-- .hg
-- .hgignore
-- Foo { Project Folder }
-- FooTests { Project Folder }
-- Foo.sln { References ProjectA }
-- Foo.suo
-- Bar
-- Solution
-- .hg
-- .hgignore
-- Bar { Project Folder }
-- BarTests { Project Folder }
-- Bar.sln { References ProjectA and ProjectB }
-- Bar.suo
*alas, I'm still using Windows XP...
Mercurial Subrepositories
Goal - I want to set up subrepos so that I can store the source code for any referenced library projects in my Foo and Bar repositories.
According to this page (which is literally the only documentation I can find on subrepos), setting up a subrepo requires executing the following commands from a DOS console window:
1| $ hg init main
2| $ cd main
3| $ hg init nested
4| $ echo test > nested/foo
5| $ hg -R nested add nested/foo
6| $ echo nested = nested > .hgsub
7| $ hg add .hgsub
8| $ ci -m "initial commit"
Questions
> do? I tried searching through the Mercurial docs for >, but didn't find anything.nested/foo is. Where did foo come from? What is foo? A repository? A folder?.hgsub is being added to main? Or is it being added to nested?Bar repository is now up to revision 10. If I attempt to update my working directory to revision 7, will this cause my library folders (My Documents/Development/Libraries/ProjectA and .../Libraries/ProjectB) to update to whatever is stored in revision 7 as well?Update
I added an 8th line of code: ci -m "initial commit". This does two things: (1) adds a .hgsubstate file to the main repo and (2) commits all changes, including the new subrepo into the main repository (with message "initial commit"). The purpose of the .hgsubstate file is to keep track of the state of all subrepos, so if you return to an earlier revision, it will grab the correct revision from all subrepos as well.
Update 2 - some instructions
After further experimentation, I think I can now provide the steps to solve my original problem (using mostly Windows Explorer and TortoiseHG):
Creating a subrepo
Libraries/ProjectA, Libraries/ProjectB, and the main repositories (Projects/Foo/Solution and Projects/Bar/Solution) must be separate repositories.Projects/Foo/Solution.Libraries/ProjectA to Projects/Foo/Solution.ProjectA to the Foo repository.Use a text editor to create a file called .hgsub, containing the following:
ProjectA = ProjectA
Open a DOS console window and enter the following commands (see note below):
cd c:\...\Projects\Foo\Solution
hg ci -m "Committing subrepo "ProjectA"
For Bar, the steps are basically the same, except the .hgsub file should contain entries for both projects, like this:
ProjectA = ProjectA
ProjectB = ProjectB
Note: starting with TortoiseHG 0.10 (which is slated for March), you will be able to use the HG Commit shell command to do this, but for now, you have to use the command line.
Once this is all set up, it gets a little easier.
Committing changes - to commit changes to Foo or Bar, you do a Synchronize/Pull operation for each subrepo to get the subrepos in sync with the latest revisions in the library project repositories. Then you again use the command line to commit the changes (until version 0.10, when you can just use TortoiseHG to commit).
Updating working directory to an earlier revision - This seems to work pretty normally with TortoiseHG and doesn't seem to require use of any DOS commands. To actually work with the earlier revision in Visual Studio, you will need to do a Synchronize/Push operation to put the older version of the library projects back into the Libraries/ProjectX folder.
As much as I like TortoiseHG for simple tasks, it's probably better to write batch files for frequently used subrepo operations (especially updating).
Hope this helps someone in the future. If you see any mistakes, please let me know (or feel free to edit yourself if you are able).
You could probably try this stuff out and learn it more quickly than writing up your question took, but I'll bite.
Can any or all of these steps be executed with TortoiseHG, as of version 0.9.2? If yes, how?
TortiseHG doesn't yet put GUI wrappers around sub-repo creation, but TortiseHG has always done a great job of working with the command line. Use the command line to create and them and you're good to go.
What does the above code do (a line-by-line explanation would be much appreciated).
hg init main # creates the main repo
cd main # enter the main repo
hg init nested # create the nested. internal repo
echo test > nested/foo # put the word test into the file foo in the nested repo
hg -R nested add nested/foo # do an add in the nested repo of file foo
echo nested = nested > .hgsub # put the string "nested = nested" into a file (in main) named .hgsub
hg add .hgsub # add the file .hgsub into the main repo
Here are some specific questions that came to mind as I was trying to decipher it: What does > do?
That has nothing to do with mercurial it's standard shell (unix and dos) for "put the result into a file named X"
In line 5, I don't understand what nested/foo is. Where did foo come from? What is foo? A repository? A folder?
It's a file in the subrepo. Foo is a traditional arbitrary name, and the arbitrary contents are the string "test"
Line 6 - this one completely baffles me.
It's putting the contents in .hgsub necessary to say that nested is a nested repo named nested and located at nested.
In line 7, I assume .hgsub is being added to main? Or is it being added to nested?
main
Let's say I get my subrepos set up, and my Bar repository is now up to revision 10. If I attempt to update to revision 7, will this cause my library folders (My Documents/Development/Libraries/ProjectA and .../Libraries/ProjectB) to update to whatever is stored in revision 7 as well? Given that Foo also refers to Libraries/ProjectA, this could get interesting!
Revision numbers won't carry across, but you have control by editing the .hgsubstate file.
Just a quick update, after the release of TortoiseHg 1.0.
The subrepo support in THG 1 is good enough to do let you do example steps from Windows Explorer. The only one I couldn't do from Explorer was step 6:
echo nested = nested > .hgsub
Windows explorer (in XP at least) reports a rename error "You must type a file name." if you try to rename "New Text Document.txt" to ".hgsub". *8')
Edit: Incidentally, if you use both hg via TortoiseHg and the command line and you don't already have Microsofts "Command Here" PowerTool installed, I can highly recommend it. It adds an "Open Command Window Here" context menu entry to every directory in Windows Explorer, making it very easy to open command windows any where you need them.
Scenario
I have a Library that contains Projects A, B, and C.
I have two solutions. Solution 1 includes a copy of Project A, and Solution 2 includes a copy of Projects A and B.
When I build Solution 1, here's what should happen:
When I build Solution 2, here's what should happen:
How can I do this?
Is this something I could automate with a version control system or off-the-shelf file syncing software? Or do I need to roll my own solution?
If I do build my own solution, I have some thoughts on how it could work, but I'd appreciate any input you may have:
Could be a simple console app with a command-line switch for specifying the "source solution", for example:
c:\Program Files\Library Syncronizer\LibSync.exe /solution:Solution 1
XML file used to register active solutions that contain library projects. Possible format:
<solutions>
<solution>
<name>Solution1</name>
<path>c:\...\Projects\Solution 1</path>
</solution>
<solution>
<name>Solution2</name>
<path>c:\...\Projects\Solution 2</path>
</solution>
<!-- more solutions -->
</solutions>
Program would do the following:
This sounds relatively simple in concept, but this may have serious unintended consequences I'm not thinking of. Hopefully someone will warn me if it does :)
Update - What is my motivation for copying project folders?
In a word - Version Control.
If I keep the library projects in a separate folder and only link to them in my various solutions (rather than physically locate the folders in my solution folders), my version control repository ends up not containing the source code to my library projects. So, if I update to "three version ago", and I need to make a minor change to one of my library methods, the code is not there.
My workaround for this has been to add tags to the revisions in my library's repository that say things like "Solution 1 - Version 2.5.3", but this is pretty clunky. And things get really awkward if I'm working on "three version ago of" of Solution 1 and the current version of Solution 2. Now, Solution 2 will be pointing to an old version of the library projects, which makes it potentially impossible to work with and test until I'm done working on the old version of Solution 1.
If I were working with copies instead, all solutions would contain the library source code in their repositories, and I could go back to it easily any time I need to.
I should note here that I've been using Tortoise HG (Mercurial) for version control.
Anyway, I'm open to any solution to this problem. It doesn't have to involve copying project folders around--that's just the only thing I could think of to ensure that all my version control repositories are complete, stand-alone packages.
Update 2
First of all, just a note. I'm using Mercurial (TortoiseHG) for version control, not SVN. I could change if absolutely necessary, but I really prefer Mercurial.
Based on responses so far, I've decided to do away with the "bi-directional copying" idea, and go back to referencing my library projects. Here's a new diagram:
I continue to have the same goals, however:
Goal #1 is taken care of automatically by referencing the library projects instead of using copies, and Goal #2 is just a matter of how my set up my repositories, but Goals #3 and #4 remain elusive.
With Mercurial, there is a subrepositories feature that seems like it would handle my situation, but as the documentation indicates, this is still considered experimental/risky.
For the moment, I'm thinking a good workaround might be to just store backup copies of the library projects in my Solution folders. When I say "backup copies", I mean that literally. I would still be referencing the library projects--the copies would be solely for the purpose of ensuring all source code ends up in my repository (Goal #3). To satisfy Goal #4, these backups could be automated using a post-build event in studio.
I welcome your thoughts on any of this.
Consider why your Applications need to work with different versions of the libraries. If you design your libraries properly, and make sure you don't break anything while upgrading them (use continuous integration and unit tests, as well as testing all dependent projects) then the best (simplest, cleanest) approach in most cases is simply to have all Applications run off the same version of the Libraries. I would go so far as to say that if your Applications can't run off the same Library version, that tells you that your Libraries are not designed/implemented/maintained properly, and you should reconsider your approach.
Another approach is to use a branch for each Application, so each has its own independent copy of the Libraries (use a relative reference between the projects and the libraries and then you can relocate the code in the branches). This allows the Applications to build off different versions of the libraries, but does have all the disadvantages of branching, though - two copies of the libraries so you have to be careful not to edit in the wrong branch; the potential for nasty merges, etc.
I'd recommend moving the Library projects into the Library. Your diagram shows the Application solutions building library code and pushing it up to the library, then sucking the built library files back down into the projects - a bi-directional copy, eek! Just place the library projects in the library and build the library, then reference that library from your projects - a unidirecitonal copy. You may think this would mean you have to build two solutions (Library and then Application), but you can actually add/remove library projects in your application Solution whenever you wish, so this layout does not necessitate a two-stage build process. But the logical distinction between the library and application is much cleaner.
The way we solve a similar problem is just what you describe in update 2, but where you suggest 'backup copies', we use clones and they are an integral part of our workflow.
We use a combination of clones and named branches to allow us to control when the libraries for a particular application (solution in your example) are updated.
What we do is have a core repository for each of our libraries which contains the mainline branch of that library. When we create a new application we clone all of the relevant libraries (we use one mercurial repo per library, where a library may contain the library and it's test application) into directories beside the new application and reference the libraries in that application.
Any commits to the libraries for this application are committed to a branch named according to the application. When an application is complete, we review the changes to the library and then merge appropriate changes back into the mainline, creating a new mainline. This also has the advantage that in the future, you can easily identify which application caused a particular change to a library by looking at which branch that change was committed to.
Whenever we touch an application, we can chose whether to continue using the old libraries, or update to a more recent mainline version (or even another projects development version) of the library. Library changes aren't pushed out to every application which uses them (some might be legacy applications which haven't been touched for years and are working fine with the library they were suplied with), they are pulled in by applications which need the new facilities in a given version of the library.
The problem I'm trying to avoid here is one I constantly ran into at a previous company.
I would get my application working with a given library. Someone else would change the library for their application so that it did what they needed and the next time I went to edit my project, it wouldn't compile. I would then have to spend time fixing up my project to beghave in the way the library now wanted or spend time to revert inappropriate changes made to the library (which would then cascade back to the other developer).
With local project clones, every application gets to chose when it updates to a more recent library version and from a chance management perspective, we get to review changes to libraries due to application requirements before they get merged back into the mainline.
This is a workflow which would never have been possible with a traditional VCS like SourceSafe, but works beautifully with a DVCS like Hg.
To try and answer your elusive goals
.3. Each repository contains all source code, including library projects
By cloning libraries into the directories close to your application, you get a set of repositories which can be managed together and possibly eventually will convert nicely into sub-repos of an 'application' super-repo.
.4. Everything is as automated as possible to minimize the risk of mistakes
I do this with a bunch of batch files which I store in my application directory.
For instance a given applications "_projects.bat" might contain:
@echo off
@shift
set APPDIR=%CD%
cd ..\Library1
%0 %1 %2 %3 %4 %5 %6 %7 %8 %9
cd ..\Library2
%0 %1 %2 %3 %4 %5 %6 %7 %8 %9
cd ..\Library3
%0 %1 %2 %3 %4 %5 %6 %7 %8 %9
cd %APPDIR%
%0 %1 %2 %3 %4 %5 %6 %7 %8 %9
pause
Then I have batch files to do useful synchronisation things like check what files would be pulled with "__incoming.bat:
@echo off
call _projects hg incoming
and check what would be pushed with "__outgoing.bat":
@echo off
call _projects hg outgoing
Or actually do those operations with "__push.bat":
@echo off
call _projects hg push
and "__pull.bat":
@echo off
call _projects hg pull
while "__update.bat" updates everything to the latest version (within the same branch, you still have to explicitly update outside the current branch):
@echo off
call _projects hg update
One of my favourites is "__ids.bat", which shows what changesets (and branched) are currently in use and critically, whether they have uncomitted changes outstanding:
@echo off
call _projects hg id
Whenever I come to start work on an application update, I check to see if there are updated libraries, pull down everything which is appropriate, update to the versions I want and then continue development.
Note the underscores in the filenames are just there to push them to the top of the directory lists, to make them easier to find. *8')
Eventually I would like to fully automate this workflow by using sub-repos (so the state of the whole application and all of it's libraries are recorded in one application changeset), but while it is getting pretty stable in Mercurial, TortoiseHG integration doesn't seem to be a priority. I couldn't get the THG commit tool to do anything useful the last time I tried it (around 0.8.3). I really should retest with 0.9.3 but I can't remember seeing any notes about sub-repos in the changelogs, so it isn't worth it unless people tell me THG sub-repo support has been silently added.
As it is, the batch files work quite well. The next thing on my todo list is a "__clone.bat" which should make cloning the application and all of it's libraries a whole lot easier, but I haven't had the time to get that working.
If anyone fancies having a go though, I'd love to see a reply in this thread. *8')
Take care, hope this helps,
Mark..........
This sounds exactly like what the sub repository support in mercurial is for. If project A and project B, etc. are are separate repositories you can can make them sub-repos within Solutions 1 and 2. The .hgsub files in 1 and 2 are versioned themselves and point to specific revisions within A, B, and C, so you can always build with the same version in each Solution, but need not keep them in lock-step. Moving changes back from the solutions to the libraries becomes easy, and if desired, branchable.
Don't let the "beta in 1.3" mention on that wiki page fool you. Mercurial is up to 1.4.2 now and subrepos are staying as they are.
I'm not sure I understand the purpose of your "Library"?
Why do the two solutions not actually reference the same project rather than a copy?
If the purpose is to be able to work on different branches of the "Library" then what you are describing is the sort of thing handled by source code control software like SVN.
You would hava "trunk" (your library) then two branches created from the trunk. At appropriate milestones you would merge a branch back into the trunk and be merging the trunk down into other branches.
Sorry I didn't read whole text on this page. BUT! The short answer is: Visual Studio does all necessary automation you want.
We have similar structure. Solution1, Solution2, and common library with several projects in it. Our folder structure under SVN is following:
\myRepository
\Solution1
\Solution2
\CommonLibrary\
\Project1
\Project2
\Project3
As you can see no copying here. Both solutions simply keeps reference to ..\CommonLibrary\ProjectX.
After I do SVN-Update command for repository the Visual Studio asks me 'ProjectX was changed. Do you want to reload it?' I click 'yes' and proceed my coding.
PS: also look at this software http://svnnotifier.tigris.org/ It can update any number of repository local copies automatically (by a timer) or by a mouse click.
I can't find the Visual Studio autocomplete file for JQuery 1.4. Googling for jquery-1.4-vsdoc or jquery-1.4.min-vsdoc turns up nothing.
good answer by Nick Berardi - checking out Scott Gu's Twitter -
**
@sirkirby Yes - we'll be updating the Microsoft AJAX CDN to host jQuery
1.4. We'll also have full intellisense support for it. 2:47 PM Jan 14th
from web in reply to sirkirby
**
This typically comes out 2 weeks after a new release. Because the Visual Studio Documentation XML for JavaScript is non-standard and requires a lot of manual work to move from JSDoc to VSDoc. Give it another week and you should see an announcement on the Gu's blog.
I think you'll find that the vsdoc-ing the jquery source is a separate exercise done by peeps working for Microsoft. There is bound to be a lag between the releasing of jquery code and these peeps getting around to tweaking it up for intellisense in VS.
If it's not on google it doesn't exist ;-)
According to http://code.google.com/p/jqueryjs/downloads/list latest available version with Intellisense is 1.3.2.
As you can see:
http://www.asp.net/ajaxLibrary/cdn.ashx
The vsdoc for jquery 1.4 (or 1.4.1) is not yet ready or atleast published/linked
but in that website i'm sure you'll find it when ready
I believe you may be looking for the jQuery Code Snippets for Visual Studio 2010.
OK - this is pretty specific, i'm looking for a cheat sheet for visual studio keyboard shortcuts that I can set as my desktop bg.
so, something in a modest 1280 x 1024.
Something like this; http://www.microsoft.com/downloads/details.aspx?FamilyID=c15d210d-a926-46a8-a586-31f8a2e576fe&DisplayLang=en
but more succinct.
Anyone got juicy linkage? Is this a DIY job?
In case someone else comes across this, the VS 2010 versions of Microsoft's cheat sheets are here:Visual Studio 2010 Keybinding Posters
Sounds like a DIY job but perhaps this will come in handy for a starting point: Visual Studio .NET 2008 Keyboard Shortcuts.
DevCheatSheet.com has probably the most complete collection of Visual Studio quick references available here. They include keybindings for both VS2008 and VS2005, but not yet for VS2010. (The only 2010 entry at the time of this writing is a snippet reference, based on VS2010beta2.) The ones approximately in the middle of the list are the official Microsoft entries. They seem to be comprehensive, and the best that I have found, but still too verbose to my mind. (So I do not think they will work as a desktop background :-)
I printed it out and attached it to the wall next to my monitors. Then I can just look take a quick peek when needed. For keys and stuff I forgot often, I have a post-it note on monitor. Like Ctrl+Shift+Space, which I always forget, but use many times per hour.
I did a screen capture and set it as the desktop, but found it too difficult to work with and hard to read, now that my eye sight is getting weaker.
By default, of course, Visual Studio creates separate bin folders for Debug and Release builds. We are having some minor issues dealing with those from the perspective of external dependencies, where sometimes we want release binaries and sometimes debug. It would make life slightly easier to just have a single bin folder on all projects and make that the target for both Debug and Release. We could then point our external scripts, etc. at a single location.
A co-worker questioned why we couldn't just do that--change the VS project settings to go to the same bin folder? I confess I couldn't really think of a good reason to keep them, other than easily being able to see on my local filesystem which are Debug and which are Release. But so what; what does that gain?
My question(s):
I am NOT asking why have separate Debug and Release builds. I understand the difference, and the place of each. My question concerns placing them in separate folders.
Dave, if you will compile Debug and Release to single folder, you may encounter the situation where some dll-s will not be recompiled after switching from Release to Debug and vice versa because dll files will be newer than source files. Yes, the "Rebuild" should help you, but if you forget this - you can have a few extra hours of debugging.
The way I see it, this is simply a convenience on the developer's machine allowing them to compile and run both Debug and Release builds simultaneously.
If you have scripts or tools running inside Visual Studio, the IDE allows you to use the ConfigurationName and other macros to obtain paths which are configuration-independent.
If you are running scripts and tools externally from the command-line (i.e. you are structuring some kind of release or deployment process around it), it is better to do this on a build server, where the distinction between Debug and Release goes away.
For example, when you invoke msbuild from the command-line (on the build server) you can specify the Configuration property for Debug or Release, and the OutputPath property to build to one location only (regardless of the Configuration).
One reason I use separate folders is that it guarantees that I only generate installers that use Release-build code. I use WiX, which allows me to specify the exact path to the files I want to include in the installer, so I end up specifying the path in the Release folder. (Of course, you can do the same using normal VS installers, so that isn't really the point.) If you forget to switch your project to Release before building, the installer doesn't build unless you have old code in the Release folder, in which case you end up with an old installer, so that's a bit of a pitfall. The way I get around that is to use post-build event on the WiX installer project that clears out the release folder after the WiX installer builds.
In a previous company we got round this problem by changing the names of the debug executable and dlls by appending a "D". So
MainProgram.exe & library.dll
become
MainProgramD.exe & libraryD.dll
This meant that they could co-exist in the same output folder and all scripts, paths etc. could just reference that. The intermediate files still need to go to separate folders as the names of these can't be changed.
Obviously you need to change all your references to point to the modified name for debug - which you will forget to do at some point.
I usually compile in Debug mode, but sometimes need to compile in Release mode. Unfortunately, they don't behave exactly the same in certain error situations. By having separate folders, I don't need to recompile everything just to change modes (and a full recompile of our stuff in Release mode will take a while).
Visual Studio kinds of IDEs works what best for the crowd. They create the default project structure, binary folders. You could map the binaries to the single folder. Then you need to educate the other developers that Release/Debug files are stored in the same folder.
Developers would ask you, who you do like that?
In VC++, we have different libraries generated and you need to link the appropriate versions. Otherwise you will get linker error.
Occasionally one may run into a particularly-nasty uninitialized memory problem that only occurs with a release build. If you are unable to maintain (as ChrisF suggests) separate names for your debug vs. release binaries it's really easy to loose track of which binary you're currently using.
Additionally, you may find yourself tweaking the compiler settings (i.e. optimization level, release-with-debug symbols for easy profiling, etc.) and it's much easier to keep these in order with separate folders.
It's all a matter of personal preference though - which is why Visual Studio makes it easy to change the options.
You should have a post-build step setup in the project to copy files to th ebinaries directory.
Being consistent in your assemblies is a good thing. You don't want to deal with issues around conditional compilation/etc. where your release and debug dlls are incompatible, but you're trying to run them against each other.
What everyone elsesaid about technical aspects are important. Another aspect is that you may run into race conditions if one build relies on the single-output-location build, but there's no synchronization between the two builds. If the first build can be re-run (especially in a different mode) after the second build starts, you won't really know if you're using a debug of release build.
And don't forget the human aspect: it's far easier to know what you're working with (and fix broken builds) if the two builds output to different locations.
I have an experience from somewhat bigger project. If there are few solutions using file references to other solutions, you have to point the reference to ONE directory, so obviously it has to be the "release" one for continuous/night build. Now you can imagine what happens if developer wants to work with debug versions - all the references point to release ones. If it pointed to the same directory, switching to debug would be only matter of recompiling all related stuff in debug mode and the file references would automatically point to debug versions since then.
On the other side, I don't see the point why developer would ever want to work with release versions (and switching back and forth) - the release mode is only useful for full/nighlty builds, so the solutions in VS can stay by default in debug mode, and build script (anyway) always does clean, release build.
This is an incredibly basic question, but how do I start a new CUDA project in Visual Studio 2008? I have found tons and tons of documentation about CUDA related matters, but nothing about how to start a new project. I am working with Windows 7 x64 Visual Studio 2008 C++. I would really like to find some sort of really really basic Hello World app to just get a basic program compiling and running.
Edit:
I tried your steps Tom. I setup a console app. I then deleted the default .cpp it drops in and copied over the three files from the template project just to have something to compile. When I compile that, template_gold.cpp complained about not having stdafx.h included, so i included that. Now the build fails with this:
NOTE With the release of version 3.2 of the CUDA Toolkit, NVIDIA now includes the rules file with the Toolkit as opposed to the SDK. Therefore I've split this answer into two halves, use the correct instructions for your version of the Toolkit.
NOTE These instructions are valid for Visual Studio 2005 and 2008. For Visual Studio 2010 see this answer.
CUDA TOOLKIT 3.2 and later
I recommend using the NvCudaRuntimeApi.rules file (or NvCudaDriverApi.rules if using the driver API) provided by NVIDIA, this is released with the toolkit and supports the latest compiler flags in a friendly manner. Personally I would advise against using the VS wizard, but only because I really don't think you need it.
The rules file (installed into the Program Files\Microsoft Visual Studio 9.0\VC\VCProjectDefaults directory) "teaches" Visual Studio how to compile and link any .cu files in your project into your application.
NvCudaRuntimeApi.rules (right click on the project, Custom Build Rules, tick the relevant box), see note 1$(CUDA_PATH)\lib\$(PlatformName) to the Additional Library Directories and in Linker -> Input add cudart.lib to the Additional Dependencies), see notes [2] and [3]$(CUDA_PATH)\include to the Additional Include Directories), see note [3]Some other tips:
<sdk_install_dir>\C\doc\syntax_highlighting\visual_studio_8I'd also recommend enabling Intellisense support with the following registry entry (replace 9.0 with 8.0 for VS2005 instead of VS2008):
[HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\9.0\Languages\Language Services\C/C++]
"NCB Default C/C++ Extensions"=".cpp;.cxx;.c;.cc;.h;.hh;.hxx;.hpp;.inl;.tlh;.tli;.cu;.cuh;.cl"
Incidentally I would advocate avoiding cutil if possible, instead roll your own checking. Cutil is not supported by NVIDIA, it's just used to try to keep the examples in the SDK focussed on the actual program and algorithm design and avoid repeating the same things in every example (e.g. command line parsing). If you write your own then you will have much better control and will know what is happening. For example, the cutilSafeCall wrapper calls exit() if the function fails - a real application (as opposed to a sample) should probably handle the failure more elegantly!
CUDA TOOLKIT 3.1 and earlier
I would use the Cuda.rules file provided by NVIDIA with the SDK, this is released alongside the toolkit and supports the latest compiler flags in a friendly manner. Personally I would advise against using the VS wizard, but only because I really don't think you need it.
The rules file (in the C\common directory of the SDK) "teaches" Visual Studio how to compile and link any .cu files in your project into your application.
Cuda.rules (right click on the project, Custom Build Rules, browse for the rules file and ensure it is ticked)$(CUDA_LIB_PATH) to the Additional Library Directories and in Linker -> Input add cudart.lib to the Additional Dependencies), see note [2] below$(CUDA_INC_PATH) to the Additional Include Directories)Some other tips:
<sdk_install_dir>\C\doc\syntax_highlighting\visual_studio_8I'd also recommend enabling Intellisense support with the following registry entry (replace 9.0 with 8.0 for VS2005 instead of VS2008):
[HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\9.0\Languages\Language Services\C/C++]
"NCB Default C/C++ Extensions"=".cpp;.cxx;.c;.cc;.h;.hh;.hxx;.hpp;.inl;.tlh;.tli;.cu;.cuh;.cl"
Incidentally I would advocate avoiding cutil if possible, instead roll your own checking. Cutil is not supported by NVIDIA, it's just used to try to keep the examples in the SDK focussed on the actual program and algorithm design and avoid repeating the same things in every example (e.g. command line parsing). If you write your own then you will have much better control and will know what is happening. For example, the cutilSafeCall wrapper calls exit() if the function fails - a real application (as opposed to a sample) should probably handle the failure more elegantly!
NOTE
NvCudaRuntimeApi.v3.2.rules. This means that instead of looking for the CUDA Toolkit in %CUDA_PATH% it will look in %CUDA_PATH_V3_2%, which in turn means that you can have multiple versions of the CUDA Toolkit installed on your system and different projects can target different versions. See also note [3].LNK4098: defaultlib 'LIBCMT' conflicts with use of other libs) or multiply defined symbols for standard library functions, then this should be your first suspect.Additional info about installing CUDA wizard on VS2008 can be found here and here
[edit]
If you don't want to use wizard you have to setup CUDA lib/include/nvcc paths manually and add custom build rules to each new CUDA program. For additional info how to do it take a look at Tom's Answer.
What a great question!! For all the CUDA documentation out there, this is something that I've always thought was an obvious omission... In fact, I'm really glad I found this post, because after using CUDA for quite a while, I still hadn't found an official, correct way to get VS to produce a CUDA program from scratch.
When I've needed to start a new CUDA program, I've always just copied and modified the "template" example from the SDK directory. This may not be exactly what you're looking for, because it doesn't start fresh, but it is a quick way to get a CUDA-capable project working in VS with all the correct project/file names...
You may want to take a look at this guide: http://www.programmerfish.com/how-to-run-cuda-on-visual-studio-2008-vs08/
T4 has existed for several years in Visual Studio, but doesn't get a lot of attention. However, for those that know it, there seems to be some very creative and useful purposes.
I am researching some different ways that T4 is used, and I would appreciate to hear how YOU may have used it for real life scenarios. I am primarily interested in non-standard and creative uses.
Some interesting examples:
Note: I realize this is a discussion-oriented question, but the answers could be helpful to others. I have tagged it as subjective and also marked as "community wiki", so please allow the question to remain open. Thanks!
I am not a big fan of the stringy-ness of app.config/web.config, so I use T4 to read those files and make an AppSettings/WebSettings class that wraps the connection strings and key/values in a real class. This means that, as long as I always use AppSettings.SomeValue to reference my app.config, I get compile time checking, which is really nice.
I've used the T4 Templates within the sharp-architecture to generate everything from models to controllers to basic views.
Definitely worth checking out, even if you just want to see some advanced examples of T4 templates in action
SubSonic 3.0 makes heavy use of T4 templates for generating your entity code.
Essentially it calls GetSchema() on your database connection and runs each table it finds through the T4 entity template. The great thing about using T4 here is that if you don't like the way it's handling your database schema, just edit the template.
I've tweaked the T4's to handle MySQL databases better for my situation, as I make use of many tinyint columns which the default T4 maps to byte types. A quick edit to the T4 gave me the type I wanted instead for my application entities.
LINQ to SQL templates for T4
http://l2st4.codeplex.com/
Templates replicating the functionality of the SQLMetal and the LINQ to SQL classes designer code-generators for both C# and VB.Net requiring just Visual Studio 2008.
Check out this podcast on T4 by Scott Hanselman talking with Kathleen Dollard.
http://www.hanselminutes.com/default.aspx?showID=170
T4 Templates are used heavily in the Web Service Software Factory (Service Factory).
See here for a list of more than 30 T4 Generators from the community in several areas including ASP.NET,WCF, UML, ADO.NET, .NET
http://t4-editor.tangible-engineering.com/How-Do-I-With-T4-Editor-Text-Templates.htm
I have a rather involved Visual Studio solution (2010, but it shouldn't matter) that I need to rename. I want to rename the folders to match the new solution name, but I can't figure out a way to refactor the folder names automatically, and going through every single project file will be painful.
Is there an official way to do this? Alternatively (and much less preferably), are there free tools to accomplish this?
The Rename operations in visual studio only change the filename, i.e. for a project, *.prj and for a solution *.sln. You will need to rename folders seperately using the filesystem, and you will need to remove and readd the projects since they will have new foldernames. However, note that the solution and project files are respectively texst and xml files. You could write your own program that parses them and renames both the folder names, filenames, and fixes the project/solution files internally.
Delete your bin and obj subfolders to remove a load of incorrect reference then use windows to search for old name.
Edit any code or xml files found and rebuild, should be ok now.
The Visual Studio Project Renamer tool has worked well for me. You can download it here.
I have a T4 template for a class set up with TextTemplatingFileGenerator Custom Tool in Visual Studio:
<#@ template language="C#v3.5" hostspecific="True" debug="True" #>
<#
var className = System.IO.Path.GetFileNameWithoutExtension(Host.TemplateFile);
var namespaceName = "MyNamespace";
#>
namespace <#= namespaceName #>
{
public static class <#= className #>
{
// some generated code
}
}
How can I get the value of the "Custom Tool Namespace" property in Visual Studio, so I don't have to hardcode the namespace?
I would even be happy with the default namespace for the C# project.
If you're using Visual Studio 2010, you can retrieve the namespace by checking the CallContext's "NamespaceHint" property.
System.Runtime.Remoting.Messaging.CallContext.LogicalGetData("NamespaceHint");
Damien Guard includes some code in a blog posting which retrieves the Custom Tool Namespace for a given file:
public override String GetCustomToolNamespace(string fileName)
{
return dte.Solution.FindProjectItem(fileName).Properties.Item("CustomToolNamespace").Value.ToString();
}
Here is what you can do with T4 Toolbox:
<#@ template language="C#v3.5" hostspecific="True" debug="True" #>
<#@ include file="T4Toolbox.tt" #>
<#
var namespaceName = TransformationContext.DefaultNamespace;
#>
DefaultNamespace property of TransformationContext class returns a string with namespace based on the root namespace of your project and the location of your .tt file in it (i.e. it treats folders as namespaces). This way you don't have to specify Custom Tool Namespace property for every instance of your .tt file.
If you prefer to use the Custom Tool Namespace property, you can pass Host.TemplateFile to the GetCustomToolNamespace method posted by @sixlettervariables.
Oleg
I know this doesn't really answer your question but this guy Oleg Sych has a lot of information about T4 stuff on his site. He may be able to help you out with this one. Another one to look at would be Damien Guard.
I'm pretty new to unit testing and currently experimenting a bit with Visual Studio's testing tools.
My question is how to define assertions about concurrent behaviour in these tests. E.g. given a class BoundedChan<T> implementing a bounded channel, how can I specify tests like
channel.Send will not block" orchannel.Send will block until a value is read"Is there an elegant solution to write these assertions?
Here's a blog article that discusses the topic; it focuses on NUnit.
Unfortunately, concurrency is still an area of unit testing that is challenging to structure easily. It's not a simple problem, and still requires that you implement some of your own synchronization and concurrency logic in the test.
For the example you provide, it may be impossible to write a test that conclusively demonstrates that a method will or won't block under certain conditions. You may be able to achieve some level of confidence by first creating worst-case circumstances where you would expect the blocking behavior - and then write tests to determine if that occurs or not.
This question could lead to enough content to fill a book.
In general, I would not recommend adding unit tests to your classes for concurrent scenarios. With practice I think you'll learn that automated unit tests have one or several "sweet spots" -- and that focusing your efforts in these areas (and using other practices in other areas) yields better ROI.
But your class seems to be about concurrency (can't tell for certain based on info provided), and therefore this could be a case where you really want a concurrency-simulating test.
You can (as far as I know) start up multiple threads in a unit test if you wish. But there may be a simpler way. Consider leveraging the Compose Method pattern. While we're on the subject -- this pattern is pretty critical to effective unit tests over all, not just with concurrency.
This should be an interesring read -> http://c2.com/cgi-bin/wiki?ExtremeProgrammingChallengeFourteen
I have a Visual Studio 2008 C#/.NET 3.5 project with a post build task to ZIP the contents. However I'm finding that I'm also getting the referenced assemblies' .pdb (debug) and .xml (documentation) files in my output directory (and ZIP).
For example, if MyProject.csproj references YourAssembly.dll and there are YourAssembly.xml and YourAssembly.pdb files in the same directory as the DLL they will show up in my output directory (and ZIP).
I can exclude *.pdb when ZIP'ing but I cannot blanket exclude the *.xml files as I have deployment files with the same extension.
Is there a way to prevent the project from copying referenced assembly PDB and XML files?
I wanted to be able to add and remove referenced assemblies in my primary application while avoiding the the need to maintain which files I needed to delete or exclude.
I dug through Microsoft.Common.targets looking for something that would work and found the AllowedReferenceRelatedFileExtensions property. It defaults to .pdb; .xml so I explicitly defined it in my project file. The catch is that you need something (whitespace is not sufficient) otherwise it will still use the default.
<Project ...>
<PropertyGroup Condition=" '$(Configuration)|$(Platform)' == 'Release|AnyCPU' ">
...
<AllowedReferenceRelatedFileExtensions>
<!-- Prevent default XML and PDB files copied to output in RELEASE.
Only *.allowedextension files will be included, which doesn't exist in my case.
-->
.allowedextension
</AllowedReferenceRelatedFileExtensions>
</PropertyGroup>
You can add a Post Build event command similar to del "$(TargetDir)YourAssembly*.xml", "$(TargetDir)YourAssembly*.pdb"
I have a simple WinForms solution in VS 2010. Whenever I build it, output file (bin\debug\app.exe) ends up locked, and subsequent builds fail with a message like "The process cannot access the file 'bin\Debug\app.exe' because it is being used by another process." The only way to build the project is to restart VS after every build, which is very awkward.
I have found this old blog post http://blogs.geekdojo.net/brian/archive/2006/02/17/VS2005FileLocking.aspx - it seems that the problem is really old. Does anyone know what is happening here, or at least some workaround?
Update
I don't actually run the file. Locking happens after build, not after debug (i.e. start VS - build - build - fail!) And I tried turning antivirus off. It doesn't help.
Update 2
Process Explorer shows devenv.exe having loaded the file (in DLLs, not in Handles). It seems like some glitch during build prevented the unloading, but the (first) build completes without any messages other then "1 succeeded, o failed"/
It is not a virus issue. It is visual studio 2010 bug. It seems the issue is related to using visual studio gui designer.
The workaround here is to move locked output file into another temporary one in pre-build event. It make sense to generate temporary file name randomly.
del "$(TargetPath).locked.*" /q
if exist "$(TargetPath)" move "$(TargetPath)" "$(TargetPath).locked.%random%"
exit /B 0
In case of using constant temporary file names you will just postpone locks:
That workaround works exactly once
if exist "$(TargetPath).locked" del "$(TargetPath).locked"
if exist "$(TargetPath)" if not exist "$(TargetPath).locked" move "$(TargetPath)" "$(TargetPath).locked"
I have also found a solution with 2 temporary files that works exactly 2 times.
Had the same issue, but found an solution (thx to Keyvan Nayyeri):
But how to solve this? There are various ways based on your project type but one simple solution that I recommend to Visual Studio add-in developers is to add a simple code to their project's build events.
You can add following lines of code to the pre-build event command line of your project.
if exist "$(TargetPath).locked" del "$(TargetPath).locked"
if exist "$(TargetPath)" if not exist "$(TargetPath).locked" move "$(TargetPath)" "$(TargetPath).locked"
I've seen this on either a greedy virus scanning software, or if app.exe isn't shutting down properly. Make sure the process isn't still running.
What about virus scanners on your machine? Can you see any processes that are holding handles to your file (use Process Explorer to find out)?
Maybe there is "app.exe" visible in your process list, i.e the last version you debugged is still running? When you develop applications which have multiple threads, this may happen if you don't join all of them.
I had this problem and resolved it with some custom code. See here: http://stackoverflow.com/questions/3095573/visual-studio-2010-build-file-lock-issues
Compile the utility in the accepted answer and reference it during the build step as described to workaround the problem. I still turn off VS 2010 at lunch to clean up the morning's work.
The reason for the custom code was that the often recommended solution only worked once and then the renamed files were also locked, preventing the rename. Here we just append the data-time info to the file so the renamed versions can't conflict.
I have pretty much the same problem, although, I thought mine was related to building an exe with DLL's...
http://stackoverflow.com/questions/1406856/dll-and-main-project-building-annoyance
I have created a new blank solution and added all the old files to it. This somehow solved the problem.
There is also a known issue 533411 where the usage of automatically updating build numbers can cause the locking issue. Workaround from bug report
Temporary workaround would be disable assembly version update after the rebuild. In AssemblyInfo.cs file, remove the wild card from the AssemblyVersion attribute, for example:
replace this:
[assembly: AssemblyVersion("1.4.*")]
[assembly: AssemblyFileVersion("1.4")]
with this:
[assembly: AssemblyVersion("1.4.0.0")]
[assembly: AssemblyFileVersion("1.4.0.0")]
I had the same problem and I found out, that VS only locks the exe when I opened a Form or UserControl in VS before building. The solution was quite easy, I just had to close any Form/UserControl before I build the solution and it worked.
Is anyone here using the Intel C++ compiler instead of Microsoft's Visual c++ compiler?
I would be very interested to hear your experience about integration, performance and build times.
The Intel compiler is the most advanced C++ compiler available, it has a number of advantages over for instance the Microsoft Visual C++ compiler, and one major drawback. The advantages include:
Very good SIMD support, as far as I've been able to find out, it is the compiler that has the best support for SIMD instructions.
Supports both automatic parallelization (multi core optimzations), as well as manual (through OpenMP), and does both very well.
Support CPU dispatching, this is really important, since it allows the compiler to target the processor for optimized instructions when the program runs. As far as I can tell this is the only C++ compiler available that does this, unless G++ has introduced this in their yet.
It is often shipped with optimized libraries, such as math and image libraries.
However it has one major drawback, the dispatcher as mentioned above, only works on Intel CPU's, this means that advanced optimizations will be left out on AMD cpu's. There is a workaround for this, but it is still a major problem with the compiler.
To work around the dispatcher problem, it is possible to replace the dispatcher code produced with a version working on AMD processors, one can for instance use Agner Fog's asmlib library which replaces the compiler generated dispatcher function. Much more information about the dispatching problem, and more detailed technical explanations of some of the topics can be found in the Optimizing software in C++ paper - also from Anger (which is really worth reading).
On a personal note I have used the Intel c++ Compiler with Visual Studio 2005 where it worked flawlessly, I didn't experience any problems with microsoft specific language extensions, it seemed to understand those I used, but perhaps the ones mentioned by John Knoeller were different from the ones I had in my projects.
While I like the Intel compiler, I'm currently working with the microsoft C++ compiler, simply because of the financial extra investment the Intel compiler requires. I would only use the Intel compiler as an alternative to Microsofts or the GNU compiler, if performance were critical to my project and I had a the financial part in order ;)
I'm not using Intel C++ compiler at work / personal (I wish I would).
I would use it because it has:
Excellent inline assembler support. Intel C++ supports both Intel and AT&T (GCC) assembler syntaxes, for x86 and x64 platforms. Visual C++ can handle only Intel assembly syntax and only for x86.
Support for SSE3, SSSE3, and SSE4 instruction sets. Visual C++ has support for SSE and SSE2.
Is based on EDG C++, which has a complete ISO/IEC 14882:2003 standard implementation. That means you can use / learn every C++ feature.
I've had only one experience with this compiler, compiling STLPort. It took MSVC around 5 minutes to compile it and ICC was compiling for more than an hour. It seems that their template compilation is very slow. Other than this I've heard only good things about it.
Here's something interesting:
Intel's compiler can produce different versions of pieces of code, with each version being optimised for a specific processor and/or instruction set (SSE2, SSE3, etc.). The system detects which CPU it's running on and chooses the optimal code path accordingly; the CPU dispatcher, as it's called.
"However, the Intel CPU dispatcher does not only check which instruction set is supported by the CPU, it also checks the vendor ID string," Fog details, "If the vendor string says 'GenuineIntel' then it uses the optimal code path. If the CPU is not from Intel then, in most cases, it will run the slowest possible version of the code, even if the CPU is fully compatible with a better version."
OSnews article here
The last time the company I work for compared the two was about a year ago, (maybe 2). The Intel compiler generated faster code, usually only a bit faster, but in some cases quite a bit.
But it couldn't handle some of the MS language extensions that we depended on, so we ended up sticking with MS. It was VS 2005 that we were comparing it to. And I'm wracking my brain to remember exactly what MS extension the Intel compiler couldn't handle. I'll come back and edit this post if I can remember.
I tried using Intel C++ at my previous job. IIRC, it did indeed generate more efficient code at the expense of compilation time. We didn't put it to production use though, for reasons I can't remember.
One important difference compared to MSVC is that the Intel compiler supports C99.
Anecdotally, I've found that the Intel compiler crashes more frequently than Visual C++. Its diagnostics are a bit more thorough and clearly written than VC's. Thus, it's possible that the compiler will give diagnostics that weren't given with VC, or will crash where VC didn't, making your conversion more expensive.
However, I do believe that Intel's compiler allows you to link with Microsoft runtimes like the CRT, easing the transition cost.
If you are interoperating with managed code you should probably stick with Microsoft's compiler.
Recent Intel compilers achieve significantly better performance on floating-point heavy benchmarks, and are similar to Visual C++ on integer heavy benchmarks. However, it varies dramatically based on the program and whether or not you are using link-time code generation or profile-guided optimization. If performance is critical for you, you'll need to benchmark your application before making a choice. I'd only say that if you are doing scientific computing, it's probably worth the time to investigate.
Intel allows you a month-long free trial of its compiler, so you can try these things out for yourself.
Intel C++ Compiler has AMAZING (human) support. Talking to Microsoft can literally take days. My non-trivial issue was solved through chat in under 10 minutes (including membership verification time).
Consider an ASP.NET MVC 2 project with VS 2010. The goal is to set the 'start URL' on run/debug using VS's built-in Cassini web server.
Entering the URL as I want to be loaded, in the typical & valid format, controller/action, VS 2010 gives this exception.
Tried Remedies:
Question: How can you specify the start URL for an MVC 2 project?
Technologies:
Resolution: I was using the wrong field in the startup options. What was needed was the "Specific Page" field with the relative URL, and not Start URL.
Use Start Page \ Specific Page -- NOT START URL -- and specify your URL without a slash:
that oughta do it for you.
Start URL has to be a fully qualified URL and is not really used that often. It's meant for testing web services by opening a page that will call into the service, but isn't part of the application itself.
If you're just looking to start on a certain page of your application, which it sounds like you want, then use the "Specific Page" field, and enter your relative URL.
How can you implement regions a.k.a. code collapse for JavaScript in Visual Studio?
If there are hundreds of lines in javascript, it'll be more understandable using code folding with regions as in vb/C#.
#region My Code
#endregion
Microsoft now has an extension for VS2010 that provides this functionality:
Thanks to Roboto for a great answer. I've had good luck with it. Darin Dimitrov also makes a good argument about limiting the complexity of your JS files. Still, I do find occasions where collapsing functions to their definitions makes browsing through a file much easier.
Regarding #region in general, this SO Question covers it quite well.
I have made a few modifications to the Macro to support more advanced code collapse. This method allows you to put a description after the //#region keyword ala C# and shows it in the code as shown:
Example code:
//#region InputHandler
var InputHandler = {
inputMode: 'simple', //simple or advanced
//#region filterKeys
filterKeys: function(e) {
var doSomething = true;
if (doSomething) {
alert('something');
}
},
//#endregion filterKeys
//#region handleInput
handleInput: function(input, specialKeys) {
//blah blah blah
}
//#endregion handleInput
};
//#endregion InputHandler
Looks like this:
And this expanded:
Updated Macro:
Option Explicit On
Option Strict On
Imports System
Imports EnvDTE
Imports EnvDTE80
Imports EnvDTE90
Imports System.Diagnostics
Imports System.Collections.Generic
Public Module JsMacros
Sub OutlineRegions()
Dim selection As EnvDTE.TextSelection = CType(DTE.ActiveDocument.Selection, EnvDTE.TextSelection)
Const REGION_START As String = "//#region"
Const REGION_END As String = "//#endregion"
selection.SelectAll()
Dim text As String = selection.Text
selection.StartOfDocument(True)
Dim startIndex As Integer
Dim endIndex As Integer
Dim lastIndex As Integer = 0
Dim startRegions As New Stack(Of Integer)
Do
startIndex = text.IndexOf(REGION_START, lastIndex)
endIndex = text.IndexOf(REGION_END, lastIndex)
If startIndex = -1 AndAlso endIndex = -1 Then
Exit Do
End If
If startIndex <> -1 AndAlso startIndex < endIndex Then
startRegions.Push(startIndex)
lastIndex = startIndex + 1
Else
' Outline region ...
Dim tempStartIndex As Integer = CInt(startRegions.Pop())
selection.MoveToLineAndOffset(CalcLineNumber(text, tempStartIndex), CalcLineOffset(text, tempStartIndex))
selection.MoveToLineAndOffset(CalcLineNumber(text, endIndex) + 1, 1, True)
selection.OutlineSection()
lastIndex = endIndex + 1
End If
Loop
selection.StartOfDocument()
End Sub
Private Function CalcLineNumber(ByVal text As String, ByVal index As Integer) As Integer
Dim lineNumber As Integer = 1
Dim i As Integer = 0
While i < index
If text.Chars(i) = vbLf Then
lineNumber += 1
i += 1
End If
If text.Chars(i) = vbCr Then
lineNumber += 1
i += 1
If text.Chars(i) = vbLf Then
i += 1 'Swallow the next vbLf
End If
End If
i += 1
End While
Return lineNumber
End Function
Private Function CalcLineOffset(ByVal text As String, ByVal index As Integer) As Integer
Dim offset As Integer = 1
Dim i As Integer = index - 1
'Count backwards from //#region to the previous line counting the white spaces
Dim whiteSpaces = 1
While i >= 0
Dim chr As Char = text.Chars(i)
If chr = vbCr Or chr = vbLf Then
whiteSpaces = offset
Exit While
End If
i -= 1
offset += 1
End While
'Count forwards from //#region to the end of the region line
i = index
offset = 0
Do
Dim chr As Char = text.Chars(i)
If chr = vbCr Or chr = vbLf Then
Return whiteSpaces + offset
End If
offset += 1
i += 1
Loop
Return whiteSpaces
End Function
End Module
Blog entry here explains it and this MSDN question.
You have to use Visual Studio 2003/2005/2008 Macros.
Copy + Paste from Blog entry for fidelity sake:
OutlineRegionsOption Strict Off
Option Explicit Off
Imports System
Imports EnvDTE
Imports EnvDTE80
Imports System.Diagnostics
Imports System.Collections
Public Module JsMacros
Sub OutlineRegions()
Dim selection As EnvDTE.TextSelection = DTE.ActiveDocument.Selection
Const REGION_START As String = "//#region"
Const REGION_END As String = "//#endregion"
selection.SelectAll()
Dim text As String = selection.Text
selection.StartOfDocument(True)
Dim startIndex As Integer
Dim endIndex As Integer
Dim lastIndex As Integer = 0
Dim startRegions As Stack = New Stack()
Do
startIndex = text.IndexOf(REGION_START, lastIndex)
endIndex = text.IndexOf(REGION_END, lastIndex)
If startIndex = -1 AndAlso endIndex = -1 Then
Exit Do
End If
If startIndex <> -1 AndAlso startIndex < endIndex Then
startRegions.Push(startIndex)
lastIndex = startIndex + 1
Else
' Outline region ...
selection.MoveToLineAndOffset(CalcLineNumber(text, CInt(startRegions.Pop())), 1)
selection.MoveToLineAndOffset(CalcLineNumber(text, endIndex) + 1, 1, True)
selection.OutlineSection()
lastIndex = endIndex + 1
End If
Loop
selection.StartOfDocument()
End Sub
Private Function CalcLineNumber(ByVal text As String, ByVal index As Integer)
Dim lineNumber As Integer = 1
Dim i As Integer = 0
While i < index
If text.Chars(i) = vbCr Then
lineNumber += 1
i += 1
End If
i += 1
End While
Return lineNumber
End Function
End Module
The JSEnhancements plugin for Visual Studio addresses this nicely.
I have ReSahrper 4.5 in Visual Studio 2008. Now I want to install ReSharper 5, but I can't do it before I uninstall ReSharper 4.5.
How can I uninstall ReSharper 4.5?
Control Panel
--> Add Remove Programs
--> JetBrains ReSharper 4.5
--> Uninstall
??
Can't you just install Resharper 5 directly? It will override the Resharper 4.5
Possible Duplicate:
Using Git with Visual Studio
What's the most painless way for the Visual Studio developer to start using GitHub? Ideally the answer would involve a Visual Studio plugin, or some other integration app?
See this question for general hints using git with Visual Studio.
The accepted answer was the Git Extensions project.
I'm not aware that github would require any specific extras beyond that.
Have a look at tortoisegit . It is not a visual studio plugin but it provides a gui interface to the world of git (which can be irritating at first).
What exactly is the difference between the HintPath in a .csproj file and the ReferencePath in a .csproj.user file? We're trying to commit to a convention where dependency DLLs are in a "releases" svn repo and all projects point to a particular release. Since different developers have different folder structures, relative references won't work, so we came up with a scheme to use an environment variable pointing to the particular developer's releases folder to create an absolute reference. So after a reference is added, we manually edit the project file to change the reference to an absolute path using the environment variable.
I've noticed that this can be done with both the HintPath and the ReferencePath, but the only difference I could find between them is that HintPath is resolved at build-time and ReferencePath when the project is loaded into the IDE. I'm not really sure what the ramifications of that are though. I have noticed that VS sometimes rewrites the .csproj.user and I have to rewrite the ReferencePath, but I'm not sure what triggers that.
I've heard that it's best not to check in the .csproj.user file since it's user-specific, so I'd like to aim for that, but I've also heard that the HintPath-specified DLL isn't "guaranteed" to be loaded if the same DLL is e.g. located in the project's output directory. Any thoughts on this?
According to this MSDN blog http://blogs.msdn.com/manishagarwal/archive/2005/09/28/474769.aspx
There is a search order for assemblies when building. The search order is as follows:
So, if the desired assembly is found by HintPath, but an alternate assembly can be found using ReferencePath, it will prefer the ReferencePath'd assembly to the HintPath'd one.
My own experience has been that it's best to stick to one of two kinds of assembly references:
I've found (much like you've described) other methods to either be too easily broken or have annoying maintenance requirements.
Any assembly I don't want to GAC, has to live in the execution directory. Any assembly that isn't or can't be in the execution directory I GAC (managed by automatic build events).
This hasn't given me any problems so far. While I'm sure there's a situation where it won't work, the usual answer to any problem has been "oh, just GAC it!". 8 D
Hope that helps!
I recently found out about the Linq To Sql Visualizer for Visual Studio. Are there any other useful visualizers out there?
I've recently done a lot of work using the Graphics object and found this visualizer a must have.
Self promotion: VS Image Visualizer.
It is a visualizer for System.Drawing.Image (and derived types).
There are several available from the Visual Studio Gallery.
Mole is incredibly useful for WPF and even for Forms development. Allows deep inspection of Controls.
(also self promotion, but might still be usefull)
If you want an Image Debugger Visualizer for VS2010 (only), you can find one here: http://imagedebugvisualizer.codeplex.com
The dll for debugger visualizers in VS2010 has changed version, so old versions most likely won't work (if they do, I'd be glad to find out)
Cheers
As Linq to Sql visualizer is for MS SQL server you have Linq to Entities visualizer (free) for all other databases available at http://visualstudiogallery.msdn.microsoft.com/en-us/99468ece-689b-481c-868c-19e00e0a4e69. You have how to use links at www.rajavenkatesh.com.
I built this one... it was very specific but if there was demand, I could always take input and get it abstracted and useful... it was hugely helpful in troubleshooting some spatial stuff I was building.
Also self-promotion, but if you use Autofac as a DI container I wrote a visualizer to inspect the container at runtime:
https://github.com/jgraves/Autofac-Visualizer
It's not entirely complete but if other people find it useful I'll probably start updating it more frequently.
Another self promotion visualizer.. WPF Brush Visualizer lets you see (visually) your WPF brushes during debugging.
Is there a way to have an empty Project in Visual Studio 2008 or 2010? I do not mean an empty solution, I mean an empty project in a solution. Basically I have a solution with multiple projects, and I want to add a project to track some static files that are part of the solution but not of any specific project. Adding them as solution files doesn't work because solution folders are not mapped to file system folders and I want to manage hierarchy from Visual Studio.
At the moment I create an empty Visual C# project which works, but I just wonder if there is a "more empty" project.
The Visual C++ project types has an "Empty Project" in the "General" category.
It comes up with several empty folders ("Header Files", "Resource Files", "Source Files") that are just 'filters' (they aren't on the file system). You can just remove them.
It also has all the properties of a C++ project available, so don't put C/C++ files in there unless you want them built (or you exclude them from the build).
Other than that, it's pretty empty.
Probably even closer to an "empty project" is a "Makefile Project" which is also located in the "General" category of the Visual C++ project templates. It also creates the 3 filter folders, along with a readme.txt file that you can delete. It has the advantage that unless you specifically give it commands to run during the build, it won't do a damn thing.
Sounds to me like you want a solution folder!
My ASP.NET application runs in IIS on my web server and uses Microsoft .NET Framework 4 Beta 2. (Its Application Pool is set to .NET Framework version .NET Framework v4.0.21006.)
It gives this new error:
A potentially dangerous Request.Form value was detected from the client...
This is due to a breaking change in .NET 4.
To revert to the behavior of the ASP.NET 2.0 request validation feature, I added the following setting in the Web.config file:
<httpRuntime requestValidationMode="2.0" />
Now Visual Studio 2008 throws a compile-time error:
The 'requestValidationMode' attribute is not declared.
And I can no longer debug on my development machine using the ASP.NET Development Server that comes with Visual Studio.
I need Visual Studio and its ASP.NET Development Server to recognize the new .NET Framework 4 requestValidationMode attribute.
How can I debug my application in .NET 4? Must I switch from Visual Studio 2008 to Visual Studio 2010 Beta 2?
You cannot use Visual Studio 2008 to develop 4.0 applications in a supported manner. Currently only Visual Studio 2010 can be used to develop 4.0 apps. Starting with 2008 you can use it to develop for earlier versions of the framework but not later ones.
From ScottGu's blog:
There isn't any way to target .NET 4 from VS08 and use new features. Having said that, .NET4 is upwards comaptible with .NET 3.5 - so applications you build targeting .NET 3.5 with VS08 should work fine on top of .NET 4.
as many previous Visual Studio releases, you cannot develop a higher version framework application (in this question .NET 4.0) using a VS for a lower version framework (in this question VS 2008), just the same as you cant develop 3.5 apps in VS 2005, and so on and so forth. You may try updating the references from .NET 3.5 to .NET 4.0 (for example, using System.dll from .NET 4.0 instead of the one referenced directly by the project) every time you develop apps, but I dont think it would recognize the new features from the new framework version.
The only way to develop for .Net 4 is to use Visual Studio 2010. However, if you do create a managed assembly in VS2008, you could run in on a machine with .net 4 run-time installed.
My guess is that you have found one of those fabulous cases where it is just going to complain to no end. You will likely be better off using the beta of VS2010 or removing the validationMode attribute.
You could, in theory, try attaching to appropriate worker process and get some debugging love - but it still might not work.
You can target the .NET Framework 4.0 using VS2008, just have to wait for the right plugins (create Silverlight 4 projects, etc). For instance, you can use .NET Framework 3.5 in VS2005 with the correct SDK.
If you want to develop for .net 4 without the pricey Visual Studio 2010 Pro, you can try Mono:
I don't want to uninstall code rush. I just want to have the chance ti turn it off when I dont want it.
Is this possible? (express version)...
First you should turn on the "DevExpress" menu. This is hidden by default in CodeRush Xpress.
See this blogpost http://www.coderjournal.com/2009/08/show-coderush-xpress-9-2-menu-in-visual-studio/
Once this is done you should be able to use the Unload/Load menu option (Last item on DevExpress menu)
Additionally you can set CodeRush Xpress to not load fully by default..
Follow these steps to get to the Startup options page:
In the tree view on the left, navigate to this folder:
Core
Select the "Startup" options page. This page level is Expert, and will only be visible if the Level combo on the lower-left of the Options dialog is set to Expert.
Once on this page, you can toggle the "Load Manually" setting to dictate how CodeRush starts.
Shift Ctrl Alt O brings up CR's options dialog - not sure if there's something useful in the Xpress version though.
(In the Pro, the DevExpress menu has a "Unload" option)
In Visual Studio, choose Tools | Add-in Manager...
I do not have any "Load Manually" checkbox in DevExpress Options, but 2 checkboxes: + Re-register CodeRush commands with Visual Studio on next startup + Always re-register CodeRush commands on startup
VS2008 DXCore 9.1.3 ReSharper 5.1
Have you used JustCode? is it better than resharper? seems like performance better. Do I need to uninstall resharper before using JustCode?
Looks very promising, I especially like the Highlight Usages feature! I miss that from Netbeans. However, I would be a bit reluctant to install a beta product on a production machine.
I would think that you should uninstall ReSharper first, as this changes keyboard shortcuts, intellisense etc., so you would probably end up with a big mess if both are installed :(
Haven't used CodeRush, so can't comment on that one.
Update:
Just for giggles, I installed JustCode alongside ReSharper on my home computer. It doesn't show up on the product list on the splash screen and VS2008, and this dialog is shown:
So it seems like you can't run them together.
My initial impression is that it opening files is a bit slower than with ReSharper (note: just a feeling, might be the same), and does not decorate your code with as many colored warnings and notes than ReSharper.
I like the content menu though, the one from JustCode is on top of the content menu, whereas ReSharper is way down close to the bottom, and JustCode's menu is split in three:
Really smart IMHO, as navigating for instance is easier. Highlight Usage is also very helpful, and works across files!
Edit after tried it a few days:
I've just uninstalled JustCode. As smart as it seems, it's too buggy for production use. It's slow and makes intellisense fail. For instance, when writing a simple for loop, I type { and } in rapid succession after the closing parenthesis - for some reason, JustCode fumbles and makes me insert one } inside the parenthesis, so I end up with this code:
for(int i = 0; i < content.length; ++i})
{
This has happened to me more than once, so I'm pulling the plug here. Too bad, I liked some of the features, but it's really counterproductive for me, and the slowdown and fumbles are really a show stopper :(
Mark.. what are the odds. I also uninstalled resharper (trial expired) and installed justcode to see if it would do as as replacement, but it's die-ing a death on my multi-project solution. And my name is also Mark Davis. That's just weird.
For me, JustCode needs to be better than Resharper 5 to install it.
I installed JustCode after winning it at a user group meeting. I've been using resharper. I was unable to load my solution after uninstalling resharper, installing justCode and rebooting. that might have something to do with the 107 projects in out solution (don't ask). So the only input i have is that if you have losts of projects in your solution then JustCode may not load your solution.
I am trying to see the properties of an object with over 300 properties in the Immediate Window of Visual Studio 2005. Only the first 100 items are displayed, followed by this caption:
< More... (The first 100 of 306 items were displayed.) >
I am trying to see the rest of the items, but can't figure it out.
I realize that I could see these in a Watch window, but that's not the same.
The immediate window was designed to be a quick view tool. If you want to see more detail, you will have to view it in either the Watch Window or the Quick Watch Window.
Another option is to write a Visual Studio AddIn that operates similarly to the Immediate Window, but has more options.
can somebody tell me, is there an analogue of a Visual Studio #region feature for Eclipse IDE ?
I really need this magic! :)
User-defined regions for code folding can be added by using the Coffee-Bytes plugin.
Sorry; there is not.
There might be a plugin
This is a probably an embarasing question as no doubt the answer is blindingly obvious.
I've used Visual Studio for years, but this is the first time I've done any 'Console Application' development.
When I run my application the console window pops up, the program output appears and then the window closes as the application exits.
Is there a way to either keep it open until I have checked the output, or view the results after the window has closed?
If you run without debugging (Ctrl+F5) then by default it prompts your to press return to close the window. If you want to use the debugger, you should put a breakpoint on the last line.
Throw a Console.ReadKey() at the end of your Main() method to wait for a keypress. If you want to be really user-friendly, HCI and all that, you can put Console.WriteLine("Press any key to exit") before that.
If you're using .NET, put Console.ReadLine() before the end of the program.
It will wait for <ENTER>.
add ?| pause? in command arguments box under debugging section at project properties.
You could run your executable from a command prompt. This way you could see all the output. Or, you could do something like this:
int a = 0;
scanf("%d",&a);
return YOUR_MAIN_CODE;
and this way the window would not close until you enter data for the a variable.
Use console.readline. Yours is writing the line but not reading it.
I want to edit a binary file but I don't want to use another tool other than Visual Studio because it's a pain to switch back and forth.
Is there perhaps a add-in or some built in functionality that can do that in Visual Studio?
Or for the keyboard geeks out there:
Is it possible to get a method's return value in the Visual Studio debugger, even if that value isn't assigned to a local variable? For example, I'm debugging the following code:
public string Foo(int valueIn)
{
if (valueIn > 100)
return Proxy.Bar(valueIn);
else
return "Not enough";
}
Since I'm not setting any local variables in Foo, and assuming I'm not setting a break point in whatever's calling Foo, is there a way to see what the return value is if I have a breakpoint inside of Foo (or another way)? I don't have much experience with the Autos or Intermediate windows, so I'm not sure if those are even a valid option or not.
You can set a breakpoint in Foo, open the immediate window and run the following command:
? Foo(valueIn)
This will print the return value in the Immediate Window.
You can also copy the expression and paste it into the Watch window, though I would do this only if I am certain that the call has no side effects (otherwise you can get confusing results).
You can always switch to disassembler view and step through the individual instructions. The return value will be in @eax (or @rax) just before you execute the 'ret' instruction.
No, I don't know of a way to do this. I would put a breakpoint in the caller and look at the return value there.
You can also highlight any expression in the debugger and right-click -> quick watch. That will execute the expression (assuming it's valid) and give you the value.
You can always use your watch box to evaluate function calls.
Foo(valueIn);
This will only work if your Proxy.Bar(valueIn) is time independent though.
A workaround is to use a Pascal-style result variable:
public string Foo(int valueIn)
{
string result;
if (valueIn > 100)
result = Proxy.Bar(valueIn);
else
result = "Not enough";
return result;
}
This is good style in my opinion for longer functions. For very short ones like the one above it could be considered overkill, but it does get around the debugger problem.
I recently created a very nice UML Class diagram inside Visual Studio 2010 (b2). The tools worked like a charm and I was able to model a rather complex domain within minutes.
However, I cannot find any way to export my diagram as an image (PNG/JPEG/etc.).
Does the modelling features in VS2010 support exporting diagrams as images? If so - how do I do it?
Print src is NOT the answer.
Edit: Found one way to export... Go to File > Print and select Adobe PDF
Edit 2: Found another, slightly more elegant, way to export. In the diagram editor: Select all (Ctrl + A), Copy (Ctrl + C), Go to your favourite image editor (paint works fine) and Paste (Ctrl + V). Viola!
The VS 2010 Ultimate RC documentation has more info about exporting the UML diagrams as images: How to: Save Images of Diagrams
See also Cameron Skinner's blog http://blogs.msdn.com/camerons/archive/2010/03/08/save-a-diagram-to-image-file.aspx
We now have a topic in the documention about how to do this programmatically:
Using Visual Studio 2008 to create an msi to deploy my program with a setup project. I need to know how to make the msi run the exe it just installed. A custom action? If so please explain where/how. Thanks.
This is a common question. I don't do it with just a custom action. The only way I know, is to modify the .msi after it has been generated. I run a Javascript script as a post-build event to do exactly that. It inserts a new dialog in the installer wizard, with a checkbox that says "Launch Application Foo?". And then there is a custom action to run the app, if the checkbox is checked.
It appears as the last screen in the install Wizard sequence. Looks like this:
This is the script I use to modify the MSI:
// EnableLaunchApplication.js <msi-file>
// Performs a post-build fixup of an msi to launch a specific file when the install has completed
// Configurable values
var checkboxChecked = true; // Is the checkbox on the finished dialog checked by default?
var checkboxText = "Launch [ProductName]"; // Text for the checkbox on the finished dialog
var filename = "WindowsApplication1.exe"; // The name of the executable to launch - change this to match the file you want to launch at the end of your setup
// Constant values from Windows Installer
var msiOpenDatabaseModeTransact = 1;
var msiViewModifyInsert = 1;
var msiViewModifyUpdate = 2;
var msiViewModifyAssign = 3;
var msiViewModifyReplace = 4;
var msiViewModifyDelete = 6;
if (WScript.Arguments.Length != 1)
{
WScript.StdErr.WriteLine(WScript.ScriptName + " file");
WScript.Quit(1);
}
var filespec = WScript.Arguments(0);
var installer = WScript.CreateObject("WindowsInstaller.Installer");
var database = installer.OpenDatabase(filespec, msiOpenDatabaseModeTransact);
var sql;
var view;
var record;
try
{
var fileId = FindFileIdentifier(database, filename);
if (!fileId)
throw "Unable to find '" + filename + "' in File table";
WScript.Echo("Updating the Control table...");
// Modify the Control_Next of BannerBmp control to point to the new CheckBox
sql = "SELECT `Dialog_`, `Control`, `Type`, `X`, `Y`, `Width`, `Height`, `Attributes`, `Property`, `Text`, `Control_Next`, `Help` FROM `Control` WHERE `Dialog_`='FinishedForm' AND `Control`='BannerBmp'";
view = database.OpenView(sql);
view.Execute();
record = view.Fetch();
record.StringData(11) = "CheckboxLaunch";
view.Modify(msiViewModifyReplace, record);
view.Close();
// Insert the new CheckBox control
sql = "INSERT INTO `Control` (`Dialog_`, `Control`, `Type`, `X`, `Y`, `Width`, `Height`, `Attributes`, `Property`, `Text`, `Control_Next`, `Help`) VALUES ('FinishedForm', 'CheckboxLaunch', 'CheckBox', '9', '201', '343', '12', '3', 'LAUNCHAPP', '{\\VSI_MS_Sans_Serif13.0_0_0}" + checkboxText + "', 'CloseButton', '|')";
view = database.OpenView(sql);
view.Execute();
view.Close();
WScript.Echo("Updating the ControlEvent table...");
// Modify the Order of the EndDialog event of the FinishedForm to 1
sql = "SELECT `Dialog_`, `Control_`, `Event`, `Argument`, `Condition`, `Ordering` FROM `ControlEvent` WHERE `Dialog_`='FinishedForm' AND `Event`='EndDialog'";
view = database.OpenView(sql);
view.Execute();
record = view.Fetch();
record.IntegerData(6) = 1;
view.Modify(msiViewModifyReplace, record);
view.Close();
// Insert the Event to launch the application
sql = "INSERT INTO `ControlEvent` (`Dialog_`, `Control_`, `Event`, `Argument`, `Condition`, `Ordering`) VALUES ('FinishedForm', 'CloseButton', 'DoAction', 'VSDCA_Launch', 'LAUNCHAPP=1', '0')";
view = database.OpenView(sql);
view.Execute();
view.Close();
WScript.Echo("Updating the CustomAction table...");
// Insert the custom action to launch the application when finished
sql = "INSERT INTO `CustomAction` (`Action`, `Type`, `Source`, `Target`) VALUES ('VSDCA_Launch', '210', '" + fileId + "', '')";
view = database.OpenView(sql);
view.Execute();
view.Close();
if (checkboxChecked)
{
WScript.Echo("Updating the Property table...");
// Set the default value of the CheckBox
sql = "INSERT INTO `Property` (`Property`, `Value`) VALUES ('LAUNCHAPP', '1')";
view = database.OpenView(sql);
view.Execute();
view.Close();
}
database.Commit();
}
catch(e)
{
WScript.StdErr.WriteLine(e);
WScript.Quit(1);
}
function FindFileIdentifier(database, fileName)
{
// First, try to find the exact file name
var sql = "SELECT `File` FROM `File` WHERE `FileName`='" + fileName + "'";
var view = database.OpenView(sql);
view.Execute();
var record = view.Fetch();
if (record)
{
var value = record.StringData(1);
view.Close();
return value;
}
view.Close();
// The file may be in SFN|LFN format. Look for a filename in this case next
sql = "SELECT `File`, `FileName` FROM `File`";
view = database.OpenView(sql);
view.Execute();
record = view.Fetch();
while (record)
{
if (StringEndsWith(record.StringData(2), "|" + fileName))
{
var value = record.StringData(1);
view.Close();
return value;
}
record = view.Fetch();
}
view.Close();
}
function StringEndsWith(str, value)
{
if (str.length < value.length)
return false;
return (str.indexOf(value, str.length - value.length) != -1);
}
I originally got this from Aaron Stebner's blog, and then modified it.
Save that Javascript file to the project directory (same dir as contains .vdproj), name it ModifyMsiToEnableLaunchApplication.js . For each unique setup project, you need to modify that script and put the proper exe name into it. And then, you need to set the post-build event in the Setup project to be this:
cscript.exe "$(ProjectDir)ModifyMsiToEnableLaunchApplication.js" "$(BuiltOuputPath)"
That oughtta do it.
This seems to be a MUCH simpler solution: Visual Studio Installer > How To Launch App at End of Installer
Concerning the "hidden checkbox bug" I figured out the following which is not explained by Cheeso's and Muleskinner's answers above:
The change of the script (provided by Muleskinner) places the Y position of the checkbox to 201 (I guess top Y pixel for the control). If you change Y to, say, 151 (in order to kind of align it in the center vertically), the bug "suddenly" appears. The reason for that is that there is another control in the Control table of the msi, namely the 'BodyText' ('Dialog' field = 'FinishedForm') which its Y is set to 63 and its height to 138. That is 138 + 63 = 201. Therefore, if you change the Y value for the checkbox, the 'BodyText' control overlaps the newly added control and that's why the user needs to put their mouse over in order to show the checkbox. If you have no 'BodyText' or its number of characters is small enough you could change (by using Orca msi editor as I do, or by altering the script above) the Ys and Heights of these 2 controls in order to be able and accomodate a different Y position for the newly added checkbox. The same applies for the control: 'BodyTextRemove' in which again we should alter its height value (which appears during uninstall)
Hope that this helps all the users that had the same question as I had about this "bug"
Nevertheless, the script does a really good job!
Another question was how to make invisible the Checkbox during unistallation procedure. Using the Orca msi editor I added the following 2 rows in the ControlCondition table of the msi:
Row 1 (When control should be shown):
(Dialog)FinishedForm (Control)CheckboxLaunch (Action)Show (Condition)REMOVE=""
Row 2 (When control should be invisible):
(Dialog)FinishedForm (Control)CheckboxLaunch (Action)Hide (Condition)REMOVE<>""
P.S. I am using VS 2010, on windows 7 (x64), but I believe these should work with previous versions too.
Yes.. I would write a custom action, and stick it at the end of the InstallExecutionSequence table
OK!!! Here is the code (without the 2 auxiliary functions 'FindFileIdentifier' & 'StringEndsWith' in the end - use the original ones instead) which gives us the ability to change the Ys and Heights of the controls, along with adding the Checkbox Control Visibility Conditions (see the 2 comments that are marked between 'NEW - START' to 'NEW - END'):
// EnableLaunchApplication.js
// Performs a post-build fixup of an msi to launch a specific file when the install has completed
// Configurable values
var checkboxChecked = true; // Is the checkbox on the finished dialog checked by default?
var checkboxText = "Launch [ProductName]?"; // Text for the checkbox on the finished dialog
var filename = "*.exe"; // The name of the executable to launch - change * to match the file name you want to launch at the end of your setup
// Constant values from Windows Installer
var msiOpenDatabaseModeTransact = 1;
var msiViewModifyInsert = 1
var msiViewModifyUpdate = 2
var msiViewModifyAssign = 3
var msiViewModifyReplace = 4
var msiViewModifyDelete = 6
if (WScript.Arguments.Length != 1)
{
WScript.StdErr.WriteLine(WScript.ScriptName + " file");
WScript.Quit(1);
}
var filespec = WScript.Arguments(0);
var installer = WScript.CreateObject("WindowsInstaller.Installer");
var database = installer.OpenDatabase(filespec, msiOpenDatabaseModeTransact);
var sql
var view
var record
try
{
var fileId = FindFileIdentifier(database, filename);
if (!fileId)
throw "Unable to find '" + filename + "' in File table";
WScript.Echo("Updating the Control table...");
// Modify the Control_Next of BannerBmp control to point to the new CheckBox
sql = "SELECT `Dialog_`, `Control`, `Type`, `X`, `Y`, `Width`, `Height`, `Attributes`, `Property`, `Text`, `Control_Next`, `Help` FROM `Control` WHERE `Dialog_`='FinishedForm' AND `Control`='BannerBmp'";
view = database.OpenView(sql);
view.Execute();
record = view.Fetch();
record.StringData(11) = "CheckboxLaunch";
view.Modify(msiViewModifyReplace, record);
view.Close();
// NEW - START
// Insert the new CheckBox control
// I changed the value for Y below from 201 to 191 in order to make the checkbox more obvious to the user's eye. In order to do so, and avoid the controls 'BodyText' & 'BodyTextRemove' in the same form to
// overlap the checkbox, I added yet 2 more sql statements that change the values of the heights for the 'BodyText' & 'BodyTextRemove' from 138 to 128. This way I can play around with the values without using
// the Orca msi editor.
var CheckBoxY = 191; //This was initially set to 201
var NewHeight = 128; //This was initially set to 138
sql = "INSERT INTO `Control` (`Dialog_`, `Control`, `Type`, `X`, `Y`, `Width`, `Height`, `Attributes`, `Property`, `Text`, `Control_Next`, `Help`) VALUES ('FinishedForm', 'CheckboxLaunch', 'CheckBox', '9', '" + CheckBoxY + "', '343', '12', '3', 'LAUNCHAPP', '{\\VSI_MS_Sans_Serif13.0_0_0}" + checkboxText + "', 'CloseButton', '|')";
view = database.OpenView(sql);
view.Execute();
view.Close();
sql = "Select `Dialog_`, `Control`, `Type`, `X`, `Y`, `Width`, `Height`, `Attributes`, `Property`, `Text`, `Control_Next`, `Help` FROM `Control` WHERE `Dialog_` = 'FinishedForm' AND `Control` = 'BodyText'";
view = database.OpenView(sql);
view.Execute();
record = view.Fetch();
record.IntegerData(7) = NewHeight;
view.Modify(msiViewModifyReplace, record);
view.Close();
sql = "Select `Dialog_`, `Control`, `Type`, `X`, `Y`, `Width`, `Height`, `Attributes`, `Property`, `Text`, `Control_Next`, `Help` FROM `Control` WHERE `Dialog_` = 'FinishedForm' AND `Control` = 'BodyTextRemove'";
view = database.OpenView(sql);
view.Execute();
record = view.Fetch();
record.IntegerData(7) = NewHeight;
view.Modify(msiViewModifyReplace, record);
view.Close();
// NEW - END
WScript.Echo("Updating the ControlEvent table...");
// Modify the Order of the EndDialog event of the FinishedForm to 1
sql = "SELECT `Dialog_`, `Control_`, `Event`, `Argument`, `Condition`, `Ordering` FROM `ControlEvent` WHERE `Dialog_`='FinishedForm' AND `Event`='EndDialog'";
view = database.OpenView(sql);
view.Execute();
record = view.Fetch();
record.IntegerData(6) = 1;
view.Modify(msiViewModifyReplace, record);
view.Close();
// Insert the Event to launch the application
sql = "INSERT INTO `ControlEvent` (`Dialog_`, `Control_`, `Event`, `Argument`, `Condition`, `Ordering`) VALUES ('FinishedForm', 'CloseButton', 'DoAction', 'VSDCA_Launch', 'LAUNCHAPP=1', '0')";
view = database.OpenView(sql);
view.Execute();
view.Close();
WScript.Echo("Updating the CustomAction table...");
// Insert the custom action to launch the application when finished
sql = "INSERT INTO `CustomAction` (`Action`, `Type`, `Source`, `Target`) VALUES ('VSDCA_Launch', '210', '" + fileId + "', '')";
view = database.OpenView(sql);
view.Execute();
view.Close();
if (checkboxChecked)
{
WScript.Echo("Updating the Property table...");
// Set the default value of the CheckBox
sql = "INSERT INTO `Property` (`Property`, `Value`) VALUES ('LAUNCHAPP', '1')";
view = database.OpenView(sql);
view.Execute();
view.Close();
}
// NEW - START
WScript.Echo("Updating the ControlCondition table...");
// Insert the conditions where the Launch Application Checkbox appears
sql = "INSERT INTO `ControlCondition` (`Dialog_`, `Control_`, `Action`, `Condition`) VALUES ('FinishedForm', 'CheckboxLaunch', 'Show', 'REMOVE=\"\"')";
view = database.OpenView(sql);
view.Execute();
view.Close();
sql = "INSERT INTO `ControlCondition` (`Dialog_`, `Control_`, `Action`, `Condition`) VALUES ('FinishedForm', 'CheckboxLaunch', 'Hide', 'REMOVE<>\"\"')";
view = database.OpenView(sql);
view.Execute();
view.Close();
//NEW - END
database.Commit();
}
catch(e)
{
WScript.StdErr.WriteLine(e);
WScript.Quit(1);
}
Is there a way to execute the application even in /quiet or /passive mode?
I logged the difference between a normal installation, a /quiet and a /silent, but I can't see why it is not launching my application. The property LAUNCHAPP is always set to 1. But the CustomAction is not triggered. Is it because there is no FinishedForm to trigger it or something like that?
I also noticed that even when uninstalling, the setup tries to launch my application by returns an error code of:
Action ended 17:08:17: VSDCA_Launch. Return value 1631.
Action ended 17:08:17: FinishedForm. Return value 1.
Jeff
Greetings all
Regarding the 'PostBuildEvent' failed with error code '1' 'Unspecified error' error, change the PostBuildEvent from
cscript.exe \"$(ProjectDir)ModifyMsiToEnableLaunchApplication.js\" \"$(BuiltOuputPath)\"
to
cscript.exe "$(ProjectDir)ModifyMsiToEnableLaunchApplication.js" "$(BuiltOuputPath)"
Regarding the hidden checkbox bug you can edit line 54 of the script to become:
sql = "INSERT INTO `Control` (`Dialog_`, `Control`, `Type`, `X`, `Y`, `Width`, `Height`, `Attributes`, `Property`, `Text`, `Control_Next`, `Help`) VALUES ('FinishedForm', 'CheckboxLaunch', 'CheckBox', '9', '201', '343', '12', '3', 'LAUNCHAPP', '{\\VSI_MS_Sans_Serif13.0_0_0}" + checkboxText + "', 'CloseButton', '|')";
Happy coding
While after using the js, the Checkbox was shown only after i move mouse onto it, why? I'm using VC++, but I don't think it will matter.
another question, how to change to the TargetDIR to run the application? now i do it in the application initialize routine.
You can use a little-known program to create these install packages that have the the install forms built in. When you create an .SED self-extracting directive file (installer) it provides a way to choose "run the program after installing" as an option for the user.
To get this thing going you just run the Windows XP cmd line program : iexpress Just type that at your cmd line and follow the screens to create your install pkg. I actually used this program to create a self-extracting .exe that when run extracts an msi and starts installing it. Good luck.
How do I get a T4 template to generate its output on every build? As it is now, it only regenerates it when I make a change to the template.
I have found other questions similar to this:
http://stackoverflow.com/questions/1293320/t4-transformation-and-build-order-in-visual-studio (unanswered)
http://stackoverflow.com/questions/405560/how-to-get-t4-files-to-build-in-visual-studio (answers are not detailed enough [while still being plenty complicated] and don't even make total sense)
There has got to be a simpler way to do this!
I used JoelFan's answer to come up w/ this. I like it better because you don't have to remember to modify the pre-build event every time you add a new .tt file to the project.
%PATH%transform_all ..\.."transform_all.bat
@echo off
SETLOCAL ENABLEDELAYEDEXPANSION
:: set the working dir (default to current dir)
set wdir=%cd%
if not (%1)==() set wdir=%1
:: set the file extension (default to vb)
set extension=vb
if not (%2)==() set extension=%2
echo executing transform_all from %wdir%
:: create a list of all the T4 templates in the working dir
dir %wdir%\*.tt /b /s > t4list.txt
echo the following T4 templates will be transformed:
type t4list.txt
:: transform all the templates
for /f %%d in (t4list.txt) do (
set file_name=%%d
set file_name=!file_name:~0,-3!.%extension%
echo: \--^> !file_name!
TextTransform.exe -out !file_name! %%d
)
echo transformation complete
I agree with GarethJ - in VS2010 it is much easier to regenerate tt templates on each build. Oleg Sych's blog describes how to do it. In short:
</Project>That's it. Open your project. On each build all *.tt templates will be reprocessed
<!-- This line could already present in file. If it is so just skip it -->
<Import Project="$(MSBuildToolsPath)\Microsoft.CSharp.targets" />
<!-- process *.tt templates on each build -->
<PropertyGroup>
<TransformOnBuild>true</TransformOnBuild>
</PropertyGroup>
<Import Project="$(MSBuildExtensionsPath)\Microsoft\VisualStudio\TextTemplating\v10.0\Microsoft.TextTemplating.targets" />
I used MarkGr's answer and developed this solution. First, create a batch file called RunTemplate.bat in a separate tools folder above the main solution folder. The batch file just has the line:
"%CommonProgramFiles%\Microsoft Shared\TextTemplating\1.2\texttransform.exe" -out %1.cs -P %2 -P "%ProgramFiles%\Reference Assemblies\Microsoft\Framework\v3.5" %1.tt
This batch file takes 2 parameters... %1 is the path to the .tt file without the .tt extension. %2 is the path to any DLLs referred to by Assembly directives in the template.
Next, go into the Project Properties of the project containing the T4 template. Go into Build Events and add the following Pre-build event command line:
$(SolutionDir)..\..\tools\RunTemplate.bat $(ProjectDir)MyTemplate $(OutDir)
replacing MyTemplate with filename of your .tt file (i.e. MyTemplate.tt) without the .tt extension. This will have the result of expanding the template to produce MyTemplate.cs before building the project. Then the actual build will compile MyTemplate.cs
Recently found this great VS plugin, Chirpy.
Not only does it generate your T4 on a build, but it allows T4-based approach to minification of javascript, CSS, and even lets you use LESS syntax for your CSS!
Check out C:\Program Files (x86)\Common Files\Microsoft Shared\TextTemplating there is a command line transformation exe in there. Alternatively write a MSBuild task with a custom host and do the transform yourself.
If you're using Visual Studio 2010, you can use the Visual Studio Modeling and Visualization SDK: http://code.msdn.microsoft.com/vsvmsdk
This contains msbuild tasks for executing T4 templates at build time.
Have a look at Oleg's blog for more explanation: http://www.olegsych.com/2010/04/understanding-t4-msbuild-integration
Hey, my script can also parse output extension
for /r %1 %%f in (*.tt) do (
for /f "tokens=3,4 delims==, " %%a in (%%f) do (
if %%~a==extension "%CommonProgramFiles%\Microsoft Shared\TextTemplating\1.2\texttransform.exe" -out %%~pnf.%%~b -P %%~pf -P "%ProgramFiles%\Reference Assemblies\Microsoft\Framework\v3.5" %%f
)
)
echo Exit Code = %ERRORLEVEL%
Just create transform_all.bat $(SolutionDir) pre-build event, and all *.tt files in your solution will be transformed automaticaly.
I'm new to Visual C# Studio (actually using the Express edition, but another developer is using the full version), and we are using version control (svn).
It's acceptable to me to add the project files to the repository, since this repo is just for the two of us using Visual C# Studio. But it feels like there are some irrelevant files in there. Can someone familiar with Visual C# Studio project files tell me which files can safely be svn:ignored?
Some suspect files:
I'm sure the .sln is required, but what's this .suo? and the .csproj? Can/should any of these be generated by Visual C# Studio on loading a project?
Dont include
bin
obj
*.suo
*.user
_Resharper* (if you have Resharper)
Include
*.sln
*.csproj
.csproj defines the project structure. It is vital.
This is what I add to my global ignore list in Tortoise SVN:
*.suo *.user bin obj *.pdb *.cache *_svn *.svn *.suo *.user *.build-res TestResults _ReSharper*
Shouldn't be versioned:
Should be versioned:
I'm not sure about "contentproj" but it sounds like it's a project file which should be under svn.
The .sln file defines your solution together with the .proj files (one for each project), so keep them in your svn!
You can skip the .suo file (personal settings - binary anyway) as well as the bin or obj folders. Also the .cache files can be left.
Needed...
*.sln - The solution file contains references to all the projects and dependencies between the projects.
*.csproj - The project files themselves. These tell what files are included in the project, references, and the build steps for the project.
Not...
*.suo - This is a user settings file...
Just to add, anything that gets regenerated at build time, should be excluded. For example, files generated from the prebuild event or in some cases a custom tool.
We also work with Visual Studio C# and SVN and I don't know about all the project files, but we only exclude the complete bin directory.
I leave out the Visual Studio Solution User Options file (*.suo) and the binaries directories as they get recompiled everytime you build your solution (the bin and obj folders).
You definitely need csproj files... You might want to try AnkhSVN or VisualSVN, those VS addins add only the required files to SVN.
Or you could remove files from your directory structure until it does not load anymore.
I suggest experimenting this way because it is a great way to learn how a solution is structures by VS.
Does any know if there is any native mechanism to report on the total solution build time in Visual Studio 2008? You can change the build verbosity to report build times per project as discussed here or report total build time from msbuild but I?d like to see this in the IDE across an entire solution containing many projects. Short of creating custom pre and post build events, does anyone know if there?s any native output for total build time? Thanks!
Not native and not not for VS 2008 (currently only for VS 2010), but the VSCommands 2010 extension provides these statistics.
See also: VS 2010: Prevent display of Build Summary in the output window
MSBuild will show the total build time when you run it from the command prompt, e.g:
> msbuild MySolution.sln
...
Time Elapsed 00:00:36.94
For the sake of completeness, the correct answer is "No, you can't report on total solution build time directly within Visual Studio".
I think you could probably hook into the OnBuildBegin and OnBuildDone events
http://visualstudiohacks.com/general/customize-your-project-build-process/
This is also a reasonable option for VS 2008: How to measure developer build time...
I want to use the RequireHttpsAttribute to prevent unsecured HTTP requests from being sent to an action method.
C#
[RequireHttps] //apply to all actions in controller
public class SomeController
{
[RequireHttps] //apply to this action only
public ActionResult SomeAction()
{
...
}
}
VB
<RequireHttps()> _
Public Class SomeController
<RequireHttps()> _
Public Function SomeAction() As ActionResult
...
End Function
End Class
Unfortunately, ASP.NET Development Server doesn't support HTTPS.
How can I make my ASP.NET MVC application use RequireHttps when published to the production environment, but not when run on my development workstation on the ASP.NET Development Server?
This won't help if you run Release builds on your development workstation, but conditional compilation could do the job...
#if !DEBUG
[RequireHttps] //apply to all actions in controller
#endif
public class SomeController
{
//... or ...
#if !DEBUG
[RequireHttps] //apply to this action only
#endif
public ActionResult SomeAction()
{
}
}
In Visual Basic, attributes are technically part of the same line as the definition they apply to. You can't put conditional compilation statements inside a line, so you're forced to write the function declaration twice - once with the attribute, and once without. It does work, though, if you don't mind the ugliness.
#If Not Debug Then
<RequireHttps()> _
Function SomeAction() As ActionResult
#Else
Function SomeAction() As ActionResult
#End If
...
End Function
Several people have mentioned deriving from RequireHttpsAttribute without providing an example, so here's one for you. I think that this approach would be much cleaner than the conditional compilation approach, and it would be my preference in your position.
DISCLAIMER: I haven't tested this code, even a little bit, and my VB is fairly rusty. All I know is that it compiles. I wrote it based on the suggestions of spot, queen3, and Lance Fisher. If it doesn't work, it should at least convey the general idea, and give you starting point.
Public Class RemoteRequireHttpsAttribute
Inherits System.Web.Mvc.RequireHttpsAttribute
Public Overrides Sub OnAuthorization(ByVal filterContext As _
System.Web.Mvc.AuthorizationContext)
If IsNothing(filterContext) Then
Throw New ArgumentNullException("filterContext")
End If
If Not IsNothing(filterContext.HttpContext) AndAlso _
filterContext.HttpContext.Request.IsLocal Then
Return
End If
MyBase.OnAuthorization(filterContext)
End Sub
End Class
Basically, the new attribute just quits out instead of running the default SSL authorization code, if the current request is local (that is, you're accessing the site through localhost). You can use it like this:
<RemoteRequireHttps()> _
Public Class SomeController
<RemoteRequireHttps()> _
Public Function SomeAction() As ActionResult
...
End Function
End Class
Much cleaner! Provided my un-tested code actually works.
Deriving from RequireHttps is a good approach.
To side step the issue entirely, you can use IIS on your local machine with a self-signed certificate too. IIS is faster than the built-in webserver, and you have the advantage that your development environment is more like production.
How about inheriting the RequireHttps attribute in a custom attribute. Then, inside your custom attribute, check the IsLocal property of the current request to see if the request is coming from the local machine. If it is, then do not apply the base functionality. Otherwise, call the base operation.
As it was the ASP.Net Development Server that caused your problem in the first place, it's worth noting that Microsoft will soon release IIS Express. This is a cut-down version of IIS that will be as easy to use as the Development Server, but will support the full feature set of IIS 7.5 including SSL.
If anyone needs the C# version:
using System;
using System.Web.Mvc;
namespace My.Utils
{
public class MyRequireHttpsAttribute : RequireHttpsAttribute
{
public override void OnAuthorization(AuthorizationContext filterContext)
{
if (filterContext == null)
{
throw new ArgumentNullException("filterContext");
}
if (filterContext.HttpContext != null && filterContext.HttpContext.Request.IsLocal)
{
return;
}
base.OnAuthorization(filterContext);
}
}
}
`
If you can derive and override - do it. If you can't - MVC comes with sources, just take the sources and create your own [ForceHttps] attribute that checks IsLocal.
For MVC 3 I added my own FilterProvider (based on code found here: Global and Conditional Filters that, among other things (displaying Debug info for local users etc.) will decorate all actions with RequireHttpsAttribute when HttpContext.Request.IsLocal == false.
As Joel mentioned you can alter the compilation by using the #if !DEBUG directive.
I just found out that you can alter the value of the DEBUG symbol in the web.config file compilation element. Hope that helps.
Leveraging the MVC filter system and Global.asax.cs, I'm assuming you could do this...
protected void Application_Start()
{
RegisterGlobalFilters(GlobalFilters.Filters);
}
public static void RegisterGlobalFilters(GlobalFilterCollection filters)
{
filters.Add(new HandleErrorAttribute());
if(Config.IsProduction) //Some flag that you can tell if you are in your production environment.
{
filters.Add(new RequireHttpsAttribute());
}
}
I'm a longtime Visual Studio(from versions 6 to 2008) user that really like the editor and especially the debugger. Now I'm thinking of giving Linux a go, is there a IDE with similar, or better, capabilities out there?
I'm also interested in recommendations for GUI libraries, c++ or c#.
http://monodevelop.com/ would be your closest bet for an editor similar to visual studio
I would recommend Eclipse, it's quite similar to Visual studio in capabilities and can be extended with much more plugins than VS has to offer.
I'd check out Mono. You shouldn't have to change too much from what you already do.
Dont, just dont! I'm doing this now @ work since I have to and i tried, netbeans, kdevelop, eclipse. They're so basic compared to VS, especially if you're used to the more advanced features that you'll get crazy and desire visual studio back.
Eclipse is the only IDE out there supporting multiple languages which has a comparable power to Visual Studio.
If you are going to do c# development on linux I would recommend MonoDevelop. It is designed specifically for .net development (eclipse is not) and it is really quite full featured now, it includes a visual debuggers, code completion, graphical nunit integration and virtually everything else you would expect from a modern IDE. It includes some features missing from Visual Studio. I was excited just recently to discover I can right click on an interface and choose find all implementations, This is a feature not implemented in visual studio and which I find extremely helpful.
Regarding the GUI libaries, if you are using c# on linux then the best GUI framework is GTK#. MonoDevelop includes a built in graphical designer for it. Several mature and widely used linux applications use this including:
Banshee - music player
FSpot - photo manager (default in Ubuntu)
Tomboy - Notes application (default in gnome)
MonoDevelop - IDE (similar to Visual Studio)
GTK# is also cross platform and so can run on mac and windows as well. This is proved by its usage in MonoDevelop where it is used to run on linux, mac and windows.
I'm a Linux developer and I would kill (or at least maim) for a development environment approaching the sophistication of Visual Studio. But then Visual Studio doesn't support Lua or Haskell or ML, which are the major languages I use these days.
Like many others I find Eclipse too slow and lacking in functionality for languages that are not Java.
I do have two positive recommendations: for debugging C and C++ programs, the combination of valgrind (a memory debugger) and the Data Display Debugger (an interactive GUI debugger) make me about 5 times more productive in C than I used to be with just dbx or gdb.
Now I'm thinking of giving Linux a go, is there a IDE with similar, or better, capabilities out there?
I'm also interested in recommendations for GUI libraries, c++ or c#.
I only speak for C++:
Do not even bother with Eclipse or MonoDevelop for C++, try KDevelop or QtCreator. The C++ debugging will be especially painful compared to what you've been used to.
I moved from windows to linux 9 or so years ago after spending my initial career using Visual Studio.
The move was relatively easy as the build environment was first and foremost based on Makefiles. Up to this point I used scripts to create a visual studio project for the project each time there were changes.
At that time, the others in my team were using emacs. The learning curve is pretty steep when you come from something like VS, but IMHO it has been well worth the time I invested in it.
What sold me on emacs was the integration with gdb. Emacs has a mode specifically for gdb. Once this mode is started you can enable 'gdb-many-windows'. This gives you a view very similar to that of any debuger environment. Also, one of the first things that I did after moving was to setup the VS key shortcuts. So even after all this time, I have the following in my .emacs file:
(global-set-key [f7] 'compile) ;; asks for a command to run eg: make
(global-set-key [f4] 'next-error) ;; show the next error
(global-set-key [S-f4] 'previous-error) ;; show the previous error
(global-set-key [f5] 'gdb) ;; start the debugger
(add-hook 'gud-mode-hook ;; allows changes to debugger mode
'(lambda ()
(define-key (current-local-map)
[f10]
'gud-next) ;; F10 does step over
(define-key (current-local-map)
[f11]
'gud-step) ;; F11 does step into
(define-key (current-local-map)
[\S-f11]
'gud-finish) ;; Shift+F11 finish function
(define-key (current-local-map)
[f5]
'gud-cont) ;; F5 does continue.
(gdb-many-windows t))) ;; Set's up a debugger type view
If you haven't used emacs before, then the first thing you need to know is that you type: Ctrl+X Ctrl+C to exit emacs.
If you do decide to give it a go, after loading it up use Ctrl-H then 't'. This starts the emacs tutorial which will give you the basics.
Of course, if you get stuck, then just review or ask a SO question tagged with emacs. This has become a really could source of information for emacs use. I only found out about gdb-many-windows this April from this question!
monodevelop. Also #Develop is pretty nice - fast, though missing some features, and only supports C# (Mono or .NET)
I'd like to synchronize a VC++ 2010 project with a VC++ 2008 one. Is it even possible ? Basically, if I'm adding/deleting/renaming a file to a project in VS2010, I'd like it to be added/deleted/renamed to the corresponding VS2008 project. Project options synchronization would be awesome too, but not necessary. I don't need a solution-level synchronization either.
Edit: I've been suggested to "merge" the project files at check-in or build time with a script or tool. Unfortunately, VC++ project file format has changed from VS2008 to VS2010 and have nothing in common. So my question is more like: Is there a tool out there capable of merging/converting between vc9 and vc10 project files ? I might write my own tool if there is not any other way to address this.
Thanks.
The Gallio OSS project is built using VS2010 while most of the contributors still use VS2008. To keep the *.csproj files synchronized with the *.vs2010.csproj files, we use a simple PowerShell script that runs WinMerge against every pair of project files. Nothing complicated, but very handy.
You can download the script at Google Code. To run it, just type the following command:
@echo off
powershell "& './Compare VS2010 Projects.ps1' -sync %*"
I hope it helps.
At my company we had exactly the same problem and chose to use CMake.
At least try it on one of your projects, it is the ideal solution for your problem.
It allows to describe our projects with a simple syntax in text files and then CMake generates VS2005, VS2008 and VS2010 projects from the same files.
This way only the Cmake files are modified and all the projects are updated at the same time.
In short CMake is:
1. clean
2. descriptive
3. native
4. safe
Because:
1. All the options and configurations can be read in the files, not in many properties panels.
2. The CMake grammar and syntax is easy to read.
3. All the generated projects are complete and independant from CMake.
4. You can use a Source Control Manager on the CMake files.
We had some solutions of 50 projects or 20 projects and it was a lot of work, and one of the reason we used CMake was because we needed to work with Xcode on Mac on some libraries which projects are now common for VS and Xcode.
But it would have been worth it even for the different versions of VS only.
Source control helps here. I have done this before with previous versions by making an upgraded (VS2010) branch and merging changes back and forth between it and the trunk (VS2008). While certainly not seamless, it works.
I don't know if the project changes in VS2010 would make it any better or worse than before!
I believe the is a command line option to migrate a VS2008 project file to VS2010. So an option would be to only maintain the VS2008, and regenerate the VS2010 projects. The downsides are
You only can maintain those solution/project files separately. if you'll write your add-on please let me know!
I don't have 2010 installed at work so I'm going mostly from memory here. Very little has changed in the project file schema from 2005 to 2008 to 2010. For the most part I simply use a text comparison tool like WinDiff or BeyondCompare to highlight the changes and copy them from one file to the other. I haven't played with any of the web project types, but I'm assuming for the most part the same technique will work. Since their basically XML schema's you could also use an XML mapping tool to do the same job.
I did notice when I converted an open source project that 2010 really did not like ClickOnce project settings. It would convert fine, but would ask me to convert again every subsequent time I opened the project. I ended up having to completely remove the ClickOnce information from the project file in order to get it to stop.
EDIT: My experience is mostly based on the C# project schema, which hasn't changed much over time. As TheSamFrom1984 has pointed out, there are some big changes in the C++ schema that hasn't made it into the MSDN documentation on version 10 yet.
Visual Studio 2010 supports multi-targeting which will allow you to develop using VS2010 and downtarget the Platform tools to V9 so you can use the latest tools to maintain an older project. Why not just do that?
It comes with VS2010 and VS2008 for C++ out of the box, here is some info on settingup the VS2005 toolchain
I did precisely this back when VS 2008 came out and we were evaluating it while the rest of the team were using VS 2005. I didn't want to commit any of the new format project files in as that would break it for the rest of the team, so I wrote a small script in ruby that just searched for all .vcproj files and renamed them to _2008.vcproj . I did the same for the .sln files too, but also searched for the references to .vcproj in the sln files and renamed that to _2008.vcproj so that it references the new projects.
Next, just load the new solution files and let the migration wizard do its thing (I assume VS 2010 has one just like the older versions). This lets you run both versions side by side. If anyone else in the team makes any changes to the old project file then simply re-run your conversion and then the wizard should just migrate the project that changed.
There's a further tweak you may need to add to the script which is to change the OutputDirectory and IntermediateDirectory fields in the vcproj file so that you're building to different directories too. If you do that then it means that you should be able to build with either version of Visual Studio on the same source tree.
You should treat the VS2010 copy as a Branch. Every couple days and upon any major change (Pending tests pass, of course), merge changes into the other Branch. This is a widely adopted and accepted practice in Enterprise software environments.
In my admittedly somewhat short time as programmer, I have used many development environments on many platforms. Most notably, Eclipse/Linux, XCode/OSX, CLI/editor/Linux, VisualDSP/Blackfin/Windows and MSVC/Windows. (I used each one for several months)
There are neat features in pretty much all of them. But somehow, I just can't find any in MSVC. Then again, so many people really seem to like it, so I am probably missing something here. So please tell me: What is so great about Visual Studio?
Things I like:
Things I don't like
Honestly, this is not meant to be a rant. Of course I am a Mac-head and biased as hell, but I have to use MSVC on the job, so I really want to like it.
The best thing about visual studio is that it's the host application for Resharper ;)
It depends from programmer to programmer. I preferably like Visual Studio because:
(1) Development is much faster as compared to other IDEs.
(2) Intelli-Sense concept works best in Visual Studio. In some IDEs I noted that the menu opens when you pressed the . and moved ahead. And also the concept of Intelli-Sense started with Visual Studio. I am sorry for hurting if I am wrong.
(3) I use Aptana Studio for PHP development. It is a great IDE as it is built on Eclipse, but still I am able to work faster, specially while working on HTML files, using Visual Studio than in Aptana. But again, Aptana also has some very neat features.
(4) I find debugging a .NET application using Visual Studio much easier than working with other IDEs.
IMHO, Visual Studio has one of the best debuggers in the business. Much easier to use than the many graphical frontends to gdb out there.
Visual Studio is more integrated with its supported languages than anything I have ever experienced (I've been around the block--Aptana, Eclipse, Zend Studio, etc.).
Add ReSharper to the mix, and I'm in heaven.
What I like is the:
ReSharper is a plug-in which enhances these things and adds some more advanced features like large-scale refactoring, killer object discovery features, code validation against recommended standards (which you can change to fit your own needs).
After close to 10 years using and loving Visual Studio up to version 2008, I have been doing some Java development in Eclipse for a few months and I am quite surprised that, in my opinion, Eclipse is a much more advanced IDE. I just miss a lot of features when I go back to VS.
Perhaps the people that think VS is the best haven't used any other modern IDE lately.
If you are using Visual Studio for C or C++ programming, you should really look into Visual Assist X. It adds refactoring and better syntax highlighting and a few extra things.
If you are using Subversion for version-control, you should also look into VisualSVN (best) or AnkhSvn (free).
With those add-ons you might find Visual Studio more to your liking.
'Out of the box', I can write a program without having to go through all the hooplah of installing CDT (or whatever other tools). This is a real PITA for Ubuntu and not much better on windows. (The updates never seem to work right, there are always stupid package incompatibility problems, or special install steps).
The environment 'feels' natural to windows and non-clunky, and that lack of awkwardness counts a lot toward productivity. Shortcuts are common with other windows apps, window behavior is the same, etc.
VS is also not cluttered by a crapload of windows when you open a project. I'm sure that there are ways to save the perspectives in Eclipse so you don't have to do this every time, but it is an extra step.
Visual Studio isn't a great IDE at all - I discovered that when I started C# development.
With Resharper it's pretty nice, with features present in better IDEs like Eclipse andIntelliJ IDEA.
I have no idea why Microsoft doesn't just buy JetBrains and merges Resharper into Visual Studio.
I had the same question myself, since everyone seems to love Studio (and I personally think it's not even close to Eclipse's abilities).
After a lot of reading, I came to the (possibly wrong?) conclusion that: Visual Studio is great for .net languages, but Visual Studio for C/C++ is just not close to as good.
Almost everyone who speaks so highly of Visual Studio is coming from a .net background, and a lot of the wonderful things they keep talking about, I just couldn't find when working on C++.
This, btw, makes a lot of sense: the main effort of Microsoft is to push .net forward, and the tight integration with Studio makes it a very powerful IDE (the same way Eclipse is great for Java development).
Visual Studio Team System Data Base Edition - all the tools you need: code editor with designer, Source Control, Team View and , what's best - Data Base deployment!
Probably someone else already gave this answer, but:
That's it. Simple as that. Point me to one tool that can debug code as fully as VS can, and I'd marry it (yes, I'm married to VS). When you are targeting .Net, things get even better.
Which one did you use first?
From someone who has been developing since...uhm...punching holes in cards and has seen IDEs evolve I actually like using Visual Studio, but I like other ones too. I find Visual Studio is best with Microsoft specific languages such as VB or C#, and it has many of the features comparable to the points you say you like in others.
I do find that I need time to get used to a new IDE because since I use VS a lot, I'm usually looking for the VS way to do something. So maybe it's just the case of giving it time. And if you don't like it try out the customisations to change it or turn it off.
I dare say that VS introduced some ideas that other IDEs adopted and vice versa.
My top favourite thing is the intelli-sense that never seemed too obtrusive compared to other IDEs, and for C# VS 2003 seemed to get a lot clever at predicting what I wanted to type.
It certainly is not an IDE to despise.
VS is getting better from version to version, with 3rd party tools like resharper it is as good as the other tools. (sames goes to profiling.. the 3rd parties are pretty good).
basically - if you coding dot net - this is the tool, and if you're coding java - you have the others... so the real question - which framework you like better, and not which IDE....
.... and if you are only using good old c++ I think which ever tool you're used to... I used to compile c++ on borland on dos and I was happy :-)
I use both Delphi and Visual Studio. While I prefer Delphi (for a lot of reasons), there are some things that Visual Studio does better.
It's more of a .Net thing than Visual Studio, but I'm really liking ASP.Net, so I'd have to call that another win for VS.
And for bonus points, I'm also a big fan of Delphi Prism, which is hosted in Visual Studio.
So, if you're writing code for Windows, there are a lot of things to like in the Visual Studio IDE.
The debugger (I primarily use C++). I make sure my projects work in Visual Studio all along, even if my team in my job isn't supporting it, because it always saves our hide in the end. Otherwise its non-standard solution/project system is somewhat annoying.
Also, for someone accustomed to using VS, Eclipse is far too sluggish. It's like an ice hockey fan trying to become a soccer fan. It can happen, but it's not easy.
I tried using VS2010 for working on a Great Plains / eConnect project, and it kept crashing on me.
I would like to like this IDE, but I can't even use it right now. VS2010 has the featureset I need to work on the above (with the newest versions).
I like VS because it is the more responsive one (runs circles around Eclipse for instance). I'm still using 2005 though and not looking forward to the upgrade to 2010 (we skip every other release, so not 2003 and no 2008 here).
I am using Visual Studio 2008, and I was wondering if it was possible to create the .cpp files given the header files.
So if I have a .h files with a class and functions, it can create the code file with all the functions typed in with a blank body
You should check the Visual Assist X add-in for Visual Studio. It has lots of features.
You can say Project -> Add Class but that only does the basics. I don't think you can do (yet) what you are suggesting but it would be really awesome and there is no reason (that I can think of) why you cannot.
Try my AtomineerUtils addin.
It won't do an entire header, but can convert a single method's header declaration into an implementation in the related source file. It adds in the class name/namespaces as required, fills in a default implementation where possible (e.g. return(NULL)) and adds a Doxygen or DocXml doc-comment, incorporating and word-wrapping the comment from the header as the brief description if available.
I'm looking for a tool that would generate an UML diagram from a C# project or the compiled .NET dll. I've yet failed to come across any and the built-in basic class diagram generation in Visual Studio is not sufficient to my needs.
Any suggestions?
We use Modelmaker. It can work with both Delphi and C#
[http://www.modelmakertools.com/modelmaker/index.html%5D%5B1%5D
Dave Craggs
[Update] I should add that it does more than just diagrams, it can be used for reverse engineering, refactoring and the like. It's been going for a while now and has many great features.
We use Enterprise Architect it is not free but it is pretty good tool for the price. It will generate the UML diagram from the C# source code.
The combination of Graphviz and Doxygen can generate some nice class diagrams (and much more) from C# source. Both tools are free.
Here's an example:
You might want to try the code visualization and exploration tools in Visual Studio 2010 Ultimate. You can create sequence, dependency graphs, and layer diagrams from code. VS 2010 also supports UML class, sequence, component, use case, and activity diagrams. As for reverse-engineering UML diagrams, see this post on the VS Architecture & Modeling tools forum: Is it possible to reverse engineer C# code into an UML Class Diagram?
I've posted more links on my profile for more info.
The Guys at Tigris.org have also done some work on this. Open Source Link
Have you tried NDepend tool for .NET developers? It comes with both a dependency graph and a dependency matrix and integrates in VS. The graph and matrix can be generated from .NET assemblies and they are interactive.
You can download and use the free trial edition for a while and make your own opinion.
More on NDepend Dependency Graph
More on NDepend Dependency Matrix:
Disclaimer: I am part of the tool team
Anyone see this before? I have a large Visual Studio project that keeps adding [Subtype] Designer[/Subtype] to my .vcproj then removing it on the next open and close of the project. There is only one class defined in StoredImageControl.cs. Anyone know how to shut this off as it is really messing up my revision control.
This is before:
<EmbeddedResource Include="StoredImageControl.resx">
<DependentUpon>StoredImageControl.cs</DependentUpon>
</EmbeddedResource>
This is after
<EmbeddedResource Include="StoredImageControl.resx">
<DependentUpon>StoredImageControl.cs</DependentUpon>
<SubType>Designer</SubType>
</EmbeddedResource>
Do you try to put the SubType as an attibute of the EmbeddedResource object?
<EmbeddedResource Include="StoredImageControl.resx" SubType="Designer">
<DependentUpon>StoredImageControl.cs</DependentUpon>
</EmbeddedResource>
I saw a question like yours in the follow link, and he solved his problem with this.
I am encountering the same problem in my ASP.NET web application's .csproj file:
<ItemGroup>
<Content Include="site.master" />
<Content Include="Web.config">
<SubType>Designer</SubType>
</Content>
</ItemGroup>
Versus:
<ItemGroup>
<Content Include="site.master" />
<Content Include="Web.config" />
</ItemGroup>
My annoyance with this issue is due to revision control changes as well. The issue seems to be present in VS 2005/2008/2010. Have found the following question on Microsoft forums, but the answer is not clear.
I hope that a VS setting causes it, in which case, I will like you know when I find out what that setting is.
I get the same problem. I get code from shared source control that works perfectly on another computer. We're both running VS2008.
When I get the code, VS2008 decides to insert the following code into the .vbproj file:
Changing the code from this:
<Compile Include="User Controls\MultiListCombo\ObjectTypeListSelect.vb">
</Compile>
To this:
<Compile Include="User Controls\MultiListCombo\ObjectTypeListSelect.vb">
<SubType>UserControl</SubType>
</Compile>
I can't figure why my machine does this and nobody else's does...
This might be related to what files you have open in the saved solution state. I ran into this problem in VS2010 and found that if I close the solution while an .xml file was open in the editor, then on the subsequent re-open of the solution, the project containing that .xml file would get this <SubType>Designer</SubType> line added. If I close the solution without that file open, though, it does not try to add that line on the following re-open.
I realize that there have been similar questions, but they seem to have been from when Qt Creator was still in beta, so the answer might have changed since then:
We are going to start a project with a small amount of GUI that needs to work on Windows, OS X and Linux. So choosing Qt was a no-brainer, even though we have little experience with Qt.
What is currently the best option for IDE?
All the developers will be using Windows machines, so the IDE does not need to be cross-platform.
We use Visual Studio for most things, but most of us are also comfortable with Eclipse.
How are the refactoring tools in Qt Creator? I like Visual Assist X when using Visual Studio for C++. Have anyone tried using that with Qt-projects?
I realize that was a lot of different questions. Please answer even if you can't answer all of them.
EDIT:
I should probable add that we already have Visual Studio and Visual Assist licenses, so the cost of those is not an issue.
I use Visual C++ 2008 with Visual Assist and Qt Creator with MinGW:
QtCreator is a good alternative to VC++ and I would definitely use it on Linux. If you already have VC++ 2005 or 2008 and VA X, I recommend that you install the Qt addin and use VC++ for development. I also recommend that you install the Qt SDK side by side and compile in both MinGW and VC++ to catch cross-platforms issues early! Try to keep the .pro files in sync to the sln and beware of this issue.
QTCreator is still in the beginning of its dev if you are facing it with Visual Studio.
Personally I'm using QTCreator for QT devs since all QT environment (IDE, QTDesigner, QT Documentation) is embedded and I find it great but not mature for now.
But since you used to develop with Visual Studio (with the Visual Assist X add-in) you should continue using it. In addition new QT binaries have been released for Visual Studio 2008. So no need to compile QT before using it!
Edit (Oct 5) : Next QtCreator release 1.3 will have an improved completion system at least as good as Visual Assist X : http://www.youtube.com/watch?v=TyfO-7lvy%5Fc&feature=player%5Fembedded.
Use QtCreator, but learn key all shortcuts first.
I'm 30% faster (veeeery subjective:-) since I switched, and I tried every IDE and editor there is for several days to several years. I'm fed up with visual-something and even eclipse, my long-time favorite.
First I thought 'another ide, what a waste of these developers' time', but after some days I used Qt creator even for non-Qt C++ development.
This IDE helps you to focus on your work, hides all distraction and lets you jump instead of search. (So, no class browser desired)
I own Visual Studio 2005 and the wonderful add-on "Visual Assist X" (VAX I call it), but am pleased with using Qt Creator. Things get way better with Qt Creator 1.3, and I hope 1.4 adds a class browser, which is its worst weakness. But I am continually amazed by how good Qt Creator is, and how clear a vision its developers have. Amazed, I Say! It is as though all the VS competitors laid down and died and now Qt Creator is all that stands to truly develop a C++-Centric IDE. I always hated how VS watered itself down to adapt to every language, to the point that later versions downplayed the MFC wizards (yuck, but hey, I needed them back then). Eclipse is based on Java. I love using an IDE build with Qt and made for Qt. So go Qt Creator and don't look back. At first I was a bit wary that Qt Creator might be another "dies on the vine" type of project, but after the last two releases and the coming v1.3 I see that it is going to be the new kid on the block -- if only it gets that class browser!
I was confronted with the same problem not so long ago. I chose QtCreator in the end, because it really grew stable over the past few months.
It's just so much easier to have all your tools within one environment. The debugging facilities are also quite extensive and integrate well with the Qt framework. Code completion is almost as good as in Visual Studio (as long as you don't own Visual Assist ;-), and the code navigation is very easy to use!
That together with the fact that QtCreator works on all three major platforms made the difference for me in the end.
I think when starting a new project, QtCreator has become a serious alternative to consider...
Another possibility is using Netbeans. Have a look at this
Netbeans provides great tools about memory and profiling for free. Morevover, the integration with Qt is nice.
I've never used the Qt visual studio integration, and I've only taken a quick look at qt creator, but here are my thoughts anyway.
Using Qt creator gives you a familiar debugging enviroment across platforms, with support for stuff like Qt collections.
It seems like Qt creator has really good code navigation features. It also integrates with git, subversion and perforce. When starting a new project, that seems like a plus compared to VS.
QtCreator is stable enough and a comfortable IDE, although compile/debug cycles are slower on Windows than with Visual Studio. It doesn't have all the fancy features Visual Studio offers, but after using it for a while I just realized I wasn't missing them. Especially in C++, where Visual Studio doesn't provide source refactoring - they really are pushing C# aren't they? ;)
Visual Studio is certainly a nice IDE, but at the end of the day if you have to pay many licences just for the fancy features (depending on the size of your team), that money could be better spent on other tools.
You will also avoid the trouble of maintaining different project files (Visual Studio on Windows, something else on MacOS and Linux), even if you develop on Windows only, time will come when you will have to compile, test and debug minor issues on the other OS'es.
Eclipse is an alternative, but I haven't checked the stability of Designer on that IDE. You might spend some time on configuring each workstation, and you might have to wait for updates. On the other hand, you benefit from the whole Eclipse environment, which could help if you have other needs. But is that worth the risk?
I would definitely try QtCreator first and try to stick with their environment. If that proves to be a problem, it won't be too late to move to VS later.
Your timing isn't too bad either: you should probably test the 4.6 preview, normally the official release should be soon.
Hit CTRL+K in QtCreator.
Have you considered a third option, MonoDevelop?
I have found it to be fairly quick, it has rudimentary refactoring support and it plays nice with QT.
Kindness,
Dan
I would recommend to at least try QtCreator. Obviously for someone used to Visual Studio the transition won't be overnight but in the end I believe it'll be worth it.
Main reason is although you mention all developers will be using Windows, eventually you will have to run the program on other platforms during testing. And then it's hard to imagine you won't need to debug and fix things. You can do just fine with gdb/vim but for someone who's used to a debugger/editor experience that Visual Studio delivers, getting used to gdb/vim can take some time. QtCreator isn't perfect in this area, but it's as close as it gets to Visual Studio.
A few other points worth mentioning:
qtcreator with ccache and make -j 5 make compile time cut down to almost unnoticeable.
I'm using Visual Studio 2008, C#. I try to use edit-and-continue (edit the code while debugging), and get this exception:
"Changes to 64-bit applications are not allowed"
Why is that? Is there a workaround?
Edit and Continue is not supported on 64 bit applications at the CLR level so there is no way for Visual Studio to implement it either.
The easiest way to work around this problem is to target your application to x86 chips. This will cause it to run in Wow64 mode as a 32 bit process and hence be able to ENC. You can do this by doing the following
Like jcopenha said there's no edit-and-continue on x64 yet. Current version of the 64bit CLR does not support it. However, there's a work around.
You can find it on Bug Babble post.
Hope it helps.
the edit-and-continue feature simply hasn't been implemented in x64 yet. I haven't heard any updates on when they plan to do it yet.
see also http://stackoverflow.com/questions/955922/why-doesnt-edit-and-continue-work-on-the-x64-clr
Read here
http://social.msdn.microsoft.com/forums/en-US/csharpide/thread/479e8c54-5508-4f1d-9c2a-051d4d940424/
I'm a solo developer running Visual Studio 2008 and looking into MSBuild to improve my build process.
Almost all of the tutorials I've found so far have plenty of information about writing a build file. However I'm having a lot of trouble finding out how to integrate MSBuild into Visual Studio. Maybe MSBuild is only used with something like CruiseControl but that's overkill for me as a single developer.
Where should the build file live in a Visual Studio project and how can I run it from within the IDE?
Visual Studio executes MSBuild automatically for projects it supports.
If you right click on a project and unload it, you can then edit it in Visual Studio. Reload (right click on project again), force a (re)build to test your changes.
Sounds like you're on the right track, and if you are considering writing Targets or custom MSBuild Tasks, take the time to separate them from your current project so that you can re-use them. Don't re-invent the wheel though, the two main complementary MSBuild projects are MSBuild Community Tasks and MSBuild Extension Pack.
Update: Judging from your comment on Mitch's answer, you might also want to consider adding a new Configuration element or custom properties to a project. A new MSBuild Configuration (something other than the default Debug/Release) could run unit tests, build documentation, or whatever you want automated. A custom MSBuild property would allow you to use normal Debug/Release Configuration and extend it to automate more of your build process, just depends on what you want. Either approach could also be driven from the command line.
As others have noted, MSBuild is already available when you install Visual Studio.
If you want to integrate into VS2008: Running MSBuild from Visual Studio
Your .csproj file is a MSBuild file. So you are actually using it already.
You may of course wish to create a separate build file to have more control, especially within a continuous integration or nightly build say.
If you simply wish to edit your project build file then you can use the IDE to edit some settings such as pre and post build actions or edit the Xml itself by unloading project and right click and editing.
MSBuild is the build engine used by Visual Studio to process the files included in a project.
The Visual Studio project files themselves (*.csproj for C#, and .vbproj for VB, for example) are in fact MSBuild scripts that are run every time you build a project.
You can use your current .vcproj files to build your project with MSBuild. However, as MSBuild is not directly supported (at least for vc++) vcbuild is used instead (internally). In VS2010 all project files are MSBuild based...
This is an older article about some simple extension points from the msbuild team
How To: Insert Custom Process at Specific Points During Build
Also, don't forget you can use the MSBuild SideKick for developing and debugging your (local) msbuilds, available for free at http://www.attrice.info/msbuild/
I'd suggest you call msbuild as a post build step. Then you can put your build script somewhere in your solution and call it.
<windowsdir>\Microsoft.NET\Framework\v3.5\MSBuild.exe c:\temp\MyProject\mybuildfile.proj
The easiest way is probably to invoke your custom build script using a post-build step. Right click project, choose "Build Events" and call msbuild with your custom msbuild file from there.
I use the msbuild template to intergrate with visual studio
Env.: VS2008 C# project
Hi,
I need to build my app for use in 2 different environments. In one of those environments, I need to use a 3rd party DLL assembly.
I could isolate the code that uses this DLL using #if blocks. But how do I conditionally include the reference to the DLL in the CS project file?
Edit: womp has a good point in his comment. I turned into a separate question: Will the referenced DLL be loaded at all if it's never called? TIA,
Serge.
Unload the project and open it as .XML
Locate the reference item tag and add a Condition attribute.
For instance:
<ItemGroup>
<Reference Include="System.Core">
<RequiredTargetFramework>3.5</RequiredTargetFramework>
</Reference>
<Reference Include="System.Data" />
<Reference Include="System.Drawing" />
<Reference Include="System.Xml" />
<Reference Include="MyUtilities.Debug"
Condition=="'$(Configuration)'=='Debug'"/>
</ItemGroup>
Notice the last reference now has a condition.
The following, in the csproj file references itemgroup works in vs 2008 for me:-
<Reference Include="DRLClasses, Version=1.0.0.0, Culture=neutral, processorArchitecture=MSIL" Condition=" '$(Configuration)' == 'Debug' ">
<SpecificVersion>False</SpecificVersion>
<HintPath>..\..\..\..\Visual Studio User Library\Debug\DRLClasses.dll</HintPath>
</Reference>
<Reference Include="DRLClasses, Version=1.0.0.0, Culture=neutral, processorArchitecture=MSIL" Condition=" '$(Configuration)' == 'Release' ">
<SpecificVersion>False</SpecificVersion>
<HintPath>..\..\..\..\Visual Studio User Library\Release\DRLClasses.dll</HintPath>
</Reference>
I have a fluent interface for an IoC container registration process, and this contains some classes that are used to build up the registrations.
For instance, I can do this:
builder.Register<IFoo>().From.ConcreteType<Foo>();
However, at each step after a dot, intellisense pops up showing the four standard methods from the Object class, GetHashCode, Equals, GetType, and ToString.
I tried overriding these methods in a couple of the classes, attaching the EditorBrowsableAttribute attribute to each, but they still show up. Is there no way for me to hide them?
Note that I'm not trying to hide them from the class itself, just from intellisense.
Basically, I'd like this:
+---------------+
builder.Register<IFoo>().|As |
|By |
|Equals | <-- remove this
|From |
|GetHashCode | <-- and this
|GetType | <-- as well as this
|ToString | <-- and finally this
+---------------+
Here's what I tried in the class that is returned from Register<T>:
[EditorBrowsable(EditorBrowsableState.Never)]
public override Boolean Equals(Object obj)
{
return base.Equals(obj);
}
[EditorBrowsable(EditorBrowsableState.Never)]
public override Int32 GetHashCode()
{
return base.GetHashCode();
}
[EditorBrowsable(EditorBrowsableState.Never)]
public override String ToString()
{
return base.ToString();
}
This clearly did not work. Is there anything else I can try?
I also tried adding a new method, not overridden from Object, and applying the same attribute to that, and that too shows up, so clearly the attribute is not doing what I thought it would do.
I noticed the note in the documentation about not hiding things from the same assembly, but I tried creating a new project and they still show up there.
According to thread, it is by design. The methods/properties decorated with EditorBrowsable(EditorBrowsableState.Never) are only hidden from intellisense if they're part of a class that is in another referenced assembly. The assembly should not be part of the same solution.
Ok, I found the solution, it was partly my fault, and partly incomplete documentation.
My fault was that I had not tagged all the methods in the correct class, but even when correcting that, the methods still showed up.
Turns out the note in the documentation, which reads:
In Visual C#, EditorBrowsableAttribute does not suppress members from a class in the same assembly.
Should actually be (emphasis mine):
In Visual C#, EditorBrowsableAttribute does not suppress members from a class in the same open solution.
I tagged the methods in the appropriate class, did a full rebuild, created a new project outside of the solution file, made file references to the compiled files from my IoC project, and lo and behold, the methods disappeared.
I'll leave the question up in case someone else has this problem.
In Visual Studio there is a way to have a file in another project that is a shortcut to the first so that it builds in both. How do I do that?
Right-click the project, select Add > Existing Item, and in the dialog drop down the Add button and select Add As Link.
Are you talking about a solution with multiple projects? In that case answer would be using Project Dependencies (within Project menu).
I'm considering migrating from Subversion to Git at work, and would like to get opinions about the best way to set up Git on Windows, and any problems that might arise from the combination of Visual Studio and Git.
The current setup is TortoiseSVN, with Visual Studio 2008 and AnkhSVN for .NET applications. The replacement would probably be Git Extensions.
Advice on repository layouts would be particularly appreciated. All of our solutions use multiple projects, and we now have a number of custom assemblies that we will need to share between applications. The current layout of our Subversion repositories definitely isn't optimal.
UPDATE: I've now migrated to Git using Git Extensions, and it's working very well. Shared code and assets live in separate repositories and are used as submodules. I found submodules slightly confusing when I started, and this post was very helpful.
The main Git installer for Windows is msysgit (SO question).
TortoiseGit is also a nice Windows integration (on top of msysgit).
You need to be aware of Git limits, particularly in term of Git repository (do not try to stuff every projects into one repo, unless you are building a "system", i.e. something which can only run with all its parts/components.)
External code dependencies are best represented with submodules.
Same thing for vendor branches.
We have a solution containing 9 projects & we're using git extensions (having come from the svn stack).
Three of the projects are shared with other solutions and we've used sub modules to reference them.
This just about works but the interface to it is very confusing. Going forward we're thinking of removing the sub modules and just referencing the dlls instead.
I'm using msysgit, it's pretty nice =)
For the Git Extensions, I don't like much, since I'm more comfortable with command line commands... But the "File History" feature of Git Extensions is awesome
As in the title. Is it possible? When I rightclick on Visual Studio in a Taskbar I have a "Recent" category there i have but 1 .cs file that I can pin.
Now the question is: what to do to pin a .sln solution there?
I posted a workaround here http://einsteintech.spaces.live.com/Blog/cns!89E05724AF67A39E!744.entry?wa=wsignin1.0&sa=632924437
If you pin the VSLauncher.exe to the taskbar (drag it in) you will get recent projects and solutions on the right click menu.
You can find this exe in your program files / common files directory. Mine is in
C:\Program Files\Common Files\Microsoft Shared\MSENV\VSLauncher.exe
You can also do this by dragging a solution into the task bar (which does the same as the above). If you do this rightclicking it will show recent projects and solutions.
Hope this helps.
The VSLauncher.exe needs a solution or project path to do anything usefull. In the right click of the taskbar item you can right click the microsoft version selector and click properties. There you will then be able to give it a path by editing the target field. This will stop you getting the error.
This is all based on adding one solution to the task bar as per your question. I did not find a way of adding more than one!
Hope this helps.
This is for Visual C++ 2008 Express Edition. You may adapt for other editions.
reg add HKCR\.sln\OpenWithProgids /v VCExpress.dsw.9.0
Every time i build, or publish, a web-site, Visual Studio attempts to check out the web.config file so that it can add numerous assemblies that are not required.
In other words:
web.config before:
<configuration>
<system.web>
<compilation>
<assemblies>
</assemblies>
</compilation>
</system.web>
</configuration>
web.config after:
<configuration>
<system.web>
<compilation>
<assemblies>
<add assembly="Microsoft.ReportViewer.Common... />
<add assembly="Microsoft.ReportViewer.WinForms... />
<add assembly="System.DirectoryServices... />
<add assembly="System.Windows.Forms... />
<add assembly="ADODB... />
<add assembly="System.Management... />
<add assembly="System.Data.OracleClient... />
<add assembly="Microsoft.Build.Utilities... />
<add assembly="Microsoft.ReportViewer.ProcessingObjectModel... />
<add assembly="System.Design... />
<add assembly="Microsoft.Build.Framework... />
</assemblies>
</compilation>
</system.web>
</configuration>
None of these assemblies are required, and most don't exist on the target test, or production, servers.
i keep deleting them every time i build, but it's getting real annoying real fast.
Right now my workaround is to leave web.config read-only - so Visual Studio cannot add assemblies to it.
Screenshots as proof:
Project Property Pages before:
Web.Config before:
Project Property Pages after:
Web.config after:
It should be pointed out explicitly that the web-site works without these extraneous references being added. My interim solution is to keep web.config read-only, and hit Cancel whenever Visual Studio complains that it's read-only as it tries to modify it. If i can just stop Visual Studio from trying to modify it in the first place...
It looks like it's not possible. Someone can feel free to give the correct answer, "You cannot stop Visual Studio from adding assemblies to your web.config." and i'll mark it.
The only reason i'm keeping the question up is that hopefully someone knows the super-secret option, or registry key, or project or solution setting, to tell Visual Studio to stop thinking.
i didn't accept the accepted answer, and i'd unaccept it if i could. i'm still hoping for the panacea. But right now i'm leaning towards:
How do i stop Visual Studio from adding assemblies to my web.config?
Maybe the "Avatar DotNet Library" is referencing those assemblies by itself. The references of a referenced assembly are needed to correctly deploy a project. Otherwise, how could the referenced assembly work?
Note that it's possible that your referenced assembly does not use its own references, although they exists.
Edit: You can use the great tool ".Net Reflector" to check this.
I had this problem with Visual Studio 2005 (but I'm happy to report that the solution works for VS 2008, see bolded text below). There is a registry section that VS checks before it adds assemblies to the web.config file.
Here is the key:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\VisualStudio\8.0\Projects\{E24C65DC-7377-472B-9ABA-BC803B73C61A}\FilteredGACReferences
So, let's say you don't want Visual Studio to add the Microsoft.VisualStudio.Designer.Interfaces assembly to your web.config. Add the following entry to your registry and you are set.
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\VisualStudio\8.0\Projects\{E24C65DC-7377-472B-9ABA-BC803B73C61A}\FilteredGACReferences\Microsoft.VisualStudio.Designer.Interfaces
It worked perfectly for me. And yes, the rest of your team will have to do the same, but at least you don't have to manually remove the entries every time :)
To make it work for VS 2008 - just change the 8.0 in the registry path to 9.0
Convert you "Web Site" project to a "Web Application" project.
A "Web Site" does not have a project file, so it contains all assembly references in the web.config. A "Web Project" has a project file, and all references are stored in the project file.
Remove the References.
If it is a web app: you can see the References under Solution Explorer.
If it's a website: right-click the project on Solution Explorer then select Property Pages. Manage them there.
HTH
If a shared assembly references them, then they will be added to the calling project as well.
Since the Avatar library makes these other references, Visual Studio adds these references to the main project as well. Otherwise, a call into the Avatar library could fail since the reference it needs is missing.
Sorry, you cannot stop Visual Studio from adding assemblies to your web.config, but all is not lost.
I have hit this in the past; someone had added some references (including WinForms) to a low level data access assembly. The web-site used the low level data access assembly and therefore had WinForms etc added to the web.config file.
The solution was to move his code into the correct assembly and remove the incorrect reference.
If you can not sort how the assembly that has the unwanted references and you know you are not calling code that depends on the unwanted references. Then you can (none of these are nice)
It can take ages to find how why Visual Studio is adding a reference to the web.config file. You have to hand-check EVERY assembly that is used directly or indirection by the web site.
I know and appreciate why Microsoft invented Web Sites in ASP.NET 2.0, but sometimes they just plain suck. If it is practical for you, convert your site to a Web Application Project, and problems like this will go away.
If that is not practical for you, try to re-factor as much code as possible into a separate class library project. Any references you can move out of the web site and into the class library will cut down on web.config changes.
EDIT: To clarify, in a Web Site, the aspnet compiler compiles everything (markup, code-behind, the lot), so all assembly references must go into web.config. However, in a Web Application Project, the C# or VB compiler compiles the code-behind files into a separate DLL, which is then referenced by the aspnet compiler when it compiles the markup. In this scenario, assemblies that are only referenced in code-behind files will go into the code-behind DLL and not touch web.config at all. Only assemblies that are directly referenced in markup will go into web.config.
Well this might seem like a hack but given your requirements another option would be to load the Avatar assembly dynamically using Assembly.Load or LoadFrom at runtime. This would keep a reference out of the main project and should then prevent the extra reference lines in the web.config. This would only really be practical though if you were only using a small number of classes from the Avatar project. I would make a third project that both projects referenced that held interfaces that one or more Avatar classes implemented in order for the main project to maintain strict typing when handling Avatar instances. I admit this could be a lot more work that previously submitted answers. If your interested in this method search google for creating plugins in .Net
As long as you are using a website, rather than a webapp, I don't know of any way to stop Visual Studio from adding assemblies to your web.config. This same problem of sorts happens for my company's solutions as well.
You cannot stop Visual Studio from adding assemblies to your web.config.
I don't believe you can prevent Visual Studio from automatically adding references to assemblies that are referenced by others.
One solution is to create a Web Setup project with a custom action that automates the removal of these unwanted assembly references from the web.config.
Those are all the assemblies required by your project, in some shape or manor and the aid the compilation that ASP.NET does on your pages at runtime. They are probably being imported in by either by code you are using in your project or another library that is using them.
But according to the documentation. These are the assemblies defined in your global web.config which can be found in C:\Windows\Microsoft.NET\Framework\v2.0.50727\CONFIG:
<assemblies>
<add assembly="mscorlib" />
<add assembly="System, ..." />
<add assembly="System.Configuration, ..." />
<add assembly="System.Web, ..." />
<add assembly="System.Data, ..." />
<add assembly="System.Web.Services, ..." />
<add assembly="System.Xml, ..." />
<add assembly="System.Drawing, ..." />
<add assembly="System.EnterpriseServices, ..." />
<add assembly="System.Web.Mobile, ..." />
<add assembly="*" />
</assemblies>
If you look there is an assembly="*" reference being added. And if you read the documentation about this command it says:
Optionally, you can specify the asterisk (*) wildcard character to add every assembly within the private assembly cache for the application, which is located either in the \bin subdirectory of an application or in the.NET Framework installation directory (%systemroot%\Microsoft.NET\Framework\version).
This means that any assembly in your /bin directory or in the .NET Framework installation directory is going to be included already.
What this tells me about your problem is that those assemblies that are being included are already referenced in some way to your project. And they are probably coming from the Avatar Dot Net Library or some controls on your page. Check the "References" folder in your Visual Studio project on the Avatar Library for these references you don't want. Because that is where the build process gets these libraries from.
So in other words if you don't want them to be included scrub your referenced projects of all references of these libraries.
Alternatively you can use a MSBuild XML parser to drop that section of the web.config each time you run your build process. Personally I use a task called XmlUpdate to modify certain parts of my web.config to get it production ready. If you would like to do the same it is part of the MSBuild Community Tasks.
If you are running on a vista or server 08 machine, you can use the appcmd command line utility to remove it after rebuilding rather than manually removing it.
http://technet.microsoft.com/en-us/library/cc772200(WS.10).aspx http://learn.iis.net/page.aspx/114/getting-started-with-appcmdexe/
see http://msdn.microsoft.com/en-us/library/ms178728.aspx
there it's explained that what you see in Property Page is not all, implicit references exist also in Machine.config file and are added at compile time. Hope this helps.
I would start by checking the "using" statments in your code files as well as any references in your .aspx, .ascx files. It sounds like you've referenced some of these (I know some are added by default from the Add New Item templates.
Can you use Visual Studio for Android Development?
If so how would you set the android SDK instead of .NET framework and are there any special settings or configuration?
Yes you can:
http://www.gavpugh.com/2011/02/04/vs-android-developing-for-android-in-visual-studio/
In case you get "Unable to locate tools.jar. Expected to find it in C:\Program Files (x86)\Java\jre6\lib\tools.jar" you can add an environment variable JAVA_HOME that points to your Java JDK path, for example c:\sdks\glassfish3\jdk (restart MSVC afterwards)
An even better solution is using WinGDB Mobile Edition in Visual Studio: it lets you create and debug Android projects all inside Visual Studio:
http://ian-ni-lewis.blogspot.com/2011/01/its-like-coming-home-again.html
Download WinGDC for Android from http://www.wingdb.com/wgMobileEdition.htm
From the Android documentation:
The recommended way to develop an Android application is to use Eclipse with the ADT plugin... However, if you'd rather develop your application in another IDE, such as IntelliJ, or in a basic editor, such as Emacs, you can do that instead.
Currently, there are plug-ins for IntelliJ IDEA and NetBeans, but you can still use the tools in /tools to build, debug, monitor, measure and start the emulator.
Believe me, I've tried so hard to find a decent IDE for Android developement but I failed. I used Visual Studio for many years, and it is so hard for me to get use to the way Eclipse doing things.
However, the new IntelliJ supports for Android development, it's the closest you can get.
I completely agree. I am a native to developing in VS, and moving to an IDE like Eclipse is a hard step, but im learning its a necessary one. I have reasons for wanting to us VS to do my development, but not because im delusional enough to think that its superior. Yes, in most cases, it does alot of the miniscule stuff for you, plugins arent hard to setup, and if your already used to how to use it, its nice. So, having VS as an IDE for Android would be great, but im not saying its better by any means. Now, if anyone knows how to get VS to develop for Java, please reply and let me know.
Besides, you can use VS for Android development too, because in the end, the IDE is nothing but a fancy text editor with shortcuts to command line tools, so most popular IDE's can be used.
However, if you want to develop fully native without restrictions, you'll have all kinds of issues, such as those related to file system case insensitivity and missing libraries on Windows platform..
If you try to build windows mobile apps on Linux platform, you'll have bigger problems than other way around, but still makes most sense to use Linux with Eclipse for Android OS.
I suppose you can open Java files in Visual Studio and just use the command line tools directly. I don't think you'd get syntax highlighting or autocompletion though.
Eclipse is really not all that different from Visual Studio, and there are a lot of tools that are designed to make Android development more comfortable that work from within Eclipse.
I have a unit test called TestMakeAValidCall(). It tests my phone app making a valid call.
I am about to write another test called TestShowCallMessage() that needs to have a valid call made for the test. Is it bad form to just call TestMakeAValidCall() in that test?
For reference this is my TestMakeAValidCall() test.
[TestMethod]
public void TestMakeAValidCall()
{
//Arrange
phone.InCall = false;
phone.CurrentNumber = "";
// Stub the call to the database
data.Expect(x => x.GetWhiteListData()).
Return(FillTestObjects.GetSingleEntryWhiteList());
// Get some bogus data
string phoneNumber = FillTestObjects.GetSingleEntryWhiteList().
First().PhoneNumber;
// Stub th call to MakeCall() so that it looks as if a call was made.
phone.Expect(x => x.MakeCall(phoneNumber)).
WhenCalled(invocation =>
{
phone.CurrentNumber = phoneNumber;
phone.InCall = true;
});
//Act
// Select the phone number
deviceControlForm.SelectedNumber = phoneNumber;
// Press the call button to make a call.
deviceMediator.CallButtonPressed();
//Assert
Assert.IsTrue(phone.InCall);
Assert.IsTrue(phone.CurrentNumber == phoneNumber);
}
Refactor the setup to another method and call that method from both tests. Tests should not call other tests.
IMHO, you should do one of the following:
I think its a bad idea. You want your unit test to test one thing and one thing only. Instead of creating a call through your other test, mock out a call and pass it in as an argument.
A unit test should test one unit/function of your code by definition. Having it call other unit tests makes it test more than one unit. I break it up in to individual tests.
Yes - unit tests should be separate and should aim to test only one thing (or at least a small number of closely-related things). As an aside, the calls to data.Expect and phone.Expect in your test method are creating expectations rather than stub calls, which can make your tests brittle if you refactor...
To offer a counter point:
I strongly believe that well designed unit test should depend on one another!
Of course, that makes sense only if the testing framework is aware of these dependencies such that it can stop running dependent test when a dependency fails. Even better, such a framework can pass the fixture from test to test, such that can build upon a growing and extending fixture instead of rebuilding it from scratch for each single test. Of course, caching is done to take care no side-effects are introduced when more than one test depends from the same example.
We implemented this idea in the JExample extension for JUnit. There is no C# port yet, though there are ports for Ruby and Smalltalk and ... the most recent release of PHPUnit picked up both our ideas: dependencies and fixture reuse.
Is there a way to skip code without having to set a breakpoint after it? I am using the debugging to explore code with a GUI painting event that runs lots of times. I wish to see what comes after the event is done triggering without having to click next a bunch of times.
[DebuggerHidden]
When this attribute is attached to a constructor/method/property or indexer then that code is hidden from the debugger, it will not be possible for you to step into the code, the debugger will just skip over the code. Even if you set a breakpoint inside one of the pieces of code decorated with this attribute, the debugger will ignore it.
[DebuggerStepThrough]
This attribute is the same as the DebuggerHiddenAttribute, apart from the fact that you can set a breakpoint inside the code which has been decorated with the DebuggerStepThroughAttribute, and the debugger will stop at the breakpoint.
[DebuggerNonUserCode]
This attributes marks a section of code as not being user code, you can then use this with the Tools->Options->Debugging->General->Enable Just My Code, option to tell the debugger not to step into the decorated code.
You can specify a breakpoint condition (right click on the breakpoint red circle icon) so that the breakpoint stops the execution only when something interesting happens.
Here's another handy one: If you are currently stopped on a break point, and you just want to run to some other point in the code, you can right-click on the line that you wish to run to and select "Run to Cursor".
If you want to execute the code after the breakpoint, up to another line, use JMarsch's "Run to Cursor" suggestion.
If you want to SKIP the following lines, and resume execution at another point, you can use your mouse to drag the yellow arrow in the left margin of the code window - down to the line you want to execute next.
This is also useful if you want to re-execute some code that's already run - just drag the yellow arrow UP to that line. I often use this to "Step Into" code that I've already done a "Step Over" on.
"Set Next Statement" in the right-click menu has the same effect.
-Tom Bushell
My solution contains multiple projects which can be started. SometimesI would like to start a single project without using my solution startup projects settings. When I right-click on the project, I can navigate to Debug->Start New Instance, which starts the application with debugger.
But I would like to start a new instance without debugger. Is this possible?
Best Regards
If you are interested in permanent solution then I have written a small macro for this task. It does following things :
Below is the Macro that I have written and the procedure how to do it.
How to write Macro : First thing you need to go to Visual Studio Tools --> Macros --> Macro Explorer. Once you got that right click on MyMacros and create a new module (I called it CollapseAll).
Now edit the new module (double-click on it) erase whatever is in there and paste this stuff into it.
Sub RunSelectedWithoutDebug()
Dim Projs As Array
Dim Proj As Project
Projs = DTE.ActiveSolutionProjects()
If (Projs.Length > 0) Then
Proj = Projs.GetValue(0)
Dim Prop As EnvDTE.Property
Prop = DTE.Solution.Properties.Item("StartupProject")
Dim PrevStartup As Object
PrevStartup = Prop.Value
Prop.Value = Proj.Name
DTE.ExecuteCommand("Debug.StartWithoutDebugging")
Prop.Value = PrevStartup
End If
End Sub
How to bind macro to keyboard shortcut : To do this you need to go to Tools-->Options-->Environment-->Keyboard. Pick your macro from the listBox with all the default VS stuff (remember it will be there like MyMacros.Module1.RunSelectedWithoutDebug) and then assign a hotkey combination or chord to it and save.
Note : Fourth step is creating a problem and spawns an annoying messagebox saying : The build must be stopped to change the solution property. Stop the build? Ok or Cancel. I used to hit Ok for the timebeing. If you dont have any problem if the macro sets up current selected project as Startup project than please comment last line of macro Prop.Value = PrevStartup by putting ' at the start of line.Now the messagebox will not come.
I am looking into it and will post the updated macro once i solve it ( if I can :) )
I just put together this macro.. It's a combination of several snippets I found around the interweb. If the project is configured to run the default project output, it will find and run that. If it's configured to run a specific program, it will run that. This macro will NOT compile your application either, so you'll want to make sure it's compiled before you run the macro. At the same time, this macro doesn't suffer from the problem mentioned in Mahin's macro above.
Sub RunActiveProjectOutput()
Dim Projs As Array
Dim Proj As Project
Projs = DTE.ActiveSolutionProjects()
If (Projs.Length > 0) Then
Proj = Projs.GetValue(0)
Dim action = DirectCast(Proj.ConfigurationManager.ActiveConfiguration.Properties.Item("StartAction").Value, Integer)
If (action = 1) Then
Dim app = Proj.ConfigurationManager.ActiveConfiguration.Properties.Item("StartProgram").Value
Dim args = Proj.ConfigurationManager.ActiveConfiguration.Properties.Item("StartArguments").Value
System.Diagnostics.Process.Start(app, args)
Else
Dim fullPath = Proj.Properties.Item("FullPath").Value.ToString()
Dim outputPath = Proj.ConfigurationManager.ActiveConfiguration.Properties.Item("OutputPath").Value.ToString()
Dim outputDir = System.IO.Path.Combine(fullPath, outputPath)
Dim outputFileName = Proj.Properties.Item("OutputFileName").Value.ToString()
Dim assemblyPath = System.IO.Path.Combine(outputDir, outputFileName)
System.Diagnostics.Process.Start(assemblyPath)
End If
End If
End Sub
Use
Start without debugging
under Debug menu
or
Ctrl F5
or
you can modify the web.config file for the project
<compilation debug="false"/>
Set As a startup project and press Ctrl+F5 or from the Menu option choose, Debug Menu + Start Without debugging.
Right-Click on the project and Set it as Startup Project.
Hit Ctrl + F5
I usually start the executable directly. If i need one solution without debugging mode a lot i usually add them to a quick launch menu somewhere on my taskbar.
Here is the the way to solve problem related to Mahin's macro
Problem description: Fourth step is creating a problem and spawns an annoying messagebox saying : The build must be stopped to change the solution property. Stop the build? Ok or Cancel.
Public Module Custom
Private WithEvents t As Timers.Timer
Private Prop As EnvDTE.Property
Private PrevStartup As Object
Private Sub StartTimer()
t = New Timers.Timer
t.Interval = 0.05
t.Start()
End Sub
Sub t_Elapsed(ByVal ee As Object, ByVal dd As Timers.ElapsedEventArgs) Handles t.Elapsed
If DTE.Solution.SolutionBuild.BuildState <> vsBuildState.vsBuildStateInProgress Then
t.Stop()
Prop.Value = PrevStartup
End If
End Sub
Sub RunSelectedWithoutDebug()
Dim Projs As Array
Dim Proj As Project
Projs = DTE.ActiveSolutionProjects()
If (Projs.Length > 0) Then
Proj = Projs.GetValue(0)
Prop = DTE.Solution.Properties.Item("StartupProject")
PrevStartup = Prop.Value
Prop.Value = Proj.Name
DTE.ExecuteCommand("Debug.StartWithoutDebugging")
StartTimer()
End If
End Sub
End Module
Enjoy !
In short no.
What you could do is bind a key to the "Set as startup project" and then bind another key to start without debugging. Then you would have to push 2 keys to start this project without debugging, but at least it'd be quicker than using the mouse...
I've been trying to do the same thing. It seems like an oversight by the VS team that you can start with or without debug at the solution level, but only with debug at the project level.
One thing that I've noticed is that if you right-click on a toolbar and choose "Customize", in the popup window of actions, go to Category "Project". In there, there is a command for "Run" and "Run Selected". Interesting, I added both to my project context menu, and to the main button bar, and the items seem to always be disabled.
Also interesting, the project context menu's "Debug | Start New Instance" command is nowhere to be found in the list of customizable commands. I looked through almost every category and couldn't find it.
Hopefully someone comes up with a good way to do this... it would be really handy!
I have a Visual Studio setup project. Upon installation, it creates an uninstall batch file in the application folder. IF the user wants to uninstall the product, he can go to "Add/Remove Programs", or he can just double-click the uninstall.cmd. The contents are:
%windir%\system32\msiexec /x {CC3EB7BF-DD82-48B9-8EC5-1B0B62B6D285}
The GUID there is the ProductCode from the Setup Project in Visual Studio.
But, in order for upgrades to work properly, I have to increment the Version number, every time I produce a new MSI. And, if I increment the Version number, then I also have to generate a new Guid for the ProductCode. Which means the static uninstall.cmd file needs to change.
How can I dynamically generate a batch file that contains the ProductCode for the, at build time?
I found this solution here
"Using Visual Studio 2005/2008, you don?t need to write any code to add a uninstall option for a Setup project (Yes I know some people can write code to do it)
1) In the Setup Project ?> File System windows ?> Right Click ?File System on Target machine? ?> add a Special Folder, select System Folder;
2) Into this system folder Add a file. Browse for msiexec.exe from local System32 folder and add it. Override default properties of this file as follows:
Condition:=Not Installed (make sure you put ?Not Installed? exactly like that, same case and everything), Permanent:=True, System:=True, Transitive:=True, Vital:=False.
3) Create a new shortcut under the ?Users Program Menu?, Set Target to the System Folder which you created in the step 1. and point it?s at the msiexec.exe. Rename the shortcut to ?Uninstall Your Application?. Set the Arguments property to /x{space}[ProductCode].
4) Build the project, ignore warning about the fact that msiexec should be excluded, DONT exclude it or the setup project wont build.
The ?Not Installed? condition and Permananet:=True ensure that the msiexec.exe is only placed into the system folder as part of the install IF it doesn?t aready exist, and it is not removed on an uninstall - therefore it;s pretty safe to ignore that warning and just go for it.
(Based on the description from SlapHead)"
I just made this work:
Add an uninstall.bat file to your project. The file contents is:
msiexec.exe /x %1
Make a shortcut to that batch file (say in User's Program Menu), specify in the shortcut's properties, next to Arguments: [ProductCode].
This is the script I wrote that creates an uninstall.cmd. It runs as a custom action during installation.
var fso, ts;
var ForWriting= 2;
fso = new ActiveXObject("Scripting.FileSystemObject");
var parameters = Session.Property("CustomActionData").split("|");
var targetDir = parameters[0];
var productCode = parameters[1];
ts = fso.OpenTextFile(targetDir + "uninstall.cmd", ForWriting, true);
ts.WriteLine("@echo off");
ts.WriteLine("goto START");
ts.WriteLine("=======================================================");
ts.WriteBlankLines(1);
ts.WriteLine(" Uninstall.cmd");
ts.WriteBlankLines(1);
ts.WriteLine("=======================================================");
ts.WriteBlankLines(1);
ts.WriteLine(":START");
ts.WriteLine("@REM The uuid is the 'ProductCode' in the Visual Studio setup project");
ts.WriteLine("%windir%\\system32\\msiexec /x " + productCode);
ts.WriteBlankLines(1);
ts.Close();
The result is a cmd file that always has the current ProductCode in it.
The downside of this is that ?the script that creates the uninstall.cmd remains in the installation directory. Not a huge problem but I don't like the rubbish in the install directory. I haven't yet tried to make the "createInstaller.js" self-deleting. That might work.
EDIT: yes, making the createInstaller.js self-deleting works fine.
I'm going to accept my own answer!
For removing the application I would use the [ProductCode] as a parameter, calling the msiexec from within the application itself - for a detailed guide as to creating the uninstaller please check this blog: http://endofstream.com/creating-uninstaller-in-a-visual-studio-project/
What is the least slow Virus scanner to use with Microsoft Visual Studio
I have just had Microsoft Visual Studio ?go slow? on me again due to my Virus Checker? (100s of Projects, some with over 100 C# files in them, so any thing that slows down builds is bad.)
We all know that development tools do a lot of file access so are badly effect by Virus Scanner. Most of us have to run a Virus scanner due to do many reasons.
So has anyone measured the effect of different virus scanners (and settings) on the speed of Microsoft Visual Studio?
Has anyone tied Microsoft Security Essentials that has been recently released with Visual Studio?
See also (if you have the rep, please extend the list)
What are peoples experiences with Visual Studio 2010 and virus checkers?
I got this as part of a helpful email from someone (that will rename nameless) at Microsoft speaking on his own behalf.
It?s not clear that we (Microsoft) would be able to endorse 3rd party products. With that in mind, I did notice that in the posting Ian linked to (this question) that Computer Associates was listed by someone as one of the best performing virus checkers for development environments, which interestingly enough is a product that I believe many Microsoft developers use on their desktops.
I don't really have done any measurements, but what I usually do is to exclude the real time scanning of my development folder (usually my :\Projects folder). That way, the compiler can work as fast as possible during my everyday repetitive tasks. I do have a daily scan that have the folder in question in its path, in order to fetch any possible threat. On a subjective note, I prefer to use NOD32.
Based on previous installations at various jobs, empirically rated from slowest (very annoying) to quickest (almost no impact):
I wouldn't bother with the speed tests, etc. shown at the AV review sites since most of these are in controlled environments, often with review-mode enabled. The impact will also vary depending on your network environment (workgroup or domain) and administrator-enforced policies.
Disclosure: I used to work on another now-obsolete anti-virus package back in the 90's.
+1 for bringing this to light. Its one of those gripes that I have about corporate antivirus policy that kills developers on slow machines.
I know your question is virus scanner related, but I'm going to try this from another angle and try eliminate the dependency/effect of the virus scanner slowdown.
I'm a contractor and I've worked on a lot of different machines and I've learned a few tricks to speed up my environment on slower PC's.
Number 1: - if you're using Windows Vista / Windows 7 immediately look into using Readyboost. After I plugged a USB flash drive (readyboost capable), my build / project run times dropped dramatically. Readyboost buffers the fragmented parts of your cache and stops your hard drive head hopping all over. If you're not reading your hard drive, you're not virus scanning... Made a major difference for me. Unfortunately many office PC's are still XP - in that case this isn't an option.
Number 2: - if you're using a Virus scanner that lets you do this, would you consider not scanning "all files"? I usually set mine to scan program files only. Admittedly not as secure, but trade off of some security versus not bringing your machine to a grinding halt. Excluding your project folder won't always help... If you're doing web development, there's disk writes to \Temporary ASP.NET files\ and the page file.
Number 3: - a faster hard drive. (Probably only possible if this is your machine). I wrote a blog post with an analogy that might help clear this up. Instead of repeating it all, here's a link: http://codeoverview.com/blog/2009/08/faster-hdd/
Essentially I'm trying to say that if your antivirus is crippling you, you probably have a typical corporate PC (maybe with an extra boost of RAM) instead of a proper developer rig. Crippled by a one-size fits all spanner? I'd bet your hard drive isn't particularly better performing than the one in the receptionist's PC, just bigger (not trying to be snide - just pointing out what I've frequently seen and it frustrates me)
We have Trend Micro antivirus at work, and it's terrible. It seems particularly bad doing checkouts.
We commissioned a new build machine recently, and the IS team hadn't set up exclusions for the build drives, and it was taking 45 minutes to check out source code from TFS. With the AV turned off, the exact same source code took about 1 minute 30 seconds to check out.
I also dont have maesurements, but some experiences:
Dont use McAfee: We had serious performance problems (and other more serious ones) on a number of installations with that.
Use Avira AntiVir: Reportedly the highest success rates, and no noticeable delay. I use it since years.
I'd have to agree with the first answer.
I've seen such issues differ between jobs according to the verocity of the admins' intent to leave configs unchanged for devs. Correctly setup virus scanners still hinder dev, but at least it's bearable.
So I edit the scan lists to:
I find this improves the disk thrashing that otherwise occurs with Visual Studio, Resharper and a Virus Scanner all hammering the drive. As always SysInternals' Filemon can help you target rogue services/processes.
Exclude your project folders and the visual studio app folder for realtime scan, and schedule a scan as often as you can feel safe.
Would comment on answers from @MagnusJohannsson or @Rodrigo but don't have enough reputation. Just to agree really, and +1 for both.
I have NOD32 4.x on two very similar machines, 2nd Gen intel SSD's plenty of RAM, Duo / Quad Core's overclocked, clean installs of win 7, VS2010.
Have used NOD32 for years on many different boxes and many different builds without any problems, but had a horrible issue on one of the machines after a hardware upgrade and reinstall of OS where ekrn.exe (NOD's service) would go nuts and just eat up all the CPU leaving me having to physically shutdown the box.
After lots of to and fro with ESET support it was decided it was due to Visual Studio file access looking suspicious / being to quick, and in the end I excluded my project folders, and since then has been fine. Interestingly was project folder for a solution I was not using at the time, so maybe a TFS thing?
Anyhow this link is a simple guide for anyone having same problem with NOD32's ekrn.exe eating CPU
Well to be honest, my work machine doesn't have a virus scanner installed, and for almost 2 years, I've never had a problem with viruses because I'm constantly behind corporate web patrol and other things keeps me pretty safe.
At home, though, I use NOD32, and on 3 different machines all using Visual Studio, I've never noticed any slowdowns. I apologize for not having any benchmarks to measure, just wanted to throw out my "answer."
Don't use Kaspersky(The old Tect Review one) it slows down normal explorer file opening for almost 10 second(Yes, you need to wait 10 second before opening each folder). And yes it affects Visual Studio. The new version does not seem the have the problem. NOD32 seem to not have this problem, and is a bit faster than Kaspersky(I don't even know if it's scan as much as Kaspersky does).
But for what ever reason, NOD32 firewall is bad!
how can I automatically merge and minify multiple Javascript files, as well as minify my CSS when building my ASP.NET MVC application in visual studio? Are there any build scripts/tools that do this?
Dave Ward has a great article that I found helpful when setting this up in Visual Studio
http://encosia.com/2009/05/20/automatically-minify-and-combine-javascript-in-visual-studio/
This blog post is a little better, methinks.
http://arranmaclean.wordpress.com/2010/07/22/minify-combine-css-and-javascript-with-visual-studio/
I'm working on an MVVM project, so I have folders in my project like Models, ViewModels, Windows, etc. Whenever I create a new class, Visual Studio automatically adds the folder name to the namespace designation instead of just keeping the project-level namespace. So, adding a new class to the ViewModels folder would result in the namespace, MyProject.ViewModels instead of just MyProject.
When I first encountered this, it annoyed me. My class names are pretty clear, sometimes even containing the name of the folder in them (e.g., ContactViewModel). I quickly found myself manually removing the folder name on the namespaces. I even tried at one point to create a custom class template (see this question), but I couldn't get that to work, so continued doing it manually.
I've begun to wonder, though, if this convention exists for a good reason that I'm just not seeing. I could see it being useful if you for some reason had lots of sets of identical class names organized into folders, but that doesn't seem like a particularly common scenario.
Questions:
Same as you - I fought this for the longest time. Then I started considering why I created folders. I found myself starting to create folders to represent namespaces and packages instead of...well...whatever I would have normally done.
For instance, in a domain project, I started creating folders called 'Entities'. In an MVVM project, it might be helpful to put views and view models in a separate namespace. For MVP projects, you can nicely separate objects into Model, View, and Presenter folders/namespaces.
Suddenly, the project feels a little more organized.
In my opinion, it is up to how you use folders. When I moved on to the namespace convention, I felt myself making better buckets for my data types.
i was annoyed by this as well but working with and refactoring projects with large codebases quickly taught me otherwise. Having embraced the concept i think that it's a very good way to structure your code "physically" as well as logically. When you have a large project and the namespaces do not match up to the folders it becomes difficult to locate files quickly. It's also that much more difficult to remember where things are...
Also, if ReSharper recommends it, then it's probably a good idea. E.g. R# will complain if your class' namespace does not match its folder name.
If you want some solid advice I'd recommend buying Framework Design Guidelines: Conventions, Idioms, and Patterns for Reusable .NET Libraries which gives you all you need to know from the actual framework design team.
...the goal when naming namespaces is creating sufficient clarity for the programmer using the framework to immediately know what the content of the namespace is likely to be...
<Company>.(<Product>|<Technology>)[.<Feature>][.<Subnamespace>]
And importantly
Do not use the same name for a namespace and a type in that namespace
Fragmenting every 1/2 types into namespaces would not meet the first requirement as you would have a swamp of namespaces that would have to be qualified or used, if you followed the Visual Studio way. For example
Core - Domain - Users - Permissions - Accounts
Would you create
or just
For Visual Studio's way it would be the former. Also if you use lowercase file/folder naming you're looking at renaming the class each time, as well as making one big namespace tangle.
Most of it is common sense and really down to how you would expect to see the namespaces organised if you were a consumer of your own API or framework.
One way of not following the convention is to create the file in the project root folder and then move it to the final sub-folder.
Anyhow, it is a convention I actually like. If I am splitting types into folders, then probably those types have some kind of conceptual grouping related to the folder. Therefore, it ends making some sense, their namespaces are also similar. Java takes this approach and enforces it with its package system. The biggest difference is that VS is only "suggesting" it to you, since neither the language or the CLR enforces it.
File system folders and namespaces both represent a hierarchy. I seems perfectly natural to me to match the two. I go even one step further and use a 1:1 relationship between files and classes. I even do so when I program in other languages such as C++.
Now that you question the relation between these two hierarchies, I seriously wonder what you would like to represent by the file system hierarchy.
While I agree with everyone else, that a physical structure matching the logical structure is helpful, I have to say I also fight with Visual Studio's auto-naming. There are half a dozen reasons why I have to rename classes:
With thiose reasons, I've resigned myself to having to adjust those for every class I create. My strategy to avoid the issue is copying a file that has the namespace declaration I want, and then immediately delete the contents.
I also feel the pain with this 'by default' behaviour in Visual Studio.
Visual Studio also tries to set a namespace/directory match when you put your LinqToSql .dbml files in their own directory. Whenever I edit the .dbml, I have to remember to:
.dbml.designer.cs filenamespace declarationThere's a way to stop this behaviour, though. It involves creating a custom class template.
I'm developing an application using Visual C# Express Edition - what is the downside to using the express editions? Are there any limitations on what I can build and release? Will my users be able to tell I'm using the Express Edition?
It won't impact your users, other than by making you less productive by prohibiting add-ons such as ReSharper, TestDriven.NET etc and not having some of the built-in features of the commercial editions.
To put it another way: if a word processor didn't have a spell checker, you could still make sure that your documents were spelled correctly, so readers wouldn't know - but it's a lot quicker (usually!) if the tool has it built in...
Here is a huge comparison chart of all versions of Visual Studio, from Express until Team System.
Apart from that, it's fine. It uses the same compiler to generate the same code, you just don't get all the Time-Saving tools that VS Professional offers.
The Express debugger does not allow Attach to Process.
Reference http://en.wikipedia.org/wiki/Microsoft_Visual_Studio_Express:
The ability to attach the debugger to an already-running process has also been removed, hindering scenarios such as writing Windows services and re-attaching a debugger under ASP.NET when errors under the original debugging session cause breakpoints to be ignored.
I can live with everything else but that.
no Mobile Device support - one of the most important features, for me :o)
Only one language is supported. You can't have an application in C# and a library in C++ in the same solution, for instance.
Also, third party ADO.NET providers are not supported in the designers
VS Express can do "most" of what the higher editions can do until you start getting into more advanced things such as trying to install 3rd party components and get full integration, adding database projects, integration into 3rd party systems, etc. On that note even VS Standard lacks several of these features so you'd be looking at Pro (at a minimum) to get a fully robust and feature-rich edition.
No MFC visual gui builder for C++.
EDIT
Oops - just read the C# tag. I'll leave this up though in case it comes up in a search for anyone else who might also be using c++
We're thinking of switching to SVN at my work, so I was wondering about SVN plugins for VS2008 (and 2010 when it comes out). After a bit of research I found AnkhSVN and VisualSVN, the 2 that seemed most dominant. (I am aware of TortoiseSVN and will use the plugin in conjunction with it).
I am aware that this has been asked before, but these questions were asked almost a year ago and we all know that a lot of things can change in a year.
The question: From your experience, which is better and why?
Granted, it has been a year since I've used each product head-to-head, but my current preference is AnkhSVN. Though folks grumbled about early versions of AnkhSVN, 2.0 was a near rewrite of the original and is now a full Source Control Provider Integration Package rather than a Visual Studio Add-In. With commercial backing from CollabNet and renewed open source enthusiasm, AnkhSVN 2.0 deserves a chance.
My two favorite features of AnkhSVN are it is free and I love the Pending Changes window.
As for VisualSVN, I find it to be sluggish and I feel it leverages TortoiseSVN rather than handling the file management itself far too often. And it costs money (albeit a small amount.)
Again, this is based on my last head-to-head test which was about 1 year ago. As already stated, TortoiseSVN is great on it's own, but if you really want to plug into the VS IDE, give AnkhSVN a whirl before VisualSVN. Best of luck.
I have tried both of the VS plugins...after several months of use I quickly realized that I spent ALL of my time in Tortoise! The plugins don't get all of my trunk related items. They only work with items that are part of the solution and that VS recognizes. For this reason I spent pretty much all of my time in Tortoise...and eventually all of my time. There is no reason to pay for plugins when Toroise is both free and updated almost daily.
Stick with Tortoise and learn how to use it. You will be happier in the end.
Responses:
@jeroenh: "... There really is an advantage of using a (properly integrated) VS plugin, namely when moving/renaming files in your solution. ..."
I agree that renaming/moving files in Tortoise is clumsy. And VisualSVN does make this easier.
@Darko Z: "on a personal level I agree, but on an organisational level I don't. We have a few people here that NEED VS integration. Yeah its silly but fair enough :)"
Yes, I have several people like that in my current team. And training them to get used to Tortoise has been a Bear! They are the reason that we got some licenses for VisualSVN..but they complained about that too.
I had the same dilemma as well a few months ago, and finally decided to go with VisualSVN. We've been using it for 4 months for C# inhouse web application development and our experience has been positive.
Firstly, the server part integrates with Active Directory and offers an easy to use MMC control for managing the repositories.
Secondly, the client part integrates with VS2008, doesn't slow down Visual Studio loading times, and works with pretty trivial color codes (green for untouched files, yellow for files you changed). It features full revision diff's, you can comment every revision.
One down side is that its supports for hooks (like post-commit hooks) is very rudimentary. You can view statistics like who made the most commits, etc.
It supports branches although we don't use those features. All client-server communication is done through SSL (keys and certificates are configured automatically).
I asked them a question at some point about how to delete the branch history from the Visual Studio dropdown, and Olga kindly answered me that I simply needed to delete the .suo file.
Finally, my experience from working with VisualSVN: simple and straightforward for our relatively small team. (we're 5 programmers, but I'm pretty sure this scales a lot more than that).
I use VisualSVN atm and its great as it auto adds any new files to the svn and allows easy revert and diff with out having to open a explorer window. However you will still need to use TortoiseSVN for files not in your visual studio solution.
Last time i used AnkhSVN it didnt work to well and screwed my svn checkout up (but this was a couple years ago).
That question you asked boils down to personal preference but I would advise you to have IN ADDITION to the ide client either Tortoise SVN or the command line client. You will often be forced into positions where the IDE client cannot perform the task you need.
What is the difference between just a Rebuild and doing a Clean + Build in Visual Studio 2008? Is Clean + Build different then doing Clean + Rebuild?
Earl is correct that 99% of the time Rebuild = Clean + Build.
But they are not guaranteed to be the same. The 3 actions (rebuild, build, clean) represent different MSBuild targets. Each of which can be overriden by any project file to do custom actions. So it is entirely possible for someone to override rebuild to do several actiions before initiating a clean + build (or to remove them entirely).
Very much a corner case but pointing it out due to comment discussions.
Rebuild = Clean + Build
From http://www.cs.tufts.edu/r/graphics/resources/vs_getting_started/vs_getting_started.htm, (just googled it):
Build means compile and link only the source files that have changed since the last build, while Rebuild means compile and link all source files regardless of whether they changed or not. Build is the normal thing to do and is faster. Sometimes the versions of project target components can get out of sync and rebuild is necessary to make the build successful. In practice, you never need to Clean.
Build or Rebuild Solution builds or rebuilds all projects in the your solution, while Build or Rebuild builds or rebuilds the StartUp project, "hello" in the screen shot above. To set the StartUp project, right click on the desired project name in the Solution Explorer tab and select Set as StartUp project. The project name now appears in bold. Since the homework solutions typically have only one project, Build or Rebuild Solution is effectively the same as Build or Rebuild .
Compile just compiles the source file currently being edited. Useful to quickly check for errors when the rest of your source files are in an incomplete state that would prevent a successful build of the entire project. Ctrl-F7 is the shortcut key for Compile.
I am using Visual Studio for editing source code and once a while I switch to Windows Explorer to commit changes with TortoiseSVN. This procedure works well for me and I am quite happy with it. However recently I started to rename classes and reorganize namespaces a lot. I like to rename and move files in Visual Studio because it automatically update project file for me. However when I commit changes I have to tell to TortoiseSVN that old files was deleted and new files was added what isn't quite true and it breaks history of particular code.
So my question is: When I rename file in Visual Stuido is there any way to tell TortoiseSVN that I did that to prevent file history?
Update (16:30): Ankhsvn seems to be obvious answer but I like thing as they are now. It sounds weird but I like TortoiseSVN not being integrated in Visual Studio. This is maybe because of my two monitor setup when I have always opened file manager on my secondary monitor. May because I found Solution Explorer little clunky. Maybe because I like to think about code editing and revision control as separate steps of software development. I don't know.
If you have a newer version of TSVN (after 1.5.0, I think), you can use the "repair moves" feature. I use it all the time for situations just like that.
Have a look at http://ankhsvn.open.collab.net/. It looks for these things and handles the changes appropriately and shows you directly in the Solution Explorer what has changed. Plus, you don't have to go back to Explorer! I really like it a lot!
There is no reason to prevent file history. That is the whole point of a source code control system.
I think AnkhSVN will do the job. It's a free SVN plugin for Visual Studio. There is another one - VisualSVN, but its shareware.
No. You should do all file moving/renaming in TortoiseSVN (ie file explorer).
There are SVN plugins for Visual Studio that might do what you want.
maybe you can use ankhsvn plugin for visual studio for svn
or there are plugins like that
AFAIK, when you use TortoiseSVN to rename your files within the boundaries of source control it deletes and adds the renamed files as new, too.
Commit the parent folder
Since renames and moves are done as a delete followed by an add [...]
I don't know how you can do what you asked, but I think you can solve your problems if you start using AnkhSVN.
It's a great tool that integrates Subversion into Visual Studio and you can do your commits from the VS IDE.
Is it possible to find the number of lines of code in an entire solution? I've heard of MZ-Tools, but is there an open source equivalent?
I've found powershell useful for this. Because I consider LoC to be a pretty bogus metric anyway, I don't believe anything more formal should be required.
From a smallish solution's directory:
PS C:\Path> (dir -include *.cs,*.xaml -recurse | select-string .).Count
8396
PS C:\Path>
That will count the non-blank lines in all the solution's .cs and .xaml files. For a larger project, I just used a different extension list:
PS C:\Other> (dir -include *.cs,*.cpp,*.h,*.idl,*.asmx -recurse | select-string .).Count
909402
PS C:\Other>
Why use an entire app when a single command-line will do it? :)
An open source line counter for VS2005, 2003 and 2002 is available here:
There is also discussion of creating a line counting VS addin, complete with code on Codeproject, here
http://www.codeproject.com/KB/macros/LineCounterAddin.aspx
Also Slick Edit Gadgets have a nice line-counter, here:
http://www.slickedit.com/index.php?option=com_content&view=article&id=78&Itemid=90
and Microsoft Visual Studio Team System 2008 includes a good line counter.
Just remember though:
Measuring programming progress by lines of code is like measuring aircraft building progress by weight. Bill Gates
Found this tip: LOC with VS Find and replace
Not a plugin though if thats what you are looking for.
In Visual Studio Team System 2008 you can do from the menu Analyze--> 'Calculate Code Metrics for Solution' and it will give you a line count of your entire solution (among other things g)
Visual Studio 2010 Ultimate has this built-in.
Analyze -> Calculate Code Metrics
cloc is an excellent commandline, Perl-based, Windows-executable which will break down the blank lines, commented lines, and source lines of code, grouped by file-formats.
Now it won't specifically run on a VS solution file, but it can recurse through directories, and you can set up filename filters as you see fit.
Here's the sample output from their web page:
The third generation equivalent scale is a rough estimate of how much code it would take in a third generation language. Not terribly useful, but interesting anyway.
A simple solution is to search in all files. Type in "*" while using wildcards. Which would match all lines. At the end of the find results window you should see a line of the sort:
Matching lines: 563 Matching files: 17 Total files searched: 17
Of course this is not very good for large projects, since all lines are mached and loaded into memory to be dispayed at the find results window.
Reference:
I prefer OxyProject Metrics VS Addin.
Other simple tool For VS2008 (open source): http://www.accendo.sk/Download/SourceStat.zip
Use Menu-> Analyse - > Calculate Code Metrics option in Visual Studio 2010 Ultimate.
You could use:
Try neptuner. It also gives you stuff like spaces, tabs, Lines of comments in addition to LoC. http://neptuner.googlecode.com/files/neptuner_0_30_windows.zip
You can use the Project Line Counter add-in in Visual Studio 2010. Normally it doesn't work with Visual Studio 2010, but it does with a helpful .reg file from here: http://www.onemanmmo.com/index.php?cmd=newsitem&comment=news.1.41.0
Could any one suggest a tool for performing peer code review before check-ins that is integrated with Team Foundation Server and Visual Studio 2008?
[Update]: Looks like there is no such tool. Can you suggest the best process for code-review after check in?
The key feature that help us do code reviews on our team would be shelvesets. Granted, they are a less visible feature to work with in Visual Studio Team Editions out of the box. You can take it a step further and define a workflow as part of your Team Project template that enforces the code review process through policies and custom work items. A good example to start from can be found in CodePlex: TFS Code Review Workflow
Personally, I have not used the workflow; our team feels that we are sufficiently able to perform code reviews with the base shelveset feature. It only takes a little understanding on how to use it. Here is a summary of our process:
Developer creates a shelveset of the changes they want to commit.
Developer sends an email to the Reviewer specifying the name of the shelveset to review and any associated work items to reference in the changes.
Reviewer gets the shelveset and performs a review, optionally making any suggested modifications if necessary in a new shelveset.
Reviewer sends an email to notify the Developer once the review has been completed.
If the review did not result in any suggested modifications for the Developer to make, the shelveset can be committed by the Developer. Otherwise, modifications are made and the process repeats.
There is another solution on Codeplex named Team Review thats is a pretty comprehensive peer reviewing system. It also makes use of shelved check ins, and event subscriptions to inform reviewers.
I've had good experience with CodeCollaborator while using Mercurial DSCS, even though there wasn't much integration. CC provides a way to have online exchanges on a marked line of code, to mark code as a defect and it keeps track of when all comments and defects have been looked at and resolved. It also shows code changes in diff window and allows uploading of new change sets shows differences between any two change sets in the review.
Now I'm looking to use TFS. I've just received email from CodeCollaborator vendor SmartBear that it is possible to integrate with an external SCS. See External Tracking. If I do this I'll update here. I have no connection with SmartBear other than having used their CodeCollaborator product.
You might want to try out a new Code Review Tool which integrates with multiple different version control systems including TFS 2008 and above. Currently it doesn't support a visual studio plugin.
You can download a full featured time limited trial version to install on Windows Server or you can try out the hosted version.
Note: I am associated with the company that builds the above product.
If there is a URL in a source file comment, I can "CTRL + click to follow link." However, when I do this, the link opens inside Visual Studio. How can I make it open in my web browser--in my case, Google Chrome?
I could not find a setting for this so I wrote a simple macro that you can use. You can bind this to a key-combo like all macros. This will get the job done until we get a better answer.
Sub OpenURLInChrome()
'copy to end of line
DTE.ActiveDocument.Selection.EndOfLine(True)
'set var
Dim url As String = DTE.ActiveDocument.Selection.Text
'launch chrome with url
System.Diagnostics.Process.Start(Environment.GetFolderPath(Environment.SpecialFolder.LocalApplicationData) + "\Google\Chrome\Application\chrome.exe", url)
End Sub
Just put your cursor in front of the url and run the macro...
There is a full description of a solution here: http://stevenharman.net/blog/archive/2007/08/02/setting-a-default-browser-for-visual-studio.aspx
There is a handy link for VS2005 half way down by capgpilk
In VS2008 , just right click on the link and select "Open link in external window". You have to select Chrome as your default browser.
Maybe you should write a plug in?
I have a Visual Studio C++ based program that uses pre-compiled headers (stdafx.h). Now we are porting the application to Linux using gcc 4.x.
The question is how to handle pre-compiled header in both environments. I've googled but can not come to a conclusion.
Obviously I want leave stdafx.h in Visual Studio since the code base is pretty big and pre-compiled headers boost compilation time.
But the question is what to do in Linux. This is what I found:
Use approach from here - make stdafx.h look like (set USE_PRECOMILED_HEADER for VS only):
#ifdef USE_PRECOMPILED_HEADER ... my stuff #endif
Use the approach from here - compile VC++ with /FI to implicitly include stdafx.h in each cpp file. Therefore in VS your code can be switch easily to be compiled w/o pre-compiled headers without changing a line of code. I personally dislike dependencies and the mess stdafx.h is pushing a big code base towards. Therefore the option is appealing to me - on Linux you don't have stdafx.h, while still being able to turn on pre-compiled headers on VS by /FI only.
On Linux compile stdafx.h only as a precompiled header (mimic Visual Studio)
Your opinion? Is there're another approaches to treat the issue?
You're best off using precompiled headers still for fastest compilation.
You can use precompiled headers in gcc as well. See here.
The compiled precompiled header will have an extension appended as .gch instead of .pch.
So for example if you precompile stdafx.h you will have a precompiled header that will be automatically searched for called stdafx.h.gch anytime you include stdafx.h
Example:
stdafx.h:
#include <string>
#include <stdio.h>
a.cpp:
#include "stdafx.h"
int main(int argc, char**argv)
{
std::string s = "Hi";
return 0;
}
Then compile as:
> g++ -c stdafx.h -o stdafx.h.gch
> g++ a.cpp
> ./a.out
Your compilation will work even if you remove stdafx.h after step 1.
I used option 3 last time I needed to do this same thing. My project was pretty small but this worked wonderfully.
I'd either go for option 4 or option 2. I've experimented with precompiled headers on both various VS versions and GCC on Linux (blog posts about this here and here). In my experience, VS is a lot more sensitive to the length of the include paths, number of directories in the include path and the number of include files than G++ is. When I measured build times properly arranged precompiled headers would make a massive difference to the compile time under VS whereas G++ was pretty much unimpressed by this.
Actually, based on the above what I did the last time I worked on a project where this was necessary to rein in the compile time was to precompile the equivalent of stdafx.h under Windows where it made sense and simply used it as a regular file under Linux.
I've done both option 2 (#ifdef) and option 4 (PCH for gcc) for cross platform code with no issues.
I find gcc compiles much faster than VS so the precompiled headers are generally not that important, unless you are referencing some huge header file.
It's simple, really:
Project->Project Settings (Alt + F7)
Project-Settings-Dialog:
C++ -> Category: Precompiled Headers -> Precompiled Headers radio buttons --> disable
Since stdafx.h is by default all the Windows-specific stuff, I've put an empty stdafx.h on my other platform. That way your source code stays identical, while effectivly disabling stdafx on Linux without having to remove all the #include "stdafx.h" lines from your code.
Let me start off by saying that I'm a relatively new programmer and I have no prior experience with source control -- although after some reading, the concepts and general lingo are not alien to me.
I'm about to start my first professional project (I'll be the only one committing) and I'd like to take this opportunity to become proficient with Subversion and source control practice in general.
Development will take place on a Windows box in Visual Studio with the help of the AnkhSVN SC plug-in.
I've setup SVN on a Windows server and created a repository where I'll store my project(s).
This particular project will require delivery of binaries and source code.
How is solution building usually set up? Say I've imported an initial version of the solution into the repository; next, I've achieved some milestone in my local working copy; I commit those changes; what happens then? Do I just build the solution on my local development machine and package the binaries right there and then? How is this done in the real world?
After messing around with VS and AnkhSVN in a VM, I've noticed that after I checkout some revision of a solution, my local copy's directory tree gets an extra directory called ".svn" in each node. As per the third point in "Background", I'll also be delivering source code along with the binaries. This poses a question: how do I get a "clean" version of my solution? Am I expected to write a shell script that does the cleaning for me?
I often create, merge (by hand, that is), and delete files in my solutions. Will SVN (rather VS and AnkhSVN) handle this gracefully? Will VS/AnkhSVN automatically reload a solution that had files added/removed from it if I go back to a certain revision?
Where did you learn to use source control, and how long did it take you to become proficient (i.e., until these operations were second nature) at it.
I really want to start using source control, but I'm scared that if I start using it and I do something unintentionally stupid, I'd lose my code. Any extra advice is appreciated.
I've used AnkhSVN in the past and it's nice, but if you have large solutions with lots of files, you might want to shell out some cash for VisualSVN. It uses TortoiseSVN (which in term has some caching mechanisms), making it faster (see comment below about AnkhSVN 2.0). VisualSVN will also help you a little in setting up properties on special directories. It will automatically ignore bin and obj directories for instance.
I'm not a big fan of paying for a product leaning so heavily on a free project, but I have to say the investment was worth it.
Other people have linked some nice sources on how to set up your repository, so I won't go into that too much. I generally use the /trunk, /branches, /tags approach myself. Tag your release versions at least, to find them quickly later.
Ad 4:
I've worked with CVS (very little), Visual SourceSafe, Subversion and Team Foundation Server so far. I mean to try Git at some point, but you could do a lot worse than SVN.
4) I start with this one because this will answer many of your first questions: Pragmatic Version Control using Subversion is the bible for working with SVN in my respect. But unlike the bible, you can go through it in a couple of days with no haste at all.
1) Versioning projects usually take the form of committing only source files, as project files (of your VS, for example) usually contain irrelevant definitions of your current installation, and litter the repository. Everyday commits are for your personal use. For major versions use tags.
2) The .svn directory is a local cache repository completely managed by the SVN client. Don't touch it.
3) Merging, deleting and adding files is what version control is all about. Yes, SVN will handle this gracefully, and this is all explained easily in the referenced book. Each revision of your project is self-contained.
I can't answer your main questions because they are very VS specific, but when you say:
I'm scared that if I start using it and I do something unintentionally stupid, I'd lose my code.
let me reassure you. The whole point of a VCS is to prevent any code loss, ever. All version control systems I'm aware of make it impossivble to modify older versions of your files without jumping through some extremely unlikely hoops, such as directly editing the repository with a text or hex editor. So long as you don't do that, and so long as you back up your repository regularly, your code will be safe and you should feel free to experiment.
You should read the book. It's free and has answers to things like question 2 (Answer: export).
I'll second Avihu Turzion's recommendation of Pragmatic Version Control using Subversion. Also check out Eric Sink's source control how-to if you haven't already.
Since you're the only one committing, building and packaging the binaries locally is definitely an option. If the building/packaging steps are fairly standard, automate them by setting up a continuous integration system. TeamCity Professional is a free product you can start with that is easy to configure and get working with Subversion.
As mentioned by others, the Export option is the way to get a version of your solution without the .svn files.
Subversion handles file creation, merging, and deleting fairly smoothly. With the plug-ins you mention, particularly if you're using something like AnhkSVN and TortoiseSVN, it's possible for what the plug-in reports as committed (versus what the Subversion repository actually has committed) to get out of sync. If you delete files or move files, considering doing it entirely at the command-line (or in TortoiseSVN).
I learned to use source control on my own once I'd been working a few years. While I started with Visual SourceSafe (which was terrible), I eventually moved on to companies that used Subversion and/or TFS for version control.
You're far more likely to lose code if you don't use source control than if you do. You're definitely starting things off on the right foot.
The way I store my files in Subversion is to setup the Trunk/Branch/Tag directories, though I almost never use Tags. You're trunk is your solid, working foundation. Branches are when you need to "branch" the code, work on something, then merge it back into the trunk. You can do this for something that you know will take a while and you know you might have to do some quick fixes, which modify the trunk. Make sense?
-- You can checkout your latest and do a build locally or setup a build environment using MSBuild, or Cruise Control.NET or TeamCity (from the guys who do resharper). This will do a build for you, which you can then deploy. All this can be automated, it's just some work configuring everything. Team Foundation Server handles most of this.
The .svn directory is so subversion knows what you're working on and can say "hey something changed, alert the user with a nice red mark and let them know somethings changed."
Yes SVN will handle deletes and merges gracefully. You may be forced to use the "clean up" utility from time to time.
I learned source control from a senior dev on my first project.
It is only wierd right at the beginning, but an SVN will quickly become second nature to you. Good luck on your project.
Personally I picked up source control through trial and error. I do feel that Sourcegear Vault is much more user friendly and better tuned for Visual Studio development but I've managed to use both effectively.
If you run into trouble with SVN I recommend you check out vault which is free for one or two man teams. (One admin and one user account does not require a purchase.)
How is solution building usually set up? Say I've imported an initial version of the solution into the repository; next, I've achieved some milestone in my local working copy; I commit those changes; what happens then? Do I just build the solution on my local development machine and package the binaries right there and then? How is this done in the real world
Most places have standardized on an automated build process. How to set one up varies based on the requirements of the company and the project but the benefits can't be disputed. The last place I worked automated 90% of the build and ran it as needed but they were moving toward a fully automated one when I left. This is beyond the scope of your question but if you're interested you should look in to build automation. Some common tools for .NET development are CruiseControl.NET, MSBuild, NANT. Most tools were created for a specific development environment or language but are easily adapted to other environments.
After messing around with VS and AnkhSVN in a VM, I've noticed that after I checkout some revision of a solution, my local copy's directory tree gets an extra directory called ".svn" in each node. As per the third point in "Background", I'll also be delivering source code along with the binaries. This poses a question: how do I get a "clean" version of my solution? Am I expected to write a shell script that does the cleaning for me?
As others have noted, .svn is a cache of the repository. When you update, checkin or merge svn compares the cached version against the operation your intending to do and only updates, checks in, merges the differences. In the case of AnkhSVN, it integrates pretty well with VS and is designed to ignore unnecessary files when it checks in files. So you shouldn't have a problem with checking in temporary files and binaries (unless you specifically add them of course).
I often create, merge (by hand, that is), and delete files in my solutions. Will SVN (rather VS and AnkhSVN) handle this gracefully? Will VS/AnkhSVN automatically reload a solution that had files added/removed from it if I go back to a certain revision?
This is SVN's forte. Some VCSs (suchs as Visual Source Safe) make merging a scary operation. SVN on the other hand was specifically designed with merging operations in mind. Most are handled automatically. If there's a conflict between to versions being merged (the same line was modifed in two different ways), it will show you the problem and the rest is up to you. Its very hard to truly delete a file in SVN. So if you decide to explore an old version any deleted files will still be their.
Where did you learn to use source control, and how long did it take you to become proficient (i.e., until these operations were second nature) at it.
I'd heard of VCS in college but never used one until my first paid programming position. It was visual source safe. It was pretty easy to learn the basics (check out, check in, comments, viewing and comparing old versions). Branching I learned later with a private repository. It was a good thing too. Branching in VSS is more error prone than most other VCSs. My current employer uses SVN, which even though it is not the most advanced VCS available, made VSS look like a hack.
I can't stress the importance of an an automated build enough. My current employer had no build process when I started (still doesn't for most projects). One of the first things I did with the project I inherited was automate the entire build process. It runs on a dedicated server as a background process monitoring SVN for changes. If it detects any it kicks off an incremental build that only takes a few seconds. This is followed by a suite of automated unit tests. If all the tests succeed it drops the binaries into a test environment for further automated integration and system testing. I get notified at each step of the process and know instantly if something fails.
I'm going to try and add some comments that haven't already been covered by the well-written answers above.
How is solution building usually set up? Say I've imported an initial version of the solution into the repository; next, I've achieved some milestone in my local working copy; I commit those changes; what happens then? Do I just build the solution on my local development machine and package the binaries right there and then? How is this done in the real world?
It should be noted that ignoring certain files is a core function of SVN, so there is no additional tooling necessary - just some setup. Once you've configured SVN to ignore your build output you can develop and build to your heart's content without worrying about SVN trying to suck up binaries.
Tag your releases. Use the version number in the release in the tag name. Build your binaries from the tag and send your customer a clean copy of the source as well as the generated binaries. You don't need to revision the binaries themselves because the immutability of tags means you will always be able to re-generate the same payload.
I often create, merge (by hand, that is), and delete files in my solutions. Will SVN (rather VS and AnkhSVN) handle this gracefully? Will VS/AnkhSVN automatically reload a solution that had files added/removed from it if I go back to a certain revision?
There are a few operations that VCS typically have problems with. One is deleting a revisioned file using Windows Explorer (aka: keyboard delete). Another is moving revisioned files from one place in your repository to another from Windows Explorer. Outside of these semi-rare actions, SVN will easily keep up with your modifications and merges. For the two events listed above you can use the SVN command line, TortoiseSVN, or another helped application to perform an 'SVN delete' or 'SVN delete + SVN (re)add'.
Btw - a good (and free) merge tool is Kdiff3.
Where did you learn to use source control, and how long did it take you to become proficient (i.e., until these operations were second nature) at it.
I learned SVN at work, Mercurial at home, and AccuRev at work (again). It can take a very long time to 'get' your first VCS - especially if you are learning it in a vacuum. After the first one, it gets easier. I would put this on the order of months, not weeks.
Good luck!
I am beginning to look into the PowerShell model and snap-in development. The first thing I notice is to reference System.management.automation.dll. However in Visual Studio, the .NET tab does not that assembly, and neither am I able to browse to C:\windows\assembly\GAC_MSIL\System.Management.Automation\1.0.0.0__31bf3856ad364e35\System.Management.Automation.dll to make a file-based reference.
Am i forced to copy the file out manually to make an easy reference?
A copy of System.Management.Automation.dll is installed when you install the windows SDK (a suitable, recent version of it, anyway). It should be in C:\Program Files\Reference Assemblies\Microsoft\WindowsPowerShell\v1.0\
I couldn't get the SDK to install properly (some of the files seemed unsigned, something like that). I found another solution here and that seems to work okay for me. It doesn't require installation of new files at all. Basically, what you do is:
Edit the .csproj file in a text editor, and add:
<Reference Include="System.Management.Automation" />
to the relevant section.
Hope this helps.
The assembly coming with Powershell SDK (C:\Program Files\Reference Assemblies\Microsoft\WindowsPowerShell\v1.0) does not come with Powershell 2 specific types.
Manually editing the csproj file solved my problem.
Is there any way to speed up the Add Reference dialog? For example, has anyone found any way to open it by default in the Recent or Browse tabs (which is what I use 90% of the time), to avoid the other tabs' slowness?
All I have found is this blog post where a lot of people complain about this issue, but no solutions...
Note that this is not a duplicate of 8440 as this is not a general question.
No, I don't believe there is a good way to speed it up.
However, you can try a plug-in that does similar a thing but faster:
I'm not sure that this is possible, or that it's going to get fixed by Microsoft - see this item on Microsoft Connect ...
I replaced my HD with an SSD. Now opening the Add References dialog takes about 2 seconds when I open it the first time, less than a second after that. That alone was worth the money.
Try tweaking your virus checker.
I keep my virus checker (Nod32) set to scan on write, create, execute but not "file read". My whole machine is about 3 times faster, and "add reference" takes under 3 seconds. If I have my virus checker scanning reads it takes about 15 seconds to load add reference!!! Of course this introduces a small amount of risk, but for me the performance improvements far outweigh the risks.
The fastest way of adding a reference is to use the following visual studio extensions
http://visualstudiogallery.msdn.microsoft.com/en-us/36a6eb45-a7b1-47c3-9e85-09f0aef6e879
Enjoy,
Muse VSExtensions
<tongue mode="in cheek"> Get a faster machine? </tongue>
Is it any free Visual Studio addons that emulate vim text edit mode? For now I have found only ViEmu, but it's 100$ :(.
After @joe's answer, Jared Parsons created the great VsVim. It's been featured on Visual Studio Gallery. It's a ready extension package. I downloaded it, ran the file and it worked out of the box. It's free, too.
http://vim.wikia.com/wiki/Integrate_gvim_with_Visual_Studio
and SO has same details available in http://stackoverflow.com/questions/110477/anyone-know-of-any-free-open-source-vi-integration-for-visual-studio
Problem: I have a large Visual C++ project that I'm trying to migrate to Visual Studio 2010. It's a huge mix of stuff from various sources and of various ages. I'm getting problems because something is including both winsock.h and winsock2.h.
Question: What tools and techniques are there for displaying the #include hierarchy for a Visual Studio C++ source file?
I know about cl /P for getting the preprocessor output, but that doesn't clearly show which file includes which other files (and in this case the /P output is 376,932 lines long 8-)
In a perfect world I'd like a hierarchical display of which files include which other files, along with line numbers so I can jump into the sources:
source.cpp(1)
windows.h(100)
winsock.h
some_other_thing.h(1234)
winsock2.h
There is a C/C++ -> Advanced project setting "show Includes". That will generate the tree. It maps to the compiler switch /showIncludes
We have found IncludeManager to be a very powerful tool. It is not free (but not expensive) and it allowed us to get a grip of our Include issues and drop our compile time from 50 minutes to 8 minutes by pruning out large chunks of includes we weren't using.
The compiler also supports a /showIncludes switch -- it doesn't give you line numbers, but can give a pretty comprehensive view of which includes come from where.
It's under Project Settings -> Configuration Properties -> C/C++ -> Advanced -> Show Includes.
Here is a good 3rd-party, FOSS tool. You can export results to XML, which will include data on number of occurrences and line numbers.
cl /P should show you the line numbers, such that you can tell the context of where a header file is being included from.
If you grep out the lines with ...
grep "^#line" file.i
... then you should have a pretty clean indication of what files were encountered in order by the preprocessor.
If it's a one off incident this should be a pretty quick diagnostic.
Try redhat Source-Navigator for a more graphical solution.
I found this tool very useful. Give it a try.
When I open a command prompt through Visual Studio, I get:
Setting environment for using Microsoft Visual Studio 2008 x86 tools.
C:\Program Files\Microsoft Visual Studio 9.0\Common7\IDE>
What kind of tools are available, and what are the most common uses of this command prompt?
It basically just sets several of the visual studio binary locations into the path environment variable for that command window instance. This means you can use all the various commands and tools without having to include the full paths.
There's a partial list of some of the tools available on MSDN here and here.
Th Visual Studio command prompt is a convenient way to access the command line tools that ship with the .NET Framework SDK and, if installed the, Windows Platform SDK tools.
By providing the Visual Studio command prompt Microsoft allows you to run these tools without requiring your PATH, INCLUDE, LIB and LIBPATH environment variables to contain all the additional paths to the various folders where Visual Studio and the .NET SDK are installed. Instead these folder references are added on the fly when you start the Visual Studio command prompt allowing you to run the tools.
For example if you open a regular command prompt you cannot run xsd.exe without changing to the directory "C:\Program Files\Microsoft Visual Studio 8\SDK\v2.0\Bin". However in the Visual Studio command prompt you can just type xsd.exe /? and it works.
Please see this page from MSDN for a complete list of the tools provided with Visual Studio 2008 SP1 and details on what they do.
The Visual Studio command prompt has a few tools with it. Some tools are for repairing the install of Visual Studio. One of the tools I love using is for WCF. You type wcftestclient and you get a client to test your WCF services.
One use seems to be to call the XML Class Generator for using XSD schemas for serialization/deserialization:
This link seems to have some good information:
This article has a nice explanation. Short, straight to the point and fun to read. http://visualbasic.about.com/b/2010/08/17/the-visual-studio-command-prompt.htm
For one of my ASP.NET 3.5 applications, every single time I try to build the web app, it throws the following build errors in Visual Studio 2008:
Error 165 Unable to copy file "C:\InOne\Common\DexProcessor\bin\Debug\DexProcessor.dll" to "bin\DexProcessor.dll". The process cannot access the file 'bin\DexProcessor.dll' because it is being used by another process. InVision2 Error 166 Unable to copy file "C:\InOne\Common\DexParser\bin\Debug\InOne.DexParser.dll" to "bin\InOne.DexParser.dll". The process cannot access the file 'bin\InOne.DexParser.dll' because it is being used by another process. InVision2 Error 167 Unable to copy file "C:\InOne\Common\AlertProcessor\bin\Debug\InOne.Invision.AlertProcessing.dll" to "bin\InOne.Invision.AlertProcessing.dll". The process cannot access the file 'bin\InOne.Invision.AlertProcessing.dll' because it is being used by another process. InVision2 Error 168 Unable to copy file "C:\InOne\Common\InVision.BusinessLogic\bin\Debug\InVision.BusinessLogic.dll" to "bin\InVision.BusinessLogic.dll". The process cannot access the file 'bin\InVision.BusinessLogic.dll' because it is being used by another process. InVision2 Error 169 Unable to copy file "C:\InOne\Common\InVision.Common\bin\Debug\InVision.Common.dll" to "bin\InVision.Common.dll". The process cannot access the file 'bin\InVision.Common.dll' because it is being used by another process. InVision2 Error 170 Unable to copy file "C:\InOne\Data\bin\Debug\InVision.Data.dll" to "bin\InVision.Data.dll". The process cannot access the file 'bin\InVision.Data.dll' because it is being used by another process. InVision2 Error 171 Unable to copy file "C:\InOne\Common\InVision.DataAccessLayer\bin\Debug\InVision.DataAccessLayer.dll" to "bin\InVision.DataAccessLayer.dll". The process cannot access the file 'bin\InVision.DataAccessLayer.dll' because it is being used by another process. InVision2 Error 172 Unable to copy file "C:\InOne\Common\InVision.DataAccessLayer.SqlClient\bin\Debug\InVision.DataAccessLayer.SqlClient.dll" to "bin\InVision.DataAccessLayer.SqlClient.dll". The process cannot access the file 'bin\InVision.DataAccessLayer.SqlClient.dll' because it is being used by another process. InVision2
This just started happening a week ago and is very annoying... I have to go into the web app's bin folder and delete the pdb files and then it'll let me delete the dll's most of the time. Every once in a while it doesn't let me so I have to close Visual Studio and then it lets me delete them. I checked and it's Visual Studio (devenv) that is locking the dll's. Rebooting the machine doesn't help.
This is really reducing my productivity, is there anything I can do to resolve this?
As mentioned, Visual Studio 2008 (devenv.exe) is the process locking the DLLs.
I noticed something... When it compiles successfully, it's copying all the DLLs into the bin folder, then they are all deleted, then a new set are copied into the bin. When it isn't successfull, the first set of DLLs are copied in, then it fails. So it seems to be using the bin folder for 2 things when it should only be for 1. Does this help??
The issue ended up being that in the web.config someone had added:
hostingEnvironment shadowCopyBinAssemblies="false"
After commenting this out, everything started building ok. What a nightmare!!
What worked for me is the following pre-build event:
if exist "$(TargetPath).locked.bak" del "$(TargetPath).locked.bak"
if exist "$(TargetPath).bak" del "$(TargetPath).bak"
if exist "$(TargetPath).locked" ren "$(TargetPath).locked" "$(TargetPath).locked.bak"
if exist "$(TargetPath)" ren "$(TargetPath)" "$(TargetPath).bak"
What I have noticed in my case is that the 2 files are being created and can not be deleted. You can, however, rename them (and they are still in use if you try to delete them). On a next build, the renamed files are no longer in use (lock removed) and they can be deleted, which is what the above script does, after which it can safely rename the new locked files so there will be no problems in generating the build output.
The other pre-build events posted here and in other places did not help me a lot (they worked only for one extra build or only a few before the problem arose again). So now I am currently using the one posted above for my debugging purposes.
Use ProcessExplorer to find out what process has the file open and go from there.
If a process is currently using those DLL, you can't delete and re-write it. You'll have to kill or otherwise stop the process using those DLLs while you compile.
I just wanted to say that this problem started with me today. (VS 2010, C#) I have been working on this program for a month without this problem, now today it started. I start VS, change code, compile and test and quit program. Make another change, compile and BOOM Unable to copy file "obj\x86\Debug\progname.exe" to "bin\Debug\progname.exe" because if is being used by another process.
ProcExp shows only Visual Studio (actually devenv.exe) using this file. There is only one instance of VS running. There are two listing on my debug\progname.exe, one is a Type DLL, the other is a Type handle.
Using devenv /ResetSettings did not resolve anything, but wasted 10 minutes putting everything back to my desired view.
Using the PREBUILD events rename trick mentioned above solves the problem for a couple of changes, but on the next change the "exe.locked" file is locked and cannot be deleted. Then the rename fails.
The debug\progname.exe file name remains locked even after closing the project.
Closing VS, manually delete the files in the debug folder, opening VS and my solution, then Build->Clean Solution seems to work for me, at least its working now after I did all of that stuff.
Hope this helps -rwg
File locks are just part of working with Visual Studio. There aren't any great ways to get around this problem.
Hi I'm facing the same issue for a little while. It's very annoying.
I have an easier yet not so efficient solution for the problem. Cleaning the project or solution solves the problem.
Easy fix for Windows 7: Start the service "Application Experience" . Search for "Services" in "Control Panel".
-Martin
You could download the excellent SysInternals Handle program. This will tell you which processes have a lock on the files concerned.
If it is an external program (e.g. virus scanner/indexer) then this should help. If it just reports Visual Studio (devenv.exe) as the culprit, then it will be of less help!
I'm assuming you already know it's VS2008 which is locking the files. You can try running MSBuild from the command line and see if the problems disappear. Unfortunately Visual Studio can keep files locked when it shouldn't, in some hard-to-predict scenarios.
There was a specific bug in Visual Studio 2008 which was fixed in SP1 which may be your issue. It occurs when you reference an embedded JavaScript file and causes the problem you are seeing. See here for more details.
I have battled this issue FOR YEARS!
Have you tried adding this to your PREBUILD Event?
if exist "$(TargetPath).locked" del "$(TargetPath).locked" if exist "$(TargetPath)" if not exist "$(TargetPath).locked" move "$(TargetPath)" "$(TargetPath).locked"
SEE THIS FOR MORE INFO: http://nayyeri.net/file-lock-issue-in-visual-studio-when-building-a-project
Here's another thread, with more things to try...
h t t p ://social.msdn.microsoft.com/forums/en-US/Vsexpressinstall/thread/5b71eb06-5047-483d-8fd3-b75c102d41e9/?prof=required
@ I did had simillar problem solution for me was to look at the *.csproj file and under i found missing file so and below was correct one so i just removed lines and it worked straight away
Removing the following lines from my app.config solved this for me - I'm using VS2010.
<runtime>
<assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
<dependentAssembly>
<assemblyIdentity name="nunit.framework" publicKeyToken="96D09A1EB7F44A77" culture="neutral"/>
<bindingRedirect oldVersion="0.0.0.0-2.5.7.10213" newVersion="2.5.7.10213"/>
</dependentAssembly>
</assemblyBinding>
</runtime>
Check if the user dll and the application referencing the dll target the same .NET framework. I had a case where the frameworks were different which caused this problem.
I didn't have any luck with the pre-build events unfortunately. What worked, in typical IT Crowd fashion, was to quit Visual Studio and reopen it.
The file cannot be deleted, fortunately can be renamed and moved. So I created prebuild batch (using date and time as random string, there can be easier ways):
For /f "Tokens=2,3,4 Delims=/. " %%i In ("%Date%") Do @( Set Month=%%i& Set Day=%%j& Set Year=%%k )
set ActDate=%Year%-%Month%-%Day%
For /f "Tokens=1,2,3 Delims=/.:, " %%i In ("%Time%") Do @( Set Hour=0%%i& Set Min=%%j& Set Sec=%%k )
set ActTime=%Hour:~-2,2%-%Min%-%Sec%
move c:\MyProject\bin\Debug\myproject.exe c:\garbage\%ActDate%_%ActTime%_myproject.exe
Just go to \Debug\bin and delete all .dll files.
Working great for me.
I have two solutions which have some common code, so I'd like to extract it out and share it between them. Furthermore, I'd like to be able to release that library independently because it might be useful to others. What's the best way to do it with Visual Studio 2008? Is a project present in more than one solution? Do I have a separate solution for the separate piece of code? Can a solution depend on another one?
You can "link" a code file between two projects. Right click your project, choose Add -> Existing item, and then click the down arrow next to the Add button:
In my experience linking is simpler than creating a library. Linked code results in a single executable with a single version.
A project can be referenced by multiple solutions.
Put your library or core code into one project, then reference that project in both solutions.
You would simply create a separate Class Library project to contain the common code. It need not be part of any solution that uses it. Reference the class library from any project that needs it.
The only trick at all is that you will need to use a file reference to reference the project, since it will not be part of the solutions that refer to it. This means that the actual output assembly will have to be placed in a location that can be accessed by anyone building a project that references it. This can be done by placing the assembly on a share, for instance.
You can include a project in more than one solution. I don't think a project has a concept of which solution it's part of. However, another alternative is to make the first solution build to some well-known place, and reference the compiled binaries. This has the disadvantage that you'll need to do a bit of work if you want to reference different versions based on whether you're building in release or debug configurations.
I don't believe you can make one solution actually depend on another, but you can perform your automated builds in an appropriate order via custom scripts. Basically treat your common library as if it were another third party dependency like NUnit etc.
File > Add > Existing Project... will let you add projects to your current solution. Just adding this since none of the above posts point that out. This lets you include the same project in multiple solutions.
You could include the same project in more than one solution, but you're guaranteed to run into problems sometime down the road (relative paths can become invalid when you move directories around for example)
After years of struggling with this, I finally came up with a workable solution, but it requires you to use Subversion for source control (which is not a bad thing)
At the directory level of your solution, add a svn:externals property pointing to the projects you want to include in your solution. Subversion will pull the project from the repository and store it in a subfolder of your solution file. Your solution file can simply use relative paths to refer to your project.
If I find some more time, I'll explain this in detail.
Extract the common code into a class library project and add that class library project to your solutions. Then you can add a reference to the common code from other projects by adding a project reference to that class library. The advantage of having a project reference as opposed to a binary/assembly reference is that if you change your build configuration to debug, release, custom, etc, the common class library project will be built based on that configuration as well.
It is a good idea to create a dll class library that contain all common functionality. Each solution can reference this dll indepently regardless of other solutions.
Infact , this is how our sources are organized in my work (and I believe in many other places).
By the way , Solution can't explicitly depend on another solution.
If you're attempting to share code between two different project types (I.e.: desktop project and a mobile project), you may look into the shared solutions folder. I have to do that for my current project as the mobile and desktop projects both require identical classes that are only in 1 file. If you go this route, any of the projects that have the file linked can make changes to it and all of the projects will be rebuilt against those changes.
Does Eclipse have an analog to Visual Studio's "Immediate Window", a window where I can evaluate statements while in the debugger?
Yes. The view name is "Display".
Window->Show View->Other It is under the Debug folder.
Once in there you evaluate statements while in the debugger.
Eclipse has a really cool concept call Scrapbook Pages where you can evaluate statements even when you're not debugging. However, if you want to eval code using values from the current program, go to Window->Show View->Expressions. There you can put in any expression you want and track it as your program executes.
Inspect ctrl-shift-i or Display ctrl-shift-d?
I'm working on a page using <canvas>, which is a HTML5 tag, in Visual Web Developer Express Edition 2008, and the validator in the HTML editor is telling me it's an invalid tag. That's because it's set to validate against XHTML 1.0 Transitional. I'd prefer for it to not do that and tell me what's valid or invalid based on the HTML5 doctype, but I can't find anywhere in the preferences that suggests this would be possible.
Is there a way to tell Visual Studio to validate against HTML5, or add a new spec reference manually? I'd prefer not to have to go in and add tags manually, which appears to be the only option at the moment.
It looks like the Visual Web Developer team solved the problem by adding HTML5 support themselves: http://blogs.msdn.com/webdevtools/archive/2009/11/18/html-5-intellisense-and-validation-schema-for-visual-studio-2008-and-visual-web-developer.aspx
You all probably know that new HTML 5 standard is coming. We made a new intellisense schema that you can add to VS 2008 or VWD Express 2008 and get intellisense and validation on HTML 5 elements.
For Visual Studio 2010 you'll want to install the Web Standards Update for Visual Studio 2010 SP1:
It updates the HTML5 intellisense and validation to reflect the latest W3C specifications and fixes some bugs bugs in the current SP1 support for HTML5. Also JavaScript intellisense it updated to reflect many of the new browser capabilities such as Geolocation and DOM storage. Finally, this update adds comprehensive CSS3 intellisense and validation based on the latest specifications from W3C.
For Visual Studio 2008, Microsoft has provided an updated version of the HTML 5 validation schema and intellisense in the Visual Studio Gallery.
The updated schema was posted by Mikhail Arkhipov, the same Microsoft employee who wrote the blog post linked in Rahul's answer.
I created a validation schema that you're free to use: http://johndyer.name/post/2009/07/21/HTML5-XHTML5-Validation-Schema-for-Visual-Studio-2008.aspx
You can define your own validation standards.
You need to add the file to the folder in VS install, and add to the registry.
This is the description I used (HTML and CSS have a very similar approach): http://blogs.msdn.com/mikhailarkhipov/archive/2007/10/19/how-to-create-custom-css-intellisense-schema-in-visual-studio-2005-and-2008.aspx
In Visual Studio 2005 the XSD compiler was in the SDK/v2.0 directory. In Visual Studio there is only a SDK/v3.5 directory has gone and so too has the xsd.exe compiler. Where has it gone?
Tony
Not being completely happy with the above answers I have found that the SDK containing amongst other things the XSD.exe compiler is distributed now as part of the Windows SDK. See http://msdn.microsoft.com/en-gb/windows/bb980924.aspx?wt.svl=more_downloads
It is distributed as part of the Visual Studio 2008 package but they have moved it from the Visual Studio directory tree to "Program Files/Microsoft SDKs".
I have xsd.exe here
C:\Program Files\Microsoft SDKs\Windows\v6.0A\bin\xsd.exe
C:\Program Files\Microsoft Visual Studio 8\SDK\v2.0\Bin\xsd.exe
I have VS2005 and VS2008 installed (and had VS2003 before installed).
I have xsd.exe here: C:\Program Files\Microsoft SDKs\Windows\v6.0A\bin\xsd.exe So I think you have yours at the Windows Platform SDK corresponding path on your machine. Make sure you have installed PlatformSDK sometimes it can be in VisualStudio directory
Is it a best practice to commit a .sln file to source control? When is it appropriate or inappropriate to do so?
Update There were several good points made in the answers. Thanks for the responses!
Yes -- I think it's always appropriate. User specific settings are in other files.
I think it's clear from the other answers that solution files are useful and should be committed, even if they're not used for official builds. They're handy to have for anyone using Visual Studio features like Go To Definition/Declaration.
By default, they don't contain absolute paths or any other machine-specific artifacts. (Unfortunately, some add-in tools don't properly maintain this property, for instance, AMD CodeAnalyst.) If you're careful to use relative paths in your project files (both C++ and C#), they'll be machine-independent too.
Probably the more useful question is: what files should you exclude? Here's the content of my .gitignore file for my VS 2008 projects:
*.suo
*.user
*.ncb
Debug/
Release/
CodeAnalyst/
(The last entry is just for the AMD CodeAnalyst profiler.)
For VS 2010, you should also exclude the following:
ipch/
*.sdf
*.opensdf
Yes you should do this. A solution file contains only information about the overall structure of your solution. The information is global to the solution and is likely common to all developers in your project.
It doesn't contain any user specific settings.
You should definitely have it. Beside the reasons other people mentioned, it's needed to make one step build of the whole projects possible.
I generally agree that solution files should be checked in, however, at the company I work for we have done something different. We have a fairly large repository and developers work on different parts of the system from time to time. To support the way we work we would either have one big solution file or several smaller. Both of these have a few shortcomings and require manual work on the developers part. To avoid this, we have made a plug-in that handles all that.
The plug-in let each developer check out a subset of the source tree to work on simply by selecting the relevant projects from the repository. The plugin then generates a solution file and modifies project files on the fly for the given solution. It also handles references. In other words, all the developer has to do is to select the appropriate projects and then the necessary files are generated/modified. This also allows us to customize various other settings to ensure company standards.
Additionally we use the plug-in to support various check-in policies, which generally prevents users from submitting faulty/non-compliant code to the repository.
Yes, it should be part of the source control. When ever you add/remove projects from your application, .sln would get updated and it would be good to have it under source control. It would allow you to pull out your application code 2 versions back and directly do a build (if at all required).
Yes, things you should commit are:
Things you should not commit are:
Regarding other automatically generated files, there is a separate thread.
Yes, you always want to include the .sln file, it includes the links to all the projects that are in the solution.
We do because it keeps everything in sync. All the necessary projects are located together, and no one has to worry about missing one. Our build server (Ant Hill Pro) also uses the sln to figure which projects to build for a release.
The only case where you would even considder not storing it in source control would be if you had a large solution with many projects which was in source control, and you wanted to create a small solution with some of the projects from the main solution for some private transient requirement.
Yes - Everything used to generate your product should be in source control.
We keep or solution files in TFS Version Control. But since or main solution is really large, most developers have a personal solution containing only what they need. The main solution file is mostly used by the build server.
We usually put all of our solutions files in a solutions directory. This way we separate the solution from the code a little bit, and it's easier to pick out the project I need to work on.
Under most circumstances, it's a good idea to commit .sln files to source control.
If your .sln files are generated by another tool (such as CMake) then it's probably inappropriate to put them into source control.
.slns are the only thing we haven't had problems with in tfs!
1) Create a new project in VS
2) Right click on the solution in Solution Explorer, select Add to Source Control
Is the sln added to source control? That's your answer.
Firefox is set as Windows' default browser.
I want to change the default browser used by Visual Studio for debugging. Normally the route I'd take to do this is right clicking on an .aspx file and setting the default from the Browse With... dialog.
Unfortunately, ASP.NET MVC Views don't have the Browse With... option.
In what other ways can you set the default browser for ASP.NET MVC projects?
Related, but NOT ASP.NET MVC specific:
Visual Studio opens the default browser instead of Internet Explorer
For MVC1:
For MVC2:
For VS2010:
You can try this extension. It is safe, hopefully this will be added in the next releases of Visual Studio.
http://visualstudiogallery.msdn.microsoft.com/en-us/bb424812-f742-41ef-974a-cdac607df921
There appears to be an answer here
If you right click on any page other than default.aspx you will not get the "browse with" option.
So, when working on an ASP.NET MVC application, right click on default.aspx and chose "Browse With..." Then you'll get a dialog that will allow you to change your default browser.
For an ASP.NET MVC 2 project in Visual Studio 2010 I've found that
Then the context menu offers a Browse with... option when right-clicking on this file in the solution explorer.
answer here
1) Right click on a .aspx page in your solution explorer
2) Select the "browse with" context menu option
3) In the dialog you can select or add a browser. If you want Firefox in the list, click "add" and point to the other browser name (ex:firefox.exe) filename
4) Click the "Set as Default" button to make this the default browser when you run any page on the site.
In visual studio 2010 you can use this extension: World of VS Default Browser Switcher
Even if I create a clean WinForms project, Edit and Continue doesn't work and gives me the error mentioned above.
I also found this article on MSDN website: http://msdn.microsoft.com/en-us/library/ms164927(VS.80).aspx :
Unsupported Scenarios
Edit and Continue is not available in the following debugging scenarios:
Debugging on Windows 98.
Mixed-mode (native/managed) debugging.
SQL debugging.
Debugging a Dr. Watson dump.
Editing code after an unhandled exception, when the "Unwind the call stack on unhandled exceptions" option is not selected.
Debugging an embedded runtime application.
Debugging an application with Attach to rather than running the application with Start from the Debug menu.
Debugging optimized code.
Debugging managed code when the target is a 64-bit application. If you want to use Edit and Continue, you must set the target to x86. (Project Properties, Compile tab, Advanced Compiler setting.).
Debugging an old version of your code after a new version failed to build due to build errors.
But I can answer "No" to every item in this list.
It worked before, but several days ago it stopped working, and I don't know what could be the reason.
I finally got to solve the problem: UNINSTALL Gallio
Gallio seems to have quite some many rough edges and it's better to not use MbUnit 3.0 but use the MbUnit 2.0 framework but use the gallio runner, that you are running without installing from the installer (which also installed a visual studio plugin).
Incidentally, I had the issue even after "disabling" he Gallio plugin. Only the uninstall solved the problem.
PS. Edited by nightcoder:
In my case disabling TypeMock Isolator (mocking framework) finally helped! Edit & Continue now works!!!
Here is the answer from TypeMock support:
After looking further into the edit and continue issue, and conversing about it with Microsoft, we reached the conclusion it cannot be resolved for Isolator. Isolator implements a CLR profiler, and according to our research, once a CLR profiler is enabled and attached, edit and continue is automatically disabled. I'm sorry to say this is no longer considered a bug, but rather a limitation of Isolator.
None of the above solutions worked for me(running on a 64x machine).
Finally I clicked on 'advanced compiler settings' and UNCHECKED 'enable optimizations' and I can now step through code and edit while debugging.
Couple of things to check
EDIT
I don't believe this should matter but make sure that the hosting process is enabled for the target platform. Probably won't help.
If it repros for new projects then it might be something even more subtle. I would try the following.
I had the same problem. I even re-installed VS 2008 but the problem did not go away. However, when I deleted all the break points then it started to work.
Debug->Delete All Breakpoints
I think it was happening because I had deleted an aspx page that had break points in its code, and then I created another page with the same name. This probably confused the VS 2008.
If you're debugging an ASP.NET application, go to properties > web > Servers, and make sure that "enable and continue" is checked under Use Visual Studio Development Server.
That happens when the debugger hasn't hit a breakpoint or you haven't hit Break All (pause). It couldn't be that simple could it?
Go To Project Solution Property Set Configuration as Debug..
The error says a possible cause is: "the code being debugged was optimized at build or run time". Go to Project Properties->Debug and uncheck the Optimize Code box for Debug mode.
For me, for a reason that I don't understand, the setting "Generate debug info" in the "Advanced Compiler Settings" was set to "pdb-only" instead of "Full".
By default, this parameter is always set to "Full" but a mysterious poltergeist has changed this parameter on last night. :)
P.S. I'm in Visual Basic .Net with Visual Studio 2010
If I create a new project, edits while debugging do not work. If I create a new website, edits while debugging work as expected.
In my case just reseting to default debugger settings and setting IntelliTrace-> only intellytrace events helps
If your concern is with an ASP.NET app, ensure you have edit and continue enabled on the web tab (vs2010). There was also a separate setting for ASP.NET debugging in earlier versions.
Regards,
Adam.
I found that even though under project properties build & debug tab are set to Debug and all the other setting are correct I still get the message, however after digging some more under the Build menu select Configurations Manager... and make sure Debug is selected in two places there as well. go figure...how many different places do they need to set debug?????? even though you set Project - Configuration to Debug then under Build - Manager it is not changed so you have change the same setting there as well Project Configuration - seems like a microsoft issue again.......
This problem is due to Intellitrace setting
If Intellitrace is enabled make sure Intellitrace event only is checked
Otherwise this will not allow edit and continue..
If you will click on Intellitrace options you will see the warnings.
Some things that seemed to help using VS2010:
For creating algorithm template function I need to know whether x or X (and y or Y) in class that is template argument. It may by useful when using my function for MFC CPoint class or GDI+ PointF class or some others. All of them use different x in them. My solution could be reduces to the following code:
template<int> struct TT {typedef int type;};
template<class P> bool Check_x(P p, typename TT<sizeof(&P::x)>::type b = 0) { return true; }
template<class P> bool Check_x(P p, typename TT<sizeof(&P::X)>::type b = 0) { return false; }
struct P1 {int x; };
struct P2 {float X; };
// it also could be struct P3 {unknown_type X; };
int main()
{
P1 p1 = {1};
P2 p2 = {1};
Check_x(p1); // must return true
Check_x(p2); // must return false
return 0;
}
But it does not compile in Visual Studio, while compiling in the GNU C++. With Visual Studio I could use the following template:
template<class P> bool Check_x(P p, typename TT<&P::x==&P::x>::type b = 0) { return true; }
template<class P> bool Check_x(P p, typename TT<&P::X==&P::X>::type b = 0) { return false; }
But it does not compile in GNU C++. Is there universal solution?
UPD: Structures P1 and P2 here are only for example. There are could be any classes with unknown members.
Another way is this one, which relies on SFINAE for expressions too. If the name lookup results in ambiguity, the compiler will reject the template
template<typename T> struct HasX {
struct Fallback { int x; }; // introduce member name "x"
struct Derived : T, Fallback { };
template<typename C, C> struct ChT;
template<typename C> static char (&f(ChT<int Fallback::*, &C::x>*))[1];
template<typename C> static char (&f(...))[2];
static bool const value = sizeof(f<Derived>(0)) == 2;
};
struct A { int x; };
struct B { int X; };
int main() {
std::cout << HasX<A>::value << std::endl; // 1
std::cout << HasX<B>::value << std::endl; // 0
}
It's based on a brilliant idea of someone on usenet.
Why don't you use specialization like this:
struct P1 {int x; };
struct P2 {int X; };
template<class P>
bool Check_x(P p) { return true; }
template<>
bool Check_x<P2>(P2 p) { return false; }
The second answer (litb's) to this shows how to detect a member:
http://stackoverflow.com/questions/257288/possible-for-c-template-to-check-for-a-functions-existence
Boost.ConceptTraits provides between others some macros to define type traits, as for example BOOST_TT_EXT_DEFINE_HAS_MEMBER(name), which defines a type trait of the form:
has_member_##name<T>
This gives true if T has a member type named . Note, however, that this won't detect reference type members.
In you case it will be enough to add in a header file
BOOST_TT_EXT_DEFINE_HAS_MEMBER_TYPE(x)
and check as follows
BOOST_STATIC_ASSERT(has_member_x<P1>::value);
The technique used is the same as the one explained on some of the preceding answers.
Unfortunately this library is no more maintained. Now that C++0x will not includes concept, this library together with SFINAE is a perfect replacement to work with most of the concepts.
Long answer is below, but here's a snippet of how the code below ends up being used:
//Multiple inheritance forces ambiguity of member names.
//SFINAE is used to make aliases to member names.
//Expression SFINAE is used to write just one has_member
//that can accept any alias we pass it.
has_member<alias_x<ambiguate<A, var_x>>, alias_x<var_x>>::value;
I know this is an old question, but I thought I'd throw in another answer. Cobbled this together from various has_memberXYZ solutions I've seen here on SO (including the answer I accepted on this question) and on the web. It uses plain SFINAE and expression SFINAE. I wanted to be able to have just a single has_member meta function that could accept the name of a member I want to check for, along with the class to check.
Effectively, what this code does is set up an alias to the member. In the alias, we create a member with a common name which all aliases will use, and make it dependent on the type of the actual member we're checking for. Here, SFINAE dictates whether that member will exist in the resulting alias. Then has_member is set up to check for the common alias member name using expression SFINAE. There's also a static_assert in there that I think should eliminate the scenario I describe in the question I link to above, where the member name being checked is specified in multiple places and has the potential for typos (the "member does not exist at all" case).
has_member and helpers:
//template <typename... Args> struct ambiguate : public Args... {};
//non-variadic ambiuate
template <typename A, typename B> struct ambiguate : public A, public B {};
template<typename A>
struct got_type : std::true_type {};
template<typename AmbiguousMember, typename Member>
struct has_member {
template<typename C> static char ((&f(decltype(&C::value))))[1];
template<typename C> static char ((&f(...)))[2];
//Make sure the member name is consistently spelled the same.
static_assert(
(sizeof(f<Member>(0)) == 1)
, "Member name being checked is different from member name specified in alias."
);
static bool const value = sizeof(f<AmbiguousMember>(0)) == 2;
};
Code that user of has_member will need to set up. I wanted this to be a minimal amount of code to be reproduced for each member name being checked:
//Want to test for an x member and then a y member...
struct Member_x { int x; };
template<typename T, typename = std::true_type>
struct AliasTo_x;
template<typename T>
struct AliasTo_x<
T, std::integral_constant<bool, got_type<decltype(&T::x)>::value>
> { static const decltype(&T::x) value; };
struct Member_y { int yy; }; //Somebody fat-fingered the member name.
template<typename T, typename = std::true_type>
struct AliasTo_y;
template<typename T>
struct AliasTo_y<
T, std::integral_constant<bool, got_type<decltype(&T::y)>::value>
> { static const decltype(&T::y) value; };
Usage:
//Pretend these classes are not under our control,
//and have unknown member innards.
struct ClassA { char x; };
struct ClassB { string y; };
struct ClassC { private: float x(int); }; //Seems to work...
int main() {
bool AHasMember_x = has_member<
AliasTo_x<ambiguate<ClassA, Member_x>>, AliasTo_x<Member_x>
>::value; //true
bool BHasMember_x = has_member<
AliasTo_x<ambiguate<ClassB, Member_x>>, AliasTo_x<Member_x>
>::value; //false
bool BHasMember_y = has_member<
AliasTo_y<ambiguate<ClassB, Member_y>>, AliasTo_y<Member_y>
>::value; //triggers static_assert about member name consistency.
bool CHasMember_x = has_member<
AliasTo_x<ambiguate<ClassC, Member_x>>, AliasTo_x<Member_x>
>::value;
//true... Seems like it should be false since this is a private x()
//Don't know enough of the c++ specs to know why this seems to work.
}
I didn't do extensive testing by any means, so I'd be interested in any caveats with this method, ways to shrink the amount of code the user has to write to alias the member name, or other possible improvements.
Why don't you just create template specializations of Check_x ?
template<> bool Check_x(P1 p) { return true; }
template<> bool Check_x(P2 p) { return false; }
Heck, when I think of it. If you only have two types, why do you even need templates for this?
Are the functions (x, X, y, Y) from an abstract base class, or could they be refactored to be so? If so you can use the SUPERSUBCLASS() macro from Modern C++ Design, along with ideas from the answer to this question:
http://stackoverflow.com/questions/145814/compile-time-type-based-dispatch
I save 100.000 Vectors of in a database. Each vector has a dimension 60. (int vector[60])
Then I take one and want present vectors to the user in order of decreasing similarity to the chosen one.
I use Tanimoto Classifier to compare 2 vectors:
Is there any methods to avoid doing through all entries in the database?
One more thing! I don't need to sort all vectors in the database. I whant to get top 20 the most similar vectors. So maybe we can roughly threshold 60% of entries and use the rest for sorting. What do you think?
First, preprocess your vector list to make each vector normalized.. unit magnitude. Notice now that your comparison function T() now has magnitude terms that become constant, and the formula can be simplified to finding the largest dot product between your test vector and the values in the database.
Now, think of a new function D = the distance between two points in 60D space. This is classic L2 distance, take the difference of each component, square each, add all the squares, and take the square root of the sum. D(A, B) = sqrt( (A-B)^2) where A and B are each 60 dimensional vectors.
This can be expanded, though, to D(A, B) = sqrt(A * A -2*dot(A,B) + B * B). A and B are unit magnitude, then. And the function D is monotonic, so it won't change the sort order if we remove the sqrt() and look at squared distances. This leaves us with only -2 * dot(A,B). Thus, miniumizing distance is exactly equivalent to maximizing dot product.
So the original T() classificiation metric can be simplified into finding the highest dot product between the nornalized vectors. And that comparison is shown equivalent to finding the closest points to the sample point in 60-D space.
So now all you need to do is solve the equivalent problem of "given a normalized point in 60D space, list the 20 points in the database of normalized sample vectors which are nearest to it."
That problem is a well understood one.. it's K Nearest Neighbors. There are many algorithms for solving this. The most common is classic KD trees .
But there's a problem. KD trees have an O(e^D) behavior.. high dimensionality quickly becomes painful. And 60 dimensions is definitely in that extremely painful category. Don't even try it.
There are several alternative general techniques for high D nearest neighbor however. This paper gives a clear method.
But in practice, there's a great solution involving yet another transform. If you have a metric space (which you do, or you wouldn't be using the Tanimoto comparison), you can reduce the dimensionality of the problem by a 60 dimensional rotation. That sounds complex and scary, but it's very common.. it's a form of singular value decomposition, or eigenvalue decomposition. In statistics, it's known as Principal Components Analysis.
Basically this uses a simple linear computation to find what directions your database really spans. You can collapse the 60 dimensions down to a lower number, perhaps as low as 3 or 4, and still be able to accurately determine nearest neighbors. There are tons of software libraries for doing this in any language, see here for example.
Finally, you'll do a classic K nearest neighbors in probably only 3-10 dimensions.. you can experiment for the best behavior. There's a terrific library for doing this called Ranger, but you can use other libraries as well. A great side benefit is you don't even need to store all 60 components of your sample data any more!
The nagging question is whether your data really can be collapsed to lower dimensions without affecting the accuracy of the results. In practice, the PCA decomposition can tell you the maximum residual error for whatever D limit you choose, so you can be assured it works. Since the comparison points are based on a distance metric, it's very likely they are intensely correlated, unlike say hash table values.
So the summary of the above:
Update:
After you made clear that 60 is the dimension of your space, not the length of the vectors, the answer below is not applicable for you, so I'll keep it just for history.
Since your vectors are normalized, you can employ kd-tree to find the neighbors within an MBH of incremental hypervolume.
No database I'm aware of has native support of kd-tree, so you can try to implement the following solution in MySQL, if you are searching for a limited number of closest entries:
2-dimensional space possible (takes n * (n - 1) / 2 columns)SPATIAL indexMBR of a given area within any projection. The product of these MBR's will give you a hypercube of a limited hypervolume, which will hold all vectors with a distance not greater than a given one.MBR's using MBRContainsYou'll still need to sort within this limited range of values.
For instance, you have a set of 4-dimensional vectors with magnitude of 2:
(2, 0, 0, 0)
(1, 1, 1, 1)
(0, 2, 0, 0)
(-2, 0, 0, 0)
You'll have to store them as follows:
p12 p13 p14 p23 p24 p34
--- --- --- --- --- ---
2,0 2,0 2,0 0,0 0,0 0,0
1,1 1,1 1,1 1,1 1,1 1,1
0,2 0,0 0,0 2,0 2,0 0,0
-2,0 -2,0 -2,0 0,0 0,0 0,0
Say, you want similarity with the first vector (2, 0, 0, 0) greater than 0.
This means having the vectors inside the hypercube: (0, -2, -2, -2):(4, 2, 2, 2).
You issue the following query:
SELECT *
FROM vectors
WHERE MBRContains('LineFromText(0 -2, 4 2)', p12)
AND MBRContains('LineFromText(0 -2, 4 2)', p13)
?
, etc, for all six columns
So the following information can be cached:
If you only need the N closest vectors or if you are doing this same sorting process multiple times, there may be further tricks available. (Observations like T(A,B)=T(B,A), caching the vector norms for all the vectors, and perhaps some sort of thresholding/spatial sort).
In order to sort something, you need a sorting key for each item. So you will need to process each entry at least once to calculate the key.
Is that what you think of?
======= Moved comment here:
Given the description you cannot avoid looking at all entries to calculate your similarity factor. If you tell the database to use the similarity factor in the "order by" clause you can let it do all the hard work. Are you familiar with SQL?
In short, no, probably not any way to avoid going through all the entries in the database. One qualifier on that; if you have a significant number of repeated vectors, you may be able to avoid reprocessing exact repeats.
Uh, no?
You only have to do all 99,999 against the one you picked (rather than all n(n-1)/2 possible pairs), of course, but that's as low as it goes.
Looking at your response to nsanders's answer, it is clear you are already on top of this part. But I've thought of a special case where computing the full set of comparisons might be a win. If:
then you could pre-compute the as the data comes in and just lookup the results per pair at sort time. This might also be effective if you will end up doing many sorts...
Newer answer
How much preprocessing can you do? Can you build "neighborhoods" ahead of time and note which neighborhood each vector is in inside the database? That might let you eliminate many vectors from consideration.
Old answer below, which assumed 60 was magnitude of all the vectors, not the dimension.
Since the vectors are all the same length (60), I think you're doing too much math. Can't you just do the dot product of the chosen one against each candidate?
In 3D:
Three multiplies. In 2D it's just two multiplies.
Or does that violate your idea of similarity? To me, the most similar vectors are the ones with the least angular distance between them.
If you're willing to live with approximations, there are a few ways you can avoid having to go through the whole database at runtime. In a background job you can start pre-computing pairwise distances between vectors. Doing this for the whole database is a huge computation, but it does not need to be finished for it to be useful (i.e. start computing distances to 100 random vectors for each vector or so. store results in a database).
Then triangulate. if the distance d between your target vector v and some vector v' is large, then the distance between v and all other v'' that are close to v' will be large(-ish) too, so there is no need to compare them anymore (you will have to find acceptable definitions of "large" yourself though). You can experiment with repeating the process for the discarded vectors v'' too, and test how much runtime computation you can avoid before the accuracy starts to drop. (make a test set of "correct" results for comparisons)
good luck.
sds
Without going trough all entries? It seems not possible. The only thing you can do is to do the math at insert time (remembering that :P ).
This avoids your query to check the list against all the other lists at execution time (but it could heavily increase the space needed for the db)
Another take on this is the all pair problem with a given threshold for some similarity function. Have a look at bayardo's paper and code here http://code.google.com/p/google-all-pairs-similarity-search/
I do not know if your similarity function matches the approach, but if so, that is another tack to look at. It would also require normalized and sorted vectors in any case.
When I try to compile an assembly in VS 2008, I got (occasionally, usually after 2-3 hours of work with the project) the following error
Metadata file '[name].dll' could not be opened -- 'Not enough storage is available to process this command.
Usually to get rid of that I need to restart Visual Studio
The assembly I need to use in my project is BIG enough (> 70 Mb) and probably this is the reason of that bug, I've never seen some thing like this in my previous projects. Ok, if this is the reason my question is why this happens and what I need to do to stop it.
I have enough of free memory on my drives and 2Gb RAM (only ~1.2 Gb are utilized when exception happens)
I googled for the answers to the questions like this.
Suggestions usually related to: 1) to the number of user handlers that is limited in WinXP... 2) to the physical limit of memory available per process
I don't think either could explain my case
For user handlers and other GUI resources - I don't think this could be a problem. The big 70Mb assembly is actually a GUI-less code that operates with sockets and implements parsers of a proprietary protocols. In my current project I have only 3 GUI forms, with total number of GUI controls < 100.
I suppose my case is closer to the fact that in Windows XP the process address space is limited with 2 GB memory (and, taking into account memory segmentation, it is possible that I don't have a free segment large enough to allocate a memory). However, it is hard to believe that segmentation could be so big after just 2-3 hours of working with the project in Visual Studio. Task Manager shows that VS consumes about 400-500 Mb (OM + VM). During compilation, VS need to load only meta-data. Well, there are a lot of classes and interfaces in that library, but still I would expect that 1-2 Mb is more then enough to allocate metadata that is used by compiler to find all public classes and interfaces (though it is only my suggestion, I don't know what exactly happens inside CLR when it loads assembly metadata).
In addition, I would say that entire assembly size is so big only because it is C++ CLI library that has other um-managed libraries statically linked into one DLL. I estimated (using Reflector) that .NET (managed) code is approx 5-10% of this assembly.
Any ideas how to define the real reason of that bug? Are there any restrictions or recommendations as to .NET assembly size? (Yes I know that it worth thinking of refactoring and splitting a big assembly into several smaller pieces, but it is a 3rd party component, and I can't rebuilt it)
The error is misleading. It really should say "A large enough contiguous space in virtual memory could not be found to perform the operation". Over time allocations and deallocations of virtual memory space leads to it becoming fragmented. This can lead to situations where a large allocation cannot be filled despite there being a plenty total space available.
I think this what your "segmentation" is refering to. Without knowing all the details of everything else that needs to load and other activity which occupies the 2-3 hour period its difficult to say whether this really is the cause. However I would not put it into the category of unlikely, in fact it is the most likely cause.
As Anthony pointed out, the error message is a bit misleading. The issue is less about how big your assembly is and more about how much contiguous memory is available.
The problem is likely not really the size of your assembly. It's much more likely that something inside of Visual Studio is fragmenting memory to the point that a build cannot complete. The usual suspects for this type of problem are
If you have more than say 10 projects in the solution. Try breaking up the solution and see if that helps.
If you have any 3rd party addins, try disabling them one at a time and seeing if the problem goes away.
In my case the following fix helped: http://www.jetbrains.net/confluence/display/ReSharper/OutOfMemoryException+Fix
Another cause for this problem can be using too many typed datasets via the designer. or other types that can be instaniated via a designer like lots of databound controls on lots of forms. I imagine your the sort of hardcore programmer though who wouldn't drag n' drop a DS! :D
in relation to your problem, Bogdan, have you tried to reproduce the problem w/o your c++ component loaded? If you can't then maybe its this. How are you loading the component? have you tried other techniques like late binding, etc? any difference?
Additional: Yes you are right, the other culprits are lots of controls on the form. I once saw this same issue with a dev that had imported a very VB6 app over to .net. he had literally 100's of forms. He would get periodic crashing of the IDE after a couple of hours. I'm pretty sure it was thread exhaustion. It might be worth setting up a vanilla box w/ no addins loaded just to rule addins out, but my guess is you are just hitting the wall in terms of a combined limiation of VS and your box specs. Try running Windows Vista 64bit and install some extra RAM modules.
Hi I'm struggling with similar issue.
Error 13 Metadata file '[...]\IKVM.OpenJDK.ClassLibrary.dll' could not be opened -- 'Not enough storage is available to process this command. '
The library has about 30MB, it is a third party. The issue came up when we started using this version library (previous were significantly smaller)
I'm able to work for some time, but then I have to restart IDE. This also happens to my colleagues on the team.
We are using Visual Studio 2005 SP. There are 98 projects in the solution. Windows XP SP3 2GB RAM available
At the time the problem occurs, VS consumes about 450 MB (with a few addins).
I am getting this error on one of my machines and surprisingly, this problem is not seen on other dev machines. May be something wrong with VS installation. But I found an easier solution. If I delete the .suo file of teh solution and re-open the solution again, it will start working smoothly. Hope this will be useful for somebody in distress..
If you are just interested to make it work then restart your computer and it will work like a charm. I Had same kind of error in my application and then after reading all of the answer here at stackoverflow, I decided to first restart my computer before doing any other modifications. And it saved me a lot of time.
In Visual Studio (2008) there a command to collapse/expand all the sections of code in a file?
CTRL + M + O will collapse all.
CTRL + M + L will expand all.
CTRL + M + P will expand all and disable outlining.
CTRL + M + M will collapse/expand the current section.
These options are also in the context menu under Outlining.
Ctrl-M, Ctrl-L collapses/expands (toggles) all regions.
CTL + M + L expands all
CTL + M + O collapses all
Check here if you're looking for other shortcuts - these 2 are just a few of the many that are available.
Yes there's a keystroke command, see this link for a how to:
http://weblogs.asp.net/mrdave/archive/2004/09/17/230732.aspx
Are you refering to the toggle outlining?
You can do Control-M then Control-L for toggle all outlining
If you mean shortcut then
CTRL + "M" + "M": This one will collapse the region your cursor is at whether its a method, namespace or whatever for collapsing code blocks, regions and methods. The first will collapse only the block/method or region your cursor is at while the second will collapse the entire region you are at.
http://www.dev102.com/2008/05/06/11-more-visual-studio-shortcuts-you-should-know/
I have a strange bug in the Visual Studio text editor. All my blank spaces are replaced by a "."
public class Person
{
int age;
}
looks like this
public..class..Person..........................
{..................
..int age;...................
}.....................
I reset the settings to default. Didn't work. I also re-installed VS2008. Still didn't work. What's the error?
http://www.carlovella.com/index.php/2007/08/18/tips-and-tricks-visual-studio-whitespace/
Visual Studio is configured to show whitespace.
press Ctrl+R, Ctrl+W.
Looks like you have the view white space option enabled. Go to Edit -> Advanced -> and uncheck "View Whitespace"
I had the same problem and resolved by pressing Ctrl+R, Ctrl+W.
~ FOR VISUAL STUDIO 6 ~
use: ctrl+shift+8 to toggle on/off.
(or manualy go to: Edit> Advance > "View Whitespaces")
goodluck!
Works also for Visual Studio 2008, when Tools/Options/Environment/Keyboard/Mapping Scheme: Visual C++ 6 is selected.
Is it possible to view an array in the Visual Studio debugger? QuickWatch only shows the first element of the array.
You can try this nice little trick for C++. Take the expression which gives you the array and then append a comma and the number of elements you want to see. Expanding that value will show you elements 0-(N-1) where N is the number you add after the comma.
For example if "pArray" is the array, type "pArray,10" in the watch window.
Are you trying to view an array with memory allocated dynamically? If not, you can view an array for C++ and C# by putting it in the watch window in the debugger, with its contents visible when you expand the array on the little (+) in the watch window by a left mouse-click.
If it's a pointer to a dynamically allocated array, to view N contents of the pointer, type "pointer, N" in the watch window of the debugger. Note, N must be an integer or the debugger will give you an error saying it can't access the contents. Then, left click on the little (+) icon that appears to view the contents.
Hover your mouse cursor over the name of the array, then hover over the little (+) icon that appears.
Note: The accepted solution doesn't quite work, but it's very close.
Is there a macro or keyboard shortcut that will toggle "break when an exception is thrown" without using the GUI.
Opening the dialog with ctrl+alt+e and checking the "Common Language Runtime Exceptions" "Thrown" box then clicking OK is simple enough, but this is something I do a lot. I would rather have a keyboard shortcut for this.
This question is a duplicate of http://stackoverflow.com/questions/323390/any-have-a-visual-studio-shortcut-macro-for-toggling-break-on-handled-unhandled-e
However, the poster accepted an answer that doesn't really work, and I would really like an answer that does work.
The answer in the duplicate question is not acceptable because it toggles only one specific exception, not the entire CLR group.
"Well write a loop then." you say. But not so fast! Someone tried that already and it was uselessly slow. (Yes I've verified that its slow on my system as well.)
So the challenge is to use a macro to toggle the entire CLR Exceptions category in less than 1 or 2 seconds. This question is a duplicate of http://stackoverflow.com/questions/323390/any-have-a-visual-studio-shortcut-macro-for-toggling-break-on-handled-unhandled-e
Very similar to the other answer, but there is a special ExceptionSetting for the group.
Dim dbg As EnvDTE90.Debugger3 = DTE.Debugger
Dim exSettings As EnvDTE90.ExceptionSettings = dbg.ExceptionGroups.Item("Common Language Runtime Exceptions")
Dim exSetting As EnvDTE90.ExceptionSetting
Try
exSetting = exSettings.Item("Common Language Runtime Exceptions")
Catch ex As COMException
If ex.ErrorCode = -2147352565 Then
exSetting = exSettings.NewException("Common Language Runtime Exceptions", 0)
End If
End Try
If exSetting.BreakWhenThrown Then
exSettings.SetBreakWhenThrown(False, exSetting)
Else
exSettings.SetBreakWhenThrown(True, exSetting)
End If
Here's Bryce Kahle's very useful macro blindly updated to run in VS2010:
Sub ToggleExceptions()
Dim dbg As EnvDTE100.Debugger5 = DTE.Debugger
Dim exSettings As ExceptionSettings = dbg.ExceptionGroups.Item("Common Language Runtime Exceptions")
Dim exSetting As ExceptionSetting
Try
exSetting = exSettings.Item("Common Language Runtime Exceptions")
Catch ex As COMException
If ex.ErrorCode = -2147352565 Then
exSetting = exSettings.NewException("Common Language Runtime Exceptions", 0)
End If
End Try
If exSetting.BreakWhenThrown Then
exSettings.SetBreakWhenThrown(False, exSetting)
Else
exSettings.SetBreakWhenThrown(True, exSetting)
End If
End Sub
First i initalized a timer an then i call the command Exception.Debug. The timer hit, when the modal dialog is openend. If you use Win 7 with deactivated UAC SendKeys with ALT-Key will fail...i don't know why.
i played a little bit...try this (VS2010 EN):
Imports System
Imports EnvDTE
Imports EnvDTE80
Imports EnvDTE90
Imports EnvDTE90a
Imports EnvDTE100
Imports System.Diagnostics
Imports System.Runtime.InteropServices
'...
Private WithEvents t As Timers.Timer
Private Sub t_Elapsed(ByVal ee As Object, ByVal dd As Timers.ElapsedEventArgs) Handles t.Elapsed
t.Stop()
' Tastatureingaben simulieren
System.Windows.Forms.SendKeys.SendWait("{DOWN}")
System.Threading.Thread.Sleep(1500) ' Pause wichtig zum Laden des Exceptionbaums
System.Windows.Forms.SendKeys.SendWait("%t")
System.Windows.Forms.SendKeys.SendWait("{ENTER}")
End Sub
Public Sub toggleCLRExceptions()
If DTE.Solution.Count <= 0 Then
MsgBox("Nicht ohne geöffnete Solution!")
Exit Sub
End If
' Timer wird benötigt, da der Dialog Modal ist
' und weitere Befehle im Macro werden erst nach beenden des Dialogs ausgeführt
t = New Timers.Timer()
t.Interval = 0.5
t.Start()
DTE.ExecuteCommand("Debug.Exceptions")
'System.Windows.Forms.SendKeys.SendWait("^%e") ' alternativ: STRG+ALT+e
System.Threading.Thread.Sleep(200)
If isCLRExceptionsActive() Then
MsgBox("BREAK @CLR-Exception", MsgBoxStyle.Information, "Info")
Else
MsgBox("NO BREAK @CLR-Exception", MsgBoxStyle.Information, "Info")
End If
End Sub
Function isCLRExceptionsActive() As Boolean
' prüft, ob Setting Debug CLR-Exceptions aktiviert/deaktivert ist
Dim dbg As EnvDTE100.Debugger5 = DTE.Debugger
Dim exSettings As ExceptionSettings = dbg.ExceptionGroups.Item("Common Language Runtime Exceptions")
Dim exSetting As ExceptionSetting
Try
exSetting = exSettings.Item("Common Language Runtime Exceptions")
Catch ex As COMException
If ex.ErrorCode = -2147352565 Then
exSetting = exSettings.NewException("Common Language Runtime Exceptions", 0)
End If
End Try
Return exSetting.BreakWhenThrown
End Function
'...
Well, I wrote a VS2008 C# based plug-in that toggles the 386 exceptions, and it takes about 1 second per state toggle. I'm assuming that's due to COM inter-op.
This was based on the VB/macro code in the one of your links. I could not find an easier C++ method (but not ruling it out).
The next level would be to make a plug-in that has a keyboard binding, that then opens the Exceptions UI and then "clicks" the correct tick box for you.
Good luck.
You could use a tool like AutoHotKey to create a recorded script (mouse clicks or key presses) and then assign it a hotkey that will play it back when pressed...
Just offering some info I found on this (here) as I was scouring the net in my futile attempt to help...
Someone else posed this same question and it was responded to by Gary Chang from MS Support, here's the quoted response:
I am afraid the Macro code cannot manipulate the operations on the Exceptions dialog box...
It's important to note that this posting is from December of 2005 so this response may no longer be accurate; either way, thought I'd throw it out there.
The suggestion of setting the special ExceptionSetting for the group does indeed toggle the state of the top-level checkbox. However, it doesn't seem to toggle the individual Exceptions below it in the tree, and moreover, my process does not stop when such exceptions are thrown as it does if I manually check the top-level checkbox. Do you see different behavior?
I ask because I couldn't find the stack trace in Visual Studio, while debugging an exception that occurred.
While debugging, Debug/Windows/Call Stack
The default shortcut key is Ctrl-Alt-C.
Do you mean finding a stack trace of the thrown exception location? That's either Debug/Exceptions, or better - Ctrl-Alt-E. Set filters for the exceptions you want to break on.
There's even a way to reconstruct the thrower stack after the exception was caught, but it's really unpleasant. Much, much easier to set a break on the throw.
Our TFS server has some temporary connectivity issues right now, and as such VS has gone unresponsive, leaving 50+ developers unable to work!
Is it possible to switch TFS into an offline mode in the event of such an issue?
Martin
See this reference for information on how to bind/unbind your solution or project from source control.
Quoting from the reference:
To disconnect a solution or project from source control
In Visual Studio, open Solution Explorer and select the item(s) to disconnect.
On the File menu, click Source Control, then Change Source Control.
In the Change Source Control dialog box, click Disconnect.
Click OK.
plundberg: The "disconnect" button is only available for the TFS provider starting in VS 2008. Even then, I'm not sure if it's officially supported. The recommended way to use the Go Offline feature is to [re]open the solution.
Martin Pritchard: if you get stuck mid-operation, you can force VS to timeout by pulling the network plug (literally) or running ipconfig /release.
Once you're marked offline, here's a step by step guide to working in that mode: http://teamfoundation.blogspot.com/2007/12/offline-and-back-again-in-vs2008.html
More detailed info on tweaking the behind-the-scenes behavior: http://blogs.msdn.com/benryan/archive/2007/12/12/when-and-how-does-my-solution-go-offline.aspx http://blogs.msdn.com/benryan/archive/2007/12/12/how-to-make-tfs-offline-strictly-solution-based.aspx
The 'Go Offline' extension adds a button to the Source Control menu.
http://visualstudiogallery.msdn.microsoft.com/425f09d8-d070-4ab1-84c1-68fa326190f4?SRC=Home
Depending on which tool windows you have open, VS may or may not try to hit the team server automatically when it starts up.
For best results try this:
You should notice now that you can start visual studio without it trying to hit the TFS server.
I know its just an aside to your problem, but I hope you find this helpful!
I just wanted to include a link to a resolution to an issue I was having with VS2008 and TFS08.
I accidently opened my solution without being connected to my network and was not able to get it "back the way it was" and had to rebind every time I openned.
I found the solution here; http://www.fkollmann.de/v2/post/Visual-Studio-2008-refuses-to-bind-to-TFS-or-to-open-solution-source-controlled.aspx
Basically, you need to open the "Connect to Team Foundation Server" and then "Servers..." once there, Delete/Remove your server and re-add it. This fixed my issue.
I just installed VS2010 and I want to connect to TFS, But I don't have any team explorer options.
I searched for Team Explorer and I found this link that states that Team Explorer comes preinstalled in VS2010 Team Suit.
I downloaded VS2010 Pro and don't have team explorer and can't find it anywhere.
Any ideas? Tips?
Thanks
I think there's been a misunderstanding down MS naming conventions.
All versions of Visual Studio 2010 have the ability to conenct to TFS built in, there is no longer a separate install (what was previously called Team Explorer).
What the Ultimate edition gets with what is now called Team Explorer (codename Eaglestone) is a standalone rich client for accessing TFS.
If you downloaded VS2010 Pro...you didn't download a version that came with Team Explorer. You need to re-download VS2010 Team System. You can grab it from MSDN or download it from:
Visual Studio 2010 Team System Beta 1 Download
UPDATE
As of Beta 2, Microsoft renamed versions a little. TFS Connectivity is now included with 'Ultimate'.
It looks like Team Explorer is also available as a separate download. The VS 2010 Beta 2 version is here: http://www.microsoft.com/downloads/details.aspx?familyid=CA86215B-A824-44E7-B4C3-982C7ECEA46D&displaylang=en
VS2010 Pro is a different release from VS2010 Team Suit and it doesn't contain anything that has to do with TFS. If you want to connect to TFS you need to get the VS2010 Team Suit release.
This has been the norm ever since VS2005.
The RTM version of Team Explorer is here: Microsoft Visual Studio Team Explorer 2010 - ISO
I have VS2010 Ultimate and it have team explorer
Does anybody know if there is a shortcut or something similar for changing the font size in the editor in Visual Studio 2008?
What I mean is something like Ctrl + MouseWheel as in FireFox.
Accessing the Options window and then selecting Environment > Fonts and Colors is fine if you don't have to change the font size all the time, but in my case, I would like to be able to change it depending on what I am doing (writing and reading code or just reading it).
I guess I could create 2 almost identical settings files and import them whenever I want, but that is even slower!
Thanks!
In the Macros explorer under samples/accessibility there is an IncreaseTextEditorFontSize and a DecreaseTextEditorFontSize. Bind those to some keyboard shortcuts.
Ctrl + Shift + MouseWheel on active editor.
Be sure to check out the VS 2010 Beta that was just released. The new editor should have this.
Ctrl + MouseWheel works on almost anything...not just visual studio
Is there a way to automatically stop the ASP.NET Development Server (Cassini) whenever I do a build/rebuild in VS2008 (and then obviously have it start again when required)? Maybe there's some hidden configuration setting somewhere? Or at least some way to do it as a post-build event maybe?
For some background, the issue is that I'm using Spring.NET for dependency injection, etc, but it loads its singletons on Application Start, meaning that if I change any spring related code/configuration I have to stop the Development Server, so that it starts again next debug/run ensuring the Application Start event is triggered again. In other words, even if you change a bunch of code/config & then start debugging again, it doesn't actually start again, since its already running, so your new code isn't being used.
Enabling "Edit & Continue" on the web server project worked for me. It doesnt shutdown cassini when you stop debugging, but it does restart cassini when you start debugging.
The only way that I know of is to do a custom Cassini startup on the post.build event. This custom made process kills all instances of Cassini, and startup a new one. In order to get this to work, you will need to build a small custom command line utility. I have called it SpawnProcess here.
using System;
using System.Collections.Generic;
using System.IO;
using System.Text;
using System.Diagnostics;
namespace SpawnProc
{
class Program
{
public static void Main(string[] args)
{
if (args.Length > 0)
{
// Kill all current instances
FileInfo fi = new FileInfo(args[0]);
string name = Path.GetFileNameWithoutExtension(fi.FullName);
foreach (Process proc in Process.GetProcessesByName(name))
{
proc.Kill();
}
ProcessStartInfo startInfo = new ProcessStartInfo(args[0]);
if (args.Length > 1)
{
startInfo.Arguments += "/port:" + args[1];
}
if (args.Length > 2)
{
startInfo.Arguments += " /path:\"" + args[2].Trim(new char[]{'"'}) + "\"";
}
if (args.Length > 3)
{
startInfo.Arguments += " /vpath:\"" + args[3].Trim(new char[]{'"'}) + "\"";
}
try
{
Process.Start(startInfo);
}
catch (Exception ex)
{
Debug.WriteLine("Error: " + ex.Message);
for (int i = 0; i < args.Length; i++)
{
Debug.WriteLine("args[" + i + "]: " + args[i].ToString());
}
}
}
}
}
}
Then you will have instruct Visual Studio to not use Cassini. Got to properties for your web application -> Web and select "Use Custom Web Server", enter something like:"http://localhost:1685/". (Or whatever port number you would like to use). Then, enter this command in the post-build event:
"$(ProjectDir)..\SpawnProc\bin\debug\SpawnProc" "C:\Program Files (x86)\Common Files\microsoft shared\DevServer\9.0\WebDev.WebServer.exe" 1685 "$(ProjectDir)" /
Make sure your paths is correct, for instance, since I'm running a 64bit OS, my Program files path is different from a 32bit OS. Also, my SpawnProc.exe is in a sub project.
Hope this helps.
/Magnus
So I ended up with a workaround based off Magnus' answer, but using the following relatively simple macro (why do they force you to use VB for macros? I feel all dirty):
Imports System
Imports System.Diagnostics
Public Module KillCassini
Sub RestartDebug()
If (DTE.Debugger.DebuggedProcesses.Count > 0) Then
DTE.Debugger.Stop(True)
End If
KillCassini()
DTE.Debugger.Go(False)
End Sub
Sub KillCassini()
Dim name As String = "WebDev.WebServer"
Dim proc As Process
For Each proc In Process.GetProcesses
If (proc.ProcessName = name) Then
proc.Kill()
End If
Next
End Sub
End Module
Basically if the debugger is currently running, it will stop it & then kill any processes named "WebDev.WebServer" which should be all the Cassini instances and then starts the debugger again (which will implicitly start Cassini again). I'm using proc.Kill() because neither proc.CloseMainWindow() or proc.WaitForExit(1000) seemed to work...
Anyway, once you've got your macro you can assign it to keyboard shortcuts, or create custom toolbar buttons to run it.
Inspired by this post and another one about code clean up I added the macro as PostDebug-event. So every time the debugger returns, it will remove all WebDev.WebServer-s. (And I relaxed the ProcessName-constraint.)
Note: this will probably kill all the WebServers, so also WebServers of other debug-sessions (which is fine with me, at this moment, I usually don't have any). So you may want to only look for child-processes or something like that (and post that code here ;-) ).
So my code looks like this:
Private Sub DebuggerEvents_OnEnterDesignMode(ByVal Reason As EnvDTE.dbgEventReason) _
Handles DebuggerEvents.OnEnterDesignMode
If (Reason = dbgEventReason.dbgEventReasonStopDebugging) Then
Dim name As String = "WebDev.WebServer"
Dim proc As System.Diagnostics.Process
For Each proc In System.Diagnostics.Process.GetProcesses()
If (proc.ProcessName.StartsWith(name)) Then
proc.Kill()
End If
Next
End If
End Sub
Are there new features in Visual Studio 2010 that are must-haves? If so, which ones?
For me, the big draws for VS2008 as compared to VS2005 were LINQ, .NET Framework multitargeting, WCF (REST + Syndication), and general devenv.exe reliability. Granted, some of these features are framework things, and not tool things. For the purposes of this discussion, I'm willing to combine them into one bucket.
What is the list of must-have features for VS2010 versus VS2008? Are there any? I am particularly interested in C#.
Update: I know how to google, so I can get the official list from Microsoft. I guess what I really wanted was, the assessment from people using it, as to which things are really notable. Microsoft went on for 3 pages about 2008/3.5 features, and many people sort of boiled it down to LINQ, and a few other things. What is that short list for VS2010?
Summary so far, what people think is cool or compelling:
Visual Studio engine
.NET Framework
C# 4.0
VB 10.0
I read up on these at Zander's blog. He described these and other features. Nobody on this list said anything about:
Visual Studio engine
C++
Much better support for multiple displays:
Code Contracts. The fact that they're statically checked makes them 100x better than asserts and other argument guards to me.
The only thing is I wish C# 4 had a special syntax for it to hide the library calls.
Add Reference dialog doesn't take six hundred million years to open.
File>New New Item > Class generates public class by default.
The support for parallel programming designed for multi-core systems is a big one for me!
Support for at least some of the new C++0X features:
For me, the lambdas and r-value references are almost compelling enough on their own. The multi-monitor support is the other thing that I can see being the most useful.
The new extensibility model is great. We should see a plethora of new, lighter-weight Visual Studio plugins with 2010.
Scott Guthrie demonstrates that in the PDC 2008 Keynote: http://channel9.msdn.com/pdc2008/KYN02/
I like the optional and named parameters as well as the co/contra-variance stuff
http://channel9.msdn.com/posts/mike+ormond/C-40-New-Features-Optional-Parameters/ http://channel9.msdn.com/shows/Going+Deep/Inside-C-40-dynamic-type-optional-parameters-more-COM-friendly/
As a guy who does a lot of interop, I cannot wait for the "interop done right" features of 4.0. Here's a great talk on some of the new features from PDC.
Newly implemented C++ intellisense.
I played with it a little and it looks much better than VS2008 and it can only improve until the release.
Visual Basic Collection and Array Literals.
They are super awesome.
(disclaimer: I wrote that feature, so I'm a little biased)
IntelliTrace (called "historical debugging")
--> Going back in time during a debugging session.
Not to confound with the Stacktrace.
--> Going back in the call hierarchy.
IntelliTrace: Like watching a movie and rewinding back to see what happened (what caused an exception)
MSDN info here
http://msdn.microsoft.com/en-us/library/dd264915(VS.100).aspx
Personal plug: Checkout slide 61 here
http://www.slideshare.net/PeterGfader/testing-with-vs2010-a-bugs-life
General
VB
line continuation is my #1 reason to upgrade, since we use VB 75% here.
F# is definitely something to watch (and explore) in VS2010. It's going to be a paradigm shift for many OOP (Object Oriented Programming) programmers, in much the same way that OOP was a paradigm shift for the people steeped in the "structured programming" approaches of the 1980s and '90s.
The draw for F# will be much the same that OOP had over "structured programming": do more with less code while making your code more stable at the same time.
Jason Zander, the Visual Studio Developer Division General Manager, has a blog. You should read it... (There are many changes to how projects are handled, to the editor, and to various language-specific features in both - whether these make it a compelling upgrade for you... is something only you can answer)
VS 2010 has a lot of features for improving productivity, (From ScottGu's blog):
General
Pascal Case Intellisense is also there.
Improvements for WPF, Ribbon Interface and Windows 7.
weblogs.asp.net/scottgu/archive/2009/10/26/wpf-4-vs-2010-and-net-4-0-series.aspx
Better performance for "add reference" dialog.
Auto-Start for web applications - the ability to automatically startup and proactively initialize a web application without having to wait for an external client to hit the web server.
Box select / Multi-line editing - Allows you edit multiple lines of code at once.
For me it is the new features that ship with the tester edition and TFS 2010, such as the new automated testing tools.
While the new features of C# may not seem as impressive compared to LINQ - variance is really nice and useful.
The library and runtime have a lot of new features. Personally I find the parallel library to be the most interesting. The demos and code I have seen so far are really impressive and the added debugging support in VS2010 for tasks etc. makes for a nice package.
The VS extensibility model has been changed as well and it allows for some pretty cool features and it seems much more accessible than the current model.
I kept hearing about a "black box" debugging (or historical debugging) that would be included in 2010 version. That's what i'm interested in. Is it there?
MSVC 2010 is getting rid of the side-by-side configuration model and going back to where you can just distribute the runtime DLLs alongside the EXE. I am pretty excited about that.
So, obviously, there are a ton of new features but I have a few of my favorite things in the IDE listed here: http://blogs.msdn.com/b/zainnab/archive/tags/vs2010+new+features/
They range from seriously cool (WPF Tree Visualizer, Zero-Length Box Selection, Call Hierarchy) to the more mundane (remove projects from project list); but they all, in my opinion, make a compelling argument to upgrade is you are using any version of the CLR from 2.0 to 4.0 -- just my .02 :)
I would upgrade because of the new web application deployment features.
Being stuck using VB.NET, I'm so happy to see automatic properties and inline subs.
Built-in project templates for SharePoint 2010 features, webparts and solutions. One-click deployment to SharePoint 2010.
Combined with the fact that it is possible to install SharePoint 2010 on a developer Vista/Windows 7 environment this will greatly speed up SharePoint development.
Easy:
F#.
Parallel programming.
:-)
As I am not a pro developer, so i haven't explored it deeply. I tried my hands on VS2010 immediately after its beta release. I found it more cooler & smarter than its ancestor. I like the following features that every dev must have experienced:
1. Highlighting References : all instances of that symbol are highlighted
in the document.
2. Intelligent Intellisense, searches on as you type. Even searches in any part
of the reference. also CTRL+ALT+SPACEBAR to toggle
between completion mode and suggestion mode
(also in earlier version CTRL+SPACEBAR).
3. The new ClientIDMode() property in ASP.Net 4
4. ASP.Net Chart tools, that was lacking by default in VS2008
5. Multi monitor support
6. The most important is quick reference adding. In earlier version you have to
wait for 1-2 minutes for add reference dialog to appear,but in this within
2-3 secs. Really optimized one.
Following beta 2 announcements and release, many things to ponder.
Visual Studio product line is completely revamped. 3 SKUs (excluding express editions): Professional, Premium, and Ultimate. Premium includes many features that used to be team system edition features. Ultimate is where the "new" team system features will go, such as UML.
Premium VS will come with the Premium subscription. Slight price increase from the old Professional VS + Premium subscription.
All VS subscriptions will have TFS, which will now run on client systems (Win 7 and Vista)! If you're looking for a compelling reason to upgrade, TFS may be enough all by itself.
I like it that Silverlight 3 is in the box (runtime, SDK, tools), you don't have to install anything extra.
Call Hierarchy feature is quite nice too ;)
I also like Generate From Usage, Highlight References, Navigate To.
Unit testing and visual designer for Silverlight. That's what made me to take the decision of installing beta 2, even though generally I don't like to rely too much in betas.
Note that Visual Studio 2010, with its WPF rewrite, dropped the MDI option for documents. Tabs are the only way now, barring some macro magic.
This is the only big regression in functionality I've noticed yet.
I'd be interested in hearing what you think about the code visualization and exploration tools in Visual Studio 2010 Ultimate such as creating sequence, dependency graphs, and layer diagrams from code and using Architecture Explorer to browse and explore your solution. VS 2010 also supports UML class, sequence, component, use case, and activity diagrams for software design. You'll also be able to link UML diagrams to Team Foundation work items and extend your UML models.
I've posted more links on my profile for more info.
I have listed most of the features in my blog access http://rajsoftware.com/ See ASP.NET links.
I just wrote up a blog post that kinda discusses a little of this (Which Visual Studio 2010 Edition Do I Buy?) but the Microsoft Marketing website is starting to have some really good information about the features that are beneficial to you if you were to upgrade to 2010.
Some new features in Visual studio 2010.
Co- and contravariance in delegates and generic classes (finally... I wonder what the people at MS thought when they left that out?)
Fully usable XamlReader - class (which is VERY important for what I'm doing)
Better WF (MUCH better)
WCF supports now gzip (I know, it's a facepalm that MS only brought us that in 4.0, but hey... it's here now!)
Memory mapped files (yay!!!)
Web.Config transformations are really useful; makes deploying just that little bit easier and quicker.
personally i like the look and feel of the new user interface
Maybe you shouldn't upgrade... if you're not using VS2008 to its full potential (and that's really the root cause that the reason for YOU to upgrade is not already obvious to you), it probably won't be any different in VS2010.
It might be time to focus your efforts elsewhere... if so, move on to where your true interest is and don't waste a lot of time looking back.
I was wondering if there is a way to copy ALL my settings from ReSharper (including the StyleCop for ReSharper settings and the keyboard bindings I have set for ReSharper) from one PC to another?
Since the export option within Resharper is only for code styles, you'll need to be a bit craftier for all settings.
From Peter Ritchie's blog...
...the settings are stored in "%userprofile%\application data\jetbrains\resharper\v4.0\vs9.0". There are a couple of xml files in there that store your settings. Before you upgrade to the latest build, just copy those to another directory.
It's very likely that the format of these files has changed since the last build so copying the backups over the new version could possibly make Resharper to blow-up. So, use with caution.
I have Resharper 4.1 so instead of "...\v4.0\vs9.0" it's actually "...\v4.1\vs9.0" (obvious, I know, but worth mentioning).
I'm not sure about StyleCop settings, but this should work for most other settings (keyboard scheme, code completion settings, etc...).
There is a R# settings manager plugin for resharper that stores all of this I think, including stylecop settings
StyleCop settings are not stored in the resharper plugin. they are in the stylecop directory and in an xml file (Settings.StyleCop).
You can Export/Import your ReSharper Code Style or put it on the network and share between multiple computers. To do so:
From VS Menu select ReSharper -> Options then in Option dialog select Languages/Common/Code Style Sharing.
Not sure if it's exactly what you're looking for.
I'm currently maintaining an "old" system written in C#.net, removing some obsolete features and doing some refactoring. Thanks god, the previous guy wrote some unit tests (MSTests). I quite comfortable with JUnit tests, but didn't do yet much with MSTests.
The test methods have a DeploymentItem attribute, specifying a text file which is parsed by the business logic method that is being tested and a 2nd DeploymentItem where just a path has been specified containing a bunch of TIF files that have to be deployed too.
[TestMethod()]
[DeploymentItem(@"files\valid\valid_entries.txt")]
[DeploymentItem(@"files\tif\")]
public void ExistsTifTest()
{
...
}
The tests worked before, but now I had to change the names of the TIF files contained in the \files\tif directory. According to a rule, the TIF filenames have to match a certain pattern which is also checked by the ExistsTifTest() method. Now I had to change the filenames in order to adapt them to the new requirements and suddently the TIF files are no more being deployed as before.
Can someone give me a hint why this happens or what may be the cause? The same thing happens also if I add a new text-file say "my2ndTest.txt" beside the "valid_entries.txt" in the \files\valid\ directory with the according DeploymentItem attribute on the test method. The file doesn't get deployed?
I got the images now deployed by defining the deployment path directly in the testrunconfig, but I'd like to understand why these things happen or why for instance my new file "my2ndTest.txt" doesn't get deployed while the others do.
Thanks a lot.
DeploymentItem is a bit of a mess.
Each file in your solution will have a "Copy To Output Folder" setting in VS.NET. You need this to be "Copy Always" (or similar) in order to get the files into the output folder.
Check that you've got this set for the new files. If you don't have this set then the files won't get copied to the output folder, and then they can't be deployed from the output folder to the folder where MSTest does it stuff.
Personally, if I have files that I need for my unit tests I've found that embedding those files as resources into an assembly, and having that assembly "unpack" itself during the tests is a more predictable way of doing things. YMMV.
In VS2010, my Local.testsettings had the "Enable Deployment" unchecked and the DeploymentItem attribute was not working. I checked it and everything worked fine. I hope this helps!
If you go into your .testrunconfig file and under deployment uncheck "Enable Deployment", the tests will run in their normal location, and everything will work like it does when running the app outside a unit test.
Since I always found the DeploymentItem attribute a mess, I do the deployment of such files by using the post-build script. - Make sure the files you wanna copy has the Copy Always property set. - Modify your test project post-build script to copy the files from build target folder(Bin\Debug) to the location where your test is expecting them.
This probably doesn't relate to your exact problem, but here's a couple of tips I found with the [DeploymentItem] attribute.
It does NOT work when used with the [TestInitialize] attribute
[TestInitialize]
[DeploymentItem("test.xlsx")]
public void Setup()
{
It should be on your [TestMethod], e.g.
[TestInitialize]
public void Setup()
{
string spreadsheet = Path.GetFullPath("test.xlsx");
Assert.IsTrue(File.Exists(spreadsheet));
...
}
[TestMethod]
[DeploymentItem("test.xlsx")]
public void ExcelQuestionParser_Reads_XmlElements()
{
...
}
I had Deployment flag disabled first. But even after I enabled it, for some unknown reason nothing even target DLLs would still be copied. Accidentally I opened Test Run window and killed all the previous runs and magically I found all the DLLs and files I needed in the test folder the very next run... Very confusing.
What kind of problems might this cause?
Is it better to install in a VM?
It is always possible that side-by-side installation issues exist, and you should have the appropriate safeguards in place (e.g. backup, use a VM, etc.).
In my personal experience, it has worked just fine. For my Tech Ed presentation, I rebuilt my laptop with Visual Studio 2005, 2008 and 2010 all installed side-by-side on Windows 7 x64. I didn't experience any problems.
The VS team has chimed in on this issue here. From the post:
"Q: Is it ?safe? to install VS 2010 Beta1 on my machine?
A: Yes! We?ve tested side-by-side scenarios, so installing the beta on a machine with VS 2008 installed is fine. The beta also supports uninstall and should leave VS 2008 and your machine in working order afterward. You can install VS 2010 Beta1 on a VPC if you prefer, though you will notice slower performance than if you run VS on your local machine. And please remember that however you install, this is pre-release software. The VS 2010 Beta1 readme documents major known issues, but it?s not guaranteed to be an exhaustive list."
On my machine I have installed:
and it works like a charm
It's unlikely to cause problems as VS 2010 is primarily designed for developing with the .NET 4.0 framework (although multi-targetting is implemented, like it was in VS 2008, just in a better manner).
I (and no one I work with) ever had a problem with VS 2005 & VS 2008 installed side-by-side. In fact, it was strongly encoraged as we had legacy projects which were built in VS 2005 and although the upgrade to VS 2008 was minor (if staying with the .NET 2.0 framework for the projects) it was safer to not risk it.
If you're really concerned about conflicts or potential issues using beta software may not be for you. If you do want to try it and still have reservations I'd suggest that you do use a separate VM with VS 2010 on it.
I myself will be installing it side-by-side with VS 2008 on Vista (after backing up my VM) so if there are any problems I'll edit this post and report them.
I don't expect any problems with VS2010 RTM installed side by side with any of the previous versions.
But this is a beta. Installing it on your computer means you're asking to have your disk reformatted (metaphorically speaking). Be sure you're ready to reformat the disk you install it on.
For me, that means I run it in a VM.
That said, there's a good chance I'll install the RC when it ships, but that's just me trying to find the bugs so others don't have to.
I have Visual Studio 2008 Professional SP1 and Visual Studio 2010 Team Suite installed on my Windows 7 box. I have had zero issues so far.
Does that mean you won't? I have no idea.
You can install them side by side and it's supported by Microsoft to do so. For more information visit the Microsoft site on doing it located here, http://msdn.microsoft.com/en-us/library/ms246609.aspx.
However you might want to determine why you would need to do such. Visual Studio 2010 support multi-targeting as in previous Visual Studio versions however it is much more advanced in 2010. You can easily upgrade you project to 2010 by using the project import and then target whatever .NET version you need. The only thing to note here is that once you upgrade to 2010, you will no longer be able to open the project in 2008 and the back conversion is not an easy process.
For what it's worth I've installed both VS2008 and VS2010 on the same box without issue. Uninstallation can cause some hiccups but those are directly related to VS2010 being new and shouldn't affect 2008.
I'd do it in a VM just to be safe, and so that I wouldn't have to uninstall it when the final version comes out. Also in the VM I could roll back to a clean OS and install RC versions. It's safer and you have more options in the VM, and I don't even notice the minor performance penalty. Someone go try it on their system and let us know.
I would suggest installing it on a VM if it's your work machine, but other than that, I usually install Beta products on my home machine as I have backups and don't mind reinstalling as my home pc is kinda like my sandbox
I have profession ver of 2003, 2005, and 2008 all installed and they worked great on the same pc. I even installed the beta 2010 and it worked for a while in uninstalled because it didn't hav crystal reports. Just within the last month I purchased pro ver of 2010 and it blew my 2008 to shreds. I couldn't load data bases anymore, system would stal or stop period. So I'm loading it (2010) on a different PC. They seemed to merge and us settings from each other.
Will it cause problems?
Short answer: Yes.
Longer answer: No, but it's quite possible. If you're working on anything vaguely important, VM'ify the installation for now..
It has caused problems for me. I had to uninstall Visual Studio 2010 Ultimate off of my Windows 7 machine because VS 2008 keeps freezing up whether or not I have VS 2010 running.
After a while... but just in case someone else going around here.
VS 2010 doesn't support .Net compact framework anymore, u're stuck with WinPhone only.. you have to use VS 2008 for your Windows mobile 6.5 projects. So.. another reason to install 2008 and 2010 side by side.
If you use Crystal Reports you will have problems running Visual Studio 2008 and 2010 on the same machine.
I could not install VS 2008 Prof after I installed VS 2010 Ultimate. Guess you have to step up from smallest to largest version in order to have everything working.
Yes, I know... I could set up a virtual machine running XP. Unfortunately our build environment is such that we need to be running VC2003, 2005 and 2008 concurrently and it would be much more convenient if I could run 2003 natively on Windows 7 for the few projects we have that require it.
I realize some things may not be available in the IDE, but I was able to run 2003 under windows Vista and if I could get the same base level of functionality under Windows 7 I would be extremely happy.
Right now I get an error opening the *.pdb file when I compile after switching vc2003 to run as Administrator under compatibility mode for XP SP 2.
Thanks!
Give XP Mode a try if you can't get it to run natively.
I wrote a blog entry about this a while back that you can check out - http://technikhil.wordpress.com/2010/01/12/visual-studio-2003-and-windows-7-can-get-along-really/
The only thing I am stuck on right now is the global search functionality of VS 2003 - it hangs the application. My workaround is to use windows 7 search :-). Other than that - so far so good...
Update: I got the search to work as well by disabling the Aero functionality - I have updated my blog post with the details...
Solution i found on the web which helped: For your visual studio, use application compatibility = windows vista SP2, and NOT WinXP SP3
I have attempted to install VS2003 on Windows 7 64-bit using the Virtual Windows XP feature. I'm reasonably certain that this will be successful. The issue I ran into is that the installer wants IIS installed, and the XP installation provided by the Virtual XP doesn't have that enabled by default.
If you go to Add/Remove components, and try to add it, it will ask for the disc, which I didn't have on hand. Once I get my hands on the disc, I'm pretty sure that it will run fine.
If you haven't tried it for other apps, the Virtual XP feature is really neat...
I have a really dirty and pathetic workaround for the pdb problem.
Download and run Sysinternals-ProceXP, press CTRL-F enter the name of pdb(smt like ($ProjectName).pdb) that can't be created while linking. Double click when it is found.(if it can't be found run procexp with administrator priviliges)
Then you will see that the .pdb file is highlighted in the lower pane of the main screen. Right click it and select Close Handle. When you retry building your solution it wont raise an error.
I dont know if this solution can be scripted but it is at least better than restarting visual studio.
I've been using Visual studio 2003 on win7 since the very first RC edition was released :S why do people have issues?
Have you considered upgrading your solutions to vs2005, using MSBEE to target .net 1.1?
In windows 7, there is the compatabiliy mode in the executable properties. open:C:\Program Files\Microsoft Visual Studio .NET 2003\Common7\IDE\ then right click on the devenv.exe and select properties. In the compatability tab, select the "Run in compatability mode" and select "Windows XP" in the dropdown.
Try that, I am not sure if it works, but it is worth a shot.
I am experiencing the same issue; devenv.exe is leaving pdb files open after running the project. I have made a batch file to work around it, it closes all .pdb files open by devenv.exe:
handle.exe .pdb | awk "/devenv.exe/ { split($4, fd, \":\"); system(\"handle.exe -c \" fd[1] \" -y -p \" $3)}"
You will need to have handle.exe by sysinternals and awk by gnu in your path to make it work.
Use at your own risk. Closing handles can cause application or system instability.
I am having no problems with Visual Studio 2003 on Windows 7 64-bit.
Run this install. You need to run it from the setup directory, the setup.exe on the root of the cd will not work.
D:\setup\SetUp.exe /NO_BSLN_CHECK
I'm sorry, your build environment requires you to have VC 2003, 2005, AND 2008 running concurrently? I would really bet that your efforts would be better spent simply consolidating your build environment to just one environment.
Today I ran WinDirStat to check what is filling up my harddisk. I was surprised to see that this folder contains 4.6 GB (!):
C:\Users\...\AppData\Roaming\Microsoft\VisualStudio\9.0\ReflectedSchemas
What is the purpose of this folder and the files it contains? Is there a way to get rid of these files in a safe way?
Thanks!
I've tried to empty the folder completely, and have no problems found since i've done. When launching a project in VS, a new schema was created.
Edit: you can also move the folder and put it back when you believe you screwed things up...
This drives me crazy and hopefully it will be fixed in VS 2010; however, I found another solution to this problem.
My "fix" is to use the "Junction" tool to map the folder to another drive. If you're like me and have a second drive, then you can use window's Junction tool to create something like a symbolic link to map the folder to another drive.
Best of all, you no longer need to use the command line. This freeware tool works great: Junction Link Magic.
I have this problem where I open Visual Studio and the internal windows are scattered all over the place. None of them are docked; some that should be visible have become invisible and vice versa. I then have to spend ages getting the windows back where I like them.
It only seems to happen with some solutions and only appeared recently.
For the life of me I can't fix the problem. Has anyone else been through this?
Sounds like there is definitely a problem with Visual Studio retaining your settings between round-trips and possibly your Visual Studio settings profile in general.
The solution I'd recommend is firstly to reset all settings, secondly customize things to your personal preference and finally take a backup of those customized settings. The idea is that this settings backup file can be used later to automate a quick settings restore to a point you are happy with. The following steps show how to do this and hopefully should sort out even the most confused Visual Studio setting issues:
Close down all instances of Visual Studio.
Go to Start > Programs > Visual Studio 200X > Visual Studio Tools > and choose 'Visual Studio 200X Command Prompt'
Run the sligthly less well known 'devenv.exe /ResetUserData' command. With this command you will lose all of your Visual Studio environment settings and customizations. Because of this, the /ResetUserData switch is not officially supported and Microsoft does not advertise it (the switch is not described in the help for devenv.exe you get when you type devenv.exe /? in a command prompt). Importantly, wait for the resulting devenv.exe process to disappear from Task Manager or even better Process Explorer.
When the process disappears from Task Manager or Process Explorer, run 'devenv.exe /ResetSettings' which will restore the IDE's default settings and eventually start a single instance of Visual Studio.
Now in Visual Studio choose 'Import and Export Settings...' near the bottom of the 'Tools' menu to start the Import and Export Settings Wizard.
Choose 'Reset all settings' radio button and Next > Choose 'No, just reset settings, overwriting my current settings' and Next > Choose your personal 'Settings Collection' preference, I would choose Visual C# Development Settings here (Note: What you choose here has an effect on keyboard shortcuts etc. but you can always repeat this process until happy) and click Finish.
When you get the message that 'Your settings were successfully reset to XXXXXX Development Settings.' click Close then spend a good bit of time adding any personal customizations to Visual Studio such as opening windows you always want open, customizing toolbars and adding any toolbar buttons etc.
When you are finished with your personal customization and completely happy with your setup go again to Tools > 'Import and Export Settings...'
Choose 'Export selected environment settings' radio button and Next > Tick 'All Settings' and Next > Choose a file name and directory and click Finish to store a backup of your current settings in a .vssettings file.
In future if things go haywire again head back to Tools > 'Import and Export Settings...' and this time choose 'Import selected environment settings' radio button and Next > Choose 'No, just import new settings, overwriting my current settings' and Next > Either choose the name of your .vssettings file from the list (usually under the My Settings folder) or Browse.. to where you saved the file and Next > Tick 'All Settings' and click Finish.
Importantly, close the single instance of Visual Studio. Any future instance you open should retain your latest customizations.
I had a similar issue when the My Documents folder was stored on a mapped drive. If I opened VS before mapping the drive, VS would act as if it was the first time it had been opened. I solved this issue by storing the environment settings on the local disk.
Actually I worked out what the culprit was: previous VS crashes.
If one of my Visual Studio instances crashes for whatever reason - the next time I start up VS, I get a weird batch of settings. The behaviour depends on various factors, like whether or not I had other instances of VS open at the time.
Which solution you're opening shouldn't matter because those settings are not solution-specific. But I wonder do you maybe have Visual Studio 2005 and 2008 installed? If so, opening a solution created in 2005 will open VS 2005 and opening a 2008 solution will open VS 2008. You may have VS 2005 even if you didn't install it. For example, InfoPath 2007 installs a VS 2005 shell.
First I would position the windows where you want them, then do a Tools -> Export Settings and include only the window layouts. That way you at least have something you can revert to.
Then I would check Tools -> Options -> Import Export Settings and make note of where the "Automatically Save My Settings To This File" path is set to. Keep an eye on that file. Do you have any sync software that may be inadvertently overwriting it? Does it point to a non-existing location?
I'm facing similar issue. And it also only started recently, like, within the last 30 days or so. The only thing I remember changing in this period was updating Resharper 4.5.
Is there anyway to reopen the last closed tab in Visual Studio? Similar to Ctrl+Shift+t in FireFox and Chrome.
Thanks
You can with the Visual studio Power Commands
If you're using VS 2008, PowerCommands offers a "Undo Close" pane, featuring your recently closed documents, or like David said, check the File menu. PowerCommands doesn't limit the number of files it shows, though.
I don't know of way to open the last closed tab, but you can open your most recent file through your File Menu and the top one should be your most recently closed tab.
in VS 2010 "PowerCommands for Visual Studio 2010"
http://visualstudiogallery.msdn.microsoft.com/e5f41ad9-4edc-4912-bca3-91147db95b99/
Adds a command "Undo Close"
I'm used to press shift+F7 to switch between my code behind and the designer (which takes between 1 and 5 seconds to load) then I always have to click on View Xaml to modify my XAML code.
I don't find any shortcut in Tools/Options/Keyboard to go directly (from code behind to XAML code). How can I do that ?
In VS2008, while in code-behind of your XAML page (.xaml.cs), pressing SHIFT-F7 will take you to the XAML Designer or the XAML code page, depending on which one had the latest focus. Pressing SHIFT-F7 again will take you from the XAML code page to the designer and vice versa.
While in the XAML designer or XAML code page, pressing F7 takes you to the related code behind page.
When I first installed VS2010, my keyboard mappings were set to (Default). The default setting had View.ViewDesigner mapped to "Shift-F7 (HTML Editor Source View)". To get the shortcut to work in all views, I had to change the mapping to "Shift-F7 (Global)". Changing the keyboard mappings to "Visual C# 2005" worked as well.
For VS 2008:
F7 goes from XAML to Code Behind, Shift-F7 goes from Code Behind to XAML
I've finally found the solution for VS 2010:
F7: switch between Code Behind and XAML (Design or Markup depending on last used)
Shift+F7: switch between XAML (Design) and XAML (Markup).
F7 shortcut mapping should look like "View.ToggleDesigner (F7 (Global))"
Shift+F7 shortcut mapping should look like "View.ViewDesigner (Shift+F7 (Global))" and "View.ViewMarkup (Shift+F7 (HTML Source Editor View))" (two mappings for one shortcut).
Download dpack for visual studio (free) - then F7 will always switch to the "other" view. Plenty of other great features in there too.
It is Ctrl-Shift-F7.
Download this the keyboard shortcut poster from MS for all the Keyboard short cuts.
I have two similar problems:
a) I have a solution which includes several projects and I want to be able easily switch project location by setting some environment variable/macro. As example this project can be located in \SolutionDir\Dir1\ or \SolutionDir\Dir2\ So, I want to specify that it should be located in \SolutionDir\$(Var) and just set the variable.
Is there any build in Visual Studio way to do it?
I know currently only two solutions - edit .sln file manual/programmatically to find this project and set correct path.
I wasn't able to use environment variable in .sln file.
b) I have a project which includes resources (.rc and .h) files. I want to be able to set their location through other environment variable or macro.
Something like \ProjectDir\$(Var2)\resource.rc
I found some promising info on property sheets, but Visual studio doesn't expand macros when I am using them in File tag in the .vcproj.
Thank you for any ideas how to solve this problem.
Regards, Victor
Just use the environment variable in the relevant field:
OutputDirectory="$(MyEnvVariableName)\Bin"
One trick is that you need to restart the Visual Studio IDE each time you change the variable.
There is an MSDN article precisely about this: How to: Use Environment Variables in a Build
I think I have the same goal than you: I want to use environment variables to locate some projects in a solution file (.sln) and to use some environment variables to locate some files within my projects.
I found a way to do that and it works fine for me (with Visual Studio 2005): - edit the .sln file with a text editor and use environment variables with the following syntax %MyEnvironmentVariable% - edit the .vcproj files and replace the path to the desired files with some variables, with the following syntax $(MyEnvironmentVariable).
Hope it helps... Cyrille
The best way to achieve what you describe in b) is to use property sheets. Check out also this very similar question.
I found some promising info on property sheets, but Visual studio doesn't expand macros when I am using them in File tag in the .vcproj.
I am not sure what version of VS you use. VS2008 lets you define for example an include directory like this: "$(OpenCVInclude)\cxcore\include". I use it all the time. OpenCVInclude is a macro defined in a property sheet.
As for question a), I think there is no "clean" way to do what you want. As an alternative you could the configuration manager:
(a) Cyrille gives a decent solution to what you asked for. Another way is to keep your changeable settings in one common place. Note that this won't work for non-msbuild files like *.sln and *.vcproj (until VS 2010).
Project files: ... $(ChangeableDir)\foo.cs
Common.targets: ChangeThis ...
However, I don't think this is a great way to do things. If the differences between what you're building are large pieces of functionality, you should consider creating a branch in your source control system. OTOH, if the differences are minor -- eg hardcoded strings -- then this leads to your second question...
(b) The kind of resource management you describe is essentially the same problem faced by people localizing their project into different languages. Luckily, direct support is built into Visual Studio since 2005. Check out previous questions like: http://stackoverflow.com/questions/355685/localization-in-visual-studio-2008
I am working in a Web Project in Visual Studio 2008. When I hit F12 (or right-click and select Go To Definition) Visual Studio is consistently going to the Meta data file instead of going to the source.
Some Points:
Has anyone else seen this behavior and/or know how to fix it?
Well, another developer found the answer. The specific project we had an issue with was originally added as a file reference, then removed and added as a Project Reference. Visual Studio however, kept both in the csproj file for the web site, causing the issue. He went in and manually edited the csproj file to remove the file reference to the problem project and all is fixed now
It happens when you don't add reference as a project but point to a dll or exe using Browse tab in Add Reference dialog. If you add reference using Projects tab you should go directly to the source code when you select Go To Definition.
However, if you install ReSharper, you'll go to source code even if you added your reference to a dll/exe using Browse tab.
Visual studio often suffer from a problem of going to metadata rather than your project if you shift location where you are building the project, ie you may have several versions to test things out.
Simply delete the reference and immediately add it back and everything will be sorted out.
This problem can arise when referencing projects that target a different .NET Framework version. Read the post below:
Why Does "Go to Definition" And Intellisense Not Work Properly For Referenced Projects in VS.NET:
http://allen-conway-dotnet.blogspot.com/2010/09/why-does-go-to-definition-and.html
I figured out how to solve my problem from this post, maybe it will also work for some of you.
I followed these steps:
(I believe either step 3 or 4 regenerates the intellisense database file when it is missing)
Intellisense, "go to defintion" and "find all references" should be working again.
The only solution I've seen is at: http://johnson1965.blogspot.com/2007/07/visual-studio-2005-go-to-definition-i.html
Best guess is that you don't have debug information. Maybe you have multiple copies of your assembly on disk and it doesn't have the .pdb file with it.
Do a search for your assembly names from your projects and delete them all and rebuild.
1.click on web site menu from VS. 2. Add reference... 3. Click on project tab from dialog box 4. Select ddl 5. Click on ok button
Visual Studio freezes up continually when I'm editing master pages or aspx files. Here's what I've tried that have not helped:
I don't have tons of files - 3 Master pages and maybe 30 aspx files. It is a asp.net mvc project. All I have to do to get VS to freeze is type a little text or even just paste. The freezing lasts a good 5-10 seconds. My machine has 4GB of RAM and fast disks.
Could it have anything to do with asp.net mvc? Would the amount and size of other projects in the solution affect the editor?
I Solved this problem by uninstalling 'Microsoft Visual Studio Web Authoring Component' from my machine. It can be uninstalled from 'Add/Remove Programs' option in Control Panel. What a nightmare!
Now everything works just like its supposed to. I'm surprised Microsoft couldn't figure out what the problem and solution is. How much do they spend on R&D and Q/A again?????
Hope this helps others.
I had a similar issue and found an article about the problem, rather than reinstall Office to check, I simply renamed the setup.exe to setup.exe.old and that resolved it.
I'm not sure about that, but I guess that if you're having a lot of (probably huge) projects in the solution, this would definitely slow down VS for it parses the code to give you an up-to-date intellisence menu ... Master pages are a little slow anyway, especially that VS is not that fast on rendering the HTML elements, not to mention Master pages.
I finally figured out what the problem was with mine. I had a protocol relative script reference in my masterpage that was reeking havick on my editor. Hopefully a bug microsoft will fix soon.
Here is what I had:
<script src="//ajax.googleapis.com/ajax/libs/jquery/1.4.2/jquery.min.js"
type="text/javascript"></script>
What I had to do to fix it:
<script src="http://ajax.googleapis.com/ajax/libs/jquery/1.4.2/jquery.min.js"
type="text/javascript"></script>
Hope that helps someone
Have you installed SP1?
I have been having this problem off and on for a few weeks. I finally resolved it today. The source (nice pun) of the problem was source control. I am currently using Visual Source Safe 2005 (I know, I'm dumping it soon), but I think it could be an issue with any source control package.
I first suspected VSS when I was able to edit ASPX pages in the design view without issue using a machine that was not connected to VSS. If I removed source control from the project, everything worked fine.
I then discovered that somehow my VSS connection settings got changed from using a folder connection to a web connection. I'm not sure how this could have happened since I am the only one that uses VSS and I certainly didn't change it. Anyway, I reset it back and everything began to work normally again.
rename worked for me i.e. changed setup.exe to setiup.exe.old
C:\Program Files (x86)\Common Files\microsoft shared\ OFFICE12\Office Setup Controller\Setup.exe
wish i'd found this article first - it has taken me many man hours
thx -j
It can also happen if you have markup problems. For instance, if you have a Label control and add something like Text="<%# TranslateLabel("lblSearch") %>" the page will freeze even in source mode when attempting to save it. The correct sintax should be Text='<%# TranslateLabel("lblSearch") %>'. I know it is not your problem, but maybe it's useful for somebody else...
I got the sampe problem with Visual Studio 2008 SP1. And yeah it was a masterpage as well. The solution what I found is to restart Visual Studio 2008 and use the source mode of ASPX file :)
I guess the problem here is a masterpage.
I had the same problem when I removed Office 2007 to install Office 2010 beta. I have installed Office 2010 64 bits on Windows 7
I used Robert MacLean's solution, and it works for me, I just renamed the file.
I am not sure if this is going to help anybody but after trying all the answers here to no avail I deleted a huge block of commented code on my ASPX page and the behavior went away. I am not really sure why a large commented block of code would cause VS to freeze up after every edit action but that seems to be what happened.
With VS2005 I found the problem to be with a link to a javascript file (that was in a master page) that I entered as
<script src="../../js/file.js" type="text/javascript" />
when I change this to just <script src="/js/file.js" ... >
the problem went away.
NOTE while this "bad link" was in the master page, VS2005 hung even when I did not have the masterpage as an open document. Basically as soon as I tried to edit anything (or even build the app) VS hung. I had to close VS, change the offending file in note pad and open VS again. Then all was good.
The very odd thing was I added this link to the file last night and VS was still behaving ok, it was not until this morning after a restart that the file caused the problem.
I Hope this helps someone Derek
Uninstalling 'Visual Studio Web Authoring tool' solved this problem.
On a successful build, I wish to copy the contents of the output directory to a different location under the same "base" folder. This parent folder is a relative part and can vary based on Source Control settings.
I have listed a few of the Macro values available to me ...
$(SolutionDir) = D:\GolbalDir\Version\AppName\Solution1\build
$(ProjectDir) = D:\GolbalDir\Version\AppName\Solution1\Version\ProjectA\
I want to copy the Output Dir contents to the following folder :
D:\GolbalDir\Version\AppName\Solution2\Project\Dependency
The base location "D:\GolbalDir\Version\AppName" needs to be fetched from one of the above macros. However, none of the macro values list only the parent location.
How do I extract only the base location for the post build copy command ?
If none of the TargetDir or other macros point to the right place, use the ".." directory to go backwards up the folder hierarchy.
ie. Use $SolutionDir\..\.. to get your base directory.
You could try:
$(SolutionDir)\..\..\
Here is what you want to put in the project's Post-build event command line:
copy /Y "$(TargetDir)$(ProjectName).dll" "$(SolutionDir)lib\$(ProjectName).dll"
Would it not make sense to use msbuild directly? If you are doing this with every build, then you can add a msbuild task at the end? If you would just like to see if you can?t find another macro value that is not showed on the Visual Studio IDE, you could switch on the msbuild options to diagnostic and that will show you all of the variables that you could use, as well as their current value.
To switch this on in visual studio, go to Tools/Options then scroll down the tree view to the section called Projects and Solutions, expand that and click on Build and Run, at the right their is a drop down that specify the build output verbosity, setting that to diagnostic, will show you what other macro values you could use.
Because I don?t quite know to what level you would like to go, and how complex you want your build to be, this might give you some idea. I have recently been doing build scripts, that even execute SQL code as part of the build. If you would like some more help or even some sample build scripts, let me know, but if it is just a small process you want to run at the end of the build, the perhaps going the full msbuild script is a bit of over kill.
Hope it helps Rihan
I want to store a set of integers that get auto incremented at build time:
int MajorVersion = 0;
int MinorVersion = 1;
int Revision = 92;
When I compile, it would auto-increment Revision. When I build the setup project, it would increment MinorVersion (I'm OK with doing this manually). MajorVersion would only be incremented manually.
Then I could display a version number in menu Help/About to the user as:
How can this be achieved?
If you add an AssemblyInfo class to your project and amend the AssemblyVersion attribute to end with an asterisk, for example:
[assembly: AssemblyVersion("2.10.3.*")]
Visual studio will increment the final number for you according to these rules (thanks galets, I had that completely wrong!)
To reference this version in code, so you can display it to the user, you use reflection. For example,
string version = System.Reflection.Assembly.GetExecutingAssembly().GetName().Version.ToString();
Here's the quote on AssemblyInfo.cs from MSDN:
You can specify all the values or you can accept the default build number, revision number, or both by using an asterisk (). For example, [assembly:AssemblyVersion("2.3.25.1")] indicates 2 as the major version, 3 as the minor version, 25 as the build number, and 1 as the revision number. A version number such as [assembly:AssemblyVersion("1.2.")] specifies 1 as the major version, 2 as the minor version, and accepts the default build and revision numbers. A version number such as [assembly:AssemblyVersion("1.2.15.*")] specifies 1 as the major version, 2 as the minor version, 15 as the build number, and accepts the default revision number. The default build number increments daily. The default revision number is random
This effectively says, if you put a 1.1.* into assembly info, only build number will autoincrement, and it will happen not after every build, but daily. Revision number will change every build, but randomly, rather than in an incrementing fashion.
This is probably enough for most use cases. If that's not what you're looking for, you're stuck with having to write a script which will autoincrement version # on pre-build step
Use AssemblyInfo.cs
Create the file in App_Code: and fill out the following or use Google for other attribute/property possibilities.
AssemblyInfo.cs
using System.Reflection;
[assembly: AssemblyDescription("Very useful stuff here.")]
[assembly: AssemblyCompany("companyname")]
[assembly: AssemblyCopyright("Copyright © me 2009")]
[assembly: AssemblyProduct("NeatProduct")]
[assembly: AssemblyVersion("1.1.*")]
AssemblyVersion being the part you are really after.
Then if you are working on a website, in any aspx page, or control, you can add in the <Page> tag, the following:
CompilerOptions="<folderpath>\App_Code\AssemblyInfo.cs"
(replacing folderpath with appropriate variable of course).
I don't believe you need to add compiler options in any manner for other classes; all the ones in the App_Code should receive the version information when they are compiled.
Hope that helps.
If you put an asterisk in for build and revision visual studio uses the number of days since Jan. 1st 2000 as the build number, and the number of seconds since midnight divided by 2 as the revision.
A MUCH better life saver solution is http://autobuildversion.codeplex.com/
It works like a charm and it VERY flexible.
You could try using UpdateVersion by Matt Griffith. It's quite old now, but works well. To use it, you simply need to setup a pre-build event which points at your AssemblyInfo.cs file, and the application will update the version numbers accordingly, as per the command line arguments.
As the application is open-source, I've also created a version to increment the version number using the format (Major version).(Minor version).([year][dayofyear]).(increment). More information about this and the revised code is available on my blog entry, Assembly Version Numbers and .NET.
You could use the T4 templating mechanism in Visual Studio to generate the required source code from a simple text file.
You could use this VS addin http://autobuildversion.codeplex.com/
You can do more advanced versioning using build scripts such as Build Versioning
I like to put my using directives inside the current namespace, and not outside as VS and Resharper per default puts them.
Does anyone know of a macro/standard functionality that sorts/removes unused using directives and puts them inside the current namespace?
--larsw
Have you tried the Resharper option:
Languages -> C# -> Formatting Style -> Namespace Imports -> Add using directive to the deepest scope
I'm not sure whether R#'s code cleanup will reorder the existing ones for you though.
I've edited my default visual studio templates to put my using directives inside the namespace.
For sorting and removing unused directives, I use Power Commands for Visual Studio 2008.
What can you do if you get the following error when installing Visual Studio 2008 sp1 in Windows 7 RC?
Operation Aborted
while installing Visual Studio 2008 SP1 on Windows 7 RC 7100, run this as administrator:
reg delete HKLM\SOFTWARE\Microsoft\SQMClient\Windows\DisabledSessions /va /f
Afterwards Visual Studio 2008 SP1 will install correctly.
I copied this from the original question, just to make it a proper question/answer... marked as community wiki
Download this update and install it before you install sp1 on to visual studio 08
I cannot get rid of this in my VS 2008 web project when debugging. I've checked that it's in debug mode on the non-web project in question and it's in Active(Debug). Deleted all items in my .NET 2.0 temp folder in Windows. Not sure what else to do here.
Try disabling "Enable Just My Code" in Tools/Options/Debugging/Options.
I had the same problem and discovered that I wasn't outputting my debug info on my build. If you right click on the project and go to 'properties', then select the 'build' tab, on the bottom of the page there's an 'Advanced...' button that will display your setting for you output debug info. Set that to 'full' and the error should go away.
resolved. Deleted all occurences (all projects) of the dll in question.
Check your build configuration options. Make sure optimizations are turned off and the DEBUG constant is defined.
Check out this link
http://social.msdn.microsoft.com/Forums/en-US/vsdebug/thread/43cb16ba-0759-42ab-8e7d-9f168ace3b6f
try unchecking "Just My Code" in Tools->Options->Debugging->General.
it works for me
I too have all these. And I've done all this. It appears this happens to me every time I get a fresh copy of the entire solution out of source control. So if we've done all these, deleted dlls & .pdb files for all references (Assemblies) in the web project, used the clean option on the solution, deleted temp files, closed out VS and reopened, made sure debug mode is selected and set at full and optimations are off, what more is there?!?!?!
At least for non-web applications this works:
From: http://www.stellarpc.com/articles/board.aspx?id=40
2 - Allow Debugging...
Due to the nature in which one of the assemblies has been built in your application, you will need to change a few settings to allow the code to be handled by the Visual Studio Debugger.
Right click on any project in question from the solution explorer and select 'Properties'. This will open up the project properties panel giving us access to a great many options for our projects. Navigate to the 'Complile' Tab (or 'Build' if your in a C# environment) and select 'Advanced Compile Options...' from the bottom of the screen. This presents us with a prompt that has two key areas of interest:
1) Optimizations - uncheck 'Enable Optimizations'
2) Generate debug info - Ensure that the option is set to 'Full'
You mentioned it's a web project...do you have
<compilation debug="true />
in your web.config?
Try rebooting...seriously...I shut down VS, started back and up and no problems. SQL Server was out of control on memory and I recycled the MSSQLSERVER service as well.
Guessing VS 2008 is not rebuilding the dll correctly.
1) Delete all occurrences of the dll
2) Rebuild solution
And that should fix it.
I had the same problem after building with a Release configuration. It turned out that when I switched back to Debug, VS wasn't detecting any differences, so it was not updating the .dll and .pdb files in the bin folder.
Here's what worked for me:
Try a rebuild then debug.
My case is following: webservice referenced lib1.dll. Later I removed reference as it was no longer used. However lib1.dll remained in the bin folder. Because library was not referenced then Rebuild and Clean actions were not helpful. After manually deleting lib1.dll from bin folder I've get rid of this message.
If everything else fails, try renaming the Assembly name in the project's properties. This fixed the issue for me.
I had the same issue on my web project in visual studio 2010, and finally I found the reason why I was getting this meessage, what i did is to change an existing debugging option on Visual studio ----> Tools->Options->Debugging->Symbols->All modules, unless excluded check shouldb be checked, click on the link "Specify excluded modules", then remove the dll that you want to debug... in my case it was my web dll file...
Ernesto...
I had this issue with a solution in a certain folder, but if I moved it to another folder or others built it, I didn't get the message. I did the clean, rebuild, and even rebooted and still couldn't get the original to debug without this message. I searched my system for copies of the file causing the error and I found that copies were kept in
c:\User\username\AppData\Local\Assembly\dl3
This was on Win7-64 but will be similar on other Windows OSes. I deleted all of the copies I found there and I no longer get the message. I didn't need to uncheck the "Enable Just My Code".
Also, this was for a WPF app, but I came across this thread in my search so hopefully this will help someone else.
I just ran into this issue, and quickly decided that the other answers posted didn't apply to me.
I'm the owner of the project, and I know it was built with debug information, as well as without optimizations. Furthermore, I'm never happy choosing the disabling of a warning as my first choice. Hiding/ignoring this warning could become an issue in a future debugging session.
Since this only started occurring after I signed the assembly, this clued me in on my quick fix: temporarily remove the strong name of my DLL (and consuming EXE). Voila! Problem solved.
A better, long-term solution, could take the form of adding a post-build action to update the GAC so it has the latest version of the signed DLL.
But for now, I'm happy to move on from this diversion, and continue working on the issue that brought me to this debugging session.
I love using an IDE, because I get some great productivity gains. However, I have a couple reasons to stop using a mouse with an IDE:
I've got my cheat sheet for my IDE printed out and now I'm ready.
Move it to the wrong side (eg if you are right handed then put it on the left of the keyboard). That way, you can still use it if necessary, but you should find you aren't using it unecessarily.
If changing sides isn't enough to confuse your brain, then moving it to a place where it is accessible but you have to think before reaching for it. As long as you can't reach for the mouse without thinking about it, then you will find that it is easier to use keyboard shortcuts instead. Essentially you want the mouse to be an option but the keyboard to be a better/easier/more convenient one!
As for pitfalls, well you may find that if you have to test any interfaces (web based or dektop) that you need to revert back to using the mouse. Also I find that if I have to work outside of the IDE, then it is just not as efficient to do without the mouse. Often we use WOrd for specifications and documentation, and trying to get away with using that without a mouse, is tricky (in my experience).
Another potential source of annoyance, is when switching between applications (Eclipse, VS, etc), you find that they often use different keyboard shortcuts, and so it can take a while to get back up to speed again, or you have to spend some time reconfiguring the shortcuts to be consistent.
Unplug it.
If your mouse is completely gone then you will be forced to learn how to live without it and therefore will become productive without it.
Anytime you're about to use the mouse, forcibly stop yourself and look up the keyboard shortcut for that operation. Do that a few times per operation and soon your muscle memory will kick in and you won't even have to think about it anymore.
Learn the keyboard short cuts :)
Also some editors are better suited for mouse free operation. I use ViEmu with Visual Studio which has helped me reduce, but not eliminate the need for using the mouse.
Your real question is about pain and productivity, the mouse is just a by-product of your circumstances. I would rephrase the question to reflect your real purpose.
Check out the wrist braces. I've heard from people that it makes a huge difference.
For VS, check out Sara Ford's blog.
Search her blog for plenty of other tips and tricks.
Get a trackball.
Hide the mouse under a copy of your cheat sheet.
For visual studio I use the ViEmu plugin that allows you to use vi commands in visual studio. It's a bit difficult to get the hang of it but once you're done you'll only be using the mouse on the designer.
I've summed up some shortcuts that will get you working faster with Visual Studio in my blog.
Open the nearest drawer and shove it in and close the drawer. That way, when you really do need it it'll be inconvenient to use it!!!
Also, if you're using multiple IDEs it pays to configure key bindings that are common across them, so that you can switch between them easily.
Change your keys to Emacs setup , Learn the Keyboard Shortcuts. I rarely use the mouse, if ever, in eclipse. i find it alot easier to just use emacs key short cuts.
When I contracted for an investment bank in NYC, there was this guy who didn't use a mouse. He was a java/kdb dev and just used vim. I used to think it was the strangest thing that he didn't have a mouse attached to his computer, but damn.. that guy was productive. Probably the most productive guy I've ever worked with.
So yea, if you really want to go that route you could try using vim, or something similar. You'll lose the features you're used to in your IDE, but it worked for him...
Become a better typer. As a slow typer, I find myself going to the mouse so I dont have to type. If I were more efficient at typing, I would be less inclined to use the mouse.
If you are using a laptop and a mouse, remove the mouse and leave the trackpad as your only option. That will be so painful that you will be forced to learn more keyboard shortcuts.
Get a webcam and eye-tracking software. Then you can fix bugs just by looking at them. It makes you feel all-powerful.
Some very good answers above.
I spent a while injured with RSI and mousing was an issue. I already used shortcuts a LOT. But coding using strictly the keyboard was definitely slower, especially when it comes to navigating around the code.
As I was using vi at the time, I would primarily move around the screen by doing searches for text at the location I wanted to go to; this is very fast, assuming you pick unambiguous text. Leaving line-numbers on and then going to the line number is another way to rapidly navigating. Judicious use of code folding (available in many IDEs) helps, too.
Finally, consider an alternate pointing device. A trackpad sucks for games but can be more accessible for coding, especially if you put it in easy reach of the keys (e.g., if you use a split keyboard, between the two hands). Try switching between two or more styles of device, to avoid injury because of one specific device. And don't ignore wrist pain! Treat it before it gets worse and you end up non-productive for a year or something.
Change your keyboard:
Configure your IDE to use VI or EMACS keyboard controls (and learn them.) Both options allow you do do most tasks without moving your hands of the home row. You'll see your productivity drop during the learning curve but jump way up after as you save a lot of time by not moving your hand of the keyboard to use the mouse.
As a side note, learning to use a terminal based editor is a good skill to have in case you ever need to remotely administer a *nix machine. It will save your bacon some day.
All these coders and no one suggested to write some code to hide the pointer when the IDE's window is active??
Great question... A co-worker suggested Launchy to me as a way to reduce mouse-use/be more productive. It searches your Start Menu (or non-windows equivalent) for apps, docs, shortcuts, etc. Type alt+spacebar to bring up its prompt where you type what you want to launch. Here are a few examples - what you type depends on other things in your Start Menu.
A power-user can fiddle with its settings to get more out of it but even basic users will benefit from it. Hope it helps.
Hide your mouse - at least one arm's length away - then you can always get it back in an emergency
Switch to emacs.
Move it far enough away that it's inconvenient to use, while your cheat sheet is close enough to easily lookup whenever you are in doubt about how to do something. I would not suggest unplugging it, since it is a useful tool for some operations, such as moving files around. I find drag and drop in some sort of tree like file system view is much easier than the alternatives. The majority of editing operations though, are quickly accomplished via key strokes once you remember them.
I am using IntellijIDEA IDE. There is one very annoying plugin - "Key promoter".
For every mouse-inited action it shows annoying alert with keyboard shortcut which you could use to do the same action.
Well, it took about 2 or 3 weeks for me to stop using mouse at all. It was hard to not turn it off (plugin), but very useful :)
IMHO the best answer is combination of two already given answers:
You may also want to consider doing your coding on a Macbook/Macbook pro. I generally HATE touchpads, but I've had to do some coding on the plane and the new touch-sensitive pads are actually really convenient. For example, you can do things like scrolling with a flick of two singers, and it's a lot more accurate.
It may not be perfect, but it might help with your hands.
I don't think avoiding the mouse completely is practical (you need things like hovers, etc.)
MouseFeeds plugin will help you in eclipse: http://www.mousefeed.com/installation
First off, don't try to do everything with a keyboard, start by forcing yourself to use keyboards for the top 3 things that you do all the time. Get the biggest bang for your buck/effort and you will quickly want to use more.
Keep a sheet of paper near by where you write down keyboard short cuts you use. (Alternatively, add this to a company wiki so others can benefit.)
Pay attention to menu items, they frequently have keyboard short cuts.
Find out the keyboard shortcuts that show all other keyboard short cuts.
I use Eclipse all the time, there are several keyboard short cuts that I find invaluable:
And CTRL+SHIFT+L gives you a list of all keyboard shortcuts
I have a C# app that must link with a 32-bit library and also needs to use the maximum amount of memory possible (imaging app); we run the app on XP64 desktops, thus we are using WOW64, targeting builds in Visual Studio for x86 (and doing an editbin /largeaddressaware post-build). We're encountering a few problems:
In the Visual Studio built-in debugger, we can only ever use 2gb of memory (~1.5gb to the app, plus overhead)
Running from the command line, the app can see 3gb of memory, but Microsoft documents would seem to say we should see 4gb.
Can anyone tell me how to get a WOW64 C# app to see the full 4gb that the platform should be able to give it?
Also, can anyone tell me how to get the Visual Studio (VS 2008, otherwise known as VS90) debugger to obey the /largeaddressaware bit and stop limiting the app memory to 2gb?
I see the same behavior in VS80 and VS90; also no difference between .NET Framework 3.5, 3.0, and 2.0. Here's a trivial C# program that illustrates the problems; build for x86, editbin /largeaddressaware, then run in built-in debugger versus run from command line to see the difference in memory available to C#.
namespace MemoryAllocTest
{
class Program
{
static void Main(string[] args)
{
const int allocSize = 1024 * 1024;
List<byte[]> myMem = new List<byte[]>();
UInt64 totalAlloc = 0;
while (true)
{
myMem.Add(new byte[allocSize]);
totalAlloc += allocSize;
Console.WriteLine("{0} allocs: {1}MB total",
myMem.Count, totalAlloc / (1024 * 1024));
}
}
}
}
can anyone tell me how to get the Visual Studio (VS 2008, otherwise known as VS90) debugger to obey the /largeaddressaware bit and stop limiting the app memory to 2gb?
This requires two steps -- both in the project properties:
With these two steps, your sample program was running to 3045MB
From Microsoft:
The virtual address space of processes and applications is still limited to 2 GB unless the /3GB switch is used in the Boot.ini file. When the physical RAM in the system exceeds 16 GB and the /3GB switch is used, the operating system will ignore the additional RAM until the /3GB switch is removed. This is because of the increased size of the kernel required to support more Page Table Entries. The assumption is made that the administrator would rather not lose the /3GB functionality silently and automatically; therefore, this requires the administrator to explicitly change this setting. The /3GB switch allocates 3 GB of virtual address space to an application that uses
IMAGE_FILE_LARGE_ADDRESS_AWAREin the process header. This switch allows applications to address 1 GB of additional virtual address space above 2 GB.
What exact version of .NET are you using? This Connect report is about the same problem (as far as I can tell), seen on .NET 2.0 but fixed in .NET 2.0SP1.
If your x64 machines don't have 2.0SP1 (or later) on, it's worth a try...
I built your simple sample app from the post, crashed it and attached WinDbg to it.
!address -summary will show you the effective user mode address space for the process.
0:003> !address -summary
TEB fffdd000 in range fffdb000 fffde000
TEB fffda000 in range fffd8000 fffdb000
TEB fffd7000 in range fffd5000 fffd8000
TEB fffaf000 in range fffad000 fffb0000
ProcessParametrs 004c2b40 in range 004c0000 00535000
Environment 004c1978 in range 004c0000 00535000
-------------------- Usage SUMMARY --------------------------
TotSize ( KB) Pct(Tots) Pct(Busy) Usage
e7d2e000 ( 3798200) : 90.56% 98.77% : RegionUsageIsVAD
1547b000 ( 348652) : 08.31% 00.00% : RegionUsageFree
2887000 ( 41500) : 00.99% 01.08% : RegionUsageImage
3ff000 ( 4092) : 00.10% 00.11% : RegionUsageStack
0 ( 0) : 00.00% 00.00% : RegionUsageTeb
1c0000 ( 1792) : 00.04% 00.05% : RegionUsageHeap
0 ( 0) : 00.00% 00.00% : RegionUsagePageHeap
1000 ( 4) : 00.00% 00.00% : RegionUsagePeb
0 ( 0) : 00.00% 00.00% : RegionUsageProcessParametrs
0 ( 0) : 00.00% 00.00% : RegionUsageEnvironmentBlock
**Tot: ffff0000 (4194240 KB)** Busy: eab75000 (3845588 KB)
-------------------- Type SUMMARY --------------------------
TotSize ( KB) Pct(Tots) Usage
1547b000 ( 348652) : 08.31% : <free>
2aa3000 ( 43660) : 01.04% : MEM_IMAGE
1f6a000 ( 32168) : 00.77% : MEM_MAPPED
e6168000 ( 3769760) : 89.88% : MEM_PRIVATE
-------------------- State SUMMARY --------------------------
TotSize ( KB) Pct(Tots) Usage
db838000 ( 3596512) : 85.75% : MEM_COMMIT
1547b000 ( 348652) : 08.31% : MEM_FREE
f33d000 ( 249076) : 05.94% : MEM_RESERVE
Largest free region: Base fbfc0000 - Size 03fed000 (65460 KB)
Based on Tot: ffff0000 (4194240 KB) we do have 4GB of effective user mode space.
Also our largest free block is 65,460KB which does imply that we should be able to allocate more memory.
Thanks to everyone who responded; this site really rocks!
Seems that we really do get to 4gb user space in WOW64, but it seems to me (mildly educated guess) that the garbage collector overhead (or perhaps safety margin) becomes sizeable as the memory allocated by managed code grows. Running my test app on WOW64 (command line, with LARGEADDRESSAWARE), I get total allocations of 3175MB; running on a WIN32 XP machine with the 4GT parameter set, I get total allocations of 2857MB: so a full gig of additional user-mode memory yields an increase of only ~318MB at the C# app level!
(I have modified my test program to halve the allocation unit size when an allocation fails, and also added calls to strategically force garbage collection in an effort to go a little beyond the limit of what a 'normal' application might be able to grab -- drop a note here if you would like me to post the revised code.)
Anyway, thanks again to everyone; looks like the system is working correctly but the managed environment gets less improvement from the additional gig of memory than may have been expected.
Can you post where it implies that you can see all 4 GB? Ooh, maybe here: Interesting info at this link
Differences in Addressable Memory
The first thing most developers notice is that 64-bit processors provide a huge leap in the amount of physical and virtual memory that can be addressed.
* 32-bit applications on 32-bit platforms can address up to 2 GB
* 32-bit applications built with the /LARGEADDRESSAWARE:YES linker flagon 32-bit Windows XP or Windows Server 2003 with the special /3gb boot option can address up to 3 GB. This constrains the kernel to only 1 GB which may cause some drivers and/or services to fail.
* 32-bit applications built with the /LARGEADDRESSAWARE:YES linker flagon 32-bit versions of Windows Vista, and on 32-bit versions of Windows Server Code Name "Longhorn" operating systems, can address memory up to the number specified by the boot configuration data (BCD) element IncreaseUserVa. IncreaseUserVa can have a value ranging from 2048, the default, to 3072 (which matches the amount of memory configured by the /3gb boot option on Windows XP). The remainder of 4 GB is allocated to the kernel and can result in failing driver and service configurations.
For more information about BCD, see Boot Configuration Data on MSDN.
* 32-bit applications on 64-bit platforms can address up to 2 GB, or upto 4 GB with the /LARGEADDRESSAWARE:YES linker flag. * 64-bit applications use 43 bits for addressing, which provides 8 TB of virtual address for applications and 8 TB reserved for the kernel.
So yes, it appears you should (on an XP64 target) be able to see 4 GB.
The immediate window is an immensely useful tool for debugging applications. You can use it to execute code statements that are valid in the context of your break point and inspect values. I also use it to type code snippets to learn language features.
How do you use the immediate window?
One nice feature of the Immediate Window in Visual Studio is its ability to evaluate the return value of a method particularly if it is called by your client code but it is not part of a variable assignment. In Debug mode, as mentioned, you can interact with variables and execute expressions in memory which plays an important role in being able to do this.
For example, if you had a static method that returns the sum of two numbers such as:
private static int GetSum(int a, int b)
{
return a + b;
}
Then in the Immediate Window you can type the following:
? GetSum(2, 4)
6
As you can seen, this works really well for static methods. However, if the method is non-static then you need to interact with a reference to the object the method belongs to.
For example, let?s say this is what your class looks like:
private class Foo
{
public string GetMessage()
{
return "hello";
}
}
If the object already exists in memory and it?s in scope, then you can call it in the Immediate Window as long as it has been instantiated before your current breakpoint (or, at least, before wherever the code is paused in debug mode):
? foo.GetMessage(); // object ?foo? already exists
"hello"
In addition, if you want to interact and test the method directly without relying on an existing instance in memory, then you can instantiate your own instance in the Immediate Window:
? Foo foo = new Foo(); // new instance of ?Foo?
{temp.Program.Foo}
? foo.GetMessage()
"hello"
You can take it a step further and temporarily assign the method's results to variables if you want to do further evaluations, calculations, etc.:
? string msg = foo.GetMessage();
"hello"
? msg + " there!"
"hello there!"
Furthermore, if you don?t even want to declare a variable name for a new object and just want to run one of its methods/functions then do this:
? new Foo().GetMessage()
"hello"
A very common way to see the value of a method is to select the method name of a class and do a ?Add Watch? so that you can see its current value in the Watch window. However, once again, the object needs to be instantiated and in scope for a valid value to be displayed. This is much less powerful and more restrictive than using the Immediate Window.
Along with inspecting methods, you can do simple math equations:
? 5 * 6
30
or compare values:
? 5==6
false
? 6==6
true
The question mark ('?') is unnecessary if you are in directly in the Immediate Window but it is included here for clarity (to distinguish between the typed in expressions versus the results.) However, if you are in the Command Window and need to do some quick stuff in the Immediate Window then precede your statements with '?' and off you go.
Intellisense works in the Immediate Window, but it sometimes can be a bit inconsistent. In my experience, it seems to be only available in Debug mode, but not in design, non-debug mode.
Unfortunately, another drawback of the Immediate Window is that it does not support loops.
If you referring to issue individual Visual Studio commands then have a look at Immediate Window for examples. That show how to evaluate expressions, execute statements, print variable values, and so forth though the immediate window.
I use it less now than in the past. Sometimes it's helpful to change the value of a variable, or inspect objects. That can be done through the watch window too, so I tend to use that more often.
What directory/solution/project structure do you find to be the most manageable and convenient for medium to large projects written in C#? By "medium to large" I mean projects which include a diverse set of Visual Studio C# project types in a hierarchical structure with nested namespaces.1
I'm primarily interested in those project types found in the 'Windows' section in Visual Studio 2008: Windows Forms, WPF, Custom Controls for both and Class Libraries. Additionally, I'm using MSBuild (via Visual Studio) to build my project.
I've never found the default structure automatically generated by Visual Studio to be worth using. This structure has one folder solely for containing the solution and a nested folder for each project. I'm wondering if this is because of the scale of project I've used C# for in the past (small to medium). What benefits does this structure have for larger projects? Have you found it useful?
I'm also interested in things like folder names and their relation to namespaces.
The following are my personal goals for project structure.
Projects should build with little or no extra effort in Visual Studio (MSBuild) at most or all levels of the heirarchy
I currently use a structure where the whole system is split into logical parts, each part being a separate Visual Studio solution. Each such solution is contained in a folder structure looking like this:
[logical part name]
|-doc
|-lib
|- // any non-GAC-assemblies needed by the projects in the solution
|-src
|-Production
| |-Project1
| |-Project2
|-Tests
|-UnittestProject1
|-UnittestProject2
|-tools
|- // any tools needed for automated builds and such
// (NUnit, NCover, MSBuild tasks, ...)
This does require some moving around of files (output from one logical part that is referenced by another needs to be moved into that other part's lib folder, for instance) but this can easily be automated within an MSBuild script. We also have such an MSBuild script that calls the MSBuild scripts of each of the logical parts in order, and moves the output into the appropriate lib folders. This way I can build the logical part that I am currently working with in one step, and also make a build of the full system with one click (or, well, double click).
We have used that structure in the current project for the last year and a half or so, and it seems to work out rather well.
You may want to check out TreeSurgeon.
For C# projects, I use usually a N layer structure. Something like:
/projectname_interface_layer/ /projectname_service_layer/ /projectname_business_layer/ /projectname_data_layer/
This has the advantage of offering a clear logical separation between the different entities of the application.
What we do:
We have separate solutions, subversion repositories, and builds for each layer.
Each layer has dependency builds so that building a lower layer will cause that layer to build.
Each layer has a Lib directory with externals pointing at the lower layer output directories.
Prior to a build, any layer(other than the root one), will do an update on the external folder(s), pulling the latest binaries in. If the build is successful, then it will update the external link to latest version, and then check in it's own binaries. This will trigger the next build down the chain, etc.
This way a breaking change in a lower level layer will fail builds up the chain, but if you do a get from the upper level layer it will still work in the most recent functional check-in.
As for deciding on layers, we pretty much have a framework layer, business logic layers, and presentation layers(either web service, application, or web site).
As for tests, they should be in the same solution as what they are testing, but different assemblies. The test assemblies should never be deployed to a production environment. The reason is that often, if not always, you will have your test assemblies be "friend" assemblies to the real ones. Assuming an attacker can execute any public members on deployed assemblies this gives them access to not only public members on your real code, but also internal ones.
Also, we keep things related to building, tools, config files, etc, in their own repository, separate from the code.
Does anyone have a summary list of what new features are available in VS2010? And what and high level requirements are (OS, etc)?
The .NET Framework universe poster
This is the best place to start your journey into features. The MIX conference had a couple of sessions on VS 2010 that are worth looking at, and I see someone mentioned the Channel 9 video series.
Here are some features I think are worthwhile:
Here are a couple of links to get you reading (the first one is a slideshow):
A good place to start is the Visual Studio section on Channel 9.
There are a number of 2010 links on that page which give great introductions and walk throughs of the upcoming features.
How can no one have linked to the Gu ?
MSDN has an article on What's New in Visual Studio 2010
Check this - New features of Visual Studio 2010
The list of features, together with the table showing which are available for which version, is now up here (Microsoft).
Note that the versions for less than $12,000 are seriously crippled, to various degrees. So Code Coverage is only available from $5K up, and Historical Debugger (now "Intellitrace") only for $12K.
Check this - http://weblogs.asp.net/scottgu/archive/2010/04/12/visual-studio-2010-and-net-4-released.aspx
I'm trying to export classes from a DLL that contain objects such as std::vectors and std::stings - the whole class is declared as dll export through:
class DLL_EXPORT FontManager
{
The problem is that for members of the complex types I get this warning:
warning C4251: 'FontManager::m__fonts' : class 'std::map<_Kty,_Ty>' needs to have dll-interface to be used by clients of class 'FontManager' with [ _Kty=std::string, _Ty=tFontInfoRef ]
I'm able to remove some of the warnings by putting the following forward class declaration before them even though I'm not changing the type of the member variables themselves:
template class DLL_EXPORT std::allocator<tCharGlyphProviderRef>;
template class DLL_EXPORT std::vector<tCharGlyphProviderRef,std::allocator<tCharGlyphProviderRef> >;
std::vector<tCharGlyphProviderRef> m_glyphProviders;
Looks like the forward declaration "injects" the DLL_EXPORT for when the member is compiled but is it safe? Does it realy change anything when the client compiles this header and uses the std container on his side? Will it make all future uses of such a container DLL_EXPORT (and possibly not inline?)? And does it really solve the problem that the warning tries to warn about?
Is this warning anything I should be worried about or would it be best to disable it in the scope of these constructs? The clients and the dll will always be built using the same set of libraries and compilers and those are header only classes...
I'm using Visual Studio 2003 with the standard STD library.
---- Update ----
I'd like to target you more though as I see the answers are general and here we're talking about std containers and types (such as std::string) - maybe the question really is:
Can we disable the warning for standard containers and types available to both the client and the dll through the same library headers and treat them just as we'd treat an int or any other built-in type? (It does seem to work correctly on my side.) If so would should be the conditions under which we can do this?
Or should maybe using such containers be prohibited or at least ultra care taken to make sure no assignment operators, copy constructors etc will get inlined into the dll client?
In general I'd like to know if you feel designing a dll interface having such objects (and for example using them to return stuff to the client as return value types) is a good idea or not and why - I'd like to have a "high level" interface to this functionality... maybe the best solution is what Neil Butterworth suggested - creating a static library?
When you may touch a member in your class from the client, you need to provide an DLL-interface. A DLL-interface means, that the compiler creates the function in the DLL itself and makes it importable.
Because the compiler doesn't know which methods are used by the clients of an DLL_EXPORTED class it must enforce that all methods are dll-exported. It must enforce that all members which can be accessed by clients must dll-export their functions too. This happens by the compiler warning you of methods not exported and the linker of the client sending errors.
No every member must be marked with with dll-export, e.g. private members not touchable by clients. Here you can ignore/disable the warnings (beware of compiler generated dtor/ctors).
Otherwise the members must export their methods. Forward declaring them with DLL_EXPORT does not export the methods of these classes. You have to mark the according classes in their compilation-unit as DLL_EXPORT.
What it boils down to ... (for not dll-exportable members)
If you have members which aren't/can't be used by clients, switch of the warning.
If you have members which must be used by clients, create an dll-export wrapper or create indirection methods.
To cut down the count of externally visible members use methods like PIMPL.
template class DLL_EXPORT std::allocator<tCharGlyphProviderRef>;
This does create an instantiation of the template specialization in the current compilation unit. So this creates the methods of std::allocator in the dll and exports the corresponding methods. This does not work for concrete classes as this is a only an instantiation of template classes.
That warning is telling you that users of your DLL will not have access to your container member variables across the DLL boundary. Explicitly exporting them makes them available, but is it a good idea?
In general, I'd avoid exporting std containers from your DLL. If you can absolutely guarantee your DLL will be used with the same runtime and compiler version you'd be safe. You must ensure memory allocated in your DLL is deallocated using the same memory manager. To do otherwise will, at best, assert at runtime.
So, don't expose containers directly across DLL boundaries. If you need to expose container elements, do so via accessor methods. In the case you provided, separate the interface from the implementation and expose the inteface at the DLL level. Your use of std containers is an implementation detail that the client of your DLL shouldn't need to access.
Alternatively, do what Neil suggest and create a static library instead of a DLL. You lose the ability to load the library at runtime, and consumers of your library must relink anytime you change your library. If these are compromises you can live with, a static library would at least get you past this problem. I'll still argue you're exposing implementation details unnecessarily but it might make sense for your particular library.
One alternative that few people seem to consider is not to use a DLL at all but to link statically against a static .LIB library. If you do that, all the issues of exporting/importing go away (though you will still have name-mangling issues if you use different compilers). You do of course lose the features of the DLL architecture, such as run-time loading of functions, but this can be a small price to pay in many cases.
Found this article. In short Aaron has the 'real' answer above; Don't expose standard containers across library boundaries.
Though this thread is pretty old, I found a problem recently, which made me think again about having templates in my exported classes:
I wrote a class which had a private member of type std::map. Everything worked quite well untill it got compiled in release mode, Even when used in a build system, which ensures that all compiler settings are the same for all targets. The map was completely hidden and nothing was directly exposed to the clients.
As a result the code was just crashing in release mode. I gues, because different binary std::map instances were created for implementation and client code.
I guess the C++ Standard is not saying anaything about how this shall be handled for exported classes as this is pretty much compiler specific. So I guess the biggest portability rule is to just expose Interfaces and use the PIMPL idiom as much as possible.
Thanks for any enlightenment
There are other issues.
Some STL containers are "safe" to export (such as vector), and some aren't (e.g. map).
Map for instance is unsafe because it (in the MS STL distribution anyway) contains a static member called _Nil, the value of which is compared in iteration to test for the end. Every module compiled with STL has a different value for _Nil, and so a map created in one module will not be iterable from another module (it never detects the end and blows up).
This would apply even if you statically link to a lib, since you can never guarantee what the value of _Nil will be (it's uninitialised).
I believe STLPort doesn't do this.
The best way I found to handle this scenario is:
create your library, naming it with the compiler and stl versions included in the library name, exactly like boost libraries do.
examples:
- FontManager-msvc10-mt.dll for dll version, specific for MSVC10 compiler, with the default stl.
- FontManager-msvc10_stlport-mt.dll for dll version, specific for MSVC10 compiler, with the stl port.
- FontManager-msvc9-mt.dll for dll version, specific for MSVC 2008 compiler, with the default stl
- libFontManager-msvc10-mt.lib for static lib version, specific for MSVC10 compiler, with the default stl.
following this pattern, you will avoid problems related with different stl implementations. remember, the stl implementation in vc2008 differs from the stl implementation in the vc2010.
See your example using boost::config library:
#include <boost/config.hpp>
#ifdef BOOST_MSVC
# pragma warning( push )
# pragma warning( disable: 4251 )
#endif
class DLL_EXPORT FontManager
{
public:
std::map<int, std::string> int2string_map;
}
#ifdef BOOST_MSVC
# pragma warning( pop )
#endif
In such cases, consider the uses of the pimpl idiom. Hide all the complex types behind a single void*. Compiler typically fails to notice that your members are private and all methods included in the DLL.
If you use a DLL make initialization of all objects at event "DLL PROCESS ATTACH" and export a pointer to its classes/objects.
You may provide specific functions to create and destroy objects and functions to obtain the pointer of the objects created, so you can encapsulate these calls in a wrapper class of access at include file.
none of the workarounds above are acceptable with MSVC because of the static data members inside template classes like stl containers
each module (dll/exe) gets its own copy of each static definition...wow! this will lead to terrible things if you somehow 'export' such data (as 'pointed' above)...so don't try this at home
I work with multiple projects and I want to recursively delete all folders with the name 'bin' or 'obj'. That way, I am sure that all projects will rebuild everyhing (sometimes it's the only way to force visual studio to forget all about previous builds).
Is there a quick way to accomplish this (with a bat file for example) without having to write a .net program?
something like this should work in a batch file - just please run it somewhere safe first to test it!
FOR /F "tokens=*" %%G IN ('DIR /B /AD /S bin') DO RMDIR /S /Q "%%G"
FOR /F "tokens=*" %%G IN ('DIR /B /AD /S obj') DO RMDIR /S /Q "%%G"
Personally I would rather use the msbuild command line clean method to do this though
Is 'clean' not good enough? Note that you can call msbuild with /t:clean from the command-line.
This worked for me:
for /d /r . %%d in (bin,obj) do @if exist "%%d" rd /s/q "%%d"
Based on this answer on superuser.com
I use to always add a new target on my solutions for achieving this.
<Target Name="clean_folders">
<RemoveDir Directories=".\ProjectName\bin" />
<RemoveDir Directories=".\ProjectName\obj" />
<RemoveDir Directories="$(ProjectVarName)\bin" />
<RemoveDir Directories="$(ProjectVarName)\obj" />
</Target>
And you can call it from command line
msbuild /t:clean_folders
This can be your batch file.
msbuild /t:clean_folders
PAUSE
On our build server, we explicitly delete the bin and obj directories, via nant scripts.
Each project build script is responsible for it's output/temp directories. Works nicely that way. So when we change a project and add a new one, we base the script off a working script, and you notice the delete stage and take care of it.
If you doing it on you logic development machine, I'd stick to clean via Visual Studio as others have mentioned.
I think you can right click to your solution/project and click "Clean" button.
As far as I remember it was working like that. I don't have my VS.NET with me now so can't test it.
I actually hate obj files littering the source trees. I usually setup projects so that they output obj files outside source tree. For C# projects I usually use
<IntermediateOutputPath>..\..\obj\$(AssemblyName)\$(Configuration)\</IntermediateOutputPath>
For C++ projects
IntermediateDirectory="..\..\obj\$(ProjectName)\$(ConfigurationName)"
We have a large .SLN files with many project files. I started the policy of having a "ViewLocal" directory where all non-sourcecontrolled files are located. Inside that directory is an 'Inter' and an 'Out' directory. For the intermediate files, and the output files, respectively.
This obviously makes it easy to just go to your 'viewlocal' directory and do a simple delete, to get rid of everything.
Before you spent time figuring out a way to work around this with scripts, you might think about setting up something similar.
I won't lie though, maintaining such a setup in a large organization has proved....interesting. Especially when you use technologies such as QT that like to process files and create non-sourcecontrolled source files. But that is a whole OTHER story!
Command line tool that finds Visual Studio solutions and runs the Clean command on them. This lets you clean up the /bin/* directories of all those old projects you have lying around on your harddrive
I found this thread and got bingo. A little more searching turned up this power shell script:
Get-ChildItem .\ -include bin,obj -Recurse | foreach ($) { remove-item $.fullname -Force -Recurse }
I thought I'd share, considering that I did not find the answer when I was looking here.
I have an ASP.NET 3.5 Website (visual studio lingo), but the site continues to grow and is looking rather cowboyish among other things. I'd like to see this get converted into a Web Application (namespaces and all).
Is this something that can be easily done in Visual Studio? If not, are there any other tools out there that could create all of the namespaces, etc. automagically?
Well, it turns out that the option "Convert to web application" does NOT exist for "websites". The option "Convert to web application" does exist only for "web applications" !!!!
[emphasis mine]
So, here's the deal, to do the conversion, you need to:
Add a new "Web Application" to your VS 2008 solution (File->Add->New Project->C#->Web->ASP.NET Web Application).
Afterwards, you copy all the files in the old "website" to your newly created "web application", and override any files created in it by default
The next step is the most ugly, you need to "manually" add the references in your "website" to the new "web application". I thought the VS 2008 PowerCommands toy would do this for me as it does copy references from other project types, but it didn't. You have to do it by yourself, manually, and you have to be cautious in this step if you have multiple versions of the same assembly (like AJAXToolkit in my case) or assemblies that have both GAC and local versions or so.
Keep repeating the last step and trying to build the "web application". You'll keep getting errors like " '....' is unknown namespace. Are you missing an assembly reference? ". Make sure you have none of those except the ones where '....' is replaced by the IDs of the server controls you use. In other words, keep adding references and building the project until only the errors that exist because of missing .DESIGNER.CS or .DESIGNER.VB files.
Afterwards, go to the "web application" root project node in VS 2008 solution explorer, and right click it, then you WILL find the option "Convert to web application". What this option does is actually making small changes to the "@Page" and "@Control" directives of pages and controls, and creating the required .DESIGNER.CS or .DESIGNER.VB files.
Try building the "web application" again. If you get errors, see what references may be missing and/or go click the "Convert to web application" again. Sometimes, if there's any error other than those caused of missing DESIGNER files, not all the pages/controls will have those DESIGNER files created for them. Fixing the non DESIGNER problem and clicking "Convert to web application" again should do the job for this.
Once you are done successful VS build, you should be ready to go. Start testing your web application. Optionally, you can right click the "web application" root project node in VS 2008 Solution Explorer and click "Properties" then go to the tab "Web" to set the "web application" to a virtual folder in IIS (you can create new virtual directory from there in VS). If you want to use the IIS virtual directory that the old "website" used, you need to remove that from IIS first.
Update: When testing your pages, pay MOST ATTENTION to classes in "App_Code" folder, especially those with NO NAMESPACE. Those can be a big trap. We had a problem with two extension method overloads in the same static class that had no namespace,one extends DateTime? (Nullable) and calls another overload that extends DateTime itself. Calling the other overload as extension method passed VS 2008 compilation and gave us a compilation error ONLY IN RUNTIME (With IIS). Changing the call to the other overload from calling it as extension method to calling it as normal static method (only changing the call in the same class, calls from other classes remained extension method calls) did solve this one, but clearly, it's not as safe as it used to be in VS 2005. Especially with classes with no namespaces.
Update2: During the conversion, VS 2008 renames your "App_Code" to "Old_App_Code". This new name sounds ugly, but DO NOT RENAME IT BACK. In the "web application" model, all code will be in one assembly. In runtime, the web server does not know what web project type you are using. It does take all code in "App_Code" folder and create a new assembly for it. This way, if you have code in folder named "App_Code", you'll end up with RUNTIME compilation errors that the same types exist in two assemblies, the one created by VS, and the one created by IIS / ASP.NET Development Server. To avoid that. leave the "Old_App_Code" with the same name, or rename it to ANYTHING EXCEPT: "App_Code". Do not place any code in such "App_Code" folder and prefereably do NOT have a folder with such name in your "web application" at all.
I know this since before but forgot it now as I have not used "website" model for long :(.
If your website application grows.. it's better to split it into several projects. Convertion from Web Site project to Web Application project won't help much.
Create a New Web Application in VS 2010.
1. Using Windows Explorer copy all your files into you project folder.
2. In VS 2010 solution explorer show all files.
3. Select the files and folders - right click include in project.
4. Right click the project solution explorer and select Convert to Web Application.
There are quite a few small differences, such as the App_Code folder will get renamed to old_app_code - that surprisingly doesn't cause any errors. The TypeName on your object data sources and the inherits on the @Page tag might need the [ProjectName]. prefix appended globally. For example if your type name was "BusinessLogic.OrderManager" and your project name is InventorySystem you would need to change it to InventorySystem.BusinessLogic.OrderManager. Also a few display changes, such as required field validators don't default to red font anymore, they default to black.
I have a file a xyz.cpp. I want to open two instances of a this file in Visual studio (btw I am using 2005). Why would I want to do so? I want to compare two sections of the same file side by side. I know workarounds such as
1) make a copy of the file. But the problem is that its not elegant and I dont want to make copies everytime I faced with this.
2) I can split the window into two. The problem with split it than I can split it horizontally only. The result of horizontal split is that right half my screen is white space.
If I were able to split it vertically or open two instances of the same file, it would increase the number of lines of code I can compare.
Here's how to do it ...
To enable the Window > New Window menu item mentioned in PaulB's answer for those using Basic (Visual Basic), HTML or JScript...
This article and this one point to a registry key: [HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\VisualStudio\10.0\Languages\Language Services\Basic] "Single Code Window Only"=dword:00000001
on Win 32 you may find this at HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\VisualStudio\10.0\Languages\Language Services\Basic
You switch off that key (set it to 0), or rename the key, to enable the "New Window" menu item (assuming you can see the item but it's greyed out). In addition to Basic (Visual Basic), the key is also there for HTML, JScript and RDL Expression. All other languages do not restrict to a single code window so you can use PaulB's answer without editing the registry.
To actually see the New Window menu item I had to add it back into the menu:
Open the file (it you are using multiple tab groups, make sure your file is selected).
Menu: Window --> Split (alternately, there's this tiny nub just above the editor's vertical scroll bar - grab it and drag down)
This gives you two (horizontal) views of the same file. Beware that any edit-actions will reflect on both views.
Once you are done, grab the splitter and drag it up all the way (or Menu: Window --> Remove Split)
Window menu, New Horizontal/Vertical Tab Group there will do, I think.
For file types, where the same file can't be opened in a vertical tab group (for example .vb files) you can
If you save to disk in one instance though, you'll have to reload the file when you switch to the other. Also if you make edits in both instances, you'll have to resolve on the second save. Visual Studio prompts you in both cases with various options. You'll simplify your life a bit if you edit in only the one instance.
I don't have a copy of VS 2005, but this process works on VS 2008:
You should now have 2 instances of file in separate vertical tab groups.
I seem to have achieved this, though I have no idea how (I landed here looking for how I did it). I have two tabs for the same file, labeled with "filename.c:1" and "filename.c:2". I can put them in separate vertical tab groups, so it sounds like exactly what you're trying to do. Anyone know how I accomplished this?
I'm using ASP.NET MVC a lot recently which means using server blocks a bunch. Visual Studio does this strange thing when I type:
<% } %>
and hit enter, I get this:
<%
}
%>
Which is unsightly and generally the most horrible thing I've ever seen. I've customized the Ctrl+K+D behavior pretty heavily and when I do this I get everything to look the way I want except for this one case. Anyone have any suggestions on how to customize this?
Looking at the behavior. I don't know that you can override it just for the HTML editor. It is exhibiting the exact behavior that is defined in the C# editor preferences.
I suppose you could modify the behavior for a closing brace in the C# editor preferences, but it would do fugly things to your .cs files.
Edit:
I got tired of trying to find other ways to do it. So I wrote this macro. Tested in VS 2k8. Not 2k5. You can see what it does. Also, sorry about the VB, but it was the default for the macro editor.
Sub FixFormatCurrentFile()
Dim selection As TextSelection = DTE.ActiveDocument.Selection
Dim fixed As String = "<% } %>"
Dim regex As String = "\<\%:Wh*\}:Wh*\%\>"
While selection.FindPattern(regex, vsFindOptions.vsFindOptionsRegularExpression)
selection.ReplacePattern(regex, fixed, vsFindOptions.vsFindOptionsRegularExpression)
End While
End Sub
i think you format it by Ctrl + K, Ctrl + D
This may sound a bit provocative but it actually is a real question. Feel free to edit if you don't like the tone.
Now, as much as I understand vi from my short experience with it like 10 years ago, it's a primitive text editor with one editable line at the bottom of the screen created before the scrollbars were invented, with some crazy shortcuts to overcome this limitation.
Can somebody explain me how one can be more productive with it than with, say normal VS.NET editor? Moreover, why would anybody want to use viEmu which supposedly turns your VS.NET into an ancient vi?
I'm willing to give it a try but I need some motivation to overcome the learning curve.
EDIT: Thanks to everybody who replied, I'm checking it out. See my blogpost at http://zvolkov.com/blog/post/2009/04/15/Learning-VI.aspx for account of my experience.
It honestly sounds like you have never seen someone use Vi who is truly proficient in it. When you normally use Visual Studio you frequently will move your hand over to your mouse, click through options, dialogs, classes, etc.
With ViEmu your hand never leaves the keyboard. You are compiling, switching files, highlighting groups of text, fixing indentation, performing complex motions on your code and running regular expression searches in seconds. For people who are fast typists it allows you to achieve a speed for tasks you would not be able to otherwise.
Many people will counter this by saying things like, "Most of my development time is spent thinking. The extra speed I gain from using tools like these is negligible.".
That is a non-argument in my opinion. It is true, for most large programming tasks you spend far more time planning and thinking then you do actually slinging code. But that doesn't mean that being able to express yourself through your IDE 2x faster doesn't have an impact on your productivity as a programmer.
The viEmu page itself has a pretty good article that might help to answer your question: Why, oh WHY, do those #?@! nutheads use vi?
I've spent the last couple months trying to teach myself to use vim "properly" and now I can hardly stand using other editors because they seem underpowered and clunky. For a random example, imagine you have a line of code that looks like this:
$welcomeMessage = "Welcome to SiteName!"; // shows at the top of homepage
In a normal editor, how would you change the string? You'd probably have to reach over and grab your mouse and carefully select it, or you'd move your cursor inside the first quotation mark, and hold down Shift and the right-arrow until you got to the closing quotation mark.
In vim, with my cursor anywhere in-between the quotes, I type ci" and it erases everything inside the quotation marks and puts me into insert-mode so I can type the new value I want. My hands didn't even have to move from my normal typing position.
There are so many things like this, I think you really have to spend a while using the editor to understand how powerful it is. It's very slow and hard to use at first, that's why a lot of people try it for a short time and think "this is dumb, everything is way harder", but after a while you start thinking in terms of the motions, it all starts to become automatic and it's much, much faster than using a "normal" editor. As I said, I can't go back now.
You are wrong about "one editable line at the bottom of the screen." All the text in the window is editable. And it does scroll (all versions) and in the case of gvim, has scrollbars.
Maybe you inadvertently put it in "ex mode". This is easily done and can be confusing.
I think they have a long and acceptable answer for your question on the viEmu hompage:
One other even more powerful example: let's take the 'ce' command, which is composed of 'c' and 'e'. The 'c'hange command deletes the range specified by the next motion command, and also enters insert mode. It's the same as 'd', but with the distinction that it enters insert mode, instead of staying in normal mode. The boon is that the text you type in the next (short) input session is also part of the command. So if you do 'ceHello>', what you do is replace from the cursor to the end of the word by 'Hello', and the '.' command afterwards will work exactly like that: replace up to the end of the word with 'Hello'.
From: http://www.viemu.com/a-why-vi-vim.html
I have viEmu installed ~half year ago. But I have to say (maybe without strong linux experiences) I've never used it. Too alien, too far, too complex.
So IMHO viEmu it's a great technical&historical challenge but no more for the 95% of the developers.
Another answer got me thinking that watching some skilled editing using vim would be pretty revealing so I dug up this video showing basic and more advance motions while coding. This person could get even a bit efficient using some marks, etc but it gives an idea.
If you need inspiration or want to see someone who really knows what they are doing with Vim, check out Gary Bernhardt's String Calculator Kata In Python, look at him go! http://vimeo.com/8569257
I have not experience with VS.Net but I guess it has the same features that any other IDE has.
I have found that learning the all the key commands of the editor in my IDE was a sufficient replacement for Vi. Things like renaming, indenting, formatting, moving lines and that kind of stuff.
So I guess the major win would be for someone who already know Vi to be productive without having to learn VS.Net.
But then again, Vi has some truly esoteric but powerful features that probably can't be matched by you standard IDE editor.
I think you really should give Vim a try.
If you quickly tried Vi ten years ago, I may understand you didn't appreciate it. It's not really user-friendly at first sight. Actually its real power is revealed when you start feeling comfortable with the movements and start making it your own with customisation. Once Vim is familiar to you you may understand why it deserves to be learnt.
I actually use VS only for debugging these days. Coding with vim (real vim, not viemu) is just a better experience.
Now, I am not going to claim that using one over another makes any difference in productivity - after all I spend most of my time trying to figure out how to solve a problem - entering the code is the easy part.
When I define my class properties with out using fields (which was enabled with C# 3.0), class diagram is not showing my one to one/many relationships. Inheritance is visible in the diagram though..
Is there a way to fix this?
When you right click on the field or property you can select show as association or show as collection association.
Andrew
This combines with Visual Studio and does everything you want to do with Class diagrams. http://modeling.codeplex.com/
Does anyone know of a .NET library/script for parsing Visual Studio solution (SLN) files? I would like to write an app that merges multiple solutions into one while saving the relative build order.
The .NET 4.0 version of the Microsoft.Build assembly contains a SolutionParser class in the Microsoft.Build.Construction namespace that parses Visual Studio solution files.
Unfortunately this class is internal, but I've wrapped some of that functionality in a class that uses reflection to get at some common properties you might find helpful.
public class Solution
{
//internal class SolutionParser
//Name: Microsoft.Build.Construction.SolutionParser
//Assembly: Microsoft.Build, Version=4.0.0.0
static readonly Type s_SolutionParser;
static readonly PropertyInfo s_SolutionParser_solutionReader;
static readonly MethodInfo s_SolutionParser_parseSolution;
static readonly PropertyInfo s_SolutionParser_projects;
static Solution()
{
s_SolutionParser = Type.GetType("Microsoft.Build.Construction.SolutionParser, Microsoft.Build, Version=4.0.0.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a", false, false);
if (s_SolutionParser != null)
{
s_SolutionParser_solutionReader = s_SolutionParser.GetProperty("SolutionReader", BindingFlags.NonPublic | BindingFlags.Instance);
s_SolutionParser_projects = s_SolutionParser.GetProperty("Projects", BindingFlags.NonPublic | BindingFlags.Instance);
s_SolutionParser_parseSolution = s_SolutionParser.GetMethod("ParseSolution", BindingFlags.NonPublic | BindingFlags.Instance);
}
}
public List<SolutionProject> Projects { get; private set; }
public Solution(string solutionFileName)
{
if (s_SolutionParser == null)
{
throw new InvalidOperationException("Can not find type 'Microsoft.Build.Construction.SolutionParser' are you missing a assembly reference to 'Microsoft.Build.dll'?");
}
var solutionParser = s_SolutionParser.GetConstructors(BindingFlags.Instance | BindingFlags.NonPublic).First().Invoke(null);
using (var streamReader = new StreamReader(solutionFileName))
{
s_SolutionParser_solutionReader.SetValue(solutionParser, streamReader, null);
s_SolutionParser_parseSolution.Invoke(solutionParser, null);
}
var projects = new List<SolutionProject>();
var array = (Array)s_SolutionParser_projects.GetValue(solutionParser, null);
for (int i = 0; i < array.Length; i++)
{
projects.Add(new SolutionProject(array.GetValue(i)));
}
this.Projects = projects;
}
}
[DebuggerDisplay("{ProjectName}, {RelativePath}, {ProjectGuid}")]
public class SolutionProject
{
static readonly Type s_ProjectInSolution;
static readonly PropertyInfo s_ProjectInSolution_ProjectName;
static readonly PropertyInfo s_ProjectInSolution_RelativePath;
static readonly PropertyInfo s_ProjectInSolution_ProjectGuid;
static SolutionProject()
{
s_ProjectInSolution = Type.GetType("Microsoft.Build.Construction.ProjectInSolution, Microsoft.Build, Version=4.0.0.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a", false, false);
if (s_ProjectInSolution != null)
{
s_ProjectInSolution_ProjectName = s_ProjectInSolution.GetProperty("ProjectName", BindingFlags.NonPublic | BindingFlags.Instance);
s_ProjectInSolution_RelativePath = s_ProjectInSolution.GetProperty("RelativePath", BindingFlags.NonPublic | BindingFlags.Instance);
s_ProjectInSolution_ProjectGuid = s_ProjectInSolution.GetProperty("ProjectGuid", BindingFlags.NonPublic | BindingFlags.Instance);
}
}
public string ProjectName { get; private set; }
public string RelativePath { get; private set; }
public string ProjectGuid { get; private set; }
public SolutionProject(object solutionProject)
{
this.ProjectName = s_ProjectInSolution_ProjectName.GetValue(solutionProject, null) as string;
this.RelativePath = s_ProjectInSolution_RelativePath.GetValue(solutionProject, null) as string;
this.ProjectGuid = s_ProjectInSolution_ProjectGuid.GetValue(solutionProject, null) as string;
}
}
Note that you have to change your target framework to ".NET Framework 4" (not client profile) to be able to add the Microsoft.Build reference to your project.
I can't really offer you a library and my guess is there isn't one that exists out there. But I've spent a deal of time messing around with .sln files in batch editting scenarios and I've found Powershell to be a very useful tool for this task. The .SLN format is pretty simple and can be almost completely parsed with a few quick and dirty expressions. For Example
Included Project files.
gc ConsoleApplication30.sln |
? { $_ -match "^Project" } |
%{ $_ -match ".*=(.*)$" | out-null ; $matches[1] } |
%{ $_.Split(",")[1].Trim().Trim('"') }
It's not always pretty, but it is an effective way to do batch processing.
we solved a similar problem of merging solutions automatically by writing a Visual Studio plugin which created a new solution then searched for *.sln file and imported them into the new one using:
dte2.Solution.AddFromFile(solutionPath, false);
Our problem was slightly different in that we wanted VS to sort out the build order for us, so we then converted any dll references to project references where possible.
We then automated this into a build process by running VS via COM automation.
This solution was a little Heath Robinson, but had the advantage that VS was doing the editing so our code was not dependant on format of the sln file. Which was helpful when we moved from VS 2005 to 2008 and again to 2010.
This web site provides source code for converting VS2008/2005 solution files. It may provide insights for creating your Solution merge utility.
I expounded, determined that the MSBuild classes can be used to manipulate the underlying structures. I will have further code on my web site later.
// VSSolution
using System;
using System.Reflection;
using System.Collections.Generic;
using System.Linq;
using System.Diagnostics;
using System.IO;
using AbstractX.Contracts;
namespace VSProvider
{
public class VSSolution : IVSSolution
{
//internal class SolutionParser
//Name: Microsoft.Build.Construction.SolutionParser
//Assembly: Microsoft.Build, Version=4.0.0.0
static readonly Type s_SolutionParser;
static readonly PropertyInfo s_SolutionParser_solutionReader;
static readonly MethodInfo s_SolutionParser_parseSolution;
static readonly PropertyInfo s_SolutionParser_projects;
private string solutionFileName;
private List<VSProject> projects;
public string Name
{
get
{
return Path.GetFileNameWithoutExtension(solutionFileName);
}
}
public IEnumerable<IVSProject> Projects
{
get
{
return projects;
}
}
static VSSolution()
{
s_SolutionParser = Type.GetType("Microsoft.Build.Construction.SolutionParser, Microsoft.Build, Version=4.0.0.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a", false, false);
s_SolutionParser_solutionReader = s_SolutionParser.GetProperty("SolutionReader", BindingFlags.NonPublic | BindingFlags.Instance);
s_SolutionParser_projects = s_SolutionParser.GetProperty("Projects", BindingFlags.NonPublic | BindingFlags.Instance);
s_SolutionParser_parseSolution = s_SolutionParser.GetMethod("ParseSolution", BindingFlags.NonPublic | BindingFlags.Instance);
}
public string SolutionPath
{
get
{
var file = new FileInfo(solutionFileName);
return file.DirectoryName;
}
}
public VSSolution(string solutionFileName)
{
if (s_SolutionParser == null)
{
throw new InvalidOperationException("Can not find type 'Microsoft.Build.Construction.SolutionParser' are you missing a assembly reference to 'Microsoft.Build.dll'?");
}
var solutionParser = s_SolutionParser.GetConstructors(BindingFlags.Instance | BindingFlags.NonPublic).First().Invoke(null);
using (var streamReader = new StreamReader(solutionFileName))
{
s_SolutionParser_solutionReader.SetValue(solutionParser, streamReader, null);
s_SolutionParser_parseSolution.Invoke(solutionParser, null);
}
this.solutionFileName = solutionFileName;
projects = new List<VSProject>();
var array = (Array)s_SolutionParser_projects.GetValue(solutionParser, null);
for (int i = 0; i < array.Length; i++)
{
projects.Add(new VSProject(this, array.GetValue(i)));
}
}
public void Dispose()
{
}
}
}
// VSProject
using System;
using System.Reflection;
using System.Collections.Generic;
using System.Linq;
using System.Diagnostics;
using System.IO;
using System.Xml;
using AbstractX.Contracts;
using System.Collections;
namespace VSProvider
{
[DebuggerDisplay("{ProjectName}, {RelativePath}, {ProjectGuid}")]
public class VSProject : IVSProject
{
static readonly Type s_ProjectInSolution;
static readonly Type s_RootElement;
static readonly Type s_ProjectRootElement;
static readonly Type s_ProjectRootElementCache;
static readonly PropertyInfo s_ProjectInSolution_ProjectName;
static readonly PropertyInfo s_ProjectInSolution_ProjectType;
static readonly PropertyInfo s_ProjectInSolution_RelativePath;
static readonly PropertyInfo s_ProjectInSolution_ProjectGuid;
static readonly PropertyInfo s_ProjectRootElement_Items;
private VSSolution solution;
private string projectFileName;
private object internalSolutionProject;
private List<VSProjectItem> items;
public string Name { get; private set; }
public string ProjectType { get; private set; }
public string RelativePath { get; private set; }
public string ProjectGuid { get; private set; }
public string FileName
{
get
{
return projectFileName;
}
}
static VSProject()
{
s_ProjectInSolution = Type.GetType("Microsoft.Build.Construction.ProjectInSolution, Microsoft.Build, Version=4.0.0.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a", false, false);
s_ProjectInSolution_ProjectName = s_ProjectInSolution.GetProperty("ProjectName", BindingFlags.NonPublic | BindingFlags.Instance);
s_ProjectInSolution_ProjectType = s_ProjectInSolution.GetProperty("ProjectType", BindingFlags.NonPublic | BindingFlags.Instance);
s_ProjectInSolution_RelativePath = s_ProjectInSolution.GetProperty("RelativePath", BindingFlags.NonPublic | BindingFlags.Instance);
s_ProjectInSolution_ProjectGuid = s_ProjectInSolution.GetProperty("ProjectGuid", BindingFlags.NonPublic | BindingFlags.Instance);
s_ProjectRootElement = Type.GetType("Microsoft.Build.Construction.ProjectRootElement, Microsoft.Build, Version=4.0.0.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a", false, false);
s_ProjectRootElementCache = Type.GetType("Microsoft.Build.Evaluation.ProjectRootElementCache, Microsoft.Build, Version=4.0.0.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a", false, false);
s_ProjectRootElement_Items = s_ProjectRootElement.GetProperty("Items", BindingFlags.Public | BindingFlags.Instance);
}
public IEnumerable<IVSProjectItem> Items
{
get
{
return items;
}
}
public VSProject(VSSolution solution, object internalSolutionProject)
{
this.Name = s_ProjectInSolution_ProjectName.GetValue(internalSolutionProject, null) as string;
this.ProjectType = s_ProjectInSolution_ProjectType.GetValue(internalSolutionProject, null).ToString();
this.RelativePath = s_ProjectInSolution_RelativePath.GetValue(internalSolutionProject, null) as string;
this.ProjectGuid = s_ProjectInSolution_ProjectGuid.GetValue(internalSolutionProject, null) as string;
this.solution = solution;
this.internalSolutionProject = internalSolutionProject;
this.projectFileName = Path.Combine(solution.SolutionPath, this.RelativePath);
items = new List<VSProjectItem>();
if (this.ProjectType == "KnownToBeMSBuildFormat")
{
this.Parse();
}
}
private void Parse()
{
var stream = File.OpenRead(projectFileName);
var reader = XmlReader.Create(stream);
var cache = s_ProjectRootElementCache.GetConstructors(BindingFlags.Instance | BindingFlags.NonPublic).First().Invoke(new object[] { true });
var rootElement = s_ProjectRootElement.GetConstructors(BindingFlags.Instance | BindingFlags.NonPublic).First().Invoke(new object[] { reader, cache });
stream.Close();
var collection = (ICollection)s_ProjectRootElement_Items.GetValue(rootElement, null);
foreach (var item in collection)
{
items.Add(new VSProjectItem(this, item));
}
}
public IEnumerable<IVSProjectItem> EDMXModels
{
get
{
return this.items.Where(i => i.ItemType == "EntityDeploy");
}
}
public void Dispose()
{
}
}
}
// VSProjectItem
using System;
using System.Reflection;
using System.Collections.Generic;
using System.Linq;
using System.Diagnostics;
using System.IO;
using System.Xml;
using AbstractX.Contracts;
namespace VSProvider
{
[DebuggerDisplay("{ProjectName}, {RelativePath}, {ProjectGuid}")]
public class VSProjectItem : IVSProjectItem
{
static readonly Type s_ProjectItemElement;
static readonly PropertyInfo s_ProjectItemElement_ItemType;
static readonly PropertyInfo s_ProjectItemElement_Include;
private VSProject project;
private object internalProjectItem;
private string fileName;
static VSProjectItem()
{
s_ProjectItemElement = Type.GetType("Microsoft.Build.Construction.ProjectItemElement, Microsoft.Build, Version=4.0.0.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a", false, false);
s_ProjectItemElement_ItemType = s_ProjectItemElement.GetProperty("ItemType", BindingFlags.Public | BindingFlags.Instance);
s_ProjectItemElement_Include = s_ProjectItemElement.GetProperty("Include", BindingFlags.Public | BindingFlags.Instance);
}
public string ItemType { get; private set; }
public string Include { get; private set; }
public VSProjectItem(VSProject project, object internalProjectItem)
{
this.ItemType = s_ProjectItemElement_ItemType.GetValue(internalProjectItem, null) as string;
this.Include = s_ProjectItemElement_Include.GetValue(internalProjectItem, null) as string;
this.project = project;
this.internalProjectItem = internalProjectItem;
// todo - expand this
if (this.ItemType == "Compile" || this.ItemType == "EntityDeploy")
{
var file = new FileInfo(project.FileName);
fileName = Path.Combine(file.DirectoryName, this.Include);
}
}
public byte[] FileContents
{
get
{
return File.ReadAllBytes(fileName);
}
}
public string Name
{
get
{
if (fileName != null)
{
var file = new FileInfo(fileName);
return file.Name;
}
else
{
return this.Include;
}
}
}
}
}
I am searching for a way to setup Visual Studio so it always saves my files in UTF-8.
I have only found options to set this project wide is there a way to set it Visual Studio wide?
Do you want the files to save as UTF-8 because you are using special characters that would be lost in ASCII encoding? If that's the case, then there is a VS2008 global setting in Tools > Options > Environment > Documents, named Save documents as Unicode when data cannot be saved in codepage. When this is enabled, VS2008 will save as Unicode if certain characters cannot be represented in the otherwise-default codepage.
Also, which files are not being saved as UTF-8? All of my .cs, .csproj, .sln, .config, .as*x, etc, all save as UTF-8 (with signature, the byte order marks), by default.
I don't know of a global setting nither but you can try this:
I have a page that dynamically adds script references via jQuery's $.getScript function. The scripts load and execute fine, so I know the references are correct. However, when I add a "debugger" statement to any of the scripts to allow me to step through the code in a debugger (such as VS.Net, Firebug, etc.), it doesn't work. It appears that something about the way jQuery loads the scripts is preventing debuggers from finding the files.
Does anybody have a work-around for this?
Ok, so it turns out that the default implementation of the $.getScript() function works differently depending on whether the referenced script file is on the same domain or not. External references such as:
$.getScript("http://www.someothersite.com/script.js")
will cause jQuery to create an external script reference, which can be debugged with no problems.
<script type="text/javascript" src="http://www.someothersite.com/script.js"></script>
However, if you reference a local script file such as any of the following:
$.getScript("http://www.mysite.com/script.js")
$.getScript("script.js")
$.getScript("/Scripts/script.js");
then jQuery will download the script content asynchronously and then add it as inline content:
<script type="text/javascript">{your script here}</script>
This latter approach does not work with any debugger that I tested (Visual Studio.net, Firebug, IE8 Debugger).
The workaround is to override the $.getScript() function so that it always creates an external reference rather than inline content. Here is the script to do that. I have tested this in Firefox, Opera, Safari, and IE 8.
<script type="text/javascript">
// Replace the normal jQuery getScript function with one that supports
// debugging and which references the script files as external resources
// rather than inline.
jQuery.extend({
getScript: function(url, callback) {
var head = document.getElementsByTagName("head")[0];
var script = document.createElement("script");
script.src = url;
// Handle Script loading
{
var done = false;
// Attach handlers for all browsers
script.onload = script.onreadystatechange = function(){
if ( !done && (!this.readyState ||
this.readyState == "loaded" || this.readyState == "complete") ) {
done = true;
if (callback)
callback();
// Handle memory leak in IE
script.onload = script.onreadystatechange = null;
}
};
}
head.appendChild(script);
// We handle everything using the script element injection
return undefined;
},
});
</script>
Agree with the answer, but may add:
script.type = "text/javascript"; //or relevant MIME
jQuery.extend({
getScript: function(url, callback) {
var head = document.getElementsByTagName("head")[0];
var ext = url.replace(/.*\.(\w+)$/, "$1");
if(ext == 'js'){
var script = document.createElement("script");
script.src = url;
script.type = 'text/javascript';
} else if(ext == 'css'){
var script = document.createElement("link");
script.href = url;
script.type = 'text/css';
script.rel = 'stylesheet';
} else {
console.log("??????????? ?????????? ????????????? ???????");
return false;
}
// Handle Script loading
{
var done = false;
// Attach handlers for all browsers
script.onload = script.onreadystatechange = function(){
if ( !done && (!this.readyState ||
this.readyState == "loaded" || this.readyState == "complete") ) {
done = true;
if (callback)
callback();
// Handle memory leak in IE
script.onload = script.onreadystatechange = null;
}
};
}
head.appendChild(script);
// We handle everything using the script element injection
return undefined;
}
});
With JQuery 1.6(maybe 1.5) you could switch to not using getScript, but using jQuery.ajax(). Then set crossDomain:true and you'll get the same effect.
The error callback will not work. So you might as well not set it up like below.
However, I do setup a timer and clear it with the success. So say after 10 seconds if I don't hear anything I assume the file was bad.
jQuery.ajax({
crossDomain: true,
dataType: "script",
url: url,
success: function(){
_success(_slot)
},
error: function(){
_fail(_slot);
}
})
I'm working on an older .NET code base that has all the designer code stuffed into the same code file as my code (pre - partial classes).
Is there a mechanism to tell Visual Studio 2008 to go back and refactor designer code into a X.designer.cs partial class file?
What I just did was completely manually:
a) Remove the components object you might have in your original Winform. If the application was .NET 1.1 you will have something like this:
/// <summary>
/// Required designer variable.
/// </summary>
private Container components = null;
b) add a new components object in the Designer class:
/// <summary>
/// Required designer variable.
/// </summary>
private System.ComponentModel.IContainer components = null;
c) Unless you had a specific dispose method, this is the standard. If you don't have any form Inheritance, I think that base.Dispose can be safety removed:
/// <summary>
/// Clean up any resources being used.
/// </summary>
/// <param name="disposing">true if managed resources should be disposed; otherwise, false.</param>
protected override void Dispose( bool disposing )
{
if ( disposing && ( components != null ) )
{
components.Dispose();
}
base.Dispose( disposing );
}
d) Copy all the code inside the #region Windows Form Designer generated code to the new Designer.cs class.
e) You should also copy all the member variables for all your objects (labels, texboxes, etc. that you use in the designer).
That should be all about it. Save and compile.
Is it worth? Well, in my case, I had a bunch of huge winforms with tons of code and controls. VS2008 crawled every time I switched from/to designer. This made the code view more responsive. I remember having to wait for 3-5 seconds before having a responsive code. Now it takes 1?
Doing steps 1 to 5 and moving an existing or adding a new control won't automatically move anything to the designer.cs class. New stuff goes to the new Designer class, but old stuff remains where it was, unfortunately.
You also have to close and reopen the file (after you have added/created the partial class) for VS to draw correctly in the Designer; failure to do may result in empty forms being drawn.
If anyone is still looking for an automated method of doing this there's a VS macro here that will do most of it for you.
A very nice tool.
Is the solution file of the older .NET code 2003/2005? I've tried to do what you're talking about by using the conversion wizard in VS2008. During conversion it should try to parse your .aspx pages and build designer files for them. What the designer generator has a problem with is that these older .aspx pages are so malformed that they simply can't be parsed.
I've come to the realization that perhaps trying to convert old ASP.NET code up to 2.0 or 3.5 is, in itself, going to be a large project. I have not yet found an effective way to factor out the designer code from old existing code, so I'd also be happy to learn of a solution here.
AFAIK there isn't anything built in to do this automatically. I could definitely use an automated way to do this.
If it's WinForms - I have a PowerShell script that edits the project and adds .designer.cs for all forms/controls.
You'd still have to move the designer code by hand though (or improve the script) - I only had a few forms and it wasn't worth the effort to add that too.
I can look it up and post it if that would help.
There's no such thing, but actually it's not that bad. Just make sure it's in a region and keep it closed.
I'd be interested to see what happens if you open one of these forms in the designer and save it; or modify it and save it; or do one of the above after creating a .designer.cs file with only an empty shell of the partial class. It wouldn't surprise me to find the designer placing at least the changes into the .designer.cs file.
I'm using a library from CGAL which during the linking stage of my code compilation produces a lot of linking warnings of this form:
warning LNK4099: PDB 'vc80.pdb' was not found with 'gmp-vc80-mt-sgd.lib' or at 'vc80.pdb'; linking object as if no debug info
How do I turn off this specific linker warning under Visual C++/Studio 2008?
Note that I do not have any control on the external (CGAL) library which I am using. I cannot/donot want to get into recompiling the external library. Hence, the need to fix the messages at my end.
Add the following as a additional linker option:
/ignore:4099
This is in Properties->Linker->Command Line
According to Geoff Chappell the 4099 warning is too important to ignore, and cannot even be ignored by using /wx (which works for other warnings)
(/wx makes warnings into errors)
The PDB file is typically used to store debug information. This warning is caused probably because the file vc80.pdb is not found when linking the target object file. Read the MSDN entry on LNK4099 here.
Alternatively, you can turn off debug information generation from the Project Properties > Linker > Debugging > Generate Debug Info field.
I suspect /ignore is a VC6 link.exe option. for VS2005 and VS2008's linker there's no documented /ignore option available, but the linker looks just ignore the "/ignore:XXX" option, no error and no effect.
EDIT: don't use vc80 / Visual Studio 2005, but Visual Studio 2008 / vc90 versions of the CGAL library (maybe from here).
You could also compile with /Z7, so the pdb doesn't need to be used, or remove the /DEBUG linker option if you do not have .pdb files for the objects you are linking.
Somewhat inspired by this question about a graphical programming environment. I don't think that C++ or C# are really conducive to this type of environment, but perhaps there's something halfway there.
Lot's of IDEs that I've used will use syntax highlighting to change the foreground (or even the background) colour of text for keywords, strings, comments, etc...
Are there IDEs out there that will highlight larger syntactic structures? Here's an example of what I'm thinking of.
(Please don't comment on my poor choice of colours... I'm not a graphic designer for a reason.)
While it's not a graphical drag-and-drop environment, the highlighting would still give an overall view of the structure of the code. Personally, learning C# after years of C++, I still catch myself tripping over the fact that at the end of a file you usually have the end of a class and the end of a namespace, so the end of a function is two-levels in. (In a C++ code file, the end of a function is usually at the top level of indentation). I help myself out there by throwing in little comments at the close brackets:
} // end class
} // end namespace
But it seems to me that some automatic colouring would make that completely unnecessary. Anyway, has this been done already? Bonus if it's an add-on to Visual Studio.
I'm the author of Codekana. Indeed, what you describe above was the main goal for the product. BTW, I'm about to publish an article about the "making of" and the underlying technology, which is pretty nifty. It will probably be available next week (March 26, '09 or so). Recommended reading, if I may say so myself.
The reason Codekana only provides outlines, instead of a colored background, are limitations in VS's text rendering extensibility. I will hopefully be able to implement a solid-background version at some point in the future, although it will definitely require serious hacking and "rocket surgery".
I would have commented above, instead of providing another answer, but my reputation doesn't allow commenting. :(
[UPDATE: Thanks for the upvotes, now I can comment!]
The closest thing that I've seen is Codekana, although doesn't have "background syntax-highlighting" it colorizes the different flow-control structures:
Coderush does structural highlighting:
It quite feasible you could write your own plugin with DevExpress that achieves your exact original screen shot.
The current BlueJ editor does exactly what you describe:
The Visual Studio IDE does this already, but with a different visualization - you can expand and contract nested blocks by clicking the +/- buttons on the left margin.
A nice idea. Personally, I really don't like folding editors, but this would be quite tolerable - you'd want to be able to toggle it on/off easily though. Perhaps someone has already done this for the hyper-programmable editors like vim and emacs?
I think Xcode 3 does roughly what you want, especially with Focus Follows Selection enabled. Individual blocks are highlighted as you hover over them in the sidebar.
Existing SO question with some emacs implementations for lisp:
http://stackoverflow.com/questions/318785/emacs-mode-that-highlight-lisp-forms
You should try this Addin and you will never work in visual studio without it, http://www.jetbrains.com/resharper/features/index.html
PS: I'm not affiliated with this company or product but I'm an addict using it and I can never work without it, it saves me alot of time in my coding tasks and code exploration and debugging.
I'm working on a Visual Studio extension inspired by this question. You can see what I have so far here:
There's also a free extension that at least draws the guide lines colored according to what they belong to. For instance, if guides in green and so on:
It's called StructureAdornment and you can get it in the Extension Manager or from the Visual Studio Gallery.
I find it quite handy.
In some sufficiently large applications, you can spend more time figuring out how to drill down to the various layers than you do actually debugging: That's the case with a piece of software I work on now. Layout/separation of concerns issues aside, it'd be nice to have a breakpoint plug-in that would allow you to load breakpoints depending on which Bugzilla/Jira/Fogbugz/SVN defect entry you're working off of.
Do any plug-ins exist for Visual Studio that allow you to 'save' toggled breakpoints to a file, allowing you to load various breakpoints depending on what bug you're working on?
As an adjunct to that question; if there aren't any such plug-ins, can anyone point me to a 'good' (quite a subjective term, but in this case I mean explanatory and useful) resource on creating plug-ins for Visual Studio?
Check out the Breakpoint Analyzer for Visual Studio.
I found this based on a recent Google search:
It seems that Visual Studio 2010 (Professional) has added an "export breakpoints to file" function. (You can find it in the Breakpoints window.)
Break point analyzer is a really useful tool for debugging huge projects.
I've recently given it a try (SQL 2008 version) and I find them quite okay. Well, the only problem is that the wizard is not intelligent enough to update database structure without first erasing all data. Is this why these projects are not used in practice?
Actually never seen anyone using them or ever mentioning them at all. Also nothing to be seen in blogs and forums unless you explicitly look for it.
What's wrong with them?
I use the database project that is part of Visual Studio Database Edition. This is a great tool. Basically you define the entire schema, in create scripts which are then checked into source control. It then has tools built in to generate difference scripts, which by the way do not delete the data.
It also has data compare tools so you can compare data between database and generates the script to make the databases the same.
The recent GDR release has some interesting features added to it. Such that it sounds like if you use their built in deployment method you can generate a deployment package which when you run it will analyze the target database and apply only the differences.
If you have Team Studio - Team Suite or Development edition then you can use the Database Edition.
Give it a try and is a great evolution in database development
Like Glennular, we are using them to version control our schema and s'procs.
Although we have a fairly advanced version control structure (CI, auto deployments to dev, single click deployments to stage and prod); we don't include any of the DB projects in that structure. We just don't trust it yet.
UPDATE: (for Out In Space)
We have separate TFS projects for functional areas of the company (Sales, Marketing, etc). Within each TFS project we have a Main and Production folder. We also have one TFS project which contains the Database projects and another one that contains Common assemblies / visual studio projects.
Upon release, we branch from Main to Production. We don't have a staging branch as we move too fast to deal with that. Right or wrong, our productivity is measured in part by the number of production level releases we do per week; bug fixes, new features, etc.
CI is set up on the Main branch such that every check in causes the Build server to deploy to our DEV environments. Unit and Web tests are then run and the build quality is automatically set to "Development" if it completes successfully. When someone changes the Build Quality to "In Staging" This causes any previous "In Staging" builds to be set to "Rejected" and causes that build to be pushed to our staging servers while updating the config files to point to the correct servers. (I used TFS Deployer and PowerShell scripts for this).
QA does testing out of our staging servers. Once they are happy, the production team changes the Build Quality to "Production". This causes the build to be sent to a Production area which then is manually copied to the correct location. Once completed, production notifies development who then branches that version into the Production folder. QA is also notified who then does a battery of Production tests to verify everything is indeed working as expected.
We have reports set up to show us what changes exist between production releases so that we know every check in that is being deployed. That prevents unknowns from popping up such as a database change etc. or some other potentially breaking code.
Further, our BA's are tracking work items via Team System Web Access and know when those items are in production.
Although our DBA's are using Database Edition (GDR), they haven't been impressed with the level of control for auto deployments. I'm hoping that Rosario brings some better deployment control to the product line; but until then we have TFS Deployer and powershell.
We use them. We keep all of our schema creates/update scripts and Stored Procedures. The main purpose is that we can connect the project to a SourceSafe or SVN.
Its an easy way to keep your SQL scripts version controlled.
It is a little quirky trying to do some SQL testing in VS, but you find ways around it.
Update
We actually have it built into our deployment scripts, our deploy tool, goes through the DB project (except for flagged folders) and runs all the script. We just built a quick tool for run the project. If anyone has other solutions to deploy out the DB project that would be helpful.
We use the database project to provide version control for our SQL scripts. We also like using the Visual Studio environment to edit the SQL; it's a little bit easier to use for some of our newer developers than query analyzer.
I've used them on a few paid projects and I think its a great tool. Thats said, I've seen some issues.
If the .dat file in your db project folder gets out of sync with the temporary instance of the database, schema compare will give inaccurate results. Not sure how this happens, review schema compares carefully and blow away your .dat file (after closing solution) if things seem wrong.
If you have 20+ databases and they reference each other and use circular references... Its going to hurt. I haven't figured out how to make it scale to that scenario. GDR 2 seems to offer some promise.
I've got a test which requires an XML file to be read in and then parsed. How can I have this file copied into the test run folder each time?
The XML file is set to "Copy if newer" and a compile mode of "none" (since it's not really a compile-able thing)
use a DeploymentItem attribute
using System;
using System.IO;
using Microsoft.VisualStudio.TestTools.UnitTesting;
using CarMaker;
namespace DeploymentTest
{
[TestClass]
public class UnitTest1
{
[TestMethod()]
[DeploymentItem("testFile1.xml")]
public void ConstructorTest()
{
string file = "testFile1.xml";
Assert.IsTrue(File.Exists(file), "deployment failed: " + file +
" did not get deployed");
}
}
}
The Preet answer is used to deploy items for a single test. If you want to do it at solution level, use the .testrunconfig settings.
It seems that if you provide a TestSettings file for the Solution then you can uncheck the "Enable deployment" option and stop mstest from trying to run from the ...TestResults\...\out folder where it doesn't copy your extra files (unless you make them a deployment option).
This is also useful if you depend on the extra files being in a preserved folder structure because Deployment items all seem to be copied directly (flat) into the temporary run folder (out) if you use the Deployment, Add Folder option in the TestSettings (answers above suggest you can keep the structure if you add each item as its own DeploymentItem).
For me it worked fine running tests directly in Visual Studio (i.e. my extra files in their structure were found and used by tests) because I had created a TestSettings file for another reason long ago (which has Enable deployment unchecked), but not when TeamCity ran mstest to run tests because I hadn't specified that the TestSettings file should be used.
To create a TestSettings file in Visual Studio, right click on the Solution and choose New Item, and select the TestSettings template. To use the TestSettings file at the command prompt of mstest.exe add the option, /testsettings:C:\Src\mySolution\myProject\local.testsettings (or add as an extra command line option in TeamCity with appropriate path)
I work as a c# developer in a purely Microsoft shop.
I recently started teaching myself assembly using gas and Linux in my free time away from work. I like messing about with Linux, I'm still very new to it though.
I keep hearing I should learn VIM or Emacs but the thing is, there is absolutely no way I'll need to use them in work, so I feel a bit guilty pouring time into mastering one of them. Worse than that I'm wondering if learning VIM or Emacs could make me slower with visual studio as I'd confusing short cut keys.
Currently I'm doing my editing in Linux using SciTE (I think this became notepad++ on windows).
For someone who works in a purely ms product environment is there any real reason for me to learn Emacs/VIM? I see that there is a setting in vs studio to use Emacs shortcuts, has anyone here got more productive by mastering them in vs, or in other words can you see it being worth while?
Thanks in advance!
Related: Is learning VIM worth the effort?
Related: Is it worth investing time in learning to use Emacs?
Related: Why should I use an IDE? (view from the otherside)
Begin the flame war :)
I'm a VIM addict and not ashamed to admit it. I find that using VIM makes me significantly more productive in my daily life. Coding is a lot faster when you don't have to take your hands off of the keyboard.
By default VS has poor support for VIM bindings. However, there is a cheap add-in available (ViEmu) that provides excellent VIM keybindings for Visual Studio. I have a personal license and I believe it was worth every penny.
That being said there is a steep learning curve associated with VIM. It will in all likelyhood kill your productivity for a week or two. After that though, the benefits will start coming and you should notice a boost in your productive powers.
I work in a 90% Microsoft shop, but I still use gvim every day. I have a vi plugins for every IDE I work with. I'd recommend vim if you are going to learn one or the other, but I know emacs users will strongly disagree.
emacs and vi have been around for a long time, and are both very powerful. Learning one of these might open your eyes to a more efficient world of coding.
I also work for a Microsoft only shop, but, at home, I only use Linux. Suffice it to say that I use Vim exclusively for editing at home. At work, I use Visual Studio for all development, but I use Vim for many tasks that require complex text manipulation. Even if I didn't use Vim at home, it would still be incredibly useful to me for what I do at work. Our IT guy thinks I'm some sort of magician when he sees me doing my Vim acrobatics. That's got to be worth something, right? ;)
I used to use VIM almost exclusively, and after moving to a nearly 100% MS shop, have found no problems switching back and forth.
VIM and EMACS are great if you're willing to learn the keyboard shortcuts. I find that I don't really have issues when I go back and forward - I think it helps that they are such a completely different environment than VS that it's easy to make the mental switch.
You can always start slow - use them, and see how it goes. You'll have some learning curve, but it's very much up to you.
If Scite is working for you, and you're just "playing around" as a hobby, it may not be worth the effort. For me, the effort of learning new and different ways of working/thinking is part of the fun, though.
I use emacs and Visual Studio together and would have a difficult time without emacs. VS is indispensable of course, but it doesn't deliver the text editing that emacs does. Emacs is 98.4% editing pane for me. Visual Studio has 12 different panels, each of them important, but sometimes I just want to look at the code. Emacs lets me do that. And I can split screens and see 4 editing windows on a single screen, even in the same file. With dual-monitors I can have emacs windows on each one. This sounds kooky but it is very helpful to me when I am working on different parts of the code at the same time (let's say an interface definition and an implementation, at the same time). The regex search-and-replace.
I have auto-revert mode turned on in emacs, which is the analog to the VS feature that says "a file changed outside of Visual Studio, do you want to reload it?" Except in emacs it always silently reloads, which is the way I want it. So I bounce from VS to emacs and back, and there's never a problem with pending changes in the source code that haven't shown up in the other editor. VS has "full screen" capability, but I haven't found that to be as flexible or useful as emacs.
I cannot imagine not having the capability of this combination of tools. Visual Studio alone just does not offer this. Emacs alone wouldn't be sufficient. I still use emacs for basic snippets and small test programs. I use VS for managing projects, TFS, testing and debugging.
My use of emacs is not a choice at this point. I picked it up a long time ago, at a previous company, where emacs was the standard tool, so it was ... not to say "easy" but it was automatic. I cannot imagine learning emacs "on my own." I learned things osmotically, just from the community of other emacs users around me. From the people in the hallway, I acquired and customized a bunch of elisp code for my setup. Doing it with a book... I cannot imagine.
As for making you less productive because of finger confusion... I haven't had a problem.
Mastering a good editor is always worth, as a developer you spend a lot of time typing plain text, writing programs, XML, HTML, you can save much of that time by using a good editor and using it effectively.
I started to learn Vi like nine years ago, and now I can't live without it.
Whatever which editor you select, I think almost you'll be able to find plugins to have the input model of your editor of choice, in all major IDE's, for Visual Studio you can use ViEmu or the Emacs Keybindings
I've been a professional C/C++ programmer for 16 years. 5 years ago I picked up some Common Lisp, and ended up learning elisp/emacs too. I also dabble in Haskell. I've found these experiences massively helpful in programming C++. If nothing else you get to see the future, as the C++ slowly becomes more expressive by adopting things that CL has had for decades.
Learning emacs is a long slow process that starts to pay off once you're fully fluent in its features, way of doing things and elisp. I use Visual Studio for a lot of my development, but often I switch to emacs to take advantage of the quick to use key macros, or to do some complex processing on a table of values. Lot's of stuff that you can knock up really quickly in elisp that would take a few hours of hair tearing with Visual Studios plugins.
I was hardcore user of VIM and also developed intellisense for C# (http://insenvim.sourceforge.net/).. but with latest language changes i cannot avoid using Visual Studio. But many time look back using VIM is for simplicity reasons. Visual Studio takes lot of memory and start-up time is very huge. Even to read a file or do simple things it require quite a few minutes. But with it is so easy to open a file and navigate. I might port VIM intellisense to C# 3.0.
Learning one will be completley worth it. I personally would recommend emacs but I am biased. Im 99% sure that emacs can be setup to the .net devlopment backend (cant think of the right words sorry).
JaredPar mentioned ViEmu, which I've heard really good things about. But if you're really wondering what the benefits of switching would be, there's a good article hosted on the ViEmu site: Why, oh WHY, do those #?@! nutheads use vi?
Personally I feel that using gvim has been a huge boost to my productivity, and I definitely prefer it to the Visual Studio editor or SlickEdit or any of the others I've used. But as mentioned in earlier answers, Vim can be a steep learning curve. There are people who have used it professionally for 5-10 years and are still learning things about it. Vim can be a lot like perl... there are a lot of ways to make any series of edits, and it can take a while to learn the best one.
IMHO, no. i am using acme over vim. gedit or vs2008 at work.
I use (and love) Emacs, but I can understand the vi folks out there (I'm always torn between minimalism and kitchen-sink-ism). What keeps me using Emacs day in and day out, and what makes me eventually leave every IDE I've ever used, is that I can write functions. And when I say functions I mean functions; I can really program the editor itself. I add a new function, eval it, and bam now it's in my editor. If I use that function a bunch, then it gets a keybinding.
I've noticed that with IDEs, they're great at a particular language (Eclipse is amazing for doing Java). I don't think Emacs is as good at any one language (Except maybe as a Lisp IDE, but I won't try and extol the virtues of that here...) as a dedicated IDE but it is better at language N, where "N" is practically any programming language that has or will be invented. It is nice, if I'm learning a new programming language (or even just hopping between any of C, PowerShell, Haskell, Lisp, Java... etc.) that my environment is comfortable and quite able. My answer then, is "yes" because Emacs (or vi, I would assume) gives you portability in your toolset. You may be doing C# today, but down the line, who knows maybe you'll be hacking on Monad#++, and if you are, you can bet there's going to be an Emacs mode for it.
take a look at JP Boodhoo and what he's doing www.jpboodhoo.com. He and Kyle Bailey have been blogging recently about using VIM as part of their development experience with VS2008.
You should learn at least how to save (:w) and edit files (magic) in VIM--even minimal OS installs have it included. That way if you are stranded on an empty unix box, you can at least edit files.
Otherwise, naw--I dont buy the hype. You've got bigger fish to fry and nano is getting better all the time. Heck, nano has some syntax coloring and auto-indentation and it even works with the mouse over PuTTY.
The best thing to learn is how to configure Samba on your unix box and then use a real text editor on your Windows box like UltraEdit (cue flamewar). I use this configuration for editing anything larger than a config file in /etc.
I am also a long time C# developer. When developing C++ in Linux, I use Eclipse CDT because it's the closest thing I have found to Visual Studio.
Being quite experienced with vim, I use it for editing Linux config files and such, but I'm not particularly drawn to it for development when I could just use an IDE.
By the way, if you do use vim, you may want to enable line numbers and syntax highlighting; I always add these lines to my ~/.vimrc file:
number on
set syntax
If you're using Vim with VS, or thinking about it, you should be aware of the Vim Intellisense project: http://insenvim.sourceforge.net/
Speed of coding is very much dependent on editor choice, so its one of the most important deceisions you will take.
I'm using StyleCop. But there a couple of rules I want to ignore, for instance using this. in front of class members.
How do I turn off a StyleCop rule. I've looked but can't find how to do it.
In you StyleCop install, there's a Settings.StyleCop file. You can edit this to turn off rules globally. Drag that file onto the Settings Editor executable in that file to edit it.
You can also put copies of the settings file into your projects to override the global settings.
If you're using Visual Studio integration and not just MSBuild integration, you should be able to get to the settings editor on a per-project basis by right clicking on your project and choosing "StyleCop Settings" or something like that.
For my production sites I usually change the "debug" flag in the Web.Config to "false". But I always publish my sites with the Configuration Manager set to "Debug". Should I change this setting too?
Yes, you should - though if it makes a difference is dependent on how your website is coded. Only precompiled sites (Web Application Projects) or Class Libraries in the same solution will care. ASP.NET sites (Website Projects) will be compiled on the server, and will check web.config for it's debug setting.
Yes, as suggested in MSDN :
Enabling debug mode will greatly affect the performance of your ASP.NET application. Remember to disable debug mode before you deploy a release application or conduct performance measurements.
Yes, absolutely. Setting it to release will compile code without debugging symbols and with the right conditional compilation (i.e. #if DEBUG).
Yes Release will compile a smaller DLL
As a best practice I use a virtual machine for my development - I would like to try and optimize my VM as much as possible. All I have installed is server 2003, IIS and Visual Studio 2008. What do you do to optimize your development VM i.e what service do you switch off etc...
As always, there is no single set of recommendations that are universally "correct" or "best". However, these are some of the items that have worked well for my development virtual environments.
Determine how much memory each one of your virtual machines require and how much memory your host requires (if you are running things in the host at the same time). Add up the total of memory requirements for all VMs that will be running simultaneously and determine the maximum VM RAM load and add in the host load. I suggest having at least 512MB of "padding"
For example, I need about 768MB for the host OS (WinXP Pro SP3) and about 1GB in my guest OS (WinXP Pro SP3 w/ Visual Studio 2005/2008 and SQL Server Developers Edition). 1024MB + 768MB + 512MB = 2.3GB
Personally, since RAM is incredibly cheap currently, I just maxed out my 32-bit system with 4GB (3.5 addressable).
Have a disk separate from your OS disk to run your virtual machine images. This greatly reduces the disk I/O contention between the Host and the Guests.
NOTE: Using an external HDD to get the spindle separate can help, but beware - Firewire and USB have higher latency than IDE, SATA, or SCSI! While the USB 2.0 and Firewire interfaces have more than sufficient bandwidth for maximum disk throughput they do add a significant amount of latency to each operation. This becomes very significant in high disk transaction, small file accesses situations like C++ compilation. I haven't had a chance to run some tests on eSATA yet to see how well it performs in comparision to internal SATA access times.
During development there is quite a bit of random disk access occuring, especially during compilation in languages like C++. Using a 7200 RPM over a 5400RPM drive for your VMs reduces access times and thus, reduces compile times. Going to a 10,000RPM or high-end SSD reduces these times further. The point of diminishing returns depends on the particular disk access load/patterns of your environment.
Tell your virus scanner to ignore your Virtual Machine directory OR the .vmdk file extension so that it won't be constantly scanning your virtual machine disks.
If you are running more than one virtual machine at a time OR you are doing work both in the host and the guest OS, then save at least 1 CPU for the host OS on a multi-core/proc machine. For example, if you are running two virtual machines and doing no work in the host OS then a dual core processor on the host with single core virtual machines will probably serve you best.
If you are running a single virtual machine and no work on the host OS, then running a dual processor VM may be helpful if the virtual machine applications can make use of the second processor.
If you are running two virtual machines, 1 which is single proc and 1 which is dual proc, you probably need to be running a quad-core system.
VMware Note (not confirmed for other virtualization applications): If you give a virtual machine multiple processors, it will wait for both processors to become available and will reserve them even if it isn't using them. This can cause significant contention between virtual machines or between the virtual machine and the host.
Make sure you allocate enough RAM to cover the virtual machine's demand
Don't use snapshots unless you really need to. There is a significant disk I/O penalty associated with maintaining a snapshot based virtual machine file system.
Such as:
Consider not running anti-virus, anti-spyware, or firewall software within your VM. You'll have to weigh the pros/cons of security vs speed here. For many, if they get a virus it's not a problem, they just restore a previous copy or snapshot. For others, the potential exposure of sensitive information requires strict security policies even within the VM.
I will say that not running anti-virus or firewall software within the VM is probably the number one reason that VMs of Windows often feel "snappier" than their physical host OS counterparts.
Unfortunately, there are three places file fragmentation can occur in a VM configuration: Within the Guest OS's filesystem, within the virtual machine file's (e.g. vmdk) representation of the VM, and the virtual machine file on the physical disk itself. The order in which you defragment each matters.
I switch off the file system indexer, saving disk space and CPU time.
I always disable "System Restore" on my Windows XP virtual PCs.
Ixclude my build folder from my virus guard for on access scans
These are the services that I turn off in my VM
Putting the disk images on external HDD (even usb) can improve performance (with a laptop specifically)
There is a great article about Virtual Machine performance here
It's written specifically about Sharepoint virtual machines, but there are plenty of tips that apply in general.
I disable the Windows page file when using VMware Server. Disk IO is the weakest link with VMWare Server, and nothing is worse than paging virtualized RAM to a virtualized disk file. Give your VM enough RAM and this works pretty well.
Also, not all virtualization solutions perform the same in different areas. VMware is great for stability and mobility of VM images, but you might want to try some other solutions if you have the time. I've found that better disk IO performance gives me a better overall experience, so I traded the better CPU performance (and overall stability, unfortunately) of VMware server for the better IO performance of VirtualBox. The non-free VMware versions may be much better, but I have no idea.
I've found that putting the disk images on a separate drive doesn't buy you that much. Plenty of people will argue this, and it can give you a little bit more performance depending on how much else is going on with the host, but for me it was marginal. I tried using a raw disk also, which didn't do as much as I'd hoped.
One thing that does really kill IO performance is running with a snapshot active. This uses a copy-on-write strategy on most implementations, and you can expect 20% drop in disk performance.
I recently built a VM and I started to optimize it before I even did the install by using Nlite and Windows Update Downloader. NLite allows you to strip out all the components you don't need (mspaint,pinball,french, etc.), apply all your windows updates, and tweak out registry and service settings. So you can have the System Indexer disabled on first boot for example. If your using Vista or 2008 Vlite is available as well.
Two SSDs, one for the host's OS and one for the VMs.
How can I make Visual Studio default to View Source when you double-click the Form1.cs. I prefer to make View Source the default of double-click than View Designer.
Right click the file in the Solution Explorer, choose "Open With...", select the CSharp Editor, and click the "Set as Default" button.
Right click a form file and click "Open With...". Pick your desired designer to open as default (in this case "CSharp Editor" or "Microsoft Visual Basic Editor") and click "Set as Default". Voila.
I work in Delphi 2007 (both win32 and .Net) but the CodeGear IDE frequently annoys me, so if possible I'd like to find a replacemnt.
We have a build script so I can compile from the command line and I very rarely do any GUI designing, so the only thing I need is a text editor (with syntax highlighting, Autocomplete/Intellisense ...).
I would like to use Visual Studio or Emacs but don't know how feasible it is to work on Delphi code in those environments. Particularly debugging - can the Delphi IDE still act as my debugger even if I don't use it for editing?
Does anyone have any experience of breaking away from RAD studio?
P.S. I am aware of the new Delphi Prism but that won't solve my problems - I still need to work in vanilla Delphi and use the Delphi 2007 compiler.
One thing you can do is to put in GExperts to make your life better.
You can of course edit source files outside of the Delphi IDE. When you switch back to the IDE it will notice that files have been changed outside of it, and ask you whether to reload them (if they are currently opened in the editor). This is a safe thing to do if you never edit inside the IDE, but to keep the confirmations from appearing it is best to not have source files open in the Delphi editor at all while you edit them in emacs.
Even if you use a custom build script and build the project from emacs you should still keep the project file up-to-date. When you use the debugger in the IDE it will usually first compile the project. To have this always work (even with visual form or frame inheritance) a correct project file is crucial. It is also important for debugging when you have several source files with the same name in different directories that are in your search / browse path, or if you have not all your source directories in the search / browse path.
Whatever tools you use for editing or otherwise changing your source files, make sure that you always have DOS style CR+LF line endings (\r\n, #13#10) in all lines, as LF only (\n, #10) tends to confuse the IDE - you will notice that the blue dots in the debugger are out of sync with the source lines, and that compiler error line numbers are wrong. Using sed or awk on source files can be a big time saver, but be sure to use the tools compiled for Win32, and not those provided with (for example) the cygwin environment.
Emacs does appear to have a Delphi editing mode, which is probably a good starting point if you're trying to get up and running.
If you have Delphi 2009 and it is not annoying to you, try Andy's IDE Compiler Plugin 1.0
It can be used to compile a Delphi 2007 project with the Delphi 2009.
I use CodeFactor, but unfortunately it's no longer available.
Delphi 2009 is a pretty big improvement, even over Delphi 2007, so if you've got the means, that might help a lot.
If your main problem is the low speed of Delphi 2007 IDE, then use DelphiSpeedUp.
You should try TSEPro (aka QEdit) from Semware. It has support for the language, a very powerful macro system and supports compiling from inside the editor via bcc32.
I do know that the FreePascal editor called Lazarus can be a nice replacement.
Although it's not compatible with the VCL, so it would only be feasibly for a new project.
See free OPEditII, at http://www.codefactor2.com It sounds like the free and updated version of the late codefactor. Worth saying it works like a charm under Windows Seven 64 bits, and is very fast, with integrated Delphi code parser. So you have a class browser, code completion, code navigation from interface to implementation, and a lot of code refactoring tools.
Have a look at Multi Edit ? It is a fantastic editor and has support for the Borland products
One option is EditPad Pro. I haven't tried the product, but I know the vendor is reliable.
ConText or EditPad Pro both offer syntax highlighting for Delphi code, as do many other programmers editors (they sometimes call it Pascal though). I've used both of those though, and they work really well. I use them when I want to open code fragments or samples.
They both have a nice feature of being able to associate specific commands with certain file types. So you could associate the Delphi command-line compiler or your build script with your source files to allow you to build, run unit tests, etc. from there. I've done similar with other command line compilers, but frankly I really like the Delphi IDE so have had no need to try to replace it.
Is there a way to display the lines in the stack trace for the .NET assembly build/deployed in Release mode?
UPDATE:
My application is divided into three class library projects and one ASP.NET "website" project. The error I am trying to track down is in one of the three class library projects. I only deployed the pdb file for the class library project that is generating the "Object reference not set to an instance of an object" error.
The line numbers are still not showing up in the stack trace. Do I need to deploy the pdb files for all projects to get the line numbers in the stack trace?
Working solution
Deploying the pdb file for each application fixed the line number issue.
Include debug symbols with your build/deployment package.
My solution
Copy pdb file in same folder that executable file.
now i can view the line number when run the exe file.
this is reason
http://msdn.microsoft.com/en-us/library/bb694540%28VS.85%29.aspx
I've run into problems in the past where I feel the need to deploy PDB files with a release build in order to track down an error. The reason is, like you said, was that the exception occurred in a method that was very large and I could not accurately pinpoint where it was happening.
This might be an indication that the method needs to be refactored into smaller, more granular methods. Not a one size fits all answer, but this approach has served me well in the short term (I've often found the bug during the refactoring) and in the long run.
Just a thought.
In VS 2008 Express, I found it under Project Properties --> Compile --> Advanced Compile Options.
For some reason this error started popping up today on one of my projects.
Error 1 Unable to write to output file 'C:\MyProject\Release\MyProject.pdb': Unspecified error
If I go into advanced compile options and change it to not generate and debug info, my project compiles fine.
I have tried setting the permissions on the Release folder to full for everyone, so I would assume it's not a permissions issue. Also, I don't see anything in my log files that would provide me with more information about the issue.
Does anyone know why this error would just start showing up or a way to fix it?
Thanks.
Update: I have rebooted my machine, restarted VS several times and have even completely deleted the existing OBJ file where the issue is happening. It's still giving me the same error.
This is a simple one project solution that was working fine just last week. It appears to be an issue with VS trying to build the PDB file because I can delete them out of the Release and Debug folders without issue. When I try rebuilding them VS will start creating the file (about 1.4MB is size) but I still get the error.
After banging my head on the wall for a while on this one and digging through source control to try to get back to a working copy, it turned out that the PDB file wasn't the issue at all. Someone had deleted a source file which was causing VS to choke when I tried to find that file to create the debug information.
So if anyone comes across this error and can't figure it out, make sure that you aren't missing a source file somewhere.
It would have been very helpful if VS would have told me that file is missing rather than just telling me it had an unspecified error creating the PDB file.
Thanks.
Is the program running/being debugged in another process? That's usually the first culprit.
Perhaps something else has the file open, like an editor or another copy of Visual Studio?
Try shutting down and restarting VS, or even rebooting your machine to see if that resolves the problem.
In the worst case try to restart Visual Studio. Another good tool for you to try is Process Explorer from SysInternals that allows you to see who is keeping handle on your PDB file. This way you know exactly what to kill/restart to get access to the file.
If you work on solution with more than one projects inside, there is possibility of wrong compile order.
The reason is almost certainly that another process is hanging onto a handle to that file which prevents it from being overwritten. VS is unfortunately often the culprit. If this is the case, restarting VS will fix the problem.
Visual Studio sometimes gets a bit "confused" about files being locked, especially if during a previous debugging run the application being debugged crashed unexpectedly, Visual Studio crashed unexpectedly, or even sometimes if you simply stop debugging.
Generally, the solution is to close and reopen Visual Studio.
Yes - definitely check for files that didn't get pulled down from VSS, if that's where you got your project from. Just look for the files with exclamation marks. Once all files in the project are where they should be locally, PDB gets generated w/o problems.
Check for missing files which will be shown in visual studio with exclamatory icon and those files may not exist in project source folder. if you don't want those files delete them in visual studio else add those files in source folder. clean or refresh..
I'm aware of the "Enable just my code" debug option, but that only works for managed code.
I'm looking for a way to step into a function call without having to step through, for example, an STL string cast operator because there is an implicit conversion from a char* to a string in one of the function's parameters.
I found this blog entry which has a solution. Although I'd prefer to be able to say "don't step into anything that isn't part of this project", this looks workable.
EDIT: After looking at a few blogs and newsgroups, the method is to add an entry for each function that you don't want to step into under this registry key (assuming VS 2005):
This key contains a set of rules which affect how stepping is performed. Each rule is specified as a separate entry whose name is a decimal number and whose value is a function name pattern that specifies which functions we want to affect. e.g.
prevents stepping into boost::scoped_ptr functions.
The rules are evaluated from high to low values until a matching pattern is found, or there are no rules left. In that case the function is stepped into.
Function names are regular expressions.
Colons need to be quoted with a backslash.
You can specify StepInto as well as NoStepInto. This gives you a way to avoid stepping into all but a few functions in the same scope/namespace.
My copy-past:
Avoiding Stepping Into Things
It's often useful to avoid stepping into some common code like constructors or overloaded operators. autoexp.dat provides this capability. Add a section called "[ExecutionControl]". Add keys where the key is the function name and the value is "NoStepInto". You can specify an asterisk (*) as a wildcard as the first set of colons for a namespace or class.
autoexp.dat is only read on Visual Studio's start up.
To ignore the function myfunctionname, and all calls to the class CFoo:
[ExecutionControl]
myfunctionname=NoStepInto
CFoo::*=NoStepInto
To ignore construction and assignment of MFC CStrings: (Notice the extra = in CString::operator=.)
[ExecutionControl]
CString::CString=NoStepInto
CString::operator==NoStepInto
To ignore all ATL calls:
[ExecutionControl]
ATL::*=NoStepInto
from this (http://www.highprogrammer.com/alan/windev/visualstudio.html) article.
Also you can use "Step Into Specific Function" from pupup menu.
Edit Sorry, it looks like that autoexp.dat doesn't works in vs 2003/2005. The same you can do with registry settings. http://groups.google.com/group/microsoft.public.vsnet.debugging/browse_thread/thread/b03dee5a626470c0/26addb1b539883e8
There is also the "step into specific" entry on the context menu, that will list the functions that could be stepped into on the current line, and you can pick the one you want.
VS6 used to let you define values in the autoexp file that let you skip stepping into common functions (e.g. string constructors). Starting with VS7 these exclusions were moved to the registry. Ease of use takes a serious hit.
In VS7 and higher Microsoft, in their wisdom, moved these exclusions to the registry. Here are some examples:
Windows Registry Editor Version 5.00
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\VisualStudio\9.0\NativeDE\StepOver]
"10"="CString\\:\\:CString=NoStepInto"
"11"=".*\\.c_str.*=NoStepInto"
Key names represent the search order. Key values contain VS regular expressions to search for.
If you create your own exclusions, be sure to get the name out of the disassembly view. The declaration in source may not match the compiler generated name, especially for templated functions.
I usually prefer to code with a black background and white/coloured text but I had never taken the time to change my syntax-highlighting in Visual Studio.
Yesterday, when I finally got around to it one of my changes was to change User Types and User Types (Value Types) to different colors. Without realizing it, I had been using a struct type to pass and return data from methods more than I would have liked.
This change in syntax-highlighting made it very apparent what was going on. So it made me wonder if there were other settings which could provide similar help.
I also usually set my documentation and comment colours to something more washed out and passive so that actual code jumps more at you and makes quickly skimming through code faster.
Do you have any other tips like this which can help spot issues or makes things more readable?
Note: (I've seen this post, but I'm looking more for tips which are functional and provide help rather than purely cosmetic preferences.)
I make strings look horrible. Yellow background. Bold. Red foreground. To remind me that hardcoding strings is generally bad and to try as much as possible to minimize it!
I recommend a dark (but not black) background, and light (but not white) text. The higher contrast is easy on the eyes, but too much contrast gives me (personally) a headache over time. I also 100% agree on your comment about using a washed out color for docs and comments.
Definitely use different (even if just slightly) different colors for User types, delegates, and value types. This makes them pop, and really helps when you're trying to understand other people's code quickly.
Also, I second the comment about making string literals stand out. I don't necessarily use horrible colors, but I have them a color separate from all of my other colors so they are very noticable.
I also like having Numbers be a separate color. Many times, numbers have some of the same issues as string literals, and having them colored separately makes them stand out for me and helps clue me into places where I should replace a numeric literal with a constant, property, etc.
I've found that it helps me to have a separate theme available where the colors are all exaggerated (bright blue instead of muted blue coloring for interfaces, for example) for refactoring. I use the same basic color scheme I normally use, but with "brighter" colors for each of the types. (I don't like changing color schemes - my brain is kind of wired to my standard set of colors - switching defeats the purpose for me). Having brighter versions makes everything "pop" a bit more, though, so it's nice for refactoring or for trying to understand somebody else's code.
People have put together entire "themes" for Visual Studio. I find that introducing a new settings theme every 6-12 months gives everything a new perspective, although admittedly there are very few themes that I like (I tend to switch between just two different ones).
Check out Scott's article on VS Themes: http://www.hanselman.com/blog/VisualStudioProgrammerThemesGallery.aspx
Use some nice color for interaces and an ugly one for user defined classes, that helps to decouple things.
The Vibrant Ink theme has some really well thought through things in it. I like to tone down the colors like this a bit htough, but it is a good start.
Why don't you see what works for you? There is a cool theme generator at http://www.frickinsweet.com/tools/Theme.mvc.aspx
Full instructions on the site how to backup your current settings and import the one you create.
Try setting your string literals to be bright red background with bold white text. It'll encourage you not to use magic strings =)
I use a different color for classes and structs.
Color strings bright so that you immediately notice them in your code. I use green for string on black. On grey I used to use yellow.
Btw I do the same for constants, numbers, etc.
It's not really highlighting but I recently switched to a proportional font after reading some recommendations and found it noticably better.
Before switching my main fear was things would not line up properly but after trying it I realised it worked fine without any apparent disadvantage. Tabs (or spaces) line up the blocks and words that repeat down the page line up because they are made-up of the same letters. My fear was imaginary because I somehow thought I would need words to line up if they were different . This is not the case.
One thing it prevents is aligning words that are in the middle of expressions, not at the left. E.g. In a fixed width font you can do:
string firstName = "John";
string lastName = "Smith";
int age = 30;
Whereas you can't do that with a proportional font. But that practice seems rare these days. Perhaps more of a C or assembly language thing.
I recommend trying it anyway. The internet runs on proportional fonts and so it makes sense to use them, as long as they don't have any disadvantages. When it was recommended to me they claimed it would only take a few days to get used to and that turned out to be true. I find Arial 11 point to be a good choice in Visual Studio.
I always set the brace matching background to something red, and make it bold. This way when I close braces or parens I can see what its being matched against.
I think that it's more important to choose good monospaced font for programming (my choice is consolas, for some other good fonts take a look at this article on coding horror).
Visual Studio's default theme is pretty good imho, maybe too bright if your are working at night.
I really like Resharper's colorizing system. Using it you get a little more detail out of your editor. For example: fields, locals and parameters are all different colors. I have no idea why VS didn't include this out of the box.
Related to a previous issue that I thought was resolved and actually isn't...
My Visual Studio 2008 installation may be a bit messed up, I think.
Any ideas how to track this one down?
Thanks!
I had a similar problem which hit my 2 main machines at the same time. On investigating I found it to be related to the Eset personal security (guessing a recent update messed something up). To solve it I excluded VS2008 from the active browser filtering - this is in: setup -> advanced firewall setup -> antivirus & anti spyware -> web access protection -> HTTP -> webbrowsers
Deselecting vsdev in here fixed the problem - interestingly enough disabling the firewall and antivirus / antispyware did not solve the issue, so it is worth looking for a similar setting if you are running different security software
First try to kill all "WebDev.WebServer.exe" processes.
Hope this helps
Weird!
The port number is stored in the .sln file. So, I'd blow that away the solution file first, re-create it and see what happens. If that doesn't help, I'd then move onto the web.config file and blow that away and start again too.
I do absolutely agree with Macros' answer. Just want to share solution for Eset Nod32 v5
In ESET NOD32 v5 to allow Visual Studio to run Development or IIS Express server you must uncheck Visual Studio in Nod32 Advanced Setup => Web and Email => Protocol filtering => Web and email clients
To solve your problem, just restart your PC. I've had the same problem, I did the same thing.
I'm currently migrating a big solution (~70 projects) from VS 2005 + .NET 2.0 to VS 2008 + .NET 3.5. Currently I have VS 2008 + .NET 2.0.
The problem is that I need to move projects one by one to new .NET framework ensuring that no .NET 2.0 project references .NET 3.5 project. Is there any tool that would give me a nice graph of project dependencies?
Have you tried NDepend? It'll shows you the dependencies and you can also analyze the usability of your classes and methods.
Their website:
You can get a project dependency graph easily using Visual Studio 2010 Ultimate, scan to 5 minutes into this video to see how: http://www.lovettsoftware.com/blogengine.net/post/2010/05/27/Architecture-Explorer.aspx
In Visual Studio 2010 Ultimate: Architecture | Generate Dependency Graph | By Assembly.
You can create a dependency graph of your projects in VS 2010 Ultimate. Architecture Explorer lets you browse your solution, select projects and the relationships that you want to visualize, and then create a dependency graph from your selection.
For more info, see the following topics:
How to: Generate Graph Documents from Code: http://msdn.microsoft.com/en-us/library/dd409453%28VS.100%29.aspx#SeeSpecificSource
How to: Find Code Using Architecture Explorer: http://msdn.microsoft.com/en-us/library/dd409431%28VS.100%29.aspx
RC download: http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=457bab91-5eb2-4b36-b0f4-d6f34683c62a.
Visual Studio 2010 Architectural Discovery & Modeling Tools forum: http://social.msdn.microsoft.com/Forums/en-US/vsarch/threads
You can create a nice graph of the references in your projects. I've described the way I did it on my blog http://www.mellekoning.nl/index.php/2010/03/11/project-references-in-ddd/
To complete the eriawan answer on graphs generated by NDepend see screenshoots below. You can download and use the free trial edition of NDepend for a while.
More on NDepend Dependency Graph
More on NDepend Dependency Matrix:
Disclaimer: I am part of the tool team
I wrote a tool that might help you. VS Solution Dependency Visualizer analyzes project dependencies within a solution and create a dependency chart from this information, as well as a text report.
If you simply want a dependency graph I've found this is one of the cleanest ways to get one:
I think I'll stick to the Visual Studio build order list. I checked out NDepend, but it have so powerful functionality, that their refference graph is unreadable.
You're in Visual Studio... you press F5 (Run) and are greeted by this dialog:
There were build errors. Would you like to continue and run the last successful build?
Wonderful.
I'm sure there are cases where running the last successful build is useful, however, I have never purposefully answered yes to this question. Oh sure, I've clicked Yes plenty of times, and waiting in frustration for the first opportunity to undo my blunder, but nothing more.
So, have you ever found this feature useful? And if so, under what circumstances did it become helpful for you to be able to run the last successful build of your application?
How often do you accidentally click Yes and kick yourself while waiting for the app to start?
In VS2008 there are the following options you can set to change the behavior (not sure if there are similar options in other versions of Visual Studio):
Projects and Solutions/Build and Run
- On Run, when projects are out of date:
Always build
Never build
Prompt to build <== default setting
- On Run, when build or deployment errors occur:
Launch old version
Do not launch
Prompt to launch <== default setting
Set the above options to "Always build" and "Do not launch" and you get what I consider a more ueseful behavior. Though sometimes when I try to launch the debugger and there's a build error it takes me a few seconds to realize why I'm not getting to the breakpoint I thought I'd be hitting (it might be nice to get some sort of 'toaster' type of message to knock me out of my stupor).
This can be useful when you debug a web application and one of the pages does not compile, because some other developer checked in a bad version, or you can't check out the latest code for whatever reason, but you know you will not hit that page. I do it all the times.
I have a scenario when this feature is useful. Imagine your boss coming to your room, asking what are you doing, and you want to show him, but you made some change to the code and it's not compiling ... :). Naaah ... it's stupid :D. Fortunately this feature can be turned off
Interesting. I've actually never seen that dialog - I know there's an option to enable/disable running the previous successful build, so perhaps it shows a dialog first. You can look into disabling it if you won't use it.
One reason this can be useful, however, is if you want to remind yourself what the bug was that you were working on. Not all things can be fixed in edit-and-continue, and you might need a memory jog.
It's also helpful on web applications, because it will force the cassini servers to start. You need this if you are working on one project in the solution that won't compile, and you need to refresh the web services in another project.
When using VS 2008 Express, there is a box to never show this dialog again. Just tried it and it will take away the dialog, leaving only a build failed message in the bottom left hand portion of the screen.
As for how often do I hit it, quite often. Frustrating as sometimes I have changed the code complete while testing things and will get something completely unrelated to the task at hand. Not sure when Microsoft figured this would be useful.
This behaviour can be defined under Tools->Options->Projects and Solutions->Build And Run-> On Run, when Build or Deployment Errors occur
here you can select: - Launch old version - Do not launch - Ask to launch
It works on the preference of selection of appropriate dll on runtime. Executables are not generated if there is any built error so the compiler looks for the executable which is existing which is obviously the last successful compiled.
This message is absolutely typical of Visual Studio. We can tick a box to suppress the dialog, but no information is given as to the consequences. Will it always build on errors, or will it always run the last successful build? It doesn't say. Either nobody at MS has thought about this, or sombody thought about it and thought it was good enough.
There is, of course, no help, even if one had the patience to wait for it.
I have written some code that makes use of an open source library to do some of the heavy lifting. This work was done in linux, with unit tests and cmake to help with porting it to windows. There is a requirement to have it run on both platforms.
I like Linux and I like cmake and I like that I can get visual studios files automatically generated. As it is now, on windows everything will compile and it will link and it will generate the test executables.
However, to get to this point I had to fight with windows for several days, learning all about manifest files and redistributable packages.
As far as my understanding goes:
With VS 2005, Microsoft created Side By Side dlls. The motivation for this is that before, multiple applications would install different versions of the same dll, causing previously installed and working applications to crash (ie "Dll Hell"). Side by Side dlls fix this, as there is now a "manifest file" appended to each executable/dll that specifies which version should be executed.
This is all well and good. Applications should no longer crash mysteriously. However...
Microsoft seems to release a new set of system dlls with every release of Visual Studios. Also, as I mentioned earlier, I am a developer trying to link to a third party library. Often, these things come distributed as a "precompiled dll". Now, what happens when a precompiled dll compiled with one version of visual studios is linked to an application using another version of visual studios?
From what I have read on the internet, bad stuff happens. Luckily, I never got that far - I kept running into the "MSVCR80.dll not found" problem when running the executable and thus began my foray into this whole manifest issue.
I finally came to the conclusion that the only way to get this to work (besides statically linking everything) is that all third party libraries must be compiled using the same version of Visual Studios - ie don't use precompiled dlls - download the source, build a new dll and use that instead.
Is this in fact true? Did I miss something?
Furthermore, if this seems to be the case, then I can't help but think that Microsoft did this on purpose for nefarious reasons.
Not only does it break all precompiled binaries making it unnecessarily difficult to use precompiled binaries, if you happen to work for a software company that makes use of third party proprietary libraries, then whenever they upgrade to the latest version of visual studios - your company must now do the same thing or the code will no longer run.
As an aside, how does linux avoid this? Although I said I preferred developing on it and I understand the mechanics of linking, I haven't maintained any application long enough to run into this sort of low level shared libraries versioning problem.
Finally, to sum up: Is it possible to use precompiled binaries with this new manifest scheme? If it is, what was my mistake? If it isn't, does Microsoft honestly think this makes application development easier?
Update - A more concise question: How does Linux avoid the use of Manifest files?
All components in your application must share the same runtime. When this is not the case, you run into strange problems like asserting on delete statements.
This is the same on platforms. It is not something Microsoft invented.
You may get around this 'only one runtime' problem by being aware where the runtimes may bite back. This is mostly in cases where you allocate memory in one module, and free it in another.
a.dll
dllexport void* createBla() { return malloc( 100 ); }
b.dll
void consumeBla() { void* p = createBla(); free( p ); }
When a.dll and b.dll are linked to different rumtimes, this crashes, because the runtime functions implement their own heap.
You can easily avoid this problem by providing a destroyBla function which must be called to free the memory.
There are several points where you may run into problems with the runtime, but most can be avoided by wrapping these constructs.
For reference :
But this is not a problem with manifests.
The manifest gets embedded by the linker and contains the version info of the runtime used by the module. When an application is loaded and its dependencies are to be resolved, the loader looks at the manifest and then based on this information uses the right version of the dll from the WinSxS folder. You cannot just copy the runtime or other modules to the WinSxS folder, but you must install the runtime. There are MSI packages supplied by Microsoft which can be executed when you install your software on a test/end-user machine.
So install your runtime before using your application, and you won't get a 'missing dependency' error.
(Updated to the "How does Linux avoid the use of Manifest files" question)
What is a manifest file?
Manifest files were introduced to place disambiguation information next to an existing executable/dynamic link library.
This is done by specifying the specific version of dlls which are to be loaded when starting the app/loading dependencies.
(There are several other things you can do with manifest files, e.g. some meta-data may be put here)
Why is this done?
Because the version is not part of the dll name due to historic reasons. So "comctl32.dll" is named this way in all versions of it. (So the comctl32 under Win2k is another then the one in XP or Vista). To specify which version you really want (and have tested against) you place the version information in the "appname.exe.manifest" file (or embed this file).
Why was it done this way?
Many programs installed their dlls into the system32 directory in the systemrootdir. This was done to allow bugfixes to shared libraries to be deployed easily and for all dependent applications. And in the days of limited memory, shared libraries reduced the memory footprint when several applications used the same libraries.
This concept was abused by many programmers, because they installed all dlls into this directory. Sometimes overwriting newer versions of shared libraries with older ones. Sometimes libraries changed silently in their behavoir, so that dependent applications crashed.
This lead to the approach of distributing all your dlls in the application directory.
Why was this bad?
When bugs appeared, all dlls scattered in several directories had to be updated. (gdiplus.dll) In other cases this was not even possible (windows components)
The manifest approach
This approach solves all problems above. You can install the dlls in a central place, where the programmer may not interfere. Here the dlls can be updated (by updating the dll in the WinSxS folder) and the loader loads the 'right' dll. (version matching is done by the dll-loader).
Why doesn't Linux have this mechanic?
I have several guesses. (This is really just guessing ...)
If a third party DLL will allocate memory and you need to free it, you need the same run-time libraries. If the DLL has allocate and deallocate functions, it can be ok.
It the third party DLL uses std containers, such as vector, etc. you could have issues as the layout of the objects may be completely different.
It is possible to get things to work, but there are some limitations. I've run into both of the problems I've listed above.
If a third party DLL allocates memory that you need to free, then the DLL has broken one of the major rules of shipping precompiled DLL's. Exactly for this reason.
If a DLL ships in binary form only, then it should also ship all of the redistributable components that it is linked against and its entry points should isolate the caller from any potential runtime library version issues, such as different allocators. If they follow those rules then you shouldn't suffer. If they don't then you are either going to have pain and suffering or you need to complain to the third party authors.
I finally came to the conclusion that the only way to get this to work (besides statically linking everything) is that all third party libraries must be compiled using the same version of Visual Studios - ie don't use precompiled dlls - download the source, build a new dll and use that instead.
Alternatively (and the solution we have to use where I work) is that if the third-party libraries that you need to use all are built (or available as built) with the same compiler version, you can "just" use that version. It can be a drag to "have to" use VC6, for example, but if there's a library you must use and its source is not available and that's how it comes, your options are sadly limited otherwise.
...as I understand it. :)
(My line of work is not in Windows although we do battle with DLLs on Windows from a user perspective from time to time, however we do have to use specific versions of compilers and get versions of 3rd-party software that are all built with the same compiler. Thankfully all of the vendors tend to stay fairly up-to-date, since they've been doing this sort of support for many years.)
I am supporting a number of .Net developers who are using Subversion to version control their work, but we have been running into a number of issues that seem to revolve around the additional files that Visual Studio uses to manage projects, do debuging, etc. Specifically, it seems that these files are causing conflicts due to the fact that they are already in the repo. I know how to get them out and how to handle them, but I need to know what "they" are first.
So, what are the files/directories that Subversion can ignore, and why can they be ignored?(aka. what do those files do?)
This is a large, rather un-organized ASP.Net site and deploying the site is done via. svn updates, so files needed by IIS to dynamically compile (I think that's what it is) the site as files change needs to be left in the repo.
I have had good luck with this global ignore pattern:
I am running the Resharper plugin, so you can probably ignore that. ".~m2" is for a temporary file my data modeler creates.
I think a better question would be "What files should I add to Subversion?"
The AnkhSVN 2.0 Subversion integration asks exactly this question to all the projects in your solution. (This question is one of the key parts of the SCC specification.) It will then only suggest adding these files.
As user you can add other files manually (or mark some of the files suggested as ignored), but this behavior makes it very easy to do the right thing.
Most other subversion clients don't have the luxury of talking to a system that really understands what should and shouldn't be added. (E.g. External clients like TortoiseSVN and its frontends can just guess based on file extensions).
AnkhSVN does a great job of only checking in the files that are necessary to the project.
I would probably say anything in the bin directory.
In addition to the ones people have suggested above, I frequently have to ignore *.cache because for some reason I don't know Resharper likes to put it's .cache files in the same folders as the code I work on. Also, I don't think anyone has mentioned *.pdb yet.
Here's my TortoiseSVN global ignore:
*.suo *.resharper *.sln bin obj *.user *.suo Debug Release *.pdb test.* _ReSharper*.* *.scc *.vssscc *.vspscc
The last 3 help when you transition from Microsoft Visual SourceSafe.
I have been getting an error message that I can't resolve. It originates from Visual Studio or the debugger. I'm not sure whether the ultimate error condition is in VS, the debugger, my program, or the database.
This is a Windows app. Not a web app.
First message from VS is a popup box saying: "No symbols are loaded for any call stack frame. The source code can not be displayed." When that is clicked away, I get: "ContextSwitchDeadlock was detected", along with a long message reproduced below.
The error arises in a loop that scans down a DataTable. For each line, it uses a key (HIC #) value from the table as a parameter for a SqlCommand. The command is used to create a SqlDataReader which returns one line. Data are compared. If an error is detected a row is added to a second DataTable.
The error seems to be related to how long the procedure takes to run (i.e. after 60 sec), not how many errors are found. I don't think it's a memory issue. No variables are declared within the loop. The only objects that are created are the SqlDataReaders, and they are in Using structures. Add System.GC.Collect() had no effect.
The db is a SqlServer site on the same laptop.
There are no fancy gizmos or gadgets on the Form.
I am not aware of anything in this proc which is greatly different from what I've done dozens of times before. I have seen the error before, but never on a consistent basis.
Any ideas, anyone?
Full error Text: The CLR has been unable to transition from COM context 0x1a0b88 to COM context 0x1a0cf8 for 60 seconds. The thread that owns the destination context/apartment is most likely either doing a non pumping wait or processing a very long running operation without pumping Windows messages. This situation generally has a negative performance impact and may even lead to the application becoming non responsive or memory usage accumulating continually over time. To avoid this problem, all single threaded apartment (STA) threads should use pumping wait primitives (such as CoWaitForMultipleHandles) and routinely pump messages during long running operations.
The ContextSwitchDeadlock doesn't necessarily mean your code has an issue, just that there is a potential. If you go to Debug > Exceptions in the menu and expand the "Managed Debugging Assistants", you will find ContextSwitchDeadlock is enabled. If you disable this, VS will no longer warn you when items are taking a long time to process. In some cases you may validly have a long-running operation. It's also helpful if you are debugging and have stopped on a line while this is processing - you don't want it to complain before you've had a chance to dig into an issue.
As Pedro said, you have an issue with the debugger preventing the message pump if you are stepping through code.
But if you are performing a long running operation on the UI thread, then call Application.DoEvents() which explicitly pumps the message queue and then returns control to your current method.
However if you are doing this I would recommend at looking at your design so that you can perform processing off the UI thread so that your UI remains nice and snappy.
It sounds like you are doing this on the main UI thread in the app. The UI thread is responsible for pumping windows messages as the arrive, and yet because yours is blocked in database calls it is unable to do so. This can cause problems with system wide messages.
You should look at spawning a background thread for the long running operation and putting up some kind of "I'm busy" dialog for the user while it happens.
If you don't want to disable this exception, all you need to do is to let your application pump some messages at least once every 60 seconds. It will prevent this exception to happen. Try calling System.Threading.Thread.CurrentThread.Join(10) once in a while. There are other calls you can do that let the messages pump.
We work on several different branches of the same code, and when working on two branches at once, it can become confusing and time wasting.
Presently, the VS title bar has the text <solution-name> - Visual Studio.
Is it possible for me to write an extension that will make that text <solution-name>: <branch-name> - <Visual Studio>?
Check out latest release of VSCommands 2010 Lite. It introduced a feature called Friendly Solution Name where you can set up a regex pattern to extract branch name from folder structure and have it placed in Visual Studio main window title. More details: http://vscommands.com/releasenotes/3.6.8.0 and http://vscommands.com/releasenotes/3.6.9.0
Trying to set MainWindow.Caption throws an exception. You have to use the Win32 SetWindowText function to change the title, but beware: Visual Studio resets the title bar text at the drop of a hat, so you should implement a Timer to keep setting your desired text. The following code from the Connect class of the add-in will permanently (or, as long as the add-in is running) keep the title bar text as "Hello World!"
public void OnConnection(object application, ext_ConnectMode connectMode, object addInInst, ref Array custom)
{
_applicationObject = (DTE2)application;
_addInInstance = (AddIn)addInInst;
resetTitleTimer = new Timer(new TimerCallback(SetMainWindowTitle), "Hello world!", 0, 10);
}
[DllImport("user32.dll")]
private static extern bool SetWindowText(IntPtr hWnd, string lpString);
private void SetMainWindowTitle(object state)
{
IntPtr hWnd = (IntPtr)_applicationObject.MainWindow.HWnd;
SetWindowText(hWnd, "Hello World!");
}
I just created a small Visual Studio extension that can help: http://visualstudiogallery.msdn.microsoft.com/f3f23845-5b1e-4811-882f-60b7181fa6d6
This small extension will detect whenever two instances of Visual Studio are running and change the window title of Visual Studio to include the parent folder name of the solution. It will therefore change SolutionFolder - Microsoft Visual Studio into SolutionFolderParent\SolutionFolder - Microsoft Visual Studio.
This is particularly useful when branching a solution: it becomes possible to easily identify which branch you are working on, in the case where both would have the same solution name.
Official page here: http://erwinmayer.com/labs/visual-studio-2010-extension-rename-visual-studio-window-title/
In the VS automation model there is
_DTE.MainWindow.Capation
which you could start with.
See http://msdn.microsoft.com/en-us/library/envdte._dte.mainwindow.aspx
To be honest, I am not sure I am understanding your question correctly, but I had asked one here on SO that seems to be about a similar problem:
Working with different versions/branches of the same Visual Studio 2005 solution
Perhaps a simpler solution would be to use virtual desktops? Spacial arrangement is easier to remember, you could group any related windows with the corresponding VS, and switching would be simpler.
When I try to start a service I created in Visual Studio I receive the following error:
System error 5 has occurred.
Access is denied.
I am running the command line with elevated privileges, so it's not that problem. Is there any place I can look to see what error is occuring.
To get it to work I needed to add permissions to the output bin\debug folder for my service project.
The Local Service account didn't have permissions to the output .exe file, and this was why the error was occuring.
I see you've fixed the problem; but in reality, you shouldn't normally be running the service from a project's bin folder anyway - the files should be put somewhere project and profile independent (for example, under program files). For debugging purposes (when it will be in the bin folder), you can detect whether it is a service in Main(), and if it is being run interactively just run the service code directly, rather than the usual service-start setup.
You can detect either by adding a command line argument, or you can try checking Environment.UserInteractive.
I had the same problem because my project and its source code was in a folder that had NTFS's Encrypting File System (EFS) enabled. This caused by compiled assemblies being encrypted aswell and the user running my service didn't have permissions to decrypt them. Removing EFS was the easy solution for this. It can be done by command line using CIPHER.EXE, which is a Windows tool.
I have a legacy (haha) ASP.Net Webforms Web Site Project in Visual Studio 2008 SP1, that I would like to gradually introduce some MVC functionality into.
Most of the information I can locate on how to integrate ASP.Net MVC with WebForms seems to assume the use of a Web Application Project. However, it seems impossible to find information about how to retrofit an existing ASP.net Web Site Project with the ASP.Net MVC features.
I've reviewed Scott Hanselman's post and Chapter 13 of his upcoming book, both of which assume the Web Application Project type.
Is this possible? Does anyone have a how-to on this?
Well for starters adding MVC to a webforms project is pretty simple, to get the features in VS 2008 for MVC takes a little bit more work (still easy). First you want to be sure you reference the assemblies and are using .Net 3.5. Second you can create a controllers folder and views folder in your current web forms project. You can also create a simple controller with an index action. Then setup/configure the routes in the global.ascx file. You should be set from there. Check here for reference.
However you will only be able to create aspx pages with code behinds (you can delete those and enter the right inheritance class in the markup). To actually "convert" your project type so that you get the goodness of MVC and visual studio (add new view, goto controller, etc) is going to take some playing around with. My best advice is to create a new MVC project in VS 2008 and a new Web App project and compare the .csproj files in plain text. There is a long string value that tells VS the project template.
Believe me this does work. I have done it before on my own legacy projects. I don't remember how I found the project type "key" besides trial/error/elimination. ASP.Net MVC does play nice in the same project as webforms.
UPDATE: I think you can change to an MVC project type, which is still a web application by using these in the PropertyGroup of the .csproj file. Compare those to what you have and change the one that are differnt, be sure to copy/backup the file.
<ProjectGuid>{B99EC98A-1F09-4245-B00D-5AF985190AA9}</ProjectGuid>
<ProjectTypeGuids>{603c0e0b-db56-11dc-be95-000d561079b0};{349c5851-65df-11da-9384-00065b846f21};{fae04ec0-301f-11d3-bf4b-00c04f79efbc}</ProjectTypeGuids>
Update 2: You wouldn't affect your project or impact it very much. If you are un easy about it make a backup and play around. If you encounter changes you will always have the backup. I was skeptical at first but was glad I went down the MVC path.
I thought I would give an updated answer using Visual Studio 2010 SP1 / NuGet / Scott Hanselman's totally unsupported utility.
This will add all necessary dlls, javascript files, web.config setting changes, etc to the project. If everything was successful, you should be able to press F5, navigate to "home" on your website, and see a sample form rendered by mvc: "Welcome to ASP.NET MVC, upgraded with a NuGet package in a totally unsupported way by Hanselman! No warranty!".
For a WebSite project, you just need to add Controllers to App_Code, not the root. You'll miss some VS goodness - as it doesn't know you're using MVC without the csproj file, but you'll actually get it working.
Just remember to inherit from Controller and ViewPage and you should be good.
As long as you setup the routing in web.config, setup the necessary directory structure, and add the correct routes in global.asax, you could theoretically add MVC items to any web project. So far as I know, those are the only requirements for it to work.
However, the combination of the two might be a bit confusing and difficult to maintain, long term. Maybe you could move all of the existing web forms site content into a subfolder to keep it out of the way and keep the root directory of the site clean to reduce the clutter and make things more clear.
If you want to add MVC 3 to an asp.net website rather than web project then Scott Hanselman's AddMvc3ToWebForms nuget package will get you 99% of the way there, but will throw an error during install you can saefly ignore (I think, at least in my tests this seems to be the case), and a couple of simple steps are needed after install.
Full details on http://delradiesdev.blogspot.com/2011/08/adding-mvc-3-to-aspnet-web-site.html
Mark (@delradie)
Something that I learn, while trying to migrate an MVC2 application is that your project needs a Default.aspx. I was tasked with adding some GUI functions to an existing Web Services project, and therefore there was no default.aspx. Took me a while to figure out why my routes weren't being setup.
The Microsoft .NET 4.0 exam on Web development (70-519) has almost this exact question in the prep materials. The answer, according to Microsoft then, is:
This info is in paid-for materials my employer purchased so there is not necessarily a web page stating it this clearly to which I could link.
I have a C# project which includes one exe and 11 library files. The exe references all the libraries, and lib1 may reference lib2, lib3, lib4, etc.
If I make a change to a class in lib1 and built the solution, I assumed that only lib1 and the exe would need to be changed. However, all dll's and the exe are being built if I want to run the solution.
Is there a way that I can stop the dependencies from being built if they have not been changed?
Is the key this phrase? "However, all dll's and the exe are being built if I want to run the solution"
Visual Studio will always try to build everything when you run a single project, even if that project doesn't depend on everything. This choice can be changed, however. Go to Tools|Options|Projects and Solutions|Build and Run and check the box "Only build startup projects and dependencies on Run". Then when you hit F5, VS will only build your startup project and the DLLs it depends on.
I am not sure if there is a way to avoid dependencies from being built. You can find some info here like setting copylocal to false and putting the dlls in a common directory.
Optimizing Visual Studio solution build - where to put DLL files?
We actually had this problem on my current project, in our scenario even running unit tests (without any code changes) was causing a recompile. Check your build configuration's "Platform".
If you are using "Any CPU" then for some reason it rebuilds all projects regardless of changes. Try using processor specific builds, i.e. x86 or x64 (use the platform which is specific to the machine architecture of your machine). Worked for us for x86 builds.
We had a similar problem at work. In post-build events we were manually embedding manifests into the outputs in the bin directory. Visual Studio was copying project references from the obj dir (which weren't modified). The timestamp difference triggered unnecessary rebuilds.
If your post-build events modify project outputs then either modify the outputs in the bin and obj dir OR copy the modified outputs in the bin dir on top of those in the obj dir.
You can uncheck the build option for specified projects in your Solution configuration:
You can can create your own solution configurations to build specific project configurations...
Now, after I say this, some propeller-head is going to come along and contradict me, but there is no way to do what you want to do from Visual Studio. There is a way of doing it outside of VS, but first, I have a question:
Why on earth would you want to do this? Maybe you're trying to save CPU cycles, or save compile time, but if you do what you're suggesting you will suddenly find yourself in a marvelous position to shoot yourself in the foot. If you have a library 1 that depends upon library 2, and only library 2 changes, you may think you're OK to only build the changed library, but one of these days you are going to make a change to library 2 that will break library 1, and without a build of library 2 you will not catch it in the compilation. So in my humble opinion, DON'T DO IT.
The reason this won't work in VS2005 and 2008 is because VS uses MSBuild. MSBuild runs against project files, and it will examine the project's references and build all referenced projects first, if their source has changed, before building the target project. You can test this yourself by running MSBuild from the command line against one project that has not changed but with a referenced project that has changed. Example:
msbuild ClassLibrary4.csproj
where ClassLibrary4 has not changed, but it references ClassLibrary5, which has changed. MSBuild will build lib 5 first, before it builds 4, even though you didn't mention 5.
The only way to get around all these failsafes is to use the compiler directly instead of going through MSBuild. Ugly, ugly, but that's it. You will basically be reduced to re-implementing MSBuild in some form in order to do what you want to do.
It isn't worth it.
Check out the following site for more detailed information on when a project is built as well as the differences between build and rebuild.
I had this problem too, and noticed these warning messages when building on Windows 7 x64, VS2008 SP1:
cl : Command line warning D9038 : /ZI is not supported on this platform; enabling /Zi instead
cl : Command line warning D9007 : '/Gm' requires '/Zi'; option ignored
I changed my project properties to:
C/C++ -> General -> Debug Information Format = /Zi
C/C++ -> Code Generation -> Enable Minimal Build = No
After rebuilding I switched them both back and dependencies work fine again. But prior to that no amount of cleaning, rebuilding, or completely deleting the output directory would fix it.
I just "fixed" the same problem with my VS project. Visual Studio did always a rebuild, even if didn't change anything. My Solution: One cs-File had a future timestamp (Year 2015, this was my fault). I opened the file, saved it and my problem was solved!!!
I don't think there's away for you to do it out of the box in VS. You need this add-in http://workspacewhiz.com/
It's not free but you can evaluate it before you buy.
Yes, exclude the non-changing bits from the solution. I say this with a caveat, as you can compile in a way where a change in build number for the changed lib can cause the non built pieces to break. This should not be the case, as long as you do not break interface, but it is quite common because most devs do not understand interface in the .NET world. It comes from not having to write IDL. :-)
As for X projcts in a solution, NO, you can't stop them from building, as the system sees a dependency has changed.
BTW, you should look at your project and figure out why your UI project (assume it is UI) references the same library as everything else. A good Dependency Model will show the class(es) that should be broken out as data objects or domain objects (I have made an assumption that the common dependency is some sort of data object or domain object, of course, but that is quite common). If the common dependency is not a domain/data object, then I would rethink my architecture in most cases. In general, you should be able to create a path from UI to data without common dependencies other than non-behavioral objects.
Not sure of an awesome way to handle this, but in the past if I had a project or two that kept getting rebuilt, and assuming I wouldn't be working in them, I would turn the build process off for them.
Right click on the sln, select configuration manager and uncheck the check boxes. Not perfect, but works when Visual Studio isn't behaving.
If no real reason (like loops of building dependencies or other ugly stuff that shouldn't really exist) Restarting the studio usually fixes it.
Simple as that.
I would like feedback on what people consider the "best" free (or cheap) subversion tool for C#... By "best" I mean easiest for a given level of capability. I am a complete newbie in C#, and am using Visual C# Express as my development tool. Obviously I am not a sophisticated C# user!
In Java I use Eclipse, and Subclipse, which I find fairly easy to use. I tried TortoiseSVN, and couldn't get to first base with it - not sure why not - maybe just the wrong mental habits! Ideally I would like something that has the same relationship to Visual C# Express that Subclipse has to Eclipse... Help would be appreciated.
Tortoise SVN is the best for windows. Spend some time reading the documentation and you'll get it. The interaction between the explorer window, the overlay icons, and the repository is quite nice.
Similarly, I like the VisualSVN plugin for Visual Studio, to make interacting with the SVN repository directly from the IDE easier. However, I don't believe it will work with Visual Studio express edition.
The "Express" IDEs don't support source control integration, so I think you're going to have to choose between switching IDEs or learning to use an external tool. TortoiseSVN is considered to be the best external tool by far, so I doubt you'll find anything better. I'd just spend a few hours and put the effort into learning Tortoise, it's not particularly difficult, just requires a slight modification of your workflow.
In terms of plugins for visual studio Visual SVN is very good but is not free software. Ankhsvn is your best bet for something like subclipse but for Visual Studio.
VisualSVN integrates well with VS. However, it's not free, altough it's relatively cheap at $49.
AnkhSVN is your other alternative. It's free and I've heard good things about it, however I personally have not used it.
I don't know if any of these two integrate with Visual C# Express, though.
With C# Express, you can not have plug-ins so VisualSVN and AnkhSVN are impossible to use.
On Garry blog , there are settings that you can use to have Toolbarmenu and menu added to Visual Studio (including express) to interract with TortoiseSVN without leaving Visual Studio.
I use VisualSvn, its the easiest one i have found. I tried AnkhSVN, but wasnt too impressed. VisualSVN does cost ($50), but it seems worth it.
Try to use #Develop. This is open-source full featured IDE for C# (among others). It has SVN integration build-in. Interface of the #Develop very similar to VS Express.
I've used VS with Visual SourceSafe integration, and I've used VS with TortoiseSVN in a separate Windows Explorer window. The latter is so much easier to live with it's hard to begin describing it. TortoiseSVN is so straightforward I've never felt the need to figure out how to integrate SVN with VS.
But there are two pretty significant issues about using non-integrated source control.
The first is that when you add a new file to a project, you have to add it to SVN as a separate action. Without VS integration, you can't tell (by looking at Solution Explorer) that you haven't done this yet. This is pretty dangerous.
The second is that importing a project into SVN is really clumsy. There's two ways to do it and they both suck. I'd presume that a decent VS integration would make this a one-button operation.
(How to import a project with TortoiseSVN: Make a copy of your project directory called projectName.import. Delete every file from that directory tree that you don't want source-controlled, like everything in the bin directory. Import it into SVN and then throw away projectName.import. Rename your project directory as projectName.original. Create a new directory called projectName. Check your project out into that directory. Build and test. Once you're comfortable that everything's really in SVN you can throw away projectName.original.)
I've learned to live with both of those problems. Also, since I don't have SVN integration in Eclipse either, it means that I've only had to learn one thing instead of three.
The only benefit I've found for an integrated subversion plug-in is that you're less likely to forget to add new files to the repository. Apart from that, tortoisesvn works really well.
It'm not sure if subclipse does something fancy to get you started, in tortoise, open windows explorer:
You can also use tortoise svn to create a new blank repository in an empty folder.
Free source code control for Visual C # Express 2010: (Untested)
I voted up @Simucal's recommendation of TortoiseSVN. I've used it for quite a while now and I like it.
I also use Subclipse, an SVN plugin for Eclipse. And I find that knowing my way around the straight-up command-line version of SVN is helpful too.
(That command-line hyperlink also contains a table of third-party Subversion clients for various platforms.)
Assuming that I'm starting a new web project at home using Visual Studio, which version control system, viz. Git or Subversion will be better to use? Which one will have the least setup complexity?
Since this is for your own personal playing around, my question is simple: Do you know Subversion or Git already?
If you don't know either - use SVN. It's a better introduction.
I'd go with Git. It's not that bad getting up to speed on the basics (there are now a ton of good resources, including learn.github.com) and it'll pay off in spades. And I've been using it on Vista with no probs.
Subversion is far more Windows-friendly in my experience and also more immediately useful for the solo developer.
Another possibility is Perforce, which is slightly less Windows-friendly, but full featured and fairly easy to use, not to mention free for up to two users.
Git is a distributed source control setup and as you are the only user I can't imagine that you would benefit much from its features. Subversion is (in my opinion) easier to set up so I would recommend you go with it.
If you are working alone and want some kind of version control easy to use, then use Subversion.It works great on Windows, setting up the repository is one right click in an empty with Tortoise SVN. Ankh SVN provides a very good integration with Visual Studio - almost on par with TFS provided you use VS 2005 or more recent.
On the other hand, Git is much more promising than SVN. I'll check it during this year, but third party tools are not on par yet.
I'd go with Mercurial instead. It's supposed to be similar to Git (which I never could get running because of the Windows issue) and is really easy to setup in Windows & very nice for "personal" version control systems.
Which one you decide to use depends a lot on what your needs are now and going forward. Git has a very nice community built a round it with GitHub which is great for sharing code and projects. SVN is pretty simple to setup and get going, but in large teams Git has it beat hands down with it's branching and merging. This is ideal in cases where you have multiple people working on the same project, either in an office setting or an OSS sense where the team is spread out.
If all you need is something quick and simple to setup and get going so you can start your project, SVN should be fine. SVN is also integrated into many editors and IDE's as well as many bug tracking and continuous integration systems.
If you plan on having a team, or already do, Git is worth looking at for its branching and merging setup. Git however, due largely to still being kind of young, doesn't have nearly as much support available
Let's my ride-in on your question and ask:
On a side note: If it's really a one man home project, you don't really need any source control tool. Just put your project in a DropBox folder and you're done (auto-commits, infinite revisions, undelete). Unless you really think you're going to need tags and branches and stuff. But for personal home projects... do ya?
If you want Visual Studio integration there is no question. Only Subversion has Visual Studio integrations (AnkhSVN, VisualSVN and several scripts that allow access to TortoiseSVN).
One of the most important reasons that Subversion has such a large amount of tools written for it is that it was designed as a stable library for use by multiple clients.
It's unlikely that Git gets the same level of integration in Visual Studio before git support is available as some kind of reusable library. (There are plans for a libgit2 that could make this a reality).
You can make your own opinion after reading this : http://whygitisbetterthanx.com
With SVN you will have to set up a server, create a repository there, check out the (empty) repository, add your files, and then commit.
With Git, all you need is git init in your project's root directory. Then you can add and commit files as you see fit.
There's not really any idea in setting up a Subversion server, since you're the only one working on the source. Contrary to what many people think, solo projects is a perfect match for distributed version control tools. It's also very easy to grow your project later on.
In my experience, Subversion is easier to "grok", but Git is faster and easier to engage in software development best practices. As a former CVS user, Subversion made immediate sense to me when I started using it. Git took some study and I still have to refer to the manual from time to time, but I love how easy it is to branch and merge code when I've got to maintain a release process.
If you are already familiar with CVS and just need something to keep your history and diffs, Subversion will be easier to get started with. If you are new to version control, the tide is shifting toward DVCS in general and Git in particular, so you may get more mileage out of that in general.
I do recommend you look at a hosted provider so you don't have to worry about setting up a Subversion server or so you can have a backup location for your Git data. You can Google for "subversion hosting" or "git hosting" to see the premier providers in the space.
Git................................(these dots are there because SO wont accept a 3 lettered answered).
If you plan to take your project along on an USB stick, use Subversion. Windows XP it really, really, really bad at caching lots of small files on an USB stick. Git writes many small files for commit operations and that takes ages on Windows.
[EDIT] The problem with Windows XP and files on an USB stick is caching (or the lack thereof). To prevent data loss, XP will always write files synchonously on an USB stick (so any write will come back only after the FS has reported that all blocks have been written to the stick). Add that to the fact that USB sticks are slow when handling small files (they have a lot of overhead initializing their wear level management) which leads to very poor performance for any kind of application which writes lots of small files.
[EDIT2] If you put a SVN checkout on the USB stick, you will also have a lot of small files (especially in the .svn directories). So the solution in this case is to put the Subversion repository (the "server") on the USB drive. The repository uses only a bunch of big files (if you use the database option instead of the file based one: svnadmin create --fs-type bdb). This avoids the "many little files problem". There is no way to achieve the same thing with current versions of Git.
What exactly is a first chance exception? How and where does it originate in a .Net program? And why is it called by that peculiar name (what 'chance' are we talking about)?
It's a debugging concept. Basically exceptions are thrown to the debugger first and then to the actual program where if it isn't handled it gets thrown to the debugger a second time, giving you a chance to do something with it in your IDE before and after the application itself. This appears to be a MSVS invention.
(edit: slightly wrong about the meaning of second chance it seems, edited accordingly)
First chance exception notifications are raised when an exception is thrown. Second chance notifications are when it is not caught. (Chance - as in opportunity to break into the code in the debugger).
See this explanation.
I'm from Java background, in Java program I can use System.out.println(message) to print a message to the output window, what's the equivalent in the C# .net Visual Studio ?
I know when I'm in debug mode I can use :
Debug.WriteLine("Debug : User_Id = "+Session["User_Id"]);<Br>
System.Diagnostics.Trace.WriteLine("Debug : User_Id = "+Session["User_Id"]);<Br><Br>
to see the message in the output window, but how to do it without being in the debug mode ?
The Trace messages can occur in the output window as well, even if you're not in debug mode. You just have to make sure the the TRACE compiler constant is defined.
The results are not in the Output window but in the Test Results Detail (TestResult Pane at the bottom, right click on on Test Results and go to TestResultDetails).
This works with Debug.WriteLine and Console.WriteLine.
The Trace.WriteLine method is a conditionally compiled method. That means that it will only be executed if the TRACE constant is defined when the code is compiled. By default in Visual Studio, TRACE is only defined in DEBUG mode.
Right Click on the Project and Select Properties. Go to the Compile tab. Select Release mode and add TRACE to the defined preprocessor constants. That should fix the issue for you.
Visual Studio occasionally tells me:
The line endings in the following files are not consistent. Do you want to normalize the line endings?
It then gives me a drop down with different standards or something, such as Windows, Mac, Unix, and a couple of Unicode ones.
What does this mean and what is going to happen if I click Yes?
What that usually means is that you have lines ending with something other than a carriage return/line feed pair. It often happens when you copy and paste from a web page into the code editor.
Since you're developing in Visual Studio, you'll obviously want to choose "Windows" from the drop down. :-)
Some lines end with \n
Some other lines end with \r\n
VS suggests you to make all lines end the same.
The file you are editing have been edited with some other editor that does not use the same line endings resulting in a file with mixed line endings.
The ASCII characters in use for line endings are:
CR, Carriage Return
LF, Line Feed
Windows = CRLF
Mac OS 9 or earlier = CR
Unix = LF
It means that, for example, some of your lines of text with a <Carriage Return><Linefeed> (the Windows standard), and some end with just a <Linefeed> (the Unix standard).
If you click 'yes' these the end-of-lines in your source file will be converted to have all the same format.
This won't make any difference to the compiler (because end-of-lines count as mere whitespace), but it might make some difference to other tools (e.g. the 'diff' on your version control system).
The Wikipedia article on this might help you out
There'a an add-in for Visual Studio 2008 that converts the end of line format when a file is saved. You can download it here: http://grebulon.com/software/stripem.php
It's not just VS... it'd be any tools that read the files... compilers, linkers, ... that would have to be able to handle it. In general (for software development) we accept the multiplatform line ending issue but let the version control software deal with it.
Go to
File
advanced save options
select- line endings type as -Windows
I recently had cause to work with some Visual Studio C++ projects with the usual Debug and Release configurations, but also 'Release All' and 'Debug All', which I had never seen before.
It turns out the author of the projects has a single ALL.cpp which #includes all other .cpp files. The *All configurations just build this one ALL.cpp file. It is of course excluded from the regular configurations, and regular configurations don't build ALL.cpp
I just wondered if this was a common practice? What benefits does it bring? (My first reaction was that it smelled bad.)
What kinds of pitfalls are you likely to encounter with this? One I can think of is if you have anonymous namespaces in your .cpps, they're no longer 'private' to that cpp but now visible in other cpps as well?
All the projects build DLLs, so having data in anonymous namespaces wouldn't be a good idea, right? But functions would be OK?
Cheers.
It's referred to by some (and google-able) as a "Unity Build". It links insanely fast and compiles reasonably quickly as well. It's great for builds you don't need to iterate on, like a release build from a central server, but it isn't necessarily for incremental building.
And it's a PITA to maintain.
EDIT: here's the first google link for more info: http://rant.blackapache.net/2007/12/10/the-magic-of-unity-builds/
The thing that makes it fast is that the compiler only needs to read in everything once, compile out, then link, rather than doing that for every .cpp file. It's slightly non-obvious until you realize that the compile/link cycle is usually I/O bound. That's why it's a win.
I wonder if that ALL.cpp is attempting to put the entire project within a single compilation unit, to improve the ability for the compiler to optimize the program for size?
Normally some optimizations are only performed within distinct compilation units, such as removal of duplicate code and inlining.
That said, I seem to remember that recent compilers (Microsoft's, Intel's, but I don't think this includes GCC) can do this optimization across multiple compilation units, so I suspect that this 'trick' is unneccessary.
That said, it would be curious to see if there is indeed any difference.
There is a short video presenting the built-time difference in unitybuild.
An introduction on "Unity Builds" along with benefits, disadvantages and a complete CMake integration can be found at cheind.wordpress.com.
hth, Christoph
It is a very bad smell indeed but at least the author made it a different configuration.
If everything is in a single file, it means everything needs to be compiled for every change. On projects that can take up to an hour to build, I think we can agree this is kind of a no-no.
This can also causes all kind of bad things with templates, any kind of private type or function, make static variables global, and a long list of other very nighmarish things.
At least it's in a different configuration, but that also means you will have to maintain and test this configuration.
EDIT: Didn't read the question correctly and made changes accordingly.
Definitely pathological; I can only guess at the reason why anyone might want to do that (if you, on the other hand, can ask them directly, you should). Normally in C++ you want to do the opposite, keep not only implementation files but also headers well separated. (A common trap of C++ projects being "#include spaghetti", with every header file depending on every other.) Perhaps to stress test the compiler ?
I am using a pre-build task in Visual Studio 2008 that invokes msbuild:
C:\WINDOWS\Microsoft.NET\Framework\v3.5\MSBuild.exe $(MSBuildProjectDirectory)\version.targets /p:Configuration=$(ConfigurationName)
Inside version.targets, I am updating the AssemblyInfo.cs file to replace version information:
<FileUpdate
Encoding="ASCII"
Files="$(MSBuildProjectDirectory)\Properties\AssemblyInfo.cs"
Regex="AssemblyInformationalVersion\(".*"\)\]"
ReplacementText="AssemblyInformationalVersion("Product $(ConfigurationString) ($(buildDate))")]"
/>
When I build the project through Visual Studio 2008, it builds without any problems.
But when I look at the resulting exe's version information, it contains the previous time stamp even though the AssemblyInfo.cs has been changed with the "correct" one.
It seems that the pre-build's changes aren't seen by the main compilation task and it's always one behind.
Any ideas of what I'm doing wrong?
I don't think you are doing anything wrong - it's a bug.
I have reported it here - check if you can reproduce it and add a validation, maybe we can get it fixed by MS.
EDIT: I tried the suggestion by "Si" to update the file in the "BeforeBuild" event - however I still get the same wrong result with Visual Studio 2008/SP1.
UPDATE/WORKAROUND: MS has responded to the bug report. As a workaround you can add
<UseHostCompilerIfAvailable>FALSE</UseHostCompilerIfAvailable>
to your csproj file.
+1 for the <UseHostCompilerIfAvailable>FALSE</UseHostCompilerIfAvailable> trick, although neither the accepted solution nor the linked article specified that the line should be added to the first <PropertyGroup> element in the .csproj file.
It is also a problem with Visual Studio only, as invoking msbuild from the command-line on the same .csproj file (without the trick) will see the generated code files compiled right away (and not the previous versions).
Also, I would like to recommend that this topic be tagged with the following, as I had to dig a lot to find it:
Interesting, I wrote my own custom task which is hooked into BeforeBuild and this is working fine. Never had a problem from VS or MSBuild via command line. So I would say explore BeforeBuild some more...
I know because we use our build server (CruiseControl.NET) build number as the "Build" part of the version, which is built into all assemblies (we share the same AssemblyInfo.cs for AssemblyVersion and AssemblyFileVersion across assemblies in the solution) and this is then pushed (via FileUpdate task) to a variable in our WiX project and also used to label the MSI file name.
<Target Name="BeforeBuild">
<CallTarget Targets="UpdateAssemblyInfo" />
</Target>
<Target Name="UpdateAssemblyInfo" Condition="'$(CIBuildNumber)' != ''">
<UpdateVersion Attribute="AssemblyFileVersion"
AssemblyInfo=".\Properties\AssemblyInfo.cs"
BuildNumber="$(CIBuildNumber)" />
</Target>
If you do some googling you should find other examples...sorry I can't give you the UpdateVersion code, i'd need permission from my work, but if you can't find anything suitable on the net, custom tasks are easy to write and the above should help.
Use something like below to change any content for any file. Here i am changing Build date value in hallo.aspx when every time i create a build.
e.g. Hallo.aspx content
<BuildDate> 12-23.2011 </BuildDate>
<!-- regular expression to get value between html node: "[^<>]+(?=[<])" -->
<FileUpdate Files="$(AboutDir)Hallo.aspx"
Regex="Builddate[^<>]+(?=[<])" ignoreCase="true"
ReplacementText="BuildDate: $(Day)-$(Month)-$(Year)" />
It is not documented on the web site and people seems having problem setting up the framework. Can someone please show step by step introduction to a sample project setup.
(These instructions get the testing framework working for the Debug configuration. It should be pretty trivial to apply the same process to the Release configuration.)
Get Google C++ Testing Framework
C:\gtestBuild the Framework Libraries
C:\gtest\msvc\gtest.sln in Visual StudioCreate and Configure Your Test Project
C:\gtest\includeC:\gtest\msvc\gtest\Debuggtestd.libVerifying Everything Works
main() function.#include "stdafx.h"
#include <iostream>
#include "gtest/gtest.h"
TEST(sample_test_case, sample_test)
{
EXPECT_EQ(1, 1);
}
int main(int argc, char** argv)
{
testing::InitGoogleTest(&argc, argv);
RUN_ALL_TESTS();
std::getchar(); // keep console window open until Return keystroke
}
If everything worked, you should see the console window appear and show you the unit test results.
What Arlaharen said was basically right, except he left out the part which explains your linker errors. First of all, you need to build your application without the CRT as a runtime library. You should always do this anyways, as it really simplifies distribution of your application. If you don't do this, then all of your users need the Visual C++ Runtime Library installed, and those who do not will complain about mysterious DLL's missing on their system... for the extra few hundred kilobytes that it costs to link in the CRT statically, you save yourself a lot of headache later in support (trust me on this one -- I've learned it the hard way!).
Anyways, to do this, you go to the target's properties -> C/C++ -> Code Generation -> Runtime Library, and it needs to be set as "Multi-Threaded" for your Release build and "Multi-Threaded Debug" for your Debug build.
Since the gtest library is built in the same way, you need to make sure you are linking against the correct version of it, or else the linker will pull in another copy of the runtime library, which is the error you saw (btw, this shouldn't make a difference if you are using MFC or not). You need to build gtest as both a Debug and Release mode and keep both copies. You then link against gtest.lib/gtest_main.lib in your Release build and gtestd.lib/gtest_maind.lib in your Debug build.
Also, you need to make sure that your application points to the directory where the gtest header files are stored (in properties -> C/C++ -> General -> Additional Include Directories), but if you got to the linker error, I assume that you already managed to get this part correct, or else you'd have a lot more compiler errors to deal with first.
Having built gtest, this is what I have done:
After that I just write my tests using TEST or TEST_F as appropriate and compile them together with my main function:
int main(int argc, char** argv)
{
testing::InitGoogleTest(&argc, argv);
return RUN_ALL_TESTS();
}
I did a video tutorial about the setup: http://www.youtube.com/watch?v=mzSzwQOmMRs
I got a lot of linker errors in Release. In Debug I had no problem. Where is the problem?
In Microsoft Visual Studio, misconfigured runtime library type causes link errors.
VS 2005(and 2008) uses Multithreaded DLL or Multithreaded Debug DLL as default. But Google Test library uses Mulithreaded or Mulithreaded debug runtime as default.
So, choose appropriate run time library type for google test library. (in Configuration properties -> Code Generation -> Runtime Library).
In Visual Studio and C#, when using a built in function such as ToString(), IntelliSense shows a yellow box explaining what it does.
How can I have that for functions and properties I write?
Type in /// on the line before your function and hit return It will generate the stuff required for you to fill in for that stuff to occur. In VB type '''
This will generate an area where you can specify a description for the function and each parameter for the function
What you need is xml comments - basically, they follow this syntax (as vaguely described by Solmead):
C#
///<summary>
///This is a description of my function.
///</summary>
string myFunction() {
return "blah";
}
VB
'''<summary>
'''This is a description of my function.
'''</summary>
Function myFunction() As String
Return "blah"
End Function
Those are called XML Comments. They have been a part of Visual Studio since forever.
You can make your documentation process easier by using GhostDoc, a free add-in for Visual Studio which generates XML-doc comments for you. Just place your caret on the method/property you want to document, and press Ctrl-Shift-D.
Here's an example from one of my posts.
Hope that helps :)
Do XML commenting , like this
/// <summary>
/// This does something that is awesome
/// </summary>
public void doesSomethingAwesome() {}
use /// to begin each line of hte comment and have the comment contain the appropriate xml for the meta data reader.
///<summary>
/// this method says hello
///</summary>
public void SayHello();
Although personally, I believe that these comments are usually misguided, unless you are developing classes where the code cannot be read by its consumers.
Solmead has the correct answer. For more info you can look at XML Comments.
Also the visual studio add-in ghost doc will attempt to create and fill-in the header comments from your function name.
When creating a new ASP.NET application in Visual Studio, a couple of files and folders are created automatically. One of those folders is called App_Data.
Also when publishing a website by selecting the menu option Build->Publish a checkbox is available Include files from the App_Data folder.
Am I right assuming that the files put in this file and its sub-folders are not going to be accessible through the web? For example, would it be safe to put in that folder resources that I only intend to be used by the application code?
What is the real intended use of the App_Data folder?
EDIT:
Thank you for all the answers. From the answers received so far I am interested mostly in two points mentioned:
Would someone be able specify how the "not viewable by the web" is ensured? Can I rely on that fact when performing standard deployment, or do I need to check some IIS settings on the server as well.
In the situation when I have a set of pdf files that I want to be accessible only from the application. Would App_Data folder be the right place to use, or should I create a separate folder and manually set IIS to ensure that it is not accessible by Web?
App_Data is essentially a storage point for file-based data stores (as opposed to a SQL server database store for example). Some simple sites make use of it for content stored as XML for example, typically where hosting charges for a DB are expensive.
It's a place to put an embedded database, such as Sql Server Express, Access, or SQLite.
The intended use of App_data is to store application data for the web process to acess. It should not be viewable by the web and is a place for the web app to store and read data from.
The main intention is for keeping your application's database file(s) in.
And no this will not be accessable from the web by default.
The App_Data folder is a folder, which your asp.net worker process has files sytem rights too, but isn't published through the web server.
For example we use it to update a local CSV of a contact us form. If the preferred method of emails fails or any querying of the data source is required, the App_Data files are there.
It's not ideal, but it it's a good fall-back.
The intended use for App_Data is to store database related file. Usually SQL Server Express .mdf files.
We use it as a temporary storage area for uploaded csv files. Once uploaded, an ajax method processes and deletes the file.
For a small community discussion, what are some essential Visual Studio macros you guys use? I just started learning about them, and want to hear what some of you guys can't live without.
I add buttons on the toolbar for the following 3 macros. Each will take the currently selected text in any file and google it (or MSDN-it, or spell-check-it). Make up a nifty icon for the toolbar for extra style-points.
Private Const BROWSER_PATH As String = "C:\Program Files\Mozilla Firefox\firefox.exe"
Sub SearchGoogle()
Dim cmd As String
cmd = String.Format("{0} http://www.google.com/search?hl-en&q={1}", BROWSER_PATH, DTE.ActiveDocument.Selection.Text)
Shell(cmd, AppWinStyle.NormalFocus)
End Sub
Sub SearchMSDN()
Dim cmd As String
cmd = String.Format("{0} http://www.google.com/search?hl-en&q={1}+site%3Amsdn.microsoft.com", BROWSER_PATH, DTE.ActiveDocument.Selection.Text)
Shell(cmd, AppWinStyle.NormalFocus)
End Sub
Sub SpellCheck()
Dim cmd As String
cmd = String.Format("{0} http://www.spellcheck.net/cgi-bin/spell.exe?action=CHECKWORD&string={1}", BROWSER_PATH, DTE.ActiveDocument.Selection.Text)
Shell(cmd, AppWinStyle.NormalFocus)
End Sub
Show build duration in the Output window
Put this code in your EnvironmentEvents module. This will write the duration directly to the build window for any action on a solution (build, rebuild, clean, deploy).
You can change the IsBuild function to specify the actions you want to see this information for.
Dim buildStart As Date
Private Function IsBuild(ByVal scope As EnvDTE.vsBuildScope, ByVal action As EnvDTE.vsBuildAction) As Boolean
Return scope = vsBuildScope.vsBuildScopeSolution
End Function
Private Sub BuildEvents_OnBuildBegin(ByVal Scope As EnvDTE.vsBuildScope, ByVal Action As EnvDTE.vsBuildAction) Handles BuildEvents.OnBuildBegin
If (IsBuild(Scope, Action)) Then
buildStart = Date.Now
End If
End Sub
Private Sub BuildEvents_OnBuildDone(ByVal Scope As EnvDTE.vsBuildScope, ByVal Action As EnvDTE.vsBuildAction) Handles BuildEvents.OnBuildDone
If (IsBuild(Scope, Action)) Then
Dim buildTime = Date.Now - buildStart
WriteToBuildWindow(String.Format("Build time: {0}", buildTime.ToString))
End If
End Sub
Private Sub WriteToBuildWindow(ByVal message As String)
Dim win As Window = DTE.Windows.Item(EnvDTE.Constants.vsWindowKindOutput)
Dim ow As OutputWindow = CType(win.Object, OutputWindow)
For Each owPane As OutputWindowPane In ow.OutputWindowPanes
If (owPane.Name.Equals("Build")) Then
owPane.OutputString(message)
Exit For
End If
Next
End Sub
Show the start page after you close a solution (but keep Visual Studio open)
Put this code in your EnvironmentEvents module:
Private Sub SolutionEvents_AfterClosing() Handles SolutionEvents.AfterClosing
DTE.ExecuteCommand("View.StartPage")
End Sub
Hide the start page after you open a solution
Put this code in your EnvironmentEvents module:
Private Sub SolutionEvents_Opened() Handles SolutionEvents.Opened
Dim startPageGuid As String = "{387CB18D-6153-4156-9257-9AC3F9207BBE}"
Dim startPage As EnvDTE.Window = DTE.Windows.Item(startPageGuid)
If startPage IsNot Nothing Then startPage.Close()
End Sub
These two together will cause your Start Page to hide itself when you open a solution. When you close the solution, the Start Page comes back.
I use the following lesser-known shortcuts very often:
Insert GUID, great for WiX work, add to menu as button or as key shortcut.
Sub InsertGuid()
Dim objTextSelection As TextSelection
objTextSelection = CType(DTE.ActiveDocument.Selection(), EnvDTE.TextSelection)
objTextSelection.Text = System.Guid.NewGuid.ToString.ToUpper(New System.Globalization.CultureInfo("en", False))
End Sub
Organise usings for all .cs files in a solution - Original Author: djpark.
Sub OrganizeSolution()
Dim sol As Solution = DTE.Solution
For i As Integer = 1 To sol.Projects.Count
OrganizeProject(sol.Projects.Item(i))
Next
End Sub
Private Sub OrganizeProject(ByVal proj As Project)
For i As Integer = 1 To proj.ProjectItems.Count
OrganizeProjectItem(proj.ProjectItems.Item(i))
Next
End Sub
Private Sub OrganizeProjectItem(ByVal projectItem As ProjectItem)
Dim fileIsOpen As Boolean = False
If projectItem.Kind = Constants.vsProjectItemKindPhysicalFile Then
'If this is a c# file
If projectItem.Name.LastIndexOf(".cs") = projectItem.Name.Length - 3 Then
'Set flag to true if file is already open
fileIsOpen = projectItem.IsOpen
Dim window As Window = projectItem.Open(Constants.vsViewKindCode)
window.Activate()
projectItem.Document.DTE.ExecuteCommand("Edit.RemoveAndSort")
'Only close the file if it was not already open
If Not fileIsOpen Then
window.Close(vsSaveChanges.vsSaveChangesYes)
End If
End If
End If
'Be sure to apply RemoveAndSort on all of the ProjectItems.
If Not projectItem.ProjectItems Is Nothing Then
For i As Integer = 1 To projectItem.ProjectItems.Count
OrganizeProjectItem(projectItem.ProjectItems.Item(i))
Next
End If
'Apply RemoveAndSort on a SubProject if it exists.
If Not projectItem.SubProject Is Nothing Then
OrganizeProject(projectItem.SubProject)
End If
End Sub
I use Jeff's FormatToHtml macros if I'm going to be pasting a code example into a blog post or an email.
Outlining: Collapse to definitions but expand regions
Are you working in one of those shops that insists on regions around everything, so that when you collapse to definitions, you can't see any code?
What you really need is a collapse-to-definitions-but-expand-regions macro, like this one:
Sub CollapseToDefinitionsButExpandAllRegions()
DTE.ExecuteCommand("Edit.CollapsetoDefinitions")
DTE.SuppressUI = True
Dim objSelection As TextSelection = DTE.ActiveDocument.Selection
objSelection.StartOfDocument()
Do While objSelection.FindText("#region",
vsFindOptions.vsFindOptionsMatchInHiddenText)
Loop
objSelection.StartOfDocument()
DTE.SuppressUI = False
End Sub
Put this in a regular macro module, assign it to a hot key, and your code is back.
(Except...if you work with some really nefarious individuals who put regions inside methods, this will unfortunately expand those methods. If anybody knows a way to write this to avoid that, feel free to edit.)
Collapse all nodes of the Solution panel, very useful especially for big projects:
Public Module CollapseAllNodes
Sub RunCollapseAllNodes()
Dim UIHSolutionExplorer As UIHierarchy
UIHSolutionExplorer = DTE.Windows.Item(Constants.vsext_wk_SProjectWindow).Object()
' Check if there is any open solution
If (UIHSolutionExplorer.UIHierarchyItems.Count = 0) Then
Return
End If
' Get the top node (the name of the solution)
Dim UIHSolutionRootNode As UIHierarchyItem
UIHSolutionRootNode = UIHSolutionExplorer.UIHierarchyItems.Item(1)
CloseRecursif(UIHSolutionRootNode)
' Select the solution node, or else when you click
' on the solution windows scrollbar, it will synchronize the open document
' with the tree and pop out the corresponding node which is probably not
' what you want.
UIHSolutionRootNode.Select(vsUISelectionType.vsUISelectionTypeSelect)
End Sub
Function CloseRecursif(ByRef element)
For Each UIHChild In element.UIHierarchyItems()
CloseRecursif(UIHChild)
If (UIHChild.UIHierarchyItems.Expanded = True) Then
UIHChild.UIHierarchyItems.Expanded = False
End If
Next
End Function
End Module
I work with dual monitors, and I find Sharon's layout-switching macro (from a 1 monitor to a 2 monitor layout) totally invaluable. When you need to be referencing a web page or other program while typing a bit of code, Ctrl-Alt-1 to switch to a one monitor layout for your Visual Studio windows. Once you're done, Ctrl-Alt-2 to switch to your two monitor layout and get all your windows back. Awesome!
http://www.invisible-city.com/sharon/2008/06/workstation-hack-visual-studio-on-2.html
I mapped ctrl-shift-G to a macro that generates a GUID in registry format - this is useful for editing IDL
Not a macro on its own, but useful:
Public Sub WriteToOutputWindow(ByVal pane as String, ByVal Msg As String)
Dim owPane As OutputWindowPane
Dim win As Window = DTE.Windows.Item(EnvDTE.Constants.vsWindowKindOutput)
Dim ow As OutputWindow = win.Object
Try
owPane = ow.OutputWindowPanes.Item(pane)
Catch
owPane = ow.OutputWindowPanes.Add(pane)
End Try
If Not owPane Is Nothing Then
owPane.Activate()
owPane.OutputString(Msg & vbCrLf)
End If
End Sub
I'm currently working on two different projects with different coding standards, one that uses tabs for line beginnings and another that uses spaces. This macro will toggle between which standard is used based on which environment is currently active:
Public Sub ToggleTabs()
If DTE.ActiveDocument.Language = "CSharp" Then
Dim currentSetting As Boolean = DTE.Properties("TextEditor", "CSharp").Item("InsertTabs").Value
DTE.Properties("TextEditor", "CSharp").Item("InsertTabs").Value = Not currentSetting
End If
If DTE.ActiveDocument.Language = "SQL" Then
Dim currentSQLSetting As Boolean = DTE.Properties("TextEditor", "SQL").Item("InsertTabs").Value
DTE.Properties("TextEditor", "SQL").Item("InsertTabs").Value = Not currentSQLSetting
End If
If DTE.ActiveDocument.Language = "HTML" Then
Dim currentHTMLSetting As Boolean = DTE.Properties("TextEditor", "HTML").Item("InsertTabs").Value
DTE.Properties("TextEditor", "HTML").Item("InsertTabs").Value = Not currentHTMLSetting
End If
If DTE.ActiveDocument.Language = "JScript" Then
Dim currentJScriptSetting As Boolean = DTE.Properties("TextEditor", "JScript").Item("InsertTabs").Value
DTE.Properties("TextEditor", "JScript").Item("InsertTabs").Value = Not currentJScriptSetting
End If
End Sub
I used to employ a lot of macros in VS 2002/2003. One example would be Region creation - I always like my classes to be divided into the following regions - "Private members", "Public Properties", "Public Methods" and "Private methods". So, I have a macro mapped to a shortcut key that creates these regions in any new class file.
Refactoring support in VS 2005/2008 (and the facility of adding common code snippets) as well as the use of Addins like DXCore and SlickEdit allow me to work without having to create too many macros anymore.
I couldn't let this question go without mentioning this one. It even has a video to show how to install and use it. This macro simply allows you to create the nested files in the solution explorer (like resources.resx).
Edit: Updated the link
As a long-time Visual SourceSafe user (& hater) I was discussing switching to SVN with a colleague; he suggested using Git instead, since apparently it can be used peer-to-peer without a central server (we just have a 3-developer team). I haven't been able to find anything about tools that integrate Git with Visual Studio, though - does such a thing exist? If not, can anyone report on their experiences using Git with Visual Studio?
There is a project called Git Extensions that includes add-ins for Visual Studio 2005, 2008 and 2010, as well as Windows Explorer integration. It's regularly updated and having used it on a couple of projects, I've found it very useful.
Another option is Git Source Control Provider.
I use Git with Visual Studio for my port of Protocol Buffers to C#. I don't use the GUI - I just keep a command line open as well as Visual Studio.
For the most part it's fine - the only problem is when you want to rename a file. Both Git and Visual Studio would rather that they were the one to rename it. I think that renaming it in Visual Studio is the way to go though - just be careful what you do at the Git side afterwards. Although this has been a bit of a pain in the past, I've heard that it actually should be pretty seamless on the Git side, because it can notice that the contents will be mostly the same. (Not entirely the same, usually - you tend to rename a file when you're renaming the class, IME.)
But basically - yes, it works fine. I'm a Git newbie, but I can get it to do everything I need it to. Make sure you have a git ignore file for bin and obj, and *.user.
I've looked into this a bit at work (both with Subversion and Git). Visual Studio actually has a source control integration API to allow you to integrate third party source control solutions into VS. However, most folks don't bother with it for a couple of reasons.
The first is that the API pretty much assumes you are using a locked-checkout workflow. There are a lot of hooks in it that are either way expensive to implement, or just flat out make no sense when you are using the more modern edit-merge workflow.
The second (which is related) is that when you are using the edit-merge workflow that both Subverion and Git encourage, you don't really need Visual Studio integration. The main killer thing about SourceSafe's integration with VS is that you (and the editor) can tell at a glance which files you own, which must be checked out before you can edit, and which you cannot check out even if you want to. Then it can help you do whatever revision-control voodoo you need to do when you want to edit a file. None of that is even part of a typical Git workflow.
When you are using Git (or SVN typically), your revision-control interactions all take place either before your development session, or after it (once you have everything working and tested). At that point it really isn't too much of a pain to use a different tool. You aren't constantly having to switch back and forth.
Git Source Control Provider is new plug-in that intgrates Git with Visual Studio.
Also don't miss TortoiseGIT ... http://code.google.com/p/tortoisegit/
I find that git, working on whole trees as it does, benefits less from ide integration than source control tools that are either file based or follow a checkout-edit-commit pattern. Of course there are instances when it can be nice to click on a button to do some history examination but I don't miss that very much.
The real must-do is to get your .gitignore file full of the things that shouldn't be in a shared repository. Mine generally contain (amongst other stuff) the following:
*.vcproj.*.user
*.ncb
*.aps
*.suo
but this is heavily C++ biased with little or no use of any class wizard style functionality.
My usage pattern is something like the following.
1) Code, code, code in VS.
2) When happy (sensible intermediate point to commit code, switch to git, stage changes and review diffs. If anything's obviously wrong switch back to VS and fix, otherwise commit.
Any merge, branch, rebase or other fancy SCM stuff is easy to do in git from the command prompt. VS is normally fairly happy with things changing under it, although it can sometimes need to reload some projects if you've altered the project files significantly.
I find that the usefulness of git outweighs any minor inconvenience of not having full IDE integration but it is, to some extent, a matter of taste.
The newest Release of Git Extensions supports VS 2010 now (along with 2008 and 2005).
I found it to be fairly easy to use with 2008 and the Interface seems to be the same in VS 2010.
TortoiseGit has matured and I recommend it especially if you have used TortoiseSVN.
As mantioned by Jon Rimmer, you can use GitExtensions. GitExtensions does work in Visual Studio 2005 and Visual Studio 2008, it also does work in Visual Studio 2010 if you manually copy and config the .Addin file.
The simplest solution that actually works quite well is to add the TortoiseGit commands as external tools.
Solution to adding a Git (TortoiseGit) toolbar to Visual Studio
While it is true that DVCS and Git in particular are the new hotness, it's also true that Windows is still very much "the undiscovered country" for Git.
It can be made to work, but forget about any kind of integration into the Explorer or Visual Studio.
SVN is actually pretty solid on Windows these days (TortoiseSVN + AnkhSVN + command line). If you really want to play with Git, use a blended approach. Use SVN for your shared stable repository and Git locally for experimental work and push changesets with git-svn.
How do I prevent the name of the Solution Folder in a VS project from being appended to the namespace generated for new items added to the solution folder?
Example: C# project in a VS solution Default Namespace set in C# project properties: "BigClient.Domain"
If you create a solution folder in this project called "MySpecialStuff" and then add a new class to the 'MySpecialStuff" solution folder, VS creates the new .cs file with a "BigClient.Domain.MySpecialStuff" namespace. I want to find a way to allow the namespace of the newly-added class to retain just the 'project-level' namespace of "BigClient.Domain" instead of VS appending the "MySpecialStuff" solution-folder-name to the namespace.
I seem to recall reading a blog post by someone that this was possible (either via options/settings in VS or a registry setting) but I cannot recall where or how now that I want it :)
My platform is VS 2008 if answer = different for different VS versions.
If you have ReSharper installed, on the settings for the directory (F4), set Namespace Provider to false.
Make a new class template or change Visual Studio's class template. See the MSDN documentation for how to this. In the template file you quickly see the line that inserts the 'safe' namespace name.
If you have resharper:
Right click on folder (in solution explorer) and change "Namespace Provider" to false.
Another way is to play with templates that generating the new classes.
I don't have ReSharper, and am actually having the opposite problem in VS2008: I want the nested folder names to be appended to my namespace, but Visual Studio won't do it. I create a project at ...\Documents\Visual Studio 2008\Projects\Folder1\Folder2\ProjectName or whatever, and I want the namespace to be like Folder1.Folder2.ProjectName, but it VS always makes it match the plain project name.
I've found one workaround which is to name it like \Folder1\Folder2\Folder1.Folder2.ProjectName\Folder1.Folder2.ProjectName.csproj etc. but that's pretty ugly.
I've tried using the IronPython integration extension provided by Microsoft. But it does not work with Visual Studio 2008.
Is there a proper VS 2008 IDE extension for IronPython?
For IronPython 1.1 support (whose syntax mirrors CPython 2.4), I successfully built and installed the sample from the Visual Studio 2008 SDK 1.0 with the Professional Edition of Visual Studio 2008 SP1. It will work with any edition from Standard up to Team Suite. It definitely won't work with Express Edition due to limitations built in to Express.
For IronPython 2.0 (whose syntax mirrors CPython 2.5), there is currently no good way to write and debug under Visual Studio 2008, and unfortunately, it would be a significant undertaking to adapt IronPython Studio to host IronPython 2.0--one of the big updates in IronPython 2.0 was to base it on the Dynamic Language Runtime, and this breaks the tricks for enabling IntelliSense that were used previously such as static compilation.
Have you tried the IronPython Studio for VS 2008 Shell
Right now, there is no extension to run IronPython v2.0 on Visual Studio.
I'm new to both VS2008 and IronPython (but not Python itself): but it sure looks to me like i'm running IronPython 2.0.1 under VS 2008 Pro, albeit in a rather cumbersome fashion.
The rest of the instructions worked for me: i built a simple test console app, and it worked as i expected. I haven't tried any .Net stuff yet, though.
Now if there were just an easy way to change sys.path to use the normal Python libraries ...
string code = @"100 * 2 + 4 / 3";
ScriptEngine engine = Python.CreateEngine();
ScriptSource source =
engine.CreateScriptSourceFromString(code, SourceCodeKind.Expression);
int res = source.Execute<int>();
Console.WriteLine(res);
For the complete tutorial and example code, check out the following link:
Extending your C# application with IronPython
If you are just looking at using IronPython in ASP .NET websites (projects not supported), check out how to install Microsoft ASP.NET Futures (July 2007)
Sometimes I will be at a breakpoint in my code and I want to view the contents of a datatable variable (or a datatable in a dataset). The quick watch doesn't give you a very clear view of the contents. How can I view them easily?
The Visual Studio debugger comes with four standard visualizers. These are the text, HTML, and XML visualizers, all of which work on string objects, and the dataset visualizer, which works for DataSet, DataView, and DataTable objects.
To use it, break into your code, mouse over your DataSet, expand the quick watch, view the Tables, expand that, then view Table[0] (for example). You will see something like {Table1} in the quick watch, but notice that there is also a magnifying glass icon. Click on that icon and your DataTable will open up in a grid view.
I've not tried it myself, but Visual Studio 2005 (and later) support the concept of Debugger Visualizers. This allows you to customize how an object is shown in the IDE. Check out this article for more details.
http://davidhayden.com/blog/dave/archive/2005/12/26/2645.aspx
Give Xml Visualizer a try. Haven't tried the latest version yet, but I can't work without the previous one in Visual Studio 2003.
on top of displaying DataSet hierarchically, there are also a lot of other handy features such as filtering and selecting the RowState which you want to view.
public static void DebugDataSet ( string msg, ref System.Data.DataSet ds )
{
WriteIf ( "===================================================" + msg + " START " );
if (ds != null)
{
WriteIf ( msg );
foreach (System.Data.DataTable dt in ds.Tables)
{
WriteIf ( "================= My TableName is " +
dt.TableName + " ========================= START" );
int colNumberInRow = 0;
foreach (System.Data.DataColumn dc in dt.Columns)
{
System.Diagnostics.Debug.Write ( " | " );
System.Diagnostics.Debug.Write ( " |" + colNumberInRow + "| " );
System.Diagnostics.Debug.Write ( dc.ColumnName + " | " );
colNumberInRow++;
} //eof foreach (DataColumn dc in dt.Columns)
int rowNum = 0;
foreach (System.Data.DataRow dr in dt.Rows)
{
System.Diagnostics.Debug.Write ( "\n row " + rowNum + " --- " );
int colNumber = 0;
foreach (System.Data.DataColumn dc in dt.Columns)
{
System.Diagnostics.Debug.Write ( " |" + colNumber + "| " );
System.Diagnostics.Debug.Write ( dr[dc].ToString () + " " );
colNumber++;
} //eof foreach (DataColumn dc in dt.Columns)
rowNum++;
} //eof foreach (DataRow dr in dt.Rows)
System.Diagnostics.Debug.Write ( " \n" );
WriteIf ( "================= Table " + dt.TableName + " ========================= END" );
WriteIf ( "===================================================" + msg + " END " );
} //eof foreach (DataTable dt in ds.Tables)
} //eof if ds !=null
else
{
WriteIf ( "NULL DataSet object passed for debugging !!!" );
}
} //eof method
public static void WriteIf ( string msg )
{
//TODO: FIND OUT ABOUT e.Message + e.StackTrace from Bromberg eggcafe
int output = System.Convert.ToInt16(System.Configuration.ConfigurationSettings.AppSettings["DebugOutput"] );
//0 - do not debug anything just run the code
switch (output)
{
//do not debug anything
case 0:
msg = String.Empty;
break;
//1 - output to debug window in Visual Studio
case 1:
System.Diagnostics.Debug.WriteIf ( System.Convert.ToBoolean( System.Configuration.ConfigurationSettings.AppSettings["Debugging"] ), DateTime.Now.ToString ( "yyyy:MM:dd -- hh:mm:ss.fff --- " ) + msg + "\n" );
break;
//2 -- output to the error label in the master
case 2:
string previousMsg = System.Convert.ToString (System.Web.HttpContext.Current.Session["global.DebugMsg"]);
System.Web.HttpContext.Current.Session["global.DebugMsg"] = previousMsg +
DateTime.Now.ToString ( "yyyy:MM:dd -- hh:mm:ss.fff --- " ) + msg + "\n </br>";
break;
//output both to debug window and error label
case 3:
string previousMsg1 = System.Convert.ToString (System.Web.HttpContext.Current.Session["global.DebugMsg"] );
System.Web.HttpContext.Current.Session["global.DebugMsg"] = previousMsg1 + DateTime.Now.ToString ( "yyyy:MM:dd -- hh:mm:ss.fff --- " ) + msg + "\n";
System.Diagnostics.Debug.WriteIf ( System.Convert.ToBoolean( System.Configuration.ConfigurationSettings.AppSettings["Debugging"] ), DateTime.Now.ToString ( "yyyy:MM:dd -- hh:mm:ss.fff --- " ) + msg + "\n </br>" );
break;
//TODO: implement case when debugging goes to database
} //eof switch
} //eof method WriteIf
What I do is have a static class with the following code in my project:
#region Dataset -> Immediate Window
public static void printTbl(DataSet myDataset)
{
printTbl(myDataset.Tables[0]);
}
public static void printTbl(DataTable mytable)
{
for (int i = 0; i < mytable.Columns.Count; i++)
{
Debug.Write(mytable.Columns[i].ToString() + " | ");
}
Debug.Write(Environment.NewLine + "=======" + Environment.NewLine);
for (int rrr = 0; rrr < mytable.Rows.Count; rrr++)
{
for (int ccc = 0; ccc < mytable.Columns.Count; ccc++)
{
Debug.Write(mytable.Rows[rrr][ccc] + " | ");
}
Debug.Write(Environment.NewLine);
}
}
public static void ResponsePrintTbl(DataTable mytable)
{
for (int i = 0; i < mytable.Columns.Count; i++)
{
HttpContext.Current.Response.Write(mytable.Columns[i].ToString() + " | ");
}
HttpContext.Current.Response.Write("<BR>" + "=======" + "<BR>");
for (int rrr = 0; rrr < mytable.Rows.Count; rrr++)
{
for (int ccc = 0; ccc < mytable.Columns.Count; ccc++)
{
HttpContext.Current.Response.Write(mytable.Rows[rrr][ccc] + " | ");
}
HttpContext.Current.Response.Write("<BR>");
}
}
public static void printTblRow(DataSet myDataset, int RowNum)
{
printTblRow(myDataset.Tables[0], RowNum);
}
public static void printTblRow(DataTable mytable, int RowNum)
{
for (int ccc = 0; ccc < mytable.Columns.Count; ccc++)
{
Debug.Write(mytable.Columns[ccc].ToString() + " : ");
Debug.Write(mytable.Rows[RowNum][ccc]);
Debug.Write(Environment.NewLine);
}
}
#endregion
I then I will call one of the above functions in the immediate window and the results will appear there as well. For example if I want to see the contents of a variable 'myDataset' I will call printTbl(myDataset). After hitting enter, the results will be printed to the immediate window
If I paste something like
<asp:DropDownList ID="DropDownListExpirationDate" runat="server" />
onto an ASPX file that already has a DropDownListExpirationDate control, it will rename the newly-pasted control as DropDownList1.
<asp:DropDownList ID="DropDownList1" runat="server" />
I'd rather it didn't. I'd rather is just paste exactly what I copied.
Is there a way to disable this feature?
After a quick check(!)....
Tools > Options > Text Editor > HTML > Miscellaneous
Uncheck 'Auto ID elements on paste in Source view'.
We are switching over to SVN+Jira+VS2008 for our .NET development. Are there any plugins for Visual Studio that allow to work with Jira directly from the IDE? It would be great if it could be integrated with SVN support (we use AnkhSVN for now), although it's probably too much to ask. Google did not yield much, only some mailing lists which were mostly about other topics.
Atlassian has published a free connector for Visual Studio. It's available from the plugin exchange website : https://plugins.atlassian.com/plugin/details/19493
The JIRA-VSTD integration already exists; I just found it yesterday.
Check this out. It's a commercial product by ALM Works.
I havent personally tried it myself, but in the process of obtaining it.
You may also want to look here now:
I only found that one here. It is unfinished - but maybe starting point... And while you're at it, you might want to try this lib with Jiras Xml-Rpc. Maybe a poor mans Visual Studio Pluign isn't all that difficult to write?!
I'm trying to define a 1:1 association between two entities (one maps to a table and the other to a view - using DefinedQuery) in an Entity Framework model. When trying to define the mapping for this in the designer, it makes me choose the (1) table or view to map the association to. What am I supposed to choose? I can choose either of the two tables but then I am forced to choose a column from that table (or view) for each end of the relationship. I would expect to be able to choose a column from one table for one end of the association and a column from the other table for the other end of the association, but there's no way to do this. Here I've chosen to map to the "DW_ WF_ClaimInfo" view and it is forcing me to choose two columns from that view - one for each end of the relationship.
I've also tried defining the mapping manually in the XML as follows:
<AssociationSetMapping Name="Entity1Entity2" TypeName="ClaimsModel.Entity1Entity2"
StoreEntitySet="Entity1">
<EndProperty Name="Entity2">
<ScalarProperty Name="DOCUMENT" ColumnName="DOCUMENT" />
</EndProperty>
<EndProperty Name="Entity1">
<ScalarProperty Name="PK_DocumentId" ColumnName="PK_DocumentId" />
</EndProperty>
</AssociationSetMapping>
But this gives: Error 2010: The Column 'DOCUMENT' specified as part of this MSL does not exist in MetadataWorkspace. Seems like it still expects both columns to come from the same table, which doesn't make sense to me.
Furthermore, if I select the same key for each end, e.g.:
<AssociationSetMapping Name="Entity1Entity2" TypeName="ClaimsModel.Entity1Entity2"
StoreEntitySet="Entity1">
<EndProperty Name="Entity2">
<ScalarProperty Name="DOCUMENT" ColumnName="PK_DocumentId" />
</EndProperty>
<EndProperty Name="Entity1">
<ScalarProperty Name="PK_DocumentId" ColumnName="PK_DocumentId" />
</EndProperty>
</AssociationSetMapping>
I then get:
Error 3021: Problem in Mapping Fragment starting at line 675: Each of the following
columns in table AssignedClaims is mapped to multiple conceptual side properties:
AssignedClaims.PK_DocumentId is mapped to
<AssignedClaimDW_WF_ClaimInfo.DW_WF_ClaimInfo.DOCUMENT,
AssignedClaimDW_WF_ClaimInfo.AssignedClaim.PK_DocumentId>
What am I not getting?
You have to select the table, that cotains the foreign key. The next step is to remove that foreign key from the entity, as it is already expressed using the relation you just created.
Example:
table A
-------
A_ID int
B_ID int
table B
-------
B_ID int
In this case, you would select the table A in the designer, as it contains the foreign key. Also you'll need to remove B_ID from the A entity afterwards.
Thanks driAn. This is getting me closer. The problem is that the foreign key (e.g. A.B_ ID) is also the primary key of the table, and if I delete it from the entity (A) I get another error:
Error 159: EntityType 'ClaimsModel.DW_WF_ClaimInfo' has no key defined.
Define the key for this EntityType.
Can a property serve as both the primary key for an entity and a foreign key to another entity? If so, how?
I was dealing with a legacy app so adding an additional primary key was not an option for me. What I had to do was map it as a 1:(0 or 1) rather than a 1:1 to get it to work. For example if I had two tables say Customer and CustomerDetails that both had a primary key called CustomerID. To create the association, I had to set it up as 1 Customer can relate to (0 or 1) CustomerDetails records. Eveytime you Insert a Customer, make sure to also insert the CustomerDetails so you can maintain the 1:1.
I agree that the way this is set up seems counter-intuitive. For anyone that is too slow (like me) to get driAn's answer: Per the forum post below, I remembered that we are dealing with an entity, not a table directly. The association is on the entity (which could model the table, but doesn't have to).
The entity framework is associating PROPERTIES to TABLE COLUMNS. That is why we must delete the "foreign key" PROPERTY on the ENTITY (note: we are not deleting the table column). To reference the column in code, (using the ENTITY modeling the given example of TABLE A & TABLE B) you would write something like this:
variable_A = tableAs.A_ID
variable_B = tableAs.tableBs.B_ID
The second assignment is using the association defined in the entity to get to the data. There is no PROPERTY called "B_ID" on table A.
That is all assuming I understand it right :). It is at least intelisensing correctly for me now.
:-Dan
first create foriegn key in the database and then create association or update model from database
In Entity Framework, there should be no foreign keys in the conceptual design. I believe this is now allowed in EF4 (with some tweaking), but in EF3.5, it can't be done.
To fix this, simply delete all properties which represent foreign keys in the EF-designer. Do not delete the primary keys!
If you then get an "Association end is not mapped.." error, see (my answer to) this post.
I received the same error when I tried to do a one-to-one between two tables joined on their primary keys. (No, I didn't design the db). So, the solution of deleting the FK doesn't work - the FK is also the PK, so you are not going to delete it. As an experiment, I changed one side of the association to 0..1, and lo and behold, the model compiled w/o errors. I was using EF3.5
In simple terms I did the following:
In XAML metadata code, Parent Entity having PK will show up the child view Entity, that can be associated to bind the items.
Not shure to have the answer, but with Entity Framework, I always create a primary key in each table (even if I don't need it). Example :
I have the following configuration file for NHibernate:
<?xml version="1.0" encoding="utf-8" ?>
<hibernate-configuration xmlns="urn:nhibernate-configuration-2.2">
<session-factory>
<property name="connection.connection_string">Server=.\SQLEXPRESS;Database=mydb;Integrated Security=True;</property>
<property name="dialect">NHibernate.Dialect.MsSql2005Dialect</property>
<property name="connection.provider">NHibernate.Connection.DriverConnectionProvider</property>
<property name="connection.driver_class">NHibernate.Driver.SqlClientDriver</property>
<property name="connection.release_mode">auto</property>
<property name="adonet.batch_size">500</property>
<property name="show_sql">true</property>
</session-factory>
</hibernate-configuration>
But the SQL doesn't show in the output window of Visual Studio. Is it mandatory to install log4net? Or should show_sql work alone?
To show the SQL in the output window of Visual Studio, configure log4net to use TraceAppender in your log4net config. This:
<appender name="DebugSQL" type="log4net.Appender.TraceAppender">
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%date [%thread] %-5level %logger [%property{NDC}] - %message%newline" />
</layout>
</appender>
Then this:
<logger name="NHibernate.SQL" additivity="false">
<level value="DEBUG" />
<appender-ref ref="DebugSQL" />
</logger>
EDIT: I can't seem to format this correctly here. See this link for code example
show_sql outputs to Console.Out - it's most useful when running integration tests
There is something called NHibernate profiler you can use.
it's pricey but it works and it has a 30 day trial.
Is there any sort of plug-in or tool available for Visual Studio 2008 to alphabetize methods? Ideally I'd like a tool that will alphabetize a selection, or specified type (i.e. only methods, not member variables), either automatically or on-demand.
Thanks!
Resharper has a Type Members Layout, which can order members by type, accessibility and alphabetically as well.
You can also take a look into Ora, which presents a pane in visual studio that is ordered (even though your source may not be).
You can create such a function yourself using Devexpress' free DXCore product (the same extensibility framework used to create CodeRush).
For C# you can use Regionerate to organize your code. You can create a template that simply organizes your code but doesn't use regions.
Assuming that you mean alphabetize them in the source code file; No, there is not. And I don't really think that would be a good thing, as most procedures are organized via different means.
However, I believe in Visual Studio, the drop-down on the right for the most part alphabetizes them. Also, in the Object Browser of Visual Studio, I believe they are mostly alphabetized.
What Subversion plugins exist for Visual Studio?
Visual Studio Plugins
Visual Basic 6 Plugin
Microsoft Source Code Control (SCC) SVN API Provider
Related topic:
AnkhSVN is the (free) weapon of choice.
It has made a considerable progress recently, when it was rehauled from VS add-in into full blown VS source control provider, thus providing seamless integration in the same way SourceSafe is available in VS. I was very happy to see that happen!
I've use Visual SVN at work and am a big fan of it, but it's a pay tool ($49). It's basically Tortoise SVN integration inside of Visual Studio with some more bells and whistles like visual indicators on which files have changed and which portions of a file have changed since last commit.
I've used AnkhSVN as well (briefly) and my preference is for Visual SVN, but Ankh is free and gets the job done without costing you anything.
EDIT: Just visited the AnkhSVN website. The project has progressed a lot since I used it. So it looks to me like VisualSVN and Ankh are on equal footing these days. The only thing that would keep me from switching now is that I'm too used to the Tortoise SVN icons (Visual SVN uses the same ones). ;)
AnkhSVN has worked very well for me in the past.
there's several:
I always felt TortoiseSVN isn't as good as either subclipse or ankhSVN. I've had some bad experiences with Tortoise initially - mainly usability and interface issues. Ankh is far better than what it was sometime back.
I like the Agent SVN plug-in. It works for me.
you can it create manually just google it: visual+studio+tortoisesvn for example, http://blog.vorpal.cc/category/development/tortoisesvn-in-visual-studio.html
AnkhSVN didn't work on my PC. Don't know why. So i am using VisualSVN. Works fine for me.
There are a couple of commercial plug-ins I saw mentioned in this answer that you might consider:
The first can be used free for 30 days. To continue using it beyond that time, it's $27 per copy.
The second is free and fully-functional, with the "this is an evaluation" pop-up. To get rid of that, register it for $9.99.
TUsvnAddIn - Free open source TortoiseSVN addon for Visual Studio 2005/2008/2010. It gives you TortoiseSVN access within visual studio.
I now have web site to my Tortoise SVN addin for visual studio (TUsvnAddIn). It is located here: http://www.visualstudioaddin.com/
I've decided I want to get more into native code development with C++. I'm trying to decide if I would be better served using CodeGear C++ Builder 2009 or Visual Studio 2008. I currently use Delphi 2007, so I'm very comfortable with C++ Builder's IDE (its the same as Delphi), as well as the VCL and RTL.
I've never been a big fan of MFC (from the first time I played around with it in the VS 6.0 days), but haven't taken a close look at it since then.
I'm interested in hearing from some experts that have experience with both IDE's, whether they are the most recent versions or not.
Right now, I'm leaning towards C++ Builder because I believe the VCL is much more robust and easier to work with than MFC --- but as I said, it's been a while since I've used MFC. I'm not interested in building programs that rely on the .NET Framework because I'm partly teaching myself native development. Is MFC still king for Windows C++? Or is WTL or ATL the big thing?
Any C++ gurus out there want to share their opinions?
EDIT: I understand MFC is not the only gui toolkit for Visual Studio. However, I'm looking for some recommendations based on GUI toolkit + IDE. For C++ Builder, there is only 1 real option, which is C++ Builder + the VCL. For VS 2008, it's VS + MFC/ATL/WTL/QT....confusing for me since I don't know much about them.
Visual Studio and MFC are not the same. I use Studio all the time and I avoid MFC like the plague. You can use WTL, ATL, Win32 or any number of libraries to create apps without MFC.
Coming from Delphi, you'll find the VCL straightforward to use with C++ Builder. There are a few oddities, like C++ doesn't hide the fact that TObjects are all really pointers (which Delphi hides from you), and some things like array properties are accessed differently.
Two or three years back, I was looking for any way out of C++Builder, but now, with recent releases (and Embarcadero's purchase of Codegear), I'm happy with the product and the direction.
You'll find the number of string types and the assorted potential incompatibilities quite painful with C++Builder, but you'll get used to it! (std::string, char[], wchar_t[], TCHAR, AnsiString, WideString, UnicodeString and String to name a few)
Personally I'd vote for C++ Builder - because of two-way RAD and the VCL, although it may not be the best way of learning modern C++ idioms.
The simple answer is that for pure C++ development it has to be VC++.
To expand: as a pure C++ development environment you simply cannot beat VC++, the debugger is better, the IDE is superior (all IMHO, of course). I've used it to develop libraries that I then use from C++Builder because of these reasons.
However once you start into UI development, or anything that you can solve using the VCL or components C++B is the better choice. Compared to the VCL, MFC or ATL are horrible by comparison, and so that leaves you to use .NET, which is probably a better option, but not
I'm not sure that I'd recommend building a new product using C++B or Delphi based on the last few years of 'direction' from the vendors. However that appears to be changing for the better, but until a little more time has passed it is hard to tell how the promises translate into reality.
If you're doing pure C++ development on Windows then it's hard to beat VS. The compiler is fast, quite standards-conforming and produces well optimised code. The debugger is the best on any platform. The IDE is OK.
It's also clearly the most widely-supported compiler toolchain on Windows. Download any open-source project/library and, if Windows is supported, it's likely to have been built and tested using VS. Its popularity also ensures that it's the most useful to have on a resume.
What does Builder give you? A reasonable GUI library. Well, that's good but there are many other decent GUI toolkits out there (wxWidgets, GTK, Qt etc). Many are open source and cross-platform.
However, these days I find it better to restructure my applications to provide an API and then build the GUI on top of it in a different language. C++'s strength is not in GUI development. At least not today...
I'd choose - and recommend - VS over Builder.
I haven't used C++ Builder for years but on the topic of C++ debugging, Visual Studio 2008 is way out in front of other IDEs and previous VS especially if you use STL containers as it makes it very easy to inspect their content.
However, on the GUI side, C++ is now very much a second-class language for Microsoft. The way of the future is WPF and C++ is not supported as a XAML-friendly language: We will continue investing in C++/CLI to enable developers to expose native C++ assets to the managed world and vice versa. We believe that pure .NET development is done best using a .NET focused language such as C# or VB. Investing in C++/CLI will be mainly in the native-managed interop areas.
So, to create a modern-looking C++ GUI, your best option may indeed be VCL - if VCL continues to make such possible ;-)
I second going for C++ Builder, given that you already know Delphi. MFC has not changed much since the VS6 days, so code written using MFC still looks like shit. However, VS has changed and is now quite a good IDE.
Also, keep in mind that C++ Builder is not stable as a product line. There have times in the past where it was not maintained/its future was not clear etc. So you're taking a chance if you want to build something that lasts.
Just for the hell of it, can we throw in eclipse to the mix as well?
I just found working in eclipse to be better than working in visual studio.
Unless you are using VS2008 with winforms, the gui support is through windows templates (typically from resources) which is old hat and you probably don't want to use. So the gui support in VS2008 isn't that special.
As for gui toolkit, perhaps see What is a good GUI/widgets toolkit
Well, you can use Eclipse + MinGW + Qt4 + QT Eclipse Integration and you get all of the stuff: debugger, visual GUI designer, etc.
Mind that Qt4 is dual licensed: Open Source and commercial license.
Also you can combine Qt4 with Visual Studio (even with Express) and use all goodnes VS gives you.
For me Qt4 is the way to go and VS over Builder.
I loved C++ Builder a couple of years ago. It was fantastic. It was a way better with its VCL than VS with its crappy MFC. Then things have been changing with every year.
Builder has been going down; 1. Builder hasn't been updated with any real functionality. 2. Borland abandoned the idea of rewriting VCL in C++ for use with Kylix and Builder 3. CodeGear mess and uncertain future of Builder put many people off the product.
VS has been getting better; 1. IDE has been improved a lot 2. Compiler from the least standard-compliant one on windows platform became the most standard-compliant (not counting GCC on MinGW of course) 3. .NET emerged and there was Managed C++ and then C++/CLI to make it possible to use this framework from within C++
We got new, strong players 1. Eclipse 2. Qt Creator
and new GUI toolkits
To summarize; Builder is dead because Borland
When it comes to windows development nothing really tops Visual Studio. It is very feature rich and has an excellent debugger, not to mention the vast community of users to help you with any problems you may encounter. If a company's development tools for their own operating system weren't the best for it, I'd fear their status in the software world. But if you don't need the extra features and absolutely need a RAD tool with drag & drop (besides MFC) C++ builder isn't too far behind. Using the delphi environment prior is just an advantage for you.
C++ Builder is far superior than MS-VS when it comes to UI based development and Database oriented application. MFC sucks!! However VS has better debugging capabilities.
The one thing about last C++ Builder by CodeGear - I mean 2009 version - is that its updates can really make you hate this IDE.
After having installed the 2nd update, I found out that if/else block DOESNOT WORK PROPERLY. It can enter IF statement but cannot enter else one - and it doesnot depend on the situation - this language instruction simply stopped work at all. The time it took me to figure it out was about two or three hours - and I started to develop the needed win32 app in VS, I consider it is more reliable than the CodeGear product. The 2nd feature I dislike that you can`t switch off Unicode support and have to use ANSI versions of win32 functions EXPLICITLY (e.g. SendMessageA(...)) which is very boring. I barely meet the deadline to finish the job using VS2008.
It s just my experience, the choice to make is yours
i've added a reference to the log4net assembly dll to my project.
When i build i get a warning saying:
Warning Assembly 'Lib\log4net.dll' is incorrectly specified as a file.
i look up the help for this error on MSDN, and it says:
This warning is generated during application manifest generation when the build process detects that a file reference is actually a (managed or native) assembly.
This is exactly what i'm doing; the file reference is an assembly. What am i being told here?
How do i add a reference to an assembly dll, while not adding a reference to an assembly dll?
Try setting the Build Action property of the source DLLs to None. It solved the issue for us.
It sounds like VisualStudio is assuming you have a file reference (like a .txt or .bmp) instead of an assembly reference. In the File Type property of your reference, does it show "Assembly" or something else?
Is this a Windows app, service, or website?
I was running into this problem myself.
This is what worked for me:
I had added an assembly as a reference and as an "Existing Resource." Deleting the file from the Solution Explorer, closing, then reopening the project worked.
The author says don't call the folder "Includes" that contains the dll.
In my case the folder is called "Lib" (which is what the author renamed his folder to make it work)
The author said renaming the folder to libs didn't work, he goes on to say the the actual fix was to set the build action to none and copy if newer for each of the dll?s generating this warning.
You have added this file to Includes beforehand and the reference to it is still in the Manifest? Can you add the file with a different name into a new folder 'foo'?
I have moderate size solution in Visual Studio which takes around 5 minutes to build (It take that long because of FxCop and other post build steps). My problem is, Visual Studio stops responding while it's building. You can't continue working as VS almost hangs. I tried using two VS instances, just using one for build, but it keeps crashing every now and then.
My question is, How to not waste time looking at Visual Studio building your large/moderate project. Are there any best practices for this?
Two excellent MSBuild tips I just learned yesterday...
You can run tasks in parallel by using the /m:n switch where n is the number of processors to use. All you have to do is set BuildInParallel on your MSBuild task.
The other trick is that if you have several <exec /> tasks to run you can actually run them in parallel too by calling <exec command="sleep 10|sleep 10|sleep 20" /> by using the pipe character between each command. A more practical example:
<CreateItem Include="server1;server2;server3;server2">
<Output ItemName="IISServer" TaskParameter="Include"/>
</CreateItem>
<CreateProperty Value="@(IISServer->'iisreset.exe /start %(Identity)', '|')">
<Output TaskParameter="Value" PropertyName="IISServerStartAll" />
</CreateProperty>
<exec command="$(IISServerStartAll)" />
What other post build tasks have you put in place ?
Use Incredibuild if you have more than one computer or setup this program to another friends at work. it is easy to setup and use. speed up is linear for compiling.
it is also good for multicore cpu's bacause normally vs uses one core for one project but incredibuild make it parallel for each .cpp file...
try and see.. :)
You might consider a dedicated build machine using MSBuild. From there, you'd be able to continue working while compiling. It does make it more complicated, though, as you're introducing networking issues.
You can create classes in another project by stubbing the classes that you would need to make the code compiles. This way, you can test and document your new code. After this, you just include it to the real project and you compile "for real". By the time it compiles, you are already working on another snippet of the project because you are 95% it will successfully compiles. Or, by the time it compiles, you can also write your unit tests..
Does anyone know of any good tools/utilities for managing Web.Config files between different build/deployment environments?
For example, I have a WCF project that in development I don't want to enable SSL, but I do want it enabled in production. I want different logging settings, different DB connection strings, different error handling, different file paths... Even some different Unity framework bindings (wire up mocks for unit testing instead of the real objects for deployment).
Maintaining individual copies of the Web.Config is a pain, because adding a new web service means editing multiple files and keeping them in sync.
I've also noticed that if you muck with the Web.Config too much by hand, Visual Studio will choke if you try to use the "add item" wizard to, say, add a new Web Service for WCF, since it has to modify the Web.Config to add the endpoint,a nd can't parse it any more. So I have to be careful not to invalidate the existing Web.Config.
I also thought about just using some regex to do replacements and just building a new Web.Config in a pre-build command. That seems like the best option so far...
Any other ideas? It seems like this should be a very common issue, since the Web.Config should probably never be the same between development and production deployments.
Update:
I decided to write a quick console app that will take all the xml files in a given directory and merge them into one, and only include certain files based on the name.
So I can make in a directory:
WebConfig_All
<configuration>
<configSections>
...
</configSections>
<system.web>
...
</system.web>
</configuration>
connectionStrings_Debug
<configuration>
<connectionStrings>
<add name="connstr" connectionString="...dev..." />
</connectionStrings>
</configuration>
connectionStrings_Release
<configuration>
<connectionStrings>
<add name="connstr" connectionString="...prod..." />
</connectionStrings>
</configuration>
Then run my command line tool, and pass in the configuration (Debug, Release, custom...) And it will merge all the files that end in "All" or "<configuration>".
So now I have 80% of my Web.Config in a single WebConfig_All file,a nd the 20% custom stuff in seperate files per build configuration. I can then run my command line tool as a pre-build task in VisualStudio, or from NAnt, or wherever I want...
I also made my XML merge logic good enough to handle stuff like:
<x>
<y a="1">
<z a="1"/>
</y>
</x>
merge with
<x>
<y a="1">
<z a="2"/>
</y>
<y a="2"/>
</x>
results in:
<x>
<y a="1">
<z a="1"/>
<z a="2"/>
</y>
<y a="2"/>
</x>
Looking good so far... :)
We split out all region specific settings into thier own config file. Under the root of the web app we create a config folder and place the region specific settings there. So whatever files are living under the root of config will get picked up.
our web.config looks something like:
.
.
.
<appSettings configSource="config\appSettings.config"/>
<nlog configSource="config\nlog.config"/>
<applicationSettings>
<MyApp.UI.Properties.Settings configSource="config\Settings.APGUI.config"/>
<MyApp.BusinessServices.Properties.Settings configSource="config\Settings.Business.config"/>
<MyApp.Auditing.Properties.Settings configSource="config\Settings.Auditing.config"/>
</applicationSettings>
.
.
.
So if we are deploying to the release region the build tool will just have an action to replace the files in the root of config with the files from the appropriate region folder. The file structure looks something like:
ADDED: This is how the source control structure looks, the deployed app would just have the config dir with no sub folders or course
\Root
web.config
\Config
appsettings.config
services.config
logging.config
\release
appsettings.config
services.config
logging.config
\debug
appsettings.config
services.config
logging.config
It is pretty clean and supported by any automated build tool(copying/replacing files). The nice side affect is that developers can create different flavors and keep them under source control without affecting the "real" configs.
You could use Build Events to manage your web configs. Hanselman has a good article about it.
Basically you have all your different web.configs in the solution you then create (some) new build types. Depending on the build type you run a web.config is copied over the referenced one!
You want the XmlMassUpdate task in MSBuildCommunityTasks (does what you're trying to do with your xml console app)
http://msbuildtasks.tigris.org/
use it like this
<XmlMassUpdate Condition=" '@(ConfigTemplateFile)'!='' And '@(ConfigSubstitutionsFile)'!=''"
ContentFile="@(ConfigTemplateFile)"
SubstitutionsFile="@(ConfigSubstitutionsFile)"
MergedFile="@(ConfigFile)"
ContentRoot="/configuration"
SubstitutionsRoot="/configuration/substitutions/$(Configuration)"/>
I use this tool: xmlpreprocess
we maintain separate 'property' files for each environment that are merged in by the deployment script.
I like to use a build task to automate changing the config file for the desired environment.
I use the method explained by Scott Hanselman (he explains it much better than I can reproduce this so follow the link :) ) It has worked fine for me...
I have traditionally used the multiple web.configs as you mentioned. It can be a pain but it is mitigated by file compare tools such as BeyoneComapare2 or KDIff...
Annoyance:
I mentioned my little cmd line app to merge XML docs in my 1st update... Well to do that I just use XmlDocument, and eventually just .Save() it to an FileStream.
Unfortuantely, the nodes aren't really in any particular order, and apparently, .NET requires the <configSections> element be the 1st child of the document.
I thought all these fancy tools were supposed to make programming life easier?
We use tags in our config files, that are replaced at build time to reflect the intended deployment environment. I've been inspired by Lavablast blog
It's nice to have only one template config file to manage.
The drawback is that you can't easily have custom "sections".
How do I set a path for dll's to be searched in Visual Studio for a particular project alone. Now I am setting it in environment path variable, but I would like better control over this.
You have a couple of options:
Search MSDN for "How to: Set Environment Variables for Projects". (It's Project>Properties>Configuration Properties>Debugging "Environment" and "Merge Environment" properties for those who are in a rush.)
The syntax is NAME=VALUE and macros can be used (for example, $(OutDir)).
For example, to prepend C:\Windows\Temp to the PATH:
PATH=C:\WINDOWS\Temp;%PATH%
Similarly, to append $(TargetDir)\DLLS to the PATH:
PATH=%PATH%;$(TargetDir)\DLLS
If you only need to add one path per configuration (debug/release), you could set the debug command working directory:
Project | Properties | Select Configuration | Configuration Properties | Debugging | Working directory
Repeat for each project configuration.
Set the PATH variable, like you're doing. If you're running the program from the IDE, you can modify environment variables by adjusting the Debugging options in the project properties.
If the DLLs are named such that you don't need different paths for the different configuration types, you can add the path to the system PATH variable or to Visual Studio's global one in Tools | Options.
I'm developing an ASP.NET site off of my Windows XP IIS Installation, and whenever I tell visual studio to attach-to-process to the aspnet_wp.exe it starts a new instance of asp.net development server. Is there a way to make it not start asp.net development server since I don't need it to launch anything?
If you want to turn that off all you have to do is change the settings on the project file (using f4 to show the property grid). There is an option that says Always Start When Debugging, set that to false and you should be fine.
If you right-click the web project and select Properties, there is a Web tab. On there you can select the Server to use when debugging, by default it is set to the Visual Studio Development Server. You probably want to use the Local IIS Web Server instead.
If you want to attach to the IIS worker process then you need to attach to w3wp.exe.
I'm considering using SVN for my .net projects, and I'd like to know what plugins are available for integrating the source control capabilities directly into the IDE.
I already know about :
Visual SVN, which seems great but is not free. Is anyone using it?
AnkhSVN, which is free but I've heard it's a bit buggy. Is anyone using it? are you experiencing problems? Edit: The 2.0 version is a complete rewrite and seems to solve the problem I've heard about (which were related to the 1.x versions)
Edit : TortoiseSVN + Mindscape's FileExplorer VS Extension, which is not a real IDE integration but somewhat eases the use of TortoiseSVN from Visual studio
Edit : I've found a few comparison posts between AnkhSVN and VisualSVN here, here and here.
I've used AnkhSVN for the past year and I've never had a problem with it. I switch between that and TFS and some of the times I think I prefer AnkhSVN to TFS.
I use VisualSVN and it works great, but you're correct, it's not free. No experience with Ankh here.
Early versions (1.X) of AnkhSVN were pretty unstable. Latest builds (v2.0.x) work as a native VisualStudio source control provider and it's very stable. I would recommend you to just download and try it yourself.
I also use AnkhSVN and it does work OK but I tend to drop to the file system to work with TortoiseSVN. For some reason I feel safer using Tortoise. I think that come's from concerns about Visual Studio than it is AnkhSsvn.
I tried AnkhSVN, but didn't like it. It tried to do too many things automatically and behind the scenes (e.g. adding files to SVN). I prefer if I see exactly what happens.
Now I mainly use TortoiseSVN (outside Visual Studio) or sometimes Mindscape VS FileExplorer in Visual Studio (which is available for free).
Note: VS FileExplorer plugin simply displays a file explorer in VS and allows you to invoke TortoiseSVN from there (and it also displays the TortoiseSVN overlay icons).
Update:
I reinstalled the current version of AnkhSVN 2.0.5250 and tried to reproduce the problems described above in a sample solution.
Result: AnkhSVN did exactly what I expected. I was not able to reproduce any of the problems. I think it might be time to give AnkhSVN another try at work!
Update 2:
I have now used AnkhSVN for some days, and I have to say it works very well. It's a big improvement compared to the previous version (1.x).
I use AnkhSVN and haven't had any issues worth complaining about. Sometimes (about 1 in 10 times?) I do get a strange nondescript error trying to commit, but restarting VS has always fixed the problem.
Edit: The error actually seems to be coming from the dataset designer, not AnkhSVN. Sometimes I get an error where it tries to "read or write to protected memory", which then just continues until I restart VS. Sorry for the confusion.
Call me crazy, but this solution seems pretty clean to me: http://blog.programmerslog.com/?p=4.
Garry Bodsworth has put forth Visual Studio settings that make use of TortoiseSVN. Basically, instead of adding the external tool customizations by hand, importing these settings does it all for you: Subversion toolbar, Subversion menu, and context menu commands.
I would think that this would be a more simple solution than installing either AnkhSVN or VisualSVN.
The Agent SVN plug-in does a good job of integrating Subversion and Visual Studio, but it too is not free.
Another vote for visual SVN. To be honest, I think its just me being lazy. I could do everything visual svn does with just using tortoise, but it saves me from switching between programs. The color coded warning lights you get with visual svn are nice, but not that big a deal.
I use VisualSvn and it's fine. It wasn't expensive and it helps make sure you include all files you've added to the solution. It's not so good when using locking in svn (but then svn isn't great at locking files). If you want to edit a file that has needs-lock set, it will automatically update it when you lock it (sensible), but that could end up doing an update when you dont want it too.
I've got into trying Svn Monitor too and am happy with that, but it does seem to grind my computer to a halt.
I've tried old versions of ANKH but got in a mess and corrupted the svn repository (I suspect that was version 1.x) so I'd guess later versions are better.
I have used both AnkhSVN and VisualSVN each for about 6 months. I prefer VisualSVN for one reason alone: Compatibility.
At my work, we keep our Subversion server and TortoiseSVN software very up-to-date (some people just go with one version and stick with it for years, but that's not our style). With new versions sometimes comes new working copy formats and it seems that AnkhSVN is very slow to adapt these new formats. What happens at this point is AnkhSVN completely breaks:
VisualSVN has been "on the ball" in this respect as we have never had any compatibility issues with their software. This factor alone easily swayed me toward VisualSVN.
I use VisualSVN, and love it. It may not be free but I found it extremely reliable, very well integrated, and very much worth the $49 per license. By setting up a few key-bindings comitting and updating become almost second-nature to my entire team (most of whom had no previous SVN/SCC experience).
Being able to quickly scan the solution explorer to see which files had changed was very useful for keeping tabs on things for writing status reports and the like (but that's probably specific to my overly beurocratic manager).
The "Checkout Solution from SVN" feature was great for quickly getting the summer student interns setup and giving them a gentle introduction to version control. Again, this is probably specific to our needs so may not be of interest to you.
So a thumbs-up for VisualSVN and the convenience it gives us.
My experience with working with AnkhSVN is better than tortoise but it still has a lot of flaws that you really don't get with native Visual Studio plugins like Source Safe, TFS, Dynamic soft. It has real problems with the .svn folders and synchronising so you end up spending a portion of your time removing the .svn folder and starting again.
That's my experience. One example is moving a folder from one project (in the same solution) to another project. It breaks on this from the working set being different. The solution is to go into the folder and remove the .svn files but it seems like a a lot of effort.
I'm use to it being a mirror of my filesystem though, and basic 2 developer branches of files.
When writing plugins for media center your plugin is hosted in ehexthost.exe this exe gets launched from ehshell.exe and you have no way of launching it directly, instead you pass a special param to ehshell.exe which will launch the plugin in a seperate process.
When we are debugging media browser I find the process of attaching to a second process kind of clunky, I know about Debugger.Attach and also of some special registry entries I can use.
Both these methods don't exactly fit my bill. What I want is to press F5 and have my current instance of visual studio attach to the child process automatically. Can this be done?
If there is a plugin for VS that allows me to achieve this functionality I would be happy with it.
EDIT
I ended up going with the following macro:
Public Sub CompileRunAndAttachToEhExtHost()
DTE.Solution.SolutionBuild.Build(True)
DTE.Solution.SolutionBuild.Debug()
Dim trd As System.Threading.Thread = New System.Threading.Thread(AddressOf AttachToEhExtHost)
trd.Start()
End Sub
Public Sub AttachToEhExtHost()
Dim i As Integer = 0
Do Until i = 50
i = i + 1
Try
For Each proc As EnvDTE.Process In DTE.Debugger.LocalProcesses
If (proc.Name.IndexOf("ehexthost.exe") <> -1) Then
proc.Attach()
Exit Sub
End If
Next
Catch e As Exception
' dont care - stuff may be busy
End Try
Threading.Thread.Sleep(100)
Loop
End Sub
Also, I outlined the process on how to get this going on my blog.
I would use a macro. I've redefined my F5 function to attach to the asp.net process instead of the long build/validate it usually performs. This works pretty well for me and it's really easy.
For Each process In DTE.Debugger.LocalProcesses
If (process.Name.IndexOf("aspnet_wp.exe") <> -1) Then
process.Attach()
Exit Sub
End If
Next
Please look the plugin I wrote.
You can automatically attach to a process by pressing F5, if you setup something like that in visual studio:
http://vvcap.net/db/ujYL7zeN_n_RgeprqCSM.htp
notice: There's "Command" filled up as an executable name, and "Attach" must be "yes"
When trying out these tutorials (T4 Tutorial: Creating reusable code generation templates) I noticed that although I was using plain c# I didn't get any intellisense, probably because of the file extension (.tt)
Isn't there anyway to say to Visual Studio to consider those .tt files as .cs files and thus get the correct intellisense help?
You can just download tangible's T4 Editor at t4editor.tangible-engineering.com it has Intelli-Sense for most important namespaces also in the FREE EDITION.
http://visualstudiogallery.msdn.microsoft.com/en-us/60297607-5fd4-4da4-97e1-3715e90c1a23
Here you go with a plugin...
Vaseem.
You can purchase the professional version of T4 Editor. It works very well in standalone .tt files, but unfortunately, due to the differences in how the pro version of T4 Editor and T4 itself compile the templates, you will get false errors reported for this tutorial, which relies on T4 Toolbox.
As Scott Hanselman also points out, the intellisense you might be expecting from some of the videos and articles on T4 are not built in to VS2008, you need the T4 Editor from Clarius, but they do have a community edition with some minimalist features to get you started.
You can try out Devart T4 Editor. It is free and provides syntax highlighting, intellisense, and code outlining support.
My job is currently based on Visual Studio (ASP.NET).
Looking for experiences using Visual Studio on a Mac.
Does it work?
I run Visual Studio 2008 on a Mac via the Parallels desktop and it works perfectly.
In a word, yes.
I use a Mac Mini 1.67 GHz machine with 2GB of RAM. That's not an impressive box, but performance under WinXP is excellent. I have used VS2005, VS2008, MySQL Server, Sql Server Express, and dozens of little utilities.
The only issues I've ever had were when I used a hotkey (ex: F10) that was assigned to something like Expose in the mac. So I would hit F10 and instead of stepping over, it would bring up the weather widget. Workaround was to reassign those keys on the Mac (i.e., reassign to Shift+F10).
Edit:
I see others report having sluggish performance. You may want to get an extra drive and keep your Virtual Drive there. I've been doing that for a long time, and that may be the reason for good performance under XP. Jeff Atwood has a blog entry about this topic.
Lots of people are talking about Parallels and VMWare Fusion, but I didn't see any mention of the other methods I've used to good effect.
Visual Studio via Remote Desktop - I have a laptop running Windows/Visual Studio with a static IP and use the Microsoft Remote Desktop client to connect from my Mac. This has the advantage of minimal overhead on the Mac, so is more responsive than a VM. However, it has the obvious disadvantage of requiring a second machine running Windows and Visual Studio. If you're running Windows Server 2008, as a bonus you can run RemoteApp to share just Visual Studio to your mac - very convenient.
Virtual machine using VirtualBox - All the major features of a VM, except VirtualBox is free. I've used VMs with VMWare Fusion, Parallels and VirtualBox and I have to say I find performance to be pretty much even across all three. Parallels tended to drive my CPU harder than the other two but the actual VM responsiveness was fine. VirtualBox also has Seamless mode, essentially similar to Parallel's Coherence mode, but less integrated into the Desktop. I use this every day to run a Windows-only application on my Mac and it works great, sharing only the window for that application instead of running a full Windows desktop.
Boot Camp - depending on your needs, running Boot Camp with Windows installed as a dual-boot OS will of course offer the best performance but with the downside of running Windows ;)
Yes it does, using VMWare Fusion. It works quite well, actually; the Unity feature allows you to treat Visual Studio in its own Mac window. However, you will need a current version of OS X (10.5.x), a LOT of RAM (more than 4GB), and a lot of hard drive space, as you will need to install all of Windows in your VM.
I've run it in VMWare Fusion (and Parallels previously) on several Macs with 2 gig of RAM without any issues. I generally install with BootCamp because that lets you boot into "native" Windows if you need more "umph" (or if you want to game), and the more recent versions of VMWare and Parallels both allow booting the VM directly from the BootCamp partition.
I use Base Camp and I run Vista w/ VS 2008 on a MacBook Pro. I think it's the bees knees. Mac may make crappy dirty hippie software but they make some rockin hardware.
I am working on an IMac now using VS2008 through BootCamp using Vista. I have tried it using Parallels and found it to be very slow at times. Using BootCamp it is a dream though (apart from having to reboot if you want to use OSx.) I would recommend the BootCamp route.
Visualization is the only way I know. If you want to do .NET work in a native IDE I suggest MonoDevelop
I do this a bit, but I find the keyboard on a MBP miserable for VS/R# - the home/end/page-up/page-down differences/omissions are particularly tedious.
Some default replacements for Home/End et al.:
I'm running VMWare Fusion on an iMac with 3GB memory. 1.5GB memory is allocated to the Windows XP that lives in the virtual world. The performance is very satisfying overall, but seems sluggish when I open or compile large C# projects. I am using visual studio 2008.
It definitely works using VMware or Parallels. I've used it in both and it worked far better in VMware Fusion. Things to keep in mind:
Good luck!
Like Stephen Doyle I use Parallels Desktop.
I'm currently running Parallels Desktop 4.0 on an old MackBook Pro with 2GB and its a bit slow.
In my last job I had a MacBook Pro with 4GB. I used Parallels Desktop 3.0 and ran VS2008 in a VM with 1.5GB memory. It worked well.
Personally, I am a big fan of VMWare Fusion. You can not only run the development environment of your choice, but setup test sandboxes to deploy and view your application through. I have a crusty XP install running IE6 just to make sure that my applications are passable by its poor standards.
Make sure you've got plenty of RAM for your Mac!
VS.2008 under XP/Vista/Win7. The tradeoff is whether you want faster compiles or more fan noise. If I need the power, the VM gets to virtualize both cores, then studio becomes much zippier. However, it tends to annoy the fans.
All things considered, it's very slick.
I'm using a 2.66 dual-core MacBook Pro 4gb RAM, VS2008 + XP in Parallels and I'm not having the best experience. Sadly, another hard drive is not an option and if I were to get an external hard drive, I'm not sure why I wouldn't just go back to a Windows laptop that doesn't need extra hardware. Others seem to have had a good experience with this set up though so I'm going to continue to tweak my settings. So far I'm kinda regretting having bought a Mac but not quite enough yet to take the financial hit of selling it on eBay.
If you have an Intel mac and run windows through boot camp, paralles or vmware etc, yes
I run VS 2008 / SQL 2008 on a MistakeBook Pro. I thought Parallels and Fusion kinda sucked for development. Bootcamp is pretty good though, just no native drivers to read the Mac partition of the hard drive. Also the windows 7 drivers are still lacking, the trackpad does not work. Still better than OSX.
A colleague has written a Windows Application and left me to do the installers. I have created the installer project through Visual Studio and added the primary output of the service project to the new project.
When I run the installer it creates the correct folders and copies the dlls, exe and config file in, but it doesn't do the actual install of the service.
The service isn't listed in the Services window, and if I double click on the exe I'm told I need to run installutil to install the service.
How do I make the installer do this bit for me? I found this article:
http://www.codeproject.com/KB/install/InstallService.aspx
but that seems overly complex for what I would expect to be pretty basic.
I'm sure I'm missing something obvious, can someone tell me what it is?!
Ta.
I used this article:
http://support.microsoft.com/kb/317421
Felt pretty dumb that I couldn't figure it all out until I went through all of the steps in this article. It's not a trivial exercise by any means.
For those who are looking for updated instructions for Visual Studio 2010 (instructions in answer are for VS 2005) check the following link:
In the last 3-5 years I have been renewing an insurance application and a commmercial integration toolkit based on Visual Basic 6.0.
According to Microsoft's "It just works policy" the IDE is no longer supported after april 8th 2008.
It still works to develop and deploy Visual Basic 6.0 applications.
When will it be impossible to support Visual Basic 6.0 applications, or will they live forever like Cobol applications do?
Update: Microsoft statement march 2010: The Visual Basic team is committed to ?It Just Works? compatibility for Visual Basic 6.0 applications on Windows Vista, Windows Server 2008 including R2, and Windows 7.
Update may 2011:
Happy 20th Birthday Visual Basic!
I'd say they're at risk, because the OS and hardware will evolve out from under them.
You can run Visual Basic 6.0 on Windows XP, but even that's close to the end of its life (it keeps being revived on its death bed).
Those Cobol applications still live because the mainframes they run on aren't going anywhere. "Big iron" was built during a time when computers were expensive and rare and had to run for 20-30 years. Not true with applications based on PCs and Windows, which are viewed as more disposable.
If you need to continue to support VB6 I would recommend creating a VM that contains XP and VB 6 with all the service packs on it. This way you can continue to run your development environment even though your desktop evolves to something that may be incompatible with the VB 6 dev environment. Installing Visual Studio 6 on Vista had issues two years ago.
For new development beyond maintenance I would look towards using a different environment. It's been my experience that you are better off looking at it from a completely fresh view point and not restrict yourself to migrating to VB .NET. It's enough of a hassle to migrate that you really should do new development in the best environment for your application. That may be VB .NET and it may not.
Developing using obsolete technology is never a problem until it's a problem and then it is too late. You need to stay in the sweet spot of the curve and you are the only one that can decide what that is. If you switch too early you will probably make the wrong decision and if you wait too long you will be too far behind. It's decisions like this that makes this field fun and painful at the same time.
It will probably work for a good number of years, but eventually you'll get to the point where you have to maintain old hardware, running an old, unpatchable OS, in order to run the software. Meanwhile, you're missing out on all of the new framework and language goodies that get developed. Eventually, you'll have a need to fix something or add something that isn't possible in your environment and then you get to pay the entire bill for your accumulated technical debt.
My take: you should already be working on an upgrade to a newer platform or replacement for the application. My preference is almost always to do this before I'm forced to by circumstances.
There is a ton of vertical market software developed in VB6 by manufacturers of various types of machinery. VB6 use of ActiveX controls, ActiveX DLLs, and the ability to consume most Win32 DLLs has lead to many manufacturers of various components to support VB6.
Using VB6 and the support libraries is at least an order of magnitude faster and more reliable than the older methods of assembly on custom chips, or using C. Note that even the C/C++ developers were helped as they can consume the new support libraries as well.
Many of these applications are filled with math functions that have been tested to work for the environment and the machinery they were designed for.
So when Microsoft made VB.NET incompatible with VB6 this was a BIG deal for many of us. Unlike the transition from VB3 to VB4-6, we have to touch our code in many place in order to get it working with .NET. So many in fact that it devolves to the same thing as rewriting your software in a new language.
For these reasons VB6 will live on for a while longer as all these machines are out there. Still needing new updates and fixes.
COBOL is a public standard, with multiple implementations by multiple vendors on multiple hardware platforms.
VB6 is only supported by Microsoft, and they've already told you that they won't be supporting it on new versions of Windows. So eventually it will be effectively dead. The same may be true of COBOL, but nowhere near as quickly.
You will always be able to develop in VB 6, since Microsoft won't visit your computers to uninstal it. If you don't want to rewrite your application, then you don't/won't have to.
But the tools you get now are the same as the ones you'll have ten years from now. So, you may end up falling behind as new computer science paradigms come along(assuming you won't develop your own VB compiler).
By sticking with current VB, your application will always be "possible" to maintain, but it'll get harder every second.
I expect it will impossible to support VB6 applications post Windows 7. (I expect the VB6 runtime and IDE to work on windows 7, but not windows 8)
With virtualization using VirtualPC/VMWare/VirtualBox etc, it in theory should be possible to support VB6 applications provided you have a host OS that can run VB6 correctly that you can virtualize that can run these applications.
I'm thinking of many companies that run software written for NT4 that lack driver support for new machines in virtual machines.
I began professional programming with Visual Basic 3.0 around a decade ago, and I was probably the last guy to migrate to .NET (I did it in 2004). So you COULDN'T find a bigger admirer of the platform than me.
I don't think Visual Basic 6.0 is going to go away soon. There're are a lot of legacy applications written in it. Company accounting software, customised tools, you name them. So the applications will be around.
The number of fresh Visual Basic 6.0 applications is going down in a spiral, so if you're looking to make a career as a Visual Basic 6.0 programmer, you're obsolete.
That said, there will be a pretty strong demand for people who can maintain/fix/upgrade old code.
I've got software written in Visual Basic 6.0 that's got about a 100 thousand users, and is still going strong. All of my fresh development is in C#, but for this particular software, I think I will re-write it in C# by 2009 end, or 2010 beginning. So at least till then I don't see Visual Basic 6.0 being not supported by Windows.
I think Visual Basic 6.0 applications will live for a long time, like COBOL applications, and for similar reasons. Parts of my company's products are still VB6, and they won't be changed until there's a good reason. We're hoping Microsoft won't be able to drop VB6 support for a good while because too many of their enterprise customers have VB6 apps. They've already been forced to extend the support period beyond their original plans. We're hoping Raymond Chen wins over MSDN magazine - obscure joke that will only make sense if you remember Joel's post about Microsoft's dilemmas with backward compatibility versus design purity.
If you're considering upgrading or rewriting, IMHO this question and this question have some informative answers. You can mix new .NET components with existing Visual Basic 6.0 using Interop, if there are .NET features you want or even if you just want to learn .NET.
The Visual Basic 6.0 newsgroups are still pretty active so there's obviously a lot of old fogeys like me still developing in Visual Basic 6.0 :)
Duffymo, Bruceatk - the Visual Basic 6.0 IDE can be made to work on Vista with a bit of effort.
If you still have the OS and the Tools it will never be "Impossible" to support them.
The real questions is if you still WANT to support them.
In one respect they'll live forever as the vb runtime will continue working on the microsoft OSes that exist today. VB6 apps still work in Vista, for example. VB6 applications will be impossible to support going forward when microsoft stops supporting the VB6 runtime on its operating systems.
This means that they will probably continue to live forever, much as some COBOL applications still live today. New code should almost never be written in the effectively dead language, now, though, so the marketability of VB6 skills will be in a progressive decline until some low, steady-state remains.
I think they'll be there forever. Simple reason: MS can't ship an OS that doesn't support them because no major corporation would buy that OS.
Most of what is needed to run Visual Basic 6.0 applications is also needed for VBA.
And VBA isn't going anywhere soon - there is simply too much of it about.
So if you're old enough to be developing in Visual Basic 6.0, I wouldn't worry about it stopping working in your lifetime.
I suspect VB6 apps will have limited life, because Redmond has to keep its coders busy pulling the rug out from under everybody.
If you think re-writing your apps in .NET will guarantee their immortality, just remember DDE, OLE, COM, DAO, etc. etc.
If an app works there is no GOOD reason it should stop working without somebody finding the resources to re-write it every few years, but sadly there are plenty of reasons.
I think Visual Basic 6.0 will continue to work for a long time. For a start, .NET has failed as a development platform for commercially mass distributed applications. nobody seems to use it in the way Visual Basic 6.0/C++ were/are used. The .NET runtimes are STILL not reliably there (from experience, we pulled a .NET application and recoded it in C++ for this one reason)
I agree about employability, though.
Loosing Visual Basic 6.0 was a major mistake by Microsoft: they were hypnotised by the whole OO thing. Most people want rapid development, not pedantic arguments about beautiful code.
VBA has replaced Visual Basic 6.0 within offices: who thinks of manipulating Office via the .NET route?
It only becomes "impossible" if you start adding machines and OS's into the mix that the app will no longer run on.
Vista will still run VB6 apps. My guess is that 7 will continue to do so as well.. and if not, there is always virtualization.
Any type of hardware / os upgrades that your company may be planning needs to take your existing LOB applications into consideration. This is no different than taking your current version of Office or your email client into consideration.
PC's don't really have an expiration date. Even if you are stuck with XP you can get hardware that works with it and will continue to do so for quite some time. If you buy prebuilt machines, you may need to simply downgrade the installed OS. Which isn't that big a deal.
That said, you probably have about 3 more years before things become difficult, and another 1 or 2 after that before people no longer want to work in your IT department because of how ancient everything is.
The runtimes are still the nightmare with .NET.
I support code on 20,000-30,000 desktops and analyse the registry of them. The amount of PCs without any .NET runtimes (let alone 2+) is staggering. There is no way one can mass-distribute auxillary code to them (the core application is C++) without employing an army of support staff to hand-hold on the reboots.
C++ is the only way to go for client-side applications.
What a disaster the whole OO mirage has been for MS and so us! What a cost inflator!
... and ASP.NET webforms/viewstate... I could type for DAYS (our programming contractors clearly did.)
VB6 probably will be around forever in insurance / bank type organizations. Hardware moving out of their realm is not an issue. They will simply get some form of emulator. I've seen an application for a very old mainframe working inside an emulator which was inside of another emulator.
It usually just doesnt make business sense for the non technicals to consider a rewrite and retest for something that already works. -
Welcome to the world of painful hell... get out now :-) -
Visual Basic 6.0 works, until you need using threads, or until you will have to face files larger than 4 GB.
A VB6 program is nothing than a Win32-executable, that relies on a number of accompanying COM-ActiveX-libraries. So its just a matter of creating a proper setup-package.
By the way, the VB6 IDE runs perfectly on a Windows 7 64 bit machine (with a couple of small tweaks of course).
PS. Unfortunately my company still ships commercial and publicly available VB6-products, so - I happen to know that.
I have to say this is something you cannot accuse the much (and justly!) maligned COBOL for.
COBOL is continuously supported with frequent new releases from IBM, UNISYS, MicroFocus on several platforms which support things like the latest hardware, 64bit addressing, built in support for XML etc.. There is even a Linux version (OpenCobol) which is progressing nicely.
Furthermore the language itself is continuously developing (if you can call making the same old mistakes with new reserved words developing :-} ) and the latest langauge specification is fully OO look here if you don't believe me!
So COBOL is not yet dead merely archaic. Whereas I think VB 6.0 really is dead and just bit late for its own funeral.
Is there any way to make Visual Studio show the code of a control / form by default instead of the designer? I tend not to be a fan of the designers as they add bloat.
Right-click on a file and select "Open With..."
Select "CSharp Editor" and then click "Set as Default".
I like having my forms open up in Design View, but I made a partial class file which had only code and Visual Studio wanted to open it in Design View all the time. To prevent Visual Studio from realizing that a specific source file can be loaded by Designer, look at the csproj file for the Compile Include tag of the appropriate source file and remove the SubType tag underneath it.
When I start a new ASP.NET project in Visual Studio 2008, I can either create a new ASP.NET Web Site or an ASP.NET Web Application.
What's the difference between these two project types? Why would I choose one over the other?
If I'm using Visual Studio 2005 instead of Visual Studio 2008, is the answer different?
If I'm using Visual Studio 2010, is the answer different?
Website:
The Web Site project is compiled on the fly. You end up with a lot more DLL files, which can be a pain. It also gives problems when you have pages or controls in one directory that need to reference pages and controls in another directory since the other directory may not be compiled into code yet. Another problem can be in publishing.
If VS isn't told to re-use the same names constantly, it will come up with new names for the dll files generated by pages all the time. That can lead to having several close copies of dlls containing the same class name, which will generate plenty of errors. The Web Site project was introduced with VS 2005, but has turned out not to be extremely popular.
Web Application:
The Web Application Project was created as an add-in and now exists as part of SP 1 for VS 2005. The main differences are the Web Application Project was designed to work similar to the Web projects that shipped with VS.net and VS 2003. It will compile the application into a single dll at build time. In order to update the project it must be recompiled and the dll published for changes to occur.
Another nice feature of the Web Application project is it's much easer to exclude files from the project view. In the Web Site project, each file that you exclude is renamed with an exclude keyword in the filename. In the Web Application Project, the project just keeps track of which files to include/exclude from the project view without renaming them, making things much tider.
This article also gives reasons on why to use one and not the other. Here is an excerpt of it:
- You need to migrate large Visual Studio .NET 2003 applications to VS 2005? use the Web Application project.
- You want to open and edit any directory as a Web project without creating a project file? use Web Site project.
- You need to add pre-build and post-build steps during compilation? use Web Application project.
- You need to build a Web application using multiple Web projects? use Web Application project.
- You want to generate one assembly for each page? use Web Site project.
- You prefer dynamic compilation and working on pages without building entire site on each page view? use Web Site project.
- You prefer single-page code model to code-behind model? use Web Site project.
Link to msdn about differences between web site and web application projects. Also, discusses about the configuration to be made in visual studio.
Web Site is what you deploy to an ASP.NET web server such as IIS. Just a bunch of files and folders. There?s nothing in a Web Site that ties you to Visual Studio (there?s no project file). Code-generation and compilation of web pages (such as .aspx, .ascx, .master) is done dynamically at runtime, and changes to these files are detected by the framework and automatically re-compiled. You can put code that you want to share between pages in the special App_Code folder, or you can pre-compile it and put the assembly in the Bin folder.
Web Application is a special Visual Studio project. The main difference with Web Sites is that when you build the project all the code files are compiled into a single assembly, which is placed in the bin directory. You don?t deploy code files to the web server. Instead of having a special folder for shared code files you can put them anywhere, just like you would do in class library. Because Web Applications contains files that are not meant to be deployed, such as project and code files, there?s a Publish command in Visual Studio to output a Web Site to a specified location.
Deploying shared code files is generally a bad idea, but that doesn?t mean you have to choose Web Application. You can have a Web Site that references a class library project that holds all the code for the Web Site. Web Applications is just a convenient way to do it.
This topic is specific to .aspx and .ascx files. This topic is decreasingly relevant in new application frameworks such as ASP.NET MVC and ASP.NET Web Pages which do not use codebehind files.
By having all code files compiled into a single assembly, including codebehind files of .aspx pages and .ascx controls, in Web Applications you have to re-build for every little change, and you cannot make live changes. This can be a real pain during development, since you have to keep re-building to see the changes, while with Web Sites changes are detected by the runtime and pages/controls are automatically recompiled.
Having the runtime manage the codebehind assemblies is less work for you, since you don't need to worry about giving pages/controls unique names, or organizing them into different namespaces.
I?m not saying deploying code files is always a good idea (specially not in the case of shared code files), but codebehind files should only contain code that perform UI specific tasks, wire-up events handlers, etc. Your application should be layered so that important code always end up in the Bin folder. If that is the case then deploying codebehind files shouldn't be considered harmful.
Another limitation of Web Applications is that you can only use the language of the project. In Web Sites you can have some pages in C#, some in VB, etc. No need for special Visual Studio support. That?s the beauty of the build provider extensibility.
Also, in Web Applications you don't get error detection in pages/controls as the compiler only compiles your codebehind classes and not the markup code (in MVC you can fix this using the MvcBuildViews option), which is compiled at runtime.
Because Web Applications are Visual Studio projects you get some features not available in Web Sites. For instance, you can use build events to perform a variety of tasks, e.g. minify and/or combine Javascript files.
Another nice feature introduced in Visual Studio 2010 is Web.config transformation. This is also not available in Web Sites.
Building a Web Application is faster than building a Web Site, specially for large sites. This is mainly because Web Applications do not compile the markup code. In MVC if you set MvcBuildViews to true then it compiles the markup code and you get error detection, which is very useful. The down side is that every time you build the solution it builds the complete site, which can be slow and inefficient, specially if you are not editing the site. l find myself turning MvcBuildViews on and off (which requires a project unload). On the other hand, with Web Sites you can choose if you want to build the site as part of the solution or not. If you choose not to, then building the solution is very fast, and you can always click on the Web Site node and select Build, if you?ve made changes.
In an MVC Web Application project you have extra commands and dialogs for common tasks, like ?Add View?, ?Go To View?, ?Add Controller?, etc. These are not available in an MVC Web Site.
If you use IIS Express as the development server, in Web Sites you can add virtual directories. This option is not available in Web Applications
Chek out the article I wrote dedicated to the differences between Web Application Projects vs Web Site Projects at http://vishaljoshi.blogspot.com/2009/08/web-application-project-vs-web-site.html
Web Site = use when the website is created by graphic designers and the programmers only edits 1 or 2 pages
Web Application = use when the application is created by programmers and the graphic designers only edit 1 or two paged/images.
Web Sites can be worked on using any HTML tools without having to have developer studio, as project files don?t need to be updated etc. Web Applications are best when the team is mostly using developer studio and there is a high code content.
Here is a post I put out that may answer your question:
http://www.codersbarn.com/post/2008/06/01/ASPNET-Web-Site-versus-Web-Application-Project.aspx
In short, stick to the Web Application project if you're doing any serious work.
Anthony :-)
Unless you have a specific need for a dynamically compiled project, don't use a web site project.
Why? Because web site project will drive you up the wall when trying to change or understand your project. The static typing find features (e.g. find usages, refactor) in VS will all take forever on any reasonably sized project. For further information, see the the SO question: Slow ?Find All References? in Visual Studio
I really can't see why they dropped web applications in VS2005 for the pain-inducing, sanity-draining, productivity carbuncle web site project type.
Web sites are dynamically compiled and source is distributed with them. Web Applications can be compiled into a single DLL and deployed.
You cannot use the app_code folder in WAP projects, but you can with WSP.
There is a bit of MSDN documentation between WAP/WSP.
This may sound a bit obvious, but I think it's something that is misunderstood because VS2005 only shipped with the web site originally. If your project deals with a website that is fairly limited and doesn't have a lot of logical or physical separation, the website is fine. However if it is truly a web application with different modules where many users add and update data, you are better off with the web application.
The biggest pro of the website model is that anything in the app_code section is dynamically compiled. You can make cs file updates without a full redeploy. However this comes at a great sacrifice. A lot of things happen under the covers that are difficult to control. Namespaces are difficult to control and specific dll usage goes out the window by default for anything under app_code since everything is dynamically compiled.
The web application model does not have dynamic compilation, but you gain control over the things that I have mentioned.
If you are doing nTier development, I highly recommend the web application model. If you are doing a limited web site or a quick and dirty implementation, the web site model may have advantages.
More detailed analysis can be found here:
http://west-wind.com/weblog/posts/5601.aspx
http://blogs.vertigo.com/personal/swarren/Blog/Lists/Posts/Post.aspx?ID=10
One thing to watch out for is that Website projects are difficult to build with MSBuild. You will only come up against this is if you are planning to automate the build which has always worked extremely well for me.
One additional benefit of the Web Application is that it produces a DLL suitable for static analysis. Trying to use tools like NDepend on a Web Site project is not fun.
Continuous integration was much simpler for me when using Web Application projects. I've tried both, and the website required jumping through some hoops with Cruise Control.Net.
This is an old question but in case anybody is reading and wants to know the difference, I recommend you watch this video on asp.net website which explains the difference in great detail, it was quite helpful to me.
Web Application Projects & Web Deployment Projects
By the way, don't get confused by the title, a great part of the video explains the difference between website projects and web application projects and why Microsoft re-introduced Web application projects in Visual studio 2005 (as you probably already know, it originally shipped with only website projects then web application projects were added in SP1). A great video I highly recommend for anyone who wants to know the difference.
With web application (project),
Some details from Apress ? Pro ASP.NET 3.5 in C# 2008 Second Edition
I am working on an open source C++ project, for code that compiles on Linux and Windows. I use cmake to build the code on Linux. For ease of dev-setup and political reasons, I must stick to visual studio project files/editor on Windows (I can't switch to Code::Blocks, for example). I see instructions to generate visual studio files using cmake, as here.
Have you used cmake to generate visual studio files before? How has been your experience? Suppose I want to add a new file to my project. What is the workflow for this?
cmake is actually pretty good for this, the key part was everyone on the windows side has to remember to run cmake before loading in the solution, and everyone on our mac side would have to remember to run it before make. The hardest part was as a windows developer making sure your structural changes were in the cmakelist.txt file and not in the solution or project files as those changes would probably get lost and even if not lost would not get transfered over to the mac side who also needed them, and the Mac guys would need to remember not to modify the make file for the same reasons. It just requires a little thought and patience but there will be mistakes at first. But if you are using continuous integration on both sides then these will get shook out early and people will eventually get in the habit.
We moved our department's build chain to CMake, and we had a few internal roadbumps since other departments where using our project files and where accustomed to just importing them into their solutions. We also had some complaints about CMake not being fully integrated into the Visual Studio project/solution manager, so files had to be added manually to CMakeLists.txt; this was a major break in the workflow people were used to.
But in general, it was a quite smooth transition. We're very happy since we don't have to deal with project files anymore.
The concrete workflow for adding a new file to a project is really simple:
CMake 2.6 automatically reruns itself if any CMakeLists.txt files have changed (and (semi-)automatically reloads the solution/projects).
Remember that if you're doing out-of-source builds, you need to be careful not to create the source file in the build directory (since Visual Studio only knows about the build directory).
As Alex says, it works very well. The only tricky part is to remember to make any changes in the cmake files, rather than from within Visual Studio. So on all platforms, the workflow is similar to if you'd used plain old makefiles.
But it's fairly easy to work with, and I've had no issues with cmake generating invalid files or anything like that, so I wouldn't worry too much.
CMake can generate really nice Visual Studio .projs/.slns, but there is always the problem with the need to modify the .cmake files rather than .proj/.sln. As it is now, we are dealing with it as follows:
/src and files visible in Visual Studio are just "links" to them defined in .filter./src directory, not the default project's one..cmake files.At first we were a little afraid of how it will turn out, but the workflow works really well and with nice diff visible before each commit, everyone can easily see if his changes were correctly mapped in .cmake files.
One more important thing to know about is the lack of support (afaik) for "Solution Configurations" in CMake. As it stands, you have to generate two directories with projects/solutions - one for each build type (debug, release, etc.). There is no direct support for more sophisticated features - in other words: switching between configurations won't give you what you might expect.
So the issue is simple really, instead of creating folders in visual studio, i create a directory structure for my project on the file system. How to i include all the folders and files in a project, keeping the structure?
If i "Add Existing File" on a folder named Services and navigate to a file in the directory structure .. Services > AccountManagement > CreateAccount.cs it appears in visual studio like so : Services > CreateAccount.cs. I do not want this.
I have an entire directory structure worked out already, as I am mimicking our client developers using the same structure for organization. How do i add all the folders and files to the project in Visual Studio? Or do i have to do what most MS users do and "put up with it" and recreate each and every folder through visual studio?
You need to put your directory structure in your project directory. And then click "Show All Files" icon in the top of Solution Explorer toolbox. After that, the added directory will be shown up. You will then need to select this directory, right click, and choose "Include in Project."
You can also drag'n'drop the folder from windows explorer onto your visual studio solution window.
There are times when I want to test new code from the forums or when I need to help my friends with specific C# problem. The problem is I don't want to create new "project" in Visual Studio each time just to code/run only this small code.
Java & Eclipse IDE comes up with "Scrapbook" feature which allows the execution of arbitrary Java expressions. What are the choices for C# programmers?
Snippet Compiler is great for this.
LINQPad is also good for testing out LINQ code.
Here's what I do:
Go to Tools->Options->ProjectsAndSolutions, and disable "Save new projects when created".
Fire up a new VS, Ctrl-Shift-N to create a project, and use that.
Use C# Express to have something that launches more quickly and has less clutter, but still enough power to do most things.
I usually use csc directly from the command line
C:\Users\Greg>csc /o- /debug+ Test.cs
Check also Snippy and the Snippy Addin for Reflector
I just use the scratch console application project that I've defined for just this purpose. I cut out whatever is in the main program and go to town. If I decide that I need to keep whatever I've prototyped, I create a new project and copy to it. Since I do this all the time, the project's always in my recent-projects list, too.
There's also the interactive C# shell, built on top of Mono:
http://mono-project.com/CsharpRepl
That's similar to what other languages have (for example, irb with Ruby)
This is something I've never liked about visual studio. One thing (and probally the only thing) I miss from VB6 was the ability to create a project, and run it without saving it or anything. Was great for just what you said.
I typically have at least one or two scrap projects of each type, (Console, Winforms, and Web), that I just rotate and use. This way I'm not always creating new projects.
you could have a look into C# Scripting.
this is ment to allow you to build fast scripts without the use of the IDE.
HTH
bones
I always keep a copy of Express Edition running; this can execute and debug projects without needing a proper file location (as long as you don't hit save). Does the job for me...
I use a batch file (csc.bat):
C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\csc %1 %2 %3 %4 %5 %6 %7 %8 %9
For vb.net I use this batch file(vbc.bat):
C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\vbc %1 %2 %3 %4 %5 %6 %7 /r:system.windows.forms.dll /r:system.data.dll /r:system.dll
For example: C:>csc testit.cs
Each will create a .net .exe file. This solution is not so good for Windows Forms applications, however.
Try SharpDevelop. It doesn't contain everything, but is good for quick examples. You can open a solution and easily swap out the code to test something else. In the project properties you can change a solution from console to window app via a combobox selection. You can easily translate your code from C# to Boo, Python, Ruby or VB, or from any of these languages to another, starting with whatever your source is. Therefore, if you go looking for a problem solution on the web and can't find one in VB - but do find one in C#, you may be able to convert it.
There are plenty of different Add-Ins for Visual Studio see Visual Studio Gallery . Please share your experiences and favorites.
As motivation, here are some of my favorites:
Tools
For coffe break
Your suggestions:
[F] - freeware [O] - open source [C] - commercial.
I'm amazed that Visual Assist has not been mentioned yet!
ViEmu is my personal favorite. Emulates VI right inside of VS. :^)
BTW, this post is essentially the same thing.
RockScroll is awesome, but there is something more powerful: MetalScroll :)
btw... I also recommend this patch: http://code.google.com/p/metalscroll/issues/detail?id=9
vscommands free and awesome!
VSFileExplorer is a nice file explorer for VS. It's also very helpful when used together with subversion/tortoiseSVN, since it displays the tortoise overlay icons within VS.
and of course
GhostDoc for generation of XML doc comments for methods, properties, classes, ...
Is nobody using Resharper? - Shame on you! ;-)
Seriously, you don't know what you're missing (I do, because I've yet to convince my boss to buy it, and my evaluation period has expired)
The addition of this tool to visual studio almost brings it up to the level of IntelliJ Idea for Java
assist is very useful, visual lint is good but boring.
A minor one by me: Linkify that simplifies links in comments to dev wiki, msdn, bug tracker etc.
My two pennies worth: TabStudio and RockScroll.
Tab Studio is uber-awesome when working on WPF / Silverlight apps, trying to keep track of any number of code behind, view-model and xaml files.
Rock scroll is great for larger files and quickly finding references.
I have a vs 2008 solution and I would like to include a real folder in the solution, but not at the project level, instead at the solution level.
I noticed you can right click the solution and add a solution folder, but it comes up as some white folder, and I have my doubts as to exactly what it is supposed to be...
basically on the file system I have c:\mySolution\myFolder....
I want that myFolder added to the solution, so that items are also under source control...
thanks for the help
I also would like to be able to add physical folders to a solution, but unfortunately you can't do so outside a project.
The best solution I have found is to add a solution folder with the same name as the physical folder (myFolder in your example), then add files from that physical folder to the solution folder.
However Visual Studio does not maintain a mapping between the solution folder and the physical folder which means that:
new files subsequently created in the solution folder using Visual Studio are not automatically placed in the physical subfolder (I think they are created in the solution root folder by default)
files added to the physical folder are not automatically visible in the solution folder, even with "Show All Files".
To add new files, I therefore always create the new file in the physical folder outside Visual Studio, then add it to the solution folder using "Add/Existing Item"
What I have done historically is to create a project for just holding files (DLLs, etc.)
You can do that as well. This project can be named as whatever folder you are trying to create.
I have to also add - this http://msdn.microsoft.com/en-us/library/haytww03(VS.80).aspx is not really what I am interested in.
I would like a real folder included in the solution, for holding files, not for holding projects
You can also add standalone files in a solution folder, and they will be source-controlled. But be wary that VS tends to put these files in the same folder as the solution file - the "Solution Folders" are virtual and don't corresspond to real filesystem folders. To have a real filesystem folders I think you would have to create the structure yourself and then choose "Add Existing Item".
You can use a solution folder to group files in a solution, but a solution folder doesn't represent an on disk folder, like its logo suggests. (It can contains file references and project references)
Follow this...
Then the new project will be put inside your new New Physical Folder.
Here is the easiest way:
On visual studio:
File --> Open --> Website --> Select the root folder
This seems to be an absurdly simple question but Google and SO searches yield nothing. How can I disable horizontal scrolling in a WPF listbox when items take up more horizontal space than is available in the box?
In XAML:
<ListBox ScrollViewer.HorizontalScrollBarVisibility="Disabled" />
In C#:
myListBox.SetValue(ScrollViewer.HorizontalScrollBarVisibilityProperty, ScrollBarVisibility.Disabled);
Visual Studio syntax highlighting colors this word blue as if it were a keyword or reserved word. I tried searching online for it but the word "array" throws the search off, I get mostly pages explaining what an array is. What is it used for?
It's not a reserved word under ISO standards. Microsoft's C++/CLI defines array in the cli namespace, and Visual Studio's syntax highlighting will treat it as a reserved word. This usage would be considered a vendor extension and not a part of any international C or C++ standard.
ISO C99 Keywords:
ISO C++98 Keywords:
It isn't. At least not in standard C/C++.
Now you might well ask the reason "entry" was a reserved word in C in K&R but not in C99 - somebody thought they might add the feature at some point, but eventually decided against it.
Apparently it's used in C++/CLI.
Visual C++ Language Reference: "The array keyword lets you create a dynamic array that is allocated on the common language runtime heap."
In what edition? A Google search for "c++ reserved words" shows no such usage.
I routinely use "array" in sample code.
Visual Studio never bothered with defining different C++ grammars for their pretty printer. ISO C++, VC++, C++/CLI, or just old C - all share the same grammar. So, names like array and interface are all treated as if they were keywords.
It would also be quite hard for the pretty printer to spot the C++ dialect used in foo.cpp. You'd need to compile the code for that. Currently the pretty printer can operate on tokens, which means it only needs to parse the code.
Merging project/solution files is a well-known disaster among developers/SCM admins performing merges in their source control.
Take, for example, a common scenario: development is done on a project/solution in two different branches. When time comes to merge back into a main development line, there is a very small resemblance between the VCPROJ's (and SLNs).
The reason is, Visual Studio may change (and DOES change) location of the various XML-like elements within these files. E.g., Configurations Debug and Release may swap order upon every save operation on the proj file. This makes it impossible to easily incorporate changes from each development branch, not even considering an automatic merge.
I can assume that Microsoft are using some perl hashing system to hold the vcproj structures, hence the rendering of the files upon a save operation is not ordered.
I'd first like to ask: did anyone found some elegant method to workaround this?
Second, I'd like to make two suggestions:
Have Microsoft please reimplement the above files and restrict them to some rigid ordering of elements.
find a tool (or write one) that sorts vcproj (xml format) and sln (sln format...) files alphabetically, recursively (all elements within elements etc.). Using this tool on both source and target files would enable to easily point (and merge) the changes, hoping that Visual Studio reads the sorted, merged project or sln file.
Any other ideas and thoughts are welcome.
I created a tool to compare and merge solution file (http://slntools.codeplex.com). It's a lot easier to merge a solution with the tool compared to a 'generic merger'. It cannot handle project files thought.
Project: Merge is my tool for comparing and merging XML files. I originally wrote it because I was experiencing exactly this problem with Visual Studio project files.
It correctly detects re-ordered elements and/or attributes within the XML file and will correctly resolve nearly all 'conflicts' automatically.
You might want to consider associating your tool with a trigger within your SCM (like a re-commit hook for SVN), in order to enforce the re-ordering within those files.
Then you would stand a chance to efficiently merging these elements together.
I typically try to avoid putting automatically-generated files under SCM. Automatically-generated files should be generated from source files that a developer controls, and those can be put under SCM. If a particular tool stores data in an opaque and fragile format, this is the tool's problem.
Regarding Visual Studio, although I think it has decent compilers, libraries, and a debugging environment, I believe that the files in generates (PRJ, SLN, RC) are highly problematic. Apart from the problems you mention, they also change a lot between different VS versions. For this reason, we write our own makefiles, and build the programs externally, using make. Furthermore, we split the resource files into parts for which we are forced to rely on VS, and those we can sanely handle with a normal editor. We generate many resource files automatically from high-level description, written in custom domain-specific languages. We thus minimize the impact of changes that are difficult to handle under SCM.
This doesn't seem to offer any great help either:
it actually adds a +1 for makefiles unfortunately.
I have not yet run into this problem because of the nature of the projects I work on. (smaller teams and minimal if any branching of project files) I am amazed at Microsoft's appalling shortcoming here; what a huge mistake.
What we do with resource files (not so much trouble with project files) is to sort them prior merging. We've configured the merge command on Plastic to actually run a sort (a different app we've developed for that, we can share the code if you're interested, nothing fancy) before merging, so all the random relocations go away... Hope it helps.
I've written a small Perl-script to merge solution files:
http://blog.tedd.no/index.php/2011/01/06/merging-multiple-visual-studio-solution-sln-files-into-one/
The script could be modified to suit your needs.
On occasion, I get the following error in design mode of some user controls in Visual Studio 2008:
The file 'UserControl.vb' does not support code parsing or generation because it is not contained within a project that supports code.
It doesn't happen on a consistent basis, but it happens enough to be annoying. Are there any common causes of this error?
And yes, it is in a project that supports code - last I checked, WinForms projects typically have code in them!
It is a bug in VS. It happens in VS2005 as well.
Don't waste your time: close VS, open it again and everything should work fine.
Note that there is a Microsoft Connect issue on this: https://connect.microsoft.com/VisualStudio/feedback/ViewFeedback.aspx?FeedbackID=366006
What if the linker is encountering an exception during the build, but the exception handler doesn't have complete state information and returns that message because it's the one that corresponds to the information which it does have? If code is being generated to handle a call from one module to another rather than letting the runtime binding by the DLL loader based on the function descriptor (which should be present) in the called module do the work of setting up the call, and the compiler hasn't yet resolved all of the symbols denoting .sdata or .sbss sections, the difference between initialized and uninitialized data segments might not be flagged if the linker was expected to have that data. If the compiler generates code using link tables instead of leaving it to the linker to set things up for the DLL loader, and doesn't recognize that the import stub didn't have the value of gp (i.e., the r1 register) but, since no error was generated so far, it goes ahead and tries to calculate it and suddenly runs up against the problem that .sbss is an uninitialized data segment but has to have a function descriptor in it anyway, what does it do? I don't know how the memory allocation would work there, or how it would be represented in the object file; but if something as simple as an allocation error generates an exception and the compiler is caught at a moment when it still has incomplete state information to pass to the exception handler, it seems possible that the handler would assume that the call is due to an ownership or security issue and then activate a check to see what type of violation is implied. Finding no violations, what would the handler do then? Obviously, it would have to report that it checked and there was no error; so what then? Does it reset a flag that the compiler picks up before it checks the return value from the exception stack? What if the end result is that the compiler sees a state that looks like 'function unsupported' rather than 'unknown error'? This may sound like a far-fetched scenario; but something far-fetched has to be causing the error these people are talking about! How else are you going to imagine C# returning a message that implies there's no such thing as a code segment? Whatever it is, there has to be a 'mechanism' for it; and the most obvious thing- the thing that sticks out in your imagination -is that the compiler must not be able to generate a reference to the function descriptor for a load module, and somehow it gets handled as global. If someone good at using the kernel debugger would attach to the compiler and check which namespaces are being used- and in which order -by the code generator, linker, and exception handler, that should indicate whether the mismatch is symbolic (at the level of the source symbols) or direct (at the address binding level). The fact that this error message pops up sporadically, and almost invariably disappears when these people exit the IDE and restart it, suggests that there is an uninitialized variable somewhere which has a partial dependency on the state-spaces of other variables which don't always determine its state uniquely. I don't think it's the 'reserved bit' problem, although that's probably not impossible. If it is this type of problem, then it should be possible to add a couple of lines of code somewhere that would serve no other purpose than to cause generation of symbolic and linking information for the faulty module earlier in the build process; or if there is a flag somewhere that isn't being set correctly, to get that job done before the compiler or exception handler sees it. Since every module has to be able to address its own code, you might fail-safe it by putting exportable null routines in any header files that could be causing the problem, and see if that does the trick. At least that would make sure the .bss sections all have been allocated function descriptors before external modules are expected to be able to see them.
What's the difference between Debug and Release?
The most important thing is that in Debug mode there are no optimizations, while in Release mode there are optimizations. This is important because the compiler is very advanced and can do some pretty tricky low-level improving of your code. As a result some lines of your code might get left without any instructions at all, or some might get all mixed up. Step-by-step debugging would be impossible. Also, local variables are often optimized in mysterious ways, so Watches and QuickWatches often don't work because the variable is "optimized away". And there are multitudes of other optimizations too. Try debugging optimized .NET code sometime and you'll see.
Another key difference is that because of this the default Release settings don't bother with generating extensive debug symbol information. That's the .PDB file you might have noticed and it allows the debugger to figure out which assembly instructions corresspond to which line of code, etc.
"Debug" and "Release" are actually just two labels for a whole slew of settings that can affect your build and debugging.
In "Debug" mode you usually have the following:
In "Release" mode optimizations are turned on (though there are multiple options available) and the _DEBUG preprocessor definition is not defined. Usually you will still want to generate the PDB files though, because it's highly useful to be able to "debug" in release mode when things are running faster.
If you go through project compile options and compare them, you'd see what are the differences.
Assuming the question is about native/C++ code (it's not entirely clear from the phrasing):
Basically, in Debug all code generation optimizations are off. Some libraries (e.g. STL) default to stricter error checking (e.g. debug iterators). More debugging information is generated (e.g. for "Edit and Continue"). More things are generated in code to catch errors (local variable values set to uninitialized pattern, debug heap is used).
Mostly, debug includes a lot of extra information useful when debugging. In release mode, this is all cut and traded for performance.
It's probably worth mentioning the very obvious, that build flags allow for different logic which should be used just to change logging and "console" messaging, but can be abused and dramatically change not just the low-levels but the actual business logic.
Also note that when using MFC for example, debug projects link against non-redistributable DLL versions like MFC90D.DLL while release builds link against the redistributable versions like MFC90.DLL. This is probably similar with other frameworks.
Therefore you will probably not be able to run debug-build applications on non-development machines.
The obvious difference you can see is the size of the binary. Debug build produces a larger binary than Release build.
When compiling in Debug, the symbol table is added to the compiled object of the code file which allows for debugging programs to tap into these binaries and asses the values of objects and variables.
Another observable difference is that, in Release mode, the binary would simply crash on a fatal error while in Debug mode, if you start debugging the application in Visual Studio, you can check the call stack which tells you the exact location of the erroneous statement.
Also, apparently, Debug mode creates a lot of extra threads to help with debugging. These remain active throughout the life of the process, regardless of whether you attach a debugger or not. See my related question here.
Our company is considering using the Visual Studio Shell for one of our products.
Does anyone have any experience using it? Was it easy to work with? Did it save time? Are there any things that you weren't able to get it to do? Have you shipped anything with it?
I played around a bit with it a couple of weeks ago, like every thing there is going to be a learn curve but if you study the examples a bit and have a look at a project on codeplex called Storyboard designer. I'm sure that you could pick it up, I found it very hard to find other examples on the net but I wasn't looking very hard.
I would say if you think that the shell can give you want you need I would go for it, it is a very handy interface to work with and if your targeting developers it is also a common interface for them, so it will feel natural.
A couple of points regarding the Isolated shell.
As you might know, there are two considerations when you use shell - Isolated Mode and Integrated Mode. (Read more from MSDN)
Isolated Shell can be used by organizations, to build applications that run side by side with other editions of Visual Studio.
Here are some points we learned, trying to use shell for some of our applications.
Though not directly related - If you are using VS SDK 1.1 to develop your packages - remember that the managed package framework is no longer available with the default distribution. So don't get surprised if your old packages can't load MPF files after moving to SDK 1.1. It has got moved to Codeplex as a separate download.
When programming in C++ in Visual Studio 2008, why is there no functionality like that seen in the refactor menu when using C#?
I use Rename constantly and you really miss it when it's not there. I'm sure you can get plugins that offer this, but why isn't it integrated in to the IDE when using C++? Is this due to some gotcha in the way that C++ must be parsed?
The syntax and semantics of C++ make it incredibly difficult to correctly implement refactoring functionality. It's possible to implement something relatively simple to cover 90% of the cases, but in the remaining 10% of cases that simple solution will horribly break your code by changing things you never wanted to change.
Read http://yosefk.com/c++fqa/defective.html#defect-8 for a brief discussion of the difficulties that any refactoring code in C++ has to deal with.
Microsoft has evidently decided to punt on this particular feature for C++, leaving it up to third-party developers to do what they can.
I'm not sure why it is like this, but third-party tools exist that help. For example, right now I'm evaluating Visual Assist X (by Whole Tomato). We're also using Visual Studio 2005.
Don't feel hard-done-by, it isn't available in VB.Net either :)
C++ is a HARD language to parse compared with C# (VB too unless you've "Option Explicit" and "Option Strict" switched on, it's difficult to tell exactly what any line of code is doing out of a MUCH larger context).
At a guess it could have something to do with the "difficulty" of providing it.
P.S. I marked my answer as community wiki because I know it's not providing any useful information.
devexpress provides Add-in Refactor! for C++ for VS2005 and VS2008.
I've been using Visual Assist X with visual studio for about one year and a half. It's an incredible tool that helps you a lot with ordinary C++ code, but it doesn't perform very well on templated code. For instance, you if have a sophisticated policy-based template design, it won't know how to rename your variables, and the project won't compile anymore.
I was just wondering how I could automatically increment build (and version?) of my files when using Visual Studio (2005).
If I look up the properties of say C:\Windows\notepad.exe, the Version tab gives "File version: 5.1.2600.2180". I would like to get these cool numbers in the version of my dll's too, not version 1.0.0.0, which let's face it is a bit dull.
I tried a few things, but it doesn't seem to be out-of-box functionality, or maybe I'm just looking in the wrong place (as usual)
I work with mainly web projects....
Yah, I looked at both
and I couldn't believe it so much effort to do something is standard practise.
EDIT: It does not work in VS2005 as far I can tell (http://www.codeproject.com/KB/dotnet/AutoIncrementVersion.aspx)
open up the AssemblyInfo.cs file and change
// You can specify all the values or you can default the Build and Revision Numbers
// by using the '*' as shown below:
// [assembly: AssemblyVersion("1.0.*")]
[assembly: AssemblyVersion("1.0.0.0")]
[assembly: AssemblyFileVersion("1.0.0.0")]
to
[assembly: AssemblyVersion("1.0.*")]
//[assembly: AssemblyFileVersion("1.0.0.0")]
you can do this in IDE by going to project -> properties -> assembly information
This however will only allow you to auto increment the Assembly version and will give you the "Assembly File Version: A wildcard ("*") is not allowed in this field" message box if you try place a * in the file version field.
So just open up the assemblyinfo.cs and do it manually.
In visual Studio 2008, the following works.
Find the AssemblyInfo.cs file and find these 2 lines:
[assembly: AssemblyVersion("1.0.0.0")]
[assembly: AssemblyFileVersion("1.0.0.0")]
You could try changing this to:
[assembly: AssemblyVersion("1.0.*")]
[assembly: AssemblyFileVersion("1.0.*")]
But this won't give you the desired result, you will end up with a Product Version of 1.0.* and a File Version of 1.0.0.0. Not what you want!
However, if you remove the second of these lines and just have:
[assembly: AssemblyVersion("1.0.*")]
Then the compiler will set the File Version to be equal to the Product Version and you will get your desired result of an automatically increment product and file version which are in sync. E.g. 1.0.3266.92689
Another option for changing version numbers in each build is to use the Version task of MSBuild.Community.Tasks. Just download their installer, install it, then adapt the following code and paste it after <Import Project="$(MSBuildBinPath)\Microsoft.CSharp.targets" /> in your .csproj file:
<Import Project="$(MSBuildExtensionsPath)\MSBuildCommunityTasks\MSBuild.Community.Tasks.Targets" />
<Target Name="BeforeBuild">
<Version VersionFile="Properties\version.txt" Major="1" Minor="0" BuildType="Automatic" StartDate="12/31/2009" RevisionType="BuildIncrement">
<Output TaskParameter="Major" PropertyName="Major" />
<Output TaskParameter="Minor" PropertyName="Minor" />
<Output TaskParameter="Build" PropertyName="Build" />
<Output TaskParameter="Revision" PropertyName="Revision" />
</Version>
<AssemblyInfo CodeLanguage="CS"
OutputFile="Properties\VersionInfo.cs"
AssemblyVersion="$(Major).$(Minor)"
AssemblyFileVersion="$(Major).$(Minor).$(Build).$(Revision)" />
</Target>
Note: Adapt the StartDate property to your locale. It currently does not use the invariant culture.
For the third build on January 14th, 2010, this creates a VersionInfo.cs with this content:
[assembly: AssemblyVersion("1.0")]
[assembly: AssemblyFileVersion("1.0.14.2")]
This file then has to be added to the project (via Add existing item), and the AssemblyVersion and AssemblyFileVersion lines have to be removed from AssemblyInfo.cs.
The different algorithms for changing the version components are described in $(MSBuildExtensionsPath)\MSBuildCommunityTasks\MSBuild.Community.Tasks.chm and Version Properties.
Just install the Build Version Increment addin. This little addin gives you way more control then the * option.
Setting a * in the version number in AssemblyInfo or under project properties as described in the other posts does not work with all versions of Visual Studio / .NET.
Afaik it did not work in VS 2005 (but in VS 2003 and VS 2008). For VS 2005 you could use the following: Auto Increment Visual Studio 2005 version build and revision number on compile time.
But be aware that changing the version number automatically is not recommended for strong-named assemblies. The reason is that all references to such an assembly must be updated each time the referenced assembly is rebuilt due to the fact that strong-named assembly references are always a reference to a specific assembly version. Microsoft themselves change the version number of the .NET Framework assemblies only if there are changes in interfaces. (NB: I'm still searching for the link in MSDN where I read that.)
To get the version numbers try
System.Reflection.Assembly assembly = System.Reflection.Assembly.GetExecutingAssembly()
System.Reflection.AssemblyName assemblyName = assembly.GetName();
Version version = assemblyName.Version;
To set the version number, create/edit AssemblyInfo.cs
[assembly: AssemblyVersion("1.0.*")]
[assembly: AssemblyFileVersion("1.0.*")]
Also as a side note, the third number is the number of days since 2/1/2000 and the fourth number is half of the amount of total seconds in the day. So if you compile at midnight it should be zero.
Set the version number to "1.0.*" and it will automatically fill in the last two number with the date (in days from some point) and the time (half the seconds from midnight)
Go to Project | Properties and then Assembly Information and then Assembly Version and put an * in the last or the second-to-last box (you can't auto-increment the Major or Minor components).
Use the AssemblyInfo task from the MSBuild Community Tasks (http://msbuildtasks.tigris.org/) project, and integrate it into your .csproj/.vbproj file.
It has a number of options, including one to tie the version number to the date and time of day.
Recommended.
I came up with a solution similar to Christians but without depending on the Community MSBuild tasks, this is not an option for me as I do not want to install these tasks for all of our developers.
I am generating code and compiling to an Assembly and want to auto-increment version numbers. However, I can not use the VS 6.0.* AssemblyVersion trick as it auto-increments build numbers each day and breaks compatibility with Assemblies that use an older build number. Instead I want to have a hard-coded AssemblyVersion but a auto-incrementing AssemblyFileVersion. I've accomplished this by specifying AssemblyVersion in the AssemblyInfo.cs and generating a VersionInfo.cs in MSBuild like this,
<PropertyGroup>
<Year>$([System.DateTime]::Now.ToString("yy"))</Year>
<Month>$([System.DateTime]::Now.ToString("MM"))</Month>
<Date>$([System.DateTime]::Now.ToString("dd"))</Date>
<Time>$([System.DateTime]::Now.ToString("HHmm"))</Time>
<AssemblyFileVersionAttribute>[assembly:System.Reflection.AssemblyFileVersion("$(Year).$(Month).$(Date).$(Time)")]</AssemblyFileVersionAttribute>
</PropertyGroup>
<Target Name="BeforeBuild">
<WriteLinesToFile File="Properties\VersionInfo.cs" Lines="$(AssemblyFileVersionAttribute)" Overwrite="true">
</WriteLinesToFile>
</Target>
This will generate a VersionInfo.cs file with an Assembly attribute for AssemblyFileVersion where the version follows the schema of YY.MM.DD.TTTT with the build date. You must include this file in your project and build with it.
As of right now, for my application,
string ver = Application.ProductVersion;
returns
ver = 1.0.3251.27860
The value 3251 is the number of days since 1/1/2000. I use it to put a version creation date on the splash screen of my application. When dealing with a user, I can ask the creation date which is easier to communicate than some long number.
(I'm a one-man dept supporting a small company. This approach may not work for you.)
Each time I do a build it auto-increments the least-significant digit.
I don't have any idea how to update the others, but you should at least be seeing that already...
It is in your project properties under publish
Is there any built-in, add-in solution for visual studio to compare two files and display result with differences? I could't find one...
I use WinMerge. Not as good as Beyond Compare but it's free and open source.
Also check out Visual Studio Comparison Tools, it's a Visual Studio add-in that connects it to WinMerge.
Here is an excellent post that describes integration of many 3rd party diff and merge tools into Visual Studio - including araxis, beyond compare, WinMerge and many others. The post is badly needed, since the command-line parameters that VS can supply aren't fully documented.
Personally, I switched from the built-in tool to Araxis, and am generally happy with it. I am also curious about bazaar, which supposedly (according to the colorful author of its diff-component), "solves the diff problem"... Anyone has any experience with that?
Visual Studio 2005 Team Edition has a built in version (based on WinDiff?) but you can incorporate third party tools e.g.
Beyond Compare which I regularly use.
See here for how-to.
That functionality appears to be related to Source Control. So it is really as source control issue.
If you are not using Source Control - You should be - Try The Vault from www.sourcegear.com for a good (and free for one user) commercial source control system. There are others and they should come with a comparision tool (The Vault has one and its installed into VS when you install the vault client and connect to a source controlled project).
In addition to djeidot's answer: beware if you're using Visual Studio 2010, Visual Studio Comparison Tools works very well with VS 2008, but does not under VS 2010...
Not that I know of, but Beyond Compare is probably worth a look anyway.
Depending on your use case I'd recommend VisualSVN. You'll get the source control feature of SVN built into the VS IDE plus the ability to compare any source code file with any checked in version file from SVN.
It installs all the prerequites for you SVN (Subversion), TortoiseSVN, Diff, AND VisualSVN (The Visual Studio Integration).
It also has a nice quick windows installer for the SVN server which worries about apache etc. so you don't have to.
Essential for the non linux geek, it it not free but at $49 it is a bargain,
SlickEdit Tools Versioning Toolbox has the same diff tool built in as the SlickEdit programmer's editor. The Versioning Toolbox is not free but isn't that expensive either. The diff tool is very nice.
As for me, CodeCompare is a useful solution for your task. You can compare, merge and edit data within one environment - in the Visual Studio.
I was using CodeRush quite while ago and now I'm planning to use it again. I've installed the trial but I forgot all the cool features except Alt + Home (drop a marker). And when you don't know some cool tricks it's really like burning money (since it's not cheap for personal use).
What do you like about it? What are your best features?
My best feature is marker: Alt + Home (and use escape to go back)
P.S.: Dear DevExpress, if you think I helped you by asking this question I can accept some donations, a free license of CodeRush would be nice!
Currently What I like most
I recently installed the Xpress version and went on a similar hunt. This cheat-sheet is what I found so far. The XPress version is pretty gimped BTW so I'm trying to get funding for a license.
I use these a lot:
/ will comment or uncomment highlighted blocks of code.
b will wrap a highlighted selection in braces.
Ctrl + 3 will wrap a selection into a region.
tc will generate a try/catch block.
mbs will write a MessageBox.Show(""); and drop the cursor in the quotes.
cws will do the same but with Console.Writeline.
m will create a method block (ms would do a method block that returns type string).
. will make a comment block.
"NumPad+Plus" widens the scope of your selection one level.
Try it. It's sublime :)
F2 - Rename
Strictly this is a RefactorPro shortcut as the Rename functionality is for RefactorPro. (However since RefactorPro is included in the Price of Coderush that should not be an issue)
It is also, I think, Disabled by default.
You should be able to use the DevExpress\options...IDE\Shortcuts screen to search for F2 and re-enable it.
Very natural to rename Vars and Methods using F2 when you're already used to F2 functionality for Files and Folders in Explorer.
rt / rf = For Return True and False
Search for Type
QuickNav (Ctrl+Shift+Q) can be a bit excessive at times....
If you know you're looking for a Type, bind Ctrl+T to QuickNav using additional params of "AllTypes,, AllVisibilities, CurrentSolution" (without quotes)
This will allow you to search for only Types in the current solution
These params can be tweaked to your liking. See http://community.devexpress.com/forums/p/66380/225556.aspx#225556 for details
Search for Member
QuickNav (Ctrl+Shift+Q) can be a bit excessive at times....
If you know you're looking for a Method, bind Ctrl+M to QuickNav using additionial params of "AllTypes, AllMembers, AllVisibilities, CurrentFile" (without quotes)
This will allow you to search for only Members in the current file.
These params can be tweaked to your liking. See http://community.devexpress.com/forums/p/66380/225556.aspx#225556 for details
This is an old post on the DevExpress Coderush Forum:
In it is a setting suggestion by Mark Miller to enhance the default "Embed in Parenthesis" feature of CodeRush.
Once in place ... highlight some text and hit '('. your selection will be wrapped in Parenthesis and more importantly your caret will be on the left of the selection. (Similar applies to the Right Parenthesis)
Ideal for VB.Net users to use alongside CInt, CStr etc
Inside VS.NET
Press "Ctrl + Shift + Alt + O" will list all the DX Options (and putting shortcuts in the search box will bring you to the keyboard bindings)
CR_MetricShader: is a free open source plugin for CodeRush or CodeRush Xpress which will allow you to see visually when your method's complexity is getting out of hand.
It alters the background color of your method to indicated severity with respect to your chosen Metric.
Works with the built in metrics of CodeRush (and the hidden ones in CodeRush Xpress) aswell as being compatible with any you might choose to create yourself.
Here is a simple CodeRush Template for generating guard clauses.
Type inx space within a method, whilst you have a variable reference on the clipboard and you'll get...
If [VariableName] Is nothing Then
return
End If
or
if ([VariableName] == null)
{
return;
}
... depending on the language you're currently operating in.
This Template is often referred to within DevExpress Webinars as If Not Null or If Null Exit
Greetings,
I have a utility (grep) that gives me a list of filenames and a line numbers. After I have determined that devenv is the correct program to open a file, I would like to ensure that it is opened at the indicated line number. In emacs, this would be:
emacs +140 filename.c
I have found nothing like this for Visual Studio (devenv). The closest I have found is:
devenv /Command "Edit.Goto 140" filename.c
However, this makes a separate instance of devenv for each such file. I would rather have something that uses an existing instance.
These variations re-use an existing devenv, but don't go to the indicated line:
devenv /Command "Edit.Goto 140" /Edit filename.c
devenv /Command /Edit filename.c "Edit.Goto 140"
I thought that using multiple "/Command" arguments might do it, but I probably don't have the right one because I either get errors or no response at all (other than opening an empty devenv).
I could write a special macro for devenv, but I would like this utility to be used by others that don't have that macro. And I'm not clear on how to invoke that macro with the "/Command" option.
Any ideas?
Well, it doesn't appear that there is a way to do this as I wanted. Since it looks like I'll need to have dedicated code to start up Visual Studio, I've decided to use EnvDTE as shown below. Hopefully this will help somebody else.
#include "stdafx.h"
//-----------------------------------------------------------------------
// This code is blatently stolen from http://benbuck.com/archives/13
//
// This is from the blog of somebody called "BenBuck" for which there
// seems to be no information.
//-----------------------------------------------------------------------
// import EnvDTE
#pragma warning(disable : 4278)
#pragma warning(disable : 4146)
#import "libid:80cc9f66-e7d8-4ddd-85b6-d9e6cd0e93e2" version("8.0") lcid("0") raw_interfaces_only named_guids
#pragma warning(default : 4146)
#pragma warning(default : 4278)
bool visual_studio_open_file(char const *filename, unsigned int line)
{
HRESULT result;
CLSID clsid;
result = ::CLSIDFromProgID(L"VisualStudio.DTE", &clsid);
if (FAILED(result))
return false;
CComPtr<IUnknown> punk;
result = ::GetActiveObject(clsid, NULL, &punk);
if (FAILED(result))
return false;
CComPtr<EnvDTE::_DTE> DTE;
DTE = punk;
CComPtr<EnvDTE::ItemOperations> item_ops;
result = DTE->get_ItemOperations(&item_ops);
if (FAILED(result))
return false;
CComBSTR bstrFileName(filename);
CComBSTR bstrKind(EnvDTE::vsViewKindTextView);
CComPtr<EnvDTE::Window> window;
result = item_ops->OpenFile(bstrFileName, bstrKind, &window);
if (FAILED(result))
return false;
CComPtr<EnvDTE::Document> doc;
result = DTE->get_ActiveDocument(&doc);
if (FAILED(result))
return false;
CComPtr<IDispatch> selection_dispatch;
result = doc->get_Selection(&selection_dispatch);
if (FAILED(result))
return false;
CComPtr<EnvDTE::TextSelection> selection;
result = selection_dispatch->QueryInterface(&selection);
if (FAILED(result))
return false;
result = selection->GotoLine(line, TRUE);
if (FAILED(result))
return false;
return true;
}
With VS2008 SP1, you can use the following command line to open a file at a specific line in an existing instance :
devenv /edit FILE_PATH /command "edit.goto FILE_LINE"
I can't figure out a way to do this with straight command-line options. It looks like you will have to write a macro for it. Supposedly, you can invoke them like so.
devenv /command "Macros.MyMacros.Module1.OpenFavoriteFiles"
So, you can probably create a macro that takes a filename and a line number, then opens the file and jumps to the proper place. But, I don't know that you can specify a same-instance flag somewhere, or not.
I've read Rick Strahl's article on Linq to SQL DataContext Lifetime Management hoping to find some answers on how I would manage my .dbml files since they are so closely related to DataContext. Unfortunately, Rick's article seems to be focused on DataContext lifetime at runtime though, and my question is concerned with how the .dbml's should be organized at design time.
The general question of 'Best practices with .dbml's' has been asked and answered here, and the answers have focused on external tools to manage the .dbml.
I'm asking a more focused question of when and why should you not have a single .dbml file in your LINQ to SQL based project?
Please note that LINQ2SQL is intended for simple and easy way to handle database relationship with objects.
Do not break table relationship and units of work concepts by creating multiple .dbml files.
If you ever need to create multiple .dbml files (which i don't recommend), then try to satisfy the following:-
If your database is too complex, then I would consider ORM such as NHibernate, EF 4
I'd say, you always just need 1 dbml-file PER database. If you have multiple connections to other databases, consider design or use seperate dbml-files. Either way, one is enough per database.
This because the dbml mapps to your tables and why not just use one "data connector" / "data layer" for that, seems odd / weird design to use more than one.
It's probably more controllable using only 1 aswell.
In my opinion, you can split the .dmbl files so that each hold a subset of tables/procs from a DB according to function and relationship. I have not done this yet so this is just opinion.
I have however created multiple .dbml files to assist with unit testing. If you work in an environment which restricts you to using stored procs in your production environment then you cannot use the table part of the .dbml (you can use the proc part though). So if you "unit test" (this is really integration testing) the DB layer of your code you can call the proc wrapper and then check the results by querying the tables through the .dbml interface. In cases like this I'll split the .dmbl file into just the tables that I want to query in my "unit test."
Further info: I have 2 solutions that I build. One has unit tests and is never built on the build server. The other is built on the build server and deployed to test/production.
This issue has been thoroughly analyzed here: http://craftycode.wordpress.com/2010/07/19/linq-to-sql-single-data-context-or-multiple/
In summary, you should create at most one data context per strongly connected group of tables, or one data context per database.
Say you have a database:
Database D contains tables A, B, C, X, Y, Z where
Say you have 2 DBML files P and Q based on database D
AFAIK, there is no way for DBML files P and Q to contain an association between entities A' and X'. This is the single biggest problem with having multiple DBML files.
To my mind, a DBML file reflects the data-model represented by the tables and constraints on those tables in a database. If some tables or constraints are missing from a set of DBML files, then the set of DBML files do not accurately reflect the underlying database.
Going back to our example, if there was no relationship between tables A and X in database D, then one would be able to create 2 DBML files.
Generically speaking, one can have multiple DBML files if each DBML file contains all entities and relationships that are connected. Note that the converse is not a problem, i.e., one can have a single DBML file containing multiple groups of entities that are not related to each other by any associations.
Yes, hm, I read the thorough analysis in craftycodeblog, but wouldn't it be nice if you could get all the benefits from both sides?
I want to have a single DataContext for my application, but still split it into multiple .dbml files (and multiple dbml.layout and designer.cs files). I assume this is not supported by Visual Studio, but it would solve all problems.
The use case is this: A large application is composed of several modules, each of which adds a set of tables (and of course code) to the application (i.e. to a single database) and has access to the code and the tables of other modules.
Let's say module ABC defines tables A, B, C, and module XYZ defines tables X, Y, Z. The XYZ tables may have foreign keys to the ABC tables. It would be best if: * When working with the code of module ABC you "see" only the ABC tables, both in the designer and in the linq editor. * When working with the code of module XYZ, you can see only XYZ tables in the dbml designer, so that you reduce clutter and see only your module's schema. The linq editor should have access to both ABC and XYZ tables.
The answer is tricky because it's what the situation requires. I try to logically separate each DBML into contexts (after all, the DBML provides the DataContext functionality). So if my app has a single context, then it doesn't make sense for me to have a separate DBML for each table. Context is king when creating your DBML files is what I say.
Another thing to bear in mind is that LINQ uses the DataContext to track the identities of the instances of entities it creates. Therefore, an entity representing a row in a table created by one instance of the DataContext class is not the same as one created by another, even if all the properties are the same.
When one has multiple DBML files, then by necessity, there will be multiple instances of DataContexts, one for each DBML file. Therefore, entities can't be joined or shared from one DataContext to another.
This is applicable when an entity exists in both (or all) DBML files.
Is there a way to disable the drag&drop functionality for Solution Explorer? Why would you ask? I'm using an wacom pen tablet for quite some years and I love it. But when you use it in solution explorer in combination with a source control like TFS or AnkhSvn it's a disaster when you accidentally move a file into an different directory.
I currently set visual studio to prompt when files are wanted to check out, but when a solution/project file already is checked out then the above problems still exist.
There is a plugin to Visual Studio 2010 that will prompt you drag & drop files in Solution Explorer: http://visualstudiogallery.msdn.microsoft.com/en-us/d491911d-97f3-4cf6-87b0-6a2882120acf
Sadly, turning off the drag and drop function in the Sollution Explorer is not possible.
Edit: The third post (by a Microsoft employee) in this Microsoft Forum thread confirms this.
Edit: Judging from this entry on Microsoft connect it also looks like this is something they have no intention of improving.
How do I set the executable icon for my C++ application in visual studio 2008?
First go to Resource View (from menu: View --> Other Window --> Resource View). Then in Resource View navigate through resources, if any. If there is already a resource of Icon type, added by Visual Studio, then open and edit it. Otherwise right-click and select Add Resource, and then add a new icon.
Use the embedded image editor in order to edit the existing or new icon. Note that an icon can include several types (sizes), selected from Image menu.
Then compile your project and see the effect.
See: http://social.microsoft.com/Forums/en-US/vcgeneral/thread/87614e26-075c-4d5d-a45a-f462c79ab0a0
The important thing is that the icon you want to be displayed as the application icon ( in the title bar and in the task bar ) must be the FIRST icon in the resource script file
The file is in the res folder and is named (applicationName).rc
/////////////////////////////////////////////////////////////////////////////
//
// Icon
//
// Icon with lowest ID value placed first to ensure application icon
// remains consistent on all systems.
(icon ID ) ICON "res\\filename.ico"
In the solutions explorer right click your program and select properties. Under the resource section select Icon and manifest, then browse to the location of your icon.
Does Visual Studio .NET have a way to toggle word-wrap on and off?
I am used to this feature in Eclipse which allows you to right click and toggle word wrap on and off so that when you have long lines that extend out to the right, you don't have to move the bottom scroll bar right and left to read your code/html: http://ahtik.com/blog/2006/06/18/first-alpha-of-eclipse-word-wrap-released/
All version of Visual Studio: Tools -> Options -> Text Editor -> All Languages -> Word Wrap
Visual studio 2005, 2008 & 2010: ctrl+E+W
Visual Studio 2003 & 2005 only: Edit->Advanced->Word Wrap
Visual studio 2003: ctrl+R+R
I use this feature often enough that I add a custom button to the command bar.
In VS2008, CTRL E+W
Edit->Advanced->Word Wrap in VS 2003
In Visual studio 2008 it is ctrl+E+W
in vs 2005 Pro: Ctrl-E, Ctrl-W
or Edit->Advanced->Word Wrap
Ok, this is my own fault, but I can't seem to rescue myself.
Whenever I try to step into a class that has fields with assignments calling into .NET code, I get a dialog box that contains this text:
For instance, stepping into the constructor of the following class would give me the above message:
public class Test
{
private Stack<String> _Dummy = new Stack<String>();
public Test() { }
}
I assume this is because at some point I fiddled with the settings for the symbol server, but no matter what I fiddle with now, I can't seem to get rid of that message.
Can anyone point out where my stupidity has forgotten what it did?
Summary of my current options:
See if some source files are accidentally excluded. Do properties of the solution and look at the Debug Source Files section under Common Properties.
Are the PDB files for your own code up to date?
I was also facing this issue and luckily find out following solution.
If you do not want to debug .NET assembly, a quick fix to avoid "No source available to current location" problem is to uncheck "Require source files to exactly match the original version" check-box under Tool -> Options -> Debugging -> General
Please let me know, if it solves your problem.
Thanks Shilpa
If you don't want this annoying tab to appear, you can try this add-on that I created: http://erwinmayer.com/labs/visual-studio-2010-extension-disable-no-source-available-tab/
It is directly downloadable on the Visual Studio Gallery: http://visualstudiogallery.msdn.microsoft.com/en-us/fdbb2036-471e-40a7-b20e-31f8fd5578fa
Check if your projects have a project reference not dll reference! If there exists a dll reference, your changes will not be recognized by your referenced project and you will get an error message like yours.
This error made me go crazy as well. I was using 'AjaxControlToolkit' and had referenced it using 'Add Reference' to my project.
Deleted the 'AjaxControlToolkit' reference and added the same with 'Add Exissting Item' and no problems at all...
I'm moving from Eclipse to Visual Studio .NET and have found all my beloved hotkeys except two:
Has anyone discovered these hotkey features in Visual Studio .NET?
A D D E N D U M :
An example of when you would use the second feature described above is to move the bottom line here up into the for loop. In Eclipse, you would put the cursor on the Console.WriteLine and then press ALT-(uparrow), I use that all the time: one key stroke to move lines up and down.
for (int i = 0; i < 10; i++) {
}
Console.WriteLine(i);
Ok, extrapolating Charlie's idea with no-selection-ctrl-c to select a line, in Visual Studio you could put your cursor on Console.WriteLine, (no selection) press CTRL-X and then move up and press CTRL-V.
The answers proposed work, but none of them are as nice as eclipse with regard to how they preserve the existing paste buffer, the currently selected characters, and they do not allow the user to operate upon a range of lines. Here is a solution I came up with that preserves the paste buffer, the current character selection, and works with or without a selection (that may or may not span multiple rows):
'' Duplicates the current line (or selection of lines) and places the copy
'' one line below or above the current cursor position (based upon the parameter)
Sub CopyLine(ByVal movingDown As Boolean)
DTE.UndoContext.Open("CopyLine")
Dim objSel As TextSelection = DTE.ActiveDocument.Selection
' store the original selection and cursor position
Dim topPoint As TextPoint = objSel.TopPoint
Dim bottomPoint As TextPoint = objSel.BottomPoint
Dim lTopLine As Long = topPoint.Line
Dim lTopColumn As Long = topPoint.LineCharOffset
Dim lBottomLine As Long = bottomPoint.Line
Dim lBottomColumn As Long = bottomPoint.LineCharOffset()
' copy each line from the top line to the bottom line
Dim readLine As Long = lTopLine
Dim endLine As Long = lBottomLine + 1
Dim selectionPresent As Boolean = ((lTopLine <> lBottomLine) Or (lTopColumn <> lBottomColumn))
If (selectionPresent And (lBottomColumn = 1)) Then
' A selection is present, but the cursor is in front of the first character
' on the bottom line. exclude that bottom line from the copy selection.
endLine = lBottomLine
End If
' figure out how many lines we are copying, so we can re-position
' our selection after the copy is done
Dim verticalOffset As Integer = 0
If (movingDown) Then
verticalOffset = endLine - lTopLine
End If
' copy each line, one at a time.
' The Insert command doesn't handle multiple lines well, and we need
' to use Insert to avoid autocompletions
Dim insertLine As Long = endLine
While (readLine < endLine)
' move to read postion, and read the current line
objSel.MoveToLineAndOffset(readLine, 1)
objSel.EndOfLine(True) 'extend to EOL
Dim lineTxt As String = objSel.Text.Clone
' move to the destination position, and insert the copy
objSel.MoveToLineAndOffset(insertLine, 1)
objSel.Insert(lineTxt)
objSel.NewLine()
' adjust the read & insertion points
readLine = readLine + 1
insertLine = insertLine + 1
End While
' restore the cursor to original position and selection
objSel.MoveToLineAndOffset(lBottomLine + verticalOffset, lBottomColumn)
objSel.MoveToLineAndOffset(lTopLine + verticalOffset, lTopColumn, True)
DTE.UndoContext.Close()
End Sub
'' Duplicates the current line (or selection of lines) and places the copy
'' one line below the current cursor position
Sub CopyLineDown()
CopyLine(True)
End Sub
'' Duplicates the current line (or selection of lines) and places the copy
'' one line above the current cursor position
Sub CopyLineUp()
CopyLine(False)
End Sub
'' Moves the selected lines up one line. If no line is
'' selected, the current line is moved.
''
Sub MoveLineUp()
DTE.UndoContext.Open("MoveLineUp")
Dim objSel As TextSelection = DTE.ActiveDocument.Selection
' store the original selection and cursor position
Dim topPoint As TextPoint = objSel.TopPoint
Dim bottomPoint As TextPoint = objSel.BottomPoint
Dim lTopLine As Long = topPoint.Line
Dim lTopColumn As Long = topPoint.LineCharOffset
Dim lBottomLine As Long = bottomPoint.Line
Dim lBottomColumn As Long = bottomPoint.LineCharOffset()
Dim textLineAbove As TextSelection = DTE.ActiveDocument.Selection
textLineAbove.MoveToLineAndOffset(lTopLine - 1, 1, False)
textLineAbove.MoveToLineAndOffset(lTopLine, 1, True)
Dim indentChange As Integer = CountIndentations(textLineAbove.Text) * -1
' If multiple lines are selected, but the bottom line doesn't
' have any characters selected, don't count it as selected
Dim lEffectiveBottomLine = lBottomLine
If ((lBottomColumn = 1) And (lBottomLine <> lTopLine)) Then
lEffectiveBottomLine = lBottomLine - 1
End If
' move to the line above the top line
objSel.MoveToLineAndOffset(lTopLine - 1, 1)
' and move it down, until its below the bottom line:
Do
DTE.ExecuteCommand("Edit.LineTranspose")
Loop Until (objSel.BottomPoint.Line >= lEffectiveBottomLine)
' Since the line we are on has moved up, our location in the file has changed:
lTopLine = lTopLine - 1
lBottomLine = lBottomLine - 1
IndentBlockAndRestoreSelection(objSel, lBottomLine, lBottomColumn, lTopLine, lTopColumn, indentChange)
DTE.UndoContext.Close()
End Sub
'' Moves the selected lines down one line. If no line is
'' selected, the current line is moved.
''
Sub MoveLineDown()
DTE.UndoContext.Open("MoveLineDown")
Dim objSel As TextSelection = DTE.ActiveDocument.Selection
' store the original selection and cursor position
Dim topPoint As TextPoint = objSel.TopPoint
Dim bottomPoint As TextPoint = objSel.BottomPoint
Dim lTopLine As Long = topPoint.Line
Dim lTopColumn As Long = topPoint.LineCharOffset
Dim lBottomLine As Long = bottomPoint.Line
Dim lBottomColumn As Long = bottomPoint.LineCharOffset()
' If multiple lines are selected, but the bottom line doesn't
' have any characters selected, don't count it as selected
Dim lEffectiveBottomLine = lBottomLine
If ((lBottomColumn = 1) And (lBottomLine <> lTopLine)) Then
lEffectiveBottomLine = lBottomLine - 1
End If
Dim textLineBelow As TextSelection = DTE.ActiveDocument.Selection
textLineBelow.MoveToLineAndOffset(lEffectiveBottomLine + 1, 1, False)
textLineBelow.MoveToLineAndOffset(lEffectiveBottomLine + 2, 1, True)
Dim indentChange As Integer = CountIndentations(textLineBelow.Text)
' move to the bottom line
objSel.MoveToLineAndOffset(lEffectiveBottomLine, 1)
' and move it down, which effectively moves the line below it up
' then move the cursor up, always staying one line above the line
' that is moving up, and keep moving it up until its above the top line:
Dim lineCount As Long = lEffectiveBottomLine - lTopLine
Do
DTE.ExecuteCommand("Edit.LineTranspose")
objSel.LineUp(False, 2)
lineCount = lineCount - 1
Loop Until (lineCount < 0)
' Since the line we are on has moved down, our location in the file has changed:
lTopLine = lTopLine + 1
lBottomLine = lBottomLine + 1
IndentBlockAndRestoreSelection(objSel, lBottomLine, lBottomColumn, lTopLine, lTopColumn, indentChange)
DTE.UndoContext.Close()
End Sub
'' This method takes care of indenting the selected text by the indentChange parameter
'' It then restores the selection to the lTopLine:lTopColumn - lBottomLine:lBottomColumn parameter.
'' It will adjust these values according to the indentChange performed
Sub IndentBlockAndRestoreSelection(ByVal objSel As TextSelection, ByVal lBottomLine As Long, ByVal lBottomColumn As Long, ByVal lTopLine As Long, ByVal lTopColumn As Long, ByVal indentChange As Integer)
' restore the cursor to original position and selection
objSel.MoveToLineAndOffset(lBottomLine, lBottomColumn)
objSel.MoveToLineAndOffset(lTopLine, lTopColumn, True)
If (indentChange = 0) Then
' If we don't change the indent, we are done
Return
End If
If (lBottomLine = lTopLine) Then
If (indentChange > 0) Then
objSel.StartOfLine()
Else
objSel.StartOfLine()
objSel.WordRight()
End If
End If
objSel.Indent(indentChange)
' Since the selected text has changed column, adjust the columns accordingly:
' restore the cursor to original position and selection
Dim lNewBottomColumn As Long = (lBottomColumn + indentChange)
Dim lNewTopColumn As Long = (lTopColumn + indentChange)
' ensure that we we still on the page.
' The "or" clause makes it so if we were at the left edge of the line, we remain on the left edge.
If ((lNewBottomColumn < 2) Or (lBottomColumn = 1)) Then
' Single line selections, or a bottomColumn that is already at 1 may still have a new BottomColumn of 1
If ((lTopLine = lBottomLine) Or (lBottomColumn = 1)) Then
lNewBottomColumn = 1
Else
' If we have multiple lines selected, don't allow the bottom edge to touch the left column,
' or the next move will ignore that bottom line.
lNewBottomColumn = 2
End If
End If
If ((lNewTopColumn < 2) Or (lTopColumn = 1)) Then
lNewTopColumn = 1
End If
' restore the selection to the modified selection
objSel.MoveToLineAndOffset(lBottomLine, lNewBottomColumn)
objSel.MoveToLineAndOffset(lTopLine, lNewTopColumn, True)
End Sub
'' This method counts the indentation changes within the text provided as the paramter
Function CountIndentations(ByVal text As String) As Integer
Dim indent As Integer = 0
While (Text.Length > 0)
If (Text.StartsWith("//")) Then
Dim endOfLine As Integer = Text.IndexOf("\n", 2)
If (Equals(endOfLine, -1)) Then
' The remaining text is all on one line, so the '//' terminates our search
' Ignore the rest of the text
Exit While
End If
' continue looking after the end of line
Text = Text.Substring(endOfLine + 1)
End If
If (Text.StartsWith("/*")) Then
Dim endComment As Integer = Text.IndexOf("*/", 2)
If (Equals(endComment, -1)) Then
' This comment continues beyond the length of this line.
' Ignore the rest of the text
Exit While
End If
' continue looking after the end of this comment block
Text = Text.Substring(endComment + 1)
End If
If (Text.StartsWith("{")) Then
indent = indent + 1
Else
If (Text.StartsWith("}")) Then
indent = indent - 1
End If
End If
Text = Text.Substring(1)
End While
Return indent
End Function
I edited this post to add the UndoContext mechanism (suggested by Nicolas Dorier) at the beginning of the MoveLineUp() and MoveLineDown() methods and closing it at their end. 11/23/11 - I updated this again to allow the moved lines to indent themselves as you cross bracket boundaries
If you haven't already found it, the place where these keyboard shortcuts are setup is under Tools | Options | Environment | Keyboard. A lot of handy commands can be found just by browsing through the list, although unfortunately I've never found any good reference for describing what each command is intended to do.
As for specific commands:
I believe the forward/backward navigation commands you're referring to are View.NavigateBackward and View.NavigateForward. If your keyboard isn't cooperating with the VS key bindings, you can remap them to your preferred Eclipse keys. Unfortunately, I don't know of a way to change the algorithm it uses to actually decide where to go.
I don't think there's a built-in command for duplicating a line, but hitting Ctrl+C with no text selected will copy the current line onto the clipboard. Given that, here's a simple macro that duplicates the current line on the next lower line:
Sub CopyLineBelow()
DTE.ActiveDocument.Selection.Collapse()
DTE.ActiveDocument.Selection.Copy()
DTE.ActiveDocument.Selection.Paste()
End Sub
Sub CopyLineAbove()
DTE.ActiveDocument.Selection.Collapse()
DTE.ActiveDocument.Selection.Copy()
DTE.ActiveDocument.Selection.LineUp()
DTE.ActiveDocument.Selection.Paste()
End Sub
Sub MoveLineUp()
DTE.ActiveDocument.Selection.Collapse()
DTE.ActiveDocument.Selection.Cut()
DTE.ActiveDocument.Selection.LineUp()
DTE.ActiveDocument.Selection.Paste()
DTE.ActiveDocument.Selection.LineUp()
End Sub
If you haven't yet started playing with macros, they are really useful. Tools | Macros | Macros IDE will take you the editor, and once they're defined, you can setup keyboard shortcuts through the same UI I mentioned above. I generated these macros using the incredibly handy Record Temporary Macro command, also under Tools | Macros. This command lets you record a set of keyboard inputs and replay them any number of times, which is good for building advanced edit commands as well as automating repetitive tasks (e.g. code reformatting).
For anyone looking for a way to do this in Visual Studio 2010, the free Visual Studio 2010 Pro Power Tools extension adds the capability to move lines up and down.
http://visualstudiogallery.msdn.microsoft.com/en-us/d0d33361-18e2-46c0-8ff2-4adea1e34fef
I have recently done the same thing and moved from Eclipse to Visual Studio when I moved onto a new project. The Resharper add in is highly recommended - it adds some of the rich editing, navigational and refactoring functionality that eclipse has to VS.
Resharper also allows you to use a keybaord mapping scheme that is very simillar to InteliJ. Very handy for the Java escapees...
Regarding your second question, Resharper has the same move code up / down function as eclipse, but with some caveats. Firstly, using the InteliJ keyboard mappings, the key combination is rather tortuous.
Move code up: ctrl + shift + alt + up cursor
Move code down: ctrl + shift + alt + down cursor
Secondly, it does not always move by just one line, but actually jumps code blocks. So it cannot move a line from outside an if statement to inside it - it jumps the selected line right over the if block. To do that you need to move "left" and "right" using
Move code into outer code block: ctrl + shift + alt + left cursor
Move code into next inner code block: ctrl + shift + alt + right cursor
Record a macro in visual studio to do the alt-arrow thing:
ctrl-alt-r -- record mode
ctrl-c -- copy a line
up arrow -- go up a line
home -- beginning of line (maybe there is a way to paste before the current line without this)
ctrl-v -- paste
ctrl-alt-r -- end record mode
Now you can map this macro to any set of keystrokes you like using the macros ide and the keyboard preferences.
I don't know if VS supports the features you're talking about natively, but I know the resharper plugin allows you to go to the previous edits by using CTRL + SHIFT + BACKSPACE. I don't think it has support for moving a line up and down tho (well not that I've found yet)
Edit.LineTranspose but this doesn't work to move a line up... Here is the macro to move line up
Sub LineTransposeUp()
Dim offset As Integer
Dim sel As TextSelection
DTE.UndoContext.Open("LineTransposeUp")
Try
sel = DTE.ActiveDocument.Selection
offset = sel.ActivePoint.LineCharOffset
sel.LineUp()
DTE.ExecuteCommand("Edit.LineTranspose")
sel.LineUp()
sel.MoveToLineAndOffset(sel.ActivePoint.Line, offset)
Catch ex As System.Exception
End Try
DTE.UndoContext.Close()
End Sub
Paul Ostrowski I tried your tool. It works mostly okay.
The other thing that eclipse does is move the line to the current indentation level.
For example:
function test()
{
// do stuff
}
Console.WriteLine("test");
Doing a shift-up on console.writeline would change it to
function test()
{
// do stuff
Console.WriteLine("test");
}
but your tool seems to do this:
function test()
{
// do stuff
Console.WriteLine("test");
}
I have a Visual Studio 2005 C++ program that runs differently in Release mode than it does in Debug mode. In release mode, there's an (apparent) intermittent crash occurring. In debug mode, it doesn't crash. What are some reasons that a Release build would work differently than a Debug build?
It's also worth mentioning my program is fairly complex and uses several 3rd party libraries for XML processing, message brokering, etc...
Thanks in advance!
Surviving the Release Version gives a good overview.
Things I have encountered - most are already mentioned
Variable initialization by far the most common. In Visual Studio, debug builds explicitely initialize allocated memory to given values, see e.g. Memory Values here. These values are usually easy to spot, cause an out of bounds error when used as an index or an access violation when used as a pointer. An uninitialized boolean is true, however, and may cause uninitialized memory bugs going undetected for years.
In Release builds where memory isn't explicitely initialized it just keeps the contents that it had before. This leads to "funny values" and "random" crashes, but as often to deterministic crashes that require an apparently unrelated command to be executed before the command that actually crashes. This is caused by the first command "setting up" the memory location with specific values, and when the memory locations are recycled the second command sees them as initializations. That's more common with uninitialized stack variables than heap, but the latter has happened to me, too.
Raw memory initialization can also be different in a release build whether you start from visual studio (debugger attached) vs. starting from explorer. That makes the "nicest" kind of release build bugs that never appear under the debugger.
Valid Optimizations come second in my exeprience. The C++ standard allows lots of optimizations to take place which may be surprising but are entirely valid e.g. when two pointers alias the same memory location, order of initialization is not considered, or multiple threads modify the same memory locations, and you expect a certain order in which thread B sees the changes made by thread A. Often, the compiler is blamed for these. Not so fast, young yedi! - see below
Timing Release builds don't just "run faster", for a variety of reasons (optimizations, logging functions providing a thread sync point, debug code like asserts not executed etc.) also the relative timing between operations change dramatically. Most common problem uncovered by that is race conditions, but also deadlocks and simple "different order" execution of message/timer/event-based code. Even though they are timing problems, they can be surprisingly stable across builds and platforms, with reproductions that "work always, except on PC 23".
Guard Bytes. Debug builds often put (more) guard bytes around selected instances and allocations, to protect against index overflows and sometimes underflows. In the rare cases where the code relies on offsets or sizes, e.g. serializing raw structures, they are different.
Other code differences Some instructions - e.g asserts - evaluate to nothing in release builds. Sometimes they have different side effects. This is prevalent with macro trickery, as in the classic (warning: multiple errors)
#ifdef DEBUG
#define Log(x) cout << #x << x << "\n";
#else
#define Log(x)
#endif
if (foo)
Log(x)
if (bar)
Run();
Which, in a release build, evaluates to if (foo && bar) This type of error is very very rare with normal C/C++ code, and macros that are correctly written.
Compiler Bugs This really never ever happens. Well - it does, but you are for the most part of your career better off assuming it does not. In a decade of working with VC6, I found one where I am still convinced this is an unfixed compiler bug, compared to dozens of patterns (maybe even hundreds of instances) with insufficient understanding of the scripture (a.k.a. the standard).
Variables that are not initialized explicitly will or might not be zeroed in Release build.
In debug version often assertions and/or debug symbols are enabled. This can lead to different memory layout. In case of a bad pointer, overflow of an array or similar memory access you access in one case critical bad memory (e.g. function pointer) and in other case maybe just some non-critical memory (e.g. just a doc string is trashed)
Release build (hopefully) would run faster than your debug build. If you are using more than one thread, you might see more interleaving, or simply one thread running faster than the others, which you may have not noticed in debug build.
Release builds are usually compiled with optimisation enabled in the compiler, while debug builds usually are not.
In some languages or when using many different libraries this can cause intermittent crashes - especially when the chosen optimization level is very high.
I know that this is the case with the gcc C++ compiler, but I'm not sure about Microsoft's compiler.
I had a similar problem not long ago, which ended up being caused by the stack being treated differently in release builds. Other things that can differ:
It depends both in the compiler vendor and the libraries you compile with the DEBUG flags. While DEBUG code should never affect running code (should have no side effects) it sometimes does.
In particular, variables may be initialized only in DEBUG mode and left uninitialized in RELEASE mode. The STL in Visual Studio compilers are different in DEBUG and RELEASE modes. The idea is that iterators are fully checked in DEBUG to detect possible errors (using invalidated iterators, for example an iterator into a vector is invalidated if an insertion occurs after the iterator is retrieved).
The same happens with third party libraries, the first that I can think of is QT4, that will terminate your program with an assert if a thread different to the one that created the graphical object performs painting operations.
With all the changes, your code and memory footprint will be different in both modes. A pointer (reading the position one pass the end of an array) problem may pass undetected if that position is readable.
Assertions are meant to kill the application during DEBUG and disappear from RELEASE builds, so I would not think on assertions as being your problem. A rogue pointer or accessing one past the end would be my first suspects.
Some time ago there were problems with some compiler optimizations breaking code, but I have not read complaints lately. There could be an optimization problem there, but this would not be my first suspect.
In my experience the most common reason seems to be that configurations differ in more ways than the release/build settings. E.g. different libs are included, or the debug build has a different stack size than the release build.
To avoid this in our Visual Studio 2005 projects we use property sheets extensively. This way the release and debug configurations can share common settings.
http://www.debuginfo.com/tips/userbpntdll.html
Due to the fact that guard bytes are added in debug builds, you may be able to "safely" access memory that is out-of-bounds for an array (particularly dynamic arrays), but this will cause an access violation in the release build. This error might go unnoticed, causing a corrupt heap and possibly an access violation in a place unrelated to the original error.
Use PageHeap (or, if you have Debugging Tools installed you could use gflags) to discover bugs related to corrupt heaps.
This post along with the links provided is very helpful in fixing related bug. adding to the above list, difference in calling conventions can also lead to this behavior - It failed in release build only with optimization for me. i declared as __stdcall and defined as __cdecl ( by default). [strangely this warning is not picked even in warn level 4 MSVC?]
As I've only ever used Visual Studio for .NET development, I would like to expand my horizons and see what else there is on offer as an alternative to it. So what in your opinion is the best alternative to Visual Studio? Is there a viable alternative?
If you're into C# and VB.Net and don't mind open source then you could use SharpDevelop. It does a pretty good job!
There are many alternatives, check this list:
Alternative IDEs to Visual Studio.NET
Edit: seem that the original site it's no longer working, here is an archive.org link:
There is also the free Visual Studio 2008 Express.
The other great thing about SharpDevelop is the ability to translate solutions between the two big managed .NET languages VB.NET and C#. I believe it doesn't work for "websites" but it does for web application projects.
There's MonoDevelop, which I occasionally use when I want to do some light C# coding when in Linux. It's nothing close to VS.Net, but it works for small projects. I really don't think most of the alternatives people have listed come anywhere close to VS.Net.
coderun, a browser based .Net IDE!
It also helps you to stop using your mouse so much!
As far as .net languages go, VS is hard to beat.
I have used SharpDevelop before for .net, and is overall pretty good.
For other languages like Java, Eclipse is really good, as well as some of the Eclipse variants like Aptana for web work.
Then there's always notepad...
For .NET development, VS2008 is the best but if you want to check for another best IDE, Eclipse probably the best after VS if you are rating it among the IDEs, ofcourse you cant do .NET development in Eclipse though
If you are looking to try Java, I believe NetBeans is a very, very good IDE. However, for .NET, sure there are alternative IDEs but I don't think it makes much sense to use them unless you are developing on an Open Source platform, in which case SharpDevelop is a good choice and is reasonably mature.
I still like Source Insight a lot, but I'm hesitant to recommend it anymore as I'm not sure anybody's still maintaining it. They released a very minor update back in March but haven't had a major release in years. And there seems to be no web community presence. It's a shame because I still like its auto-completion-friendly file open and symbol browsing panels (as well as syntax formatting) better than anything else I've ever used.
Try out this one: "Pao" at http://pao-ide.info . It's still in development and not up to production use but it's quite unique in features. Basically, all the language constructs, such as assemblies, types, members, statements, expressions are treated as objects and are associated with rich operation options. You can enjoy features usually seen in graphical editors, such as multiple selection, multiple copy-paste, tagging, batch operation and very powerful search capability. It takes some getting used to but eventually might increase productivity. Right now, it only supports form applications though.
What about WebMatrix: http://www.microsoft.com/web/webmatrix/ ?
Does anyone have any good font and colour themes for Visual Studio that will give me nice support for Resharper? The majority of themes out there don't support Resharper, and as such all the extra R# highlighting looks rubbish...
Cheers! Matt
I use this VibrantInk theme, with EnvyCode R font, looks good with the Resharper Highlighting
Here are mine, based on textmate
Edit: (still a work in progress, but its getting there)
First, I will describe an example of how this can happen using C# in Visual Studio, since VS will typically inform you if you have a circular reference and prevent it.
First, a Utilities class is created relying only on the code given to you by Visual Studio and .Net. Then, an E-mail class is created that depends on Utilities. Instead of adding both projects to a single solution, a new solution is created and a reference to Utilities.dll is added. Then, some time later, someone decides that they want the Utilities class to send an e-mail and adds a reference to Email.dll. Visual Studio is perfectly happy to let you do this, but now the source won't compile as-is without one of the binaries.
At my place of work it is standard procedure to copy-and-paste binaries when doing development and then only building the projects you're working on. This has led to at least one circular reference in the codebase that has gone unnoticed for over 3 years.
This seems like a very bad practice to me because there is no way to build either project from source without having the DLLs first. That argument falls a little flat to the "practical" people I work with since it seems highly unlikely that we will lose all copies of our binaries simultaneously. The binaries aren't stored in version control at any point, which only makes me more worried.
This seems like a situation that should be avoided, but not a situation that poses any appreciable threat. Are circular references between projects really a big deal or am I blowing it out of proportion?
Yes, this is a bad practice for precisely the reason you've stated - you cannot rebuild from the source.
This is one of the symptoms of over-modularization.
I worked at a company once with about twenty developers and more than sixty different active projects in the SVN repository. Every project had its own build script and produced a JAR file that was a dependency of at least a half-dozen or so other projects. Managing all those dependencies was so complicated that we wasted a ton of time trying (unsuccessfully, I might add) to set maven projects to automatically fetch all the correct libraries (and the correct versions) for all those little micro-projects.
The funny thing (to me) was that it was really only one project, and it wasn't even something we distributed to the outside world. It was a hosted application, with a web front-end, running on a single server cluster.
Sheesh.
Another side-effect of the architecture was that the same kinds of functionality got duplicated over and over again (not always with the same algorithms, or results, for that matter) in several different projects. I think part of the reason was because people didn't want to introduce a new dependency on an entire sub-project just to get access to a few of its classes. But I think another reason was the people just didn't know what code existed where, and rather than go to the trouble of finding the code they wanted to reuse, they'd just rewrite it in their own project.
Of course, modularity is generally a good thing.
But like all good things, it can be taken to ridiculous extremes.
My advice is to find those circular dependencies and merge the projects into bigger chunks, since the current project breakdown probably represents a false modularity. Better to divide your big project into a few well-separated modules than to have a zillion pseudo-modules creating artificial boundaries between logically-coupled classes.
Aside from build issues, circular references always indicate a design flaw. In .NET, a circular relationship makes two assemblies effectively one assembly. If neither one can live on its own without the other, building them separately is just an exercise - it doesn't change the fact that together they represent a monolithic assembly.
I've noticed this a lot with utility assemblies. Must be an anti-pattern.
The question I would pose to your coworkers is:
Okay, it is very unlikely we'll lose all our binaries at the same time. But, tell me, what's the benefit of this approach?
If they come with anything different than "We've always done it this way", I'd like to hear it. And, as everybody knows "we've always done it this way" is NOT a good reason and they shouldn't defend it.
Hm, I think in terms of the OP question, about building projects from scratch, it is bad practices, due to:
circular dependencies are bad because:
this is potentially an infinite-loop in the build process
Yes, it's a big deal, because it leads to unmanageable component compositions, and most likely some form of build errors and very likely some deployment errors, at some point in the project life cycle.
Visual Studio 2008 explicitly prevents circular references between projects (not binaries) in solutions. As you have stated, that is not the case for binaries. I believe that is because VS2008 expects that binary references are managed independently and it expects that you are building those projects independently. Generally speaking, that means all binary references should be viewed as third-party components that represent a distinct one-way relationship (between your code and the binary).
Furthermore, MSBuild allows you to use the SLN file to build everything, if all your projects use VB or C#. This allows for the creation of an uber-solution file, which is ideal for an automated build process. The catch is that in order for such a master solution file to work, all of the projects in the SLN must utilize project references. Therefore, in order to take advantage of this, by definition, Microsoft expects that you are not employing circular references, since they are explicitly forbidden by the Visual Studio IDE (for project references).
Scott Hanselman makes reference to an uber-solution file in the following post:
Hack: Parallel MSBuilds from within the Visual Studio IDE
http://www.hanselman.com/blog/CategoryView.aspx?category=MSBuild
If you're having trouble convincing your "pragmatic" colleagues that this is a bad practice, offer a pragmatic solution: Remove these circular references and build times will go down since loads of unnecessary rebuilding will be avoided.
I need to use different database connection string and SMTP server address in my ASP.NET application depending on it is run in development or production environment.
The application reads settings from Web.config file via WebConfigurationManager.AppSettings property.
I use Build/Publish command to deploy the application to production server via FTP and then manually replace remote Web.config with correct one.
Is it possible somehow simplify the process of deployment? Thanks!
The <appSettings> tag in web.config supports a file attribute that will load an external config with it's own set of key/values. These will override any settings you have in your web.config or add to them.
We take advantage of this by modifying our web.config at install time with a file attribute that matches the environment the site is being installed to. We do this with a switch on our installer.
eg;
<appSettings file=".\EnvironmentSpecificConfigurations\dev.config">
<appSettings file=".\EnvironmentSpecificConfigurations\qa.config">
<appSettings file=".\EnvironmentSpecificConfigurations\production.config">
Note:
Have you looked in to web deployment projects?
There is a version for VS2005 as well, if you are not on 2008.
In Visual Studio 2010, you now have the ability to apply a transformation to your web.config depending on the build configuration.
When creating a web.config, you can expand the file in the solution explorer, and you will see two files:
They contains transformation code that can be used to
See http://msdn.microsoft.com/en-us/library/dd465326(VS.100).aspx for more information.
It is also possible (albeit officially unsupported) to apply the same kind of transformation to an non web application app.config file. See Phil Bolduc blog concerning how to modify your project file to add a new task to msbuild.
I'd like to know, too. This helps isolate the problem for me
I then keep a connectionStrings.config as well as a "{host} connectionStrings.config". It's still a problem, but if you do this for sections that differ in the two environments, you can deploy and version the same web.config.
(And I don't use VS, btw.)
I use a NAnt Build Script to deploy to my different environments. I have it modify my config files via XPath depending on where they're being deployed to, and then it automagically puts them into that environment using Beyond Compare.
Takes a minute or two to setup, but you only need to do it once. Then batch files take over while I go get another cup of coffee. :)
Here's an article I found on it.
Please read http://vishaljoshi.blogspot.com/2009/03/web-deployment-webconfig-transformation_23.html which is VS 2010 solution for dealing with your exact problem...
The Enterprise Library configuration editor can help you do this. It allows you to create a base config file and then deltas for each environment. You can then merge the base config and the delta to create an environment-specific web.config. Take a look at the information here which takes you through it better than I can.
You could also make it a post-build step. Setup a new configuration which is "Deploy" in addition to Debug and Release, and then have the post-build step copy over the correct web.config.
We use automated builds for all of our projects, and with those the build script updates the web.config file to point to the correct location. But that won't help you if you are doing everything from VS.
This is one of the huge benefits of using the machine.config. At my last job, we had development, test and production environments. We could use the machine.config for things like connection strings (to the appropriate, dev/test/prod SQL machine).
This may not be a solution for you if you don't have access to the actual production machine (like, if you were using a hosting company on a shared host).
On one project where we had 4 environments (development, test, staging and production) we developed a system where the application selected the appropriate configuration based on the machine name it was deployed to.
This worked for us because:
It worked well for us in this instance, but probably wouldn't work everywhere.
How do you feel about VS making you hunt for a tab that you used just minutes ago when you have a bazillion open tabs? What about constantly dragging tabs around to keep the ones you use close together?
Oh, so you think AARGH, too? Then read on.
I work on a piece of software with dozens of projects and hundreds of files. It's really easy to get the tab bar to fill up - like when debugging, which can open a lot of files, most of which are just boilerplate, or not really interesting for the task at hand.
This makes the few files that are relevant to 'fall off' the tab bar, or a pain to find by skimming the visible tabs.
There are some solutions, some more widely known than others. Here's my top 3:
III. This works if you can exactly remember the file name (or at least the first letters): use the 'find box':
type: Ctrl-D >of yourFileName
As you type the file name, you get autocomplete on the file names in the solution. More details here.
II. The most obvious one: using the 'active files' drop-down on the right of the tab bar which is alphabetically ordered.
Lesser known fact: use Ctrl-Alt-DownArrow to open that drop-down, then start typing the file name. You get the added benefit of visualizing the available choices. [info shamelessly stolen from here]
I. <drum roll/> This one is my personal favourite, and it's based on an undocumented feature of VS 2005/2008. When activated, it does one simple thing: clicking a tab moves it to the left-most side of the window. This basic action usually lets me find the tab I'm looking for in the first 3 to 5 tabs. It goes like this:
In order to enable this functionality, you have to get your hands dirty with the Windows registry.
Compulsory edit-registry-at-your-own-risk warning:
Editing the registry may make your network card drop packets on the floor. You have been warned.
Add this key to the registry for VS 2005:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\VisualStudio\8.0]
"UseMRUDocOrdering"=dword:00000001
or this for VS 2008:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\VisualStudio\9.0]
"UseMRUDocOrdering"=dword:00000001
You don't even have to restart VS to see it work! [plagiarized from here]
Now go on, give it a try!
Update: This trick no longer works in VS2010 Pro :(
This wraps up my part. Now it's your turn to share how you deal with tab hunting!
My company uses Visual Assist X. This provide numerous great features in Visual Studio, first and foremost a better "intellisense" capability. However, it also has an "Open File in Solution" dialog which allows me to type substrings of the file I'm looking for and filters the list accordingly. I highly recommend this software to any developer working with Visual Studio.
ReSharper and its Recent Files feature works a lot better for me.
I mostly use Ctrl-TAB to cycle through the tabs I have most recently been working on. I can seem to manage a stack of 4 or 5 files without thinking in this way. If the file is out of the stack then I usually settle for reopening it again using Ctrl-O.
Or if the file I want is related to a piece of code I am looking at, so highlighting a variable, method, etc that is defined in that file and hitting F-12 works.
Hold Ctrl, press Tab, and keep Ctrl held. Now you can use the arrow keys to choose any open file (right column) or tool window (left column.)
Control-Tab and the ">of" trick are both useful. Neither of them quite work for me, though, especially when I've got a lot of open files or I want quicker access.
I like the free DPack collection of tools. There's a lot of neat stuff in there, some of which is built in to more recent versions of VS. I haven't seent anything like the file browser, though. It sits as a tool window (or dialog, if you prefer), and gives you an incrementally-filtered list of files in your solution. You can limit the list to open files if you use it as a modal dialog, apparently, though I haven't tried that.
I've created Tabs Studio add-in for Visual Studio exactly for this purpose - to comfortably work with a lot of opened files. Tabs Studio add-in offers multiple rows of tabs and tab grouping.
See Tabs Studio home page for more information.
I ran into the same problems described here, so I created a visual studio addin to manage open documents in "sessions", it's free and open source, you can find more information on the codeplex project here
I'm developing a C++ command-line application in Visual Studio and need to debug it with command-line arguments. At the moment I just run the generated EXE file with the arguments I need (like this program.exe -file.txt) , but this way I can't debug. Is there somewhere I can specify the arguments for debugging?
Yes, it's on the Debugging section of the properties page of the project.
In VS 2008, right click the project, choose properties, go to the Debugging section -- there is a box for command line arguments.
The Mozilla.org FAQ on debugging Mozilla on Windows is of interest here.
In short, the Visual Studio debugger can be invoked on a program from the command line, allowing one to specify the command line arguments when invoking a command line program, directly on the command line.
This looks like the following for Visual Studio 8 or 9
It is also possible to have an explorer action to start a program in the Visual Studio debugger.
Just for those who encounter the same problem as I had. I could not pass parameters while debugging in Visual C++ even tough after checking this post. The thing was in fact quite stupid, the project with the "main" file was not set as start-up project- (Dough!) That solve the problem.
Even if you do start the executable outside Visual Studio, you can still use the "Attach" command to connect Visual Studio to your already-running executable. This can be useful e.g. when your application is run as a plug-in within another application.
When you hit F5, the browser windows pops up, how do you set which browser the debugger users in Visual Studio 2008?
Update 1
I have looked for the 'Browse with' option and not found it.
Visual Studio opens default browser instead of IE
Update 2
If you are already debugging you dont have the 'Browse with' option.
Update 3
The accepted answer below is also relevant for Visual Studio 2010.
If you use ASP-NET MVC, you need to right-click on Default.ASPX which will have a Browse With menu.
ASP.NET projects:
ASP.NET MVC 1 projects:
Right click Default.aspx, then follow steps above.
ASP.NET MVC 2 projects:
As there is no Default.aspx, you need to create a Web Form (right-click project > Add > New Item) and follow the steps above.
To permanently make Visual Studio open a project in IE without changing the default browser you can do the following:
Project Properties -> Web -> Start Action
Start external program: C:\Program Files\Internet Explorer\iexplore.exe Command line arguments: Enter the url of the path to your start page ie http:\localhost\myproject\default.aspx
This won't allow you to debug client side script in Visual Studio though.
If you are using MVC 2 you do not need to create another project, just add component -> webform to the project then:
* Right click the webform
* Select Browse With...
* Choose your browser
* Click Set as Default
* Delete the webform
If you use MVC, you don't have this menu (no "Browse With..." menu)
Create first a normal ASP.NET web site.
ie ---> Tools ----> Internet options -----> Programe ------> Make Defualt
I am working on refactoring some old code and have found few structs containing zero length arrays (below). Warnings depressed by pragma, of course, but I've failed to create by "new" structures containing such structures (error 2233). Array 'byData' used as pointer, but why not to use pointer instead? or array of length 1? And of course, no comments were added to make me enjoy the process... Any causes to use such thing? Any advice in refactoring those?
struct someData
{
int nData;
BYTE byData[0];
}
NB It's C++, Windows XP, VS 2003
There are, unfortunately, several reasons why you would declare a zero length array at the end of a structure. It essentially gives you the ability to have a variable length structure returned from an API.
Raymond Chen did an excellent blog post on the subject. I suggest you take a look at this post because it likely contains the answer you want.
Note in his post, it deals with arrays of size 1 instead of 0. This is the case because zero length arrays are a more recent entry into the standards. His post should still apply to your problem.
http://blogs.msdn.com/oldnewthing/archive/2004/08/26/220873.aspx
This is an old C hack to allow a flexible sized arrays.
In C99 standard this is not neccessary as it supports the arr[] syntax.
Yes this is a C-Hack.
To create an array of any length:
someData mallocSomeData(int size)
{
someData* result = (someData*)malloc(sizeof(someData) + size * sizeof(BYTE));
if (result)
{ result->nData = size;
}
return result;
}
Now you have an object of someData with an array of a specified length.
I love Visual Studio about 90% of the time, but that last 10% it is such a PITA it makes me want to launch my monitor off the desk.
My latest annoyances:
The best part ... ReSharper :)
EDIT [Jay Bazuzi]: It seems like this discussion is only productive if it's focused on the latest released version. Set the title to VS2008.
This question exists because it has historical significance, but it is not considered a good, on-topic question for this site, so please do not use it as evidence that you can ask similar questions here.
More info: http://stackoverflow.com/faq
The length of time the Help dialog takes to appear (locking up the IDE in the process)...
It is quicker for me to open Firefox, type what I'm after into Google, click on the relevant MSDN link, read my solution/search again and make a cup of tea, than it is for help to load.
No multimonitor support...
Why does it take forever to launch the Add Reference dialog for a project?
When IntelliSense stops working.
My biggest annoyance is that no one else can compete with it!
We need more choices for IDEs to promote ingenuity.
I think the help system for Visual Studio is horribly, horribly broken. Between online and offline content, finding help on topic was much much better 10 years ago than it is now. Now, you often navigate a maze of help. There are likely many more help "pages", but it is so much more like being at the zoo.
Simplify! Make it work well! Is that too much to ask?
Related item: I know it is fixable, but I've had to correct this for other developers on my team: when other items are installed (SQL Server, for example), it can mess with the Visual Studio help system. It is correctable, but why so complicated? Just make it work.
Complete disregard for C++ support, which is basically the same as it was in VS 2005.
I actually used to think Visual Studio was awesome... until I used Eclipse for a few years. Now I really miss programming Java in Eclipse.
Things I DONT like:
Things I DO like:
The best part ... ReSharper :)
This is actually one of the big weaknesses of Visual Studio, I think. As far as I have read on SO, a lot of programmers do not want to code without ReSharper any more - the annoyance is that this addon seems to incorporate a lot of functionality which should actually be core components, and are core components in other IDEs.
Disclaimer: I have not used ReSharper, yet, but SO has several questions dealing with stuff like ?How can I do Feature X from Eclipse/Netbeans/? in Visual Studio??, which can quite often be answered with ?Visual Studio cannot do this, get ReSharper?.
If you don't want to pay for ReSharper, consider CodeRush Express for C#; it's free. It sounds like Microsoft did something to make that happen, but I don't know what.
The lack of speed in the newer versions, I want my 6.0 speed back in the vs2008! :P
When I'm doing WPF, it crashes constantly. Three or four crashes per hour of work.
The performance is my main annoyance definitely.
Visual studio is the slowest desktop application I have.
Windows Workflow Designer.
It's a crippled, one-legged, drunk, poisoned, hippopotamus carrying fifteen elephants slow. It's an absolute dog. It's really the shining example of why shifting portions of VS from native code to managed code was just a silly idea.
Most of the rest of my annoyances are fixed by ReSharper, to be honest. (Things like Intellisense presenting overloads one line at a time, instead of in a multiline box.)
Despite all that, you can pry my copy of Visual Studio from my cold, dead hands.
I don't remember the specific ones, but I've been annoyed by a number of dialogs with bad (or no) resize behavior, meaning that long lines of text get truncated and you've no way of seeing the pertinent information at the end. Seems amateurish.
Though on the whole it's a very nice IDE.
The biggest annoyance is when you open a project that was built in another version of VS it has to convert. It should be able to open any project in read-only mode for browsing.
I also don't like how it implies you can never go back - you can if you edit the proj files. This should all be more transparent and simpler.
Second annoyance is when it tells you it is going to check files out of source control when opening a solution especially since I do not use source control through the IDE and often I'm looking at open source software for read-only.
Creating a new file takes a ridiculous amount of mouse clicks.
My biggest annoyance, is when intellisense pops up, and steals what I was trying to type.. That, and when intellisense decides to get in the way of what I was writing with a big window, and I have to click elsewhere to get it to leave me alone so I can see what I was writing.
If searching for text within a file that has regions, it's considered hidden text. One must STILL remember to check Find options->Search hidden text. Otherwise one will not find what they're looking for.
We have a solution with about 60 projects, one of which is a user controls library with 30+ controls in it. The toolbox goes mad when you open the project, or a form designer or various other common tasks. It means it can take minutes to open a form.
We recently had a problem, I compiled a release of a solution, published it, tested it and it was the previous version. Visual Studio refused to compile the new version, I had to delete the entire source tree form my working folder then re-get from source safe.
@Josh - Debug -> Exceptions - Yes, where'd it go!
It doesn't seem to be able to keep any of my tool windows or toolbars in the place I put them for more than 10 minutes. Even when I make sure I have only one instance open, get it all set up nice, close it. Re-open it everything is still fine. Open another instance to do something else and its all moved. Currently its think is to make my error list/output window that I normally have across the bottom just high enough to display the tabs and move the vertical split between them about 600px to the left.
The price! (Coupled with the fact that for most development tasks, realistically I don't have any alternatives).
When you add a reference, the dialog box seems to take forever to load - like minutes - because it's loading up every bloody .net, com, whatever library it can think of.
There is no shortcut for switching between source and header files in C++.
That is just ridiculous...
C++ Builder has it from years (and QT Creator has this feature as well).
Overall, I think Visual Studio 2005 and 2008 are fantastic IDEs. But the one thing that gets me time and time again is accidentally dragging and dropping files in the Solution Explorer. Maybe I'm trying to work too quickly, but there really needs to be an "Undo file move" or something along those lines.
The time it takes to shutdown Visual studio. Even with small project it sometimes takes very long time, sometimes so long that I reside to force it with task manager. I can't figure out why, there is obviously a lot of disk activity but I can't figure out the reason to why it should save so much.
I hate that VS2008 as well as the versions before do not get it managed to let the actual interface be usable, since it permanently locks up.
While building a project, it locks up, background compiling for intellisense works, but while actual compiling the code, it locks up the whole frontend.
Thats the most annoying thing with VS to me.
I don't know what causes it, but on occasions as I'm typing in an .aspx page the 'Error List' tab keeps jumping up and down like a f@cking jack russell terrier.
Otherwise I like it.
No locking on tool window postitions. I make a sub-mm slip with the touchpad and I have to remember how to redock all the controls.
Intellisense goto declration/definition always going to the declaration.
The broken help system. I'm in a C++ file in a c++ project, I only have c++ support installed, I press f1 on a 'printf' statement - and it shows me the help for foxpro or some random language.
The build system in general. But specifically after generating an error it continues for 5mins creating a browse info and debugger file.
When designing windows forms with lots of controls I'll first design the form with all the controls and then go back and rename all the controls prior to wiring anything up. I'm very careful to click one time with my mouse on each control I am renaming, however VS 2008 (and previous versions) often interprets a double click -- which throws me into the code behind thinking I want to wire up an event handler. This is highly annoying and wastes a tremendous amount of my time clicking to get out of the code behind. The problem becomes exponentially worse with forms containing many controls. Why in the heck isn't there an option to disable auto-wireup (at least temporarily)? I can't be the first windows developer to encounter this problem.
No intuitive way to "Refresh" the .dbml file when the underlying SQL tables/sproc are changed.
1 Performance.. Start-up, loading help (I'm not pressing F1, I'm not stupid).
Seriously, would use Excel if it had the start-up time of Visual Studio? It doesn't matter if i have a 80k or 8MB XLS file, it opens fast, saves fast and is generally a pleasure to use.
2 Inconsistent search options, find, find in files, etc. Pick one!
4 If you create a blank solution, then add a project to it, the project appears at the top of the hierarchy, even though it's not. If you add another project, the solution reappears at the top of the hierarchy, and then shows the two projects below it, so irritating. Most of us create solution folders to get around this annoyance.
5 Poor setup. Why is the only difference between complete and typical install the 64 bit compilers?
VS2008 SP1 caused more problems that it fixed for our team. I am trying to work with MS via Connect, but progress is slloooowwwwwww. 1) IDE disappears if you have a pane floated (Callstack, etc) and you stop debugging. Already in Connect and MS claims we must wait for VS2010. 2) Break points are not hit, or breaks on random x86 instructions in a C# project. We have a possible fix from MS 3) IDE disappers when editing cs proj props, and certain xaml files are open. MS escalated this to their dev team 4) Other cases where IDE disappears/dies
Our productivity dropped a lot after SP1. No s/w is perfect, not mine nor their's
Single biggest annoyance, particularly given how easy it would be for MS to fix: the fact that there is no simple option to make compilations abort on the first project which contains errors.
Given how unresponsive the IDE becomes during a compilation, it's a real pain to have to attempt to switch to the output tab, in order to hit CTL-Break so that you can stop a compilation once you notice that you've got compile errors on a project.
I know that there are 'work-arounds' that IIRC, involve custom build steps etc., but for something so darn simple I shouldn't have to jump through PIA hoops in order to change the behavior to what I would argue should most likely be the default behavior.
Argh.
Having said that, there's a lot I do like about VS.
One more area that it must be said is problematic is the WPF designer support. As has been commented by others it's very buggy. For me this has been exacerbated by having a couple of more unusual system configuration items, and the difficulty finding information on hotfixes: I have had to install one hotfix to VS to solve 64bit windows issues, and have had to install Silverlight 2 tools for VS2008 SP1 - so that it's compatible with Blend 3 behaviors (even though I'm not using Silverlight!).
I don't know if this is in the latest version, but in VS2005 it annoys me that Ctrl+W does not close the currently open file. Ctrl+F4 is a bit awkward.
It also seems to take ages to realize that I corrected a mistake. Particularly if I paste something, it leaves the blue underline across two words - it thinks the previous word is still there.
It's a bit clunky for most anything that isn't done it's way. If I have a pile of C code, to build it, I must create solution and project and mess with all that. Some sort of Ad-Hoc project (e.g. all C files in this dir) would be very nice.
Its truly and deeply CRAPPY integration with SourceSafe. If I'm in SourceSafe itself and I want to check out a branched version of a file, no problem. But if I'm in Visual Studio, it completely scrozzes the destination folder settings for the entire branch and then checks out the wrong version on top of it. I not only have to manually uncheck and fix the files, but I also have to shut down VS and SS and manually delete the incorrect ss.ini folder settings to prevent SS from continuing to use the wrong branch folders. I've completely given up on ever letting Visual Studio check anything in/out of any branch other than the central development line.
Solution Explorer visibly repaints itself too often; for instance, every time you double click in the main editor. Seen on Vista (I don't recall seeing that in Windows XP).
There was a really nice FTP interface for deploying web site projects in 2005. Now they replaced it with something much worse.
Edit: my new biggest annoyances are:
Sometimes windows like the solution explorer forget that they are supposed to autohide, and you have to tack and untack them again to make them go away.
One of the windows from the bottom, such as the Output or Error List pops up for no good reason, such as when I save a file, although thankfully it usually realizes it should hide and goes away after a second.
I would really like to be able to copy references from one project to another.
Especially since the add references dialog takes forever to load.
The big sleep ...
Loading projects (medium sized, up to 10 projects in a solution) it takes minutes to load the solution and display the files left open last time on a good equipped pc (4gb ram, dual core ~3ghz). And it's not just on one pc...
Anyone else has this phenomen?
No incremental build support. At all.
See Eclipse for how it should be done: Ctrl+S, and a second later I can run. Compare to VS 2008: save, and it just sits there. F5 and I have to wait 5 minutes (more, if Code Analysis is on) for it to finally cough up that class Foo does not implement method Bar from interface IFoo. Then I have to wait another 5 minutes for it to stop building the rest of the projects, because it DOES NOT stop building by default when it hits an error.
Microsoft did not realize that there is a huge difference between a build tool for a build server and a build tool in an IDE (batch vs interactive application).
You can't do a textual search in the toolbox, the properties window (in non-WPF projects) or the add references dialog.
The time it takes to upgrade VS 2008 to SP1!
It takes about 90 minutes on my machine.
The fact that the regular expression syntax in the Find/Replace dialog (used in the IDE itself) is different from the regular expression syntax used by the Regex class (used in programs you write).
Creating new Projects and Solutions is a mess.
Various menu items lead to dead ends (e.g. 'Create Project from Existing Code"... but there is no option to create a web application).
Why can't we do File->New->Solution, save the solution where we want it, then add projects to it?
Files get auto saved all over the place and its never clear what is actually going on.
This really pisses me off because it lacks Cancel and Retry buttons. All I need to do is fix the connectivity issue (LAN, Internet, VPN... whatever) and then hit Retry.
It lacks a "Reload all" command, when you use source control and make an update before shutting down visual studio. Then sometimes you have to click "Reload" almost as many times as how many projects you have. Or press ctrl-alt-del and kill VS (which is almost always faster)!
My favorites:
I love the squiggly lines indicating I have a mistake, but when I fix it, can't it check my new code a little quicker? I often find myself watching, waiting for it to disappear...
lack of multi-monitor support is a bigger issue though.. Excel and Visual Studio both seem like apps from the dark ages with no ability to take advantage of several screens. Does anyone code on a single screen anymore?
Viewing resources could use some more organization and options. It is like going to a folder and being forced to view all the files with only a single 'view'...
Design View!
Crashes are the biggest pain... it just breaks your flow of thoughts and decreases productivity way too much.
In Visual Web Developer / Design View
Sometimes clicking a control and changing its properties does not work: The Properties window becomes "out of sync", still linked to the previously-selected-control.
Switching to Source view then back to Design view solves this, but is an annoyance.
UI designer is targeted for C# and VB and not C++.
All code it generates for given form is put in a single file without separation on header and source files.
C++ Builder has this for years...
I'm pissed off on M$ how they treat C++ and it's users; no respect at all.
I'm sure they will regret this. The sooner the better.
That you can't select the event handlers for controls from the code-behind for C#.
Also the fact that you have to be in design mode to even get the Event Handler options in the ascx or aspx for C#. Why can't that option just be available in source mode?
Ctrl+W closes the current tab in almost every tabbed application I use ...except VS. grr
Most of my pet peeves have been mentioned already, but here's another one:
Visual Studio includes lots of great options for controlling Code Formatting, but all of those options are global (across all solutions). One thing I really miss from Eclipse is being able to define different Code Formatting for different projects. In particular, this is important when you're working on different projects with different teams, and each team has its own quirks in coding standards.
When you have multiple instances open and change preferences, you have to be careful in what order you close all instances, or you loose the changes.
Trying to navigate the visualization of objects in the debugger.
Here's this TEENY plus sign, followed by myriad other plus signs, and damn you to heck if you don't move the mouse precisely as required. You have to HOVER the mouse, and probably click the object, to get the visualization started; there's no keyboard shortcut. There's no way to use the keyboard AFAIK (PLEASE tell me, if there is) for dropping the visualization menu so you can select from text or XML or HTML.
The labels are obscure. You get into base type fugues, recursing down base type to base type, and sometimes there's never any data to reward your spelunking. If you're looking at a lot of data, like members of a dictionary, there's no way to capture that data.
I'd like to be able to put the cursor on an object and enter Ctrl-E + Ctrl-D (for ExplicateData) -- to open a window where ALL of the data is expanded, the parent-child relationships shown via indentation, with the option to mark bits as "favorites" that are placed in a window at the top. Save the favorites in the SUO file. Permit opening or closing blocks using the usual VS shortcuts, and save the open/closed state in the SUO. Select all or part of the data and click the alternate tabs at the top to see the data as XML or HTML.
My biggest annoyance is that it doesn't catch certain errors in C# unless you manually build or run a project that it catches in VB.NET at design time.
I've heard that this is fixed in VS 2008 SP1, but I'm stuck with VS 2005 at work.
That it sometimes causes access failures when building in parallell. Extremely annoying, since it causes our automatic build machine to fail randomly.
When I saw/used Visual Studio 2008, I was not specially impressed with most stuff because of the reason that it was exposing the advancements in .NET technologies. As a developer I need tool that make my everyday work easy. Having worked with linux editors and mac editors that in no way do as much as visual studio does but I absolutely love using editors like Kate or TextMate or E which have absolutely awesome text editing features. I would personally like to have themes like Zenburn etc working out of the box. I would definitely like Microsoft to collaborate with experts at JetBrains or DevExpress and include it in VS instead of plugin. I saw PDC2008 presentation for VS2010 almost stopped my bitchin...
Peace!
I've gotten bit by the SECURE_SCL defaults in VS 2008, whereas in VS 2005 I was able to compile and hack with libraries really easily -- VS 2008 has proven much trickier.
Some links about that:
http://connect.microsoft.com/VisualStudio/feedback/ViewFeedback.aspx?FeedbackID=352699 http://stackoverflow.com/questions/137089/boostsignal-memory-access-error http://connect.microsoft.com/VisualStudio/feedback/ViewFeedback.aspx?FeedbackID=352481 http://stackoverflow.com/questions/49330/vs-2005-2008-library-linking
Extremely slow refactoring, lack of refactoring features, slow symbol search, constant recompiling due to terrible non-incremental compiler, lack of occurrence highlighting, the list goes on. Visual Studio has a lot of catching up to do, a sad state considering how it used to be the best. I actually miss Eclipse.
Output to OMF format so it can be used directly with digital mars tools which use OMF but visual studio uses COFF. I always use this tool because it is less buggy than digital mars's converter but if anyone knows how to output in OMF in MS visual studio please share your knowledge.
I'm not sure if this is Visual Studio or SourceGear or both but I'd say once every other day I have to rebind my two web projects in my solution to source control.
I wish I could work with SQL Server better inside the VS IDE and stay out of Management Studio.
I agree with what someone said a few posts up, no competition.
But if these are my biggest gripes then I'm doing okay.
Shift+alt+F10 for auto adding the relevant namespace, come on you could do better than that......
I've got a solution reaching 70 projects and constantly growing (I've done a very small percentage of the project).
The toolbox doesn't remember my additions - Telerik and ASP.NET AJAX (you'd think the last one would be remembered by the IDE because it's all Microsoft!).
Html Designer crashes (or used to).
Got .NET 3.5/VS2008 SP1 and now my Silverlight projects cannot be loaded!
IntelliSense hogging the up/down keys to scroll through search results.
So if you're typing some function call and want to move to the next line it's (esc)(down) instead of just (down).
When I moved from VS 2003 to VS 2005, it became much more difficult to chase down object properties in the debugger QuickWatch window. How should I know if it's "base" or "Non-Public" or "Static", and, more to the point, what do I care?
They also buried the code deeper into the folder tree, from "My Documents\Visual Studio Projects\MyApp" to "My Documents\Visual Studio 2005\Projects\MyApp\MyApp". How did that improve my experience?
First of all... I love Visual Studio. I worked with it for years and it keeps getting better for every version.
I hate it when VS 2008 stops giving IntelliSense and when, for some unknown reason, it sets my keyboard settings to a different language, so 'special' keys like - and = become things like °, only in Visual Studio so a restart of it fixes the problem.
Another thing I think needs improvement is opening XAML files. I've changed the settings so it doesn't open in split mode but only shows me the actual XAML. Very often Visual Studio shuts down immediately. When restarting Visual Studio after that and opening in my project, that file is still open so Visual Studio shuts down again. After that Visual Studio doesn't load any files when opening the project. Very annoying.
Simpler addon development would be really nice.
Two of my biggest gripes:
On thing that I really like:
Edit Thanks to SLaks's comment, the first gripe is no longer an issue. However, this is:
Another edit Here's one of my biggest beefs with the user interface:
It's sad but I still need to work with 1.1. So I need two versions of VS installed.
Projects are incorrectly ordered when placed in Solution Folders.
UPDATE Apparently fixed now, though I guess I'll have to wait for VS2010.
When having a Setup & Deployment project in your solution, you can't unload it by right-clicking it in the solution explorer (there's no "Unload Project" option like there should be).
You have to either go to the top menu bar and do it from there or select another project with it and unload them both.
The macro recorder is just so slow it hurts. I remember in MSVC 6, it was lightning fast. Now, it feels like the whole IDE is in molasses when you record. I don't know what they have done to it, but it's a shame.
I'd like it to be able to export build files to other platforms - or at least provide a plug-in ability to do that.
Basically I want it to be its own CMake.
Two complaints:
Custom build rules are source-based, instead of target-based, and they operate by file extension. That means if I want to add a custom step (such as unit-test boilerplate generation for CxxTest), I need to create a new type of file, foo.unit and define a rule that operates on *.unit files.
Refusal to support C99 features. I want my <stdint.h>, <inttypes.h>. I know not a lot of people use C anymore, but C99 headers are at least accessible from C++, and I hate resorting to third-party projects for something like this.
I think some of the simple features included in Visual Assist should make its way into Visual Studio; for example "go to file", and fast switch between .h and .cpp file.
The time it takes to delete a single damn file out of your project the first time you run a delete command. Seriously, c'mon!
Debug CRT Deployment: Installing the debug C runtime (msvcr90d.dll) on test systems is far more complicated than it needs to be. I usually would prefer to use a lighter weight debugger, and adding Visual Studio 2008 to test system images takes a lot more space and imaging time.
%SystemRoot%\system32 does not work, due to WinSxS (except on Windows 2000).xcopy deployment) works, assuming that you are debugging an application that has its own directory. This does not work if you're debugging a DLL installed in %SystemRoot%\system32.C++ Intellisense constantly consuming ALL available processor cycles. OK, it may be in a low priority backgroud thread, but it still burns cycles and does slow other stuff down. Not to mention - it makes my laptop run really hot!
I've joined the dark side, but the Solution Explorer still burns my eyes.
I don't know if it's my biggest annoyance, but it really bugs me how many long-running operations are either modal or just cause the UI to lock up. Now I'm forced to use TFS which is a DOG, and causes lots of little glitches in UI responsiveness, but at least I understand why some of those need to prevent you from interacting for a bit.
I really don't understand why opening help need to tie up the IDE while Document Explorer takes what seems like hours to update for new content. Or why loading the available tests for a large project needs to lock up the whole IDE. There's a little progress bar on the Test View tab, which makes me think that they tried to make this more localized and just couldn't get it to work or something. I guess I need a faster machine or something.
But my biggest annoyance is TFS and it's remarkably painful integration. Not the little glitches I mention above, but the incredible, across the board, immense crappiness of this POS. I can't express in words how much I hate this thing.
The folks over at Coding Horror gave an example of a Visual Studio macro for collapsing to definitions but expanding macros. The following was given by Kyralessa in a comment:
Sub CollapseToDefinitionsButExpandAllRegions()
DTE.ExecuteCommand("Edit.CollapsetoDefinitions")
DTE.SuppressUI = True
Dim objSelection As TextSelection = DTE.ActiveDocument.Selection
objSelection.StartOfDocument()
Do While objSelection.FindText("#region", vsFindOptions.vsFindOptionsMatchInHiddenText)
Loop
objSelection.StartOfDocument()
DTE.SuppressUI = False
End Sub
This code works fine when you execute it as a regular macro, but I would prefer it to happen automatically when I open a document.
I tried taking this code and working it into an EnvironmentEvent, but without much luck. When I try debugging the macro, the debugger gets to the ExecuteCommand line and then does not return to the subroutine. It also doesn't collapse to definitions (Edit > Outlining > Collapse to Definitions). Here's my EnvironmentEvent subroutine, for anyone to poke at:
Public Sub documentEvents_DocumentOpened(ByVal Document As EnvDTE.Document) Handles DocumentEvents.DocumentOpened
' Thanks to http://www.codinghorror.com/blog/archives/001147.html
Document.DTE.ExecuteCommand("Edit.CollapsetoDefinitions")
'DTE.ExecuteCommand("Edit.CollapsetoDefinitions")
DTE.SuppressUI = True
Dim objSelection As TextSelection = DTE.ActiveDocument.Selection
objSelection.StartOfDocument()
Do While objSelection.FindText("#region", vsFindOptions.vsFindOptionsMatchInHiddenText)
Loop
objSelection.StartOfDocument()
DTE.SuppressUI = False
End Sub
So beyond trying to offer some potentially useful region-expanding code, I'd also like to register that this is way too much pain to go through just to collapse methods but expand regions when opening a file. Really, VS? That can't just be a preference somewhere?
Not being able to add snippets for other languages than MS supported ones (for example, while using Intel's fortran compiler).
The fact that the icon colors are almost identical to Chrome, and they're right next to each other in my quicklaunch bar.
In other words, nothing that hasn't been mentioned yet.
That you cannot create an empty solution inside an existing folder. VS 2008 always creates a new folder whenever you create an empty solution.
An ability to quickly find and open files. In a solution with lots of projects it takes too much time to find and open the file you want. I know about Find bar + ">of Filename...", and this helps a lot, but still it takes too much time...
Being able to collapse/expand JavaScript code when editing wouldn`t have been that hard for Microsoft to implement, would it?
BTW, what JS editor offers VS integration and collapses/expand JavaScript?
Federico Caldas (TeamDotNet)
I find the VS IDE very unreliable. It stuffs up my resources. I add images to the tollbar (lots of them) and a few days later, they're all gone. The references are there but some how it manages to stuff it up and then I have to go and add all the images again, double-click on them all all over again and re-paste the code all over again. Worst IDE known to mankind.
"Could not load file or assembly xxxxxx" when the assembly is f**** right there!
If any projects, which are under source control, get updated, VS keeps on popping up the dialog asking me whether I want to reload the project for each project. There is no option to reload automatically or a "Reload All" button in the dialog.
IronPython is developed by Microsoft and there is practically zero support on Visual Studio. (Yes they do have something, but that is not under active development and is for an older version of IPy)
Sometimes while debugging, if I do things like "Open Containing Folder" on a file, things just freeze.
There is no direct way to manually edit project files -- I have to unload the project and then do an "Edit Project".
Lack of incremental compilation ala eclipse in the c# mode. I miss seeing the mistakes before compiling. Always hitting the compile button. It's become a muscle memory thing.
I hate the way that you can't remove items from the "Recent Projects" list without going into the registry, or moving/deleting the project. I make throwaway projects often, and it's annoying when they push your real projects off the bottom of the list.
When changing values on a control in designer mode, it takes forever to find the thing you want to change. To make this even more annoying when your doing WPF they have a easy search field on top of the properties window making finding what you wanna change simple.
A few times a year, "Find in Files" fails with the message : "No files were found to look in." The inexplicable solution is to press Ctrl+ScrLk . This occurs in VS 2008, and I think earlier versions.
Javascript debugging is forced on in Internet Explorer with no way to switch it off. Which results in all sorts of (anonymous) javascript blocks to flicker on and off as solution items.
When stopping the debugger, the computer hangs for up minutes at a time, while God Knows What is going on.
Can't put two source codes window from two projects side by side if I don't open one from the other instance of VS or create a solution file containing the two projects. If I put two VS window side by side, then tool bar button area, menu areas take too much space.
Can't copy files in a project when the project is opened with VS. Some files are locked and can't be copied. This is weird. Copying is to "read". Why "read" is not possible?
The javascript editor does not remember your preferences for formatting. I'm a "brace at the end of the opening line" kinda guy, but I work where the brace needs to be on its own line. I like that in VS I can just type the way I've conditioned myself and VS will fix it for me.
Except the javascript editor. It forgets the settings periodically, and next thing I know I diff my changes and 80% of the file has changed because the braces all moved. So annoying!
When highlighting gets "sticky" and does not want to start selecting from your cursor. Only way to correct it is by restarting. Very annoying....
My three:
A simple to fix but very annoying thing is the QuickWatch Window. It never remembers it's column slider positions so I always have to slide the colums into view every time I open the QuickWatch. The default settings of are pretty bad. The column that displays the Type of the Object is out of view. A quick fix would be a better default. Remembering where I put them would be luxurious but is not a must.
In the XAML editor, alt-tab somewhere else, alt-tab back and it's moved your cursor to the beginning of the control! so frustrating
Completely Uninstalling It for:
Without a doubt the worst program when it comes to uninstalling as it has literally taken over your system completely and has it's garbage laying everywhere from registry to my documents to your drive. You have to uninstall several programs and even then it is not completely removed. Horrible, especially coming from a company like Microsoft who own the OS as well.
That sometimes the C++ rebuild dependencies stop working. I've seen this with VS2005 & VS2008 on different projects at different companies. Sometimes changing a header file will not cause all the cpp files that include it to be recompiled and link errors result. Some combination of deleting .idb, .obj files will fix it, or do a rebuild all of the solution but that can take a long time.
Wow, 4 pages of responses and nobody has mentioned "Copy Web Site"?
In VS2005 it worked as fast as any other file-synchronization utility. In VS2008, a Remote Source located on a network share takes at least 10 seconds just to list the file names if there are more than ~5 files in the directory.
I have an XSD file that is encoded in UTF-8, and any text editor I run it through doesn't show any character at the beginning of the file, but when I pull it up in Visual Studio's debugger, I clearly see an empty box in front of the file.
I also get the error:
Data at the root level is invalid. Line 1, position 1.
Anyone know what this is?
Update: Edited post to qualify type of file. It's an XSD file created by Microsoft's XSD creator.
It turns out, the answer is that what I'm seeing is a Byte Order Mark, which is a character that tells whatever is loading the document what it is encoded in. In my case, it's encoded in utf-8, so the corresponding BOM was EF BB BF, as shown below. To remove it, I opened it up in Notepad++ and clicked on "Encode in UTF-8 without BOM", as shown below:
.
To actually see the BOM, I had to open it up in TextPad in Binary mode:, and conducted a Google search for "EF BB BF".
It took me about 8 hours to find out this was what was causing it, so I thought I'd share this with everyone.
Update: If I had read Joel Spolsky's blog post: The Absolute Minimum Every Software Developer Absolutely, Positively Must Know About Unicode and Character Sets (No Excuses!), then I might not have had this problem.
here's how you do it with vim:
# vim file.xml
:set nobomb
:wq
I have an msbuild project which builds a SLN file from visual studio which holds all the projects in (about 70+ project), and a lot of the projects are dependent on each other meaning they need to be build in order - sometimes a developer forgets to set the build order manually in visual studio in the solution file causing the msbuild on a clean solution to fail as something gets built out of order/cant find a dll.
Is there a way for msbuild to take all projects and work out the dependencies and build the projects in order, if there is how do i do this? using an MSBuild task? With current tries it seems to just build in the order it reads the projects in - if i pass in a list of project files+paths.
Currently the only way i can think to solve this is a external app which scans the proj files and references and then manually creates a solution each time.. but this seems overkill for such a simple thing.
Anyone solved / seen this before?
How are you calling MSBuild? If you point MSBuild to the solution file, it should be able to work out the dependencies. If you point it to individual project files, then it won't be able to resolve any project references.
If you don't use project references you can still control the dependency order in a solution by using the "Project Dependencies" dialog to manually set the dependencies.
Is this your problem? It's currently giving me trouble.
There doesn't seem to be a great solution. I think we're going to write a tool to parse through the .sln file, look in the referenced .csproj files for the tags, and copy that info back into the .sln file.
This is an old question but the issue was most likely that projects in the solution used direct references to dependent DLLs (Add Reference > select Browse tab > select dependent DLL) instead of using project references (Add Reference > select Projects tab > select dependent project). With direct references, Visual Studio can't figure out the dependency chain. You must tell it by right clicking on the solution node and select Properties. Pick Common Properties > Project Dependencies to set the required projects. Mr. Klaus is correct but I wanted to document how to fix this issue.
While Project Dependencies are hard to maintain and not shared across .sln files, Project References are honoured and do dictate the order consistently - see the ResolveReferences task in Microsoft.Common.targets.
ASIDE: A 'friend of mine' may 'during a refactoring' have accidentally stubbed out their Build Task and it's DependsOnTargets linkage to the Microsoft.Common.targets ResolveReferences task and ended up with ProjectReferences not being honoured in ways that sound like the question here. If you read some of the posts, you might get the idea that it's all mad shaky - it's not; the shaky bits are the Project dependencies, not the Project references.
If all of your dependent projects are in the solution and you are using Project references, Visual Studio should manage the dependencies for your and build in order of that dependency list.
It sounds like you are not using project references. I always recommend project references.
While it is correct that MSBuild should observe the build order when you use project dependencies there is one caveat. It doesn't at present observe the reverse build order when building the clean target (as I have blogged about here). For regular build however it works nicely as described by others here.
When I add an assembly reference to a project in Visual Studio 8 the Aliases property, of that reference, is set to "global". What is this property good for and why is it set to global?
MSDN tells me that this is a list of aliases for the assembly but not why I might want to use this property or why most are aliased as "global".
This is for "extern aliases". Suppose you want to use two different types, both of which are called Foo.Bar (i.e. Bar in a namespace of Foo). The two types will be in different assemblies (by definition) - you use the property in VS to associate an alias with each reference, then you can do:
extern alias FirstAlias;
extern alias SecondAlias;
using FirstBar = FirstAlias::Foo.Bar;
using SecondBar = SecondAlias::Foo.Bar;
and then use FirstBar and SecondBar in your code.
So basically it's an extra level of naming - and you shouldn't use it unless you really, really have to. It will confuse a lot of people. Try to avoid getting into that situation in the first place - but be aware of this solution for those times where you just can't avoid it.
Search for "extern alias"; it is a very rarely used feature that is only needed to disambiguate between two dlls that contribute the same types (for example, two different versions of the same assembly, or two assemblies that have a class which shares a fully-qualified-name).
"global" is the default. For example, if you have a class called Foo.System, you can unambiguously refer to the main System namespace via global::System.
There are several different debug flags you can use with the Visual Studio C++ compiler. They are:
The /Gm flag is incompatible with the /MP flag for Multiple Process builds (Visual Studio 2005/2008)
If you want to enable minimal rebuilds, then the /Zi flag is necessary over the /Z7 flag.
If you are going to use the /MP flag, there is seemingly no difference between /Z7 and /Zi looking at MSDN. However, the SCons documentation states that you must use /Z7 to support parallel builds.
What are the implications of using /Zi vs /Z7 in a Visual Studio C++ project?
Are there other pros or cons for either of these options that I have missed?
Specifically, what is the benefit of a single Program Database format (PDB) file for the target vs multiple CodeView format (.obj) files for each source?
MDSN /Z7, /Zi, /ZI (Debug Information Format)
MSDN /MP (Build with Multiple Processes)
Codeview is a much older debugging format that was introduced with Microsoft's old standalone debugger back in the "Microsoft C Compiler" days of the mid-1980s. It takes up more space on disk and it takes longer for the debugger to parse, and it's a major pain to process during linking. We generated it from our compiler back when I was working on the CodeWarrior for Windows in 1998-2000.
The one advantage is that Codeview is a documented format, and other tools can often process it when they couldn't deal with PDB-format debug databases. Also, if you're building multiple files at a time, there's no contention to write into the debug database for the project. However, for most uses these days, using the PDB format is a big win, both in build time and especially in debugger startup time.
One advantage of the old C7 format is that it's all-in-one, stored in the EXE, instead of a separate PDB and EXE. This means you can never have a mismatch. The VS dev tools will make sure that a PDB matches its EXE before it will use it, but it's definitely simpler to have a single EXE with everything you need.
This adds new problems of needing to be able to strip debug info when you release, and the giant EXE file, not to mention the ancient format and lack of support for other modern features like minrebuild, but it can still be helpful when you're trying to keep things as simple as possible. One file is easier than two.
Not that I ever use C7 format, I'm just putting this out there as a possible advantage, since you're asking.
Incidentally, this is how GCC does things on a couple platforms I'm using. DWARF2 format buried in the output ELF's. Unix people think they're so hilarious. :)
BTW the PDB format can be parsed using the DIA SDK.
I'm trying to connect to an MDF. I've even gone to the lengths of re-installing sql server express entirely (it is now the only flavor of SQL installed on my box, where previously I had 05 dev and express). I've verified that the paths are all correct, and thus far my google-fu hasn't helped.
The Full exception message is: Failed to generate a user instance of SQL Server due to a failure in starting the process for the user instance. The connection will be closed.
The Connection string is: <add name="CustomerEntities" connectionString="metadata=res://*/Data.CustomerModel.csdl|res://*/Data.CustomerModel.ssdl|res://*/Data.CustomerModel.msl; provider=System.Data.SqlClient; provider connection string='Data Source=.\SQLEXPRESS; AttachDbFilename=\App_Data\CustomerDb.mdf; Integrated Security=True; User Instance=True'" providerName="System.Data.EntityClient" />
Thanks in advance for any insight you might be able to provide :-)
additional info: several of the references to this error I've found online do not apply to me. For example, one I've seen is where this error occurs when trying to start the user instance over remote desktop (I'm doing this locally). While another suggests that it has to do with leftover files from an old express installation ... I've looked in the prescribed locations and not found those artifacts. I also tried running sp_configure 'user instances enabled', '1', but it said that it was already set to 1.
ok, it works now! guess it was a compound problem ... the steps I took to resolve it are as such:
AttachDbFilename=|DataDirectory|CustomerDb.mdf;c:\Users\<user name>\AppData\Local\Microsoft\Microsoft SQL Server Data\SQLEXPRESS. I thought I had looked for this before, but I had actually looked in the Microsoft Sql Server folder. Again, a subtle difference.Once I did these two things, the connection started working :-D
Here is the exact step-by-step tutorial showing how to fix this error:
In addition to the other solutions here, this one may also be helpful. Ensure the Application Pool is running as network service, and not ApplicationPoolIdentity.
This solution was found here: http://blogs.msdn.com/b/webdevelopertips/archive/2010/05/06/tip-106-did-you-know-how-to-create-the-aspnetdb-mdf-file.aspx
Have you tried to connect to the SQL Server instance by using SQL Management Studio?
If this also doesn't allow you to connect then it could be because the SQL service is not starting correctly.
Verify that the service is running by checking the services in the control panel.
I have a large c# solution file (~100 projects), and I am trying to improve build times. I think that "Copy Local" is wasteful in many cases for us, but I am wondering about best practices.
In our .sln, we have application A depending on assembly B which depends on assembly C. In our case, there are dozens of "B" and a handful of "C". Since these are all included in the .sln, we're using project references. All assemblies currently build into $(SolutionDir)/Debug (or Release).
By default, Visual Studio marks these project references as "Copy Local", which results in every "C" being copied into $(SolutionDir)/Debug once for every "B" that builds. This seems wasteful. What can go wrong if I just turn "Copy Local" off? What do other people with large systems do?
FOLLOWUP:
Lots of responses suggest breaking up the build into smaller .sln files... In the example above, I would build the foundation classes "C" first, followed by the bulk of the modules "B", and then a few applications, "A". In this model, I need to have non-project references to C from B. The problem I run into there is that "Debug" or "Release" gets baked into the hint path and I wind up building my Release builds of "B" against debug builds of "C".
For those of you that split the build up into multiple .sln files, how do you manage this problem?
In a previous project I worked with one big solution with project references and bumped into a performance problem as well. The solution was three fold:
The default cs targets that get shipped with the framework calculate the set of references to be copied to the output dirctory of the project currently being built. Since this requires calculating a transitive closure under the 'References' relation this can become VERY costly. My workaround for this was to redefine the GetCopyToOutputDirectoryItems target in a common targets file (eg. Common.targets ) that's imported in every project after the import of the Microsoft.CSharp.targets. Resulting in every project file to look like the following:
This reduced our build time at a given time from a couple of hours (mostly due to memory constraints), to a couple of minutes. The redefined GetCopyToOutputDirectoryItems can be created by
For completeness the resulting target definition then becomes:
With this workaround in place I found it workable to have as much as > 120 projects in one solution, this has the main benifit that the build order of the projects can still be determined by VS instead of doing that be hand by splitting up your sln.
I'll suggest you to read Patric Smacchia article on that subject :
CC.Net VS projects rely on the copy local reference assembly option set to true. [...] Not only this increase significantly the compilation time (x3 in the case of NUnit), but also it messes up your working environment. Last but not least, doing so introduces the risk for versioning potential problems. Btw, NDepend will emit a warning if it founds 2 assemblies in 2 different directories with the same name, but not the same content or version.
The right thing to do is to define 2 directories $RootDir$\bin\Debug and $RootDir$\bin\Release, and configure your VisualStudio projects to emit assemblies in these directories. All project references should reference assemblies in the Debug directory.
You could also read this article to help you reduce your projects number and improve your compilation time.
In my opinion, having a solution with 100 projects is a BIG mistake. You could probably split your solution in valid logical small units, thus simplifying both maintenance and builds.
our "best practise" is avoid solutions with many projects. We have a directory named "matrix" with current version of assemblies, and all references are from this directory. If you change some project and you can say "now is the change complete" you copy the assembly into the "matrix" directory. So all project, which depends on this assembly has current(=latest) version.
If you have few projects in solution, the build process is much faster.
The step "copy assembly to matrix directory" you can automatize with visual studio macros or with "menu -> tools -> external tools...".
If you got the dependency structure defined via project references or via solution level dependencies it's safe to turn of "Copy Local" I would even say that it's a best practice todo so since that will let you use MSBuild 3.5 to run your build in parallel (via /maxcpucount) without diffrent processes tripping over each other when trying to copy referenced assemblies.
You are correct CopyLocal will absolutely kill your build times. If you have a large source tree then you should disable CopyLocal. Unfortunatley it not as easy as it should be to disable it cleanly. I have answered this exact question about disabling copy local at How do I override CopyLocal (Private) setting for references in .NET from MSBUILD. Check it out. As well as Best practices for large solutions in Visual Studio (2008).
Here is some more info on CopyLocal as I see it.
Copy local was implemented really to support local debugging. When you perpare your application for package and deployment you should build your projects to the same output folder and make sure you have all the references you need there.
I have written about how to deal with building large source trees in the article MSBuild: Best Practices For Creating Reliable Builds, Part 2.
I tend to build to a common directory (e.g. ..\bin), so I can create small test solutions.
You can try to use a folder where all assemblies that are shared between projects will be copied, then make an DEVPATH environment variable and set
<developmentMode developerInstallation="true" />
in machine.config file on each developer's workstation. The only thing you need to do is to copy any new version in your folder where DEVPATH variable points.
Also divide your solution into few smaller solutions if possible.
This may not be best pratice, but this is how I work.
I noticed that Managed C++ dumps all of its binaries into $(SolutionDir)/'DebugOrRelease'. So I dumped all my C# projects there too. I also turned off the "Copy Local" of all references to projects in the solution. I had noticable build time improvement in my small 10 project solution. This solution is a mixture of C#, managed C++, native C++, C# webservice, and installer projects.
Maybe something is broken, but since this is the only way I work, I do not notice it.
It would be interesting to find out what I am breaking.
Usually, you only need to Copy Local if you want your project using the DLL that is in your Bin vs. what is somewhere else (the GAC, other projects, etc.)
I would tend to agree with the other folks that you should also try, if at all possible, to break up that solution.
You can also use Configuration Manager to make yourself different build configurations within that one solution that will only build given sets of projects.
It would seem odd if all 100 projects relied on one another, so you should be able to either break it up or use Configuration Manager to help yourself out.
You can have your projects references pointing to the debug versions of the dlls. Than on your msbuild script, you can set the /p:Configuration=Release, thus you will have a release version of your application and all satellite assemblies.
If you want to have a central place to reference a DLL using copy local false will fail without the GAC unless you do this.
I suggest having copy local = false for almost all projects except the one that is at the top of the dependency tree. And for all the references in the one at the top set copy local = true. I see many people suggesting sharing a output directory, I think this is a horrible idea based on past experience. If your startup project holds references to a dll that any other project hold a reference to you will at some point experience a access\sharing violation even if copy local = false on everything and your build will fail. This issues is very annonying and hard to track down. I completely suggest staying away from a shard output directory and instead having the project at the top of the dependency chain write the needed assemblies to the corresponding folder. If you don't have a project at the "top" then I would suggest a post build copy to get everything in the right place. Also I would try and keep in mind the ease of debugging. Any exe projects I still leave copy local=true so the F5 debugging experience will work.
I wonder if it's possible to save all files in a Visual Studio 2008 project into a specific character encoding. I got a solution with mixed encodings and I want to make them all the same (UTF-8 with signature).
I know how to save single files, but how about all files in a project?
Since you're already in Visual Studio, why not just simply write the code?
foreach (var f in new DirectoryInfo(@"...").GetFiles("*.cs", SearchOption.AllDirectories)) {
string s = File.ReadAllText(f.FullName);
File.WriteAllText (f.FullName, s, Encoding.UTF8);
}
Only three lines of code! I'm sure you can write this in less than a minute :-)
I would convert the files programmatically (outside VS), e.g. using a Python script:
import glob, codecs
for f in glob.glob("*.py"):
data = open("f", "rb").read()
if data.startswith(codecs.BOM_UTF8):
# Already UTF-8
continue
# else assume ANSI code page
data = data.decode("mbcs")
data = codecs.BOM_UTF8 + data.encode("utf-8")
open("f", "wb").write(data)
This assumes all files not in "UTF-8 with signature" are in the ANSI code page - this is the same what VS 2008 apparently also assumes. If you know that some files have yet different encodings, you would have to specify what these encodings are.
This may be of some help.
http://code-journey.com/2008/12/22/visual-studio-2008-text-file-encoding-problems/
Short version: edit one file, select File -> Advanced Save Options. Instead of changing UTF-8 to Ascii, change it to UTF-8. Edit: Make sure you select the option that says no byte-order-marker (BOM)
Set code page & hit ok. It seems to persist just past the current file.
In case you need to do this in PowerShell, here is my little move:
Function Write-Utf8([string] $path, [string] $filter='*.*')
{
[IO.SearchOption] $option = [IO.SearchOption]::AllDirectories;
[String[]] $files = [IO.Directory]::GetFiles($path, $filter, $option);
foreach($file in $files)
{
"Writing $file...";
[String]$s = [IO.File]::ReadAllText($file);
[IO.File]::WriteAllText($file, $s, [Text.Encoding]::UTF8);
}
}
I'm only offering this suggestion in case there's no way to automatically do this in Visual Studio (I'm not even sure this would work):
Thanks for your solutions, this code has worked for me :
Dim s As String = ""
Dim direc As DirectoryInfo = New DirectoryInfo("Your Directory path")
For Each fi As FileInfo In direc.GetFiles("*.vb", SearchOption.AllDirectories)
s = File.ReadAllText(fi.FullName, System.Text.Encoding.Default)
File.WriteAllText(fi.FullName, s, System.Text.Encoding.Unicode)
Next
By default when you add an image (icon, bitmap, etc) as a resource to your project, the image's Build Action is set to None. This is done because the image is magically stored inside a .resources file.
I want the resource to be stored as an embedded resource (my reasons are irrelevant, but let's just pretend it's so that I can see them inside RedGate's Reflector)
So I changed each image's Build Action to Embedded Resource, and the resource then appears inside Lutz's Reflector - exactly as i want.
Unfortunately, Microsoft says specifically not to do this:
Note that when the resource editor adds an image, it sets Build Action to None, because the .resx file references the image file. At build time, the image is pulled into the .resources file created out of the .resx file. The image can then easily be accessed via the strongly-typed class auto-generated for the .resx file.
Therefore, you should not change this setting to Embedded Resource, because doing so would include the image twice in the assembly.
So what is the proper way to include an image as an embedded resource?
Don't add the image as a resource. I would rather do the following:
You can then access this resource using
Assembly.GetExecutingAssembly().GetManifestResourceStream(resourceUri)
This way the image is not magically added to the projects resource file and you will only have one copy of the image stored in the assembly's resources.
This depends on how you want to use the image.
If you want to localize and access specific images for a specific culture, then using the ResourceManager is a good way to go because it provides some nice functionality for satellite assemblies, searching, fallbacks, etc.
If you just want to embed a resource in an assembly and aren't worried about localization (using Assembly.GetManifestResourceStream) then just adding a image and setting the build action to Embedded Resource is fine.
The documentation warns you about not setting the build action to Embedded Resource because the resource is already compiled into the assembly by the resource compiler via the .resx file.
in the project view, open the Properties subtree; double-click the Resources.resx item.
[If you don't have one, right-click the Properties item and choose Open, then click on the Resources tab on the left, and click the link in the middle of the page to create a default resources file. ]
click the first droplist at the top of the resources.resx page, it probably says something unhelpful like "Strings", and select Images. Alternately you can press Ctrl+2. This changes to the Image resources view. Now click the Add Resource droplist and choose 'existing file'. Select your image file and click Open. Rename the resource if you like.
click the Save icon
you can now access your embedded resource programmatically as
[namespace].Properties.Resources.[yourResourceName]
In VS 2005:
To reference the image in code use something like:
btnStop.Image = myImages.Stop;
Has anyone found a plugin for Visual Studio to allow for PowerShell syntax highlighting or IntelliSense? If not, does anyone have any idea why not? I keep hoping someone else with copious free time would have tackled this by now. I have hope since other folks have managed to take the limited documentation and build custom IntelliSense providers for other languages such as NHaml.
Edit: To clarify,I'm not looking for a list of IDEs that can be used to develop PowerShell . I spend 90% of my day in Visual Studio. It already does a really good job of slicing and dicing code. That is the IDE I prefer to use to edit all text and code. The lack of PowerShell syntax highlighting now that I work with PowerShell scripts is down right painful.
The recently released PowerGUI Visual Studio Extension adds PowerShell IntelliSense support to Visual Studio. While it depends on the (free) PowerGUI graphical user interface and script editor, reusing this editor component should be a sign of maturity rather than an impediment I'd hope. (See Kirk Munros PowerShell support in Visual Studio! blog post for an introduction.)
Being a 1.0 there are still some minor issues with the extension as such, but Adam Driscoll seems to be pretty active tackling these - the PowerShell syntax highlighting and IntelliSense support is working most excellent for me already!
Here's a useful one: PowerGUI VS Extension.
I have not seen anything about Visual Studio Intellisense for PowerShell scripts.
I recommend you to try some other tools like:
Look this screen cast:
The PowerConsole extension for VS2010 is very nice and looks promising. I am not sure though that it is suitable (or able) to edit scripts. It is worth to try in any case.
In .NET should you place unit test projects in with the rest of the solution? Or should there be a test solution that houses all the test projects?
We have all the test projects in with our code base solution...it seems a bit cumbersome.
What do you usually do?
In our current project we decided to put all unit tests in separate projects. The application code and tests are in the same solution, but at least we can build (and deploy) a version without the unit test code.
The downside of this -so far- has been that sometimes your unit tests can't reach certain members of the application code (protected and internals), but that usually lead us to discover that our design could be improved.
And I guess I should point out a similar thread Here with more answers on the same/similar topic.
I've always kept them as part of the solution - they are, after all, part of the solution. You can have multiple solutions though for different approaches to viewing your projects, so a testless solution may be what you'd want to create for some cases.
Our test code doesn't ship but they are part of the solution as a whole. Our builder separates out test assemblies and core components. From a solution management perspective it seems like a solution with 140+ projects is overwhelming.
We always use a separate project within the same solution.
This means that we can be certain (using references) that the unit-test code also tests our explicit references (rather than implicitly picking up some visibility of something because it is in the same assembly -- e.g. "Internal")
Generally I put unit tests in their own project and integration tests in their own project within the application solution.
Where I work we are considering putting web tests in a separate solution. We plan to share web test authoring with the QA team and we don't want these tests to become a build liability.
I don't use .NET, but when I develop test cases of any sort, I keep them isolated from the rest of the code so that I can deploy the application without the tests. The user doesn't need, or even want that stuff.
Look at the design of your project. If it is anywhere close to the MVC layout or one of it's alternatives then you should have distinct levels of different assemblies. Make one test subassembly for each level of your design.
Our test project usually runs in place of the project that creates the EXE. Our EXE project is a thin shell that passes event and information to an assembly filled with controller classes that has the code most people put into a EXE Project. This allow the Test Project to pretend to be the EXE for 90% of the normal testing process.
We are still working out the best arrangement for the actual test cases. Right now we have several major levels of our framework Utility, Applicaiton Objects, UI Framework, Commands, UI Controllers, and EXE. We have one assembly for each level except for EXE (which is tested manually). When we edit an assembly we load the test assembly for that level. When we need to do something that touches every level we have to load all the test assemblies.
During our one button build process we run the test project exe. (We have a separate utility for this).
Take the following function:
DataTable go()
{
return someTableAdapter.getSomeData();
}
When I set a breakpoint in this function, is there a possibility to inspect the returned value? The "go" function is directly coupled to a datagrid in an aspx page.
The only way to inspect the returned datatable, is to use a temporary variable... However, that's a bit inconvenient. Isn't there another way?
This isn't possible with Visual Studio 2010 or earlier for C# code. According to a Connect bug report, this was possible for VB.NET under VS2008 but no longer works for VS2010. It's been available to C/C++ developers for some time.
I've logged this as a suggestion on Connect. Please vote for it if you want this improved in future Visual Studio versions!
Not that I know of. Note that if you do add a variable, it will get removed by the compiler in release builds anyway...
Step out of the go() method using Shift-F11, and then in the "Autos" debug window it will show the return value of the method call which just popped off the stack (in this case, the go() method which is what you want). This is the behaviour in Visual Studio 2005; I haven't used Visual Studio 2008 so I don't know if this behaves the same way in that version.
There are a lot of work arounds, but none seems satisfactory.
To quote John Skeet below:
Still looks inconvenient to me - especially if you don't know which return value you're going to need before you start debugging. I really don't want to have to have a temporary variable cluttering up my code every time I ever return anything.t
In theory, the debugger could have a return-variable. After all: it's just a variable on the stack:
unsafe {
int * sp = stackalloc int[1];
try {
return a+b;
}
finally {
Trace.WriteLine("return is " + *(sp+3));
}
}
So consider this an feature request for Visual Studio.
If you go to options, IntelliTrace, and change the setting to collect events and call information. You can go back to the previous call event (ctrl shft f11) and see the temp value returned from the method call in the autos window as a child of the method name.
This isn't showing you the return value for the method you are in, it just shows you the return value of the last method called in the current method.
So, its fine for:
DataTable go(){return someTableAdapter.getSomeData();}
as it shows you the return value for someTableAdapter.getSomeData()
but not for:
int go(){return 100 * 99;}
I agree that this is a very useful thing to have: not only seeing the return value of the method before stepping out of it, but also seeing the return value of methods I just stepped over. I implemented it as part of a commercial extension to Visual Studio called "BugAid" that I am making with a friend, currently in beta.
With it, you can view method return values right on the code editor, as sort of a HUD-display, like in this screenshot:
For more information, please see my blog post about this feature.
Microsoft Visual C++ used to do this, but Visual Studio doesn't AFAIK.. :(
Open the Debug-Autos window gets you close. It won't show the actual return value, but will show what was evaluated in the return statement.
The only way I know, is to place a breakpoint on the return line and then call the Quick Watch Window and enter the returned expression :
someTableAdapter.getSomeData();
But this only works if the call does not change the state of any object (since there will be a second call to the same method when you will resume the execution).
You can also ask to evaluate the value in the intermediate window as well, if it does not set flags or other variables, but only returns something.
You could try selecting "someTableAdapter.getSomeData();", right clicking on it and go for Quick Watch.
Drag and drop the return expression into a watch window.
Eg: In the statement
return someTableAdapter.getSomeData();
drag and drop
someTableAdapter.getSomeData()
into a watch window and you'll see the value.
You can do this for any expression.
Is there a way to select which TestMethods you want to execute in Visual Studio 2008 Unit Test project while debugging? I want to debug one particular test without having my other TestMethods execute during each debug session.
Click on a test method name, then press Ctrl+R, Ctrl+T. (Or go to Test / Debug / Tests in Current Context.)
CTRL-R + T = Run test in context. This can easily be triggered inside a test.
CTRL-R + A = Run all tests
CTRL-R + C = Run all tests in class
CTRL-R + N = Run all tests in namespace
CTRL-R + F = Run all checked tests (good for rerunning al failing tests)
CTRL-R + CTRL-T = Debug test in context, ie. it also attaches debugger
This also works for all other combinations.
There are probably other ways, but I install TestDriven.NET. It allows you to right click on a test method (MSTest, NUnit, MbUnit, etc) and select Run in Debugger. I highly recommend it.
You've got two options when running tests. Look at your Test Tools toolbar. There are four buttons: Run tests in current context, debug tests in current context, run all tests, and debug all tests in solution.
When you want to debug a single test, you can put your cursor in the body of the test and click one of the "current context" test run buttons. To run all tests in a class, put the cursor at the test class name and click one of those buttons.
Alternatively, you can create a test list (Test->Create New Test List), and use that to select the tests you want to run. You can also use theis to disable and remove tests.
If you want to debug while running your tests under an ASP.NET solution, check out the MSDN article "How to: Debug while Running a Test in an ASP.NET Solution" at http://msdn.microsoft.com/en-us/library/ms243172.aspx.
I had to do this tonight and partially followed the instructions for "Debugging While Running on ASP.NET Development Server", setting in web.config and the System.Diagnostics.Debugger.Break() statement at the start of the method. However, I executed with the "Debug Checked Tests" command (Ctrl+R, Ctrl+T) which produced a Just-in-time debugger prompts and ran up a new instance of Visual Studio (I'm using VS2010 Beta2). It worked well.
Like Will mentioned, you can use test lists for all kinds of "test herding" scenarios, as each unit test in a solution can be a member of zero-or-more test lists and you can create a tree of test lists in Test -> Windows -> Test List Editor.
As a team we are using Visual Studio 2005 with framework 3.0. I am thinking if it will be nice for us to switch to Visual Studio 2008 with framework 3.5 ? Is it worth it ?
Thanks.
Yes, it is 100% worth it. Visual Studio 2008 supports 2005 code (.net 2.0) completely. There are also a lot of improvements that you'll enjoy as you use 2008.
Multi-Targeting support (utilization of Dev Studio 2008 for all .Net project, without having to convert them)
Refactor (Productivity tools / Macro )
Unit Test (Pro only)
Better Web Designer with improve Editing and CSS Support
CSS Source View Intellisense
Transparent Intellisense (don?t hide code behind)
ASP.NET AJAX
JavaScript support with Intelissense
JavaScript Debugging
Windows Presentation Foundation (WPF) Designer LINQ (Language INtegrated Query)
Object Relational Designer (O/R Designer)
Better debbuging capabilities (Multithread, script, LINQ, WPF)
Debug Remote process, SQL Debug, XSLT Debug (Professional version only)
New reporting tool (with PDF support)
Crystal report new feature (also ASP.NET) (Pro version only)
Community help (comment added by user in online help)
ClickOnce Deployment enhancement (setup)
Better Vista support
Office support (Pro version only)
Many tools for smart device (Pro version only)
With Dev Studio 2008 SP1
Support for Smart Device Occasionally connected Application
Power Packs Controls and components
Printer Compatiblity Library (use VB6 report without rewriting them)
Sources:
http://msdn.microsoft.com/en-us/library/bb386063.aspx#Original
http://msdn.microsoft.com/en-us/vstudio/products/cc149003.aspx
100% worth it, agreed.
Also switching to 3.5 with new projects (or easy to migrate ones) will help a lot with productivity. Even it you don't use features like LinQ.
Object Initializers and Automatic Properties will make your life much easier.
Also as said before, you can still develop 2.0 projects with VS 2008, so switching won't hurt at all. There have been some improvements in the Webdesigner space, especially with Javascript Syntaxhighlightning etc..
Even if you can't use .NET 3.5 yet, the C# 3.0 language features (especially if you use LINQBridge) are well worth it. It also has better support for WCF etc (since you mention 3.0 - this is a kludge in VS2005).
Add to that the IDE improvements, and it is a no-brainer IMO.
The intellisense for C# is much improved
yes it is. works faster and more reliable
I've got a VS 2008 C# Web project and whenever I make some changes to the files in it (not even to the project file itself) VS will remove some lines like this from the csproj file:
<SubType>ASPXCodeBehind</SubType>
So something like this:
<Compile Include="Default.aspx.cs">
<DependentUpon>Default.aspx</DependentUpon>
<SubType>ASPXCodeBehind</SubType>
</Compile>
will become
<Compile Include="Default.aspx.cs">
<DependentUpon>Default.aspx</DependentUpon>
</Compile>
BUT the next time I work on this project it will add those lines back! It keeps going back and forth like this, resulting in a lot of meaningless "changes" in our source control system. This never used to happen with VS 2005 and it doesn't seem to be happening for other developers who work on the same project file, only for me.
Does anyone know why this is happening and how I can stop it from doing this?
Splitting the content of your file into multiple files - one file per class may help.
https://connect.microsoft.com/VisualStudio/feedback/ViewFeedback.aspx?FeedbackID=283434
For me, the difference depends on whether or not the web project is open in Visual Studio.
I find if I commit the project file to version control with the project open in Visual Studio the SubType elements are present. Closing the solution/project then removes the SubType elements from the project file. Now I always ensure my commits are performed with the project closed in VS to avoid unnecessary changes to the project file.
We're using Perforce and Visual Studio. Whenever we create a branch, some projects will not be bound to source control unless we use "Open from Source Control", but other projects work regardless. From my investigations, I know some of the things involved:
In our .csproj files, there are these settings:
Sometimes they are all set to "SAK", sometimes not. It seems things are more likely to work if these say "SAK".
In our .sln file, there are settings for many of the projects:
(The # is a number that identifies each project.) SccLocalPath is a path relative to the solution file. Often it is ".", sometimes it is the folder that the project is in, and sometimes it is ".." or "..\..", and it seems to be bad for it to point to a folder above the solution folder. The relativized one is a path from that folder to the project file. It will be missing entirely if SccLocalPath points to the project's folder. If the SccLocalPath has ".." in it, this path might include folder names that are not the same between branches, which I think causes problems.
So, to finally get to the specifics I'd like to know:
I would disagree with the claim that Perforce integration in Visual Studio is "terrible". Rather, I'd define it as "out of the box experience is less than optimal" :-). The following sections discuss my understanding of the integration and recommendations for project/solution setup.
If you're not interested in the details of how the source control integration works you can skip to the end of this answer where I summarize answers to Weeble's question.
Disclaimer: The following sections are just educated guesses based on my empirical experience, however I've used the technique over many years in many projects (each project having multiple experimental/trunk/maintenance/release branches, sometimes even multiple solution files, without issues). The disadvantage is that you have to manually update the project files - but the 2 minute investment is amortized over the lifetime of a project pretty nicely IMHO :-).
Visual Studio uses source control binding information from both solution file and each project file during the initial solution loading. This binding information is then stored in name.suo file (assuming we're using name.sln as solution) - note that suo files are marked with hidden flag so they won't be visible in file explorer (unless you override the "Hidden files and folders" option).
The easiest way to re-bind to source control provider if anything goes wrong is to delete the appropriate suo file and reopen solution. After suo file has been created, changes to <Scc*> elements have no effect.
If during the initial solution opening there is a discrepancy between the binding information stored in solution file and information stored in project file, Visual Studio will attempt to fix this (sometimes it will even prompt for your decision to choose whether the information in solution or the information in project should be used as a "master" to resolve the discrepancy):
Why is Visual Studio violating DRY (Don't Repeat Yourself) principle? I have no idea. I presume this has historic reasons and is tightly coupled to the needs of that nightmare called Visual Source Safe :-).
When adding either new or existing solutions/projects to Perforce, I always start by creating a blank solution (see the "Source-controlling a blank solution" section). I then add projects to this blank solution, one after another. The steps differ slightly based on whether the project being added already exists (see the "Source-controlling existing (unbound) projects" and "Source-controlling existing (bound) projects" sections) or I need to create a new one (see the "Source-controlling new projects" section).
To add a new blank solution to source control, do the following:
Open the name.sln file in your favourite editor (notepad, if you're really desperate :-) ) and add two new lines (SccProjectName0 and SccProvider0) - the blank solution file should now have a source control section as follows:
GlobalSection(SourceCodeControl) = preSolution
SccNumberOfProjects = 1
SccLocalPath0 = .
SccProjectName0 = Tutorial
SccProvider0 = MSSCCI:Perforce\u0020SCM
EndGlobalSection
The values should be chosen as follows:
You can now test the bindings:
If you're creating a brand-new project and would like to immediately start tracking it in a Perforce depot, follow these steps:
Manually edit the project file you just created using an editor of your choice (come on, notepad AGAIN? ;-) ). Add the following property elements into a PropertyGroup (any property group):
<PropertyGroup>
...
<SccProjectName>Tutorial</SccProjectName>
<SccLocalPath>..\..</SccLocalPath>
<SccProvider>MSSCCI:Perforce SCM</SccProvider>
...
</PropertyGroup>
The values should be chosen as follows:
Switch back to Visual Studio; it should automatically detect that the project file has been updated externally and offer to reload it (if not, unload and reload the project manually)
To verify that the newly added project is bound properly, you can follow these steps:
You can now verify source control status of the solution by using "File" -> "Source Control" -> "Change Source Control...":
One thing to note about this status screenshot is that when I selected the solution row, all the remaining rows were "selected" as well (blue highlight). This is because all those entries have the same "Server Binding" + "Local Binding" and thus share the same source-control-provider (P4) connection.
Also note that "Relative Path" for both projects has two levels, and are relative to the same "Local Binding" - the directory where solution file resides.
If you have existing projects that have not yet been used in any other Perforce solution, follow these steps to add them to Perforce (i.e. importing projects that have not been source-controlled before (Internet downloads etc.) or were using a different source control provider (Visual Source Safe, etc.).
Verification steps are exactly the same as in "Source-controlling new projects" section.
If you have projects that have already been bound to Perforce using the technique discussed here and you want to use them in a different solution (new branch, alternative solution reusing the project, etc) use the following steps:
I'm also including answers to your original questions:
What happens when you do "Change source control" and bind projects? How does Visual Studio decide what to put in the project and solution files?
This updates "Scc*" elements in a project file you're rebinding; the solution file is then updated as well so that it is in sync with the project file bindings
What happens when you do "Open from source control"?
Allows you to pick solution that you'd like to open. Afterwards all the projects included in the solution are automatically synced to head. I find this feature not very useful in Perforce world where you have to create a client anyway and the chances are you're syncing this client from a P4V/P4Win/P4 instead of relying on Visual Studio. This was kind-of useful in Visual Source Safe world where there was no concept of views and you were defining where a repository goes on checkout time.
What's this "connection" folder that SccLocalPath and SccProjectFilePathRelativizedFromConnection refer to? How does Visual Studio/Perforce pick it?
This is Visual Studio's bookkeeping. It is determined based on bindings in each project file (I guess in theory if a project file looses binding information for some reason, it could be reconstructed from the solution information...)
Is there some recommended way to make the source control bindings continue to work even when you create a new branch of the solution?
I hope the sections above give you some idea of a way that is working very well for me :-).
Milan's post is well-researched and well-written, but its length demonstrates beyond a shadow of a doubt that the P4SCC model is broken. Storing source control binding info inside the project & solution files is ridiculous. Enforcing (via sccprojectname) that a project be part of only one solution is equally ridiculous.
Additionally, P4SCC has a tremendous performance cost in a large solution, as it retrieves info from source control for each file at startup, and maintains that state in memory throughout the development session. It creates extra cruft in the form of information-free .vsscc & vssscc files to support some SCC feature that (AFAICT) Perforce does not use.
The ideal Perforce integration looks like:
We have moved completely away from P4SCC and its bizarre requirements and burdens. Instead we use NiftyPerforce. There are some bugs, but we find working around these bugs to be much less frustrating than working around the design defects in the Perforce<->VSSCC model.
Support for renaming a file or moving it to a new folder directory is terrible and painful if using the Visual Studio P4 plug-in integration. No built-in feature exists that alerts P4 to renaming the file or that it has been moved.
The issue is that renaming a file requires not just updating the associated VS project file but Perforce needs to be informed as well of the change if you want to maintain proper revision history.
Currently, I do not see a way to do both in a single operation if using the VS integration. Instead, you have to:
If you use a continuous integration build process and you submit changes at any point prior to the last step, you are guaranteed to have a broken build.
The problem magnifies significantly the more files that require renaming or moving. This is not a smooth process whatsoever.
I can answer the last one.
In order to get source control bindings to work even when you create a new branch, follow a strict hierarchical structure:
/Solution
/library1
/library2
/product1
/product2
/subsolution
/sublibrary1
/subproduct1
Each file must be in exactly one .vcproj. You can have multiple .vcproj in the same directory, but if they share files, the shared files must go into their own .vcproj.
If you are relentless in this, all the Scc stuff will be relative-path, so a new branch will work (because it only changes the topmost directory).
Very poorly. I know that is not the answer to your questions that you were looking for (in the future, perhaps you could narrow the focus?), but source control integration with Visual Studio just sucks. The reason being that they all have to use Microsoft's terrible SCC interface. It's pathetic! They put source control information in the project files! Why would they do that?
Just abandon the Visual Studio integration and use the Perforce client. It's not that much extra work. You can't spare 30 seconds per day to switch over to the Perforce client and check in/out the files out from there?
After experimenting with Milan Gardian's very informative answer, I think I can provide a simpler solution to get it working pretty well.
As Weeble mentioned, the SAK values work fine when everything else is set up correctly, and they are often the default values (but I think it depends on which project type it is). If they do not show up in your project, just paste in this property group.
<PropertyGroup>
<SccProjectName>SAK</SccProjectName>
<SccProvider>SAK</SccProvider>
<SccAuxPath>SAK</SccAuxPath>
<SccLocalPath>SAK</SccLocalPath>
</PropertyGroup>
Add these two lines to the *.sln in the SourceCodeControl GlobalSection. As long as the project files have SAK values, they should inherit the names from the solution.
SccProjectName0 = Perforce\u0020Project
SccProvider0 = MSSCCI:Perforce\u0020SCM
No *.vssscc, *.vspscc, or *.SCC files need to be checked in (though they will be generated when the solution is opened).
Using Perforce with Visual Studio can be simplified by using the P4CONFIG environment variable.
Basically you go into Visual Studio, Tools -> Options -> Source Control -> Plug-in Settings, Advanced button. This will bring up a Perforce configuration dialog specific to the SCC integration. Switch to the Connection tab, and check the radio button titled 'Bind the workspace that matches your Perforce environment settings'. This will tell perforce to prefer using P4CONFIG environment variable for determining the environment you are under. This same dialog exists in P4V under Edit -> Preferences, but only affects p4v's behavior.
How you setup the P4CONFIG environment variable is up to you to some degree. I like having them be named the same everywhere so I set a system-wide environment variable P4CONFIG to look for a file named p4config.cfg. This file is just an ini style file, where you can assign other variables such as P4USER, P4CLIENT, P4HOST etc. Perforce will search for this file in the current directory and all parent directories until it encounters one. Basically you put this file in the root most directory of your where your clientspec is mapped to on your hard drive, and leave it alone.
This approach greatly reduces the amount of 'correctness' that the SCC configuration needs in visual studio in order to function. (SAK bindings work fine etc.)
If after syncing your code from perforce for the first time or to a totaly clean directory structure, and getting a dialog complaining about perforce wanting to either temporarily work offline or remove bindings, there is still some editing you need to do. Primarily the .sln file itself needs to be modified so it knows the sln has SCC bindings for itself . This is done by making sure the following fields are placed right after SccNumberOfProjects in the .sln file.
SccProjectName0 = Perforce\u0020Project
SccProvider0 = MSSCCI:Perforce\u0020SCM
All of the individual projects should work fine with default 'SAK bindings' provided you are using the P4CONFIG approach. Fixing this should allow Perforce to work from a clean sync perfectly, and also eliminate the generation of MSSCCPRJ.SCC cruft in each of the project directories.
Does MSTest have standalone GUI similar to nUnit that lets me use it and run test without visual studio? What is the official site for MSTest where I can learn more about how to use it?
It doesn't have a GUI (apart from Visual Studio) but there's a command line tool: MSTest.exe
Here is the official documentation on running MSTest tests.
You can do this with mstest.exe, but the trick is in getting it to work without installing visual studio. This involves the copying of several files and registry entries. I have blogged about it here.
Use Gallio as your test runner... then its not so much of a drama when you enventually drop MsTest and move to a real test framework.
I describe here how to run mstest without VS - http://www.shunra.com/shunrablog/index.php/2009/04/running-mstest-without-visual-studio/
You can also use this tool from codeplex: http://testrunner.codeplex.com...
MSTest can be used without installing Visual Studio. You will need to install Visual Studio Test Agent, which is a free download from Microsoft: http://www.microsoft.com/download/en/details.aspx?id=1334.
I think this approach is better from a licensing perspective than manually copying MSTest.exe and its dependencies onto the build server.
See this blog for reference: http://blogs.msdn.com/b/anutthara/archive/2009/12/16/running-tests-in-mstest-without-installing-the-vs-ide.aspx
if i decide to use the 'publish' option for my ASP.NET website, instead of a Web Deployment Project, can i do custom msbuild things? Or do i need to stick with WDP's if i want to do custom msbuild stuff during compile/deployment.
I think of the publish option as a part of the VS.NET toolset for developers to use to publish web sites on dev machines. It isn't really built to be a real deployment.
If you need custom actions, a Web Deployment Project would be more suited to a real deployment that multiple people other than the developer run regularly and that you want created with each build.
I would also look at three other options:
PowerShell: A good way to script against IIS, set up websites, etc. You can even build cmdlets from OO code (like C#) that your script can call. Many professional IT firms use it to deploy big web sites.
MSDeploy: A new deployment tool for websites that can replicate a vroot over several servers. Very good for having your golden image and then blasting it out to various places.
C# application: If you are a more advanced developer, you can always write your own application that xcopies files (via Process) and uses WMI to configure IIS. Harder, but you have complete control.
It looks like you can customize the Publish task through the _CopyWebApplication MSBuild target. Or you can at least create a batch file that will call that target, which you can customize.
You can use custom MSBuild options. In fact, you can execute MSBuild on a sln file configured to publish as a website, and then copy the precompiled website files to a webserver. We do that internally using Cruise Control.net from Thoughtworks.
The sln file contains info about where the precompiled website will be located:
Release.AspNetCompiler.VirtualPath = "/PrecompiledWeb"
Release.AspNetCompiler.PhysicalPath = "..\Web\"
Release.AspNetCompiler.TargetPath = "..\..\PrecompiledWeb\"
Release.AspNetCompiler.Updateable = "true"
Release.AspNetCompiler.ForceOverwrite = "true"
Release.AspNetCompiler.FixedNames = "true"
Release.AspNetCompiler.Debug = "False"
We don't use publish to deploy our web projects, but we used to use Web Deployment Projects. When we switched to Visual Studio 2008, we ran into a bunch of problems with them, so we got rid of them.
What I can tell you is that we were able to replace the WDP functionality we were using with aspnet_merge.exe. We use a combination of msbuild and aspnet_merge.exe in a script to get our deployments done.
I'm developing a library for use in other apps and this library has lots of debugging and logging statements thanks to NLog.
Is it possible to exclude the reference to NLog.dll when I switch to release mode?
Cheers,
You can manually edit the csproj file, and do something like this:
<Reference Include="NLog" Condition="'$(Configuration)' == 'Debug'" />
This only makes it reference that assembly in Debug. I wouldn't recommend doing this often though, because this behavior isn't reflected in the references list in Visual Studio when you change the configuration. It does work when compiling though
The only way I know is to take the reference out completely and call the assembly via reflection. Then, you should only log if the assembly loads.
I can't think of a good way to do this. Unless maybe you wrote a stub reference for NLog.dll. Since you are using the reference in your code I don't see how you could just remove it in your release.
Probably too late now but in the future you could write a class to wrap NLog.dll and then just change it in one place so it wouldn't actually log in the release version. Or have some sort of flag.
There is no reason for removing a reference in case you are sure that no code will be in use from that DLL. In that case you can simply remove DLL.
Why would you want to do that?
If you want to stop logging, you can programatically turn off the logging. The performance hit will be minimal. (I have had great success with NLog even when logging cross process.)
Otherwise, you need to wrap it as described above.
-Scott
Sometimes while developing in Visual Studio IDE, when you use "Find in Files" dialog to find something, the search fails and you will see the following message in the "Find Results" window.
No files were found to look in. Find stopped progress
Once this message shows-up all the subsequent searches will result in the same message. Nothing fixes the problem including restarting computer except Pressing "Ctrl + ScrLk".
Does anyone know what causes Visual Studio to get into this state and is there a setting to permanently prevent it from happening?
According to this thread:
Posted by Microsoft on 10/13/2009 at 4:33 PM
Hi all,
Thank you for your continued interest in this bug. We have been able to reproduce the issue intermittently in several versions of Visual Studio running on several versions of Windows and have identified the root cause as external to VS. The Windows team unfortunately did not have time to fix this for their current release, but we are working with them to hopefully have this bug fixed for a future version of Windows. At present, the workaround (as many of you noted) is to press Ctrl+Scroll Lock, Ctrl+Break, or the Break key alone.
Again, thanks for all of the details you provided about this bug. If you have any further questions or comments, please feel free to post again here; although this issue was closed quite a while ago, I'll make sure it stays on our radar.
Thanks, Brittany Behrens Program Manager, VS Platform - Editor
This bug has been around since at least 2004 and, as of the above post in 2009, had not been fixed.
Sometimes Ctl + Break works, sometimes ALT+Break, Sometimes Ctrl + Scroll Lock, other times ALT + Scroll Lock.
Right now, nothing works.This has been a huge problem for me. Same on MS for not fixing this bug in the last 9 years.
I don't think there is anything you can do to prevent it. It seems to occur after I have stopped a build with CTRL+Break...Maybe I am pressing CTRL+Scroll Lock during that time???
I have only had it happen to me 2-3 times, and that was several months apart.
What he is saying is that occasionally when performing a search within Visual Studio you get the mentioned error message. Even though you know there is stuff to find. It is some weird state that Visual Studio gets into. If you press the (CTRL+Scroll Lock) it will 'fix' the issue.
Apparently, for those for who the key combinations don't work (like me at the moment), deleting the folowing registry key brings salvation:
MyComputer\HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\[VS VERSION NUMBER]\Find
Ofcourse, [VS VERSION NUMBER] should be internal version number of the IDE. Don't forget to restart your computer.
Mind you, deleting stuff in the registry is dangerous. Like anyone on SO cares but anyway...
VS 2010. Nothing works... Deletion of all find keys in registry helped only.
I am using VS 2008. I could not remove the error using the key combination. But the Find registry deletion works.
I have had this problem and saw peoples answers about the multiple CTRL + break /pause scroll lock combinations. I considered this but thought it a poor workaround (especially as I use a Mac Keyboard so those keys are not easily available).
So the solution I found was to do this:
Menu: Tools->Options->Envionment->Find and Replace
uncheck the top 3 check boxes (checked by default in my settings)
re-check the top 3 check boxes.
et voila, everything should work fine. Well it did for me anyway, which was a relief as I can't believe Microsoft would allow a weird key combination as a work around for a bug like this. I submit this hoping it may help !
I have whitespace characters showing in the Visual Studio code editor, and I'd like to remove them.
Ajryan is correct but depending on your profile this menu item may be obscured. The keyboard shortcut should still work though. CTRL+R,CTRL+W
You need to turn off showing whitespace characters. Menu: Edit > Advanced > View White Space.
If it is VS2008 then you can use "Ctrl+E, S" combination to toggle.
I work in C#, and I've been pretty lax about using using blocks to declare objects that implement IDisposable, which you're apparently always supposed to do. However, I don't see an easy way of knowing when I'm slipping up. Visual Studio doesn't seem to indicate this in any way (am I just missing something?). Am I just supposed to check help every time I declare anything, and gradually build up an encyclopedic memory for which objects are and which are not disposable? Seems unnecessary, painful, and error-prone.
How do you handle this?
EDIT:
Looking at the related questions sidebar, I found another question which made it clear that Dispose() is supposed to be called by the object's finalizer anyway. So even if you never call it yourself, it should eventually happen, meaning you won't have a memory leak if you don't use using (which is what I suppose I was really worried about all along). The only caveat is that the garbage collector doesn't know how much extra memory is being held by the object as unmanaged stuff, so it won't have an accurate idea how much memory will be freed by collecting the object. This will result in less-ideal-than-usual performance by the garbage collector.
In short, it's not the end of the world if I miss a using. I just wish something would generate at least a warning for it.
(Off-topic: why is there no special markdown for linking to another question?)
EDIT:
Ok, fine, stop clamoring. It's super duper all-fired dramatic-chipmunk-level important to call Dispose() or we'll all die.
Now. Given that, why is it so easy — hell, why is it even allowed — to do it wrong? You have to go out of your way to do it right. Doing it like everything else results in armageddon (apparently). So much for encapsulation, huh?
[Stalks off, disgusted]
FxCop might help (although it didn't spot a test I just fired at it); but yes: you are meant to check. IDisposable is simply such an important part of the system that you need to get into this habit. Using intellisense to look for .D is a good start (though not perfect).
However, it doesn't take long to familiarize yourself with types that need disposal; generally anything involving anything external (connection, file, database), for example.
ReSharper does the job too, offering a "put into using construct" option. It doesn't offer it as an error, though...
Of course, if you are unsure - try using it: the compiler will laugh mockingly at you if you are being paranoid:
using (int i = 5) {}
Error 1 'int': type used in a using statement must be implicitly convertible to 'System.IDisposable'
If an object implements the IDisposable interface, then it is for a reason and you are meant to call it and it shouldn't be viewed as optional. The easiest way to do that is to use a using block.
Dispose() is not intended to only be called by an object's finalizer and, in fact, many objects will implement Dispose() but no finalizer (which is perfectly valid).
The whole idea behind the dispose pattern is that you are providing a somewhat deterministic way to release the unmanaged resources maintained by the object (or any object in it's inheritance chain). By not calling Dispose() properly you absolutely can run in to a memory leak (or any number of other issues).
The Dispose() method is not in any way related to a destructor. The closest you get to a destructor in .NET is a finalizer. The using statement doesn't do any deallocation...in fact calling Dispose() doesn't do any deallocation on the managed heap; it only releases unmanaged resources that had been allocated. The managed resources aren't truely deallocated until the GC runs and collects the memory space allocated to that object graph.
The best ways to determine if a class implements IDisposable are:
Dispose() or a Close() method)IDisposable you get a compiler error)Open(), there is probably a corresponding Close() that should be called)using statement. If it doesn't implement IDisposable, the compiler will generate an error.Think of the dispose pattern as being all about scope lifetime management. You want to acquire the resource as last as possible, use as quickly as possibly, and release as soon as possible. The using statement helps to do this by ensuring that a call to Dispose() will be made even if there are exceptions.
In short, it's not the end of the world if I miss a using. I just wish something would generate at least a warning for it.
The problem here is that you can't always deal with an IDisposable by just wrapping it up in a using block. Sometimes you need the object to hang around for a bit longer. In which case you will have to call its Dispose method explicitly yourself.
A good example of this is where a class uses a private EventWaitHandle (or an AutoResetEvent) to communicate between two threads and you want to Dispose of the WaitHandle once the thread is finished.
So it isn't as simple as some tool just checking that you only create IDisposable objects within a using block.
This is why (IMHO) C++'s RAII is superior to .NET's using statement.
A lot of people said that IDisposable is only for un-managed resources, this is only true depending on how you define "resource". You can have a Read/Write lock implementing IDisposable and then the "resource" is the conceptual access to the code block. You can have an object that changes the cursor to hour-glass in the constructor and back to the previously saved value in IDispose and then the "resource" is the changed cursor. I would say that you use IDisposable when you want deterministic action to take place when leaving the scope no matter how the scope is left, but I have to admit that it's far less catchy than saying "it's for managing un-managed resource management".
See also the question about why there's no RAII in .NET.
@Atario, not only the accepted answer is wrong, your own edit is as well. Imagine the following situation (that actually occurred in one CTP of Visual Studio 2005):
For drawing graphics, you create pens without disposing them. Pens don't require a lot of memory but they use a GDI+ handle internally. If you don't dispose the pen, the GDI+ handle will not be released. If your application isn't memory intensive, quite some time can pass without the GC being called. However, the number of available GDI+ handles is restricted and soon enough, when you try to create a new pen, the operation will fail.
In fact, in Visual Studio 2005 CTP, if you used the application long enough, all fonts would suddenly switch to ?System?.
This is precisely why it's not enough to rely on the GC for disposing. The memory usage doesn't necessarily corelate with the number of unmanaged resources that you acquire (and don't release). Therefore, these resoures may be exhausted long before the GC is called.
Additionally, there's of course the whole aspects of side-effects that these resources may have (such as access locks) that prevent other applications from working properly.
Unfortunately, neither FxCop or StyleCop seem to warn on this. As other commenters have mentioned, it is usually quite important to make sure to call dispose. If I'm not sure, I always check the Object Browser (Ctrl+Alt+J) to look at the inheritance tree.
I don't really have anything to add to the general use of Using blocks but just wanted to add an exception to the rule:
Any object that implements IDisposable apparently should not throw an exception during its Dispose() method. This worked perfectly until WCF (there may be others), and it's now possible that an exception is thrown by a WCF channel during Dispose(). If this happens when it's used in a Using block, this causes issues, and requires the implementation of exception handling. This obviously requires more knowledge of the inner workings, which is why Microsoft now recommends not using WCF channels in Using blocks (sorry could not find link, but plenty other results in Google), even though it implements IDisposable.. Just to make things more complicated!
Like Fxcop (to which they're related), the code analysis tools in VS (if you have one of the higher-up editions) will find these cases too.
Always try to use the "using" blocks. For most objects, it doesn't make a big difference however I encountered a recent issue where I implemented an ActiveX control in a class and in didn't clean up gracefully unless the Dispose was called correctly. The bottom line is even if it doesn't seem to make much of a difference, try to do it correctly because some time it will make a difference.
I use using blocks primarily for this scenario:
I'm consuming some external object (usually an IDisposable wrapped COM object in my case). The state of the object itself may cause it to throw an exception or how it affects my code may cause me to throw an exception, and perhaps in many different places. In general, I trust no code outside of my current method to behave itself.
For the sake of argument, lets say I have 11 exit points to my method, 10 of which are inside this using block and 1 after it (which can be typical in some library code I've written).
Since the object is automatically disposed of when exiting the using block, I don't need to have 10 different .Dispose() calls--it just happens. This results in cleaner code, since it is now less cluttered with dispose calls (~10 fewer lines of code in this case).
There is also less risk of introducing IDisposable leak bugs (which can be time consuming to find) by somebody altering the code after me if they forget to call dispose, because it isn't necessary with a using block.
According to this link the CodeRush add-in will detect and flag when local IDisposable variables aren't cleaned up, in real-time, as you type.
Could meet you halfway on your quest.
I'm not getting the point of your question. Thanks to the garbage collector, memory leaks are close to impossible to occur. However, you need some robust logic.
I use to create IDisposable classes like this:
public MyClass: IDisposable
{
private bool _disposed = false;
//Destructor
~MyClass()
{ Dispose(false); }
public void Dispose()
{ Dispose(true); }
private void Dispose(bool disposing)
{
if (_disposed) return;
GC.SuppressFinalize(this);
/* actions to always perform */
if (disposing) { /* actions to be performed when Dispose() is called */ }
_disposed=true;
}
Now, even if you miss to use using statement, the object will be eventually garbage-collected and proper destruction logic is executed. You may stop threads, end connections, save data, whatever you need (in this example, I unsubscribe from a remote service and perform a remote delete call if needed)
[Edit] obviously, calling Dispose as soon as possible helps application performance, and is a good practice. But, thanks to my example, if you forget to call Dispose it will be eventually called and the object is cleaned up.
Any ideas on how to disable, but not uninstall Resharper 4.x or above?
The accepted answer does not work from resharper 5 onwards. You should suspend ReSharper from the Tools > Options > Resharper
You can disable ReSharper using the Visual Studio Add-In Manager (remove the check from check box on the left):
Caveat: only tested with VS 2005 and R# 3.1, but I see no reason why it wouldn't work with other versions too. :)
In R5, this is how you can suspend ReSharper from the Tools > Options > Resharper
This didn't work for me. The checkbox in the Startup column was both checked and disabled.
BUT! I found a fix elsewhere on the web.
What you need to do is make the following file(s) writeable:
C:\Program Files\JetBrains\ReSharper\v4.0\Bin\Product.VisualStudio.80.AddIn
C:\Program Files\JetBrains\ReSharper\v4.0\Bin\Product.VisualStudio.90.AddIn
Because these files were read-only, VS200x was unable to modify them to set the startup enabledness of the Resharper addin.
If you want to do it without clicking too much, open the Command Window (Ctrl + W, A) and type:
ReSharper_Suspend or ReSharper_Resume depending on what you want.
Or you can event set a keyboard shortcut for this purpose. In VS, go to Tools > Options > Environment > Keyboard.
There you can assign a keyboard shortcut to ReSharper_Suspend and ReSharper_Resume.
You can also press Ctrl+8.
In ReSharper 5.0, the keyboard shortcut to temporarily enable/disable code analysis for the current file is Ctrl+Shift+Alt+8. It was Ctrl+8 in previous versions.
On Win7, open VS as admin, and the .AddIn file will be writable. (the checkbox will be active)
How do I keep VS from opening a new tab in Firefox every time I hit F5 to debug a web application? I would really like it to re-use the same tab.
This may not work for you but, in a project's properties on the Web tab there is a setting described as "Don't open a page. Wait for a request from an external application." All the developers at my company have this set and then just use bookmarks to load our pages.
In firefox click: Tools>Options>Tabs
"New pages should be opened in"
Select the option to always open new windows in a new browser and not in a new tab.
While this might not have the desired effect, I don't know if it's actually possible to get Firefox to play nicely with it's tabs.
Thanx for the answer, but unfortunately that opens a whole new window. I'd like it to use the same tab in the same window. And I'm afraid you are correct, its probably not possible to get the desired affect with FF.
I'm cheap and don't want to pay for ReSharper or TestDriven.NET, is there a free visual Studio addin for NUnit?
You can create a blank project (Choose console application for example) and in the property of the project you can select DEBUG tag and select "Start External Program". Put the path of Nunit. Than, in the start option, the command line arguments select the DLL that contain all your test (mine is always in the nunit\bin...). Than select "enable unmanaged code debugging" and you will be able to start the projet inside VS and even use the debugger step-by-step.
This is a free solution.
This article probably explains what you want to do.
Now you can use Gallio: it's open source. www.gallio.org
NUnit actually ships with a basic integrated runner. It's not very good, and not very publicized, but unless Charlie has taken it out, it should be in the source.
By the way TestDriven can be downloaded for free if it's for personal use or Open Source project.
I had to find a way to use .Net Reflector inside VS few days ago and when I downloaded TestDriven it cames with. Never got any popup asking me to paid.
I know this is an old question but another way to do this is to add an external tool from the tools menu to run nunit - set the arguments to be $(TargetName)$(TargetExt) and initial directory to $(ProjectDir)\bin\Debug
check out this link
Check this link: NUnitAddin
I know that Ctrl + Shift + B launches a solution build, but I would like a shortcut that just builds the current project. Is a custom shortcut my only option?
Edit: Looks like a custom shortcut is my only option as Shift + F6 does not work for me.
Assigning the shortcut to "Build.BuildOnlyProject" command doesn't seem to work in VS2008.
Assign the shortcut to "Build.BuildSelection". If you have a solution with several projects and files open from the various projects, whatever file you are currently editing will define the project that will be built when you use the assigned shortcut for "Build.BuildSelection".
You'll know the keyboard shortcut is working when you click the Build menu option and you see the keyboard shortcut on the menu itself.
btw - a restart/reboot is not required when assigning keyboard shortcuts.
custom shortcut depending on what keybindings you are using.....if you look in your menu it will tell you if you have a keybinding...
the other thing I have got used to because I make use of ViEmu a lot is use the menu shortcuts which are actually quite quick to do, and are independent of bindings.
for C# development. Tools -> Options. Select Keyboard, select additional keyboard mapping scheme to "Visual C# 2005". This mapping has "F6" as standard shortcut.
For C# development:
F6 or Shift+Ctrl+B - Builds all the projects in the solution.
Shift+F6 - Builds the selected project and its dependencies.
In the Visual Studio options window, under "Keyboard", look for the "Build.BuildOnlyProject" command and you can set whatever you want.
I hope this link is help full to you.....
http://msdn.microsoft.com/en-us/library/xte2hh6a%28v=vs.71%29.aspx
In this link all short cut defines....
CodeGear announces that their Next .Net product which is known as Delphi Prism Will be RemObjects's Oxygene.
Oxygene has many nice features that not found in Delphi or C#, and I think it will be a more effective solution for .Net than Delphi .Net previous releases, but it's uses Visual Studio IDE instead of Delphi IDE. which has some cons and pros.
As Delphi Developer or .Net Developer, do you consider to use Delphi Prism for .Net developmenet?
Look at these Links for more info.
"Delphi Prism" is not Delphi. It's Oxygene. A very different language (designed to be this way since day one). Just giving it a new name wouldn't help to fill this gap.
Do you want to take the risk? If yes, what you will gain? Since backward compatibility is dead (or will suffer, at best)... Compare the "new" features of "Prism" with future C# 4.0, for example.
So... Sorry, RemObjects. Sorry, Embarcadero. We all love you guys, but C# is and would continue to be the safest harbor in this game.
Absolutely, while our main application will continue to live and breathe as a native win32 application, there is the need to connect it to existing .net framework applications. While traditionally we have done this in C#, moving this code over to Prism will not be that much of a problem, and will be very welcome. As a very long time pascal programmer, I tend to think in begin end pairs, not in brackets.
For new development, we will carefully weigh what makes the most sense for our customers. Most likely this will continue to be back end win32 native systems and front ends in either .net or win32 depending on our target audience.
Delphi was great because it could produce small, native, blazing fast programs. It was faster to develop in than C, while providing similar fast speeds when running - fast enough to write its own components. Delphi should stick to native, and move to support both ARM processors and 64 bit processors. VCL for OSX would be very interesting, and they could do it cleaner than Kylix.
But Prism. Ugh. I looked at the examples - right there is an example of writing the VB.Net split routine using Prism/Pascal to support the example. In .Net, the last thing in the world you want to do is write library routines in the .Net language. You want to use the .Net library that was written closer to the metal. In VB.Net, you already have split for arrays built-in. The examples provided show the very weakness of the concept.
Any you know what? The cluttered version of pascal when it lives in Prism is just such a noisey pain in the butt - nothing like the clean structure of Delphi, and no clean run time on hand. VB.net is so much cleaner, and really, if you use it as a glue for the program as you should do with Prism, it is easier to read and just as fast. Same goes for C# if you like something that looks similar to C.
In everything .Net - the key is the run time, and learning it. The run times are just better supported, and better understood, by the developers of the VS products.
With classic Delphi - it's the run time. Sure, not everyone likes the TObject tree, but it is more handily constructed to do just about any real world programming task in short order than nearly any other run time library. .Net is clunky, not at your fingertips, but the classic VCL is just a dream to work with. Couple that with the ability to take concepts from advanced computer scientists and translate quickly into Pascal - you have a dream environment for lean, clean and mean code. And you don't need hundreds of megabytes to have run time support for your Delphi app.
But in Prism, you're 99% MS .Net, some untidy glue, a sprinkle of messy syntax, and an envornment that is a "me too" tack-on.
Prsim. What's the point in it? Why not just use C#, VB.Net or whatever. It's definitely NOT Delphi, and it doesn't feel warm and cozy to me as a Delphi.
What did surprise me is that the environment still runs about the same with Prism (it didn't ruin VS 2008). Also, Delphi 2009, while unicode, is at least faster in its IDE on a fast machine than Delphi 2007 (a surprise).
For all the effort of Prism, they could have brought an innovative 64 bit compiler. Then, while porting to Unicode, we could also have ported to 64 bit. Then, Delphi could be a fast, lean and clean 64 bit tool for server processes and large image processing applications as well as complex business rule evaluation engines and perhaps some decision support software. For me, 64 bit Delphi, and possibly direct native OSX support would be real winners, and Prism should be ditched - I cannot find any reason to use it. Right now, it is just a big turd sitting there, an answer that doesn't seem to have a problem.
If Delphi Prism had existed 5 years ago I would be using it right now (and loving it).
But as Borland being a train wreck, I used C# for .NET development, and now I have kind of grown to like C# more than Delphi.
Perhaps I'll use Delphi Prism to speed up migration of Delphi Win32 code to .NET.
Yes.
As enthusiastic as I was about Delphi for .Net, it still lagged behind the .Net framework. Prism resolves this for the current and future framework versions, including full designer support (except cf, which I don't use). Since I prefer the Pascal language, this gives me the opportunity to use it anywhere I currently use C#.
I don't mind that Prism uses the Visual Studio IDE. This means less time spent duplicating designers that are tied to VS and more time to concentrate on language features.
I'm not happy about the loss of VCL.Net, but I suspect the upside will more than make up for it.
I don't know how much I'll use the Mono support to target Linux and the Mac (and iPhone?), but I certainly like having the option.
Just my thoughts.
Not without VCL.NET support.
Delphi inside Visual Studio? That at least sounds interesting for me as a .net Guy.
For me, the one thing that will matter: Will it keep up? It's now having .net 3.5 Features, but will they manage to keep track with new .net Features, or will they fall again behind several years.
On the other hand:
Pricing will be announced in November when we begin accepting preorders.
If it is as ridiculously priced as recent Delphi Versions, I'll pass.
I am currently a Delphi w32 developer. Although I think it is very brave to create a language that can be used both on native and .NET, I think there are better optons for .NET programming.
At our company we already have C# developers on board, and they have no interest in switching to an obscure third party language.
Management and auditors are worried about the future of Delphi, right or wrong as they may be, but it is a fact that they are worried and would like to eliminate that perceived risk by moving away from everything that has Delphi in its name. I won't even try to sell Prism for .NET development because it's a religious battle against higher powers.
The only part of Prism that I might use is the DataSnap interop for integrating our massive native Delphi codebase with our new .NET development, but for that I would use C# on the .NET side if at all possible.
Yes, most likely. As a Delphi Win32 developer, Prism gives me a nice gateway into the .NET world, and w/RemObjects Hydra, I can pull the two together into a single app as needed. Will let me leverage the best of both worlds.
As some people have pointed out in their comments, Delphi Prism is waay ahead of C#. I've been using it for well over a year now and I love it.
I was a Delphi programmer from version 1 and as time went by I watched a great product lose its edge over the years until I could stand it no longer and I bit the bullet and jumped to .NET and C#.
However, as soon as I became aware of Chrome/Oxygene/Prism I jumped back to Pascal. I think C# is a great language but if you're looking to the future and will be writing multi-threaded and multi-core apps then Prism is going to give you a big helping hand with that. Take a look at futures and the other async and parallel features to see what I mean. And that is just the tip of the ice-berg as far as features over C# go.
No, Delphi's lack of backward compatibility let to me changing over to C# & VS. Plus, finding developers to collaborate with and good information on in Delphi is hard enough without the compatibility issues.
Plus, the price of the IDE is too high.
This is pretty much DEAD OF VCL.NET :) Shame on you Borland/Codegear. Your product was very good, but price and marketing model was never as smart as microsoft one. They have FREE versions, and Full professional VS2008 comes with MSDN still cheaper than Borland Studio. You killing yourself guys.
Decided to move to C#. Being too kind to you for over a decade, developing components, applications, participating in forums and newsgroups. And at the end - what we get- big middle finger. Thanks borland...
Never Ever! I've switched to Java and C#.NET a few months ago and I'll never return to that "Still alive - and well" attitude by Borland/CodeGear/Embarcadero with no support, examples nor good IDE. I know that Prism is going to ship with VS and you'll get all the goods that come with that but hey - you get Visual C# Express for free! I personally escaped from the "being a Delphi developer" attitude a few months ago (after 10 years!) and I fell great about it!.
For me, it's all about the language. Sadly, I was FORCED to migrate into C# from Delphi.
I have never come across a more naturally objective language then Object Pascal. I will always see C, C++, C#(Visual Basic) as lacking in comparison.
Doors need to be locked, not people. .Net seems to be like having a roadblock attached to your bumper that lifts when you pay, but you carry the weight regardless, everywhere you go.
Over the years I've built up a nice library of code so that developing new stuff is really fast. Some code was even originally written in Turbo Pascal, and it's still linked into new projects flawlessly.
This is what make me faster than other people. I only have to solve new problems.
Moving to Delphi Prism would force me to start from scratch, because none of that old code will even compile. I would only rewrite stuff with the goal of having the code be used for at least 15 more years, and I think C# would be a safer bet than Delphi Prism.
Therefore, I think I'll be skipping the Prism train for now.
I don't see the .NET logic at all. Nowadays even color is an "object", alignment is an object and so on. I don't see why making it all harder to learn is an option. And then.. in all it's wisdom, M$ added linq so even data manipulation could be messed up more than ever. I thought that was why they invented stored procedures in the first place.
ASP.NET looked like something promising but even with .NET you end up coding whole pages by hand. M$ does not have the balls to build an intuitive designer for that. Drag and drop design is treated like something scarry. I'm afraid that Prism will be something like that.
.NET is not ready yet. Look at versions and the time between them. Look at what is missing. Look at the ease of reverse engineering. Think of stupid tools like obfuscation if you want to prevent yourself from giving your code away. And there is the DLL hell we wanted to avoid: every little application is 100 mb of framework, all using it's own assemblies, keeping all .NET versions next to eachother. How about the "there are no version conflicts with assemblies"? How about one party using version 1.0 of an assembly and the other using 1.1? They don't have to be in the GAC, they can be everywhere.
Delphi .NET or Prism should have come with something compatible to the VCL. That is were the strength of Delphi was. Add the TComponent.NET version and let developers re-use their custom made components. I have 10 years of Delphi code that is not portable to .NET. How stupid can one be to think that with alternatives like C# and VB.NET someone will rewrite the whole bunch in Delphi/Prism.NET and not just switch to C# in the first place?
I wonder if anybody just opened their eyes and looked under the hood of the M$ .NET crap in the first place. Maybe then someone can explain why the efford of learning a over complicated framework like .NET and getting along with all the crap and M$ stuff pushed down your throats is worth wile.
Yes. As a Windows developer, I need both Win32 and .NET capabilities.
The syntax is a lot different from the usual Delphi but very intuitive for a Delphi or Pascal programmer, makes a lot of sense than VCL.NET. Imagine the VCLs completely integrated to the .NET itself already.
My only longing: a good Delphi prism book or reference to object properties/functions/etc...I'm still trying to guess objects using a C# book/reference.
I'm a Delphi developer, since Delphi 1 (and Turbo Pascal before that).
I have always had an interest in Oxygen, but overall I'd rather just buy it from Remobjects - you can't buy at the US Embarcadero store from Brazil, and it always takes a long time for products to be available here (even though last time what I got was a package shipped from the US...), and it usually is a lot more expensive.
When I tried to buy Delphi 2009, the process involved them e-mailing a proposal (after I ordered) that I had to sign and snail mail to them.
I guess I'll see how the new RAD price will be compared to plain Delphi 2009.
The quality of Borland's/Codegear's IDE and libraries become worse and worse each year. Bugs, bugs and bugs. Kylix 1,2,3, Delphi 8, Delphi 2005, Delphi 2006 - that was total crap and almost no support, no or very small amount of bugfixes. Delphi 2007, 2009 are slightly better, but I simply tired of this. I'll try Delphi Prism but I am very sceptical about it. I've tried Visual Studio. It is fantastic no single IDE crash for two weeks.
NO,
Ruby may be on Rails, but Delphi now goes off Rails.
Good luck guys, bon voyage, here is where we finally get off!
Why would we possibly want to go through a major conversion effort to go from Delphi Win32 to Delphi Prism on dotNet.
With it now a forgone conclusion that ALL our VCL based components and custom development based on the VCL is obsolete. Embarcadero has outdone even Borland in finally destroying Delphi Pascal.
We will now start collecting a set of components that is roughly equivalent to what we had in Delphi and look for the best Delphi Pascal to C# dotNET conversion facility.
Why would we possibly want to convert from Delphi to Delphi prism without all our VCL based components ever.
At least moving directly to C# dotNet will end all this uncertainty we had to put up with the last few years.
You have lost it guys !
No. I don't see the point. It is C# with some pascallized syntax here and there.
For that bit of syntax alone, it is not worth sticking with a non-standard vendor. Delphi has its advantages, but PRISM IMHO inherits none.
I don't know if I would move from Delphi to Prism or to .NET. When I look at commercial software in the top market none of them is using .NET framework, not even Microsoft Office. My company still write software package and customized software using Delphi and Visual C++ for hi-speed, native Windows application.
Will .NET stayed for more than five years or change to something else that will be for all of us to see. Hope we don't have to throw away our existing code and re-learned new programming language.
Seriously thinking about using it for new code.
Delphi Prism 2010 is nice, the integration with Visual Studio 2008 is slick and fast and the ability to make WPF applications helps to get over some of my .net reservations regarding the occasional perceptible lack of responsiveness for more complicated UI's. Definitely a pro to be able to use the base language and syntax I am most familiar with, even if the library is completely different. Also, can still leverage a good base of programmers with .net experience (in my experience learning the capabilities of the libraries is more work than the syntax of arrays, variable assignments, etc...). It's definitely getting difficult to find local Delphi programmers that are engaged and passionate about it, while similar people with .net experience are all over the place.
On the con side of the equation: I'm still reluctant to drop native code performance and responsiveness, I'm working with a large legacy code base that I am reluctant to rewrite just for the sake of moving to .net and as a corollary to the pro about being able to find people with .net library experience, I don't have as much so there is an added learning curve there for me.
I need .Net to develop mobile application, but Delphi Prims doesn't support CF designer, same as old Delphi for .Net
Since Delphi is always catching up on .Net, I don't see any valid reason for using it, besides not being a MS product.
There is already a good language for .Net that has everything in it that delphi has and much more.
As much as I love delphi, using some logic tells me to stay away from it for .Net.
No,
I would only think about using:
Delphi Prism has a lot of work to do before I even consider thinking about it.
I think C# is the most sensible option for .Net.
BUT, as a Delphi developer, - I would still consider having it in my toolbox, and in particular, the DataSnap features.
If you want to migrate from Win32 to .NET, in my opinion, the best option is C#. But if you want to recycle your Delphi developer skils and avoid to learn a completly different language, Oxygene seems much more attractive than Delphi for .NET.
I just would consider two other things:
- The component libraries: To check if the component libraries you have, and want to use, for Delphi are available for Visual Studio.
- The visual form designer: After a decade using Delphi for Win32 and 3 years using Visual Studio for Windows Forms, I concluded Delphi has a much better visual form designer than Visual Studio, and it can affect the productivity.
You should analyse both options yourself before to choose. What is better for us, may be worst for you and your team.
Why should we? What do we get? I stick to C# for .net. But what about a delphi for iphone? Theres an env that could use some "delphing up" Just like www.morfik.com has done it for web programming. This is true to the delphi sprit.
If Delphi is the way you love developing in then you can still develop killer app with it. But their is no future for Delphi for Windows, if in future Delphi put foot in the world of cross platform RAD app world then they may gain momentum, but I don't see any effort being made toward that.. so Delphi Prism or Delphi 2009 they both going down against MS Visual Studio (unless they goes open-source and free).
Long time Delphi developer here. I won't be going to Prism.
Simply, if I have a need to develop a standalone win32 application I'll crank up Delphi, use the extensive tools at my disposal, and be done quickly with a high quality product.
Unfortunately, in the current economy my if I have a client request it will include access to the source code. (No one trusts that anyone else will be around long term) I can forget making a bid if the source is Delphi.
I'm also keeping my eyes out for a better job career opportunity. Last I checked there are zero opportunities for Delphi developers in Northern California.
Absolutely! I have been a Pascal guy in one form or another for nearly 25 years (started with Turbo Pascal 3.02a and have a copy of every release since then - am now working on converting to Delphi 2009 and Unicode). I make my living (unfortunately) writing code in C#. If the marketing folks could ever figure out how to convince the world at large that Delphi Prism isn't going away and that it is a good product (from what I have seen, it is) I would convert back in an instant. I am still going to write private projects in Prism and any of my consulting customers that will allow it will also get Prism products. It is my very strong hope that the CodeGear/RemObjects team have a very successful product in Prism so I can go back to writing code that makes sense (there are some pretty weird ideas in C# that are there just to make the old C guys happy)! My one wish above that is for someone, somewhere to write a ReSharper like gadget for Prism. In any event, Yes, I will use Prism for as long as it is available.
Looks like CodeGear is too confused about the way it should go ? The very DNA of Delphi is to produce small and fast native code.
Learning the dot net framework is a far bigger issue that learning c# syntax. If I have lo learn dot net (which I do) then I'll switc to Visual Studio (which I have).
Where's Philippe when he's needed most?
No. Too little, too late.
Please make me 64-bit native Delphi compiler with free grid-tree DB aware component, all multithreaded VCL from start, DirectX, GDI+ or whatever is fast today, terabyte dynamic memory allocation, unicoded from ground up. And yes, do it 5-7 years ago.
I am trying to avoiding going to .NET period. I write database driven apps where most of the business logic and data logic is all in the database (stored procedures etc.). .NET in general seems to provide no advantages to the developer in this case except in the esoteric sense. Put all your logic in the database all your GUI behavior in the client. Then the switch from one language to another is not as traumatic. Mostly just calls to the database and display. When Delphi 32/64 no longer exists I will be exclusively a database programmer, no more front end. I have been writing in Delphi since Delphi 2 and have never looked back. My success is because of Delphi not Oracle, not SQLServer, not .NET but DELPHI.
ABSOLUTELY NOT! It is not Pascal. It is a language mess between Pascal and C created by irresponsible to language standards people. One is the best readable section in the Pascal programs where variables are declared now is... pfuuu
begin
var I := 5; ??????????????? What the hell is that???????
end
Delphi is dead. If you are serious about writing software for .NET, then c# and Visual Studio is the only game in town. Android development is properly done with the Android SDK on Eclipse, and iPhone development is properly done with Cocoa Touch in Objective C. PERIOD. Delphi is now a product without a valid reason for existence.
As a former expert Delphi developer / Former TurboPower Senior Software Engineer and formerly head-over-heels in love with my job because of Delphi, it pains me to say these things, but say them I must.
If Embarcadero, Borland, Inprise, whatever... would just have the common decency to die gracefully, it'd be a much nicer world.
By the way, Floyd Burger isn't my real name. It is a name that a handful of former TurbPower engineers use on forums from time to time.
I have a Visual Studio 2008 solution with two projects (a Word-Template project and a VB.Net console application for testing). Both projects reference a database project which opens a connection to an MS-Access 2007 database file and have references to System.Data.OleDb. In the database project I have a function which retrieves a data table as follows
private class AdminDatabase
' stores the connection string which is set in the New() method
dim strAdminConnection as string
public sub New()
...
adminName = dlgopen.FileName
conAdminDB = New OleDbConnection
conAdminDB.ConnectionString = "Data Source='" + adminName + "';" + _
"Provider=Microsoft.ACE.OLEDB.12.0"
' store the connection string in strAdminConnection
strAdminConnection = conAdminDB.ConnectionString.ToString()
My.Settings.SetUserOverride("AdminConnectionString", strAdminConnection)
...
End Sub
' retrieves data from the database
Public Function getDataTable(ByVal sqlStatement As String) As DataTable
Dim ds As New DataSet
Dim dt As New DataTable
Dim da As New OleDbDataAdapter
Dim localCon As New OleDbConnection
localCon.ConnectionString = strAdminConnection
Using localCon
Dim command As OleDbCommand = localCon.CreateCommand()
command.CommandText = sqlStatement
localCon.Open()
da.SelectCommand = command
da.Fill(dt)
getDataTable = dt
End Using
End Function
End Class
When I call this function from my Word 2007 Template project everything works fine; no errors. But when I run it from the console application it throws the following exception
ex = {"The 'Microsoft.ACE.OLEDB.12.0' provider is not registered on the local machine."}
Both projects have the same reference and the console application did work when I first wrote it (a while ago) but now it has stopped work. I must be missing something but I don't know what. Any ideas?
I have a visual Basic program with Visual Studio 2008 that uses an access 2007 database and was recieving the same error. I'm found some threads that advised changing the advanced compile configuration to x86 found in the programs properties if your running 64 bit system. So far I haven't had any problems with my program since.
Basically, if you're on a 64-bit machine, IIS 7 is not (by default) serving 32-bit apps, which the database engine operates on. So here is exactly what you do:
1) ensure that the 2007 database engine is installed, this can be downloaded at: http://www.microsoft.com/downloads/details.aspx?FamilyID=7554F536-8C28-4598-9B72-EF94E038C891&displaylang=en
2) open IIS7 manager, and open the Application Pools area. On the right sidebar, you will see an option that says "Set application pool defaults". Click it, and a window will pop up with the options.
3) the second field down, which says 'Enable 32-bit applications' is probably set to FALSE by default. Simply click where it says 'false' to change it to 'true'.
4) Restart your app pool (you can do this by hitting RECYCLE instead of STOP then START, which will also work).
5) done, and your error message will go away.
-Matt
Are you running a 64 bit system with the database running 32 bit but the console running 64 bit? There are no MS Access drivers that run 64 bit and would report an error identical to the one your reported.
Solution:
That's it! Thanks Arjun Paudel for the link. Here's the solution as found on XNA Creator's Club Online. It's by Stephen Styrchak.
The following error suggests me to believe that you are compiling for 64bit:
The 'Microsoft .ACE.OELDB.12.0' provider is not registered on the local machine
I dont have express edition but are following steps valid in 2008 express?
http://forums.xna.com/forums/t/4377.aspx#22601
http://social.msdn.microsoft.com/Forums/en-US/vbgeneral/thread/ed374d4f-5677-41cb-bfe0-198e68810805/?prof=required
- Arjun Paudel
In VC# Express, this property is missing, but you can still create an x86 configuration if you know where to look.
It looks like a long list of steps, but once you know where these things are it's a lot easier. Anyone who only has VC# Express will probably find this useful. Once you know about Configuration Manager, it'll be much more intuitive the next time.
1.In VC# Express 2005, go to Tools -> Options. 2.In the bottom-left corner of the Options dialog, check the box that says, "Show all settings". 3.In the tree-view on the left hand side, select "Projects and Solutions". 4.In the options on the right, check the box that says, "Show advanced build configuraions." 5.Click OK. 6.Go to Build -> Configuration Manager... 7.In the Platform column next to your project, click the combobox and select "". 8.In the "New platform" setting, choose "x86". 9.Click OK. 10.Click Close. There, now you have an x86 configuration! Easy as pie! :-)
I also recommend using Configuration Manager to delete the Any CPU platform. You really don't want that if you ever have depedencies on 32-bit native DLLs (even indirect dependencies).
Stephen Styrchak | XNA Game Studio Developer http://forums.xna.com/forums/p/4377/22601.aspx#22601
I thought I'd chime in because I found this question when facing a slightly different context of the problem and thought it might help other tormented souls in the future:
I had an ASP.NET app hosted on IIS 7.0 running on Windows Server 2008 64-bit.
Since IIS is in control of the process bitness, the solution in my case was to set the Enable32bitAppOnWin64 setting to true: http://blogs.msdn.com/vijaysk/archive/2009/03/06/iis-7-tip-2-you-can-now-run-32-bit-and-64-bit-applications-on-the-same-server.aspx
It works slightly differently in IIS 6.0 (You cannot set Enable32bitAppOnWin64 at application-pool level) http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/0aafb9a0-1b1c-4a39-ac9a-994adc902485.mspx?mfr=true
check your OLEDB connection string
http://vb.net-informations.com/ado.net-dataproviders/ado.net-oledbconnection.htm
bolton.
i'm having same problem. i try to install office 2010 64bit on windows 7 64 bit and then install 2007 Office System Driver : Data Connectivity Components.
after that, visual studio 2008 can opens a connection to an MS-Access 2007 database file.
I've got the same error on a fully updated Windows Vista Family 64bit with a .NET application that I've compiled to 32 bit only - the program is installed in the programx86 folder on 64 bit machines. It fails with this error message even with 2007 access database provider installed, with/wiothout the SP2 of the same installed, IIS installed and app pool set for 32bit app support... yes I've tried every solution everywhere and still no success.
I switched my app to ACE OLE DB.12.0 because JET4.0 was failing on 64bit machines - and it's no better :-/ The most promising thread I've found was this:
http://ellisweb.net/2010/01/connecting-to-excel-and-access-files-using-net-on-a-64-bit-server/
but when you try to install the 64 bit "2010 Office System Driver Beta: Data Connectivity Components" it tells you that you can't install the 64 bit version without uninstalling all 32bit office applications... and installing the 32 bit version of 2010 Office System Driver Beta: Data Connectivity Components doesn't solve the initial problem, even with "Microsoft.ACE.OLEDB.12.0" as provider instead of "Microsoft.ACE.OLEDB.14.0" which that page (and others) recommend.
My next attempt will be to follow this post:
The issue is due to the wrong flavor of OLEDB32.DLL and OLEDB32r.DLL being registered on the server. If the 64 bit versions are registered, they need to be unregistered, and then the 32 bit versions registered instead. To fix this, unregister the versions located in %Program Files%/Common Files/System/OLE DB. Then register the versions at the same path but in the %Program Files (x86)% directory.
Has anyone else had so much trouble with both JET4.0 and OLEDB ACE providers on 64 bit machines? Has anyone found a solution if none of the others work?
I added a project to an existing solution that is currently under source control using TFS, but for some reason I cannot check in the new project. When I view my pending changes, none of the files in the new project show up. None of the files have a plus (for a new file) next to them. What did I do wrong? How do I fix it? It's time to check in.
The problem is the solution has lost it's binding. That's why it's not checking out automatically when you add the new project.
In order to restore the binding, go to File->Source Control->Change Source Control. Look for the "Solution: your solution name" and if it's not bound it will say "no server". Click on it and then click "Bind" from the toolbar.
This should create a new vssscc file that is correctly bound. Now add the new project and everything should work correctly.
Head over to Source Control Explorer and browse to the place in the tree which matches where the new project is at for your solution. Add the files there.
However, I'd be concerned that you modified the solution file and it didn't ask you to check that out. What you may want to try doing is manually checking out the solution file, then readding the project to the solution and seeing if it takes then.
You shouldn't need to drop to the command line - this is a pretty straightforward operation.
Open the solution. Select the project (make sure it is in the solution).
File -> Source Control -> Properties will bring up the binding dialog.
Bind the project to source control.
You should now see + signs next to all your files. The key is that that a .vssscc is added for your project to version control.
If that fails, open your csproj in notepad (after making a backup), and ensure any version control bindings are removed, then try again.
I was also having the same problem, this is how I fixed it:
Go to Visual Studion: File->Source Control->Change Source Control Find your project there, its status would be "Invalid", Click on it and press "Unbind". Now go back to Solution Explorer and Remove your project. Add this project again into the solution explorer solve the problem.
Good Luck!
Unfortunately, I'd wager that your best bet is to manually do the check-ins through the command line. I've ran into situations where the Team Explorer UI grows out of sync with what's actually happening in source control, and manually fixing things through tf.exe was the only way to resolve it.
That said, normally, adding a new project to a solution isn't a hassle.
TFS can simply do not know about your project existed. Just add your project files through Source Control Explorer and re-load the solution.
While loading of a solution it can ask you to bind your project to source control. Let it do so by clicking Bind button - it should do all the magic for you.
Is it possible you added the project to a location on the hard disk that is not "mapped" as part of your workspace? Double check the location of the new project
If the newly added project was previously under (another) source control, that might mess things up, make sure to "unbind" it before adding it. (See source control bindings somewhere under the "file" menu in Visual Studio)
You shouldn't need the command line.
With VS2005, I want to create a DLL and automatically export all symbols without adding __declspec(dllexport) everywhere and without hand-creating .def files. Is threre a way to do this?
It can be done...
The way we do it here is to use the /DEF option of the linker to pass a "module definition file" containing a list of our exports. I see form your question that you know about these files. However, we do not do it by hand. The list of exports itself is created by the dumpbin /LINKERMEMBER command, and manipulating the output via a simple script to the format of a module definition file.
It is a lot of work to setup, but it allows us to compile code created without dllexport declarations for Unix on Windows.
I've written a small program to parse the output of "dumpbin /linkermember" on the .lib file. I have upwards of 8,000 function references to export from one DLL.
The problem with doing it on a DLL is that you have to link the DLL without the exported definitions once to create the .lib file, then generate the .def which means you now have to relink the DLL again with the .def file to actually have the references exported.
Working with static libraries is easier. Compile all your sources into static libs, run dumbin, generate a .def with your little program, then link the libs together into a DLL now that the export names are available.
Unfortunately my company won't allow me to show you the source. The work involved is recognizing which "public symbols" in the dump output are not needed in your def file. You have to throw away a lot of those references, NULL_IMPORT_DESCRIPTOR, NULL_THUNK_DATA, __imp*, etc.
No, you will need a macro that resolves to double-underscore-declspec(dllexport) when it's included by the .cpp file that implements the exported functions, and resolves to double-underscore-declspec(dllimport) otherwise. (Markdown formatting was having problems with __declspec.)
I have always found this to be a very useful feature in Visual Studio. For those who don't know about it, it allows you to edit code while you are debugging a running process, re-compile the code while the binary is still running and continue using the application seamlessly with the new code, without the need to restart it.
How is this feature implemented? If the code I am modifying is in a DLL loaded by the application, does the application simply unload the DLL and reload it again? This would seem to me like it would be prone to instability issues, so I assume it would be smarter than this. Any ideas?
My understanding is that when the app is compiled with support for Edit and Continue enabled, the compiler leaves extra room around the functions in the binary image to allow for adding additional code. Then the debugger can compile a new version of the function, replace the existing version (using the padding space as necessary), fix up the stack, set the instruction pointer, and keep going. That way you don't have to fix up any jump pointers, as long as you have enough padding.
Note that Edit and Continue doesn't usually work on code in libs/dlls, only with the main executable code.
My guess is that it recompiles the app (and for small changes this wouldn't mean very much would have to be recompiled). Then since Microsoft makes both the compiler and debugger they can make guarantees about how memory and the like are laid out. So, they can use the debugging API to re-write the code segments with the new ones as long as the changes are small enough.
If the changes redirect to entirely new code, this can obviously be loaded into memory in a similar style as DLLs.
Microsoft also has a mechanism for "hot-patching". Functions have a 2 byte no-op instruction usually something like "mov edx, edx" before any real code. This allows them to redirect the execution of a function cleanly. This may be an option as well.
The key thing to remember is that the application isn't "running", all it's threads are in the stopped state. So as far as the process is concerned any modifications the debugger makes are entirely atomic.
Of course, this is all speculation ;)
My guess is all objects are aligned to a 4096 byte memory boundary. So if you make small changes to some code then the objects will still be within those boundaries and therefore run as before.
I've had instances where changing a couple of lines will cause a full recompile and link and others where a fairly substantial refactoring of a function will e&c just fine.
I have finally finished my web site. I published it, and I was surprised at the results. Although the App_Code compiled into a single DLL file, every page's code behind compiled into its own DLL file. How do I make it so that it is one DLL file?
Also, is it possible to compile everything (SubSonic, AJAX, etc.) into that same single DLL file?
You might prefer to use the web application project style for that.
You can use ILMerge to merge assemblies into one.
The way we do it is by adding a deployment project to our site:
To accomplish this you will have to covert your project into a Web Application Project (Supported in Visual Studio 2005 SP1 and Visual Studio 2008).
The process of converting is not that hard, but you will need to move everything out of the app_code folder, as WAP projects to not have code inside app_code.
Once you do this, everything inside your project is compiled into a single DLL file, any external assemblies are still contained in their own DLL files though, but there are options around that as well.
We use build scripts for our websites and run the aspnet_merge.exe from the command line. Here's the MSDN page: http://msdn.microsoft.com/en-us/library/bb397866.aspx
Mylyn is a task oriented plugin that allows for example to assign a set of files to a task. Is there a Mylyn type plugin for Visual Studio?
Tasktop has just announced that it is bringing the productivity of Mylyn into Visual Studio! The beta version that is being released will support bringing tasks from HP ALM, Quality Center, and Bugzilla. It includes Mylyn's Task List and Task Editor. The next level of support, which will include compatibility with all existing Mylyn connectors, will be delivered after this beta. Further down the road Tasktop will also be delivering context capture and focus within the Visual Studio IDE.
The beta release will be happening end of November 2010.
See the recent blog post for more details.
David Shepherd, Tasktop Technologies
http://www.twitter.com/davidcshepherd
The closest I've found is Tasktop, by the people that created Mylyn, but it's a standalone application that doesn't integrate with Visual Studio.
(Resharper is irrelevant).
Not even close to mylyn, but here is an open source addin for visual studio that helps to assign a list of source files to a "session" (you could think of the session as a "task")
i'm not aware of anything open source but i do know that team system is setup to support this type of workflow.
resharper might also have features you are looking for but, again, not foss
I asked that question to the VS.NET Development team in Teched 2008.
She said that they've notice about Mylyn, but are still looking on it. Task focusing plugin is not yet ready in VS.NET environment.
You may be interested in this news from Tasktop: http://tasktop.com/blog/tasktop/eclipse-mylyn-microsoft-visual-studio
I'll second tasktop. The newest version especially looks nice. Like orip said, it doesn't provide VS integration, but there's a Firefox extension which should be pretty nice... beats using Eclipse purely for Mylyn.
How hard would it be to use GCC instead of VC++ from within Visual Studio 2008? Obviously, some of the keywords won't match, and some may not get syntax highlighting (unless you made a new language service).
Is this what a 'makefile project' is for, pretty much?
I believe this has been asked before on SO, but I can't find the question right now.
There is no GCC plugin for Visual Studio as the one for example for Intel C++, which allows Intel's compiler to be used as a drop-in replacement for Visual C++.
You can use Makefile projects which allows you to use any external tool you like (make, SCons, jam, whatever) to do your build. If you don't like Makefiles, you may want to look at CMake which allows you to generate Makefiles or Visual Studio projects from a much simpler description. This also means that you're not bound to Makefiles or Visual Studio projects, but can switch between them as you like.
The thread is pretty old. But just in case someone read this thread in future.
see here for similar discussion.
We're looking at upgrading from Visual Studio 2005 to Visual Studio 2008. I discovered the following disturbing comment:
http://msdn.microsoft.com/en-us/library/6sehtctf.aspx
"Beginning with Visual C++ 2008, Visual C++ does not support targeting Windows 95, Windows 98, Windows ME, or Windows NT."
Does this mean that if we rebuild our products with visual C++ 2008, they will stop working on Windows 98 machines? It sounds like it, but I have trouble believing they'd make that big a change.
Thanks for your help.
It's not just about .NET 3.5. It's about the Windows SDK header file macros and definitions pulled in by the mandatory version bump in WINVER. So yes, Colen, Visual C++ 2008 binaries will target the Windows NT APIs only and while occasionally they may work on 98 you should assume that you cannot use Visual Studio 2008 to target Win9x. You will have to use VS2005 or older.
It's natural that they do not support older versions of their operating system on their newer products. It would cost them more (not just monetary cost, but also making harder or impossible to provide some newer useful features) to make things work with the limitations (and often bugs) of older systems. This happens all the time, and with everyone; new versions of gcc drop support for older less popular architectures; new releases of glibc require a more recent minimum kernel version; and so on.
These operating systems have long been retired; from Microsoft's point of view, nobody should be using them anymore. If you still want to develop for them, you can use older tools of the same vintage.
Yes it does mean that: The windows CreateProcess and LoadLibrary APIs on Windows NT before 2000 and all of Windows (95,98 AND ME) will not load a DLL or EXE file made by VS9 because the PE header in the file has the required OS version field set to 5.
The error message upon attempting to load a VS9 generated exe file will (be a very unfriendly modal error dialog) actually say "You need to upgrade your operating system to run this program".
I experimented with editing the field to 4 - the binary will be loaded, but any use of the VS9 c-runtime will hang or crash the process. There are ways to get VS9 projects to not use their native c-runtimes but if massive use of c++ features is important to you this approach is not going to scale past a small application.
VS8 / VS2005 has most of the features of VS9 but still targets early OS versions which is why at my shop we are sticking with that for the moment.
according to the following link, windows 98 is not supported by .NET 3.5 so I would imagine that is what they mean. You can still do .NET 2.0 and lower development, but if you use the 3.5 libraries, Windows 98 is not supported.
.NET 3.5 information
The 3.5 Framework won't even install on Windows 2000 Server at this point. So I don't believe that they will on 95, 98, or NT either. Microsoft doesn't want the responsibility of supporting these retired operating systems anymore.
I'd recommend that you take this as a opportunity to stop supporting Windows 9x. This is a good reason as any to do so. And, at least if you're writing C/C++ code for the Win32 API, life is much easier if you can assume that the target OS is Windows 2000 or later.
While I agree with JesperE, Windows 98 is such a small percentage of users that it makes little sense to target them, unless of course you know a large percentage of your customers are in fact using Windows98.
In any case, you can in fact target Windows 98 in Visual Studio 2008 (you can't develop on Windows 98). You must, however, target your projects at .NET 2.0 only, you cannot use any 3.0, or 3.5 features.
With the recent announcement of .NET 4.0 and Visual Studio 2010, it is becoming ever more difficult to keep track of what .NET Framework versions build on what version of the CLR and belong with which version(s) of Visual Studio.
Is there a definative table that shows these relationships?
Expanding on this a bit, and including some of the information from dok1's answer, the actual version numbers for the different shipped builds of the .NET Framework are available on Aaron Stebner's blog, which covers everything from 1.0 through 3.5 SP1.
The actual Visual Studio version numbers are:
Please help fill in the missing pieces. This is all I could easily find online.
Thanks to @DannySmurf for the information on the full version numbers for the CLR.
Note that while 3.0 bascially only added new assemblies (same CLR), 3.5 added new assemblies, new compiler, and updated the CLR to SP1 level.
Framework 4.0 will be a whole new CLR (4.0, no CLR 3.x) which will run side-by-side with CLRs 1.1 and 2.0. It will also have all-new assemblies versioned 4.0 instead of using the 2.0 assemblies.
(Collected from various answers and linked documents, especially this MSDN article linked by DOK) A full list with KB update versions and support retirement dates can be found in Wikipedia.
It's hard to find, isn't it? I believe these are the versions (ignoring service packs)
Visual Studio ver 6 = last one before .Net, released in '98
Visual Studio 2002 = ver 7.1, Rainier, 1st .Net ver. retroactively added 2002 to the name, .Net 1.0 -- released Feb02
Visual Studio 2003 = ver 7, Everett, .Net 1.1 -- released early 2003.
Visual Studio 2005 = ver 8 Whidbey, .Net 2.0 & 3.0 -- launch was Nov 2005. No longer called Visual Studio .Net
Visual Studio 2008 = ver 9 Orcas, .Net 3.5 -- released 11/19/2007 as 9.0.21022.8
Visual Studio 2010 = ver 10 Hawaii
next ver. of Visual Studio Team System = Rosario
This will give you more information about build numbers and service packs, but only through .Net 2.0.
It should be noted that VS2008 added the ability to target specific frameworks that build upon the .NET 2.0 runtime (i.e. 2.0, 3.0 and 3.5). Previously it would target the highest version framework supported.
Addendum to the previous posts:
Not hard to figure out which CLR version (as opposed to .NET version) goes where:
1.0/VS2002 uses 1.0.3705
1.1/VS2003 uses 1.1.4322
2.0/VS2005 uses 2.0.50727
3.0/VS2005 uses 2.0.50727
3.5/VS2008 uses 2.0.50727
Framework 4.0 RTM
Visual Studio 2010
Assembly Version 4.0.30319
Date 4/12/2010
I have a header file like this:
#ifndef __GEN_NOTE_MARKERS_TO_DEVELOPERS_HPP__
#define __GEN_NOTE_MARKERS_TO_DEVELOPERS_HPP__
#ifdef _DEBUG
// macros for turning a number into a string
#define STRING2(x) #x
#define STRING(x) STRING2(x)
#ifdef TRIAGE_MESG_AS_WARNING
#define TRIAGE_TODO_TAG(description) __pragma(message(__FILE__"("STRING(__LINE__)") : warning : TRIAGE TO-DO: " STRING(description) ))
#define TRIAGE_FIXTHIS_TAG(description) __pragma(message(__FILE__"("STRING(__LINE__)") : warning : TRIAGE FIXTHIS: " STRING(description) ))
#else
#define TRIAGE_TODO_TAG(description) __pragma(message(__FILE__"("STRING(__LINE__)") : message : TRIAGE TO-DO: " STRING(description) ))
#define TRIAGE_FIXTHIS_TAG(description) __pragma(message(__FILE__"("STRING(__LINE__)") : message : TRIAGE FIXTHIS: " STRING(description) ))
#endif
#else
#define TRIAGE_TODO_TAG(description)
#define TRIAGE_FIXTHIS_TAG(description)
#endif
#endif // __GEN_NOTE_MARKERS_TO_DEVELOPERS_HPP__
Which outputs notes to the output pane in Visual Studio 2005. When 'TRIAGE_MESG_AS_WARNING' is defined, Visual Studio will harvest these messages and list them as warnings in the Error List. It does this because the text format matches a warning. However, I don't want them to show up as warnings all the time, I would rather they show up in the Messages pane of the Error List.
What do I need to do to get the output to show up in the Messages pane of the Error List? The format I have setup for messages in the above code looks like a message from other output, but does not get harvested in the same way.
Thanks.
UPDATE: A co-worker suggested to me that I might need to write a 'custom automation object' to write to the Messages pane. That seems like a pain, especially since it is trivial to end-up with entries in the Error pane and Warning pane simply by proper formating. Is this a possible avenue?
Okay I've had a hunt around and it looks as if you can do this if you have the Visual Studio SDK installed.
I found this link here
You'll need to be using the Microsoft.VisualStudio.Shell namespace I believe.
Snippets of code from the above link are as follows:
//Get the "Error List Window"
ErrorListProvider errorProvider = new ErrorListProvider(this);
Task newError = new Task();
newError.ErrorCategory = TaskErrorCategory.Error; // or TaskErrorCategory.Warning for warnings
newError.Category = TaskCategory.BuildCompile;
newError.Text = "Some Error Text";
errorProvider.Tasks.Add(newError);
I haven't tried this yet, so if you're successful could you post back here for future reference please.
I believe they just forgot about adding additional category: info. At least it is not specified in output format for external tools.
Citation: "Category must be either 'error' or 'warning'. Case does not matter. Like origin, category must not be localized."
I'm not sure how to do what you're asking, but I found this website that tells how to solve a similar problem.
Visual Studio Web Applications?Error List and Task List
Sorry if this doesn't help you any.
MSDN says there is a straight forward answer, and gives it here:
Sadly, it doesn't appear to work - in any version of Visual Studio.
I don't have an answer, just thought I'd share the nuggets I've found on my search for the answer to the same question.
-Jesse Chisholm
Just a follow up. Still not an answer.
I just learned that in VS 2008 at least, there is BOTH an "Error List" and a "Task List".
Over in the Task List, in the section called "Comments" were all those promised // TODO messages MS was talking about.
Sigh.
I still don't know what tag to put in file(line): tag: message to get it to show up in the "Error List" in the "Messages" category.
-Jesse Chisholm
I have used the call to OutputDebugString(...), which will print a given string to the output window.
I've attempted to get this to work as well, and as far as i can tell, its impossible unless you actually write your own plug-in for VS that parses output and generates tasks. This would be a really handy feature to have, and i just hope they add it at some point in the future (can't be bothered writing a plug-in myself, too many other little projects going on to spare the time :L)
In the end, i've just opted to output it as a warning, which isn't too bad, seeing how i try to fix all warnings (or if they are intentional, turn the warning off for that little bit of code and comment if its not obvious why the warning is being ignored)
Have you tried customizing the Task List keywords?
This page suggests it's possible to do so. I suggest you read on from there, in case you haven't already.
Followup (still not an answer):
For all you very helpful people who don't seem to understand the question. I'll try restating it, with code examples.
How do you format lines you put in the "Output Window" so that Visual Studio will auto-magically show them in the "Messages" tab of the "Error List" window?
We are looking for an unmanaged C++ way to do this. We do not want to extend VS with hooks.
We know that this works:
// to put an entry in the "Errors" tab of the "Error List" window.
CString msg;
msg.Format(_T("%hs(%d): error: entry in the Error tab of the Error List window.\n"),
__FILE__, __LINE__);
OutputDebugString(msg);
// to put an entry in the "Warnings" tab of the "Error List" window.
msg.Format(_T("%hs(%d): warning: entry in the Warning tab of the Error List window.\n"),
__FILE__, __LINE__);
OutputDebugString(msg);
// TODO: to put an entry to in the "Task List" window, in the TODO category.
// But we don't know the format that puts it in the "Messages" tab of the "Error List"
// none of these three "tags" seem to work.
// What does?
//
char* tags[]= {"info","message","note"};
for(int i=0; i<3; ++i)
msg.Format(_T("%hs(%d): %hs: entry in the Messages tab of the Error List window?\n"),
tags[i], __FILE__, __LINE__);
OutputDebugString(msg);
Thank you for all the continued effort in answering this convenience question.
-Jesse
I may not be understanding your question correctly but I'll give it a shot anyway.
Have you looked at the TraceSwitch implentation? You can implement different listeners and output the info to various sources like text, console, etc.
It might be what you need.
Good luck!
Could you not use "Trace" command within your code? This will just place whatever text that you tell it within the Output window. So for placing of error messages you'll need to format them first probably.
My current solution for renaming the project folder is:
Is there a better way?
To clarify Mortens solution:
Currently, no. Well, actually you can click the broken project node and in the properties pane look for the property 'Path' then click the small browse icon and select the new path.
Voila :)
There is another way doing this, using the *.sol, *csproj files.
it will be like this (relative to the *.sol file):
Project("{FAE04EC0-301F-11D3-BF4B-00C04F79EFBC}") = "Shani.Commands.Impl", "Shani.Commands.Impl\Shani.Commands.Impl.csproj", "{747CFA4B-FC83-419A-858E-5E2DE2B948EE}"
and just change the first part to the new diretory for example:
Impl\Shani.Commands.Impl\Shani.Commands.Impl.csproj
of course don't forget to move the whole project to that directory
Have fun.
In andersjanmyr's answer its easier to rename the project first.
Also, after those steps are carried out you might want to rename other references to your old project name.
In project properties, update the Assembly Name and Default Namespace. This will update the following in the project file...
<RootNamespace>SomeProjectName</RootNamespace>
<AssemblyName>SomeProjectName</AssemblyName>
...and will get rid of the error "Namespace does not correspond to file location, should be: 'SomeProjectName'"
Rename your root namespace (if you have resharper right click the Namespace and go Refactor -> Rename).
Change all occurences of your old project name in AssemblyInfo.cs
a. Close the solution and the IDE
b. In Explorer: Change the directory name to the new name.
c. In Explorer: Open the .sln file with a text editor.
c. Change the directory name to the new name and save.
d. Restart the IDE and open the solution from the File, Recent Files menu if it doesn't start automatically.
e. Click on the Project folder of the Solution Explorer and check the path property in the properties at the bottom. It will now be referencing to the new project folder.
It worked for me.
@andersjanmyr's Solution: you may press Alt+Enter to bring up the Properties Page for the unavailable project and set the "File Path" property there; since it is not available in the right-click_context-menu of the unavailable project (in VS2008).
There is no simple, one-click way of doing it. Not from within Visual Studio, anyways.
NOTE: This fix is for Visual Studio 2008, but should work here.
.sln file located in the parent folder..sln file. Click Yes..sln file has the same name as the folder. Not required, but maintains consistency.) DONE.
I just had to do this myself (using VS2010). As some folks have answered, the simplest step seems to be:
I have written a small tool that automates all these steps. Also supports subversion for now. Download it here: Visual Studio Project Renamer
If you are using the tool, please leave some feedback. I may be able to improve it alot.
Regards,
C++ guarantees that variables in compilation unit (.cpp file) are initialised in order of declaration. For number of compilation units this rule works for each one separately (I mean static variables outside of classes) , but order between them is undefined.
Where I can see some explanations about this order for gcc and MSVC (I know that relying on that is a very bad idea - it is just to understand the problems that we may have with legacy code when moving to new GCC major and different OS) ?
Thanks
As you say the order is undefined across different compilation units.
Within the same compilation unit the order is well defined: The same order as definition.
This is because this is not resolved at the language level but at the linker level. So you really need to check out the linker documentation. Though I really doubt this will help in any useful way.
For gcc: Check out ld
I have found that even changing the order of objects files being linked can change the initialization order. So it is not just your linker that you need to worry about, but how the linker is invoked by your build system. Even try to solve the problem is practically a non starter.
This is generally only a problem when initializing global that reference each other during their own initialization (so only affects objects with constructors).
There are techniques to get around the problem.
I expect the constructor order between modules is mainly a function of what order you pass the objects to the linker.
However, GCC does let you explicitly specify the ordering for global ctors:
class Thingy
{
public:
Thingy(char*p) {printf(p);}
};
Thingy a("A");
Thingy b("B");
Thingy c("C");
outputs 'ABC' as you'd expect, but
Thingy a __attribute__((init_priority(300))) ("A");
Thingy b __attribute__((init_priority(200))) ("B");
Thingy c __attribute__((init_priority(400))) ("C");
outputs 'BAC'.
In addition to Martin's comments, coming from a C background, I always think of static variables as part of the program executable, incorporated and allocated space in the data segment. Thus static variables can be thought of as being initialised as the program loads, prior to any code being executed. The exact order in which this happens can be ascertained by looking at the data segment of map file output by the linker, but for most intents and purposes the initialisation is simultaeneous.
Edit: Depending on construction order of static objects is liable to be non-portable and should probably be avoided.
How do I prevent Visual Studio 2008 from automatically creating the "Mixed Platforms" and "Any CPU" solution configurations? We have "Win32" and "x64" configurations and a developer needs to choose between them. However, as soon as anyone makes any changes to the solution VS automatically creates "Mixed Platforms" and it seems to be the default configuration. This causes a lot of issues, because it turns out some new projects are not selected in this configuration or the wrong project configuration is selected, etc. I just want to stop it doing that and manage the solution configurations myself.
We see a similar issue with Visual Studio 2005 projects that we want to build both for a Win32 configuration and for a number of distinct smart device platform/configuration combinations.
At arbitrary times, every configuration gets auto-generated for every platform, whether it's valid or not, exploding the size of each of our ~50 project files and causing a lot of work to fix the issue.
It consistently happens when we open the Configuration Manager dialog, and it sometimes (but not always) happens when changing a project setting for a configuration. In the latter case, it seems to be related to manipulating the platform and configuration drop-downs on the project setting dialog.
We filed it as a Visual Studio issue; MSFT closed it as "won't fix".
You could filer your sln files in a commit hook of your source control. So that if you check it in the sln file and possibly the project files get fixed. The open source Chromium project has such a filer implemented.
We have a similar issue with Visual Studio 2005. We use Crystal for Visual Studio 2005 and that is x86 only, but we develop on X64. We want everything in our solution to be x86 always, but every time we add a project we have to change the target from "Any CPU" to "x86". This is ridiculous.
IMHO, the solution should have a default configuration and every project that gets added to the solution should inherit that configuration if it does not already have its own configuration.
I've been dealing with the same sort of problem. I agree it is a mess. I've seen two viable options for dealing with it - neither are really what you want.
I am just getting started with Silverlight and have recently added a Silverlight project to an established solution. In this particular scenario my solution included an existing ASP.NET web site (not application) which Visual Studio kindly offered to integrated my Silverlight application into, which I accepted.
So everything is fine and all, and the Silverlight XAP is being copied to the web site's ClientBin directory. Now I have decided to start a new ASP.NET MVC web application that will eventually replace the older (non-MVC) web site. But I cannot for the life of me figure out what Visual Studio modified to get the XAP to automatically appear in the web site's ClientBin on build, so that I can reproduce that on my MVC site.
So my question is essentially, what are the manually steps for getting Visual Studio to autocopy a Silverlight application's XAP to a newly added ASP.NET MVC web application?
You can do this through the properties of your web project. The Silverlight tools for visual studio add a new tab to the properties of web projects named "Silverlight Links".
Add a reference to your Silverlight project here, with the folder where you want it, and visual studio will make the copy for you.
The copying of the XAP to the ClientBin is a MSBuild task. If you're using a standard ASP.NET project template it can be found under the Silverlight Link section.
For everything else you might be able to figure out the name of the MSBuild task and add it to your ASP.NET MVC project. The easier solution would probably be to use a custom post-build event on the APS.NET project to copy the file.
There is no "magic" happening, oter than copying the XAP file from the BIN directory of your Silverlight project to the ClientBin of your web application. It doesn't even have to live inside the ClientBin directory - you can copy it to any directory, or the root of your site.
Update: The recently released Beta 1 of ASP.NET MVC includes support for Silverlight projects, so you can link it to your ASP.NET MVC application the same way you do for regular ASP.NET applications.
Go to the property pages of your Silverlight application, Choose Build Events Tab, Enter following line in Post-Build events command line:
copy $(TargetDir)*.xap $(SolutionDir)<youar web solution folder name such as app.web>\ClientBin
Now onwards, on each successful build, the xap file will be copied automatically.
This is a somewhat older post so it probably has changed... in my Visual Studio under the web project there is a tab called "Silverlight Applications". There is an add button there for existing projects that you import into the solution and you can add them and choose to place the xap in the ClientBin or anywhere else. Not sure if you have to have the SDK installed to have this tab. I have it installed so you may have to. I don't do MVC, so it may be different for MVC projects, I don't know.
I am looking for a reporting service/tool for visual Studio. My only restraint is my web server is off limits to me as far as installing ANYTHING. So I need something I can just include in my project.
My users need to be able to export a report to PDF and without being able to use Crystal I am pretty much lost.
Any ideas?
fyireporting (released under Apache License) is worth a try.
The fyiReporting RDL Project is a powerful report and charting system based on Report Definition Language (RDL). Tabular, free form, matrix, charts are fully supported. Report output may be displayed as HTML, PDF, XML, .Net Control, Web Archive, and to a printer. Libraries exist for use in your ASP.NET, Windows .Net, and command line applications.
Try Microsoft's ReportViewer system. It to uses the Report Definition Language, but it's ready to go out of the box. It's not Open Source, but it is redistributable.
As suggested by Ant, there is also ReportingCloud which is a branch of fyiReporting
If you're willing to have no report designer and open source is an absolute requirement, then take a look at iTextSharp - version 4.0 is totally open source (5.0 you have to pay for comercial use).
I've been working for years with VS's debugger, but every now and then I come across a feature I have never noticed before, and think "Damn! How could I have missed that? It's so useful!"
[Disclaimer: These tips work in VS 2005 on a C# project, no guarantees for older incarnations of VS or other languages]
Working with multiple instances of a given class? How can you tell them apart? In pre-garbage collection programming days, it was easy to keep track of references - just look at the memory address. With .NET, you can't do that - objects can get moved around. Fortunately, the watches view lets you right-click on a watch and select 'Make Object ID'.
This appends a {1#}, {2#} etc. after the instance's value, effectively giving the instance a unique label. It looks like this:
The label is persisted for the lifetime of that object.
By default, a watched variable's value is it's type. If you want to see its fields, you have to expand it, and this could take a long time (or even timeout!) if there are many fields or they do something complicated.
However, some predefined types show more meaningful information :
Wouldn't it be nice to have that for my own types?
Hmm...
...some quality time with .NET Reflector shows how easily this can be accomplished with the DebuggerDisplay attribute on my custom type:
[System.Diagnostics.DebuggerDisplay("Employee: '{Name}'")]
public class Employee {
public string Name { get { ... } }
...
}
... re-run, and...
There's a lot more info on the subject here: MSDN
... even the ones that are handled in code! I know, I'm such a n00b for not knowing about this ever since I was born, but here it goes anyway - maybe this will help someone someday:
You can force a debugged process to break into debug mode each time an exception is thrown. Ever went on a bug hunt for hours only to come across a piece of code like this?
try {
runStrangeContraption();
} catch(Exception ex) {
/* TODO: Will handle this error later */
}
Catching all exceptions is really handy in these cases. This can be enabled from Debug > Exceptions... (Ctrl-Alt-E). Tick the boxes in the 'Thrown' column for each type of exception you need.
Those were a few forehead-slapping moments for me. Would you care to share yours?
Here's another neat trick I learned:
System.Diagnostics.Debugger.Break()
programatically causes the debugger to break on the next instruction. The really nice part is, this also works for a program compiled in Release mode, without debugging information.
try {
// do something big
}
catch {
// breakpoint set here:
throw CantHappenException("something horrible happened that should never happen.");
}
How do you see the exception that was originally thrown? In a watch window, enter $exception
I always make sure to set the "Name" property on new threads that I create. That way, when I'm debugging I can more easily identify different threads.
Of course, check out the VS tip of the day:
A few from me
Two in-code tricks:
I really like the System.Diagnostics.DebuggerStepThrough attribute; you can attach it to a class, method or property to make VS not enter the code by default when debugging. I prefer it over the DebuggerHidden attribute as it will still allow you to put breakpoints in the ignored code if you really need to debug it.
Another (sometimes) useful call is System.Diagnostics.Debugger.Launch(); when the execution hits it, you will be presented with the "select a debugger" dialog, and a debugger will start. A bit rude, but useful with particularly nasty to attach to processes, like a process that gets spawned by another and immediately executes your code.
.load sos in the Immediate window :)
Tools -> Attach To Process - easy to forget, but with it I can debug script in web pages, managed code loaded up in another process (think an add-in model), or even unmanaged code. Be careful with letting it automatically pick the type of debugging you're interested in.
Tracepoints (and other breakpoint features... right click on the breakpoint and have fun)! - http://blogs.msdn.com/saraford/archive/2008/06/13/did-you-know-you-can-use-tracepoints-to-log-printf-or-console-writeline-info-without-editing-your-code-237.aspx
The immediate window is awesome.
Remote Debugging is very useful if you deploy apps (and can get to the machine where the problem can be reproduced).
There are tons more. Try getting into WinDbg and SoS!
I found the Modules window useful a lot of times. It tells whether the debugger has loaded a required dll and which version of the dll is loaded. It also lets you manually load or unload a dll.
Conditional breaks are very useful if you have code that is repeated a lot but only fails under a specific set of conditions, such as code in a loop, methods called from a loop, or methods called from multiple threads. Put the break statement at the line of interest and set its conditions to match the error case. (There is a quick example here.)
Two from me: one that I hope everyone uses all over the place:
Debug.Assert(<condition>, <message>)
the second DebuggerHidden:
<DebuggerHidden()> _
Public Sub ReadDocumentProperty(ByVal propertyName As String, ByRef PropVal As Integer, ByVal DefaultVal As Integer)
Try
Dim prop As Office.DocumentProperty
prop = CustomProps.Item(propertyName)
PropVal = CType(prop.Value, Integer)
Catch
PropVal = DefaultVal
End Try
End Sub
Even if you have Debug, Exceptions, Break on thrown exceptions set, exceptions in here will not be caught.
Create a Macro for attaching to a process and assign to an unused keyboard shortcut. Much faster than going: debug -> attach to process -> search for the process in the processes list ->...
How about setting the IDE to break into exceptions when they occur, even when we don't have any debug point set.
Debug--> Exceptions-->Commmon Language Runtime Exceptions-->Thrown
This makes finding hidden exception handling problems a breeze. Actually this is kind of a setting every developer should have set through out the development, to avoid any unhanded or even handled exceptions that are going underneath.
In unmanaged code you can set "data breakpoints". They user the debug registers of the CPU to issue an INT3 and the debugger stops on that instruction with no overhead during run time (in older version the debugger stepped through the program checking the memory..... slow!)
This is useful if you have some corruption at a knwon address (stack / heap vaiable getting clobbered).
Also AutoExp.dat in ide\packages\debugger can be customized to show your data structures.
pointer, mb shows a hex dump in the watch window http://msdn.microsoft.com/en-us/magazine/dd252945.aspx
Yum!
Does anybody have a keybinding scheme similar to VS 2005 available for Eclipse?
How to import it into preferences of Eclipse (I see only export button).
To get the Visual Studio key bindings in Eclipse you need to install the C++ development plugins - see this.
I downloaded the latest Java development version of Eclipse (version below), when to Help -> Software Updates -> Available Software -> Ganymede and ticked the C++ box. After a restart the Visual Studio key binding appeared in the list.
Eclipse Platform
Version: 3.4.1
Build id: M20080911-1700
I think the latest Eclipse ships with Visual Studio bindings but at least the Eclipse PDT doesn't (which I just installed). And I would prefer to not have lots of extra plug-ins in Eclipse to keep it more "slim", so I didn't add the C++ plug-in. (maybe it doesn't affect performance but I really need only the keys...)
So anyway, I added the keys which I needed. As previous posters noted, when you "Export" in the key customization there is no way to import them, so the separate File->Export/Import functionality is the way to go.
So, as summary:
Try add to Eclipse C++ plugin and see if it ships with key bindings that work for you
Use mine key bindings, key list and download here install: unzip, use File->Import->General... to get it to Eclipse
It's far from complete of course (it's only keys which I missed to get started...), but better than nothing anyway.
Update (2009-10-16): Added Ctrl + G (go-to-line) to the bindings.
I don't have a VS2005 keybinding scheme as I personally prefer a Brief-style scheme.
However, to import "it", as far as I know (at least on Eclipse 3.4 Ganymede) use File -> Import -> General -> Preferences where "it" is a .prf file which has been saved out using File -> Export -> General -> Preferences.
Eclipse Ganymede has a built-in keybinding scheme for Visual Studio. Have you tried that?
This may help you making-eclipse-behave-like-visual-studio
Every time you start Visual Studio, the first time you click "Add Reference" to add a DLL reference to a project, by default, the .NET tab on that dialog box is selected. As most people reading this have probably noticed, it can take a long time -- often more than 30 seconds -- for the full list of .NET components to fill in.
Because of the way we're designing our solutions, though, about 80% of the time, I want to select either from the "Projects" tab or from the "Browse" tab.
Is there a setting anywhere in Visual Studio that will let me make "Projects" be the first tab that loads up? Does anyone know any other, hidden tricks to accomplish the same effect?
I use this tip to do this in a different way. Open your Object Browser (Cntrl + Alt + J). Change Browse dropdown to "My Solution". Select the project you want. On Toolbar, click "Add to References in Selected Project in Solution Explorer".
A neat work around which has saved me many hours.
I have never found anywhere that allows you to change the default tab. And yeah, it's annoying how long that window can take to load. I think this is something that we just have to live with.
If you have the PowerCommands for Visual Studio 2008 installed, there is functionality to copy-paste references between projects, as well as copy-paste individual projects as references, all without opening the references dialog.
Tuna Toksoz has created a Fast Add Reference dialog plugin for Visual Studio.
Another tip you might consider is that if you reference a type in another project, ReSharper will notice it and offer to add it to your references for you.
With this, I never visit that tab unless I have file dll references to add.
I am afraid the answer, as far as I can tell, is no. I even took a trip through the registry to determine if there was someway to reorder the tabs. You might be able to do it with a hex editor but I would advise against that.
I have a collection of boost unit tests I want to run as a console application.
When I'm working on the project and I run the tests I would like to be able to debug the tests and I would like to have the console stay open after the tests run.
I see that if I run in release mode the console window stays up after the program exits, but in debug mode this is not the case.
I do not want to add 'system("pause");' or any other hacks like reading a character to my program. I just want to make Visual Studio pause after running the tests with debugging like it would if I were running in release mode. I would also like it if the output of tests were captured in one of Visual Studio's output windows but that also seems to be harder than it should be.
How can I do this?
Thanks!
Try to run the app with the Ctrl+F5 combination.
boost test offers the following usage recommendations for visual studio that would enable you to run the unit tests automatically at the end of compilation and capture the output into the build window.
the nice side effect of this trick is it enable you to treat test failures as compilation errors. "...you could jump through these errors using usual keyboard shortcuts/mouse clicks you use for compilation error analysis..."
Set a breakpoint on the last line of code.
Why not use the system("pause") hack?
If it's because you don't want the program to prompt when it's not being debugged, there's a way around that. This works for me:
void pause () {
system ("pause");
}
int main (int argc, char ** argv) {
// If "launched", then don't let the console close at the end until the
// user has seen the report.
// (See the MSDN ConGUI sample code)
//
do {
HANDLE hConsoleOutput = ::GetStdHandle (STD_OUTPUT_HANDLE);
if (INVALID_HANDLE_VALUE == hConsoleOutput) break;
CONSOLE_SCREEN_BUFFER_INFO csbi;
if (0 == ::GetConsoleScreenBufferInfo (hConsoleOutput, &csbi)) break;
if (0 != csbi.dwCursorPosition.X) break;
if (0 != csbi.dwCursorPosition.Y) break;
if (csbi.dwSize.X <= 0) break;
if (csbi.dwSize.Y <= 0) break;
atexit (pause);
} while (0);
I just paste this code into each new console app I'm writing. If the program is being run from a command window, the cursor position won't be <0,0> and it won't call atexit(). If it has been launched from you debugger (any debugger) the console cursor position will be <0,0> and the atexit() call will be executed.
I got the idea from a sample program that used to be in the MSDN library, but I think it's been deleted.
Edit addition: The Microsft VS implementation of the system() routine requires the COMSPEC environment variable to identify the command line interpreter. If this environment variable gets messed up -- for example, if you've got a problem in the Visual Studio project's debugging properties so that the environment variables aren't properly passed down when the program is launched -- then it will just fail silently.
If it is a Console Application, use Cntrl+F5
Just copied from http://social.msdn.microsoft.com/forums/en-US/Vsexpressvc/thread/1555ce45-8313-4669-a31e-b95b5d28c787/?prof=required:
The following works for me :-)
///////////////////////////////////////////////////////////////////////////////////// Here is another reason the console may disappear and the solution.
With the new visual studio 2010 you might see this behavior even when you use ctrl f5 aka "start without debugging". This is most likely because you created an "empty project" instead of a "Win32 console application". If you create the project as a "Win32 console application" you can disregard this as it does not apply.
In the older versions it would default to the console subsystem even if you selected "empty project", but not in 2010, so you have to set it manually. To do this select the project in the solution explorer on the right or left (probably is already selected so you don't have to worry about this). Then select "project" from the menu bar drop down menus, then select "*project_name* properties" > "configuration properties" > "linker" > "system" and set the first property, the drop down "subsystem" property to "console (/SUBSYSTEM:CONSOLE)". The console window should now stay open after execution as usual.
/////////////////////////////////////////////////////////////////////////////////////
It would actually be more effort, but you could just build in VS.Net, run it from the regular command line (cmd.exe), and then attach to the process after it starts running. This is probably not the solution you are looking for however.
What about just using a logging library, like log4net, and have it log to a file appender?
You could also setup your executable as an external tool, and mark the tool for Use output window. That way the output of the tool will be visible within Visual Studio itself, not a separate window.
I start the app with F11 and get a breakpoint somewhere in unit_test_main.ipp (can be assembly code). I use shift-f11 (Step out) to run the unit test and get the next assembly instruction in the CRT (normally in mainCRTStartup()). I use F9 to set a breakpoint at that instruction.
On the next invocation, I can start the app with F5 and the app will break after running the tests, therefore giving me a chance to peek at the console window
take a input at the last of program........
I would use a "wait"-command in a specific time (milliseconds) of your own choice. Application executes until the line you want to inspect, and then continues after the time expired.
Include the header
clock_t wait;
wait = clock(); while (clock() <= (wait + 5000)); // Wait for 5 seconds and then continue wait=0;
In Boost.Test there is --auto_start_dbg parameter for breaking into debugger when test fails (on exception or on assertion failure). For some reason it doesn't work for me.
For this reason i have create my custom test_observer that will break into the debugger when there is an assertion failure or an exception. This is enabled on debug builds when we are running under a debugger.
In one of the source files of my unit test exe I have added this code:
#ifdef _DEBUG
#include <boost/test/framework.hpp>
#include <boost/test/test_observer.hpp>
struct BoostUnitTestCrtBreakpointInDebug: boost::unit_test::test_observer
{
BoostUnitTestCrtBreakpointInDebug()
{
boost::unit_test::framework::register_observer(*this);
}
virtual ~BoostUnitTestCrtBreakpointInDebug()
{
boost::unit_test::framework::deregister_observer(*this);
}
virtual void assertion_result( bool passed /* passed */ )
{
if (!passed)
BreakIfInDebugger();
}
virtual void exception_caught( boost::execution_exception const& )
{
BreakIfInDebugger();
}
void BreakIfInDebugger()
{
if (IsDebuggerPresent())
{
/**
* Hello, I know you are here staring at the debugger :)
*
* If you got here then there is exception in your unit test code.
* Walk the call stack to find the actual cause.
*/
_CrtDbgBreak();
}
}
};
BOOST_GLOBAL_FIXTURE(BoostUnitTestCrtBreakpointInDebug);
#endif
Or you could use boost_test "Test Log Output."
http://www.boost.org/doc/libs/1_47_0/libs/test/doc/html/utf/user-guide/test-output/test-log.html
Then it won't matter whether the console window shows up at all AND your build logging can preserve the unit testing output as an artifact for examination on failed builds...
Do a readline at the end, (Its the "forma cochina", like we say in Colombia, but it works)
static void Main(string[] args)
{
.
.
.
String temp = Console.ReadLine();
}
How can I get Emacs style key bindings in Visual Studio? Is it available in Settings? Do I need a Plug-in?
You can try the Emacs keyboard scheme (Tools->Options->Environment->Keyboard)
Xkeymacs does a really good job of this. It is possible to configure this tool for every application running on your desktop.
With Settings:
Try the Emacs keyboard scheme on Environment options.
Plugins:
I have only seen this one: VisEmacs, it will integrate Emacs as the default text editor for Visual Studio.
I use VisEmacs because the emacs keyboard scheme isn't quite as nice as emacs itself.
A quick Live search for "visual studio emacs" gave this page. I'm not sure how thorough it is though (having never used emacs myself).
I used the Emacs keyboard scheme for a few days, but it quickly drove me crazy -- I couldn't rebind keys they way I was used to in Emacs (or couldn't find how to rebind quickly).
I should try XKeyMacs....
After posting that Emacs keybindings/emulation would no longer be available in Visual Studio 2010, Emacs Emulation is now available as a free extension for VS 2010.
There are so many little options and settings within Microsoft Visual Studio. Which adjustments do you recommend to others?
Line Numbers
Tools > Options
Text Editor > All Languages > General
Display: Line Numbers
Environment->General->Animate environment tools => OFF.
Speeds UI responsiveness by 82%.
I've never found dynamic help to be either dynamic or helpful, and just tends to slow visual studio down, so using regedit:
I'm also keen on setting the following in Options->Projects and Solutions:
Gotta have the tab indention set up right.
Also, Consolas & Color Themed - white backgrounds hurt my eyes
Option Strict On
Tools > Options
Projects and Solutions > VB Defaults
Default project settings: Option Strict: On
Tools -> Options -> Environment -> Keyboard
Setup a shortcut to close the active document. Ctrl+Alt+W in my case.
Personally i hate that VS defaults to "Tab to Spaces" when you are developing in C#. This is so awkward to work with and unnecessary.
Yes, i know there are issues with Tabs but honestly, did any of you ever encounter them coding in C# on Windows?
Several have mentioned custom keybindings. Here are handy default keybinding reference posters…
Microsoft Visual Basic Default Keybindings reference poster
A high quality, print-ready PDF containing the useful keybindings for developers that choose the Visual Basic developer profile in Visual Studio 2008 or use Visual Basic Express.
Microsoft Visual C# Default Keybindings reference poster
Visual C# in Visual Studio 2008 and Visual C# 2008 Express Edition Wall chart showing useful keyboard shortcuts for Visual C# programming language.
I like Microsoft's instructions:
- Download and extract PDF
- Send to favorite full color printer/copier
- Hang on wall
- Code
- Smile
Set the active document you're working on to display in the solution explorer. I've seen a lot of people hunting for their current doc if the project gets too big.
Tools -> Options. Make sure show all settings is checked.
Click on Projects and Solutions.
Enable the Track Active Item in Explorer checkbox.
Environment => General => Recent files
24 items shown in Window menu
24 items shown in recently used lists
Environment => General
Show status bar ON
Animate environment tools OFF
Window Layouts
This really isn't a setting but something I always do is back up my settings via Tools > Import and Export Settings.
I make sure to back up my window layouts for both single and multiple monitors. It saves frustration when moving from my multi-monitor setup to a single monitor for a presentation.
Not to mention, it makes it easy to get up and running on a new PC.
Fixedsys Font
Tools > Options
Environment > Fonts and Colors
Font: Fixedsys
Always show solution
Tools > Options
Projects and Solutions
Always show solution
Prevent Visual Studio from renaming pasted controls
I'm somewhat surprised to be the first person recommending Visual Studio Hacks for a lot of suggestions of this variety
Visible white space. (Edit -> Advanced -> View White Space)
The default color is too strong. I immediately change it to silver. (Tools -> Options -> Fonts and Colors -> Visible White Space).
On some displays, even silver is too strong, and I create a "light silver".
Source View
Tools > Options
HTML Designer > General
Start pages in: Source View
Check out this thread for the Color theme options for Visual Studio http://stackoverflow.com/questions/141371/which-visual-studio-color-theme
And consolas is my favourite font
This applies to winform projects.
Instead of opening the form in design mode by default, you can configure VS to open the code editor instead. This is configured by right-clicking on a form in the solution explorer and choosing the "Open with" option. This gives you a dialog that allows you to specify the default option when double-clicking on a file.
In a control's properties, setting GenerateMembers to false for items you don't need (labels, etc). It's not a specifically Visual-Studio thing, more related to the platform, but mixed with the contextual list of objects and functions, it just clears up so much clutter.
Its all about Resharper ;) Gives you tons of shortcuts which are so useful I can no longer work without them. I don't get on with the intellisense though, so I've turned that off.
This is incredibly useful, allows you to write underscores with the space bar when writing long test method names.
Un-Bold Brace Matching
Tools > Options
Environment > Fonts and Colors
Display items: Brace Matching (Hilight)
uncheck Bold
Find and Replace window?s "Search Hidden Text" checkbox.
It's not really a preference but it is indispensable. It sure is frustrating when you don?t notice that it "magically" unchecked itself.
When designing a form:
View > Tab Order
Allows you you specify and control your TabIndexes easily (much more so than setting them by hand!)
Besides, Line Numbers, the first thing I always do in a newly-installed IDE is set the Edit.GoToDefinition keyboard shortcut.
Tools > Options > Keyboard
Is there any way to change the background color of the Solution Explorer in Visual Studio using a Theme? - or any other way for that matter?
I can change it by changing windows-wide color settings, but obviously that affects too much.
Just created VS extension for that in under an hour, search extension manager for "SExColor". Enjoy ;)
Not by any means of configuration from Visual Studio itself.
You can however probably "hack" the window object from the Win32 API (look up "window enumeration"). Once you have the window handle, you can set all characterstics you want.
Regards
/Robert
Even changing the standard Windows background color does not work for the Solution Explorer. This Visual Studio bug report mentions the issue. Microsoft has marked this as "Closed -- Won't Fix."
Which is very irritating! Using a dark theme and having a bright white Solution Explorer hanging on the side of the screen is extremely annoying.
One possible solution is to not use the Solution Explorer at all. The Productivity Power Tools provides a Solution Explorer replacement called the "Solution Navigator." It currently is also hard-coded to white. But I think there is probably a better chance of getting the developers of that tool to add support for modifying colors than of getting Microsoft to do it in Visual Studio. (even though Microsoft created the PPTs.)
I couldn't manage to change the Solution Explorer's background color.
However, I found a workaround: I set Solution Explorer's AutoHide property (unpin it) - Explorer hides when I switch to code editor and when I need it again I just bring it up with a hotkey CTRL+ALT+L. This solution also creates a bigger space for your code on the screen.
This works fine, especially, if you're using tools like Resharper a lot.
Regards Mike
Changing Visual Studio?s Color Palette
This what you are looking for? VS2010 only though.
Tried in VS 2005.
Tools > options > Fonts & colors
Select "plain text" in "display items" textarea
Click the "custom" button at the right-side of the drop-down "item background"
Select a shade of gray as per your choice. I selected (R/G/B) = (153/33/219)
Click OK. Click OK again.
Done!!!!!
I am using Team Foundation Server (TFS) for Visual Studio 2005.
Whenever i wish to compare two file's versions TFS displays a window with the differences.
The problem is that it is always splitted vertically.
In fact, almost every time, i would prefer to have it splitted horizontally. I've already looked at TFS options and googled but i found nothing. I'm appalled to think that such option is not available!
Is there any way to configure TFS to split it horizontally?
Thank you, LuÃs
I've found the built in differencing tool in TFS woefully lacking so I set up WinMerge (http://www.winmerge.org/) in my environment in Tools -> Options -> Source COntrol -> Visual Studio Team Foundation.
A nice blog post exists below:
http://www.vitalygorn.com/blog/post/2007/12/Better-DiffMerge-tool-for-TFS.aspx
There is no ability to change the orientation of the built-in diff/merge utility. There are a lot of third-party tools (some free, some not) to choose from. Check out this post from James Manning where he tracks the correct command/argument values to use when configuring various tools for use by Team Foundation's compare and (content) merge operations.
This appears to be a more thorough description of how to use Winmerge in TFS- http://www.neovolve.com/post/2007/06/19/using-winmerge-with-tfs.aspx
We all know Visual Studio is one of the best IDEs out there but what about the free Express edition. Is it any good ? Would any of you use it for serious work ?
I have Visual Studio 2005 Standard and the Express editions of the 2008 tools at home. (I use VS2005 at work; we haven't brought 2008 into the fold just yet.)
Here's what I like about the Express Editions:
Here's what I dislike about the Express Editions:
If you can live with the (very few) limitations, and you're on a tight budget, go for it.
If it meets your needs it's a great tool.
See this question for details on what the VS Express editions do not have: http://stackoverflow.com/questions/86562/what-is-missing-in-the-visual-studio-express-editions
It has been suggested that VS Express cannot be used for commercial interest:
See Microsofts FAQ page for VS Express - specifically question #7:
'7. Can I use Express Editions for commercial use? Yes, there are no licensing restrictions for applications built using Visual Studio Express Editions.
Yeah I think the Microsoft business plan around it, and what you should probably look into doing/using, is this:
I have VB.Net Express, C++ Express, and C# Express installed on my home (and now work) and I am very pleased with them. They can do a lot of great stuff, and most of the more premium features I have not missed.
Would I use it for serious work: yes, I expect to do that until I can afford an MSDN license.
I don't use any add-ons in VS, so to me Express is just as good. I'd absolutely would use it for 'serious work'.
The C++ compiler supplied with Express is the same optomising compiler in all the other editions.
With vs2008 MS have a really quite nice and standards compliant C++ compiler. Herb Sutter must have some influence!
The problem with Visual Studio Express is that it is crippled, as long as you only want to use it with what it comes with you are ok, but you cannot extend it. To be fair though, it comes with an awful lot, so maybe.
Another option for you is SharpDevelop, it's surprisingly good and it can be extended (in fact you can download the source for it) In fact maybe the best option is have both, they can run side by side and share the same project file format.
VS Express can be extended - and has extensions available. There is even a project type for specifically building Express extensions. What this means is that anybody making a VS extension would have to make two packages: One for VS and one for VS express. Nearly everybody just makes the VS extensions - could be a Microsoft licensing issue.
The most notable VS express extension: XNA Game Studio - works with VS Express 2005, but NOT full VS 2005.
The two weaknesses of VS Express are therefore: 1. The lack of extensions (but there are some available). 2. The inability to mix languages in a single workspace, because each language uses a separate IDE.
The wall I just ran into is that it won't take 3rd party extensions.
It's as good at the "regular version" and can readily be used for "serious" work.
The main differences center around team features and enterprise features. For a developer or small team just starting out there aren't too many things you'd miss.
I've been very satisfied with VS Express, only thing that I miss from the full version at my office is the deployment package projects. No support for those in the express editions unfortunatly, but I was able to bypass that a tad with a 3rd party free deployment package builder called Install Creator.
Visual Studio Express is quite good and can be used for serious development. However, it does have certain limitations. You should really look at the comparison of all VS SKUs to determine whether Express will meet your needs.
We use express edition, but we found out (afx.h compile problem) that:
"MFC and ATL are not included with Visual C++ 2008 Express. MFC and ATL will be included in Visual Studio 2008 Standard and above editions" Se this link (question #32).
I had trouble with Visual Studio Express (C++) 2008 (with service pack 1) on Windows Vista, with debugging. Any time I did anything such as (a) break the program, (b) set focus from the app back to the IDE, (c) resume execution, the program hung for about 30 seconds. Task Manager showed "VSExpress.exe" consuming an entire CPU for the duration. Vista showed "Not responding" in the IDE's title bar during this time.
This was driving me bonkers so I bought a commercial copy of Visual Studio Professional 2008 ($150 from SoftwareSurplus) and this solved the problem.
I used VS Express as my primary development environment for about two years.
If I were using SourceSafe I'd probably have found the lack of source-control integration to be prohibitive, because if you need to check out each file before you can work on it, having to leave the IDE to do it really hurts. But I'm using Subversion and really never missed integration with the IDE.
I'd probably still be using it if I hadn't needed to use Resharper and Memory Profiler.
I use Visual Studio 2008 Express at work - absolutely brilliant as an IDE although we compile using various other tools..
I use Visual C# and C++ Express Editions. Yes, there are features missing, like plugins and MFC. But as I don't need them, I'm not planning any upgrade to full version for now.
Missing the reporting tools is a killer for me.
Missing Ghostdoc or other extensions is a disappointment for me. Guess I've gotta find some other documentation generator, as I don't want to pay for the full thing.
I miss java. Things like reference docs and customizing your IDE and stuff were much better in eclipse based environments. Unfortunately my current project requires C# and in that area VS is sadly still the best option.
I had installed resharper evaluation version and uninstalled it. After this the intellisense stopped working. I have restarted computer but still i have this problem.
Can anyone plesae help me here?
I am using Visual Studio 2005
thanks
Try opening Visual Studio Command Prompt and entering:
devenv.exe /ResetSettings
Try going to Tools > Options > Text Editor > C# and checking all of the options under Statement completion. I think Resharper disables these upon installation.
Sometimes deleting the ncb file helps. Go to your solution directory and find the sln file, there will also be a file with the same name and the extension ncb. Make sure Visual Studio is closed (at least don't have that project open) and then delete that file. Don't worry Visual Studio will rebuild it for you.
The devenv.exe /ResetSettings was the only thing that worked for me. The full path in command prompt is as follows (for VS 2008)
C:\Program Files\Microsoft Visual Studio 9.0\Common7\IDE>devenv.exe /ResetSettings
took me a while to find so I thought I'd post this to help
devenv /ResetSettings worked after uninstalling ReSharper. I did not have to do a repair. I did verify that the settings were checked under Text Editor > C#, but ResetSettings was the only thing that worked.
In javascript of you, such as:
<script src="../../jQueryUI/js/jquery-ui-1.8.14.custom.min.js" type="text/javascript"></script>
<script src="../../Scripts/jquery-1.4.1-vsdoc.js" type="text/javascript"></script>
<script src="../../Scripts/jquery-1.4.1.js" type="text/javascript"></script>
You should delete paragraph:
<script src="../../jQueryUI/js/jquery-ui-1.8.14.custom.min.js" type="text/javascript"></script>
then intellisense of you will continuing.
You could try to reset your Visual Studio setting by
Hope It can help you.
I would try a "repair" on the installation first. Control Panel, Add/Remove Programs, select Microsoft Visual Studio 2005, click "Change/Remove". It will load up the install dialog and give you the option to do a "repair".
YMMV, but at least it should reset a lot of the VS resources to their "fresh" state.
My current position is this: if I thoroughly test my ASP.NET applications using web tests (in my case via the VS.NET'08 test tools and WatiN, maybe) with code coverage and a broad spectrum of data, I should have no need to write individual unit tests, because my code will be tested in conjunction with the UI through all layers. Code coverage will ensure I'm hitting every functional piece of code (or reveal unused code) and I can provide data that will cover all reasonably expected conditions.
However, if you have a different opinion, I'd like to know:
1) What additional benefit does unit testing give that justifies the effort to include it in a project (keep in mind, I'm doing the web tests anyway, so in many cases, the unit tests would be covering code that web tests already cover).
2) Can you explain your reasons in detail with concete examples? Too often I see responses like "that's not what it's meant for" or "it promotes higher quality" - which really doesn't address the practical question I have to face, which is, how can I justify - with tangible results - spending more time testing?
Thanks, Richard
Code coverage will ensure I'm hitting every functional piece of code
The problem with only doing web-testing is that it only ensures that you hit the code, and that it appears to be correct at a high-level.
Just because you loaded the page, and it didn't crash, doesn't mean that it actually works correctly. Here are some things I've encountered where 'web tests' covered 100% of the code, yet completely missed some very serious bugs which unit testing would not have.
It is easy to come up with hundreds more examples of things like this.
You need both unit tests to make sure that your code actually does what it is supposed to do at a low level, and then functional/integration (which you're calling web) tests on top of those, to prove that it actually works when all those small unit-tested-pieces are chained together.
Unit testing is likely to be significantly quicker in turn-around than web testing. This is true not only in terms of development time (where you can test a method in isolation much more easily if you can get at it directly than if you have to construct a particular query which will eventually hit it, several layers later) but also in execution time (executing thousands of requests in sequence will take longer than executing short methods thousands of times).
Unit testing will test small units of functionality, so when they fail you should be able to isolate where the issue is very easily.
In addition, it's a lot easier to mock out dependencies with unit tests than when you hit the full front end - unless I've missed something really cool. (A few years ago I looked at how mocking and web testing could integrate, and at the time there was nothing appropriate.)
Unit testing does not generally prove that any given set of functionality works--at least it's not supposed to. It proves that your class contract works as you expect it to.
Acceptance tests are more oriented at customer requirements. Every requirement should have an acceptance test, but there is really no requirement between acceptance tests and unit tests--they might not even be in the same framework.
Unit testing can be used to drive code development, and speed of retesting is a significant factor. When testing, you often remove parts that the class under test relies on to test in isolation.
Acceptance tests the system just as you would deliver it--from GUI to database. Sometimes they take hours or days (or weeks) to run.
If you start to think of it as two completely different beasts, you will be a much more effective tester.
Good, focused unittests make it a lot faster to find and fix problems when they crop up. When a well-written unittest breaks, you know pretty much what the failure means and what caused it.
Also, they're typically faster to run, meaning that you're much more likely to run them during development as part of your edit-compile-test cycle (as opposed to only when you're about to check-in).
When you write unit tests you will be forced to write your code in a better way. More loosely coupled and more object oriented. That will lead to better architecture and a more flexible system.
If you write unit tests in a TDD style you will probably don't do as much unnecessary code because you will focus on tiny steps and only do the necessary.
You will be more confident when doing refactoring to improve your code to increase maintainability and reduce code smell.
And the unit test themselves will serve as exilent documentation of what the system does and does not.
Those are just a few examples of benefits I have noticed when applying TDD to my work.
Unit testing gives you speed and most of all, pin point accuracy of where a failure or bug has been introduced. It enables you to test each component, isolated from every other component and be assured that it works as it should.
For example, if you had a web test, that sent an Ajax request back to a service on the server which then hit a database, which then fails. Was it the Javascript, service, business logic or database that caused the problem?
Where as if you unit test each of the service on its own, stubbing/mocking out the database, or each business logic unit, then you are more likely to know exactly where the bug is. Unit testing is less about coverage (although important) and more about isolation.
Almost as Dijkstra put it: unit-tests could only be used to show that software has defects, not to prove that it's defect-free. So, in general, hitting every code path once (and obtaining 100% coverage) has nothing to do with testing - it just helps to eliminate bitrot.
If you are playing it by the book, every serious bug should be eliminated only after there is a unit test written that triggers that bug. Coincidentally, fixing the bug means that this particular unit-test is not failing anymore. In future, this unit test checks that this particular bug stays fixed.
It is much easier to write a unit test that triggers a particular bug than write an end-to-end (web) test that does ONLY that and doesn't run heaps of completely irrelevant code along the way (which could also fail and mess up with root cause analysis).
Unit Tests test that each component works. These are extremely helpful in finding defects close to the time they are created, which dramatically cuts down the cost to fix defects and dramatically reduces the number of defects which end up in your release. Additionally, good unit tests make refactoring a whole lot easier and more robust.
Integration tests (or "web" tests in this case) are also very important but are a later line of defense than unit tests. A single integration test covers such a huge swath of code that when one fails it requires a lot of investigation to determine the defect (or possibly the group of defects) which caused the failure. This is costly, especially when you are trying to test a release build to get it out the door. This is even more costly given that the chance of introducing a bug with the fix tends to be pretty high on average and the chance that the failure is blocking further testing of the release (which is extremely expensive to the development cycle).
In contrast, when a unit test fails you know exactly where the defective code is and you usually know exactly what the code is doing wrong. Also, a unit test failure should only impact one developer at a time and be fixed before the code is checked in.
It's always more expensive to fix bugs later than earlier. Always.
Consider building an automobile. Would you wait until the entire vehicle rolls off the assembly line to test that each component works? At that point if you discover the CD player or the engine or the air conditioner or the cruise control doesn't work you have to take the whole vehicle off the line, fix the problem, then re-test everything (which hopefully doesn't reveal any new defects). This is obviously the wrong way to do it, just as it is obviously wrong to try to release software while only testing if it works at the end of the process rather than at every important step along the line from the ground up.
One more aspect - forgive the somewhat ideal environment that this is situated in:
Suppose you have 3 components that finally have to work together. Each can individually be completely unit-tested (whatever that means) with 5 unit tests. This makes 5 + 5 + 5 = 15 unit tests for complete coverage.
Now if you have your integration/web/combined test that tests all components together, you'd need (remember the ideal world for this abstract scenario) 5 * 5 * 5 = 125 tests that test all permutations to give you the same result as the 15 test cases above (given that you can even trigger all permutations, otherwise there would be untested/unspecified behaviour that might bite you later when you extend your components).
Additionally the 125 test cases would have a significantly more complicated setup, higher turnaround time and greatly decreased maintainability should the feature ever change. I'd rather opt for 15 unit tests plus some basic web tests that ensure that the components are wired somewhat correctly.
It depends on how the ASP.NET application architecture. If the web pages are merely hooking up an underlying business logic layer or data access layer, then unit tests working independently of the ASP.NET state model are faster to developer and run than similar WaitiN tests.
I recently developed an area of a legacy ASP.NET application, in Visual Studio 2003, with NUnit as the test framework. Whereas previously testing involved working through UI tests to ensure functionality was implemented correctly, 90% of the testing occurred wihtout requiring UI interaction.
The only problem I had was time estimates - one of the tasks was planned in Trac as taking 1 day for the data access/business logic, and 2 days for the UI creation and testing. With NUnit running over the data access/business logic the time for that portion of the development went from 1 day to 2 days. The UI developmente was reduced to a single 1/2 day.
This continued with other tasks within the new module being added to the application. The unit tests discovered bugs faster, and in a way that was less painful (for me) and I have more confidence in the application functioning as expected. Even better the unit tests are very repeatable, in that they do not depend on any UI redesign, so tend to be less fragile as changes in design fail in compilation, not at runtime.
Unit testing allows for more rigourous performance testing and makes it much easier to determine where bottlenecks occur. For large applications, performance becomes a major issue when 10,000 users are hitting a method at the same time if that method takes 1/100th of a second to execute, perhaps because of a poorly written database query, because now some of the users have to wait up to 10 seconds for the page to load. I know I personally won't wait that long for pages to load, and will just move on to a different place.
Unit testing allows you to focus on the logic of getting data, applying rules, and validating business processes before you add the intricacies of a front end. By the time the unit tests have been written and conducted, I know that the infrastructure for the app will support the data types that I pass back and forth between processes, that my transactions work appropriately, etc.
In other words, the potential points of failure are better isolated by the time you start your acceptance testing because you have already worked through the potential errors in your code with the unit tests. With the history of the unit tests, you'll know that only certain modules will throw certain errors. This makes tracking down the culprit code much easier.
What are some of the new features that can be used in .NET 2.0 that are specific to C# 3.0/3.5 after upgrading to Visual Studio 2008? Also, what are some of the features that aren't available?
Available
Not Available
You can use any new C# 3.0 feature that is handled by the compiler by emitting 2.0-compatible IL and doesn't reference any of the new 3.5 assemblies:
Func<..>, not Expression<Func<..>> )Pretty much everything! Daniel Moth covers this here and here. That only leaves runtime support: LINQ-to-Objects is provided by LINQBridge - which leaves just bigger APIs like Expression support, and tools like LINQ-to-SQL. These are too big to be reasonably ported back to .NET 2.0, so I'd use .NET 3.5 for these.
I cover this in an article on my site.
Almost all C# 3.0 features are available when targeting .NET 2.0. For extension methods, you need to define an extra attribute. Expression trees aren't available at all. Query expression support is based on a translation followed by "normal" C# rules, so you'll need something to provide the Select, Where etc methods. LINQBridge is the de facto standard "LINQ to Objects in .NET 2.0" implementation. You may well want to declare the delegates in the Func and Action delegate families to make it easier to work with lambda expressions - and then remove them if/when you move to .NET 3.5
To define extension methods, you'll need to supply the following class if you're targeting .NET 2.0:
namespace System.Runtime.CompilerServices {
[AttributeUsage(AttributeTargets.Method | AttributeTargets.Class | AttributeTargets.Assembly)]
sealed class ExtensionAttribute : Attribute { }
}
There was a previous discussion about something similar you may also want to read too:
http://stackoverflow.com/questions/140239/targeting-net-framework-35-using-net-20-runtime-caveats
You can use Mono's version of the System.Core which fully supports LINQ & Expression Trees. I compiled its source against .net 2.0, and now I can use it in my .net2.0 projects. This is great for projects that needs to be deployed on win2k, where .net3.5 is not available.
Lambdas & Extension methods are handled purely by the compiler and can be used with the .Net 2.0 framework.
The default output path for any project is Visual studio is bin/Debug, but I have noticed that obj folder is also generated which again contains dlls and pdbs. Can someone tell me why is this folder generated
"obj" folder is used to store temporary object files and other files used to create the final binary.
Further reading here
Has anybody tried programming on the EEE Pc in Visual Studio?
I'm considering buying one so I can show some apps on the fly, but also make small changes to them if necessary, without the inconvenience of a large laptop.
Some key points I'm after:
It sounds like the specs would get completely owned, but I've heard/seen strangely good things about the EEE Pc, like how it launches Word 2007 super quick on a nLite'd XP install. :)
I own an eeepc 900 and have successfully installed Visual Studio 2008, the MSDN library and SQL Server 2005 developer edition.
The biggest issue was fitting it all in the 4GB solid state C Drive. In short, you can't. Therefore using the 16GB secondary internal flash drive is essential.
The utility nlite was all I needed to do this. In summary nlite lets you create a more compact version of windows XP with just the components you need. However most important for the eeePC was it allowed me to easily tell windows to use D:\ instead of C:\ as the destination for "Program Files" and "Document and Settings".
Then you re-install windows from the nlite windows image, with the required paths automatically set as required. (I strongly recommend this approach over trying to change the paths of an existing/running windows install due to numerous issues it may cause for application compatibility etc).
Unfortunately (on the eepc900 at least) the D:\ drive is slower in general use then the solid state flash drive. For Visual Studio this means the startup time can be slower than ideal (ie 30 seconds). But I have 2GB of RAM and have completely disabled the windows swap file, so once the data has been loaded into RAM, Visual Studio runs nicely.
Overall I use Visual Studio on my eeePC for smaller projects and it is ideal for creating proof of concept type apps while on the move. While it is never going to be ideal as a main development machine, I can completely recommend installing Visual Studio etc on it.
To help resolve possible confusion:
The eeePC 9 series (900, 901) have an 8.9 inch screen, resolution 1024 * 600 and a total of 20GB internal storage, RAM can be upgraded to 2GB.
The older eeePC 7 series have 7 inch screens with 800* 480 resolution and a total of 4GB built internal storage (RAM up to 2GB?). As a development machine, the 7 series are not really up to the job, however the 9 series certainly are.
[Update]
I now own an eeePC 900HA, 1.6Ghz Atom, 2G RAM, 160GB hard drive. Great little machine for proof of concepts and smaller programs. The biggest performance improvement is in the standard 160GB HDD, much better then a pretend solid state drive, much cheaper then an equivalent real SSD.
More or less like Ash, I have an EEE PC 901, installed with VS2008 without SP1, Resharper and MSDN library. I didn't install SQL Server as I use MySQL most of the time. I install all my "important" tools, which is VS2008 on C:, the rest of the stuffs in D:, as I prefer to have maximum performance for my VS2008. Like the others had mentioned, screen size is quite a limiting factor, so I use ProFont at 8, shrinked the default window's UI, not forgetting to turn off the theme too.
Performance wise, CPU is doing ok, but the SSD read/write speed is a factor. I benchmarked and get around 30MB/s read, slightly more than 10MB/s write. When I try to load multiple apps, or when VS2008 is busy with something, it will take a much longer time to even load notepad, so I kinda practice to be patient and load 1 thing at a time (on my desktop, I can never wait to load everything in 1 shot). I had 2GB of RAM, had been trying to allocate more ram for disk cache, but still haven't achieve anything.
I used it to do onsite troubleshooting and minor touch up, or whenever I go outstation, plus watching my favourite CSI when I'm traveling :P. Anyway, the main reason I got this is because of it's battery runtime, 7 hours. I doubt you can find another decent notebook that can match it. It produce so little heat so it can play nice on my laps and the standby also quite seamless. I use the standby extensively and even leave it on standby for days. Battery only drop about 10% per day. I can be seated and working on my program and next minute close my notebook and move to the next location without worrying that it won't go into standby(even if it doesn't standby, it can still last until the next time it's opened up, and not burning the pouch along the way)
I did look into Acer AspireOne before I got the EEE PC, AspireOne did have a wider keyboard, much easier to type, but the touchpad and battery puts my off. I had been considering various 12" notebook too before decided on EEE PC, as I used to have a 12" for 4 years. But 12 incher doesn't have that much juice for me to work for more than 2 hours. Those that can run for 4 hours is just too pricey.
There's one time when I came into my client's office earlier then usual, in the morning at 9, started working on my notebook, left it on standby when I go for lunch, then worked until 5 in the evening, when everyone left, I still had 20% left on my battery. Knowing this, I can even leave the power adaptor in the hotel and just go around with a pouch. Way to go ASUS
EDIT: Sorry for the mis-information guys, I didn't realized that I only had VS2008 without SP1 on my Eee PC. Didn't realized the "difficulty" until Menelmacar as me about it.
I would recommend something other than the Asus EEE, they're too small of a "netbook" and the screen resolution is terrible.
The HP Mini Note has a nice 8.9" display, practically full size keyboard and best of all has a display that can do 1280 x 768, though you might need to bump your font sizes a bit. :)
You also have the option of the Acer Aspire One which appears to be a much better netbook with a low price point.
If you Google any other those netbooks you will find many reviews and if you hit up YouTube you can find lots of hands on video reviews.
I think the 700 series would just be a dog. The 900 series would be a far better choice with a bigger screen and faster RAM (but the same processor), but it's still not well-intended for Visual Studio 2008. I find VS cramped on my 12" tablet.
Take a look at the Dell Inspiron Mini.
I managed to install Visual Web Developer installed on the XP that came with my eee pc 901 and i've still got 1.3Gb left on the C Drive.
Once the install complete it turns out only about 200mb-300mb is actually used on the C drive.
I think it largely depends on the size of your project. A small project might not have too much trouble. But a large project would probably bring the thing to it's knees. I've seen my work project on VS.Net 2008 eat up to 350 MB pf RAM all by itself. Not counting loading the OS and actually running the project. Also, you might be using up a lot of hard disk space by installing visual studio on it. There isn't a lot of space on the EEE, unless you plan on using some kind of external USB hard disk.
Personally, I would recommend a more real laptop. You could get something cheap and small, and you'd probably be a lot happier in the end.
http://www.hardforum.com/showthread.php?t=1303682
It seems that other people have tried it, all have complained about the screen resolution, but surprisingly not the CPU. Needless to say, I didn't want to have all the panels open / want to use it primarily for a development machine, I just wanted the option to do so if possible.
I'm looking at a 700 series, if it works it's a bonus, if it doesn't, I'll just have to look into using SharpDevelop maybe (I'm a student without much money, so it really needs to be budget.
I am just trying to install SP1 and it seems that I will not be successfull. So you think that pointing Program Files to the D drive will force the installer to use drive D: for service pack installation? Currently, I have 1 GB free on drive C but the installation needs 1,9 although Visual Studio is installed to the D drive. You can see details about the installation here: http://blogs.msdn.com/heaths/archive/2008/07/24/why-windows-installer-may-require-so-much-disk-space.aspx .
Wow, I've just installed .net 3.5 and the disk requirements dropped to 1090MB. Hopefully, I will be able to install SP1 without the reinstalling-and-changing-programfiles-path gymnastics.
Well, it works! So - if you are short of disk space (you need 1,9GB) while applying VS2008 SP1, try installing .net 3.5 first. I would also recommend to install it from the ISO package (ie., you don't need to download the installer files).
I was really surprised about the performance - I compiled a web site with five DLL projects and also started the SQL and developer web server and it was really good.
Just a thought or alternative suggestion that might be applicable...
I regularly use Visual Studio without any issues on my eeePC. The trick is that I simply access another machine running Visual Studio remotely in order to do this. This lets me have the convenience and portability of the netbook, along with the full-scale computing power of a real development environment.
Obviously this won't work if you don't have connectivity, but for me its an ideal setup..
I have a solution that contains two projects. One project is an ASP.NET Web Application Project, and one is a class library. The web application has a project reference to the class library. Neither of these is strongly-named.
In the class library, which I'll call "Framework," I have an endpoint behavior (an IEndpointBehavior implementation) and a configuration element (a class derived from BehaviorExtensionsElement). The configuration element is so I can attach the endpoint behavior to a service via configuration.
In the web application, I have an AJAX-enabled WCF service. In web.config, I have the AJAX service configured to use my custom behavior. The system.serviceModel section of the configuration is pretty standard and looks like this:
<system.serviceModel>
<behaviors>
<endpointBehaviors>
<behavior name="MyEndpointBehavior">
<enableWebScript />
<customEndpointBehavior />
</behavior>
</endpointBehaviors>
</behaviors>
<serviceHostingEnvironment aspNetCompatibilityEnabled="true" />
<services>
<service name="WebSite.AjaxService">
<endpoint
address=""
behaviorConfiguration="MyEndpointBehavior"
binding="webHttpBinding"
contract="WebSite.AjaxService" />
</service>
</services>
<extensions>
<behaviorExtensions>
<add
name="customEndpointBehavior"
type="Framework.MyBehaviorExtensionsElement, Framework, Version=1.0.0.0, Culture=neutral, PublicKeyToken=null"/>
</behaviorExtensions>
</extensions>
</system.serviceModel>
At runtime, this works perfectly. The AJAX enabled WCF service correctly uses my custom configured endpoint behavior.
The problem is when I try to add a new AJAX WCF service. If I do Add -> New Item... and select "AJAX-enabled WCF Service," I can watch it add the .svc file and codebehind, but when it gets to updating the web.config file, I get this error:
The configuration file is not a valid configuration file for WCF Service Library.
The type 'Framework.MyBehaviorExtensionsElement, Framework, Version=1.0.0.0, Culture=neutral, PublicKeyToken=null' registered for extension 'customEndpointBehavior' could not be loaded.
Obviously the configuration is entirely valid since it works perfectly at runtime. If I remove the element from my behavior configuration temporarily and then add the AJAX-enabled WCF Service, everything goes without a hitch.
Unfortunately, in a larger project where we will have multiple services with various configurations, removing all of the custom behaviors temporarily is going to be error prone. While I realize I could go without using the wizard and do everything manually, not everyone can, and it'd be nice to be able to just use the product as it was meant to be used - wizards and all.
Why isn't my custom WCF behavior extension element type being found?
Updates/clarifications:
I filed this issue on Microsoft Connect and it turns out you either have to put your custom configuration element in the GAC or put it in the IDE folder. They won't be fixing it, at least for now. I've posted the workaround they provided as the "answer" to this question.
Per the workaround that Microsoft posted on the Connect issue I filed for this, it's a known issue and there won't be any solution for it, at least in the current release:
The reason for failing to add a new service item: When adding a new item and updating the configuration file, the system will try to load configuration file, so it will try to search and load the assembly of the cusom extension in this config file. Only in the cases that the assembly is GACed or is located in the same path as vs exe (Program Files\Microsoft Visual Studio 9.0\Common7\IDE), the system can find it. Otherwise, the error dialog will pop up and "add a new item" will fail.
I understand your pain points. Unfortunately we cannot take this change in current release. We will investigate it in later releases and try to provide a better solution then,such as providing a browse dialog to enable customers to specify the path, or better error message to indicate some work around solution, etc...
Can you try the work around in current stage: GAC your custom extension assembly or copy it to "Program Files\Microsoft Visual Studio 9.0\Common7\IDE"?
We will provide the readme to help other customers who may run into the same issue.
Unfortunately, it appears I'm out of luck on this one.
As an FYI to anyone who stumbles across this these days a possible solution is to FULLY qualify your assembly in your app.config/web.config. EG if you had
<system.serviceModel>
<extensions>
<behaviorExtensions>
<add name="clientCredential" type="Client.ClientCredentialElement, Client" />
</behaviorExtensions>
</extensions>
try - replacing the values as necassary
<system.serviceModel>
<extensions>
<behaviorExtensions>
<add name="clientCredential" type="Client.ClientCredentialElement, Client, Version=1.0.0.0, Culture=neutral, PublicKeyToken=null" />
</behaviorExtensions>
</extensions>
this particular solution worked for me.
Do you have a copy of Framework.dll with your custom behavior in the bin directory of your web project? If not that is probably the problem. Visual Studio is looking for the implementation of the behavior. Since it's listed in your config it doesn't think to look in the other projects; it expects to find the assembly in the bin.
Depending on how your project is setup, it may be able to run in debug without this assembly being put in the bin, although VS usually builds it and puts it there. But again, it depends on how things are setup.
Anyway, might just want to double check at that the assembly is available at design time.
I tried this with a new project just to make sure it wasn't your specific project/config and had the exact same issue.
Using fusion logs, it appears that the system looks for the behavior extensions ONLY in the IDE directory (C:\Program Files\Microsoft Visual Studio 9.0\Common7\IDE). Copying the assembly to this directory in a post-build step works, but is ugly.
Putting the assembly in the GAC would probably help, but I appreciate this isn't the answer you're looking for. Not sure where else VS will look for assemblies apart from the GAC and the directory containing devenv.exe.
Yes,
I am having the same problem. It's impossible to add a WCF or a Silverlight WCF service from the IDE.
The solution that I have adopted it's very simple:
I have installed ReSharper and "played" with it twice now. I have always found it annoying and that it got in the way of the hotkeys I was already using in Visual Studio. The people that use it tend to swear by it.
For those of you that do use it, where do you find it saves you the most time or what do you think its best feature is? Please be specific.
Result(6 months later)
Once I got over the initial invasiveness I found resharper to be very useful and I now depend on it so much that I can't remember how I used to get by before I started using it....
I especially like
Ctrl T --> go to type
go to base
go to inheritor
extract interface
Things that R# speed up coding for me are:
These previously asked questions should help in answering your question:
It saves me a lot of time when I can just use the Find Usages... option, when I am merging methods into classes to improve the encapsulation.
I also like how I can make TODO comments in my code and easily find them on the scrollbar, and I like knowing I can safely remove namespace declarations when they are not needed.
I also use the namespace declaration not needed thing to know if I have separated the UI from the code good enough. If I'm importing System.Data for something in the code-behind, really it probably deserves it's own class.
The best feature is CTRL + ALT + L (2008) or SHIFT + ALT + L (2005). This selects the file you are viewing in the solution explorer. If i'm patching some changes into another branch and need to view the file histories (via TFS) then this is a HUGE time saver. Also when combined with CTRL + T (search type) it lets me fly all over the v.large code base we have at work. It's pretty much worth it just for that.
Another v.coolio feature is the graying out of redundant code. There is many a time that has pointed me towards a more significant problem.
Refactor -> Move -> Into a new file is also nice for extracting classes into different files.
It's worth pointing out that Resharper also kills time because of the amount of time it takes to initialise. The speed at which Visual Studio opens for me has at least doubled if not quadrupled. However, overall I think it is definitely worth it.
I like typing control-n and control-shift-n to get to the class or file I need to be in. I also like clicking on the color highlighted lines next to the scroll bar, and then typing alternate-enter to get a suggestion for what's wrong there and how to fix it.
It takes plain Visual Studio (at least 2005) refactoring several minutes (while it tries to analyze the whole code base) to simply rename a local variable.
And after all Visual Studio forgets all the analyzes results, so you should prepare for the same time waste on next Visual Studio reopen.
I tested a lot of refactoring tools for Visual Studio. Didn't like most of them. But ReSharper really saves a lot of time in development. Can't imagine to work without it! At the beginning it will be bit confusing bacause all shortcuts changed, but after you are into it you will love it.
I use it to build demo. Trust me... it it can cut time in half really fast. Normally you are fighting against Visual Studio to extract interface, move class to file, rename namespace, etc.
ReSharper removes the shackles and allow to flow through your code. :)
ALT-ENTER is the best since sliced bread.
I use everything MagicKat mentioned and a few more things:
I'm sure there are many other I'm leaving out or have yet to learn. Resharper makes cleaning up your code a joy!
After working for a few days with Eclipse Java I totally got addicted to pressing Ctrl and clicking on an identifier to go to its definition. Since then I've been looking for a way to achieve this in Visual Studio as well.
I realize VS has right click, Go to definition, and that F12 does the same. I also realize that Visual Assist does something similar with Alt + G. Yet none of these are as perfect as Ctrl + click.
I've actually tried my luck for a few hours trying to write a VS plugin to do it but didn't get anywhere in the time frame I thought reasonable for this.
Does anyone know how this could be achieved? A ready plugin? A macro of some kind?
If you use Visual Studio 2010, you can use the free Visual Studio 2010 Productivity Power Tools from Microsoft to achieve this.
I'll answer the commentors who asked about the difference between ctrl-click and F12.
Ctrl-click workflow:
F12 workflow
If you assume the cursor is already positioned on the desired variable, F12 is better. However, that's rarely the case. Also, if you stop after this specific action, assuming you want hands back at the keyboard, the cost is the same. But if you keep in mind that you probably had a reason for wanting to go to the definition, the ctrl-click workflow saves you an instance of moving between the keyboard and mouse.
Visual Assist supports Ctrl+Click as of June 2009 (build 1727).
I use the built in options (F12, Right-click -> Go to definition) but I know a lot of the guys at my company use Resharper and it definitely has this functionality.
I don't work in VS much, so I haven't used it, but I've heard incredibly good things about Resharper from everyone I know who does. Everyone has told me it's worth every penny, and significantly improves efficiency in Visual Studio. I think it has a feature like what you're looking for, along with a TON of others.
Another option with VS (besides F12 and right-click > Go to Def) is add the code definition pane (View > Code Def Window). This is essentially another editing pane that shows the code for the current symbol - no need to ctrl-click or anything. I keep it pinned to my secondary monitor. Any time I need to see the implementation for a symbol I just click it and look over.
Another nice thing about F12 is you can also do Shift-F12 to find references to a symbol and F8 through them. The two go together like love and happiness.
right click + go to definition requires 2 steps from the same hand. ctrl+click can be done in one step (using both hands). way better! I really miss ctrl+click in VS :-(
oh man, just install resharper!! (vs plugin) with it installed you just go and ctrl + click to go to definition.
this is not the only thing resharper does, try it out free!!!
I must be missing something because I don't see how Eclipse's ctrl-click feature (as described) is any better than Visual Studio's right-click-go-to-definition which requires fewer steps and can be done with one hand.
See also this question.
If you have Visual Studio 2010 you can use "Go To Definition" by Noah Richards.
http://visualstudiogallery.msdn.microsoft.com/en-us/4b286b9c-4dd5-416b-b143-e31d36dc622b
I prefer to bind Go To Definition to Ctrl-D. This makes it extremely easy to use either with both hands on the keyboard (Ctrl-D to go tho the definition of the symbol under the cursor) or one hand on the keyboard and one hand on the mouse (Click on a symbol, then Ctrl-D).
Microsoft released a Visual Studio 2010 extension named "Productivity Power Tools" which now adds Ctrl+Click functionality. So if you're like me, and hate installing third-party addons, you can now have the same functionality!
I've always wondered if there was a way to place a watch on variable and only have visual studio break when that value changes...it would make it so much easier to find tricky state issues.
Does anyone know if this can be done?
EDIT: Breakpoint conditions still need a breakpoint set, I'd rather set a watch and VS set the breakpoints at state changes.
In the VS2005 menu:
Debug / New Breakpoint / New Data Breakpoint
enter:
&myVariable
You can also choose to break explicitly in code:
// assuming C#
if (condition)
{
System.Diagnostics.Debugger.Break();
}
From MSDN:
Debugger.Break: If no debugger is attached, users are asked if they want to attach a debugger. If yes, the debugger is started. If a debugger is attached, the debugger is signaled with a user breakpoint event, and the debugger suspends execution of the process just as if a debugger breakpoint had been hit.
This is only a fallback, though. Setting a conditional breakpoint in VS, as described in other comments, is a better choice.
right click on the breakpoint works fine for me (though mostly using it for conditional breakpoints on specific variable values, even breaking on expressions involving thread name works which is very useful if you're trying to spot threading issues)
I remember the way you described using vb6. In visual studio, the only way i have found so far is by specifying a breakpoint condition..
You can use a memory watchpoint in unmanaged code. Not sure if these are available in managed code though.
I thought the whole point of a watch was to stop if the value changed. What is the purpose otherwise?
juste do this:
if( condition to check) { int a = 2;a;// place break point here }
Imagine you have a class called A with the following declaration.
class A
{
public:
A();
private:
int m_value;
};
You want the program to stop when someone modifies the value of "m_value".
Go to the class definition and put a breakpoint in the constructor of A.
A::A()
{
... // set breakpoint here
}
Once we stopped the program:
Debug -> New Breakpoint -> New Data Breakpoint ...
Address: &(this->m_value)
Byte Count: 4 (Because int has 4 bytes)
Now, we can resume the program. The debugger will stop when the value is changed.
You can do the same with inherited classes or compound classes.
class B
{
private:
A m_a;
};
Address: &(this->m_a.m_value)
If you don't know the number of bytes of the variable you want to inspect, you can use the sizeof operator.
For example:
// to know the size of the word processor,
// if you want to inspect a pointer.
int wordTam = sizeof (void* );
If you look at the "Call stack" you can see the function that changed the value of the variable.
You can probably make a clever use of the DebugBreak() function.
If you are using WPF, there is an awesome tool : WPF Inspector.
It attaches itself to a WPF app and display the full tree of controls with the all properties, an it allows you (amongst other things) to break on any property change.
But sadly I didn't find any tool that would allow you to do the same with ANY property or variable.
You're stepping through C/C++ code and have just called a Win32 API that has failed (typically by returning some unhelpful generic error code, like 0). Your code doesn't make a subsequent GetLastError() call whose return value you could inspect for further error information.
How can you get the error value without recompiling and reproducing the failure? Entering "GetLastError()" in the Watch window doesn't work ("syntax error").
As mentioned a couple times, the @err pseudo-register will show the lasst error value, and @err,hr will show the error as a string (if it can).
According to Andy Pennell, a member of the Visual Studio team, starting with VS 7 (Visual Studio .NET 2002), using the '@' character to indicate pseudo-registers is deprecated - they prefer to use '$' (as in "$err,hr"). Both $ and @ are supported for the time being.
You can also use the $err pseudo-register in a conditional breakpoint; so you can break on a line of code only if the last error is non-zero. This can be a very handy trick.
Some other pseudo registers that you may find handy (from John Robbins' outstanding book, "Debugging Applications for Microsoft .NET and Microsoft Windows"):
ERR,hr in a watch window usually does the trick
"edit and continue" add the code so you can see the error (just don't create a new global variable to store it). It works really well if you can quickly put a call to a pre-existing function that executes this kind of error handling code.
As a bonus, you can leave the new code there for the future too.
If you can't do this, then QBziZ is right "ERR,hr" does it.
Short of cutting and pasting, is there a way to sort the methods in my classes in Visual Studio 2008? I like orderly code.
This is a free plug-in that does what you are asking: http://www.visualstudiogallery.com/ExtensionDetails.aspx?ExtensionID=800978aa-2aac-4440-8bdf-6d1a76a5c23c
Unfortunately the link is outdated. You can download Regionerate at http://www.rauchy.net/regionerate/docs/2007/05/download.html
If you are using Resharper, you can change the Type Members Layout template so that it orders your code however you like. See under Resharper>Options>Languages>C#>Type Members Layout.
You can, for example, put methods with particular attributes first in your file... e.g. methods marked with NUnit's [Setup] and [TearDown] could come before methods marked with [Test] by placing a block like:
<!--Fixture Setup/Teardown-->
<Entry>
<Match>
<And>
<Kind Is="method"/>
<Or>
<HasAttribute CLRName="NUnit.Framework.TestFixtureSetUpAttribute" Inherit="true"/>
<HasAttribute CLRName="NUnit.Framework.TestFixtureTearDownAttribute" Inherit="true"/>
</Or>
</And>
</Match>
</Entry>
before:
<!--Test methods-->
<Entry>
<Match>
<And Weight="100">
<Kind Is="method"/>
<HasAttribute CLRName="NUnit.Framework.TestAttribute" Inherit="false"/>
</And>
</Match>
<Sort>
<Name/>
</Sort>
</Entry>
and then have a catch-all for everything else:
<!--All other members-->
<Entry>
<Sort>
<Name/>
</Sort>
</Entry>
The template system is very powerful and should meet your needs.
You may find or be able to make a macro to do this, but there is no built in functionality of VS to sort your methods. Some third party productivity tools like Resharper and CodeRush provide some functionality to reorder your code.
ReSharper has Code Reordering functionality and a File Structure view that lets you do drag and drop reordering.
Resharper will do a good job in a limited way. It depends on how much you want. For example, it wont go and reorder your overrides in an asp.net page based on lifecycle, or anything like that, but it will keep properties, fields, methods and what not clearly grouped
EDIT: By the eway i was refering to auto reordering aka reformatting.
When you double click on a class (in 'solution explorer')... if that class happens to be an .asmx.cs webservice... then you get this...
To add components to your class, drag them from the Toolbox and use the Properties window to set their properties. To create methods and events for your class, click here to switch to code view.
...it's a 'visual design surface' for webservices.
(Who actually uses that surface to write webservices?)
So what I want to know, how do I configure visual studio to never show me that design view?
Or at least, to show me the code view by default?
You can set the default editor for any given file type (.cs, .xml, .xsd, etc). To change the default editor for a given type:
I don't see the behavior you see with web services, but this should work with all file types in Visual Studio.
Add the following attribute to your class:
<System.ComponentModel.DesignerCategory("")>
Add the following attribute to your class:
[System.ComponentModel.DesignerCategory("Code")]
(Not sure why [System.ComponentModel.DesignerCategory("")] does not work.)
What is the best way to bind WPF properties to ApplicationSettings in C#? Is there an automatic way like in a Windows Forms Applicatoin? Similar to this question, how (and is it possible to) do you do the same thing in WPF?
You can directly bind to the static object created by VS.NET.
In your windows declaration add:
xmlns:p="clr-namespace:UserSettings.Properties"
where UserSettings is the application namespace.
Then you can add a binding to the correct setting:
<TextBlock Height={Binding Source={x:Static p:Settings.Default}, Path=Height, Mode=TwoWay} ... />
Now you can save the settings, per exemple when you close your application:
protected override void OnClosing(System.ComponentModel.CancelEventArgse)
{
Properties.Settings.Default.Save();
base.OnClosing(e);
}
The easiest way would be to bind to an object that exposes your application settings as properties or to include that object as a StaticResource and bind to that.
Another direction you could take is creation your own Markup Extension so you can simply use PropertyName="{ApplicationSetting SomeSettingName}". To create a custom markup extension you need to inherit MarkupExtension and decorate the class with a MarkupExtensionReturnType attribute. John Bowen has a post on creating a custom MarkupExtension that might make the process a little clearer.
Kris, I'm not sure this is the best way to bind ApplicationSettings, but this is how I did it in Witty.
1) Create a dependency property for the setting that you want to bind in the window/page/usercontrol/container. This is case I have an user setting to play sounds.
public bool PlaySounds
{
get { return (bool)GetValue(PlaySoundsProperty); }
set { SetValue(PlaySoundsProperty, value); }
}
public static readonly DependencyProperty PlaySoundsProperty =
DependencyProperty.Register("PlaySounds", typeof(bool), typeof(Options),
new FrameworkPropertyMetadata(false, new PropertyChangedCallback(OnPlaySoundsChanged)));
private static void OnPlaySoundsChanged(DependencyObject obj, DependencyPropertyChangedEventArgs args)
{
Properties.Settings.Default.PlaySounds = (bool)args.NewValue;
Properties.Settings.Default.Save();
}
2) In the constructor, initialize the property value to match the application settings
PlaySounds = Properties.Settings.Default.PlaySounds;
3) Bind the property in XAML
<CheckBox Content="Play Sounds on new Tweets" x:Name="PlaySoundsCheckBox" IsChecked="{Binding Path=PlaySounds, ElementName=Window, Mode=TwoWay, UpdateSourceTrigger=PropertyChanged}" />
You can download the full Witty source to see it in action or browse just the code for options window.
I like the accepted answer, I ran into a special case though. I had my text box set as "read only" so that I can change the value of it only in the code. I couldn't understand why the value wasn't propagated back to the Settings although I had the Mode as "TwoWay".
Then, I found this: http://msdn.microsoft.com/en-us/library/system.windows.data.binding.updatesourcetrigger.aspx
The default is Default, which returns the default UpdateSourceTrigger value of the target dependency property. However, the default value for most dependency properties is PropertyChanged, while the Text property has a default value of LostFocus.
Thus, if you have the text box with IsReadOnly="True" property, you have to add a UpdateSourceTrigger=PropertyChanged value to the Binding statement:
<TextBox Text={Binding Source={x:Static p:Settings.Default}, Path=myTextSetting, Mode=TwoWay, UpdateSourceTrigger=PropertyChanged} ... />
Also read this article on how it is done in BabySmash
You only need to back the Settings with DO (Like Alan's example) if you need the change notification! binding to the POCO Settings class will also work!
Looking for good techniques to justify "great than normal" machine for developers. The company I work for buys the same underpowered $500 dollar systems for everyone, and looking for ways to prove ROI or arguments to use. Sorry, I didn't say this in the initial question, the stack is VS 2008, SQL 2005/2008. As duties dictate we are SQL admins as well as Web/Winform/WebService Developers. So its very typical to have 2 VS sessions and at least one SQL session open at the same time.
Figure out how long you spend in the edit -> build -> debug cycle, then total that up over the course of a year. Then guesstimate (with some justifiable inflation) what a good computer would do to that number. Multiply the time improvement by your hourly rate, and present it as a business case.
A good one is:
Extra time per compile X number of compiles per hour X hours in working day X days in month X number of developers
This highlights how much of your (expensive) time is being wasted waiting for the machine to finish. You can do the same for test runs etc...
Don't forget to include multiple display devices in your request: having a second screen to have the code on one, debugger on the other (eg) is invaluable. Or to be coding in one screen with the language reference in another.
Do you have a central server where building is done? If so, arguing for a "greater than normal" development workstation may be hard.
Being able to cut build times by a factor of 2-3, though, is a logical reason to buy bigger hardware.
OTOH, if a company is so worried about how much they're spending that they only ever get the Walmart specials (which are fine for "normal" work (typing, email, scheduling, presentations)), they're going to scare-off their actual technical folks, like yourself, who actually want to get work done, and who have a more complex job, than, say, the administrative assistant.
Unless you're hiring incompetent developers or your developers are making extremely ridiculous demands, the return on investment is almost always orders of magnitude higher than the cost of a workstation. Even a high-powered machine with a 30" monitor is cheap compared to a good developer's salary, anyway. It's so easy to please developers with a few shiny gadgets. If you don't do it, the company next door will!
Everything you get from your developer is channeled through his or her tools. The slightest inadequacy in those tools will be compounded a thousand times over the lifetime of those tools (expect to have to upgrade them within two years). These inadequacies kill your developer's productivity and may even generate a lot of frustration. Why would you want to skimp on the most important resource for your developers? I bet if you look deeply, you'll find much greater waste elsewhere in your company.
Expressed as code:
AnnualSavings := DeveloperCostPerHour * (AnnualWaitHours(OldPC) - AnnualWaitHours(NewPC));
if AnnualSavings > (MachineCost(NewPC) - MachineCost(OldPC)) then
ShowMessage('Time to pony up for a new machine!!')
else
ShowMessage('Sorry bub, gotta keep the old clunker.');
Testing, at least, should be occurring on a system as close as possible to the environment it will be released into. Most developers do at least some testing on their desktop, so that's a reason to not be any worse than your live environment.
If your live environment is an underpowered $500 system, then well, that's your environment. Perhaps you should work on that? Hard to say what other things you should bring up without any idea of what kind of development you're doing. Application? Server? An interpreted language or a compiled language?
My saying is "The answer to programmer productivity is not to give everyone slow machines"
Volunteer for as many dog and pony shows as you can (opportunities to show off what you've done to important people like the VP and so forth). At some point your machine will bog down. They'll ask why everything is taking so long. Explain that you have a painfully slow computer. Also point out how you're going to risk missing a deadline because of it. Point out how the hard drive never stops grinding.
Playing the numbers, point out how expensive your time is compared to the one-time cost of upgrading you now.
Being cheap on hardware is stupid. People are way more expensive to find, hire, and retain than hardware. The difference in cost between minimal and great hardware is usually equivalent to a few weeks of programmer salary. You should give developers a top-end machine of their choice and at least 2 screens. If your company won't give you the tools for you (and thus them) to be successful, they aren't worth your time.
If you are a salaried drone working insane hours and getting everything done that is asked of you, don't waste your time squeezing blood from the turnip. The company is exploiting you, you allow it, and there is no reason for them to change. Either spend your own money (buying yourself some additional time each day), find some way that the current situation causes pain upstairs, or put up with it.
If on the other hand you are working a reasonable amount of hours or are paid by the hour, you should be able to justify the request, either through reduced hours (= reduced cost) or through improved productivity (= things getting done faster). You need to decide which the organization is more interested in and present your request in those terms.
Identify (and quantify if possible) how the under-powered machine impedes your productivity and slows you down. Then apply that to EITHER reduced hours for the same work OR to more work done in the same time.
Good luck!
Danimal has a good formula there. You might include in that business case a spread sheet showing the base machine compared to what an "average" developer for your company needs, and wants. Things like Ram, CPU speed, preinstalled applications, GPU and so on.
partly because of productivity and responsiveness of the machine for a developer who would otherwise play chair-jousting during compiles; but also because a developer is going to install the biggest, resource-hungry applications you'll see outside a production server.
Visual Studio takes up a lot of disc, RAM and masses of CPU. Eclipse (I'm told) is just the same. Any developer why is doing something useful will also have source control, development versions of production systems (eg a local DB to develop against), etc. All those apps take up lots of ram and CPU too.
Unless you're remotely developing on a server somewhere, you'll need tons of resources just to install half the bloaty apps they want you to use!
I can contribute from my own experience why would stronger machine would be helpful:
Yeah I hear you.
The basic justification is always the same for me : Slower machine -> Slower developement ; Faster machine -> Faster developement.
Altough if your boss is too much focused on numbers Microsoft is not helping either.
Visual Studio setup requirements :
System Requirements for Installing Visual Studio 2005
Processor
Minimum: 600 megahertz (MHz) Pentium processor
Recommended: 1 gigahertz (GHz) Pentium processor
RAM
Minimum: 192 megabytes (MB)
Recommended: 256 MB
I'm guessing that you probably don't work for a software company - like me, you probably are part of a software group within a manufacturing/hardware company, or maybe a financial or educational institution, etc?
For me, working with/for these types of companies, it's usually not that the company wants to deny people the tools they need to get their work done, but rather a matter of not understanding "why" developers need better machines than sales people.
Maybe try using an analogy that makes sense to the person(s) holding the checkbook. Why do sales people take clients to a steakhouse when McDonald's is right across the street? Why do mechanics spend extra money to buy Snap-On tools when Wal-Mart sells Buffalo brand screw drivers? (sure, I have some Buffalo screw drivers at home - but I'm not a mechanic)
This is just rediculous, developers are very expensive to hire and pay, hardware is very cheap.
Giving everyone a decent machine on their desktop plus a well spec'd server ( 8G ram should be ok) in the server room is the minimum that you should expect.
Otherwise, how are they going to be able to run a decent amount of VMs at once?
Strictly speaking, their desktop machine doesn't matter too much provided they have a decent development server (I'm assuming this is not games development etc here). Two screens is a good idea though.
Tell them that you will pay the difference between their cheap machines and the machine that you want. If you are confident that it will boost your productivity significantly then you will make the money back easily in performance bonuses / salary increases.
Also, if you put your money where your mouth is then chances are they will not follow through on making you pay for it because it will cause too many problems in accounting.
One of the reasons companies standardize on machines to buy is to avoid the bickering that goes on when employee A gets one thing and employee B gets something better. If you paid for it then no-one is going to complain that you have a better PC.
If they still say no then at least you know where you stand. They don't take you seriously and they don't take the role of developer seriously. Dust off the CV.
UPDATE:
This is one of my most-visited questions, and yet I still haven't really found a satisfactory solution for my project. One idea I read in an answer to another question is to create a tool which can build solutions 'on the fly' for projects that you pick from a list. I have yet to try that though.
How do you structure a very large application?
And how do you manage dependencies in the case where you don't have one solution. Note: I'm looking for advice based on experience, not answers you found on Google (I can do that myself).
I'm currently working on an application which has upward of 80 dlls, each in its own solution. Managing the dependencies is almost a full time job. There is a custom in-house 'source control' with added functionality for copying dependency dlls all over the place. Seems like a sub-optimum solution to me, but is there a better way? Working on a solution with 80 projects would be pretty rough in practice, I fear.
(Context: winforms, not web)
EDIT: (If you think this is a different question, leave me a comment)
It seems to me that there are interdependencies between:
But I have great difficulty separating these out to consider them individually, if that is even possible.
I have asked another related question here.
Source Control
We have 20 or 30 projects being built into 4 or 5 discrete solutions. We are using Subversion for SCM.
1) We have one tree in SVN containing all the projects organised logically by namespace and project name. There is a .sln at the root that will build them all, but that is not a requirement.
2) For each actual solution we have a new trunks folder in SVN with SVN:External references to all the required projects so that they get updated from their locations under the main tree.
3) In each solution is the .sln file plus a few other required files, plus any code that is unique to that solution and not shared across solutions.
Having many smaller projects is a bit of a pain at times (for example the TortoiseSVN update messages get messy with all those external links) but does have the huge advantage that dependancies are not allowed to be circular, so our UI projects depend on the BO projects but the BO projects cannot reference the UI (and nor should they!).
Architecture We have completely switched over to using MS SCSF and CAB enterprise pattern to manage the way our various projects combine and interact in a Win Forms interface. I am unsure if you have the same problems (multiple modules need to share space in a common forms environment) but if you do then this may well bring some sanity and convention to how you architect and assemble your solutions.
I mention that because SCSF tends to merge BO and UI type functions into the same module, whereas previously we maintained a strict 3 level policy:
FW - Framework code. Code whose function relates to software concerns. BO - Business Objects. Code whose function relates to problem domain concerns. UI - Code which relates to the UI.
In that scenario dependancies are strictly UI -> BO -> FW
We have found that we can maintain that structure even while using SCSF generated modules so all is good in the world :-)
To manage dependencies, whatever the number of assemblies/namespaces/projects you have, you can have a glance at the tool NDepend.
Personnaly, I foster few large projects, within one or several solutions if needed. I wrote about my motivations to do so here: Benefit from the C# and VB.NET compilers perf
I think it's quite important that you have a solution that contains all your 80 projects, even if most developers use other solutions most of the time. In my experience, I tend to work with one large solution, but to avoid the pain of rebuilding all the projects each time I hit F5, I go to Solution Explorer, right-click on the projects I'm not interested in right now, and do "Unload Project". That way, the project stays in the solution but it doesn't cost me anything.
Having said that, 80 is a large number. Depending on how well those 80 break down into dicrete subsystems, I might also create other solution files that each contain a meaningful subset. That would save me the effort of lots of right-click/Unload operations. Nevertheless, the fact that you'd have one big solution means there's always a definitive view of their inter-dependencies.
In all the source control systems that I've worked with, their VS integration chooses to put the .sln file in source control, and many don't work properly unless that .sln file is in source control. I find that intriguing, since the .sln file used to be considered a personal thing, rather than a project-wide thing. I think the only kind of .sln file that definitely merits source control is the "one-big-solution" that contains all projects. You can use it for automated builds, for example. As I said, individuals might create their own solutions for convenience, and I'm not against those going into source control, but they're more meaningful to individuals than to the project.
I think the best solution is to break it in to smaller solutions. At the company I currently work for, we have the same problem; 80 projects++ in on solution. What we have done, is to split into several smaller solutions with projects belonging together. Dependent dll's from other projects are built and linked in to the project and checked in to the source control system together with the project. It uses more disk space, but disk is cheap. Doing it this way, we can stay with version 1 of a project until upgrading to version 1.5 is absolutely necessary. You still have the job with adding dll's when deciding to upgrade to a other version of the dll though. There is a project on google code called TreeFrog that shows how to structure the solution and development tree. It doesn't contain mush documentation yet, but I guess you can get a idea of how to do it by looking at the structure.
A method that i've seen work well is having one big solution which contains all the projects, for allowing a project wide build to be tested (No one really used this to build on though as it was too big.), and then having smaller projects for developers to use which had various related projects grouped together.
These did have depencies on other projects but, unless the interfaces changed, or they needed to update the version of the dll they were using, they could continue to use the smaller projects without worrying about everything else. Thus they could check-in projects while they were working on them, and then pin them (after changing the version number), when other users should start using them.
Finally once or twice a week or even more frequently the entire solution was rebuild using pinned code only, thus checking if the integration was working correctly, and giving testers a good build to test against.
We often found that huge sections of code didn't change frequently, so it was pointless loading it all the time. (When you're working on the smaller projects.)
Another advantage of using this approach is in certain cases we had pieces of functionality which took months to complete, by using the above approach meant this could continue without interrupting other streams of work.
I guess one key criteria for this is not having lots of cross dependencies all over your solutions, if you do, this approach might not be appropriate, if however the dependencies are more limited, then this might be the way to go.
For a couple of systems I've worked on we had different solutions for different components. Each solution had a common Output folder (with Debug and Release sub-folders)
We used project references within a solution and file references between them. Each project used Reference Paths to locate the assemblies from other solutions. We had to manually edit the .csproj.user files to add a $(Configuration) msbuild variable to the reference paths as VS insists on validating the path.
For builds outside of VS I've written msbuild scripts that recursively identify project dependencies, fetch them from subversion and build them.
We have one gigantic solution on the source control, on the main branch.
But, every developer/team working on the smaller part of the project, has its own branch which contains one solution with only few projects which are needed. In that way, that solution is small enough to be easily maintenaced, and do not influence on the other projects/dlls in the larger solution.
However, there is one condition for this: there shouldn't be too much interconnected projects within solution.
OK, having digested this information, and also answers to this question about project references, I'm currently working with this configuration, which seems to 'work for me':
This configuration seems to be working ok for me at the moment, but the big test will be trying to sell it to my colleagues, and seeing if it will fly as a team setup.
Currently unresolved drawbacks:
Summary - things I didn't know before asking this question which have proved useful:
This is my most popular question, so I hope this answer helps readers. I'm still very interested in further feedback from other users.
I'd like my .exe to have access to a resource string with my svn version. I can type this in by hand, but I'd prefer an automated way to embed this at compile time. Is there any such capability in Visual Studio 2008?
I wanted a similar availability and found $Rev$ to be insufficient because it was only updated for a file if that file's revision was changed (which meant it would have to be edited and committed very time: not something I wanted to do.) Instead, I wanted something that was based on the repository's revision number.
For the project I'm working on now, I wrote a Perl script that runs svnversion -n from the top-most directory of my working copy and outputs the most recent revision information to a .h file (I actually compare it to a saved reversion in a non-versioned file in my working copy so that I'm not overwriting current revision information at every compile but whether you chose to do so is up to you.) This .h file (or a number of files if necessary, depending on your approach) is referenced both in my application code and in the resource files to get the information where I'd like it.
This script is run as a pre-build step so that everything is up-to-date before the build kicks off and the appropriate files are automatically rebuilt by your build tool.
How about using SubWCRev the command line tool that ships with TortoiseSVN. You create a template file with tokens in it like $WCREV$ $WCDATE$ etc. Then have a pre-build step that run SubWCRev on your template file to create the actual source file that is fed to the compiler.
You can get SVN to embed it for you, if that will solve the problem. See the $Rev$ keyword on that page.
Have a look at svn keyword substitution here. There is another SO question here which I found through google!
antik's solution is the one we use. Be careful of using environment variables, the .h file ensures you can have a dependency which will cause any files that need it to be recompiled when the svn rev number changes.
How can I limit my post-build events to running only for one type of build? I'm using the events to copy DLLs to a local IIS virtual directory but I don't want this happening on the build server in release mode.
Pre- and Post-Build Events run as a batch script. You can do a conditional statement on $(ConfigurationName).
For instance
if $(ConfigurationName) == Debug xcopy something somwhere
alternatively (since the events are put into a batch file & then called), use the following. (in the Build event box, not in a batch file):
if $(ConfigurationName) == Debug goto :debug
:release
signtool.exe ....
xcopy ...
goto :exit
:debug
' debug items in here
:exit
This way you can have events for any configuration, and still manage it with the macros rather than having to pass them into a batch file & remember that %1 is $(OutputPath) etc:
FYI, you do not need to use goto. the shell IF command can be used with round brackets:
if $(ConfigurationName) == Debug (
copy "$(TargetDir)myapp.dll" "c:\delivery\bin" /y
copy "$(TargetDir)myapp.dll.config" "c:\delivery\bin" /y
) ELSE (
echo "why, Microsoft, why".
)
Add your post build event like normal. Then save you project, open it in Notepad (or your favorite editor) and add condition to the PostBuildEvent property group. Here's an example:
You can pass the configuration name to the post-build script and check it in there to see if it should run.
Pass the configuration name with $(ConfigurationName)
Checking it is based on how you are implementing the post-build step -- it will be a command-line argument
Like any project setting the buildevents can be configured per Configuration, just select the configuration you want to change in the dropdown of the Property Pages dialog and edit the post build step
What is the keyboard shortcut to expand the little red line that gives you the menu where you can choose to have the necessary Using statement added to the top of the file?
My Googling skills have not proved fruitful.
As will Ctrl + . which I find easier to type.
Alt + Shift + F10 will show the menu associated with the smart tag.
Just stumbled upon this question years after it was added. I can highly reccommend checking out the visual studio pluin Resharper. It has a QuickFix feature that does the same (and a lot more).
But the Resharper doesn't require the cursor to be located on the actual code that requires a new namespace. Say, you copy/paste some code into the source file, and just a few clicks of Alt + Enter, and all the required usings are included.
Oh, and it also makes sure that the required assembly reference is added to your project. Say for example, you create a new project containing NUnit unit tests. The first class you write, you add the [TestFixture] attribute. If you already have one project in your solution that references the nunit dll, then Resharper is able to see that the TestFixtureAttribute comes from that dll, so it will automatically add that assembly reference to your new project.
And it also adds required namespaces for extension methods. At least the Resharper version 5 beta does. I'm pretty sure that Visual Studio's build in resolve function doesn't do that.
On the down side, it's a commercial product, so you have to pay for it. But if you work with software commercially, the gained productivity (the plug in does a lot of other cool stuf) outweighs the price tag.
Yes, I'm a fan ;)
Quite an old thread but here are my comments:
In Visual Studio 2010 you will find the keyboard command to resolve namespaces in a command called View.ShowSmartTag. Mine was also mapped to Shift-Alt F10 which is a lot of hassle - so I usually remap that promptly.
On Pete commenting on Resharper - yes, for anyone with the budget, Resharper makes life an absolute pleasure. The fact that it is intelligent enough to resolve dependencies outside the current references, and add them both as usings and references will not only save you countless hours, but also make you forget where all framework classes reside ;-) That is how easy it makes development life... Then we have not even started on ReSharper refactorings yet.
DevExpress' CodeRush offers no assistence on this regard; or nothing that is obvious to me - and DevExpress under non-expert mode is quite forthcoming in what it wants to do for you :-)
Last comment - this IDE feature of resolving dependencies is so mature and refined in the Java IDE world that the bulk of the internet samples don't even show the imports (using) anymore.
This said, Microsoft now finally has something to offer on this regard but it is also clear to me that Microsoft development (for many of us) has now come full circle - the focus went from source, to visual designers right back to focus being on source again - meaning that the time you spend in a source code view / whether it is C#, VB or XAML is on the up and the amount of dragging and dropping onto 'forms' is on the down. With this basic assumption, it is simple to say that Microsoft should start concentrating on making the editor smarter, keyboard shortcuts easier, and code/error checking and evaluation better - the days of a dumb editor leaving you to google a class to find out in which library it resides are gone (or should be in any case) for most of us.
I have seen a few (old) posts on the 'net about hacking together some support for pre-compiled headers in CMake. They all seem a bit all-over the place and everyone has their own way of doing it. What is the best way of doing it currently?
Im using the following macro to generate and use precompiled headers:
MACRO(ADD_MSVC_PRECOMPILED_HEADER PrecompiledHeader PrecompiledSource SourcesVar)
IF(MSVC)
GET_FILENAME_COMPONENT(PrecompiledBasename ${PrecompiledHeader} NAME_WE)
SET(PrecompiledBinary "${CMAKE_CURRENT_BINARY_DIR}/${PrecompiledBasename}.pch")
SET(Sources ${${SourcesVar}})
SET_SOURCE_FILES_PROPERTIES(${PrecompiledSource}
PROPERTIES COMPILE_FLAGS "/Yc\"${PrecompiledHeader}\" /Fp\"${PrecompiledBinary}\""
OBJECT_OUTPUTS "${PrecompiledBinary}")
SET_SOURCE_FILES_PROPERTIES(${Sources}
PROPERTIES COMPILE_FLAGS "/Yu\"${PrecompiledBinary}\" /FI\"${PrecompiledBinary}\" /Fp\"${PrecompiledBinary}\""
OBJECT_DEPENDS "${PrecompiledBinary}")
# Add precompiled header to SourcesVar
LIST(APPEND ${SourcesVar} ${PrecompiledSource})
ENDIF(MSVC)
ENDMACRO(ADD_MSVC_PRECOMPILED_HEADER)
Lets say you have a variable ${MySources} with all your sourcefiles, the code you would want to use would be simply be
ADD_MSVC_PRECOMPILED_HEADER("precompiled.h" "precompiled.cpp" MySources)
ADD_LIBRARY(MyLibrary ${MySources})
The code would still function just fine on non-MSVC platforms too. Pretty neat :)
Here is a code snippet to allow you to use precompiled header for your project. Add the following to your CMakeLists.txt replacing myprecompiledheaders and myproject_SOURCE_FILES as appropriate:
if (MSVC)
set_source_files_properties(myprecompiledheaders.cpp
PROPERTIES
COMPILE_FLAGS "/Ycmyprecompiledheaders.h"
)
foreach( src_file ${myproject_SOURCE_FILES} )
set_source_files_properties(
${src_file}
PROPERTIES
COMPILE_FLAGS "/Yumyprecompiledheaders.h"
)
endforeach( src_file ${myproject_SOURCE_FILES} )
list(APPEND myproject_SOURCE_FILES myprecompiledheaders.cpp)
endif (MSVC)
Adapted from Dave, but more efficient (sets target properties, not for each file):
if (MSVC)
set_target_properties(abc PROPERTIES COMPILE_FLAGS "/Yustd.h")
set_source_files_properties(std.cpp PROPERTIES COMPILE_FLAGS "/Ycstd.h"
endif(MSVC)
I ended up using an adapted version of larsm macro. Using $(IntDir) for pch path keeps precompiled headers for debug and release builds separate.
MACRO(ADD_MSVC_PRECOMPILED_HEADER PrecompiledHeader PrecompiledSource SourcesVar)
IF(MSVC)
GET_FILENAME_COMPONENT(PrecompiledBasename ${PrecompiledHeader} NAME_WE)
SET(PrecompiledBinary "$(IntDir)/${PrecompiledBasename}.pch")
SET(Sources ${${SourcesVar}})
SET_SOURCE_FILES_PROPERTIES(${PrecompiledSource}
PROPERTIES COMPILE_FLAGS "/Yc\"${PrecompiledHeader}\" /Fp\"${PrecompiledBinary}\""
OBJECT_OUTPUTS "${PrecompiledBinary}")
SET_SOURCE_FILES_PROPERTIES(${Sources}
PROPERTIES COMPILE_FLAGS "/Yu\"${PrecompiledHeader}\" /FI\"${PrecompiledHeader}\" /Fp\"${PrecompiledBinary}\""
OBJECT_DEPENDS "${PrecompiledBinary}")
# Add precompiled header to SourcesVar
LIST(APPEND ${SourcesVar} ${PrecompiledSource})
ENDIF(MSVC)
ENDMACRO(ADD_MSVC_PRECOMPILED_HEADER)
ADD_MSVC_PRECOMPILED_HEADER("stdafx.h" "stdafx.cpp" MY_SRCS)
ADD_EXECUTABLE(MyApp ${MY_SRCS})
I can't edit my own question anymore because I changed my OpenID. So answering it myself is the best I can do now. To add more context to this question, I was looking into this to improve build times with Boost (http://www.boost.org/). So yes, I do believe adding PCH (pre-compiled headers) would be beneficial in my situation.
I found this: http://www.vtk.org/Bug/view.php?id=1260
Though I couldn't get it to work on Apple GCC 4.0
Well when builds take 10+ minutes on a quad core machine every time you change a single line in any of the project files it tells you its time to add precompiled headers for windows. On *nux I would just use ccache and not worry about that.
I have implemented in my main application and a few of the libraries that it uses. It works great to this point. One thing that also is needed is you have to create the pch source and header file and in the source file include all the headers that you want to be precompiled. I did this for 12 years with MFC but it took me a few minutes to recall that..
Take a quick step back -- are you sure you need precompiled headers?
For some projects, they're more hassle than they're worth.
It's probably worth benchmarking how quickly you can do a clean build with and without them (outside of CMake, given the question).
Don't even go there. Precompiled headers mean that whenever one of the headers changes, you have to rebuild everything. You're lucky if you have a build system that realizes this. More often than never, your build will just fail until you realize that you changed something that is being precompiled, and therefore you need to do a full rebuild. You can avoid this mostly by precompiling the headers that you are absolutely positive won't change, but then you're giving up a large part of the speed gain as well.
The other problem is that your namespace gets polluted with all kinds of symbols that you don't know or care about in many places where you'd be using the precompiled headers.
When you open a solution in Visual Studio 2008 (or ealier versions for that matter), it opens all the documents that you did not close before you closed Visual Studio. Is there anyway to turn this functionality off, or a plugin that fixes this behavior? It takes forever to load a solution with 50 files open?
Thanks in advance
You can automate the process of closing all the files prior to closing a solution by adding a handler for the BeforeClosing event of EnvDTE.SolutionEvents -- this will get invoked when VS is exiting.
In VS2005, adding the following to the EnvironmentEvents macro module will close all open documents:
Visual Studio 2008 appears to support the same events so I'm sure this would work there too.
I'm sure you could also delete the .suo file for your project in the handler if you wanted, but you'd probably want the AfterClosing event.
Have you tried deleting the .suo file?
It's a hidden file that lives beside your solution (sln) file. suo is "solution user options", and contains your last configuration, such as what tabs you left open the last time you worked on the project, so they open again when you reload the project in Visual Studio.
If you delete it, a new 'blank' suo file will be recreated silently.
ALT-W-L
That's the key combination to close all open tabs, which can be pressed before closing a project, unless you prefer clicking Window | Close All Documents before closing the project.
--Gus
Tools-> Options -> Environment -> Startup
Select "Show empty environment"
I dont think there is an option for this (or I couldnt find one) but you could probably write a macro to do this for you on project open.
This link has some code to close open files which you could adapt: http://blogs.msdn.com/djpark/
I couldnt find the answer to this particular question but a good link for ide tips and tricks is: http://blogs.msdn.com/saraford/default.aspx
Alternative answer:
Before you close your solution, press and hold Ctrl+F4, until all windows have been closed.
VS attempts to save the last known view. Other than the scripts mentioned above you can manually close all documents before exiting VS
What is the best way to version control my database objects? I'm using Visual studio 2005/2008 and SQL server 2005. I would prefer a solution which can be used with SVN.
Same as your other code, add a "Database project" to your application solution and keep the sql files used to build the database objects in there. Use the same version control for those code files as you do for the application.
Look at the tools offered by RedGate. They specifically deal with backup / restore / comparison cases for SQL Server objects including SP's. Alternately I am not sure but I think that Visual Studio allows you to check sp's into a repository. Havent tried that myself. But I can recommend RedGate tools. They have saved me a ton of trouble
I use SVN for all of my table/sproc/function source control.
I couldn't find anything that met my needs so I ended up writing a utility to allow me to dump the code out into a nice directory structure to use with SVN.
For those interested, the source is now available at svn://finsel.com/public/VS2005/GenerateSVNFilesForSQL2005.
We use Subversion and all we do is save the sql code in the directory for our subversion project and then commit the code to the repository when we are ready and update from the repository before we start working on something already in there.
The real trick is to convince developers to do that. Our dbas do that by deleting any stored proc (or other database object) that isn't in Subversion periodically. Lose stuff once and pretty much no one does it again.
I don't know of a pre-packaged solution, sorry...
... but couldn't you just a little script that connected to the database and saved all the stored procedures to disk as text files? Then the script would add all the text files to the SVN repository by making a system call to 'svn add'.
Then you'd probably want another script to connect to the DB, drop all stored procedures and load all the repository stored procedures from disk. This script would need to be run each time you ran "svn up" and had new/changed stored procedures.
I'm not sure if this can be accomplished with MS SQL, but I'm fairly confident that MySQL would accommodate this. If writing SVN extensions to do this is too complicated, Capistrano supports checkin/checkout scripts, IIRC.
Best way - one which works for you.
Easiest way - one that doesn't currently exist.
We use a semi-manual method (scripts under source control, small subset of people able to deploy stored procedures to the production server, changes to the schema should be reflected in changes to the underlying checked in files).
What we should do is implement some sort of source control vs plaintext schema dump diff ... but it generally 'works for us' although it's a really faff most of the time.
We do dumps to plaintext and keep them in our VCS.
You'd be able to script a backup-and-commit to do something similar.
Here is a complete solution: http://blog.boxedbits.com/archives/133 It uses a combination of vbs script and SQL. Works fine for me!
This tool should do it:
I agree that if possible, you should use database projects to version your db along with your application source.
However, if you are in an enterprise scenario, you should also consider using a tool to track changes on the server, and version those changes. Just because the database project exists doesn't mean some admin or developer can't change those sprocs on the server.
I'm using scriptdb.exe from http://scriptdb.codeplex.com/
And it might be usefull to use the rails way: http://code.google.com/p/migratordotnet/wiki/GettingStarted
I strongly disagree with using subversion to source control stored procedures.
What if you had to include DROP and ADD details to every C# file you were working with, in order to "update" the file system it lived in? Ridiculous, right? You don't care how the file is saved, and you certainly don't want the details of how that happens intruding in your code.
And yet, when you use standard source control to version stored procedures, you get into the rank silliness of having to include DROP PROCEDURE and ADD PROCEDURE and GO statements in every godforsaken "file". Irrelevant, cookie-cutter code repeated on such a scale is a strong indicator that something isn't being done right.
Stored procedures are not "files", they are data. And data belongs in a database.
Use versaplex for dumping your schema: http://code.google.com/p/versaplex/
Versaplex comes with Schemamatic, which reads database schema (tables, SPs, etc) and also data (data is dumped as CSV). I use it, with SVN and git, and it's awesome :) If you need help let me know, it's worth a try! http://github.com/eduardok/versaplex
I keep reading about C99 and C++0x and all these totally sweet things that are getting added to the language standard that might be nice to use someday. However, we currently languish in the land of writing C++ in Visual Studio.
Will any of the new stuff in the standard ever get added to visual studio, or are microsoft more interested in adding new C# variants to do that?
Thanks!
Edit: In addition to the accepted answer, I found the Visual C++ team blog:
And specifically, this post in it:
http://blogs.msdn.com/vcblog/archive/2008/02/22/tr1-slide-decks.aspx
Very useful. Thanks!
MS has a series of public replies to this, most of them blaming their users. Like this one:
http://blogs.msdn.com/vcblog/archive/2007/11/05/iso-c-standard-update.aspx
Now, the Visual C++ compiler team receives the occasionally question as to why we haven?t implemented C99. It?s really based on interest from our users. Where we?ve received many requests for certain C99 features, we?ve tried to implement them (or analogues). A couple examples are variadic macros,
long long,__pragma,__FUNCTION__, and__restrict. If there are other C99 features that you?d find useful in your work, let us know! We don?t hear much from our C users, so speak up and make yourselves heard
http://connect.microsoft.com/VisualStudio/feedback/ViewFeedback.aspx?FeedbackID=345360
Hi: unfortunately the overwhelming feadback we get from the majority of our users is that they would prefer that we focus on C++-0x instead of on C-99. We have "cherry-picked" certain popular C-99 features (variadic macros,
long long) but beyond this we are unlikely to do much more in the C-99 space (at least in the short-term).Jonathan Caves
Visual C++ Compiler Team.
This is a pretty sad state of affairs, but also makes sense if you suspect MS wants to lock users in: it makes it very hard to port modern gcc-based code into MSVC, which at least I find extremely painful.
A workaround exists, though: Note that Intel is much more enlightened on this. the Intel C compiler can handle C99 code and even has the same flags as gcc, making it much easier to port code between platforms. Also, the Intel compiler works in visual studio. So by scrapping MS COMPILER you can still use the MS IDE that you seem to think has some kind of value, and use C99 to your hearts content.
A more sensible approach is honestly to move over to Intel CC or gcc, and use Eclipse for your programming environment. Portability of code across Windows-Linux-Solaris-AIX-etc is usually important in my experience, and that is not at all supported by MS tools, unfortunately.
Herb Sutter is both the chair and a very active member of C++ standardisation comitee, as well as software architect on Visual Studio for Microsoft.
He is among the author of the new C++ memory model standardised for C++0x. For example, the following papers:
http://www.open-std.org/jtc1/sc22/wg21/docs/papers/2008/n2669.htm
http://www.open-std.org/jtc1/sc22/wg21/docs/papers/2007/n2197.pdf
have his name on it. So I guess the inclusion on Windows of C++0x is assured as long as H. Sutter remains at Microsoft.
As for C99 only partly included in Visual Studio, I guess this is a question of priorities.
So, would I be Microsoft, why would I implement features few people will ever use when the same features are already offered in more community active languages already used by most people?
C++0x will be included, as extention of VS 2008, or on the next generation (generations?) of Visual Studio.
The C99 features not already implemented won't be in the next years, unless something dramatic happens (a country full of C99 developers appears out of nowhere?)
Apparently, the "country full of C99 developers" already exist: http://blogs.msdn.com/vcblog/archive/2007/11/05/iso-c-standard-update.aspx#6415401
^_^
Still, the last comment at: http://blogs.msdn.com/vcblog/archive/2007/11/05/iso-c-standard-update.aspx#6828778 is clear enough, I guess.
I've been involved in the ISO C++ work (2000-2005), and Microsoft made significant contributions to that language. There's no doubt they will work on C++0x, but they'll need a bit more time than say Intel. Micosoft has to deal with a larger codebase that often uses their proprietary extensions. This simply makes for a longer testfase. Yet, they will support most of C++0x eventually (export still isn't loved though, or so I understand).
When it comes to ISO C, the people working on standard are not representative for Microsofts market. Microsofts customers can use C++98 if they're just looking for a better C. So why would Microsoft spend money on C99? Sure, Microsoft cherry-picked parts, but that's sane business. They'd need those for C++0x anyway, so why wait?
Visual C++ 2008 SP1 contains parts of TR1 at least, and from time to time, the Visual C++ team is blogging or talking about C++0x, so I guess they will support it at some time in the feature. I didn't read anything official though.
Updated information on this:
There is now (10 Nov 2008) a "Community Tech Preview" (CTP) of VS2010 which contains a preview of VC10 that has some parts of C++0x implemented (note that VC10 will not have the full set of C++0x changes implemented even when VC10 is released):
Some details on what's new in the VC10 CTP:
As noted in the above article, "The Visual C++ compiler in the Microsoft Visual Studio 2010 September Community Technology Preview (CTP) contains support for four C++0x language features, namely:"
Microsoft has never expressed any real interest in keeping up-to-speed with the c99-standard (which is getting old by now). Sad for C-programmers, but I suspect that Microsoft cares more for the C++-community.
Herb Sutter is the chairman of the ISO C++ standards body and also works for Microsoft. I don't know about the Visual Studio C standard - mainly because I never use plain C - but Microsoft is sure trying to push the new C++ standard forward. Evidence of this is - like OregonGhost mentioned - the TR1 that is included in the latest Visual Studio Service Release.
MSVC support for C is unfortunately very lacking. It only supports the portion of C99 that is a subset of C++... which means that, for example, it is physically impossible to compile ffmpeg or its libav* libraries in MSVC, because they use many C99 features such as named struct elements. This is made worse by the fact that libavcodec also requires a compiler that maintains stack alignment, which MSVC doesn't.
I work on x264, which unlike ffmpeg does make an effort to support MSVC, though doing so has often been a nightmare in and of itself. It doesn't maintain stack alignment even if you explicitly pass the highest function call through an explicit assembly-based stack alignment function, so all functions that require an aligned stack have to be disabled. Its also been very annoying that I cannot use vararrays either; perhaps this is for the best, since apparently GCC massively pessimizes them performance-wise.
The Visual C++ team did put out a table of C++0x features that the 2010 release supports at http://blogs.msdn.com/b/vcblog/archive/2010/04/06/c-0x-core-language-features-in-vc10-the-table.aspx. Since there can be a lag time between the spec and the implementation, that seems pretty reasonable. Wikipedia has a nice article about the spec. It's not finished at the time I'm writing this.
A more recent post about MSVC's C++11 feature compatibility for MSVC 2010 and 2011 is now online.
I'm doing some Android dev, and I much prefer Visual Studio, but I'll have to use Eclipse for this.
Has anyone made a tool that switches Eclipse to look and behave more like visual studio? I mainly can't stand its clippyesqe suggestions on how I should program (Yes, I know I have not yet used that private field! Thanks Eclipse!), or its incredibly lousy intellisense.
For example, in eclipse, if I don't type "this" first, its intellisense won't realize I want to look for locally scoped members. Also, the TAB to complete VS convention is drilled into my head, and Eclipse is ENTER to complete, I could switch everything by hand but that would take hours, and I was hoping someone had some sort of theme or something that has already done it :)
Have you tried using the Visual Studio keybindings available in Eclipse Ganymede (3.4)?
(You may want to know that "IntelliSense" is a Visual Studio-term, an probably unknown to anyone without Visual Studio-experience. "Autocompletion" is probably a more widely used term.)
If you start typing the name of any class/variable visible in the current scope and hit Ctrl+Space, it'll bring down the autocompletion.
By default, tab is used to move around autocompleted function call arguments.
There are also other choices for Java IDEs. You've obviously found Eclipse, but you also may want to check out IntelliJ and NetBeans. IntelliJ is not free, but has a 30 day evaluation period and a Visual Studio key map :)
Shop around, find one that you like and start to use it heavily. They are all very good IDEs, and I'm sure once you use one for a while you'll get comfortable with it.
I'm gonna play devils advocate here and say that forcing you to use this.myString is actually much safer than just myString. myString could be defined locally (in the method) or in the class as a private member. I sometimes think VS is a bit cavalier about this. In the sample you mention (I saw the video but it was illegible) where is myString scoped?
Greetings.
I have a little dilemma on how to set up my visual studio builds for multi-targeting.
Background: c# .NET v2.0 with p/invoking into 3rd party 32 bit DLL's, SQL compact v3.5 SP1, with a Setup project. Right now, the platform target is set to x86 so it can be run on Windows x64.
The 3rd party company has just released 64 bit versions of their DLL's and I want to build a dedicated 64bit program.
This raises some questions which I haven't got the answers to yet. I want to have the exact same code base. I must build with references to either the 32bit set of DLL's or 64bit DLL's. (Both 3rd party and SQL Server Compact)
Can this be solved with 2 new sets of configurations (Debug64 and Release64) ?
Must I create 2 separate setup projects(std. visual studio projects, no Wix or any other utility), or can this be solved within the same .msi?
Any ideas and/or recommendations would be welcomed.
/M
Yes, you can target both x86 and x64 with the same code base in the same project. In general, things will Just Work if you create the right solution configurations in VS.NET (although P/Invoke to entirely unmanaged DLLs will most likely require some conditional code): the items that I found to require special attention are:
The assembly reference issue can't be solved entirely within VS.NET, as it will only allow you to add a reference with a given name to a project once. To work around this, edit your project file manually. After adding a reference to, say, the x86 version of an assembly, your project file will contain something like:
<Reference Include="Filename, ..., processorArchitecture=x86">
<HintPath>C:\path\to\x86\DLL</HintPath>
</Reference>
Wrap that Reference tag inside an ItemGroup tag indicating the solution configuration it applies to, e.g:
<ItemGroup Condition=" '$(Configuration)|$(Platform)' == 'Debug|x86' ">
<Reference ...>....</Reference>
</ItemGroup>
Then, copy and paste the entire ItemGroup tag, and edit it to contain the details of your 64-bit DLL, e.g.:
<ItemGroup Condition=" '$(Configuration)|$(Platform)' == 'Debug|x64' ">
<Reference Include="Filename, ..., processorArchitecture=AMD64">
<HintPath>C:\path\to\x64\DLL</HintPath>
</Reference>
</ItemGroup>
After reloading your project in VS.NET, the Assembly Reference dialog will be a bit confused by these changes, and you may encounter some warnings about assemblies with the wrong target processor, but all your builds will work just fine.
Solving the MSI issue is up next, and unfortunately this will require a non-VS.NET tool: I prefer Caphyon's Advanced Installer for that purpose, as it pulls off the basic trick involved (create a common MSI, as well as 32-bit and 64-bit specific MSIs, and use an .EXE setup launcher to extract the right version and do the required fixups at runtime) very, very well.
You can probably achieve the same results using other tools or the Windows Installer XML (WiX) toolset, but Advanced Installer makes things so easy (and is quite affordable at that) that I've never really looked at alternatives.
One thing you may still require WiX for though, even when using Advanced Installer, is for your .NET Installer Class custom actions. Although it's trivial to specify certain actions that should only run on certain platforms (using the VersionNT64 and NOT VersionNT64 execution conditions, respectively), the built-in AI custom actions will be executed using the 32-bit Framework, even on 64-bit machines.
This may be fixed in a future release, but for now (or when using a different tool to create your MSIs that has the same issue), you can use WiX 3.0's managed custom action support to create action DLLs with the proper bitness that will be executed using the corresponding Framework.
Edit: as of version 8.1.2, Advanced Installer correctly supports 64-bit custom actions. Since my original answer, its price has increased quite a bit, unfortunately, even though it's still extremely good value when compared to InstallShield and its ilk...
Let's say you have the DLLs build for both platforms, and they are in the following location:
C:\whatever\x86\whatever.dll
C:\whatever\x64\whatever.dll
You simply need to edit your .csproj file from this:
<HintPath>C:\whatever\x86\whatever.dll</HintPath>
To this:
<HintPath>C:\whatever\${Platform}\whatever.dll</HintPath>
You should then be able to build your project targeting both platforms, and MSBuild will look in the correct directory for the chosen platform.
Not sure of the total answer to your question - but thought I would point out a comment in the Additional Information section of the SQL Compact 3.5 SP1 download page seeing you are looking at x64 - hope it helps.
Due to changes in SQL Server Compact SP1 and additional 64-bit version support, centrally installed and mixed mode environments of 32-bit version of SQL Server Compact 3.5 and 64-bit version of SQL Server Compact 3.5 SP1 can create what appear to be intermittent problems. To minimize the potential for conflicts, and to enable platform neutral deployment of managed client applications, centrally installing the 64-bit version of SQL Server Compact 3.5 SP1 using the Windows Installer (MSI) file also requires installing the 32-bit version of SQL Server Compact 3.5 SP1 MSI file. For applications that only require native 64-bit, private deployment of the 64-bit version of SQL Server Compact 3.5 SP1 can be utilized.
I read this as "include the 32bit SQLCE files as well as the 64bit files" if distributing for 64bit clients.
Makes life interesting I guess.. must say that I love the "what appears to be intermittent problems" line... sounds a bit like "you are imagining things, but just in case, do this..."
Regarding your last question. Most likely you cant solve this inside a single MSI. If you are using registry/system folders or anything related, the MSI itself must be aware of this and you must prepare a 64bit MSI to properly install on 32 bit machine.
There is a possibility that you can make you product installed as a 32 it application and still be able to make it run as 64 bit one, but i think that may be somewhat hard to achieve.
that being said i think you should be able to keep a single code base for everything. In my current work place we have managed to do so. (but it did took some juggling to make everything play together)
Hope this helps. Heres a link to some info related to 32/64 bit issues: http://blog.typemock.com/2008/07/registry-on-windows-64-bit-double-your.html
You should use the Configuration Manager to handle compiling the two different versions of your P/Invoke calls. However, you will not be able to do what you'd like with a single MSI.
From How to: Create a Windows Installer for a 64-bit Platform (emphasis added):
64-bit MSI packages can support both 32- and 64-bit DLLs or EXEs to perform custom actions; however, 32-bit MSI packages cannot support 64-bit DLLs or EXEs to perform custom actions.
...
To distribute a .NET Framework application both to 32- and 64-bit platforms, build two MSI packages, one targeted at a 32-bit and the other a 64-bit computer. The user can install the 32-bit setup project package and it will most likely run as a 64-bit application, only the 64-bit setup project will install to the "Program Files64" directory.
If you use Custom Actions written in .NET as part of your MSI installer then you have another problem.
The 'shim' that runs these custom actions is always 32bit then your custom action will run 32bit as well, despite what target you specify.
More info & some ninja moves to get around (basically change the MSI to use the 64 bit version of this shim)
Building an MSI in Visual Studio 2005/2008 to work on a SharePoint 64
For the most part you just take whatever Visual Studio sets it for you as a default.. I'm referring to the BuildAction Property for each file selected in your solution explorer. There are a number of options and its difficult to know what each one of them will do.
From the documentation:
The BuildAction property indicates what Visual Studio does with a file when a build is executed. BuildAction can have one of several values:
None - The file is not included in the project output group and is not compiled in the build process. An example is a text file that contains documentation, such as a Readme file.
Compile - The file is compiled into the build output. This setting is used for code files.
Content - The file is not compiled, but is included in the Content output group. For example, this setting is the default value for an .htm or other kind of Web file.
Embedded Resource - This file is embedded in the main project build output as a DLL or executable. It is typically used for resource files.
I got a few... I know I'll stand vote-corrected if I falter.
Page -- Takes the specified XAML file, and compiles into BAML, and embeds that output into the managed resource stream for your assembly (specifically AssemblyName.g.resources), Additionally, if you have the appropriate attributes on the root XAML element in the file, it will create a blah.g.cs file, which will contain a partial class of the "codebehind" for that page; this basically involves a call to the BAML goop to re-hydrate the file into memory, and to set any of the member variables of your class to the now-created items (e.g. if you put x:Name="foo" on an item, you'll be able to do this.foo.Background = Purple; or similar.
ApplicationDefinition -- similar to Page, except it goes onestep furthur, and defines the entry point for your application that will instantiate your app object, call run on it, which will then instantiate the type set by the StartupUri property, and will give your mainwindow.
Also, to be clear, this question overall is infinate in it's results set; anyone can define additional BuildActions just by building an MSBuild Task. If you look in the %systemroot%\Microsoft.net\framework\v{version}\ directory, and look at the Microsoft.Common.targets file, you should be able to decipher many more (example, with VS Pro and above, there is a "Shadow" action that allows you generate private accessors to help with unit testing private classes.
My favourite new Build action is SplashScreen! Read more about it here.
In VS2008, the doc entry that seems the most useful is:
Windows Presentation Foundation Building a WPF Application (WPF)
ms-help://MS.VSCC.v90/MS.MSDNQTR.v90.en/wpf_conceptual/html/a58696fd-bdad-4b55-9759-136dfdf8b91c.htm
ApplicationDefinition Identifies the XAML markup file that contains the application definition (a XAML markup file whose root element is Application). ApplicationDefinition is mandatory when Install is true and OutputType is winexe. A WPF application and, consequently, an MSBuild project can only have one ApplicationDefinition.
Page Identifies a XAML markup file whose content is converted to a binary format and compiled into an assembly. Page items are typically implemented in conjunction with a code-behind class.
The most common Page items are XAML files whose top-level elements are one of the following:
Window (System.Windows..::.Window).
Page (System.Windows.Controls..::.Page).
PageFunction (System.Windows.Navigation..::.PageFunction<(Of <(T>)>)).
ResourceDictionary (System.Windows..::.ResourceDictionary).
FlowDocument (System.Windows.Documents..::.FlowDocument).
UserControl (System.Windows.Controls..::.UserControl).
Resource Identifies a resource file that is compiled into an application assembly. As mentioned earlier, UICulture processes Resource items.
Content Identifies a content file that is distributed with an application. Metadata that describes the content file is compiled into the application (using AssemblyAssociatedContentFileAttribute).
I work on a small web team where I am the only .NET developer currently using Visual Studio 2008 Professional to build and maintain a few web applications. I am about to start training another member of our team so we purchased him a copy of Visual Studio 2008 Professional. I've looked into Visual Source Safe, but I'm dubious. I don't like that is file system based. Ideally, the system would work with SQL Server 2005 and plug into Visual Studio. Windows based solutions are the best because of the IT environment of the organization I work for.
What are my options for a source control system?
(Forgive me if the answer exists in another thread.)
Subversion has good integration with Visual Studio 2008 through VisualSVN and Ankh.
SourceSafe is dangerous. You're right that a filesharing-based SCM is a bad idea, and Microsoft themselves have downplayed it and replaced it with a new SCM that comes with the Team edition of Visual Studio.
I can't believe nobody has mentioned SourceGear Vault. It stores your code in SQL Server, integrates extremely well into VS, and is an excellent replacement/alternative to Source Safe. Since their single-user license is free, I even use it when coding at home. Plus, it's the company founded/run by Eric Sink.
Has any body given Git any thought? There is a very usable solution for windows called GitExtensions here. It integrates with Visual Studio Proffessional trough an extra menu and optional toolbar. Unlike Subversion, Git is distributed, which means you can commit locally to your copy of the repository, and afterwards push the changes to the server. The bottom line? Git is FAST! It's storage is also more efficient than subversion, which means your repository takes up less space.
Subversion. Free. Visual SVN is a great add on, and is fairly inexpensive.
Definitely, as most people says, Subversion + VisualSVN.
VisualSVN is a fairly cheap addon at $49, subversion is free and very stable. We use that for teams of 10-15 people and it works really well for us. The only con is that it is file-system based.
On the other hand, if you have a very specific need for it not to be on the file system i would NOT recommend Visual Source Safe, on my last job we had a lot of trouble with it and lost precious days of work. If you want to go that way get something like sourcegear vault which is database based. There is also Team Foundation Server from Microsoft but I believe it is really expensive (and heavy) for small teams.
Microsoft's Team Foundation Server integrates fully into VS2008 and uses SQL Server for its back end. The downside is that it's a very expensive solution.
We switched over from SourceSafe to tfs recently and have found it to work quite capably.
The only notable exception in features we exercised is file linking.
To keep the costs down, we make sure that we get the Gold Certified Partner status.
Visual SVN might work for you, it is supposed to integrate well and is relatively cheap at ~$50 per license. I've been considering buying it myself, so far I just use Tortoise SVN as I do relatively little non-Eclipse work right now.
Why not use a SVN server? That way, all your developers can use it, and there is a very good free Windows Client for it (TortoiseSVN). You can integrate SVN support with TortoiseSVN into Visual Studio with VisualSVN, which is commercial, but not actually expensive.
I recommend subversion, coupled with AnkhSVN, a plugin (Free!) that integrates Subversion with the Visual Studio IDE.
If you use the svnserve distribution that's free from CollabNet (Windows binaries: here), setup is very simple. Administration is very easy. And the product works very well.
It is still file-system based, but that isn't really a problem. Make sure that you back-up regularly, both full dumps and hot-copies (both of which are explained in detail in the documentation).
Team Foundation Server does satisfy your requirements of working with SQL Server, but is probably overkill for such a small development team.
I would recommend using Subversion (free) for source control along with VisualSVN ($49) for the visual studio integration. There is also an excellent Subversion client for windows explorer called TortoiseSVN, which is awesome.
The nice thing about giving something like Subversion a try is that it is free and very easy to set up. It will also scale up to a pretty large team. It is worth a shot before investing effort in MSFTs Team Foundation Server.
Visual Source Safe has a bad rap from it's earlier incarnations. They came out with a new version in 2005, and it solves many of the problems of earlier versions. I don't think they've solved the branching problems though. They have a client/server portion now (well, it's http based) so that solves some of the remote issues.
SVN is probably a better solution, but VSS isn't as bad as it once was.
Which Visual Studio Color Theme do you use?
Do you find that the darker themes work best for you? Do they help ease your eye strain?
What is your favorite color theme & where can I get it?
I use Ragnarok Blue
Visual Studio
SQL Management Studio
that theme and others can be found here: http://winterdom.com/weblog/2007/11/22/VS2008ColorSchemes.aspx
Scott Hanselmans's blog about Visual Studio Programmer Themes Gallery
Out of that big list in the blog, I like the bellow theme
My eyes have been a lot happier since I switched to zenburn after reading Jeff's post.
http://www.iunknown.com/2007/06/vibrant_ink_vis.html
Helped my eye strain, but is a personal pref for sure.
I have a homebrew theme.. nothing special except for one thing: I make literals (strings and numbers) really pop out to remind me/encourage me not to hardcode things.
I find dark color schemes strain my eyes more than those with a white/light background. I took Jeff Atwood's variation (Is Your IDE Hot or Not?) and tweaked the colors a bit for my liking.
I've concluded that a black background works best because I can perceive a wider variety of colors, which is useful for me since Visual Studio lets you color a variety of different things (giving different colors to struct, class, and interface types, for instance). Somehow, it seems harder to distinguish small color differences on a white background than black.
But don't take my word for it. Take a look and make up your own mind:
http://loyc-etc.blogspot.com/2008/09/bitstream-vera-sans-mono-bold.html
I like dark themes with black or some dark gray background. To much light that white background generates causes me eye strain.
Also WPF antialiasing looks much better on dark background. Text is too blurry on white background.
I prefer dark themes, and use a variant of this one. It definitely helps with the eye strain. Unfortunately you can't seem to theme all the Visual Studio windows consistently which makes things look a little garish.
I also switch all the console windows to a dark green text on black background to reduce 'glare'.
I use my own custom themes, which i call "Elements". I've put Elements Blue up at Studio Styles, and here's the link: http://studiostyles.info/schemes/elements-blue . I recommend Consolas 11pt font.
I use a port of vim's oceandeep - the background's actually blue, not black. There's a whole bunch of schemes listed here if you want to roll your own from the .vim configs.
I agree with muloh. Do you know that black text on white background is more contrast (read as it is more readable) than white text on black background. Dark themes may be useful if you like to work in the evening but not in the middle of the day. Your eyes take information not only from a screen but also from other space in your room and if your room is in light colors but your screen is in dark then your eyes must be harder to distinguish items on your display. Your eye is like a photo camera in auto mode - it must define values for contrast/brightness settings - so it is better for it when all surface has the same values - in this case it doesn't do any work to change focus on another object.
One more problem with VS dark themes - it is impossible to change color for Solution Explorer for example! You can only hide it when you coding. But again - if you need to open another file you must open Solution Explorer and "bang!" background is changed from dark (your pupils are big) to white (they must to do something to get smaller - its a pain for them).
Wish you be healthy
Here is the nicest collection of color schemes for Visual Studio. Light and Dark are both represented http://www.hanselman.com/blog/VisualStudioProgrammerThemesGallery.aspx
I created a theme inspirated in Github: http://studiostyl.es/schemes/like.
You haven't PIMPed out your IDE completely, if you haven't themed it. Colors and Fonts for the text editor is available in studiostyl.es, but the toolbars and toolboxes can be customized with this :
I would like to distribute my .NET programs without the .NET framework. Is it possible to compile a .NET program to machine code?
Yes, you can precompile using Ngen.exe, however this does not remove the CLR dependence.
You must still ship the IL assemblies as well, the only benefit of Ngen is that your application can start without invoking the JIT, so you get a real fast startup time.
According to CLR Via C#:
Also, assemblies precompiled using Ngen are usually slower than JIT'ed assemblies because the JIT compiler can optimize to the targets machine (32-bit? 64-bit? Special registers? etc), while NGEN will just produce a baseline compilation.
EDIT:
There is some debate on the above info from CLR Via C#, as some say that you are required to run Ngen on the target machine only as part of the install process.
Remotesoft has one: Salamander .NET Linker
I don't have any experience with it though.
There are some third party tools that do this, e.g.
Another (expensive and proprietary, licenses start at $1599) product that can do this is Xenocode Postbuild. Haven't used it myself though, with it costing about the gross national product of a small African country and all...
I don't think that it is possible. You can make a prejitted assembly but you still need the framework.
If you just concerned with the size of deploying the Framework, you might read up on this.
Is it possible to compile .NET IL code to machine code?
Yes, but the .NET Framework does it for you at runtime (default) or at install time (ngen). Among other reasons, this IL -> machine code is done separately on each install machine so it can be optimized for that particular machine.
I would like to distribute my .NET programs without the .NET framework. Is it possible to compile a .NET program to machine code?
No, for all intents and purposes you cannot do this. The 3rd party workarounds may work in some scenarios, but by then I wouldn't really consider it "managed code" or ".NET" anymore.
There is IL2CPU for the compilation part.
I think you should not: That's the task of the JIT compiler.
However, you could use ClickOnce or Windows Installer to deploy it so that the missing framework isn't such a big problem: you could tell the installer to download the Framework and install it.
I'd always thought it would be cool to compile c# to machine code directly without the CLR dependency though....
Look at MONO project: mono command with --aot option. http://www.mono-project.com/AOT
Quite simply, no.
I know I can compile individual source files, but sometimes -- say, when editing a header file used by many .cpp files -- multiple source files need to be recompiled. That's what Build is for.
Default behavior of the "Build" command in VC9 (Visual C++ 2008) is to attempt to compile all files that need it. Sometimes this just results in many failed compiles. I usually just watch for errors and hit ctrl-break to stop the build manually.
Is there a way to configure it such the build stops at the very first compile error (not the first failed project build) automatically?
I came up with a better macro guys. It stops immediately after the first error/s (soon as build window is updated).
Visual Studio -> Tools -> Macros -> Macro IDE... (or ALT+F11)
Private Sub OutputWindowEvents_OnPaneUpdated(ByVal pPane As OutputWindowPane) Handles OutputWindowEvents.PaneUpdated
If Not (pPane.Name = "Build") Then Exit Sub
pPane.TextDocument.Selection.SelectAll()
Dim Context As String = pPane.TextDocument.Selection.Text
pPane.TextDocument.Selection.EndOfDocument()
Dim found As Integer = Context.IndexOf(": error ")
If found > 0 Then
DTE.ExecuteCommand("Build.Cancel")
End If
End Sub
Hope it works out for you guys.
This can be done by adding a macro that is run in response to the event OnBuildProjConfigDone.
The macro is as follows:
Private Sub BuildEvents_OnBuildProjConfigDone(ByVal Project As String, ByVal ProjectConfig As String, ByVal Platform As String, ByVal SolutionConfig As String, ByVal Success As Boolean) Handles BuildEvents.OnBuildProjConfigDone
If Success = False Then
DTE.ExecuteCommand("Build.Cancel")
End If
End Sub
Yeah, this works fine on MSVC 2005-2010:
Public Module EnvironmentEvents
Private Sub OutputWindowEvents_OnPaneUpdated(ByVal pPane As OutputWindowPane) Handles OutputWindowEvents.PaneUpdated
If Not (pPane.Name = "Build") Then Exit Sub
Dim foundError As Boolean = pPane.TextDocument.StartPoint.CreateEditPoint().FindPattern(": error")
Dim foundFatal As Boolean = pPane.TextDocument.StartPoint.CreateEditPoint().FindPattern(": fatal error")
If foundError Or foundFatal Then
DTE.ExecuteCommand("Build.Cancel")
End If
End Sub
End Module
There is this post http://stevenharman.net/blog/archive/2008/01/17/visual-studio-tip-kill-that-build.aspx not sure if it stops the build at the first error or the first failed project in a solution.
Ctrl-break will also stop it manually.
Now if there was some way to stop it spending 10mins rebuilding intelisense after a build failed!
I'm looking to pick up either C# or VB.Net. I'd done a fair bit of VB6 programming in the past.
I'm looking at getting the book, Visual Basic .NET or C#, Which to Choose? but I'm hoping that someone has read it, or used both languages and can offer advice.
Should I just RTFB?
Edit: Anders Sandvig raised a valid question. I'm intending to develop ActiveX applications that will be served through IE.
Edit: Given that the functionality is pretty close and my favored approach to learning is to "just build it" and solve problems by looking it up on the internet, I've decided that the choice of language will be based on how easy it is to learn it. I looked around and found sites like C# Corner that supports my approach. Personal note: I wish I could also select Seb Nilsson's response as an accepted answer as well.
Thanks guys for your input!
Alright, then! I admit, theoretically, this topic is subjective; but a quick tally of answers seems to skew votes heavily in C#'s favor. Anyway, I'm really after experiences like what Keith's alluding to. I'm hoping he'll return to this topic and drop us a few more gems.
The main reason would be that C# is very similar to other languages, such as C++, Java and even JavaScript. So if you know any of those languages you'll already have a bonus and if you don't, you can probably learn those languages easier.
C# is a bit more compact, has a few more easy-accessible features, such as Extension Methods and Attributes, which are a bit cumbersome in VB.NET.
VB.NET got XML literals, which C# doesn't. Otherwise, I can't see any other advantage to VB.NET.
Personal answer: I started out in VB.NET, but that felt like I was coding... But going to C# felt more like I was developing. Went from copying and changing gaps of code, to actually understanding the concept of developing. Again strictly personal.
I use both a lot. I massively prefer C#, but VB.Net has some good points.
If you're working with COM VB.Net has some real advantages. Otherwise C# gives more 'precise' control - it has fewer implicit conversions and the like. C# is also more terse and is regarded by many as the more professional language - while that view is not accurate enough people hold it for C# to be worth more on your CV.
To be honest it doesn't really matter - the syntax of either is a day or two to learn. All the important stuff is common to both of them. Learn C# and you can pick up VB.Net in a day or two, and vice versa.
Don't waste your money on an entire book on the topic - it's gotta be mostly filler.
I agree with everybody else when they say this is a subjective topic. You can do .NET with either language. Here is what nobody seems to tell newcomers:
Knowing C# will pay more than VB.NET!
I had about 5 years experience with VB, before I moved to VB.NET. I learned C# while on a contract fixing some legacy VB6 code. My salary and contract rates jumped quite a bit since then.
So on paper both look good, but in the market place, you will get more money by knowing C#.
I've used both.
They are practically exactly the same to use, with VB.NET slightly more catered to a more novice audience (due to the verbose nature of the language), and C# slightly more catered to a more mature developer (due to the syntax similarities to Java and the C/C++ languages). Apart from that there is no discernible difference, although C# will get slightly more money out in the industry.
As has already been mentioned (and this is the most important point), they use the same underlying framework, so you will be able to switch between the two with minimal fuss. So for all intents and purposes, just choose whichever you feel the most comfortable with.
Yes it's subject, but it seems like many people are afraid to give their opinion to the question. I don't think we are being helpful by simply saying "it's subjective" and closing the door on the question.
So here's my take...
There's no correct answer but if I were in that situation today I would choose C#
I've had to do projects in both and VB.Net seem a little to wordy for me, but with no benefit that I can discern.
They both use the same exact libraries and compile to very similar bytecode/MSIL. They both are built using the same processes in the same environment. So yes, the differences aren't much.
Another small point is that I tend to see more examples and literature in general in C# than VB.Net. Again, this is a single person's point of view. If anyone has experienced differently I'd like to hear.
Wikipedia is a good resource to start with on this topic. It has an extensive article on The Comparison Between C# and VB.Net. An interesting read at least.
In the end, whatever you choose, you'll be able to switch in the future.
I know this will be viewed as heretical to acknowledge, but deep down, VB.NET and C# are really the same language. The differences are almost entirely syntactical, and unless you are involved in a bizarre edge case, you can get the job done just as efficiently in one as another. Translating between them is trivial, and there are plenty of mechanical translators out there to prove how easy it is.
So, the choice really comes down to syntactic preference. You say that you come from VB6; this would suggest that in your case, VB.NET would be the easy choice. On the other hand, if you are comfortable reading "curly-brace" languages like C or Java, then C# is a good choice.
Personally, I like VB.NET, as I think the verbosity makes programmer intent a bit clearer.
Once you learn the framework, it really does not matter what language you choose. Initially you will probably be more comfortable in VB. It still heavily caters to newer developers and developers "just trying to get the job done."
I personally develop my class libraries and frameworks in C#, and do all my UI development in VB. It takes some getting used to, but I enjoy the freedoms both languages offer.
While you are trying to learn the framework, use what is most comfortable and then extend your knowledge with the other syntax.
If possible, both :)
If just one, then I'd go with C# myself. If you use the feature that Visual Studio 2008 added to be able to download the source for reference, you'll notice that it is written in C#. There isn't anything that you won't be able to do in C# that you can't do in VB.NET.
That being said...
As of today, there are features in C# that take more work to do in VB.NET. They do not have parity on one to one features.
For example, C#'s support for lambdas and anonymous delegates is currently far better than VB.NET's.
As of today, the two below statements are impossible to do in VB.NET:
List<string> vals = new List<string>();
vals.ForEach(val =>
{
val = val.ToUpper();
Console.WriteLine(val);
});
Or simply:
vals.ForEach(val => Console.WriteLine(val));
The reason for this is that the first lambda has multiple statements which isn't supported in VB.NET yet. The second is not possible in VB.NET yet because all lambdas must return a value. Also, VB.NET doesn't yet support iterators via a yield statement.
Now, that being said, VB.NET has the XML Literals support that C# doesn't have either. Let me tell you, if you work with XML, the XML Literals support might make me sway back to VB.NET over C# :)
Consider also that Paul Vick has posted articles (see here or here) that make it look like VB.NET will be adding features to bring VB.NET back to feature parity with C#.
And... if you don't care about any of these functional features... well, flip a coin then :)
Do not forget that there are free versions of both C# and VB available from Microsoft (Visual Studio Express) so it is easy to run sample code and see how each language works.
I've been using VB and VB.NET for almost 12 years. Check out the job market. I see there are about two to three times more jobs available coding C# over VB.NET. VB has seen a steady decline over the years and C# is starting to become the norm for .NET development. I hate to part with VB, but the job market is making the choice for me.
This is a pretty subjective topic. If you feel comfortable with VB, you might want to stick with VB.NET. If you want to try out another language, try C#. C# is also highly productive like VB.
I have used VB6 in the past but chose to code in C++ for speed. C++ was horrible for UI though. Then came C#, which made me enjoy writing windows apps as well as keeping familiarity to C++.
It's all down to your preferences imho. If you're looking for a kick, I suggest you try a bit of both to see which suits you best.
Learn C#. You need a clean break from VB6, otherwise you'll be tempted to keep using the legacy functions. That's not to say that they don't work, but that a lot of VB6's functions fell into the pit of failure - they tended to perform peculiarly in the face of changing circumstances, or just have weird semantics generally.
Once you get all of VB.NET's Option Strict options turned on, to make VB predictable rather than a mass of surprising implicit conversions, it becomes very verbose.
Since you had a little bit of VB background I would say go for VB .NET, it Will be easier to learn...
RWendi
If I were you, I'd pick up a language that's as radically different from what I already know as possible. A second language should, IMO, be a break, not a continuation, from the first - or you'll get way too stuck up on your habits as a programmer.
Try Erlang or Ruby or Assembler, perhaps.
Then, with new perspective, return to the question.
Can you give more details about those ActiveX apps? How urgent are they, who are they for, what do they do?
I had VB 3,4,5,6 experience, but when I switched to .NET, I sticked with C#. I never looked back. I don't like the verbosity of VB.
But in terms of features, in the end there's almost nothing you can't do in either, albeit with some small differences.
If you want my opinion (and you asked for it), I'd say go for C#. In the future, if you need to change to Java, C, C++, etc., you might find that code easier to understand.
But the truth behind .NET is not C# or VB, but .NET Libraries. Learn how to move in those and you'll be ok.
Learn both.
In their current (.NET 3.5) incarnations, VB .NET is better for working with XML, whereas C# is better for working with lambda expressions. You can use an assembly built with one in an assembly built with the other. So you can use both in the same overall solution.
Why not, then, use the best language for the job? Plus, speaking of jobs, you'll have access to more jobs if you know both languages.
Now here's the stupid part. If you're applying for a VB .NET job, put both languages on your resume. But if you're applying for a C# job, leave the VB .NET off. I've actually been rejected occasionally for a C# job simply for knowing VB .NET; the company seemed to think it'd be better to know only C# than to know both. VB .NET still has the stigma.
On the other hand, maybe it's just as well not to work at a place like that.
I'd recommend both. Start with whichever you have a solid background with. I've got a few years of VB.NET under my belt, and find it a little annoying that when I go to look up help topics for .NET or ASP.NET, just about everything is in C#, so you end up having to learn a bit about C# regardless. I found this wonderful conversion tool from Developerfusion to be very useful. It isn't always correct, but it's very handy.
One thing to consider is the available community support.
The arguments either way all make sense. However, issue I don't see mentioned here is the level of community support. In my very subjective personal experience, I would say that there is probably at least twice as much advice/examples/blogging/etc for C# than there is for VB.NET.
I started with VB.NET, but found myself forced to start picking up the C# syntax, etc, because so much of the sample code I saw was in C#. Eventually, I moved (evolved?) to 100% C# for writing .NET-based code. I couldn't/wouldn't go back though VB.NET does still have some nice conveniences that I miss.
This is much too subjective. It really depends on what your background is. You can pretty much do the same in both. Each langugae has a few special features, like VB.NET having inline XML in code.. I prefer C# though as I have better familiarity with C style languages.
EDIT: And of course you will get lots of biased answers with this question which DOESNT HELP you one little bit.
If you want to get up and running as quickly as possible, choose VB.net. You already know VB and that will help you greatly.
However, if you want to be more flexible, choose C#. This language is closer to other popular programming languages (such as Java) while VB.Net is more a "dead-end". I would also claim that it is easier to get good jobs if you know C# and easier to get help on sites such as StackOverflow.
Also, if you learn C# and already know VB, you will more or less dominate VB.Net as well without further effort.
Finally, remember that the big decision you've made isn't to learn a new language; it's to learn a new API/framework. I think you will find that to be a wise and productive choice.
Good luck!
I've also used both. I started out using VB6 for many years, before moving on to VB.net. Once I'd gotten used to using VB.net for about a year, I decided to try out C#. Since then I haven't looked back.
My favourite part about using C#, is of course the for loops. In C#, they are much more powerful, with the same syntax as C, Java, et cetera. In VB.net, one is pretty much limited to doing things like
For i = 0 To 9 Step 2
...
Next
For i = 9 to 0 Step -1
...
Next
Whereas in C#, one can do something along the lines of
for(i = 1; i < 129; i*= 2) {
...
}
Which allows a sequence: 1, 2, 4, 8, 16, which is quite neat. In VB one would have to do something like
i = 1
While i < 129 : i *= 2
...
End While
Which is a bit more verbose, and harder to follow.
There are a lot of niceties like that in C style language.
I've also found, after a few years of using C#, that it is a lot easier to follow a page of code. Because it is less verbose and more compact, I can scan, and understand lines a lot faster than I could in VB.
It's also useful for the reason that there are a lot more code samples available in C# than there are in VB.net. This was also one of my factors in switching. I used to find examples in C#, then I'd translate them into VB, which did give me a bit of experience in using two different languages, and after having to do that for a while, it was fairly easy to switch over.
As for actually benefits in what kind of program could be produced, I found there to be little difference. They are both just as powerful, but these days I simply prefer C#, because it's easier to read, and I can do a lot of things with less typing. Things that annoyed me, such as the lack of nice VB shortcuts such as
text = InputBox("Enter some text")
In C#, it required me to make my own InputBox class. Alternatively I could have imported the VB library, and done it that way.
Also, VB had nice things like
text = Left(Value, 3)
In C# one would have to write
text = value.SubString(0, 3);
But that didn't take too much getting used to.
Anyway, my personal recommendation would be to try out C# at first, and if you don't like it, you can always switch to VB.net without much effort.
As stated already, it is very subjective.
Since you have worked with VB6 you will have an easier time with syntax in VB.Net. However, they had to make changes between VB6 and VB.Net to make it work as a .Net language and play nice with C#.
I have used both and always prefer to work with C#, but I came to .Net from Java.
The biggest reason I would suggest C# is the similarity to other languages, this isn't an advantage just when you already know one of the other languages, but if you decide to expand beyond C#.
It's completely subjective, but in the realm of career enhancement, C# is the better to learn. On average, the salaries of C# developers are slightly higher than those of VB.NET developers. On just that fact along C# is a bit higher on the scale of things to learn. VB.NET tends to be a bit more verbose, but I think it's not very difficult to learn both. And flexibility in the languages you know would be even more helpful. Besides, they use the same framework, so it's not that big of a stretch to gain knowledge and understanding of both languages.
If you are concerned with backwards compatibility you might want to consider VB.Net. Though personally I would recommend switching to c#!
C#
The change from VB6 to VB.NET is not a minor one anyway. If you now learn C#, you will be able to ick up VB.NET "on the fly". Diverse skills = better.
The language you choose honestly does not matter as long as you understand the logic behind programming. If you understand the logic, you can use pretty much any language. It really comes down to what you need out of the programming language; VB.Net has better uses for some applications, where C# is better used for others.
If you are looking for an easy transition that I would stick with VB.net because you already have VB experience. If you are looking to broaden your horizons though C# may be better to learn.
Hope this helps you, but it really does not matter what language you learn as long as you learn the logic behind programming.
i would say go with C#, it's syntax closely resembles that of other languages like PHP and Java.
Language choice, in the absence of other factors, should be dominated by the following:
Learning a computer language is the easy bit. The tough part is maintaining code.
I don't know the specifics about C# or VB.net but I would presume C# offers the best of both.
Both have pros and cons.
I think C# is the more common language as it's syntax looks very similar to other popular languages including C++, Java, and many more so when searching for code examples it will be easier for you to find and understand even code from a language you're not fluent with.
Also, in today market there are many more C# jobs than VB.NET.
Now ask me personally,
I like VB.NET (VB10) way more than C#, it covers all the C# features and has some crucial features C# doesn't have (XML literals, Strict Off, type cast built in the language and more).
Even I have more experience with C# than with VB, and even vb is indeed more verbost with its syntax, it's not strict as C#, in VB, for example, you could write (don't! never!):
Dim x As Integer = "5"
Dim b As Boolean = 0
Dim s As String = b
And many more, and it's OK with the compiler (and remember that this is not a cast but a conversion!), in common VB syntax you don't specify type and you rely on type inference (Dim x = "String", no "As String") and many more examples that is caused by C#'s strictness, which by the end makes VB even less robust, maybe some wouldn't agree with me, and maybe I am not 100% right, but think about it, there is a point.
And I am telling you all that as an experienced C# and VB dev, for me, both are just the same language, you can do with each one the same in either way.
But again, that's my personal POV.
So bottom line, if you want to develop your own projects or if you're a lazy programer that wants the code do more for you (casting?), consider VB.NET (also then consider that the code-examples), otherwise (if you wanna get hired) learn C#.
You might also want to take a look at Comparison of C# and VB.NET at Wikipedia.
Anyway, for COM and interoperability, VB is way better, for example consider these two lines (each line is amazing for itself):
Dim xlApp = CreateObject("Excel.Application", "\\MyServer") 'Returns Object
Dim appVersion = xlApp.Version 'Note that there is no need for reflection!
Although in the new C# this can be done with dynamic, it's still much more robust.
(Dissenting opinion)
Case for VB.NET
- The code window dropdowns
Lists every control on your page and allows you to generate an event handler. No such construct in C#.
- Handles [Event]
Instead of putting a reference to a method in some remote place, you can place a "Handles" on an event handler sub.
Private Sub btnOne_Click(...) Handles btnOne.Click
This helps greatly with code maintenance, as you can see at a glance what objects are referencing an event handler.
In C#, you have to either add a reference in an initialization function or change your handler to protected and add a reference in your page.
- Partial namespaces
If C#, if you want to use an object in a namespace, you either have to type it out fully, starting with "System." or you have to add a "using" statement at the top for every full namespace you want to use.
In VB, the "imports" statement gives you more control over how your code looks.
For example, if I want to use the Page object in C#, my only choices are to type the entire namespace System.Web.UI.Page, or add a using statement for System.Web.UI. In VB I could use Web.UI.Page, or I could add an Imports for System.Web and then just use UI.Page.
With more control over namespaces, I can improve the portability of my code by leaving just the right amount of namespace information to properly identify objects.
See this great article about it here.
- Option Infer
When declaring a variable, you have to list the datatype twice in C# vs once in VB.
VB Example...
Dim dr = DirectCast(sender, System.Web.UI.HtmlControls.HtmlGenericControl)
C# Equivalent...
System.Web.UI.HtmlControls.HtmlGenericControl dr = (System.Web.UI.HtmlControls.HtmlGenericControl)sender;
Both versions are strongly typed with no runtime late binding.
Conclusion
I would recommend starting with VB. You only need to know enough C# to convert your code back and forth, and put it on your resume if you have to. You can always use a code-converter like this one (Developer Fusion) to convert samples. DO NOT use VB-Only classes and methods. Anything from the Microsoft.VisualBasic namespace should be off limits). Instead use System classes. You want your code to translate easily.
I think this would be a good opportunity to switch to c#! There are many sites that will help you get up and running pretty quickly with it.
As much as I generally don't like the discussion/subjective posts on SO, I have really come to appreciate the "Hidden Secrets" set of posts that people have put together. They provide a great overview of some commonly missed tools that you might now otherwise discover.
For this question I would like to explore the Visual Studio .NET debugger. What are some of the "hidden secrets" in the VS.NET debugger that you use often or recently discovered and wish you would have known long ago?
One of my favorite features is the "When Hit..." option available on a breakpoint. You can print a message with the value of a variable along with lots of other information, such as:
$ADDRESS - Current Instruction$CALLER - Previous Function Name$CALLSTACK - Call Stack$FUNCTION - Current Function Name$PID - Process ID$PNAME - Process Name$TID - Thread ID$TNAME - Thread NameYou can also have it run a macro, but I've never used that feature.
For .net applications System.Diagnostics has lots of useful debugging things. The Debugger class for example:
Debugger.Break(); // Programmatically set a break point
Debugger.Launch(); // Launch the debugger if not already attached
Debugger.IsAttached // Check if the debugger is attached
System.Diagnostics also has lots of good attributes. The two I've used are the debugger display attribute for changing the details put into the locals window and the step through attribute for skipping code you don't care about debugging:
// Displays the value of Property1 for any "MyClass" instance in the debugger
[DebuggerDisplay("{Property1}")]
public class MyClass {
public string Property1 { get; set; }
[DebuggerStepThrough]
public void DontStepInto() {
// An action we don't want to debug
}
}
You can right-click an object in the Watch window and click Make Object ID.
It will assign that instance an ID number, allowing you to see, in a complicated object graph, which objects refer to the same instance.
As a web developer who works with Web Services that are within the same solution as my front-end code most of the time, I found the ability to "attach" to a process to be a HUGE time saver.
Before I found this hidden gem, I would always have to set a breakpoint on some front-end code that called a web service method and step into it. Now that I know about this trick/feature I can easily set breakpoints on any part of my code that I want to which saves me loads of time and effort.
$exception in the watch window will show the exception that is currently being processed even if you don't have a catch that assign the Exception instance to a named variable.
You can load windbg extensions into the Visual Studio debugger and use them from the immediate window.
This is kind of an old one. If you add a watch expression err,hr, then this will hold the result of GetLastError(), formatted as an HRESULT (VC++ debugger only).
As posted in another post Sara Ford is doing a current series on the VS debugger.
Her blog is the best source of VS tips: http://blogs.msdn.com/saraford/archive/tags/Visual+Studio+2008+Tip+of+the+Day/default.aspx
Some useful shortcut keys.
F11 to step into a method.Shift-F11 to step out of a method.F10 to step over a method.Things I use often:
Click the menu item "Debug | Exceptions" (or Ctrl-D, E for short) and you can enable breaking at the time that any exception is thrown, or choose to not break on certain exceptions.
You can set up the debugger to download some of the framework source code and symbols from a MS server and step into the framework code. (Some libraries, like System.ServiceModel, are not yet available). It in the Options windows under Debugging. See MSDN How-To.
You can use the VS.NET debugger to debug Javascript running in IE. You just need to install the IE javascript debugger, and enable javascript debugging in IE's settings. Then on a JS error it will pop up a "do you want to debug" dialog box, and you can choose to debug in VS.NET.
You can drag current line cursor (yellow arrow) up and down your code when execution is paused.
Additionally, in order to enable this during pause on exception you have to click "enable editing" on exception details first.
You can also make VS break on handled exceptions by checking one's of interest under: Debug->Exceptions : Thrown column
You can open and place a breakpoint in a source file if the file belongs to another solution (external file). The debugger can still hit the breakpoint. No need to open another Visual Studio instance to debug the external file. Helpful in debugging web services which you source to. This works as long as all the sources are current and compiled.
During a long compilation with Visual Studio 2005 (version 8.0.50727.762), I sometimes get the following error in several files in some project:
fatal error C1033: cannot open program database 'v:\temp\apprtctest\win32\release\vc80.pdb'
(The file mentioned is either vc80.pdb or vc80.idb in the project's temp dir.)
The next build of the same project succeeds. There is no other Visual Studio open that might access the same files.
This is a serious problem because it makes nightly compilation impossible.
It is possible that an antivirus or a similar program is touching the pdb file on write - an antivirus is the most likely suspect in this scenario. I'm afraid that I can only give you some general pointers, based on my past experience in setting nightly builds in our shop. Some of these may sound trivial, but I'm including them for the sake of completion.
If nothing else works, you can schedule a watchdog script a few hours after the build starts and check its status; if the build fails, the watchdog should restart it. This is an ugly hack, but it's better than nothing.
We've seen this a lot at my site too. This explanation, from Peter Kaufmann, seems to be the most plausible based on our setup:
When building a solution in Visual Studio 2005, you get errors like fatal error C1033: cannot open program database 'xxx\debug\vc80.pdb'. However, when running the build for a second time, it usually succeeds.
Reason: It's possible that two projects in the solution are writing their outputs to the same directory (e.g. 'xxx\debug'). If the maximum number of parallel project builds setting in Tools - Options, Projects and Solutions - Bild and Run is set to a value greater than 1, this means that two compiler threads could be trying to access the same files simultaneously, resulting in a file sharing conflict. Solution: Check your project's settings and make sure no two projects are using the same directory for output, target or any kind of intermediate files. Or set the maximum number of parallel project builds setting to 1 for a quick workaround. I experienced this very problem while using the VS project files that came with the CLAPACK library. UPDATE: There is a chance that Tortoise SVN accesses 'vc80.pdb', even if the file is not under versioning control, which could also result in the error described above (thanks to Liana for reporting this). However, I cannot confirm this, as I couldn't reproduce the problem after making sure different output directories are used for all projects.
Try right click the excutable file of VS....and Properties->Compatibility-> Tick "Run this program in compatibilty mode for:" OFF........
It might also be a search indexer.
This generally happens when your previous attempts at debugging have not killed the debugger fully. In Task manager look for a process called vcjit, kill it and try again. Worst option restart visual studio, this should solve your problem.
Are you using LinqToSql at all? Perhaps it is similar to the odd error I will experience occasionally as I asked in this question: What causes Visual Studio to fail to load an assembly incorrectly?
I had this problem today and it turned out to be non-ansi characters in the path to the pdb that caused it.
I'm using windows through vmware, and my project was in a shared location: \vmware-host\Shared Folders\project
When I moved it to \Users\julian\project it resolved the issue.
To my amazement I just discovered that the C99 stdint.h is missing from MS Visual Studio 2003 upwards. I'm sure they have their reasons, but does anyone know where I can download a copy? Without this header I have no definitions for useful types such as uint32_t, etc.
Turns out you can download a MS version of this header from:
http://msinttypes.googlecode.com/svn/trunk/stdint.h
A portable one can be found here:
http://www.azillionmonkeys.com/qed/pstdint.h
Thanks to the Software Ramblings blog.
Just define them yourself.
#ifdef _MSC_VER
typedef __int32 int32_t;
typedef unsigned __int32 uint32_t;
typedef __int64 int64_t;
typedef unsigned __int64 uint64_t;
#else
#include <stdint.h>
#endif
Visual Studio 2003 - 2008 (Visual C++ 7.1 - 9) don't claim to be C99 compatible. (Thanks to rdentato for his comment.)
Update: Visual Studio 2010 and Visual C++ 2010 Express both have stdint.h. It can be found in C:\Program Files\Microsoft Visual Studio 10.0\VC\include
Boost contains cstdint.hpp header file with the types you are looking for: http://www.boost.org/doc/libs/1_36_0/boost/cstdint.hpp
Microsoft do not support C99 and haven't announced any plans to. I believe they intend to track C++ standards but consider C as effectively obsolete except as a subset of C++.
New projects in Visual Studio 2003 and later have the "Compile as C++ Code (/TP)" option set by default, so any .c files will be compiled as C++.
Another portable solution:
POSH: The Portable Open Source Harness
"POSH is a simple, portable, easy-to-use, easy-to-integrate, flexible, open source "harness" designed to make writing cross-platform libraries and applications significantly less tedious to create and port."
http://poshlib.hookatooka.com/poshlib/trac.cgi
as described and used in the book: Write portable code: an introduction to developing software for multiple platforms By Brian Hook http://books.google.ca/books?id=4VOKcEAPPO0C
-Jason
i would like Visual Studio to break when a handled exception happens (i.e. i don't just want to see a "First chance" message, i want to debug the actual exception).
e.g. i want the debugger to break at the exception:
try
{
System.IO.File.Delete(someFilename);
}
catch (Exception)
{
//we really don't care at runtime if the file couldn't be deleted
}
i came across these notes for Visual Studio.NET:
1) In VS.NET go to the Debug Menu >> "Exceptions..." >> "Common Language Runtime Exceptions" >> "System" and select "System.NullReferenceException"
2) In the bottom of that dialog there is a "When the exception is thrown:" group box, select "Break into the debugger"
3) Run your scenario. When the exception is thrown, the debugger will stop and notify you with a dialog that says something like: "An exception of type "System.NullReferenceException" has been thrown. [Break] [Continue]"
Hit [Break]. This will put you on the line of code that's causing the problem.
But they do not apply to Visual Studio 2005 (there is no Exceptions option on the Debug menu.)
Does anyone know where the find this options dialog in Visual Studio that the "When the exception is thrown" group box, with the option to "Break into the debugger"?
Update: The problem was that my Debug menu didn't have an Exceptions item. i customized the menu to manually add it.
With a solution open, go to the Debug - Exceptions (Ctrl+D,E) menu option. From there you can choose to break on Thrown or User-unhandled exceptions.
EDIT: My instance is set up with the C# "profile" perhaps it isn't there for other profiles?
There is an 'exceptions' window in VS2005 ... try Ctrl-Alt-E when debugging and click on the 'Thrown' checkbox for the exception you want to stop on.
Check this out on msdn, it explains how to set this up.
Essentially, here are the steps (during debugging):
On the Debug menu, click Exceptions.
In the Exceptions dialog box, select Thrown for an entire category of exceptions, for example, Common Language Runtime Exceptions.
-or-
Expand the node for a category of exceptions, for example, Common Language Runtime Exceptions, and select Thrown for a specific exception within that category.
A technique I use is something like the following. Define a global variable that you can use for one or multiple try catch blocks depending on what you're trying to debug and use the following structure:
if(!GlobalTestingBool)
{
try
{
SomeErrorProneMethod();
}
catch (...)
{
// ... Error handling ...
}
}
else
{
SomeErrorProneMethod();
}
I find this gives me a bit more flexibility in terms of testing because there are still some exceptions I don't want the IDE to break on.
A good document on "How to: Break When an Exception is Thrown"
http://msdn.microsoft.com/en-us/library/d14azbfh.aspx#addexceptionscommand
I've recently moved from a company with 30 or so developers all based on the same site, to a smaller company with a total of 6 developers working all over the country.
Previously when I was conducting code reviews I'd have the person sitting next to me, or I'd go round to his/her Pc and go over the code with them.
At my new company this isn't feasible as people are all over the place. I've been handed a couple of thousand lines of code to review and I can't just tell someone my thoughts.
The only way I can think of is to write a code review document. So I've resorted to pasting the code into Word and annotating it using the little margin bubble things you get.
is there an easier way to do this? I've long thought that Visual studio should have a meta comment system, which would give you similar outlining features, and allow you to write comments on a higher level.
Are there any tools that do this? If not how do people go about doing distributed code reviews?
You might like to read the Smart Bear book: Best Kept Secrets of Peer Code Review
It's free (including shipping if you're in the US) so there's little reason not to get it. On the other hand, it's a great little book with real world examples on how best to do peer code reviews, so there's plenty of reason to order it.
I wish there were better support for this type of task built into Visual Studio. There are some interesting add-ins that can help though. If you are using Visual Studio Team System take a look at TeamReview. It allows you to generate special Code Review work items that can be "played back" to someone later.
Check out the suggestions from this question:
http://stackoverflow.com/questions/403/tool-to-aid-code-review
In the company I am working for, patches, generated through SVN, are submitted on a daily basis in a newsgroup. Live code review is still the most efficient way to complete a review however, since we are working on virtual teams with developers all over the world it is sometime impossible to have the developer and the reviewer talk to each other.
To help our developers doing the reviews, we have put together a code review checklist (available at: http://www.macadamian.com/index.php?option=com_content&task=view&id=27&Itemid=31).
Our secret behind code reviews: Review small, review often.
I saw this project not too long ago, perhaps it can get voted up if people use it.
If possible, start with test cases -- have the person walk you through the test cases. It shows the design and what the developer was thinking would solve the problem(s). Dive into test cases and look at code.
Also, take a look at code coverage reports generated automatically from a build. It can be a good metric on test paths.
That's where I would start.
We have developers based around the world. We use Smart Bear's Code Collaborator. Like any tool, it's not perfect, but it certainly gets the job done. It's web based and easy to learn.
There's a tool: http://www.smartbear.com/codecollab.php
JIRA has the option to assign someone to code-review your work, he/she can then give comments within JIRA.
We were exactly in the same boat - developers all over the country, not enough overlap time during the day... Everyone working asynchronously... So we had to come up with an offline code-review tool.
We ended up with a reasonably light process: - For any non-trivial piece of code, a peer review is mandatory. - To perform a review, the author creates a "packaged changelist" (check your source control community for such stuff). It's basically a single-file, expandable ZIP of all the changes made in this chunk of work. - The author sends an email to the reviewer with the packed changelist (note they didn't submit it yet!) - The reviewer goes through the code, asynchronously, and puts in the comments in an email - If reviewer has serious objections, code is not allowed to go in until another round of reviews; otherwise, author is allowed to check in after they fix the suggestions OR open bugs to fix suggestions.
We have had some success using the the TFS shelveset feature to do distributed code reviews. Using shelvesets a developer can 'check in' a changeset without commiting them to the branch. Another developer can then unshelve the changeset and review the diffs against the commited branch. Once everyone concerned is happy with the changeset they are commited to the branch.
A very lightweight process that we have been using is to use Microsoft SharedView and Skype both to have pair programming sessions and to do code review. Granted, it's not as formal as a check-in policy, but might be a good place to start in order to develop standards before memorializing them in a check in policy.
Well, I'll tell you what my company does since it works well for us (about 10 developers plus PM ppl). YMMV.
We do our change management using Subversion and ClearQuest (used to use ClearCase, looking to ditch CQ). We do our changes, create patch files using subversion and then put the patch on the CQ record and pass the CQ around. Low-tech but it works. Obviously you can modify it to work with whatever ticketing app you use.
My development team uses source safe at a very basic level. We're moving into some more advanced and extended development cycles and I can't help but think that not using branching and merging in order to manage changes is going to be biting us very soon.
What arguments did you find most useful in order to convince your team to move to a better solution like SVN?
What programs did you use to bridge the functionality gap so that the team wouldn't miss the ide sourcesafe integration?
Or should I just accept sourcesafe and attempt to shoehorn better practices into it?
First, teach them how to use SourceSafe in an efficient way.
If they are smart enough, they will begin to love the advantages of using a version-control system, and if so, they will soon reach the limits of SourceSafe. That's where they will be the more able to listen to your arguments for switching to a better VCS, could it be a CVCS or a DVCS, depending on what's the team is ready to achieve.
If you try to force them to use another VCS when they use SourceSafe in a wrong way, like saving zip file of source code (don't laugh, that's how they were acting in my company two years ago), they will be completly reluctant to any argumentation, as good as it could be.
SVN is open and there is plenty of various tools using SVN or cooperating with it. Some examples include:
Find some excuse to start using non-ASCII characters in your C# code (Chinese and Japanese are excellent for this).
SourceSafe doesn't like Unicode (even though Visual Studio does), so if you choose the right Unicode text and check a file in and back out, your entire file will appear as corrupted gibberish. The beauty of this is that because SS uses a "diff" versioning system, this actually corrupts the file all the way back to the original check-in version, and can't be fixed automatically.
When this happens just one time (as it did to me when working on an application that had to support Japanese), you will probably find it to be a decisive argument in favor of dropping SourceSafe.
There were two features that we used to sell management and the team on SVN over VSS.
1) The ability to branch. When using VSS, when a release was scheduled to go out, the entire repository was locked until the release actually went out. This included the test and fix cycle. So, developers were unable to commit anything other than fixes for the release to the VSS repository. This resulted in long integration sessions immediately following each release. With the use of release branches in SVN, there is no longer any need to lock the entire repository.
2) The ability to rollback an entire change at once. Because SVN records all files changed in a single, atomic commit, it is trivial to revert a problematic change. In VSS, a developer had to go through the entire repository and find every file changed at about the same time and revert each change to each file individually. With SVN, this is as trivial as finding the relevant commit and hitting the "Revert Changes from this Commit" button in TortoiseSVN.
As a side note, we use TortoiseSVN and everyone loves the file overlay icons for seeing what has and has not changed.
Whatever you do, move slowly! Don't start talking to them about branching on Day 1 -- it will just put them off. I'm stereotyping VSS users with that comment, but that's what I see out there.
For the developers: sell it as a replacement for VSS that works better and faster. Use VisualSVN on Day 1 so they have a super-shallow learning curve. Sell them on it being the same except faster, more stable, and 2 people can edit the same file and they won't have problems with some guy being off sick with locks on a bunch of files.
For the admins: sell them on it being more stable and easier to administer than VSS. Show them VisualSVN server.
Good luck!
Nobody recommends using SourceSafe any more, not even Microsoft. They will now offer you an (expensive) TFS licence instead. SourceSafe is just not reliable.
I wrote about it here: Visual SourceSafe on E2. It's a bit of a rant, but that's because I had to use SourceSafe for quite a while, and the memory makes me froth at the mouth a bit.
Reliablity is the big one that will bite you. But also there are features that you may appreciate in SVN or TFS:
TFS and SVN both have atomic commits of multiple files, but Sourcesafe does not - if you check in two files "at once", it's not one operation, it's the same as checking in one of the files, then checking in the other. You can get at the state in between, where one file has been checked in, but not the other.
SourceSafe does not keep history of deleted files, file moves or renames.
Contrary to initial impressions, SourceSafe does support multiple simultaneous checkouts of the same file, if you set the right options. But TFS and especially SVN are better designed for this way of working
Unlike SourceSafe, TFS and SVN both work fine against servers on the internet (TFS just OK, SVN excellently) and SVN works well offline - e.g. if you have a laptop on a plane or train and no 'net, you can still work and compare to previous revisions or even revert, since the data to do that is held locally.
As someone else pointed out, SourceSafe, like CVS, is a "dead" product. It is not being actively developed. TFS and SVN will have next versions out some time in the future.
First, document all the problems you are having that can be traced to root causes within the source control system. Keep track of them for a month or so. Add on top of that missed opportunities resulting from not using it. (if you say "opportunity costs of not using subversion" you may impress an MBA-type manager). These numbers are actually an understimate of the opportunity cost because presumably you could have been doing work that provides more than your hourly bill rate of value if you weren't messing around with VSS.
For example, do you have problems where files are locked that need to be accessed by more than one person? Have you had problems with partial (non-atomic) check-ins? Do you have problems where it is difficult for you to keep track of releases of the software and recreate the repository as it was in the past? Do you have problems getting a copy of the code onto a server that doesn't have a sourcesafe client? Do you have problems automating your build and testing process because continuous integration tools can't monitor your version control systems for updates? I am sure you can think of many others.
If you can figure out the approximate time/money costs of problems caused by sourcesafe and benefits of things that subversion provides (using a generic number like $100/hr for labor costs or just hours) and any costs of late delivery of projects, do so. If you have collected data for a month or so, you can show the benefit using subversion per month.
Then present the approximate time/cost of moving to subversion. (About 8 hours to setup and migrate code, and 2 hours per developer to connect, checkout and move projects, something like that) The risk is low, since sourcesafe is still there to rollback to.
If the cost is more than the monthly benefit, you can divide the cost by the benefit to figure out the recovery period. You should also total it up over 3 years or so to show the long term benefit. Again, emphasize that the real opportunity cost is not directly calculable because you could have been adding value during the time you were trying to manage non-branched releases in sourcesafe.
The AnkhSVN plugin for VS is pretty good. It's got a few oddities but on the whole works well.
Convincing the team to move is hard work - I never managed it :-( Probably one of the more practical arguments though is speed - VSS is s-l-o-w when you've got a 1GB source database and several users.
edit It's been so long since I used VSS I forgot it was locking! Yes, as mentioned here the ability to move to a non-exclusive/merge changes model should help if you've got more than a handful of developers. It saves yelling "Can somebody check in the common includes" across the office!
TortoiseSvn (free) is really nice for explorer integration, giving you all the features of svn from a context menu.
VisualSvn (commercial) makes it just as easy to integrate svn into Visual Studio, with the same status indication in the solution browser as well as context menus to use all the subversion features.
Both these tools go a long way to making version control seamless. It's been a coupe of years since I dealt with VSS, but these tools are a way nicer way to use source control.
Ditto for what every one has said about VSS being poop
Subversion has good support for branching and doing merges... I don't remember VSS having any capabilities in this department at all. I do remember teams going through pain of week long merges when needing to release from VSS, pain which just doesn't exist anymore with Subversion.
Build some automation that mirrors the VSS repository into a SVN repository
It takes time to build a consensus. If your SVN mirror of the VSS repository is available at all times, it will be easier to accumulate converts. The mirror doesn't have to be perfect- it just has to be usable. There are existing tools for this purpose.
You say "What arguments did you find most useful in order to convince your team to move to a better solution like SVN?"
If you don't know that it's a better solution, then why are you making the arguments? If your mind is made up enough to go argue for a solution, you should know what those reasons are already.
What convinced you that you should move to something better? Those are your arguments right there. Anything short of those arguments will sound like it's just an issue of personal preference.
Tell them to treat the source code as if it was money and point them to the numerous examples of SourceSafe coming down in flames taking the source with it. Things like that are just not supposed to happen in a proper source control system.
The best argument against SourceSafe is that it is just isn't Safe, everything else can potentially be called "features we don't need".
First search google for the sheer quantity of pages describing how bad VSS is and share that with your coworkers.
Second, skip subversion and go straight to a proper distributed SCM like git or mercurial. Because merging is such an inherent part of distributed SCMs, they have to handle merges much better than centralized systems like svn. Subversion is still trying to retrofit itself to handle branching better, where the distributed systems were built correctly to begin with.
The clincher for us was the speed (i.e., the lack thereof) of VSS over VPN and low bandwidth hotel networks on the road and the problems of trying to tunnel through firewalls so that two teams at two different sites could quickly, securely, and reliably work from the same code repository. We were running two VSS repositories and packaging up "deliveries" that had to be merged into the other site's repository to keep them in sync.
The team grumbled for a while, but quickly got over it. TortoiseSVN is fantastic by itself and the AnkhSVN plug-in for Visual Studio really eased everyone into the changeover.
Looking back, I can't believe how many "Can you check in file SoAndSo?" e-mails we sent around, not to mention the "SourceSafe is down. We've got to restore the repository" e-mails.
Sheesh. After reading this comments and writing this response, I can't believe we put up with VSS for as long as we did.
Web page summarising problems with VSS - just point people to that URL
If you use VisualSVN the team won't miss VSS as much. 2 people being able to work on one file at the same time is a big selling point too.
The unreliability of source safe ("please fix the repository...") was enough of a sell for us. Andecdotally (I've never measured it) SVN also always seems faster. Good concurrent checkouts / merging.
I'd always figured that to a developer it was almost too obvious. SourceSafe just seems to break and die all too often to not want to replace it...
I don't remember any SourceSafe user ever liking the product. Do your colleagues actually like it?
I've got a similar issue with CVS at my current customer's usage. Since "it works" and they are mostly pleased with it, I cannot push them to change. But daily I sure wish they would!
Tell them to read this http://www.highprogrammer.com/alan/windev/sourcesafe.html
I would recommend that you go ahead and start introducing best practices to your sourcesafe usage with a view to changing to subversion further down the line. Hopefully this will make your actual subversion migration easier and give you time to sort plan out your development cycles, branching strategies et al. properly.
The other thing to consider is your development process in general. A source control management system is only ever part of the solution, to get the most out of subversion or any other product you will probably want to look at how it's usage interacts with your code review, qa and build processes.
We used to use SourceSafe. Then, when I joined the team I was in a different location and even though we have a fairly good LAN when I tried to check out the latest version it took 40 minutes. I persuaded them to convert to CVS (we now use SVN) and the checkout time dropped to a couple of minutes. SourceSafe was just too slow to be usable at a remote location.
We moved from SourceSafe to Source Gear Vault. This source control engine is very comfortable for some one used to SourceSafe. We finally decided to make the change after a couple SourceSafe corruption incidents, that came at critical times. So my advice would be to focus your sales presentation on SourceSafes unreliability.
Surely using source safe is enough reason to want to migrate to another source control system?
I used SVN and CVS at my old job and have moved to a company that uses Source safe (we are going to migrate to SVN) and just using VSS has been enough for me to take a serious dislike to it. I went in with an open mind, despite many of my colleagues from my previous job telling me horror stories about VSS I assumed that it would have gotten better since they used it.
Not being able to edit a file because somone else is/was editing it is ridiculous. I've tried to move to more distributed versioning systems like Bazzar which is made by cannonical however it's not mature enough in terms of the tools available.
Source safe gets in the way of development where SVN helps you almost every step of the way.
Plus Using tortoise Svn made code reviews a lot easier.
Only to the extend as you are able to herd a bunch of cats. I've been there twice and in both cases it took some serious problems in Source Safe before people saw the light. As a manager on the other hand I simply directed the team to use SVN and our productivity increased by 300% ( this was working with a group in India and in the US. We had code exchanges that used to take a long time before svn )
Also Trac mounts on top of Subversion. It's free and a great way to view the repository (timeline, wiki, etc)
As you're making these arguments, consider whether you need to address any policy your company may have about using open source tools. See this answer to a prior question: Switching source control
Make them use it and they will switch to something else :)
Now, being serious, tell them its not that hard to use it, many developers that I've known refused to switch because they related subversion to unix and wierd commands, show them interfaces like ToirtoiseSVN or VisualSVN, tell them that Subversion allows them to edit the same file withouth a forced locking like VSS does.
And last but not least, it is Open Source. It has lower cost than buying Team Foundation Server and if you look around you will see that small teams of developers work quite well with SVN.
I used SourceSafe on a small development team and was responsible for keeping it running.
I found the database gets corrupted pretty easily, and there isn't much recourse when that happens. The "repair" feature (as with most any Microsoft repair feature) just doesn't work 98% of the time.
Naturally, when our database became corrupt, we tried to restore from our backup archive. That was when we discovered the other bad thing about SourceSafe: its 2GB archive limit. We were making backups at our office for months before we ever realized that they couldn't be restored and were useless.
SourceSafe is just a disaster waiting to happen.
I'm planning on ditching SourceSafe in the next few weeks, after over a decade of putting up with it. Mostly I've been using it within the context of a small (< 5 person) team, and not had to do a lot of branching because there's been no call to do it.
However, the #1 problem for me, and always has been, is that the damn thing is so prone to corruption - if you have your SS database (lol, database; collection of randomly named files more accurately describes it) on a network drive, and something happens to your LAN connection partway through an add/checkin operation - 9 times out of ten you get "invalid handle" and the damn thing is corrupted in some way, and then you get to play Russian Roulette with the Analyzer tool.
I realised, a couple of months back, that for the past decade I had been making local zipped up copies of the source at every release of the software I was working on, because I didn't trust the source control system. What a waste of time.
So, it's going. I'll probably use Subversion and TortoiseSVN, because I think the team will need a UI to ease the transition.
In my previous job we started on VSS then moved to SVN and never looked back.
Just started a new job and they use VSS, fortunately the above problems are making them think about using SVN.
Not being able to add a file to a project because someone has the project file checked out is infuriating!
-- Lee
When I was at the launch for VS2005 I managed to corner a Microsofty and ask why SourceSafe was so awful to use. The reply I got was rather shocking, not just because of what he said but because he was so up front about what he'd said.
He told me that it was only really meant for one person to use and even then it wasn't very good at doing that.
My colleagues and I were a bit shocked we couldn't think of much else to do other than laugh out loud, as did the Microsofty! He then told us that it wasn't used internally.
So, we switched to subversion shortly after that. We'd pretty much decided to go for it before the launch event, but that just confirmed we'd made the right decision.
If dropping SourceSafe for another version control system I would recommend to go with Mercurial rather than with SVN
Joel Spolsky's wrote a very good introduction to Mercurial and you can use plug-in for Visual Studio as well.
Whenever i've worked in a team of 3 and they've started to increase numbers further moving away from VSS has seemed to be a natural step.
Also whenever i've shown people the benefits of Continuous Integration (specifically CruiseControl.NET); that in itself is often enough to warrant the move away from VSS to SVN (I find SVN works much better with CruiseControl.NET than VSS).
I'd suggest starting any new projects in SVN and migrate old projects across as and when necessary rather than a complete move from one to the other in a single step.
You'll be suprised how fast VSS dies off this way.
An excellent book on this topic is "Driving Technical Change."
I've had a serious issue with my Visual Studio 2008 setup. I receive the ever-so-useful error 'A problem has been encountered while loading the setup components. Canceling setup.' whenever I try to uninstall, reinstall or repair Visual Studio 2008 (team system version). If I can't resolve this issue I have no choice but to completely wipe my computer and start again which will take all day long! I've recently received very strange errors when trying to build projects regarding components running out of memory (despite having ~2gb physical memory free at the time) which has rendered my current VS install useless.
Note I installed VS2005 shell version using the vs_setup.msi file in the SQL Server folder after I had installed VS2008, in order to gain access to the SQL Server 2005 Reporting Services designer in Business Intelligence Development Studio (this is inexplicably unavailable in VS2008).
Does anyone have any solutions to this problem?
P.S.: I know this isn't directly related to programming, however I feel this is appropriate to SO as it is directly related to my ability to program at all!
Note: A colleague found a solution to this problem, hopefully this should help others with this problem.
A colleague found this MS auto-uninstall tool which has successfully uninstalled VS2008 for me and saved me hours of work!!
Hopefully this might be useful to others. Doesn't speak highly of MS's faith in their usual VS maintenance tools that they have to provide this as well!
I had the same error message. For me it was happening because I was trying to run the installer from the DVD rather than running the installer from Add/Remove programs.
In my case, uninstalling from Add&Remove Programs didn't work. Instead, the problem was due to a recently hotfix installed through automatic updates. The hotfix to VS 2008 (in my case) has the number KB952241, so I uninstalled it using Add/Remove Programs checking on the show updates option. After it was unistalled the problem was gone.
I encountered the same problem and found a very easy solution.Go to the following Link: http://msdn.microsoft.com/en-us/vs2008/bb968856.aspx
and run VS AutoUninstall tool .This will automatically remove all the components of VS 2008.
Cheers
Sure enough, for me, it was the hotfixes. In Add/Remove Programs, check the "Show Updates" box, and remove ALL of the Hotfixes associated with your version of VS2008. Then try the "Change/Remove" button - it should now proceed without a hitch.
Well, it did for me, anyway... ;-)
I have Visual Studio Team System 2008 Development Edition, and had to remove all updates and Hotfixes:
KB972221KB973674KB971091Reboot, then the following Hotfix appeared, which I then removed as per @riaraos' answer:
KB952241Before the Change/Remove would work!
Hope that helps someone else.
You should look for the MSI setup logs in the temp directory of your system. They will contain detailed inforamtion about why the setup failed. I had a similar installation problem with Visual Studio 2008 which I was able to resolve by studying the logs.
Solution to this is
http://www.dotnetzone.gr/cs/forums/48758/ShowThread.aspx#48758
Microsoft itself posted a KB article about this, and that article has a service pack that they claim fixes the problem. See below.
http://support.microsoft.com/kb/959417/
It took a while for the associated update to install itself, but once it did, I was able to run the Visual Studio setup successfully from the Add/Remove Programs control panel.
I think this sort of question is entirely appropriate to the forum, especially if an easy solution can be found, as would save others hours of pain.
Unfortunately I dont have the solution, but would suggest (if you haven't already)
Run FileMon to see if the installer is looking for specific files which are no longer there - this may give some clues.
Painful, but try uninstalling other apps based upon the VS shell (eg 2005) first.
Thanks, riaraos, uninstalling KB952241 was the solution for me, too. Before doing that I tried to run the installer from "Programs and Features" and from the installation DVD without success. I did not want to completely remove the VS 2008 installation but only add a few components.
Notes on my system:
Windows 7 Beta 1 Visual Studio 2008 SP1
Okay I had the same issues first my VS2008 was acting up so i tried to uninstall it and it didn't work...I read online that using an AutoUninstall by MS will do the trick it did just that , but left a lot of nasty files behind..
So i used "Windows Install Clean Up" and cleaned up more stuff that had to do with VS.. then went back into Add and remove in control panel Removed the KB952241... then opened up Ccleaner and scanned the registry found a lot of left behind crap from VB2008 removed all that once that was done.
I went ahead and launch the installed back from the CD again and BAM its working.
I did all this without having to restart my PC..
Hope this helps people who are stuck..like i was
In my case, installing visual studio SP1 unbroke the uninstall/repair functionality.
Uninstall hotfixes installed in related to vs2008 and then try again. It worked for me and hopefully it will for you as well.
Thanks, Zelalem
Windows 7 suggested to "Uninstall using recommended settings" after hitting OK in the error message. It solved the problem.
Remove the following hot fixes and updates
Restart the PC and try to uninstall now. This worked for me without problems.
Name of the option tells something but what Visual Studio/compiler really do and what are the real consequences?
Edit: If you search google you can find this address, but that is not really I am looking for. I wonder the real things happening. For example why do the loops get less time, etc.
Without optimizations the compiler produces very dumb code - each command is compiled in a very straightforward manner, so that it does the intended thing. The Debug builds have optimizations disabled by default, because without the optimizations the produced executable matches the source code in a straightforward manner.
Once you turn on the optimizations, the compiler applies many different techniques to make the code running faster while still doing the same. The most obvious difference between optimized and unoptimized builds in Visual C++ is the fact the variable values are kept in registers as long as possible in optimized builds, while without optimizations they are always stored into the memory. This affects not only the code speed, but it also affects debugging. As a result of this optimization the debugger cannot reliably obtain a variable value as you are stepping through the code.
There are multiple other optimizations applied by the compiler, as described in /O Options (Optimize Code) MSDN docs. For a general description of various optimizations techniques see Wikipedia Compiler Optimization article.
From Paul Vick's blog:
It removes any NOP instructions that we would otherwise emit to assist in debugging. When optimizations are off (and debugging information is turned on), the compiler will emit NOP instructions for lines that don't have any actual IL associated with them but which you might want to put a breakpoint on. The most common example of something like this would be the ?End If? of an ?If? statement - there's no actual IL emitted for an End If, so we don't emit a NOP the debugger won't let you set a breakpoint on it. Turning on optimizations forces the compiler not to emit the NOPs.
We do a simple basic block analysis of the generated IL to remove any dead code blocks. That is, we break apart each method into blocks of IL separated by branch instructions. By doing a quick analysis of how the blocks interrelate, we can identify any blocks that have no branches into them. Thus, we can figure out code blocks that will never be executed and can be omitted, making the assembly slightly smaller. We also do some minor branch optimizations at this point as well - for example, if you GoTo another GoTo statement, we just optimize the first GoTo to jump to the second GoTo's target.
We emit a DebuggableAttribute with IsJITOptimizerDisabled set to False. Basically, this allows the run-time JIT to optimize the code how it sees fit, including reordering and inlining code. This will produce more efficient and smaller code, but it means that trying to debug the code can be very challenging (as anyone who's tried it will tell you). The actual list of what the JIT optimizations are is something that I don't know - maybe someone like Chris Brumme will chime in at some point on this. The long and the short of it is that the optimization switch enables optimizations that might make setting breakpoints and stepping through your code harder.
The short answer is: use -Ox and let the compiler do its job.
The long answer: the effect of different kind of optimizations is impossible to predict accurately. Sometimes optimizing for fast code will actually yield smaller code than when optimizing for size. If you really want to get the last 0.01% of performance (speedwise or sizewise), you have to benchmark different combination of options.
Also, recent versions of Visual Studio have options for more advanced optimizations such as link-time optimization and profile-guided optimization.
Visual Studio Test can check for expected exceptions using the ExpectedException attribute. You can pass in an exception like this:
[TestMethod]
[ExpectedException(typeof(CriticalException))]
public void GetOrganisation_MultipleOrganisations_ThrowsException()
You can also check for the message contained within the ExpectedException like this:
[TestMethod]
[ExpectedException(typeof(CriticalException), "An error occured")]
public void GetOrganisation_MultipleOrganisations_ThrowsException()
But when testing I18N applications I would use a resource file to get that error message (any may even decide to test the different localizations of the error message if I want to, but Visual Studio will not let me do this:
[TestMethod]
[ExpectedException(typeof(CriticalException), MyRes.MultipleOrganisationsNotAllowed)]
public void GetOrganisation_MultipleOrganisations_ThrowsException()
The compiler will give the following error:
An attribute argument must be a constant expression, typeof expression or array creation expression of an attribute
Does anybody know how to test for an exception that has a message from a resource file?
One option I have considered is using custom exception classes, but based on often heard advice such as:
"Do create and throw custom exceptions if you have an error condition that can be programmatically handled in a different way than any other existing exception. Otherwise, throw one of the existing exceptions." Source
I'm not expecting to handle the exceptions differently in normal flow (it's a critical exception, so I'm going into panic mode anyway) and I don't think creating an exception for each test case is the right thing to do. Any opinions?
I would recommend using a helper method instead of an attribute. Something like this:
public static class ExceptionAssert
{
public static T Throws<T>(Action action) where T : Exception
{
try
{
action();
}
catch (T ex)
{
return ex;
}
Assert.Fail("Exception of type {0} should be thrown.", typeof(T));
// The compiler doesn't know that Assert.Fail
// will always throw an exception
return null;
}
}
Then you can write your test something like this:
[TestMethod]
public void GetOrganisation_MultipleOrganisations_ThrowsException()
{
OrganizationList organizations = new Organizations();
organizations.Add(new Organization());
organizations.Add(new Organization());
var ex = ExceptionAssert.Throws<CriticalException>(
() => organizations.GetOrganization());
Assert.AreEqual(MyRes.MultipleOrganisationsNotAllowed, ex.Message);
}
This also has the benefit that it verifies that the exception is thrown on the line you were expecting it to be thrown instead of anywhere in your test method.
The ExpectedException Message argument does not match against the message of the exception. Rather this is the message that is printed in the test results if the expected exception did not in fact occur.
Just an opinion, but I would say the error text:
Note that the first option should let you test multiple languages, given the ability to run with a locale.
As for multiple exceptions, I'm from C++ land, where creating loads and loads of exceptions (to the point of one per 'throw' statement!) in big heirachies is acceptable (if not common), but .Net's metadata system probably doesn't like that, hence that advice.
I think you can just do an explicit try-catch in your test code instead of relying on the ExpectedException attribute to do it for you. Then you can come up with some helper method that will read the resource file and compare the error message to the one that comes with the exception that was caught. (of course if there wasn't an exception then the test case should be considered a fail)
If you switch over to using the very nice xUnit.Net testing library, you can replace [ExpectedException] with something like this:
[Fact]
public void TestException()
{
Exception ex = Record.Exception(() => myClass.DoSomethingExceptional());
// Assert whatever you like about the exception here.
}
I wonder if NUnit is moving down the path away from simplicity... but here you go.
New enhancements (2.4.3 and up?) to the ExpectedException attribute allow you more control on the checks to be performed on the expected Exception via a Handler method. More Details on the official NUnit doc page.. towards the end of the page.
[ExpectedException( Handler="HandlerMethod" )]
public void TestMethod()
{
...
}
public void HandlerMethod( System.Exception ex )
{
...
}
Note: Something doesn't feel right here.. Why are your exceptions messages internationalized.. Are you using exceptions for things that need to be handled or notified to the user. Unless you have a bunch of culturally diverse developers fixing bugs.. you shouldn't be needing this. Exceptions in English or a common accepted language would suffice. But in case you have to have this.. its possible :)
I came across this question while trying to resolve a similar issue on my own. (I'll detail the solution that I settled on below.)
I have to agree with Gishu's comments about internationalizing the exception messages being a code smell.
I had done this initially in my own project so that I could have consistency between the error messages throw by my application and in my unit tests. ie, to only have to define my exception messages in one place and at the time, the Resource file seemed like a sensible place to do this since I was already using it for various labels and strings (and since it made sense to add a reference to it in my test code to verify that those same labels showed in the appropriate places).
At one point I had considered (and tested) using try/catch blocks to avoid the requirement of a constant by the ExpectedException attribute, but this seemed like it would lead to quite a lot of extra code if applied on a large scale.
In the end, the solution that I settled on was to create a static class in my Resource library and store my exception messages in that. This way there's no need to internationalize them (which I'll agree doesn't make sense) and they're made accessible anytime that a resource string would be accessible since they're in the same namespace. (This fits with my desire not to make verifying the exception text a complex process.)
My test code then simply boils down to (pardon the mangling...):
[Test, ExpectedException(typeof(System.ArgumentException), ExpectedException=ProductExceptionMessages.DuplicateProductName)] public void TestCreateDuplicateProduct() { _repository.CreateProduct("TestCreateDuplicateProduct"); _repository.CreateProduct("TestCreateDuplicateProduct"); }
I am working with a Visual Studio 2005 C++ solution that includes multiple projects (about 30). Based upon my experience, it often becomes annoying to maintain all the properties of the projects (i.e include path, lib path, linked libs, code generation options, ...), as you often have to click each and every project in order to modify them. The situation becomes even worse when you have multiple configurations (Debug, Release, Release 64 bits, ...).
Real life examples:
Notes:
I think you need to investigate properties files, ie *.vsprops
You do need to add the properties file manually to each project, but once that's done, you have multiple projects, but one .vsprops file. If you change the properties, all projects inherit the new settings.
I often need to do something similar since I link to the static runtime libraries. I wrote a program to do it for me. It basically scans all of the subdirectories of whatever path you give it and ids any .vcproj files it finds. Then one by one, it opens them modifies them and saves them. Since I only use it rarely, the path is hard coded it, but I think you'll be able to adjust it how you like.
Another approach is to realize that Visual Studio Project files are simply XML files and can be manipulated with your favorite XML class. I've done something using C#'s XmlDocument for updating the include directories when there were A LOT of include directories that I didn't want to type in. :)
I'm including both examples. You will need to modify them to your own needs, but these should get you started.
This is the C++ version:
#include <stdio.h>
#include <tchar.h>
#include <iostream>
#include <fstream>
#include <string>
#include <sstream>
#include <vector>
#include <boost/filesystem/convenience.hpp>
#include <boost/filesystem/operations.hpp>
#include <boost/filesystem/path.hpp>
#include <boost/regex.hpp>
#include <boost/timer.hpp>
using boost::regex;
using boost::filesystem::path;
using namespace std;
vector<path> GetFileList(path dir, bool recursive, regex matchExp);
void FixProjectFile(path file);
string ReadFile( path &file );
void ReplaceRuntimeLibraries( string& contents );
void WriteFile(path file, string contents);
int _tmain(int argc, _TCHAR* argv[])
{
boost::timer stopwatch;
boost::filesystem::path::default_name_check(boost::filesystem::native);
regex projFileRegex("(.*)\\.vcproj");
path rootPath("D:\\Programming\\Projects\\IPP_Decoder");
vector<path> targetFiles = GetFileList(rootPath, true, projFileRegex);
double listTimeTaken = stopwatch.elapsed();
std::for_each(targetFiles.begin(), targetFiles.end(), FixProjectFile);
double totalTimeTaken = stopwatch.elapsed();
return 0;
}
void FixProjectFile(path file) {
string contents = ReadFile(file);
ReplaceRuntimeLibraries(contents);
WriteFile(file, contents);
}
vector<path> GetFileList(path dir, bool recursive, regex matchExp) {
vector<path> paths;
try {
boost::filesystem::directory_iterator di(dir);
boost::filesystem::directory_iterator end_iter;
while (di != end_iter) {
try {
if (is_directory(*di)) {
if (recursive) {
vector<path> tempPaths = GetFileList(*di, recursive, matchExp);
paths.insert(paths.end(), tempPaths.begin(), tempPaths.end());
}
} else {
if (regex_match(di->string(), matchExp)) {
paths.push_back(*di);
}
}
}
catch (std::exception& e) {
string str = e.what();
cout << str << endl;
int breakpoint = 0;
}
++di;
}
}
catch (std::exception& e) {
string str = e.what();
cout << str << endl;
int breakpoint = 0;
}
return paths;
}
string ReadFile( path &file ) {
// cout << "Reading file: " << file.native_file_string() << "\n";
ifstream infile (file.native_file_string().c_str(), ios::in | ios::ate);
assert (infile.is_open());
streampos sz = infile.tellg();
infile.seekg(0, ios::beg);
vector<char> v(sz);
infile.read(&v[0], sz);
string str (v.empty() ? string() : string (v.begin(), v.end()).c_str());
return str;
}
void ReplaceRuntimeLibraries( string& contents ) {
regex releaseRegex("RuntimeLibrary=\"2\"");
regex debugRegex("RuntimeLibrary=\"3\"");
string releaseReplacement("RuntimeLibrary=\"0\"");
string debugReplacement("RuntimeLibrary=\"1\"");
contents = boost::regex_replace(contents, releaseRegex, releaseReplacement);
contents = boost::regex_replace(contents, debugRegex, debugReplacement);
}
void WriteFile(path file, string contents) {
ofstream out(file.native_file_string().c_str() ,ios::out|ios::binary|ios::trunc);
out.write(contents.c_str(), contents.length());
}
This is the C# version. Enjoy...
using System;
using System.Collections.Generic;
using System.Text;
using System.Xml;
using System.IO;
namespace ProjectUpdater
{
class Program
{
static public String rootPath = "D:\\dev\\src\\co\\UMC6\\";
static void Main(string[] args)
{
String path = "D:/dev/src/co/UMC6/UMC.vcproj";
FileStream fs = new FileStream(path, FileMode.Open, FileAccess.Read, FileShare.ReadWrite);
XmlDocument xmldoc = new XmlDocument();
xmldoc.Load(fs);
XmlNodeList oldFiles = xmldoc.GetElementsByTagName("Files");
XmlNode rootNode = oldFiles[0].ParentNode;
rootNode.RemoveChild(oldFiles[0]);
XmlNodeList priorNode = xmldoc.GetElementsByTagName("References");
XmlElement filesNode = xmldoc.CreateElement("Files");
rootNode.InsertAfter(filesNode, priorNode[0]);
DirectoryInfo di = new DirectoryInfo(rootPath);
foreach (DirectoryInfo thisDir in di.GetDirectories())
{
AddAllFiles(xmldoc, filesNode, thisDir.FullName);
}
List<String> allDirectories = GetAllDirectories(rootPath);
for (int i = 0; i < allDirectories.Count; ++i)
{
allDirectories[i] = allDirectories[i].Replace(rootPath, "$(ProjectDir)");
}
String includeDirectories = "\"D:\\dev\\lib\\inc\\ipp\\\"";
foreach (String dir in allDirectories)
{
includeDirectories += ";\"" + dir + "\"";
}
XmlNodeList toolNodes = xmldoc.GetElementsByTagName("Tool");
foreach (XmlNode node in toolNodes)
{
if (node.Attributes["Name"].Value == "VCCLCompilerTool") {
try
{
node.Attributes["AdditionalIncludeDirectories"].Value = includeDirectories;
}
catch (System.Exception e)
{
XmlAttribute newAttr = xmldoc.CreateAttribute("AdditionalIncludeDirectories");
newAttr.Value = includeDirectories;
node.Attributes.InsertBefore(newAttr, node.Attributes["PreprocessorDefinitions"]);
}
}
}
String pathOut = "D:/dev/src/co/UMC6/UMC.xml";
FileStream fsOut = new FileStream(pathOut, FileMode.Create, FileAccess.Write, FileShare.ReadWrite);
xmldoc.Save(fsOut);
}
static void AddAllFiles(XmlDocument doc, XmlElement parent, String path) {
DirectoryInfo di = new DirectoryInfo(path);
XmlElement thisElement = doc.CreateElement("Filter");
thisElement.SetAttribute("Name", di.Name);
foreach (FileInfo fi in di.GetFiles())
{
XmlElement thisFile = doc.CreateElement("File");
String relPath = fi.FullName.Replace(rootPath, ".\\");
thisFile.SetAttribute("RelativePath", relPath);
thisElement.AppendChild(thisFile);
}
foreach (DirectoryInfo thisDir in di.GetDirectories())
{
AddAllFiles(doc, thisElement, thisDir.FullName);
}
parent.AppendChild(thisElement);
}
static List<String> GetAllDirectories(String dir)
{
DirectoryInfo di = new DirectoryInfo(dir);
Console.WriteLine(dir);
List<String> files = new List<String>();
foreach (DirectoryInfo subDir in di.GetDirectories())
{
List<String> newList = GetAllDirectories(subDir.FullName);
files.Add(subDir.FullName);
files.AddRange(newList);
}
return files;
}
static List<String> GetAllFiles(String dir)
{
DirectoryInfo di = new DirectoryInfo(dir);
Console.WriteLine(dir);
List<String> files = new List<String>();
foreach (DirectoryInfo subDir in di.GetDirectories())
{
List<String> newList = GetAllFiles(subDir.FullName);
files.AddRange(newList);
}
foreach (FileInfo fi in di.GetFiles())
{
files.Add(fi.FullName);
}
return files;
}
}
}
As suggested, you should look at Property Sheets (aka .vsprops files).
I wrote a very short introduction to this feature here.
Yes, I'd definitely suggest using CMake. CMake is the best tool (I think I've actually tried them all) which can generate Studio project files.
I also had the issue of converting existing .vcproj files into CMakeLists.txt, and I wrote a Ruby-script which takes care of most of the conversion. The script doesn't handle things like post-build steps and such, so some tweaking is necessary, but it will save you the hassle of pulling all the source file names from the .vcproj files.
I am interested in hearing about experiences using TDD and unit testing for C++ in general with Visual Studio 2005 (Professional)
First some background. We have a fairly large project and much of it has been developed on Linux using CppUnit for the unit tests. The project is divided into several libraries, each with their own set of tests. I have a simple script which compiles the library, compiles the test suite and then runs the tests. So after making changes in the code I just run "test" from a command line and the tests run.
Now, most of the developers are using Visual Studio 2005 on Windows for the development of this product. Of course they can still run the tests from a command line using nmake but involves extra steps and I would prefer to have a much more integrated solution.
So my question has two parts.
Firstly, what is the best way of laying out the code for tests on a large code base? Is it normal to create several test projects in a solution, one for each library?
Secondly are there any tools for integrating CppUnit tests into Visual Studio? With dependencies set up corectly running the test project should run the tests but currently the results still appear in a command window.
One of the projects at my company does exactly this. We use a unit test framework called CXXTest (http://cxxtest.sourceforge.net/guide.html). We really like this framework for C++ because it only requires that you write a header file that contains your unit tests. The .CPP files are created by a script (both Python and Perl scripts are provided).
We integrate with visual studio by providing a post build step that builds the unit tests (if they need building) and then executes them. The output (showing what passed and what failed) is displayed in the output window -- you never need to leave the IDE.
I use the Boost Test framework. I tend to split my code into .lib files and will have a separate console-mode EXE test project for each. When the test project is built it makes use of the 'Post build stage' to launch itself, thus running the tests. You could make each test project a dependency of your main application so that each time it builds, all tests are run first, but this can be time-consuming. Instead I tend to run the test projects by hand as needed, but my automated nightly build system will run all test projects as a matter of course (I script this and if any tests fail, the build fails and I get an email notification).
More details here.
Here is what I do:
Personally, I don't think the test framework (Google Test, Boost test, CppUnit, etc) matters that much. Most are pretty much functionally equivalent.
I'm not entirely happy with the number of projects generated, but I consider this a Visual Studio GUI issue, in the sense that its actually quite useful to have these projects included like this for purposes such as debugging.
I tried using post build steps to run the tests but this unfortunately mean that the build was not interrupted after the first failure has passed.
My team is currently using an system where we have an automated nightly build (that can also be run from the project build dashboard by anyone) that includes a VS2k5 "test" solution. The test solution holds all the unit test projects; one unit test project for every "unit" of code in the main project.
When the automated build runs, it builds the main solution, then the test solution, and finally runs all the executables produced by the test solution (a Perl script glues this together). The results of the compile as well as the test execution (EXIT _ SUCCESS, EXIT _ FAILURE) are used to update the project build dashboard.
That EXIT _ FAILURE trick can also be applied to a custom build step of the main project: if the unit test custom build step returns EXIT _ FAILURE, then the build itself fails.
You can also use managed C++ to write unit tests in Visual Studio, using the unit testing framework that's built in.
Have a look at CUnitWin32. There's an example included as well.
vi is for cool kids.
Starting with Visual Studio 2010 you can use VsVim. It's a free extension available on the extension gallery. Source code is hosted on github
ViEmu is not free but does what you want at a cost of $99.
You may also want to read this http://vim.wikia.com/wiki/Integrate_gvim_with_Visual_Studio
Have you tried the gvim OLE package? I have used it with previous versions of Visual Studio and it worked okay.
http://www.vim.org/download.php#pc -- gvim##ole.zip
A GUI version with OLE support. This offers a few extra features, such as integration with Visual Developer Studio. But it uses quite a bit more memory.
Is there anyway to disable the rather annoying feature that Visual Studio (2008 in my case) has of copying the line (with text on it) the cursor is on when CTRL-C is pressed and no selection is made?
I know of the option to disable copying blank lines. But this is driving me crazy as well.
ETA: I'm not looking to customize the keyboard shortcut.
ETA-II: I am NOT looking for "Tools->Options->Text Editor->All Languages->Apply cut or copy to blank lines...".
The real problem you probably experience is that you go to paste, with CTRL+V. And you accidentally type CTRL+C, and end up overwriting the stuff that's on your clipboard. You can't disable this as far as I know, however, the work around for this, is that you can press CTRL+SHIFT+V multiple times to go back up the stack of things you have copied in visual studio. Not only does this allow you to recover what you originally copied, but you'll also find that CTRL+SHIFT+V very useful in a lot of other situations.
If you aren't willing to customize the keyboard settings, then Ctrl-C will always be Edit.Copy, which will copy the current line if nothing is selected. If you aren't willing to use the tools VS provides to customize the interface, then you can't do it.
However, the following works: Assign this macro to Ctrl-C:
Sub CopyOnlyIfSelection()
Dim s As String = DTE.ActiveDocument.Selection.Text
Dim n As Integer = Len(s)
If n > 0 Then
DTE.ActiveDocument.Selection.Copy()
End If
End Sub
I'm pretty sure the way to do it in 2008 is the same as the way in 2005... check out this tutorial on 'customizing keyboard shortcuts' (about 1/3 of the way down)
http://msdn.microsoft.com/en-us/library/bb245788(VS.80).aspx
I've the free SlickEdit add-in installed, and its CommandSpy feature shows that Ctrl-C executes Edit.Copy whether you've got text highlighted or not. Therefore I guess the answer to your question is No.
However, I do remember this feature annoying the hell out of me when I first encountered it; now I rely on it and get annoyed when I try the same trick in other programs and nothing happens.
I got the same problem, at first I thought it was my bad, I thought that i was accidentally typing ctrl-c in place of ctrl v but not, i'm really experiencing problems with these things
=/
I don't believe it is possible to do this without some type of 3rd party clip board manager that would prevent you from overwriting the clipboard content with the empty string.
What add-in/setting in Visual Studio can you not live without? Which one improves your productivity or fixes something you can't stand in Visual Studio? Why is it your favorite?
My favorite is aspx edit helper because it does really improve my productivity when working with ASP.NET applications. What it does is provide a quick way to type out server side controls, it automatically fills in runat="server" and id="" and puts your cursor in between the quotes of ID so you can type it in.
Here is a summarized list of all the plugins discussed so far
ReSharper! - It blows away the refactoring utils that are built-in to VS, and the default hotkeys as well. Once you get used to it, you'll never want to work on a VS installation that doesn't have it!
And if you use Subversion, VisualSVN is awesome!
Visual Assist X for C++, and .Net languages
rockscroll provides a preview of the entire document right next to the scroll bar:
I also like TestDriven.NET because it integrates NUnit for unit testing, NCover for code coverage, and Reflector for disassembling the .NET framework.
AnkhSVN, actually. Especially now that it's an actual SCC plugin.
It is vi emulator ViEmu. If you are used to using vim then this is one for VS.NET.
Increases the productivity a lot and i am keyboard freak who hates using mouse.
I have been using it for an year now and it is really stable.
CR Documentor allows you to preview your XML documentation without having to export them with something like sandcastle.
DevExpress CodeRush and Refactor!
I couldnt live without instant gratification from OS_CompilationResult. (It feels gimmicky, but I havent gotten around to uninstalling and a key feature is that you can start a build with Shift Ctrl B, switch to something else and it prompts when the build is finished). Of course my real answer is a +1 for CodeRush/Refactor Pro
VisualSVN for source control
Another great Visual Studio add-in is CodeKeep. CodeKeep is a website for storing snippets of code online for use later (kind of like an organized pastebin) and the Visual Studio Add-In integrates with it so you can have all your code snippets synchronized between all your systems.
Here is a screenshot:
Reflector
PowerCommands for Visual Studio
AnkhSVN (if you're using Subversion)
VSTS 2008 TFS Power Toys (if you're using TFS)
Currently I love using StyleCop for Visual Studio. It is brilliant in assisting with Code Formatting and Rules. ALso it is a free product from Microsoft based on .Net Best Practices. As far as I know it only works for C#,
Recently started to use this addin from Mindscape.
It has the potential to reduce context switches between VS and Windows Explorer (i.e. to get at Tortoise SVN or something) and has a neat feature that lets you start a command prompt in a directory in you source tree.
I actually have a favorite setting: Since i installed dark theme on my VS i'm getting the code from totally different point of view. And i like it.
I just found a great article talking about Ten Essential Visual Studio Add-ins every developer should know about, you can check it out here.
All but one of the Add-ins I use daily have already been mentioned by others, so I'll just throw in the Resource Refactoring Tool. Quite simply, it lets you take any hard-coded string, it creates a resource definition for it, and replaces all instances of that string in the entire project with a reference to the resource. Crazy handy when you have to write code with localization in mind.
When debugging Expression Trees in VS 2008 the Expression Tree Visualizer is great - http://msdn.microsoft.com/en-us/library/bb397975.aspx
The Regions Manager Add-In is great, It allows you to manage regions, move code into new regions or existing ones easily. It helps out a lot if you utilize regions heavily.
Edit: I also stumbled on another really good region manager plugin called regionerate.
DXCore Community Plugins is a collection of plugins built for DXCore (common IDE integration framework)
Linq2SQL Tools Add-in Adds the ability to sync your DBML with your database, its not free though.
CodeRush Xpress has come out and is being shipped for free!
My set of add-ins is the following:
VSCommands has lots of nifty frills for VS2010. Everyone will have a favorite - mine is the MSBuild summary dump, but I expect others will be interested in different parts. here's a pro edition, but the eval/community edition is worthwhile on its own in my experience.
Mostly amusing but I use it every time I reinstall Visual Studio is the Theme Generator, http://frickinsweet.com/tools/Theme.mvc.aspx
One that I have found beneficial from time to time has to be the Skype in Visual Studio. Here is a great tutorial on how to implement it yourself: http://www.codeproject.com/KB/dotnet/Skype_in_Visual_Studio.aspx
It also includes the code so it makes it available to play with your own Visual Studio add in. Which in my opinion is the best part of the article.
A close second would be the following for XPath expressions: http://www.codeplex.com/xmlexplorer
Visual Local History Allows you to have a revision history for local projects that you haven't placed in source control yet. This gives you the ability to keep revisions even when you are creating test/throw away projects.
Also check out: "Pimp My IDE": 101 Visual Studio tips, tricks, and add-ins
CodeSpell. Bad spelling looks unprofessional, and is difficult to refactor later in the project.
Re-sharper... now if only my company would buy me a copy.
I love IncrediBuild, a distributed compiling tool.
I love USysWare DPack Code Browser.
It opens a dialog with all available files in your solution with Alt-U. As you type, the available options filters accordingly. It does the same with the functions in the file with Alt-G. It's great!
That's much better than using the anti-navigable Solution Explorer tree.
The only drawback I see, it is a bit slow.
The Solution Navigator in the vs2010 Productivity Power Tools is very nice. I love being able to quickly filter by modified or open files. Search feature is also a good addition.
I second ReSharper. Can't live without it. The best investment I have made so far (regarding development).
My eyes are much happier since I started using the zenburn fonts and colours scheme. Soothing.
I'll cast another vote for both ReSharper and Visual Assist X. Both are great tools that greatly add to the Visual Studio experience in significant ways that have to be experienced to fully appreciate. I use both and appreciate both of them. I have used Visual Assist X for several years, and wouldn't want to program without it. I just started to use ReSharper, and I have become a huge fan of it, after using it to go through all my .Net code and correcting all the little code issues that it found, and my code was much better afterwards, and it even helped me find a potential bug or two that had remained hidden for quite some time, as well as identifying variables and code blocks that would never be executed, so they could be excised.
So, despite the ramble, I wholeheartedly vote for both ReSharper and Visual Assist X.
If you are a Linq2SQL user, the Linq 2 SQL Debugger Visualizer is a must have.. You can get it here
Visual Studio Window Manager allows you to manage and save window layouts for visual studio, this is very helpful for me because I like to hide all my toolbars by default, but sometimes to are helpful to have around.
Roland Weigelt's GhostDoc
Trac Explorer provides integration with Trac from within Visual Studio. This is a must have for any shop thats using Trac.
Xml Visualizer allows you to apply XSLT style sheets and run xpath queries on XML data, along with viewing the data better.
Dispatch is what the Copy Web Site function should have been
Here is a great site that lists a lot of visual studio plugins. http://www.visualstudiogallery.com/
ViEmu, my muscle memory has the Vi keybindings ingrained in it.
NDepend is a fantastic code analysis tool, easily the best I have seen for understanding your (or someone else's) code at multiple levels. Draws pretty diagrams too, and comes with its own query language for easily defining your own FXCop-style requirements.
Well if you're an ASP.NET developer the Visual Studio spell checker is useful: http://blogs.msdn.com/mikhailarkhipov/archive/2006/04/17/577471.aspx
Mindscape file explorer and Regionerate are not mentioned yet, but my favorite is definitely Reshareper.
As well as Resharper and VisualSVN, which have been mentioned numerous times already, I've also found the RegionTools macros by Roland Weigelt very useful and use them almost daily.
Multi-Lang Add-In allows you to easily manage localized applications.
A cool setting I just found is adding a Guide Line on your editor so you can see if you are going over a certain amount of characters, Sara Ford shows you how here.
NUnitForVS is great if you want to use NUnit without paying for VS integration.
VSFileExplorer is a nice file explorer for VS. It's also very helpful when used together with subversion/tortoiseSVN, since it displays the tortoise overlay icons within VS.
If you use Trac and Subversion, check out TracExplorer as well. I created it for my own needs, and so far it's exceeded all expectations.
Are you tired of having to open VSTD IDE to build/rebuild/clean your project?
Then this might help:
I only just found this, I wish I'd got it months earlier:
and the codeproject page with animations of it in action. My only gripe (which is a JSLint one) is that it warns about functions being undefined if they're not declared in order.
If you're using external libraries, you can stop JSLint throwing errors by adding the following, or equivalent to the top of the file:
/*extern $, jQuery */
Entrian Source Search, a Code Search add-in. Lets you search your source code in a fraction of a second, even for huge solutions. Gives syntax-coloured search results. Like Find In Files on steroids.
Goanna - a Visual Studio add-in for static analysis of C/C++. I can't live without it, because my day job is as a RedLizard Software programmer. :)
tangible T4 Editor is quite good for writing T4 templates
The free version has limited features, but it's nevertheless much better than the standard editor...
I'm surprised Cool Commands hasn't been mentioned yet. Can't do without them!
What are the major reasons for using Windbg vs the Visual Studio debugger?
Edit: and is it commonly used as a complete replacement for the VS debugger, or more for when the need arises.
If you are wondering why you should use windbg over Visual Studio, then you need to read Advanced Windows Debugging. Any time you need to debug a truly ugly problem windbg has better technology to do it with than Visual Studio. Windbg has a more powerful scripting language and allows you to write DLLs to automate difficult problems. It will install gflags.exe, which gives you better control over the heap for debugging memory overwrites.
You don't actually need to run the install, you can just copy the files over and be ready to go. Also it installs adsplus.vb, so you can take mini-dumps of running processes. It is also very easy to setup to perform remote debugging. There is nothing better than being able to debug a problem from your own desk instead of fighting the 15" monitor that flickers on a test PC.
For day to day code writing I use Visual Studio, but once you need to start debugging problems from other computers or find yourself in a very ugly situation, windbg is the only way to go. Spending some time learning windbg is a great investment. Also if you look at crash dumps there are two great resources, http://www.dumpanalysis.org/blog and http://blogs.msdn.com/ntdebugging/default.aspx that do all their debugging using windbg.
Here are some further links to help with using WinDbg, most are .NET specific.
You don't specify whether you're debugging native or managed code. It doesn't affect the answer, WinDbg is extremely useful for both, but many people believe that WinDbg is somehow less relevant when debugging .NET apps. Not so. As a bonus, you can learn a lot about how the .NET platform works by debugging your .NET app in WinDbg with the SOS extension. Run up (or attach to) your .NET app in WinDbg and type...
.loadby sos mscorwks
...to be sure that you load the right extension for the version of the CLR in use. Then type...
!help
... to see what commands are available in the SOS extension.
I've heard it joked that Microsoft only has one developer tool, and it's WinDbg. Everything you could possibly want for debugging is in there, or in an extension. Sure, a subset of those things are also available in VS with a friendlier UI... :-)
I have used it when I've been sent .dmp files from an NT4.0 server - MSVC won't load these old format files.
Mixing kernel-debugging plus remote-user-mode-debugging.
AFAIK, visual studio still cannot do remote debugging in the mode I describe as "solution". That's a darn good reason to use windbg.
Problem:
Solution:
Also, I find it easier to use the same debugger for both kernel mode and user mode, windbg is very powerful even in user mode, and I can leverage my own windbg extensions in both kernel mode and user mode instances.
Lightweight, can be run without installing it on a client's machine, fast, can debug kernel mode.
Is the latest visual studio still missing an equivalent to windbg's "-o" that makes the debugger automatically attach to child processes? Very useful for apps that must be run from a complicated .bat file, or apps that fork and exit the parent process.
I always liked the watch and trace feature: 'wt' -> It prints to the output window all the function calls as they happen. That was pretty cool stuff!
I've found that on some occasions I can edit the source while debugging, are there any other advantages of using the Visual Studio built-in webserver instead of a virtual directory in IIS?
I'm using windows XP on my development environment, and a local instance of IIS 5. I work on several projects, so I use multiple virtual directories to manage all the different sites.
Are there any disadvantages?
The built in web server for Visual Studio is called Cassini and here are a few of its limitations...
All the previous responses are great answers - here's one gottcha with Cassini that might require IIS on the destkop.
Cassini runs in the context of the developer, not as the IIS user (IUSR_, IWAM, or in WinXP x64, the w3wp process). This can be a bit painful if you've got a web site that is accessing external files or creating temp files. It is most evident when your developer is running as an Admin of their desktop.
When you move to the server IIS, something that you would have had access to in Cassini doesn't work the same. CACLing with the IIS_WPG usually is all it takes to fix, but if your developer is not thinking about this, they will quickly get quite frustrated with their deploy.
The built in server works well for larger corporations that don't want to give developers any admin access on their own machines to configure IIS.
Cassini does not support virtual directories
Looks like a 3rd option is coming soon: IIS Express.
The visual studio web server is less forgiving about // in the path.
it will refuse to serve a link like: http://localhost:52632/main//images/logo.jpg where IIS will serve that file
Thats pretty obscure but meant we had a lot of fixing to do to get rid of all // occurance.
Another disadvantage I've run into is on a Forms authenticated website using custom IPrincipal/IIdentity. Cassini will switch the AppDomains without warning (or notice).
http://www.lhotka.net/weblog/UpdateOnMyStrugglesWithTheASPNETDevelopmentServer.aspx
The headache on this made me drop Cassini and stick with IIS.
There's a bug in the way the built-in server handles HTTPModules - there is a workaround, but I hate having to put in code that'll never be needed in production.
Cassini also does not support classic ASP pages. This is only an issue for legacy projects where old ASP pages still exist (like our web app at work).
You have to have visual studio running to use it (under normal circumstances)
It only responds to localhost so you cant give the link http://simon-laptop:37473/app1 to a friend to view your site over the network
Big disavantage : its harder to get fiddler working because localhost traffic isn't sent through the proxy.
Edit: using http://ipv4.fiddler:37473 is the best way to get Fiddler working with it.
If you do hobby work at home using XP Home, you can't install IIS locally.
Install IISAdmin, and you can setup separate sites in IIS 5, instead of using virtual directories.
If you 'web reference' the url for web services that are on the built-in webserver, the port might change. Unless you have set a "Specific port" mentioned in the Project->Properties options page.
This is something I've gotten used to now. I always set a specific port. Now when sometimes the webserver crashes (I've had that happen), I simply change the port number, and all is well. I reckon restarting will also fix this.
You cant use virtual directories :(
When you use IIS in Vista or Windows 7 with UAC enabled, you must run Visual Studio with administrative rights. If you do this, you can't drag an drop from your shell to Visual Studio (even if you run an instance of explorer.exe as administrator).
For this reason I use Cassini for most projects.
FYI, Windows XP 64-bit comes with IIS 6.
The built in server isn't as configurable, and it runs on an odd port, so if your counting on specific behavior it can be troublesome.
If your project resides in the IIS directory you can still edit code, just depends if it has been published or not. You will run into so issues on the Cassini vs IIS when you are debugging certain permission based scenarios, like kerberos and ntlm authentication as well as issues like server compression etc. All in all the Cassini is still okay to dev with but make sure you do extensive testing when publishing to IIS.
The built in server means the developer doesn't have to know how to set up IIS to test their site.
You could argue this is a disadvantage, and that a windows developer should know at least that much IIS. Or you could argue that a developer who isn't a sysadmin shouldn't be messing around with the web server at all.
I think really they are pretty similar, and I don't like working on either. IIS 5 is really out of date, and I am of the firm opinion that all asp.net developers should develop on a server platform either running it as your main operating system or at least in a vm. The differences between XP IIS 5/WS IIS and 2003 (and I guess 2008 now) are just too big when you really get into heavy website development.
The built-in webserver is a little less robust than IIS, but requires no setup so it is just a tradeoff.
You may not always want your development projects exposed on your IIS server (even your local IIS server) so the built-in server is good for that.
However, if your application is going to access resources outside of the norm for a web app then you may want to debug frequently in IIS so that your app will run with restricted permissions and you can see where the pain points will be.
I often take the best of both worlds and create an application in IIS, and use the built in web server for more efficient debugging.
Cassini is ment to be a light waight test webserver. The idea is that a developer does not need to have IIS installed and configured to test his application. Use IIS if you are familier with it and you have it setup and your box can handel it. Cassini is not ment to be a replacement.
We've also seen some issues with VS built-in server regarding some third-party controls which put their scripts at the \aspnet_client folder. Since the folder isn't there when you're not running under IIS, the controls didn't work. It seems a lot simpler to always work with IIS and avoid strange problems.
One difference I've found is that the development server handles uploading files differently than IIS does. You can't trap the error if the file being uploaded is bigger than your Max_File_Size setting. The page just dies and returns a 500.
Another dis-advantage is that it sends every request through the gloabal asax file which includes all requests for images and stylesheets. This means if you have code in there which does things with the file names, such as a look up, then the auxillary files willget processed too.
This is an old thread started 2 years ago. I just stumbled upon UtilDev Cassini while googling. Looks promising to me. At least it has the ability to run multiple sites simultaneously. That feature is really useful for me, because I work on 2 different sites and have to continuously switch between them using IIS.
Here's a reason for a third way: although UWS Pro is probably closer to IIS than Cassini (although inspired by Cassini and is from the vendor of the UltiDev Cassini fork), its main purpose is to be redistributable along with ASP.NET applications.
I'm one of the AnkhSVN developers, so I shall not comment on which you should choose.
But why don't you try for yourself? VisualSVN has a 30 days trial, and AnkhSVN is free.
AnkhSVN 2.0 contains more new code, than code from AnkhSVN 1.X and AnkhSVN is now a real VAPI SCC provider. When comparing the products you should look at AnkhSVN 2.0 and Visual SVN (And not at AnkhSVN 1.X, as that is a completely different beast)
The current version of AnkhSVN and VisualSVN are both built on Subversion 1.5 and you can just switch between them.
When you are evaluating AnkhSVN 2.0 I would recommend looking at the preview of the next AnkhSVN too. On http://anhsvn.net/daily you can find daily builds with the latest fixes and new features.
[Note that the SCC VAPI implemented by AnkhSVN 2.0 is a different thing than the the old style MSSCCI api of previous Visual Studio versions. MSSCCI forced its implementation to use checkout-checkin with read only files, while the new one allows providing your own workflow.]
I used AnkhSVN for a few weeks and deleted it frustrated afterward. After some research I found VisualSVN and what can I say: It's a seamless integration between Subversion/TortoiseSVN and Visual Studio. I used it about two weeks and ordered the full version afterward. I'm now quite happy with it for nearly two years and don't notice any serious bugs.
Sure, it isn't free. But for academic use or for OpenSource projects you can get a free license. And companies should spend the license costs, it's worth it!
So, what are the advantages:
Without VisualSVN I wouldn't have the leisure to make a repository for every project I code on. It's worth a try with the 30 days test period. :)
I used AnkhSVN for about a year and it worked very well. Though there were one or two times when it caused VS to hang, it didn't happen after I updated.
I haven't used VisualSVN...
Trying both or just go with AnkhSVN since it's free. If you like it great, if not try VisualSVN. You can't go wrong.
Also I typically use several SVN clients and tend to do different things with different clients. For example I like to browse the repository and diff with Tortoise, but I like doing merges by the command line client so I know exactly what's happening
AnkhSVN is free, which is a great price :-)
My only complaints with it are when a configuration setting gets messed up - good luck trying to figure out what to do. The documentation isn't very good, either. And a lot of buttons on the UI are always disabled, which is a little weird.
That being said, for the most part, it has a lot of functionality and the integration with VS is pretty nice. I like it.
I tried both and IMO AnkSVN is better. The features are almost the same in both products, but AnkhSVN just works, whereas VisualSVN could not connect to my repository.
What's even worse, the support for VisualSVN was non-exsitant. In lack of any alternatives, I posted to the VisualSVN support forum, but go no reply within the 5 days I checked. Since version 2.0 of AnkhSVN was released, it worked flawlessly on my system, so I really don't see any reason to ever give VisualSVN another try.
AnkhSVN is unbeatable IMHO.
The price is great (free), the features are superb and most important of all: it is actively developed with dailies occuring, hmmm, daily ;)
I think the main reason why I am using AnkhSVN is because it is installed as a Visual Studio Source Control plugin, rather than as an outside application that interacts with Visual Studio...
I have never used VisualSVN, but I use AnkhSVN every day, and I've never had a single problem with it yet (though, to be fair, I use TortoiseSVN for many things that I can't be bothered to figure out how to do with AnkhSVN).
I tried both but ended up going with an alternative suggestion. Here's a post that describes how to integrate TortoiseSVN with the Visual Studio toolbar.
If cost was not an issue, I would definitely prefer VisualSVN. I tried both and VisualSVN seemed less buggy (especially when renaming files and/or folders through Visual Studio). In fact, my entire team used VisualSVN and I don't recall a single problem or moment of instability.
Tried both. Sometimes free things are just too cheap. If you get my drift.
VisualSVN all the way. You could get one functional for 49$ or less.
Today I did a bake off with ankh and visualsvn on 2 machines. On my very first operation, Ankhsvn failed to create the repository for a solution. It throws up a dialog with a red circle error icon, saying something about selecting a folder, but there is no folder to pick. There were no instructions or help for this when I clicked the help button. I even tried manually creating the repository and pointing ankh to it, with the proper url format, same error.
Then with visualsvn I had it out in the weeds in about 1 minute. It created the repository for the solution, no problem. Then I explored the menus for it a bit, and tried the commit. Bunch of added files to commit, okay looks right, but the commit hung somewhere. I got tried of waiting so I hit the x button. Bad idea. Now it won't do anything with subversion, says to cleanup, but cleanup won't run due to a lock -- a subversion lock I have to research I guess. So visualsvn is better than ankh on my bake off, and I did get visualsvn to work by starting over (deleted all the .svn folders) and letting the commit finish. Dialog text is cutoff too, I use hi-res with large fonts, need to test for this.
I haven't tried either of these yet, but I'll be trying AnkhSVN first. It looks like if I have problems (other than SVN's inherent frustrations), the Ankh team is pretty responsive and interested in all the details.
Has anyone used VSTortoise?
We use Ankh+Tortoise here, and Ankh hasn't quite handled the 2.0 transition yet for our system. Trying to update or commit a project within visual studio if the project is in a working copy of the entire repository, it will try to work above the folder level of the project and update everything. That's probably an issue with how our repository is set up (the guy who did it had no clue what he was doing), but Ankh should still be able to compensate. Tortoise has been pretty solid, though.
BTW, I'm also in Madison.
ankh is free VisualSVN is not. VisualSVN worked right out of the box. Ankh had issues for me in VS2k8. Get what you pay for...
I had problems with AnkhSvn when I tried it 12 months ago. I uninstalled it and went with VisualSVN which has been trouble free since.
Same same but different. It's funny how those who never tried VisualSVN say that AnkhSvn is better. I used both. I am going back to Visual SVN for one single feature that i miss. "Revert this block only". If it saves me a few minutes a week - it's worth it.
I can't recommend using Ankh SVN. There are two problems I have with it. Firstly it only works at the level of your source code. We have various tools and libraries in folders above the source code folder which frequently get missed in commits. Secondly it's not reliable. It frequently (at least one or twice a week) randomly excludes files from commits. I've even been in a situation where a local file and a repository file have got out of sync so committed changes don't end up in the repository.
I've got 2 monitors, and most of the time I've got some reference material open on one screen, and Visual Studio on the other. To really get in the zone, though, I need my code to be the only thing I see. Does anyone know if it's possible to have multiple code windows in Visual Studio? So far the best I can do is put debugger output and the solution explorer on my left monitor, and the rest of VS on the right. I would love to have code on both windows, however.
If you right click on the file tabs, there's an option for "New Vertical Tab group" Just maximize across both monitors and put the divider on the monitor divide and I think that's what you're after.
See also the "Visual Studio and dual/multiple monitors: how do I get optimized use out of my monitors?" question.
Though I use StudioTools for other purposes, it has a "Tear off Editor" option, with which you can "tear off" the file to a window and resize the window. Find it quite helpful
Instead of enlarging the VS2008 window to span the two monitors, you can display the 'Code Definition Window' on another monitor: just drag it outside the main window! I find this very handy to avoid switching between code windows: it is very often that one is interested in the definition of the symbol under the cursor...
The same is true for other windows like the 'Class View', the 'Call Browser', etc. You can choose to keep them grouped in the same group with tabs, or drag each of them separately (click on the label of the tab to start the drag).
I want to use Vim's quickfix features with the output from Visual Studio's devenv build process or msbuild.
I've created a batch file called build.bat which executes the devenv build like this:
devenv MySln.sln /Build Debug
In vim I've pointed the :make command to that batch file:
:set makeprg=build.bat
When I now run :make, the build executes successfully, however the errors don't get parsed out. So if I run :cl or :cn I just end up seeing all the output from devenv /Build. I should see only the errors.
I've tried a number of different errorformat settings that I've found on various sites around the net, but none of them have parsed out the errors correctly. Here's a few I've tried:
set errorformat=%*\\d>%f(%l)\ :\ %t%[A-z]%#\ %m
set errorformat=\ %#%f(%l)\ :\ %#%t%[A-z]%#\ %m
set errorformat=%f(%l,%c):\ error\ %n:\ %f
And of course I've tried Vim's default.
Here's some example output from the build.bat:
C:\TFS\KwB Projects\Thingy>devenv Thingy.sln /Build Debug
Microsoft (R) Visual Studio Version 9.0.30729.1.
Copyright (C) Microsoft Corp. All rights reserved.
------ Build started: Project: Thingy, Configuration: Debug Any CPU ------
c:\WINDOWS\Microsoft.NET\Framework\v3.5\Csc.exe /noconfig /nowarn:1701,1702 /errorreport:prompt /warn:4 /define:DEBUG;TRACE /reference:"C:\Program Files\Reference Assemblies\Microsoft\Framework\v3.0\PresentationCore.dll" /reference:"C:\Program Files\Reference Assemblies\Microsoft\Framework\v3.0\PresentationFramework.dll" /reference:"C:\Program Files\Reference Assemblies\Microsoft\Framework\v3.5\System.Core.dll" /reference:"C:\Program Files\Reference Assemblies\Microsoft\Framework\v3.5\System.Data.DataSetExtensions.dll" /reference:c:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\System.Data.dll /reference:"C:\Program Files\Reference Assemblies\Microsoft\Framework\v3.5\System.Data.Linq.dll" /reference:c:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\System.dll /reference:c:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\System.Xml.dll /reference:"C:\Program Files\Reference Assemblies\Microsoft\Framework\v3.5\System.Xml.Linq.dll" /reference:"C:\Program Files\Reference Assemblies\Microsoft\Framework\v3.0\UIAutomationProvider.dll" /reference:"C:\Program Files\Reference Assemblies\Microsoft\Framework\v3.0\WindowsBase.dll" /debug+ /debug:full /filealign:512 /optimize- /out:obj\Debug\Thingy.exe /resource:obj\Debug\Thingy.g.resources /resource:obj\Debug\Thingy.Properties.Resources.resources /target:winexe App.xaml.cs Controller\FieldFactory.cs Controller\UserInfo.cs Data\ThingGatewaySqlDirect.cs Data\ThingListFetcher.cs Data\UserListFetcher.cs Gui\FieldList.xaml.cs Interfaces\IList.cs Interfaces\IListFetcher.cs Model\ComboBoxField.cs Model\ListValue.cs Model\ThingType.cs Interfaces\IThingGateway.cs Model\Field.cs Model\TextBoxField.cs Model\Thing.cs Gui\MainWindow.xaml.cs Gui\ThingWindow.xaml.cs Interfaces\IField.cs Properties\AssemblyInfo.cs Properties\Resources.Designer.cs Properties\Settings.Designer.cs RequiredValidation.cs "C:\TFS\KwB Projects\Thingy\Thingy\obj\Debug\Gui\FieldList.g.cs" "C:\TFS\KwB Projects\Thingy\Thingy\obj\Debug\Gui\MainWindow.g.cs" "C:\TFS\KwB Projects\Thingy\Thingy\obj\Debug\Gui\ThingWindow.g.cs" "C:\TFS\KwB Projects\Thingy\Thingy\obj\Debug\App.g.cs" "C:\TFS\KwB Projects\Thingy\Thingy\obj\Debug\GeneratedInternalTypeHelper.g.cs"
C:\TFS\KwB Projects\Thingy\Thingy\Controller\FieldFactory.cs(14,19): error CS0246: The type or namespace name 'IFieldNothing' could not be found (are you missing a using directive or an assembly reference?)
Compile complete -- 1 errors, 0 warnings
========== Build: 0 succeeded or up-to-date, 1 failed, 0 skipped ==========
UPDATE: It looks like using msbuild instead of devenv is probably the right way to go (as per Jay's comment).
Using msbuild the makeprg would be:
:set makeprg=msbuild\ /nologo\ /v:q
Sample output whould be:
Controller\FieldFactory.cs(14,19): error CS0246: The type or namespace name 'IFieldNothing' could not be found (are you missing a using directive or an assembly reference?)
It looks like the tricky part here may lie in the fact that the path is relative to the .csproj file, not the .sln file which is the current directory in Vim and lies one directory above the .csproj file.
ANSWER: I figured it out...
set errorformat=\ %#%f(%l\\\,%c):\ %m
This will capture the output for both devenv /Build and msbuild. However, msbuild has one catch. By default, it's output doesn't include full paths. To fix this you have to add the following line to your csproj file's main PropertyGroup:
<GenerateFullPaths>True</GenerateFullPaths>
Copy from question to remove from 'unanswered' list
set errorformat=\ %#%f(%l\\\,%c):\ %m
This will capture the output for both devenv /Build and msbuild. However, msbuild has one catch. By default, it's output doesn't include full paths. To fix this you have to add the following line to your csproj file's main PropertyGroup:
<GenerateFullPaths>True</GenerateFullPaths>
I have a blog post which walks through all the details of getting C# projects building in Vim, including the error format. You can find it here: http://kevin-berridge.blogspot.com/2008/09/vim-c-compiling.html
In short you need the following:
:set errorformat=\ %#%f(%l\\\,%c):\ %m
:set makeprg=msbuild\ /nologo\ /v:q\ /property:GenerateFullPaths=true
Try running msbuild instead of devenv. This will open up a ton of power in how the build runs.
Open a Visual Studio Command Prompt to get your path set up. Then do msbuild MySln.sln /Configuration:Debug.
See msbuild /? for help.
I found this question when looking for errorformat for compiling c++ in Visual Studio. The above answers don't work for me (I'm not using MSBuild either).
I figured out this from this Vim Tip and :help errorformat:
" filename(line) : error|warning|fatal error C0000: message
set errorformat=\ %#%f(%l)\ :\ %#%t%[A-z]%#\ %[A-Z\ ]%#%n:\ %m
Which will give you a quickfix looking like this:
stats.cpp|604 error 2039| 'getMedian' : is not a member of 'Stats'
(with error highlighted) from
c:\p4\main\stats.cpp(604) : error C2039: 'getMedian' : is not a member of 'Stats'
As Simon Buchan mentioned you can use this in your project to generate the full paths in the output:
<GenerateFullPaths>True</GenerateFullPaths>
But you can make it more portable by adding /property:GenerateFullPaths=true to you makeprg instead of adding the above to your project files.
:set makeprg=msbuild\ /nologo\ /v:q\ /property:GenerateFullPaths=true\
I found an even better answer: use :compiler to use built-in efm settings.
" Microsoft C#
compiler cs
" Microsoft Visual C++
compiler msvc
" mono
compiler mcs
" gcc
compiler gcc
Note: It also sets the default makeprg. See $VIMRUNTIME/compiler/
None of these errorformats worked in Visual studio 2009 v9.0.21022.8 professional edition. Using cygwin, had to call devenv from bash which made setting makeprg a little tricky (screw batch files). Also had to tweak my errorformat when devenv splits into multiple processes and proceeds error message with "1>" or "2>" etc:
set autowrite
"2>c:\cygwin\home\user\proj/blah.cpp(1657) : error C2065: 'blah' : undeclared identifier
set errorformat=%.%#>\ %#%f(%l)\ :\ %#%t%[A-z]%#\ %[A-Z\ ]%#%n:\ %m
let prg="devenv"
let makepath=$MAKEPATH
let &makeprg='cmd /c "'.prg.' '.makepath.'"'
My .bashrc sets the MAKEPATH environment variable using cygpath to convert to a DOS compatible path:
export MAKEPATH="$(cygpath -d "proj/VC9/some.sln") /build \"Debug\""
If you have vim 6.x you can use :cw which is SO much better than clist (try searching for errors among hundreds of warnings and you know what I mean). Looking at vim tweaks makes me want to vomit but I'm in vim heaven!!! Good bye visual studio! Thanks for the base to tweak pydave +1.
Visual Studio is such a massively big product that even after years of working with it I sometimes stumble upon a new/better way to do things or things I didn't even know were possible.
For instance-
Crtl + R, Ctrl + W to show white spaces. Essential for editing Python build scripts.
Under "HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\8.0\Text Editor" Create a String called Guides with the value "RGB(255,0,0), 80" to have a red line at column 80 in the text editor.
What other hidden features have you stumbled upon?
Make a selection with ALT pressed - selects a square of text instead of whole lines.
Tracepoints!
Put a breakpoint on a line of code. Bring up the Breakpoints Window and right click on the new breakpoint. Select 'When Hit...'. By ticking the 'Print a message' check box Visual Studio will print out a message to the Debug Output every time the line of code is executed, rather than (or as well as) breaking on it. You can also get it to execute a macro as it passes the line.
You can drag code to the ToolBox. Try it!
Click an identifier (class name, variable, etc) then hit F12 for "Go To Definition". I'm always amazed how many people I watch code use the slower right-click -> "Go To Definition" method.
EDIT: Then you can use Ctrl+- to jump back to where you were.
Sara Ford covers lots of lovely tips: http://blogs.msdn.com/saraford/archive/tags/Visual+Studio+2008+Tip+of+the+Day/default.aspx
But some of my favourites are Code Snippets, Ctrl + . to add a using <Namespace> or generate a method stub. I can't live without that.
Check out a great list in the Visual Studio 2008 C# Keybinding poster: http://www.microsoft.com/downloadS/details.aspx?familyid=E5F902A8-5BB5-4CC6-907E-472809749973&displaylang=en
CTRL+SHIFT+V will cycle through your clipboard, Visual Studio keeps a history of copies.
CTRL-K, CTRL-D
Reformat Document!
This is under the VB keybindings, not sure about C#
How many times do you debug an array in a quickwatch or a watch window and only have visual studio show you the first element? Add ",N" to the end of the definition to make studio show you the next N items as well. IE "this->m_myArray" becomes "this->m_array,5".
Incremental search: While having a source document open hit (CTRL + I) and type the word you are searching for you can hit (CTRL + I) again to see words matching your input.
You can use the following codes in the watch window.
@err - display last error
@err,hr - display last error as an HRESULT
@exception - display current exception
Can't live without it! :)
Stopping the debugger from stepping into trivial functions.
When you?re stepping through code in the debugger, you can spend a lot of time stepping in and out of functions you?re not particularly interested in, with names such as GetID(), or std::vector<>(), to pick a C++ example. You can use the registry to make the debugger ignore these.
For Visual Studio 2005, you have to go to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\VisualStudio \8.0\NativeDE\StepOver and add string values containing regular expressions for each function or set of functions you wish to exclude; e.g.
std\:\:vector.*\:\:.*
TextBox\:\:GetID
You can also override these for individual exceptions. For instance, suppose you did want to step into the vector class?s destructor:
std\:\:vector.*\:\:\~.*=StepInto
You can find details for other versions of Visual Studio at http://blogs.msdn.com/andypennell/archive/2004/02/06/69004.aspx
Ctrl-F10: run to cursor during debugging. Took me ages to find this, and I use it all the time;
Ctrl-E, Ctrl-D: apply standard formatting (which you can define).
TAB key feature.
If you know snippet key name, write and click double Tab. for example: Write
foreach
and then click tab key twice to
foreach (object var in collection_to_loop)
{
}
2. If you write any event, write here
Button btn = new Button();
btn.Click +=
and then click tab key twice to
private void Form1_Load(object sender, EventArgs e)
{
Button btn = new Button();
btn.Click += new EventHandler(btn_Click);
}
void btn_Click(object sender, EventArgs e)
{
throw new Exception("The method or operation is not implemented.");
}
btn_Click function write automatically
MouseLeftButtonDown then click tab
MouseLeftButtonDown="" then click tab again MouseLeftButtonDown="Button_MouseLeftButtonDown" in the code section Button_MouseLeftButtonDown method created.
Sara Ford has this market cornered.
http://blogs.msdn.com/saraford/default.aspx
More Visual Studio tips and tricks than you can shake a stick at.
Some others:
T4 (Text Template Transformation Toolkit). T4 is a code generator built right into Visual Studio
Custom IntelliSense dropdown height, for example displaying 50 items instead of the default which is IMO ridiculously small (8).
(To do that, just resize the dropdown next time you see it, and Visual Studio will remember the size you selected next time it opens a dropdown.)
Discovered today:
Ctrl + .
Brings up the context menu for refactoring (then one that's accessible via the underlined last letter of a class/method/property you've just renamed - mouse over for menu or "Ctrl" + ".")
A lot of people don't know or use the debugger to it's fullest - I.E. just use it to stop code, but right click on the red circle and there are a lot more options such as break on condition, run code on break.
Also you can change variable values at runtime using the debugger which is a great feature - saves rerunning code to fix a silly logic error etc.
Line transpose, Shift-Alt-T
Swaps two line (current and next) and moves cursor to the next line. I'm lovin it. I've even written a macro which changed again position by one line, executed line transpose and changed line position again so it all looking like I swapping current line with previous (Reverse line transpose).
Word transpose, Shift-Ctrl-T
To auto-sync current file with Solution Explorer. So don't have to look where the file lives in the project structure
Tools -> Options -> Projects and Solutions -> "Track Active Item in Solution Explorer"
Edit: If this gets too annoying for you then you can use Dan Vanderboom's macro to invoke this feature on demand through a keystroke.
(Note: Taken from the comment below by Jerry).
When developing C++, Ctrl-F7 compiles the current file only.
Document Outline in the FormsDesigner (CTRL + ALT + T)
Fast control renaming, ordering and more!
I'm not sure if it's "hidden", but not many people know about it -- pseudoregisters. Comes very handy when debugging, I've @ERR, hr in my watch window all the time.
Ctrl-Minus, Ctrl-Plus, navigates back and forward where you've been recently (only open files, though).
Here's something I learned (for C#):
You can move the cursor to the opening curly brace from the closing curly brace by pressing Control + ].
I learned this on an SO topic that's a dupe of this one:
I don't use it often, but I do love:
ctrl-alt + mouse select
To select in a rectangular block, to 'block' boundaries.
As noted in comments,
alt + mouse select
Does just a plain rectangular block.
CTRL + Shift + U -> Uppercase highlighted section. CTRL + U -> Lowercase the highlighted section Great for getting my SQL Statements looking just right when putting them into string queries.
Also useful for code you've found online where EVERYTHING IS IN CAPS.
Middle Mouse Button Click on the editor tab closes the tab.
To display any chunk of data as an n-byte "array", use the following syntax in Visual Studio's QuickWatch window:
variable, n
For example, to view a variable named foo as a 256-byte array, enter the following expression in the QuickWatch window:
foo, 256
This is particularly useful when viewing strings that aren't null-terminated or data that's only accessible via a pointer. You can use Visual Studio's Memory window to achieve a similar result, but using the QuickWatch window is often more convenient for a quick check.
Ctrl + Delete deletes the whole word (forward)
Ctrl + Backspace deletes the whole word (backward)
The following is well known but am I wrong saying it hasn't been listed yet ?
Ctrl + Shift + Space inside the parentheses of a method call gives you the parameter info.
CTRL-D then type ">of " then file name. If the standard toolbar is up crtl-d put you in find combobox and there is now a dropdown with files in your solution that match the start of the filename you typed. Pick one and it will open it. This alternative to the open filedialog is awesome for big solutions with lots of directories.
Drag-drop text selections to the Watch window while in the debugger.
I accidentally found this one just now. When you are anywhere on a line and press Ctrl + Enter, it will insert a new line above the current line and move the cursor there.
Also, if you press Ctrl + Shift + Enter, it will insert a new line below the current line and move the cursor there (similar to End, Enter)
During debugging, Select an identifier or expressing and drag it to the watch window.
Beats having to write it from scratch :)
Press the F8 key to cycle through search results. (Shift+F8 for reverse direction)
Hit F12 to go to definition of variable.
Shift + alt + arrow keys = Block select!
Can't live without it! :)
.NET debugger allows you to give objects identifiers, and to refer them via those identifiers later during the session. To do so, you right-click on the variable (or expression) referencing the object in Autos/Locals/Watch window, or in the tooltip, and select "Create Object ID". IDs are sequential integer numbers, starting from 1, and suffixed by "#" - e.g 1# will be the first ID you create.
After the ID is created, if the object is associated with a given ID, it is displayed in parentheses.
You can use 1# to reference the object by ID anywhere you can normally use expressions - in Watch window, in condition of a conditional breakpoint, and so on. It's most handy when you want to set a breakpoint on a method of some particular object only - if you can first track the object creation, or some other place where this particular object is referenced, you just create the ID for it, and then set a new breakpoint with condition such as this==1#.
Ever want to look for a function in your current viewed file but there are too many member to browse? Need a filter? Then, the Navigate box is what you need. You activate it by Ctrl-, (comma).
Shift+Alt+F10 brings up the built in refactoring menu. Great for adding method stubs from interfaces, and adding Using statements automatically for specific classes.
There is an article about this. It seems to be a lengthy collection.
You can drag down the little gray box above the vertical scrollbar to split the window into two views of the same file, which can be scrolled independently - great if you're comparing two parts of the same file.
View, Other Windows, Object Test Bench
The object test bench can be used to execute code at design-time.
You can right-click on a type in Class View, click Create Instance, and select a constructor. You can then supply values for its parameters, if any, and the instance will show up in the Object Test Bench.
You can also call static methods by right-clicking a type and clicking Invoke Static Method.
In the Object Test Bench, you can right-click on an object to call methods, and you can hover over it and see its structure (like you can when debugging). You can also assign to and interact with these variables in the Immediate window, also at design time.
This feature can be useful when writing a library. Please note that to use this, your solution must be compile first.
A very little known fact is that Visual Studio 2008 does support real XSLT intellisense - not a static XSLT schema-based one, but real dynamic intellisense enabling autocompletion of template names, modes, parameter/variable names, attribute set names, namespace prefixes etc.
For all versions of VS I like
Ctrl + Shift + V
for copying data in clipboard cycle.
The existence of the Resharper add-in. It makes working with Visual Stupidio less of a pain :)
It's not really a hidden feature, but worth mention nonetheless as it comes with tons of these tricks and hotkeys.
In the watch window, you can view the current exception even if you have no variable to hold it by adding a watch on $exception
I'm surprised no one has mentioned this yet. I find the ability record and play back a series of actions very, very helpful sometimes. Like if I'm applying some repetitive action to a few lines in a text file.
For example
Ctrl+Shift+R (start recording macro)
perform a series of keystrokes
Ctrl+Shift+R (stop recording macro)
later....
Ctrl+Shift+P (play back keystrokes)
This approach is ideal for a short, one time manipulations. If it's something more involved or needed more than once, I'll write a script.
Close all documents other than the one your on by right clicking the doc's tab and selecting "Close All But This." You can do this in many other IDEs and browsers as well. Not a big feature but I find that I use it 10+ times a day. This feature was hidden from me for many years. I should map it to a keyboard shortcut :p
Ctrl+Tab - switch between open tabs/windows in Visual Studio 2005 & 2008.
Kind of like Alt+Tab in Windows, brings up a little box just for the currently open VS files.
Here's a sample screenshot:
The Debugger :-) Beats Notepad by miles.
I always map control + alt + f4 to documents.CloseAllWindows in options>environment>keyboard.
Is somewhat more intuitive than using the mouse.
I think the ability to right click on a Stored Procedure in Server Explorer and debug..
Copy-paste from a Watch window of an object's expanded properties in the debugger into Excel will perserve the tabular format and persist the data after the debug session is over.
Here is the Macro source for my aspx/aspx.cs flipper. It works in 2005, but it may have issues in 08.. I'm not sure... This was taken from my other cpp/h flipper, so there might be some clean up needed to make it the best it could be. I'm not paid to write Macros, so I have to blast though them as quickly as possible when I need one.
Sub OpenASPOrCS()
'DESCRIPTION: Open .aspx file if in .cs file, open .cs file if in .aspx file
On Error Resume Next
' Get current doc path
Dim FullName
FullName = LCase(ActiveDocument.FullName)
If FullName = "" Then
MsgBox("Error, not a .cs or asp file!")
Exit Sub
End If
' Get current doc name
Dim DocName
DocName = ActiveDocument.Name
Dim IsCSFile
IsCSFile = False
Dim fn
Dim dn
If (Right(FullName, 3) = ".cs") Then
fn = Left(FullName, Len(FullName) - 3)
dn = Left(DocName, Len(DocName) - 3)
IsCSFile = True
ElseIf ((Right(FullName, 5) = ".aspx") Or (Right(FullName, 5) = ".ascx")) Then
fn = FullName + ".cs"
dn = DocName + ".cs"
Else
MsgBox("Error, not a .cs, or an asp file!")
Exit Sub
End If
Dim doc As EnvDTE.Documents
DTE.ItemOperations.OpenFile(fn)
doc.DTE.ItemOperations.OpenFile(fn)
If Err.Number = 0 Then
Exit Sub
End If
' First check to see if the file is already open and activate it
For Each doc In DTE.Documents()
If doc.Name = dn Then
doc.Active = True
Exit Sub
End If
Next
End Sub
Ctrl+L deletes the current selected line. This is an awesome time saver (if used responsibly of course!!!)
Ctrl-M + Ctrl-L Toggle Collapse All - Expand All
Ctrl-T swaps the last two letters. For example, "swithc" -> "switch".
Ctrl+Shift+L deletes the current line (without cutting it to the clipboard)
View, Code Definition Window.
The Code Definition Window shows the definition of the currently selected identifier (If it's in your solution, it'll show your sourced; otherwise, it'll extract metadata, like right-click, Go To Definition)
I see that lot of us are posting shortcuts. I have printed this poster, it's very helpful to learn those shortcuts - nowadays I look very rarely at the poster 'cause I've learned most of them :)
Link for VS posters:
My favourites are Refactoring ones (CTRL-R + Something)
One that I only just discovered. When dealing with COM it's possible to lookup a brief message from the cryptic hexadecimal error number using a tool called errlook.exe.
The useful tool is located in your VS\Common7\Tools directory.
I don't know how 'hidden' this is, but some newew people may not know about coniditonal breakpoints.
Set a breakpoint, then right click it, and choose Condition, then enter an expression like:
(b == 0)
And it will only fire when that is true. Very useful when trying to debug a certain stage of a loop.
There is this blog on MSDN thats got some nice tips and tricks
http://blogs.msdn.com/saraford/archive/tags/Visual+Studio+2008+Tip+of+the+Day/default.aspx
Pseudovariables in the debugger: http://msdn.microsoft.com/en-us/library/ms164891.aspx
$exception: avoids the need to give your exceptions names (and cause variable not referenced warnings).
$user: tells you which user is running the application...sometimes useful when trying to diagnose permission issues.
The features I like the most are
Ctrl+E , Ctrl+C/U for C# settings.Edit.IncreaseLineIndent/Edit.DecreaseLineIndent for TextEditor)PS: I want to know how to navigate to the members drop down list (just below the tabs list) by the keyboard.
The most important feature I can't live without is Visual Studio 2008. :P
Not exactly a hidden feature, but one thing I've done is add a "Start Without Debugging" button next to my "Start With Debugging" button. Just click the down arrow at the right end of the toolbar. Then select "Add or Remove buttons". Then Customize. In the commands tab select the Debug category. Find the Start Without Debugging command and drag it to where you want it on the toolbar.
My best feature is one I had to make myself.. It's a cpp/h flipper. If you are looking at the .h file, and hit this macro, (or its keyboard shortcut), it will open the cpp file, and vice-versa.
I can provide the source if anyone wants it.
Enable Intellisense in Skin Files
The Open button in the File Open dialog has a little down arrrow next to it. Click that and you get the "Open With" option which includes the Binary Editor. As a systems-type guy, I find it quite valuable, but most of my colleagues hadn't known about it until I showed them.
Re: Stopping the debugger from stepping into trivial functions.
In C#, you can also add an attribute [DebuggerStepThrough] (using System.Diagnostics) to a method. This causes the debugger to, ironically, not step through the method.
Reference tag of Visual Studio 2008 for JavaScript IntelliSense is a brand new hidden feature. Especially jQuery IntelliSense is a devastating!
CTRL-G for jumping to a specific line number. Saves a few seconds when you've got a line number in a large code file.
I wanted to talk about comment (Ctrl + k, Ctrl + c) and uncomment (Ctrl + k, Ctrl + u) shortcuts but a Bratt (:p) already mentioned them.
How about the Ctrl + k, Ctrl + d shortcut, very convenient to format markup (ASP.NET, HTML) and JavaScript code!
I don't know how unknown most people consider them to be, but I don't think that a lot of people use snippets.
I discovered them a while back and then found that they were customizable by editing the xml in the Visual Studio Program Files directory. They make it super easy to add a lot of code quickly.
Also, to save time when using snippets make sure you hit tab twice and not try to do everything through the right click menu.
Mouse Left Click resets your cursor to the position your pointer is currently hovering. Very useful for navigating through Visual Studio.
There is only horizontal split in VS by default, but trick with window duplication allows to use vertical split too.
Vertical selection is good (it accessible with keyboard too: Alt+Shift+[Ctrl]+Arrows). But sometimes I need to use Vertical Copy/Cut and Paste. VS is smart enough to handle this correctly.
There are also very useful features: Go Next/Prev Scope (Alt+Down/Up), Go to Implementation (Alt+G), but they are a part of the Visual Assist X plug-in.
In addition to all others said like:
Selecting when you hold "Alt".
Hiting F12 on the instead of right click and choose "Go To Definition".
Today if found something new:
In WebFroms in Design mode, go to Tools menu and choose "Generate Local Resources". It's really handy for making multilingual web applications.
How about Ctrl + C to copy the current line to the clipboard without doing any range selection. This is sooooo... simple and useful.
Ctrl + Shift + F brings up "search solution" dialog and lists all the results in a nice navigable way, rather than visiting each result. Not only it's easier to use, it's also useful because it doesn't tamper with your search scope defaults you use with regular search.
I'm sure everyone knows this, it's not just VS, you can do it almost everywhere. If you press Ctrl + left arrow/right arrow you will go to the next/last word word. You can also Ctrl + Shift + left/right arrow to select whole words at a time.
Navigating around the references of a symbol in VS 2010: 1. Place your cursor at the symbol to high light all references 2. Ctrl - Alt - Up/Down to navigate backward/toward reference.
^_^
Set next statement by right-clicking code view during debugging or just dragging the yellow arrow around.
This is really useful to debug again a part of the code you have recently stepped over, or maybe change the content of some variable and trying to execute a set of statements again.
Here's an old blog article on some of the hidden debugger features in the expression evaluators.
I updated my code flipper, I posted earlier. I added support for ASP Controls.
Larry
Vertical selection with Ctrl-Left Click is pretty useful sometimes...
Shift + Delete to cut whatever line the cursor is on.
I use this all the time to delete whole lines of code.
I just wanted to copy that code without the comments.
So, the trick is to simply press the Alt button, and then highlight the rectangle you like.(e. g. below).
protected void GridView1_RowCommand(object sender, GridViewCommandEventArgs e)
{
//if (e.CommandName == "sel")
//{
// lblCat.Text = e.CommandArgument.ToString();
//}
}
In the above code if I want to select :
e.CommandName == "sel"
lblCat.Text = e.Comman
Then I press ALt key and select the rectangle and no need to uncomment the lines.
Check this out.
Just found out back and forward buttons on my mouse moves back or forward one document.
Think I was wrong about this one. Only happens when searched for stuff.
Ever want to see all the implementations of one interface member? Use "Call Hierarchy"!
Task List Tokens
Configured task list tokens are retrieved later while opening task list window and select user comments option, this will display all user comments that contains configured tokens.
This will be so useful if you try to retrieve TODO comments for example.
To use it; Tools --> Options --> Environment --> Task List, add required tokens.
A few that I know or haven't seen posted here.
Crtl + Space encourage Intellisense to complete a word.
Customize toolbox - Right click on toolbox, that brings up popupmenu > Choose items > Check/Uncheck boxes > Ok.
Start Visual Studio without splash page. Windows + R then type devenv /nosplash and press Enter.
I use it every time I open a file. And that's why I just hate regions.
Collapse to definition
Ctrl+M+O
After having read through all these marvelous (and some repetitive) posts, I have some to add that I don't think I saw:
CTRL+Z = undo
CTRL+Y = redo
;-)
Also, don't forget to modify the keyboard shortcuts! Tools > Options > Environment > Keyboard
LOTS of goodies! I have F9 == stepinto, f10 == step over and f11 == step out. VERY useful.
Another not cited that I use somewhat often (although most people probably have a toolbar with this button): f6 == Build Solution.
Enjoy!
Visual Assist, in general, while a bit OT for this question, is a great app and really helps with the day-to-day running of visual studio. Their open-any-file and find-any-symbol windows are particularly awesome.
Which Visual Studio color settings is more comfortable to reduce eye strain? Whether dark setting or default (black text on white background) is best for eyes?
I like my theme too :) http://blog.wekeroad.com/2007/10/17/textmate-theme-for-visual-studio-take-2/
which is based on TextMate's vibrant ink. I even have a copy of Monaco font for ya.
I like Zenburn
I know this is really old post but it's the #1 result in Google. Here is my color settings, i call it Steam because it uses the colors from the Steam gaming platform. It was inspired by VibrantInk. It keeps the usual scheme, blue for keywords, red for strings, etc.
This is for 2010, and i did the color edits for all filetypes, xml, vb, css, xmal, etc.
Also it includes resharper colors! Download it here: Steam Colors for visual studio
I like Rob Connery's TextMate theme for VS.
I like the Zenburn 2010 link from: http://studiostyles.info/ Lot's of other nice styles there as well. Stole the link from Hanselman.
My personal preference is black text on white background, Consolas font, 11pt.
Our very own Jeff Atwood has posts on Code Colorizing and Readability and Programming Fonts.
I like textmate from This Site
Very nice theme
I like very much dark background themes, I can work much more time, reducing eye strain.
I specially like this VibrantInk theme port.
You can generate Themes with this utility.
I like the Vibrant Ink theme.
Zenburn is also really nice. I like a dark background.
Light yellow text on a blue background. The brightness of a white background gets to me after a while.
I find both of these two options have too much contrast: I prefer a dark gray background with light colored fonts -- but not too bright.
Apparently, some people are fine staring at a black-on-white screen all day; I'm not that lucky, but by keeping the overall display dark and the contrast low, I'm able to spend waay too much time staring at the screen too. ;-)
There's a bunch of IDE schemes at http://idehotornot.ning.com/
Caveat Emptor: Not all are for Visual Studio and personally I think most of them stink.
I personally prefer light text on black background and I'm currently using a slightly modified theme posted here as this one supports R# quite well.
I like the way you can create your own visual studio styles at this site: http://studiostyles.info/.
I don't like dark themes, so I created a theme inspirated in Github: http://studiostyl.es/schemes/like.
I'm quite late to the game here, but I recently discovered the Solarized theme. The author provides version of the theme for Visual Studio 2005, 2008 and 2010. There is a light and dark version depending on your personal preferences (I prefer the light version).
A site that explains the reasons for the chosen colors is over here. Also provided, using the same colors, are themes for several other IDEs, text editors, and terminal emulators.
What is your favorite Visual Studio keyboard shortcut? I'm always up for leaving my hands on the keyboard and away from the mouse!
One per answer please.
Ctrl + - and the opposite Ctrl + Shift + -
Move cursor back (or forwards) to the last place it was. No more scrolling back or PgUp/Dwn to find out where you were.
Ctrl + tab
Switches open windows in VS.
Incremental Search - Ctrl + I
It's basically the find dialog box without the dialog box. Just start typing what you want to search for (look at the bottom status bar location to see what you've typed). Pressing Ctrl + I again or F3 searches for the next instance. Press Escape to quit. Starting a new search by pressing Ctrl + I twice repeats the last search.
For me, it's nothing about auto completing code, matching parenthesis or showing some fancy tool panel. Instead, it's just about letting me see the code.
With all the panels surrounding you, the area you use to actually write code becomes too small.
In this cases, Shift+Alt+Enter comes in to the rescue and gets the code
window in focus in full screen mode. Hit it again, and you have all the panels back ;)
Expand Smart Tag (Resolve Menu): Ctrl + . (period)
Expands the tag that shows when you do things like rename an identifier.
Ctrl+K, Ctrl+C Comment a block
Ctrl+K, Ctrl+U Uncomment the block
Stock Visual Studio? F12 - Edit.GoToDefinition.
Having DevExpress' Refactor! installed means that Ctrl + ` is my all-time fave, though ;)
The TAB key for "snippets".
E.g. type try and then hit the tab key twice.
Results in:
try
{
}
catch (Exception)
{
throw;
}
which you can then expand.
Ctrl+Shift+F
Good old Find In Files.
Ctrl+Space, VS gives the possible completions
Ctrl+K, Ctrl+D // Auto-(Re)Format
See Also: Answer
Ctrl+] for matching braces and parentheses.
Ctrl+C, Ctrl+V to duplicate the current line
Ctrl+L to delete the current line
Ctrl+F3 to search for the current selection
Ctrl+K, Ctrl+K to create a bookmark (which are useful)
Ctrl+K, Ctrl+N to go to the next bookmark
And, here is something even more interesting:
Press Ctrl+/ to put the cursor into a box where you can type commands.
For example, Pressing Ctrl+/ and type ">of ", now start typing the name of a file in your project, and it will autocomplete. This is a very fast way to open files in the current solution.
One that I use often but not many other people do is:
Shift + Alt + F10 then Enter
If you type in a class name like Collection<string> and do not have the proper namespace import then this shortcut combination will automatically insert the import (while the carret is immediately after the '>').
Update:
An equivalent shortcut from the comments on this answer (thanks asterite!):
Ctrl + .
Much more comfortable than my original recommendation.
I like Ctrl+M, Ctrl+M. To expand/collapse the current code block.
VS 2005/2008 Keybinding posters:
These don't cover customizations but they're good reference materials and definitely helpful for finding new shortcuts.
Also, a macro that dumps all the current bindings to a HTML file:
Ctrl+Shift+V paste / cycle through the clipboard ring
My favorite: F12 (go to definition) and Shift+F12 (find references).
The latter is useful with F8 (go to next result).
Ctrl+- and Ctrl+Shift+- are mapped to my mouse's back and forwards buttons.
Ctrl+. is useful too, especially for adding event handlers and "using" statements.
Solution Explorer: Ctrl+Alt+L
CTRL+F5 (Start Without Debugging)
CTRL+SHIFT+B (Build Solution)
Ctrl+M, O. Can collapse and expand all sections of code in a particular file.
I suggest a cheat sheet, by the way:
I have these things as well as the Resharper cheat sheet by my desk permanently.
Shift+ESC
This hides/closes any of the 'fake window' windows in Visual Studio. This includes things like the Solution Explorer, Object Browser, Output Window, Immediate window, Unit Test Windows etc. etc. and still applies whether they're pinned, floating, dockable or tabbed.
Shortcut into a window (e.g. Ctrl + Alt + L or Ctrl + Alt + I) do what you need to do, and Shift + Esc to get rid of it. If you don't get rid of it, the only way to give it focus again is to use the same keyboard shortcut (or the mouse, which is what we're trying to avoid....)
Once you get the hang of it, it's immensely useful.
Grrr....The amount of times of hit Ctrl + F4 to close the 'window' only to see my current code window close was insane before I found this, now it only happens occasionally..
One that other editors should take up: Ctrl+C with nothing selected will copy the current line.
Most other editors will do nothing. After copying a line, pasting will place the line before the current one, even if you're in the middle of the line. Most other editors will start pasting from where you are, which is almost never what you want.
Duplicating a line is just: Hold Ctrl, press c, then v. (Ctrl+C, Ctrl+V)
Ctrl+Shift+R Tools.RecordTemporaryMacro (again to stop recording)
Ctrl+Shift+P Tools.RunTemporaryMacro
Beats the heck out of trying to work out a regexp search and replace!
If 'Favorite' is measured by how often I use it, then:
F10 : Debug.StepOver
:)
By far the most useful (after Ctrl+Shift+B) are:
Ctrl+F10
run to cursor when debugging. Looked for this for ages before I found the keyboard shortcut...
Ctrl+Alt+P -> Attach to process
Good old Ctrl+Tab for flipping back and forth between open documents.
Visual Studio actually provides a very nice Ctrl+Tab implementation; I especially appreciate that the Ctrl+Tab document activation order is most-recently-used order, rather than simple "left-to-right" order, so that Ctrl+Tab (press once and release) can be used repeatedly to flip back and forth between the two most-recently-used documents, even when there are more than two documents open.
Ctrl+R+T (Runs the current test)
Ctrl+R+A (Runs all tests in the project)
Alt+Shift+arrow keys(←,↑,↓,→)
This allow you to select things in a block. Like you could select all of the "int" in the block and then search and replace to double for example.
**int** x = 1;
**int** y = 2;
**int** z = 3;
Ctrl+Shift+S
Save all changed files. saved me quite a few times.
By usage, the pair:
Ctrl+I for incremental search
I like my code clean and arranged so my favorite keyboard shortcuts are the following:
Ctrl+K,D - Format document
Ctrl+K,F - Format selected code
Ctrl+E,S - Show white spaces
Ctrl+L - Cut line
Alt+Enter - Insert line below
Select word: Ctrl+W
I can't live without that shortcut. Used over 100+ (or 200+) a day.
Here is a list that I use frequently:
Ctrl + i : for progressive search. If you don't type anything after i, and keep pressing i (holding the CTRL key down), it will search the last item you had searched. Ctrl + Shift + i will reverse search. You might also want to use F3 (and Shift + F3) once some search string is entered.
Ctrl + k Ctrl + c : For commenting highlighted region. If nothing is highlighted, current line will be commented. Naturally, you can just hold Ctrl and press k, c in succession.
Ctrl + k Ctrl + u : For uncommenting highlighted region. Works like above.
Ctrl + / : Will take the cursor to the small search box on top. You can type ">of filename" (without the quotes) to open a file. Very useful if your project contains multiple files.
Ctrl + k Ctrl + k : Will bookmark the current line. This is useful if you want to look at some other part of code for a moment and come back to where you were.
Ctrl + k Ctrl + n : Will take you to the next bookmark, if there are more than one.
Ctrl + - : Will take the cursor to its previous location
Ctrl + Shift + - : Will take the cursor to its next location (if it exists)
Ctrl + Shift + b : Build your project
Ctrl + c : Although this does the usual copy, if nothing is highlighted, it copies the current line. Same for Ctrl + x (for cut)
Ctrl + Space : Autocomplete using intellisense
Ctrl + ] : Will take you to the matching brace. Works with all kinds of braces: '(', '{', '['. Useful for big blocks.
F12 : Will take you to the function definition/variable definition.
Alt + p + p : Will open up project properties. Although not many use this, it useful if you want to quickly change the command line arguments to your program.
F5 : To start debugging
Shift + F5 : To stop debugging
While debugging, you can use Ctrl + ALT + q to add a quick watch. Other debugging shortcuts can be found in the debug drop down menu.
Haven't seen this one ...
Ctrl + Up
Ctrl + Down
Scrolls the window without moving the cursor.
I hate closing the extra tabs when I use "Start Debugging" on ASP.NET apps. Instead, I usually use "Start without Debugging" (Ctrl+F5).
If I end up needing to debug, I use Ctrl+Alt+P (Attach to Process)
and choose WebDev.WebServer.exe. Then I'm still on my previous page and I only have one tab open.
The combination Ctrl+F3 and Ctrl+Shift+F3 for finding selected and previous selected item works very well for me.
Everyone knows Ctrl + X and Ctrl + C for cutting/copying text; but did you know that in VS you don't have to select the text first if you want to cut or copy a single line? If nothing is selected, the whole line will be cut or copied.
Alt + B + U - Build the current project.
Ctrl + I for incremental search.
Open a newline above Ctrl + Enter
Open a newline below Ctrl + Shift + Enter
Surround With
CTRL + k , s
great when you want to wrap some text in a tag
In debug mode, Alt * jumps to the current breakpoint, where execution is stopped.
Ctrl+Shift+B - Build
Ctrl+[ (Move to corresponding })
Ctrl+Shift+V (Cycle clipboard)
There are some great tips and trips and shortcuts on Sara Ford's blog.
F7 and Shift+F7 to switch between designer/code view
Ctrl+Break to stop a build.
Great for those "oh, I realized this won't compile and I don't want to waste my time" moments.
Alt+Enter opens the resharper smart tag
Bookmark ShortCuts
Ctrl+K Ctrl+K to place a bookmark
Ctrl+K Ctrl+N to go to next bookmark
Ctrl+K Ctrl+P to go to previous bookmark
The refactor shortcuts.
Each starts with Ctrl+R.
Follow it with Ctrl+R for rename. Ctrl+M for extract method. Ctrl+E for encapsulate field.
If you have your keyboard settings set to the "Visual C# 2005" setting, the window switching and text editing chords are excellent. You hit the first combination of Ctrl + Key, then release and hit the next letter.
I still use F4 to show the properties pane so I don't know the chord for that one.
If you go to the Tools > Customise menu option and press the Keyboard button, it gives you a list of commands you can search to see if a shortcut is available, or you can select the "Press Shortcut Keys:" textbox and test shortcut keys you want to assign to see if they conflict.
Addendum: I just found another great one that I think I'll be using quite frequently: Ctrl+K, S
pops up an intellisense box asking you what you would like to surround the selected text with. It's exactly what I've needed all those times I've needed to wrap a block in a conditional or a try/catch.
F9: toggle and un-toggle breakpoints!
I like to use all my screen real estate for code and have everything else hidden away. These shortcuts keep these windows handy when I need them, so they can be out of the way the rest of the time.
Ctrl + BP (Previous bookmark), Ctrl + BN (Next bookmark)
Ctrl + W for selecting the current word
Well, if you're really
always up for leaving my hands on the keyboard and away from the mouse!
Than you should go here
It's not really my favorite, it's just everything!
A shortcut a day will keep the mouse away.
Ctrl + Alt + E = Exception/Catch Settings and code snippets
Ctrl+M, Ctrl+O : collapse to definitions. I use it all the time together with #regions
(despite what Jeff says) to get an overview of the code on my screen.
I just found out that Shift+F11 steps out of the current function.
This is very useful when you want to debug function foo in foo(bar(baz()). Use F11, Shift+F11 to jump in and out of bar and baz.
"Find in files" has been an enormous productivity booster for me. Rather than jump to each result one by one, it just shows you a list of results in your entire project or solution. It makes it very simple to find sample code, or see if a function is used anywhere.
The great thing about this is that it applies to the element you're currently in - you don't have to select a whole line of VB code to comment it, for example, you just type Ctrl+K, Ctrl+C to comment the current line. On an aspx page, you can comment out a big chunk of code - for example an entire ListView - by just going to the first line and hitting Ctrl+K, Ctrl+C.
F7 toggles from design view to code view.
Not a keyboard shortcut, but with your mouse, you can use forward and backwards buttons on your mouse to go to previous locations in your code and return to your current location.
If you install Visual Assist X, which I highly recommend you do, these are useful:
Alt+O: Toggle current document between header/implementation (.h/.cpp)
Alt+G: Go to definition/declaration
F7 to build and then F8 to go to the errors and warnings one by one.
Some handy ones that I use often are:
Ctrl+J -> Forces Intellisence to pop up.
Ctrl+Alt+L -> Show the Solution Explorer.
Ctrl+ E + D : Format Document
Tip for teams: Set up agreed-on formatting options in Visual Studio (they are very flexible), then export the settings to a .settings file for each developer to import.
Now if all developers learn to autoformat everything, it will not only produce perfect formatting consistency throughout the project with no effort at all, but also greatly reduce annoying false differences in the diff tool when merging multiple check-ins to Source Control.
Oh, I enjoy good tools!
Insert snippet:
Ctrl+K, Ctrl+S
I use if often for try..catch and #region
Im a big fan of Ctrl+D+Q to open quickwatch while debugging.
Ctrl-Shift-Space shows the syntax/overloads for the current function you are typing parameters for.
Control+Apostrophe.
Oh wait, that was after I remapped it away from that god-awkward Alt+Shift+F10 or whatever it was.
When you remap options to help bind this away from it's original hard to hit shortcut, it becomes a lot lot more useful.
The combination Ctrl+u and Ctrl+Shift+u for converting a block of characters to all upper/lower case.
Ctrl + K + C - set current selected code to be comments Ctrl + K + U - set current selected comments to be code
Ctrl + , for 'Navigate To' window (link)
When intellisense drop down is displayed, Holding down Ctrl turns the list semi-transparent so you can see what is hidden behind it :)
Use Emacs-like keybinding, it's TAB :P
What Ray said. Ctrl + ..
I really didn't like the smart tags (those little blue and red underscores that appear wanting to help you) until I found out that you don't need to waste time trying to hover the mouse over the exact pixel that gets the menu to show.
I think Ctrl + . to open the smart tag menu saves me about five minutes every day and reduces my blood pressure considerably.
Ctrl+Shift+S // Save
Ctrl+Shift+B // Build
I have two that I use a lot, the first is standard, the second you have to map:
Ctrl+A, Ctrl+E, F (Select All, Format Selection)
Ctrl+E, R (Remove Unused Usings and Sort)
Both help pay down the "cruft debt" early and often
Ctrl+K then Ctrl+H to add a line of code to the built in task/todo list
(Ctrl+Alt+K). Very handy!
Ctrl+Shift+8 - Backtracks go to previous "F12/ Go to definition"
Ctrl+X
This cuts (to clipboard) the current line of code.
Nothing beats Ctrl+Shift+B - Building the solution!!
As far as navigation control, Ctrl+- and Ctrl++ is nice...
But I prefer Ctrl+K+K ---> creates bookmark...
and Ctrl+K+N ---> to navigate to the next bookmark... awesome stuff...
Another useful Find short key sequence is Ctrl (+ Shift) F --> ALT C --> ALT W for switching between exact and fuzzy searches.
Save LOTS of time copy and cutting:
Alt+Shift+ Arrow keys(←↑↓→) or mouse moving = Block/Column selection
comes really handy
Ctrl+K, Ctrl+D - Format the current document.
Helped me fix indentation and remove unneeded spaces quickly
"prop" and hit tab.. stubs out property for you...
Ctrl+M, Ctrl+L will expand every collapsed bit of code. It is the opposite of Ctrl+M, Ctrl+O
Ctrl+E, Ctrl+W
Sometimes you want to see the flow of the code with all of your indents in place; sometimes you need to see all 50 attributes in a GridView declaration. This lets you easily switch back and forth.
On an aspx page, this takes care of properly indenting all of your markup and ensures that everything is XHTML compliant (adds quotes to attributes, corrects capitalization, closes self-closing tags). I find that this makes it much easier to find mismatched tags and to make sure that my markup makes sense. If you don't like how it's indenting, you can control which tags go on their own line and how much space they get around them under Tools/Options/Text Editor/HTML/Format/Tag Specific Options.
In your C# or VB code, this will correct any capitalization or formatting issues that didn't get caught automatically.
For CSS files, you can choose compact (one definition per line), semi-expanded, or expanded (each rule on its own line); and you can choose how it handles capitalization.
ctrl+shift+J
I've found intellisense for Javascript to be flaky - this usually straightens it out.
This works both in VB/C# code (e.g. collapse/expand a function) and in an aspx page (e.g. collapse/expand a GridView definition).
One very nice use of this is to cut or copy a big chunk of markup or code: For example, to move a big, sprawling <table> or <asp:gridview> definition:
Each snippet has a shortcut that you can access by typing a word then tab. The one I use the most is for a standard property definition; just type property then tab.
Open a file without using the mouse:
CTRL + ALT + A (opens command window) Followed by >open somedoc
I didn't see this one yet. Can't believe how many cool shortcuts have been posted here!
Here's a link to a list of Shortcuts I find usefull (VS2003) but some still apply,
My favorite being F12 and Ctrl+- to navigate to the declaration and back
Ctrl+- and Ctrl+Shift+-
Alt+D, P Attach the debugger to the application.
(first letter of any application you want to debug, works most of the time)
Ctrl+Shift+F
Ctrl+I (incremental seach)
Simple one. F8 : Go to next build error.
Found that now it will work in any sort of list window (the ones that cluster together at the bottom usually.
Hmmm, nobody said F1 for help.
Could it be that Google is faster and better for getting at the information that you need.
VS 2008
The ones I use all the time:
ctrl+] Matching Brace
ctrl+shift+] Select to the end of brace
ctrl+shift+q Untabify
ctrl+k,ctrl+c comment out the currently selected block
ctrl+k,ctrl+u uncomment out the currently selected block
alt+mouse move vertical selection
ctrl+alt+x toolbox
ctrl+shift+b build
Ctrl+Shift+F4 to close all windows. You have to map it yourself:
Instructions:
Credit to Kyle Baley at codebetter.com. I modified his example to use shift instead of alt because it was easier on my hands.
Alt+F4 ;)
But on a more serious note, Ctrl+Space is probably hit a lot from me, in my limited usage of VS.
I've mapped File.Close to CTRL+SHIFT+W. That and CTRL+TAB mean you can close exactly whichever files you want.
Ctrl+Shift+R -> Refactor with Resharper
Here are my favourite debugging keyboard shortcuts:
I'm addicted to some very subtle stuff in http://blog.jpboodhoo.com/UsefulVSKeySequencesShortcuts.aspx
e.g. Alt-W U to auto collapse everything when in Full screen mode when it all gets too much
Paste in loop Ctrl + Shift + V
Expand Collapse current block - Ctrl + M + M
Code Snippet - for creating property type prop and press tab.
Ctrl+Shift+V multiple times cycles through the clipboard ring.
It's simple, but
Ctrl + L
deletes the entire line. Great for fast code editing.
Ctrl + M, L - Expands all regions
I don't think that any shortcut is remaining for me to mention so let me mention a shortcut that I would love Visual Studio to have :-) One shortcut that I really miss and that is present in Eclipse is "Open Resource" (Ctrl + Shift + S) which allows you to type in a file name and the IDE displays the files matching it. Really useful when you are working with bid code bases!
Ctrl+A, K, F
Select all, prettyprint.
People have mentioned Ctrl+C and Ctrl+V to paste a line when nothing is selected but I use Ctrl+X to move lines of code regularly.
Hopefully this hasn't already been posted, apologies if so. I've just come across a useful keyboard shortcut in Visual Studio 2008. With the QuickWatch window open, highlight a row with a string value in it and hit Space Bar. The text visualiser window will appear with the value in it.
I have found it quite useful for checking jQuery innerText values as the QuickWatch window by default is too small to show longer strings fully.
Ctrl R W to display whitespace (great for tab or space enforcement).
Also, holding down Alt while selecting with the mouse will create a rectangular region.
Ctrl+Shift+Alt+B Rebuild Solution.
Ctrl+R, Ctrl+T Debug Tests in Current Context
Surprised not to find this one on the list as I use it all the time:
Ctrl+K,Ctrl+M - Implement method stub.
Write a call to a non-existent method, then use that shortcut to create the method in the right place, with the right parameters and return value - but with a method body that just throws a NotImplementedException.
Great for top-down coding.
I think Ctrl+K+D is definitely my favourite. I use it more than any other shortcuts. It helps to format the document according to the indentation and code formatting settings specified by us.
CTRL + Alt + ↓
This causes the list of open files to pop open in the upper right corner of the editor window. The cool thing is that it is searchable so you can leave go of the keys and start typing the file name to shift the focus to that file. Very handy when you have zillions of files open.
Ctrl+- and Ctrl+Shift+-. But if you are a keyboard lover then go for Resharper
I mapped all of the expand/collapse commands so that they can be used with the left and only so my right hand stays on my mouse.
Ctrl + E, Ctrl + E toggles expansion,Ctrl + E, Ctrl + D collapses all to definitions, Ctrl + E, Ctrl + A toggles all outlining.
We want to put a number of our in-house projects under version control. Our projects are C# .NET applications and assemblies. We originally decided to go Microsoft all the way (as is the norm around here), and tried installing Visual Studio Team Foundation Server. To say the least, it was way more trouble of trying to get a successful install than it's worth, and I'm afraid we don't have a entire server to dedicate to TFS itself, as the installer seems to insist.
We also considered a generic solution like Subversion or CVS, or possibly some kind of free online hosting that doesn't make our source publicly available under some license like Google Code appears to. Does anyone have any suggestions for us that would best fit our in-house MS environment? We'd also get some benefit out of some kind of project management tools if they were nicely integrated in to the solution, but this would only be a perk.
I should also mention that we haven't entirely ruled out TFS, but it's looking like a pain, so anything you guys have to say for or against it would be helpful.
I've used Subversion in a number of cases for both .Net and Java projects and it has managed quite well. As it was designed as a replacement for CVS, the previous tool-of-choice for open-source projects, it got a great deal of traction and there are a lot of tools available to make working with it a pleasure.
For a start, it doesn't require a dedicated server and will run anywhere you decide to place it, it installs it's own file-based database system (Berkely db I think from memory) to store files so no large database server is required. For basic access to the source code for updates and commits you can use the command line (which is great for automation), but there are several tools you can use to make things easier. Personal favorite of mine is TortoiseSVN which integrates subversion commands into windows explorer, enabling you to manage source code from the directory listing. (Wonderful when combined with QTTabBar on large projects). Some of my co-workers also swear by Ankh, which is a plugin that puts subversion controls into visual studio itself. Apparently the last few versions have been quite stable and pleasant to use.
It doesn't directly integrate with project management tools that I know of, but the generic nature of it allows all sorts of information, including design documentation and project plans, to be stored in it. It can also be used as the base store for some communications intranet systems, such as confluence, which can be useful in project collaboration environments.
I hope that helps!
I now use Git with Git Extensions
It now integrates with Visual Studio 2005 and 2008:
Subversion + AnkhSVN as VS-Plugin + TortoiseSVN ist the best for me.
Subversion!
The Collab installer works well.
Another one-click solution is VisualSVN Server.
I've really liked using Vault. We actually have the web service running on one server and the database backend running on another to spread the load.
[snip from the site]
Built for Reliability
Vault was designed to ensure the reliability of data. All repository data is stored in a SQL Server database.
Atomic Checkins
You can checkin a group of logically-related operations as a changeset, and the checkin operation is atomic. The entire changeset either succeeds or fails. Your repository is never left in a half-baked state.
Familiar User Interface
SourceSafe users can begin using Vault with no learning curve. The terminology is the same. All major VSS features are present.
SourceSafe Import
Vault includes a SourceSafe import wizard that can move all your VSS data into a Vault repository. Every version of every file is imported, including change comments. Even shares and pins are properly maintained.
Remote Access
Vault was designed to work well over the Internet. All communication between client and server is done over HTTP, familiar and friendly for network administrators. Compression and binary deltas are used in both directions to minimize network traffic. Configure IIS for SSL support to keep your data secure.
Advanced Features
Vault brings smart branching and merging to your team, including our Merge Branches wizard. And check out our exclusive Line History feature (think Blame on steroids).
Clients for Linux
The Vault command-line client is fully supported and tested on Linux using Mono.
IDE Integration
Vault integrates seamlessly with both Microsoft Visual Studio and Eclipse.
[/snip from the site]
CVS is better than VSS, but still about two generations behind when it comes to version control. SVN is a perfectly fine choice, and works well for a lot of people. You may want to check out Sourcegear's Vault. It's a good choice if you're looking for a version control system that integrates nicely with the Microsoft development environment.
Git + Git Extensions + Visual Studio 2008 works very well for me.
Our team uses Subversion via VisualSVN Server, which is extremely easy to get running. We use TortoiseSVN as a client on our development machines.
When we approached the decision of which source control system to use, we initially looked at Team Foundation Server, but it was way too complicated for our current development processes (read: not formalized yet). We just wanted to get all of our source into a spot where it was versioned instead of XCOPYing to our CYA folders.
One thing to note, however, is that sometimes it gets confusing using TortoiseSVN alongside Visual Studio. A lot of our team members like to move/rename folders and files inside the IDE, which wreaks havoc the next time they commit/update. With that said, you may want to look at products that integrate into the IDE (such as VisualSVN).
At work, we use SourceGears Fortress. At home I use SVN. Both work nicely. Fortress seems to get flakey when you drop network connectivity (e.g. after a hurricane) and some other things that can be annoying, but day-to-day operations both seem to run fine.
The important thing to think about is do you want exclusive check outs or not.
Both offers different repositories.
The style of source control is different. Fortress will auto-checkout something while SVN will not -- it lets you do the merges and such.
Fortress is NOT free and is NOT cheap while SVN is free.
Personally, given a choice I would choose SVN. I have used CVS however I like how SVN handles blobs better -- since I like keeping a full db export in to the source control (in a seperate branch though) since it allows a central location for restoring mistakes.
Subversion, Tortoise and Ankh.
If you're up for taking another shot at TFS, look in to running it in a virtual machine. That should solve the dedicated server problem for both the software and your budget. Just make sure it has plenty of RAM.
The integration of TFS in VS is nice... don't give it up too easily.
I really like Subversion although it does have its quirks. An article on Rick Strahl's blog that explains in detail a Windows based install turned me on to it. Here's some linkage:
Setting up and running Subversion and Tortoise SVN with Visual Studio and .NET
I have used VSS and VisualSVN (VSVN). I have switch back to VSS due to problems with corruption of the project files by VSVN. My team has had problem with merging when more than 1 person adds new files to the project with VSVN and there has also been corruption problems with refactoring changes. At the time when I tried Ankh over a year ago it did not work well, but I hear good things about it's plugin of late...
Whatever choice you choose, make sure it integrates with Visual Studio well and that it can handle addign new files by multiple people, moving folders and files as well as refactorign a class that is used in more than 1 project. The last thing you want is for your source control system to corrupt your source!
I work on a small project and we use Subversion (via VisualSVN server) and Ankh for Visual Studio integration. It works perfectly for what we need and the price is right too :)
We also use Trac for app lifecycle management which integrates perfectly with SVN, and adding in post-commit-hooks for the repository allows us to include things like 'fixes #123' in our commit messages and the corresponding ticket is automatically updated (e.g. closed or set to a pending/assigned state).
There's some online SaaS tools such as Unfuddle which provide the same features but you dont have to worry about the management :)
Give a try to Plastic SCM.
Subversion rocks. If you don't want to run it yourself, use Google Code or Assembla (both free).
There's also a one-click install for setting up an SVN server, but I don't remember the name off the top of my head. It should be easy to find on Google.
FYI: Forrester recently rated Subversion as the best standalone source control product.
Try installing TFS on the server anyways. Just make sure that the server is backed up first! If it doesn't work the way that you would hope, you can always uninstall it. Other then that, I would recommend SVN + VisualSVN.
Side Note: At least with SVN, you can hook it up with a wiki/bug tracking system like Trac that would be total kick ass in house :)
I've been using a hosting provider, Assembla for the last few months and I've had no problems using their source control (Svn), issue management, and wiki. I would recommend this only for smaller teams because may lose some control vs. hosting it all in house. I've also used Team System and Svn in-house and I personally prefer Svn with Visual Svn as the client. Svn was a little tricky to setup in a Windows environment early on but there are plenty of how-to's out there now so you probably can't go wrong with that solution.
I too throw my vote in for Subversion.
However for the user client, I highly recommend SmartSVN. Its not integrated with Visual Studio, which may be confusing for developers use to SourceSafe or TFS, but it makes up for that with an impressive set of features.
The integration between the source control and work items (bugs, issues, requirements) is a very compelling reason to use TFS. However I'm in the lucky position of not having to administer TFS and may have a different view if I did.
TFS is actually quite easy to install and maintain imo. Our server installed fine with no issues at all. The one thing that could be a bit better is Account and Security management, but once you are used to it, its a breeze.
Besides that its really nice, as mentioned the integration, but its also very fast i find for source control. But then I was used to VSS and i think anything was faster than that. I also ind it nice that using it I can better collaborate with my customers on projects, and they can get more feedback without necassarily having to be an onsite customer. And because it is all in one, its actually easier to learn . (I use it for pretty much everything on a project, from source to docs, tasks, bug tracking, requirements, planning, etc etc etc, i am sure you all know what it does.)
My favorite source code control system is ClearCase, both as a developer and as an administrator. Since as a developer you'll only really be using snapshot views, the "LT" cheaper version is more than sufficient. The only downside is that their diff-merge tool isn't as elegant or fully featured as it ought to be. We used Araxis and integrated it directly with ClearCase so that all diffs and merges were done with Araxis.
I've also had good luck with SourceGear Vault. It's easy to administer, and their diff-merge tool works well (and it can also be used standalone). Eric Sink is their CEO, and he's a straight shooter.
On the open source front, Subversion is the easy winner. You'll want to pick a front end for it, and there are several suitable ones from which to choose (many of which have already been mentioned). You can easily set it up for single-machine use if you're doing Lone Ranger work, and it's not much more difficult to set it up server-style for team efforts (which is the preferred way).
Any of these systems mentioned have sufficient command-line ability to play nicely with any build tools you choose (ant, nant, whatever), and while the core paradigms of each are slightly different from each other, all are easily mastered with a little effort. All are also integrateable with most IDEs, but I'd verify that your chosen IDE works your chosen VCS before committing.
Definitely stay away from VSS. It's not as durable as it ought to be, and it's missing some enterprise class features. It might be ok for simple mom-and-pop work, but don't trust it for larger teams or if you decide to do any serious multi-branch work.
The first is the plugin to manage svn from visual studio but it needs the second to do all of its work, first one is not free, but its worth the $49 that costs, the latter is free.
The difference is that TortoiseSVN is a shell extension (you get your context menu options when right clicking on the desktop for exmaple) and can be used outside Visual Studio so it is not made for integration on any IDE. VisualSVN its just a wrapper for Tortoise that will let you use it from inside Visual Studio and believe me, it is really good.
I dont know if SVN is worst than commercial solutions but sure its a thousand times better than Visual Source Safe which gave us headache when we were using it.
SunStudio (now owned by Oracle) seems a good substitute for M$ VS and supports multiple versioning options, including Subversion. May also be free.
Does anyone know a keyboard shortcut to close all tabs except for the current one in Visual Studio? And while we're at it, the shortcut for closing all tabs? Is there a Resharper option for this? I've looked in the past and have never been able to find it.
I don't think there is one by default, but you can go to Options>Environment>Keyboard and bind a key to File.CloseAllButThis.
I use ctrl+alt+w
I close all documents using ALT + W + L.
This is available in Visual Studio without any special plugins or configuration. It just uses the tool bar mnemonics.
Right-click on a File Tab and select Close All But This. This command will close all the other files in the editor, except for the currently-activated file. There isn't a keyboard shortcut by default but you can bind it to a keyboard shortcut in the general environment settings (Options->Environment->Keyboard), the command is File.CloseAllButThis.
If you find yourself using "Close all but this" too often, you can also try Tools \ Options \ Environment \ Documents \ [x] Reuse current document window, if saved. Combined with ReSharper's Recent Edits (ctrl-, or ctrl-e depending on keymap) you can avoid having too much open documents all the time and still quickly navigate between recently opened.
Sara Ford has a lot of tips like these about Visual Studio
Here's one that references what aaronjensen said about File.CloseAllButThis:
I follow aarojensen's method, but put it in the file menu (right click on the menu and select customize). Then Alt-F-B closes all but the current.
This is a great tip. The less time I spend using the mouse the better. The only problem is remembering to look out for when you need these features so that you don't just accept the defaults settings.
In order to close all documents:
Tools->Customize...->Keyboard..->Environment->Keyboard
There I've mapped command Window.CloseAllDocuments to Alt+Ctrl+F4
On larger and/or long running projects, I tend to reference many assemblies and namespaces, and often I end up removing some functionality later on or moving it into a different project.
I just wonder, is there a way to check every project (heck, every .cs file) in my whole Visual Studio solution and get a list of all referenced Assemblies and Namespaces that are not actually being used and can be safely removed? I know that ReSharper can do it for a single Code File, but I did not see an option to check all files or to check for unneeded Assemblies.
Using Visual Studio 2005 and 2008 Professional if that matters.
Edit: Thanks so far. The Problem with ReSharper or "Remove and Readd if build breaks" is that it's quite tedious on every single file and assembly (My project has about 120 .cs Files in 7 Assemblies, and references a total of 18 Assemblies outside of the solution), so ideally i'm looking for something "one-click". Big Bonus points for some automatic way that can be used in buildscripts to generate a report :)
Resharper will do this for you and you can set it up in the Clean Code option that you can run solution wide ;o)
If you have ReSharper then, select the solution, right click and select cleanup code. Resharper will then go through every code file in the solution.
As to removing project references, when the compiler runs it won't add the reference if no code uses that dll.
If you have ReSharper installed, then from within the Solution Explorer you can right-click on a reference and click Find Dependent Code. If it comes back with a dialog of results then you're using that reference/assembly. If you get the message "Code dependent on module module name not found." Then you should be OK to remove that reference/assembly because it's not being used.
I found this question while searching in Google and looking for a way to remove unused "Using" statements from my code.
Refactor is great, but it isn't available to me. However, as it turns out Visual Studio 2008 does this on its own.
Here are the steps:
Done. I realize this doesn't answer the original question (doing this en masse for an entire project) but it does answer my question.
(Cross-posted from here) Given that VisualStudio (or is it msbuild?) detects unused references and doesn't include them in the output file, you can write a script which parses the references out of the csproj, and compares that with the referenced Assemblies detected by reflexion on the project output.
If you're motivated...
As was mentioned by previous responses, Resharper works well for this as well as a variety of other cases such as ways to make code cleaner and generate certain things for you. The best way to really figure out all the advantages of Resharper is to download the trial, print out a Keymap Cheatsheet and stick it next to you where you're developing at.
Long story short, it does solve this problem but it does a heck of a lot more than just that.
Removing unused references is a feature Visual Studio 2008 already supports. Unfortunately, only for VB .NET projects.
I have opened a suggestion on Microsoft Connect to get this feature for C# projects too:
http://connect.microsoft.com/VisualStudio/feedback/ViewFeedback.aspx?FeedbackID=510326
If you like this feature as well then you might vote my suggestion.
Yeah, i don't think there is one. I just delete some i don't think are needed then build :/
BTW. that will keep using errors. You can use the Visual Studio Power commands to remove and sort usings, so do that first, then delete random assemblies :D
Any decent code profiler will do this for you. I like DevPartner personally.
It won't get rid of any references in code to your referenced assemblies (I think), but you can go to the properties of each of your projects, got to References, and click "Unused References...". Visual Studio then gives you the option to remove them right there.
No way to do it at the solution level though.
Let's show some Resharper love and learn new shortcuts while at it:
Along the lines of Joel Spolsky's "What is your single favorite keyboard shortcut in Emacs?" what is your single favorite Resharper shortcut? One shortcut per answer, please.
Would it be:
I figure we can deal with more than one favorite by providing multiple answers - let the best ones rise to the top.
UPDATE:
I think we have to give this on to Ilya because of his work with Resharper in the first place. Thanks Ilya!
Honourable mention to bdukes for multiple entries in the format requested, the link to reference for Resharper shortcuts for those that don't know it yet, and the mention of the Scout plugin.
For the category of "a shortcut I didn't know that I'm glad to have now": although not necessarily a Resharper one, is Jivko Petiov's for remapping File.OpenContainingFolder to Alt-O
Thanks all!
Some very useful shortcuts rarely known:
Recent Files (Ctrl-,) Recent Edits (Ctrl-Shift-,) Locate in Solution Explorer (Alt-Shift-L)
PS: VS keymap
Alt-enter does so many things based on your context.
More favs:
It has to be Alt+Enter. I use it more than any other short-cut in any other program.
F12 - Go To Definition (made even better through the Scout plugin, which'll go to .NET Source, then Reflector if it can't show you otherwise).
CTRL-N - find class. Most heavily used.
In 2006 I requested a new ReSharper feature that allows moving left and right one 'hump' at a time. That is, in SomeSortOfPascal or someSortOfCamel symbol, you can move within words.
You can make this the default behaviour for CTRL+LeftArrow and CTRL+RightArrow (via CamelHumps in the R# options) but personally I can't do without moving left and right with great speed. So instead you can map these commands yourself to whatever keystrokes you like. Here are the ones I use:
Default set from VS:
My additional mappings:
The commands for these can all be found by filtering the command list on the term hump. From memory they are HumpLeft, HumpRight, HumpExtendLeft, HumpExtendRight.
You can bind commands to keystrokes via Tools > Options > Keyboard.
I only wish R# supported these commands in dialogs. More often than not when renaming things I'm inserting, removing, moving or changing one of the terms within a compound word.
Ctrl+R, R to rename
Ctrl+E, U to surround with a live template
Shift + F12 and Alt + Shift + F12 to find usages of a member
Ctrl+Alt+V - Introduce field / variable.
ctrl-shift-alt-arrow (move method up and down)
I'm a CTRL-ALT-F (code cleanup) junkie
CTRL + M, CTRL + O (Collapse To Definitions)
use of capital letters to navigate through intellisense suggestions
CTRL+ALT+j (surround with)
Ctrl+R, M to extract method
Ctrl + Shift + R to refactor the current selection
Ctrl + T to go to type
CTRL-ALT-M => Extract Method, very nice for refactoring
CTRL-ALT-V => Extract Variable: i don't define variables any more, i just write a statement and extract it then :)
CTRL-ALT-J => surround with (i just love it!)
and of course: F2
For completeness and cross-referencing, IDEA/ReSharper 2.x keyboard shortcuts and Visual Studio keyboard shortcuts
It's actually custom and maps to File.OpenContainingFolder.
Global search. Invaluable when going through lots of source code.
Shift+Alt+PageDown => Goes to next error in solution. Requires you have solution analysis turned on.
Most of my favorite ones are custom made. But a really good one that is standard is Ctrl + Alt + Down Arrow.
That will drop down the list of open files that can be typed into for searching and switching files.
All of this totals to a nice easy keyboard way to switch between open files.
Vaccano
Ctrl+R, O to move a method
Alt + \ to go to member
This'll be hard to actually vote on, because pretty much all of the above are huge time savers.
I'll add ctrl-shift-backspace (navigate to past edits)
ALT+R, U, N - run all unit tests.
ALT+R, N, C - create a new class.
ALT+R, N, I - create a new interface.
VS provides CTRL+ALT+L to show the solution explorer. However, this just focusses the panel. To move to the active document in solution explorer, use the command provided by ReSharper: ReSharper.LocateInSolutionExplorer.
You can bind commands to keystrokes via Tools > Options > Keyboard.
Personally, I bound this to CTRL+SHIFT+L and use it many times a day.
For my Resharper has two great features: Find type (Ctrl + T) and locate file in solution explorer (Alt-Shift-L).
I can't live without them, because usually I know what class I want to see but I don't know where in solution it is.
I think all of the find shortcuts are my favorite (Ctrl+T, Ctrl+Shift+T, etc)
I do wish that the symbol find would be confinded to the current file though.
As a bit of an addition to the Alt + Enter i rebind this to something else (i use Alt + #). It's in the VS options under keyboard, called "Quickfix". You can then assign this to any additional buttons on your mouse for super quick access.
I really like ALT+Shift+F11, Highlight Usages.
Say you've got a big file open and you want to quickly see where the current word is used in the file.
If your caret is over a class name like HtmlAnchor, use this shortcut and it'll show blue highlights in the overview bar on all the places that HtmlAnchor is used.
Press Esc to remove the blue highlighting when you're done!
use VisualAssistX then
Alt + O => open header/source
Alt + G
or create many other shortcuts for "create definition", "rename", "encapsulate field", "create comment"
If I'm refactoring another developer's code, Inline variable or Safe delete
CTRL+ALT+N
ALT+DELETE
If it's my code, Extract method
CTRL+ALT+M
(using ReSarper/ItelliJ Idea style shortcut bindings, not Visual Studio's, you can set this using ReSharper-> Options -> General)
CTRL-W
Extend selection.
I'm using this command way more than anything else. Extremely useful, it extends your selection by another level.
How do I create a resource that I can reference and use in various parts of my program easily?
My specific problem is that I have a NotifyIcon that I want to change the icon of depending on the state of the program. A common problem, but one I've been struggling with for a long time.
Well, after searching around and cobbling together various points from around StackOverflow (gee, I love this place already), most of the problems were already past this stage. I did manage to work out an answer to my problem though.
How to create a resource.
In my case, I want to create an icon. It's a similar process, no matter what sort of data you want to add as a resource though.
How to use a resource.
Great, so we have our new resource and we're itching to have those lovely changing icons... How do we do that? Well, lucky us, C# makes this exceedingly easy.
There is a static class called Properties.Resources that gives you access to all your resources, so my code ended up being as simple as:
paused = !paused;
if (paused)
notifyIcon.Icon = Properties.Resources.RedIcon;
else
notifyIcon.Icon = Properties.Resources.GreenIcon;
Done! Finis! Everything is simple when you know how, no?
The above method works good.
Another method (I am assuming web here) is to create your page. Add controls to the page. Then while in design mode go to: Tools>Generate Local Resource. A resource file will automagically appear in the solution with all the controls in the page mapped in the resource file.
To create resources for other languages, append the 4 character language to the end of the file name, before the extension (Account.aspx.en-US.resx, Account.aspx.es-ES.resx...etc).
To retrieve specific entries in the codebehind, simply call this method: GetLocalResourceObject([resource entry key/name]).
The above didn't actually work for me as I had expected with Visual Studio 2010. It wouldn't let me access Properties.Resources, said it was inaccessible due to permission issues. I ultimately had to change the Persistence settings in the properties of the resource and then I found how to access it via the Resources.Designer.cs file, where it had an automatic getter that let me access the icon, via MyNamespace.Properties.Resources.NameFromAddingTheResource. That returns an object of type Icon, ready to just use.
good articles but can i create a resource file with html control (means not for server control)
Introduction
I've always been searching for a way to make Visual Studio draw a line after a certain amount of characters:
Below is a guide to enable these so called guidelines for various versions of Visual Studio.
Visual Studio 2010
HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\10.0\Text Editor Guides with the value RGB(100,100,100), 80. The first part specifies the color, while the other one (80) is the column the line will be displayed.Visual Studio 2008 and Other Versions
If you are using Visual Studio 2008 open the registry at HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\9.0\Text Editor and add a new string called Guides with the value RGB(100,100,100), 80. The first part specifies the color, while the other one (80) is the column the line will be displayed. The vertical line will appear, when you restart Visual Studio.
This trick also works for various other version of Visual Studio, as long as you use the correct path:
2003: HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\7.1\Text Editor
2005: HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\8.0\Text Editor
2008: HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\9.0\Text Editor
2008 Express: HKEY_CURRENT_USER\Software\Microsoft\VCExpress\9.0\Text Editor
This also works in SQL Server 2005 and probably other versions.
This is originally from Sara's blog.
It also works with almost any version of Visual Studio, you just need to change the "8.0" in the registry key to the appropriate version number for your version of Visual Studio.
The guide line shows up in the Output window too. (Visual Studio 2010 corrects this, and the line only shows up in the code editor window.)
You can also have the guide in multiple columns by listing more than one number after the color specifier:
RGB(230,230,230), 4, 80
Puts a white line at column 4 and column 80.
Be sure to pick a line color that will be visisble on your background. This color won't show up on the default background color in VS. This is the value for a light grey: RGB(221, 221, 221).
Here are the registry keys that I know of:
Visual Studio 2010: HKCU\Software\Microsoft\VisualStudio\10.0\Text Editor
Visual Studio 2008: HKCU\Software\Microsoft\VisualStudio\9.0\Text Editor
Visual Studio 2005: HKCU\Software\Microsoft\VisualStudio\8.0\Text Editor
Visual Studio 2003: HKCU\Software\Microsoft\VisualStudio\7.1\Text Editor
For those running Visual Studio 2010, you may want to install the following extensions rather than changing the registry yourself:
http://visualstudiogallery.msdn.microsoft.com/en-us/0fbf2878-e678-4577-9fdb-9030389b338c
http://visualstudiogallery.msdn.microsoft.com/en-us/7f2a6727-2993-4c1d-8f58-ae24df14ea91
These are also part of the Productivity Power Tools, which includes many other very useful extensions.
If you don't want to edit any registry keys, and don't mind the other features installed with the extension, you could simply install the Productivity Power Tools extension and you get guideline functionality out of the box.
after installation just right click on the desired column while in the editor window and choose the add guide line option.
This will also work in Visual Studio 2010 (Beta 2), as long as you install Paul Harrington's extension to enable the guidelines from the VSGallery or from the extension manager inside VS2010. Since this is version 10.0, you should use the following registry key:
HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\10.0\Text Editor
Also, Paul wrote an extension that adds entries to the editor's context menu for adding/removing the entries without needing to edit the registry directly. You can find it here: http://visualstudiogallery.msdn.microsoft.com/en-us/7f2a6727-2993-4c1d-8f58-ae24df14ea91
If you are a user of the free Visual Studio Express edition the right key is in HKEY_CURRENT_USER\Software\Microsoft\VCExpress\9.0\Text Editor {note the VCExpress instead of VisualStudio) but it works! :)
This works for SQL Server Management Studio also.
The registry path for Visual Studio 2008 is the same, but with 9.0 as the version number:
HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\9.0\Text Editor
I like ReSharper, but it is a total memory hog. It can quickly swell up and consume a half-gig of RAM without too much effort and bog down the IDE. Does anybody know of any way to configure it to be not as slow?
Turn off the on-the-fly compilation (which, unfortunately, is one of its best features)
What bothers me more is the amount by which ReSharper slows down Visual Studio startup. Once it's up and running, I usually do not notice any major slow downs.
The next release 4.5 is going to based around performance and memory footprint.
see Ilya Ryzhenkov's blog
Resharper 4.5 has been released From my experience it is less of a memory hog, but i still can run out of memory.
I had an issue where it was taking upwards of 10 minutes to load a solution of 100+ projects. Once loaded VS performance would be ok, though it would oddly flutter back and forth between ok and really bad.
The short answer: Eliminating Resharper warnings seems to improve overall VS/R# performance.
The biggest problem ultimately was that we had a number of files of binary data (encrypted stuff) being included as embedded resources, which happened to have .xml extensions. Resharper was trying really really hard to analyze those files. Eventually it'd get through but would generate 100K+ errors in the process. Changing the extension to one Resharper did not automatically analyze (.bin in this case) solved the problem.
We still have about 10 files which when they or a file they depend on is edited performance tanks for a while. These files are the partial parts of a single class definition where each file averages 3000 LOC. Yes, that's right, it's about a 30K line class. It also happens to be rather poor code for other reasons, many of which Resharper flags making the right hand gutter bar practically a solid orange line. Editing often causes Resharper to reanalyze the whole thing. While that analysis runs, performance is noticeably affected.
I've come to the conclusion that the less errors/warnings there are for R# to identify, the better it performs. My anecdotal evidence gathered while cleaning up/refactoring this project seems to support it.
A lot of folks complain of perf problems with Resharper. If you have even a few big ugly code files with lots of Resharper warnings, then a little time spent cleaning that code up might yield better performance overall. It has for us.
Not sure how big your solutions are, but I stopped using 4.5 for the same reasons I stopped using all previous versions, memory usage.
Code analysis and unit test support was the main reason I bought it, turning it off means the rationale for using it is gone.
Workstation has 4GB of memory, and I can easily kill it with ReSharper when running our end-to-end stack in debuggers.
You can look how much memory ReSharper use.
ReSharper -> General -> Show managed memory usege in status bar.
If you are working on large source files, Resharper does get sluggish (I'm working on version 5.0 at the time of writing this).
You can view the memory usage of Resharper by clicking on Resharper options -> General -> Show memory use in status bar.
When I first did this, I noticed Resharper had clocked up hundreds of megabytes of memory usage! However, the next step worked for me in (temporarily) fixing the slugishness:
Right click the memory usage, and select "Collect garbage" - this seemed to fix the slugishness for me straight away.
Regarding memory hogging - I've found that my VS2008 memory footprint grows every time I close one solution and open another. This is true even if I close a solution and re-open that same solution.
The new ReSharper 4.5 works a lot better than the previous 4.x releases. I would recommend you try that one.
In previous versions I had the same problem, when 4.0 came out these problems have seemed to have gone away. Now with 4.1 i do not feel the huge slow down i used to have. My IDE does not freeze up anymore.
have you tried upgrading ?
Try the 4.5 beta. 4.1 was killing my 2GB dev machine, but it's back to running incredibly smoothly with the beta. Others have had the opposite experience, though, so YMMV.
Yes, 4.5 works much better. My understanding is that 4.5 was to address the performance issues.
Me and my colleagues are also having huge performance issues with ReSharper, just now my ReSharper took 1.1GB of memory. Visual Studio slows down specially when writing JavaScript, it's unbearable. You can turn of the on the fly compilation, but it's the best feature it has...
edit: Everybody in this thread seems to have ReShaprper 4.x, my version is 6.0.
Is it possible to configure Visual Studio 2008 to automatically remove whitespace characters at the end of each line when saving a file? There doesn't seem to be a built-in option, so are there any extensions available to do this?
You can create a macro that executes after a save to do this for you.
Add the following into the EnvironmentEvents Module for your macros.
Private saved As Boolean = False
Private Sub DocumentEvents_DocumentSaved(ByVal document As EnvDTE.Document) _
Handles DocumentEvents.DocumentSaved
If Not saved Then
Try
DTE.Find.FindReplace(vsFindAction.vsFindActionReplaceAll, _
"\t", _
vsFindOptions.vsFindOptionsRegularExpression, _
" ", _
vsFindTarget.vsFindTargetCurrentDocument, , , _
vsFindResultsLocation.vsFindResultsNone)
' Remove all the trailing whitespaces.
DTE.Find.FindReplace(vsFindAction.vsFindActionReplaceAll, _
":Zs+$", _
vsFindOptions.vsFindOptionsRegularExpression, _
String.Empty, _
vsFindTarget.vsFindTargetCurrentDocument, , , _
vsFindResultsLocation.vsFindResultsNone)
saved = True
document.Save()
Catch ex As Exception
MsgBox(ex.Message, MsgBoxStyle.OkOnly, "Trim White Space exception")
End Try
Else
saved = False
End If
End Sub
I've been using this for some time now without any problems. I didn't create the macro, but modified it from the one in ace_guidelines.vsmacros which can be found with a quick google search.
Find/Replacing using Regular Expressions
In the Find and Replace dialog, expand Find Options, check Use, choose Regular expressions
Find What: ":Zs#$"
Replace with: ""
click Replace All
In other editors (a normal Regular Expression parser) ":Zs#$" would be "\s*$".
You can use a macro like this: http://www.codeguru.com/cpp/v-s/devstudio_macros/article.php/c3203/
ASIDE NOTE: I also think that VS is far from Eclipse for example with regard with save actions and plugin integration. But that is a fundamental problem regarding the underlying infrastructure and architecture of VS and has nothing to do with the current question.
Before saving you maybe be able to use the auto-format shortcut. CTRL+K+D
Unless this is a one-person project, don't do it. It's got to be trivial to diff your local files against your source code repository, and clearing whitespace would change lines you don't need to change. I totally understand; I love to get my whitespace all uniform ? but this is something you should give up for the sake of cleaner collaboration.
Taking elements from all the answers already given, here's the code I ended up with. (I mainly write C++ code, but it's easy to check for different file extensions, as needed.)
Thanks to everyone who contributed!
Private Sub DocumentEvents_DocumentSaved(ByVal document As EnvDTE.Document) _
Handles DocumentEvents.DocumentSaved
Dim fileName As String
Dim result As vsFindResult
Try
fileName = document.Name.ToLower()
If fileName.EndsWith(".cs") _
Or fileName.EndsWith(".cpp") _
Or fileName.EndsWith(".c") _
Or fileName.EndsWith(".h") Then
' Remove trailing whitespace
result = DTE.Find.FindReplace( _
vsFindAction.vsFindActionReplaceAll, _
"{:b}+$", _
vsFindOptions.vsFindOptionsRegularExpression, _
String.Empty, _
vsFindTarget.vsFindTargetFiles, _
document.FullName, _
"", _
vsFindResultsLocation.vsFindResultsNone)
If result = vsFindResult.vsFindResultReplaced Then
' Triggers DocumentEvents_DocumentSaved event again
document.Save()
End If
End If
Catch ex As Exception
MsgBox(ex.Message, MsgBoxStyle.OkOnly, "Trim White Space exception")
End Try
End Sub
I think that the Jeff Muir version could be a little improved if only trims source code files (in my case C#, but is easy to add more extensions). Also I added a check to ensure that the document window is visible because some situations without that check show me strange errors (LINQ to SQL files '*.dbml', for example).
Private Sub DocumentEvents_DocumentSaved(ByVal document As EnvDTE.Document) Handles DocumentEvents.DocumentSaved
Dim result As vsFindResult
Try
If (document.ActiveWindow Is Nothing) Then
Return
End If
If (document.Name.ToLower().EndsWith(".cs")) Then
document.Activate()
result = DTE.Find.FindReplace(vsFindAction.vsFindActionReplaceAll, ":Zs+$", vsFindOptions.vsFindOptionsRegularExpression, String.Empty, vsFindTarget.vsFindTargetCurrentDocument, , , vsFindResultsLocation.vsFindResultsNone)
If result = vsFindResult.vsFindResultReplaced Then
document.Save()
End If
End If
Catch ex As Exception
MsgBox(ex.Message & Chr(13) & "Document: " & document.FullName, MsgBoxStyle.OkOnly, "Trim White Space exception")
End Try
End Sub
Thanks everybody for your help.
You can do this this easily with these 3 actions:
CTRL+A (select all text)
Edit -> Advanced -> Delete Horizontal Whitespace
Edit -> Advanced -> Format Selection
Wait a few seconds and done.
It's CTRL-Z'able in case something went wrong.
I use ArtisticStyle (C++) to do this and also reformat my code. However I had to add this as external tool and you need to trigger it yourself so you might not like it.
However I find it excellent that I can reformat code in more custom way (eg. multiline function parameters) that I can pay the price of running it manually. The tool is free.
Building on Dyaus's answer and a regex from a connect report, here's a macro that handles save all, doesn't replace tabs with spaces, and doesn't require a static variable. It's possible downside? It seems a little slow, perhaps due to multiple calls to FindReplace.
Private Sub DocumentEvents_DocumentSaved(ByVal document As EnvDTE.Document) _
Handles DocumentEvents.DocumentSaved
Try
' Remove all the trailing whitespaces.
If vsFindResult.vsFindResultReplaced = DTE.Find.FindReplace(vsFindAction.vsFindActionReplaceAll, _
"{:b}+$", _
vsFindOptions.vsFindOptionsRegularExpression, _
String.Empty, _
vsFindTarget.vsFindTargetFiles, _
document.FullName, , _
vsFindResultsLocation.vsFindResultsNone) Then
document.Save()
End If
Catch ex As Exception
MsgBox(ex.Message, MsgBoxStyle.OkOnly, "Trim White Space exception")
End Try
End Sub
I am using VWD 2010 Express where macros are not supported, unfortunately. So I just do copy/paste into Notepad++ and choose "Trim Trailing Space" under "Edit" menu. Then copy/paste back into VS.
One can also use Netbeans instead of Notepad++, which has "Remove trailing spaces" under "Source" menu.
This is a really good example of how to remove trailing whitespace. There are a few things that I would change based on what I discovered using this macro. First of all, the macro automatically converts tabs to spaces. This is not always desirable and could lead to making things worse for people that love tabs (typically Linux-based). The tab problem is not really the same as the extra whitespace problem anyways. Secondly, the macro assumes only one file is being saved at once. If you save multiple files at once, it will not correctly remove the whitespace. The reason is simple. The current document is considered the document you can see. Third, it does no error checking on the find results. These results can give better intelligence about what to do next. For example, if no whitespace is found and replaced, there is no need to save the file again. In general, I did not like the need for the global flag for being saved or not. It tends to ask for trouble based on unknown states. I suspect the flag had been added solely to prevent an infinite loop.
Private Sub DocumentEvents_DocumentSaved(ByVal document As EnvDTE.Document) _
Handles DocumentEvents.DocumentSaved
Dim result As vsFindResult
'Dim nameresult As String
Try
document.Activate()
' Remove all the trailing whitespaces.
result = DTE.Find.FindReplace(vsFindAction.vsFindActionReplaceAll, _
":Zs+$", _
vsFindOptions.vsFindOptionsRegularExpression, _
String.Empty, _
vsFindTarget.vsFindTargetCurrentDocument, , , _
vsFindResultsLocation.vsFindResultsNone)
'nameresult = document.Name & " " & Str$(result)
'MsgBox(nameresult, , "Filename and result")
If result = vsFindResult.vsFindResultReplaced Then
'MsgBox("Document Saved", MsgBoxStyle.OkOnly, "Saved Macro")
document.Save()
Else
'MsgBox("Document Not Saved", MsgBoxStyle.OkOnly, "Saved Macro")
End If
Catch ex As Exception
MsgBox(ex.Message, MsgBoxStyle.OkOnly, "Trim White Space exception")
End Try
End Sub
I added debug message boxes to help see what was going on. It made it very clear that multiple file save was not working. If you want to play with them, uncomment those lines.
The key difference is using document.Activate() to force the document into the foreground active current document. If the result is 4, that means that the text was replaced. Zero means nothing happened. You will see two saves for every file. The first will replace and the second will do nothing. Potentially there could be trouble if the save cannot write the file but hopefully this event will not get called if that happens.
Before the original script, I was unaware of how the scripting worked in Visual Studio. It is slightly surprising that it uses Visual Basic as the main interface but it works just fine for what it needs to do.
A simple addition is to remove carriage returns during the save.
' Remove all the carriage returns.
result = DTE.Find.FindReplace(vsFindAction.vsFindActionReplaceAll, _
"\x000d\x000a", _
vsFindOptions.vsFindOptionsRegularExpression, _
"\x000a", _
vsFindTarget.vsFindTargetCurrentDocument, , , _
vsFindResultsLocation.vsFindResultsNone)
The key to this working is changing \x000d\x000a to \x000a. The \x prefix indicates a Unicode pattern. This will automate the process of getting source files ready for Linux systems.
I've found the partial solution for VS2010 rename crash. After the following macro changes, if file was saved before calling rename, then crash is not occured anymore.
Private Sub DocumentEvents_DocumentSaved(ByVal document As EnvDTE.Document) _
Handles DocumentEvents.DocumentSaved
Dim fileName As String
Dim result As vsFindResult
Try
fileName = document.Name.ToLower()
If fileName.EndsWith(".cs") _
Or fileName.EndsWith(".cpp") _
Or fileName.EndsWith(".c") _
Or fileName.EndsWith(".h") _
Or fileName.EndsWith(".xaml") _
Or fileName.EndsWith(".txt") Then
' Remove trailing whitespace
result = DTE.Find.FindReplace( _
vsFindAction.vsFindActionFind, _
"{:b}+$", _
vsFindOptions.vsFindOptionsRegularExpression, _
String.Empty, _
vsFindTarget.vsFindTargetFiles, _
document.FullName, _
"", _
vsFindResultsLocation.vsFindResultsNone)
If result = vsFindResult.vsFindResultFound Then
result = DTE.Find.FindReplace( _
vsFindAction.vsFindActionReplaceAll, _
"{:b}+$", _
vsFindOptions.vsFindOptionsRegularExpression, _
String.Empty, _
vsFindTarget.vsFindTargetFiles, _
document.FullName, _
"", _
vsFindResultsLocation.vsFindResultsNone)
If result = vsFindResult.vsFindResultReplaced Then
' Triggers DocumentEvents_DocumentSaved event again
document.Save()
End If
End If
End If
Catch ex As Exception
MsgBox(ex.Message, MsgBoxStyle.OkOnly, "Trim White Space exception")
End Try
End Sub
I think I have a version of this macro that won't crash VS2010 on refactor, and also won't hang the IDE when saving non-text files. Try this:
Private Sub DocumentEvents_DocumentSaved( _
ByVal document As EnvDTE.Document) _
Handles DocumentEvents.DocumentSaved
' See if we're saving a text file
Dim textDocument As EnvDTE.TextDocument = _
TryCast(document.Object(), EnvDTE.TextDocument)
If textDocument IsNot Nothing Then
' Perform search/replace on the text document directly
' Convert tabs to spaces
Dim convertedTabs = textDocument.ReplacePattern("\t", " ", _
vsFindOptions.vsFindOptionsRegularExpression)
' Remove trailing whitespace from each line
Dim removedTrailingWS = textDocument.ReplacePattern(":Zs+$", "", _
vsFindOptions.vsFindOptionsRegularExpression)
' Re-save the document if either replace was successful
' (NOTE: Should recurse only once; the searches will fail next time)
If convertedTabs Or removedTrailingWS Then
document.Save()
End If
End If
End Sub
Our build server is taking too long to build one of our C++ projects. It uses Visual Studio 2008. Is there any way to get devenv.com to log the time taken to build each project in the solution, so that I know where to focus my efforts?
Improved hardware is not an option in this case.
I've tried setting the output verbosity (under Tools / Options / Projects and Solutions / Build and Run / MSBuild project build output verbosity). This doesn't seem to have any effect in the IDE.
When running MSBuild from the command line (and, for Visual Studio 2008, it needs to be MSBuild v3.5), it displays the total time elapsed at the end, but not in the IDE.
I really wanted a time-taken report for each project in the solution, so that I could figure out where the build process was taking its time.
Alternatively, since we actually use NAnt to drive the build process (we use Jetbrains TeamCity), is there a way to get NAnt to tell me the time taken for each step?
Tools -> Options -> Projects and Solutions -> VC++ Project Settings -> Build Timing
should work.
Tools... Options... Projects and Solutions.... MSBuild project build output verbosity - set to "Detailed", and the build time will appear in the output window
If you're stuck on VS2005 you could use the vs-build-timer plugin. At the completion of a build it shows the total time taken and a (optional) summary of each of the project durations.
Disclaimer; I wrote it. And yes, I need to create an installer...one day!
Since your question involves using DevEnv from the command line, I would also suggest using MSBuild (which can build .sln files w/o modification).
msbuild /fl /flp:Verbosity=diagnostic Your.sln
msbuild /? will show you other useful options for the filelogger.
How can I find and delete unused references in my projects?
I know you can easily remove the using statements in vs 2008, but this doesn't remove the actual reference in your projects. The referenced dll will still be copied in your bin/setup package.
*Note: see http://www.jetbrains.net/devnet/message/5244658 for another version of this answer.
Reading through the posts, it looks like there is some confusion as to the original question. Let me take a stab at it.
The original post is really asking the question: "How do I identify and remove references from one Visual Studio project to other projects/assemblies that are not in use?" The poster wants the assemblies to no longer appear as part of the build output.
In this case, ReSharper can help you identify them, but you have to remove them yourself.
To do this, open up the References inth Solution Browser, right mouse click on each referenced assembly, and pick "Find Dependent Code". See:
You will either get:
A list of the dependencies on that Reference in a browser window, or
A dialog telling you "Code dependent on module XXXXXXX was not found.".
If you get the the second result, you can then right mouse click the Reference, select Remove, and remove it from your project.
While you have to to this "manually", i.e. one reference at a time, it will get the job done. If anyone has automated this in some manner I am interested in hearing how it was done.
You can pretty much ignore the ones in the .Net Framework as they don't normally get copied to your build output (typically - although not necessarily true for Silverlight apps).
Some posts seem to be answering the question: "How do I remove using clauses (C#) from a source code file that are not needed to resolve any references within that file".
In this case, ReSharper does help in a couple ways:
Identifies unused using clauses for you during on the fly error detection. They appear as Code Inspection Warnings - the code will appear greyed out (be default) in the file and ReSharper will provide a Hint to remove it:
http://www.jetbrains.com/resharper/features/code%5Fanalysis.html#On-the-fly%5FError%5FDetection
Allows you to automatically remove them as part of the Code Cleanup Process:
Finally, realize that ReSharper does static code analysis on your solution. So, if you have a dynamic reference to the assembly - say through reflection or an assembly that is dynamically loaded at runtime and accessed through an interface - it won't pick it up. There is no substitute for understanding your code base and the project dependencies as you work on your project. I do find the ReSharper features very useful.
Removing unused references is a feature Visual Studio 2008 already supports. Unfortunately, only for VB .NET projects.
I have opened a suggestion on Microsoft Connect to get this feature for C# projects too:
http://connect.microsoft.com/VisualStudio/feedback/ViewFeedback.aspx?FeedbackID=510326
If you like this feature as well then you might vote my suggestion.
you can use the 'Remove Unused References' extension I wrote:
http://visualstudiogallery.msdn.microsoft.com/9811e528-cfa8-4fe7-9dd1-4021978b5097
Resharper will do this for you (and so so much more!)
ReSharper 6.1 will include these features:
-Optimize references: analyze your assembly references and their usages in code, get list of redundant references and remove them.
-Remove Unused References: quick refactoring to remove redundant assembly references.
-Safe delete on assembly references: will delete assembly references if all of them are redundant, otherwise dispalies usages and can remove only redundant assembly references of the selected list.
Ah, it will? Has it always been able to do this?
Earlier on I loved resharper, untill it broke the double-tab functionality. Then I realised I actually like my visual studio without all the resharper magics.
Maybe I should give it another shot at some point..
Given that VisualStudio (or is it msbuild?) detects unused references and doesn't include them in the output file, you can write a script which parses the references out of the csproj, and compares that with the referenced Assemblies detected by reflexion on the project output.
If you're motivated...
PowerCommands for Visual Studio 2008 (free from MSDN Code Gallery) has a "Remove and Sort Usings" command in a context menu that can be executed at the file, folder, project, and solution levels. It has many other nice features as well, including an "Undo Close" pane for re-opening recently closed files.
When I debug in Visual Studio, Firefox opens and that is annoying because of the hookups that Internet Explorer and Visual Studio have, such as when you close the Internet Explorer browser that starting debug opened, Visual Studio stops debugging. How can I get Visual Studio to open Internet Explorer instead without having to set Internet Explorer as my default browser?
Scott Guthrie has made a post on how to change Visual Studio's default browser:
1) Right click on a .aspx page in your solution explorer
2) Select the "browse with" context menu option
3) In the dialog you can select or add a browser. If you want Firefox in the list, click "add" and point to the firefox.exe filename
4) Click the "Set as Default" button to make this the default browser when you run any page on the site.
I however dislike the fact that this isn't as straightforward as it should be.
In Visual Studio 2010 the default browser gets reset often (just about every time an IDE setting is changed or even after restarting Visual Studio). There is now a default browser selector extension for 2010 to help combat this:
WoVS Default Browser Switcher: http://visualstudiogallery.msdn.microsoft.com/en-us/bb424812-f742-41ef-974a-cdac607df921
Edit: This works with ASP.NET MVC applications as well.
Note: One negative side effect of installing this extension is that it seems to nag to be updated about once a month. This has caused some to uninstall it because, to them, its more bothersome then the problem it fixes. Regardless it is easily updated through the extension manager and I still find it very useful.
You will see the following error when starting VS:
The Default Browser Switcher beta bits have expired. Please use the Extension Manager or visit the VS Gallery to download updated bits.
Right-click on an aspx file and choose 'browse with'. I think there's an option there to set as default.
Also may be helpful for ASP.NET MVC:
In an MVC app, you have to right-click on Default.aspx, which is the only ?real? web page in that solution. The default page displays ?Browse with??
In the Solution Explorer, right-click any ASPX page and select "Browse With" and select IE as the default.
Note... the same steps can be used to add Google Chrome as a browser option and to optionally set it as the default browser.
Quick note if you don't have an .aspx in your project (i.e. its XBAP) but you still need to debug using IE, just add a htm page to your project and right click on that to set the default. It's hacky, but it works :P
I couldn't find any aspx page in my MVC3 project, so I added a dummy webform1.aspx. This is totally useless, but it worked for setting the default browser for the project. I then deleted the dummy file and everything works great!
If you're running an MVC 3 application - in your solution explorer click the show all files icon and then under the Global.asax file there should be a file called YourProjectName.Publish.XML right-click it and then click "Browse With..." and select your favorite browser as the default.
You may debug by firefox also .
Fallow these steps Tool->Attach to process and select firefox.exe or your default browser than debugger works by this browser. But I had some trouble when firefox is 32 bit and and VS2010 is 64 bit.
Anyway right click the current document browse with--> than choose your browser than set as default it. This way is better. B'cause firefox's process id may change than you will be annoyed for attaching the process again.
Note that this is almost certainly a political decision on Microsoft's part. When the modern era of VS was being designed - VS 2003 or so - regulators were still very keen to avoid Microsoft pushing IE in any way. It would have been politically unfeasible to have VS default to anything except the user's chosen browser.
I remember about the same time, MS put out a patch for ?Media Player? because one of the menu items that opened a web page used IE instead of the default browser.
Is there a way to prevent mspdbsrv.exe from continuing to run after finishing the compilation? or even after I terminate visual studio? or perhaps even prevent it from even spawning in the first place?
what is this guy good for anyway?
using vs2005
MS recommends to add a postbuild-event to the Project options here.
[...]Sometimes it is possible that mspdbsrv.exe stays alive even after the build is over. In such scenarios, it is safe to add a post build event to kill the mspdbsrv.exe.
Background infos on postbuild-Events can be found on the linked page.
mspdbsrv.exe is the process Visual Studio uses to create .pdb files when you compile; these are the symbol files that let you debug an application. Sometimes it goes berserk and doesn't shutdown correctly when you exit Visual Studio. I've had this cause bad compiles even after quitting and restarting Visual Studio. Use Process Explorer or the task list (Ctrl+Alt+Delete in Windows) to manually kill mspdbsrv.exe if it's broken on you.
For what it's worth, I haven't seen this problem happen in Visual Studio 2008 as of yet, but I've only been using it a few days.
A little googling seems to indicate that mspdbsrv.exe zombies are a known issue in VS2005. We've had similar (intermittent) problems, but there did not seem to be a solution.
Yes, it sucks.
Killing mspdbsrv.exe from task manager doesn't seem to be a good solution. Isn't there any workaround?
If you have a statically allocated array, the Visual Studio debugger can easily display all of the array elements. However, if you have an array allocated dynamically and pointed to by a pointer, it will only display the first element of the array when you click the + to expand it. Is there an easy way to tell the debugger, show me this data as an array of type Foo and size X?
Yes, simple. say you have
char *a = new char[10];
writing in the debugger:
a,10
would show you the content as if it were an array.
In a watch window, add a comma after the name of the array, and the amount of items you want to be displayed.
Try something along the lines of
(Foo[x])(*ptr)
May just work...
(My own experience with VC++ ended on VS2000, but try it anyway)
I have somehow misconfigured fingers. This leads to a very annoying situation.
Is there any way to disable this behavior, that is to disable copy of empty blocks of text in Visual Studio 2005+?
It's not copying an empty block, it's copying the blank line. You can change this setting in Tools > Options > Text Editor > All Languages > 'Apply Cut or Copy Commands to blank lines when there is no selection'
Press CTRL+SHIFT+V twice.
I'm using Visual Studio 2008 (but I believe this answer applies to Visual Studio 2005).
Select Tools -> Options.
Navigate to the "Text Editor" node and expand it.
Expand "All Languages" (or whatever language you want to apply this to) and check the "Apply Cut or Copy commands to blank lines when there is no selection".
The option that saved my sanity is found in Tools - Options - Text Editor - All Languages - General. There's a checkbox Apply Cut or Copy commands to blank lines when there is no selection. Unchecking this allowed me to hit Ctrl+C all i want on a blank line without losing the content on my clipboard.
Go to Tools > Options > Text Editor > All Languages > General
The option on that page is "Apply Cut or Copy commands to blank lines when there is no selection"
I am getting some errors thrown in my code when I open a win form in visual studio's designer. I would like to branch in my code and perform a different initialization if the form is being opened by designer than if it is being run for real.
How can I determine at run-time if the code is being executed as part of designer opening the form?
To find out if you're in "design mode":
The Control.DesignMode property is probably what you're looking for. It tells you if the control's parent is open in the designer.
In most cases it works great, but there are instances where it doesn't work as expected. First, it doesn't work in the controls constructor. Second, DesignMode is false for "grandchild" controls. For example, DesignMode on controls hosted in a UserControl will return false when the UserControl is hosted in a parent.
There is a pretty easy workaround. It goes something like this:
public bool HostedDesignMode
{
get
{
Control parent = Parent;
while (parent!=null)
{
if(parent.DesignMode) return true;
parent = parent.Parent;
}
return DesignMode;
}
}
I haven't tested that code, but it should work.
Process.GetCurrentProcess().ProcessName.ToLower().Trim() == "devenv";
causes a memory leak. You must dispose the process object.
I'm not sure if running in debug mode counts as real, but an easy way is to include an if statement in your code that checkes for System.Diagnostics.Debugger.IsAttached.
It's hack-ish, but if you're using vb.net and when you're running from within visual studio My.Application.Deployment.CurrentDeployment will be Nothing, because you haven't deployed it yet. I'm not sure how to check the equivalent value in C#.
If you are in a form or control you can use the DesignMode property:
if (DesignMode)
{
DesignMode Only stuff
}
The most reliable approach is:
public bool isInDesignMode
{
get
{
return (System.Diagnostics.Process.GetCurrentProcess().ProcessName == "devenv");
}
}
System.Diagnostics.Debugger.IsAttached
You check the DesignMode property of your control:
if (!DesignMode)
{
//Do production runtime stuff
}
Note that this won't work in your constructor because the components haven't been initialized yet.
System.ComponentModel.Component.DesignMode == true
We use the following code in UserControls and it does the work. Using only DesignMode will not work in your app that uses your custom user controls as pointed out by other members.
public bool IsDesignerHosted
{
get { return IsControlDesignerHosted(this); }
}
public bool IsControlDesignerHosted(System.Windows.Forms.Control ctrl)
{
if (ctrl != null)
{
if (ctrl.Site != null)
{
if (ctrl.Site.DesignMode == true)
return true;
else
{
if (IsControlDesignerHosted(ctrl.Parent))
return true;
else
return false;
}
}
else
{
if (IsControlDesignerHosted(ctrl.Parent))
return true;
else
return false;
}
}
else
return false;
}
I found the DesignMode property to be buggy, at least in previous versions of Visual Studio. Hence, I made my own using the following logic:
Process.GetCurrentProcess().ProcessName.ToLower().Trim() == "devenv";
Kind of a hack, I know, but it works well.
The most reliable way to do this is to ignore the DesignMode property and use your own flag that gets set on application startup.
Class:
public static class Foo
{
public static bool IsApplicationRunning { get; set; }
}
Program.cs:
[STAThread]
static void Main()
{
Foo.IsApplicationRunning = true;
// ... code goes here ...
}
Then just check the flag whever you need it.
if(Foo.IsApplicationRunning)
{
// Do runtime stuff
}
else
{
// Do design time stuff
}
Visual Studio solutions contain two types of hidden user files. One is the solution .suo file which is a binary file. The other is the project .user file which is a text file. Does anyone know exactly what data these files contain? I've also been wondering whether I should be adding these files to source control (Subversion in my case). If I don't add these files and another developer checks out the solution, will Visual Studio automatically create new user files?
These files contain user preference configurations that are in general specific to your machine, so it's better not to put it in SCM. Also, VS will change it almost every time you execute it, so it will allways be marked by the SCM as 'changed'. I don't include both, I'm in a project using VS for 2 years and had no problems doing that. The only minor annoyance is that the debug parameters (execution path, deployment target, etc.) are stored in one of those files (don't know which), so if you have a standard for them you won't be able o 'publish' it via SCM for other developers to have the entire development environment 'ready to use'.
You don't need to add these -- they contain per-user settings, and other developers won't want your copy.
Others have explained why adding the *.suo and *.user files to source control is not a good idea.
I'd like to suggest that you set the svn:ignore property to include those types of files, for 2 reasons:
We don't commit the binary file (*.suo), but we commit the .user file. The .user file contains for example the start options for debugging the project. You can find the start options in the properties of the project in the tab "Debug". We used NUnit in some projects and configured the nunit-gui.exe as the start option for the project. Without the .user file, each team member have to configure it separately.
Hope this helps.
No, you should not add them to source control since - as you said - they're user specific.
SUO (Solution User Options): Records all of the options that you might associate with your solution so that each time you open it, it includes customizations that you have made.
The .user file contains the user options for the project (while SUO is for the solution) and extends the project file name (e.g. anything.csproj.user contains user settings for the anything.csproj project).
Visual Studio will automatically create them. I don't recommend putting them in source control. There have been numerous times where a local developer's SOU file was causing VS to behave erratically on that developers box. Deleting the file and then letting VS recreate it always fixed the issues.
By default Microsoft's Visual SourceSafe does not include these files in the source control because they are user-specific settings files. I would follow that model if you're using SVN as source control.
These files are user-specific options, which should be independent of the solution itself. Visual Studio will create new ones as necessary, so they do not need to be checked in to source control. Indeed, it would probably be better not to as this allows individual developers to customize their environment as they see fit.
This appears to be Microsoft's opinion on the matter: http://social.msdn.microsoft.com/forums/en-US/vssourcecontrol/thread/dee90d75-d825-4c76-a30f-016eab15ef7f
you cannot source-control the .user files because that's user specific. it contains the name of remote machine and other user dependent things. it's a vcproj related file
the .suo is a sln related file and it contains the "solution user options" (startup project(s), windows position (what's docked and where, what's floating), etc )
it's a binary file, I don't know if it contains something "user related".
In our company we do not take under source control those files.
Since I found this question/answer through google in 2011, I thought I'd take a second and add the link for the *.SDF files created by Visual Studio 2010 to the list of files that probably should not be added to version control (the IDE will re-create them). Since I wasn't sure that a *.sdf file may have a legitimate use elsewhere, I only ignored the specific [projectname].sdf file from SVN.
Why does the visual studio conversion wizard 2010 create a massive SDF database file?
Sorry about the old thread resurrection, but hopefully useful to someone else.
.user is the user settings, and I think .suo is the solution user options. You don't want these files under source control; they will be re-created for each user.
Using Rational ClearCase the answer is no, only the .sln & .*proj should be registered in source code control, I can't answer for other vendors. If I recall correctly these files are "user" specific options, your environment.
I wouldn't. Anything that could change per "user" is usually not good in source control. .suo, .user, obj/bin directories
They contains the specific settings about project that are tipically assigned to a single developer (like, for example, the starting project and starting page to start when you debug your application).
So it's better not adding them to version control, leaving VS recreate them so that each developer can have the specific settings he wants.
Is there any way to know if I'm compiling under Microsoft Visual Studio 2008 ?
_MSC_VER is what you need. You can also examine visualc.hpp in any recent boost install for some usage examples.
Some values for the more recent versions of the compiler are:
MSVC++ 10.0 _MSC_VER = 1600
MSVC++ 9.0 _MSC_VER = 1500
MSVC++ 8.0 _MSC_VER = 1400
MSVC++ 7.1 _MSC_VER = 1310
MSVC++ 7.0 _MSC_VER = 1300
MSVC++ 6.0 _MSC_VER = 1200
MSVC++ 5.0 _MSC_VER = 1100
The version number above of course refers to the major version of your Visual studio you see in the about box, not to the year in the name.
By using Visual Studio specific macros, more info is here.
_MSC_VER should be defined to a specific version number. You can either #ifdef on it, or you can use the actual define and do a runtime test. (If for some reason you wanted to run different code based on what compiler it was compiled with? Yeah, probably you were looking for the #ifdef. :))
By using the _MSC_VER macro.
In visual studio, go to help | about and look at the version of Visual Studio that you're using to compile your app.
This is a little old but should get you started:
//******************************************************************************
// Automated platform detection
//******************************************************************************
// _WIN32 is used by
// Visual C++
#ifdef _WIN32
#define __NT__
#endif
// Define __MAC__ platform indicator
#ifdef macintosh
#define __MAC__
#endif
// Define __OSX__ platform indicator
#ifdef __APPLE__
#define __OSX__
#endif
// Define __WIN16__ platform indicator
#ifdef _Windows_
#ifndef __NT__
#define __WIN16__
#endif
#endif
// Define Windows CE platform indicator
#ifdef WIN32_PLATFORM_HPCPRO
#define __WINCE__
#endif
#if (_WIN32_WCE == 300) // for Pocket PC
#define __POCKETPC__
#define __WINCE__
//#if (_WIN32_WCE == 211) // for Palm-size PC 2.11 (Wyvern)
//#if (_WIN32_WCE == 201) // for Palm-size PC 2.01 (Gryphon)
//#ifdef WIN32_PLATFORM_HPC2000 // for H/PC 2000 (Galileo)
#endif
Yep _MSC_VER is the macro that'll get you the compiler version.
You can use code like this:
#if (_MSC_VER >= 1500 && _MSC_VER < 1600)
// ... Do VC9/Visual Studio 2008 specific stuff
#endif
I am using VS2008 and Resharper. Resharper creates a directory _Resharper.ProjectName. These files provide no value for source control that I am aware of and cause issues when committing changes. How can I get SVN to ignore them? I am using TortoiseSVN as my interface for SVN.
EDIT: You guys are fast.
Add the file names (or even the pattern _Resharper.*) to the svn:ignore property for its parent directory.
Gonna post an answer to my own question here as I RTFM after I typed this up. In TortoiseSVN, goto settings. Add
*ReSharper*
to the "Global ignore pattern". Adding items to the global ignore pattern means that these files will be ignored for any project you work on for the client with TortoiseSVN installed, so it might not be appropriate to use the global ignore in all cases.
You can also add specific files and directories to the ignore list for individual projects if you select this from the TortoiseSVN menu BEFORE they have been added to your repository. The "BEFORE" part is what tripped me up originally. Since this is a single developer project, I've been checking in binaries, etc. b/c it has no consequence for other developers, and the Resharper files got in there.
Short answer: the "svn:ignore" property
Long answer:
# cd /your/working/copy
# export EDITOR=vi
# svn propedit svn:ignore .
(add "_Resharper.ProjectName" on its own line and write the file out)
Edit: erg... doh, just realized you said tortoise... this is how you do it with the command-line version of SVN
Store Resharper caches in system temp folder. Check First setting page in r#. Environment -> General -> System -> Store caches ..
svn has an "ignore" property you can attach to a filename pattern or a directory. Files and directories that are ignored won't be reported in "svn st" commands and won't go into the repo.
Example: you have C source code in .c and .h files, but the compiler creates a bunch of .o files that you don't want subversion to bother telling you about. You can use Subversion's properties feature to tell it to ignore these.
For a few files in one checked-out working directory, for example myproject/mysource/
bash> svn propedit svn:ignore mysource
In the text editor that pops up (in linux, probably vi or whatever your EDITOR env var is set to), add one filename pattern per line. Do not put a trailing space after the pattern (this confuses svn).
*.o
*.bak
That's all. You may want to do a commit right away, since sometimes svn gets fussy about users making too many different kinds of changes to files between commits. (my rule is: if in doubt, commit. It's cheap)
For a type of file appearing in many places in a sprawling directory tree, edit the subversion config file kept inside the repository. This requires the repository administrator's action, unless you have direct access to the repository (not through svn: or http: or file:, but can 'cd' to the repository location and 'ls' its files). The svn books should have the details; i don't recall offhand right now.
Since i don't use Tortoise, i don't know how directly the description above translates - but that's why we have editable answers (joy!)
Look at this answer for storing the Resahrper cache in the system TEMP folder.
This way you can not even accidentally add it to any version control system - not just SVN.
This blog post provides a example on how to do what you want on via command line svn. http://sdesmedt.wordpress.com/2006/12/10/how-to-make-subversion-ignore-files-and-folders/
These change will be reflected in TortoiseSVN.
I believe there is a way to do it via tortoise however i don't have a windows vm accessible atm, sorry :(
SVN only controls what you put into it when creating your repository. Don't just import your entire project folder but import a "clean" folder BEFORE doing a build. After the build you get all the object files or your _Resharper folder etc. but they are not version controlled.
I forgot: the
How do I use the profiler in Visual Studio 2008?
I know theres a build option in Config Properties -> Linker -> Advanced -> Profile (/PROFILE), however I can't find anything about actauly using it, only articles I was able to find appear to only apply to older versions of Visual Studio (eg most say to goto Build->Profile to bring up the profile dialog box, yet in 2008 there is no such menu item).
Is this because Visual Studio 2008 does not include a profiler, and if it does where is it and where is the documentation for it?
Microsoft has released stand-alone Profiler for VS 2008 here
The profiler is only available in the Team System editions of Visual Studio 2008. The last version that I used that included a profiler was Visual C++ 6.0.
For Visual Studio 2005, you could try Compuware DevPartner Performance Analysis Community Edition.
There was also a list of .NET profilers in the What Are Some Good .NET Profilers question.
Is there a way to access Visual Studio's built-in ASP.NET Development Server over HTTPS?
Cassini does not support HTTPS.
However, you can use IIS to do this, if your using IIS 5.1, download the MS IIS toolpack for IIS 6.0, it comes with a tool to create self signed SSL certificates. This works on IIS 5.1
The one tool you need (SelfSSL.exe) works just fine with IIS 5.1. Unfortunately, it comes bundled with a bunch of other stuff.
Steps:
At this point, you will be able to run your localhost over HTTPS.
Wilco Bauwer wrote a webdev server that will support https. He is one of the developers that worked on cassini visual studio 2005 built in web server. WebDev.WebServer2
I am planning to give a Technical presentation for a product we are building. Intended audience is Technical developers. So, most of the time, I will be debugging trough the code in Visual Studio, performance analysis, some architecture review etc.
I have read couple of blogs on font sizes to use, templates to use on Visual Studio, presentation tools, among other very useful tips.
What I am looking specifically for is how to keep the session interesting without making it a dry code walkthrough? How to avoid making people fall asleep? Would be great to hear some stories..
Update1: Nice youtube clip on zoomit. Glue Audience To Your Presentation With Zoomit.
Update2: New post from Scott Hanselman after his PDC talk - Tips for Preparing for a Technical Presentation
Put interesting comments in the code.
// This better not fail during my next presentation, stupid @#$@#%$ code.
Don't talk about them, let them be found by the audience.
FYI, that Hanselman article has an update (your link is from 2003).
Use stories. Even with code examples, have a backstory: here's why someone is doing this. To increase audience participation, ask for examples of X where X is something you know you can demo, then phrase the walk-through in those terms.
Or maybe you have war stories about how it was different or how it normally takes longer or whatever. I find people identify with such things, then as you give your examples they're mentally tracking it back to their own experience.
I recommend Scott Hanselman's post (previously mentioned). I've written up a post with some tips, mostly for selfish reasons - I review it every time before I give a technical presentation:
Tips for a Technical Presentation
If you're using a console prompt, make sure the font is readable and that your paths are preset when possible.
Take 15 minutes to install and learn to use ZoomIt, so your audience can clearly see what you're showing off. If you have to ask if they can see something, you've already failed.
Probably most important is to have separate Visual Studio settings pre-configured with big, readable fonts.
One of the best pieces of advice I ever got for doing demos is to just plain record them in advance and play back the video, narrating live. Then the unexpected stuff happens in private and you get as many stabs at it as you need.
You still usually need some environment to use as a reference for questions, but for the presentation bit, recording it in advance (and rehearsing your narration over the video) pretty much guarantees you can be at the top of your game.
I also like to put small jokes into the slides and that recorded video that make it seem like the person who made the slides is commenting on the live proceedings or that someone else is actually running the slides. Often, I make absolutely no reference at all to the joke in the slide.
For instance, in my most recent demo presentation, I had a slide with the text "ASP.NET MVC" centered that I was talking over about how I was using the framework. In a smaller font, I had the text "Catchy name, huh?". When I did that demo live, that slide got a chuckle. It's not stand-up worthy by any stretch of the imagination, but we're often presenting some pretty dry stuff and every little bit helps.
Similarly, I've included slides that are just plain snarky comments from the offscreen guy about what I'm planning to say. So, I'll say, "The codebase for this project needed a little help", while the slide behind me said "It was a pile of spaghetti with 3 meatballs, actually" and a plate of spaghetti as the slide background. Again, with no comment from me and just moving on to the next slide as though I didn't even see it actually made it funnier.
That can also be a help if you don't have the best comedic timing by taking the pressure off while still adding some levity.
Anyway, what it really comes down to is that I've been doing most of my demo/presentation work just like I would if it was a screencast and then substituting the live version of me (pausing the video as appropriate if things go off the rails) for the audio when I give it in front of an audience.
Of course, you can then easily make the real presentation available afterward for those who want it.
For the slides, I generally go out of my way to not say the exact words on the screen more often than not.
If you are showing code that was prepared for you then make sure you can get it to work. I know this is an obvious one but I was just at a conference where 4 out of 5 speakers had code issues. Telling me it is 'cool' or even 'really cool' when it doesn't work is a tough sell.
The #1 rule for me is: Don't try to show too much.
It's easy to live with a chunk of code for a couple of weeks and think, "Damn, when I show 'em this they are gonna freak out!" Even during your private rehearsals you feel good about things. But once in front of an audience, the complexity of your code is multiplied by the square of the number of audience members. (It becomes exponentially harder to explain code for each audience member added!)
What seemed so simple and direct privately quickly turns into a giant bowl of spaghetti that under pressure even you don't understand. Don't try to show production code (well factored and well partitioned), make simple inline examples that convey your core message.
My rule #1 could be construed, by the cynical, as don't overestimate you audience. As an optimist, I see it as don't overestimate your ability to explain your code!
rp
Since it sounds like you are doing a live presentation, where you will be working with real systems and not just charts (PPT, Impress, whatever) make sure it is all working just before you start. It never fails, if I don't try it just before I start talking, it doesn't work how I expected it to. Especially with demos. (I'm doing one on Tuesday so I can relate.)
The other thing that helps is simply to practice, practice, practice. Especially if you can do it in the exact environment you will be presenting in. That way you get a feel for where you need to be so as not to block the view for your listeners as well as any other technical gotchas there might be with regards to the room setup or systems.
This is something that was explained to me, and I think it is very useful. You may want to consider not going to slide heavy at the beginning. You want to show your listeners something (obviously probably not the code) up front that will keep them on the edge of their seats wanting to learn about how to do what you just showed them.
You should read Mark Jason Dominus excellent presentaton on public speaking: Conference Presentation Judo
I've recently started to use Mind Mapping tools for presentations and found that it goes over very well.
http://en.wikipedia.org/wiki/Mind_map
Basically, I find people just zone out the second you start to go into details with a presentation. Conveying the information with a mind map (at least in my experience), provides a much easier way for the information to be conveyed and tied together.
The key is presenting the information in stages (ie, your high-level ideas first, then in more detail, one at a time). The mind-mapping tools basically let you expand your map, as the audience watches and your present more and more detailed information. Doing it this way lets your audience gradually absorb the data in smaller stages, which tends to aid retention.
Check out FreeMind for a free tool to play with. Mind Manager is a paid product, but is much more polished and fluent.
Keep your "visual representation" simple and standard.
If you're on Vista hide your desktop icons and use one of the default wallpapers. Keep your Visual Studio settings (especially toolbars) as standard and "out of the box" as possible. The more customizations you show in your environment the more likely people are going to focus on those rather than your content.
Keep the content on your slides as consisce as possible. Remember, you're speaking to (and in the best scenario, with) your audience so the slides should serve as discussion points. If you want to include more details, put them in the slide notes. This is especially good if you make the slide decks available afterwards.
If someone asks you a question and you don't know the answer, don't be afraid to say you don't know. It's always better than trying to guess at what you think the answer should be.
Also, if you are using Vista be sure to put it in "presentation mode". PowerPoint also has a similar mode, so be sure to use it as well - you have the slide show on one monitor (the projector) and a smaller view of the slide, plus notes and a timer on your laptop monitor.
Have you heard of Pecha-Kucha?
The idea behind Pecha Kucha is to keep presentations concise, the interest level up and to have many presenters sharing their ideas within the course of one night. Therefore the 20x20 Pecha Kucha format was created: each presenter is allowed a slideshow of 20 images, each shown for 20 seconds. This results in a total presentation time of 6 minutes 40 seconds on a stage before the next presenter is up
Now, i am not sure if that short duration could be ok for a product demonstration. But you can try to get some nice ideas from the concept, such as to be concise and keep to the point, effective time, space management etc..
Besides some software like Mind Manager to show your architecture, you make find a screen recorder as a presentation tool to illustrate your technical task. DemoCreator would be something nice to make video of your onscreen activity. And you can add more callout to make the process easier to understand.
I once wrote a series of blog posts with tips for better delivery of scientific presentations. Actually, most of the time scientific presentations are a special case (a subset) of technical presentations. These tips to not cover the techniques of technical presentation delivery, but rather give small additional points to improvement. Here you are:
If you use slides at all, follow Guy Kawasaki's 10/20/30 rule:
I thought JQuery Intellisense was supposed to be improved with SP1. I even downloaded an annotated version of jquery 1.2.6, but intellisense will not work in a separate jscript file. I have the jquery library referenced first on my web page in the tag. Am I doing anything wrong?
At the top of your external js file, add the following:
/// <reference path="jQuery.js"/>
Make sure the path is correct, relative to the file's position in the folder structure, etc.
Also, any references need to be at the top of the file, before any other text, including comments - literally, the very first thing in the file. Hopefully future version of VS will work regardless of where it is in the file, or maybe they will do something altogether different...
Once you have done that and saved the file, hit CTRL+SHIFT+J to force VS to update Intellisense.
There is an officially supported jQuery documentation javascript file for Visual Studio 2008. This file is only an interim fix until MS releases a hotfix that will more adequately address the issue.
Embedded in ASPX:
<% if (false) { %>
<script src="jquery-1.2.6-vsdoc.js" type="text/javascript"></script>
<% } %>
Embedded in JS:
/// <reference path="jquery-1.2.6-vsdoc.js" />
Pick it up here: jquery-1.2.6-vsdoc.js
References:
You'll want to look at this link:
http://blogs.ipona.com/james/archive/2008/02/15/JQuery-IntelliSense-in-Visual-Studio-2008.aspx
UPDATE: There is a new HotFix for Visual Studio 2008 and a new jQuery Intellisense Documentation file that brings full jQuery Intellisense to VS'08. Below are links to get these two:
http://blogs.msdn.com/webdevtools/archive/2008/10/28/rich-intellisense-for-jquery.aspx
You shouldn't need to actually reference the "-vsdoc" version. If you put the jquery-1.2.6-vsdoc.js in the same directory as jquery-1.2.6.js then Visual Studio will know to covert a jquery-1.2.6.js reference to jquery-1.2.6-vsdoc.js.
I think that will actually work for any file.
Hmmm... that gives a good workaround for another question on this site...
Edit: This feature only works with VS2008 Service Pack 1.
for inline javascript use:
/// <reference path="~\js\jquery-vsdoc.js"/>
note the BACKslashes.
this will not work:
/// <reference path="~/js/jquery-vsdoc.js"/>
If you are including the annotated jquery file in your source solely for intellisense, I recommend leveraging preprocessor directives to remove it from your view when you compile. Ala:
<% #if (false) %>
<!-- This block is here for jquery intellisense only. It will be removed by the compiler! -->
<script type="text/javascript" src="Scripts/jquery-1.3.2-vsdoc.js"></script>
<% #endif %>
Then later in your code you can really reference jQuery. This is handy when using the Google AJAX Libraries API because you get all the benefits Google provides you, plus intellisense.
Here is a sample of using the Libraries API:
<script type="text/javascript" src="http://www.google.com/jsapi"></script>
<script type="text/javascript">
google.load("jquery", "1.3.2", { uncompressed: false });
</script>
make sure you're not using a minimized jQuery file
Ctrl+Shift+J to make it work after adding js files to the project
If you want to pick up the Intellisense file from the Microsoft CDN you can use:
/// <reference path="http://ajax.microsoft.com/ajax/jQuery/jquery-1.4.1-vsdoc.js" />
I loved this post by ScottGu which made me think a bit about Hard drive speeds and how it is linked to Visual Studio performance. Since it is a bit older post, I would like to hear from you (serious programmers) if you bought any laptop recently with the same ideas.
Is it worth using Solid State drives? Should I go for 64-bit?
I am a heavy user of Visual Studio and my old Latitude started giving me a hard time. If you have any recommendation, it will help me a lot.
PS: Since it is more of a hardware related question and if it is not appropriate here, feel free to leave a comment. I will gladly delete the post.
I just want to hear first hand experience if you have any.
Just get a MacBook Pro =)
I'm serious, it is the best hardware I have ever used. Mine is two years old and feels exactly like the day I got it.
And this has nothing to do with Mac OS X, you can wipe it clean and install Windows Vista.
PC World: MacBook Pro: The fastest Windows Vista laptop
I haven't used solid state drives, I can't comment on that.
UPDATE
Times have changed and I can't leave answer as it is. I'm going to suggest that people now go buy themselves a SSD. Write problems have mostly been solved, prices have come down and affordable storage capacity has gone up.
Forget SSD, they're slower than you think and have very little capacity.
Instead consider a VelociRaptor IDE drive from Western Digital ($179.99 for 150 GB or $289.99 for 300GB at NewEgg). It's the fastest IDE hard drive known to man right now and has up to a 300 GB capacity. Buy a laptop with eSata (or get a card for it) and you'll experience speeds you've never dreamed of on a laptop (eSata can sport up to 3 Gbps).
This implies that you use it with an external hard drive enclosure, but odds are you'll need one anyways for the SSD (unless you get it installed in a new laptop which costs a LOT of money).
Consider the following HDTach benchmarks from an external Raptor (10,000 RPM/120GB): http://bp3.blogger.com/%5Fx%5FKlQTLtnfI/R8RqCdiA4sI/AAAAAAAAAX0/PikIVAfrHuE/s1600-h/raptor+esata+speed+test.PNG
VS an internal MacBook Pro Harddrive (5400RPM 120GB): http://bp3.blogger.com/%5Fx%5FKlQTLtnfI/R8Rp6diA4rI/AAAAAAAAAXs/lC-WfGlToIg/s1600-h/MacBook+pro+internal+hdd+speed+test.PNG
And the VelociRaptor is even FASTER than the Raptor! If you still need more convincing as to which is a better idea, Maximum PC did a SSD vs. VelociRaptor not too long ago and the VelociRaptor slapped around the SSD like it owed the VelociRaptor money.
Solid State is getting there... 64GB SSD for $200, 128GB SSD for $500. Personally, I love my SSD, and it kicks serious ass. People are always blown away by how fast it does everything.
My experience with laptops and IDE's is that the persistent storage is a bottleneck, as is single core for a developer.
An IDE uses heavily I/O to load and save source ode files. An IDE furthermore is constantly compiling code and updates syntax trees. Therefore, a dual core CPU is a must. For persistent storage, you cannot have the best available. If you are on a budget, get those OCZ Core v3's, they do 155MB/sec read and 100MB/sec write, and are ?99. If you want more performance, replace your optical drive with another SSD or get 1-2 Intel X-25M. Once you go SSD, HDD seems like tech we used years ago, such a difference you will notice in usability. Compile&Run never went so fast in your IDE.
When working with VM's a lot, such as Javascript, VMware/Virtual PC, and/or having the habit to keep lotsa tools/programs running, buy the biggest amount of RAM available. Its cheap, and it can only do good. It is not unthinkable that newer IDE's such as the upcoming VS2010 use your graphics card to accelerate graphics and other tasks using the massively parrallel amount of pipelines available in a GPU. It might be quite well that you are using it within a few years as well for development of spcific modules/graphic UI acceleration. So add a decent DX 10 GPU too with about 256MB of ram.
My personal experience: SSD's let VS2008 run like a purling baby. Since I have those SSD's, I wonder how it was years back when we used hard disks ;). Very slow windows updates and F5 times where I could get coffe, flirt with the girl at the counter down the hall, taking a dump to see that its 90% done. HDD-> SSD was the best investment I made since years. The Dual core CPU is a nice second, it really helps with snappyness in multitasking and compiling. Also, when a bug of your coding made the compiled app go 100% CPU use, it won't lock up/freeze your system.
Look for my SOF question to see why I need a GPU for development of software (business software, that is) in VS2008.
One sidenote here: I use exclusively Lenovo laptops, since they are the most robust laptops in terms of physical quality. I dropped it a few times, no scratch and its still working after about 5 years. Other benefit is the businessy-look of it: dull, to the point, and matches with all suits/clothing. You dont want to attend a business meeting with a pink/red/blue laptop.
Solid state not worth it, but 7200 RPM makes a huge difference.
At least 2 gigs of RAM and a decent CPU (preferably dual-core.)
Pick one with a screen resolution/size that suits you.
That's it.
Kind of depends on the OS.
But usually, 7200 rpm drives are more bang for the buck.
The ram should be throttled to the os's level, xp seems to run good at 2 gig, vista seems to run good at 4. Running vs and a few other things, my vista box hums at 1.4 gig constantly.
Also get the biggest battery, even 2 if possible, I have a 9-cell and its decent life, but it would take more than one to fly cross country.
As many cores as they'll cram in. I have a desktop with a core2Quad, its sweet for running vs, compiles in no time flat. And doesn't flinch at running iis7 and sqlserver locally.
Personally I would go for a 64bit OS and as much ram as you can cram into the thing. I recently switched from 32bit to 64bit with 4gb ram on a dell xps and the stability is fantastic particularly when running visual studio, sql server 2005 and virtual machines all at the same time.
SSD is nice, but if you get a 64gb drive then pretty much the only thing you'll want installed on it is Visual Studio
I live in Visual Studio and use virtual machines heavily. I can't recommend fast enough drives and more ram.
I'm currently using a laptop with a 200 gb 7200 rpm drive. It came with 2GB ram and a 32 bit OS. I've upgraded the Ram to 4gb, and I'm waiting for a lull to install a 64 bit OS (to take advantage of the full 4gb ram, of course)
Just be sure to buy the ram after the laptop. Buying a ram upgrade from your local electronics store will be WAY cheaper that paying for it as a factory installed option.
I have always used a Dell Precision Mobile Workstation (my current one is M65). I think above that, its diminishing returns.
UPDATE : I am using Lenovo 17" ThinkPad W701 , it has amazing power and you can work on it as if it is a desktop. 17" really helps me code better. Ofcourse you might need to purchase 2 chargers since it is heavy so that I kept one at office and one at home
I'm using an Eee PC which has two solid state drives (SSD) internally, and I can say that for reading large files, the access speeds are pretty fast. However, the big downside is that when there is heavy disk access, especially writing many small files, the whole system can come to a crawl.
Also, keep in mind that not all SSDs are equal, as their flash memory can utilize different types of cells. Single-level cells (SLC) are faster, however, they are more expensive. Multi-level cells (MLC), where each memory cell can be in multiple states (more states than just "on" or "off") are cheaper, but their access speeds are slower. (Although Intel has introduced their MLC-based SSD, which I hear is fairly fast.)
The Eee PC I use has a 4GB SLC SSD and a 8GB MLC SSD, and the difference in speed between the two are fairly noticeable.
Unless there is a need for the laptop to be more rugged (as SSDs are more shock-resistant than hard drives) and have a long battery life, a hard disk would probably be more preferable than using a SSD. Considering the compiling and building process can involve many small disk writes, I would guess that a hard disk would be faster.
For a combination of price & performance, I bought: Gateway P-7811FX
Pros
Cons
I have a wrapper around a C++ function call which I call from C# code. How do I attach a debugger in Visual Studio to step into the native C++ code?
This is the wrapper that I have which calls GetData() defined in a C++ file:
[DllImport("Unmanaged.dll", CallingConvention=CallingConvention.Cdecl,
EntryPoint = "GetData", BestFitMapping = false)]
public static extern String GetData(String url);
The code is crashing and I want to investigate the root cause.
Thanks, Nikhil
Check the Debug tab on your project's properties page. There should be an "Enable unmanaged code debugging" checkbox. This worked for me when we developed a new .NET UI for our old c++ DLLs.
If your unmanaged DLL is being built from another project (for a while ours were being built using VS6) just make sure you have the DLL's pdb file handy for the debugging.
The other approach is to use the C# exe as the target exe to run from the DLL project, you can then debug your DLL normally.
in addition to Lou's advise for starting the debugger, you can select which debug engines are used when attaching to an existing process by clicking on 'Select...' in the 'attach to process' dialog and choosing both 'managed code' and 'native code'.
Debugging in this way is called mixed mode debugging. See this blog post for some tips.
I believe this isn't supported for 64 bit processes ... though would love to be wrong on that point.
To anyone using WinDbg:
1>Setup symbols
Look at these commands. (Help: in console .hh < command> )
.sympath
.sympath+
.symfix
2>Set up source path
.srcpath
3>Load SOS extention to debug managed / mixed mode programs.
(Make sure you have extention path setup correctly)
Add Microsoft.NET\Framework\v2.0.50727 for x86 using-
.extpath
Set a breakpoint for the clr to load.
sxe ld:mscorwks
(F5 / g) (Wait for ModLoad BP on mscorwks.dll)
Make sure you dont have a duplicate sos extention already loaded. See:
.chain
Now we're ready to load the sos extention. :)
.loadby sos mscorwks
4> Reload all the symbols..
.reload
Now you're all set :)
(YMMV)
Mixed debugging is not supported in 64bit mode (as of Visual Studio 2008).
I feel ridiculous for asking this because it seems like it should be so simple, however I have been unable to discover an answer to this question.
I have a free standing set of files not affiliated with any C# project at all that reside in a complicated nested directory structure. I want to add them in that format to a different directory in an ASP.NET web application I am working on; while retaining the same structure. So, I copied the folder into the target location of my project and I tried to ?add existing item? only to lose the previous folder hierarchy. Usually I have re-created the directories by hand, copied across on a one-to-one basis, and then added existing items. There are simply too many directories/items in this case.
So how do you add existing directories and files in Visual Studio 2008?
Enable "Show All Files" for the specific project (you might need to hit "Refresh" to see them)**. The folders/files that are not part of your project appear slightly "lighter" in the project tree. Right click the folders/files you want to add and click "Include In Project". It will recursively add folders/files to the project.
** - these buttons are located on the mini Solution Explorer toolbar.
drag the files / folder from windows explorer into the solution explorer. it will add them all.
You need to put your directory structure in your project directory. And then click "Show All Files" icon in the top of Solution Explorer toolbox. After that, the added directory will be shown up. You will then need to select this directory, right click, and choose "Include in Project."
We are getting very slow compile times, which can take upwards of 20+ minutes on dual core 2GHz, 2G Ram machines.
A lot of this is due to the size of our solution which has grown to 70+ projects, as well as VSS which is a bottle neck in itself when you have a lot of files. (swapping out VSS is not an option unfortunately, so I don't want this to descend into a VSS bash)
We are looking at merging projects (not nice, as we like the separation of concerns, but is a good opportunity to refactor away some dead wood).
We are also looking at having multiple solutions to achieve greater separation of concerns and quicker compile times for each element of the application. This I can see will become a dll hell as we try to keep things in synch.
I am interested to know how other teams have dealt with this scaling issue, what do you do when your code base reaches a critical mass that you are wasting half the day watching the status bar deliver compile messages
UPDATE Apologies, I neglected to mention this is a C# solution. Thanks for all the cpp suggestions, but it's been a few years since I've had to worry about headers. At a distance I say I miss C++, but I'm not sure I want to go back
EDIT:
Nice suggestions that have helped so far (not saying there aren't other nice suggestions below, just what has helped)
Still not rip-snorting through a compile, but every bit helps.
Orion did mention in a comment that generics may have a play also. From my tests there does appear to be a minimal performance hit, but not high enough to sure - compile times can be inconsistent due to disc activity. Due to time limitations, my tests didn't include as many Generics, or as much code, as would appear in live system, so that may accumulate. I wouldn't avoid using generics where they are supposed to be used, just for compile time performance
WORKAROUND
We are testing the practice of building new areas of the application in new solutions, importing in the latest dlls as required, them integrating them into the larger solution when we are happy with them.
We may also do them same to existing code by creating temporary solutions that just encapsulate the areas we need to work on, and throwing them away after reintegrating the code. We need to weigh up the time it will take to reintegrate this code against the time we gain by not having Rip Van Winkle like experiences with rapid recompiling during development.
The Chromium.org team listed several options for accelerating the build (at this point about half-way down the page):
In decreasing order of speedup:
- Install Microsoft hotfix 935225.
- Install Microsoft hotfix 947315.
- Use a true multicore processor (ie. an Intel Core Duo 2; not a Pentium 4 HT).
- Use 3 parallel builds. In Visual Studio 2005, you will find the option in Tools > Options... > Projects and Solutions > Build and Run > maximum number of parallel project builds.
- Disable your anti-virus software for .ilk, .pdb, .cc, .h files and only check for viruses on modify. Disable scanning the directory where your sources reside. Don't do anything stupid.
- Store and build the Chromium code on a second hard drive. It won't really speed up the build but at least your computer will stay responsive when you do gclient sync or a build.
- Defragment your hard drive regularly.
- Disable virtual memory.
I had a similar issue on a solution with 21 projects and 1/2 million LOC. The biggest difference was getting faster hard drives. From the performance monitor the 'Avg. Disk Queue' would jump up significantly on the laptop indicating the hard drive was the bottle neck.
Here's some data for total rebuild times...
1) Laptop, Core 2 Duo 2GHz, 5400 RPM Drive (not sure of cache. Was standard Dell inspiron).
Rebuild Time = 112 seconds.
2) Desktop (standard issue), Core 2 Duo 2.3Ghz, single 7200RPM Drive 8MB Cache.
Rebuild Time = 72 seconds.
3) Desktop Core 2 Duo 3Ghz, single 10000 RPM WD Raptor
Rebuild Time = 39 seconds.
The 10,000 RPM drive can not be understated. Builds where significantly quicker plus everything else like displaying documentation, using file explorer was noticable quicker. It was a big productivity boost by speeding the code-build-run cycle.
Given what companies spend on developer salaries it is insane how much they can waste buy equiping them with the same PCs as the receptionist uses.
Use distributed compilation. Xoreax IncrediBuild can cut compilation time down to few minutes.
I've used it on a huge C\C++ solution which usually takes 5-6 hours to compile. IncrediBuild helped to reduce this time to 15 minutes.
Turn off your antivirus. It adds ages to the compile time.
If this is C or C++, and you're not using precompiled headers, you should be.
Make sure your references are Project references, and not directly to the DLLs in the library output directories.
Also, have these set to not copy locally except where absolutely necessary (The master EXE project).
I posted this response originally here: http://stackoverflow.com/questions/8440/visual-studio-optimizations#8473 You can find many other helpful hints on that page.
If you are using Visual Studio 2008, you can compile using the /MP flag to build a single project in parallel. I have read that this is also an undocumented feature in Visual Studio 2005, but have never tried myself.
You can build multiple projects in parallel by using the /M flag, but this is usually already set to the number of available cores on the machine, though this only applies to VC++ I believe.
We had a 80+ projects in our main solution which took around 4 to 6 minutes to build depending on what kind of machine a developer was working. We considered that to be way too long: for every single test it really eats away your FTEs.
So how to get faster build times? As you seem to already know it is the number of projects that really hurt the buildtime. Of course we did not want to get rid of all our projects and simply throw all sourcefiles into one. But we had some projects that we could combine nevertheless: As every "Repository project" in the solution had its own unittest project, we simply combined all the unittest projects into one global-unittest project. That cut down the number of projects with about 12 projects and somehow saved 40% of the time to build the entire solution.
We are thinking about another solution though.
Have you also tried to setup a new (second) solution with a new project? This second solution should simply incorporates all files using solution folders. Because you might be surprised to see the build time of that new solution-with-just-one-project.
However, working with two different solutions will take some carefull consideration. Developers might be inclined to actually -work- in the second solution and completely neglect the first. As the first solution with the 70+ projects will be the solution that takes care of your object-hierarchy, this should be the solution where your buildserver should run all your unittests. So the server for Continous Integration must be the first project/solution. You have to maintain your object-hierarchy, right.
The second solution with just one project (which will build mucho faster) will than be the project where testing and debugging will be done by all developers. You have to take care of them looking at the buildserver though! If anything breaks it MUST be fixed.
Instructions for reducing your Visual Studio compile time to a few seconds
Visual Studio is unfortunately not smart enough to distinguish an assembly's interface changes from inconsequential code body changes. This fact, when combined with a large intertwined solutions, can sometimes create a perfect storm of unwanted 'full-builds' nearly every time you change a single line of code.
A strategy to overcome this is to disable the automatic reference-tree builds. To do this, use the 'Configuration Manager' (Build / Configuration Manager...then in the Active solution configuration dropdown, choose 'New') to create a new build configuration called 'ManualCompile' that copies from the Debug configuration, but do not check the 'Create new project configurations' checkbox. In this new build configuration, uncheck every project so that none of them will build automatically. Save this configuration by hitting 'Close'. This new build configuration is added to your solution file.
You can switch from one build configuration to another via the build configuration dropdown at the top of your IDE screen (the one that usually shows either 'Debug' or 'Release'). Effectively this new ManualCompile build configuration will render useless the Build menu options for: 'Build Solution' or 'Rebuild Solution'. Thus, when you are in the ManualCompile mode, you must manually build each project that you are modifying, which can be done by right-clicking on each affected project in the Solution Explorer, and then selecting 'Build' or 'Rebuild'. You should see that your overall compile times will now be mere seconds.
For this strategy to work, it is necessary for the VersionNumber found in the AssemblyInfo and GlobalAssemblyInfo files to remain static on the developer's machine (not during release builds of course), and that you don't sign your DLLs.
A potential risk of using this ManualCompile strategy is that the developer might forget to compile required projects, and when they start the debugger, they get unexpected results (unable to attach debugger, files not found, etc.). To avoid this, it is probably best to use the 'Debug' build configuration to compile a larger coding effort, and only use the ManualCompile build configuration during unit testing or for making quick changes that are of limited scope.
For local development builds we created a Visual Studio Addin that changes Project references to DLL references and unloads the unwanted projects (and an option to switch them back of course).
Our builds now only take seconds when we are working on only a few projects at a time. We can also still debug the additional projects as it links to the debug DLLs. The tool typically takes 10-30 seconds to make a large number of changes, but you don't have to do that often.
I notice this question is ages old, but the topic is still of interest today. The same problem bit me lately, and the two things that improved build performance the most were (1) use a dedicated (and fast) disk for compiling and (2) use the same outputfolder for all projects, and set CopyLocal to False on project references.
Some additional resources:
Some analysis tools:
tools->options->VC++ project settings -> Build Timing = Yes will tell you build time for every vcproj.
Add /Bt switch to compiler command line to see how much every CPP file took
Use /showIncludes to catch nested includes (header files that include other header files), and see what files could save a lot of IO by using forward declarations.
This will help you optimize compiler performance by eliminating dependencies and performance hogs.
Before spending money to invest in faster hard drives, try building your project entirely on a RAM disk (assuming you have the RAM to spare). You can find various free RAM disk drivers on the net. You won't find any physical drive, including SSDs, that are faster than a RAM disk.
In my case, a project that took 5 minutes to build on a 6-core i7 on a 7200 RPM SATA drive with Incredibuild was reduced by only about 15 seconds by using a RAM disk. Considering the need to recopy to permanent storage and the potential for lost work, 15 seconds is not enough incentive to use a RAM disk and probably not much incentive to spend several hundreds of dollars on a high-RPM or SSD drive.
The small gain may indicate that the build was CPU bound or that Windows file caching was rather effective, but since both tests were done from a state where the files weren't cached, I lean heavily towards CPU-bound compiles.
Depending on the actual code you're compiling your mileage may vary -- so don't hesitate to test.
How big is your build directory after doing a complete build? If you stick with the default setup then every assembly that you build will copy all of the DLLs of its dependencies and its dependencies' dependencies etc. to its bin directory. In my previous job when working with a solution of ~40 projects my colleagues discovered that by far the most expensive part of the build process was copying these assemblies over and over, and that one build could generate gigabytes of copies of the same DLLs over and over again.
Here's some useful advice from Patrick Smacchia, author of NDepend, about what he believes should and shouldn't be separate assemblies:
There are basically two ways you can work around this, and both have drawbacks. One is to reduce the number of assemblies, which is obviously a lot of work. Another is to restructure your build directories so that all your bin folders are consolidated and projects do not copy their dependencies' DLLs - they don't need to because they are all in the same directory already. This dramatically reduces the number of files created and copied during a build, but it can be difficult to set up and can leave you with some difficulty pulling out only the DLLs required by a specific executable for packaging.
Perhaps take some common functions and make some libraries, that way the same sources are not being compiled over and over again for multiple projects.
If you are worried about different versions of DLLs getting mixed up, use static libraries.
Turn off VSS integration. You may not have a choice in using it, but DLLs get "accidentally" renamed all the time...
And definitely check your pre-compiled header settings. Bruce Dawson's guide is a bit old, but still very good - check it out: http://www.cygnus-software.com/papers/precompiledheaders.html
I have a project which has 120 or more exes, libs and dlls and takes a considerable time to build. I use a tree of batch files that call make files from one master batch file. I have had problems with odd things from incremental (or was it temperamental) headers in the past so I avoid them now. I do a full build infrequently, and usually leave it to the end of the day while I go for a walk for an hour (so I can only guess it takes about half an hour). So I understand why that is unworkable for working and testing.
For working and testing I have another set of batch files for each app (or module or library) which also have all the debugging settings in place -- but these still call the same make files. I may switch DEBUG on of off from time to time and also decide on builds or makes or if I want to also build libs that the module may depend on, and so on.
The batch file also copies the completed result into the (or several) test folders. Depending of the settings this completes in several seconds to a minute (as opposed to say half an hour).
I used a different IDE (Zeus) as I like to have control over things like .rc files, and actually prefer to compile from the command line, even though I am using MS compliers.
Happy to post an example of this batch file if anyone is interested.
Disable file system indexing on your source directories (specifically the obj directories if you want your source searchable)
If this is a web app, setting batch build to true can help depending on the scenario.
<compilation defaultLanguage="c#" debug="true" batch="true" >
You can find an overview here: http://weblogs.asp.net/bradleyb/archive/2005/12/06/432441.aspx
One cheaper alternative to Xoreax IB is the use of what I call uber-file builds. It's basically a .cpp file that has
#include "file1.cpp"
#include "file2.cpp"
....
#include "fileN.cpp"
Then you compile the uber units instead of the individual modules. We've seen compile times from from 10-15 minutes down to 1-2 minutes. You might have to experiemnt with how many #includes per uber file make sense. Depends on the projects. etc. Maybe you include 10 files, maybe 20.
You pay a cost so beware:
It's kind of a pain, but for a project that is largely static in terms of new modules, the intial pain might be worth it. I've seen this method beat IB in some cases.
You also may want to check for circular project references. It was an issue for me once.
That is:
Project A references Project B
Project B references Project C
Project C references Project A
I am running a solution with over 70 projects (around 900 class) and it compiles under 1 minutes. I have a dual core, 2 gig rams... your solution must be horribly big if it take you 20 minutes... Are you sure it's Visual Studio and not something else that take all the power of your machine?
We have our source code divided into several solutions. This is good for cutting down the compilation time but creates some problems if you happen to break files used in multiple solutions.
The problem I have is that linking is horribly slow in VS2008. Compilation doesn't seem to be a big issue (using IncrediBuild) but oh boy the linking just takes ages. I mean, what on earth is taking so long when all it's supposed to be doing is copying bits from a few files into one dll.
Just now I finished a compilation of 170 files. Compiling the code took 6 mins and linking took another 6 mins.
If anyone knows what could be wrong I would greatly appreciate it?
If it's a C++ project, then you should be using precompiled headers. This makes a massive difference in compile times. Not sure what cl.exe is really doing (with not using precompiled headers), it seems to be looking for lots of STL headers in all of the wrong places before finally going to the correct location. This adds entire seconds to every single .cpp file being compiled. Not sure if this is a cl.exe bug, or some sort of STL problem in VS2008.
Looking at the machine that you're building on, is it optimally configured?
We just got our build time for our largest C++ enterprise-scale product down from 19 hours to 16 minutes by ensuring the right SATA filter driver was installed.
Subtle.
There's undocumented /MP switch in Visual Studio 2005, see http://lahsiv.net/blog/?p=40, which would enable parallel compilation on file basis rather than project basis. This may speed up compiling of the last project, or, if you compile one project.
When choosing a CPU: L1 cache size seems to have a huge impact on compilation time. Also, it is usually better to have 2 fast cores than 4 slow ones. Visual Studio doesn't use the extra cores very effectively. (I base this on my experience with the C++ compiler, but it is probably also true for the C# one.)
I'm also now convinced there is a problem with VS2008. I'm running it on a dual core Intel laptop with 3G Ram, with anti-virus switched off. Compiling the solution is often quite slick, but if I have been debugging a subsequent recompile will often slow down to a crawl. It is clear from the continuous main disk light that there is a disk I/O bottleneck (you can hear it, too). If I cancel the build and shutdown VS the disk activity stops. Restart VS, reload the solution and then rebuild, and it is much faster. Unitl the next time
My thoughts are that this is a memory paging issue - VS just runs out of memory and the O/S starts page swapping to try to make space but VS is demanding more than page swapping can deliver, so it slows down to a crawl. I can't think of any other explanation.
VS definitely is not a RAD tool, is it?
Kristopher Johnson:
If this is C or C++, and you're not using precompiled headers, you should be.
+1.
We did this on a large (50 or so project) codebase a few years ago and it cut down our build times by a huge amount.
I've never heard of a .NET project taking anywhere near that long to build, so I'm going to assume that you are in fact using C++
Nice suggestions that have helped so far (not saying there aren't other nice suggestions below, if you are having issues, I recommend reading then, just what has helped us)
Still not rip-snorting through a compile, but every bit helps.
We are also testing the practice of building new areas of the application in new solutions, importing in the latest dlls as required, them integrating them into the larger solution when we are happy with them.
We may also do them same to existing code by creating temporary solutions that just encapsulate the areas we need to work on, and throwing them away after reintegrating the code. We need to weigh up the time it will take to reintegrate this code against the time we gain by not having Rip Van Winkle like experiences with rapid recompiling during development.
Orion did mention in a comment that generics may have a play also. From my tests there does appear to be a minimal performance hit, but not high enough to sure - compile times can be inconsistent due to disc activity. Due to time limitations, my tests didn't include as many Generics, or as much code, as would appear in live system, so that may accumulate. I wouldn't avoid using generics where they are supposed to be used, just for compile time performance
It's sure there's a problem with VS2008. Because the only thing I've done it's to install VS2008 for upgrading my project which has been created with VS2005. I've only got 2 projects in my solution. It isn't big. Compilation with VS2005 : 30 secondes Compilation with VS2008 : 5 minutes
There are a few things that I have found useful for speading up C# /.NET builds:
Combine small projects into larger projects as there is a large per project overhead on building a solution. (Use nDepend if needed to control calling across layers)
Make all our projects build into the some output directory and then set ?copy local? to false on all the project references ? this can lead to a large speed up due to reduced IO.
Turn of your virus checker to see if it makes much difference; if so find a faster virus checker, or exclude the "hot" folders from the virus checker scanning
Use perforce monitor and the sys internal tool to see way your compiles are taking so long.
Consider a ram disk to put your output directory on.
Consider using a SSD
More memory can have a big effect at times ? (reduce the ram in the machine if you get a big slow down by removing a little ram, you may get a big speed up by adding more) Remove unneeded project references (you may have to remove unneeded ?usings? first)
Consider using a dependency injection framework and interfaces for your lowest domain layer, so a recompile of everything is only needed when the interface changes ? this may not gain much depending on how often the interface is changed.
I have found the following helps the compile speed: After repeated compile (iterative development in memory), I would quite out of VS2008. Then go into the project directories and delete all the "obj" and "bin" folders, start the project back up, and y compile time went way back down. This is similar to the "Clean solution" action within VS2008.
Just want to confirm if this is useful for anyone out there.
I found my fix here: http://blogs.msdn.com/b/vsdteam/archive/2006/09/15/756400.aspx
We are using VS 2008 Team System with the automated test suite, and upon running tests the test host "randomly" locks up. I actually have to kill the VSTestHost process and re-run the tests to get something to happen, otherwise all tests sit in a "pending" state.
Has anyone experience similar behavior and know of a fix? We have 3 developers here experiencing the same behavior.
This may be related to an obscure bug that causes unit tests to hang unless the computer name is UPPERCASE. Crazy, I know - but I had this problem and the fix worked for me.
Bug report on MS Connect
Workaround on MS Connect
TFS Blog Article about this issue
HowTo edit the registry to change your computer name
The easiest approach is to tweak the registry. You need to edit two keys:
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\ComputerName\ActiveComputerName
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\ComputerName\ComputerName
Change value ComputerName to be upper case in both keys, and restart. Tests then magically work.
When you say lock up, do you mean VS is actually hung, or do the tests not run?
The easiest way to track down what is going on would be to look at a dump of the hung process. If you are on Vista, just right-click on the process and choose to create a memory dump. If you are on Windows XP, and don't have the Debugging Tools for Windows installed, you can get a memory dump using ntsd.exe. You'll need the process ID, which you can get from Task Manager by adding the PID column to the Processes tab display.
Once you have that, run the following commands:
ntsd -p <PID>
.dump C:\mydump.dmp
You can then either inspect that dump using WinDBG and SOS or if you can post the dump somewhere I'd be happy to take a look at it.
In any case, you'll want to likely take two dumps about a minute apart. That way if you do things like !runaway you can see which threads are working which will help you track down why it is hanging.
One other question - are you on VS2008 SP1?
I would try running the tests from the command line using MSTest.exe. This might help isolate the problem to Visual Studio, and at least give you some method of running the tests successfully.
What is the shortcut key for Run to cursor in visual studio 2008?
The shortcut key is CTRL+F10.
The default is CTRL+F10 but it can be overridden. The place to find what your current shortcuts are and change them is
*T*ools
*C*ustomize...
*K*eyboard...
Show *c*ommands containing:
Debug.RunToCursor
or
*T*ools
*O*ptions
*E*nvironment
*K*eyboard
Show *c*ommands containing:
Debug.RunToCursor
After answering on this question I thought it would be nice to collect some tips & tricks for working with MSVS solutions and projects.
Here is my list:
How to avoid saving new projects automatically to reduce garbage in file system.
Uncheck Tools->Options->Projects and Solutions->Save new projects when created
How to add common file to multiple projects without copying it to project?s directory.
Right click on a project, select Add->Existing Item->Add as link (press on small arrow on Add button)
How to add project to solution without including it in the build process
Right click on solution, select Add->New solution folder.
Right click on created folder, select Add->Add existing project
How to edit project file from Visual Studio?
Right click on project and select Unload Project, right click on unloaded project and select Edit. Or install Power Commands and select Edit Project File
How to group files in the project tree (like auto-generated files for WinForms controls)
Open project file for editing.
<Compile Include="MainFile.cs" />
<Compile Include="SecondaryFile.cs" />
To
<Compile Include="SecondaryFile.cs ">
<DependentUpon> MainFile.cs </DependentUpon>
</Compile>
Do you have anything else to add?
First rule of working with Visual Studio:
I'm a huge fan of using msbuild to build my solutions with the /m option so that it builds using multiple cores. It can drastically decrease your build time.
Scott Hanselman posted on how to add it to your tools list at http://www.hanselman.com/blog/HackParallelMSBuildsFromWithinTheVisualStudioIDE.aspx.
I usually just run 'msbuild /m' from the command prompt or PowerShell, though.
Another tip that is sometimes useful is taking advantage of the pre- and post-build events to add additional logic before or after a build. To see these, go to the Properties for a Project, click on the Compile tab, and then choose "Build Events..."
I love debugging with the Multiple startup projects option
Using the command window to quickly open files in your solution:
open <filename>I create an alias for open by executing the following at the Command Window: alias o open. Visual Studio will remember the alias from then on, so I only ever need to type o <filename>.
It even searches database projects unlike some third-party plugins!
Unfortunately, there is a bug in the filename completion when searching for nested files. A simple workaround is to type the beginning of the filename, hit the ESC key and then type the rest of the name. To search for login.aspx.cs, type login.aspx, hit ESCP and then type .cs.
I like changing the default location that new projects are saved to.
Tools->Options (Select Projects and Solutions tab)
This "tab" has all sorts of goodness. Not just the ability to change the default locations and avoid saving new projects automatically but other nice things as well. For example:
Track Active Item - Selects the file in the solution explorer when you change windows.
Show Output window when build starts - Toggle to show or not. I like it on, your mileage will vary.
I have a tip regarding the "Track Active Item" option mentioned above, for when working with big projects. It's posted here:
Sometimes when I'm editing page or control the .designer files stop being updated with the new controls I'm putting on the page. I'm not sure what's causing this to happen, but I'm wondering if there's any way of forcing Visual Studio to regenerate the .designer file. I'm using Visual Studio 2008
EDIT: Sorry I should have noted I've already tried:
If you open the .aspx file and switch between design view and html view and back it will prompt VS to check the controls and add any that are missing to the designer file.
Also, you can try to right click on the as(c/p)x and select "Convert to Web Application". When this is done you should see that you now have a *.Designer.cs file available and your controls within the Design HTML will be available for your control.
PS: This should not be done in debug mode, as not everything is "recompiled" when debugging.
Some people have also reported success by deleting the .designer.cs file and then recreate an empty file with the same name.
Well I found a solution that works, though I don't really like it. I had to delete the .designer.cs file then recreate an empty file with the same name. When I went back in and saved the aspx file again, the designer file was re-generated.
Dodgy!
There is another possibility: You may have an error in your .aspx file that does not allow Visual Studio to regenerate the designer.
If you switch to Design View, it will show the control as unable to be rendered. Fixing the control (in my case it was an extra quote in the properties) and recompiling should regenerate the designer.
I use the following method which works everytime:
Recompile.
the only way I know is to delete the designer file, and do a convert to web app. However when you do this, it usually pops up with the error, as to why it didn't auto-regen in the first place, its usually a control ref that isn't declared in the head of the page.
My experience is that if you want to do like in this article, like stated above.
Your markup file (aspx/ascx) has to include the CodeBehind="MyPage.aspx.cs" attribute or else it won´t work. I blogged about it here.
I recently saw that I was having the same problem. Visual Studio 2010 was refusing to update the designer file.
As it turns out, VS doesn't modify the designer file for a page that uses CodeFile (run off of pages) instead of CodeBehind (DLL). This is true no matter how many times you close VS, reload the project, re-create the control(s), or modify a file. Nothing would prompt VS to regenerate the designer. It's as if it doesn't create the designer file for CodeFile pages but does require it to be there.
I changed it to CodeBehind and saved the page. The designer file updated immediately. Then I just changed it back and everything was still golden. This behavior seems to be new with VS 2010 / .NET 4.0 as VS 2008 by default didn't suffer from this.
It's this part:
<%@ Page Language="vb" AutoEventWireup="false" CodeFile="YourPage.aspx.vb" Inherits="YourPageClass" %>
Change CodeFile to CodeBehind, save, and then revert.
(The following comes from experience with VS2005.)
If you edit an ASPX page while debugging, then the codebehind doesn't get updated with the new classes. So, you have to stop debugging, trivially edit the ASPX page (like add a button or something), then click Design View, then delete the button. Then, your designer files should be updated.
If you are having a different issue with VS2008, then I can't help.
Here is wat i experienced , Select the website folder right click in the Solution Explorer, select Convert to Web application for all the aspx file a designer file will get generated.
Sameer
Delete the designer.cs file and then right click on the .aspx file and choose "Convert To Web Application". If there is a problem with your control declarations, such as a tag not being well-formed, you will get an error message and you will need to correct the malformed tag before visual studio can successfully re-generate your designer file.
In my case, at this point, I discovered that the problem was that I had declared a button control that that was not inside of a form tag with a runat="server" attribute.
I often found that copy/pasting caused this behaviour for me. Most cases can be solved by editing the ID of a server control (just add a character, then delete it).
Also remember that control inside things like Repeaters aren't visible in the designer file.
And yes, there are cases where you need to do the delete-the-file magic listed above - but the name-change solution will work most of the time.
I had this problem and for me, I had a space in one of my ID values for one of my controls. I took the space out and the designer file regenerated itself.
This is a bug in the IDE; I've seen it since VS 2003. THe solution is simple though.
Save your files. Completely exit the IDE (make sure the process stops, task mgr.)
Reopen the solution, dirty the markup, save. Fixed.
In my case I was just missing a register TagPrefix at the top. Somehow the previous dev worked without having this in there?
I have had this issue before. I usually just hit enter to add a line and then wait for the plus/minus to show on the html page and the designer should add what you need. I have also had to close the project and reopen it to get it to work.
I had two problems... outdated AJAXControlkit - deleted the old dll, removed old controls from toolbox, downloaded new version, loaded toolbox, and dragged and dropped new controls on the page (see http://www.experts-exchange.com/Programming/Languages/.NET/Visual_Studio_.NET_2005/Q_24591597.html)
Also had misspelling in my label control (had used 'class' instead of 'cssclass').
Ta
I had a similar problem with a user control which contained other user controls. Dirtying the markup didn't help. Deleting the ascx.designer.cs, then creating a new empty one worked a treat. Thanks.
I've had this problem a lot, and just did again. I tried fixing it using these suggestions, and nothing worked. I finally found that I had the 'Title' attribute in the page header twice(I added to the end, not realizing that VS added a blank Title="" to the beginning)-- removing the extra attribute caused VS2008 to re-generate the designer file... I hope VS2010 fixes this problem, letting us know why the designer file generation isn't happening...
-- Derek
When you are in design view, right click on the screen and hit refresh.
Apart from all the good answers already given, I'd like to add to @johan-leino's great answer. In my case, for some arbitrary reason, the CodeBehind attribute was omitted from the @Page directive/.aspx file. Likewise, it might be worthwhile to check the CodeFile attribute for @Control directives/.ascx files (obviously in conjunction with an Inherits attribute in both cases).
Depending on the exact scenario and reason required to 'force' a regenerate of .designer.cs, one could also try to format the document (potentially indicating a parsing error) before (quick) saving (regardless whether there were any changes or not) and check the Error List for warnings.
In my case, it was fixed when I added a CodeBehind to the @Page section.
I know I'm late to the party, but I thought if after trying the accepted answer by @Glenn Slaven and the current highest rated answer by @Espo you are still out of luck, the following might save some people out there some trouble.
User Controls (.ascx) are what constantly stop auto-generating for me. I've found that in the instances where I use other User Control(s) in my User Control, it breaks the auto-generation.
The solution I came up with was to use the trick we all know of for getting IntelliSense to work in User Controls or Skin files when using CSS classes from external sources. Instead of just referencing the CSS file, now I Register the other User Control(s) that I need. It looks something like this:
<% If False Then %>
<%@ Register TagPrefix="uc" TagName="Title" Src="~/controls/title.ascx" %>
<link rel="stylesheet" type="text/css" href="../css/common.css" />
<% End If %>
After that, I Save the file, which prompts the auto-generation to regenerate, and I'm back up and running.
If you are like me and you add old .ASPX files to a more recent project. You are probably going to forget some of the controls used on the page...
If so, first thing, if there are multiple files you are installing; Fix one at a time first.
When you compile, fix errors generated. They will probably be the same errors in all the files.
Next, if you have Designer files, delete all of the inserted - designer files. Next, make sure there are not any other errors when you compile, other than the designer files....
Finally right click your web project and click on Convert to Web Application. This will insert the designer files you need.
Anyway this is the absolute Best steps to fix these issues.
-Carlos
I had the problem that my new controls would not generate in the designer file when declared in the .ascx file. The problem was that i declared them in the code behind also. So deleting the declaration in the code behind solved my problem.
Is there a way to always have LF line endings in Visual Studio? I can never seem to find it!
There'a an add-in for Visual Studio 2008 that converts the end of line format when a file is saved. You can download it here: http://grebulon.com/software/stripem.php
Hope this article will help you:
How To Save a File from Visual C++ in UNIX Format
Unfortunately it seems to be the only way to save files in Unix format by default.
Personally I use Advance Save option in Save File dialog. But to be hones I never have a need to work with large number of files in Unix format from MSVS.
Visual Studio 2008 doesn't retain the advanced save options after the solution is closed. I would be willing to hand edit a lot of files if that would make it work consistently, but I am not willing to change all of the settings every time I open VS.
This is too bad. Since VS does support forcing the line-endings to whatever is desired in the backend, its just not hooked up properly in the UI. Maybe Microsoft will fix this isn a service pack.
Every time I publish the Application in Click Once I get get it to update the revision number by one. Is there any way to get this change automatically to change the version number in AssemblyInfo.cs file (all our error reporting looks at the Assembly Version).
We use Team Foundation Server Team Build and have added a block to the TFSBuild.proj's AfterCompile target to trigger the ClickOnce publish with our preferred version number:
<MSBuild
Projects="$(SolutionRoot)\MyProject\Myproject.csproj"
Properties="PublishDir=$(OutDir)\myProjectPublish\;ApplicationVersion=$(PublishApplicationVersion);Configuration=$(Configuration);Platform=$(Platform)"
Targets="Publish" />
The PublishApplicationVersion variable is generated by a custom MSBuild task to use the TFS Changeset number but you could use your own custom task or an existing solution to get the version number from the AssemblyInfo file.
This could theoretically be done in your project file (which is just an MSBuild script anyway) but I'd recommend against deploying from a developer machine.
I'm sure other CI solutions can handle this similarly.
Edit: Sorry, got your question backwards. Going from the ClickOnce version number to the AssemblyInfo file should be doable. I'm sure the MSBuild Community Tasks (link above) have a task for updating the AssemblyInfo file so you'd just need a custom task to pull the version number from the ClickOnce configuration xml.
However, you may also consider changing your error reporting to include the ClickOnce publish version too:
if (System.Deployment.Application.ApplicationDeployment.IsNetworkDeployed)
{
Debug.WriteLine(System.Deployment.Application.ApplicationDeployment.CurrentDeployment.CurrentVersion);
}
I implemented this recently using some custom tasks. An issue I found with implementing this with ClickOnce is that all your dll's are updated. This causes the ClickOnce update to download all the application files every update. This bypasses on of the nice features of the ClickOnce deployment where only the modified files are re-downloaded in an update.
Just something to think about when implementing something like this with ClickOnce.
Steps:
BTW, nice bonus is that, whenever you automatically publish newer ClickOnce deployment version via the integration script, if you also specify the minimal version to mage.exe (same as version), then every user will be updated automatically on the next application launch.
You'll probably need to create a piece of code that updates AssemblyInfo.cs according to the version number stored in the .csproj file. (The ClickOnce deploy version is stored inside an XML tag.)
You'd then change your .csproj file to run this bit of code when Publish|Release build is performed. The MSBuild folks have blogged about how to perform custom actions during certain build types; check the MSBuild team blog.
We are working on a winforms app in Visual Studio 2005 and the setup project we created output both an MSI and an EXE. We aren't sure what the EXE file is used for because we are able to install without the EXE.
It's a bootstrapper that checks to make sure that the .NET Framework is installed, before launching the MSI. It's pretty handy.
I suggest using something like SFX Compiler to package the two together into one self-extracting .exe and then launch the extracted setup.exe. This way you retain the benefits of the bootstrapper, but your users only download a single thing.
Edit: also see
The EXE checks if Windows Installer 3.0 is present and downloads and installs it if it's not. It's needed only for Windows 2000 or older. Windows XP and newer all have Windows Installer 3.0 out of the box.
Other prerequisites, like .NET, are checked for by the MSI itself.
I think the EXE is just a wrapper/bootstrapper for the MSI in case you don't have Window Installer. If you have the requisite Windows Installer version installed then the MSI should work fine on its own.
I have been working with Visual Studio (WinForm and ASP.NET applications using mostly C#) for several months now. For the most part my IDE is set up fairly standard but I have been wondering what are some suggestions in terms of plugins/settings that you find to be the most useful?
Update: Thanks for all the great suggestions. It looks like a general consensus that I should look into 'Resharper' along with some eye-candy with themes and custom fonts.
Themes
Free Tools
Paid Tools
Resharper is definitely a great tool. It has a moderate learning curve but is easy to pick up for some simple things and add mastery later. It is a good price for students and kinda expensive for the rest of us. Resharper is similar to CodeRush, but seems to have a larger following.
PowerCommands is a great set of add-ons that comes free from Microsoft. Things like "Open in Windows Explorer", "Command Prompt Here", and Copy/Paste references.
A discussion regarding add-ins is floating around here somewhere.
For straight-up customization, changing colors is fun, easy, and gives you a big bang for your buck. I prefer a slightly personalized version of Rob Conery's TextMate theme for Visual Studio. Once you get colors you like, you can just export the settings and carry them with you wherever you go.
Related to colors and themes, the Consolas font pack is pretty nifty and easy on the eye.
And like John recommends, a mastery of keyboard shortcuts will pay big dividends.
Make sure you install a custom color theme. These URLs are a good place to start looking for one:
http://www.codinghorror.com/blog/archives/000682.html http://www.hanselman.com/blog/VisualStudioProgrammerThemesGallery.aspx
I myself love Oren Ellenbogen's Dark Scheme. Really pleasant to the eyes. Also, make sure to replace the default font with Consolas or Inconsolata (one is Microsoft's, the other is free). They are both awesome.
Master the built-in keyboard shortcuts (links to C# and VB keybinding cheatsheets can be found here)
I agree with the customizing of the theme - it makes the environment a whole lot easier to deal with.
You can choose some of the ones from the gallery at Hanselman's site, or create one with this online generator.
I have Resharper and SQL Prompt, both are excellent.
You could try Resharper from JetBraing (http://www.jetbrains.com/resharper/), the ultimate when it comes to code refactoring. I also use GhostDoc (http://www.roland-weigelt.de/ghostdoc/) for helping me with documentation.
I second the vote for Resharper. It really substantially improves the quality of your code. CodeRush is also good, and more visual, either one of them is worth the money (if you can convince your employer to buy them for you :)). You would probably not want to use both at the same time, though, since there is a lot of functional overlap.
There's a cool free add-in that Scott Hanselman links to called "rockscroll", that replaces the scroll bar with a visual view of your code, I find it really helpful.
I have tried CodeRush as my employer provides it however I find it too intrusive when coding. Does Resharper behave similar to CodeRush?
Personally I like having the ide pleasing to the eye. I think I found a link on Hanselman's blog but I switched to Consolas font slightly bigger than normal with a darker theme. Makes all the difference.
I have tried CodeRush as my employer provides it however I find it too intrusive when coding. Does Resharper behave similar to CodeRush?
Yes, they are similar. I added this to my first response.
I personally customize the context menu's to remove the ones I don't want and minimize my scroll time. It can also speed up the time taken for the menu's to appear.
To do this go to Tools/Customize and Check the "Context Menus" item. The menu's appear on the top of the main design area. To modify them select the context menu you want and drag and drop items around.
I usually remove items like "Get Version" in Team Foundation Server as I rarely if ever use it and I can use it from Team Explorer if I need to.
I can't coding without Resharper and GhostDoc, both are very good, i love that.
Does anyone know a good way to debug errors in the Visual Studio Designer?
In our project we have tons of UserControls and many complex forms. For the complex ones, the Designer often throws various exceptions which doesn't help much and was wondering if there's some nice way to figure out what has gone wrong.
The language is C# and we're using Visual Studio 2005.
Thanks, Daisuke
I've been able to debug some control designer issues by running a second instance of VS, then from your first VS instance do a "Debug -> Attach to Process" and pick "devenv".
The first VS instance is where you'll set your breakpoints. Use the second instance to load up the designer to cause the "designer" code to run.
I have had this happen many times and it is a real pain.
Firstly I'd suggest attempting to follow the stack trace provided by the designer, though I found that often simply lists a bunch of internals stuff that isn't much use.
If that doesn't work then try compiling and determining the exception from there. You really are flying blind which is the problem. You could then try simply running the code and seeing what exception is raised when you run it, that should give you some more information.
A last-gasp approach could be to remove all the non-generated code from the form and gradually re-introduce it to determine the error.
If you're using custom controls you could manually remove the generated code related to the custom controls as well if the previous method still results in an error. You could then re-introduce this step-by-step in the same way to determine which custom control is causing the problem, then go and debug that separately.
Basically as far as I can tell there's no real way around the problem other than to slog it out a bit!
Each one is different and they can sometimes be obscure. As a first step, I would do the following:
You can run a second instance of VS and attach it to the first instance of VS (Ctrl+Alt+P). In the first instance set the breakpoints, in the second instance run the designer, and the breakpoint will fire. You can step through the code, but Edit-and-Continue will not work.
For Edit-and-Continue to work, set you control library's debug options to run a VS with the command line argument being the solution filename. Then you can simply set the breakpoints and hit F5. It will debug just like user code! As a side note, you can do this will VS and Office add-ins also.
I have a winforms application where users will be creating stock items, and a time of creation there are a number of different things that need to happen.
I think the UI for this should probably be a wizard of some kind, but I'm unsure as to the best way to achieve this. I have seen a couple of 3rd party Wizard controls, and I have also seen manual implementations of making panel visible/invisible.
What are the best ways that people have used in the past, that are easy to implement, and also make it easy to add "pages" to the wizard later on if needed?
Here are a few more resources you should check out:
This DevExpress WinForms control: http://www.devexpress.com/Products/NET/Controls/WinForms/Wizard/
A home-grown wizards framework: http://weblogs.asp.net/justin_rogers/articles/60155.aspx
A wizard framework by Shawn Wildermut part of the Chris Sells's Genghis framework: http://www.sellsbrothers.com/tools/genghis/
I know this answer has already been accepted, but I just found a better Wizard control that's free, and of course, sonce it's on CodeProject, includes the source, so you can modify it if it's not exactly what you want. I'm adding this as an answer for the next person to stumble across this question looking for a good Wizard control.
http://www.codeproject.com/KB/miscctrl/DesignTimeWizard.aspx
Take a look at this article on MSDN about "inductive user interfaces". It describes a framework (and provides the code to download) based on UserControls that give you "navigation" within a form. Perfect for designing wizards.
The easiest way to create a wizard dialog is to use one of the third-party versions available that handle all of the "hard stuff" (the page navigation, UI framework, etc.) for you. The one I like the most is from Divelements; they have both a WinForms and a WPF version.
Use a tab-control inside a form.
Change back color to "Control" in all tab-pages.
Set "appearance" to flat buttons to get rid of the white border-stuff.
Hide the tabs by sizing the entire control so that the tabs gets pushed up "under" the title bar of the form. If you need other controls (or banner maybe) above the tab-control, then instead hide the tabs with a panel-control or similar.
Childplay to code logic for back/next buttons and very easy to extend with new pages.
I have a few Visual Studio Solutions/Projects that are being worked on in my company, which now require a scheme for automatic nightly builds. Such a scheme needs to be able to check the latest versions from SVN, build the solutions, create the appropriate downloadable files (including installers, documentation, etc.), send e-mails to the developers upon errors and all sorts of other nifty things. What tool, or tool-set, should I use for this?
I used to use FinalBuilder a few years ago and I liked that a lot but I'm not sure if they support such features as nightly-builds and email messages.
At my work we use CCNET, but with builds on check-in more than nightly - although it's easily configured for either or both.
You can very easily set up unit testing to run on every checkin as well, FXCop testing, and a slew of other products.
I would also advise checking out Team City as an option, because it has a free version, and the reporting and setup is reportedly much simpler (it does look nice to me). It does have a limit of somewhere around 20 team members/projects, before it hits a pay-for window.
That said, we started with CCNET, and have grown several products too large to look at Team City on the free version and are very happy with what we have.
Features that help with CCNET include:
But I'd definitely go with running a CI build on every check-in - for the most part will run the unit tests before checking in, but let the CCNET server handle run any applications/assemblies that would have dependencies on the assembly we're checking in, and they get re-built, and re-tested on every checkin.
Given that CCNET is free free and takes very little time to set up - I'd highly recommend just going for it and seeing if it suits you, then expanding from there.
(There's another thread here where I posted pretty much the same/with a few alterations - but some of the other comments may help too! Automated Builds)
Edit to add: You can easily set up your own deployment scheme for CCNET, and there are a tonne of blog posts out there to assist, and email notifications can really be set up fairly granularly, either on all successes, all failures, when it changes from success to fail, etc. There's also built in RSS, and you could even set up your own notifiers for other systems.
FinalBuilder does support emailing and just executing FinalBuilder each night will give you nightly builds. You don't really need other software for that if you don't want to.
You could also use CCNet to trigger a build when needed and have it execute FinalBuilder for the build. You can then decide if FinalBuilder or CCNet should email.
Finally FinalBuilder has a Server version which is sorta like CCNet in that it is a continues integration tool using FinalBuilder. See http://www.finalbuilder.com/finalbuilder-server.aspx
Of course the biggest advantage of CCNet is that it is free and open source.
Although it costs, I highly recommend Visual Build. It works with MSBuild, and old tools like Visual Basic. It is scriptable, and can do everything from making installers to simple Continuous Integration.
We just started using Hudson here at the office.
Its free and open-source, it has a very user friendly UI. Plus there are tons of options and plugins available.
I was up and running in a matter of minutes after installing it. All the other devs here are loving it.
All in all, its a very elegant solution for Continuous Integration or Nightly Builds.
I've recently started using CruiseControl.NET (http://confluence.public.thoughtworks.org/display/CCNET/Welcome+to+CruiseControl.NET). It works reasonably well, although configuration could be easier. CruiseControl.NET is free and open source, and seems to integrate with most standard tools, although I've personally only used it with CVS, SVN, NUnit and MSBuild.
Supports a wide variety of source control and build systems. Very customizable. Open Source. Setup takes some time, but it's not too horrible.
Buildbot is open source and very powerful too. You should take a look at it.
Cascade supports doing a build on every single change committed to the repository.
I would not recommend doing only nightly builds -- that's a pretty long window where a build break can slip in before it's reported.
My current preferred C++ environment is the free and largely excellent Microsoft Visual Studio 2005 Express edition. From time to time I have sent release .exe files to other people with pleasing results. However recently I made the disturbing discovery that the pleasing results were based on more luck that I would like. Attempting to run one of these programs on an old (2001 vintage, not scrupulously updated) XP box gave me nothing but a nasty "System cannot run x.exe" (or similar) message.
Some googling revealed that with this toolset, even specifying static linking results in a simple hello-world.exe actually relying on extra .dll files (msvcm80.dll etc.). An incredibly elaborate version scheming system (manifest files anyone?) then will not let the .exe run without exactly the right .dll versions. I don't want or need this stuff, I just want an old fashioned self contained .exe that does nothing but lowest common denominator Win32 operations and runs on any old win32 OS.
Does anyone know if its possible to do what I want to do with my existing toolset ?
Thank you.
For the C-runtime go to the project settings, choose C/C++ then 'Code Generation'. Change the 'runtime library' setting to 'multithreaded' instead of 'multithreaded dll'.
If you are using any other libraries you may need to tell the linker to ignore the dynamically linked CRT explicitly.
I've had this same dependency problem and I also know that you can include the VS 8.0 DLLs (release only! not debug!---and your program has to be release, too) in a folder of the appropriate name, in the parent folder with your .exe:
How to: Deploy using XCopy (MSDN)
Also note that things are guaranteed to go awry if you need to have C++ and C code in the same statically linked .exe because you will get linker conflicts that can only be resolved by ignoring the correct libXXX.lib and then linking dynamically (DLLs).
Lastly, with a different toolset (VC++ 6.0) things "just work", since Windows 2000 and above have the correct DLLs installed.
In regards Jared's response, having Windows 2000 or better will not necessarily fix the issue at hand. Rob's response does work, however it is possible that this fix introduces security issues, as Windows updates will not be able to patch applications built as such.
In another post, Nick Guerrera suggests packaging the Visual C++ Runtime Redistributable with your applications, which installs quickly, and is independent of Visual Studio.
Are there any VC++ settings I should know about to generate better PDB files that contain more information?
I have a crash dump analysis system in place based on the project crashrpt.
Also, my production build server has the source code installed on the D:\, but my development machine has the source code on the C:\. I entered the source path in the VC++ settings, but when looking through the call stack of a crash, it doesn't automatically jump to my source code. I believe if I had my dev machine's source code on the D:\ it would work.
"Are there any VC++ settings I should know about"
Make sure you turn off Frame pointer ommision. Larry osterman's blog has the historical details about fpo and the issues it causes with debugging.
Symbols are loaded successfully. It shows the callstack, but double clicking on an entry doesn't bring me to the source code.
What version of VS are you using? (Or are you using Windbg?) ... in VS it should defintely prompt for source the first time if it doesn't find the location. However it also keeps a list of source that was 'not found' so it doesn't ask you for it every time. Sometimes the don't look list is a pain ... to get the prompt back up you need to go to solution explorer/solution node/properties/debug properties and edit the file list in the lower pane.
Finally you might be using 'stripped symbols'. These are pdb files generated to provide debug info for walking the callstack past FPO, but with source locations stripped out (along with other data). The public symbols for windows OS components are stripped pdbs. For your own code these simply cause pain and are not worth it unless you are providing your pdbs to externals. How would you have one of these horrible stripped pdbs? You might have them if you use "binplace" with the -a command.
Good luck! A proper mini dump story is a godsend for production debugging.
If your build directly from your sourcecode management system, you should annotate your pdb files with the file origins. This allows you to automatically fetch the exact source files while debugging. (This is the same proces as used for retrieving the .Net framework sourcecode).
See http://msdn.microsoft.com/en-us/magazine/cc163563.aspx for more information. If you use subversion as your SCM you can check out the SourceServerSharp project.
You could trying using the MS-DOS subst command to assign your source code directory to the D: drive.
This is the procedure I used after some trouble similar to yours:
a) Copied to the production server all the EXE & DLL files that were built, each with its corresponding PDB to the same directory, started the system, and waited for the crash to happen.
b) Copied back all the EXE, DLL & PDB files to the development machine (to a temporary folder) along with the minidump (in the same folder). Used Visual Studio to load the minidump from that folder.
Since VS found the source files where they were originally compiled, it was always able to identify them and load them correctly. As with you, in the production machine the drive used was not C:, but in the development machine it was.
Two more tips:
One thing I did often was to copy an EXE/DLL rebuilt and forget to copy the new PDB. This ruined the debug cycle, VS would not be able to show me the call stack.
Sometimes, I got a call stack that didn't make sense in VS. After some headache, I discovered that windbg would always show me the correct stack, but VS often wouldn't. Don't know why.
In case anyone is interested, a co-worker replied to this question to me via email:
Artem wrote:
There is a flag to MiniDumpWriteDump() that can do better crash dumps that will allow seeing full program state, with all global variables, etc. As for call stacks, I doubt they can be better because of optimizations... unless you turn (maybe some) optimizations off.
Also, I think disabling inline functions and whole program optimization will help quite a lot.
In fact, there are many dump types, maybe you could choose one small enough but still having more info http://msdn.microsoft.com/en-us/library/ms680519(VS.85).aspx
Those types won't help with call stack though, they only affect the amount of variables you'll be able to see.
I noticed some of those dump types aren't supported in dbghelp.dll version 5.1 that we use. We could update it to the newest, 6.9 version though, I've just checked the EULA for MS Debugging Tools -- the newest dbghelp.dll is still ok to redistribute.
Is Visual Studio prompting you for the path to the source file? If it isn't then it doesn't think it has symbols for the callstack. Setting the source path should work without having to map the exact original location.
You can tell if symbols are loaded by looking at the 'modules' window in Visual Studio.
Assuming you are building a PDB then I don't think there are any options that control the amount of information in the PDB directly. You can change the type of optimizations performed by the compiler to improve debuggabilty, but this will cost performance -- as your co-worker points out, disabling inline will help make things more obvious in the crash file, but will cost at runtime.
Depending on the nature of your application I would recommend working with full dump files if you can, they are bigger, but give you all the information about the process ... and how often does it crash anyway :)
Is Visual Studio prompting you for the path to the source file?
No.
If it isn't then it doesn't think it has symbols for the callstack. Setting the source path should work without having to map the exact original location.
Symbols are loaded successfully. It shows the callstack, but double clicking on an entry doesn't bring me to the source code. I can of course search in files for the line in question, but this is hard work :)
When building projects in C++, I've found debugging linking errors to be tricky, especially when picking up other people's code. What strategies do people use for debugging and fixing linking errors?
Not sure what your level of expertise is, but here are the basics.
Below is a linker error from VS 2005 - yes, it's a giant mess if you're not familiar with it.
ByteComparator.obj : error LNK2019: unresolved external symbol "int __cdecl does_not_exist(void)" (?does_not_exist@@YAHXZ) referenced in function "void __cdecl TextScan(struct FileTextStats &,char const *,char const *,bool,bool,__int64)" (?TextScan@@YAXAAUFileTextStats@@PBD1_N2_J@Z)
There are a couple of points to focus on:
At this point, in many cases the fastest way to resolution is to search the code base for this function and find where the implementation is. Once you know where the function is implemented you just have to make sure the two places get linked together.
If you're using VS2005, you would use the "Project Dependencies..." right-click menu. If you're using gcc, you would look in your makefiles for the executable generation step (gcc called with a bunch of .o files) and add the missing .o file.
In a second scenario, you may be missing an "external" dependency, which you don't have code for. The Win32 libraries are often times implemented in static libraries that you have to link to. In this case, go to MSDN or "Microsoft Google" and search for the API. At the bottom of the API description the library name is given. Add this to your project properties "Configuration Properties->Linker->Input->Additional Dependencies" list. For example, the function timeGetTime()'s page on MSDN tells you to use Winmm.lib at the bottom of the page.
One of the common linking errors I've run into is when a function is used differently from how it's defined. If you see such an error you should make sure that every function you use is properly declared in some .h file.
You should also make sure that all the relevant source files are compiled into the same lib file. An error I've run into is when I have two sets of files compiled into two separate libraries, and I cross-call between libraries.
Is there failure you have in mind?
The C-runtime libraries are often the biggest culprit. Making sure all your projects have the same settings wrt single vs multi-threading and static vs dll.
The MSDN documentation is good for pointing out which lib a particular Win32 API call requires if it comes up as missing.
Other than that it usually comes down to turning on the verbose flag and wading through the output looking for clues.
I'm working on a visual studio 2005 vb.net windows forms project that's been around for several years. It's full of default textboxes, labels, dropdowns, datagrids, datetime pickers -- all the standard stuff. The end result is a very gray, old-looking project.
What would be the best approach to making this project look fresh and snazzy? I'd rather not rewrite the entire solution with all brand new forms objects, but would that be avoidable?
I was actually just sprucing up a dialog today. A lot of it depends on what kind of application you have, and what OS they are running on. A couple of these tips will certainly go a long way to jazzing things up.
Ensure adequate spacing between controls - don't cram them all together. Space is appealing. You might also trying flowing the controls a little differently when you have more space.
Put in some new 3D and glossing images. You can put a big yellow exclamation mark on a custom warning dialog. Replace old toolbar buttons with new ones. Two libraries I have used and like are GlyFX and IconExperience. You can find free ones too. Ideally get a graphic artist to make some custom ones for the specific actions your application does to fill in between the common ones you use (make sure they all go together). That will go a long way to making it look fancy.
Try a different font. Tahoma is a good one. Often times the default font is MS Sans Seirf. You can do better. Avoid Times Roman and Comic Sanserif though. Also avoid large blocks of bold - use it sparingly. Generally you want all your fonts the same, and only use different fonts sparingly to set certain bits of text apart.
Add subdued colors to certain controls. This is a tricky one. You always want to use subdued colors, nothing bright or stark usually, but the colors should indicate something, or if you have a grid you can use it to show logical grouping. This is a slippery slop. Be aware that users might change their system colors, which will change how your colors look. Ideally give them a few color themes, or the ability to change colors.
Instead of thinking eye-candy, think usability. Make the most common course of action obvious. Mark Miller of DevExpress has a great talk on the Science of User Interface. I actually have a video of it and might be able to post it online with a little clean-up.
Invest in a few good quality 3rd party controls. Replacing all your controls could be a pain, but if you are using the default grids for example, you would really jazz it up with a good grid from DevExpress or some other component vendor. Be aware that different vendors have different philosophies for how their components are used, so swapping them out can be a bit of a pain. Start small to test the waters, and then try something really complicated before you commit to replacing all of them. The only thing worse then ugly grids is ugly grids mixed with pretty grids. Consistency is golden!
You also might look at replacing your old tool bars and menus with a Ribbon Control like Microsoft did in Office 2007. Then everyone will think you are really uptown! Again only replacing key components and UI elements without thinking you need to revamp the whole UI.
Of course pay attention to the basics like tab order, etc. Consistency, consistency, consistency.
Some apps lend themselves to full blown skinning, while others don't. Generally you don't want anything flashy that gets used a lot.
One other thing to also check is that your controls have the FlatStyle property set to System instead of Standard.
What this will do is make sure that the app uses the system defaults for radio buttons, standard buttons and the like. This takes all your apps from the flat Win 2000 look and gives them the XP or Vista bling depending on the OS they are running.
What would be the best approach to making this project look fresh and snazzy?
IMHO the best thing you can do is make sure the controls are logically ordered, and have ample spacing between them, and add groupboxes / labels / etc where appropriate.
If you try and change the 'sea of gray' that is the default color scheme, your app will just end up looking crap.
I recommend purchasing a good 3rd-party control library - Infragistics and DevExpress, are just a couple. Most of these libraries give you the ability to drop in new compatible controls on top of your existing ones - for example, you can replace the default EditBox with an enhanced version. They also give you access to some of the snazzy new UIs such as Ribbon, or the Outlook-style navigator people are always wanting.
The reason I specifically recommend using one of these libraries is that they were designed to be relatively easy to use in existing applications, you get support, a community, and all sorts of upgrade paths/options.
The downside: money.
This depends on how the existing "gray old looking" project is structured in terms of code. For example, is data access code separated from the UI in a Data Access Layer, is the business logic in a Business Logic Layer? If yes, then cleaning the UI for a snazzy look should be relatively simple.
If everything is all there in the "Button Click" event, then a rewrite is the only way in my humble opinion as otherwise it will just be too time consuming trying to work with the existing code base.
Cheers
This isn't so much an "answer" as an opinion.
I tried to jazz up a WinForms project I created back a few years ago by giving the forms a fancy blue gradient background etc, and it looked pretty good on XP. But then on Vista it looked out of place. Taking away any custom painting and reverting the form to "battleship gray" made it look much better IMHO.
I'm seeing a lot of applications (particularly from MS) coming out with custom window chrome etc, and all it does is detract from the nice sense of consistency that Windows gives.
I guess what I'm saying is that you don't need to worry too much about making your application look fashionable. If you keep your colours based on the SystemColors enumeration then Windows can do that for you.
You can subclass all the default controls and override their appearance. Admittedly, you will have to go thru the entire project and change all references of TextBox to MyTextBox, but all of the default properties and methods will still work. The same cannot be guaranteed if you go with a 3rd party vendor. The other advantage of this approach is you can pick one control at a time and perform an incremental upgrade of the application.
I coded a Mancala game in Java for a college class this past spring, and I used the Eclipse IDE to write it. One of the great (and fairly simple) visual aids in Eclipse is if you select a particular token, say a declared variable, then the IDE will automatically highlight all other references to that token on your screen. Notepad++, my preferred Notepad replacement, also does this.
Another neat and similar feature in Eclipse was the vertical "error bar" to the right of your code (not sure what to call it). It display little red boxes for all of the syntax errors in your document, yellow boxes for warnings like "variable declared but not used", and if you select a word, boxes appear in the bar for each occurance of the word in the document.
A screenshot of these features in action:
After a half hour of searching, I've determined that Visual Studio cannot do this on its own, so my question is: does anyone know of any add-ins for 2005 or 2008 that can provide either one of the aforementioned features?
Being able to highlight the current line your cursor is on would be nice too. I believe the add-in ReSharper can do this, but I'd prefer to use a free add-in rather than purchase one.
There is a RockScroll alternative called MetalScroll which is essentially the same thing with a few tweaks and improvements.
Also there is a small and simple WordLight plug-in that only highlights the identical tokens.
Both are open source and support code folding which is nice.
Imho, the bar next to the scroll bar in Eclipse is a lot more elegant solution than the scroll bar replacement of RockScroll/MetalScroll. Unfortunately I couldn't find any VS plug-ins that do it the Eclipse way, so I just stick with WordLight.
In a different question on SO (link), someone mentioned the VS 2005 / VS 2008 add-in "RockScroll". It seems to provide the "error bar" feature I was inquiring about in my question above.
EDIT: RockScroll also does the identical token highlighting that I was looking for! Great!
The highlight functionality is conveniently implemented in VisualAssist. In my opinion, they are both must-have.
1) Highlight identifier under editing caret: Options -> Advanced -> Refactoring -> Automatically highlight references to symbol under cursor
2) Highlight search result - in all windows. Works for RegExps! Options -> Advanced -> Display -> Highlight find results
Old question but... Visual Studio 2010 has this feature built-in, at last.
DevExpress CodeRush does this when you press TAB when the cursor is in an identifier, you can then tab through all the highlighted instances. There's also a DXCore plugin (the foundation upon which CodeRush/Refactor Pro are built) that does current-line highlighting.
The automatic highlight is implemented in Visual Assist as the refactoring command "Find References". It highlights all occurences of a given variable or method, but that's not automatic (binded to a keyboard shortcut on my computer).
Here is an exmaple:
I tried RockScroll and it doesn't even know anything about code folding!
Not my favorite...
The "error bar" functionality is provided in JetBrains ReSharper. I'm not sure if it does highlighting of references to the currently selected identifier.
About RockScroll: It doesn't highlight the identifiers. It only highlights the same string in the source code! If there are similar identifier declared : ex. _test and test, and test is highlighted it will highlight the string "test" in variable _test too! And it will also highlight the same string in a method called "sometesting()". So it isn't exactly like eclipse and doesn't work for me.
Check following addins Productivity Power Tools- Displays error in scrollbar and
In Visual Studio 2005, whenever I would view a file in the main editor, the Solution Explorer would find and highlight that file. Some time ago, this stopped working and the Solution Explorer would do nothing.
This has become quite a pain since following a chain of "Go To Definition"s can lead you all over your solution. Where is the setting to turn this back on?
Tools>Options...>Projects and Solutions>General
Make sure "Track active item in Solution Explorer" is checked. That should do it.
I like to keep this option turned off (especially when working with a big project), but it's useful to be able to find the file in the tree now and then. I found a way to do this here:
http://weblogs.asp.net/kdente/archive/2008/04/30/locating-the-active-item-in-solution-explorer.aspx
I hope I'm not being too verbose here, but here's the guide to making this work that I wrote for my work's wiki:
code:
Imports System
Imports EnvDTE
Imports EnvDTE80
Imports EnvDTE90
Imports System.Diagnostics
Public Module SyncItem
Sub SyncSolutionExplorer()
DTE.ExecuteCommand("View.TrackActivityinSolutionExplorer")
DTE.ExecuteCommand("View.TrackActivityinSolutionExplorer")
End Sub
End Module
The macro is most useful if you bind it to a keystroke. Here's how to do that:
I just discovered that ReSharper can do what Owen suggests. I have disabled the "Track active item in Solution Explorer"-setting, and when I'm working in a source-file I press Shift + Alt + L and the file is selected in the Solution Explorer. I haven't changed the binding, so I guess that is the default. The upside to this is that you don't have to create a macro and then bind it to a keystroke (although not very difficult, it still has to be done). The downside is that ReSharper isn't free, so it's probably not a solution for everybody.
Tools->Options->Project and Solutions->General
Check the box "Track Active Item in Solution Explorer"
Tools -> Options -> Environment -> Keyboard
Assign the command
View.TrackActivityinSolutionExplorer
(I use Alt+L)
then to use always hit Alt+L followed by Alt+L
which turns on the feature and locates the file in the source tree and then turns it off again to stop the location bouncing around when you do not want it to.
If possible one that supports at least spell checking:
The plugin from Microsoft's Mikhail Arkhipov does HTML and Comments, I don't believe it does C# strings, though. I use the Agent Smith plugin for ReSharper for that.
If you're using ReSharper, there's a free addon for it called Agent Smith Plugin. One of its many features is a built in spell checker, that allows fixing the spelling mistakes using the ReSharper shortcut key, Alt-Enter.
Well, 3 weeks later, I've stumbled across CodeSpell. [Note: this link no longer works and the product does not appear to be listed by that company).
Its $30 but has a trial period. Does everything I asked for. Check link to see features.
This blog entry, though dated, helped me out.
Edit: The original link is now invalid but this appears to be the new home of CodeSpell at SubMain. Here is acquisition announcement from them.
Visual Assist X. Spell checks your comments and a whole lot more.
FxCop ships with a spell check now - have you tried that?
Here's a nice add-on for Visual Studio 2005/2008 by Mikhail Arkhipov of MSFT.
I use this to check Comments and string spell checker. It's from component one http://www.componentone.com/SuperProducts/IntelliSpell/. It's very fast and there is a free community version.
CodeRush also has spell check.
The source code for Spelly is available, it would be pretty easy to update it for vs2008.
Spelly has been ported to VS 2003. I don't know if it works with VS 2008 (because I'm very happy with Agent Smith for ReSharper), but source is included.
I was running an obsolete version on Visual Studio 08, as of April last year this is the apparent update: http://visualstudiogallery.msdn.microsoft.com/2f3d691d-8838-4d84-ad64-44a02db37e30/
Unfortunately for me, it only works on commented code and not strings.
I frequently work with multiple instances of Visual Studio, often working on different branches of the same solution.
VC6 used to display the full path of the current source file in its title bar, but Visual Studio 2005 doesn't appear to do this. This makes it slightly more awkward than it should be to work out which branch of the solution I'm currently looking at (the quickest way I know of is to hover over a tab so you get the source file's path as a tooltip).
Is there any way to get the full solution or file path into the title bar, or at least somewhere that's always visible so I can quickly tell which branch is loaded into each instance?
There is not a native way to do it, but you can achieve it with a macro. The details are described here in full: http://www.helixoft.com/blog/archives/32
You just have to add a little VB Macro to the EvironmentEvents macro section and restart VS.
Note: The path will not show up when you first load VS, but will whenever you change which file you are viewing. There is probably a way to fix this, but it doesn't seem like a big deal.
Check out latest release of VSCommands 2010 Lite. It introduced a feature called Friendly Solution Name where you can set it to display solution file path (or any part of it) in Visual Studio main window title. More details: http://vscommands.com/releasenotes/3.6.8.0 and http://vscommands.com/releasenotes/3.6.9.0
This is a extension available in the online gallery specifically tailored for this job. Checkout http://erwinmayer.com/labs/visual-studio-2010-extension-rename-visual-studio-window-title/
It's awkward indeed. Hovering on the tab is indeed one of the few things useful. Alternatives: right click on the file tab : http://weblogs.asp.net/piseth/archive/2008/11/08/find-your-file-path-in-visual-studio.aspx Seems we have to do with that
For 2008, a slightly better way to write the macro from the accepted answer above is to use the Solution events instead of the document ones - this lets you always edit the title bar, even if you don't have a document selected. Here's the macro my coworker and I put together based on the other one - you'll want to change lines 15-18 to pull your branch name from the source directory for however you're set up.
01 Private timer As System.Threading.Timer
02 Declare Auto Function SetWindowText Lib "user32" (ByVal hWnd As System.IntPtr, ByVal lpstring As String) As Boolean
03
04 Private _branchName As String = String.Empty
05 Private Sub SolutionEvents_Opened() Handles SolutionEvents.Opened
06 Try
07 If timer Is Nothing Then
08 ' Create timer which refreshes the caption because
09 ' IDE resets the caption very often
10 Dim autoEvent As New System.Threading.AutoResetEvent(False)
11 Dim timerDelegate As System.Threading.TimerCallback = _
12 AddressOf tick
13 timer = New System.Threading.Timer(timerDelegate, autoEvent, 0, 25)
14 End If
15 Dim sourceIndex As Integer = DTE.Solution.FullName.IndexOf("\Source")
16 Dim shortTitle As String = DTE.Solution.FullName.Substring(0, sourceIndex)
17 Dim lastIndex As Integer = shortTitle.LastIndexOf("\")
18 _branchName = shortTitle.Substring(lastIndex + 1)
19 showTitle(_branchName)
20 Catch ex As Exception
21
22 End Try
23 End Sub
24
25 Private Sub SolutionEvents_BeforeClosing() Handles SolutionEvents.BeforeClosing
26 If Not timer Is Nothing Then
27 timer.Dispose()
28 End If
29 End Sub
30
31
32 ''' <summary>Dispose the timer on IDE shutdown.</summary>
33 Public Sub DTEEvents_OnBeginShutdown() Handles DTEEvents.OnBeginShutdown
34 If Not timer Is Nothing Then
35 timer.Dispose()
36 End If
37 End Sub
38
39 '''<summary>Called by timer.</summary>
40 Public Sub tick(ByVal state As Object)
41 Try
42 showTitle(_branchName)
43 Catch ex As System.Exception
44 End Try
45 End Sub
46
47 '''<summary>Shows the title in main window.</summary>
48 Private Sub showTitle(ByVal title As String)
49 SetWindowText(New System.IntPtr(DTE.MainWindow.HWnd), title & " - " & DTE.Name)
50 End Sub
Related note: As an alternative, for Visual Studio 2005 you can use the command File -> Advanced Save Options. The dialog displays the full path of the current file, and you are able to copy the text.
If I open a solution in Visual Studio 2008 and run a unit test then VS creates a new .vsmdi file in the Solution Items folder and gives it the next number available e.g. My Solution2.vsmdi.
Any idea why VS is doing this and how I can get it to stop doing this?
It appears that the VSMDI problem is a known bug and has been around since VS2005 Team System but it has no clear fix as yet. Another reason to NOT use MS Test.
An MSDN blog details how to run unit tests without VSMDI files.
An old post but vsmdi is a meta data file created by the test system.
A problem which persists in the VS2010 Beta2. It's looking more and more like I'll be going back to NUnit or MBUnit in the near future.
I work around this by always checking out the .vsmdi.
It seems that this only happens when the .vsmdi file is read-only, e.g. not checked-out in a version control system that uses that kind of lock-local-files behavior (Perforce etc).
I had a plugin installed in Visual Studio 2008, and it created some extra dockable windows. I have uninstalled it, and I can't get rid of the windows it created - I close them, but they always come back. They're just empty windows now, since the plugin is no longer present, but nothing I've tried gets rid of them. I've tried:
Any ideas?
Have you tried this? In Visual Studio go to Tools > Import and Export Settings > Reset all settings
Try devenv.exe /resetuserdata. I think it's more aggressive than the Tools > Import and Export options suggested.
Also check Tools > Add In Manager and make sure there aren't any orphans there.
How about running the following from command line,
Devenv.exe /ResetSettings
You could also save those settings in to a file, like so,
Devenv.exe /ResetSettings "C:\My Files\MySettings.vssettings"
The /ResetSettings switch, Restores Visual Studio default settings. Optionally resets the settings to the specified .vssettings file.
I tried most of the suggestions, and none of them worked. I didn't get a chance to try /resetuserdata. Finally I reinstalled the plugin and uninstalled it again, and the windows went away.
Note: if you have vs2010 and vs2008 and you want to reset the 2008, you will need to specify in command line the whole path. like this:
"C:\Program Files\Microsoft Visual Studio 9.0\Common7\IDE\devenv.exe" /resetsettings
If you don't specify the path (like devenv.exe /resetsettings), it will reset the latest version of Visual studio installed on your computer.
If you've ever backed up your settings (Tools -> Import and Export Settings), you can restore the settings file to get back to a prior state. This is the only thing that I've found to work.
I close them, but they always come back
When you say "they always come back" do you mean "next time you restart Visual Studio" or "immediately"?
One quirk of Visual Studio (at least VS2005) is that settings aren't saved until you exit. That means that if VS crashes at all while you are using it, any layout changes you made will be lost. The way around this is to always gracefully exit when you have set up everything like you want it to be.
Not sure if this will help your particular situation though.
I had similar problem except that it happened without installing any plugin. I begin to get this dialog about source control every time I open the project + tons of windows popping up and floating which I had to close one by one.
Windows -> Rest Windows Layout, fixed it for me without any problems. It does bring the default setting which I don't mind at all :)
I have a .exe and many plug-in .dll modules that the .exe loads. (I have source for both.) A cross-platform (with source) solution would be ideal, but the platform can be narrowed to WinXP and Visual Studio (7.1/2003 in my case).
The built-in VS leak detector only gives the line where new/malloc was called from, but I have a wrapper for allocations, so a full symbolic stack trace would be best.
The detector would also be able to detect for a leak in both the .exe and its accompanying plug-in .dll modules.
I personally use Visual Leak Detector, though it can cause large delays when large blocks are leaked (it displays the contents of the entire leaked block).
If you don't want to recompile (as Visual Leak Detector requires) I would recommend WinDbg, which is both powerful and fast (though it's not as easy to use as one could desire).
On the other hand, if you don't want to mess with WinDbg, you can take a look at UMDH, which is also developed by Microsoft and it's easier to learn.
Take a look at these links in order to learn more about WinDbg, memory leaks and memory management in general:
I have had good experiences with Rational Purify. I have also heard nice things about Valgrind
Try Jochen Kalmbach's Memory Leak Detector on Code Project. The URL to the latest version was somewhere in the comments when I last checked.
As for me I use deleaker to locate leaks. I am pleased.
I'm used to the vi(m) editor, and am using MS VisualStudio 2005 at work. I couldn't find a free vi add-in (there's one for the 2003 version :-( ). I've googled a bit, saw that there was a 'Google summer of code' project this year to write such an add-in, and am eagerly awaiting the result. I've also heard of ViEmu (not free, and I can't test it at work :( ).
I was wondering if anyone in my situation had found a solution (and/or if anyone had tested ViEmu)?
Edit: can't test at work because they are paranoid about what we install on our boxes: it has to go through channels,..., and for 30 days I don't reckon it's worth it (and I have no Windows box at home).
As both answers were quite equivalent, I ended up accepting the first one that came in.
ViEmu works great with Visual Studio. I used Vi(m) strictly in Linux, but I was turned on to bringing the Vi(m) editing process into the Windows world by JP Boodhoo. JP praises about it also.
ViEmu works great. I've been using it for about a year now and couldn't imagine coding in Visual Studio without it.
Why can't you test it at work? It has a 30 day free trial.
How do you turn a Visual Studio build that you'd perform in the IDE into a script that you can run from the command line?
Update: To those also looking for the answer to this question, please check the Related box to the right as several similar questions have been asked.
\Windows\Microsoft.NET\Framework\[YOUR .NET VERSION]\msbuild.exe
Lots of command line parameters, but the simplest is just:
msbuild.exe yoursln.sln
With VS2008 you can do this:
devenv solution.sln /build configuration
nant and msbuild are the most popular tools to automate your build in .net, and you can can find a discussion on there the pros/cons of each in this question "best .net build tool"
Look into build tool NAnt (http://nant.sourceforge.net/) or MSBuild (http://msdn.microsoft.com/en-us/library/0k6kkbsd.aspx). I believe MSBuild is the build tool for VS2005+, I am however a fan of NAnt...
Simplest way: navigate to the directory containing the solution or project file, and run msbuild (assuming you have Visual Studio 2005 or newer).
More flexible ways:
I had to do this for a C++ project in Visual Studio 2003 so I don't know how relevant this is to later version of visual studio:
In the directory where your executable is created there will be a BuildLog.htm file. Open that file in your browser and then for each section such as:
Creating temporary file "c:\some\path\RSP00003C.rsp" with contents
[
/D "WIN32" /D "_WINDOWS" /D "STRICT" /D "NDEBUG" ..... (lots of other switches)
.\Project.cpp
.\Another.cpp
.\AndAnother.cpp
".\And Yet Another.cpp"
]
Creating command line "cl.exe @c:\some\path\RSP00003C.rsp /nologo"
create a .rsp file with the content between the square brackets (but not including the square brackets) and call it whatever you like. I seem to remember having problems with absolute paths so you may have to make sure all the paths are relative.
Then in your build script add the command line from the BuildLog.htm file but with your .rsp filename:
cl.exe @autobuild01.rsp /nologo
(note there will also be a link.exe section as well as cl.exe)
As of VS2005, all of the project files (at least for .NET based projects) are actual MSBuild files, so you can call MSBuild on the command line and pass it the project file.
Bottom line is that you need to use a "build scripting language" like NAnt or MSBuild (there are others, but these are the mainstream ones right now) if you want to have any real control over your build process.
Take a look at UppercuT. It has a lot of bang for your buck and it does what you are looking for and much more.
UppercuT uses NAnt to build and it is the insanely easy to use Build Framework.
Automated Builds as easy as (1) solution name, (2) source control path, (3) company name for most projects!
Some good explanations here: UppercuT
I know there are many discussions if Resharper or CodeRush is better. At my company we currently use Resharper and I'm fine with it.
But last week I watched a screencast about CodeRush and thought it was amazing. There are just so many "new" refactorings that I immediately thought about a migration.
What's your favorite tool for refactoring, code-analysis, navigation inside Visual Studio etc and why? At which areas do you think is Resharper better and at which areas CodeRush?
Honestly they both are equal to the task. What I've found is that CodeRush/Refactor Pro has a steeper learning curve, but once you have trained yourself and the environment (and switched a few keystrokes) CodeRush really becomes effective.
ReSharper is equally good and don't let anyone mislead you on that point. They are not equal though and it will depend on your needs. CodeRush is way more extensible (IMO), but if you move from one to the other you will be missing a couple things from the other.
Back in July I took a month and I did just what you are talking about doing (I migrated from ReSharper to CodeRush and blogged about it).
I'm pretty happy with the end result (there's a couple things I'm missing... CodeRush's Code Analysis is still not quite at ReSharper's level and the "Move" refactoring.. beyond that I found everything I needed).
Here are my blog posts so you can refer to them (if you want)...
Hello CodeRush!
After Week 1
2 weeks with CodeRush
CR/RP Wrapup
As I said though both tools are excellent and depending on your willingness to learn a new tool, you may be better with what you have right now.
The CodeRush refactoring experience is faster and smoother (fewer keystrokes, fewer dialogs - zero, fewer mouse movements) than ReSharper's. When you rename or change a signature that impacts many unopened files on disk, CodeRush properly supports multi-file undo. By contrast, ReSharper presents a dialog asking if you want undo support for this Rename, and if you say yes, ReSharper proceeds to open all the files touched by the refactoring.
CodeRush has more refactorings than ReSharper, although ReSharper has a nice Move member to class refactoring that has yet to hit CodeRush. ReSharper also has a nice rename feature that lets you rename variables that contain a class name when you rename that class. For example, if I rename a "Spaceship" class to "Spacecraft", ReSharper finds identifiers with names like "superSpaceship" and suggests they be renamed to "superSpacecraft".
CodeRush is a little bit faster than ReSharper on Visual Studio startup and on project opens. ReSharper uses more memory, up to six times as much on really large solutions (e.g., 1000+ classes).
ReSharper reports more of the background code issues than CodeRush, and the code issues ReSharper shows are in general more useful (e.g., parameter type can be demoted to a class closer to object), however CodeRush includes a code issue that spots undisposed local variables that implement IDisposable which is very useful.
CodeRush ships significantly more code templates (like VS code snippets) than ReSharper, and CodeRush's templates are designed to be optimally efficient (for example, "ms" builds a method that returns a string, "vb" creates a variable of type bool, and "nl.i" creates a new initialized List). Your fingers benefit from the efficiency but the templates take some practice getting used to. The CodeRush training window can ease this learning curve if you have it up while you code. Interestingly, CodeRush templates effectively abstract away the programming language, so developers working in more than one language (or transitioning from one language to another) can press the same keystrokes and get essentially the same code, regardless of the language they are coding in.
ReSharper has a nice Intellisense replacement and an interesting parameter tool tip replacement. ReSharper has a variable name suggestion feature that is useful. ReSharper also has a code reformatting feature that is very nice.
CodeRush's TDD consume-first declaration features require fewer keystrokes than ReSharper's (see these in free CodeRush Xpress which includes most of the consume-first declaration features shipping in the full version of CodeRush).
ReSharper's find all references window has multiple panes for each search performed, which is nice. CodeRush provides only one pane for the last search performed. CodeRush has a neat Tab to Next Reference feature that takes you through all references to an identifier just by pressing the Tab key (Shift+Tab takes you back). CodeRush's Find All References appears faster than ReSharper's.
CodeRush's Unit Test Runner released in 9.3 supports more test frameworks out of the box (NUnit, MSTest, xUnit, and MbUnit). The CodeRush Test Runner also understands more of the framework attributes (for example NUnit's ExpectedException MatchType parameter) and also supports dynamically-generated tests (e.g., RowTests, the Values attribute, factories, theories, etc.). Support for test frameworks is extensible and CodeRush includes source code for each of the test framework plug-ins.
CodeRush is where it's at man. I didn't like resharpers intellisense, so i turned it off, which makes resharper less useful.
I've been a long time user of CodeRush + RefactorPro, whereas my friend in one team is using Resharper.
I really would like to have code analysis at the same level that he has in R#. CR is just poor here. R# excells in code layout features as well and has decent test runner. In CR, there is no code layout and formatting tools and test runner is not released yet. It is in planned stage.
Regarding navigation, we find both tools equal.
My friend envies me templates that CR has. R# templates are far behind. Also, learning curve of R# is worse. CR is much easier to grasp. Also, refactorings provided by Refactor Pro are better than in R#. They are just easier to cope with. So, in terms of writing code I find CR better.
Recently we both tried to write plugins to implement features we see in opposite tool and would like to have. I was able to do this waaaay easier for CR. Extensibility of DXCore is amasing.
All in all: R# has much more features, but they are much harder to learn. Also, if you find something missing, CR is easier to extend.
It's Resharper for me. I've been using it since it's first EAP release and I love it to bits! As you say, it far more than refactoring - it's the way it supports me in navigation and code comprehension that I use far more than the refactoring. Two of my favourite features are the code cleanup and type members layout.
I find Tim's comment intriguing where he says:
it intelligently applies itself to existing things you do
I'd be interested to hear what this is in CodeRush. I have a lot of respect for Developer Express products.
I've been a long time user of CodeRush and Refactor! Pro. CodeRush is way more than refactoring. Once you learn the rules it sets out, coding speed increases. However, even before you learn the rules, it intelligently applies itself to existing things you do and makes doing them easier.
Indeed, the thing I miss the most about coding in Ruby on Rails is that I don't have an IDE with CodeRush and Refactor! TextMate bundles get me part way, but it's not the same.
They have a free trial available, so I encourage you to give it a run and see how you like it. I've never looked back.
I've tried both. JetBrains Resharper is way better for me than DevExpress Coderush.
JetBrains is better with the IDEs (they have their own IDE for java, after all) just like DevExpress is better with the beautiful components.
Having tried both, I'd say latest version of CR/R has the edge in terms of integrating with the programming workflow. Usually you won't see a dialog asking if you wanted to do this or that, it just flows with what you're doing. You're always a keystroke away of all the available refactors etc. Latest version includes IMHO important refactors like push/move method. Navigating your classes is faster in CR/R.
I have noticed also that performance in large projects tend to be better in CR/R than that of Resharper.
Intellisense support is better in Resharper, as well as code analysis.
Is there any performance difference between the two? I was a long time ReSharper user but finally gave up when I couldn't stand the sluggish performance any longer. The more complex my project (forms, etc) got, the slower the machine got. I uninstalled it and performance was way, way better. Is CodeRush as sluggish?
I used Coderush for a year pre TDD. I've now used Reshaper for nearly 1.5 years. I easily go for an hour or two without using the mouse now thanks to R# (only because I often run out of batteries)
If you practice TDD and or learn to use the tools fully then Resharper is the way to go, I hit many frustrations with CodeRush in TDD and it seems at the time effort was going to do javascript evaluation rather than evaluating productivity enhancement for core C#.
If you're the type of person that uses Resharper for CTRL+T and mouse click refactoring then you'll probably get more from Coderush, especially if property generation if high up on your consideration list. Day 1 impressions CodeRush wins, equally Day X if you dont learn embrace the tools fully, but by end of month one with a solid eval Resharper wins. Next time you reach for the mouse ask is there a shortcut for this, try it.
Resharper has a higher learning curve to get going (you need to become fluent with stuff beyond goto type) and works at its optimal potential with TDD approach.
I dont think there is any comparison. I used Resharper for years, but once I moved to CodeRush, I am not looking back. The big reason I moved to CodeRush was Resharpers horrible performance with VS2010. R# made the IDE almost unusable. I have a dual core Intel with 6GB RAM laptop and it still had serious problems. Seems to be the consensus our there on this. CodeRush is like its not even there is VS2010. Very lightweigth and just a useful. I dont think one is so much better as far as features go and there are alot of things I like more in R#, but Jet Brains really dropped the ball when VS2010 came out and I was pretty disappointed.
ReSharper is the one for me. I have written about this here : http://www.tewari.info/2009/02/21/resharper-vs-coderush-refactor-pro/
Even after a year, I have to give credit to Mark Miller he gave a very fair comparison.
Both products have improved since the original post and I do not have performance issues with either.
One feature that Resharper has that is very difficult to live without is its collection of Move File refactorings. You can select multiple files in solution explorer and move them to a new folder and/or project and ReSharper will fix up the namespaces and references for you. I used this feature today on some legacy code and I estimate it saved me at least 4 hours of tedious work.
The community plugin DX_MoveCode provides a bit of this behavior but without the ability to update the namespace and all references to the types moved it just doesn't compete.
R# Code Formatting is real hard to live without especially if you work with legacy code.
I love the fact that refactoring in Code Rush is so much cleaner and performant, however, those dialogs R# provide give me the ability to update variables, comments and strings related to the refactoring. For me, the cost of the dialogs is justified by this support.
One thing that surprises me is how CR displays code issues: ticks on the left and right of the editing surface and a HUGE hint. The ticks are fine but give us an opton to turn off that hint. I'm surprised because CR normally does a good job of staying out of the way, thise hints can be a pain at times.
Working with options in CR is a major pain. Code Rush does not do a good job of making it easy or accessible to modify its rich set of options.
For me, if CR provided the same Move File features and Code Formatting R# has, I'd buy it immediately. I'm a sucker for eye candy and CR has it in spades.
I use resharper - just downloaded the CodeRush free thing.. but there's no items on the menu bar./.. nothing.. only a line between brackets... so I think I'll stick with resharper..
The reason I got R# for its code analysis. Showing me error in real time is awesome. CR doesn't have it or its weak. it's taking them foreevr to get right.
I also love R# navigation shortcuts.
CR is probably better in refactoring but I seldom do refactorings. I do them by hand. Refactor Pro has so many refactorings, you might be buried. Learning curve is steep.
I have done some big refactorings lately and would say that I can not work without Resharper any more.
You can just find out so many things so fast, like the usages of methods, classes, interfaces, the inheritors, etc.
And if you want to apply refactorings there is a lot of support which makes Resharper a must- have for me
Both of these tool are excellent. I currently use Refactor! Pro. I've only just started using CodeRush Xpress as well. I used ReSharper a bit at a client site back in 2005. I purchased Refactor! Pro a couple of years ago because at that time it had wider language support. I was doing VB at the time and Refactor! supported it, ReSharper didn't then. I prefer the UI paradigm in CR/R! but as I've not used a current version of ReSharper I can't judge what's best. However, it does seem that ReSharper is more advanced in the code analysis area. The main point is that both tools are good and way better than what you get out of the box with Visual Studio!
I'm a long time IntelliJ and R# user and I'm sure I'd find it hard to switch, but my curiousity about what I'm missing out on is strong enough to approach trying. From what others are talking about on this question page and elsewhere online, I think I'd still miss the navigation and analysis features of R#.
I found this page of videos that show CR/RP features. It might be useful to people like me who want to see what they're missing out on before installing anything:
Training Videos and Online Tutorials - Coding Assistance and Refactoring Tools by DevExpress
I've recently switched from being an employee of a small consulting company to being an independent consultant and as time goes on I will need to upgrade Windows and Visual Studio. So what is the most affordable way to go about this for a small time developer?
My previous boss suggested I get a TechNet Plus subscription for OS licenses, I've done that and appears to be what I need, but open to other options for the future.
Visual Studio I'm having a hard time figuring out exactly what is the difference between Professional and Standard. Also I'd really like a digital version, but seems that expensive MSDN subscription is the only way?
Visual Studio 2008 Professional with MSDN Professional listed here appears to be semi-reasonably priced at $1,199. That would make the TechNet Plus subscription unneeded.
I recommend that if VS Express is not good enough, use Professional. Standard is missing some really useful features, like a Remote Debugger. Here is a detailed comparison:
http://msdn.microsoft.com/en-us/vs2008/products/cc149003.aspx
I'd say cancel TechNet and get one of the bottom two MSDN Subscriptions, Visual Studio Professional with either MSDN Professional or with MSDN Premium.
You have the Microsoft Empower for ISV program, see https://partner.microsoft.com/40011351
Gives you a full msdn pro subscription for two years.
For non developer tools try Microsoft Action Pack https://partner.microsoft.com/40016455 Then use Visual Studio Professional (in some exibitions you will get this for free) For the versioning use svn and not TeamSystem
I realise that this doesn't apply to the asker but it it is relevent to the question.
Any student developers out there try Microsfts Dream Spark scheme. Visual Studio, Expression Studio, XNA and Server 2003 for free!
Office is also available to students for less than 60 bucks in Microsfts `Ultimate Steal'
I think that Visual Studio Professional with MSDN Subscription doesn't offer much value compared to just purchasing Visual Studio 2010 Pro. You get testing licenses for Windows Server and MSSQL, but that's it. And you can get by just fine without those 90% of the time.
But Visual Studio Premium with MSDN is a different story. You get access to most other server products (testing license only of course), and an Office Professional license. That's a much better value for a one-man shop in my opinion, if you can afford it.
I currently use AnkhSVN to integrate subversion into Visual Studio. Is there any reason I should switch to VisualSVN?
AnkhSVN is free (in more than one sense of the word) while VisualSVN costs $50. So right there unless I'm missing some great feature of VisualSVN I don't see any reason to switch.
I used VisualSVN until Ankh hit 2.0, and ever since, I've abandoned VisualSVN. Ankh has surpassed VisualSVN in functionality, in my mind, and all the 1.x perf and integration issues are gone.
For me, VisualSVN is pretty, but useless. AnkhSvn on the other hand, after it came in v2 as an scc provider, it works very good. VisualSVN tries to think for you, which is not an good thing, the user should be the controller, not the software.
Here is a funny story: I managed to corrupt one SVN repository with AnkhSVN last year. All I did was moving around the files. Thanks AnkhSVN!
I've been sticking with TortoiseSVN ever since. :)
Not questioning your judgment here, just making sure you're comparing apples to apples.
So has anyone here actually tried both the 1.5 version of VisualSVN and the 2.0 version of AnkhSVN? I use VisualSVN at home and would love to use it at work, but they won't pay for it, so I'm really tempted to just buy the license myself...but if the new AnkhSVN is comparable (or better) then I'll just switch to that.
I had issues similar to Michael with AnkhSVN, but I'm using VS2008, that may be causing the problem.
I just tried Anksvn and found it good.
@Jeff, Bloody hell, what's the time out there right now? Get some sleep!
@thelsdj, I used to really miss the integration when I switched to Tortoise SVN and now when I use TFS at work, it actually gets on my nerves. Maybe try that. I used to pooh pooh anything that didn't have integration, I thought I couldn't or wouldn't live without it.
The main thing is that VisualSVN uses TortoiseSVN for nearly all of its UI. So you only really have to set up one client (preferred diff viewer, etc), and you can take advantage of things like the same "Previous messages" button on the Commit dialog, whether you're committing from Explorer or Visual Studio.
I prefer UnifiedSCC
How do I make Visual Studio show me nUnit as a testing framework when creating a new MVC project? At this point I still only have the Microsoft Testing Framework as a choice.
Update: I installed nUnit 2.5, but still with no success. From what I've found Googling, it would seem I need to create templates for the test projects in order for them to be displayed in the "Create Unit Test Project". I would have thought that templates be readily available for nUnit, xUnit, MBUnit, et. al. Also, it looks like I need to created registry entries. Anybody have any additional information?
Update: I determined the answer to this through research and it's posted below.
After a bunch of research and experimentation, I've found the answer.
From a high level, what you have to do is:
So much for the testing framework selection being easy! Although, to be fair MVC is not even beta yet.
After all that, I did get the framework of choice (NUnit) to show up in the drop down box. However, there was still a bit left to be desired:
So, I should probably read this as well which discusses making project templates for Visual Studio (also referenced in the blog post I linked to above.) I admit to being disappointed though; from all the talk about MVC playing well with other testing frameworks, etc, I thought that it'd be easier to register a 3rd party framework.
Man, they have VS 2008 project template listed in their release notes. I guess that doesn't mean they have it integrated with the dialog yet.
I use MbUnit with Gallio and everything worked like a charm. I had to install an Alpha of Gallio and MbUnit and when I read the above in the release notes, I figured they implemented it also.
Just keep a look out on nUnit's site for future alpha releases. I am sure they'll have it implemented soon. You could also implement the feature yourself and submit a patch. :-)
Although they do not have one bundled with the framework here is a link to post containing a download to automatically create the test project for "NUnit with moq" for you NUnit with Moq
(did not work right away on my computer, W7 Beta, make sure you use elevated permissions)
Do install Testdriven.net to integrate NUnit with Visual Studio. MbUnit and later versions of NUnit also contain project templates for unit tests.
You can use those project templates to create a test project and then reference to your ASP.NET MVC project and be able to test its code.
Is it possible to change how ctrl+tab and shift+ctrl+tab work in Visual Studio? I have disabled the popup navigator window because I only want to switch between items in the tab control. My problem is the inconsistency of what switching to the next and previous document do.
Every other program that uses a tab control for open document I have seen uses ctrl+tab to move from left to right and shift+ctrl+tab to go right to left. Visual Studio breaks this with it's jump to the last tab selected. You can never know what document you will end up on and it is never the same way twice.
It is very counter intuitive. Is this a subtle way to encourage everyone to only ever have two document open at once?
Let's say I have a few files open. I am working in one and I need to see what is in the next tab to the right. In every other single application on the face of the Earth (hyperbole), ctrl+tab will get me there. In Visual Studio, I have no idea which of the other tabs it will take me to. If I only ever have two documents open, this works great. As soon as you go to three or more, all bets are off as to what tab Visual Studio has decided to send you to.
The problem with this is that I shouldn't have to think about the tool, it should fade into the background, I should be thinking about the task. The current tab behavior keeps pulling me out of the task and makes me have to pay attention to the tool.
There is finally answer to make tabs work as we who are looking at this question want.
The latest version of the "Productivity Power Tools" extension adds two commands to VS:
Window.NextDocumentWellTab and Window.PreviousDocumentWellTab
Just go remap them from Ctrl+Alt+PageUp/Ctrl+Alt+PageDown to Ctrl+Tab/Ctrl+Shift+Tab in
Tools-> Options -> Environment -> Keyboard
This is my first post in Stack Overflow so I'm hoping at least somebody finds it useful. I also got fed up with the most recently used ordering of tabs found in Visual Studio ever since version 2005. There is a way around this and this blogger going by the name of Mr Speaker has the necessary macro code. Navigate to his blog post and make use of his macro. After you apply his macro to your VS you can bind your favorite keyboard shortcuts to them. Also notice the registry fix in the comments for not displaying the macro balloon since they might get annoying after a while. Have fun!
After a couple of hours of searching I found a solution how to switch between open documents using ctrl+tab which move from left to right and shift+ctrl+tab to go right to left.
In short you need to copy and paste this macro:
Imports System
Imports EnvDTE
Imports EnvDTE80
Imports EnvDTE90
Imports System.Diagnostics
Public Module TabCtrl
Public Sub TabForward()
Dim i As Integer
Dim activateNext As Boolean = False
For i = 1 To DTE.Windows.Count
If DTE.Windows().Item(i).Kind = "Document" Then
If activateNext Then
DTE.Windows().Item(i).Activate()
GoTo done
End If
If DTE.Windows().Item(i) Is DTE.ActiveWindow Then
activateNext = True
End If
End If
Next
' Was the last window... go back to the first
If activateNext Then
For i = 1 To DTE.Windows.Count
If DTE.Windows().Item(i).Kind = "Document" Then
DTE.Windows().Item(i).Activate()
GoTo done
End If
Next
End If
done:
End Sub
Public Sub TabBackward()
Dim i As Integer
Dim activateNext As Boolean = False
For i = DTE.Windows.Count To 1 Step -1
If DTE.Windows().Item(i).Kind = "Document" Then
If activateNext Then
DTE.Windows().Item(i).Activate()
GoTo done
End If
If DTE.Windows().Item(i) Is DTE.ActiveWindow Then
activateNext = True
End If
End If
Next
' Was the first window... go back to the last
If activateNext Then
For i = DTE.Windows.Count To 1 Step -1
If DTE.Windows().Item(i).Kind = "Document" Then
DTE.Windows().Item(i).Activate()
GoTo done
End If
Next
End If
done:
End Sub
End Module
The macro comes from: www.mrspeaker.net/2006/10/12/tab-un-stupidifier/
If you never add a macro to Visual Studio there is a very useful link how to do it.
I guess you want what VSS calls Next(Previous)DocumentWindow. By default, it's on Ctrl(-Shift)-F6 on my VSS 8. On Ctrl(-Shift)-Tab they have Next(Previous)DocumentWindowNav. You can change key assignments via Tools/Options/Keyboard.
The philosophy of VS tab order is very counter intuitive since the order of the displayed tabs differs from the tab-switching logic, rendering the ordering of the tabs completely useless
So until a better solution arises, change the window layout (in Environment->General) from tabbed-documents to multiple-documents; it will not change the behaviour but reduces the confusion caused by the tabs.
That way you will also find the DocumentWindowNav more useful!
I'm 100% in agreement with Jeff.
I had worked on Borland C++ Builder for several years and one of the features I miss most is the 'correct' document tabbing order with Ctrl-Tab. As Jeff said, "The current tab behavior keeps pulling me out of the task and makes me have to pay attention to the tool " is exactly how I feels about this, and I'm very much surprised by the fact that there aren't many people complaining about this.
I think Ctrl-F6 - NextDocumentWindowNav - navigates documents based on the document's last-activated time. This behavior is a lot like how MDI applications used to behave in old days.
With this taken this into account, I usually use Ctrl+F6 to switch between 2 documents (which is pretty handy in switching between .cpp and .h files when working on c++ project) even when there are more than 2 currently opened documents. For example, if you have 10 documents open (Tab1, Tab2, Tab3, ...., Tab10), I click on Tab1 and then Tab2. When I do Ctrl+F6 and release keys, I'll jump to Tab1. Pressing Ctrl+F6 again will take me back to Tab2.
In registry branch: HKEY_CURRENT_USER\Software\Microsoft\VisualStudio\9.0 add DWORD named "UseMRUDocOrdering" with value of 1. It will order documents so most recently used are placed on the left. It's not perfect but better than the default misbehaviour.
I don't use Visual Studio ( yes, really, I don't use it ), but AutoHotKey can remap any hotkey globally or in a particular application:
#IfWinActive Microsoft Excel (application specific remapping)
; Printing area in Excel (@ Ctrl+Alt+A)
^!a::
Send !ade
return
#IfWinActive
$f4::
; Closes the active window (make double tapping F4 works like ALT+F4)
if f4_cnt > 0
{
f4_cnt += 1
return
}
f4_cnt = 1
SetTimer, f4_Handler, 250
return
f4_Handler:
SetTimer, f4_Handler, off
if (f4_cnt >= 2) ; Pressed more than two times
{
SendInput !{f4}
} else {
; Resend f4 to the application
Send {f4}
}
f4_cnt = 0
return
These are two remappings of my main AutoHotKey script, I think it's an excellent tool for this type of tasks.
I know a few that I like.
Alt + Shift + F10 then ENTER which automatically adds the "using" at the top if i'm referencing an object that I haven't put the namespace in for yet.
Ctrl + + or Ctrl + -
Which moves you back and forward to which file and method you are/were looking at which is very handy when used in combination with "Go To Definition" or "Find All References".
Are there any other awesome ones I should know about?
Here are my most frequently used shortcuts. These are for the Visual Studio 2008 C# development settings, so may not work using General or VB.Net settings.
Building and Debugging
F6 Build
ALT + D, P Attach to process
ALT + D, P, N Attach to NUnit (unless notepad is open, :-))
Text Editor
CTRL + X Remove current line and place it on the clipboard
ALT + SHIFT + T Swap the current line with the line below it
CTRL + K, C Comment
CTRL + K, U Uncomment
CTRL + M, M Toggle Outlines
CTRL + M, 0 Collapse to Definitions
IDE
CTRL + ALT + L Show the Solution Explorer
F4 Show the Properties window
ALT + SHIFT + ENTER Full Screen
ALT + W, L Close all the open documents
ALT + F4 Go Home for the Day
CTRL + SHIFT + A Add new file
Refactoring
F2 Rename
ALT + SHIFT + F10 Open "Smart Tag" menu - Great for adding "usings" without typing.
SHIFT + F12 Find all References
F12 Find Definition
I've found the Visual C# 2008 Keybinding Reference Poster produced by Microsoft very useful.
There is also one for VS 2005, of course.
ALT + F4 closes the program.
Here is something I use from times to times from Coding Horror : Visual Studio .NET 2005 Keyboard Shortcuts
Ctrl + K then C to comment the selected text
Ctrl + K then C to uncomment
Ctrl + K then F to automatically format the selected code according to VS style guides
Ctrl + I is the shortcut of incremental search.
Ctrl + Shift + I is reverse incremental (These two are probably the most awesome shortcuts in VS).
Ctrl + A + M + M collapses all the document.
Ctrl + M + M toggles expand collapse at the location of the pointer.
Ctrl + . on an identifier opens the refactoring menu on the item (When you change the name of an identifier, a parameter or a method and when you type something but the using statement is missing).
Ctrl + K + D automatically formats the whole file (to correct indentation and spacing, also works on markup, XML and stylesheets).
Here're some that I use frequently:
Build.BuildSelection), for larger solutions with a ton of projects in themBoring but often used:
This actually is not a short cut but in the site:
http://blogs.msdn.com/saraford/
Sara Ford posts a lot of small tips about Visual Studio IDE.
Also one very important short cut Ctrl + S, save the current document and your job ;-)
Keep in mind that some of the VS mappings use different keystrokes for things; it helps to go into "Tools>Options" and find out the actual VS command that your shortcut is mapped to to ensure other people can set it up.
I absolutely love Ctrl + - (minus) and Ctrl + Shift + -.
Ctrl + - is mapped to View.NavigateBackwards and takes you to the last place your cursor was. Have you ever used F12 (Edit.GoToDefinition) on a method, then followed another method call, then ended up so far away from where you started that you can't get back? Ctrl + - will get you back.
Ctrl + Shift + - is View.NavigateForwards, and does the opposite. If you walk back up the call chain, then decide you need to go down again, this one suits your needs.
There's Ctrl + K + Ctrl + C or Ctrl + U to comment/uncomment the selection. F12 to go to a definition and Ctrl + NumPad * to return to where you pressed F12. There's a command to go from source to header file (for the C/C++ people) but there's no equivalent to go to source from header, so I wrote my own in a plugin.
I'm sure I'll think of more as I code.
There's also Ctrl + ] which highlights to the matching () or {}.
Ctrl + . is my favorite, particularly for automatically adding a using statement when necessary. Ctrl + Space and Ctrl + Shift + Space for autocomplete and parameter hints is nice too.
I remap Ctrl + W to close a window (matching a lot of other MDI and tabbed interface conventions) and Ctrl + Shift + P to 'Build Selection' which is really 'Build Project'
As well as the previously mentioned C# keybindings poster, there is a Visual Basic 2008 poster and a Visual C++ 2008 poster.
The ones that I personally find the most useful are the following:
Ctrl + R + R: Refactor->Rename
Ctrl + L: Cut line
Ctrl + Shift + L: Delete current line, without placing it in the clipboard
Ctrl + Tab: Switch to last used tab (very useful for switching back and forth between two files)
Ctrl + W: Select current word
Ctrl + ↑: scroll up one line, without moving caret.
Ctrl + ↓: scroll down one line, without moving caret
FYI, If you select different profiles when you first start Visual Studio then some of the key mappings will be different.
If you selected "Visual Basic development" your keys will be different from someone who selects "Visual C# development".
Even the run/build/debug keys can be different!
So you might as well post what profiles you're using.
I find the following really useful:
I use viemu to let me use the Vi editor's modal editing style within Visual Studio.
I also depend heavily on Ctrl + J and Ctrl + Space to display intellisense info.
Not really a shortcut but in code view you can drag&drop (or cut&paste) code on to the Toolbox. Then if you need that code again just double click it.
Make your own awesome short cuts with this tool:
OpenSource and fully customizable. It is Windows only, sadly.
Ctrl + Enter = Insert line above the current line
Ctrl + Shift + F9 = Clear all breakpoints
Also if, like me, you hate the popup window when using Ctrl + Tab you can fix it:
In keyboard customization reassign the keys to Window.NextDocumentWindow instead of Window.NextDocumentWindow_Nav_. Do the same for Ctrl + Shift + Tab and Window.PreviousDocumentWindow.
A couple I use frequently:
Highlight the section of code you want. Use the chord Ctrl + K, C and all the entire highlighted portion will be commented out. Use the chord Ctrl + K, U to then uncomment it.
Hold down Shift, then Alt and then you can "block select" text which will go down to the next (and subsequent lines), but not pick up the remainders of the following line.
Jonas, Actually CTRL E + U is used for uncomment, CTRL E + C for comment.
One of my personal favorites Ctrl + Alt + Q gives you QuickWatch.
ALT-D-P - attach to process
CTRL-M-M expand collapsed code blocks (boo using regions!)
Ctrl + K, K - creates a bookmark
Ctrl + K, N - navigates to next bookmark
Ctrl + K, P - navigates to previous bookmark
Ctrl + D .. places you in the find textbox of the 'standard' toolbar. Type > and you now can run a bunch of commands.
My favorite: >of then start typing a filename. It will provide a dropdown of matching files across the solution. (Using the file open dialog was my biggest gripe for solutions that span lots of directories, this flattens that nicely.)
You can also set a bp on a function by typing its name and hitting F9.
Oddly I don't see that anyone has posted a couple of the ones I use very frequently:
Shift + Esc to close current tool window and return to text editor. I use this after temporarily popping up the breakpoints window (Ctrl + Alt + B).
Ctrl + T transposes the letters on either side of the cursor. This might sound a bit pointless (did to me at first, anyway) but if you're like me and many of your compiler errors are due to character transpositions then it's surprisingly handy once you've internalized its use.
Ctrl + K, Ctrl + D reformats the entire document - if you're working in C#, anyway. No real equivalent in C++, but Ctrl + K, Ctrl + F will reformat the selection, and this works well in conjunction with Shift + Ctrl + ] if it's easy to get to the { or } of a sizeable scope. (This feature is supported way better in C#, but its C++ equivalent will at least sort out many common indentation problems.)
Ctrl + Shift + R starts or stops recording a temporary macro. Use Ctrl + Shift + P to run the result. It took me a bit of trial and error and practice to work out how best to use this, and it's not as good as the emacs equivalent, but it works well for a lot of repetetive ad-hoc fiddly editings. It's also very handy if you're trying to work out how to express in a macro something that you know how to do by hand using the UI.
Try to type "prop" and press twice [TAB] and you'll see someting cool. (at least for me)
Not sure if this works in VS08 but I like setting up some simple 'statement completions' using the Editor Gaget from Visual Studio 2005 Automation Samples (see link below). So for example I have setup:
** to be replaced with //TODO:
?? to be replaced with MessageBox.Show(
Starting with 2005, VS started this behavior of when starting debugging session it spawns up a webserver for every project in a solution. I have a solution with 15 projects so it takes a while and is a waste of resources. Is there a way to configure it differently besides just using IIS?
Some details here on why it does it and how you can overcome it:
http://vishaljoshi.blogspot.com/2007/12/tips-tricks-start-up-options-and.html
There are instances when you might have many web applications or web sites in the same solution and you may be actually debugging only one of them... In such scenario it might not be desirable to have multiple instances of ASP.NET Development Server running... VS provides an explicit setting in the property grid of web application/site called Development Web Server - "Always Start When Debugging" which is set to True by default... If you set this Property to be False only one web server instance will be created for the start up web project...
Set the web service project's "Always Start When Debugging" property to false. To get to the property, click on the project node and then hit F4 or click View | Properties Window (not Property Pages).
Be careful: this is not in the properties you reach by clicking the project node then clicking Properties; or by double-clicking the project's Properties sub-node; or by clicking View | Property Pages.
Also annoying is that this is property only persists as a user setting, in the .csproj.user file.
In Visual Studio 2008, there is an entry on the Properties page for the project called "Always Start When Debugging".
Note you have to get to this by selecting the project and going to the Properties pane (or right-clicking Properties). This option is not present when you double-click the project and open it in the main editing pane.
VS by default sets this value to on for all your web projects. Turning it off will solve this problem.
[editorial]This is fairly annoying and I wish the default were false![/editorial]
I have also been highly annoyed by that behavior. The only solution I have found is to manually change the properties page for each web appllication so it hits a real running instance in IIS.
I prefer this anyway, because debugging with the integrated web server can give you a very false impression of how your application will interact with the IIS security model.
I know this is an old question, but in Visual Studio 2010 choosing properties from a web project brings you to the big configuration screen/grid. The "Always Start When Debugging" setting is buried a bit.
With focus on the desired web project look at the properties window/tab (CTRL + W, P) and set the property there.
The Visual Studio refactoring support for C# is quite good nowadays (though not half as good as some Java IDE's I've seen already) but I'm really missing C++ support.
I have seen Refactor! and am currently trying it out, but maybe one of you guys know a better tool or plugin?
Visual Assist X by Whole Tomato software is not free, but it's absolutely worth the money if you use Visual Studio for C++.
I have tried Refactor!, as its features seemed promising, as did its testing with a simple testing project, but it failed to work with our real project at all - a lots of CPU activity, sometimes even frozen VS IDE, Refactoring UI not appearing at all for most of the code.
We are using Visual Assist X instead. While it does not offer than many refactorings and it seems to me somewhat more complicated to use, it works.
I didn't find this post and created another one. There is a great response about VS2010 there.
If you are like me, who wishes VS2010 comes with C++ refactoring support, please visit my Microsoft Connect ticket and vote for it. Hopefully with enough votes, MS may give it a higher priority.
Mozilla's Taras Glek worked the last year or two on C++ analysis and code rewriting tools. His blog is at http://blog.mozilla.com/tglek/, you can find links to the tools they created there. They are of course free and open-source. No GUI, but I thought I'd link it in case it's interesting to anybody.
I'm not familiar with the tools you mentioned but the refactoring support for C++ in Eclipse 3.4 is getting pretty useful and growing.
If you like emacs then Xrefactory is a good choice.
Is it possible to open a project in Visual Studio 2008 without opening all the files that were previously opened last time I had the project open. I have a habit of keeping many files open as I am working on them, so next time I open the project, it (very slowly) loads up a bunch of files into the editor that I may not even need open. I have searched through the settings and cannot find anything to stop this behavior.
A bit of research turns up the fact that you can do it with a macro:
EnvironmentEvents in Macro Explorer. (For details, see here.)EnvironmentEvents module.Put in this code:
Public Sub CloseDocsOnExit() Handles SolutionEvents.BeforeClosing
DTE.ExecuteCommand("Window.CloseAllDocuments")
End Sub
Simply delete the .suo file. It contains the list of open files.
I never realized how much that annoyed me as well! I haven't been able to find a setting, but in Options > Environment > Keyboard you can bind a shortcut to Window.CloseAllDocuments. ALT+X was unbound for me so I just used that. I'm interested if there's some hidden setting to automatically do this on solution exit though (or load).
Edit: Totally read the question wrong at first - ignore my first (now gone) answer. :)
I changed the keyboard mapping for CTRL-SHIFT-C from bringing up the Class View to closing all document windows - something I use several orders of magnitude more often - and then I just clear my workspace before closing a solution.
Try the following:
If you have a repository you might want to check that file in.
I suggest this because I was having the reverse problem, where it wasn't opening my old files automatically, and the cause was a .suo file that had been checked into the repository and was (for some reason) not being overwritten by Studio. The file wasn't even write protected.
I was hoping for something a little more automatic. VS will create a new .suo file every time the project is saved. So I would have to delete that file every time I open the project. I also don't want to have to remember to close all the files before closing VS.
Other IDEs that I have used have similar functionality, but also make it rather simple to turn on/off.
Thanks for your help.
Or you can close all open document from the Window menu before closing VS.
In Visual Studio 6.0 (VC++), the procedure is slightly different.
Delete the .ncb file (located normally in the same place as your .dsp or .dsw files).
The only way works for me is : change the project location and again reopen the solutions form there. :)
I am interested in dropping Visual Sourcesafe in favor of a version control application that offers branching. Sourcesafe's integration into Visual Studio makes checkins/outs a breeze. Can anyone suggest some other programs that offer the same functionality? I would prefer open source but it is not a requirement.
Go for Subversion.
Also came across this Microsoft Forum Discussion..
SourceGear Vault ... nice integration with VS and a very good product ... stores it's data on SQL Server, making it very easy to backup / migrate to other machines/servers.
By far the best source control tool I've used.
Team Foundation Server
Perforce (p4) also offers Visual Studio integration and is a very capable source code control system (although not open source).
Try Subversion: http://subversion.tigris.org/ with both tortoise SVN http://tortoisesvn.tigris.org/ for shell intergration and one of either Ankh SVN http://ankhsvn.open.collab.net/ or Visual SVN http://www.visualsvn.com/ for studio intergration.
While Subversion is gaining a pretty big following, we use AccuRev. It's simple to use, has nice graphical editors as well as Visual Studio/File Explorer integration. It ain't free though.
SourceGear Vault is very much a replacement for Visual Source Safe. You get the same feature set, and much much more. Additionally it's stable and scales well. But it is very expensive.
Subversion is great for small shops because it's free. The TortoiseSVN client integrates seemlessly into the Windows Explorer shell. But for Visual Studio integration I would promote VisualSVN's plugin. It's not free, but it is very affordable.
Subversion also gives you the advantage of integrating with many other software management tools out of the box.
Subversion. Because, dude, it's like a Time Machine.
I know you mentioned open source and this is going at the far end of the spectrum to that but I really like Team Foundation server.
It's not just a source control system but an entire Application Life cycle management tool. It gives you so much more than just source control and unless you are working in a very small team I would suggest it provides value beyond it's price tag.
If you're moving SourceSafe, then Vault is a really smooth upgrade path. It's designed as a SourceSafe replacement, so all of the things you used to use in SourceSafe (including IDE integration) are there (along with some new stuff).
It also has an import tool that will bring in your SourceSafe data along with version history. It's not open source, but it is pretty cheap for a version control system.
My vote is for Subversion because it does what you need and nothing more.
Alternatively if you are a bit more adventurous and require a more complex branching strategy you can check out git.
Lots of source control systems offer VS IDE integration. I'm currently using (actually, being forced, almost at gunpoint to use) ClearCase. As much as I loath and detest it, it does offer VS IDE integration, as well as branching.
Alienbrain also has Visual Studio integration. Wouldn't really recommend it for code, though (it's more designed for art assets).
The options that have been mentioned are all good; StarTeam is another option with integration (although not for 2008 yet).
I have used both Subversion and Team Foundation Server extensively, and even though TFS is very tightly integrated into the IDE, I would recommend Subversion. TFS lacks a couple of features that Subversion has, that I really miss - the biggest being the ability to share code across multiple projects using the svn:externals property. TFS does not have this, and this has forced us to structure our source tree in a somewhat artifical way, so as to not have to copy GB of stuff every time we create a branch. I hear that Subversion's integration into the IDE is much better now than when I last used it. I would also mention that if you need work item tracking and other ALM features like that right in the IDE - then TFS may still be the best way to go for you- it all depends on your particular needs.
While not completely free, Perforce has a free 2 user/5 workstation license, and is currently my source control of choice. The P4 SCC plugin integrates seemlessly into VS (auto-checkouts on edit, etc.)
Go for Plastic SCM. It's very easy to use, it's one of the strongests using branches and one of the few enabling true distributed development from withing VStudio. Great refactor support (move tracking, merge tracking and so on), try moving files from VStudio and so on, and it's free for open source.
What Visual Studio color theme do you use? Or just the default?
Since nobody else has mentioned this, Ryan Lanciaux wrote a really cool Visual Studio Theme Generator with an excellent user experience here:
Dark themes as described at length by Scott Hanselman are interesting.
More themes on Visual Studio Programmer Themes Gallery.
Font is a lot more important than color. Consolas!
In my opinion the best low contrast themes for Visual Studio are Zenburn and Oren Ellenbogen's modification of it. I am currently using a modification of the Zenburn theme which does not have green colored output window and has a better support for XML files. I call it Zenburn Remixed.
I'm using a customized version of Oren Ellenbogen's dark theme.
The main difference is that I've added extra highlighting for types and method signatures so they stand out a bit more for me.
I had a look at themes following two posts by Scott Hanselman Post 1|Post 2. I'm using the white theme Jeff Atwood is showing here.
You haven't PIMPed out your IDE completely, if you haven't themed it. Colors and Fonts for the text editor is available in studiostyl.es, but the toolbars and toolboxes can be customized with this :
I think this is really down to the individual.. There are numerous good posts on the subject (such as Scott Hanselman's). I'm sure Jeff did a post too but Google Reader isn't finding it for me.. :\
I prefer a dark theme, find it easiter on the eyes...
I use the default theme, but usually because I find whenver i get my system perfectly set up (fonts, color themes, etc, etc) my machine finds a reason to be re-formatted. Also, moving around from contract to contract, it's just easier to use stuff out of the box to be more productive.
These ones are very nice. I like "Dark grey" most. Very important is the Consolas font, I think there isn't any other font which is as clear to read..
I use a variation of the Zen theme: Zen Theme
I've changed a few small details but my vs looks like that one mostly. I also set Windows XP to use old style (no Luna) with grey colors. So I'm mostly dark but not black. Since I use VStudio inside a virtual machine running inside OS X, I try to make windows look more "Leopard" like (grey/dark grey) so the colors don't distract me.
Off topic: I use OS X with "Graphite" so the Aqua buttons are less annoying (in terms of colors).
Here's a small sshot of both VS and a OS X Finder window together:
I use the dark theme that I found here:http://weblogs.asp.net/infinitiesloop/archive/2006/08/06/Join-the-Dark-Side-of-Visual-Studio.aspx.
I have real problems with my eyes so have had to change my theme a couple of times because my eyes play up with some colours mostly black text on white backgroundn,some days it gives me headaches just staring at a white screen all day.
I also find changing my theme now and then helps get rid of any mind block that I have, I also run my VS in full screen mode to get rid of any remaining white so I can focus.
Call me old-skool, but I just like the default. I just can't get into the dark color-schemes.
i also like the default one.. i tryed the black theme once.. i didn't like it..
I use the defaults, except for setting the background to a slightly off-white(#FAFAFA). I find that it much less tiring on the eyes than a white background.
Modified Vibrant Jedi (basically orange on black with blue namespaces/classnames) with Droid Sans Mono. In Delphi I started off with the standard white, but tried Twilight when I thought the white was giving me eyestrain. I now much prefer dark or low contrast themes.
I don't like dark themes, so I created a theme inspirated in Github: http://studiostyl.es/schemes/like.
I just gray out the background color to be 215,215,215. Looks a little easy on eyes without much changes to the default theme. If you are working with a team and look at code at each others computer sometimes, it gets a little difficult to get used to a completely new theme. So I don't change mine too much. But if you're working alone, then will not matter.
I have the following installed:
Most important ones for me are
I am totally addicted to all three, but if I really had to choose the most important one, I'd go with ReSharper.
CodeRush with Refactor! Pro
http://www.devexpress.com/Products/Visual_Studio_Add-in/Coding_Assistance/
Does F# class as a VS addin? :)
In all seriousness, ViEmu is the only addin I use.
I use:
If anyone knows of a good native C++ refactoring tool that doesn't bring the system to a standstill all the time, please post it. Refactor! Pro isn't bad by itself but I can't get it to play nicely with R#. I found Visual Assist too slow even when it's the only plug-in installed.
For Visual Studio 2008 I'd say PowerCommands is a must have.
I also use VisualSVN for source control.
I agree with the R# comments and the agent smith plugin for that. It's not really a plugin, but VS without NUnit is like chocolate cake without icing!
This question covers around 30 add-ins that people disussed.
Simple but useful string-> resource refactoring: http://resourcerefactoring.codeplex.com/
Definitely Smart Paster
Comment and string spell checker from component one http://www.componentone.com/SuperProducts/IntelliSpell/. It's very fast and free!
Currently I use Git-Extensions, and before, i had been using AnkhSvn
An alternative for RockScroll. It fixes a few annoying issues such as region support.
See CodeHelper
http://www.bluemusa.com/codehelper/codehelper.htm
Does anyone have battle stories to share trying to use Visual Studio to develop applications for Unix? And I'm not talking using .NET with a Mono or Wine virtual platform running beneath.
Our company has about 20 developers all running Windows XP/Vista and developing primarily for Linux & Solaris. Until recently we all logged into a main Linux server and modified/built code the good old fashioned way: Emacs, Vi, dtpad - take your pick. Then someone said, "hey - we're living in the Dark Ages, we should be using an IDE".
So we tried out a few and decided that Visual Studio was the only one that would meet our performance needs (yes, I'm sure that IDE X is a very nice IDE, but we chose VS).
The problem is, how do you setup your environment to have the files available locally to VS, but also available to a build server? We settled with writing a Visual Studio plugin - it writes our files locally and to the build server whenever we hit "Save" and we have a bit fat "sync" button that we can push when our files change on the server side (for when we update to the latest files from our source control server).
The plugin also uses Visual Studio's external build system feature that ultimately just ssh's into the build server and calls our local "make" utility (which is Boost Build v2 - has great dependency checking, but is really slow to start as a result i.e. 30-60 seconds to begin). The results are piped back into Visual Studio so the developer can click on the error and be taken to the appropriate line of code (quite slick actually). The build server uses GCC and cross-compiles all of our Solaris builds.
But even after we've done all this, I can't help but sigh whenever I start to write code in Visual Studio. I click a file, start typing, and VS chugs to catch up with me.
Is there anything more annoying than having to stop and wait for your tools? Are the benefits worth the frustration?
Thoughts, stories, help?
VS chugs to catch up with me.
Hmmm ... you machine needs more memory & grunt. Never had performance problems with mine.
I've about a decade's experience doing exactly what you're proposing, most of it in the finance industry, developing real-time systems for customers in the banking, stock exchanges, stock brokerage niches.
Before proceeding further, I need to confess that all this was done in VS6 + CVS, and of late, SVN.
Source Code Versioning
Developers have separate sourcesafe repositories so that they can store their work and check it packages of work at logical milestones. When they feel they want to do an integration test, we run a script that checks it into SVN.
Once checked into SVN, we've a process that kicks off that will automatically generate relevant makefiles to compile them on the target machines for continuous integration.
We've another set of scripts that synchs new stuff from SVN to the folders that VS looks after. There's a bit of gap because VS can't automatically pick up new files; we usually handle that manually. This only happens regularly the first few days of the project.
That's an overview of how we maintain codes. I have to say, I've probably glossed over some details (let me know if you're interested).
Coding
From the coding aspect, we rely heavily on the pre-processors (i.e. #define, etc) and flags in the makefile to shape compilation process. For cross platform portability, we use GCC. A few times, we were force to use aCC on HP-UX and some other compilers, but we did not have much grief. The only thing that is a constant pain, is that we had to watch out for thread heap spaces across platforms. The compiler does not spare us from that.
Why?
The question is usually, "Why the h*ll would you even what to have such a complicated way of development?". Our answer is usually another question that goes, "Have you any clue how insane it is to debug a multi-threaded application by examining the core dump or using gdb?". Basically, the fact that we can trace/step through each line of code when you're debugging an obscure bug, makes it all worth the effort!
Plus!... VS's intellisense feature makes it so easy to find the method/attribute belonging to classes. I also heard the VS2008 has refactoring capabilities. I've shifted my focus to Java on Eclipse that has both features. You'd be more productive focusing coding business logic rather than devote energy making your mind do stuff like remember!
Also! ... We'd end up with a product that can run on both Windows and Linux!
Good luck!
I feel your pain. We have an application which is 'cross-platform'. A typical client/server application where the client needs to be able to run on windows and linux. Since our client base mostly uses windows we work using VS2008 (the debugger makes life a lot easier) - however we still need to perform linux builds.
The major problem with this was we were checking in code that we didn't know would build under gcc, which would more than likely break the CI stuff we had setup. So we installed MingGW on all our developer's machines which allows us to test that working copy will build under gcc before we commit it back to the repository.
We develop for Mac and PC. We just work locally in whatever ide we prefer, mostly VS but also xcode. When we feel our changes are stable enough for the build servers we check them in. The two build servers (Mac and PC) look for source control checkins, and each does a build. Build errors are emailed back to the team.
Editing files live on the build server sounds precarious to me. What happens if you request a build while another developer has edits that won't build?
I know this doesn't really answer your question, but you might want to consider setting up remote X sessions, and just run something like KDevelop, which, by the way, is a very nice IDE--or even Eclipse, which is more mainstream, and has a broader developer base. You could probably just use something like Xming as the X server on your Windows machines.
Network shares.
Of course, then you have killer lag on the network, but at least there's only one copy of your files.
You don't want to hear what I did when I was developing on both platforms. But you're going to: drag-n-drop copy a few times a day. Local build and run, and periodically checking it out on Unix to make sure gcc was happy and that the unit tests were happy on that platform too. Not really a rapid turnaround cycle there.
@monjardin
The main reason we use it is because of the re-factoring/search tools provided through Visual Assist X (by Whole Tomato). Although there are a number of other nice to haves like Intelli-sense. We are also investigating integrations with our other tools AccuRev, Bugzilla and Totalview to complete the environment.
@roo
Using multiple compilers sounds like a pain. We have the luxury of just sticking with gcc for all our platforms.
@josh
Yikes! That sounds like a great way to introduce errors! :-)
I've had good experience developing Playstation2 code in Visual Studio using gcc in cygwin. If you've got cygwin with gcc and glibc, it should be nearly identical to your target environments. The fact that you have to be portable across Solaris and Linux hints that cygwin should work just fine.
Most of my programming experience is in Windows and I'm a big fan of visual studio (especially with Resharper, if you happen to be doing C# coding). These days I've been writing an application for linux in C++. After trying all the IDEs (Netbeans, KDevelop, Eclipse CDT, etc), I found Netbeans to be the least crappy. For me, absolute minimum requirements are that I be able to single-step through code and that I have intellisense, with ideally some refactoring functions as well. It's amazing to me how today's linux IDE's are not even close to what Visual Studio 6 was over ten years ago. The biggest pain point right now is how slow and poorly implemented the intellisense in Netbeans is. It takes 2-3 seconds to populate on a fast machine with 8GB of RAM. Eclipse CDT's intellisense was even more laggy. I'm sorry, but a 2 second wait for intellisense doesn't cut it.
So now I'm looking into using VS from Windows, even though my only build target is linux...
Chris, you might want to look at the free automation build server 'CruiseControl', which integrates with all main source control systems (svn, tfs, sourcesafe, etc.). It's whole purpose is to react to check-ins in a source control system. In general, you configure it so that anytime anyone checks code in, a build is initiated and (ideally) unit tests are run. For some languages there are some great plugins that do code analysis, measure unit test code coverage, etc. Notifications are sent back to the team about successful / broken builds. Here's a post describing how it can be set up for C++: link (thoughtworks.org).
I'm just getting started with converting from a linux-only simple config (Netbeans + SVN, with no build automation) to using Windows VS 2008 with build automation back-end that runs unit tests in addition to doing builds in linux. I shudder at the amount of time it's going to take me to get that all configured, but the sooner the better, I guess.
In my ideal end-state I'll be able to auto-generate the Netbeans project file from the VS project, so that when I need to debug something in linux I can do so from that IDE. VS project files are XML-based, so that shouldn't be too hard.
If anyone has any pointers for any of this, I'd really appreciate it.
Thanks,
Christophe
Wow, that sounds like a really strange use for Visual Studio. I'm very happy chugging away in vim. However, the one thing I love about Visual Studio is the debugger. It sounds like you are not even using it.
When I opened the question I thought you must be referring to developing portable applications in Visual Studio and then migrating them to Solaris. I have done this and had pleasant experiences with it.
We are using a similar solution to what you described.
We have our code stored on the Windows side of the world and UNIX (QNX 4.25 to be exact) has access though an NFS mount (thanks to UNIX services for Windows). We have an ssh into UNIX to run make and the pipe to output into VS. Accessing the code is fast, builds are a little slower than before, but our longest compile is currently less than two minutes, not a big deal.
Using VS for UNIX development has been worth the effort to set it up, because we now have IntelliSense. Less typing = happy developer.
You could have developers work in private branches (easier if you're using a DVCS). Then, when you want to checkin some code, you check it into your private branch on [windows|unix], update your sandbox on [unix|windows] and build/test before committing back to the main branch.
Check out "Final Builder" (http://www.finalbuilder.com/). Select a version control system (e.g. cvs or svn, to be honest, cvs would suit this particular use case better by the sounds of it) and then set up build triggers on FinalBuilder so that checkins cause a compile and send the results back to you.
You can set up rulesets in FinalBuilder that prevent you checking in / merging broken code into the baseline or certain branch folders but allow it to others (we don't allow broken commits to /baseline or /branches/*, but we have a /wip/ branching folder for devs who need to share potentially broken code or just want to be able to commit at the end of the day).
You can distribuite FB over multiple "build servers" so that you don't wind up with 20 people trying to build on one box, or waiting for one box to process all the little bitty commits.
Our project has a Linux-based server with Mac and Win clients, all sharing a common codebase. This set up works ridiculously well for us.
Does anyone have any recommendations of tools that can be of assistance with moving literal values into resource files for localization?
I've used a resharper plugin called RGreatX but was wondering if there is anything else out there.
It's one heck of a long manual process for moving the strings across and think there must be a better way! RGreatX is OK but could be a bit slicker I feel.
Here's one:
http://www.codeplex.com/ResourceRefactoring
It'a actually a Microsoft "open source" Visual Studio(2005 and up) tool that integrates with the IDE. You can easily replace every occurence of a string with a ressource reference with a few clicks.
You may find Zeta Resource Editor useful too.
ReSharper itself (5.0+) now has support for localization which includes moving strings to resource files and highlighting localizabile strings.
What are some macros that you have found useful in Visual Studio for code manipulation and automation? Since good code can be useful in all languages, this question is not language specific.
The best is the if snippet in C#
if -> Just hit tab twice and you get
if(true)
{
}
Also works with the while loop, for loop, foreach loop. There is a good property one.
Here is a snippet I wrote for ViewState properties.
<CodeSnippets xmlns="http://schemas.microsoft.com/VisualStudio/2005/CodeSnippet">
<CodeSnippet Format="1.0.0">
<Header>
<Title>Generic Property - View State</Title>
<Description>Inserts a Generic Property</Description>
<Author>David Basarab</Author>
<Shortcut>property_ViewState</Shortcut>
<SnippetTypes>
<SnippetType>Expansion</SnippetType>
</SnippetTypes>
</Header>
<Snippet>
<Declarations>
<Literal Editable="true">
<ID>PropertyName</ID>
<Default>PropertyName</Default>
<ToolTip>Replace this with the name of the Property.</ToolTip>
</Literal>
<Literal Editable="true">
<ID>Type</ID>
<Default>string</Default>
<ToolTip>Replace this with the type of the Property.</ToolTip>
</Literal>
<Literal Editable="true">
<ID>DefaultValue</ID>
<Default>string.Empty</Default>
<ToolTip>Replace this with the default value of the Property.</ToolTip>
</Literal>
</Declarations>
<Code Language="CSharp">
<![CDATA[#region $PropertyName$
public $Type$ $PropertyName$
{
get
{
if (this.ViewState["$PropertyName$"] == null)
return $DefaultValue$;
return ($Type$)this.ViewState["$PropertyName$"];
}
set { this.ViewState["$PropertyName$"] = value; }
}
#endregion]]>
</Code>
</Snippet>
</CodeSnippet>
</CodeSnippets>
Update: There is a VS2008 extension called Snippet Designer (mentioned here) that allows you to edit/add/manage snippets in the visual studio editor.
Mostly I use snippets in my C# coding, but I have found property snippets to be very useful and time-saving.
Caveat: You may not like the variable naming/indentation, etc. but rather than start a religious war in an otherwise peaceful question, remember that its easy to tweak these snippets for your own, custom conventions.
Streamlined "prop" snippet
Visual Studio comes pre-equipped with a "prop" snippet, but it makes you enter four fields (name and type of both the property and backing field). I found that in many cases, two entries was fine. Further more, the default "prop" had some weird indention stuff going on. (Isn't the point to MINIMIZE keystrokes?) So I customized and updated the snippet:
If you use this, you will probably want to back up your existing "prop" snippet either by renaming it in its .snippet file or moving to another directory. Otherwise you will get two "prop" entries in the VS UI.
"prop_databound" snippet
In order for .NET databinding to go smoothly, having a "Changed" event is recommended. Many controls will use this to notify your properties value has updated. However, its a tedious process to generate this for each public property. "prop_databound" creates the property, backing field, event, and a function for manually triggering the event. You may not need/use all of that at once, but its easier to delete a section than it is to type it all!
"prop_lazy" snippet
I threw this in as well...This is just a property with lazy instantiation, i.e. the backing field does not allocate an object until its first use. This can be useful in certain scenarios.
Edit: Heh. My lazy example screenshot was so lazy that it ignored the fact that there is no default constructor for
Console.
Snippet XML
<?xml version="1.0" encoding="utf-8" ?>
<CodeSnippets xmlns="http://schemas.microsoft.com/VisualStudio/2005/CodeSnippet">
<CodeSnippet Format="1.0.0">
<Header>
<Title>prop_databound</Title>
<Shortcut>prop_databound</Shortcut>
<Description>Code snippet for property, backing field, and databinding event</Description>
<Author>ee from www.devfuel.com</Author>
<SnippetTypes>
<SnippetType>Expansion</SnippetType>
</SnippetTypes>
</Header>
<Snippet>
<Declarations>
<Literal>
<ID>type</ID>
<ToolTip>Property type</ToolTip>
<Default>int</Default>
</Literal>
<Literal>
<ID>field</ID>
<ToolTip>The variable backing this property</ToolTip>
<Default>myVar</Default>
</Literal>
</Declarations>
<Code Language="csharp"><![CDATA[private $type$ m_$field$;
public $type$ $field$
{
get { return m_$field$;}
set
{
if (value != m_$field$)
{
m_$field$ = value;
On$field$Changed(EventArgs.Empty);
}
}
}
public event EventHandler $field$Changed;
protected virtual void On$field$Changed(EventArgs e)
I use this one alot:
Right Click -> Insert Code Snippet
Select -> Common Code Patterns
Select -> Conditionals And Loops
Select -> If .. End If Statement
What this allows you do, is only execute some code if something (a variable or expression or whatever) is true, or false, or greater than something. It's pretty handy.
asnn as a snippet bound to Debug.Assert( [object] != null );
Anything else like that
Dispose pattern
///<summary>Releases unmanaged resources and performs other cleanup operations before the ClassName is reclaimed by garbage collection.</summary>
~ClassName() { Dispose(false); }
///<summary>Releases all resources used by the ClassName.</summary>
public void Dispose() { Dispose(true); GC.SuppressFinalize(this); }
///<summary>Releases the unmanaged resources used by the ClassName and optionally releases the managed resources.</summary>
///<param name="disposing">true to release both managed and unmanaged resources; false to release only unmanaged resources.</param>
protected virtual void Dispose(bool disposing) {
if (disposing) {
}
}
Event definition
Includes special versions for EventHandler and PropertyChangedEventHandler
///<summary>Occurs when ....</summary>
public event EventHandler<MyEventArgs> MyEvent;
///<summary>Raises the MyEvent event.</summary>
///<param name="e">A MyEventArgs object that provides the event data.</param>
internal protected virtual void OnMyEvent(MyEventArgs e) {
if (MyEvent != null)
MyEvent(this, e);
}
Dispose Source
<?xml version="1.0" encoding="utf-8" ?>
<CodeSnippets xmlns="http://schemas.microsoft.com/VisualStudio/2005/CodeSnippet">
<CodeSnippet Format="1.0.0">
<Header>
<Title>Dispose pattern</Title>
<Shortcut>dispose</Shortcut>
<Description>Code snippet for virtual dispose pattern</Description>
<Author>SLaks</Author>
<SnippetTypes>
<SnippetType>Expansion</SnippetType>
<SnippetType>SurroundsWith</SnippetType>
</SnippetTypes>
</Header>
<Snippet>
<Declarations>
<Literal Editable="false">
<ID>classname</ID>
<ToolTip>Class name</ToolTip>
<Default>ClassNamePlaceholder</Default>
<Function>ClassName()</Function>
</Literal>
</Declarations>
<Code Language="csharp">
<![CDATA[
///<summary>Releases unmanaged resources and performs other cleanup operations before the $classname$ is reclaimed by garbage collection.</summary>
~$classname$() { Dispose(false); }
///<summary>Releases all resources used by the $classname$.</summary>
public void Dispose() { Dispose(true); GC.SuppressFinalize(this); }
///<summary>Releases the unmanaged resources used by the $classname$ and optionally releases the managed resources.</summary>
///<param name="disposing">true to release both managed and unmanaged resources; false to release only unmanaged resources.</param>
protected virtual void Dispose(bool disposing) {
if (disposing) {
$end$$selected$
}
}]]>
</Code>
</Snippet>
</CodeSnippet>
</CodeSnippets>
Event Source
<?xml version="1.0" encoding="utf-8" ?>
<CodeSnippets xmlns="http://schemas.microsoft.com/VisualStudio/2005/CodeSnippet">
<CodeSnippet Format="1.0.0">
<Header>
<Title>Typed Event</Title>
<Shortcut>event</Shortcut>
<Description>Code snippet for event and raiser with custom EventArgs type</Description>
<Author>SLaks</Author>
<SnippetTypes>
<SnippetType>Expansion</SnippetType>
</SnippetTypes>
</Header>
<Snippet>
<Declarations>
<Literal>
<ID>type</ID>
<ToolTip>EventArgs type</ToolTip>
<Default>My</Default>
</Literal>
<Literal>
<ID>event</ID>
<ToolTip>Event name</ToolTip>
<Default>MyEvent</Default>
</Literal>
<Literal>
<ID>desc</ID>
<ToolTip>Event description</ToolTip>
<Default>...</Default>
</Literal>
<Literal>
<ID>n</ID>
<ToolTip>n</ToolTip>
<Default></Default>
</Literal>
</Declarations>
<Code Language="csharp"><![CDATA[///<summary>Occurs when $desc$.</summary>
public event EventHandler<$type$EventArgs> $event$;
///<summary>Raises the $event$ event.</summary>
///<param name="e">A$n$ $type$EventArgs object that provides the event data.</param>
internal protected virtual void On$event$($type$EventArgs e) {
if ($event$ != null)
$event$(this, e);
}
$end$]]></Code>
</Snippet>
</CodeSnippet>
<CodeSnippet Format="1.0.0">
<Header>
<Title>Event</Title>
<Shortcut>event</Shortcut>
<Description>Code snippet for event and raiser</Description>
<Author>SLaks</Author>
<SnippetTypes>
<SnippetType>Expansion</SnippetType>
</SnippetTypes>
</Header>
<Snippet>
<Declarations>
<Literal>
<ID>event</ID>
<ToolTip>Event name</ToolTip>
<Default>MyEvent</Default>
</Literal>
<Literal>
<ID>desc</ID>
<ToolTip>Event description</ToolTip>
<Default>...</Default>
</Literal>
</Declarations>
<Code Language="csharp"><![CDATA[///<summary>Occurs when $desc$.</summary>
public event EventHandler $event$;
///<summary>Raises the $event$ event.</summary>
internal protected virtual void On$event$() { On$event$(EventArgs.Empty); }
///<summary>Raises the $event$ event.</summary>
///<param name="e">An EventArgs object that provides the event data.</param>
internal protected virtual void On$event$(EventArgs e) {
if ($event$ != null)
$event$(this, e);
}
$end$]]></Code>
</Snippet>
</CodeSnippet>
<CodeSnippet Format="1.0.0">
<Header>
<Title>PropertyChanged Event</Title>
<Shortcut>event</Shortcut>
<Description>Code snippet for PropertyChanged event and raiser</Description>
<Author>SLaks</Author>
<SnippetTypes>
<SnippetType>Expansion</SnippetType>
</SnippetTypes>
</Header>
<Snippet>
<Declarations>
<Literal>
<ID>event</ID>
<ToolTip>Event name</ToolTip>
<Default>MyEvent</Default>
</Literal>
<Literal>
<ID>desc</ID>
<ToolTip>Event description</ToolTip>
<Default>...</Default>
</Literal>
</Declarations>
<Code Language="csharp"><![CDATA[///<summary>Occurs when a property value is changed.</summary>
public event PropertyChangedEventHandler PropertyChanged;
///<summary>Raises the PropertyChanged event.</summary>
///<param name="name">The name of the property that changed.</param>
internal protected virtual void OnPropertyChanged(string name) { OnPropertyChanged(new PropertyChangedEventArgs(name)); }
///<summary>Raises the PropertyChanged event.</summary>
///<param name="e">An EventArgs object that provides the event data.</param>
internal protected virtual void OnPropertyChanged(PropertyChangedEventArgs e) {
if (PropertyChanged != null)
PropertyChanged(this, e);
}
$end$]]></Code>
</Snippet>
</CodeSnippet>
</CodeSnippets>
Heh, i have the same kind of code snippet for the viewstate property, which i use while developping in vb.net
<?xml version="1.0"?>
<CodeSnippets xmlns="http://schemas.microsoft.com/VisualStudio/2005/CodeSnippet">
<CodeSnippet Format="1.0.0">
<Header>
<Title>ViewState property</Title>
<Author>SB</Author>
<Description>Add data in the viewstate simply. </Description>
<Shortcut>vprop</Shortcut>
</Header>
<Snippet>
<Declarations>
<Literal>
<ID>PropertyType</ID>
<ToolTip>Type of the object</ToolTip>
<Default>Integer</Default>
</Literal>
<Literal>
<ID>PropertyName</ID>
<Type>String</Type>
<ToolTip>Name of property</ToolTip>
<Default>ViewStateProperty</Default>
</Literal>
</Declarations>
<Code Language="VB"><![CDATA[Private $PropertyName$Default as $PropertyType$ '=
Public Property $PropertyName$() as $PropertyType$
Get
Dim obj as Object = ViewState("$PropertyName$")
if (obj isnot Nothing)
return DirectCast(obj, $PropertyType$)
end if
return $PropertyName$Default
End Get
Set(ByVal value As $PropertyType$)
ViewState("$PropertyName$") = value
End Set
End Property
]]></Code>
</Snippet>
</CodeSnippet>
</CodeSnippets>
I discovered these powerful tools only recently; for me, their use through shortcuts is really useful.
As a matter of fact, i think in future projects i will go as far as abstracting parts of the framework i'll be working with into snippets, assign them meaningful names and distribute them to the team; on the other hand, i could lead to code repetition, things that could be better handled by factoring the code...
Memory Jogging : IComparable.CompareTo
Every so often there are certain interfaces and overrides that need to repeatedly happen. In my current project, IComparable.CompareTo() is one of them. Since i found myself repeatedly typing it in, and reminding myself of the correct default behavior, i realized this was a perfect candidate for a snippet:
![compareto_snippet]()
Snippet Code
<?xml version="1.0" encoding="utf-8"?>
<CodeSnippets xmlns="http://schemas.microsoft.com/VisualStudio/2005/CodeSnippet">
<CodeSnippet Format="1.0.0">
<Header>
<SnippetTypes>
<SnippetType>Expansion</SnippetType>
</SnippetTypes>
<Title>compareto</Title>
<Author>ee of http://www.devfuel.com</Author>
<Description>
A quick and dirty CompareTo implementation
</Description>
<HelpUrl>
</HelpUrl>
<Shortcut>
compareto
</Shortcut>
</Header>
<Snippet>
<Declarations>
<Literal Editable="true">
<ID>ThisType</ID>
<ToolTip>The local type</ToolTip>
<Default>ThisType</Default>
<Function>
</Function>
</Literal>
</Declarations>
<Code Language="csharp"><![CDATA[public int CompareTo(object obj)
{
$ThisType$ rhs = obj as $ThisType$;
if (rhs != null)
{
//return this.Member.CompareTo(rhs.Member);
return 0;$end$
}
else
{
throw new ArgumentException("object is not of type $ThisType$");
}
}]]></Code>
</Snippet>
</CodeSnippet>
</CodeSnippets>
I modify the existing class snippet to include sealed per default, because that is much more sensible to me. Types should be designed specifically for inheritance - if they are not, they should be sealed imo.
The following is a snippet that I tend to use a lot in applications that use ODP.NET
<?xml version="1.0" encoding="UTF-8"?>
<CodeSnippets xmlns="http://schemas.microsoft.com/VisualStudio/2005/CodeSnippet">
<CodeSnippet Format="1.0.0">
<Header>
<Title>ODP.NET Stub</Title>
<Author>Rob (http://stackoverflow.com/users/1185/rob)</Author>
<Description>Inserts common Oracle code</Description>
<Shortcut>csoraclestub</Shortcut>
<HelpUrl></HelpUrl>
</Header>
<Snippet>
<Imports>
<Import>
<Namespace>Oracle.DataAccess.Client</Namespace>
</Import>
</Imports>
<Code Language="CSharp">
<![CDATA[
OracleConnection oraConnection = null;
OracleCommand oraCommand = null;
OracleDataReader oraData = null;
try
{
// Connect to the database
// Prepare and run the query
oraCommand.BindByName = true;
}
catch (OracleException ex)
{
// TODO
}
catch (Exception ex)
{
// TODO
}
finally
{
// Perform a safe cleanup
if (oraData != null) { oraData.Dispose(); }
if (oraCommand != null) { oraCommand.Dispose(); }
if (oraConnection != null) { oraConnection.Dispose(); }
}
]]>
</Code>
</Snippet>
</CodeSnippet>
</CodeSnippets>
ASP.NET Web Site or Web Project
Score: 13 - jdiaz (2008-08-14) [asp.net], [visual-studio], [projects-and-solutions] When creating a new ASP.NET project in Visual Studio should I chose create: website or project?
I understand that web application project was the way to do it back in the day with VS 2003 but is it still applicable today? What are some of the caveats using one over the other?
Score: 25* - Jon Galloway (2008-08-14) There's a pretty good comparison chart on MSDN.
Website projects are simple, in that all files added to the project folders are automatically compiled and included, which was supposedly added to make it more palatable to classic ASP and PHP developers. Once benefit is that it includes build providers, which allow for certain actions to be associated with a filetype - that's how the first release of SubSonic would rebuild the data access layer when you added a .abp file to the site.
Web Application Projects are a lot more flexible, though. For instance, all class libraries in a Website Project need to be in the App_Code folder, which is frustrating in a complex application. There are a lot of scenarios which just don't work for a Website Project.
You can convert from one to another, although if you're unsure I'd recommend just starting with a Web Application.
Score: 2 - John Saunders (2009-05-04) I strongly disagree with some of what the Websites and Web Projects article says.
First, it wasn't any "small" group of developers who rebelled - I'd suggest it was most of us, who had not been asked if we wanted to totally change the way we developed. They certainly didn't ask me if I wanted to lose six weeks of development time figuring out what they did to break a perfectly good web service.
It wasn't some "download" MS released - it was VS2005 SP1, and they released it pretty damned fast.
In their plusses for projectless development, the "Copy Project" command works very well, and we don't have to avoid debug or project files; you can move pages around - if you don't use source control; where do they get that you have to lock the project files in order to collaborate? What are they using for source control?
I'd also add one question to the debate: what's so special about web sites that they should be the only "project" type (as far as I know) that doesn't use a "project" file? I can't think of anything, unless it's that Microsoft thought that web developers were too simpleminded to understand projects.
Of course, if anyone knows of any other Visual Studio "project" type that does not use a project file, I'd be grateful to be informed of it.
Score: 1 - Keith (2008-08-14) The website mode was added for confused Interdev users ;-)
There is a certain ease of maintenance having the location and the project be the same thing, but for things like external assembly referencing it makes things more complicated.
It's no longer the default - MS seem to have gone back to projects. Personally I prefer the project mode.
Score: 1 - Rob Cooper (2008-08-14) People have already covered all the major angles here.. I find Web Apps to be useful for those "quick and dirty" apps.. Proof-of-concept code etc..
I tend to almost do "Web Project" on autopilot now :)
Score: 0 - Michael Stum (2008-08-14) Keep in mind one of the most compelling features of Web Projects: SVN Integration, which is simply not properly possible with Web Sites.
Score: 0 - Biri (2008-08-14) I prefer web applications for two reason:
- SVN or VSS integration
- XML based developer help generating
Score: 0 - Adam (2008-08-26) can someone edit this post to tag it so its actually searchable?
Score: 0 - Amr ElGarhy (2009-05-04) Some details from Apress ? Pro ASP.NET 3.5 in C# 2008 Second Edition
Visual Studio Optimizations
Score: 403 - lomaxx (2008-08-12) [.net], [visual-studio], [ide] Visual studio is a pretty awesome IDE, but sometimes you just wish it would go faster. I was wondering if people have any tips or tricks to help speed up visual studio in day to day use.
Things that I'm particularly interested in are speeding up build times and switching aspx files from source to design view seem to bring it to a grinding halt.
Having said that, I'd be keen to hear anything that anyone uses to make VS run that little bit faster.
Edit: Merged answers from related question, covering VS2008SP1. Please include any optimisations specific to the latest IDE.
Score: 351* - jfs (2008-08-12) Here's my list. All of these can be accessed on Tools->Options menu:
- Disable F1. (Environment->Keyboard) This is probably the best advice that I found somewhere.
- Disable "Animate environment tools" (Environment->General).
- Disable Start Page (Environment->Startup).
- Disable "Track Active Item in Solution Explorer" (Projects and Solutions).
- Disable Navigation Bar (Text Editor->C#). I think this is available for every language.
- Set "AutoToolboxPopulate" to false (Windows Forms Designer).
- You can set the Code view as the default view when viewing Windows Forms. Just right-click on the cs file and select "Open With...".
- Open Visual Studio using the command line (devenv) rather than using the Start menu. I don't know why but I notice it loads faster.
- Turn off Track Changes. (Text Editor->Track changes)
Basically I just customized John Lam's settings. It's very minimal.
Last Resort:
- Reset all settings (Tools->Import and Export Settings->Reset All Settings)
Related articles:
- Optimizing ASP.NET 2.0 Web Project Build Performance with VS 2005
- Hard Drive Speed and Visual Studio Performance
- Speed up Visual Studio 2005
- Optimize the launch of the Visual Studio 2005
@Orion Edwards:
I agree. Snippets are really a time saver. Actually there's a snippet editor that you can use and I'm using it for a while now. You can find it here.
Score: 49 - Dan Mitchell (2008-08-27) I use keyboard macros (control-shift-R) to get repetitive tasks done; you have to get the knack of it at first, but once you do, you can do a lot of stuff pretty quickly. For instance, you have:
DoStuff(1,2,"foo");
DoStuff(3,4,"bar");
DoStuff(123,123421,"baz");
... and so on for many lines, and you want to insert 'true' between the first and second arguments.
Put cursor at the start of the first line, then:
control-shift-R [start recording]
control-F [open 'find' dialog]
, enter esc [go to the next comma, close the find dialog]
type 'true,' [new text]
down, home [go to the start of the next line, so you're where you started]
control-shift-R [stop recording]
now you can just hit control-shift-P many times and it'll do that set of steps over and over again.
That's a simple example; you can do a lot of refactoring-like stuff pretty quickly this way, but it's also handy for wrangling big chunks of text for manual batch operations or whatever.
I'm sure if I learned how to do regexp search/replace, I could do the same sorts of things that way, but I got into this habit from using Brief a long while ago and I've stuck with thinking about "doing tasks the way I do them by hand", rather than turning them into regexps.
(presumably refactoring tools could do that particular operation, but I'm in C++ and none of them work very well there)
Other things:
- CommentReflower is a great add-in if you tend to write big chunks of comment; the original's here, and there's a VS2008 port here.
- control-K control-F -> automatically re-indent code, useful when things have got messy.
- If you need to make the same change to a bunch of project settings, don't forget you can do find-and-replace-in-files on .vsproj files.
Score: 47 - Charles Anderson (2008-09-17) You can improve the speed at which Visual Studio starts up by using the '/nosplash' option. Bring up the Properties of your Visual Studio shortcut, change to the Shortcut tab and amend the Target field as follows:
"C:\Program Files\Microsoft Visual Studio 8\Common7\IDE\devenv.exe" /nosplash
Score: 28 - norheim.se (2008-09-25) I have a couple of recommendations regarding the build speed for Visual Studio 2008, related to the copying of files that occurs during the build.
Apart from the obvious recommendation of keeping the solution files small:
Defragment your hard drive
Disk performance is vital to the build speed. A daily, or at least, weekly defragmentation will facilitate this. If possible, schedule a nightly fragmentation to be performed automatically. Also, make sure you have plenty of room on the disk. The less space that is available, the fewer choises are available to the file system when deciding how to layout the files on the disk, and the faster the entropy on your disk will increase. Do you have several Source Control branches of your code checked out - why not delete the binaries from the old ones? You are likely to recompile them when you get back to working on those branches anyway.
Avoid Unnecessary File Replication
The standard setup for .NET solutions is that each assembly gets its own bin directory to which it is copied along with the assemblies of all its dependencies. If your solution contains an .EXE file and, say, 40 different assemblies. Does it really make sense to copy the dependencies of each assembly to each separate build directory? The target directory of the EXE should be enough. Another way to accomplish roughly the same would be to give the assemblies common output directories. That also avoids the copying. Some earlier versions of Visual Studio did not support this well, so be careful. I have, however, been using this approach with VS2008 for quite a while without noticing any problems.
Disable System Restore (Windows XP ONLY)
The implementation of System Restore in Windows XP actually creates backups of every DLL in the system every time they are modified. As compiling a .NET solution involves copying and overwriting many DLLs, this is assumed to impede performance. Windows Vista and Windows Server 2003 does not suffer from this problem. If you keep your source files on a separate logical drive, you can disable system restore for that particular drive and keep it enabled on your system disk.
Score: 28 - Nicholas (2009-02-02) One of the best enhancements I've found is to disable the onaccess scan of your anti-virus for the folder where your projects reside. Every time I did a build the IO of the virus checker decreased the speed.
Score: 21 - HidekiAI (2008-09-18) My experiences are more for C++ than C#, but here goes... I'm taking "Optimizations" in an ambiguous term on multiple views (code optimizations, IDE speed up, compilation speed up), but they are all specific to Visual Studio environment.
- For optimizations in code, have the compiler optimize by size rather than speed, not sure where I've heard this but someone once told me Microsoft compiles all their applications this way as well. Whether it is a myth or not, to me at least it makes sense (in most generic cases) because smaller code called often will have less cache miss. This is more for C++ than CLR based languages. Alternatively, if you know your target platform, you can probably target that rather than generic x86.
- For speeding up in Visual Studio, I've noticed that if I have break-points view showing, it keeps flashing, as if it is updating over and over, so I hide it. Perhaps it is just me (and psychological).
- For speeding up compilations, on one of the projects, it used to spew 1000+ warnings (it's a project mixed with C# and C++), and it used to take 20 minutes to compile (all the warnings was because of this). The point here is, having a lot of messages serialized to output causes slowdown, so pay attention to first sign of your warnings and fix it. I'd also imagine that Visual Studio's "Error List" panel has to collect the Warnings and Errors into that view, which causes extra slowdown when you have large amount of warnings.
- Another speed-up for compilations, as somebody as mentioned, is Xoreax's IncrediBuild. But they don't work on C# (yet), only on Managed/Unmanaged C++. I used to be skeptical about distributed compilation because of my experiences with distcc, but it was because all my PC's at home are different speed, a heterogeneous distribution. At work, because of the homogeneous structure where all have similar speed, it works better. Also, distributed computing is only useful when you have machines to distribute to (* grin *) Somebody also mentioned Visual Studio's parallel compiling option (if you have multi-processors, you've probably seen messages while compiling of "1> Compling Proj1", "2> Compiling Proj2" (or something like that), where Visual Studio will compile N projects (where N = number of processors you define in your options). Unlike IncrediBuild, VS distributes by projects rather than by files, and this is only useful if you have multiple projects in single .SLN.
- Another speed-up for compilations, some have mentioned increasing memory, although that would probably help, from my experiences, a faster drive is more beneficial than memory. I've seen 2 (similar performance) PC's compile the same exact projects side-by-side, one with faster drive than another, and the gain is significant. Bottlenecked on file I/O writing the .OBJ file or seeking for .cpp file, you get the picture. Back in the old-days, we used to output all the .OBJ files to RAM drives instead of hard-drives and that sped up a lot. But today, projects are probably too large to fit in a RAM drive or the performance of drive is so much better that it's not significant to do this.
- For speeding up in Visual Studio for debugging, if you don't need it, don't include the symbols from Microsoft and you'll notice that your debugger loads faster into your applications.
I will edit/add more as I think of it.
Score: 19 - Gareth D (2008-09-22) Ensure 'Only build startup projects and dependencies on Run' is selected.
This option can be found under Tools -> Options... -> Projects and Solutions -> Build and Run.
For large solutions this can save a significant amount of time.
NB it's propbably best practice to avoid very large solutions, but if you are forced to work with one then this can make all the difference.
Score: 13 - Lars Mæhlum (2008-08-12) Increasing the speed of Visual Studio?
Why not instead increase you efficiency with the tool instead?
I use ReSharper at all times when programming in C#, and though it will slow down VS pretty bad, I still code way faster with it..
But I am very exited about the supposed performance gains in Vs 2008 Sp 1. 2008/2005 was an enormous performance boost, and I hope they can keep it up.
Score: 13 - Ben (2010-10-22) From my empirical testing, Visual Studio experiences an inverse linear relationship between UI responsiveness and number of projects "loaded". When I say "Visual Studio", I really mean "Visual Studio and ReSharper", because AFAIK most people work with ReSharper or a similar tool installed. I do not know if this slowdown is seen without ReSharper.
Reducing the project count is not always possible or desirable. However, unloading projects you are not currently working on mitigates the performance issue. BUT, doing so can break the build from with Visual Studio and/ or cause problems to be hidden when you make a change that affects an unloaded project.
THE SOLUTION: "unload" all projects you are not working on (or as many as is needed for performance to be tolerable) and perform builds from the command line, using the multi processor option.
This approach ensures Visual Studio remains responsive and useful, whilst at the same time a full compilation is performed.
This sounds like a very simple solution, and it is - but it can have a HUGE impact on productivity.
In summary - for large solutions use visual studio as a plain-old text editor and leave the compilation heavy lifting to MSBuild, invoked externally from the command line.
Score: 11 - Alex (2009-11-18) Life Changing XAML Editing Tip
If you get annoyed at VS hanging for a few seconds when you try and edit XAML the following link will improve things no end. It works so well I dont really understand why its not the default behaviour.
http://weblogs.asp.net/fmarguerie/archive/2009/01/29/life-changer-xaml-tip-for-visual-studio.aspx
Score: 11 - jvenema (2010-05-31) Empty your Recycle Bin.
Score: 11 - Martin S. (2010-10-06) Also: turn off HTML and CSS validation, making it easier to spot the actual errors in the Error list.
Under Tools -> Options -> Text Editor
- Turn off HTML validation: HTML -> Validation -> Untick 'Show errors'
- Turn off CSS validation: CSS -> Miscellaneous -> Untick 'Detect errors'.
(Use Firefox's HTML Validator instead, or similar)
Score: 10 - Orion Edwards (2008-08-12) This is not related to performance of the IDE (buying more ram and an SSD goes a long way towards that), but to the performance of you (ie: your personal productivity).
Learn about and use snippets, and the advanced text editor shortcuts.
Once you learn to use the snippets in e-texteditor and textmate, you'll never want to code without them, and VS 2005/8 can support snippets.
Unfortunately, the Microsoft Snippet syntax is verbose and crappy (XML!), and there's no inbuilt-editor, you have to roll the .snippet xml files yourself and import them, but it's still well worth doing.
For example I have a snippet asnn which expands to Debug.Assert( [object] != null );
That alone has made it noticeably nicer to use
I also have Ctrl+Shift+k bound to Edit.LineDelete and Shift+Enter bound to Edit.LineOpenBelow - mimicking E/Textmate. Those are awesome.
Score: 10 - The How-To Geek (2008-08-12) I find that if you are using a solution with a ton of files, the detection for file changes slows things down, especially if you are editing files on a shared folder. This doesn't work as well if you use a command-line source control system, of course.
- Environment \ Documents \ "Detect when file is changed outside the environment"
Note that the same setting exists in almost all editors, and makes a big difference when editing files on a share.
Score: 9 - Owen (2008-09-06) One thing that can speed things up significantly is turning off IntelliSense. Of course that will probably slow you down. But at my office we use VisualAssist, which albeit isn't free, but is better in a number of ways.
In any case, IntelliSense can't be disabled with a dialog box checkbox (as far as I know) but the process is pretty straightforward:
- Close VS.
- Remove the .ncb file next to the .sln file for any solution you work with.
- Delete or rename the file
C:\Program Files\Microsoft Visual Studio 9.0\VC\vcpackages\feacp.dll. (The 9.0 part of the path will be different for versions other than VS2008.) - (optional) Install some IntelliSense alternative like VisualAssist, or prepare to do a lot more typing.
Score: 8 - Matt Dillard (2008-08-28) If you are working with a team of developers, check out Incredibuild by Xoreax (or as we used to refer to them, "Planet Xoreax"). It very seamlessly sets up distributed compilation in Visual Studio. I used this at a past place of employment and it cut our build times from 40 minutes down to around 7 minutes.
Getting Incredibuild set up truly changed the way I went about my work - I was actually able to get a streamlined code-compile-test cycle going.
Score: 7 - opadilla (2009-06-03) Try running your Windows machine using /3GB mode and making Visual Studio large address aware. Your IDE will have more RAM available to it and run much faster.
Refer to this link for reference and how-to:
Score: 7 - RHaguiuda (2010-04-22) This is not a Visual Studio enhancement, but Windows enhancement.
There is a tiny tool called KatMouse that I cannot live without. KatMouse make any window or component scroll without focus, when mouse pointer is over it and mouse wheel is used. So you don`t have to click the window or component to set focus and then scroll, you can just point mouse over it and scroll.
Very useful for programmers of course!
However, this does not work in Visual Studio 2010 as they have a custom window management.
Score: 6 - Bit Destroyer (2009-11-09) Something that has saved me a few seconds here and there is a macro I found a while back that allows you to attach to the aspnet_wp.exe process for debugging. This way the IDE doesn't launch a new browser/tab every time you hit run or F5. This can be annoying if you're deep within a project and launching at the project start up page isn't beneficial. There are probably other ways to do this but binding the 'AttachToWebServer' macro below to a keyboard shortcut has served me well.
Public Sub AttachToWebServer()
Dim AspNetWp As String = "aspnet_wp.exe"
Dim W3WP As String = "w3wp.exe"
If Not (AttachToProcess(AspNetWp)) Then
If Not AttachToProcess(W3WP) Then
System.Windows.Forms.MessageBox.Show(String.Format("Process {0} or {1} Cannot Be Found", AspNetWp, W3WP), "Attach To Web Server Macro")
End If
End If
End Sub
Public Function AttachToProcess(ByVal ProcessName As String) As Boolean
Dim Processes As EnvDTE.Processes = DTE.Debugger.LocalProcesses
Dim Process As EnvDTE.Process
Dim ProcessFound As Boolean = False
For Each Process In Processes
If (Process.Name.Substring(Process.Name.LastIndexOf("\") + 1) = ProcessName) Then
Process.Attach()
ProcessFound = True
End If
Next
AttachToProcess = ProcessFound
End Function
Also, the code highlighting above is dieing on the backslash in the LastIndexOf method but the code is accurate, pasted directly from my macro editor.
Score: 5 - Christian Hagelid (2008-08-12) if you are using Visual Studio 2008 then I recommend downloading the newly released SP1. - http://msdn.microsoft.com/en-gb/vstudio/cc533448.aspx
Among other things it is meant to increase the speed of switching to design view - http://blogs.msdn.com/webdevtools/archive/2008/06/18/faster-switch-to-design-view-in-vs-2008-sp1-rtm.aspx
other updates: http://blogs.msdn.com/webdevtools/archive/2008/08/11/web-development-updates-in-visual-studio-2008-sp1.aspx
Sitecore warning: Don?t Install .NET 3.5 Service Pack 1 on Sitecore Servers Yet
Score: 5 - Michael Prewecki (2008-09-05) Using tokens in Tools | Options | Environment -> Task List will slow things considerably when you have lots of instances of a token and a large number of files.
Also with a large number of VB.NET projects background compilation can be a dog so there was a hotfix for VS2005 that increased performance.
Score: 5 - Owen (2008-09-06) @lomaxx: There's a way to track the active item only on demand.
I like this for at least a couple of reasons. One is that, especially in a big solution, working for a while with "track active item" turned on results in a large portion of the project tree being expanded, and thus a little hard to navigate.
Score: 4 - Biri (2008-08-12) I'm a big fan of snippets, they really speed up the work. And as you all know, programmers are lazy even to type. :-)
Here are two snippet editors for VB.NET: for VS 2005 and for VS2008
and here is a very nice collection of snippets: for VS 2005.
Have fun
Score: 4 - Jared Updike (2008-08-28) To avoid large delays when you run a large WinForms program in the debugger, close all Visual Forms Designer tabs, quit Visual Studio, then run VS again and load your project. Loading the Designer at all (even if you close it again) can cause these weird large delays when your program runs in the debugger.
Has anyone else experienced this?
How I found this out: I have a rather large C# WinForms solution with dozens of projects that used to take forever to run when I hit F5---even if I made only small changes and recompiled. Initially I thought it was due to the size of the solution, but later noticed that the compilation was finishing quickly, but there was a still delay before the main form would load. Later I found the same strange delay on another, new, smaller project and realized what I had in common: the Designer. Now I do all my design work in batches, and then close any Designer windows, quit VS, re-launch VS, and go back to coding.
Score: 4 - Andrew Medico (2009-10-06) The main thing I've found is disabling the "Use Visual Studio hosting process" under Project Settings->Debugging for C# projects. This fixes the problem where (on some machines) VS will freeze up for 30+ seconds after a launched project terminates, instead of letting control return to the code editor immediately.
Score: 3 - Ed S. (2008-08-12) If you are using Visual Studio 2008, you can compile using the /MP flag to build a single project in parallel. I have read that this is also an undocumented feature in Visual Studio 2005, but have never tried myself.
You can build multiple projects in parallel by using the /M<maxprojects> flag, but this is usually already set to the number of available cores on the machine.
EDIT: I'm sorry, this is only for VC++ I believe, I should have read more carefully.
Score: 3 - Greg Hewgill (2008-08-12) One of the best ways to speed up a computer doing almost anything is to install more memory. You pretty much can't go wrong with that.
Score: 3 - Charles Anderson (2008-09-24) If you're using the Visual Assist add-in and Visual Studio starts getting really slow and using a lot of RAM, you could try deleting the folder C:\Documents and Settings\\Local Settings\Application Data\VisualAssist\vs8.
I've had to do this twice in two years of using Visual Assist, and both times it's had a dramatic effect on my speed. Visual Assist now has to reparse everything, but it does that in the background, so it's not much of a penalty.
Score: 3 - Robert C. Barth (2008-10-11) The single biggest thing you can do to improve the speed of VS is to not use an integrated source code control system. All the checking it does to put the right icons in the solution tree takes FOREVER.
Score: 3 - Kunal S (2009-04-09) If you are using Vista, change the theme to windows standard, in short stop using the Aero thing.
And i've observed on my system with Vista biz edition having 2gb ram on core 2 duo, that having VS, SQL Server Mgmt Studio and Outlook, all these 3 opened simultaneously has a major kick on performance.
If using TFS, then keeping the Source control explorer always open in VS08 too slows down VS. One can have a button to bring open SCE window on a toolbar.
Score: 3 - YordanGeorgiev (2009-05-01)
Score: 3 - Piotr Owsiak (2009-07-31) I'd recommend moving your VS solution to a RAM drive. That speeded up my Visual Studio (especially operations like "Find in files" are lightning fast).
I would recommend either a free Gavotte Ramdisk or commercial product from QSoft.
I used Gavotte (which is quite fine) and now I'm running on QSoft (it can automatically save/load your ramdrive content on shutdown/startup and/or defined time/time-intervals).
BTW. QSoft prices start from 12$ (much less than their competition).
NOTE: I'm not a related to QSoft other than just happy customer :)
Score: 3 - Oskar Duveborn (2010-05-11) In Visual Studio 2010 - disabling GPU acceleration can make a huge difference in editor response/sluggishness even with workstation-class graphics cards (like older Nvidia Quadros).
This is also true of Adobe Photoshop CS4 and later - it seems to me the "detection" isn't exactly smart enough to evaluate the actual performance of the GPU before enabling it ^^
Score: 2 - lomaxx (2008-08-12) Another little performance boost I remembered this morning:
If you don't need XML Documentation, you can turn it off by right clicking in your project in solution explorer, selecting Properties -> Compile tab and uncheck the "Generate XML Documentation File" option
Score: 2 - ugasoft (2008-09-18) I suggest the reading of "Visual Studio Hacks" by James Avery. There are a lot of hint to better use your favorite IDE ;)
Score: 2 - Pondidum (2009-04-07) Disabling the Splash screen seems (psychological?) to make VS load faster.
To disable it, modify the shortcut to this: "C:\Program Files\Microsoft Visual Studio 8\Common7\IDE\devenv.exe" -nosplash
A macro that replaces F1 with an open firefox and google for the selected word is nice too.
Score: 1 - lomaxx (2008-08-12) One of the best ways to speed up a computer doing almost anything is to install more memory. You pretty much can't go wrong with that.
I've got 4GB ram in my machine, however I read a post from ScottGu a while back that said he installed a solid state drive in his laptop and got a nice speed boost. I might have to dig that article up I think
edit: It's been dug up
Score: 1 - waqasahmed (2009-06-03) are you also referring to short cut keys to speed up development time?
If so, ALT + highlight with left mouse click allows u to select a "box" of text. Extremely useful.
Score: 0 - lomaxx (2008-08-28) @Dan Mitchell: that reminds me of another great keyboard shortcut:
Ctrl+R, E will encapsulate a field (you have to have your cursor on the field). It's somewhat redundant in VS2008 where you can have automatic properties, but it's excellent for VS2005
Score: 0 - Kristopher Johnson (2008-09-30) A good list of Visual C++ tips is here: http://www.highprogrammer.com/alan/windev/visualstudio.html
Score: 0 - RC1140 (2009-05-14) I wrote a smallish post on increasing the load time on larger project that some might find interesting get it here
Score: 0 - rlb.usa (2009-11-09) The very best optimization of all : Check for Visual Studio Updates
Score: 0 - Iuliu Atudosiei (2009-12-06) - Incredibuild is really amazing stuff. In my case reduced compilation time from 30 min to 7 min and computer is not frozen so you can do some other things in parallel.
- RAM disk if possible
- If you have 2 HDD, put the source code and SWAP on different drives.
Score: 0 - terryspitz (2010-03-18) Use the magic C++ "Unity build" technique... http://buffered.io/2007/12/10/the-magic-of-unity-builds/
it's actually amazing: 20min to 3min minimum rebuild/link time for us.
Score: 0 - Robert Koritnik (2010-11-11) Very useful batch (*.bat) file execution
Basically automating command line scripts execution. I usually write few DB scripts that recreate the whole DB of the project. These scripts are version controlled. I also use a batch file that runs all of these on my local DB. Running this batch file within Visual Studio can easily be enabled by adding and additional editor for batch files.
Read this blog post where I explain the whole process step by step.
Score: -2 - Dan Anos (2011-02-09) A very obvious solution, but go to task manager and kill any processes that you don't need.
Here's my test: Standard build: 1.04 minutes "Only Build Startup and dependancies": 53 seconds build time "Selected projects only": 1.17 minutes build time "Killing unnessary processes": 4 seconds.
I'll repeat that; 1 min 4 seconds to 4 seconds by just killing processes you don't need! :)
Score: -6 - Bigwave (2009-04-07) A slightly philosophical answer, do less, KISS (Keep It Simple, Stupid)
Don't gold-plate your code, don't create a highly complex database driven framework if a simple class will do
Visual Studio and dual/multiple monitors: how do I get optimized use out of my monitors?
Score: 10 - Bryan Denny (2008-08-09) [visual-studio], [monitor], [multiple-monitors], [dual] Ultramon is a great program for dual monitors (stretching screen across monitors), but I was wondering if there is any way do to something in Visual Studio like have one tab of code open on one monitor and a second tab of code open on the second monitor with only one instance of Visual Studio running?
Or are there any other suggestions on getting most bang for buck on dual monitors and Visual Studio?
Score: 22* - Ch00k (2008-08-09) Personally, I have my windows set up so that one my main monitor, I have the main visual studio monitor, so therefore my code window, maximized, with only the toolbox docked, on the left. This means the code window takes up as much space as possible, while keeping the left hand edge of the code close to the middle of the screen, where my eyes naturally look. My main monitor is a wide screen, so I find that gives me more than enough room for my code.
My secondary monitor has a second window, which contains the tool windows that I use. So I have solution explorer, error list, task list (//todo: comments), output window, find results etc. all taking up as much space as they like on my secondary monitor.
When debugging, the solution explorer moves the main monitor, and the watch, autos and locals windows take its place.
I find this gives me a very large area to write code, and really helps usage of all of those additional windows, by giving them more real estate than they'd usually have.
Update: In response to everyone talking about using the second monitor for documentation or running the app, I wholeheartedly agree, and forgot to mention how I do that. I use PowerMenu alot to acheive this. Basically I can right-click on any window and set Always On Top. So while i'm debugging, i want to see my output window, but then if I have to refer to some documentation, I just flick to Mozilla (on the second monitor), set it on top, and go back to visual studio. I find this lets me manage the tool windows without having to either shuffle them around a lot, or take up valuable space in the code window.
Score: 4 - The How-To Geek (2008-08-09) I have three monitors, so I usually run with this configuration:
- Left Monitor: documentation / ebooks.
- Middle Monitor: code / debugging
- Right Monitor: Test application / scrolling logfiles (if needed)
This usually works pretty well, and since the monitors are fairly big I rarely need to use the test application in full-screen, so there's plenty of room for my tail -f windows.
I also use AutoHotkey to assign hotkeys that flip to the most important windows, like Firefox or my SSH session. That way I can simply use a shortcut key to access them when necessary.
The left monitor is actually a separate computer running Linux and keyboard/mouse shared with Synergy, so I have multiple ebooks or documentation pages open, one on each virtual desktop... I can flip between the documentation by moving my mouse to the left and using a shortcut key.
For GUI debugging is awesome being able to run the app into one screen and having the debugger in another screen. That's one of the most practical uses..
But really, depends on which kind of application you're developing, i.e., if you need to monitor open file handles, logs, etc.
Score: 2 - Tarks (2008-08-09) When I first got two monitors I wanted to do the same as you, use all the space for visual studio, but I think that you come to realize that it's best to keep VS on one monitor and use the second monitor for documentation, external resources etc. You wouldn't think it at first, but all the little touches like just being able to maximize other resources without them hiding your code is a great feature.
Score: 2 - EndangeredMassa (2008-08-10) I have VS in my left monitor and the GUI/running window in the right. However, if you want to have to code tabs open on each monitor, you could use UltraMon's option to expand a window across both monitors, then drag a code page over such that it puts up a divider. Then, you align that divider with the break in your monitors.
I've done that before, just to test it out. It's not a bad setup.
Score: 1 - ram (2010-02-16) Though I use StudioTools for other purposes, it has a "Tear off Editor" option, with which you can "tear off" the file to a window and resize the window. Find it quite helpful
Score: 1 - the_mandrill (2010-02-16) I find the Code Definition window absolutely invaluable to have open in my other monitor. As the cursor moves over a type name in your editor the other window shows its definition.
Score: 0 - tvanfosson (2008-12-31) Three monitors -- all 1600x1200
- Left: Email, IM, SQL Server Management Studio, Remote Desktops to servers
- Middle: VisualStudio -- maybe multiple instances -- maximized, solution explorer and team explorer docked on right, errors/output docked bottom, others auto-hide
- Right: Web browsers -- app debugging and normal web work, ADUC (if needed)
Other apps get moved around depending on what I'm working on and how crowded the monitors are and the interaction between the app that's open and what I need the info from it for.
Score: 0 - KMessenger (2008-12-31) I have three monitors, set up where Visual Studio is full screen on the middle monitor, the right hand monitor has all the tool windows configured and the left monitor is for browser, help, SSMS, email, etc..
Works well except if I have to remote in, so I have a separate exported configuration to bring move the tool windows back into Visual Studio, and one to set them back up for multiple monitors.
Score: 0 - Dax Fohl (2009-09-10) You could try right-clicking a file in solution explorer, Open With, and then go find devenv.exe. That will open it up in a new instance of VS. Plus, it saves devenv as one of your default options in the future, so you don't have to go hunting around for devenv all the time. Not beautiful, but an option.
Web Services -- WCF vs. Standard
Score: 21 - jdiaz (2008-08-09) [.net], [visual-studio], [wcf], [web-services] Working on a new project and was wondering was there any benefit with going with a WCF web service over a regular old fashion web service. Visual Studio offers templates for both.
What are the differences? Pros / Cons?
Score: 23* - Nathan (2008-08-10) What is a "regular old fashioned web service?" An ASMX service, or are you using WSE as well? ASMX services are not naturally interoperable, don't support WS-* specs, and ASMX is a technology that is aging very quickly. WSE (Web Service Enhancements) services DO add support for WS-* and can be made to be interoperable, but WCF is meant to replace WSE, so you should take the time to learn it. I would say that unless your application is a quick an dirty one-off, you will gain immense flexibility and end up with a better design if you choose WCF. WCF does have a learning curve beyond a [WebMethod] attribute, but the learning curve is over-exaggerated in my opinion, and it is exponentially more powerful and future proof than legacy ASMX services.
Unless your time line simply cannot tolerate the learning curve, you would be doing yourself a huge favor learning WCF instead of just sticking with ASP.NET Web Services. Applications will only continue to become more and more distributed and interconnected, and WCF is the future of distributed computing on the Microsoft platform.
Here is a comparison between the two.
Score: 6 - doekman (2008-08-09) The Pros of doing all by yourself is:
- No learning curve
- Very flexible
The Pros of WCF are:
- Costs less time in the longer run
- Switch protocols without programming
A disadvantage of WCF: some static property names can be pretty lengthy...
To summarize: WCF lets you focus on programming, but you need to learn it first ;-)
Score: 2 - Esteban Araya (2008-08-10) I like the fact writing WCF services makes it easy to separate your service from the implementation. You can write your service and then host it in IIS, a console app, or a windows service; you can also talk to it via http, net tcp, etc.
Score: 2 - Andrei Rinea (2008-10-05) Pro for WCF : You don't need a web server (i.e. IIS). You actually don't need a server OS.
Score: 0 - Nicolas Dorier (2009-03-12) Unit tests on your services implamentation and interaction are easier to do !
How do you feel about code folding?
Score: 15 - Bryan Denny (2008-08-08) [visual-studio], [folding] For those of you in the Visual Studio environment, how do you feel about wrapping any of your code in #regions? (or if any other IDE has something similar...)
Score: 24* - Lars Mæhlum (2008-08-11) 9 out of 10 times, code folding means that you have failed to use the SoC principle for what its worth.
I more or less feel the same thing about partial classes. If you have a piece of code you think is too big you need to chop it up in manageable (and reusable) parts, not hide or split it up.
It will bite you the next time someone needs to change it, and cannot see the logic hidden in a 250 line monster of a method.
Whenever you can, pull some code out of the main class, and into a helper or factory class.
foreach (var item in Items)
{
//.. 100 lines of validation and data logic..
}
is not as readable as
foreach (var item in Items)
{
if (ValidatorClass.Validate(item))
RepositoryClass.Update(item);
}
My $0.02 anyways.
Score: 11 - Pat (2008-08-08) This was talked about on Coding Horror.
My personal belief is that is that they are useful, but like anything in excess can be too much.
I use it to order my code blocks into :
Enumerations
Declarations
Constructors
Methods
Event Handlers
Properties
Score: 7 - Joseph Daigle (2008-08-08) Sometimes you might find yourself working on a team where #regions are encouraged or required. If you're like me and you can't stand messing around with folded code you can turn off outlining for C#:
- Options -> Text Editor -> C# -> Advanced Tab
- Uncheck "Enter outlining mode when files open"
Score: 4 - Greg Hurlman (2008-08-08) While I understand the problem that Jeff, et. al. have with regions, what I don't understand is why hitting CTRL-M,CTRL-L to expand all regions in a file is so difficult to deal with.
Score: 4 - EndangeredMassa (2008-08-08) I use #Region to hide ugly and useless automatically generated code, which really belongs in the automatically generated part of the partial class. But, when working with old projects or upgraded projects, you don't always have that luxury.
As for other types of folding, I fold Functions all the time. If you name the function well, you will never have to look inside unless you're testing something or (re-)writing it.
Score: 3 - Teifion (2008-08-08) I use Textmate (Mac only) which has Code folding and I find it really useful for folding functions, I know what my "getGet" function does, I don't need it taking up 10 lines of oh so valuable screen space.
I never use it to hide a for loop, if statement or similar unless showing the code to someone else where I will hide code they have seen to avoid showing the same code twice.
Score: 3 - Jon Limjap (2008-08-08) I prefer partial classes as opposed to regions.
Extensive use of regions by others also give me the impression that someone, somewhere, is violating the Single Responsibility Principle and is trying to do too many things with one object.
Score: 3 - Kev (2008-08-08) @Tom
Partial classes are provided so that you can separate tool auto-generated code from any customisations you may need to make after the code gen has done its bit. This means your code stays intact after you re-run the codegen and doesn't get overwritten. This is a good thing.
Score: 2 - Tom (2008-08-08) I'm not a fan of partial classes - I try to develop my classes such that each class has a very clear, single issue for which it's responsible. To that end, I don't believe that something with a clear responsibility should be split across multiple files. That's why I don't like partial classes.
With that said, I'm on the fence about regions. For the most part, I don't use them; however, I work with code every day that includes regions - some people go really heavy on them (folding up private methods into a region and then each method folded into its own region), and some people go light on them (folding up enums, folding up attributes, etc). My general rule of thumb, as of now, is that I only put code in regions if (a) the data is likely to remain static or will not be touched very often (like enums), or (b) if there are methods that are implemented out of necessity because of subclassing or abstract method implementation, but, again, won't be touched very often.
Score: 1 - Brian Childress (2008-08-08) I personally use #Regions all the time. I find that it helps me to keep things like properties, declarations, etc separated from each other.
This is probably a good answer, too!
Edit: Dang, Pat beat me to this!
Score: 1 - Serhat Özgel (2008-08-12) Regions must never be used inside methods. They may be used to group methods but this must be handled with extreme caution so that the reader of the code does not go insane. There is no point in folding methods by their modifiers. But sometimes folding may increase readability. For e.g. grouping some methods that you use for working around some issues when using an external library and you won't want to visit too often may be helpful. But the coder must always seek for solutions like wrapping the library with appropriate classes in this particular example. When all else fails, use folding for improving readibility.
Score: 1 - Thomas Owens (2008-08-12) I think that it's a useful tool, when used properly. In many cases, I feel that methods and enumerations and other things that are often folded should be little black boxes. Unless you must look at them for some reason, their contents don't matter and should be as hidden as possible. However, I never fold private methods, comments, or inner classes. Methods and enums are really the only things I fold.
Score: 1 - Mun (2008-08-12) My approach is similar to a few others here, using regions to organize code blocks into constructors, properties, events, etc.
There's an excellent set of VS.NET macros by Roland Weigelt available from his blog entry, Better Keyboard Support for #region ... #endregion. I've been using these for years, mapping ctrl+. to collapse the current region and ctrl++ to expand it. Find that it works a lot better that the default VS.NET functionality which folds/unfolds everything.
Score: 1 - Tundey (2008-08-25) This is just one of those silly discussions that lead to nowhere. If you like regions, use them. If you don't, configure your editor to turn them off. There, everybody is happy.
Score: 1 - Daniel Earwicker (2008-10-20) Region folding would be fine if I didn't have to manually maintain region groupings based on features of my code that are intrinsic to the language. For example, the compiler already knows it's a constructor. The IDE's code model already knows it's a constructor. But if I want to see a view of the code where the constructors are grouped together, for some reason I have to restate the fact that these things are constructors, by physically placing them together and then putting a group around them. The same goes for any other way of slicing up a class/struct/interface. What if I change my mind and want to see the public/protected/private stuff separated out into groups first, and then grouped by member kind?
Using regions to mark out public properties (for example) is as bad as entering a redundant comment that adds nothing to what is already discernable from the code itself.
Anyway, to avoid having to use regions for that purpose, I wrote a free, open source Visual Studio 2008 IDE add-in called Ora. It provides a grouped view automatically, making it far less necessary to maintain physical grouping or to use regions. You may find it useful.
Score: 1 - Mykroft (2008-11-17) I generally find that when dealing with code like Events in C# where there's about 10 lines of code that are actually just part of an event declaration (the EventArgs class the delegate declaration and the event declaration) Putting a region around them and then folding them out of the way makes it a little more readable.
Score: 0 - Adam V (2008-08-08) I prefer #regions myself, but an old coworker couldn't stand to have things hidden. I understood his point once I worked on a page with 7 #regions, at least 3 of which had been auto-generated and had the same name, but in general I think they're a useful way of splitting things up and keeping everything less cluttered.
Score: 0 - bcwood (2008-08-08) I really don't have a problem with using #region to organize code. Personally, I'll usually setup different regions for things like properties, event handlers, and public/private methods.
Score: 0 - Adam Lerman (2008-08-11) Eclipse does some of this in Java (or PHP with plugins) on its own. Allows you to fold functions and such. I tend to like it. If I know what a function does and I am not working on it, I dont need to look at it.
Score: 0 - Rob Z (2008-08-18) The Coding Horror article actual got me thinking about this as well.
Generally, I large classes I will put a region around the member variables, constants, and properties to reduce the amount of text I have to scroll through and leave everything else outside of a region. On forms I will generally group things into "member variables, constants, and properties", form functions, and event handlers. Once again, this is more so I don't have to scroll through a lot of text when I just want to review some event handlers.
Score: 0 - dmckee (2008-08-25) Emacs has a folding minor mode, but I only fire it up occasionally. Mostly when I'm working on some monstrosity inherited from another physicist who evidently had less instruction or took less care about his/her coding practices.
Score: 0 - Scott Dorman (2008-08-28) Using regions (or otherwise folding code) should have nothing to do with code smells (or hiding them) or any other idea of hiding code you don't want people to "easily" see.
Regions and code folding is really all about providing a way to easily group sections of code that can be collapsed/folded/hidden to minimize the amount of extraneous "noise" around what you are currently working on. If you set things up correctly (meaning actually name your regions something useful, like the name of the method contained) then you can collapse everything except for the function you are currently editing and still maintain some level of context without having to actually see the other code lines.
There probably should be some best practice type guidelines around these ideas, but I use regions extensively to provide a standard structure to my code files (I group events, class-wide fields, private properties/methods, public properties/methods). Each method or property also has a region, where the region name is the method/property name. If I have a bunch of overloaded methods, the region name is the full signature and then that entire group is wrapped in a region that is just the function name.
The imported project "C:\Microsoft.CSharp.targets" was not found
Score: 26 - lomaxx (2008-08-08) [c#], [visual-studio] I got this error today when trying to open a Visual Studio 2008 project in Visual Studio 2005:
The imported project "C:\Microsoft.CSharp.targets" was not found
So I thought I'd post it here in case anyone else is interested
Score: 40* - lomaxx (2008-08-08) Open your csproj file in notepad (or notepad++) Find the line:
<Import Project="$(MSBuildToolsPath)\Microsoft.CSharp.targets" />
and change it to
<Import Project="$(MSBuildBinPath)\Microsoft.CSharp.targets" />
Score: 3 - Oleg Sakharov (2009-05-18) This link on MSDN also helps a lot to understand the reason why it doesn't work. $(MSBuildToolsPath) is the path to Microsoft.Build.Engine v3.5 (inserted automatically in a project file when you create in VS2008). If you try to build your project for .Net 2.0, be sure that you changed this path to $(MSBuildBinPath) which is the path to Microsoft.Build.Engine v2.0.
Score: 1 - Peter (2011-08-12) I got this after reinstalling Windows. Visual Studio was installed, and I could see the Silverlight project type in the New Project window, but opening one didn't work. The solution was simple: I had to install the Silverlight Developer runtime and/or the Microsoft Silverlight 4 Tools for Visual Studio. This may seem stupid, but I overlooked it because I thought it should work, as the Silverlight project type was available.
Score: 0 - Mark (2009-12-03) I get this when I try to build using the command line (vsbuild). Fixing the path does not work. I run VCVARS32.BAT first, then try the build. THe build works fine when I use VS2008 from the IDE.
Score: 0 - Andre Luus (2010-05-26) ok so what if it say this: between the gt/lt signs
Import Project="$(MSBuildExtensionsPath)\Microsoft\Silverlight\v3.0\Microsoft.Silverlight.CSharp.targets" /
how do i fix the targets error?
I also found that import string in a demo project (specifically "Build your own MVVM Framework" by Rob Eisenburg).
If you replace that import with the one suggested by lomaxx VS2010 RTM reports that you need to install this.
Score: 0 - stack247 (2011-08-30) For error with Microsoft.WebApplications.targets, you can:
- Install Visual Studio 2010 (or the same version as in development machine) in your TFS server.
- Copy the ?Microsoft.WebApplication.targets? from development machine file to TFS build machine.
Here's the post: http://stack247.wordpress.com/2011/08/29/the-imported-project-microsoft-webapplications-targets-was-not-found/
What is the best way to do unit testing for ASP.NET 2.0 web pages?
Score: 15 - Bryan Denny (2008-08-07) [c#], [asp.net], [visual-studio], [unit-testing] Any suggestions? Using visual studio in C#.
Are there any specific tools to use or methods to approach this?
Update:
Sorry, I should have been a little more specific. I am using ASP.Net 2.0 and was looking more for a tool like jUnit for Java. I took a look at NUnit and NUnitAsp and that looks very promising. And I didn't even know that Visual Studio Pro has a testing suite, so I'll look at all of these options (I've just started using Visual Studio/Asp.net/C# this summer).
Score: 24* - Brad Tutterow (2008-08-07) Boy, that's a pretty general question. I'll do my best, but be prepared to see me miss by a mile.
Assumptions
- You are using ASP.NET, not plain ASP
- You don't really want to test your web pages, but the logic behind them. Unit testing the actual .ASPX pages is rather painful, but there are frameworks out there to do it. NUnitAsp is one.
The first thing to do is to organize (or plan) your code so that it can be tested. The two most popular design patterns for this at the time seem to be MVP and MVC. Both separate the logic of the application away from the view so that you can test the logic without the view (web pages) getting in your way.
Either MVP or MVC will be effective. MVC has the advantage of having a Microsoft framework almost ready to go.
Once you've selected a framework pattern that encourages testability, you need to use a unit testing tool. NUnit is a good starting point. Visual Studio Professional has a testing suite built it, but NUnit + TestDrive.NET also works in the IDE.
That's sort of a shotgun blast of information. I hope some if it hits. The Pragmatic Bookshelf has a good book covering the topic.
Score: 4 - Glenn Slaven (2008-09-23) WatiN is the best that I've found. It integrates into Visual Studio unit testing or nunit & you can do pretty much anything you need in the browser (click links, submit forms, look for text/images, etc.), plus it's written in .net so you don't need to have ruby installed (as you do for watir, which is an awesome tool none the less)
Score: 3 - Chris Farmer (2008-08-07) There was a screencast series a year or so ago on Polymorphic Podcast that did a pretty good intro walkthrough of an MVP implementation in ASP.NET. Implemented this way, unit tests fall into place much more naturally.
These frameworks are useful for integration testing, but they can't provide unit testing, that is, testing the View isolated from persistence, business logic, whatever.
For unit testing Asp.Net Webforms, as well as MVC, you can use Ivonna. For example, you can mock your database access and verify that the mocked records are displayed in the datagrid. Or you can mock the membership provider and test the logged in scenario without having to navigate to the login page and entering your credentials, as with integration testing.
Score: 2 - Frog (2008-08-28) NUnit is the way to go for you.
Score: 2 - RodH257 (2009-06-30) Your best bet is separating the model logic from presentation and thoroughly unit testing the model with NUnit or similar. Testing the users interaction with the web page can be fiddly.
If you actually do want to unit test the users interaction with the web page some of the afformentioned tools such as waitn seem good, an addition to that which I've heard of is Selenium
Score: 1 - jasonlaflair (2008-08-28) Take a look at http://selenium.openqa.org/ it offers a good automated way to build unit tests hooking into the browser. there is a nice firefox plugin for recording tests and can utilize almost any unit testing framework. We had a presentation/demo at our local user group meeting last month and it looked awesome.
Score: 1 - Jack Marchetti (2009-06-30) WaitN looks good, but if I want this to be part of a build process, I don't want the thing actually running Internet Explorer.
Score: 0 - EvilEddie (2008-09-16) Unfortunately they all suck for asp.net, that's why it's hard to find much about them. Not many people are successful in using them
Try Waitr
Score: 0 - user336423 (2010-06-03) I tend to favor the approach of separating any logic out of the UI code. Here's an article that describes a unit test friendly pattern (Model-View-Presenter)
http://www.unit-testing.net/CurrentArticle/How-To-Use-Model-View-Presenter-With-AspNet-WebForms.html
How to set up unit testing for Visual Studio C++
Score: 31 - DShook (2008-08-06) [c++], [visual-studio], [unit-testing], [testing] I'm having trouble figuring out how to get the testing framework set up and usable in Visual Studio 2008 for C++ presumably with the built-in unit testing suite.
Any links or tutorials would be appreciated.
Score: 24* - Aardvark (2008-08-30) This page may help - it reviews a bunch of cpp unit test frameworks:
- CppUnit
- Boost.Test
- CppUnitLite
- NanoCppUnit
- Unit++
- CxxTest
Check out CPPUnitLite or CPPUnitLite2. CPPUnitLite was created by Michael Feathers, who originally ported Java's JUnit to C++ as CPPUnit. CPPUnit tries mimic the development model of JUnit - but C++ lacks Java's features (reflection) to make it easy to use. CPPUnitLite attempts to make a true C++-style testing framework, not a Java one ported to C++. (I'm paraphrasing from Feather's Working Effectively with Legacy Code book). The CPPUnitLite2 seems to be another re-write - with more features and bug fixes.
I also just stumbled across UnitTest++ - which includes stuff from CPPUnitLite2 and some other framework.
Microsoft has released (via MSDN magazine) WinUnit. The download for the code seems broken, but here is a link found in the comments here. * Update: WinUnit Homepage *
Score: 11 - Jared (2009-05-05) There is a way to test unmanaged C++ using the built in testing framework within Visual Studio 2008. If you create a C++ Test Project, using C++/CLI, you can then make calls to an unmanaged DLL. You will have to switch the Common Language Runtime support to /clr from /clr:safe if you want to test code that was written in unmanaged C++.
I have step by step details on my blog here: http://msujaws.wordpress.com/2009/05/06/unit-testing-mfc-with-mstest/
Score: 5 - mos (2008-09-15) Personally, I prefer WinUnit since it doesn't require me to write anything except for my tests (I build a .dll as the test, not an exe). I just build a project, and point WinUnit.exe to my test output directory and it runs everything it finds. You can download the WinUnit project here. (MSDN now requires you to download the entire issue, not the article. WinUnit is included within.)
Score: 3 - Ben Straub (2008-08-14) The framework included with VS9 is .NET, but you can write tests in C++/CLI, so as long as you're comfortable learning some .NET isms, you should be able to test most any C++ code.
boost.test and googletest look to be fairly similar, but adapted for slightly different uses. Both of these have a binary component, so you'll need an extra project in your solution to compile and run the tests.
The framework we use is CxxTest, which is much lighter; it's headers only, and uses a Perl (!) script to scrape test suite information from your headers (suites inherit from CxxTest::Base, all your test methods' names start with "test"). Obviously, this requires that you get Perl from one source or another, which adds overhead to your build environment setup.
Score: 3 - aracntido (2009-12-01) Here is the approach I use to test the IIS URL Rewrite module at Microsoft (it is command-line based, but should work for VS too):
- Make sure your header files are consumable by moving source code to cpp files and using forward declaration if needed.
- Compile your code to test as library (.lib)
- Create your UnitTest project as C++ with CLR support.
- Include your header files.
- Include your .lib files.
- Add a reference to Microsoft.VisualStudio.QualityTools.UnitTestFramework.dll
- Use a really small class for declaring your unit test and jump from managed to C++/Native code like this (may have typos):
Here is an example:
// Example
#include "stdafx.h"
#include "mstest.h"
// Following code is native code.
#pragma unmanaged
void AddTwoNumbersTest() {
// Arrange
Adder yourNativeObject;
int expected = 3;
int actual;
// Act
actual = yourNativeObject.Add(1, 2);
// Assert
Assert::AreEqual(expected, actual, L"1 + 2 != 3");
}
// Following code is C++/CLI (Managed)
#pragma managed
using namespace Microsoft::VisualStudio::TestTools::UnitTesting;
[TestClass]
public ref class TestShim {
public:
[TestMethod]
void AddTwoNumbersTest() {
// Just jump to C++ native code (above)
::AddTwoNumbersTest();
}
};
With this approach, people don't have to learn too much C++/CLI stuff, all the real test will be done in C++ native and the TestShim class will be used to 'publish' the test to MSTest.exe (or make it visible).
For adding new tests you just declare a new [TestMethod] void NewTest(){::NewTest();} method and a new void NewTest() native function. No macros, no tricks, straighforward.
Now, the heade file is optionally, but it can be used to expose the Assert class' methods with C++ native signatures (e.g. wchar_t* instead of Stirng^), so it can you can keep it close to C++ and far from C++/CLI:
Here is an example:
// Example
#pragma once
#pragma managed(push, on)
using namespace System;
class Assert {
public:
static void AreEqual(int expected, int actual) {
Microsoft::VisualStudio::TestTools::UnitTesting::Assert::AreEqual(expected, actual);
}
static void AreEqual(int expected, int actual, PCWSTR pszMessage) {
Microsoft::VisualStudio::TestTools::UnitTesting::Assert::AreEqual(expected, actual, gcnew String(pszMe
ssage));
}
template<typename T>
static void AreEqual(T expected, T actual) {
Microsoft::VisualStudio::TestTools::UnitTesting::Assert::AreEqual(expected, actual);
}
// Etcetera, other overloads...
}
#pragma managed(pop)
HTH
I use UnitTest++ as well. I'm a big fan of its simplicity.
Score: 1 - popopome (2008-08-20) Google releases C++ Test Framework which is very similar with xUnit frameworks.
The tools that have been mentioned here are all command line tools. If you look for a more integrated solution, have a look at cfix studio, which is a Visual Studio AddIn for C/C++ unit testing . It is quite similar to TestDriven.Net, but for (unmanaged) C/C++ rather than .Net.
Score: 1 - Ovaron95 (2011-11-16) GoogleTest Visual Studio 2010 Add-in at
Score: 0 - graham.reeds (2008-08-06) I use UnitTest++.
While the example tutorial is for Visual Studio 2005, the concepts are similar (try setting one up for VC6...).
Update: The VC6 hacks are now included in the source!
Score: 0 - colgur (2008-08-11) I've used CppUnit with VS2005 and Eclipse. The wiki is very thorough (especially if you are familiar with JUnit).
Score: 0 - Orion Edwards (2008-08-11) I'm not 100% sure about VS2008, but I know that the Unit Testing framework that microsoft shipped in VS2005 as part of their Team Suite was only for .NET, not C++
I've used CppUnit also and it was alright. Much the same as NUnit/JUnit/so on.
If you've used boost, they also have a unit testing library
The guys behind boost have some serious coding chops, so I'd say their framework should be pretty good, but it might not be the most user friendly :-)
Score: 0 - Lehane (2008-08-19) The unit tester for VS2008 is only for .NET code as far as I know.
I used CppUnit on Vs2005 and found it to be pretty good.
As far as I remember, the setup was relatively painless, just make sure that in your testing projects the linker (Linker->Input->Additional Dependencies) includes cppunitd.lib.
Then, #include <cppunit/extensions/HelperMacros.h> in your header
You can then follow the steps in http://cppunit.sourceforge.net/doc/1.11.6/cppunit_cookbook.html to get your test class working.
Score: 0 - ZebZiggle (2008-08-27) I like the CxxTest as well for the same reasons. It's a header file only so no linking required. You aren't stuck with Perl as there is a Python runner as well. I will be reviewing the google library soon. The Boost stuff pulls in too much other baggage.
Score: 0 - Dushara (2009-02-12) Have a look at CUnitWin32. It includes an example.
Score: 0 - DesignFirst (2011-01-31) You can find here a useful technique to use Unit Testing engine of Visual Studio for C++.
How to generate getters and setters in Visual Studio?
Score: 23 - Paul (2008-08-06) [visual-studio], [setter], [getter] By "generate", I mean auto-generation of the code necessary for a particuliar selected (set of) variable(s).
But any more explicit explication or comment on good practice is welcome.
Score: 33* - Orion Edwards (2008-08-06) Rather than using ctrl+k,x you can also just type prop and then hit tab twice
Score: 15 - Jon Limjap (2008-08-06) By generate, do you mean auto-generate? If that's not what you mean:
Visual Studio 2008 has the easiest implementation for this:
public PropertyType PropertyName { get; set; }
In the background this creates an implied instance variable to which your property is stored and retrieved.
However if you want to put in more logic in your Properties, you will have to have an instance variable for it:
private PropertyType _property;
public PropertyType PropertyName
{
get
{
//logic here
return _property;
}
set
{
//logic here
_property = value;
}
}
Previous versions of Visual Studio always used this longhand method as well.
Score: 13 - Dan Herbert (2008-08-06) Visual Studio also has a feature that will generate a Property from a private variable.
If you right-click on a variable, in the context menu that pops up click on the "Refactor" item. Then choose encapsulate field. This will create a getter/setter property for a variable.
I'm not too big a fan of this technique as it is a little bit awkward to use if you have to create a lot of getters/setters, and it puts the property directly below the private field, which bugs me because I usually have all of my private fields grouped together, and this Visual Studio feature breaks my class' formatting.
Score: 6 - sugarcoded (2008-08-06) If you are using Visual Studio 2005 and up you can create a setter/getter real fast using the insert snippet command. Right click on your code click on Insert Snippet (Ctrl+k,x) and then choose "prop" form the list. Hope this helps.
Score: 1 - Oliver (2009-09-28) If you're using ReSharper, go into the ReSharper menu --> Code --> Generate ... (or hit Alt+Ins inside the surrounding class) and you'll get all the options for generating getters and/or setters you can think of :-)
Score: 0 - Mario Marinato -br- (2008-08-06) I don't have Visual Studio installed on my machine anymore (and I'm using Linux), but I do remember that there was an wizard hidden somewhere inside one of the menus that gave access to a class builder.
With this wizard, you could define all your classes' details, including methods and attributes. If I remember well, there was an option through which you could ask VS to create the setters and getters automatically for you.
I know it's quite vague, but check it out and you might find it.
Score: 0 - Daniel (2009-01-12) In addition to the 'prop' snippet and auto-properties, there is a refactor option to let you select an existing field and expose it via a property. Also, if you don't like the 'prop' implementation, you can create your own snippets. Additionally, a 3rd party refactoring tool like resharper will give you even more features and make it easier to create more advanced snippets. I'd recommend Resharper if you can afford it.
http://msdn.microsoft.com/en-us/library/f7d3wz0k(VS.80).aspx http://www.jetbrains.com/
Do you have any recommended add-ons/plugins for Microsoft Visual Studio?
Score: 96 - Bryan Denny (2008-08-05) [visual-studio], [plugins], [tools], [polls] Freebies preferred, but if it is worth the cost....
Score: 63 - Michael Stum (2008-08-05) Not free, but ReSharper is definitely one recommendation.
Score: 56* - David Negron (2008-09-16) SmartPaster - (FREE) Copy/Paste code generator for strings
AnkhSvn - (FREE) SVN Source Control Integration for VS.NET
VisualSVN Server - (FREE) Source Control
ReSharper - IDE enhancement that helps with refactoring and productivity
CodeRush - Code gen macros on steroids
Refactor - Code refactoring aid
CodeSmith - Code Generator
GhostDoc - (FREE) Simple code commenting tool
DXCore (FREE) and its many awesome plugins: DxCore Community Plugins, CR_Documentor, CodeStyleEnforcer, RedGreen
TestDriven.Net - (FREE/PAY) Unit Testing Aid
Reflector - (PAY) Feature rich .Net Disassembler Reflector AddIn's
Web Deployment Projects - Provides additional functionality to build and deploy Web sites and Web applications (source).
StudioTools - (FREE) Navigation assistant, code metrics tool, incremental search, file explorer in visual studio and tear off editor windows
Score: 37 - graham.reeds (2008-08-05) Whole Tomato's Visual Assist X. I absolutely swear by it. I would like to see a better plug in for Lint than Visual Lint by Riverblade, but since that will eventually be moved onto the build server I don't mind running it every couple of days manually.
Score: 28 - Brad Tutterow (2008-08-05) PowerCommands is a Microsoft-created plugin that offers a variety of new features that one would think probably should have been in Visual Studio in the first place.
These include
- Copying/Pasting project references!
- "Open Containing Folder" to jump straight to the hard-drive location of a file or project
- Automatic reorganizig and sorting of using statements
- "Open Command Prompt Here" to open a command prompt in any of your project folders.
- Collapse Projects
Score: 21 - Adam Lassek (2008-08-18) RockScroll is awesome, and free.
Addendum
As @Andrei points out, MetalScroll is a better alternative. It's Open Source, and corrects some annoying things about RS.
Score: 16 - Brett Veenstra (2008-08-05) - Resharper
- Resharper MbUnit Test Runner Add-On
- SQL Prompt for Database Projects (works inside your SQL Management Studio as well)
- Ankh SVN 2.0+ for free SVN support (v1.x pales in comparison)
- TeamCity plug-in to monitor your builds, personal builds, and bug tracking
Score: 16 - Brian G Swanson (2008-08-18) I'm a big fan of CodeRush and Refactor! Pro by DevExpress. I've been using them for a number of years, and without a doubt it makes me a faster developer. Also, both are built on a free framework called DXCore that allows you to develop your own plug-ins for Visual Studio, and the sky is the limit there...
Score: 14 - Ray (2008-08-05) I find Ghost Doc to be very useful.
GhostDoc is a free add-in for Visual Studio that automatically generates XML documentation comments for C#. Either by using existing documentation inherited from base classes or implemented interfaces, or by deducing comments from name and type of e.g. methods, properties or parameters.
Score: 11 - Chris Farmer (2008-08-05) If you use SVN for source control, definitely get VisualSVN. It enables TortoiseSVN interactions from within the Visual Studio IDE.
I also echo the Resharper comment. Retail price is a little steep, but if you're a student or otherwise educationally affiliated, it's actually pretty cheap.
Score: 9 - Andrew Grant (2008-08-18) +1 Visual Assist.
It's unfortunate that you need a plugin to get really good intellisense but it's definitely worth paying for.
Score: 7 - Wavel (2008-09-16) LinqPad is great for testing linq to objects/xml/sql. Free download.
Score: 6 - Pat (2008-08-05) Maintains your clipboard data through removal of lines, a few other nice items but that one alone makes me happy.
While some have problems with regions I think if you use them, this tool is for you. Automatically region'izes your code into appropriate region blocks. Fully configurable for custom items etc.
Score: 6 - koschi (2008-09-16) What about IncrediBuild? This is a nice distributed build system with visual studio integration.
Score: 5 - CodingWithoutComments (2008-08-05) Qt Cross-Platform Application Framework
Qt is a cross-platform application framework for desktop and embedded development. It includes an intuitive API and a rich C++ class library, integrated tools for GUI development and internationalization, and support for Java? and C++ development
They have a plug-in for Visual Studio that costs a bit of money, but it is worth every penny.
Score: 5 - Charles Anderson (2008-09-17) I've been using Visual Assist X for nearly two years now, and I find it so useful I can honestly say that if my employer didn't provide it, I'd have to pay for it myself.
I also use Cool Commands and SlickEdit (the free version), whose File Explorer and Command Spy tools are quite useful.
Score: 4 - Steve Gury (2008-08-31) +1 for Visual Assist And I will add VLH (Visual Local History) which provides a kind of local source control system. Every time you save a file, the plugin add a copy in the local repository.
Score: 4 - moobaa (2008-09-06) +1 for CodeRush & Refactor Pro. I've been using CodeRush since its Delphi incarnations, and it's utterly wonderful. The mantra of "Code at the speed of thought" is very close to reality ;)
Score: 4 - Glennular (2008-12-09) vi/vim support inside VS
Score: 3 - Ishmaeel (2008-08-05) Sonic File Finder for when you have loads of files in your solutions and searching for them in the solution explorer becomes a pain in the wrist.
You might also find DPack interesting. Several tools and enhancements rolled into one neat package.
Score: 3 - Seth Morris (2008-09-16) Consolas font Free font from MS designed for reading code.
Score: 3 - Registered User (2010-09-05) from the website: Latest version supports:
- Manage Reference Paths
- Prevent accidental Drag & Drop in Solution Explorer
- Prevent accidental linked file delete
- Apply Fix (automatically fix build errors/warnings)
- Open PowerShell
- Show Assembly Details
- Create Code Contract
- Cancel Build when first project fails
- Debug Output - custom formatting
- Build Output - custom formatting
- Search Output - custom formatting
- Configure WPF Rendering
- Configure Fusion Logs
- Configure IE for debugging
- Locate Source File
- Thumbnails in IDE Navigator
- Extended support for xaml, aspx, css, js and html files
- Disable Ctrl + Mouse Wheel Zoom
- Zoom to Mouse Pointer
- Configurability
- Attach to local IIS
- Copy Full Path
- Build Startup Projects
- Open Command Prompt
- Search Online
- Build Statistics
- Group linked items
- Copy/Paste Reference
- Copy/Paste as Link
- Collapse Solution
- Group items directly from user interface (DependantUpon)
- Open In Expression Blend
- Locate in Solution
- Edit Project File
- Edit Solution File
- Show All Files
and others, so try it now!
Score: 2 - Scott Dorman (2008-08-28) MZTools is great too.
Score: 2 - Simon Steele (2008-09-09) - Microsoft StyleCop provides code style checking for C#, we use it all the time and love it (free)
- Axialis IconWorkshop has a Visual Studio add-in which is now free for VS2008 users.
- Resharper Yes another vote, because I can't upvote everyone who suggests it :)
- Workspace Whiz for C++, I used to live by Workspace Whiz but haven't used it in VS2008 as I hadn't realised there was an update. Will have to give it a try again.
Score: 2 - Paulius Maruška (2008-09-09) I found this site called Visual Studio Gallery - it has a lot of visual studio add-ins. I'm browsing it right now and I recommend everyone to visit it.
Score: 2 - Michael Burr (2008-09-16) If you're doing C++ coding, hands down Visual Assist.
Score: 2 - Quintin Robinson (2008-09-16) I love CopySourceAsToHTML as a cool little addin. It's great if you want to copy code blocks for blogging and the like while maintaining your syntax formatting.
I think this is still the url.. you have to do some manual work to set it up with 08. http://www.jtleigh.com/people/colin/software/CopySourceAsHtml/
Score: 2 - rschuler (2008-10-02) For the laptop bound or for those with vi/vim key bindings burned into the brain I would recommend ViEmu.
If you have not tried editing with vi key bindings here is why you may want to try "Why, oh WHY, do those #?@! nutheads use vi?"
Score: 2 - Andrei Rinea (2010-10-18) Try MetalScroll!! It's better than Rockscroll
Score: 1 - Gerhard Dinhof (2008-08-18) I like ReSharper, too! It's affordable if you're a student or otherwise connected to an university.
For interaction with SVN I'll prefer AnkhSVN.
.. and of course for connecting to TeamFoundation Server there's the Visual Studio Team Explorer
Score: 1 - John Sheehan (2008-08-18) Dispatch for FTP is what Copy Web Site should have been.
This just came out but I like it a lot: Mindscape File Explorer
VisualSVN is excellent for SVN integration. Much better than Ankh (have not tried Ankh 2+ though)
SonicFileFinder for looking up files or classes quickly. Supports searching just the upper case parts of a camel-cased type name
Web Deployment Projects by Microsoft for precompiling web site projects
Score: 1 - Anheledir (2008-09-16) A lot of the mentioned Addins are used by me on a regular basis. Here are just a few I I estimate, too:
All three are free and highly recommended (by me).
Score: 1 - Seth Morris (2008-09-16) Guidance packages integrate into VS as Snippets, projects, and project templates. They provide a way to collect and reuse patterns, code, and How To answers. You can create guidance for your team and you can download the guidance packages coming out of the Patterns and Practices group at MS.
Score: 1 - jonbho (2008-09-18) If vi/vim editing is your thang:
If you want color-coded control-flow syntax-highlighting and graphical outlines:
I'm the developer of these commercial tools.
Score: 1 - sontek (2008-09-21) We've covered this on this question: http://stackoverflow.com/questions/106340/what-is-your-favorite-visual-studio-add-insetting
Score: 1 - mliesen (2009-04-07) I don't fancy the Visual Studio bookmarks so I use DPACK to get the same kind of bookmarks as the Delph IDE provides.
Score: 1 - Jason Williams (2009-09-04) AtomineerUtils Pro Documentation - automatic DocXml/Doxygen/JavaDoc/Qt doc-comment generation/updating (similar to GhostDoc, but more powerful & flexible, and supports C#, C++, C++/CLI, C, Java and Visual Basic code).
The style of the generated comments is very configurable, and automatic re-formatting (such as whitespace control and word wrapping) can be optionally applied to keep the comments as readable as possible. It also has many helpers to allow users to read and convert most legacy doc-comments into any of the above formats.
(I'm the author, but I believe the above is an accurate and objective description. This add-in was free when this answer was first added, but to cover the costs of hosting, supporting, and continuing to improve the addin in monthly releases, it is now $10 with a 30-day free trial)
Score: 1 - David Crawshaw (2009-09-07) My favorite would be the one I work on - Goanna. :)
C/C++ static analysis - it helps find bugs.
Score: 0 - Robin Robinson (2008-08-18) - Resharper (Agree it sucks you have to pay extra to get this, but well work the money)
GhostDoc (Takes away any excuse for not having comments in your code)
PowerCommands for VS 2008 (Forgot I even had this installed because it just adds a the little things that should have been there all along)
Score: 0 - Jedi Master Spooky (2008-08-25) I use a lot the Fogbguz plug in but well you need to use Fogbugz first !!!
Score: 0 - the empirical programmer (2008-08-28) I just found this rather large list of addins:
http://geekswithblogs.net/brians/archive/2008/05/12/122087.aspx
Score: 0 - mpd (2008-09-04) +1 for VisualSVN being better than AnkhSVN, having tried both, and +1 for the FogBugz Add-in.
Score: 0 - Lukas Šalkauskas (2008-09-09) GhostDoc is a free add-in for Visual Studio that automatically generates XML documentation comments for C#. Either by using existing documentation inherited from base classes or implemented interfaces, or by deducing comments from name and type of e.g. methods, properties or parameters.
KingsTools is also a nice collection of macros containing:
- Run Doxygen
- Insert Doxygen comments
- Build Solution stats
- Dependency Graph
- Inheritance Graph
- Swap .h<->.cpp
- Colorize
- } End of
- #region/#endregion for c++
- Search the web
Score: 0 - Luther Baker (2008-09-09) In addition to the refactoring and source control tools listed here, AQTime is a great windows profiler. It can run as a plugin or stand-alone and it works with .NET and native code.
Score: 0 - David (2008-09-12) XPathmania is a good little tool for writing and testing XPath queries.
Score: 0 - Joel in Gö (2008-09-15) I'm always amazed that more people don't know about/use NDepend - it shows all dependecies at every level of your code, and will even draw pretty box and arrow pictures showing how confused your architecture really is :) Together with TestDriven.Net, I can't imagine working without it any more. Free/cheap.
Score: 0 - C.Trauma (2008-09-16) I 2nd VisualAssist, been using it since V6, can't live without it...
I see no one has mentiond CoolCommands: http://geekswithblogs.net/brians/archive/2007/03/04/107922.aspx
Great set of time savers...
Score: 0 - Seth Morris (2008-09-16)
Score: 0 - Seth Morris (2008-09-16)
Score: 0 - Seth Morris (2008-09-16)
Score: 0 - Seth Morris (2008-09-16) Code Style Enforcer Lets you define a .NET code style (with some degree of flexibility) and underlines violations. Has context-menu options to change the code to match the style. Requires DXCore, which is linked from the Code Style Enforcer page. Both are free.
Score: 0 - t0mt0m72 (2008-09-16) definetly +1 for VisualAssistX (cannot work without it anymore & it's worth all the money) and +1 for VisualSVN
Score: 0 - Seth Morris (2008-09-16) PInvoke.NET addon Menu to search for pre-written P/Invoke code. Much easier than working out the marshalling code yourself, especially when there are nasty unions and alignment requirements.
Score: 0 - docgnome (2008-09-16) If you are looking for a better code editor, vim comes with VisVim, a plugin to replace the VS code editor with vim.
Score: 0 - Craig Fisher (2008-09-16) Definitely Resharper.
Score: 0 - Seth Morris (2008-09-16) Not really an addon inside VS, but one every VS use needs: Code Preview Handler Provides a preview handler with syntax highlighting for source files. The handler works in the Explorer preview pane and in the preview tab for attachments in Outlook.
Score: 0 - Seth Morris (2008-09-16) Source Monitor code analysis tool
Score: 0 - Code Monkey (2008-09-16) Resharper. It's the best productivity tool for any software engineer! TestDriven.Net is pretty good too. and GhostDoc.
Score: 0 - Seth Morris (2008-09-16) VLINQ LINQPad is essential, but for quick stuff inside VS, VLINQ is great.
Score: 0 - Seth Morris (2008-09-16) Source Code Outliner Nice alternate view of your source files. It's the outliner from the code pane, but without all the code getting in the way of the structure.
Score: 0 - Seth Morris (2008-09-16) VS Command Shell Command shell in the Output pane. Far from perfect, but often very, very useful. Faster and easier to get to than a separate cmd and has easier copy/paste support.
Score: 0 - Rick Minerich (2008-09-16) Spell Checker for comments is a godsend. GhostDoc is great for making well documented APIs.
Score: 0 - Mladen Mihajlovic (2008-09-17) TracExplorer is cool for integrating Trac with VS.
Score: 0 - Kramii (2008-09-17) - Refactor! Pro - Commercial. Free version available.
- GhostDoc - Free
- Comment Reflower - Free
- Versioning Controlled Build - Free
Score: 0 - ugasoft (2008-09-18) Visual Assist: you cannot live without it!
Score: 0 - Hugoware (2008-09-18) It's not a Visual Studio add in, but it is a tool that I couldn't use Visual Studio without it...
ClipX - it's works with the normal clipboard, but saves the entries to a searchable list, you can use copy and paste as ususal, but you can hit CTRL+SHIFT+V and the list pops up. It works with images, text, etc. It even persists after you reboot your computer.
I know this is not a VS add-in but SSMS one anyway could be useful for anyone working with MSSQL.
Just for the case you wanna see more like this one check this post. Actually from ssmstoolspack creator.
Score: 0 - Enrico Campidoglio (2008-12-02) Here is my list:
- Microsoft StyleCop (code analysis)
- JetBrains dotTrace (application profiling)
- Typemock Isolator (mocking in unit tests)
- Roland Weigelt's GhostDoc (code documentation)
Score: 0 - Josh Kodroff (2008-12-09) While Visual SVN costs $50 or so, I strongly prefer it over AnkhSVN (which I last tried about a year ago - it may have improved since).
It's one of the easiest to sell to your boss if funding is an issue. (Thankfully we don't have to scratch and claw to get good tools where I work.)
Score: 0 - Dmitri Nesteruk (2008-12-09) For C# development I use:
- ReSharper, heavily customized and with a couple dozen custom actions I wrote (not to mention weird but wonderful Live Templates)
- GhostDoc - very useful for postprocessing of generated code
- Source Code Outliner
- P/factor (a set of internally developed code gen tools for VS) - see example here
- CodeGenUtils - another internal dev for code generation, available on CodePlex
- SharpWizard - a VS add-in for rapid prototyping. Supports advanced generation of interface support, operators, patterns, metadata.
- Dependency Analyser - a really nifty tool (another internal dev.) for identifying dependencies between CLR properties. Useful for autogenerating change notifications based on dependency graphs.
In addition to these, I also have a couple of DSL graphical designers for the particularly difficult scenarios - for example, I have a DSL for complex multithreaded operations that are implemented using Pulse & Wait.
Score: 0 - pablito (2009-01-04) one that I wrote http://www.codeplex.com/lazy
Score: 0 - Brad Robinson (2009-05-18) DevExtra - but I'm biased cause I wrote it :)
http://www.toptensoftware.com/devextra/
It's a bit old now (has its origins in VC6) and mostly oriented towards C++ developers but its free and I still use it every day.
Score: 0 - Piotr Owsiak (2009-12-17) Here a few I didn't find (or spot) mentioned:
- ASPXEditHelper (a must have for ASP.NET devs)
- MouseGestures
- CodeKeep
- KNOCKS
- Git Extensions
Someone mentioned SQL Prompt so I'll add SQL Assistant (similar price, but does a lot more)
Very few people mentioned DPack which is free and absolutely awesome.
Also, really get ReSharper or something similar (it will pay many times over). Bare VS just does not "compare" ;-)
Enjoy your coding!
Score: 0 - Bobby (2009-12-17) Build Version Increment (GPL) gives you (nearly) everything you need for controlling the version of your assemblies.
Some Features (copied from the site):
- Different auto increment styles can be set per major, minor, build or revision number.
- Supports C#, VB.NET and C++.NET projects.
- Not required to be installed by all project members. Configuration is shared via properties in the solution and project files. Developers who don't have the addin won't feel a thing.
- Automatically checks out required files if under source control.
- Can be configured per solution and/or per project.
- Can be configured to update only on certain configuration builds (debug, release, any or custom)
- Can update assembly attributes in an external source file instead of the default AssemblyInfo.
Score: 0 - Phil Hale (2010-03-22) Quick Open File is a plugin that, coming from an Eclipse background, I can't live without
No more digging through the solution explorer trying to find files
Score: 0 - Steve (2010-04-15) I found Code Rocket to be very useful - http://www.getcoderocket.com/
From their website: "Code Rocket is an innovative tool that reveals the inner workings of C#, ... and C/C++ code, for Visual Studio... It makes documentation a seamlessly integrated part of the software development process, plugging directly into your development IDE with minimal overheads, delivering powerful benefits from day one."
Score: 0 - rafaelsr (2010-08-19) Take a look in this one:
- Snippets
- Auto properties creation
- Class generator
- Properties generator
- Store Procedure Generator
- many useful function like
- Collapse Solution
- Backup (Solution or Project)
- Method Finder
- Send Code to Notepad (to keep it save :D )
And many others
CodeHelper: http://www.bluemusa.com/codehelper/codehelper.htm
Are Multiple DataContext classes ever appropriate?
Score: 10 - Yaakov Ellis (2008-08-05) [.net], [asp.net], [database], [visual-studio], [linq-to-sql], [datacontext] In order to fully use LinqToSql in an ASP.net 3.5 application, it is necessary to create DataContext classes (which is usually done using the designer in VS 2008). From the UI perspective, the DataContext is a design of the sections of your database that you would like to expose to through LinqToSql and is integral in setting up the ORM features of LinqToSql.
My question is: I am setting up a project that uses a large database where all tables are interconnected in some way through Foreign Keys. My first inclination is to make one huge DataContext class that models the entire database. That way I could in theory (though I don't know if this would be needed in practice) use the Foreign Key connections that are generated through LinqToSql to easily go between related objects in my code, insert related objects, etc.
However, after giving it some thought, I am now thinking that it may make more sense to create multiple DataContext classes, each one relating to a specific namespace or logical interrelated section within my database. My main concern is that instantiating and disposing one huge DataContext class all the time for individual operations that relate to specific areas of the Database would be impose an unnecessary imposition on application resources. Additionally, it is easier to create and manage smaller DataContext files than one big one. The thing that I would lose is that there would be some distant sections of the database that would not be navigable through LinqToSql (even though a chain of relationships connects them in the actual database). Additionally, there would be some table classes that would exist in more than one DataContext.
Any thoughts or experience on whether multiple DataContexts (corresponding to DB namespaces) are appropriate in place of (or in addition to) one very large DataContext class (corresponding to the whole DB)?
Score: 12* - Evan (2008-08-07) I disagree with John's answer. The DataContext (or Linq to Entities ObjectContext) is more of a "unit of work" than a connection. It manages change tracking, etc. See this blog post for a description:
Lifetime of a LINQ to SQL DataContext
The four main points of this blog post are that DataContext:
- Is ideally suited for a "unit of work" approach
- Is also designed for "stateless" server operation
- Is not designed for Long-lived usage
- Should be used very carefully after any SumbitChanges() operation.
Considering that, I don't think using more than one DataContext would do any harm- in fact, creating different DataContexts for different types of work would help make your LinqToSql impelmentation more usuable and organized. The only downside is you wouldn't be able to use sqlmetal to auto-generate your dmbl.
Score: 2 - Kev (2008-08-05) I'd been wrangling over the same question whilst retro fitting LINQ to SQL over a legacy DB. Our database is a bit of a whopper (150 tables) and after some thought and experimentation I elected to use multiple DataContexts. Whether this is considered an anti-pattern remains to be seen, but for now it makes life manageable.
Score: 0 - John Downey (2008-08-05) In my experience with LINQ to SQL and LINQ to Entities a DataContext is synonymous to a connection to the database. So if you were to use multiple data stores you would need to use multiple DataContexts. My gut reaction is you wouldn't notice to much of a slow down with a DataContext that encompasses a large number of tables. If you did however you could always split the database logically at points where you can isolate tables that don't have any relationship to other sets of tables and create multiple contexts.
Score: 0 - liammclennan (2008-08-27) I think John is correct.
"My main concern is that instantiating and disposing one huge DataContext class all the time for individual operations that relate to specific areas of the Database would be impose an unnecessary imposition on application resources"
How do you support that statement? What is your experiment that shows that a large DataContext is a performance bottleneck? Having multiple datacontexts is a lot like having multiple databases and makes sense in similar scenarios, that is, hardly ever. If you are working with multiple datacontexts you need to keep track of which objects belong to which datacontext and you can't relate objects that are not in the same data context. That is a costly design smell for no real benefit.
@Evan "The DataContext (or Linq to Entities ObjectContext) is more of a "unit of work" than a connection" That is precisely why you should not have more than one datacontext. Why would you want more that one "unit of work" at a time?
.NET Testing Framework Advice
Score: 17 - saalon (2008-08-03) [c#], [.net], [visual-studio], [unit-testing] I'm looking to introduce a unit testing framework into the mix at my job. We're using Visual Studio 2005 (though we may be moving to 2008 within the next 6 months) and work primarily in C#. If the framework has some kind of IDE integration that would be best, but I'm open to frameworks that don't have integration but are still relatively simple to get set up. I'm going to get resistance to it one way or another, so if I can make sure what I'm pushing isn't a pain in the neck, that would help my case.
The obvious choice from the research I've done so far points to nUnit, but I'd like to get the impressions of someone who's actually used it before recommending it to my team.
Has anyone out there used nUnit? If so, are there any pitfalls or limitations of which I should be aware? Are there other good options out there? If so, if you've used both nUnit at that, I'd greatly appreciate an idea of the strengths and weaknesses of them.
Eric Sipple
Score: 28* - Karl Seguin (2008-08-03) I think NUnit is your best bet. With TestDriven.NET, you get great integration within VS.NET. (Resharper also has a unit test runner if you're using it). NUnit it simple to use and follows an established paradigm. You'll also find plenty of projects/tutorials/guides using it which always helps.
Your other main choice is probably MBUnit, which is more and more position itself as the BDD framework of choice (in conjunction with Gallio http://www.gallio.org).
Score: 10 - Michael Stum (2008-08-03) Scott Hanselman had a good Podcast about this, entitled "The Past, Present and Future of .NET Unit Testing Frameworks":
Score: 5 - qui (2008-09-16) The built in unit testing in VS 2008 is alright, but its difficult to integrate with CruiseControl.net, certainly a lot harder than normal NUnit.
So go with NUnit if you plan to have nice automated tests.
Score: 3 - denny (2008-08-03) Visual Studio 2008 has a built in test project type that works in a similar way to NUnit, but obviously has much tighter integration with Visual Studio (can run on every build and shows the results in a similar way to the conversion results page when upgrading solution files), but it is obviously not as mature as NUnit as it's pretty new and I'm not sure about how it handles mocking.
But it would be worth looking into when your team moves to VS2008
We've been using xUnit.net. It seems to combine all the best of nUnit, mbUnit and MSTest.
Score: 2 - capgpilk (2008-09-16) When I started unit testing I started with NUnit as it is simple to set up and use, currently I am using the built in test runner that comes with Resharper, that way I can easily flip between code and test results. Incidently NUnit detects when you have compiled your code so you do not need to do any refresh in NUnit. Resharper automatically does a build when you choose to run a specific test.
Score: 2 - YordanGeorgiev (2009-04-18) Try also PEX tool It Microsoft's own probably soon to be integrated into VSTS and does support NUnit , MbUnit and xUnit.net
I use also small Console Application for testing one class or small library. You could copy paste the code from here
Score: 1 - Dan (2008-08-03) mbUnit is worth alook, it has a set of features comparable to NUnit, it has its own GUI, or can be integrated into VS if you have Resharper. I would also recommend Rhino Mocks if you are doing any sort of TDD.
Score: 1 - Kevin Sheffield (2008-08-07) I would say mbUnit also, I like being able to run a single test many times just by specifying inputs and result right above the test function. Horrible description of what I mean so here is a link that shows you what I mean.
Score: 1 - Siva (2011-05-28) VSTT 2010 should be a good bet if you are looking for functional test automation. Web Services Testing, UI testing, Biztalk testing and Data Driven Testing Support. Please look at VSTT - http://msdn.microsoft.com/en-us/library/ee338734(v=vs.90).aspx
A very interesting post on using Typemock and Nunit.
Automatically update version number
Score: 33 - Robert Höglund (2008-08-03) [c#], [.net], [visual-studio] I would like the version property of my application to be incremented for each build but I'm not sure on how to enable this functionality in Visual Studio (2005/2008). I have tried to specify the AssemblyVersion as 1.0.* but it doesn't get me exactly what I want.
I'm also using a settings file and in earlier attempts when the assembly version changed my settings got reset to the default since the application looked for the settings file in another directory.
I would like to be able to display a version number in the form of 1.1.38 so when a user finds a problem I can log the version they are using as well as tell them to upgrade if they have an old release.
A short explanation of how the versioning works would also be appreciated. When does the build and revision number get incremented?
Score: 29* - Michael Stum (2008-08-03) With the "Built in" stuff, you can't, as using 1.0.* or 1.0.0.* will replace the revision and build numbers with a coded date/timestamp, which is usually also a good way. For more info, see the Assembly Linker Documentation in the /v tag.
As for automatically incrementing numbers, use the AssemblyInfo Task:
http://code.msdn.microsoft.com/AssemblyInfoTaskvers
This can be configured to automatically increment the build number.
There are 2 Gotchas:
- Each of the 4 numbers in the Version string is limited to 65535. This is a Windows Limitation and unlikely to get fixed.
- Using with with Subversion requires a small change:
Retreiving the Version number is then quite easy:
Version v = Assembly.GetExecutingAssembly().GetName().Version;
string About = string.Format(CultureInfo.InvariantCulture, @"YourApp Version {0}.{1}.{2} (r{3})", v.Major, v.Minor, v.Build, v.Revision);
Score: 5 - Solracnapod (2008-09-30) VS.NET defaults the Assembly version to 1.0.* and uses the following logic when auto-incrementing: it sets the build part to the number of days since January 1st, 2000, and sets the revision part to the number of seconds since midnight, local time, divided by two.
Assembly version is located in a assemblyinfo.vb or assemblyinfo.cs file. From the file:
' Version information for an assembly consists of the following four values:
'
' Major Version
' Minor Version
' Build Number
' Revision
'
' You can specify all the values or you can default the Build and Revision Numbers
' by using the '*' as shown below:
' <Assembly: AssemblyVersion("1.0.*")>
<Assembly: AssemblyVersion("1.0.0.0")>
<Assembly: AssemblyFileVersion("1.0.0.0")>
Score: 2 - engtech (2008-08-03) What source control system are you using?
Almost all of them have some form of $ Id $ tag that gets expanded when the file is checked in.
I usually use some form of hackery to display this as the version number.
The other alternative is use to use the date as the build number: 080803-1448
FWIW, I use subversion, cruisecontrol and ant for my Delphi builds. I manually set the Major and Minor numbers. The third number is the subversion revision and the fourth is the cruisecontrol build number.
Score: 0 - Michael Stum (2008-08-03) And, to clarify: In .net or at least in C#, the build is actually the THIRD number, not the fourth one as some people (for example Delphi Developers who are used to Major.Minor.Release.Build) might expect.
In .net, it's Major.Minor.Build.Revision.
Score: 0 - caryden (2008-08-04) Some time ago I wrote a quick and dirty exe that would update the version #'s in an assemblyinfo.{cs/vb} - I also have used rxfind.exe (a simple and powerful regex-based search replace tool) to do the update from a command line as part of the build process. A couple of other helpfule hints:
- separate the assemblyinfo into product parts (company name, version, etc.) and assembly specific parts (assembly name etc.). See here
- Also - i use subversion, so I found it helpful to set the build number to subversion revision number thereby making it really easy to always get back to the codebase that generated the assembly (e.g. 1.4.100.1502 was built from revision 1502).
Score: 0 - user283258 (2010-02-28) If you want an auto incrementing number that updates each time a compilation is done, you can use VersionUpdater from a pre-build event. Your pre-build event can check the build configuration if you prefer so that the version number will only increment for a Release build (for example).
ASP.NET, Visual Studio and Subversion - how to integrate?
Score: 11 - Michael Stum (2008-08-02) [asp.net], [visual-studio], [svn] I use AnkhSVN and Visual Studio 2005 and 2008. Now, one thing that bugs me is that Ankh does not really work with ASP.NET sites. I cannot add them properly to a repository and it won't detect changes, especially because the site is on a remote server accessed through Frontpage Extensions (File => Open Site).
What are the alternatives? Does a better plug-in exist? Manually downloading the files through FTP and using TortoiseSVN or svn.exe is not really the level of integration I want :) I want to stay within the Visual Studio IDE when possible. Also, I do not control the remote Server, so I can not install anything on it, which means the whole change tracking/comparison to repository has to be done on my machine.
Score: 13 - Geoff Dalgas (2008-08-02) Here on the Stack Overflow project we use VisualSVN. It really does a pretty decent job of integrating with Tortoise to provide menu selections that abstract away the pains of dealing with SVN at the file system level. It is highly recommended:
Working with remote site is not possible with Subversion as far as I know. Other nuances of web development with VisualSVN are described here.
Score: 1 - Dave Ward (2008-08-02) Have you tried VisualSVN?
I don't have any recent experience using anything against the Frontpage Extensions, but VisualSVN does seem generally a lot more polished than Ankh.
Score: 1 - nickd (2008-09-04) Michael, do you control the remote server? If you do, you could install a continuous integration server or a similar process that watches for changes and checks them out to the web server.
Score: 1 - holiveira (2009-02-01) I use two pieces of very inexpensive software to solve this problem: Visual SVN and DispatchFTP.
The former is to log to my Subversion Repository hosted in Dreamhost, the later is an extremely flexible ftp plugin for Visual Studio. It allows you to create different deployment configurations, such as test and production, and automatically synchronizes your local folders with your remote server.
I've been managing several websites this way and the deployment process couldn't be any simpler, it's just a keyboard shortcut away!
Score: 0 - Ishmaeel (2008-08-03) I'm not entirely sure if this would help with your VS integration issues, but, Subversion has a special mode for Visual Studio that uses _svn directories instead of .svn.
In the past, this has been an unsupported hack for the benefit of web projects in VS. Apparently, the hack is now officially supported. See: asp dot net hack
Score: 0 - Ben Mills (2008-08-03) I've also had great success with VisualSVN. I mostly use TortoiseSVN, but VisualSVN comes in really handy when you add, delete, rename and move files in the ASP.NET project. For example, if you just use TortoiseSVN and you want to delete a file from the project, then you start by deleting the file from the project in Visual Studio and then you have to flip over to the explorer window to delete the files from the Subversion repository. With VisualSVN, you just delete the file in Visual Studio and VisualSVN takes care of the rest. In my opinion, the product is useful enough to justify the $49 cost.
Score: 0 - Michael Stum (2008-08-04) Thanks! I completely forgot about Web Application Projects - mainly because they were not initially part of Visual Studio 2005 and had to be manually downloaded. In Visual Studio 2005 SP1 and Visual Studio 2008, they are back.
As it is pretty much impossible to do it otherwise, I'll use a WAP from now on.
Score: 0 - bcwood (2008-08-05) Another vote here for VisualSVN. I've also tried Ankh, and I have to say the VisualSVN is a much better product, and well worth the money. It integrates very nicely with TortoiseSVN, and gives you all the same commands within Visual Studio that you are used to seeing inside Windows Explorer.
Score: 0 - Ted (2008-09-29) May I ask why you wouldn't just develop on your local machine and then upload as necessary to the remote server? Years and years ago I had to develop on a remote machine via frontpage, and I wonder why anyone would willingly continue on that route as opposed to using frontpage to simply deploy after development.
Moving it locally now allows for easy debugging, use of Subversion with VisualSVN, and the list of benefits goes on.
Score: 0 - Chris S (2009-02-15) One thing I don't think anyone has mentioned is VisualSVN doesn't use the source code bindings that AnkhSVN uses (a built in Visual Studio provider). Everything appears committed/out of date inside Visual Studio via icons and tortoise. It takes getting use to but works very well. The only issue is the strange way SVN insists on using .svn folders everywhere instead of just one database file.
It definitely is a lot more stable than ANKHSVN, which I've had a lot of problems adding and moving folders, and it generally getting itself into a mess over trivial operations that TFS finds easy.
Score: -2 - Andrei Rinea (2008-09-28) With all these VisualSVN recommandations above I'm sure I'm redundant but could I recommend...
VisualSVN? :D
It really works great and it must be very popular since there is even a crack available for it. Not that I would encourage such practices but it can still be (the existence of at least a crack) a measurement of software success.